


TYPE OF DATA

Type of Analysis Numerical Categorical

Describing a group
or several groups

Ordered array, stem-and-leaf display, frequency
distribution, relative frequency distribution,
percentage distribution, cumulative percentage
distribution, histogram, polygon, cumulative
percentage polygon (Sections 2.3, 2.5)
Mean, median, mode, quartiles, geometric mean,
range, interquartile range, standard deviation,
variance, coefficient of variation, boxplot
(Sections 3.1, 3.2, 3.3)
Index numbers (Online Topic 16.8)

Summary table, bar chart, pie
chart, Pareto chart (Sections 2.2, 2.4)

Inference about one group Confidence interval estimate of the mean
(Sections 8.1 and 8.2)
t test for the mean (Section 9.2)
Chi-square test for a variance (Section 12.5)

Confidence interval estimate of the
proportion (Section 8.3)
Z test for the proportion
(Section 9.4)

Comparing two groups Tests for the difference in the means of two
independent populations (Section 10.1)
Paired t test (Section 10.2)
F test for the difference between two variances
(Section 10.4)
Wilcoxon rank sum test (Section 12.6)
Wilcoxon signed ranks test (Online Topic 12.8)

Z test for the difference between
two proportions (Section 10.3)
Chi-square test for the difference
between two proportions
(Section 12.1)
McNemar test for the difference
between two proportions in related
samples (Section 12.4)

Comparing more
than two groups

One-way analysis of variance (Section 11.1)
Randomized block design (Section 11.2)
Two-way analysis of variance (Section 11.3)
Kruskal-Wallis test (Section 12.7)
Friedman rank test (Online Topic 12.9)

Chi-square test for differences
among more than two proportions
(Section 12.2)

Analyzing the
relationship between
two variables

Scatter plot, time series plot (Section 2.6)
Covariance, coefficient of correlation (Section 3.5)
Simple linear regression (Chapter 13)
t test of correlation (Section 13.7)
Time series forecasting (Chapter 16)

Contingency table, side-by-side
bar chart, (Sections 2.2, 2.4)
Chi-square test of independence
(Section 12.3)

Analyzing the
relationship between
two or more variables

Multiple regression (Chapters 14 and 15) Multidimensional contingency
tables (Section 2.7)
Logistic regression (Section 14.7)

A ROADMAP FOR SELECTING
A STATISTICAL METHOD
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Preface

Educational Philosophy
Seeking ways to continuously improve the teaching of business statistics is the core value that
guides our works. We actively participate in Decision Sciences Institute (DSI), American Statistical
Association (ASA), and Making Statistics More Effective in Schools and Business (MSMESB)
conferences. We use the Guidelines for Assessment and Instruction (GAISE) reports as well as our
reflections on teaching business statistics to a diverse student body at several large universities.
These experiences have helped us identify the following key principles:

1. Show students the relevance of statistics Students need a frame of reference when learning
statistics, especially when statistics is not their major. That frame of reference for business
students should be the functional areas of business, such as accounting, finance, information
systems, management, and marketing. Each statistics topic needs to be presented in an
applied context related to at least one of these functional areas. The focus in teaching each
topic should be on its application in business, the interpretation of results, the evaluation of
the assumptions, and the discussion of what should be done if the assumptions are violated.

2. Familiarize students with the statistical applications used in the business world
Integrating these programs into all aspects of an introductory statistics course allows the
course to focus on interpretation of results instead of computations. Introductory business
statistics courses should recognize that programs with statistical functions are commonly
found on a business decision maker’s desktop computer, therefore making the interpretation
of results more important than the tedious hand calculations required to produce them.

3. Provide clear instructions to students for using statistical applications Books should
explain clearly how to use programs such as Excel and Minitab with the study of statistics,
without having those instructions dominate the book or distract from the learning of statisti-
cal concepts.

4. Give students ample practice in understanding how to apply statistics to business Both
classroom examples and homework exercises should involve actual or realistic data as much as
possible. Students should work with data sets, both small and large, and be encouraged to look
beyond the statistical analysis of data to the interpretation of results in a managerial context.

New to This Edition: MyStatLab
Custom MyStatLab course materials designed for specific use with this book are available.
MyStatLab is Pearson Education’s online learning, homework, and assessment tool that provides a
rich and flexible set of course materials, including free-response exercises that are algorithmically
generated for unlimited practice and mastery. MyStatLab provides students with a personalized,
interactive learning environment that helps them to independently improve their understanding and
performance in a course. MyStatLab allows instructors to deliver portions of a course online, to per-
form course management functions, and to create a supportive online community. In addition,
instructors can use the MyStatLab homework and test manager to select and assign their own online
exercises as well as import TestGen tests. 

The MyStatLab for Basic Business Statistics features several improvements over earlier versions
including a more intuitive user design that presents a simpler interface with fewer pop-up windows.
This MyStatLab also provides mobile device access through free apps that can be downloaded for
iPhones, iPads, and Andriod phones. (iPad users can even download a free app to access all of their
Pearson eTexts, seeing their instructors annotations and gaining links to Do Homework, Take a Test,
and Study Plan functions.)

xxiii
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New to This Edition: Enhanced Statistical Coverage
This 12th edition of Basic Business Statistics builds on previous editions with these new and
enhanced features:

• New chapter-ending “Using Statistics ... Revisited” sections that reinforce the statistical
methods and applications discussed in each chapter.

• The use of the DCOVA (Define, Collect, Organize, Visualize, and Analyze) framework as an
integrated approach for applying statistics to help solve business problems.

• Many new applied examples and exercises, with data from The Wall Street Journal, USA
Today, and other sources.

• “Managing Ashland MultiComm Services,” a new integrated case that appears at the ends of
chapters throughout the book (replacing the Springville Herald case).

• “Digital Cases,” interactive PDF files that create a new series of cases that appear at the
ends of chapters throughout the book (replacing the Web Cases).

• An expanded discussion of using Excel and Minitab to summarize and explore multidimen-
sional data.

• Revised and updated “Think About This” essays (formerly entitled “From the Author’s
Desktop”) that provide greater insight into what has just been learned and raise important
issues about the application of statistical knowledge.

• Additional in-chapter Excel and Minitab results.
• A new online section that discusses analytics and data mining.

New to This Edition: Expanded Excel and Minitab Guides
In this 12th edition of Basic Business Statistics, the instructions for using Excel and Minitab have
been revised, reorganized, and enhanced in new end-of-chapter guides and back-of-the book appen-
dices. These sections support students by:

• Providing a readiness checklist and orientation that guide students through the process of get-
ting ready to use Excel or Minitab (see Chapter 1 and the Chapter 1 Excel and Minitab Guides).

• Incorporating Excel Guide workbooks that serve as models and templates for using Excel for
statistical problem solving. These free and reusable workbooks, annotated examples of which
appear throughout the chapters of this book, can be used by students in their other courses or
in their jobs.

• Allowing students to use Excel with or without PHStat2 and with or without the Analysis
ToolPak (an Excel component that is not available in Mac Excel 2008).

• Expanding the scope of Minitab Guide instructions.
• Reviewing common operations, such as opening, saving, and printing results (see Chapter 1

Excel and Minitab Guides).
• Explaining the different types of files available online that support this book and how to

download those free files from this book’s companion website (Appendix C).
• Providing a separate appendix that discusses software configuration issues, including how to

check for Excel and Minitab updates and how to configure Excel for use with PHStat2 or the
Analysis ToolPak (Appendix D).

• An appendix that discusses formatting and other intermediate-level Excel operations
(Appendix F).

• Answering frequently asked questions about Excel, PHStat2, the Pearson statistical add-in
for Microsoft Windows–based Excel versions, and Minitab (the new Appendix G).

• In Appendix Section C.4, offering a complete list of all downloadable files and programs for
this book. (See “Student Resources” on page xxvi for more details about the files and programs
that can be downloaded.)

Chapter-by-Chapter Changes in the 12th Edition
Chapters begin with a redesigned opening page that displays the chapter sections and subsections
and conclude with the new Excel and Minitab Guides that discuss how to apply Excel and Minitab
to the statistical methods discussed in a chapter. Minitab Guides have been expanded to better match
the scope of the Excel Guides. End-of-chapter Digital Cases that use interactive documents, in lieu
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of simulated web pages, update the former Web Cases. There is a new integrated case, “Managing
Ashland MultiComm Services,” that replaces the “Managing the Springville Herald” case (see
Chapters 2, 3, 5 through 7, 9 through 14, 16, and 17). Appendices B through D and F and G have
been revised, reorganized, and updated.

Highlights of changes to individual chapters follow.

Chapter 1 The 11th edition’s Section 1.4 has been moved to Chapter 2. Section 1.6 has been
rewritten and retitled “How to Use This Book” and now includes the “Checklist for Getting
Started” (with Excel or Minitab). There are new undergraduate and graduate surveys.

Chapter 2 This chapter has been completely reorganized. Sections 1.4 of the previous edition,
concerning data collection, has been moved to this chapter. The Define, Collect, Organize,
Visualize, and Analyze approach to solving business problems has been incorporated. The
material on tables and charts has been reorganized so that the sections on organizing data into
tables is presented first, in Sections 2.2 and 2.3, followed by sections on visualizing data in
graphs in Sections 2.4–2.7. There is a new section on organizing multidimensional data
(Section 2.7). There are new Excel and Minitab Guide sections that discuss multidimensional
data. The Minitab Guide that replaces the Minitab Appendix has been greatly expanded. In
addition, there are new examples throughout the chapter, and a new data set on bond funds has
been created.

Chapter 3 A new data set on bond funds has been created. The section “Numerical Measures
for a Population” has been moved after the section on quartiles and boxplots. “Numerical
Descriptive Measures from a Population” has been deleted.

Chapter 4 The chapter example has been updated. There are new problems throughout the
chapter. The “Think About This” essay about Bayes’ theorem has been condensed and
updated. In combinations and permutations, x is used instead of X to be consistent with bino-
mial notation in Chapter 5.

Chapter 5 This chapter has revised notation for the binomial, Poisson, and hypergeometric
distributions. It uses lower-case x and includes the parameter after an | sign in the equa-
tion. To reduce the size of the book, the tables of the binomial and Poisson distributions
(Tables E.6 and E.7) have been placed online. There are new problems throughout the
chapter.

Chapter 6 This chapter has an updated Using Statistics scenario. The “Think About This”
essay on the importance of the normal distribution has been revised. The discussion of the
exponential distribution has been revised.

Chapter 7 A new “Think About This” essay replaces and expands on the pros and cons of web-
based surveys, using a famous historical example. “Sampling from Finite Populations” is
now an online topic.

Chapter 8 This chapter includes problems on sigma known in Section 8.1.
Chapter 9 This chapter includes problems on sigma known in Section 9.1. “Power of a Test” is

now an online topic.
Chapter 10 This chapter has a new example on the paired t-test on textbook prices.
Chapter 11 This chapter has an “Online Topic” subsection titled “The Analysis of Means

(ANOM).”
Chapter 12 This chapter has an “Online Topic” subsection titled “The Analysis of Proportions

(ANOP).” The Wilcoxon signed ranks test and the Friedman test are now online topicss.
Chapter 13 The “Think About This” essay has been revised. There are new problems through-

out the chapter.
Chapter 14 This chapter has various new problems.
Chapter 15 This chapter has a new “Online Topic” section titled “Analytics and Data Mining.”

There are new problems throughout the chapter.
Chapter 16 This chapter has updated examples throughout the chapter. “Index Numbers” is

now an online topic.
Chapter 17 This chapter has been edited for conciseness without any loss of concepts or clarity.
Chapter 18 This chapter now includes an interactive roadmap for analyzing data as part of a

new Digital Case. There are many new problems in the chapter.
Chapter 19 This chapter (formerly Chapter 17) has become an online chapter and is available

for download through this book’s companion website.
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Hallmark Features
We have continued many of the traditions of past editions and have highlighted some of these
features below.

Using Statistics Business Scenarios—Each chapter begins with a Using Statistics example that
shows how statistics is used in the functional areas of business—accounting, finance, infor-
mation systems, management, and marketing. Each scenario is used throughout the chapter
to provide an applied context for the concepts.

Emphasis on Data Analysis and Interpretation of Software Results—We believe that
the use of computer software is an integral part of learning statistics. Our focus empha-
sizes analyzing data by interpreting results while reducing emphasis on doing compu-
tations. For example, in the coverage of tables and charts in Chapter 2, the focus is on
the interpretation of various charts and on when to use each chart. In our coverage of
hypothesis testing in Chapters 9 through 12, and regression and time series forecasting in
Chapters 13–16, extensive computer results have been included so that the p-value
approach can be emphasized.

Pedagogical Aids—An active writing style is used, with boxed numbered equations, set-off
examples to provide reinforcement for learning concepts, problems divided into “Learning
the Basics” and “Applying the Concepts,” key equations, and key terms.

Answers—Many answers to the even-numbered exercises are included at the end of the book.

Flexibility Using Excel—For almost every statistical method discussed, this book presents
more than one way of using Excel. Students can use In-Depth Excel instructions to directly
work with the worksheet cell-level details or they can use the PHStat2 instructions or use the
Analysis ToolPak instructions to automate the creation of those same details.

Digital Cases—An end-of-chapter Digital Case is included for each of the first 16 chapters.
Most Digital Cases extend a Using Statistics business scenario by posing additional ques-
tions and raising issues about the scenario. Students examine interactive documents to sift
through claims and assorted information in order to discover the data most relevant to a sce-
nario. Students then determine whether the conclusions and claims are supported by the data.
In doing so, students discover and learn how to identify common misuses of statistical infor-
mation. (Instructional tips for using the Digital Cases and solutions to the Digital Cases are
included in the Instructor’s Solutions Manual.)

Case Studies and Team Projects—Detailed case studies are included in numerous chapters. A
“Managing Ashland MultiComm Services” continuing case, a team project related to bond
funds, and undergraduate and graduate student surveys are included at the end of most chap-
ters, and these serve to integrate learning across the chapters.

Visual Explorations—The Excel add-in workbook allows students to interactively explore
important statistical concepts in descriptive statistics, the normal distribution, sampling dis-
tributions, and regression analysis. For example, in descriptive statistics, students observe the
effect of changes in the data on the mean, median, quartiles, and standard deviation. With the
normal distribution, students see the effect of changes in the mean and standard deviation on
the areas under the normal curve. In sampling distributions, students use simulation to
explore the effect of sample size on a sampling distribution. In regression analysis, students
have the opportunity to fit a line and observe how changes in the slope and intercept affect
the goodness of fit.

Student Resources
Student Solutions Manual—Created by Professor Pin Tian Ng of Northern Arizona University,

this manual provides detailed solutions to virtually all the even-numbered exercises and
worked-out solutions to the self-test problems.

Companion website—This book comes with a companion website from which the following
resources can be downloaded for free (see Appendix C that starts on page 784 for more
details about these resources, including how to visit the companion website):
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• Data files Excel and Minitab data files used by in-chapter examples and problems (in .xls
and .mtw formats).

• Online Chapter The electronic-only Chapter 19: Decision Making in PDF format.
• Online Topics Online topics are PDF files that discuss additional topics for Chapters 5, 6, 7,

8, 9, 11, 12, 15, and 16. 
• Excel Guide workbooks Self-documenting Excel Guide workbooks illustrate solutions for

more than 60 statistical topics that serve as freely reusable templates for future problem solv-
ing.

• Case files Supporting files are provided for the Digital Cases and the Managing Ashland
MultiComm Services Case.

• Visual Explorations The files needed to use the Visual Explorations Excel add-in work-
book.

• Using Excel 2003 Guide This guide presents, where necessary, alternate Excel Guide
instructions for users of this older version of Excel.

• PHStat2 The latest version of PHStat2, the Pearson statistical add-in for Windows-based
Excel, version 2003 and later. This version eliminates the use of the Excel Analysis ToolPak
add-ins, thereby simplifying installation and setup.

MyStatLab—MyStatLab provides students with direct access to the companion website
resources as well as the following exclusive online features and tools:

• Interactive tutorial exercises A comprehensive set of exercises have been written espe-
cially for use with this book that are algorithmically generated for unlimited practice and
mastery. Most exercises are free-response exercises and provide guided solutions, sample
problems, and learning aids for extra help at point of use.

• Personalized study plan A plan indicates which topics have been mastered and creates
direct links to tutorial exercises for topics that have not been mastered. MyStatLab manages
the study plan, updating its content based on the results of future online assessments.

• Pearson Tutor Center (www.pearsontutorservices.com) The MyStatlab student access
code grants access to this online resource, staffed by qualified instructors who provide book-
specific tutoring via phone, fax, e-mail, and interactive web sessions.

• Integration with Pearson eTexts iPad users can download a free app at www.apple.com/
ipad/apps-for-ipad/ and then sign in using their MyStatLab account to access a bookshelf of
all their Pearson eTexts. The iPad app also allows access to the Do Homework, Take a Test,
and Study Plan pages of their MyStatLab course.

• Mobile Dashboard Allows students to use their mobile devices to log in and review informa-
tion from the dashboard of their courses: announcements, assignments, results, and progress
bars for completed work. This app is available for iPhones, iPads, and Android phones, and is
designed to promote effective study habits rather than to allow students to complete assign-
ments on their mobile devices.

@RISK trial Palisade Corporation, the maker of the market-leading risk and decision analysis
Excel add-ins, @RISK and the DecisionTools® Suite, provides special academic versions of its
software to students (and faculty). Its flagship product, @RISK, debuted in 1987 and performs risk
analysis using Monte Carlo simulation.

@RISK and the DecisionTools Suite are used widely in undergraduate and graduate business
programs worldwide. Thanks to the company’s generous academic sales program, more than 40,000
students learn to make better decisions using @RISK and the DecisionTools Suite each year.

To download a trial version of @RISK software, visit www.palisadecom/academic/.

Instructor Resources
Instructor’s Resource Center—Reached through a link at www.pearsonhighered.com/levine,
the Instructor’s Resource Center contains the electronic files for the complete Instructor’s Solutions
Manual, the Test Item File, and PowerPoint lecture presentations.

• Register, redeem, log in At www.pearsonhighered.com/irc, instructors can access a vari-
ety of print, media, and presentation resources that are available with this book in downloadable

www.pearsontutorservices.com
www.apple.com/ipad/apps-for-ipad/
www.apple.com/ipad/apps-for-ipad/
www.palisadecom/academic/
www.pearsonhighered.com/levine
www.pearsonhighered.com/irc
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digital format. Resources are also available for course management platforms such as
Blackboard, WebCT, and CourseCompass.

• Need help? Pearson Education’s dedicated technical support team is ready to assist instruc-
tors with questions about the media supplements that accompany this text. Visit http://
247.prenhall.com for answers to frequently asked questions and toll-free user support
phone numbers. The supplements are available to adopting instructors. Detailed descriptions
are provided at the Instructor’s Resource Center.

Instructor’s Solutions Manual—Created by Professor Pin Tian Ng of Northern Arizona University,
this manual includes solutions for end-of-section and end-of-chapter problems, answers to case
questions, where applicable, and teaching tips for each chapter. Electronic solutions are provided in
PDF and Word formats.

Lecture PowerPoint Presentations—A PowerPoint presentation, created by Professor Patrick
Schur of Miami University, is available for each chapter. The PowerPoint slides provide an instruc-
tor with individual lecture outlines to accompany the text. The slides include many of the figures
and tables from the text. Instructors can use these lecture notes as is or can easily modify the notes
to reflect specific presentation needs.

Test Item File—Created by Professor Pin Tian Ng of Northern Arizona University, the Test Item
File contains true/false, multiple-choice, fill-in, and problem-solving questions based on the defini-
tions, concepts, and ideas developed in each chapter of the text.

TestGen—The computerized TestGen package allows instructors to customize, save, and generate
classroom tests. The test program permits instructors to edit, add, and delete questions from the test
bank; edit existing graphics and create new graphics; analyze test results; and organize a database of
test and student results. This software provides ease of use and extensive flexibility, and it provides
many options for organizing and displaying tests, along with search and sort features. The software
and the test banks can be downloaded from the Instructor’s Resource Center.

MathXL for Statistics—MathXL for Statistics is a powerful online homework, tutorial, and assess-
ment system that accompanies Pearson Education statistics textbooks. With MathXL for Statistics,
instructors can create, edit, and assign online homework and tests using algorithmically generated
exercises correlated at the objective level to the textbook. They can also create and assign their own
online exercises and import TestGen tests for added flexibility. All student work is tracked in
MathXL’s online grade book. Students can take chapter tests in MathXL and receive personalized
study plans based on their test results. Each study plan diagnoses weaknesses and links the student
directly to tutorial exercises for the objectives he or she needs to study and retest. Students can also
access supplemental animations and video clips directly from selected exercises. MathXL for
Statistics is available to qualified adopters. For more information, visit www.mathxl.com or con-
tact your sales representative.

MyStatLab—Part of the MyMathLab and MathXL product family, MyStatLab is a text-specific,
easily customizable online course that integrates interactive multimedia instruction with textbook
content. MyStatLab gives you the tools you need to deliver all or a portion of your course online,
whether your students are in a lab setting or working from home. The latest version of MyStatLab
offers a new, intuitive design that features more direct access to MathXL for Statistics pages
(Gradebook, Homework & Test Manager, Home Page Manager, etc.) and provides enhanced func-
tionality for communicating with students and customizing courses. Other key features include:

• Assessment manager An easy-to-use assessment manager lets instructors create online
homework, quizzes, and tests that are automatically graded and correlated directly to your
textbook. Assignments can be created using a mix of questions from the MyStatLab exercise
bank, instructor-created custom exercises, and/or TestGen test items.

• Grade book Designed specifically for mathematics and statistics, the MyStatLab grade
book automatically tracks students’ results and gives you control over how to calculate final
grades. You can also add offline (paper-and-pencil) grades to the grade book.

• MathXL Exercise Builder You can use the MathXL Exercise Builder to create static and
algorithmic exercises for your online assignments. A library of sample exercises provides an
easy starting point for creating questions, and you can also create questions from scratch.

• eText-MathXL for Statistics Full Integration Students using appropriate mobile devices
can use your eText annotations and highlights for each course, and iPAd users can download

www.mathxl.com
http://247.prenhall.com
http://247.prenhall.com
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a free app that allows them access to the Do Homework, Take a Test, and Study Plan pages of
their course.

• “Ask the Publisher” Link in “Ask My Instructor” Email You can easily notify the con-
tent team of any irregularities with specific questions by using the “Ask the Publisher” func-
tionality in the “Ask My Instructor” emails you receive from students.

• Tracking Time Spent on Media Because the latest version of MyStatLab requires students
to explicitly click a “Submit” button after viewing the media for their assignments, you will
be able to track how long students are spending on each media file.

Palisade Corporation software—Palisade Corporation, the maker of the market-leading risk and
decision analysis Excel add-ins, @RISK and the DecisionTools® Suite, provides special academic
versions of its software. Its flagship product, @RISK, debuted in 1987 and performs risk analysis
using Monte Carlo simulation. With an estimated 150,000 users, Palisade software can be found in
more than 100 countries and has been translated into five languages.

@RISK and the DecisionTools Suite are used widely in undergraduate and graduate business
programs worldwide and can be bundled with this textbook. To download a trial version of @RISK
software, visit www.palisade.com/academic/.
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M anagers at Good Tunes & More, a consumer electronics retailer, are looking
to expand their chain to take advantage of recent store closings by their
competitors. These managers have decided to approach local banks for the
funding needed to underwrite the expansion. The managers know that they
will have to present information about Good Tunes & More that will

convince the bankers that the retailer is a good candidate for expansion.
The managers ask you to help prepare the supporting documents to be submitted to the bankers.

To this end, they give you access to the retailer’s sales transactions for the past five years. What should you
do with the data? To help find a starting point for the task, you decide to learn more about statistics.

U S I N G S TAT I S T I C S

@ Good Tunes & More

3
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1.1 Why Learn Statistics
Statistics is the branch of mathematics that transforms numbers into useful information for
decision makers. Statistics lets you know about the risks associated with making a business
decision and allows you to understand and reduce the variation in the decision-making process.

Statistics provides you with methods for making better sense of the numbers used every
day to describe or analyze the world we live in. For example, consider these news stories:

• “More Clicks to Escape an Email List” (The NewYork Times, March 29, 2010, p. B2)
A study of 100 large online retailers reported that 39% required three or more clicks to
opt out of an email list in 2009, compared to 7% in 2008.

• “Green Power Purchases Targeted to Wind, Solar” (P. Davidson, USA Today,April 1,
2009, p. 3B) Approximately 55% of green power sales was for wind energy.

• “Follow the Tweets” (H. Rui, A. Whinston, and E. Winkler, The Wall Street Journal,
November 30, 2009, p. R4) In this study, the authors used the number of tweets that
mention specific products to make accurate predictions of sales trends.

Do these numbers represent useful information? How can you decide? Statistical methods
help you understand the information contained in “the numbers” and determine whether dif-
ferences in “the numbers” are meaningful or are just due to chance.

Why learn statistics? First and foremost, statistics helps you make better sense of the
world. Second, statistics helps you make better business decisions.

1.2 Statistics in Business
In the business world, statistics has these important specific uses:

• To summarize business data
• To draw conclusions from those data
• To make reliable forecasts about business activities
• To improve business processes

The statistical methods you use for these tasks come from one of the two branches of sta-
tistics: descriptive statistics and inferential statistics.

DESCRIPTIVE STATISTICS
Descriptive statistics are the methods that help collect, summarize, present, and analyze
a set of data.

INFERENTIAL STATISTICS
Inferential statistics are the methods that use the data collected from a small group to
draw conclusions about a larger group.

Many of the tables and charts found in a typical presentation are the products of descrip-
tive methods, as are statistics such as the mean or median of a group, which you may have en-
countered previously. (The mean and median are among the concepts discussed in Chapter 3.)
When you use statistical methods to help choose which investment from a set of investments
might lead to a higher return or which marketing strategy might lead to increased sales, you
are using inferential methods.

There are four important uses of statistics in business:

• To visualize and summarize your data (an example of using descriptive methods)
• To reach conclusions about a large group based on data collected from a small group (an

example of using inferential methods)
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• To make reliable forecasts that are based on statistical models for prediction (inferential
methods)

• To improve business processes using managerial approaches such as Six Sigma that
focus on quality improvement

To use descriptive and inferential methods correctly, you must also learn the conditions
and assumptions required for using those methods. And since many of the statistical methods
used in business must be computerized in order to be of practical benefit, you also need to
know how computers can help you apply statistics in the business world.

To help you develop and integrate these skills, which will give you a basis for making bet-
ter decisions, every chapter of Basic Business Statistics begins with a Using Statistics scenario.
Each scenario describes a realistic business situation in which you are asked to make decisions
that can be enhanced by applying statistical methods. For example, in one chapter you must
decide the location in a supermarket that best enhances sales of a cola drink, while in another
chapter you need to forecast sales for a clothing store.

In the scenario on page 3, you need to answer the following questions: What data should
you include to convince bankers to extend the credit that Good Tunes & More needs? How
should you present those data?

Because Good Tunes & More is a retailer, collecting data about the company’s sales would
be a reasonable starting point. You could present the details of every sales transaction for the
past few years as a way of demonstrating that the business is thriving. However, presenting the
bankers with the thousands of transactions would overwhelm them and not be very useful. You
need to summarize the details of each transaction in some useful way that will give the bankers
the information to (perhaps) uncover a favorable pattern about the sales over time.

One piece of information that the bankers would presumably want to see is the yearly dol-
lar sales totals. Tallying and totaling sales is a common summary task. When you tally sales—
or any other relevant data about Good Tunes & More that you choose to use—you follow
standard business practice and tally by a business period, such as by month, quarter, or year.
When you do so, you end up with multiple values: sales for this year, sales for last year, sales
for the year before that, and so on.

Knowing more about statistics will definitely help you prepare a better presentation for
the bankers! And the best way to begin knowing more about statistics is to learn the basic vo-
cabulary of statistics.

1.3 Basic Vocabulary of Statistics
Seven terms—variable, data, operational definition, population, sample, parameter, and sta-
tistic (singular)—identify the fundamental concepts of the subject of statistics. Learning about
and making sense of the statistical methods discussed in later chapters is nearly impossible if
you do not first understand the meaning of these words.

Variables are characteristics of items or individuals. They are what you analyze when you
use a statistical method. For the Good Tunes & More scenario, sales, expenses by year, and net
profit by year are variables that the bankers would want to analyze. When used in everyday
speech, variable suggests that something changes or varies, and you would expect sales, ex-
penses, and net profit to have different values from year to year. These different values are the
data associated with a variable or, more simply, the “data to be analyzed.”

VARIABLE
A variable is a characteristic of an item or individual.

DATA
Data are the different values associated with a variable.
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Variables can differ for reasons other than time. For example, if you conducted an analysis
of the composition of a large lecture class, you would probably want to include the variables
class standing, gender, and major field of study. These variables would also vary because each
student in the class is different. One student might be a sophomore, a male, and an accounting
major, while another might be a junior, a female, and a finance major.

Variable values are meaningless unless their corresponding variables have operational
definitions. These definitions are universally accepted meanings that are clear to all asso-
ciated with an analysis. Even though the operational definition for sales per year might
seem clear, miscommunication could occur if one person were to refer to sales per year for
the entire chain of stores and another to sales per year per store. Even individual values for
variables sometimes need to be defined. For the class standing variable, for example, what
exactly is meant by the words sophomore and junior? (Perhaps the most famous examples
of vague definitions have been election disputes, such as the one that occurred in Florida
during the 2000 U.S. presidential election that involved the definitions for “valid” and “in-
valid” ballots.)

The subject of statistics creates useful information from either populations or samples.

POPULATION
A population consists of all the items or individuals about which you want to reach
conclusions.

SAMPLE
A sample is the portion of a population selected for analysis.

A population consists of all the items or individuals about which you want to reach con-
clusions. All the Good Tunes & More sales transactions for a specific year, all the customers
who shopped at Good Tunes & More this weekend, all the full-time students enrolled in a col-
lege, and all the registered voters in Ohio are examples of populations.

A sample is the portion of a population selected for analysis. From the four examples of
populations just given, you could select a sample of 200 Good Tunes & More sales transac-
tions randomly selected by an auditor for study, a sample of 30 Good Tunes & More customers
asked to complete a customer satisfaction survey, a sample of 50 full-time students selected
for a marketing study, and a sample of 500 registered voters in Ohio contacted by telephone
for a political poll. In each of these examples, the transactions or people in the sample repre-
sent a portion of the items or individuals that make up the population.

Parameter and statistic complete the basic vocabulary of statistics.

PARAMETER
A parameter is a measure that describes a characteristic of a population.

STATISTIC
A statistic is a measure that describes a characteristic of a sample.

The average amount spent by all customers who shopped at Good Tunes & More this
weekend is an example of a parameter because this amount refers to the amount spent in the
entire population. In contrast, the average amount spent by the 30 customers completing the
customer satisfaction survey is an example of a statistic because it refers only to the amount
spent by the sample of 30 customers.
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1.4 Identifying Types of Variables
Identifying the characteristic of an item or individual to study and assigning an operational
definition to that characteristic is only part of the variable definition process. For each vari-
able, you must also establish the type of values it will have.

Categorical variables (also known as qualitative variables) have values that can only be
placed into categories such as yes and no. “Do you currently own bonds?” (yes or no) and the
level of risk of a bond fund (below average, average, or above average) are examples of cate-
gorical variables.

Numerical variables (also known as quantitative variables) have values that represent
quantities. Numerical variables are further identified as being either discrete or continuous
variables.

Discrete variables have numerical values that arise from a counting process. “The num-
ber of premium cable channels subscribed to” is an example of a discrete numerical variable
because the response is one of a finite number of integers. You subscribe to zero, one, two, or
more channels. “The number of items purchased” is also a discrete numerical variable because
you are counting the number of items purchased.

Continuous variables produce numerical responses that arise from a measuring process.
The time you wait for teller service at a bank is an example of a continuous numerical variable
because the response takes on any value within a continuum, or an interval, depending on the
precision of the measuring instrument. For example, your waiting time could be 1 minute,
1.1 minutes, 1.11 minutes, or 1.113 minutes, depending on the precision of the measuring de-
vice used. (Theoretically, no two continuous values would ever be identical. However, because
no measuring device is perfectly precise, identical continuous values for two or more items or
individuals can occur.)

At first glance, identifying the variable type may seem easy, but some variables that you
might want to study could be either categorical or numerical, depending on how you define
them. For example, “age” would seem to be an obvious numerical variable, but what if you are
interested in comparing the buying habits of children, young adults, middle-aged persons, and
retirement-age people? In that case, defining “age” as a categorical variable would make better
sense. Again, this illustrates the earlier point that without operational definitions, variables are
meaningless.

Asking questions about the variables you have identified for study can often be a great
help in determining the variable type you want. Table 1.1 illustrates the process. Note that the
“answers” to the questions are labeled responses. The word responses is sometimes used in
statistics to refer to the values of a variable.

T A B L E 1 . 1

Types of Variables

Question Responses Data Type

Do you currently have a profile
on Facebook?

❑ Yes ❑ No Categorical

How many text messages have
you sent in the past week?

____ Numerical
(discrete)

How long did it take to download
a video game?

____ seconds Numerical
(continuous)

Measurement Scales
The values for variables can themselves be classified by the level of measurement, or meas-
urement scale. Statisticians use the terms nominal scale and ordinal scale to describe the val-
ues for a categorical variable and use the terms interval scale and ratio scale to describe
numerical values.
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T A B L E 1 . 2

Examples of Nominal
Scales

Categorical Variable Categories

Do you currently have a Facebook
profile?

❑ Yes ❑ No

Types of investments ❑ Stocks ❑ Bonds ❑ Other ❑ None

Internet email provider ❑ Gmail ❑ Windows Live ❑ Yahoo ❑ Other

T A B L E 1 . 3

Examples of Ordinal
Scales

Categorical Variable Ordered Categories

Student class designation Freshman Sophomore Junior Senior

Product satisfaction Very unsatisfied Fairly unsatisfied
Neutral Fairly satisfied Very satisfied

Faculty rank Professor Associate Professor
Assistant Professor Instructor

Standard & Poor’s bond ratings AAA AA A BBB BB B CCC CC C
DDD DD D

Student grades A B C D F

Nominal and Ordinal Scales Values for a categorical variable are measured on a nominal
scale or on an ordinal scale. A nominal scale (see Table 1.2) classifies data into distinct cate-
gories in which no ranking is implied. Examples of a nominal scaled variable are your favorite
soft drink, your political party affiliation, and your gender. Nominal scaling is the weakest
form of measurement because you cannot specify any ranking across the various categories.

An ordinal scale classifies values into distinct categories in which ranking is implied. For
example, suppose that Good Tunes & More conducted a survey of customers who made a pur-
chase and asked the question “How do you rate the overall service provided by Good Tunes &
More during your most recent purchase?” to which the responses were “excellent,” “very
good,” “fair,” and “poor.” The answers to this question would constitute an ordinal scaled vari-
able because the responses “excellent,” “very good,” “fair,” and “poor” are ranked in order of
satisfaction. Table 1.3 lists other examples of ordinal scaled variables.

Ordinal scaling is a stronger form of measurement than nominal scaling because an
observed value classified into one category possesses more of a property than does an
observed value classified into another category. However, ordinal scaling is still a relatively
weak form of measurement because the scale does not account for the amount of the differ-
ences between the categories. The ordering implies only which category is “greater,” “better,”
or “more preferred”—not by how much.

Interval and Ratio Scales Values for a numerical variable are measured on an interval scale
or a ratio scale. An interval scale (see Table 1.4) is an ordered scale in which the difference
between measurements is a meaningful quantity but does not involve a true zero point. For
example, a noontime temperature reading of 67 degrees Fahrenheit is 2 degrees warmer than a
noontime reading of 65 degrees. In addition, the 2 degrees Fahrenheit difference in the noontime
temperature readings is the same as if the two noontime temperature readings were 74 and
76 degrees Fahrenheit because the difference has the same meaning anywhere on the scale.
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Problems for Section 1.4
LEARNING THE BASICS
1.1 Four different beverages are sold at a fast-food restau-
rant: soft drinks, tea, coffee, and bottled water.
a. Explain why the type of beverage sold is an example of a

categorical variable.
b. Explain why the type of beverage sold is an example of a

nominal scaled variable.

1.2 Coffee is sold in three sizes at a fast-food restaurant:
small, medium, and large. Explain why the beverage size of
coffee is an example of an ordinal scaled variable.

1.3 Suppose that you measure the time it takes to download
a video from the Internet.
a. Explain why the download time is a continuous numeri-

cal variable.
b. Explain why the download time is a ratio scaled variable.

APPLYING THE CONCEPTS
1.4 For each of the following variables, deter-
mine whether the variable is categorical or numer-

ical. If the variable is numerical, determine whether the

SELF
Test

variable is discrete or continuous. In addition, determine the
measurement scale.
a. Number of telephones per household
b. Length (in minutes) of the longest telephone call made in

a month
c. Whether someone in the household owns a Wi-Fi-capable

cell phone
d. Whether there is a high-speed Internet connection in the

household

1.5 The following information is collected from students
upon exiting the campus bookstore during the first week of
classes.
a. Amount of time spent shopping in the bookstore
b. Number of textbooks purchased
c. Academic major
d. Gender

Classify each of these variables as categorical or numerical.
If the variable is numerical, determine whether the variable is
discrete or continuous. In addition, determine the measure-
ment scale for each of these variables.

T A B L E 1 . 4

Examples of Interval and
Ratio Scales

Numerical Variable Level of Measurement

Temperature (in degrees Celsius 
or Fahrenheit)

Interval

Standardized exam score 
(e.g., ACT or SAT)

Interval

Time to download a file
(in seconds)

Ratio

Age (in years
or days)

Ratio

Cost of a personal computer 
system (in U.S. dollars)

Ratio

A ratio scale is an ordered scale in which the difference between the measurements involves
a true zero point, as in height, weight, age, or salary measurements. If Good Tunes & More con-
ducted a survey and asked the amount of money that you expected to spend on audio equipment
in the next year, the responses to such a question would be an example of a ratio scaled variable.
As another example, a person who weighs 240 pounds is twice as heavy as someone who weighs
120 pounds. Temperature is a trickier case: Fahrenheit and Celsius (centigrade) scales are inter-
val but not ratio scales; the “zero” value is arbitrary, not real.You cannot say that a noontime tem-
perature reading of 4 degrees Fahrenheit is twice as hot as 2 degrees Fahrenheit. But a Kelvin
temperature reading, in which 0 degrees means no molecular motion, is ratio scaled. In contrast,
the Fahrenheit and Celsius scales use arbitrarily selected 0-degree beginning points.

Data measured on an interval scale or on a ratio scale constitute the highest levels of meas-
urement. They are stronger forms of measurement than an ordinal scale because you can deter-
mine not only which observed value is the largest but also by how much.
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1.6 For each of the following variables, determine whether
the variable is categorical or numerical. If the variable is
numerical, determine whether the variable is discrete or
continuous. In addition, determine the measurement scale
for each variable.
a. Name of Internet service provider
b. Time in hours spent surfing the Internet per week
c. Number of emails received in a week
d. Number of online purchases made in a month

1.7 For each of the following variables, determine whether
the variable is categorical or numerical. If the variable is
numerical, determine whether the variable is discrete or
continuous. In addition, determine the measurement scale
for each variable.
a. Amount of money spent on clothing in the past month
b. Favorite department store
c. Most likely time period during which shopping for cloth-

ing takes place (weekday, weeknight, or weekend)
d. Number of pairs of shoes owned

1.8 Suppose the following information is collected from
Robert Keeler on his application for a home mortgage loan
at the Metro County Savings and Loan Association.
a. Monthly payments: $1,927
b. Number of jobs in past 10 years: 1
c. Annual family income: $76,000
d. Marital status: Married

Classify each of the responses by type of data and meas-
urement scale.

1.9 One of the variables most often included in surveys is
income. Sometimes the question is phrased “What is your
income (in thousands of dollars)?” In other surveys, the re-
spondent is asked to “Select the circle corresponding to
your income level” and is given a number of income ranges
to choose from.
a. In the first format, explain why income might be consid-

ered either discrete or continuous.
b. Which of these two formats would you prefer to use if

you were conducting a survey? Why?

1.10 If two students score a 90 on the same examination,
what arguments could be used to show that the underlying
variable—test score—is continuous?

1.11 The director of market research at a large department
store chain wanted to conduct a survey throughout a metro-
politan area to determine the amount of time working
women spend shopping for clothing in a typical month.
a. Describe both the population and the sample of interest.

Indicate the type of data the director might want to
collect.

b. Develop a first draft of the questionnaire needed in (a) by
writing three categorical questions and three numerical
questions that you feel would be appropriate for this survey.

1.5 Statistical Applications for Desktop Computing
Advances in computing during the past 40 years have brought statistical applications to the
business desktop. Statistical functionality is so commonplace today that many simple statisti-
cal tasks once done exclusively with pencil and paper or hand calculators are now done
electronically, with the assistance of statistical applications.

Excel and Minitab are examples of desktop applications that people use for statistics.
Excel is the Microsoft Office data analysis application that evolved from earlier electronic
spreadsheets used in accounting and financial applications. Minitab, a dedicated statistical
application, or statistical package, was developed from the ground up to perform statistical
analysis as accurately as possible. Versions of Minitab run on larger computer systems and can
perform heavy-duty corporate analyses involving very large data sets. Excel and Minitab are
two very different programs, and their differences have led to an ongoing debate as to which
program is more appropriate for use in an introductory business statistics course. Proponents
of each program point to their program’s strengths: Minitab as a complete statistical solution;
Excel as a common desktop tool found in many business functional areas (and in many differ-
ent business school courses).

Although you are probably more familiar with Excel than with Minitab, both programs
share many similarities, starting with their shared use of worksheets (or spreadsheets) to store
data for analysis. Worksheets are tabular arrangements of data, in which the intersections of
rows and columns form cells, boxes into which you make entries. In Minitab, the data for each
variable are placed in separate columns, and this is also the standard practice when using
Excel. Generally, to perform a statistical analysis in either program, you select one or more
columns of data and then apply the appropriate command.

Both Excel and Minitab allow you to save worksheets, programming information, and
results as one file, called a workbook in Excel and a project in Minitab. In Excel, workbooks
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are collections of worksheets and chart sheets. You save a workbook when you save “an Excel
file” (as either an .xls or .xlsx file). In Minitab, a project includes data worksheets, all the
results shown in a session window, and all graphs created for the data. Unlike in Excel, in
Minitab you can save individual worksheets (as .mtw worksheet files) as well as save the en-
tire project (as an .mpj project file).

You can use either Excel or Minitab to learn and practice the statistical methods learned in
this book. The end of each chapter, except for the last chapter, presents guides that contain
detailed instructions for applying Microsoft Excel and Minitab to the statistical methods taught
in the chapter. These Excel and Minitab Guides use some of the downloadable files discussed
in Appendix C to illustrate the step-by-step process by which you apply a method. The Excel
Guides additionally offer a choice of techniques—all leading to the same results—that allow
you to use Excel either in a semi-automated way to get quick results or as a “sandbox” in
which you construct results from scratch or from model templates. This is further explained in
Section EG1.1 of the Chapter 1 Excel Guide.

1.6 How to Use This Book
This book organizes its material around the four important uses of statistics in business (see
Section 1.2). Chapters 2 and 3 present methods that summarize business data to address the
first use listed. Chapters 4 through 12 discuss methods that use sample data to draw conclu-
sions about populations (the second use). Chapters 13 though 16 review methods to make
reliable forecasts (the third use). Chapter 17 introduces methods that you can use to improve
business processes (the fourth use). In addition, Chapter 2 introduces a problem-solving
approach that will help you learn individual methods and help you apply your knowledge
beyond the statistics course. Chapter 18 further illustrates this approach and also summarizes
the methods discussed in earlier chapters.

As explained in Section 1.2, each chapter begins with a scenario that establishes a busi-
ness situation to which you can apply the methods of the chapter. At the end of each chapter,
you revisit the scenario to learn how the methods of the chapter could be applied in the sce-
nario. Following the revisited scenario, you will find such sections as Summary, Key Terms,
Key Equations, and Chapter Review Problems that help you review what you have learned.

Following this review material in most chapters, you will find a continuing case study that
allows you to apply statistics to problems faced by the management of Ashland MultiComm
Services, a residential telecommunications provider. Most chapters continue with a Digital
Case, in which you examine information in a variety of media forms and apply your statistical
knowledge to resolve problems or address issues and concerns of the case. Many of these cases
will help you think about what constitutes the proper or ethical use of statistics. (“Learning
with the Digital Cases” on page 15 introduces you to this unique set of business cases.) Finally,
at the very end of each chapter, except for the last chapter, are the Excel Guides and Minitab
Guides discussed in Section 1.5.

Don’t worry if your instructor does not cover every section of every chapter. Introductory
business statistics courses vary in their scope, length, and number of college credits. Your cho-
sen functional area of specialization (accounting, management, finance, marketing, etc.) may
also affect what you learn in class or what you are assigned or choose to read in this book.

Checklist for Getting Started
To make the best use of this book, you need to work with Excel or Minitab and download and
use files and other electronic resources that are available from the companion website (dis-
cussed fully in Appendix C). To minimize problems you may face later when using these re-
sources, review and complete the Table 1.5 checklist. When you have checked off all the tasks
necessary for your own work, you will be ready to begin reading the Chapter 1 Excel or Minitab
Guide and using the supplemental material in Appendices B, C, D, F and G, as necessary.

When you have completed the checklist, you are ready to begin using the Excel Guides
and Minitab Guides that appear at the end of chapters. These guides discuss how to apply
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T A B L E 1 . 5

Checklist for Getting
Started with Basic
Business Statistics

❑ Select which program, Excel or Minitab, you will use with this book. 
(Your instructor may have made this decision for you.)

❑ Read Appendix A if you need to learn or review basic math concepts and notation.
❑ Read Appendix B if you need to learn or review basic computing concepts and skills.
❑ Download the files and other electronic resources needed to work with this book. Read

Appendix C to learn more about the things you can download from the companion
website for this book. (This process requires Internet access.)

❑ Successfully install the chosen program and apply all available updates to the program.
Read Appendix Section D.1 to learn how to find and apply updates. (This process
requires Internet access.)

❑ If you plan to use PHStat2 with Excel, complete the special checklist in Appendix
Section D.2. If you plan to use the Analysis ToolPak with Excel, read and follow the
instructions in Appendix Section D.5.

❑ Skim Appendices F and G to be aware of how these appendices can help you as you use
this book with Excel or Minitab.

Excel and Minitab to the statistical methods discussed in the chapter. The Excel Guides and
Minitab Guides for this chapter (which begin on pages 17 and 22, respectively) review the ba-
sic operations of these programs and explain how Excel and Minitab handle the concept of
type of variable discussed in Section 1.4.

Instructions in the Excel Guides and Minitab Guides and related appendices use the
conventions for computer operations presented in Table 1.6. Read and review Appendix B if
some of the vocabulary used in the table is new to you.

T A B L E 1 . 6

Conventions for
Computing Operations

Operation Examples Interpretation

Keyboard
keys

Enter
Ctrl
Shift

Names of keys are always the object of the verb
press, as in “press Enter.”

Keystroke
combination

Crtl+C
Crtl+Shift+Enter

Some keyboarding actions require you to press
more than one key at the same time. Crtl+C means
press the C key while holding down the Ctrl key.
Crtl+Shift+Enter means press the Enter key while
holding down the Ctrl and Shift keys.

Click object Click OK.
Click All in the
Page Range
section.

A click object is a target of a mouse click. When click
objects are part of a window that contains more than
one part, the part name is also given, e.g., “in the
Page Range section.” Review Appendix Section B.2
to learn the verbs this book uses with click objects.

Menu or
ribbon
selection

File ➔ New
Layout ➔
Trendline ➔
Linear Trendline

A sequence of menu or ribbon selections is
represented by a list of choices separated by the ➔
symbol. File ➔ New means first select File and then,
from the list of choices that appears, select New.

Placeholder
object

Select
variablename

An italicized object means that the actual object
varies, depending on the context of the instruction.
“Select variablename” might, for one problem,
mean “select the Yearly Sales variable” and might
mean “select the Monthly Sales variable” for another.
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S U M M A R Y
Learning about statistics begins with learning the seven
terms that are the basic vocabulary of statistics. With
this vocabulary, you can begin to understand how statistics
helps you make better sense of the world. Businesses use
statistics to summarize and reach conclusions from data, to
make reliable forecasts, and to improve business processes.

You learned some of the basic vocabulary used in statistics
and the various types of data used in business. In the next
two chapters, you will study data collection and a variety of
tables and charts and descriptive measures that are used to
present and analyze data.

K E Y T E R M S
categorical variable 7
continuous variable 7
data 5
descriptive statistics 4
discrete variable 7
inferential statistics 4
interval scale 8

nominal scale 8
numerical variable 7
operational definition 6
ordinal scale 8
parameter 6
population 6
qualitative variable 7

quantitative variable 7
ratio scale 9
sample 6
statistic 6
statistical package 10
statistics 4
variable 5

In the Using Statistics scenario at the beginning of this chapter, you
were asked to help prepare documents to support the Good Tunes &
More expansion. The managers had decided to approach local banks
for funding the expansion of their company, and you needed to

determine what type of data to present and how to present those data. As a
first step, you decided to summarize the details of thousands of transac-
tions into useful information in the form of yearly dollar sales totals.

U S I N G S TAT I S T I C S @ Good Tunes & More Revisited

C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING
1.12 What is the difference between a sample and a
population?

1.13 What is the difference between a statistic and a
parameter?

1.14 What is the difference between descriptive statistics
and inferential statistics?

1.15 What is the difference between a categorical variable
and a numerical variable?

1.16 What is the difference between a discrete numerical
variable and a continuous numerical variable?

1.17 What is an operational definition, and why are opera-
tional definitions so important?

1.18 What are the four measurement scales?

APPLYING THE CONCEPTS
1.19 Visit the official website for either Excel or Minitab,
www.office.microsoft.com/excel or www.minitab.com/
products/minitab. Read about the program you chose and
then think about the ways the program could be useful in
statistical analysis.

1.20 In 2008, a university in the midwestern United States
surveyed its full-time first-year students after they completed
their first semester. Surveys were electronically distributed to
all 3,727 students, and responses were obtained from 2,821
students. Of the students surveyed, 90.1% indicated that they
had studied with other students, and 57.1% indicated that they
had tutored another student. The report also noted that 61.3%
of the students surveyed came to class late at least once, and
45.8% admitted to being bored in class at least once.
a. Describe the population of interest.
b. Describe the sample that was collected.

www.office.microsoft.com/excel
www.minitab.com/products/minitab
www.minitab.com/products/minitab
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c. Describe a parameter of interest.
d. Describe the statistic used to estimate the parameter in (c).

1.21 The Gallup organization releases the results of recent
polls at its website, www.gallup.com. Visit this site and
read an article of interest.
a. Describe the population of interest.
b. Describe the sample that was collected.
c. Describe a parameter of interest.
d. Describe the statistic used to describe the parameter in (c).

1.22 A Gallup poll indicated that 20% of Americans had con-
fidence in U.S. banks. Interestingly, 58% also said that they had
confidence in their main or primary bank. (data extracted from
D. Jacobs, “Americans’ Confidence in Banks Is at Historical
Low,” www.gallup.com, April 7, 2010). The results are based
on telephone interviews conducted March 24, 2010, with 1,006
adults living in the United States, aged 18 and older.
a. Describe the population of interest.
b. Describe the sample that was collected.
c. Is 20% a parameter or a statistic? Explain.
d. Is 58% a parameter or a statistic?

1.23 According to its home page, “Swivel is a website
where people share reports of charts and numbers. Busi-
nesses use swivel to dashboard their metrics. Students use
Swivel to find and share research data.” Visit www.swivel.
com and explore a data set of interest to you.
a. Describe a variable in the data set you selected.
b. Is the variable categorical or numerical?
c. If the variable is numerical, is it discrete or continuous?

1.24 Download and examine the U.S. Census Bureau’s
“2007 Survey of Business Owners and Self-Employed Per-
sons,” directly available at bhs.econ.census.gov/BHS/SBO/
sbo1_07.pdf or through the Get Help with Your Form link
at www.census.gov/econ/sbo.
a. Give an example of a categorical variable included in the

survey.
b. Give an example of a numerical variable included in the

survey.

1.25 Three professors at Northern Kentucky University
compared two different approaches to teaching courses in the
school of business (M. W. Ford, D. W. Kent, and S. Devoto,
“Learning from the Pros: Influence of Web-Based Expert
Commentary on Vicarious Learning About Financial Mar-
kets,” Decision Sciences Journal of Innovative Education,
January 2007, 5(1), 43–63). At the time of the study, there
were 2,100 students in the business school, and 96 students
were involved in the study. Demographic data collected on
these 96 students included class (freshman, sophomore, jun-
ior, senior), age, gender, and major.
a. Describe the population of interest.
b. Describe the sample that was collected.
c. Indicate whether each of the four demographic variables

mentioned is categorical or numerical.
d. For each of the four demographic variables mentioned,

indicate the measurement scale.

1.26 A manufacturer of cat food was planning to survey
households in the United States to determine purchasing
habits of cat owners. Among the variables to be collected
are the following:

i. The primary place of purchase for cat food
ii. Whether dry or moist cat food is purchased
iii.The number of cats living in the household
iv. Whether any cat living in the household is pedigreed

a. For each of the four items listed, indicate whether the
variable is categorical or numerical. If it is numerical, is
it discrete or continuous?

b. Develop five categorical questions for the survey.
c. Develop five numerical questions for the survey.

1.27 A sample of 62 undergraduate students answered the
following survey:
1. What is your gender? Female ______ Male ______
2. What is your age (as of last birthday)? ______
3. What is your current registered class designation?

Freshman ______ Sophomore ______ Junior ______
Senior ______

4. What is your major area of study?
Accounting ______
Computer Information Systems ______ Economics/
Finance ______
International Business ______ Management ______
Retailing/Marketing ______
Other ______ Undecided ______

5. At the present time, do you plan to attend graduate
school?
Yes ______ No ______ Not sure ______

6. What is your current cumulative grade point average?
______

7. What is your current employment status?
Full time ______ Part time ______ Unemployed ______

8. What would you expect your starting annual salary (in
$000) to be if you were to seek full-time employment im-
mediately after obtaining your bachelor’s degree? ______

9. For how many social networking sites are you
registered? ______

10. How satisfied are you with the food and dining services
on campus? ______

1 2 3 4 5 6 7
Extremely Neutral Extremely
unsatisfied satisfied

11. About how much money did you spend this semester
for textbooks and supplies? ______

12. What type of computer do you prefer to use for your
studies?
Desktop ______ Laptop ______
Tablet/notebook/netbook ______

13. How many text messages do you send in a typical
week? ______

14. How much wealth (income, savings, investment, real
estate, and other assets) would you have to accumulate

www.gallup.com
www.gallup.com
www.swivel.com
www.swivel.com
www.census.gov/econ/sbo
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(in millions of dollars) before you would say you are
rich? ______

a. Which variables in the survey are categorical?
b. Which variables in the survey are numerical?
c. Which variables are discrete numerical variables?

The results of the survey are stored in 

1.28 A sample of 44 graduate students answered the
following survey:
1. What is your gender? Female ______ Male ______
2. What is your age (as of last birthday)? ______
3. What is your current major area of study?

Accounting ______
Economics/Finance ______
Management ______
Retailing/Marketing ______
Other ______ Undecided ______

4. What is your current graduate cumulative grade point
average? ______

5. What was your undergraduate major?
Biological Sciences ______ Business ______
Computers ______
Engineering ______
Other ______

6. What was your undergraduate cumulative grade point
average? ______

7. What is your current employment status?
Full time ______ Part time ______ Unemployed ______

UndergradSurvey

E N D - O F - C H A P T E R C A S E S
At the end of most chapters, you will find a continuing case
study that allows you to apply statistics to problems faced
by the management of the Ashland MultiComm Services, a

residential telecommunications provider. You will also find
a series of Digital Cases that extend many of the Using Sta-
tistics scenarios that begin each chapter.

8. How many different full-time jobs have you held in the
past 10 years? ______

9. What do you expect your annual salary (in $000) to be
immediately after completion of your graduate studies
if you are employed full time? ______

10. About how much money did you spend this semester
for textbooks and supplies? ______

11. How satisfied are you with the MBA program advisory
services on campus?

1 2 3 4 5 6 7
Extremely Neutral Extremely
unsatisfied satisfied

12. What type of computer do you prefer to use for your
studies?
Desktop ______ Laptop ______ Tablet/notebook/
netbook ______

13. How many text messages do you send in a typical
week? ______

14. How much wealth (income, savings, investment, real
estate, and other assets) would you have to accumulate
(in millions of dollars) before you would say you are
rich? ______
a. Which variables in the survey are categorical?
b. Which variables in the survey are numerical?
c. Which variables are discrete numerical variables?

The results of the survey are stored in GradSurvey

L E A R N I N G W I T H T H E D I G I TA L C A S E S
People use statistical techniques to help communicate and
present important information to others both inside and out-
side their businesses. Every day, as in these examples, peo-
ple misuse these techniques. Identifying and preventing
misuses of statistics, whether intentional or not, is an impor-
tant responsibility for all managers. The Digital Cases help
you develop the skills necessary for this important task.

A Digital Case asks you to review electronic docu-
ments related to a company or statistical issue discussed in
the chapter’s Using Statistics scenario. You review the
contents of these documents, which may contain internal
confidential as well as publicly stated facts and claims,
seeking to identify and correct misuses of statistics. Unlike
a traditional case study, but like many business situations,
not all of the information you encounter will be relevant to
your task, and you may occasionally discover conflicting

information that you have to resolve in order to complete
the case.

To assist your learning, each Digital Case begins with a
learning objective and a summary of the problem or issue at
hand. Each case directs you to the information necessary to
reach your own conclusions and to answer the case ques-
tions. You can work with the documents for the Digital
Cases offline, after downloading them from the companion
website (see Appendix C). Or you can work with the Digital
Cases online, chapter-by-chapter, at the companion website.

DIGITAL CASE EXAMPLE
This section illustrates learning with a Digital Case. To be-
gin, open the Digital Case file GTM.pdf, which contains
contents from the Good Tunes & More website. Recall that
the privately held Good Tunes & More, the subject of the
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or something else. The use of the symbols creates the im-
pression that unit sales data are being presented. If the data
are unit sales, does such data best support the claim being
made, or would something else, such as dollar volumes, be
a better indicator of sales at the retailer?

Then there are those curious chart labels. “Latest twelve
months” is ambiguous; it could include months from the cur-
rent year as well as months from one year ago and therefore
may not be an equivalent time period to “two years ago.” But
the business was established in 1997, and the claim being
made is “best sales year ever,” so why hasn’t management in-
cluded sales figures for every year?

Are Good Tunes & More managers hiding something, or
are they just unaware of the proper use of statistics? Either
way, they have failed to properly communicate a vital aspect
of their story.

In subsequent Digital Cases, you will be asked to provide
this type of analysis, using the open-ended questions in the
case as your guide. Not all the cases are as straightforward as
this example, and some cases include perfectly appropriate
applications of statistics.

Using Statistics scenario in this chapter, is seeking financ-
ing to expand its business by opening retail locations. Be-
cause the managers are eager to show that Good Tunes &
More is a thriving business, it is not surprising to discover
the “our best sales year ever” claim in the “Good Times at
Good Tunes & More” section on the first page.

Click the our best sales year ever link to display the
page that supports this claim. How would you support such
a claim? With a table of numbers? A chart? Remarks attrib-
uted to a knowledgeable source? Good Tunes & More has
used a chart to present “two years ago” and “latest twelve
months” sales data by category. Are there any problems with
the choices made on this web page? Absolutely!

First, note that there are no scales for the symbols used,
so it is impossible to know what the actual sales volumes
are. In fact, as you will learn in Section 2.8, charts that
incorporate symbols in this way are considered examples of
chartjunk and would never be used by people seeking to
properly use graphs.

This important point aside, another question that arises
is whether the sales data represent the number of units sold
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C H A P T E R 1 E X C E L G U I D E

EG1.1 GETTING STARTED with EXCEL

You are almost ready to use Excel if you have completed the Table 1.5 checklist and reviewed the
Table 1.6 conventions for computing on page 12. Before going further, decide how you plan to
use Excel with this book. The Excel Guides include In-Depth Excel instructions that require no
additional software and PHStat2 instructions that use PHStat2, an add-in that simplifies using
Excel while creating results identical to those you would get using the Excel instructions. Table
EG1.1 lists the advantages and disadvantages of each type of instruction. Because of the equiva-
lency of these two types, you can switch between them at any time while using this book.

T A B L E E G 1 . 1

Types of Excel Guide
Instructions

In-Depth Excel Instructions

Provides step-by-step instructions for applying Excel to the statistical methods of the
chapter.
Advantages Applicable to all Excel versions. Creates “live” worksheets and chart sheets
that automatically update when the underlying data change.
Disadvantages Can be time-consuming, frustrating, and error prone, especially for
novices. May force you to focus on low-level Excel details, thereby distracting you from
learning statistics.

PHStat2 Instructions

Provides step-by-step instructions for using the PHStat2 add-in with Excel. (To learn more
about PHStat2, see Appendix G.)
Advantages Creates live worksheets and chart sheets that are the same as or similar to the
ones created in the In-Depth Excel instructions. Frees you from having to focus on low-
level Excel details. Can be used to quickly double-check results created by the In-Depth
Excel instructions.
Disadvantages Must be installed separately and therefore requires an awareness about
installing software on your system. (See Appendix D for the technical details.) Not
compatible with OpenOffice.org Calc 3.

If you want to develop a mastery of Excel and gain practice building solutions from the
bottom up, you will want to use the In-Depth Excel instructions. If you are more of a top-down
person, who first wants quick results and then, later, looks at the details of a solution, you will
want to maximize your use of the PHStat2 instructions. At any time, you can switch between
these methods without any loss of comprehension. Both methods lead to identical, or nearly
identical, results. These results are mostly in the form of reusable workbooks. These work-
books, as well as the workbooks you can download (see Appendix C) are yours to keep and
reuse for other problems, in other courses, or in your workplace.

When relevant, the Excel Guides also include instructions for the Analysis ToolPak, an op-
tional component of Excel that Microsoft distributes with many versions of Excel, although
not with the current version of Mac Excel. 

The Excel Guide instructions feature Windows Excel versions 2010 and 2007 and note
their differences, when those differences are significant. The instructions have been written for
maximum compatibility with current versions of Mac Excel and OpenOffice.org Calc, an
Excel work-alike. If you use either Mac Excel or OpenOffice.org Calc, you will be able to use
almost all the workbooks discussed in the In-Depth Excel instructions. If you use the older
Windows-based Excel 2003, you can use the PHStat2 instructions as is and can download from
this book's companion website the Using Excel 2003 with Basic Business Statistics document
that adapts the In-Depth Excel instructions for use with Excel 2003.

The rest of this Excel Guide
reviews the basic concepts
and common operations
encountered when using
Excel with this book.
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EG1.2 ENTERING DATA and VARIABLE TYPE

As first discussed in Section 1.5, you enter the data for each variable in a separate column.
By convention, you start with column A and enter the name of each variable into the cells of the
first row, and then you enter the data for the variable in the subsequent rows, as shown in
Figure EG1.1.

Excel infers the variable type from the data you enter into a column. If Excel discovers a col-
umn containing numbers, for example, it treats the column as a numerical variable. If Excel dis-
covers a column containing words or alphanumeric entries, it treats the column as a
non-numerical (categorical) variable. This imperfect method works most of the time in Excel, es-
pecially if you make sure that the categories for your categorical variables are words or phrases
such as “yes” and “no” and are not coded values that could be mistaken for numerical values,
such as “1,” “2,” and “3.” However, because you cannot explicitly define the variable type, Excel
occasionally makes “mistakes” by either offering or allowing you to do nonsensical things such
as using a statistical method that is designed for numerical variables on categorical variables.

When you enter data, never skip any rows in a column, and as a general rule, also avoid
skipping any columns. Pay attention to any special instructions that occur throughout the book
for the order of the entry of your data. For some statistical methods, entering your data in an
order that Excel does not expect will lead to incorrect results.

Most of the Excel workbooks that you can download from this book’s companion website
(Appendix C) and use with the Excel Guides contain a DATA worksheet that follows the rules
of this section. Any of those worksheets can be used as additional models for the method you
use to enter variable data in Excel.

EG1.3 OPENING and SAVING WORKBOOKS

You open and save workbooks by first selecting the folder that stores the workbook and then
specifying the file name of the workbook. In Excel 2010, you select File ➔ Open to open a
workbook file or File ➔ Save As to save a workbook. In Excel 2007, you select Office
Button ➔ Open to open a workbook file or Office Button ➔ Save As to save a workbook.
Open and Save As display nearly identical dialog boxes that vary only slightly among the dif-
ferent Excel versions. Figure EG1.2 shows the Excel 2010 Open and Save As dialog boxes.
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You select the storage folder by using the drop-down list at the top of either of these dialog
boxes. You enter, or select from the list box, a file name for the workbook in the File name box.
You click Open or Save to complete the task. Sometimes when saving files, you may want to
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change the file type before you click Save. If you want to save your workbook in the format
used by Excel 2003 and earlier versions, select Excel 97-2003 Workbook (*.xls) from the Save
as type drop-down list (shown in Figure EG1.2) before you click Save. If you want to save data
in a form that can be opened by programs that cannot open Excel workbooks, you might select
either Text (Tab delimited) (*.txt) or CSV (Comma delimited) (*.csv) as the save type.

When you want to open a file and cannot find its name in the list box, double-check that
the current Look in folder is the folder you intend. If it is, change the file type to All Files
(*.*) to see all files in the current folder. This technique can help you discover inadvertent mis-
spellings or missing file extensions that otherwise prevent the file from being displayed.

Although all versions of Microsoft Excel include a Save command, you should avoid this
choice until you gain experience. Using Save makes it too easy to inadvertently overwrite your
work. Also, you cannot use the Save command for any open workbook that Excel has marked
as read-only. (Use Save As to save such workbooks.)

EG1.4 CREATING and COPYING WORKSHEETS

You create new worksheets by either creating a new workbook or by inserting a new worksheet
in an open workbook. To create a new workbook, select File ➔ New (Excel 2010) or Office
Button ➔ New (Excel 2007) and in the pane that appears, double-click the Blank workbook icon.

New workbooks are created with a fixed number of worksheets. To delete extra worksheets
or insert more sheets, right-click a sheet tab and click either Delete or Insert (see Figure EG1.3).
By default, Excel names a worksheet serially in the form Sheet1, Sheet2, and so on. You should
change these names to better reflect the content of your worksheets. To rename a worksheet,
double-click the sheet tab of the worksheet, type the new name, and press Enter.

You can also make a copy of a worksheet or move a worksheet to another position in the
same workbook or to a second workbook. Right-click the sheet tab and select Move or Copy
from the shortcut menu that appears. In the To book drop-down list of the Move or Copy dia-
log box (see Figure EG1.3), first select (new book) (or the name of the pre-existing target
workbook), check Create a copy, and then click OK.

EG1.5 PRINTING WORKSHEETS

To print a worksheet (or a chart sheet), first open to the worksheet by clicking its sheet tab.
Then, in Excel 2010, select File ➔ Print. If the print preview displayed (see Figure EG1.4)
contains errors or displays the worksheet in an undesirable manner, click File, make the neces-
sary corrections or adjustments, and repeat File ➔ Print. When you are satisfied with the pre-
view, click the large Print button.
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In Excel 2007, the same process requires more mouse clicks. First click Office Button
and then move the mouse pointer over (but do not click) Print. In the Preview and Print
gallery, click Print Preview. If the preview displayed (see Figure EG1.4) contains errors or
displays the worksheet in an undesirable manner, click Close Print Preview, make the neces-
sary changes, and reselect the print preview. After completing all corrections and adjustments,
click Print in the Print Preview window to display the Print dialog box (shown in Appendix
Section B.3). Select the printer to be used from the Name drop-down list, click All and Active
sheet(s), adjust the Number of copies, and click OK.

If necessary, you can adjust print formatting while in print preview by clicking the Page
Setup icon (Excel 2007) or the Page Setup link (Excel 2010) to display the Page Setup dialog
box (the right panel of Figure EG1.4). For example, to print your worksheet with gridlines and
numbered row and lettered column headings (similar to the appearance of the worksheet on-
screen), click the Sheet tab in the Page Setup dialog box, check Gridlines and Row and col-
umn headings, and click OK.

Although every version of Excel offers the (print) Entire workbook choice, you get the
best results if you print each worksheet separately when you need to print out more than one
worksheet (or chart sheet).

EG1.6 WORKSHEET ENTRIES 
and REFERENCES

When you open to a specific worksheet in a workbook, you
use the cursor keys or your pointing device to move a cell
pointer through the worksheet to select a specific cell for
entry. As you type an entry, it appears in the formula bar,
and you place that entry in the cell by either pressing the
Tab key or Enter key or clicking the checkmark button in
the formula bar.

In worksheets that you use for intermediate calculations
or results, you might enter formulas, instructions to per-
form a calculation or some other task, in addition to the nu-
meric and text entries you otherwise make in cells.

Formulas typically use values found in other cells to com-
pute a result that is displayed in the cell that stores the for-
mula. With formulas, the displayed result automatically
changes as the dependent values in the other cells change.
This process, called recalculation, was the original novel
feature of spreadsheet programs and led to these programs
being widely used in accounting. (Worksheets that contain
formulas are sometimes called “live” worksheets to distin-
guish them from “dead” worksheets—worksheets without
any formulas and therefore not capable of recalculation.)

To refer to a cell in a formula, you use a cell address in
the form SheetName!ColumnRow. For example, Data!A2
refers to the cell in the Data worksheet that is in column A

F I G U R E E G 1 . 4
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and row 2. You can also use just the ColumnRow portion of
a full address, for example, A2, if you are referring to a cell
on the same worksheet as the one into which you are enter-
ing a formula. If the sheet name contains spaces or special
characters, for example, CITY DATA or Figure_1.2, you
must enclose the sheet name in a pair of single quotes, as in
'CITY DATA'!A2 or 'Figure_1.2'!A2.

When you want to refer to a group of cells, such as the
cells of a column that store the data for a particular variable,
you use a cell range. A cell range names the upper-leftmost
cell and the lower-rightmost cell of the group using the form
SheetName!UpperLeftCell:LowerRightCell. For example,
the cell range DATA!A1:A11 identifies the first 11 cells in
the first column of the DATA worksheet. Cell ranges can
extend over multiple columns; the cell range
DATA!A1:D11 would refer to the first 11 cells in the first 4
columns of the worksheet.

As with a single cell reference, you can skip the
SheetName! part of the reference if you are referring to a cell
range on the current worksheet and you must use a pair of
single quotes if a sheet name contains spaces or special char-
acters. However, in some dialog boxes, you must include the
sheet name in a cell reference in order to get the proper re-
sults. (In such cases, the instructions in this book include the
sheet name; otherwise, they do not.)

Although not used in this book, cell references can
include a workbook name in the form '[WorkbookName]
SheetName'! ColumnRow or '[WorkbookName] SheetName'!
UpperLeft Cell: LowerRightCell. You might discover such
references if you inadvertently copy certain types of work-
sheets or chart sheets from one workbook to another.

EG1.7 ABSOLUTE and RELATIVE
CELL REFERENCES

Many worksheets contain columns (or rows) of similar-
looking formulas. For example, column C in a worksheet
might contain formulas that sum the contents of the column A
and column B rows. The formula for cell C2 would be =A2 +
B2, the formula for cell C3 would be =A3 + B3, for cell C4,
=A4 + B4, and so on down column C. To avoid the drudg-
ery of typing many similar formulas, you can copy a for-
mula and paste it into all the cells in a selected cell range.
For example, to copy a formula that has been entered in cell
C2 down the column through row 12:

1. Right-click cell C2 and click Copy from the shortcut
menu. A movie marquee–like highlight appears around
cell C2.

2. Select the cell range C3:C12. (See Appendix B if you
need help selecting a cell range.)

3. With the cell range highlighted, right-click over the cell
range and click Paste from the shortcut menu.

When you perform this copy-and-paste operation,
Excel adjusts the cell references in formulas so that copying

the formula =A2 + B2 from cell C2 to cell C3 results in the
formula =A3 + B3 being pasted into cell C3, the formula
=A4 + B4 being pasted into cell C4, and so on.

There are circumstances in which you do not want Excel
to adjust all or part of a formula. For example, if you were
copying the cell C2 formula =(A2 + B2)/B15, and cell B15
contained the divisor to be used in all formulas, you would not
want to see pasted into cell C3 the formula =(A3 + B3)/B16.
To prevent Excel from adjusting a cell reference, you use an
absolute cell reference by inserting dollar signs ($) before the
column and row references. For example, the absolute cell ref-
erence $B$15 in the copied cell C2 formula =(A2 +
B2)/$B$15 would cause Excel to paste =(A3 + B3)/$B$15
into cell C3. (For ease of reading, formulas shown in the
worksheet illustrations in this book generally do not include
absolute cell references.)

Do not confuse the use of the U.S. dollar symbol in an
absolute reference with the formatting operation that dis-
plays numbers as U.S. currency values.

EG1.8 ENTERING FORMULAS 
into WORKSHEETS

You enter formulas by typing the equal sign (=) followed by
a combination of mathematical and data-processing opera-
tions. For simple formulas, you use the symbols +, -, *, /,
and ^ for the operations addition, subtraction, multiplica-
tion, division, and exponentiation (a number raised to a
power), respectively. For example, the formula =DATA!B2
+ DATA!B3 + DATA!B4 adds the contents of cells B2, B3,
and B4 of the DATA worksheet and displays the sum as the
value in the cell containing the formula.

You can also use worksheet functions in formulas to
simplify formulas. To use a worksheet function in a formula,
either type the function as shown in the instructions in this
book or use the Excel Function Wizard feature to insert the
function. To use this feature, select Formulas ➔ Insert
Function and then make the necessary entries and selec-
tions in one or more dialog boxes that follow.

If you enter formulas in your worksheets, you should re-
view and verify those formulas before you use their results.
To view the formulas in a worksheet, press Ctrl+` (grave ac-
cent). To restore the original view, the re´sults of the formu-
las, press Ctrl+` a second time. (A “formulas view”
accompanies most of the worksheet illustrations in this book.)

EG1.9 USING APPENDICES D and F

Appendices D and F contain additional Excel-related material
that you may need to know, depending on how you use this
book. If you plan to use PHStat2, make sure you have read Sec-
tions D.1 through D.3 in Appendix D. If you would like to learn
formatting worksheet details such as how to make the contents
of cells appear boldfaced or how to control the number of deci-
mal places displayed, read Sections F.1 and F.2 in Appendix F.



MG1.1 GETTING STARTED with MINITAB

You are almost ready to use Minitab if you have completed the Table 1.5 checklist and re-
viewed the Table 1.6 computing conventions on page 12. Before using Minitab for a specific
analysis, you should practice using the Minitab user interface.

Minitab project components appear in separate windows inside the Minitab window. In
Figure MG1.1 these separate windows have been overlapped, but you can arrange or hide these
windows in any way you like. When you start Minitab, you typically see a new project that
contains only the session area and one worksheet window. (You can view other components by
selecting them in the Minitab Window menu.) You can open and save an entire project or, as is
done in this book, open and save individual worksheets.

C H A P T E R 1 M I N I TA B G U I D E

MG1.2 ENTERING DATA and VARIABLE TYPE

As first discussed in Section 1.5, you enter the data for each variable in a separate column. By
convention, you start with the first column, initially labeled C1 by Minitab, and enter the name
of each variable into the cells of the unnumbered, shaded first row and then the data for the
variable into the numbered rows, as shown in Figure MG1.1.

Minitab infers the variable type from the data you enter in a column. If Minitab discovers
a column containing numbers, it treats the column as a numerical variable. If Minitab discov-
ers a column containing words or alphanumeric entries, it treats the column as “text” variable
(appropriate for use as a categorical variable). If Minitab discovers a column containing en-
tries that can be interpreted as dates or times, it treats the column as a date/time variable, a spe-
cial type of numerical variable. This imperfect method works most of the time in Minitab,
especially if you make sure that the categories for your categorical variables are words or
phrases such as “yes” and “no.”

When Minitab identifies a text or date/time variable, it appends a “-T” or “-D” to its col-
umn heading for the variable. For example, in Figure MG1.1 above:

• C1-T and C5-T mean that the first and fifth columns contain text variables.
• C2-D and C3-D mean that the second and third columns contain date/time variables.
• C4 and C6 mean that the fourth and sixth columns contain numerical variables.
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Because Minitab explicitly defines the variable type, unlike in Excel, your ability to do
nonsensical things (such as use a statistical method that is designed for numerical variables on
categorical data) is limited. If Minitab misinterprets your data, you can attempt to change the
variable type by selecting Data ➔ Change Data Type and then selecting the appropriate
change from the submenu.

When you enter data, never skip any rows in a column. Minitab interprets skipped rows as
missing values. You can use the Minitab workbooks that you can download from this book’s
companion website (see Appendix C) as models for the method you use to enter variable data
in Minitab.

MG1.3 OPENING and SAVING WORKSHEETS and PROJECTS

You open and save Minitab worksheet or project files by first selecting the folder that stores a
workbook and then specifying the file name of the workbook. To open a worksheet, you select
File ➔ Open Worksheet. To open a project, you select File ➔ Open Project. To save a work-
sheet, you select File ➔ Save Current Worksheet As. To save a project, you select File ➔
Save Project As.

Both pairs of open and save commands display nearly identical dialog boxes.
Figure MG1.2 shows the Minitab 16 Open Worksheet and Save Current Worksheet As
dialog boxes.

Inside the open or save dialog boxes, you select the storage folder by using the drop-down
list at the top of either dialog box. You enter or select from the list box a file name for the
workbook in the File name box. You click Open or Save to complete the task. Sometimes
when saving files, you might want to change the file type before you click Save. If you want
to save your data as an Excel worksheet, select Excel 97-2003 from the Save as type drop-
down list before you click Save. If you want to save data in a form that can be opened by pro-
grams that cannot open Excel workbooks, you might select one of the Text or CSV choices
as the Save as type type.

When you want to open a file and cannot find its name in the list box, double-check that
the current Look in folder is the folder you intend. If it is, change the file type to All (*.*) to
see all files in the current folder. This technique can help you discover inadvertent misspellings
or missing file extensions that otherwise prevent the file from being displayed.

When you save a project, you can click Options in the Save Project As dialog box and then
specify which parts of the project you want to save in a Save Project - Options dialog box (not
shown).
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MG1.4 CREATING and COPYING
WORKSHEETS

You create new worksheets by either creating a new proj-
ect or by inserting a new worksheet in an open project.
To create a new project, select File ➔ New and in the
New dialog box, click Minitab Project and then click
OK. To insert a new worksheet, also select File ➔ New
but in the New dialog box click Minitab Worksheet and
then click OK.

A new project is created with one new worksheet. To in-
sert another worksheet, select File ➔ New and in the New
dialog box click Minitab Worksheet and then click OK.
You can also insert a copy of a worksheet from another proj-
ect into the current project. Select File ➔ Open Worksheet
and select the project that contains the worksheet to be
copied. Selecting a project (and not a worksheet) causes an
additional dialog box to be displayed, in which you can
specify which worksheets of that second project are to be
copied and inserted into the current project.

By default, Minitab names a worksheet serially in the
form Worksheet1, Worksheet2, and so on. You should
change these names to better reflect the content of your
worksheets. To rename a worksheet, open the Project Man-
ager window (see Figure MG1.1), right-click the worksheet
name in the left pane, select Rename from the shortcut
menu, type in the new name, and press Enter. You can also
use the Save Current Worksheet As command discussed in
Section MG1.3, although this command also saves the
worksheet as a separate file.

MG1.5 PRINTING PARTS of a PROJECT

To print a worksheet, a graph, or the contents of a session,
first select the window that corresponds to the object you
want to print. Then select File ➔ Print object, where object

is either Worksheet, Graph, or Session Window, depend-
ing on which object you first selected.

If you are printing a graph or a session window, select-
ing the Print command displays the Print dialog box. The
Print dialog box contains settings to select the printer to be
used, what pages to print, and the number of copies to
produce. If you need to change these settings, change them
before clicking OK to create your printout.

If you are printing a worksheet, selecting Print
Worksheet displays the Data Window Print Options dialog
box (see Figure MG1.3). In this dialog box, you specify the
formatting options for your printout (the default selections
should be fine), enter a Title, and click OK. Minitab then
presents the Print dialog box discussed in the previous
paragraph.

Although Minitab includes Save Current Worksheet and a Save Project commands
(commands without the “As”), you should avoid this choice until you gain experience. Using
Save makes it too easy to inadvertently overwrite your work. Also, you cannot use the Save
command for any open workbook that Minitab has marked as read-only. (Use Save As to save
such workbooks.)

Individual graphs and a project’s session window can also be opened and saved separately
in Minitab, although these operations are never used in this book.

If you need to change the paper size or paper orientation
of your printout, select File ➔ Print Setup before you
select the Print command, make the appropriate selections
in the dialog box that appears, and click OK.

MG1.6 WORKSHEET ENTRIES 
and REFERENCES

You refer to individual variables in one of two ways. You can
use their column number, such as C1 in Figure MG1.1 on
page 22, that appears at the top of a worksheet. Or you can
use the variable name that you entered into the cells of the
unnumbered, shaded second row, such as Center or Order
(in Figure MG1.1). For most statistical analyses, Minitab

F I G U R E M G 1 . 3
Data Window Print Options dialog box



Chapter 1 Minitab Guide 25

presents a list of column numbers and their corresponding
variable names (if any) from which you make selections. For
a variable name such as Return 2009, that contain spaces or
other special characters, Minitab displays the name using a
pair of single quotation marks—for example, 'Return
2009'—an’d you need to include those quotation marks any
time you type such a variable name in a Minitab dialog box.

For clarity and to minimize errors, this book generally
refers to columns by their variable names. In later chapters,
you will see that Minitab allows you to refer to several

consecutive columns by using a hyphen. For example, either
C1-C6 or Center-Distance would refer to all six columns
of the Shipping data worksheet shown in Figure MG1.1.

MG1.7 USING APPENDICES D and F

Appendices D and F contain additional Minitab-related ma-
terial of a general nature. Consult these appendices if you
have a question about using Minitab that is not answered in
the Minitab Guides of this book.
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T he Choice Is Yours investment service helps clients with their investment choices.
Choice Is Yours evaluates investments as diverse as real estate, direct private equity
investments, derivatives, and various specialized types of mutual funds. You’ve
been hired to assist clients who seek to invest in mutual funds, which pool the
money of many individual clients and invest the money in a mix of securities and

other investments. (To learn more about mutual funds, visit investopedia.com/university/mutualfunds.)
Because mutual funds that are highly invested in common stocks have had mixed returns recently,

Choice Is Yours wants to examine mutual funds that focus on investing in certain types of bonds.
Company analysts have selected a sample of 184 such funds that they believe might interest clients.

You have been asked to present data about these funds in a way that will help customers make good
investment choices. What facts about each bond mutual fund would you collect to help customers

compare and contrast the many funds?
A good starting point would be to collect data that would help customers classify mutual

funds into various categories. You could research such things as the amount of risk involved in
a fund’s investment strategy and the type of bonds in which the mutual fund primarily invests.

Of course, you would want to learn how well the fund performed in the past, and you
would want to supply the customer with several measures of each fund’s past per-

formance. (Although past performance is no assurance of future
performance, past data could give customers insight into how

well each mutual fund has been managed.)
As you further think about your task, you realize that the

data for all 184 mutual funds would be a lot for anyone to
review. You have been asked to present data about these funds
in a way that will help customers make good investment
choices. How can you review and explore such data in a compre-
hensible manner? What facts about each fund would you collect
to help customers compare and contrast the many funds?
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2.1 Data Collection
Once you have defined your variables, you may need to collect the data for those variables.
Examples of data collection include the following:

• A marketing analyst who needs to assess the effectiveness of a new television advertisement
• A pharmaceutical manufacturer that needs to determine whether a new drug is more

effective than those currently in use
• An operations manager who wants to improve a manufacturing or service process
• An auditor who wants to review the financial transactions of a company in order to

determine whether the company is in compliance with generally accepted accounting
principles

When you collect data, you use either a primary data source or a secondary data
source. You are using a primary data source when you collect your own data for analysis, and
you are using a secondary source if the data for your analysis have been collected by someone
else. Data collection almost always involves collecting data from a sample because collecting
data from every item or individual in a population is typically too difficult or too time-
consuming. (See Chapter 7 to learn more about sample selection methods.)

Organizations and individuals that collect and publish data often use their data as a
primary source and may let others use those data as a secondary source. For example, the U.S.
federal government collects and distributes data in this way for both public and private
purposes. The Bureau of Labor Statistics collects data on employment and also distributes the
monthly consumer price index. The Census Bureau oversees a variety of ongoing surveys
regarding population, housing, and manufacturing and undertakes special studies on topics
such as crime, travel, and health care.

Data sources are created in one of four ways:

• As data distributed by an organization or individual
• As outcomes of a designed experiment

T he challenge you face in Part I of the Choice Is Yours scenario is to examine a large
amount of data and reach conclusions based on those data. You can make this busi-
ness task more manageable by breaking it into these five steps:

• Define the variables that you want to study in order to solve a business problem or meet
a business objective

• Collect the data from appropriate sources
• Organize the data collected by developing tables
• Visualize the data by developing charts
• Analyze the data by examining the appropriate tables and charts (and in later chapters by

using other statistical methods) to reach conclusions.

These five steps, known by the acronym DCOVA (for Define, Collect, Organize, Visualize,
and Analyze), are used throughout this book as the basis for statistical problem solving (see
Reference 2). In Chapter 1, you already learned that defining a variable includes developing an
operational definition and identifying the type of variable. In this chapter, you will learn more
about the steps involved in collecting, organizing, visualizing, and analyzing the data.

To help illustrate the DCOVA approach, this chapter frequently uses for its examples the
sample of 184 mutual funds that specialize in bond investments mentioned in Part I of the
Choice Is Yours scenario. (To examine this sample, open , one of the data files you
can download for use with this book as explained in Appendix C.) By the end of the chapter,
you will be able to answer the questions posed in the scenario. For example, you will be able
to answer questions that compare two categories of bond funds, such as “Is there a difference
in the returns of intermediate government bond funds and short-term corporate bond funds?”
or “Do intermediate government bond funds tend to be less risky investments than short-term
corporate bond funds?”

Bond Funds
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• As responses from a survey
• As a result of conducting an observational study

Market research companies and trade associations distribute data pertaining to specific in-
dustries or markets. Investment services such as Mergent (www.mergent.com) provide
financial data on a company-by-company basis. Syndicated services such as Nielsen provide
clients with data that enables client products to be compared with those of their competitors.
On the other hand, daily newspapers are secondary sources that are filled with numerical
information regarding stock prices, weather conditions, and sports statistics obtained from pri-
mary sources.

Conducting a designed experiment is another source of data. For example, one such
experiment might test several laundry detergents to compare how well each detergent
removes a certain type of stain. Developing proper experimental designs is a subject mostly
beyond the scope of this book because such designs often involve sophisticated statistical
procedures. However, some of the fundamental experimental design concepts are discussed
in Chapters 10 and 11.

Conducting a survey is a third type of data source. People being surveyed are asked ques-
tions about their beliefs, attitudes, behaviors, and other characteristics. For example, people
could be asked their opinion about which laundry detergent best removes a certain type of
stain. (This could lead to a result different from a designed experiment seeking the same
answer.) One good way to avoid data-collection flaws when using such a survey is to distribute
the questionnaire to a random sample of respondents. (Chapter 7 explains how to collect a
random sample.) A bad way would be to rely on a business-rating website that allows online
visitors to rate a merchant. Such websites cannot provide assurance that those who do the rat-
ings are representative of the population of customers—or that they even are customers.

Conducting an observational study is the fourth data source. A researcher collects data by
directly observing a behavior, usually in a natural or neutral setting. Observational studies are
a common tool for data collection in business. For example, market researchers use focus
groups to elicit unstructured responses to open-ended questions posed by a moderator to a tar-
get audience. You can also use observational study techniques to enhance teamwork or improve
the quality of products and services.

Problems for Section 2.1
APPLYING THE CONCEPTS
2.1. According to its home page, “Swivel is a website where
people share reports of charts and numbers. Businesses use
Swivel to dashboard their metrics. Students use Swivel to
find and share research data.” Visit www.swivel.com and ex-
plore a data set of interest to you. Which of the four sources
of data best describes the sources of the data set you selected?

2.2. Visit the website of the Gallup organization, at www.
gallup.com. Read today’s top story. What type of data
source is the top story based on?

2.3. A supermarket chain wants to determine the best
placement for the supermarket brand of soft drink. What
type of data collection source do you think that the super-
market chain should use?

2.4. Visit the “Longitudinal Employer-Household Dynam-
ics” page of the U.S. Census Bureau website, lehd.did.
census.gov/led/. Examine the “Did You Know” panel on the
page. What type of data source is the information presented
here based on?

ORGANIZING DATA
After you define your variables and collect your data, you organize your data to help pre-
pare for the later steps of visualizing and analyzing your data. The techniques you use to
organize your data depend on the type of variable (categorical or numerical) associated
with your data.

www.mergent.com
www.swivel.com
www.gallup.com
www.gallup.com
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T A B L E 2 . 1

Types of Bill Payment

Form of Payment Percentage (%)

Cash 15
Check 54
Electronic/online 28
Other/don’t know 3

Source: Data extracted from “How Adults Pay
Monthly Bills,” USA Today, October 4, 2007, p. 1.

2.2 Organizing Categorical Data
You organize categorical data by tallying responses by categories and placing the results in
tables. Typically, you construct a summary table to organize the data for a single categorical
variable and you construct a contingency table to organize the data from two or more categori-
cal variables.

The Summary Table
A summary table presents tallied responses as frequencies or percentages for each category.
A summary table helps you see the differences among the categories by displaying the fre-
quency, amount, or percentage of items in a set of categories in a separate column. Table 2.1
shows a summary table (stored in ) that tallies the responses to a recent survey
that asked adults how they pay their monthly bills.

Bill Payment

T A B L E 2 . 2

Frequency and
Percentage Summary
Table Pertaining to Risk
Level for 184 Bond
Funds

Fund Risk Level Number of Funds Percentage of Funds (%)

Below average 56 30.43%
Average 69 37.50%
Above average 59 32.07%
Total 184 100.00%

From Table 2.1, you can conclude that more than half the people pay by check and 82%
pay by either check or by electronic/online forms of payment.

EXAMPLE 2.1
Summary Table
of Levels of Risk 
of Bond Funds

The 184 bond funds involved in Part I of the Choice Is Yours scenario (see page 27) are classi-
fied according to their risk level, categorized as below average, average, and above average.
Construct a summary table of the bond funds, categorized by risk.

SOLUTION From Table 2.2, you can see that about the same number of funds are below
average, average, and above average in risk. This means that 69.57% of the bond funds are
classified as having an average or above average level of risk.

Starting with this section, the
sections of the Excel and
Minitab Guides duplicate the
sections in the main chapter.
For example, to learn how
to use Excel or Minitab to
organize categorical data, see
either Section EG2.2 or
MG2.2.

The Contingency Table
A contingency table allows you to study patterns that may exist between the responses of two
or more categorical variables. This type of table cross-tabulates, or tallies jointly, the responses
of the categorical variables. In the simplest case of two categorical variables, the joint
responses appear in a table such that the category tallies of one variable are located in the rows
and the category tallies of the other variable are located in the columns. Intersections of the
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rows and columns are called cells, and each cell contains a value associated with a unique pair
of responses for the two variables (e.g., Fee: Yes and Type: Intermediate Government in
Table 2.3). Cells can contain the frequency, the percentage of the overall total, the percentage
of the row total, or the percentage of the column total, depending on the type of contingency
table being used.

In Part I of the Choice Is Yours scenario, you could create a contingency table to examine
whether there is any pattern between the type of bond fund (intermediate government or short-
term corporate) and whether the fund charges a fee (yes or no). You would begin by tallying
the joint responses for each of the mutual funds in the sample of 184 bond mutual funds
(stored in ). You tally a response into one of the four possible cells in the table,
depending on the type of bond fund and whether the fund charges a fee. For example, the first
fund listed in the sample is classified as an intermediate government fund that does not charge
a fee. Therefore, you tally this joint response into the cell that is the intersection of the Inter-
mediate Government row and the No column. Table 2.3 shows the completed contingency
table after all 184 bond funds have been tallied.

Bond Funds

To look for other patterns between the type of bond fund and whether the fund charges a
fee, you can construct contingency tables that show cell values as a percentage of the overall
total (the 184 mutual funds), the row totals (the 87 intermediate government funds and the
97 short-term corporate bond funds), and the column totals (the 54 funds that charge a fee
and the 130 funds that do not charge a fee). Tables 2.4, 2.5, and 2.6 present these contin-
gency tables.

Table 2.4 shows that 47.28% of the bond funds sampled are intermediate
government funds, 52.72% are short-term corporate bond funds, and 18.48% are intermediate

T A B L E 2 . 3

Contingency Table
Displaying Type of Fund
and Whether a Fee Is
Charged

FEE

TYPE Yes No Total

Intermediate government 34 53 87
Short-term corporate 20 77 97
Total 54 130 184

T A B L E 2 . 4

Contingency Table
Displaying Type of Fund
and Whether a Fee Is
Charged, Based on
Percentage of Overall
Total

FEE

TYPE Yes No Total

Intermediate government 18.48 28.80 47.28
Short-term corporate 10.87 41.85 52.72

Total 29.35 70.65 100.00

T A B L E 2 . 5

Contingency Table
Displaying Type of Fund
and Whether a Fee Is
Charged, Based on
Percentage of Row Total

FEE

TYPE Yes No Total

Intermediate government 39.08 60.92 100.00
Short-term corporate 20.62 79.38 100.00
Total 29.35 70.65 100.00

government funds that charge a fee. Table 2.5 shows that 39.08% of the intermediate gov-
ernment funds charge a fee, while 20.62% of the short-term corporate bond funds charge
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Category Frequency

A 13
B 28
C 9

Category Frequency

Flammables/irritants 8,350
Knives and blades 4,134
Prohibited tools 753
Sharp objects 497
Other 357

Source
of Electricity

Net Electricity Generation
(millions of megawatt-hours)

Coal 1,994.4
Hydroelectric 248.1
Natural gas 876.9
Nuclear 806.2
Other 184.7

Source: Energy Information Administration, 2008.

Problems for Section 2.2
LEARNING THE BASICS

2.5 A categorical variable has three categories, with the
following frequencies of occurrence:

2.6 The following data represent the responses to two
questions asked in a survey of 40 college students majoring
in business: What is your gender? (M = male; F = female)
and What is your major? (A = Accounting; C = Computer
Information Systems; M = Marketing):
a. Tally the data into a contingency table where the two

rows represent the gender categories and the three
columns represent the academic major categories.

b. Construct contingency tables based on percentages of all
40 student responses, based on row percentages and
based on column percentages.

a. Compute the percentage of values in each category.
b. What conclusions can you reach concerning the categories?

a fee. Table 2.6 shows that of the funds that charge a fee, 62.96% are intermediate govern-
ment funds. From the tables, you see that intermediate government funds are much more
likely to charge a fee.

T A B L E 2 . 6

Contingency Table
Displaying Type of 
Fund and Whether a Fee 
Is Charged, Based on
Percentage of Column
Total

FEE

TYPE Yes No Total

Intermediate government 62.96 40.77 47.28
Short-term corporate 37.04 59.23 52.72

Total 100.00 100.00 100.00

Gender: M M M F M F F M F M F M M M M F F M F F
Major: A C C M A C A A C C A A A M C M A A A C
Gender: M M M M F M F F M M F M M M M F M F M M
Major: C C A A M M C A A A C C A A A A C C A C

APPLYING THE CONCEPTS

2.7 The Transportation Security Administration reported
that from January 1, 2008, to February 18, 2009, more than
14,000 banned items were collected at Palm Beach Interna-
tional Airport. The categories were as follows:

a. Compute the percentage of values in each category.
b. What conclusions can you reach concerning the banned

items?

2.8 The Energy Information Administration re-
ported the following sources of electricity in the

United States in 2008:

SELF
Test

a. Compute the percentage of values in each category.
b. What conclusions can you reach concerning the sources

of electricity in the United States in 2008?



2.3 Organizing Numerical Data 33

2.9 Federal obligations for benefit programs and the
national debt were $63.8 trillion in 2008. The cost per
household ($) for various categories was as follows:

properly (and therefore need to be redone) seems steady, at
about 4%. In an effort to get to the root cause of these non-
conformances, tests that need to be redone, the director of the
lab decided to keep records over a period of one week. The
laboratory tests were subdivided by the shift of workers who
performed the lab tests. The results are as follows:

What do these results tell you about whether more online
retailers were requiring three or more clicks in 2009 than in
2008?

a. Construct contingency tables based on total percentages,
row percentages, and column percentages.

b. Which type of percentage—row, column, or total—do
you think is most informative for these data? Explain.

c. What conclusions concerning the pattern of nonconform-
ing laboratory tests can the laboratory director reach?

2.12 Does it take more time to get yourself removed from
an email list than it used to? A study of 100 large online
retailers revealed the following:

Category Cost per Household ($)

Civil servant retirement 15,851
Federal debt 54,537
Medicare 284,288
Military retirement 29,694
Social Security 160,216
Other 2,172

Source: Data extracted from “What We Owe,” USA Today,
May 29, 2009, p. 1A.

a. Compute the percentage of values in each category.
b. What conclusions can you reach concerning the benefit

programs?

2.10 A sample of 500 shoppers was selected in a large
metropolitan area to determine various information con-
cerning consumer behavior. Among the questions asked was
“Do you enjoy shopping for clothing?” The results are sum-
marized in the following table:

ENJOY SHOPPING 
FOR CLOTHING

GENDER

Male Female Total

Yes 136 224 360
No 104 36 140
Total 240 260 500

a. Construct contingency tables based on total percentages,
row percentages, and column percentages.

b. What conclusions do you reach from these analyses?

2.11 Each day at a large hospital, several hundred laboratory
tests are performed. The rate at which these tests are done im-

LAB TESTS 
PERFORMED

SHIFT

Day Evening Total

Nonconforming 16 24 40
Conforming 654 306 960

Total 670 330 1,000

NEED THREE OR MORE CLICKS 
TO BE REMOVED

YEAR Yes No

2009 39 61
2008 7 93

Source: Data extracted from “Drill Down,” The New York
Times, March 29, 2010, p. B2.

2.3 Organizing Numerical Data
You organize numerical data by creating ordered arrays or distributions. The amount of data
you have and what you seek to discover about your variables influences which methods you
choose, as does the arrangement of data in your worksheet.

Stacked and Unstacked Data
In Section 1.5, you learned to enter variable data into worksheets by columns. When organiz-
ing numerical data, you must additionally consider if you will need to analyze a numerical
variable by subgroups that are defined by the values of a categorical variable.

For example, in you might want to analyze the numerical variable Return
2009, the year 2009 percentage return of a bond fund, by the two subgroups that are defined

Bond Funds
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None of the data sets used in
the examples found in the
Excel and Minitab Guides
require that you stack (or
unstack) data. However, you
may need to stack (or
unstack) data to solve some
of the problems in this book.

T A B L E 2 . 7 A

Cost per Person 
at 50 City Restaurants 
and 50 Suburban 
Restaurants

City Restaurant Meal Cost

62 67 23 79 32 38 46 43 39 43
44 29 59 56 32 56 23 40 45 44
40 33 57 43 49 28 35 79 42 21
40 49 45 54 64 48 41 34 53 27
44 58 68 59 61 59 48 78 65 42

Suburban Restaurant Meal Cost

53 45 39 43 44 29 37 34 33 37
54 30 49 44 34 55 48 36 29 40
38 38 55 43 33 44 41 45 41 42
37 56 60 46 31 35 68 40 51 32
28 44 26 42 37 63 37 22 53 62

by the categorical variable Type, intermediate government and short-term corporate. To
perform this type of subgroup analysis, you arrange your worksheet data either in stacked
format or unstacked format, depending on the requirements of the statistical application
you plan to use.

In , the data has been entered in stacked format, in which the all of the values
for a numerical variable appear in one column and a second, separate column contains the
categorical values that identify which subgroup the numerical values belong to. For example,
all values for the Return 2009 variable are in one column (the sixth column) and the values in
the second column (for the Type variable) would be used to determine which of the two Type
subgroups an individual Return 2009 value belongs to.

In unstacked format, the values for each subgroup of a numerical variable are segre-
gated and placed in separate columns. For example, contains the
IG_Return_2009 and STC_Return 2009 variable columns that contain the data of Return
2009 in unstacked format by the two subgroups defined by Type, intermediate government
(IG) and short-term corporate (STC).

While you can always manually stack or unstack your data, Minitab and PHStat2 both pro-
vide you with commands that automate these operations. If you use Excel without PHStat2,
you must use a manual procedure.

The Ordered Array
An ordered array arranges the values of a numerical variable in rank order, from the small-
est value to the largest value. An ordered array helps you get a better sense of the range of
values in your data and is particularly useful when you have more than a few values. For ex-
ample, Table 2.7A shows the data collected for a study of the cost of meals at 50 restaurants
located in a major city and at 50 restaurants located in that city’s suburbs (stored in

). The unordered data in Table 2.7A prevent you from reaching any quick conclu-
sions about the cost of meals.
Restaurants

Return 2009 Unstacked

Bond Funds

In contrast, Table 2.7B, the ordered array version of the same data, enables you to quickly
see that the cost of a meal at the city restaurants is between $21 and $79 and that the cost of a
meal at the suburban restaurants is between $22 and $68.

When you have a data set that contains a large number of values, reaching conclusions
from an ordered array can be difficult. For such data sets, creating a frequency or percentage
distribution and a cumulative percentage distribution (see following sections) would be a bet-
ter choice.
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T A B L E 2 . 7 B

Ordered Arrays of Cost
per Person at 50 City
Restaurants and 50
Suburban Restaurants

City Restaurant Meal Cost

21 23 23 27 28 29 32 32 33 34
35 38 39 40 40 40 41 42 42 43
43 43 44 44 44 45 45 46 48 48
49 49 53 54 56 56 57 58 59 59
59 61 62 64 65 67 68 78 79 79

Suburban Restaurant Meal Cost

22 26 28 29 29 30 31 32 33 33
34 34 35 36 37 37 37 37 37 38
38 39 40 40 41 41 42 42 43 43
44 44 44 44 45 45 46 48 49 51
53 53 54 55 55 56 60 62 63 68

The Frequency Distribution
A frequency distribution summarizes numerical values by tallying them into a set of
numerically ordered classes. Classes are groups that represent a range of values, called a
class interval. Each value can be in only one class and every value must be contained in one
of the classes.

To create a useful frequency distribution, you must think about how many classes are
appropriate for your data and also determine a suitable width for each class interval. In gen-
eral, a frequency distribution should have at least 5 classes but no more than 15 classes
because having too few or too many classes provides little new information. To determine the
class interval width (see Equation 2.1), you subtract the lowest value from the highest value
and divide that result by the number of classes you want your frequency distribution to have.

DETERMINING THE CLASS INTERVAL WIDTH

(2.1)Interval width =
highest value - lowest value

number of classes

Because the city restaurant data consist of a sample of only 50 restaurants, between 5 and
10 classes are acceptable. From the ordered city cost array in Table 2.7B, the difference
between the highest value of $79 and the lowest value of $21 is $58. Using Equation (2.1), you
approximate the class interval width as follows:

This result suggests that you should choose an interval width of $5.80. However, your width should
always be an amount that simplifies the reading and interpretation of the frequency distribution. In
this example, an interval width of $10 would be much better than an interval width of $5.80.

Because each value can appear in only one class, you must establish proper and clearly
defined class boundaries for each class. For example, if you chose $10 as the class interval
for the restaurant data, you would need to establish boundaries that would include all the
values and simplify the reading and interpretation of the frequency distribution. Because the
cost of a city restaurant meal varies from $21 to $79, establishing the first class interval as
from $20 to less than $30, the second from $30 to less than $40, and so on, until the last class
interval is from $70 to less than $80, would meet the requirements. Table 2.8 is a frequency
distribution of the cost per meal for the 50 city restaurants and the 50 suburban restaurants that
uses these class intervals.

Interval width =
58

10
= 5.8



In the Using Statistics scenario, you are interested in comparing the 2009 return of intermedi-
ate government and short-term corporate bond mutual funds. Construct frequency distribu-
tions for the intermediate government funds and the short-term corporate bond funds.

SOLUTION The 2009 returns of the intermediate government bond funds are highly
concentrated between 0 and 10, whereas the 2009 returns of the short-term corporate bond
funds are highly concentrated between 5 and 15 (see Table 2.9).

For the bond fund data, the number of values is different in the two groups. When the
number of values in the two groups is not the same, you need to use proportions or relative
frequencies and percentages in order to compare the groups.

EXAMPLE 2.2
Frequency
Distributions of the
2009 Return for 
Intermediate
Government and
Short-Term
Corporate Bond 
Mutual Funds

36 CHAPTER 2 Organizing and Visualizing Data

T A B L E 2 . 8

Frequency Distributions
of the Cost per Meal for
50 City Restaurants and
50 Suburban Restaurants

Cost per Meal ($) City Frequency Suburban Frequency

20 but less than 30 6 5
30 but less than 40 7 17
40 but less than 50 19 17
50 but less than 60 9 7
60 but less than 70 6 4
70 but less than 80 3 0
Total 50 50

The frequency distribution allows you to reach conclusions about the major characteristics
of the data. For example, Table 2.8 shows that the cost of meals at city restaurants is concen-
trated between $40 and $50, while for suburban restaurants the cost of meals is concentrated
between $30 and $50.

For some charts discussed later in this chapter, class intervals are identified by their class
midpoints, the values that are halfway between the lower and upper boundaries of each class.
For the frequency distributions shown in Table 2.8, the class midpoints are $25, $35, $45, $55,
$65, and $75 (amounts that are simple to read and interpret).

If a data set does not contain a large number of values, different sets of class intervals can
create different impressions of the data. Such perceived changes will diminish as you collect
more data. Likewise, choosing different lower and upper class boundaries can also affect
impressions.

T A B L E 2 . 9

Frequency Distributions
of the 2009 Return for
Intermediate
Government and 
Short-Term Corporate
Bond Funds

2009 Return
Intermediate Government

Frequency
Short-Term Corporate

Frequency

-10 but less than -5 0 1
-5 but less than 0 13 0

0 but less than 5 35 15
5 but less than 10 30 38

10 but less than 15 6 31
15 but less than 20 1 9
20 but less than 25 1 1
25 but less than 30 1 1
30 but less than 35 0 1

Total 87 97
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The Relative Frequency Distribution 
and the Percentage Distribution
When you are comparing two or more groups, as is done in Table 2.10, knowing the propor-
tion or percentage of the total that is in each group is more useful than knowing the frequency
count of each group. For such situations, you create a relative frequency distribution or a
percentage distribution instead of a frequency distribution. (If your two or more groups have
different sample sizes, you must use either a relative frequency distribution or a percentage
distribution.)

T A B L E 2 . 1 0

Relative Frequency
Distributions and
Percentage Distributions
of the Cost of Meals at
City and Suburban
Restaurants

CITY SUBURBAN

COST PER MEAL ($)
Relative

Frequency
Percentage

(%)
Relative

Frequency
Percentage

(%)

20 but less than 30 0.12 12.0 0.10 10.0
30 but less than 40 0.14 14.0 0.34 34.0
40 but less than 50 0.38 38.0 0.34 34.0
50 but less than 60 0.18 18.0 0.14 14.0
60 but less than 70 0.12 12.0 0.08 8.0
70 but less than 80 0.06 6.0 0.00 0.0
Total 1.00 100.0 1.00 100.0

The proportion, or relative frequency, in each group is equal to the number of values in
each class divided by the total number of values. The percentage in each group is its propor-
tion multiplied by 100%.

COMPUTING THE PROPORTION OR RELATIVE FREQUENCY
The proportion, or relative frequency, is the number of values in each class divided by the
total number of values:

(2.2)Proportion = relative frequency =
number of values in each class

total number of values

If there are 80 values and the frequency in a certain class is 20, the proportion of values in
that class is

and the percentage is

You form the relative frequency distribution by first determining the relative fre-
quency in each class. For example, in Table 2.8 on page 36, there are 50 city restaurants, and
the cost per meal at 9 of these restaurants is between $50 and $60. Therefore, as shown in
Table 2.10, the proportion (or relative frequency) of meals that cost between $50 and $60 at
city restaurants is

You form the percentage distribution by multiplying each proportion (or relative
frequency) by 100%. Thus, the proportion of meals at city restaurants that cost between $50

9

50
= 0.18

0.25 * 100% = 25%

20

80
= 0.25



In the Using Statistics scenario, you are interested in comparing the 2009 return of intermedi-
ate government and short-term corporate bond mutual funds. Construct relative frequency
distributions and percentage distributions for these funds.

SOLUTION You conclude (see Table 2.11) that the 2009 return for the corporate bond
funds is much higher than for the intermediate government funds. For example, 31.96% of
the corporate bond funds have returns between 10 and 15, while 6.90% of the intermediate
government funds have returns between 10 and 15. Of the corporate bond funds, only
15.46% have returns between 0 and 5 as compared to 40.23% of the intermediate govern-
ment funds.

EXAMPLE 2.3
Relative Frequency
Distributions and 
Percentage Distribu-
tions of the 2009 
Return for Inter-
mediate Government
and Short-Term
Corporate Bond 
Mutual Funds
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T A B L E 2 . 1 1

Relative Frequency
Distributions and
Percentage
Distributions of the
2009 Return for
Intermediate
Government and Short-
Term Corporate Bond
Mutual Funds

INTERMEDIATE GOVERNMENT SHORT-TERM CORPORATE

2009 RETURN Proportion Percentage Proportion Percentage

-10 but less than -5 0.0000 0.00 0.0103 1.03
-5 but less than 0 0.1494 14.94 0.0000 0.00

0 but less than 5 0.4023 40.23 0.1546 15.46
5 but less than 10 0.3448 34.48 0.3918 39.18

10 but less than 15 0.0690 6.90 0.3196 31.96
15 but less than 20 0.0115 1.15 0.0928 9.28
20 but less than 25 0.0115 1.15 0.0103 1.03
25 but less than 30 0.0115 1.15 0.0103 1.03
30 but less than 35 0.0000 0.00 0.0103 1.03

Total 1.0000 100.00 1.0000 100.00

and $60 is 9 divided by 50, or 0.18, and the percentage is 18%. Table 2.10 presents the relative
frequency distribution and percentage distribution of the cost of meals at city and suburban
restaurants.

From Table 2.10, you conclude that meals cost slightly more at city restaurants than at
suburban restaurants. Also, 12% of the meals cost between $60 and $70 at city restaurants
as compared to 8% of the meals at suburban restaurants; and 14% of the meals cost
between $30 and $40 at city restaurants as compared to 34% of the meals at suburban
restaurants.

The Cumulative Distribution
The cumulative percentage distribution provides a way of presenting information about the
percentage of values that are less than a specific amount. For example, you might want to
know what percentage of the city restaurant meals cost less than $40 or what percentage cost
less than $50. You use the percentage distribution to form the cumulative percentage distribu-
tion. Table 2.12 shows how percentages of individual class intervals are combined to form the
cumulative percentage distribution for the cost of meals at city restaurants. From this table,
you see that none (0%) of the meals cost less than $20, 12% of meals cost less than $30, 26%
of meals cost less than $40 (because 14% of the meals cost between $30 and $40), and so on,
until all 100% of the meals cost less than $80.

Table 2.13 summarizes the cumulative percentages of the cost of city and suburban restau-
rant meals. The cumulative distribution shows that the cost of meals is slightly lower in subur-
ban restaurants than in city restaurants. Table 2.13 shows that 44% of the meals at suburban
restaurants cost less than $40 as compared to 26% of the meals at city restaurants; 78% of the
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meals at suburban restaurants cost less than $50 as compared to 64% of the meals at city
restaurants; and 92% of the meals at suburban restaurants cost less than $60 as compared to
82% of the meals at city restaurants.

T A B L E 2 . 1 2

Developing the
Cumulative Percentage
Distribution for the Cost
of Meals at City
Restaurants

Cost per Meal ($) Percentage (%)
Percentage of Meals Less Than Lower

Boundary of Class Interval (%)

20 but less than 30 12 0
30 but less than 40 14 12
40 but less than 50 38 26 = 12 + 14
50 but less than 60 18 64 = 12 + 14 + 38
60 but less than 70 12 82 = 12 + 14 + 38 + 18
70 but less than 80 6 94 = 12 + 14 + 38 + 18 + 12
80 but less than 90 0 100 = 12 + 14 + 38 + 18 + 12 + 6

T A B L E 2 . 1 3

Cumulative Percentage
Distributions of the Cost
of City and Suburban
Restaurant Meals

Cost ($)

Percentage of City Restaurants
With Meals Less Than

Indicated Amount

Percentage of Suburban Restaurants
With Meals Less Than

Indicated Amount

20 0 0
30 12 10
40 26 44
50 64 78
60 82 92
70 94 100
80 100 100

In the Using Statistics scenario, you are interested in comparing the 2009 return for intermedi-
ate government and short-term corporate bond mutual funds. Construct cumulative percentage
distributions for the intermediate government and short-term corporate bond mutual funds.

SOLUTION The cumulative distribution in Table 2.14 indicates that returns are much lower
for the intermediate government bond funds than for the short-term corporate funds. The table
shows that 14.94% of the intermediate government funds have negative returns as compared to
1.03% of the short-term corporate bond funds; 55.17% of the intermediate government funds
have returns below 5 as compared to 16.49% of the short-term corporate bond funds; and
89.65% of the intermediate government funds have returns below 10 as compared to 55.67%
of the short-term corporate bond funds.

EXAMPLE 2.4
Cumulative
Percentage Distribu-
tions of the 2009 
Return for Inter-
mediate Government
and Short-Term
Corporate Bond 
Mutual Funds

T A B L E 2 . 1 4

Cumulative Percentage
Distributions of the
2009 Return for
Intermediate
Government and 
Short-Term Corporate
Bond Funds

2009 Return
Intermediate Government

Percentage Less Than Indicated Value
Short-Term Corporate Percentage

Less Than Indicated Value

-10 0.00 0.00
-5 0.00 1.03

0 14.94 1.03
5 55.17 16.49

10 89.65 55.67
15 96.55 87.63
20 97.70 96.91
25 98.85 97.94
30 100.00 98.97
35 100.00 100.00
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Problems for Section 2.3
LEARNING THE BASICS
2.13 Construct an ordered array, given the following data
from a sample of midterm exam scores in accounting:n = 7

2.19 One operation of a mill is to cut pieces of steel into
parts that will later be used as the frame for front seats in an
automobile. The steel is cut with a diamond saw and
requires the resulting parts to be within inch of the
length specified by the automobile company. Data are col-
lected from a sample of 100 steel parts and stored in .
The measurement reported is the difference in inches be-
tween the actual length of the steel part, as measured by a
laser measurement device, and the specified length of the
steel part. For example, the first value, represents a
steel part that is 0.002 inch shorter than the specified length.
a. Construct a frequency distribution and a percentage

distribution.
b. Construct a cumulative percentage distribution.
c. Is the steel mill doing a good job meeting the require-

ments set by the automobile company? Explain.

2.20 A manufacturing company produces steel housings for
electrical equipment. The main component part of the hous-
ing is a steel trough that is made out of a 14-gauge steel coil.
It is produced using a 250-ton progressive punch press with a
wipe-down operation that puts two 90-degree forms in the flat
steel to make the trough. The distance from one side of the
form to the other is critical because of weatherproofing in
outdoor applications. The company requires that the width of
the trough be between 8.31 inches and 8.61 inches. The
widths of the troughs, in inches, are collected from a sample
of 49 troughs and stored in and shown here:Trough

-0.002,

Steel

; 0.005

Raw Data on Utility Charges ($)

96 171 202 178 147 102 153 197 127 82
157 185 90 116 172 111 148 213 130 165
141 149 206 175 123 128 144 168 109 167
95 163 150 154 130 143 187 166 139 149

108 119 183 151 114 135 191 137 129 158

Source: Data extracted from teammarketing.com, April 1, 2009.

a. Organize these costs as an ordered array.
b. Construct a frequency distribution and a percentage

distribution for these costs.
c. Around which class grouping, if any, are the costs of

attending a baseball game concentrated? Explain.

2.18 The file contains the data in the
next column about the cost of electricity during

July 2010 for a random sample of 50 one-bedroom apart-
ments in a large city.
a. Construct a frequency distribution and a percentage dis-

tribution that have class intervals with the upper class
boundaries $99, $119, and so on.

b. Construct a cumulative percentage distribution.

UtilitySELF
Test

68 94 63 75 71 88 64

2.14 Construct an ordered array, given the following data
from a sample of midterm exam scores in marketing:

88 78 78 73 91 78 85

2.15 The GMAT scores from a sample of 50 applicants to
an MBA program indicate that none of the applicants scored
below 450. A frequency distribution was formed by choos-
ing class intervals 450 to 499, 500 to 549, and so on, with
the last class having an interval from 700 to 749. Two appli-
cants scored in the interval 450 to 499, and 16 applicants
scored in the interval 500 to 549.
a. What percentage of applicants scored below 500?
b. What percentage of applicants scored between 500 and 549?
c. What percentage of applicants scored below 550?
d. What percentage of applicants scored below 750?

2.16 A set of data has values that vary from 11.6 to 97.8.
a. If these values are grouped into nine classes, indicate the

class boundaries.
b. What class interval width did you choose?
c. What are the nine class midpoints?

APPLYING THE CONCEPTS

2.17 The file contains the total cost ($) for four
tickets, two beers, four soft drinks, four hot dogs, two game
programs, two baseball caps, and parking for one vehicle at
each of the 30 Major League Baseball parks during the 2009
season. These costs were

BBCost

8.312 8.343 8.317 8.383 8.348 8.410 8.351 8.373
8.481 8.422 8.476 8.382 8.484 8.403 8.414 8.419
8.385 8.465 8.498 8.447 8.436 8.413 8.489 8.414
8.481 8.415 8.479 8.429 8.458 8.462 8.460 8.444
8.429 8.460 8.412 8.420 8.410 8.405 8.323 8.420
8.396 8.447 8.405 8.439 8.411 8.427 8.420 8.498
8.409

a. Construct a frequency distribution and a percentage
distribution.

b. Construct a cumulative percentage distribution.
c. What can you conclude about the number of troughs that

will meet the company’s requirements of troughs being
between 8.31 and 8.61 inches wide?

164,326,224,180,205,162,141,170,411,187,185,165,151,166,114

158,305,145,161,170,210,222,146,259,220,135,215,172,223,216

c. Around what amount does the monthly electricity cost
seem to be concentrated?
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2.21 The manufacturing company in Problem 2.20 also
produces electric insulators. If the insulators break when in
use, a short circuit is likely to occur. To test the strength of
the insulators, destructive testing in high-powered labs is
carried out to determine how much force is required to
break the insulators. Force is measured by observing how
many pounds must be applied to the insulator before it
breaks. Force measurements are collected from a sample of
30 insulators and stored in and shown here:Force

a. Construct a frequency distribution and a percentage dis-
tribution for each manufacturer, using the following class
interval widths for each distribution:

Manufacturer A: 650 but less than 750, 750 but less than
850, and so on.
Manufacturer B: 750 but less than 850, 850 but less than
950, and so on.

b. Construct cumulative percentage distributions.
c. Which bulbs have a longer life—those from Manufac-

turer A or Manufacturer B? Explain.

2.23 The following data (stored in ) represent the
amount of soft drink in a sample of 50 2-liter bottles:

Drink

Manufacturer A Manufacturer B

684 697 720 773 821 819 836 888 897 903
831 835 848 852 852 907 912 918 942 943
859 860 868 870 876 952 959 962 986 992
893 899 905 909 911 994 1,004 1,005 1,007 1,015
922 924 926 926 938 1,016 1,018 1,020 1,022 1,034
939 943 946 954 971 1,038 1,072 1,077 1,077 1,082
972 977 984 1,005 1,014 1,096 1,100 1,113 1,113 1,116

1,016 1,041 1,052 1,080 1,093 1,153 1,154 1,174 1,188 1,230

VISUALIZING DATA
When you organize your data, you sometimes begin to discover patterns or relationships in
your data, as examples in Sections 2.2 and 2.3 illustrate. To better explore and discover
patterns and relationships, you can visualize your data by creating various charts and special
“displays.” As is the case when organizing data, the techniques you use to visualize your data
depend on the type of variable (categorical or numerical) of your data.

1,870 1,728 1,656 1,610 1,634 1,784 1,522 1,696
1,592 1,662 1,866 1,764 1,734 1,662 1,734 1,774
1,550 1,756 1,762 1,866 1,820 1,744 1,788 1,688
1,810 1,752 1,680 1,810 1,652 1,736

a. Construct a frequency distribution and a percentage
distribution.

b. Construct a cumulative percentage distribution.
c. What can you conclude about the strength of the insula-

tors if the company requires a force measurement of at
least 1,500 pounds before the insulator breaks?

2.22 The file contains the life (in hours) of a sam-
ple of 40 100-watt light bulbs produced by Manufacturer A
and a sample of 40 100-watt light bulbs produced by Manu-
facturer B. The following table shows these data as a pair of
ordered arrays:

Bulbs

2.109 2.086 2.066 2.075 2.065 2.057 2.052 2.044 2.036 2.038

2.031 2.029 2.025 2.029 2.023 2.020 2.015 2.014 2.013 2.014
2.012 2.012 2.012 2.010 2.005 2.003 1.999 1.996 1.997 1.992
1.994 1.986 1.984 1.981 1.973 1.975 1.971 1.969 1.966 1.967
1.963 1.957 1.951 1.951 1.947 1.941 1.941 1.938 1.908 1.894

a. Construct a cumulative percentage distribution.
b. On the basis of the results of (a), does the amount of soft

drink filled in the bottles concentrate around specific
values?

2.4 Visualizing Categorical Data
The chart you choose to visualize the data for a single categorical variable depends on whether
you seek to emphasize how categories directly compare to each other (bar chart) or how cate-
gories form parts of a whole (pie chart), or whether you have data that are concentrated in only
a few of your categories (Pareto chart). To visualize the data for two categorical variables, you
use a side-by-side bar chart.



In Part I of the Choice Is Yours scenario, you are interested in examining the risk of the bond
funds. You have already defined the variables and collected the data from a sample of 184 bond
funds. Now, you need to construct a bar chart of the risk of the bond funds (based on Table 2.2
on page 30) and interpret the results.

SOLUTION Reviewing Figure 2.2, you see that average is the largest category, closely
followed by above average, and below average.

EXAMPLE 2.5
Bar Chart of Levels 
of Risk of Bond
Mutual Funds
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F I G U R E 2 . 1
Bar chart for how adults
pay their monthly bills

Reviewing Figure 2.1, you see that respondents are most likely to pay by check or electroni-
cally/online, followed by paying by cash. Very few respondents mentioned other or did not
know.

The Bar Chart
A bar chart compares different categories by using individual bars to represent the tallies
for each category. The length of a bar represents the amount, frequency, or percentage of
values falling into a category. Unlike with a histogram, discussed in Section 2.5, a bar
chart separates the bars between the categories. Figure 2.1 displays the bar chart for the
data of Table 2.1 on page 30, which is based on a recent survey that asked adults how
they pay their monthly bills (“How Adults Pay Monthly Bills,” USA Today, October 4,
2007, p. 1).
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F I G U R E 2 . 2
Bar chart of the levels
of risk of bond mutual
funds

The Pie Chart
A pie chart uses parts of a circle to represent the tallies of each category. The size of each part,
or pie slice, varies according to the percentage in each category. For example, in Table 2.1 on
page 30, 54% of the respondents stated that they paid bills by check. To represent this category
as a pie slice, you multiply 54% by the 360 degrees that makes up a circle to get a pie slice that
takes up 194.4 degrees of the 360 degrees of the circle. From Figure 2.3, you can see that the
pie chart lets you visualize the portion of the entire pie that is in each category. In this figure,
paying bills by check is the largest slice, containing 54% of the pie. The second largest slice is
paying bills electronically/online, which contains 28% of the pie.

F I G U R E 2 . 3
Pie chart for how people
pay their bills
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In Part I of the Choice Is Yours scenario, you are interested in examining the risk of the bond
funds. You have already defined the variables to be collected and collected the data from a
sample of 184 bond funds. Now, you need to construct a pie chart of the risk of the bond
funds (based on Table 2.2 on page 30) and interpret the results.

EXAMPLE 2.6
Pie Chart of Levels 
of Risk of Bond
Mutual Funds

F I G U R E 2 . 4
Pie chart of the levels 
of risk of bond mutual
funds

Figure 2.4 shows a pie chart
created using Minitab; Figure
2.3 shows a pie chart created
using Excel.

SOLUTION Reviewing Figure 2.4, you see that approximately a little more than one-third of
the funds are average risk, about one-third are above average risk, and fewer than one-third are
below-average risk.

The Pareto Chart
In a Pareto chart, the tallies for each category are plotted as vertical bars in descending order,
according to their frequencies, and are combined with a cumulative percentage line on the
same chart. A Pareto chart can reveal situations in which the Pareto principle occurs.

A Pareto chart has the capability to separate the “vital few” from the “trivial many,” en-
abling you to focus on the important categories. In situations in which the data involved con-
sist of defective or nonconforming items, a Pareto chart is a powerful tool for prioritizing
improvement efforts.

To study a situation in which the Pareto chart proved to be especially appropriate, consider
the problem faced by a bank. The bank defined the problem to be the incomplete automated
teller machine (ATM) transactions. Data concerning the causes of incomplete ATM transac-
tions were collected and stored in . Table 2.15 shows the causes of incom-
plete ATM transactions, the frequency for each cause, and the percentage of incomplete ATM
transactions due to each cause.

ATM Transactions

PARETO PRINCIPLE
The Pareto principle exists when the majority of items in a set of data occur in a small
number of categories and the few remaining items are spread out over a large number of
categories. These two groups are often referred to as the “vital few” and the “trivial many.”



2.4 Visualizing Categorical Data 45

T A B L E 2 . 1 5

Summary Table of
Causes of Incomplete
ATM Transactions

Cause Frequency Percentage (%)

ATM malfunctions 32 4.42
ATM out of cash 28 3.87
Invalid amount requested 23 3.18
Lack of funds in account 19 2.62
Magnetic strip unreadable 234 32.32
Warped card jammed 365 50.41
Wrong key stroke 23 3.18
Total 724 100.00

Source: Data extracted from A. Bhalla, “Don’t Misuse the Pareto Principle,”
Six Sigma Forum Magazine, May 2009, pp. 15–18.

T A B L E 2 . 1 6

Ordered Summary Table
of Causes of Incomplete
ATM Transactions

Cause Frequency Percentage (%) Cumulative Percentage (%)

Warped card jammed 365 50.41% 50.41%
Magnetic strip unreadable 234 32.32% 82.73%
ATM malfunctions 32 4.42% 87.15%
ATM out of cash 28 3.87% 91.02%
Invalid amount requested 23 3.18% 94.20%
Wrong key stroke 23 3.18% 97.38%
Lack of funds in account 19 2.62% 100.00%
Total 724 100.00%

Table 2.16 presents a summary table for the incomplete ATM transactions data in which
the categories are ordered based on the frequency of incomplete ATM transactions present
(rather than arranged alphabetically). The percentages and cumulative percentages for the
ordered categories are also included as part of the table.

F I G U R E 2 . 5
Pareto chart for the
incomplete ATM
transactions data

Figure 2.5 shows a Pareto chart based on the results displayed in Table 2.16.



Construct a Pareto chart of the types of bill payment (see Table 2.1 on page 30)EXAMPLE 2.7
Pareto Chart of
Types of Bill Payment

Figure 2.6 shows a Pareto chart
created using Minitab; Figure
2.5 shows a Pareto chart
created using Excel.

F I G U R E 2 . 6
Pareto chart of bill
payment

In Figure 2.6, check and electronic/online account for 82% of the bill payments and check,
electronic/online, and cash account for 97% of the bill payments.

The Side-by-Side Bar Chart
A side-by-side bar chart uses sets of bars to show the joint responses from two categorical
variables. Figure 2.7 uses the data of Table 2.3 on page 31, which shows the frequency of bond
funds that charge a fee for the intermediate government bond funds and short-term corporate
bond funds.

Reviewing Figure 2.7, you see that a much higher percentage of the intermediate govern-
ment bond funds charge a fee than the short-term corporate bond funds.
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A Pareto chart presents the bars vertically, along with a cumulative percentage line. The
cumulative line is plotted at the midpoint of each category, at a height equal to the cumula-
tive percentage. In order for a Pareto chart to include all categories, even those with few de-
fects, in some situations, you need to include a category labeled Other or Miscellaneous. In
these situations, the bar representing these categories should be placed to the right of the
other bars.

Because the categories in a Pareto chart are ordered by the frequency of occurrence, you
can see where to concentrate efforts to improve the process. Analyzing the Pareto chart in
Figure 2.5, if you follow the line, you see that these first two categories account for 82.73% of
the incomplete ATM transactions. The first category listed is warped card jammed (with
50.41% of the defects), followed by magnetic strip unreadable (with 32.32%). Attempts to
reduce incomplete ATM transactions due to warped card jammed and magnetic strip unreadable
should produce the greatest payoff. The team should focus on finding why these errors
occurred.
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F I G U R E 2 . 7
Side-by-side bar chart of
fund type and whether a
fee is charged

Problems for Section 2.4
APPLYING THE CONCEPTS

2.24 A survey asked 1,264 women who were their
most trusted shopping advisers. The survey results

were as follows:

SELF
Test

a. Construct a bar chart, a pie chart, and a Pareto chart.
b. Which graphical method do you think is best for

portraying these data?
c. What conclusions can you reach concerning women’s

most trusted shopping advisers?

2.25 What would you do if you won $1 million? A survey
was taken of 1,078 adults who were asked what they would
spend money on first if they won $1 million in a March
Madness NCAA pool. The results are shown at the top of
the next column:
a. Construct a bar chart, a pie chart, and a Pareto chart.
b. Which graphical method do you think is best for portray-

ing these data?

c. What conclusions can you reach concerning what adults
would do with $1 million?

2.26 The Energy Information Administration reported the
following sources of electricity in the United States in 2010:

Shopping Advisers Percentage (%)

Advertising 7
Friends/family 45
Manufacturer websites 5
News media 11
Online user reviews 13
Retail websites 4
Salespeople 1
Other 14

Source: Data extracted from “Snapshots,” USA Today,
October 19, 2006, p. 1B.

Spending Choice Percentage (%)

Buy Final Four tickets 4
Charity 4
Pay off debt 59
Save it 16
Take a cruise 8
Take money, never enter pool 

again 4
Take luck to Las Vegas 5

Source: Data extracted from “If I Win $1 Million,” USA Today, March
19, 2009, p. 1A.

Source of Electricity Percentage (%)

Coal 44
Hydroelectric 7
Natural gas 24
Nuclear 20
Other 5

Source: Energy Information Administration, 2010.



a. Construct a Pareto chart.
b. What percentage of power is derived from coal, nuclear,

or natural gas?
c. Construct a pie chart.
d. For these data, do you prefer using a Pareto chart or the

pie chart? Why?

2.27 An article discussed radiation therapy and new cures
from the therapy, along with the harm that could be done if
mistakes were made. The following tables represent the
results of the types of mistakes made and the causes of mis-
takes reported to the New York State Department of Health
from 2001 to 2009:

a. Construct a bar chart, a pie chart, and a Pareto chart.
b. Which graphical method do you think is best for portray-

ing these data?
c. What conclusions can you reach concerning residential

electricity consumption in the United States?

2.29 A study of 1,000 people asked what respondents
wanted to grill during barbecue season. The results were as
follows:

Radiation Mistakes Number

Missed all or part of intended target 284
Wrong dose given 255
Wrong patient treated 50
Other 32

Causes of Mistakes Number

Quality assurance flawed 355
Data entry or calculation errors by

personnel 252
Misidentification of patient or treatment 

location 174
Blocks, wedges, or collimators misused 133
Patient’s physical setup wrong 96
Treatment plan flawed 77
Hardware malfunction 60
Staffing 52
Computer software or digital information

transfer malfunction 24
Override of computer data by personnel 19
Miscommunication 14
Unclear/other 8

Source: Data extracted from W. Bogdanich, “A Lifesaving Tool Turned
Deadly,” The New York Times, January 24, 2010, pp. 1, 15, 16.

Type of Appliance Percentage (%)

Air conditioning 18
Clothes dryers 5
Clothes washers/other 24
Computers 1
Cooking 2
Dishwashers 2
Freezers 2
Lighting 16
Refrigeration 9
Space heating 7
Water heating 8
TVs and set top boxes 6

Source: Data extracted from J. Mouawad, and K. Galbraith,
“Plugged-in Age Feeds a Hunger for Electricity,” The New
York Times, September 20, 2009, pp. 1, 28.

a. Construct a bar chart and a pie chart for the types of radi-
ation mistakes.

b. Which graphical method do you think is best for portray-
ing these data?

c. Construct a Pareto chart for the causes of mistakes.
d. Discuss the “vital few” and “trivial many” reasons for the

causes of mistakes.

Type of Food Percentage (%)

Beef 38
Chicken 23
Fruit 1
Hot dogs 6
Pork 8
Seafood 19
Vegetables 5

Source: Data extracted from “What Folks Want
Sizzling on the Grill During Barbecue Season,”
USA Today, March 29, 2009, p. 1A.

a. Construct a bar chart, a pie chart, and a Pareto chart.
b. Which graphical method do you think is best for portray-

ing these data?
c. What conclusions can you reach concerning what folks

want sizzling on the grill during barbecue season?

2.30 A sample of 500 shoppers was selected in a large met-
ropolitan area to learn more about consumer behavior.
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2.28 The following table indicates the percentage of resi-
dential electricity consumption in the United States, organ-
ized by type of appliance in a recent year:
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ENJOY SHOPPING 
FOR CLOTHING

GENDER

Male Female Total

Yes 136 224 360
No 104 36 140
Total 240 260 500

Among the questions asked was “Do you enjoy shopping for
clothing?” The results are summarized in the following table:

a. Construct a side-by-side bar chart of enjoying shopping
and gender.

b. What conclusions do you reach from this chart?

2.31 Each day at a large hospital, several hundred laboratory
tests are performed. The rate at which these tests are done im-
properly (and therefore need to be redone) seems steady, at
about 4%. In an effort to get to the root cause of these noncon-
formances, tests that need to be redone, the director of the lab
decided to keep records over a period of one week. The labo-
ratory tests were subdivided by the shift of workers who
performed the lab tests. The results are as follows:

LAB TESTS PERFORMED

SHIFT

Day Evening Total

Nonconforming 16 24 40
Conforming 654 306 960
Total 670 330 1,000

a. Construct a side-by-side bar chart of nonconformances
and shift.

b. What conclusions concerning the pattern of noncon-
forming laboratory tests can the laboratory director
reach?

2.32 Does it take more time to get yourself removed from
an email list than it used to? A study of 100 large online re-
tailers revealed the following:

NEED THREE OR MORE CLICKS 
TO BE REMOVED

YEAR Yes No

2009 39 61
2008 7 93

Source: Data extracted from “Drill Down,” The New York Times, March
29, 2010, p. B2.

a. Construct a side-by-side bar chart of year and whether
you need to click three or more times to be removed from
an email list.

b. What do these results tell you about whether more online
retailers were requiring three or more clicks in 2009 than
in 2008?

2.5 Visualizing Numerical Data
Among the charts you use to visualize numerical data are the stem-and-leaf display, the
histogram, the percentage polygon, and the cumulative percentage polygon (ogive).

The Stem-and-Leaf Display
A stem-and-leaf display allows you to see how the data are distributed and where concentra-
tions of data exist. The display organizes data into groups (the stems) row-wise, so that the
values within each group (the leaves) branch out to the right of their stem. For stems with more
than one leaf, the leaves are presented in ascending order. On each leaf, the values are pre-
sented in ascending order. For example, suppose you collect the following lunch costs ($) for
15 classmates who had lunch at a fast-food restaurant:

5.40 4.30 4.80 5.50 7.30 8.50 6.10 4.80 4.90 4.90 5.50 3.50 5.90 6.30 6.60

To construct the stem-and-leaf display, you use whole dollar amounts as the stems and
round the cents, the leaves, to one decimal place. For the first value, 5.40, the stem would be 5
and its leaf would be 4. For the second value, 4.30, the stem would be 4 and its leaf 3. The com-
pleted stem-and-leaf display for these data is

3 5
4 38899
5 4559
6 136
7 3
8 5



In Part I of the Choice Is Yours scenario, you are interested in studying the past performance
of the short-term corporate bond funds. One measure of past performance is the return in
2009. You have already defined the variables to be collected and collected the data from a sam-
ple of 97 short-term corporate bond funds. Now, you need to construct a stem-and-leaf display
of the return in 2009.

SOLUTION Figure 2.8 illustrates the stem-and-leaf display of the return in 2009 for short-
term corporate bond funds.

EXAMPLE 2.8
Stem-and-Leaf
Display of the 2009
Return of the 
Short-Term
Corporate Bond
Funds

Figure 2.8 shows a stem-
and-leaf display created using
Minitab and modified so that
each stem occupies only 
one row.The leaves using
PHStat2 will differ from Figure
2.8 slightly because PHStat2
and Minitab use different
methods.

F I G U R E 2 . 8
Stem-and-leaf display 
of the return in 2009 
of short-term corporate
bond funds

Analyzing Figure 2.8, you conclude the following:

• The lowest return in 2009 was –8.

• The highest return in 2009 was 32.

• The returns in 2009 were concentrated between 0 and 20.

• Only one fund had a negative 2009 return, and three funds had 2009 returns 20 and above.

The Histogram
A histogram is a bar chart for grouped numerical data in which you use vertical bars to
represent the frequencies or percentages in each group. In a histogram, there are no gaps
between adjacent bars. You display the variable of interest along the horizontal (X ) axis.
The vertical (Y ) axis represents either the frequency or the percentage of values per class
interval.

Figure 2.9 displays frequency histograms for the cost of meals at city restaurants and
suburban restaurants.The histogram for city restaurants shows that the cost of meals is concen-
trated between approximately $40 and $50. Very few meals at city restaurants cost more than

F I G U R E 2 . 9
Histograms for the cost of restaurant meals at city and suburban restaurants
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$70. The histogram for suburban restaurants shows that the cost of meals is concentrated be-
tween $30 and $50. Very few meals at suburban restaurants cost more than $60.

In Part I of the Choice Is Yours scenario, you are interested in comparing the past performance
of the intermediate government bond funds and the short-term corporate bond funds. One
measure of past performance is the return in 2009. You have already defined the variables to
be collected and collected the data from a sample of 184 bond funds. Now, you need to con-
struct histograms for the intermediate government and the short-term corporate bond funds.

SOLUTION Figure 2.10 displays frequency histograms for the 2009 return for the interme-
diate government and short-term corporate bond funds.

EXAMPLE 2.9
Histograms of the
2009 Return for 
the Intermediate
Government and
Short-Term Corpo-
rate Bond Funds

Figure 2.10 shows
histograms created using
Excel and PHStat2; Figure
2.9 shows histograms
created using Minitab.

F I G U R E 2 . 1 0

Frequency histograms of the 2009 return for the intermediate government and short-term corporate bond funds

Reviewing the histograms in Figure 2.10 leads you to conclude that the returns were
much higher for the short-term corporate bond funds than for the intermediate govern-
ment bond funds. The return for intermediate government bond funds is concentrated
between 0 and 10, and the return for the short-term corporate bond funds is concentrated
between 5 and 15.

The Percentage Polygon
If you tried to construct two or more histograms on the same graph, you would not be able to
easily interpret each histogram because the bars would overlap. When there are two or more
groups, you should use a percentage polygon. A percentage polygon uses the midpoints of
each class interval to represent the data of each class and then plots the midpoints, at their
respective class percentages, as points on a line.

Figure 2.11 displays percentage polygons for the cost of meals at city and suburban
restaurants.

Reviewing the two polygons in Figure 2.11 leads you to conclude that the highest concen-
tration of the cost of meals at city restaurants is between $40 and $50, while the cost of meals
at suburban restaurants is evenly concentrated between $30 and $50. Also, city restaurants
have a higher percentage of meals that cost $60 or more than suburban restaurants.



F I G U R E 2 . 1 1
Percentage polygons of
the cost of restaurant
meals for city and
suburban restaurants

In Part I of the Choice Is Yours scenario, you are interested in comparing the past perform-
ance of the intermediate government bond funds and the short-term corporate bond funds.
One measure of past performance is the return in 2009. You have already defined the
variables and collected the data from a sample of 184 bond funds. Now, you need to
construct percentage polygons for the intermediate government bond and short-term
corporate bond funds.

SOLUTION Figure 2.12 displays percentage polygons of the 2009 returns for the intermedi-
ate government bond and short-term corporate bond funds.

EXAMPLE 2.10
Percentage
Polygons of the
2009 Return for 
the Intermediate
Government and
Short-Term
Corporate Bond
Funds

F I G U R E 2 . 1 2
Percentage polygons 
of the 2009 return for
the intermediate
government bond and
short-term corporate
bond funds

Figure 2.12 shows
percentage polygons
created using Excel; Figure
2.11 shows percentage
polygons created using
Minitab.
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The polygons in Figure 2.11 have points whose values on the X axis represent the midpoint of
the class interval. For example, look at the points plotted at X = 65 ($65). The point for the cost of
meals at city restaurants (the higher one) represents the fact that 12% of the meals at these restau-
rants cost between $60 and $70. The point for the cost of meals at suburban restaurants (the lower
one) represents the fact that 8% of meals at these restaurants cost between $60 and $70.

When you construct polygons or histograms, the vertical (Y) axis should show the true
zero, or “origin,” so as not to distort the character of the data. The horizontal (X) axis does not
need to show the zero point for the variable of interest, although the range of the variable
should include the major portion of the axis.
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Analyzing Figure 2.12 leads you to conclude that the 2009 return of short-term corporate
funds is much higher than for intermediate government bond funds. The polygon for the
short-term corporate funds is to the right (the returns are higher) of the polygon for the inter-
mediate government bond funds. The return for intermediate government funds is concen-
trated between 0 and 10, whereas the return for the short-term corporate bond funds is
concentrated between 5 and 15.

The Cumulative Percentage Polygon (Ogive)
The cumulative percentage polygon, or ogive, uses the cumulative percentage distribution
discussed in Section 2.3 to display the variable of interest along the X axis and the cumulative
percentages along the Y axis.

Figure 2.13 shows cumulative percentage polygons for the cost of meals at city and subur-
ban restaurants.

F I G U R E 2 . 1 3
Cumulative percentage
polygons of the cost 
of restaurant meals 
at city and suburban
restaurants

Reviewing the curves leads you to conclude that the curve of the cost of meals at the city
restaurants is located to the right of the curve for the suburban restaurants. This indicates that
the city restaurants have fewer meals that cost less than a particular value. For example, 64%
of the meals at city restaurants cost less than $50, as compared to 78% of the meals at subur-
ban restaurants.

In Part I of the Choice Is Yours scenario, you are interested in comparing the past performance
of the intermediate government bond funds and the short-term corporate bond funds. One
measure of past performance is the return in 2009. You have already defined the variables and
collected the data from a sample of 184 bond funds. Now, you need to construct cumulative
percentage polygons for the intermediate government bond and the short-term corporate bond
funds.

SOLUTION Figure 2.14 on page 54 displays cumulative percentage polygons for the 2009
return for the intermediate government bond and short-term corporate bond funds.

EXAMPLE 2.11
Cumulative Percent-
age Polygons of the
2009 Return for the
Intermediate
Government and
Short-Term
Corporate Bond
Funds



Reviewing the cumulative percentage polygons in Figure 2.14 leads you to conclude that
the curve for the 2009 return of short-term corporate bond funds is located to the right of the
curve for the intermediate government bond funds. This indicates that the short-term corporate
bond funds have fewer 2009 returns that are lower than a particular value. For example, 14.94%
of the intermediate government bond funds had negative (returns below 0) 2009 returns as com-
pared to only 1.03% of the short-term corporate bond funds. Also, 55.17% of the intermediate
government bond funds had 2009 returns below 5, as compared to 16.49% of the short-term
corporate bond funds. You can conclude that, in general, the short-term corporate bond funds
outperformed the intermediate government bond funds in 2009.

Problems for Section 2.5
LEARNING THE BASICS
2.33 Construct a stem-and-leaf display, given the follow-
ing data from a sample of midterm exam scores in finance:

2.34 Construct an ordered array, given the following stem-
and-leaf display from a sample of midterm exam
scores in information systems:

n = 7

54    69    98    93    53    74

a. Construct an ordered array.
b. Which of these two displays seems to provide more infor-

mation? Discuss.
c. What amount of gasoline (in gallons) is most likely to be

purchased?
d. Is there a concentration of the purchase amounts in the

center of the distribution?

2.36 The file contains the total cost ($)
for four tickets, two beers, four soft drinks, four

hot dogs, two game programs, two baseball caps, and park-
ing for one vehicle at each of the 30 Major League Baseball
parks during the 2009 season.
Source: Data extracted from teammarketing.com, April 1, 2009.

a. Construct a stem-and-leaf display for these data.
b. Around what value, if any, are the costs of attending a

baseball game concentrated? Explain.

2.37 The file contains the cost per ounce
($) for a sample of 14 dark chocolate bars:

DarkChocolate

BBCostSELF
Test
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F I G U R E 2 . 1 4
Cumulative percentage
polygons of the 2009
return of intermediate
government bonds and
short-term corporate
bond funds

Figure 2.14 shows
cumulative percentage
polygons created using
Excel; Figure 2.13 shows
cumulative percentage
polygons created using
Minitab.

0.68 0.72 0.92 1.14 1.42 0.94 0.77
0.57 1.51 0.57 0.55 0.86 1.41 0.90

Source: Data extracted from “Dark Chocolate: Which Bars Are Best?”
Consumer Reports, September 2007, p. 8.

5 0
6
7 446
8 19
9 2

9 147
10 02238
11 125566777
12 223489
13 02

APPLYING THE CONCEPTS

2.35 The following is a stem-and-leaf display representing
the amount of gasoline purchased, in gallons (with leaves in
tenths of gallons), for a sample of 25 cars that use a particu-
lar service station on the New Jersey Turnpike:



2.5 Visualizing Numerical Data 55

a. Construct an ordered array.
b. Construct a stem-and-leaf display.
c. Does the ordered array or the stem-and-leaf display pro-

vide more information? Discuss.
d. Around what value, if any, is the cost of dark chocolate

bars concentrated? Explain.

2.38 The file contains the following data about the
cost of electricity during July 2010 for a random sample of
50 one-bedroom apartments in a large city:

Utility

What conclusions can you reach concerning the cost of
attending a baseball game at different ballparks?

2.40 The following histogram visualizes the data about the
property taxes per capita for the 50 states and the District of
Columbia, stored in .

What conclusions can you reach concerning the property
taxes per capita?

PropertyTaxes

2.41 One operation of a mill is to cut pieces of steel into
parts that will later be used as the frame for front seats in an
automobile. The steel is cut with a diamond saw and re-
quires the resulting parts to be within inch of the
length specified by the automobile company. The data are
collected from a sample of 100 steel parts and stored in

. The measurement reported is the difference in
inches between the actual length of the steel part, as meas-
ured by a laser measurement device, and the specified
length of the steel part. For example, the first value,

represents a steel part that is 0.002 inch shorter
than the specified length.
a. Construct a percentage histogram.
b. Is the steel mill doing a good job meeting the require-

ments set by the automobile company? Explain.

2.42 A manufacturing company produces steel housings
for electrical equipment. The main component part of the
housing is a steel trough that is made out of a 14-gauge
steel coil. It is produced using a 250-ton progressive punch
press with a wipe-down operation that puts two 90-degree
forms in the flat steel to make the trough. The distance
from one side of the form to the other is critical because of
weatherproofing in outdoor applications. The company re-
quires that the width of the trough be between 8.31 inches
and 8.61 inches. The widths of the troughs, in inches, are
collected from a sample of 49 troughs and stored in

.
a. Construct a percentage histogram and a percentage

polygon.
b. Plot a cumulative percentage polygon.
c. What can you conclude about the number of troughs that

will meet the company’s requirements of troughs being
between 8.31 and 8.61 inches wide?

2.43 The manufacturing company in Problem 2.42 also
produces electric insulators. If the insulators break when in

Trough

-0.002,

Steel

;0.005

96 171 202 178 147 102 153 197 127 82
157 185 90 116 172 111 148 213 130 165
141 149 206 175 123 128 144 168 109 167
95 163 150 154 130 143 187 166 139 149

108 119 183 151 114 135 191 137 129 158

a. Construct a histogram and a percentage polygon.
b. Construct a cumulative percentage polygon.
c. Around what amount does the monthly electricity cost

seem to be concentrated?

2.39 As player salaries have increased, the cost of attend-
ing baseball games has increased dramatically. The follow-
ing histogram visualizes the total cost ($) for four tickets,
two beers, four soft drinks, four hot dogs, two game pro-
grams, two baseball caps, and parking for one vehicle at
each of the 30 Major League Baseball parks during the 2009
season that is stored in .BBCost



Manufacturer A Manufacturer B

684 697 720 773 821 819 836 888 897 903
831 835 848 852 852 907 912 918 942 943
859 860 868 870 876 952 959 962 986 992
893 899 905 909 911 994 1,004 1,005 1,007 1,015
922 924 926 926 938 1,016 1,018 1,020 1,022 1,034
939 943 946 954 971 1,038 1,072 1,077 1,077 1,082
972 977 984 1,005 1,014 1,096 1,100 1,113 1,113 1,116

1,016 1,041 1,052 1,080 1,093 1,153 1,154 1,174 1,188 1,230

2.6 Visualizing Two Numerical Variables
Often you will want to explore possible relationships between two numerical variables. You
use a scatter plot as a first step to visualize such relationships. In the special case where one of
your variables represents the passage of time, you use a time-series plot.

The Scatter Plot
Often, you have two numerical measurements about the same item or individual. A scatter
plot can explore the possible relationship between those measurements by plotting the data of
one numerical variable on the horizontal, or X, axis and the data of a second numerical vari-
able on the vertical, or Y, axis. For example, a marketing analyst could study the effectiveness
of advertising by comparing advertising expenses and sales revenues of 50 stores. Using a
scatter plot, a point is plotted on the two-dimensional graph for each store, using the X axis to
represent advertising expenses and the Y axis to represent sales revenues.

Table 2.17 presents the revenues and value (both in millions of dollars) for all 30 NBA
professional basketball teams that is stored in . To explore the possible relation-
ship between the revenues generated by a team and the value of a team, you can create a
scatter plot.

NBAValues
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a. Construct percentage histograms on separate graphs and
plot the percentage polygons on one graph.

b. Plot cumulative percentage polygons on one graph.
c. Which manufacturer has bulbs with a longer life—

Manufacturer A or Manufacturer B? Explain.

2.45 The data stored in represents the amount of
soft drink in a sample of 50 2-liter bottles:
a. Construct a histogram and a percentage polygon.
b. Construct a cumulative percentage polygon.
c. On the basis of the results in (a) and (b), does the amount

of soft drink filled in the bottles concentrate around
specific values?

Drink

use, a short circuit is likely to occur. To test the strength of
the insulators, destructive testing in high-powered labs is
carried out to determine how much force is required to
break the insulators. Force is measured by observing how
many pounds must be applied to the insulator before it
breaks. Force measurements are collected from a sample of
30 insulators and stored in .
a. Construct a percentage histogram and a percentage polygon.
b. Construct a cumulative percentage polygon.
c. What can you conclude about the strengths of the insula-

tors if the company requires a force measurement of at
least 1,500 pounds before the insulator breaks?

2.44 The file contains the life (in hours) of a sam-
ple of 40 100-watt light bulbs produced by Manufacturer A
and a sample of 40 100-watt light bulbs produced by Manu-
facturer B. The table in the next column shows these data as
a pair of ordered arrays:

Use the following class interval widths for each distribution:

Manufacturer A: 650 but less than 750, 750 but less than
850, and so on.
Manufacturer B: 750 but less than 850, 850 but less than
950, and so on.

Bulbs

Force
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T A B L E 2 . 1 7

Values and Revenues for NBA Teams

Team Value Revenues Team Value Revenues

Atlanta 306 103 Milwaukee 254 91
Boston 433 144 Minnesota 268 96
Charlotte 278 96 New Jersey 269 92
Chicago 511 168 New Orleans 267 95
Cleveland 476 159 New York 586 202
Dallas 446 154 Oklahoma City 310 111
Denver 321 115 Orlando 361 107
Detroit 479 171 Philadelphia 344 115
Golden State 315 113 Phoenix 429 148
Houston 470 160 Portland 338 121
Indiana 281 97 Sacramento 305 109
Los Angeles Clippers 295 102 San Antonio 398 133
Los Angeles Lakers 607 209 Toronto 386 133
Memphis 257 88 Utah 343 118
Miami 364 126 Washington 313 110

Source: Data extracted from www.forbes.com/lists/2009/32/basketball-values-09_NBA-Team-Valuations_Rank.html.

For each team, you plot the revenues on the X axis and the values on the Y axis. Figure 2.15
presents a scatter plot for these two variables.

F I G U R E 2 . 1 5
Scatter plot of revenue
and value

Reviewing Figure 2.15, you see that there appears to be a very strong increasing
(positive) relationship between revenues and the value of a team. In other words, teams that
generate a smaller amount of revenues have a lower value, while teams that generate higher
revenues have a higher value. Notice the straight line that has been superimposed on the
plotted data in Figure 2.15. For these data, this line is very close to the points in the scatter
plot. This line is a linear regression prediction line that will be discussed in Chapter 13. (In
Section 3.5, you will return to this example when you learn about the covariance and the
coefficient of correlation.)

www.forbes.com/lists/2009/32/basketball-values-09_NBA-Team-Valuations_Rank.html


Other pairs of variables may have a decreasing (negative) relationship in which one vari-
able decreases as the other increases. In other situations, there may be a weak or no relation-
ship between the variables.

The Time-Series Plot
A time-series plot plots the values of a numerical variable on the Y axis and plots the time
period associated with each numerical value on the X axis. A time-series plot can help
explore trends in data that occur over time. For example, Table 2.18 presents the combined
gross (in millions of dollars) of movies released from 1996 to 2009 that is stored in

. To better visualize this data, you create the time-series plot shown in
Figure 2.16.

From Figure 2.16, you see that there was a steady increase in the combined gross of
movies between 1996 and 2009. During that time, the combined gross increased from under
$6 billion in 1996 to more than $10 billion in 2009.

MovieGross

T A B L E 2 . 1 8

Combined Gross
of Movies

Year Combined Gross

1996 5,669.20
1997 6,393.90
1998 6,523.00
1999 7,317.50
2000 7,659.50
2001 8,077.80
2002 9,146.10
2003 9,043.20
2004 9,359.40
2005 8,817.10
2006 9,231.80
2007 9,685.70
2008 9,707.40
2009 10,675.60

Source: Data extracted from www.
the-numbers. com/movies, February 16,
2010.
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F I G U R E 2 . 1 6
Time-series plot of
combined gross of
movies per year from
1996 to 2009

www.the-numbers.com/movies
www.the-numbers.com/movies
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Problems for Section 2.6
LEARNING THE BASICS
2.46 The following is a set of data from a sample of

items:n = 11

c. What can you say about the relationship between first
weekend gross and U.S. gross and first weekend gross
and worldwide gross?

2.49 The file contains data on the calories
and total fat (in grams per serving) for a sample of 12
veggie burgers.
Source: Data extracted from “Healthful Burgers That Taste Good,”
Consumer Reports, June 2008, p 8.

a. Construct a scatter plot with calories on the X axis and
total fat on the Y axis.

b. What conclusions can you reach about the relationship
between the calories and total fat in veggie burgers?

2.50 College basketball is big business, with coaches’
salaries, revenues, and expenses in millions of dollars. The
file contains the coaches’ salary and rev-
enue for college basketball at 60 of the 65 schools that
played in the 2009 NCAA men’s basketball tournament
(data extracted from “Compensation for Division 1 Men’s
Basketball Coaches,” USA Today, April 2, 2010, p. 8C; and
C. Isadore, “Nothing but Net: Basketball Dollars by
School,” money.cnn.com/2010/03/18/news/companies/
basketball_profits/).
a. Do you think schools with higher revenues also have

higher coaches’ salaries?
b. Construct a scatter plot with revenue on the X axis and

coaches’ salaries on the Y axis.
c. Does the scatter plot confirm or contradict your answer

to (a)?

2.51 College football players trying out for the NFL are
given the Wonderlic standardized intelligence test. The file

contains the average Wonderlic scores of foot-
ball players trying out for the NFL and the graduation rate
for football players at selected schools (data extracted from
S. Walker, “The NFL’s Smartest Team,” The Wall Street
Journal, September 30, 2005, pp. W1, W10).
a. Construct a scatter plot with average Wonderlic score on

the X axis and graduation rate on the Y axis.
b. What conclusions can you reach about the relationship be-

tween the average Wonderlic score and graduation rate?

2.52 How have stocks performed in the past? The follow-
ing table presents the data stored in that
shows the performance of a broad measure of stocks (by

Stock Performance

Wonderlic

College Basketball

VeggieBurger

Title
First

Weekend
U.S.

Gross
Worldwide

Gross

Sorcerer’s Stone 90.295 317.558 976.458
Chamber of Secrets 88.357 261.988 878.988
Prisoner of Azkaban 93.687 249.539 795.539
Goblet of Fire 102.335 290.013 896.013
Order of the Phoenix 77.108 292.005 938.469
Half-Blood Prince 77.836 301.460 934.601

Source: Data extracted from www.the-numbers.com/interactive/
comp-Harry-Potter.php.

a. Construct a scatter plot with first weekend gross on the
X axis and U.S. gross on the Y axis.

b. Construct a scatter plot with first weekend gross on the
X axis and worldwide gross on the Y axis.

X: 7 5 8 3 6 0 2 4 9 5 8
Y: 1 5 4 9 8 0 6 2 7 5 4

a. Construct a scatter plot.
b. Is there a relationship between X and Y? Explain.

2.47 The following is a series of annual sales (in millions
of dollars) over an 11-year period (2000 to 2010):

Year: 2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 2010
Sales: 13.0 17.0 19.0 20.0 20.5 20.5 20.5 20.0 19.0 17.0 13.0

a. Construct a time-series plot.
b. Does there appear to be any change in annual sales over

time? Explain.

APPLYING THE CONCEPTS

2.48 Movie companies need to predict the gross
receipts of individual movies once the movie has

debuted. The following results, stored in , are
the first weekend gross, the U.S. gross, and the worldwide
gross (in millions of dollars) of the six Harry Potter movies
that debuted from 2001 to 2009.

PotterMovies

SELF
Test

www.the-numbers.com/interactive/comp-Harry-Potter.php
www.the-numbers.com/interactive/comp-Harry-Potter.php
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percentage) for each decade from the 1830s through the
2000s:

a. Construct a time-series plot of the stock performance
from the 1830s to the 2000s.

b. Does there appear to be any pattern in the data?

2.53 According to the U.S. Census Bureau, the average
price of a new home declined in 2008 and 2009. The file

contains the average price paid for a newNew Home Prices

home from 1990 to 2009 (extracted from www.census.gov,
March 15, 2010).
a. Construct a time-series plot of new home prices.
b. What pattern, if any, is present in the data?

2.54 The following table uses the data in to
show the yearly amount of solar power installed (in
megawatts) in the United States from 2000 through 2008:

Solar Power

Decade Performance (%)

1830s 2.8
1840s 12.8
1850s 6.6
1860s 12.5
1870s 7.5
1880s 6.0
1890s 5.5
1900s 10.9
1910s 2.2
1920s 13.3
1930s –2.2
1940s 9.6
1950s 18.2
1960s 8.3
1970s 6.6
1980s 16.6
1990s 17.6
2000s* –0.5

* Through December 15, 2009.

Source: Data extracted from T. Lauricella,
“Investors Hope the '10s” Beat the '00s,”
The Wall Street Journal, December 21,
2009, pp. C1, C2.

Year
Amount of Solar 
Power Installed

2000 18
2001 27
2002 44
2003 68
2004 83
2005 100
2006 140
2007 210
2008 250

Source: Data extracted from P. Davidson, “Glut of Rooftop Solar
Systems Sinks Price,” USA Today, January 13, 2009, p. 1B.

a. Construct a time-series plot for the yearly amount of
solar power installed (in megawatts) in the United States.

b. What pattern, if any, is present in the data?

2.55 The file contains the number of audits of cor-
porations with assets of more than $250 million conducted by
the Internal Revenue Service (data extracted from K. McCoy,
“IRS Audits Big Firms Less Often,” USA Today, April 15,
2010, p. 1B).
a. Construct a time-series plot.
b. What pattern, if any, is present in the data?

Audits

2.7 Organizing Multidimensional Data
In this chapter, you have learned methods for organizing and visualizing a single variable and
methods for jointly organizing and visualizing two variables. More and more, businesses need
to organize and visualize more than two variables to mine data to discover possible patterns
and relationships that simpler explorations might miss. While any number of variables can be
used, subject to limits of computation and storage, examples of more than three or four vari-
ables can be hard to interpret when simple tables are used to present results. Both Excel and
Minitab can organize multidimensional data but the two applications have different strengths:
Excel contains PivotTables, a type of interactive table that facilitates exploring multidimen-
sional data, while Minitab has specialized statistical and graphing procedures (that are beyond
the scope of this book to fully discuss).

Multidimensional Contingency Tables
A multidimensional contingency table tallies the responses of three or more categorical
variables. In the simplest case of three categorical variables, each cell in the table contains the tal-
lies of the third variable organized by the subgroups represented by the row and column variables.

www.census.gov
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Consider the Table 2.3 contingency table, which displays the type of fund and whether a
fee is charged for the sample of 184 mutual funds. Figure 2.17 presents this table as an Excel
PivotTable. Adding a third categorical variable, Risk, to the PivotTable, forms the new
multidimensional PivotTable shown in Figure 2.18. The new table reveals that following pat-
terns that cannot be seen in the original Table 2.3 contingency table:

• Although the ratio of fee–yes to fee–no bond funds for the intermediate government cate-
gory seems to be about 2 to 3 (34 to 53), the ratio for above-average-risk intermediate gov-
ernment bond funds is about 1 to 1 (15 to 14) while the ratio for below average-risk funds
is less than 1 to 3 (6 to 20).

• While the group “short-term corporate funds that charge a fee” has nearly equal num-
bers of above-average-risk, average-risk, and below-average-risk funds (7, 7, and 6), the
group “intermediate government bond funds that charge a fee” contains many fewer be-
low-average-risk funds (6) than average risk (13) or above-average (15) ones.

• The pattern of risk tallies differs between the fee–yes and fee–no funds in each of the
bond fund categories.

F I G U R E 2 . 1 7
Excel PivotTable version
of the Table 2.3
contingency table

F I G U R E 2 . 1 8
Excel and Minitab multidimensional contingency table of type, risk, and fees

Using methods presented in
later chapters, you can
confirm whether these first
impressions are statistically
significant.

Adding Numerical Variables
Multidimensional contingency tables can contain numerical variables. When you add a numer-
ical variable to a multidimensional analysis, you use categorical variables or variables that
represent units of time for the rows and columns that will form the subgroups by which the
numerical variable will be analyzed.

For example, Figure 2.19 on page 62 shows a table that cross classifies fees and type in
which the cell amounts are the sums of the asset variable for each subgroup, and Figure 2.20
on page 62 shows the same table formatted to show percentages of assets. Comparing Figure
2.21—the table shown in Figure 2.17 but formatted for percentage of the overall total—to
Figure 2.20 shows that the percentage of assets for the intermediate government funds by fee
category does not mimic the fees category percentages.
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F I G U R E 2 . 1 9
Excel and Minitab multidimensional contingency table of type, fees, and sums of assets

F I G U R E 2 . 2 0
Multidimensional
contingency table 
of type of fund, fee
category, and
percentages of assets

F I G U R E 2 . 2 1
Contingency table 
of type and percentages
of fees

F I G U R E 2 . 2 2
Excel and Minitab multidimensional contingency table of type, risk, fees, and the mean 2009 rates of return

When you include a numerical variable, you typically compute one of the numerical
descriptive statistics discussed in Sections 3.1 and 3.2. For example, Figure 2.22 shows a
multidimensional contingency table in which the mean, or average 2009 rate of return for each
of the subgroups, is computed.1 This table reveals, among other things, that although there was
virtually no difference in the 2009 return depending on whether a fee was charged, for funds
with above-average risk, the return was much higher (4.89) for intermediate government funds
that charged a fee than for funds that did not charge a fee (1.41).

1 See Section 3.1 to learn more about
the mean.
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Problems for Section 2.7
APPLYING THE CONCEPTS

2.56 For this problem, use the data in
.

a. Construct a table that tabulates type, fees, and risk.
b. What conclusions can you reach concerning differences

among the types of mutual funds (intermediate govern-
ment and short-term corporate), based on fees (yes or no)
and the risk factor (low, average, and high)?

c. Compare the results of (b) with those shown in
Figure 2.18.

2.57 For this problem, use the data in .
a. Construct a table that tabulates category, objective, and

fees.
b. What conclusions can you reach concerning differences

among the categories of mutual funds (large cap, medium
cap, and small cap), based on objective (growth and
value) and fees (yes and no)?

Mutual Funds

BondFunds2008
SELF
Test

2.58 For this problem, use the data in .
a. Construct a table that tabulates category, fees, and risk.
b. What conclusions can you reach concerning differences

among the categories of mutual funds (large cap, medium
cap, and small cap), based on fees (yes and no) and the
risk factor (low, average, and high)?

2.59 For this problem, use the data in .
a. Construct a table that tabulates category, objective, fees,

and risk.
b. What conclusions can you reach concerning differences

among the categories of mutual funds (large cap, medium
cap, and small cap), based on objective (growth and
value), the risk factor (low, average, and high), and fees
(yes and no)?

c. Which table do you think is easier to interpret, the one in
this problem or the ones in Problems 2.56 and 2.57?
Explain.

Mutual Funds

Mutual Funds

2.8 Misuses and Common Errors in Visualizing Data
Good graphical displays clearly and unambiguously reveal what the data convey. Unfortu-
nately, many graphs presented in the media (broadcast, print, and online) are incorrect,
misleading, or so unnecessarily complicated that they should never be used. To illustrate the
misuse of graphs, the chart presented in Figure 2.23 is similar to one that was printed in
Time magazine as part of an article on increasing exports of wine from Australia to the
United States.

F I G U R E 2 . 2 3
“Improper” display of
Australian wine exports
to the United States, in
millions of gallons

Source: Based on 
S. Watterson, “Liquid Gold—
Australians Are Changing the
World of Wine. Even the
French Seem Grateful,” Time,
November 22, 1999, p. 68.

In Figure 2.23, the wineglass icon representing the 6.77 million gallons for 1997 does not
appear to be almost twice the size of the wineglass icon representing the 3.67 million gallons
for 1995, nor does the wineglass icon representing the 2.25 million gallons for 1992 appear to
be twice the size of the wineglass icon representing the 1.04 million gallons for 1989. Part of
the reason for this is that the three-dimensional wineglass icon is used to represent the two
dimensions of exports and time. Although the wineglass presentation may catch the eye, the
data should instead be presented in a summary table or a time-series plot.

In addition to the type of distortion created by the wineglass icons in the Time magazine
graph displayed in Figure 2.23, improper use of the vertical and horizontal axes leads to
distortions. Figure 2.24 presents another graph used in the same Time magazine article.
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F I G U R E 2 . 2 4
“Improper” display of
amount of land planted
with grapes for the wine
industry

Source: Based on 
S. Watterson, “Liquid Gold—
Australians Are Changing the
World of Wine. Even the
French Seem Grateful,” Time,
November 22, 1999, pp.
68–69.

There are several problems in this graph. First, there is no zero point on the vertical axis.
Second, the acreage of 135,326 for 1949–1950 is plotted above the acreage of 150,300 for
1969–1970. Third, it is not obvious that the difference between 1979–1980 and 1997–1998
(71,569 acres) is approximately 3.5 times the difference between 1979–1980 and 1969–1970
(21,775 acres). Fourth, there are no scale values on the horizontal axis. Years are plotted next
to the acreage totals, not on the horizontal axis. Fifth, the values for the time dimension are not
properly spaced along the horizontal axis. For example, the value for 1979–1980 is much
closer to 1989–1990 than it is to 1969–1970. Other types of eye-catching displays that you typ-
ically see in magazines and newspapers often include information that is not necessary and
just adds excessive clutter. Figure 2.25 represents one such display.

F I G U R E 2 . 2 5
“Improper” plot of
market share of soft
drinks

Source: Based on Anne B.
Carey and Sam Ward, “Coke
Still Has Most Fizz,” USA
Today, May 10, 2000, p. 1B.

The graph in Figure 2.25 shows the products with the largest market share for soft drinks.
The graph suffers from too much clutter, although it is designed to show the differences in
market share among the soft drinks. The display of the fizz for each soft drink takes up too
much of the graph relative to the data. The same information could be better conveyed with a
bar chart or pie chart.

The following are some guidelines for developing good graphs:

• A graph should not distort the data.
• A graph should not contain chartjunk, unnecessary adornments that convey no useful

information.
• Any two-dimensional graph should contain a scale for each axis.
• The scale on the vertical axis should begin at zero.

…they’re growing more…

Amount of land planted with grapes for the wine industry

1949–1950
135,326

acres

1959–1960
130,201

acres

1969–1970
150,300

acres

1979–1980
172,075

acres

1989–1990
146,204

acres

1997–1998
243,644

acres

Coke still has most fizz
Carbonated soft drinks with the biggest 
share of the $58 billion market last year:

Coke Classic
20%

Pepsi-Cola
14%

Mountain
Dew
7%

Diet
Coke
9% Sprite

7%
Dr Pepper

6%
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• All axes should be properly labeled.
• The graph should contain a title.
• The simplest possible graph should be used for a given set of data.

Often individuals unaware of how to construct appropriate graphs violate these guidelines.
Some applications, including Excel, tempt you to create “pretty” charts that may be fancy in
their designs but that represent unwise choices. For example, making a simple pie chart fancier
by adding exploded 3D slices is unwise as this can complicate a viewer’s interpretation of the
data. Uncommon chart choices such as doughnut, radar, surface, bubble, cone, and pyramid
charts may look visually striking, but in most cases they obscure the data.

Problems for Section 2.8
APPLYING THE CONCEPTS
2.60 (Student Project) Bring to class a chart from either a
website, newspaper, or magazine published this month that
you believe to be a poorly drawn representation of a numeri-
cal variable. Be prepared to submit the chart to the instructor
with comments about why you believe it is inappropriate. Do
you believe that the intent of the chart is to purposely mis-
lead the reader? Also, be prepared to present and comment
on this in class.

2.61 (Student Project) Bring to class a chart from either a
website, newspaper, or magazine published this month that
you believe to be a poorly drawn representation of a categor-
ical variable. Be prepared to submit the chart to the instruc-
tor with comments about why you consider it inappropriate.
Do you believe that the intent of the chart is to purposely
mislead the reader? Also, be prepared to present and com-
ment on this in class.

2.62 (Student Project) According to its home page,
Swivel is “Swivel is a website where people share reports of
charts and numbers. Businesses use Swivel to dashboard
their metrics. Students use Swivel to find and share research
data.” Go to www.swivel.com and explore some of the vari-
ous graphical displays.
a. Select a graphical display that you think does a good job

revealing what the data convey. Discuss why you think it
is a good graphical display.

b. Select a graphical display that you think needs a lot of
improvement. Discuss why you think that it is a poorly
constructed graphical display.

2.63 The following visual display contains an overembell-
ished chart similar to one that appeared in USA Today,
dealing with the average consumer’s Valentine’s Day spend-
ing (“USA Today Snapshots: The Price of Romance,” USA
Today, February 14, 2007, p. 1B).

a. Describe at least one good feature of this visual display.
b. Describe at least one bad feature of this visual display.
c. Redraw the graph, using the guidelines given on page 64

and above.

2.64 The following visual display contains an overembell-
ished chart similar to one that appeared in USA Today,
dealing with the estimated number of hours the typical
American spends using various media (“USA Today
Snapshots: Minding Their Media,” USA Today, March 2,
2007, p. 1B).

www.swivel.com


In the Using Statistics scenario, you were hired by the Choice Is Yours
investment company to assist clients who seek to invest in mutual
funds. A sample of 184 bond mutual funds was selected, and infor-
mation on the funds and past performance history was recorded. For

each of the 184 funds, data were collected on eight variables. With so much
information, visualizing all these numbers required the use of properly
selected graphical displays.

From bar charts and pie charts, you were able to illustrate that about one-third of the funds
were classified as having below-average risk, about one-third had average risk, and about one-
third had above-average risk. Cross tabulations of the funds by whether the fund charged a fee
and whether the fund invested in intermediate government bonds or short-term corporate
bonds revealed that intermediate government bond funds are more likely to charge fees. After
constructing histograms on the 2009 return, you were able to conclude that the returns were
much higher for the short-term corporate bond funds than for the intermediate government
bonds. The return for intermediate government bond funds is concentrated between 0 and 10,
whereas the return for the short-term corporate bond funds is concentrated between 5 and 15.

With these insights, you can inform your clients about how the different funds performed.
Of course, past performance history does not guarantee future performance. In fact, if you look
at returns in 2008, stored in , you will discover that the returns were much
lower for the short-term corporate bond funds than for the intermediate government bonds!

BondFunds2008
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a. Describe at least one good feature of this visual display.
b. Describe at least one bad feature of this visual display.
c. Redraw the graph, using the guidelines given on pages

64–65.

2.65 The following visual display contains an overembell-
ished chart similar to one that appeared in USA Today, dealing
with which card is safer to use (“USA Today Snapshots: Credit
Card vs. Debit Card,” USA Today, March 14, 2007, p. 1B).

corporations (see D. Rosato, “Worried About the Num-
bers? How About the Charts?” The New York Times, Sep-
tember 15, 2002, p. B7) and found that even slight
distortions in a chart changed readers’ perception of the in-
formation. Using Internet or library sources, select a cor-
poration and study the most recent annual report. Find at
least one chart in the report that you think needs improve-
ment and develop an improved version of the chart.
Explain why you believe the improved chart is better than
the one included in the annual report.

2.67 Figures 2.1 and 2.3 show a bar chart and a pie chart
for how adults pay their monthly bills (see pages 42 and 43).
a. Create an exploded pie chart, a doughnut chart, a cone

chart, or a pyramid chart that shows how adults pay their
monthly bills.

b. Which graphs do you prefer—the bar chart or pie chart
or the exploded pie chart, doughnut chart, cone chart,
and pyramid chart? Explain.

2.68 Figures 2.2 and 2.4 show a bar chart and a pie chart
for the risk level for the bond fund data (see pages 43 and
44).
a. Create an exploded pie chart, a doughnut chart, a cone

chart, and a pyramid chart that shows the risk level of
bond funds.

b. Which graphs do you prefer—the bar chart or pie chart
or the exploded pie chart, doughnut chart, cone chart,
and pyramid chart? Explain.

a. Describe at least one good feature of this visual display.
b. Describe at least one bad feature of this visual display.
c. Redraw the graph, using the guidelines given on pages

64–65.

2.66 Professor Deanna Oxender Burgess of Florida Gulf
Coast University conducted research on annual reports of

U S I N G S TAT I S T I C S @ Choice Is Yours, Part I Revisited
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S U M M A R Y
Organizing and visualizing data involves using various
tables and charts to help draw conclusions about data. In
several different chapter examples, tables and charts helped
you reach conclusions about how people prefer to pay their
bills and about the cost of restaurant meals in a city and its
suburbs; they also provided some insights about the sample
of bond mutual funds in the Using Statistics scenario.

The tables and charts you use depend on the type of data
you have. Table 2.19 summarizes the proper choices for
the type of data and the tables and charts discussed in
this chapter. In Chapter 3 you will learn about a variety
of descriptive statistics useful for data analysis and
interpretation.

T A B L E 2 . 1 9

Selecting Tables and Charts

Type of Data

Type of Analysis Numerical Categorical

Organizing data Ordered array, frequency distribution,
relative frequency distribution,
percentage distribution, cumulative
percentage distribution (Section 2.3)

Summary table, contingency
table (Section 2.2)

Visualizing one variable Stem-and-leaf display, histogram,
percentage polygon, cumulative
percentage polygon (ogive)
(Section 2.5)

Bar chart, pie chart, Pareto
chart (Section 2.4)

Visualizing two variables Scatter plot, time-series plot 
(Section 2.6)

Side-by-side bar chart
(Section 2.4)

Organizing  multidimensional 
data

Multidimensional tables (Section 2.7) Multidimensional tables
(Section 2.7)

Using graphical methods such as these is an important first step in summarizing and inter-
preting data. Although the proper display of data (as discussed in Section 2.8) helps to avoid
ambiguity, graphical methods always contain a certain degree of subjectivity. Next, you will need
descriptive statistics to further analyze the past performance of the mutual funds. Chapter 3
presents descriptive statistics (e.g., mean, median, and mode).

K E Y E Q U AT I O N S
Determining the Class Interval Width

(2.1)

Computing the Proportion or Relative Frequency

(2.2)Proportion = relative frequency =
number of values in each class

total number of values

Interval width =
highest value - lowest value

number of classes



Revenue Category Percentage (%)

Publisher 64.8
Manufacturing costs 32.3
Marketing and promotion 15.4
Administrative costs and taxes 10.0
After-tax profit 7.1

Bookstore 22.4
Employee salaries and benefits 11.3
Operations 6.6
Pretax profit 4.5

Author 11.6
Freight 1.2

Source: Data extracted from T. Lewin, “When Books Break the
Bank,” The New York Times, September 16, 2003, pp. B1, B4.
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K E Y T E R M S
analyze 28
bar chart 42
cells 31
chartjunk 64
classes 35
class boundaries 35
class interval 35
class interval width 35
class midpoints 36
collect 28
contingency table 30
cumulative percentage 

distribution 38
cumulative percentage polygon

(ogive) 53

data collection 28
DCOVA 28
define 28
frequency distribution 35
histogram 50
multidimensional contingency

table 60
ogive (cumulative percentage

polygon) 53
ordered array 34
organize 28
Pareto chart 44
Pareto principle 44
percentage distribution 37
percentage polygon 51

pie chart 43
PivotTable 60
primary data source 28
proportion 37
relative frequency 37
relative frequency distribution 37
scatter plot 56
secondary data source 28
side-by-side bar chart 46
stacked 34
stem-and-leaf display 49
summary table 30
time-series plot 58
unstacked 34
visualize 28

C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING
2.69 How do histograms and polygons differ in their con-
struction and use?

2.70 Why would you construct a summary table?

2.71 What are the advantages and disadvantages of using
a bar chart, a pie chart, and a Pareto chart?

2.72 Compare and contrast the bar chart for categorical
data with the histogram for numerical data.

2.73 What is the difference between a time-series plot and
a scatter plot?

2.74 Why is it said that the main feature of a Pareto chart is
its ability to separate the “vital few” from the “trivial many”?

2.75 What are the three different ways to break down the
percentages in a contingency table?

2.76 How can a multidimensional table differ from a two
variable contingency table?

2.77 What type of insights can you gain from a three-way
table that are not available in a two-way table?

APPLYING THE CONCEPTS

2.78 The following summary table presents the breakdown
of the price of a new college textbook:

a. Using the four categories publisher, bookstore, author,
and freight, construct a bar chart, a pie chart, and a
Pareto chart.

b. Using the four subcategories of publisher and three sub-
categories of bookstore, along with the author and freight
categories, construct a Pareto chart.

c. Based on the results of (a) and (b), what conclusions can
you reach concerning who gets the revenue from the
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sales of new college textbooks? Do any of these results
surprise you? Explain.

2.79 The following table represents the market share (in
number of movies, gross in millions of dollars, and in
number of tickets sold in millions) of each type of movie
in 2009:

Type Number
Gross

($ millions)
Tickets

(millions)

Based on 
book/short story

66 2042.9 272.4

Based on 
comic/graphic
novel

6 376.2 50.2

Based on factual
book/article

5 280.7 37.4

Based on game 3 9.2 1.2
Based on 

musical/opera
1 13.7 1.8

Based on play 8 172.0 22.9
Based on real life 

events
95 334.9 44.7

Based on toy 1 150.2 20.0
Based on TV 7 267.5 35.7
Compilation 1 0.6 0.1
Original screenplay 203 4,335.7 578.1
Remake 18 422.6 56.3
Sequel 20 2,064.2 275.2
Spin-off 1 179.9 24.0

Source: Data extracted from www.the-numbers.com/market/
Sources2009.php.

Copyediting as Compared
to Print Content Percentage

As rigorous 41
Less rigorous 48
Not copyedited 11

Fact Checking as Compared
to Print Content Percentage

Same 57
Less rigorous 27
Online not fact checked 8
Neither online nor print is 

fact-checked 8

Source: Data extracted from S. Clifford, “Columbia Survey Finds a
Slack Editing Process of Magazine Web Sites,” The New York Times,
March 1, 2010, p. B6.

2.81 The owner of a restaurant that serves Continental-
style entrées has the business objective of learning more
about the patterns of patron demand during the Friday-
to-Sunday weekend time period. Data were collected from
630 customers on the type of entrée ordered and organized
in the following table:

Type of Entrée Number Served

Beef 187
Chicken 103
Mixed 30
Duck 25
Fish 122
Pasta 63
Shellfish 74
Veal 26
Total 630

a. Construct a bar chart, a pie chart, and a Pareto chart for
the number of movies, gross (in millions of dollars), and
number of tickets sold (in millions).

b. What conclusions can you reach about the market share
of the different types of movies in 2009?

2.80 A survey was conducted from 665 consumer
magazines on the practices of their websites. The results are
summarized in a copyediting table and a fact-checking table:

a. For copyediting, construct a bar chart, a pie chart, and a
Pareto chart.

b. Which graphical method do you think is best for portray-
ing these data?

a. Construct a percentage summary table for the types of
entrées ordered.

b. Construct a bar chart, a pie chart, and a Pareto chart for
the types of entrées ordered.

c. Do you prefer using a Pareto chart or a pie chart for these
data? Why?

d. What conclusions can the restaurant owner reach con-
cerning demand for different types of entrées?

2.82 Suppose that the owner of the restaurant in Problem
2.81 also wanted to study the demand for dessert during the
same time period. She decided that in addition to studying
whether a dessert was ordered, she would also study the

c. For fact checking, construct a bar chart, a pie chart, and a
Pareto chart.

d. Which graphical method do you think is best for portray-
ing these data?

e. What conclusions can you reach concerning copy
editing and fact checking of print and online consumer
magazines?

www.the-numbers.com/market/Sources2009.php
www.the-numbers.com/market/Sources2009.php
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DESSERT ORDERED

GENDER

Male Female Total

Yes 40 96 136
No 240 224 464
Total 280 320 600

DESSERT ORDERED

BEEF ENTRÉE

Yes No Total

Yes 71 65 136
No 116 348 464
Total 187 413 600

COUNTRY

FRESH FOOD
United
States Japan Russia

Eggs, nuts, and beans 88 94 88
Fruit 124 126 88
Meat and seafood 197 146 125
Vegetables 194 278 335

a. For each of the two contingency tables, construct contin-
gency tables of row percentages, column percentages,
and total percentages.

b. Which type of percentage (row, column, or total) do you
think is most informative for each gender? For beef
entrée? Explain.

c. What conclusions concerning the pattern of dessert
ordering can the restaurant owner reach?

2.83 The following data represent the pounds per capita of
fresh food and packaged food consumed in the United
States, Japan, and Russia in 2009:

b. For the United States, Japan, and Russia, construct a bar
chart, a pie chart, and a Pareto chart for different types of
packaged foods consumed.

c. What conclusions can you reach concerning differences
between the United States, Japan, and Russia in the fresh
foods and packaged foods consumed?

2.84 In 2000, a growing number of warranty claims on
Firestone tires sold on Ford SUVs prompted Firestone and
Ford to issue a major recall. An analysis of warranty claims
data helped identify which models to recall. A breakdown of
2,504 warranty claims based on tire size is given in the
following table:

Tire Size Number of Warranty Claims

23575R15 2,030
311050R15 137
30950R15 82
23570R16 81
331250R15 58
25570R16 54
Others 62

Source: Data extracted from Robert L. Simison, “Ford Steps
Up Recall Without Firestone,” The Wall Street Journal,
August 14, 2000, p. A3.

COUNTRY

PACKAGED FOOD
United
States Japan Russia

Bakery goods 108 53 144
Dairy products 298 147 127
Pasta 12 32 16
Processed, frozen,

dried and chilled 
food, and ready-
to-eat meals

183 251 70

Sauces, dressings,
and condiments

63 75 49

Snacks and candy 47 19 24
Soup and canned 

food
77 17 25

Source: Data extracted from H. Fairfield, “Factory Food,” The New
York Times, April 4, 2010, p. BU5.

gender of the individual and whether a beef entrée was
ordered. Data were collected from 600 customers and
organized in the following contingency tables:

a. For the United States, Japan, and Russia, construct a bar
chart, a pie chart, and a Pareto chart for different types of
fresh foods consumed.

The 2,030 warranty claims for the 23575R15 tires can be
categorized into ATX models and Wilderness models. The
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a. Construct a Pareto chart for the number of warranty
claims by tire size. What tire size accounts for most of
the claims?

b. Construct a pie chart to display the percentage of the
total number of warranty claims for the 23575R15 tires
that come from the ATX model and Wilderness model.
Interpret the chart.

c. Construct a Pareto chart for the type of incident causing
the warranty claim for the ATX model. Does a certain
type of incident account for most of the claims?

d. Construct a Pareto chart for the type of incident causing
the warranty claim for the Wilderness model. Does a cer-
tain type of incident account for most of the claims?

2.85 One of the major measures of the quality of service
provided by an organization is the speed with which the or-
ganization responds to customer complaints. A large fam-
ily-held department store selling furniture and flooring,
including carpet, had undergone a major expansion in the
past several years. In particular, the flooring department
had expanded from 2 installation crews to an installation
supervisor, a measurer, and 15 installation crews. A busi-
ness objective of the company was to reduce the time be-
tween when the complaint is received and when it is
resolved. During a recent year, the company received 50
complaints concerning carpet installation. The data from
the 50 complaints, stored in , represent the num-
ber of days between the receipt of the complaint and the
resolution of the complaint:

Furniture

c. Construct a cumulative percentage distribution and plot a
cumulative percentage polygon (ogive).

d. On the basis of the results of (a) through (c), if you had
to tell the president of the company how long a customer
should expect to wait to have a complaint resolved, what
would you say? Explain.

2.86 The file contains the percentage alco-
hol, number of calories per 12 ounces, and number of
carbohydrates (in grams) per 12 ounces for 139 of the best-
selling domestic beers in the United States.
Source: Data extracted from www.Beer100.com, March 18, 2010.

a. Construct a percentage histogram for each of the three
variables.

b. Construct three scatter plots: percentage alcohol versus
calories, percentage alcohol versus carbohydrates, and
calories versus carbohydrates.

c. Discuss what you learn from studying the graphs in (a)
and (b).

2.87 The file contains the state cigarette tax
($) for each state as of December 31, 2009.
a. Construct an ordered array.
b. Plot a percentage histogram.
c. What conclusions can you reach about the differences in

the state cigarette tax between the states?

2.88 The file contains the yields for a
money market account and a five-year certificate of deposit
(CD) for 25 banks in the United States, as of March 29,
2010.
Source: Data extracted from www.Bankrate.com, March 29, 2010.

a. Construct a stem-and-leaf display for each variable.
b. Construct a scatter plot of money market account versus

five-year CD.
c. What is the relationship between the money market rate

and the five-year CD rate?

2.89 The file includes the total com-
pensation (in millions of $) of CEOs of 197 large public
companies and the investment return in 2009.
Source: Data extracted from D. Leonard, “Bargains in the
Boardroom,” The New York Times, April 4, 2010, pp. BU1, BU7,
BU10, BU11.

a. Construct a frequency distribution and a percentage
distribution.

b. Construct a histogram and a percentage polygon.
c. Construct a cumulative percentage distribution and plot a

cumulative percentage polygon (ogive).
d. Based on (a) through (c), what conclusions can you reach

concerning CEO compensation in 2009?
e. Construct a scatter plot of total compensation and invest-

ment return in 2009.
f. What is the relationship between the total compensation

and investment return in 2009?

CEO-Compensation

SavingsRate-MMCD

CigaretteTax

DomesticBeer

54 5 35 137 31 27 152 2 123 81 74 27
11 19 126 110 110 29 61 35 94 31 26 5
12 4 165 32 29 28 29 26 25 1 14 13
13 10 5 27 4 52 30 22 36 26 20 23
33 68

a. Construct a frequency distribution and a percentage
distribution.

b. Construct a histogram and a percentage polygon.

type of incident leading to a warranty claim, by model type,
is summarized in the following table:

Incident Type
ATX Model 

Warranty Claims
Wilderness

Warranty Claims

Tread
separation 1,365 59

Blowout 77 41
Other/

unknown 422 66
Total 1,864 166

Source: Data extracted from Robert L. Simison, “Ford Steps Up Recall
Without Firestone,” The Wall Street Journal, August 14, 2000, p. A3.

www.Beer100.com
www.Bankrate.com


2.90 Studies conducted by a manufacturer of Boston and
Vermont asphalt shingles have shown product weight to
be a major factor in customers’ perception of quality.
Moreover, the weight represents the amount of raw materi-
als being used and is therefore very important to the com-
pany from a cost standpoint. The last stage of the assembly
line packages the shingles before the packages are placed on
wooden pallets. The variable of interest is the weight in
pounds of the pallet which for most brands holds 16 squares
of shingles. The company expects pallets of its Boston
brand-name shingles to weigh at least 3,050 pounds but less
than 3,260 pounds. For the company’s Vermont brand-name
shingles, pallets should weigh at least 3,600 pounds but less
than 3,800. Data are collected from a sample of 368 pallets
of Boston shingles and 330 pallets of Vermont shingles and
stored in .
a. For the Boston shingles, construct a frequency distribu-

tion and a percentage distribution having eight class
intervals, using 3,015, 3,050, 3,085, 3,120, 3,155, 3,190,
3,225, 3,260, and 3,295 as the class boundaries.

b. For the Vermont shingles, construct a frequency distribu-
tion and a percentage distribution having seven class in-
tervals, using 3,550, 3,600, 3,650, 3,700, 3,750, 3,800,
3,850, and 3,900 as the class boundaries.

c. Construct percentage histograms for the Boston shingles
and for the Vermont shingles.

d. Comment on the distribution of pallet weights for the
Boston and Vermont shingles. Be sure to identify the
percentage of pallets that are underweight and overweight.

2.91 What was the average price of a room at two-star,
three-star, and four-star hotels in cities around the world in
2009? The file contains the prices in English
pounds (about US $1.57 as of October 2010). Complete the
following for two-star, three-star, and four-star hotels.
Source: Data extracted from www.hotels.com/press/hotel-
price-index-2009-h2.html.

a. Construct a frequency distribution and a percentage
distribution.

b. Construct a histogram and a percentage polygon.
c. Construct a cumulative percentage distribution and plot a

cumulative percentage polygon (ogive).
d. What conclusions can you reach about the cost of two-

star, three-star, and four-star hotels?
e. Construct separate scatter plots of the cost of two-star

hotels versus three-star hotels, two-star hotels versus
four-star hotels, and three-star hotels versus four-star
hotels.

f. What conclusions can you reach about the relationship of
the price of two-star, three-star, and four-star hotels?

2.92 The file contains calorie and cholesterol
information concerning popular protein foods (fresh red
meats, poultry, and fish).
Source: U.S. Department of Agriculture.

Protein

HotelPrices

Pallet

a. Construct a percentage histogram for the number of
calories.

b. Construct a percentage histogram for the amount of
cholesterol.

c. What conclusions can you reach from your analyses in
(a) and (b)?

2.93 The file contains the monthly average
price of gasoline in the United States from January 1, 2006,
to March 1, 2010. Prices are in dollars per gallon.
Source: “Energy Information Administration,” www.eia.doe.gov,
March 26, 2010.

a. Construct a time-series plot.
b. What pattern, if any, is present in the data?

2.94 The following data (stored in ) represent the
amount of soft drink in a sample of 50 consecutively filled
2-liter bottles. The results are listed horizontally in the order
of being filled:

Drink

Gas Prices

72 CHAPTER 2 Organizing and Visualizing Data

2.109 2.086 2.066 2.075 2.065 2.057 2.052 2.044 2.036 2.038
2.031 2.029 2.025 2.029 2.023 2.020 2.015 2.014 2.013 2.014
2.012 2.012 2.012 2.010 2.005 2.003 1.999 1.996 1.997 1.992
1.994 1.986 1.984 1.981 1.973 1.975 1.971 1.969 1.966 1.967
1.963 1.957 1.951 1.951 1.947 1.941 1.941 1.938 1.908 1.894

a. Construct a time-series plot for the amount of soft drink
on the Y axis and the bottle number (going consecutively
from 1 to 50) on the X axis.

b. What pattern, if any, is present in these data?
c. If you had to make a prediction about the amount of soft

drink filled in the next bottle, what would you predict?
d. Based on the results of (a) through (c), explain why it is

important to construct a time-series plot and not just a
histogram, as was done in Problem 2.45 on page 56.

2.95 The S&P 500 Index tracks the overall movement of
the stock market by considering the stock prices of 500
large corporations. The file contains weekly
data for this index as well as the daily closing stock prices
for three companies from January 2, 2009, to December 28,
2009. The following variables are included:

WEEK—Week ending on date given
S&P—Weekly closing value for the S&P 500 Index
GE—Weekly closing stock price for General Electric
DISC—Weekly closing stock price for Discovery

Communications
AAPL—Weekly closing stock price for Apple

Source: Data extracted from finance.yahoo.com, March 26, 2010.

a. Construct time-series plots for the weekly closing values
of the S&P 500 Index, General Electric, Discovery, and
Apple.

b. Explain any patterns present in the plots.
c. Write a short summary of your findings.

2.96 (Class Project) Have each student in the class
respond to the question “Which carbonated soft drink do

Stock Prices

www.eia.doe.gov
www.eia.doe.govwww.hotels.com/press/hotelprice-index-2009-h2.html
www.eia.doe.govwww.hotels.com/press/hotelprice-index-2009-h2.html
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you most prefer?” so that the instructor can tally the results
into a summary table.
a. Convert the data to percentages and construct a Pareto

chart.
b. Analyze the findings.

2.97 (Class Project) Let each student in the class be
cross-classified on the basis of gender (male, female) and
current employment status (yes, no) so that the instructor
can tally the results.
a. Construct a table with either row or column percentages,

depending on which you think is more informative.
b. What would you conclude from this study?
c. What other variables would you want to know regarding

employment in order to enhance your findings?

REPORT WRITING EXERCISES

2.98 Referring to the results from Problem 2.90 on page 72
concerning the weight of Boston and Vermont shingles, write
a report that evaluates whether the weight of the pallets of
the two types of shingles are what the company expects. Be
sure to incorporate tables and charts into the report.

2.99 Referring to the results from Problem 2.84 on page 70
concerning the warranty claims on Firestone tires, write a re-
port that evaluates warranty claims on Firestone tires sold on
Ford SUVs. Be sure to incorporate tables and charts into the
report.

TEAM PROJECT

The file contains information regarding nine
variables from a sample of 184 mutual funds:

Fund number—Identification number for each bond fund
Type—Bond fund type (intermediate government or

short-term corporate)
Assets—In millions of dollars
Fees—Sales charges (no or yes)
Expense ratio—Ratio of expenses to net assets in per-

centage
Return 2009—Twelve-month return in 2009
Three-year return—Annualized return, 2007–2009
Five-year return—Annualized return, 2005–2009
Risk—Risk-of-loss factor of the mutual fund (below

average, average, or above average)

2.100 For this problem, consider the expense ratio.
a. Construct a percentage histogram.
b. Using a single graph, plot percentage polygons of the ex-

pense ratio for bond funds that have fees and bond funds
that do not have fees.

Bond Funds

c. What conclusions about the expense ratio can you reach,
based on the results of (a) and (b)?

2.101 For this problem, consider the three-year annualized
return from 2007 to 2009.
a. Construct a percentage histogram.
b. Using a single graph, plot percentage polygons of the

three-year annualized return from 2007 to 2009 for inter-
mediate government funds and short-term corporate
funds.

c. What conclusions about the three-year annualized return
from 2007 to 2009 can you reach, based on the results of
(a) and (b)?

2.102 For this problem, consider the five-year annualized
return from 2005 to 2009.
a. Construct a percentage histogram.
b. Using a single graph, plot percentage polygons of the five-

year annualized return from 2005 to 2009 for intermediate
government funds and short-term corporate funds.

c. What conclusions about the five-year annualized return
from 2005 to 2009 can you reach, based on the results of
(a) and (b)?

STUDENT SURVEY DATABASE

2.103 Problem 1.27 on the page 14 describes a survey of
62 undergraduate students (stored in ). For
these data, construct all the appropriate tables and charts
and write a report summarizing your conclusions.

2.104 Problem 2.103 describes a survey of 62 undergrad-
uate students (stored in ).
a. Select a sample of undergraduate students at your school

and conduct a similar survey for those students.
b. For the data collected in (a), construct all the appropriate

tables and charts and write a report summarizing your
conclusions.

c. Compare the results of (b) to those of Problem 2.103.

2.105 Problem 1.28 on the page 15 describes a survey of
44 graduate students (see the file ). For these
data, construct all appropriate tables and charts and write a
report summarizing your conclusions.

2.106 Problem 2.105 describes a survey of 44 MBA
students (stored in ).
a. Select a sample of MBA students in your MBA program

and conduct a similar survey for those students.
b. For the data collected in (a), construct all the appropriate

tables and charts and write a report summarizing your
conclusions.

c. Compare the results of (b) to those of Problem 2.105.

GradSurvey

GradSurvey

UndergradSurvey

UndergradSurvey



M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
Recently, Ashland MultiComm Services has been criti-
cized for its inadequate customer service in responding
to questions and problems about its telephone, cable tele-
vision, and Internet services. Senior management has
established a task force charged with the business objec-
tive of improving customer service. In response to this
charge, the task force collected data about the types of
customer service errors, the cost of customer service
errors, and the cost of wrong billing errors. It found the
following data:

Types of Customer Service Errors

Type of Errors Frequency

Incorrect accessory 27
Incorrect address 42
Incorrect contact phone 31
Invalid wiring 9
On-demand programming error 14
Subscription not ordered 8
Suspension error 15
Termination error 22
Website access error 30
Wrong billing 137
Wrong end date 17
Wrong number of connections 19
Wrong price quoted 20
Wrong start date 24
Wrong subscription type 33
Total 448

Cost of Customer Service Errors in the Past Year

Type of Errors Cost ($ thousands)

Incorrect accessory 17.3
Incorrect address 62.4
Incorrect contact phone 21.3
Invalid wiring 40.8
On-demand

programming errors 38.8
Subscription not ordered 20.3
Suspension error 46.8
Termination error 50.9
Website access errors 60.7
Wrong billing 121.7
Wrong end date 40.9
Wrong number of connections 28.1
Wrong price quoted 50.3
Wrong start date 40.8
Wrong subscription type 60.1
Total 701.2

Type and Cost 
of Wrong Billing Errors

Type of Wrong
Billing Errors Cost ($ thousands)

Declined or 
held transactions 7.6

Incorrect
account number 104.3

Invalid
verification 9.8

Total 121.7

1. Review these data (stored in ). Identify the
variables that are important in describing the customer
service problems. For each variable you identify, con-
struct the graphical representation you think is most
appropriate and explain your choice. Also, suggest what
other information concerning the different types of errors
would be useful to examine. Offer possible courses of ac-
tion for either the task force or management to take that
would support the goal of improving customer service.

2. As a follow-up activity, the task force decides to collect
data to study the pattern of calls to the help desk (stored
in ). Analyze these data and present your conclu-
sions in a report.

AMS2-2

AMS2-1
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In the Using Statistics scenario, you were asked to gather
information to help make wise investment choices. Sources
for such information include brokerage firms, investment
counselors, and other financial services firms. Apply your
knowledge about the proper use of tables and charts in this
Digital Case about the claims of foresight and excellence by
an Ashland-area financial services firm.

Open EndRunGuide.pdf, which contains the EndRun Fi-
nancial Services “Guide to Investing.” Review the guide,
paying close attention to the company’s investment claims
and supporting data and then answer the following.

1. How does the presentation of the general information
about EndRun in this guide affect your perception of the
business?

D I G I TA L C A S E
2. Is EndRun’s claim about having more winners than losers

a fair and accurate reflection of the quality of its invest-
ment service? If you do not think that the claim is a fair
and accurate one, provide an alternate presentation that
you think is fair and accurate.

3. Review the discussion about EndRun’s “Big Eight Differ-
ence” and then open and examine , a sample
of mutual funds. Are there any other relevant data from
that file that could have been included in the Big Eight
table? How would the new data alter your perception of
EndRun’s claims?

4. EndRun is proud that all Big Eight funds have gained in
value over the past five years. Do you agree that EndRun
should be proud of its selections? Why or why not?

Mutual Funds

R E F E R E N C E S
1. Huff, D., How to Lie with Statistics (New York: Norton,

1954).
2. Levine, D. and D. Stephan, “Teaching Introductory

Business Statistics Using the DCOVA Framework,”
Decision Science Journal of Innovative Education, Jan-
uary 2011.

3. Microsoft Excel 2010 (Redmond, WA: Microsoft Corpo-
ration, 2010).

4. Minitab Release 16 (State College, PA: Minitab, Inc.,
2010).

5. Tufte, E. R., Beautiful Evidence (Cheshire, CT: Graph-
ics Press, 2006).

6. Tufte, E. R., Envisioning Information (Cheshire, CT:
Graphics Press, 1990).

7. Tufte, E. R., The Visual Display of Quantitative Informa-
tion, 2nd ed. (Cheshire, CT: Graphics Press, 2002).

8. Tufte, E. R., Visual Explanations (Cheshire, CT: Graph-
ics Press, 1997).

9. Wainer, H., Visual Revelations: Graphical Tales of Fate
and Deception from Napoleon Bonaparte to Ross Perot
(New York: Copernicus/Springer-Verlag, 1997).



The DATA worksheet contains unsummarized data. For
data that have already been tallied into categories, click
Table of Frequencies.

In-Depth Excel For data that need to be tallied, use the
PivotTable feature to create a summary table. (For the case
in which data have already been tallied, use the
SUMMARY _SIMPLE worksheet of the Chapter 2
workbook as a model for creating a summary table.)

For example, to create a summary table similar to Table 2.2
on page 30, open to the DATA worksheet of the Bond Funds
workbook and select Insert ➔ PivotTable. In the Create
PivotTable dialog box (shown at the top of the next column):

1. Click Select a table or range and enter I1:I185 as the
Table/Range cell range.

2. Click New Worksheet and then click OK.

In the PivotTable Field List task pane (shown below):

3. Check Risk in the Choose fields to add to report box.

4. Drag the checked Risk label and drop it in the Row La-
bels box. Drag a second copy of this checked Risk label
and drop it in the Values box. This second label
changes to Count of Risk to indicate that a count, or
tally, of the occurrences of each risk category will be
displayed in the PivotTable.

g

C H A P T E R 2 E X C E L G U I D E

EG2.2 ORGANIZING CATEGORICAL DATA

The Summary Table

PHStat2 Use One-Way Tables & Charts to create a sum-
mary table. For example, to create a summary table similar
to Table 2.2 on page 30, open to the DATA worksheet of the
Bond Funds workbook. Select PHStat ➔ Descriptive
Statistics ➔ One-Way Tables & Charts. In the procedure’s
dialog box (shown below):

1. Click Raw Categorical Data.

2. Enter I1:I185 as the Raw Data Cell Range and check
First cell contains label.

3. Enter a Title, check Percentage Column, and click OK.

76
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To add a column for the percentage frequency:

9. Enter Percentage in cell C4. Enter the formula =B5/B$8
in cell C5 and copy it down through row 7.

10. Select cell range C5:E5, right-click, and select Format
Cells in the shortcut menu.

11. In the Number tab of the Format Cells dialog box, select
Percentage as the Category and click OK.

12. Adjust cell borders, if desired (see Appendix F).

The Contingency Table

PHStat2 Use Two-Way Tables & Charts to create a
contingency table for data that need to be tallied. For ex-
ample, to create the Table 2.3 contingency table on page
31, open to the DATA worksheet of the Bond Funds
workbook. Select PHStat ➔ Descriptive Statistics ➔

In the PivotTable being created:

5. Right-click and then click PivotTable Options in the
shortcut menu that appears.

In the PivotTable Options dialog box (shown below):

6. Click the Layout & Format tab.

7. Check For empty cells show and enter 0 as its value.
Leave all other settings unchanged.

8. Click OK to complete the PivotTable.

After the procedure creates the PivotTable, rearrange the or-
der of the “No” and “Yes” columns:

5. Click the Fees drop-down list in cell B3 and select Sort
Z to A.

In-Depth Excel For data that need to be tallied, use the
PivotTable feature to create a contingency table. (For the
case in which data have already been tallied, use the
CONTINGENCY_SIMPLE worksheet of the Chapter 2
workbook as a model for creating a contingency table.)
For example, to create the Table 2.3 contingency table on
page 31, open to the DATA worksheet of the Bond Funds
workbook. Select Insert ➔ PivotTable. In the Create Piv-
otTable dialog box:

1. Click Select a table or range and enter B1:D185 as the
Table/Range cell range. (Although Type is in column B
and Fees is in column D, Excel does not allow you to en-
ter a range comprised of nonadjacent columns.)

2. Click New Worksheet and then click OK.

In the PivotTable Field List task pane (shown at the top of
page 78):

3. Check Type and Fees in the Choose fields to add to
report box.

4. Drag the checked Type label and drop it in the Row
Labels box.

5. Drag a second copy of the check Type label and drop it
in the Values box. (This label changes to Count of
Type.) Then drag the checked Fees label and drop it in
the Column Labels area.

g

Two-Way Tables & Charts. In the procedure’s dialog box
(shown below):

1. Enter B1:B185 as the Row Variable Cell Range.

2. Enter D1:D185 as the Column Variable Cell Range.

3. Check First cell in each range contains label.

4. Enter a Title and click OK.



In the PivotTable being created:

6. Click the Fees drop-down list in cell B3 and select Sort
Z to A to rearrange the order of the “No” and “Yes”
columns.

7. Right-click and then click PivotTable Options in the
shortcut menu that appears.

In the PivotTable Options dialog box:

8. Click the Layout & Format tab.

9. Check For empty cells show and enter 0 as its value.
Leave all other settings unchanged.

10. Click the Total & Filters tab.

11. Check Show grand totals for columns and Show
grand totals for rows.

12. Click OK to complete the table.

EG2.3 ORGANIZING NUMERICAL DATA

Stacked and Unstacked Data

PHStat2 Use Stack Data or Unstack Data to rearrange
data. For example, to unstack the Return 2009 variable in
column F of the DATA worksheet of the Bond Funds
workbook, open to that worksheet. Select Data Prepara-
tion ➔ Unstack Data. In that procedure’s dialog box, enter
B1:B185 (the Type variable cell range) as the Grouping
Variable Cell Range and enter F1:F185 as the Stacked
Data Cell Range. Check First cells in both ranges contain
label and click OK. The unstacked data appears on a new
worksheet.

The Ordered Array

In-Depth Excel To create an ordered array, first select the
data to be sorted. Then select Home ➔ Sort & Filter (in the
Editing group) ➔ Sort Smallest to Largest.

The Frequency Distribution, Part I

To create a frequency distribution, you must first translate
your classes into what Excel calls bins. Bins approximate
the classes of a frequency distribution. Unlike classes, bins
do not have precise lower and upper boundary values. You
establish bins by entering, in ascending order, a list of “bin
numbers” into a column cell range. Each bin number, in
turn, defines a bin: A bin is all the values that are less than
or equal to its bin number and that are greater than the
previous bin number.

Because the first bin number does not have a “previous”
bin number, the first bin can never have a precise lower
boundary value, as a first class always has. A common
workaround to this problem, used in the examples through-
out this book, is to define an extra bin, using a bin number
that is slightly lower than the lower boundary value of the
first class. This extra bin number, appearing first, will allow
the now-second bin number to better approximate the first
class, though at the cost of adding an unwanted bin to the
results.

In this chapter, Tables 2.8 through 2.11 on pages 36
through 38 use class groupings in the form “valueA but less
than valueB.” You can translate class groupings in this form
into nearly equivalent bins by creating a list of bin numbers
that are slightly lower than each valueB that appears in the
class groupings. For example, the Table 2.9 classes on page
36 could be translated into nearly equivalent bins by using
this bin number list: –10.01 (the extra bin number), –5.01
(“slightly less” than –5), –0.01, –0.01, 4.99 (slightly less
than 5), 9.99, 14.99, 19.99, 24.99, 29.99, and 34.99.

For class groupings in the form “all values from valueA
to valueB,” such as the set 0.0 through 4.9, 5.0 through 9.9,
10.0 through 14.9, and 15.0 through 19.9, you can approxi-
mate each class grouping by choosing a bin number slightly
more than each valueB, as in this list of bin numbers: (the
extra bin number), 4.99 (slightly more than 4.9), 9.99,
14.99, and 19.99.

Use an empty column in the worksheet that contains
your untallied data to enter your bin numbers (in ascending
order). Enter Bins in the row 1 cell of that column as the
column heading. Enter your bin numbers before you use the
Part II instructions to create frequency distributions.

When you create your own frequency distributions, you
can include frequency, percentage, and/or cumulative per-
centages as columns of one distribution, unlike what is
shown in Tables 2.8 through 2.11. Also, when you use
Excel, you create frequency distributions for individual
categories separately (e.g., a frequency distribution for
intermediate government bond funds, followed by one for
short-term corporate bond funds). To form worksheets that
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look like two-category Tables 2.8 through 2.11, you cut
and paste parts of separately created frequency distribu-
tions. (Examine the FD_IG and FD_STC worksheets
of the Chapter 2 workbook and then examine the
FD_COMBINED worksheet to see how frequency
distributions for an individual category can be cut and
pasted to form one table.)

The Frequency Distribution, Part II

PHStat2 Use Frequency Distribution to create a
frequency distribution. For example, to create the Table 2.9
frequency distribution on page 36, open to the DATA
worksheet of the Bond Funds workbook. Select PHStat
➔ Descriptive Statistics ➔ Frequency Distribution. In the
procedure’s dialog box (shown below):

1. Enter F1:F185 as the Variable Cell Range, enter
J1:J11 as the Bins Cell Range, and check First cell in
each range contains label.

2. Click Multiple Groups - Stacked and enter B1:B185 as
the Grouping Variable Cell Range. (In the DATA
worksheet, the 2009 returns for both types of bond funds
are stacked, or placed in a single column. The column B
values allow PHStat2 to unstack the returns for
intermediate government funds from the returns for the
short-term corporate funds.)

3. Enter a Title and click OK.

When creating other frequency distributions, if you use a
worksheet that contains data for a single group, such as the
IGDATA or STCDATA worksheets, click Single Group
Variable in step 2. Note that the Histogram & Polygons
procedure, discussed in Section EG2.5, also creates fre-
quency distributions.

In-Depth Excel Use the FREQUENCY worksheet func-
tion and a bin number list (see “The Frequency Distribu-
tion, Part I” on page 78) to create a frequency distribution.

For example, to create the Table 2.9 frequency distribution
on page 36, open to and review the IGDATA and
STCDATA worksheets of the Bond Funds workbook.
Note that the worksheets divide the bond funds sample by
fund type and that the two worksheets contain identical bin
number lists in column J. With the workbook open to the
IGDATA worksheet:

1. Right-click the IGDATA sheet tab and then click
Insert in the shortcut menu. In the Insert dialog box,
click the Worksheet icon and click OK to insert a new
worksheet.

2. In the new worksheet, enter a worksheet title in cell A1,
Bins in cell A3, and Frequency in cell B3.

3. Copy the bin number list that is in the cell range J2:J11
of the IGDATA worksheet and paste this list into column
A of the new worksheet, starting with cell A4.

4. Select the cell range B4:B13 that will contain the fre-
quency function.

5. Type, but do not press the Enter or Tab key, the formula
=FREQUENCY(IGDATA!$F$1:$F$88, $A$4:$A$13).
Then, while holding down the Ctrl and Shift keys (or the
Apple key on a Mac), press the Enter key. (This combi-
nation keystroke enters an “array formula,” explained in
Appendix F, in the cell range B4:B13.)

To create the frequency distribution for short-term cor-
porate bonds, repeat steps 1 through 5 but enter the for-
mula =FREQUENCY(STCDATA!$F$1:$F$98, $A$4:
$A$13) in step 5. Then cut and paste the results from the
two frequency distributions to create a table similar to
Table 2.9.

Note that in step 5, you entered the cell range as
IGDATA!$F$1:$F$88 (or STCDATA!$F$1:$F$98) and
not as F1:F88 (or F1:F98) because the data to be sum-
marized are located on another worksheet, and you
wanted to use absolute cell references to facilitate the
copying of the frequency column to create a table similar
to Table 2.9.

Analysis ToolPak Use Histogram with a bin number list
(see “The Frequency Distribution, Part I” on page 78) to cre-
ate a frequency distribution. For example, to create the Table
2.9 frequency distribution on page 36, open to the IGDATA
worksheet of the Bond Funds workbook and select Data
➔ Data Analysis. In the Data Analysis dialog box, select
Histogram from the Analysis Tools list and then click OK.
In the Histogram dialog box (see the top of page 80):

1. Enter F1:F88 as the Input Range and enter J1:J11 as
the Bin Range. (If you leave Bin Range blank, the pro-
cedure creates a set of bins that will not be as well-
formed as the ones you can specify.)

2. Check Labels and click New Worksheet Ply.

3. Click OK to create the frequency distribution on a new
worksheet.



In the new worksheet:

4. Select row 1. Right-click row 1 and click the Insert
shortcut menu. Repeat. (This creates two blank rows at
the top of the worksheet.)

5. Enter a title for the frequency distribution in cell A1.

The ToolPak creates a frequency distribution that contains
an improper bin labeled More. Correct this error as follows:

6. Manually add the frequency count of the More row to
the count of the preceding bin. (This is unnecessary if
the More count is 0, as it is in this Table 2.9 example.)

7. Click the worksheet row number for the More row (to
select the entire worksheet row), right-click on the row,
and click Delete in the shortcut menu that appears.

Open to the STCDATA worksheet and repeat steps 1
through 7 with rows 1 through 98. Then cut and paste the re-
sults from the two frequency distributions to create a table
similar to Table 2.9.

The Relative Frequency, Percentage, or
Cumulative Percentage Distribution

PHStat2 To create these other distributions, first use the
PHStat2 instructions in “The Frequency Distribution, Part
II” to create a frequency distribution that contains a column
of percentages and cumulative percentages. To create a col-
umn of relative frequencies, reformat the percentage col-
umn. Select the cells containing the percentages, right-click,
and then select Format Cells from the shortcut menu. In the
Number tab of the Format Cells dialog box, select Number
as the Category and click OK.

In-Depth Excel To create these other distributions, modify
a frequency distribution created using the In-Depth Excel
instructions in “The Frequency Distribution, Part II” by
adding a column for percentages (or relative frequencies)
and a column for cumulative percentages. For example,
open to the FD_IG worksheet of the Chapter 2 workbook.

This worksheet contains the frequency distribution for the
intermediate government bond funds. To modify this work-
sheet to include percentage and cumulative percentage
distributions:

1. Enter Total in cell A14 and enter �SUM(B4:B13) in
cell B14.

2. Enter Percentage in cell C3 and Cumulative Pctage in
cell D3.

3. Enter �B4/$B$14 in cell C4 and copy this formula
down through all the rows of the frequency distribution.

4. Enter � C4 in cell D4. Enter �D4 � C5 in cell D5 and
copy this formula down through all the rows of the fre-
quency distribution.

5. Select the cell range C4:D13, right-click, and click
Format Cells in the shortcut menu.

6. In the Number tab of the Format Cells dialog box, select
Percentage as the Category and click OK.

If you want a column of relative frequencies instead of
percentages, change the cell C4 column heading to Rel.
Frequencies. Then select the cell range C4:C13, right-
click, and click Format Cells in the shortcut menu. In the
Number tab of the Format Cells dialog box, select Number
as the Category and click OK.

Analysis ToolPak Use the preceding In-Depth Excel in-
structions to modify a frequency distribution created using
the “The Frequency Distribution, Part II” instructions.

EG2.4 VISUALIZING CATEGORICAL DATA

The Bar Chart and the Pie Chart

PHStat2 Modify the Section EG2.2 PHStat2 instructions for
creating a summary table (page 76) to create a bar or pie chart.
In step 3 of those instructions, check either Bar Chart and/or
Pie Chart in addition to entering a Title and clicking OK.

In-Depth Excel Create a bar or pie chart from a summary
table. For example, to create the Figure 2.2 bar chart on
page 43 or the Figure 2.4 pie chart on page 44, open to the
SUMMARY_PIVOT worksheet of the Chapter 2 work-
book and:

1. Select cell range A4:B7 (Begin your selection at cell B7
and not at cell A4, as you would normally do).

2. Click Insert. For a bar chart, click Bar in the Charts
group and then select the first 2-D Bar gallery choice
(Clustered Bar). For a pie chart, click Pie in the Charts
group and then select the first 2-D Pie gallery choice
(Pie).

3. Relocate the chart to a chart sheet and adjust chart for-
matting by using the instructions in Appendix Section
F.4 on page 815.
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For a pie chart, select Layout ➔Data Labels ➔ More
Data Label Options. In the Format Data Labels dialog box,
click Label Options in the left pane. In the Label Options right
pane, check Category Name and Percentage and clear the
other check boxes. Click Outside End and then click Close.

For a bar chart, if the horizontal axis scale does not
begin with 0, right-click the horizontal (value) axis and
click Format Axis in the shortcut menu. In the Format Axis
dialog box, click Axis Options in the left pane. In the Axis
Options right pane, click the first Fixed option button (for
Minimum) and enter 0 in its box. Click Close.

The Pareto Chart

PHStat2 Modify the Section EG2.2 PHStat2 instructions
for creating a summary table on page 76 to create a Pareto
chart. In step 3 of those instructions, check Pareto Chart in
addition to entering a Title and clicking OK.

In-Depth Excel To create a Pareto chart, modify the sum-
mary table that was originally created using the instructions
in Section EG2.3. In the original table, first sort the table in
order of decreasing frequencies and then add a column for
cumulative percentage. Use the sorted, modified table to cre-
ate the Pareto chart.

For example, to create the Figure 2.5 Pareto chart, open
to the ATMTable worksheet of the ATM Transactions
workbook. Begin by sorting the modified table by decreas-
ing order of frequency:

1. Select row 11 (the Total row), right-click, and click Hide
in the shortcut menu. (This prevents the total row from
getting sorted.)

2. Select cell B4 (the first frequency), right-click, and
select Sort ➔ Sort Largest to Smallest.

3. Select rows 10 and 12 (there is no row 11), right-click,
and click Unhide in the shortcut menu.

Next, add a column for cumulative percentage:

4. Enter Cumulative Pctage in cell D3. Enter �C4 in cell
D4. Enter �D4 � C5 in cell D5 and copy this formula
down through row 10.

5. Select the cell range C4:D10, right-click, and click
Format Cells in the shortcut menu.

6. In the Number tab of the Format Cells dialog box, select
Percentage as the Category and click OK.

Next, create the Pareto chart:

7. Select the cell range A3:A10 and while holding down
the Ctrl key also select the cell range C3:D10.

8. Select Insert ➔ Column (in the Charts group) and select
the first 2-D Column gallery choice (Clustered
Column).

9. Select Format (under Chart Tools). In the Current
Selection group, select the entry for the cumulative

percentage series from the drop-down list and then click
Format Selection.

10. In the Format Data Series dialog box, click Series
Options in the left pane and in the Series Options right
pane, click Secondary Axis. Click Close.

11. With the cumulative percentage series still selected in
the Current Selection group, select Design ➔ Change
Chart Type, and in the Change Chart Type gallery, se-
lect the fourth Line gallery choice (Line with
Markers). Click OK.

Next, set the maximum value of the primary and secondary
(left and right) Y axes scales to 100%. For each Y axis:

12. Right-click on the axis and click Format Axis in the
shortcut menu.

13. In the Format Axis dialog box, click Axis Options in the
left pane and in the Axis Options right pane, click the
second Fixed option button (for Maximum) and enter 1
in its box. Click Close.

Relocate the chart to a chart sheet and adjust chart formatting
by using the instructions in Appendix Section F.4 on page.

When using a PivotTable as a summary table, table
sorting is simpler: Right-click the cell that contains the first
frequency (cell B5 in the sample worksheet) and select Sort
➔ Sort Largest to Smallest. However, creating a Pareto
chart from a PivotTable with additional columns for per-
centage and cumulative percentage is much more difficult
than creating a chart from a simple summary table. The best
workaround is to convert the PivotTable to a simple sum-
mary table by copying the category names and frequencies
in the PivotTable, along with the additional columns, to an
empty worksheet area.

The Side-by-Side Chart

PHStat2 Modify the Section EG2.2 PHStat2 instructions
for creating a contingency table on page 77 to create a side-
by-side chart. In step 4 of those instructions, check Side-
by-Side Bar Chart in addition to entering a Title and
clicking OK.

In-Depth Excel Create a chart based on a contingency
table to create a side-by-side chart. For example, to create
the Figure 2.7 side-by-side bar chart on page 47, open to the
CONTINGENCY_PIVOT worksheet of the Chapter 2
workbook and:

1. Select cell A4 (or any other cell inside the PivotTable).

2. Select Insert ➔ Bar and select the first 2-D Bar gallery
choice (Clustered Bar). Relocate the chart to a chart
sheet and adjust the chart formatting by using the
instructions in Appendix Section F.4 on page, but with
this exception: When you click Legend, select Show
Legend at Right.



When creating a chart from a contingency table that is
not a PivotTable, select the cell range of the contingency
table, including row and column headings, but excluding the
total row and total column, before selecting Insert ➔ Bar.

Occasionally when you create a side-by-side chart, the
row and column variables need to be swapped. If a Pivot-
Table is the source for the chart, rearrange the PivotTable by
making the row variable the column variable and vice versa.
If the chart is not based on a PivotTable, right-click the chart
and then click Select Data in the shortcut menu. In the
Select Data Source dialog box, click Switch Row/Column
and then click OK. (In Excel 2010, you can also use this
second method for PivotTable-based charts.)

You may also need to rearrange the order of categories
shown on the chart. To flip their positions for a chart based
on a PivotTable, click the pull-down list for the categorical
variable that needs to be rearranged and select Sort A to Z.
In this example, after step 2, click the Fees pull-down list
for the categorical variable that needs to be rearranged and
select Sort A to Z. To rearrange the order of categories for a
chart not based on a PivotTable, physically rearrange the
worksheet columns that contain the data for the chart.

EG2.5 VISUALIZING NUMERICAL DATA

The Stem-and-Leaf Display

PHStat2 Use the Stem-and-Leaf Display procedure to
create a stem-and-leaf display. For example, to create a
stem-and-leaf display similar to Figure 2.8 on page 50, open
to the STCDATA worksheet of the Chapter 2 workbook.
Select PHStat ➔Descriptive Statistics ➔ Stem-and-Leaf
Display. In the procedure’s dialog box (shown below):

1. Enter F1:F98 as the Variable Cell Range and check
First cell contains label.

2. Leave Autocalculate stem unit selected.

3. Enter a Title and click OK.

Because Minitab uses a truncation method and PHStat2
uses a rounding method, the leaves of the PHStat2 display
differ slightly from Figure 2.8 (created using Minitab).

When creating other displays, use the Set stem unit as
option sparingly and only if Autocalculate stem unit
creates a display that has too few or too many stems. (Any
stem unit you specify must be a power of 10.)

In-Depth Excel Manually construct the stems and leaves
on a new worksheet to create a stem-and-leaf display. Use
the STEM_LEAF worksheet of the Chapter 2 workbook
as a guide to formatting your display.

The Histogram

PHStat2 Use the Histogram & Polygons procedure to cre-
ate a histogram from unsummarized data. For example, to
create the pair of histograms shown in Figure 2.10 on page 51,
open to the DATA worksheet of the Bond Funds workbook.
Select PHStat ➔ Descriptive Statistics ➔ Histogram &
Polygons. In the procedure’s dialog box (shown below):

1. Enter F1:F185 as the Variable Cell Range, J1:J11 as the
Bins Cell Range, K1:K10 as the Midpoints Cell Range,
and check First cell in each range contains label.

2. Click Multiple Groups - Stacked and enter B1:B185 as
the Grouping Variable Cell Range. (In the DATA
worksheet, the 2009 returns for both types of bond funds
are stacked, or placed in a single column. The column B
values allow PHStat2 to separate the returns for interme-
diate government funds from the returns for the short-
term corporate funds.)

3. Enter a Title, check Histogram, and click OK.

The Bins Cell Range and the Midpoints Cell Range
should appear in the same worksheet as the unsummarized
data, as the DATA worksheet of the Bond Funds workbook
illustrates. Because a first bin can never have a midpoint (be-
cause that bin does not have a lower boundary value
defined), the procedure assigns the first midpoint to the

82 CHAPTER 2 Organizing and Visualizing Data
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second bin and uses "---" as the label for the first bin. There-
fore, the Midpoints Cell Range you enter must be one cell
smaller in size than the Bins Cell Range. Read “The
Histogram: Follow-up” in the next column for an additional
adjustment that you can apply to the histograms created.

In-Depth Excel Create a chart from a frequency distribu-
tion. For example, to create the Figure 2.10 pair of
histograms on page 51, f irst use the Section EG2.4
“The Frequency Distribution, Part II” In-Depth Excel
instructions on page 79.

Follow those instructions to create a pair of frequency
distributions, one for the intermediate government bond
funds, and the other for the short-term corporate bond
funds, on separate worksheets. In each worksheet, add a
column of midpoints by entering the column heading
Midpoints in cell C3, '--- in cell C4, and starting in cell
C5, the midpoints -7.5, -2.5, 2.5, 7.5, 12.5, 17.5, 22.5, 27.5,
and 32.5. In each worksheet:

1. Select the cell range B3:B13 (the cell range of the
frequencies).

2. Select Insert ➔ Column and select the first 2-D
Column gallery choice (Clustered Column).

3. Right-click the chart background and click Select Data.

In the Select Data Source dialog box:

4. Click Edit under the Horizontal (Categories) Axis
Labels heading.

5. In the Axis Labels dialog box, enter the cell range
formula in the form =SheetName!C4:C13 (where
SheetName is the name of the current worksheet) and
then click OK to return to the Select Data Source dia-
log box.

6. Click OK.

In the chart:

7. Right-click inside a bar and click Format Data Series
in the shortcut menu.

In the Format Data Series dialog box:

8. Click Series Options in the left pane. In the Series
Options right pane, change the Gap Width slider to No
Gap. Click Close.

Relocate the chart to a chart sheet and adjust the chart format-
ting by using the instructions in Appendix Section F.4 on page.
Read “The Histogram: Follow-up” on page for an additional ad-
justment that you can apply to the histograms created.

Analysis ToolPak Modify the Section EG2.3 Analysis
ToolPak instructions for “The Frequency Distribution, Part
II” on page 79 to create a histogram. In step 5 of those in-
structions, check Chart Output before clicking OK.

For example, to create the pair of histograms in Figure
2.10 on page 51, use the modified step 5 with both the

IGDATA and STCDATA worksheets of the Chapter 2
workbook (as discussed on page 79) to create a pair of
worksheets that contain a frequency distribution and a his-
togram. Each histogram will have (the same) two formatting
errors that you can correct:

To eliminate the gaps between bars:

1. Right-click inside one of the histogram bars and click
Format Data Series in the shortcut menu that appears.

2. In the Series Options pane of the Format Data Series
dialog box, move the Gap Width slider to No Gap and
click Close.

To change the histogram bin labels:

1. Enter the column heading Midpoints in cell C3 and
enter '--- in cell C4 (the first bin has no midpoint). Start-
ing in cell C5, enter the midpoints -7.5, -2.5, 2.5, 7.5,
12.5, 17.5, 22.5, 27.5, and 32.5, in column C. (The mid-
points will serve as the new bin labels in step 3.)

2. Right-click the chart background and click Select Data.

3. In the Select Data Source dialog box, click Edit under
the Horizontal (Categories) Axis Labels heading. In
the Axis Labels dialog box, enter the cell range formula
in the form =SheetName!C4:C13 as the Axis label
range and click OK. Back in the Select Data Source di-
alog box, click OK to complete the task.

In step 3, substitute the name of the worksheet that contains
the frequency distribution and histogram for SheetName

and note that the cell range C4:C13 does not include the
column heading cell. Read the next section for an additional
adjustment that you can apply to the histograms created.

The Histogram: Follow-up

Because the example used throughout “The Histogram” uses
a technique that uses an extra bin (see “The Frequency Distri-
bution, Part I” in Section EG2.4), the histogram created will
have the extra, meaningless bin. If you would like to remove
this extra bin, as was done for the histograms shown in Figure
2.10, right-click the histogram background and click Select
Data. In the Select Data Source Data dialog box, first click
Edit under the Legend Entries (Series) heading. In the Edit
Series dialog box, edit the Series values cell range formula.
Then click Edit under the Horizontal (Categories) Axis
Labels heading. In the Axis Labels dialog box, edit the Axis
label range. For the example used in the previous section,
change the starting cell for the Series values cell range
formula from B4 to B5 and change the starting cell for the
Axis label range cell range formula from C4 to C5.

The Percentage Polygon

PHStat2 Modify the PHStat2 instructions for creating a
histogram on page 82 to create a percentage polygon. In
step 3 of those instructions, click Percentage Polygon be-
fore clicking OK.
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In-Depth Excel Create a chart based on a modified percent-
age distribution to create a percentage polygon. For example,
to create the Figure 2.12 percentage polygons on page 52,
open to the CPD_IG worksheet of the Bond Funds work-
book. (This worksheet contains a frequency distribution for the
intermediate government bond funds and includes columns for
the percentages and cumulative percentages in column C and
D.) Begin by modifying the distribution:

1. Enter the column heading Midpoints in cell E3 and
enter '--- in cell E4 (the first bin has no midpoint). Start-
ing in cell E5, enter -7.5, -2.5, 2.5, 7.5, 12.5, 17.5, 22.5,
27.5, and 32.5, in column E.

2. Select row 4 (the first bins row), right-click, and select
Insert in the shortcut menu.

3. Select row 15 (the total row), right-click, and select
Insert in the shortcut menu.

4. Enter 0 in cells C4, D4 and C15.

5. Select the cell range C3:C15.

Next, create the chart:

6. Select Insert ➔ Line and select the fourth 2-D Line
gallery choice (Line with Markers).

7. Right-click the chart and click Select Data in the short-
cut menu.

In the Select Data Source dialog box:

8. Click Edit under the Legend Entries (Series) heading.
In the Edit Series dialog box, enter the formula
="Intermediate Government" for the Series name and
click OK.

9. Click Edit under the Horizontal (Categories) Axis
Labels heading. In the Axis Labels dialog box, enter the
cell range formula =CPD_IG!E4:E15 for the Axis
label range and click OK.

10. Back in the Select Data Source dialog box, click OK.

Back in the chart sheet:

11. Right-click the vertical axis and click Format Axis in
the shortcut menu.

12. In the Format Axis dialog box, click Number in left
pane and then select Percentage from the Category list
in the Number right pane. Enter 0 as the Decimal places
and click OK.

Relocate the chart to a chart sheet and adjust chart formatting
by using the instructions in Appendix Section F.4 on page.

Figure 2.12 on page 52 also contains the percentage
polygon for the short-term corporate bond funds. To add this
polygon to the chart just created, open to the CPD_STC
worksheet. Repeat steps 1 through 5 to modify this distribu-
tion. Then open to the chart sheet that contains the interme-
diate government polygon. Select Layout ➔ Legend ➔
Show Legend at Right. Right-click the chart and click
Select Data in the shortcut menu. In the Select Data Source

dialog box, click Add. In the Edit Series dialog box, enter the
formula ="Short Term Corporate" as the Series name and
enter the cell range formula =CPD_STC!C4:C15 as the
Series values. Click OK. Back in the Select Data Source di-
alog box, click OK.

The Cumulative Percentage Polygon (Ogive)

PHStat2 Modify the PHStat2 instructions for creating a
histogram on page 82 to create a cumulative percentage
polygon, In step 3 of those instructions, click Cumulative
Percentage Polygon (Ogive) before clicking OK.

In-Depth Excel Create a cumulative percentage polygon
by modifying the In-Depth Excel instructions for creating a
percentage polygon. For example, to create the Figure 2.14
cumulative percentage polygons on page 54, use the instruc-
tions for creating percentage polygons, replacing steps 4
and 8 with the following:

4. Select the cell range D3:D14.

8. Click Edit under the Horizontal (Categories) Axis La-
bels heading. In the Axis Labels dialog box, enter the
cell range formula =CPD_IG!A4:A14 for the Axis la-
bel range and click OK.

Later, when adding the second polygon for the short-term
corporate bond funds, enter the cell range formula
=CPD_STC!D4:D14 as the Series values in the Edit Series
dialog box.

EG2.6 VISUALIZING TWO 
NUMERICAL VARIABLES

The Scatter Plot

PHStat2 Use the Scatter Plot procedure to create a scatter
plot. For example, to create a scatter plot similar to the one
shown in Figure 2.15 on page 57, open to the DATA work-
sheet of the NBAValues workbook. Select PHStat2 ➔
Descriptive Statistics ➔ Scatter Plot. In the procedure’s
dialog box (shown below):

1. Enter C1:C31 as the Y Variable Cell Range.

2. Enter B1:B31 as the X Variable Cell Range.

3. Check First cells in each range contains label.

4. Enter a Title and click OK.
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You can also use the Scatter Plot output option of the Simple
Linear Regression procedure to create a scatter plot. Scatter
plots created using this alternative will contain a superim-
posed line like the one seen in Figure 2.15. (See the Excel
Guide for Chapter 13 for the instructions for using the
Simple Linear Regression procedure.)

In-Depth Excel Use a worksheet in which the column for
the X variable data is to the left of the column for the Y vari-
able data to create a scatter plot. (If the worksheet is
arranged Y then X, cut and paste the Y variable column to
the right of the X variable column.)

For example, to create a scatter plot similar to the one
shown in Figure 2.15 on page 57, open to the DATA work-
sheet of the NBAValues workbook and:

1. Select the cell range B1:C31.

2. Select Insert ➔ Scatter and select the first Scatter
gallery choice (Scatter with only Markers).

3. Select Layout ➔ Trendline ➔ Linear Trendline.

Relocate the chart to a chart sheet and adjust the chart for-
matting by using the instructions in Appendix Section F.4
on page.

The Time-Series Plot

In-Depth Excel Create a chart from a worksheet in
which the column for the time variable data appears to
the immediate left of the column for the numerical vari-
able data. (Use cut and paste to rearrange columns, if
necessary.)

For example, to create the Figure 2.16 time-series plot on
page 58, open to the DATA worksheet of the MovieGross
workbook and:

1. Select the cell range A1:B15.

2. Select Insert ➔ Scatter and select the fourth Scatter
gallery choice (Scatter with Straight Lines and Markers).

Relocate the chart to a chart sheet and adjust chart formatting
by using the instructions in Appendix Section F.4 on page.

EG2.7 ORGANIZING MULTIDIMENSIONAL
DATA

Multidimensional Contingency Tables

In-Depth Excel Use PivotTables to create multidimen-
sional contingency tables. For example, to create the Figure
2.18 fund type, risk, and fees table on page 61, open to the
DATA worksheet of the Bond Funds workbook and select
Insert ➔ PivotTable. In the Create PivotTable dialog box:

1. Click Select a table or range and enter A1:I185 as the
Table/Range.

2. Click New Worksheet and then click OK.

In the PivotTable Field List task pane (shown below):

3. Drag Type in the Choose fields to add to report box
and drop it in the Row Labels box.

4. Drag Risk in the Choose fields to add to report box
and drop it in the Row Labels box.

5. Drag Fees in the Choose fields to add to report box
and drop it in the Column Labels box.

6. Drag Fees in the Choose fields to add to report box a
second time and drop it in the ∑ Values box. (This label
changes to Count of Fees.)

In the PivotTable being created:

7. Click the Fees drop-down list in cell B3 and select Sort
Z to A to rearrange the order of the “No” and “Yes”
columns.

8. Right-click and then click PivotTable Options in the
shortcut menu that appears.

In the PivotTable Options dialog box:

9. Click the Layout & Format tab.

10. Check For empty cells, show and enter 0 as its value.
Leave all other settings unchanged.

11. Click the Total & Filters tab.

12. Check Show grand totals for columns and Show
grand totals for rows.

13. Click OK to complete the table.
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If you create a PivotTable from an .xlsx file in Excel
2007 or later, the default formatting of the PivotTable will
differ from the formatting of the PivotTables shown in Sec-
tion 2.7. Also, in step 7 you will always see Column Labels
as the name of drop-down list and that drop-down list will
appear in cell B3.

To display the cell values as percentages, as was done in
Figures 2.20 and 2.21 on page 62, click Count of Fees in
the PivotTable Field List task pane and then click Value
Field Settings from the shortcut menu. In the Value Field
Settings dialog box (shown below):

1. Click the Show Values As tab.

2. Select % of Grand Total from the Show values as
drop-down list.

3. Click OK.

Adding Numerical Variables

In-Depth Excel Add a numerical variable to a PivotTable
by dragging a numerical variable label from the Choose
fields to add to report box to the ∑ Values box and delet-
ing the Count of categorical variable label (by dragging the
label and dropping it anywhere outside the ∑ Values box).
To display something other than the sum of the numerical

Adjust cell formatting and decimal place display as required
(see Appendix F).

variable, click the Sum of numerical variable and then click
Value Field Settings and make the appropriate entries in the
Value Field Settings dialog box.

For example, to create the Figure 2.22 PivotTable of
fund type, risk, and fees, showing averages of the 2009 re-
turn (see page 62) from the Figure 2.18 PivotTable, first cre-
ate the Figure 2.18 PivotTable using steps 1 through 12 of
the preceding section. Then continue with these steps:

13. Drag Return 2009 in the Choose fields to add to
report box and drop it in the ∑ Values box. (This label
changes to Sum of Return 2009.)

14. Drag Count of Fees in the ∑ Values box and drop it any-
where outside that box.

15. Click Sum of Return 2009 and click Value Field
Settings from the shortcut menu.

In the Value Field Settings dialog box (shown below):

16. Click the Summarize Values By tab and select Average
from the list. The label Sum of Return 2009 changes to
Average of Return 2009.

17. Click OK.



Chapter 2 Minitab Guide 87

C H A P T E R 2 M I N I TA B G U I D E

MG2.2 ORGANIZING CATEGORICAL DATA

The Summary Table

Use Tally Individual Variables to create a summary table.
For example, to create a summary table similar to Table 2.2
on page 30, open to the Bond Funds worksheet. Select
Stat ➔ Tables ➔ Tally Individual Variables. In the proce-
dure’s dialog box (shown below):

1. Double-click C9 Risk in the variables list to add Risk
to the Variables box.

The Contingency Table

Use Cross Tabulation and Chi-Square to create a contin-
gency table. For example, to create a contingency table sim-
ilar to Table 2.3 on page 31, open to the Bond Funds
worksheet. Select Stat ➔ Tables ➔ Cross Tabulation and
Chi-Square. In the procedure’s dialog box (shown below):

1. Enter Type in the For rows box.

2. Enter Fees in the For columns box

3. Check Counts.

4. Click OK.

To create the other types of contingency tables shown in
Tables 2.4 through 2.6, change step 3 by checking other ad-
ditional Display items.

MG2.3 ORGANIZING NUMERICAL DATA

Stacked and Unstacked Data

Use Stack or Unstack Columns to rearrange data. For ex-
ample, to unstack the Return 2009 variable in column C6
of the Bond Funds worksheet, open to that worksheet. Se-
lect Data ➔ Unstack Columns. In the procedure’s dialog
box (shown below):

1. Double-click C6 Return 2009 in the variables list to
add 'Return 2009' to the Unstack the data in box and
press Tab.

2. Double-click C2 Type in the variables list to add Type
to the Using subscripts in box.

3. Click After last column in use.

4. Check Name the columns containing the unstacked
data.

5. Check OK.

Minitab inserts two new columns, Return 2009_Interme-
diate Government and Return 2009_Short Term Corpo-
rate, the names of which you can edit.

To stack columns, select Data ➔ Stack ➔ Columns. In
the Stack Columns dialog box, add the names of columns
that contain the data to be stacked to the Stack the follow-
ing columns box and then click either New worksheet or
Column of current worksheet as the place to store the
stacked data.

The Ordered Array

Use Sort to create an ordered array. Select Data ➔ Sort and
in the Sort dialog box (not shown), double-click a column

2. Check Counts and Percents.

3. Click OK.
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name in the variables list to add it to the Sort column(s) box
and then press Tab. Double-click the same column name in
the variables list to add it to the first By column box. Click
either New worksheet, Original column(s), or Column(s)
of current worksheet. (If you choose the third option, also
enter the name of the column in which to place the ordered
data in the box). Click OK.

The Frequency Distribution

There are no Minitab commands that use classes that you
specify to create frequency distributions of the type seen in
Tables 2.8 through 2.11. (See also “The Histogram” in
Section MG2.5.)

MG2.4 VISUALIZING CATEGORICAL DATA

The Bar Chart and the Pie Chart

Use Bar Chart to create a bar chart from a summary table
and use Pie Chart to create a pie chart from a summary
table. For example, to create the Figure 2.2 bar chart on
page 43, open to the Bond Funds worksheet. Select Graph
➔ Bar Chart. In the procedure’s dialog box (shown below):

1. Select Counts of unique values from the Bars repre-
sent drop-down list.

2. In the gallery of choices, click Simple.

3. Click OK.

If your data are in the form of a table of frequencies, select
Values from a table from the Bars represent drop-down list
in step 1. With this selection, clicking OK in step 3 will
display the “Bar Chart - Values from a table, One column of
values, Simple” dialog box. In this dialog box, you enter the
columns to be graphed in the Graph variables box and,
optionally, enter the column in the worksheet that holds the
categories for the table in the Categorical variable box.

Use Pie Chart to create a pie chart from a summary
table. For example, to create the Figure 2.4 pie chart on page
44, open to the Bond Funds worksheet. Select Graph ➔
Pie Chart. In the procedure’s dialog box (shown below):

1. Click Chart counts of unique values and then press
Tab.

2. Double-click C9 Risk in the variables list to add Risk
to Categorical variables.

3. Click Labels.

In the Bar Chart - Counts of unique values, Simple dialog
box (see the top of the next column):

4. Double-click C9 Risk in the variables list to add Risk
to Categorical variables.

5. Click OK.

In the Pie Chart - Labels dialog box (shown at the top of
page 89):

4. Click the Slice Labels tab.

5. Check Category name and Percent.

6. Click OK to return to the original dialog box.
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In the “Bar Chart - Counts of unique values, Cluster” dialog
box (shown below):

4. Double-click C2 Type and C4 Fees in the variables
list to add Type and Fees to the Categorical variables
(2–4, outermost first) box.

5. Click OK.

MG2.5 VISUALIZING NUMERICAL DATA

The Stem-and-Leaf Display

Use Stem-and-Leaf to create a stem-and-leaf display. For
example, to create the Figure 2.8 stem-and-leaf display on
page 50, open to the Bond Funds worksheet. Select Graph
➔ Stem-and-Leaf. In the procedure’s dialog box (shown
below):

1. Double-click C6 Return 2009 in the variables list to
add 'Return 2009' in the Graph variables box.

2. Click OK.

Back in the original Pie Chart dialog box:

7. Click OK.

The Pareto Chart

Use Pareto Chart to create a Pareto chart. For example, to cre-
ate the Figure 2.5 Pareto chart on page 45, open to the ATM
Transactions worksheet. Select Stat ➔ Quality Tools ➔
Pareto Chart. In the procedure’s dialog box (shown below):

1. Double-click C1 Cause in the variables list to add
Cause to the Defects or attribute data in box.

2. Double-click C2 Frequency in the variables list to add
Frequency to the Frequencies in box.

3. Click Do not combine.

4. Click OK.

The Side-by-Side Chart

Use Bar Chart to create a side-by-side chart. For example,
to create the Figure 2.7 side-by-side chart on page 47, open
to the Bond Funds worksheet. Select Graph ➔ Bar
Chart. In the procedure’s dialog box:

1. Select Counts of unique values from the Bars repre-
sent drop-down list.

2. In the gallery of choices, click Cluster.

3. Click OK.
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The Histogram

Use Histogram to create a histogram. For example, to cre-
ate the pair of histograms shown in Figure 2.10 on page
51, open to the Bond Funds worksheet. Select Graph ➔
Histogram. In the Histograms dialog box (shown below):

1. Click Simple and then click OK.

In the Histogram - Multiple Graphs dialog box:

4. In the Multiple Variables tab (not shown), click On
separate graphs and then click the By Variables tab.

5. In the By Variables tab (shown at the top of the next
column), enter Type in the By variables in groups on
separate graphs box.

6. Click OK.

In the Histogram - Simple dialog box (shown below):

2. Double-click C6 Return 2009 in the variables list to
add 'Return 2009' in the Graph variables box.

3. Click Multiple Graphs.

Back in the Histogram - Simple dialog box:

7. Click OK.

The histograms created use classes that differ from the
classes used in Figure 2.10 (and in Table 2.9 on page 36)
and do not use the midpoints shown in Figure 2.10. To
better match the histograms shown in Figure 2.10, for
each histogram:

8. Right-click the X axis and then click Edit X Scale from
the shortcut menu.

In the Edit Scale dialog box (shown below):

9. Click the Binning tab (shown below). Click Cutpoint
(as the Interval Type) and Midpoint/Cutpoint posi-
tions and enter -10 -5 0 5 10 15 20 25 30 35 in the box
(with a space after each value).
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10. Click the Scale tab (shown below). Click Position of
ticks and enter -7.5 -2.5 2.5 7.5 12.5 17.5 22.5 27.5 32.5
in the box (with a space after each value).

11. Click OK.

In the Histogram - Scale dialog box:

5. Click the Y-Scale Type tab. Click Percent, clear
Accumulate values across bins, and then click OK.

Back again in the Histogram - Simple dialog box:

6. Click Data View.

In the Histogram - Data View dialog box:

7. Click the Data Display tab and then check Symbols.

8. Click the Smoother tab and then click Lowness and en-
ter 0 as the Degree of smoothing and 1 as the Number
of steps.

9. Click OK.

Back again in the Histogram - Simple dialog box:

10. Click OK to create the polygons.

The percentage polygons created use classes that differ from
the classes used in Figure 2.12 (and in Table 2.9 on page 36)
and do not use the midpoints shown in Figure 2.12. To bet-
ter match the polygons shown in Figure 2.12:

11. Right-click the X axis and then click Edit X Scale from
the shortcut menu.

In the Edit Scale dialog box:

12. Click the Binning tab. Click Cutpoint as the Interval
Type and Midpoint/Cutpoint positions and enter
-10 -5 0 5 10 15 20 25 30 35 in the box (with a space af-
ter each value).

13. Click the Scale tab. Click Position of ticks and enter
-7.5 -2.5 2.5 7.5 12.5 17.5 22.5 27.5 32.5 in the box
(with a space after each value).

14. Click OK.

The Cumulative Percentage Polygon (Ogive)

If you have access to image or photo editing software, use the
instructions in the section “The Percentage Polygon” to cre-
ate a cumulative percentage polygon. In step 5, click Percent
and check Accumulate values across bins before clicking
OK. At this point, the data points will be plotted (incorrectly)
to the midpoints and not the ends of the classes (the cut-
points). With the graph open, select File ➔ Save Graph As
and save the graph using a Save as type format compatible
with your image or photo-editing software. Open the software
and replace the X axis labels (the midpoints) with the proper
cutpoint values.

Otherwise, use Scatterplot with columns of data that
represent a cumulative percentage distribution to create a
cumulative percentage polygon. For example, to create the
Figure 2.13 cumulative percentage polygons of the cost of
restaurant meals at city and suburban restaurants, open to

To create the histogram of the 2009 returns for all the
bond funds, repeat steps 1 through 11, but in step 5 delete
Type from the By variables in groups on separate graphs
box. In the general case, if you have not just created his-
tograms by subgroups (as was done in the example), then fol-
low steps 1 through 4, changing step 4 to “Click OK” to create
a single histogram that contains all the values of a variable.

To modify the histogram bars, double-click over the his-
togram bars and make the appropriate entries and selections
in the Edit Bars dialog box. To modify an axis, double-click
the axis and make the appropriate entries and selections in
the Edit Scale dialog box.

The Percentage Polygon

Use Histogram to create a percentage polygon. For example,
to create the pair of percentage polygons shown in Figure 2.12
on page 52, open to the Return 2009 Unstacked worksheet.
Select Graph ➔ Histogram. In the Histograms dialog box:

1. Click Simple and then click OK.

In the Histogram - Simple dialog box:

2. Double-click C1 Intermediate Government in the
variables list to add 'Intermediate Government' in the
Graph variables box.

3. Double-click C2 Short-Term Corporate in the vari-
ables list to add 'Short-Term Corporate' in the Graph
variables box.

4. Click Scale.
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the Restaurant Cumulative Percentages worksheet.
Select Graph ➔ Scatterplot. In the Scatterplots dialog box:

1. Click With Connect Line and then click OK.

In the Scatterplot - With Connect Line dialog box (shown
below):

2. Double-click C2 City Restaurants in the variables list
to enter 'City Restaurants' in the Y variables row 1 cell.

3. Double-click C1 Cost of Meal in the variables list to
enter 'Cost of Meal' in the X variables row 1 cell.

4. Double-click C3 Suburban Restaurants in the vari-
ables list to enter 'Suburban Restaurants' in the Y
variables row 1 cell.

5. Double-click C1 Cost of Meal in the variables list to
enter 'Cost of Meal' in the X variables row 2 cell.

6. Click OK.

In the chart, right-click the Y axis label and then click Edit
Y Axis Label from the shortcut menu. In the Edit Axis
Label dialog box, enter Percentage in the Text box and then
click OK.

The Time-Series Plot

Use Time Series Plot to create a time-series plot. For exam-
ple, to create the Figure 2.16 time-series plot on page 58,
open to the MovieGross worksheet and select Graph ➔
Time Series Plot. In the Time Series Plots dialog box:

1. Click Simple and then click OK.

In the Time Series Plot - Simple dialog box (shown
below):

2. Double-click C2 Combined Gross in the variables list
to add ‘Combined Gross’ in the Series box.

3. Click Time/Scale.

MG2.6 VISUALIZING TWO NUMERICAL
VARIABLES

The Scatter Plot

Use Scatterplot to create a scatter plot. For example, to
create a scatter plot similar to the one shown in Figure 2.15
on page 57, open to the NBAValues worksheet. Select
Graph ➔ Scatterplot. In the Scatterplots dialog box:

1. Click With Regression and then click OK.

In the Scatterplot - With Regression dialog box (shown at
the top of the next column):

2. Enter Value in the row 1 Y variables cell.

3. Enter Revenue in the row 1 X variables cell.

4. Click OK.

In the Time Series Plot - Time/Scale dialog box (shown at
the top of page 93):

4. Click Stamp and then press Tab.

5. Double-click C1 Year in the variables list to add Year
in the Stamp columns (1-3, innermost first) box.

6. Click OK.

Back in the Time Series Plot - Simple dialog box:

7. Click OK.
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MG2.7 ORGANIZING MULTIDIMENSIONAL
DATA

Multidimensional Contingency Tables

Use Cross Tabulation and Chi-Square to create a multidi-
mensional contingency table. For example, to create a table
similar to the Figure 2.18 fund type, risk, and fees table on
page 61, open to the Bond Funds worksheet. Select Stat ➔
Tables ➔ Cross Tabulation and Chi-Square. In the proce-
dure’s dialog box:

1. Double-click C2 Type in the variables list to add Type
to the For rows box.

2. Double-click C9 Risk in the variables list to add Risk
to the For rows box and then press Tab.

3. Double-click C4 Fees in the variables list to add Fees
to the For columns box.

4. Check Counts.

5. Click OK.

To display the cell values as percentages, as was done in
Figures 2.20 and 2.21 on page 62, check Total percents in-
stead of Counts in step 4.

Adding Numerical Variables

Use Descriptive Statistics to create a multidimensional con-
tingency table that contains a numerical variable. For example,
to create the Figure 2.22 table of fund type, risk, and fees on
page 62, showing averages of the 2009 return, open to the
Bond Funds worksheet. Select Stat ➔ Tables ➔ Descriptive

Statistics. In the Table of Descriptive Statistics dialog box
(shown below):

1. Double-click C2 Type in the variables list to add Type
to the For rows box.

2. Double-click C9 Risk in the variables list to add Risk
to the For rows box and then press Tab.

3. Double-click C4 Fees in the variables list to add Fees
to the For columns box.

4. Click Associated Variables.

In the Descriptive Statistics - Summaries for Associated
Variables dialog box (shown below):

5. Double-click C6 Return 2009 in the variables list to
add 'Return 2009' to the Associated variables box.

6. Check Means.

7. Click OK.

Back in Table of Descriptive Statistics dialog box:

8. Click OK.
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Learning Objectives
In this chapter, you learn:

• To describe the properties of central tendency, variation,
and shape in numerical data

• To construct and interpret a boxplot

• To compute descriptive summary measures for a population

• To compute the covariance and the coefficient of correlation

Numerical Descriptive
Measures3



T he tables and charts you prepared for the sample of 184 bond mutual funds has
been useful to the customers of the Choice Is Yours service. However, customers
have become frustrated trying to evaluate bond fund performance. Although they
know how the 2009 returns are distributed, they have no idea what a typical 2009
rate of return is for a particular category of bond funds, such as intermediate gov-

ernment and short-term corporate bond funds. They also have no idea of the extent of the variability in
the 2009 rate of return. Are all the values relatively similar, or do they include very small and very
large values? Are there a lot of small values and a few large ones, or vice versa, or are there a similar
number of small and large values?

How could you help the customers get answers to these questions so that they could better evalu-
ate the bond funds?

U S I N G S TAT I S T I C S

@ Choice Is Yours, Part II

95
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T he customers in Part II of the Choice Is Yours scenario are asking questions about nu-
merical variables. When summarizing and describing numerical variables, you need
to do more than just prepare the tables and charts discussed in Chapter 2. You also

need to consider the central tendency, variation, and shape of each numerical variable.

CENTRAL TENDENCY
The central tendency is the extent to which the data values group around a typical or
central value.

VARIATION
The variation is the amount of dispersion, or scattering, of values away from a central value.

SHAPE
The shape is the pattern of the distribution of values from the lowest value to the highest
value.

This chapter discusses ways you can measure the central tendency, variation, and shape
of a variable. You will also learn about the covariance and the coefficient of correlation,
which help measure the strength of the association between two numerical variables.
Using these measures would give the customers of the Choice Is Yours service the answers
they seek.

3.1 Central Tendency
Most sets of data show a distinct tendency to group around a central value. When people talk
about an “average value” or the “middle value” or the “most frequent value,” they are talking
informally about the mean, median, and mode—three measures of central tendency.

The Mean
The arithmetic mean (typically referred to as the mean) is the most common measure of cen-
tral tendency. The mean is the only common measure in which all the values play an equal role.
The mean serves as a “balance point” in a set of data (like the fulcrum on a seesaw). You com-
pute the mean by adding together all the values in a data set and then dividing that sum by the
number of values in the data set.

The symbol called X-bar, is used to represent the mean of a sample. For a sample con-
taining n values, the equation for the mean of a sample is written as

Using the series to represent the set of n values and n to represent the number of
values in the sample, the equation becomes

By using summation notation (discussed fully in Appendix A), you replace the numerator

with the term which means sum all the values from the first XXi©
n

i=1
Xi,X1 + X2 + Á + Xn

X =
X1 + X2 + Á + Xn

n

X1, X2 ,Á , Xn

X =
sum of the values

number of values

X,
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SAMPLE MEAN
The sample mean is the sum of the values in a sample divided by the number of values in
the sample.

(3.1)

where

sample mean
number of values or sample size
ith value of the variable X

summation of all values in the sampleXia
n

i=1
Xi =

Xi =
n =
X =

X =
a

n

i=1
Xi

n

Because all the values play an equal role, a mean is greatly affected by any value that is
greatly different from the others. When you have such extreme values, you should avoid using
the mean as a measure of central tendency.

The mean can suggest a typical or central value for a data set. For example, if you knew
the typical time it takes you to get ready in the morning, you might be able to better plan your
morning and minimize any excessive lateness (or earliness) going to your destination. Follow-
ing the Define, Collect, Organize, Visualize, and Analyze approach, you first define the time
to get ready as the time (rounded to the nearest minute) from when you get out of bed to when
you leave your home. Then, you collect the times shown below for 10 consecutive workdays
(stored in ):

1 2 3 4 5 6 7 8 9 10

The first statistic that you compute to analyze these data is the mean. For these data, the
mean time is 39.6 minutes, computed as follows:

Even though no individual day in the sample actually had the value 39.6 minutes, allotting
about 40 minutes to get ready would be a good rule for planning your mornings. The mean is a
good measure of central tendency here because the data set does not contain any exceptionally
small or large values.

=
396

10
= 39.6

X =
39 + 29 + 43 + 52 + 39 + 44 + 40 + 31 + 44 + 35

10

X =
a

n

i=1
Xi

n

X =
sum of the values

number of values

Time 1minutes2: 39 29 43 52 39 44 40 31 44 35

Day:

Times

value, to the last X value, to form Equation (3.1), a formal definition of the sample
mean.

Xn,X1,
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The Mean Calories
for Cereals
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Consider a case in which the value on Day 4 is 102 minutes instead of 52 minutes. This
extreme value causes the mean to rise to 44.6 minutes, as follows:

The one extreme value has increased the mean from 39.6 to 44.6 minutes. In contrast to the
original mean that was in the “middle” (i.e., was greater than 5 of the getting-ready times and
less than the 5 other times), the new mean is greater than 9 of the 10 getting-ready times.
Because of the extreme value, now the mean is not a good measure of central tendency.

X =
446

10
= 44.6

X =
a

n

i=1
Xi

n

X =
sum of the values

number of values

Nutritional data about a sample of seven breakfast cereals (stored in ) includes the
number of calories per serving:

Cereals

The Median
The median is the middle value in an ordered array of data that has been ranked from smallest
to largest. Half the values are smaller than or equal to the median, and half the values are larger
than or equal to the median. The median is not affected by extreme values, so you can use the
median when extreme values are present.

To compute the median for a set of data, you first rank the values from smallest to largest
and then use Equation (3.2) to compute the rank of the value that is the median.

Cereal Calories

Kellogg’s All Bran 80
Kellogg Corn Flakes 100
Wheaties 100
Nature’s Path Organic Multigrain Flakes 110
Kellogg Rice Krispies 130
Post Shredded Wheat Vanilla Almond 190
Kellogg Mini Wheats 200

Compute the mean number of calories in these breakfast cereals.

SOLUTION The mean number of calories is 130, computed as follows:

=
910

7
= 130

X =
a

n

i=1
Xi

n

X =
sum of the values

number of values

MEDIAN

(3.2)Median =
n + 1

2
 ranked value



EXAMPLE 3.2
Computing the
Median From an
Odd-Sized Sample

3.1 Central Tendency 99

You compute the median by following one of two rules:

• Rule 1 If the data set contains an odd number of values, the median is the measure-
ment associated with the middle-ranked value.

• Rule 2 If the data set contains an even number of values, the median is the measure-
ment associated with the average of the two middle-ranked values.

To further analyze the sample of 10 times to get ready in the morning, you can compute
the median. To do so, you rank the daily times as follows:

Because the result of dividing by 2 is for this sample of 10, you
must use Rule 2 and average the measurements associated with the fifth and sixth ranked val-
ues, 39 and 40. Therefore, the median is 39.5. The median of 39.5 means that for half the days,
the time to get ready is less than or equal to 39.5 minutes, and for half the days, the time to get
ready is greater than or equal to 39.5 minutes. In this case, the median time to get ready of 39.5
minutes is very close to the mean time to get ready of 39.6 minutes.

110 + 12>2 = 5.5n + 1

Median = 39.5

c

 1 2 3 4 5 6 7 8 9 10Ranks:

29 31 35 39 39 40 43 44 44 52Ranked values:

Nutritional data about a sample of seven breakfast cereals (stored in ) includes the
number of calories per serving (see Example 3.1 on page 98). Compute the median number of
calories in breakfast cereals.

SOLUTION Because the result of dividing by 2 is for this sample of
seven, using Rule 1, the median is the measurement associated with fourth ranked value. The
number of calories per serving data are ranked from the smallest to the largest:

1 2 3 4 5 6 7

The median number of calories is 110. Half the breakfast cereals have equal to or less
than 110 calories per serving, and half the breakfast cereals have equal to or more than
110 calories.

Median = 110

c

Ranks:

80 100 100 110 130 190 200Ranked values:

17 + 12>2 = 4n + 1

Cereals

The Mode
The mode is the value in a set of data that appears most frequently. Like the median
and unlike the mean, extreme values do not affect the mode. Often, there is no mode
or there are several modes in a set of data. For example, consider the following time-to-get-
ready data:

There are two modes, 39 minutes and 44 minutes, because each of these values occurs twice.

29 31 35 39 39 40 43 44 44 52
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Data with No Mode

EXAMPLE 3.3
Determining the
Mode
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A systems manager in charge of a company’s network keeps track of the number of server fail-
ures that occur in a day. Determine the mode for the following data, which represents the num-
ber of server failures in a day for the past two weeks:

SOLUTION The ordered array for these data is

Because 3 occurs five times, more times than any other value, the mode is 3. Thus, the systems
manager can say that the most common occurrence is having three server failures in a day. For
this data set, the median is also equal to 3, and the mean is equal to 4.5. The value 26 is an ex-
treme value. For these data, the median and the mode are better measures of central tendency
than the mean.

0 0 1 2 2 3 3 3 3 3 4 6 7 26

1 3 0 3 26 2 7 4 0 2 3 3 6 3

A set of data has no mode if none of the values is “most typical.” Example 3.4 presents a data
set that has no mode.

The bounced check fees ($) for a sample of 10 banks is

Compute the mode.

SOLUTION These data have no mode. None of the values is most typical because each value
appears once.

26 28 20 21 22 25 18 23 15 30

The Geometric Mean
When you want to measure the rate of change of a variable over time, you need to use the geo-
metric mean instead of the arithmetic mean. Equation (3.3) defines the geometric mean.

GEOMETRIC MEAN
The geometric mean is the nth root of the product of n values.

(3.3)XG = 1X1 * X2 * Á * Xn21>n

The geometric mean rate of return measures the average percentage return of an investment
per time period. Equation (3.4) defines the geometric mean rate of return.

GEOMETRIC MEAN RATE OF RETURN

(3.4)

where

rate of return in time period iRi =

RG = 311 + R12 * 11 + R22 * Á * 11 + Rn241>n - 1

To illustrate these measures, consider an investment of $100,000 that declined to a value
of $50,000 at the end of Year 1 and then rebounded back to its original $100,000 value at the
end of Year 2. The rate of return for this investment per year for the two-year period is 0



EXAMPLE 3.5
Computing the
Geometric Mean 
Rate of Return
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The percentage change in the Russell 2000 Index of the stock prices of 2,000 small companies
was in 2008 and 27.17% in 2009. Compute the geometric mean rate of return per year.

SOLUTION Using Equation (3.4), the geometric mean rate of return per year in the Russell
2000 Index for the two years is

The geometric mean rate of return in the Russell 2000 Index for the two years is
8.24% per year.-

= 0.9176 - 1 = -0.0824

= 30.841992541>2 - 1

= 310.66212 * 11.2717241>2 - 1

= 311 + (-0.33792) * 11 + (0.27172)41>2 - 1

RG = 311 + R12 * 11 + R2241>n - 1

-33.79%

because the starting and ending value of the investment is unchanged. However, the arithmetic
mean of the yearly rates of return of this investment is

because the rate of return for Year 1 is

and the rate of return for Year 2 is

Using Equation (3.4), the geometric mean rate of return per year for the two years is

Thus, the geometric mean rate of return more accurately reflects the (zero) change in the value
of the investment per year for the two-year period than does the arithmetic mean.

= 1 - 1 = 0

= 31.041>2 - 1

= 310.502 * 12.0241>2 - 1

= 311 + ( - 0.502) * 11 + (1.02)41>2 - 1

RG = 311 + R12 * 11 + R2241>n - 1

R2 = a100,000 - 50,000

50,000
b = 1.00  or  100%

R1 = a50,000 - 100,000

100,000
b = -0.50  or -50%

X =
1-0.502 + 11.002

2
= 0.25  or  25%

3.2 Variation and Shape
In addition to central tendency, every data set can be characterized by its variation and shape.
Variation measures the spread, or dispersion, of values in a data set. One simple measure of
variation is the range, the difference between the largest and smallest values. More commonly
used in statistics are the standard deviation and variance, two measures explained later in this
section. The shape of a data set represents a pattern of all the values, from the lowest to highest



EXAMPLE 3.6
Computing the 
Range in the 
Calories in 
Cereals
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RANGE
The range is equal to the largest value minus the smallest value.

(3.5)Range = Xlargest - Xsmallest

Nutritional data about a sample of seven breakfast cereals (stored in ) includes the
number of calories per serving (see Example 3.1 on page 98). Compute the range of the num-
ber of calories for the cereals.

SOLUTION Ranked from smallest to largest, the calories for the seven cereals are

Therefore, using Equation (3.5), the The largest difference in the
number of calories between any cereals is 120.

range = 200 - 80 = 120.

80 100 100 110 130 190 200

Cereals

The range measures the total spread in the set of data. Although the range is a simple mea-
sure of the total variation in the data, it does not take into account how the data are distributed
between the smallest and largest values. In other words, the range does not indicate whether
the values are evenly distributed throughout the data set, clustered near the middle, or clus-
tered near one or both extremes. Thus, using the range as a measure of variation when at least
one value is an extreme value is misleading.

The Variance and the Standard Deviation
Being a simple measure of variation, the range does not consider how the values distribute or
cluster between the extremes. Two commonly used measures of variation that take into account
how all the data values are distributed are the variance and the standard deviation. These sta-
tistics measure the “average” scatter around the mean—how larger values fluctuate above it
and how smaller values fluctuate below it.

A simple measure of variation around the mean might take the difference between each
value and the mean and then sum these differences. However, if you did that, you would find
that because the mean is the balance point in a set of data, for every set of data, these differ-
ences sum to zero. One measure of variation that differs from data set to data set squares the
difference between each value and the mean and then sums these squared differences. In sta-
tistics, this quantity is called a sum of squares (SS). This sum is then divided by the number
of values minus 1 (for sample data), to get the sample variance The square root of the
sample variance is the sample standard deviation (S).

Because this sum of squares will always be nonnegative according to the rules of algebra,
neither the variance nor the standard deviation can ever be negative. For virtually all sets of

1S22.

value. As you will learn later in this section, many data sets have a pattern that looks approxi-
mately like a bell, with a peak of values somewhere in the middle.

The Range
The range is the simplest numerical descriptive measure of variation in a set of data.

To further analyze the sample of 10 times to get ready in the morning, you can compute
the range. To do so, you rank the data from smallest to largest:

Using Equation (3.5), the range is minutes. The range of 23 minutes indicates
that the largest difference between any two days in the time to get ready in the morning is
23 minutes.

52 - 29 = 23

29 31 35 39 39 40 43 44 44 52
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SAMPLE VARIANCE
The sample variance is the sum of the squared differences around the mean divided by the
sample size minus 1.

(3.6)

where

sample mean
sample size
ith value of the variable X

summation of all the squared differences between

the values and XXi

a
n

i=1
1Xi - X 22 =

Xi =
n =

X =

S2 =
a

n

i=1
1Xi - X22
n - 1

data, the variance and standard deviation will be a positive value. Both of these statistics will
be zero only if there is no variation in a set of data which happens only when each value in the
sample is the same.

For a sample containing n values, the sample variance (given by the
symbol ) is

Equation (3.6) expresses the sample variance using summation notation, and Equation (3.7)
expresses the sample standard deviation.

S2 =
1X1 - X22 + 1X2 - X 22 + Á + 1Xn - X22

n - 1

S2
X1, X2, X3, Á , Xn,

If the denominator were n instead of Equation (3.6) [and the inner term in Equa-
tion (3.7)] would compute the average of the squared differences around the mean. However,

is used because the statistic has certain mathematical properties that make it desir-
able for statistical inference (see Section 7.4 on page 258). As the sample size increases, the
difference between dividing by n and by becomes smaller and smaller.

In practice, you will most likely use the sample standard deviation as the measure of variation
[defined in Equation (3.7)]. Unlike the sample variance, which is a squared quantity, the standard
deviation is always a number that is in the same units as the original sample data. The standard de-
viation helps you see how a set of data clusters or distributes around its mean. For almost all sets
of data, the majority of the observed values lie within an interval of plus and minus one standard
deviation above and below the mean. Therefore, knowledge of the mean and the standard devia-
tion usually helps define where at least the majority of the data values are clustering.

To hand-compute the sample variance, and the sample standard deviation, S, do the
following:

1. Compute the difference between each value and the mean.
2. Square each difference.
3. Add the squared differences.
4. Divide this total by to get the sample variance.
5. Take the square root of the sample variance to get the sample standard deviation.

n - 1

S2,

n - 1

S2n - 1

n - 1,

SAMPLE STANDARD DEVIATION
The sample standard deviation is the square root of the sum of the squared differences
around the mean divided by the sample size minus 1.

(3.7)S = 2S2 = Qa
n

i=1
1Xi - X22
n - 1
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You can also compute the variance by substituting values for the terms in Equation (3.6):

Because the variance is in squared units (in squared minutes, for these data), to compute
the standard deviation, you take the square root of the variance. Using Equation (3.7) on page
103, the sample standard deviation, S, is

This indicates that the getting-ready times in this sample are clustering within 6.77 minutes
around the mean of 39.6 minutes (i.e., clustering between and

). In fact, 7 out of 10 getting-ready times lie within this interval.
Using the second column of Table 3.1, you can also compute the sum of the differences

between each value and the mean to be zero. For any set of data, this sum will always be zero:

This property is one of the reasons that the mean is used as the most common measure of
central tendency.

a
n

i=1
1Xi - X2 = 0 for all sets of data

X + 1S = 46.37
X - 1S = 32.83

S = 2S2 = Qa
n

i=1
1Xi - X22
n - 1

= 245.82 = 6.77

= 45.82

=
412.4

9

=
139 - 39.622 + 129 - 39.622 + Á + 135 - 39.622

10 - 1

S2 =
a

n

i=1
1Xi - X22
n - 1

T A B L E 3 . 1

Computing the Variance
of the Getting-Ready 
Times

Time (X)

X = 39.6
Step 1:1Xi - X2 Step 2:1Xi - X22

39 -0.60 0.36
29 -10.60 112.36
43 3.40 11.56
52 12.40 153.76
39 -0.60 0.36
44 4.40 19.36
40 0.40 0.16
31 -8.60 73.96
44 4.40 19.36
35 -4.60 21.16

Step 3:

Sum:
Step 4:

Divide by 1n - 12:
412.40 45.82

To further analyze the sample of 10 times to get ready in the morning, Table 3.1 shows the
first four steps for calculating the variance and standard deviation with a mean equal to 39.6.
(See page 97 for the calculation of the mean.) The second column of Table 3.1 shows step 1. The
third column of Table 3.1 shows step 2. The sum of the squared differences (step 3) is shown at the
bottom of Table 3.1. This total is then divided by to compute the variance (step 4).10 - 1 = 9

1X2
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Computing the
Variance and
Standard Deviation 
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Nutritional data about a sample of seven breakfast cereals (stored in ) includes the
number of calories per serving (see Example 3.1 on page 98). Compute the variance and stan-
dard deviation of the calories in the cereals.

SOLUTION Table 3.2 illustrates the computation of the variance and standard deviation for
the calories in the cereals.

Cereals

T A B L E 3 . 2

Computing the Variance
of the Calories in the
Cereals

Calories

X = 130
Step 1:1Xi - X2 Step 2:1Xi - X22

80 -50 2,500
100 -30 900
100 -30 900
110 -20 400
130 0 0
190 60 3,600
200 70 4,900

Step 3:

Sum:
Step 4: Divide by1n - 12:

13,200 2,200

Using Equation (3.6) on page 103:

Using Equation (3.7) on page 103, the sample standard deviation, S, is

The standard deviation of 46.9042 indicates that the calories in the cereals are clustering
within 46.9042 around the mean of 130 (i.e., clustering between and

. In fact, 57.1% (four out of seven) of the calories lie within this interval.X + 1S = 176.9042)
X - 1S = 83.0958

S = 2S2 = Qa
n

i=1
1Xi - X22
n - 1

= 22,200 = 46.9042

= 2,200

=
13,200

6

=
180 - 13022 + 1100 - 13022 + Á + 1200 - 13022

7 - 1

S2 =
a

n

i=1
1Xi - X22
n - 1

The characteristics of the range, variance, and standard deviation can be summarized as
follows:

• The greater the spread or dispersion of the data, the larger the range, variance, and stan-
dard deviation.

• The smaller the spread or dispersion of the data, the smaller the range, variance, and
standard deviation.



EXAMPLE 3.8
Comparing Two
Coefficients of
Variation When the
Two Variables Have
Different Units of
Measurement
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• If the values are all the same (so that there is no variation in the data), the range, vari-
ance, and standard deviation will all equal zero.

• None of the measures of variation (the range, variance, and standard deviation) can ever
be negative.

The Coefficient of Variation
Unlike the measures of variation presented previously, the coefficient of variation is a relative
measure of variation that is always expressed as a percentage rather than in terms of the units
of the particular data. The coefficient of variation, denoted by the symbol CV, measures the
scatter in the data relative to the mean.

COEFFICIENT OF VARIATION
The coefficient of variation is equal to the standard deviation divided by the mean,
multiplied by 100%.

(3.8)

where

sample standard deviation
sample meanX =

S =

CV = a S

X
b100%

For the sample of 10 getting-ready times, because and the coefficient of
variation is

For the getting-ready times, the standard deviation is 17.1% of the size of the mean.
The coefficient of variation is especially useful when comparing two or more sets of data

that are measured in different units, as Example 3.8 illustrates.

CV = aS

X
b100% = a6.77

39.6
b100% = 17.10%

S = 6.77,X = 39.6

Which varies more from cereal to cereal, the number of calories or the amount of sugar (in
grams)?

SOLUTION Because calories and the amount of sugar have different units of measurement,
you need to compare the relative variability in the two measurements.

For calories, from Example 3.7 on page 105, the coefficient of variation is

For the amount of sugar in grams, the values for the seven cereals are

For these data, and
Thus, the coefficient of variation is

Thus, relative to the mean, the amount of sugar is much more variable than the calories.

CVSugar = a3.3877

5.8571
b100% = 57.84%

S = 3.3877.X = 5.8571

6 2 4 4 4 11 10

CVCalories = a46.9042

130
b100% = 36.08%
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Z Scores
An extreme value or outlier is a value located far away from the mean. The Z score, which is
the difference between the value and the mean, divided by the standard deviation, is useful in
identifying outliers. Values located far away from the mean will have either very small (nega-
tive) Z scores or very large (positive) Z scores.

Z SCORE

(3.9)Z =
X - X

S

To further analyze the sample of 10 times to get ready in the morning, you can compute
the Z scores. Because the mean is 39.6 minutes, the standard deviation is 6.77 minutes, and the
time to get ready on the first day is 39.0 minutes, you compute the Z score for Day 1 by using
Equation (3.9):

Table 3.3 shows the Z scores for all 10 days.

= -0.09

=
39.0 - 39.6

6.77

Z =
X - X

S

T A B L E 3 . 3

Z Scores for the 10 
Getting-Ready Times

Time (X) Z Score

39 -0.90
29 -1.57
43 0.50
52 1.83
39 -0.09
44 0.65
40 0.06
31 -1.27
44 0.65
35 -0.68

Mean 39.6
Standard deviation 6.77

EXAMPLE 3.9
Computing the 
Z Scores of the 
Number of Calories
in Cereals

Nutritional data about a sample of seven breakfast cereals (stored in ) includes the
number of calories per serving (see Example 3.1 on page 98). Compute the Z scores of the
calories in breakfast cereals.

SOLUTION Table 3.4 on page 108 illustrates the Z scores of the calories for the cereals. The
largest Z score is 1.49, for a cereal with 200 calories. The lowest Z score is for a cereal
with 80 calories. There are no apparent outliers in these data because none of the Z scores are
less than or greater than +3.0.-3.0

-1.07

Cereals

The largest Z score is 1.83 for Day 4, on which the time to get ready was 52 minutes. The
lowest Z score is for Day 2, on which the time to get ready was 29 minutes. As a gen-
eral rule, a Z score is considered an outlier if it is less than or greater than None of
the times in this case meet that criterion to be considered outliers.

+3.0.-3.0
-1.57
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Shape
Shape is the pattern of the distribution of data values throughout the entire range of all the val-
ues. A distribution is either symmetrical or skewed. In a symmetrical distribution, the values be-
low the mean are distributed in exactly the same way as the values above the mean. In this case,
the low and high values balance each other out. In a skewed distribution, the values are not sym-
metrical around the mean. This skewness results in an imbalance of low values or high values.

Shape also can influence the relationship of the mean to the median. In most cases:

• Mean median: negative, or left-skewed
• Mean median: symmetric, or zero skewness
• Mean median: positive, or right-skewed

Figure 3.1 depicts three data sets, each with a different shape.

7
=
6

Panel A
Negative, or left-skewed

Panel B
Symmetrical

Panel C
Positive, or right-skewed

F I G U R E 3 . 1
A comparison of three
data sets that differ in
shape

T A B L E 3 . 4

Z Scores of the Number
of Calories in Cereals

Calories Z Scores

80 -1.07
100 -0.64
100 -0.64
110 -0.43
130 0.00
190 1.28
200 1.49

Mean 130
Standard deviation 46.9042

The data in Panel A are negative, or left-skewed. In this panel, most of the values are in
the upper portion of the distribution. A long tail and distortion to the left is caused by some
extremely small values. These extremely small values pull the mean downward so that the
mean is less than the median.

The data in Panel B are symmetrical. Each half of the curve is a mirror image of the
other half of the curve. The low and high values on the scale balance, and the mean equals the
median.

The data in Panel C are positive, or right-skewed. In this panel, most of the values are in
the lower portion of the distribution. A long tail on the right is caused by some extremely large
values. These extremely large values pull the mean upward so that the mean is greater than the
median.

Skewness and kurtosis are two shape-related statistics. The skewness statistic measures
the extent to which a set of data is not symmetric. The kurtosis statistic measures the
relative concentration of values in the center of the distribution of a data set, as compared with
the tails.

A symmetric distribution has a skewness value of zero. A right-skewed distribution has a
positive skewness value, and a left-skewed distribution has a negative skewness value.

A bell-shaped distribution has a kurtosis value of zero. A distribution that is flatter than a
bell-shaped distribution has a negative kurtosis value. A distribution with a sharper peak (one



EXAMPLE 3.10
Descriptive Statistics
for Intermediate 
Government and
Short-Term
Corporate
Bond Funds
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In Part II of the Choice Is Yours scenario, you are interested in comparing the past perform-
ance of the intermediate government bond and short-term corporate bond funds. One measure
of past performance is the return in 2009. You have already defined the variables to be col-
lected and collected the data from a sample of 184 bond funds. Compute descriptive statistics
for the intermediate government and short-term corporate bond funds.

SOLUTION Figure 3.2 presents a table of descriptive summary measures for the two types of
bond funds, as computed by Excel (left results) and Minitab (right results). The Excel results in-
clude the mean, standard error, median, mode, standard deviation, variance, kurtosis, skewness,
range, minimum, maximum, sum (which is meaningless for this example), and count (the sample
size). The standard error, discussed in Section 7.4, is the standard deviation divided by the square
root of the sample size. The Minitab results also include the coefficient of variation, the first quar-
tile, the third quartile, and the interquartile range (see Section 3.3 on pages 113-115).

F I G U R E 3 . 2
Excel and Minitab Descriptive statistics for the 2009 return for the intermediate government and short-term
corporate bond funds

that has a higher concentration of values in the center of the distribution than a bell-shaped
distribution) has a positive kurtosis value.

In examining the results, you see that there are large differences in the 2009 return for the in-
termediate government bond and short-term corporate bond funds. The intermediate government
bond funds had a mean 2009 return of 4.4529 and a median return of 4.4. This compares to a
mean of 9.5959 and a median of 9.1 for the short-term corporate bond funds. The medians indi-
cate that half of the intermediate government bond funds had returns of 4.4 or better, and half the
short-term corporate bond funds had returns of 9.1 or better. You conclude that the short-term
corporate bond funds had a much higher return than the intermediate government bond funds.

The intermediate government corporate bond funds had a slightly smaller standard devia-
tion than the short-term corporate bond funds (5.3606, as compared to 5.6867). While both the
intermediate government bond funds and the short-term corporate bond funds showed right or
positive skewness, the intermediate government bond funds were more skewed. The kurtosis
of both the intermediate government and the short-term corporate bond funds was very posi-
tive, indicating a distribution that was much more peaked than a bell-shaped distribution.
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Problems for Sections 3.1 and 3.2
LEARNING THE BASICS
3.1 The following set of data is from a sample of 

a. Compute the mean, median, and mode.
b. Compute the range, variance, standard deviation, and

coefficient of variation.
c. Compute the Z scores. Are there any outliers?
d. Describe the shape of the data set.

3.2 The following set of data is from a sample of

a. Compute the mean, median, and mode.
b. Compute the range, variance, standard deviation, and

coefficient of variation.
c. Compute the Z scores. Are there any outliers?
d. Describe the shape of the data set.

3.3 The following set of data is from a sample of 

a. Compute the mean, median, and mode.
b. Compute the range, variance, standard deviation, and

coefficient of variation.
c. Compute the Z scores. Are there any outliers?

12 7 4 9 0 7 3

n = 7:

7 4 9 7 3 12

n = 6:

7 4 9 8 2

n = 5:

d. Describe the shape of the data set.

3.4 The following set of data is from a sample of 

a. Compute the mean, median, and mode.
b. Compute the range, variance, standard deviation, and

coefficient of variation.
c. Compute the Z scores. Are there any outliers?
d. Describe the shape of the data set.

3.5 Suppose that the rate of return for a particular stock
during the past two years was 10% and 30%. Compute the
geometric rate of return per year. (Note: A rate of return of
10% is recorded as 0.10, and a rate of return of 30% is
recorded as 0.30.)

3.6 Suppose that the rate of return for a particular stock
during the past two years was 20% and 30%. Compute the
geometric rate of return per year.

APPLYING THE CONCEPTS

3.7 A survey conducted by the American Statistical
Association reported the results at the top of page 111 for
the salaries of professors teaching statistics in research uni-
versities with four to five years in the rank of associate pro-
fessor and professor.

-

7 -5 -8 7 9

n = 5:

Use the Visual Explorations Descriptive Statistics proce-
dure to see the effect of changing data values on meas-
ures of central tendency, variation, and shape. Open the
Visual Explorations add-in workbook (Visual Explo-
rations.xla) and:

1. Select Add-ins ➔ Visual Explorations ➔ Descriptive
Statistics.

2. Read the instructions in the Descriptive Statistics di-
alog box and then click OK (see the illustration at
right).

3. Experiment by entering an extreme value such as 5
into one of the tinted column A cells.

Which measures are affected by this change? Which ones
are not? You can switch between the “before” and “after”
diagrams by repeatedly pressing Ctrl+Z (undo) followed
by Ctrl+Y (redo) to better see the changes the extreme
value has caused in the diagram. (To learn more about
Visual Explorations, see Appendix Section D.4.)

V I S U A L E X P L O R AT I O N S Exploring Descriptive Statistics
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Interpret the median salary for the associate professors and
professors.

3.8 The operations manager of a plant that manufactures
tires wants to compare the actual inner diameters of two
grades of tires, each of which is expected to be 575 millime-
ters. A sample of five tires of each grade was selected, and
the results representing the inner diameters of the tires,
ranked from smallest to largest, are as follows:

a. Compute the mean, median, and mode.
b. Compute the variance, standard deviation, range, coeffi-

cient of variation, and Z scores.
c. Are the data skewed? If so, how?
d. Compare the results of (a) through (c) to those of Prob-

lem 3.12 (a) through (c) that refer to the miles per gallon
of small SUVs.

3.12 The file contains the overall miles per gallon
(MPG) of 2010 small SUVs:

Source: Data extracted from “Vehicle Ratings,” Consumer Reports,
April 2010, pp. 33–34.

a. Compute the mean, median, and mode.
b. Compute the variance, standard deviation, range, coeffi-

cient of variation, and Z scores.
c. Are the data skewed? If so, how?
d. Compare the results of (a) through (c) to those of Prob-

lem 3.11 (a) through (c) that refer to the miles per gallon
of family sedans.

3.13 The file contains the cost (in cents)
per 1-ounce serving for a sample of 13 chocolate chip cook-
ies. The data are as follows:

Source: Data extracted from “Chip, Chip, Hooray,” Consumer
Reports, June 2009, p. 7.

a. Compute the mean, median, and mode.
b. Compute the variance, standard deviation, range, coeffi-

cient of variation, and Z scores. Are there any outliers?
Explain.

c. Are the data skewed? If so, how?
d. Based on the results of (a) through (c), what conclusions

can you reach concerning the cost of chocolate chip
cookies?

3.14 The file contains the cost per ounce
($) for a sample of 14 dark chocolate bars:

Source: Data extracted from “Dark Chocolate: Which Bars Are
Best?” Consumer Reports, September 2007, p. 8.

a. Compute the mean, median, and mode.
b. Compute the variance, standard deviation, range, coeffi-

cient of variation, and Z scores. Are there any outliers?
Explain.

c. Are the data skewed? If so, how?
d. Based on the results of (a) through (c), what conclusions

can you reach concerning the cost of dark chocolate
bars?

0.57 1.51 0.57 0.55 0.86 1.41 0.90

0.68 0.72 0.92 1.14 1.42 0.94 0.77

DarkChocolate

54 22 25 23 36 43 7 43 25 47 24 45 44

ChocolateChip

21 18 19 21 22 22 16 16

26 26 19 19 19 21 21 21 21

24 23 22 21 22 22 18 18 26

SUV

Title Median

Associate professor 82,400
Professor 108,600

Source: Data extracted from K. Crank, “Academic Salary Survey,”
AmStat News, December 2009, p. 34.

a. For each of the two grades of tires, compute the mean,
median, and standard deviation.

b. Which grade of tire is providing better quality? Explain.
c. What would be the effect on your answers in (a) and (b) if

the last value for grade Y were 588 instead of 578? Explain.

3.9 According to the U.S. Census Bureau, in February
2010, the median sales price of new houses was $220,500
and the mean sales price was $282,600 (extracted from
www.census.gov, March 24, 2010).
a. Interpret the median sales price.
b. Interpret the mean sales price.
c. Discuss the shape of the distribution of the price of new

houses.

3.10 The file contains the amount that
a sample of nine customers spent for lunch ($) at

a fast-food restaurant:

a. Compute the mean and median.
b. Compute the variance, standard deviation, range, and co-

efficient of variation.
c. Are the data skewed? If so, how?
d. Based on the results of (a) through (c), what conclusions

can you reach concerning the amount that customers
spent for lunch?

3.11 The file contains the overall miles per gallon
(MPG) of 2010 family sedans:

Source: Data extracted from “Vehicle Ratings,” Consumer Reports,
April 2010, p. 29.

22 22 44 32 20 20 22 20 39 20
24 21 22 23 24 34 34 34 20 20

Sedans

4.20 5.03 5.86 6.45 7.38 7.54 8.46 8.47 9.87

FastFoodSELF
Test

Grade X Grade Y

568 570 575 578 584 573 574 575 577 578

www.census.gov
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3.15 Is there a difference in the variation of the yields of
different types of investments? The file
contains the yields for a money market account and a five-
year certificate of deposit (CD), for 25 banks in the United
States, as of March 29, 2010.
Source: Data extracted from www.Bankrate.com, March 29, 2010.

a. For money market accounts and five-year CDs, sepa-
rately compute the variance, standard deviation, range,
and coefficient of variation.

b. Based on the results of (a), do money market accounts or
five-year CDs have more variation in the yields offered?
Explain.

3.16 The file contains the room price (in $) paid
by U.S. travelers in six British cities in 2009:

Source: Data extracted from www.hotels.com/press/hotel-price-
index-2009-h2.html.

a. Compute the mean, median, and mode.
b. Compute the range, variance, and standard deviation.
c. Based on the results of (a) and (b), what conclusions can

you reach concerning the room price (in $) paid by U.S.
travelers in 2009?

d. Suppose that the first value was 85 instead of 185.
Repeat (a) through (c), using this value. Comment on the
difference in the results.

3.17 A bank branch located in a commercial district of a
city has the business objective of developing an improved
process for serving customers during the noon-to-1:00 P.M.
lunch period. The waiting time, in minutes, is defined as the
time the customer enters the line to when he or she reaches
the teller window. Data are collected from a sample of
15 customers during this hour. The file contains the
results, which are also listed here:

a. Compute the mean and median.
b. Compute the variance, standard deviation, range, coefficient

of variation, and Z scores. Are there any outliers? Explain.
c. Are the data skewed? If so, how?
d. As a customer walks into the branch office during the

lunch hour, she asks the branch manager how long she can
expect to wait. The branch manager replies, “Almost cer-
tainly less than five minutes.” On the basis of the results of
(a) through (c), evaluate the accuracy of this statement.

3.18 Suppose that another bank branch, located in a resi-
dential area, is also concerned with the noon-to-1 P.M. lunch
hour. The waiting time, in minutes, collected from a sample
of 15 customers during this hour, is contained in the file

and listed here:

10.49 6.68 5.64 4.08 6.17 9.91 5.47

9.66 5.90 8.02 5.79 8.73 3.82 8.01 8.35

Bank2

4.50 6.10 0.38 5.12 6.46 6.19 3.79

4.21 5.55 3.02 5.13 4.77 2.34 3.54 3.20

Bank1

185 160 126 116 112 105

HotelUK

SavingsRate-MMCD

a. Compute the mean and median.
b. Compute the variance, standard deviation, range, coeffi-

cient of variation, and Z scores. Are there any outliers?
Explain.

c. Are the data skewed? If so, how?
d. As a customer walks into the branch office during the

lunch hour, he asks the branch manager how long he
can expect to wait. The branch manager replies, “Al-
most certainly less than five minutes.” On the basis of
the results of (a) through (c), evaluate the accuracy of
this statement.

3.19 General Electric (GE) is one of the world’s largest
companies; it develops, manufactures, and markets a wide
range of products, including medical diagnostic imaging de-
vices, jet engines, lighting products, and chemicals. In 2008,
the stock price dropped 53.94%, while in 2009, the stock
price rose 0.13%.
Source: Data extracted from finance.yahoo.com, March 30, 2010.

a. Compute the geometric mean rate of return per year for
the two-year period 2008–2009. (Hint: Denote an in-
crease of 0.13% as )

b. If you purchased $1,000 of GE stock at the start of 2008,
what was its value at the end of 2009?

c. Compare the result of (b) to that of Problem 3.20 (b).

3.20 TASER International, Inc., develops, manufactures,
and sells nonlethal self-defense devices known as tasers. Mar-
keting primarily to law enforcement, corrections institutions,
and the military, TASER’s popularity has enjoyed a roller-
coaster ride. The stock price in 2008 decreased by 63.31%,
and in 2009, the stock price decreased by 17.05%.
Source: Data extracted from finance.yahoo.com, March 30, 2010.

a. Compute the geometric mean rate of return per year for
the two-year period 2008–2009. (Hint: Denote a decrease
of 63.31% as )

b. If you purchased $1,000 of TASER stock at the start of
2008, what was its value at the end of 2009?

c. Compare the result of (b) to that of Problem 3.19 (b).

3.21 In 2009, all the major stock market indices increased
dramatically as they recovered from the world financial cri-
sis that occurred in 2008. The data in the following table
(stored in ) represent the total rate of return (in per-
centage) for the Dow Jones Industrial Average (DJIA), the
Standard & Poor’s 500 (S&P 500), and the technology-
heavy NASDAQ Composite (NASDAQ) from 2006
through 2009.

Indices

R1 = -0.6331.

R2 = 0.0013.

Year DJIA S&P 500 NASDAQ

2009 18.8 23.5 43.9
2008 -33.8 -38.5 -40.5
2007 6.4 3.5 9.8
2006 16.3 13.6 9.5

Source: Data extracted from finance.yahoo.com, April 1, 2010.

www.Bankrate.com
www.hotels.com/press/hotel-priceindex-2009-h2.html
www.hotels.com/press/hotel-priceindex-2009-h2.html
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a. Compute the geometric mean rate of return per year for
the DJIA, S&P 500, and NASDAQ from 2006 through
2009.

b. What conclusions can you reach concerning the geomet-
ric mean rates of return per year of the three market in-
dices?

c. Compare the results of (b) to those of Problem 3.22 (b).

3.22 In 2006–2009, the value of precious metals
changed rapidly. The data in the following table (con-
tained in the file ) represent the total rate of return
(in percentage) for platinum, gold, and silver from 2006
through 2009:

Metals

a. Compute the geometric mean rate of return per year for
platinum, gold, and silver from 2006 through 2009.

b. What conclusions can you reach concerning the geomet-
ric mean rates of return of the three precious metals?

c. Compare the results of (b) to those of Problem 3.21 (b).

Year Platinum Gold Silver

2009 62.7 25.0 56.8
2008 -41.3 4.3 -26.9
2007 36.9 31.9 14.4
2006 15.9 23.2 46.1

Source: Data extracted from www.kitco.com, April 1, 2010.

3.3 Exploring Numerical Data
Sections 3.1 and 3.2 discuss measures of central tendency, variation, and shape. An additional
way of describing numerical data is through an exploratory data analysis that computes the
quartiles and the five-number summary and constructs a boxplot. You can also supplement
these methods by displaying descriptive statistics across several categorical variables using the
multidimensional table technique that Section 2.7 discusses.

Quartiles
Quartiles split a set of data into four equal parts—the first quartile, , divides the smallest
25.0% of the values from the other 75.0% that are larger. The second quartile, , is the
median—50.0% of the values are smaller than or equal to the median and 50.0% are larger
than or equal to the median. The third quartile, , divides the smallest 75.0% of the values
from the largest 25.0%. Equations (3.10) and (3.11) define the first and third quartiles.1

Q3

Q2

Q1

FIRST QUARTILE,
25.0% of the values are smaller than or equal to the first quartile, and 75.0% are larger
than or equal to the first quartile,

(3.10)Q1 =
n + 1

4
 ranked value

Q1.
Q1,

Q1

1The median, and are also
the 25th, 50th, and 75th per-
centiles, respectively. Equations
(3.2), (3.10), and (3.11) can be
expressed generally in terms of
finding percentiles: th

ranked value, where the
proportion.

p =
percentile = p * 1n + 12

1p * 1002

Q3Q1,

THIRD QUARTILE,
75.0% of the values are smaller than or equal to the third quartile, and 25.0% are larger
than or equal to the third quartile,

(3.11)Q3 =
31n + 12

4
 ranked value

Q3.
Q3,

Q3

Use the following rules to compute the quartiles from a set of ranked values:

• Rule 1 If the ranked value is a whole number, the quartile is equal to the measurement
that corresponds to that ranked value. For example, if the sample size the first
quartile, is equal to the measurement associated with the second
ranked value.

• Rule 2 If the ranked value is a fractional half (2.5, 4.5, etc.), the quartile is equal to
the measurement that corresponds to the average of the measurements corresponding to
the two ranked values involved. For example, if the sample size the first quartile,n = 9,

17 + 12>4 =Q1,
n = 7,

www.kitco.com
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In Excel, the QUARTILE
function uses different rules
to compute quartiles. Use the
COMPUTE worksheet of the
Quartiles workbook,
discussed in Section EG3.3,
to compute quartiles using
the rules presented in this
section.

EXAMPLE 3.11
Computing the 
Quartiles

Nutritional data about a sample of seven breakfast cereals (stored in ) includes the
number of calories per serving (see Example 3.1 on page 98). Compute the first quartile
and third quartile numbers of calories for the cereals.

SOLUTION Ranked from smallest to largest, the number of calories for the seven cereals
are as follows:

1 2 3 4 5 6 7

For these data

Therefore, using Rule 1, is the second ranked value. Because the second ranked value
is 100, the first quartile, is 100.

To compute the third quartile,

Therefore, using Rule 1, is the sixth ranked value. Because the sixth ranked value is 190,
is 190.
The first quartile of 100 indicates that 25% of the cereals have calories that are below or

equal to 100 and 75% are greater than or equal to 100. The third quartile of 190 indicates that
75% of the cereals have calories that are below or equal to 190 and 25% are greater than or
equal to 190.

Q3

Q3

=
317 + 12

4
 ranked value = 6th ranked value

Q3 =
31n + 12

4
 ranked value

Q3,
Q1,

Q1

=
7 + 1

4
 ranked value = 2nd ranked value

Q1 =
1n + 12

4
 ranked value

Ranks:

80 100 100 110 130 190 200Ranked values:

1Q32
1Q12

Cereals

is equal to the ranked value, halfway between the second ranked
value and the third ranked value.

• Rule 3 If the ranked value is neither a whole number nor a fractional half, you round
the result to the nearest integer and select the measurement corresponding to that ranked
value. For example, if the sample size the first quartile, is equal to the

ranked value. Round 2.75 to 3 and use the third ranked value.

To further analyze the sample of 10 times to get ready in the morning, you can compute
the quartiles. To do so, you rank the data from smallest to largest:

1 2 3 4 5 6 7 8 9 10

The first quartile is the ranked value. Using Rule 3,
you round up to the third ranked value. The third ranked value for the time-to-get-ready data is
35 minutes. You interpret the first quartile of 35 to mean that on 25% of the days, the time to
get ready is less than or equal to 35 minutes, and on 75% of the days, the time to get ready is
greater than or equal to 35 minutes.

The third quartile is the ranked value. Using Rule 3
for quartiles, you round this down to the eighth ranked value. The eighth ranked value is 44
minutes. Thus, on 75% of the days, the time to get ready is less than or equal to 44 minutes,
and on 25% of the days, the time to get ready is greater than or equal to 44 minutes.

31n + 12>4 = 3110 + 12>4 = 8.25

1n + 12>4 = 110 + 12>4 = 2.75

Ranks:

29 31 35 39 39 40 43 44 44 52Ranked values:

110 + 12>4 = 2.75
Q1,n = 10,

19 + 12>4 = 2.5Q1,
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EXAMPLE 3.12
Computing the
Interquartile Range
for the Number of
Calories in Cereals

The Interquartile Range
The interquartile range is the difference between the third and first quartiles in a set of data.

INTERQUARTILE RANGE
The interquartile range (also called midspread) is the difference between the third
quartile and the first quartile.

(3.12)Interquartile range = Q3 - Q1

The interquartile range measures the spread in the middle 50% of the data. Therefore, it is
not influenced by extreme values. To further analyze the sample of 10 times to get ready in the
morning, you can compute the interquartile range. You first order the data as follows:

You use Equation (3.12) and the earlier results above, and

Therefore, the interquartile range in the time to get ready is 9 minutes. The interval 35 to 44 is
often referred to as the middle fifty.

Interquartile range = 44 - 35 = 9 minutes

Q3 = 44:Q1 = 35

29 31 35 39 39 40 43 44 44 52

Nutritional data about a sample of seven breakfast cereals (stored in ) includes the
number of calories per serving (see Example 3.1 on page 98). Compute the interquartile range
of the numbers of calories in cereals.

SOLUTION Ranked from smallest to largest, the numbers of calories for the seven cereals
are as follows:

Using Equation (3.12) and the earlier results from Example 3.11 on page 114, and

Therefore, the interquartile range of the number of calories in cereals is 90 calories.

Interquartile range = 190 - 100 = 90

Q3 = 190:
Q1 = 100

80 100 100 110 130 190 200

Cereals

Because the interquartile range does not consider any value smaller than or larger than
it cannot be affected by extreme values. Descriptive statistics such as the median,

and the interquartile range, which are not influenced by extreme values, are called resistant
measures.

The Five-Number Summary
A five-number summary, which consists of the following, provides a way to determine the
shape of a distribution:

Table 3.5 explains how the relationships among these five numbers allows you to recog-
nize the shape of a data set.

Xsmallest Q1 Median Q3 Xlargest

Q1, Q3,Q3,
Q1
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T A B L E 3 . 5
Relationships Among the Five-Number Summary and the Type of Distribution

Type of Distribution

Comparison Left-Skewed Symmetric Right-Skewed

The distance from to
the median versus the distance
from the median to Xlargest.

Xsmallest The distance from to the
median is greater than the
distance from the median to
Xlargest.

Xsmallest The two distances
are the same.

The distance from to
the median is less than the
distance from the median to
Xlargest.

Xsmallest

The distance from to
versus the distance from
to Xlargest.Q3

Q1

Xsmallest The distance from to
is greater than the distance from

to Xlargest.Q3

Q1Xsmallest The two distances
are the same.

The distance from to
is less than the distance

from to Xlargest.Q3

Q1

Xsmallest

The distance from to the
median versus the distance
from the median to Q3.

Q1 The distance from to the
median is greater than the
distance from the median to Q3.

Q1 The two distances
are the same.

The distance from to the
median is less than the distance
from the median to Q3.

Q1

To further analyze the sample of 10 times to get ready in the morning, you can compute the
five-number summary. For these data, the smallest value is 29 minutes, and the largest
value is 52 minutes (see page 97). Calculations done on pages 99 and 114 show that
the and Therefore, the five-number summary is as follows:

The distance from to the median is slightly less than the dis-
tance from the median to The distance from to

is slightly less than the distance from to The
distance from to the median is the same as the distance from the me-
dian to Therefore, the getting-ready times are slightly right-skewed.Q3 144 - 39.5 = 4.52.

139.5 - 35 = 4.52Q1

Xlargest 152 - 44 = 82.Q3Q1 135 - 29 = 62
XsmallestX largest 152 - 39.5 = 12.52.

139.5 - 29 = 10.52Xsmallest

29 35 39.5 44 52

Q3 = 44.median = 39.5, Q1 = 35,

EXAMPLE 3.13
Computing the Five-
Number Summary of
the Number of Calo-
ries in Cereals

Nutritional data about a sample of seven breakfast cereals (stored in ) includes the
number of calories per serving (see Example 3.1 on page 98). Compute the five-number sum-
mary of the numbers of calories in cereals.

SOLUTION From previous computations for the calories in cereals (see pages 98 and 114),
you know that the and

In addition, the smallest value in the data set is 80, and the largest value is 200. Therefore,
the five-number summary is as follows:

The three comparisons listed in Table 3.5 are used to evaluate skewness. The distance from
to the median is less than the distance from the

median to The distance from to is the more than the dis-
tance from to The distance from to the median

is less than the distance from the median to Two
comparisons indicate a right-skewed distribution, whereas the other indicates a left-skewed
distribution. Therefore, given the small sample size and the conflicting results, the shape is not
clearly determined.

Q3 1190 - 110 = 802.100 = 102
1110 -Q1Xlargest 1200 - 190 = 102.Q3

Q1 1100 - 80 = 202XsmallestXlargest.
1200 - 110 = 9021110 - 80 = 302Xsmallest

80 100 110 190 200

Q3 = 190.median = 110, Q1 = 100,

Cereals
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The Boxplot
A boxplot provides a graphical representation of the data based on the five-number summary.
To further analyze the sample of 10 times to get ready in the morning, you can construct a box-
plot, as displayed in Figure 3.3.

Xsmallest XlargestQ1 Median Q3

20 25 30 35 40
Time (minutes)

45 50 55

F I G U R E 3 . 3
Boxplot for the getting-
ready times

The vertical line drawn within the box represents the median. The vertical line at the left side
of the box represents the location of and the vertical line at the right side of the box repre-
sents the location of Thus, the box contains the middle 50% of the values. The lower 25%
of the data are represented by a line connecting the left side of the box to the location of the
smallest value, Similarly, the upper 25% of the data are represented by a line connect-
ing the right side of the box to 

The boxplot of the getting-ready times in Figure 3.3 indicates slight right-skewness because
the distance between the median and the highest value is slightly greater than the distance be-
tween the lowest value and the median. Also, the right tail is slightly longer than the left tail.

Xlargest.
Xsmallest.

Q3.
Q1,

EXAMPLE 3.14
Boxplots of the 
2009 Returns of 
Intermediate
Government and
Short-Term
Corporate Bond
Funds

In Part II of the Choice Is Yours scenario, you are interested in comparing the past perform-
ance of the intermediate government bond and short-term corporate bond funds. One measure
of past performance is the return in 2009. You have already defined the variables to be col-
lected and collected the data from a sample of 184 bond funds. Construct the boxplot of the
2009 returns for the intermediate government bond and short-term corporate bond funds.

SOLUTION Figure 3.4 contains the five-number summaries and Excel boxplots of the 2009
return for the intermediate government and short-term corporate bond funds. Figure 3.5 dis-
plays the Minitab boxplots for the same data. Note that in Figure 3.5 on page 118, several *
appear in the boxplots. These indicate outliers that are more than 1.5 times the interquartile
range beyond the quartiles.

F I G U R E 3 . 4
Excel five-number summaries and boxplots of the 2009 return for intermediate government
bond and short-term corporate bond funds

The median return, the quartiles, and the minimum and maximum returns are much higher
for the short-term corporate bond funds than for the intermediate government bond funds. The
median return for the short-term corporate bond funds is higher than the third quartile return
for the intermediate government bond funds. The first quartile return (5.70) for the short-term
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corporate bond funds is higher than the median return (4.40) for the intermediate government
bond funds. Both the intermediate government bond and short-term corporate bond funds are
right-skewed, with a very long tail in the upper part of the range. These results are consistent
with the statistics computed in Figure 3.2 on page 109.

F I G U R E 3 . 5
Minitab boxplots of the
2009 return for
intermediate
government bond and
short-term corporate
bond funds

Panel A
Bell-shaped distribution

Panel B
Left-skewed distribution

Panel C
Right-skewed distribution

Panel D
Rectangular distribution

F I G U R E 3 . 6
Boxplots and
corresponding density
curves for four
distributions

The distributions in Panels A and D of Figure 3.6 are symmetric. In these distributions,
the mean and median are equal. In addition, the length of the left tail is equal to the length of
the right tail, and the median line divides the box in half.

The distribution in Panel B of Figure 3.6 is left-skewed. The few small values distort
the mean toward the left tail. For this left-skewed distribution, there is a heavy clustering of
values at the high end of the scale (i.e., the right side); 75% of all values are found between
the left edge of the box and the end of the right tail . There is a long left tail
that contains the smallest 25% of the values, demonstrating the lack of symmetry in this
data set.

The distribution in Panel C of Figure 3.6 is right-skewed. The concentration of values is
on the low end of the scale (i.e., the left side of the boxplot). Here, 75% of all values are
found between the beginning of the left tail and the right edge of the box . There is a long
right tail that contains the largest 25% of the values, demonstrating the lack of symmetry in this
data set.

1Q32

1Xlargest21Q12

Figure 3.6 demonstrates the relationship between the boxplot and the density curve for
four different types of distributions. The area under each density curve is split into quartiles
corresponding to the five-number summary for the boxplot.
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Problems for Section 3.3
LEARNING THE BASICS
3.23 The following is a set of data from a sample of

a. Compute the first quartile the third quartile
and the interquartile range.

b. List the five-number summary.
c. Construct a boxplot and describe its shape.
d. Compare your answer in (c) with that from Problem 3.3

(d) on page 110. Discuss.

3.24 The following is a set of data from a sample of

a. Compute the first quartile the third quartile
and the interquartile range.

b. List the five-number summary.
c. Construct a boxplot and describe its shape.
d. Compare your answer in (c) with that from Problem 3.2

(d) on page 110. Discuss.

3.25 The following is a set of data from a sample of

a. Compute the first quartile the third quartile
and the interquartile range.

b. List the five-number summary.
c. Construct a boxplot and describe its shape.
d. Compare your answer in (c) with that from Problem 3.1

(d) on page 110. Discuss.

3.26 The following is a set of data from a sample of

a. Compute the first quartile the third quartile
and the interquartile range.

b. List the five-number summary.
c. Construct a boxplot and describe its shape.
d. Compare your answer in (c) with that from Problem 3.4

(d) on page 110. Discuss.

APPLYING THE CONCEPTS
3.27 The file contains the cost (in cents)
per 1-ounce serving, for a sample of 13 chocolate chip
cookies. The data are as follows:

Source: Data extracted from “Chip, Chip, Hooray,” Consumer
Reports, June 2009, p. 7.

a. Compute the first quartile the third quartile
and the interquartile range.

b. List the five-number summary.
c. Construct a boxplot and describe its shape.

1Q32,1Q12,

54 22 25 23 36 43 7 43 25 47 24 45 44

ChocolateChip

1Q32,1Q12,
7 -5 -8 7 9

n = 5:

1Q32,1Q12,
7 4 9 8 2

n = 5:

1Q32,1Q12,
7 4 9 7 3 12

n = 6:

1Q32,1Q12,
12 7 4 9 0 7 3

n = 7:
3.28 The file contains the cost ($)
per ounce for a sample of 14 dark chocolate bars:

Source: Data extracted from “Dark Chocolate: Which Bars Are
Best?” Consumer Reports, September 2007, pp. 8.

a. Compute the first quartile the third quartile
and the interquartile range.

b. List the five-number summary.
c. Construct a boxplot and describe its shape.

3.29 The file contains the room price (in $) paid
by U.S. travelers in six British cities in 2009:

Source: Data extracted from www.hotels.com/press/hotel-price-
index-2009-h2.html.

a. Compute the first quartile the third quartile
and the interquartile range.

b. List the five-number summary.
c. Construct a boxplot and describe its shape.

3.30 The file contains the overall miles per gallon
(MPG) of 2010 small SUVs:

Source: Data extracted from “Vehicle Ratings,” Consumer Reports,
April 2010, pp. 33–34.

a. Compute the first quartile the third quartile
and the interquartile range.

b. List the five-number summary.
c. Construct a boxplot and describe its shape.

3.31 The file contains the yields for a
money market account and a five-year certificate of deposit
(CD), for 25 banks in the United States, as of March 29, 2010.
Source: Data extracted from www.Bankrate.com, March 29, 2010.

For each type of account:
a. Compute the first quartile the third quartile

and the interquartile range.
b. List the five-number summary.
c. Construct a boxplot and describe its shape.

3.32 A bank branch located in a commercial district of a
city has the business objective of developing an improved
process for serving customers during the noon-to-1:00 P.M.
lunch period. The waiting time, in minutes, is defined as the
time the customer enters the line to when he or she reaches
the teller window. Data are collected from a sample of
15 customers during this hour. The file contains the
results, which are listed at the top of page 120:

Bank1

1Q32,1Q12,

SavingsRate-MMCD

1Q32,1Q12,

21 18 19 21 22 22 16 16

26 26 19 19 19 21 21 21 21

24 23 22 21 22 22 18 18 26

SUV

1Q32,1Q12,

185 160 126 116 112 105

HotelUK

1Q32,1Q12,

0.57 0.55 0.86 1.41 0.90

0.68 0.72 0.92 1.14 1.42 0.94 0.77 0.57 1.51

Dark ChocolateSELF
Test

www.hotels.com/press/hotel-priceindex-2009-h2.html
www.hotels.com/press/hotel-priceindex-2009-h2.html
www.Bankrate.com
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Another bank branch, located in a residential area, is also con-
cerned with the noon-to-1 P.M. lunch hour. The waiting times,
in minutes, collected from a sample of 15 customers during
this hour, are contained in the file and listed here:

a. List the five-number summaries of the waiting times at
the two bank branches.

b. Construct boxplots and describe the shapes of the distri-
butions for the two bank branches.

c. What similarities and differences are there in the distri-
butions of the waiting times at the two bank branches?

3.33 For this problem, use the data in .
a. Construct a multidimensional table of the mean 2008 re-

turn by type and risk.
b. Construct a multidimensional table of the standard devia-

tion of the 2008 return by type and risk.
c. What conclusions can you reach concerning differences

between the type of bond funds (intermediate govern-
ment and short-term corporate) based on risk factor (low,
average, and high)?

d. Compare the results in (a)–(c) to the 2009 returns (stored
in ).

3.34 For this problem, use the data in .
a. Construct a multidimensional table of the mean three-

year return by type and risk.

Bond Funds2008

Bond Funds

Bond Funds2008

10.49 6.68 5.64 4.08 6.17 9.91 5.47

9.66 5.90 8.02 5.79 8.73 3.82 8.01 8.35

Bank2

4.50 6.10 0.38 5.12 6.46 6.19 3.79

4.21 5.55 3.02 5.13 4.77 2.34 3.54 3.20 b. Construct a multidimensional table of the standard devia-
tion of the three-year return by type and risk.

c. What conclusions can you reach concerning differences
between the type of bond funds (intermediate govern-
ment and short-term corporate) based on risk factor (low,
average, and high)?

d. Compare the results in (a)–(c) to the three-year returns
from 2007–2009 (stored in ).

3.35 For this problem, use the data in .
a. Construct a multidimensional table of the mean five-year

return by type and risk.
b. Construct a multidimensional table of the standard devia-

tion of the five-year return by type and risk.
c. What conclusions can you reach concerning differences

between the type of bond funds (intermediate govern-
ment and short-term corporate) based on risk factor (low,
average, and high)?

d. Compare the results in (a)–(c) to the five-year returns
from 2005–2009 (stored in ).

3.36 For this problem, use the data in .
a. Construct a multidimensional table of the mean 2008

return by type, fees, and risk.
b. Construct a multidimensional table of the standard devia-

tion of the 2008 return by type, fees, and risk.
c. What conclusions can you reach concerning differences

between the type of bond funds (intermediate govern-
ment and short-term corporate) based on fees (yes or no)
and risk factor (low, average, and high)?

d. Compare the results in (a)–(c) to the 2009 returns (stored
in ).Bond Funds

Bond Funds2008

Bond Funds

Bond Funds2008

Bond Funds

3.4 Numerical Descriptive Measures for a Population
Sections 3.1 and 3.2 presented various statistics that described the properties of central ten-
dency and variation for a sample. If your data set represents numerical measurements for an
entire population, you need to compute and interpret parameters for a population. In this sec-
tion, you will learn about three population parameters: the population mean, population vari-
ance, and population standard deviation.

To help illustrate these parameters, first review Table 3.6, which contains the one-year
returns for the five largest bond funds (in terms of total assets) as of April 27, 2010 (stored in

).LargestBonds

T A B L E 3 . 6

One-Year Return for the
Population Consisting of
the Five Largest Bond
Funds

Bond Fund One-Year Return

PIMCO: Total Rtn;Inst 14.8
American Funds Bond;A 16.5
Dodge Cox Income 16.5
Vanguard Tot Bd;Inv 7.6
Vanguard Int-TmTx;Adm 6.6

Source: Data extracted from The Wall Street Journal, April 27,
2010, p. C4.
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POPULATION MEAN
The population mean is the sum of the values in the population divided by the population
size, N.

(3.13)

where

population mean
ith value of the variable X

summation of all values in the population

number of values in the populationN =

Xia
N

i=1
Xi =

Xi =
m =

m =
a
N

i=1
Xi

N

The Population Mean
The population mean is represented by the symbol the Greek lowercase letter mu.
Equation (3.13) defines the population mean.

m,

To compute the mean one-year return for the population of bond funds given in Table 3.6,
use Equation (3.13):

Thus, the mean percentage return for these bond funds is 12.4.

The Population Variance and Standard Deviation
The population variance and the population standard deviation are parameters that meas-
ure variation in a population. As was the case for the sample statistics, the population standard
deviation is the square root of the population variance. The symbol the Greek lowercase
letter sigma squared, represents the population variance, and the symbol the Greek lower-
case letter sigma, represents the population standard deviation. Equations (3.14) and (3.15)
define these parameters. The denominators for the right-side terms in these equations use
N and not the term that is used in the equations for the sample variance and standard
deviation [see Equations (3.6) and (3.7) on page 103].

1n - 12

s,
s2,

m =
a
N

i=1
Xi

N
=

14.8 + 16.5 + 16.5 + 7.6 + 6.6

5
=

62.0

5
= 12.4

POPULATION VARIANCE
The population variance is the sum of the squared differences around the population mean
divided by the population size, N.

(3.14)

where

population mean
ith value of the variable X

summation of all the squared differences between

the values and mXi

a
N

i=1
1Xi - m22 =

Xi =
m =

s2 =
a
N

i=1
1Xi - m22

N
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POPULATION STANDARD DEVIATION

(3.15)s = Qa
N

i=1
1Xi - m22

N

To compute the population variance for the data of Table 3.6, you use Equation (3.14):

=
96.06

5
= 19.212

=
5.76 + 16.81 + 16.81 + 23.04 + 33.64

5

=
114.8 - 12.422 + 116.5 - 12.422 + 116.5 - 12.422 + 17.6 - 12.422 + 16.6 - 12.422

5

s2 =
a
N

i=1
1Xi - m22

N

Thus, the variance of the one-year returns is 19.212 squared percentage return. The
squared units make the variance difficult to interpret. You should use the standard deviation
that is expressed in the original units of the data (percentage return). From Equation (3.15),

Therefore, the typical percentage return differs from the mean of 12.4 by approximately
4.3831. This large amount of variation suggests that these large bond funds produce results
that differ greatly.

The Empirical Rule
In most data sets, a large portion of the values tend to cluster somewhere near the median. In
right-skewed data sets, this clustering occurs to the left of the mean—that is, at a value less than
the mean. In left-skewed data sets, the values tend to cluster to the right of the mean—that is,
greater than the mean. In symmetric data sets, where the median and mean are the same, the
values often tend to cluster around the median and mean, producing a bell-shaped distribution.
You can use the empirical rule to examine the variability in bell-shaped distributions:

• Approximately 68% of the values are within standard deviation from the mean.
• Approximately 95% of the values are within standard deviations from the mean.
• Approximately 99.7% of the values are within standard deviations from the mean.

The empirical rule helps you measure how the values distribute above and below the mean and
can help you identify outliers. The empirical rule implies that for bell-shaped distributions, only
about 1 out of 20 values will be beyond two standard deviations from the mean in either direction.
As a general rule, you can consider values not found in the interval as potential outliers.
The rule also implies that only about 3 in 1,000 will be beyond three standard deviations from the
mean. Therefore, values not found in the interval are almost always considered outliers.m ; 3s

m ; 2s

;3
;2
;1

s = 2s2 = Qa
N

i=1
1Xi - m22

N
= A96.06

5
= 4.3831
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EXAMPLE 3.15
Using the Empirical
Rule

A population of 2 liter bottles of cola is known to have a mean fill-weight of 2.06 liters
and a standard deviation of 0.02 liters. The population is known to be bell-shaped. Describe the
distribution of fill-weights. Is it very likely that a bottle will contain less than 2 liters of cola?

SOLUTION

Using the empirical rule, you can see that approximately 68% of the bottles will contain between
2.04 and 2.08 liters, approximately 95% will contain between 2.02 and 2.10 liters, and approxi-
mately 99.7% will contain between 2.00 and 2.12 liters. Therefore, it is highly unlikely that a bot-
tle will contain less than 2 liters.

m ; 3s = 2.06 ; 310.022 = 12.00, 2.122
m ; 2s = 2.06 ; 210.022 = 12.02, 2.102
m ; s = 2.06 ; 0.02 = 12.04, 2.082

For heavily skewed data sets and those not appearing to be bell-shaped, you should use the
Chebyshev rule, discussed next, instead of the empirical rule.

The Chebyshev Rule
The Chebyshev rule (see reference 1) states that for any data set, regardless of shape, the percent-
age of values that are found within distances of k standard deviations from the mean must be at least

a1 -
1

k2
b * 100%

% of Values Found in Intervals Around
the Mean

Interval
Chebyshev

(any distribution)

Empirical Rule 
(bell-shaped
distribution)

1m - s, m + s2 At least 0% Approximately 68%
1m - 2s, m + 2s2 At least 75% Approximately 95%
1m - 3s, m + 3s2 At least 88.89% Approximately 99.7%

T A B L E 3 . 7

How Data Vary Around
the Mean

You can use this rule for any value of k greater than 1. For example, consider The
Chebyshev rule states that at least of the values must be found
within standard deviations of the mean.

The Chebyshev rule is very general and applies to any distribution. The rule indicates at least
what percentage of the values fall within a given distance from the mean. However, if the data set
is approximately bell-shaped, the empirical rule will more accurately reflect the greater concen-
tration of data close to the mean. Table 3.7 compares the Chebyshev and empirical rules.

;2
31 - 11>2224 * 100% = 75%

k = 2.

EXAMPLE 3.16
Using the 
Chebyshev Rule

As in Example 3.15, a population of 2-liter bottles of cola is known to have a mean fill-weight
of 2.06 liters and a standard deviation of 0.02 liters. However, the shape of the population is
unknown, and you cannot assume that it is bell-shaped. Describe the distribution of fill-
weights. Is it very likely that a bottle will contain less than 2 liters of cola?
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You can use these two rules to understand how data are distributed around the mean when
you have sample data. With each rule, you use the value you computed for in place of and
the value you computed for S in place of The results you compute using the sample statis-
tics are approximations because you used sample statistics and not population parame-
ters 1m,s2. 1X, S2s.

mX

LEARNING THE BASICS

3.37 The following is a set of data for a population with

a. Compute the population mean.
b. Compute the population standard deviation.

3.38 The following is a set of data for a population with

a. Compute the population mean.
b. Compute the population standard deviation.

APPLYING THE CONCEPTS

3.39 The file contains the quarterly sales tax receipts
(in thousands of dollars) submitted to the comptroller of the
Village of Fair Lake for the period ending March 2010 by all
50 business establishments in that locale:

10.5 7.6 10.1 8.9 8.6

a. Compute the mean, variance, and standard deviation for
this population.

9.3 11.5 10.7 11.6 7.8
12.5 9.3 10.4 12.7 10.5
10.0 12.9 9.2 10.0 12.8
11.6 15.1 12.5 6.5 7.5
11.1 10.2 11.1 9.9 9.8
8.0 11.8 8.7 10.6 9.5

13.0 11.2 7.3 5.3 12.5
13.0 6.7 11.0 8.4 10.3
10.3 11.1 9.6 9.0 14.5

Tax

7 5 6 6 6 4 8 6 9 3

N = 10:

7 5 11 8 3 6 2 1 9 8

N = 10:

b. What percentage of these businesses have quarterly sales
tax receipts within or standard deviations of
the mean?

c. Compare your findings with what would be expected on
the basis of the empirical rule. Are you surprised at the
results in (b)?

3.40 Consider a population of 1,024 mutual funds that pri-
marily invest in large companies. You have determined that

the mean one-year total percentage return achieved by all
the funds, is 8.20 and that the standard deviation, is 2.75.
a. According to the empirical rule, what percentage of these

funds are expected to be within standard deviation of
the mean?

b. According to the empirical rule, what percentage of these
funds are expected to be within standard deviations
of the mean?

c. According to the Chebyshev rule, what percentage of
these funds are expected to be within or
standard deviations of the mean?

d. According to the Chebyshev rule, at least 93.75% of
these funds are expected to have one-year total returns
between what two amounts?

3.41 The file contains the state cigarette tax
($) for each of the 50 states as of December 31, 2009.
a. Compute the population mean and population standard

deviation for the state cigarette tax.
b. Interpret the parameters in (a).

3.42 The file contains the per capita energy con-
sumption, in kilowatt-hours, for each of the 50 states and the
District of Columbia during a recent year.
a. Compute the mean, variance, and standard deviation for

the population.
b. What proportion of these states has per capita energy

consumption within standard deviation of the mean,;1

Energy

CigaretteTax

;3;1, ;2,

;2

;1

s,
m,

;3;1, ;2,

Problems for Section 3.4

SOLUTION

Because the distribution may be skewed, you cannot use the empirical rule. Using the Cheby-
shev rule, you cannot say anything about the percentage of bottles containing between 2.04
and 2.08 liters. You can state that at least 75% of the bottles will contain between 2.02 and 2.10
liters and at least 88.89% will contain between 2.00 and 2.12 liters. Therefore, between 0 and
11.11% of the bottles will contain less than 2 liters.

m ; 3s = 2.06 ; 310.022 = 12.00, 2.122
m ; 2s = 2.06 ; 210.022 = 12.02, 2.102
m ; s = 2.06 ; 0.02 = 12.04, 2.082
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within standard deviations of the mean, and within
standard deviations of the mean?

c. Compare your findings with what would be expected
based on the empirical rule. Are you surprised at the
results in (b)?

d. Repeat (a) through (c) with the District of Columbia re-
moved. How have the results changed?

3.43 Thirty companies comprise the DJIA. Just how big
are these companies? One common method for measuring
the size of a company is to use its market capitalization,

;3
;2 which is computed by multiplying the number of stock

shares by the price of a share of stock. On March 29, 2010,
the market capitalization of these companies ranged from
Alcoa’s $14.7 billion to ExxonMobil’s $318.8 billion. The
entire population of market capitalization values is stored in

.

Source: Data extracted from money.cnn.com, March 29, 2010.

a. Compute the mean and standard deviation of the market
capitalization for this population of 30 companies.

b. Interpret the parameters computed in (a).

DowMarketCap

3.5 The Covariance and the Coefficient of Correlation
In Section 2.6, you used scatter plots to visually examine the relationship between two numer-
ical variables. This section presents two measures of the relationship between two numerical
variables: the covariance and the coefficient of correlation.

The Covariance
The covariance measures the strength of the linear relationship between two numerical variables
(X and Y). Equation (3.16) defines the sample covariance, and Example 3.17 illustrates its use.

SAMPLE COVARIANCE

(3.16)cov 1X, Y2 =
a

n

i=1
1Xi - X21Yi - Y2

n - 1

The covariance has a major flaw as a measure of the linear relationship between two nu-
merical variables. Because the covariance can have any value, you are unable to use it to deter-
mine the relative strength of the relationship. In other words, you cannot tell whether the value
3,115.7241 indicates a strong relationship or a weak relationship. To better determine the rela-
tive strength of the relationship, you need to compute the coefficient of correlation.

EXAMPLE 3.17
Computing the 
Sample Covariance

In Figure 2.15 on page 57, you constructed a scatter plot that showed the relationship between
the value and the annual revenue of the 30 teams that make up the National Basketball Associa-
tion (NBA) (extracted from www.forbes.com/lists/2009/32/basketball-values-09_NBA-Team-
Valuations_Rank.html; stored in ). Now, you want to measure the association
between the value of a franchise and annual revenue by computing the sample covariance.

SOLUTION Table 3.8 on page 126 provides the value and the annual revenue of the 30 teams.
Figure 3.7 on page 126 contains a worksheet that computes the covariance for these data.

The Calculations Area section of Figure 3.7 breaks down Equation (3.16) into a set of smaller
calculations. From cell F9, or by using Equation (3.16) directly, you find that the covariance
is 3,115.7241:

= 3,115.7241

cov1X, Y2 =
90,356

30 - 1

NBAValues

www.forbes.com/lists/2009/32/basketball-values-09_NBA-Team-Valuations_Rank.html
www.forbes.com/lists/2009/32/basketball-values-09_NBA-Team-Valuations_Rank.html
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F I G U R E 3 . 7
Excel worksheet to
compute the
covariance between
the value and the
annual revenue of the
30 NBA teams

T A B L E 3 . 8

Values and Annual
Revenues of the 30
NBA Teams (in
millions of 
dollars)

Team Value Revenue Team Value Revenue

Atlanta 306 103 Milwaukee 254 91
Boston 433 144 Minnesota 268 96
Charlotte 278 96 New Jersey 269 92
Chicago 511 168 New Orleans 267 95
Cleveland 476 159 New York 586 202
Dallas 446 154 Oklahoma City 310 111
Denver 321 115 Orlando 361 107
Detroit 479 171 Philadelphia 344 115
Golden State 315 113 Phoenix 429 148
Houston 470 160 Portland 338 121
Indiana 281 97 Sacramento 305 109
Los Angeles Clippers 295 102 San Antonio 398 133
Los Angeles Lakers 607 209 Toronto 386 133
Memphis 257 88 Utah 343 118
Miami 364 126 Washington 313 110
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The Coefficient of Correlation
The coefficient of correlation measures the relative strength of a linear relationship between
two numerical variables. The values of the coefficient of correlation range from for a
perfect negative correlation to for a perfect positive correlation. Perfect in this case
means that if the points were plotted on a scatter plot, all the points could be connected with
a straight line. 

When dealing with population data for two numerical variables, the Greek letter
is used as the symbol for the coefficient of correlation. Figure 3.8 illustrates three different
types of association between two variables.

r 1rho2

+1
-1

Y

Panel A
Perfect negative

correlation (r = –1)

X

Y

Panel B
No correlation

(r = 0)

X

Y

Panel C
Perfect positive

correlation (r = +1)

X

F I G U R E 3 . 8
Types of association
between variables

In Panel A of Figure 3.8, there is a perfect negative linear relationship between X and
Y. Thus, the coefficient of correlation, , equals and when X increases, Y decreases in
a perfectly predictable manner. Panel B shows a situation in which there is no relationship
between X and Y. In this case, the coefficient of correlation, equals 0, and as X in-
creases, there is no tendency for Y to increase or decrease. Panel C illustrates a perfect

r,

-1,r

SAMPLE COEFFICIENT OF CORRELATION

(3.17)

where

SY = Qa
n

i=1
1Yi - Y22
n - 1

SX = Qa
n

i=1
1Xi - X22
n - 1

cov1X, Y2 =
a

n

i=1
1Xi - X21Yi - Y2

n - 1

r =
cov1X, Y2

SXSY

positive relationship where equals In this case, Y increases in a perfectly predictable man-
ner when X increases.

Correlation alone cannot prove that there is a causation effect—that is, that the change in
the value of one variable caused the change in the other variable. A strong correlation can be
produced simply by chance, by the effect of a third variable not considered in the calculation
of the correlation, or by a cause-and-effect relationship. You would need to perform addi-
tional analysis to determine which of these three situations actually produced the correlation.
Therefore, you can say that causation implies correlation, but correlation alone does not imply
causation.

Equation (3.17) defines the sample coefficient of correlation (r).
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When you have sample data, you can compute the sample coefficient of correlation, r.
When using sample data, you are unlikely to have a sample coefficient of correlation of
exactly or Figure 3.9 presents scatter plots along with their respective sample coef-
ficients of correlation, r, for six data sets, each of which contains 100 values of X and Y.

In Panel A, the coefficient of correlation, r, is You can see that for small values of
X, there is a very strong tendency for Y to be large. Likewise, the large values of X tend to be
paired with small values of Y. The data do not all fall on a straight line, so the association
between X and Y cannot be described as perfect. The data in Panel B have a coefficient of

-0.9.

-1.+1, 0,

F I G U R E 3 . 9
Six scatter plots and their sample coefficients of correlation, r

Panel A

Panel C Panel D

Panel E Panel F

Panel B
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correlation equal to and the small values of X tend to be paired with large values of Y.
The linear relationship between X and Y in Panel B is not as strong as that in Panel A. Thus,
the coefficient of correlation in Panel B is not as negative as that in Panel A. In Panel C, the
linear relationship between X and Y is very weak, and there is only a slight tendency
for the small values of X to be paired with the large values of Y. Panels D through F depict data
sets that have positive coefficients of correlation because small values of X tend to be paired
with small values of Y and large values of X tend to be associated with large values of Y.
Panel D shows weak positive correlation, with Panel E shows stronger positive corre-
lation with Panel F shows very strong positive correlation, with r = 0.9.r = 0.6.

r = 0.3.

r = -0.3,

-0.6,

F I G U R E 3 . 1 0
Excel worksheet to
compute the sample
coefficient of correlation,
r, between the values
and revenues of 30 NBA
basketball teams

EXAMPLE 3.18
Computing the
Sample Coefficient
of Correlation

In Example 3.17 on page 125, you computed the covariance of the values and revenues of 30
NBA basketball teams. Using Figure 3.10 and Equation (3.17) on page 127, compute the sam-
ple coefficient of correlation.

SOLUTION

The value and revenue of the NBA teams are very highly correlated. The teams with the low-
est revenues have the lowest values. The teams with the highest revenues have the highest values.
This relationship is very strong, as indicated by the coefficient of correlation,

In general you cannot assume that just because two variables are correlated, changes in
one variable caused changes in the other variable. However, for this example, it makes sense to
conclude that changes in revenue would cause changes in the value of a team.

r = 0.9905.

= 0.9905

=
3,115.7241

132.45732196.91982

r =
cov1X, Y2

SXSY
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LEARNING THE BASICS
3.44 The following is a set of data from a sample of

items:

a. Compute the covariance.
b. Compute the coefficient of correlation.
c. How strong is the relationship between X and Y? Explain.

APPLYING THE CONCEPTS
3.45 A study of 218 students at Ohio State University sug-
gests a link between time spent on the social networking site
Facebook and grade point average. Students who rarely or
never used Facebook had higher grade point averages than
students who use Facebook.
Source: Data extracted from M. B. Marklein, “Facebook Use Linked
to Less Textbook Time,” www.usatoday.com, April 14, 2009.

a. Does the study suggest that time spent on Facebook and
grade point average are positively correlated or nega-
tively correlated?

b. Do you think that there might be a cause-and-effect rela-
tionship between time spent on Facebook and grade point
average? Explain.

3.46 The file lists the calories and sugar,
in grams, in one serving of seven breakfast cereals:

CerealsSELF
Test

Y 21 15 24 9 18 30 36 12 27 45 54

X  7 5 8 3 6 10 12  4 9 15 18

n = 11

a. Compute the covariance.
b. Compute the coefficient of correlation.
c. Which do you think is more valuable in expressing the

relationship between calories and sugar—the covariance
or the coefficient of correlation? Explain.

In summary, the coefficient of correlation indicates the linear relationship, or association,
between two numerical variables. When the coefficient of correlation gets closer to or
the linear relationship between the two variables is stronger. When the coefficient of correla-
tion is near 0, little or no linear relationship exists. The sign of the coefficient of correlation
indicates whether the data are positively correlated (i.e., the larger values of X are typically
paired with the larger values of Y) or negatively correlated (i.e., the larger values of X are typi-
cally paired with the smaller values of Y). The existence of a strong correlation does not imply
a causation effect. It only indicates the tendencies present in the data.

-1,+1

Problems for Section 3.5

Cereal Calories Sugar

Kellogg’s All Bran 80 6
Kellogg’s Corn Flakes 100 2
Wheaties 100 4
Nature’s Path Organic Multigrain

Flakes
110 4

Kellogg Rice Krispies 130 4
Post Shredded Wheat Vanilla

Almond
190 11

Kellogg Mini Wheats 200 10

Title
First

Weekend
U.S.

Gross
Worldwide

Gross

Sorcerer’s Stone 90.295 317.558 976.458
Chamber of Secrets 88.357 261.988 878.988
Prisoner of Azkaban 93.687 249.539 795.539
Goblet of Fire 102.335 290.013 896.013
Order of the 

Phoenix
77.108 292.005 938.469

Half-Blood Prince 77.836 301.460 934.601

Source: Data extracted from www.the-numbers.com/interactive/
comp-Harry-Potter.php.

d. Based on (a) and (b), what conclusions can you reach
about the relationship between calories and sugar?

3.47 Movie companies need to predict the gross receipts of
individual movies after a movie has debuted. The following
results, listed in , are the first weekend gross, the
U.S. gross, and the worldwide gross (in millions of dollars) of
the six Harry Potter movies that debuted from 2001 to 2009:

PotterMovies

a. Compute the covariance between first weekend gross and
U.S. gross, first weekend gross and worldwide gross, and
U.S. gross and worldwide gross.

b. Compute the coefficient of correlation between first
weekend gross and U.S. gross, first weekend gross and
worldwide gross, and U.S. gross and worldwide gross.

c. Which do you think is more valuable in expressing the
relationship between first weekend gross, U.S. gross, and
worldwide gross—the covariance or the coefficient of
correlation? Explain.

d. Based on (a) and (b), what conclusions can you reach
about the relationship between first weekend gross, U.S.
gross, and worldwide gross?

3.48 College basketball is big business, with coaches’
salaries, revenues, and expenses in millions of dollars. The
file contains the coaches’ salaries and
revenues for college basketball at 60 of the 65 schools that
played in the 2009 NCAA men’s basketball tournament
(data extracted from “Compensation for Division 1 Men’s
Basketball Coaches,” USA Today, April 2, 2010, p. 8C; and
C. Isadore, “Nothing but Net: Basketball Dollars by
School,” money.cnn.com/2010/03/18/news/companies/
basketball_profits/).

College Basketball

www.usatoday.com
www.the-numbers.com/interactive/comp-Harry-Potter.php
www.the-numbers.com/interactive/comp-Harry-Potter.php
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a. Compute the covariance.
b. Compute the coefficient of correlation.
c. Based on (a) and (b), what conclusions can you reach about

the relationship between coaches’ salaries and revenues?

3.49 College football players trying out for the NFL are
given the Wonderlic standardized intelligence test. The file

contains the average Wonderlic score of football
players trying out for the NFL and the graduation rate for
football players at selected schools.

Wonderlic

Source: Data extracted from S. Walker, “The NFL’s Smartest Team,”
The Wall Street Journal, September 30, 2005, pp. W1, W10.

a. Compute the covariance.
b. Compute the coefficient of correlation.
c. Based on (a) and (b), what conclusions can you reach

about the relationship between the average Wonderlic
score and graduation rate?

3.6 Descriptive Statistics: Pitfalls and Ethical Issues
This chapter describes how a set of numerical data can be characterized by the statistics that
measure the properties of central tendency, variation, and shape. In business, descriptive statis-
tics such as the ones you have learned about are frequently included in summary reports that
are prepared periodically.

The volume of information available on the Internet, in newspapers, and in magazines has
produced much skepticism about the objectivity of data. When you are reading information
that contains descriptive statistics, you should keep in mind the quip often attributed to the
famous nineteenth-century British statesman Benjamin Disraeli: “There are three kinds of lies:
lies, damned lies, and statistics.”

For example, in examining statistics, you need to compare the mean and the median. Are
they similar, or are they very different? Or, is only the mean provided? The answers to these
questions will help you determine whether the data are skewed or symmetrical and whether
the median might be a better measure of central tendency than the mean. In addition, you
should look to see whether the standard deviation or interquartile range for a very skewed set
of data has been included in the statistics provided. Without this, it is impossible to determine
the amount of variation that exists in the data.

Ethical considerations arise when you are deciding what results to include in a report. You
should document both good and bad results. In addition, when making oral presentations and
presenting written reports, you need to give results in a fair, objective, and neutral manner.
Unethical behavior occurs when you selectively fail to report pertinent findings that are detri-
mental to the support of a particular position.

In Part II of the Choice Is Yours scenario, you were hired by the
Choice Is Yours investment company to assist investors interested in
bond mutual funds. A sample of 184 bond mutual funds included 87
intermediate government funds and 97 short-term corporate bond

funds. By comparing these two categories, you were able to provide in-
vestors with valuable insights.

U S I N G S TAT I S T I C S @ Choice Is Yours, Part II Revisited

The 2009 returns for both the intermediate government funds and the short-term corpo-
rate bond funds were right-skewed, as indicated by the boxplots (see Figures 3.4 and 3.5 on
pages 117 and 118). The descriptive statistics (see Figure 3.2 on page 109) allowed you to
compare the central tendency and variability of returns of the intermediate government funds
and the short-term corporate bond funds. The mean indicated that the intermediate government
funds returned an average of 4.4529, and the median indicated that half of the funds had re-
turns of 4.4 or more. The short-term corporate bond funds’ central tendencies were much
higher than those of the intermediate government funds—they had an average of 9.5959, and
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S U M M A R Y
In this chapter and the previous chapter, you studied de-
scriptive statistics—how you can visualize data through ta-
bles and charts and how you can use different statistics to
help analyze the data and reach conclusions. In Chapter 2,
you were able to visualize data by constructing bar and pie
charts, histograms, and other charts. In this chapter, you
learned how descriptive statistics such as the mean, median,
quartiles, range, and standard deviation are used to describe
the characteristics of central tendency, variability, and

shape. In addition, you constructed boxplots to visualize the
distribution of the data. You also learned how the coefficient
of correlation is used to describe the relationship between
two numerical variables. Table 3.9 provides a list of the de-
scriptive statistics covered in this chapter.

In the next chapter, the basic principles of probability
are presented in order to bridge the gap between the
subject of descriptive statistics and the subject of inferential
statistics.

T A B L E 3 . 9

Summary of Descriptive
Statistics

Type of Analysis Numerical Data

Describing central tendency,
variation, and shape of a
numerical variable

Mean, median, mode, quartiles, range, interquartile
range, variance, standard deviation, coefficient of
variation, Z scores, boxplot (Sections 3.1 through 3.4)

Describing the relationship
between two numerical
variables

Covariance, coefficient of correlation (Section 3.5)

K E Y E Q U AT I O N S
Sample Mean

(3.1)

Median

(3.2)

Geometric Mean

(3.3)

Geometric Mean Rate of Return

(3.4)

Range

(3.5)Range = Xlargest - Xsmallest

RG = 3(1 + R1) * (1 + R2) * Á * (1 + Rn)41>n - 1

XG = (X1 * X2 * Á * Xn)
1>n

Median =
n + 1

2
 ranked value

X =
a

n

i=1
Xi

n

Sample Variance

(3.6)

Sample Standard Deviation

(3.7)

Coefficient of Variation

(3.8)

Z Score

(3.9)Z =
X - X

S

CV = aS

X
b100%

S = 2S2 = Qa
n

i=1
(Xi - X )2

n - 1

S2 =
a

n

i=1
(Xi - X )2

n - 1

half the funds had returns above 9.1. The intermediate government funds showed slightly less
variability than the short-term corporate funds with a standard deviation of 5.36 as compared
to 5.69. An interesting insight is that while 25% of the intermediate government funds had re-
turns of 6.5 or higher 75% of the short-term corporate bond funds had returns of
5.7 or higher Although past performance is no assurance of future performance,
in 2009, the short-term corporate funds greatly outperformed the intermediate government
funds. (To see a situation where the opposite was true, open the file.)Bond Funds2008

1Q1 = 5.72.1Q3 = 6.52,



Chapter Review Problems 133

First Quartile,

(3.10)

Third Quartile,

(3.11)

Interquartile Range

(3.12)

Population Mean

(3.13)

Population Variance

(3.14)s2 =
a
N

i=1
(Xi - m)2

N

m =
a
N

i=1
Xi

N

Interquartile range = Q3 - Q1

Q3 =
3(n + 1)

4
 ranked value

Q3

Q1 =
n + 1

4
 ranked value

Q1 Population Standard Deviation

(3.15)

Sample Covariance

(3.16)

Sample Coefficient of Correlation

(3.17)r =
cov (X, Y )

SX SY

cov(X, Y) =
a

n

i=1
(Xi - X) (Yi - Y )

n - 1

s = Qa
N

i=1
(Xi - m)2

N

K E Y T E R M S
arithmetic mean 96
boxplot 117
central tendency 96
Chebyshev rule 123
coefficient of correlation 127
coefficient of variation 106
covariance 125
dispersion 101
empirical rule 122
extreme value 107
five-number summary 115
geometric mean 100
geometric mean rate of 

return 100
interquartile range 115
kurtosis 108

left-skewed 108
mean 96
median 98
midspread 115
mode 99
outlier 107
population mean 121
population standard deviation 121
population variance 121

first quartile 113
second quartile 113
third quartile 113

quartile 113
range 102
resistant measure 115
right-skewed 108

Q3 :
Q2 :
Q1 :

sample coefficient of 
correlation (r) 127

sample covariance 125
sample mean 97
sample standard deviation 103
sample variance 103
shape 96
skewed 108
skewness 108
spread 101
standard deviation 102
sum of squares (SS) 102
symmetrical 108
variance 102
variation 96
Z score 107

C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING
3.50 What are the properties of a set of numerical data?

3.51 What is meant by the property of central tendency?

3.52 What are the differences among the mean, median, and
mode, and what are the advantages and disadvantages of each?

3.53 How do you interpret the first quartile, median, and
third quartile?

3.54 What is meant by the property of variation?

3.55 What does the Z score measure?
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Title
Sample

Size Minimum Maximum
Standard
Deviation Mean Median

Green Belt 34 33,000 106,000 18,137 65,679 64,750
Manager 2,128 22,568 182,000 25,078 86,349 84,000
Quality
Engineer

1,262 24,000 186,000 19,256 74,314 72,100

Master
Black Belt

132 33,000 201,000 24,988 109,481 106,000

Source: Data extracted from J. D. Conklin, “Salary Survey: Seeing Green,” Quality
Progress, December 2009, p. 29.

a. Compute the mean, median, first quartile, and third quartile.
b. Compute the range, interquartile range, variance, stan-

dard deviation, and coefficient of variation.
c. Construct a boxplot. Are the data skewed? If so, how?
d. What would you tell a customer who enters the bank to

purchase this type of insurance policy and asks how long
the approval process takes?

3.63 One of the major measures of the quality of service
provided by an organization is the speed with which it re-
sponds to customer complaints. A large family-held depart-
ment store selling furniture and flooring, including carpet,
had undergone a major expansion in the past several years.
In particular, the flooring department had expanded from 2
installation crews to an installation supervisor, a measurer,
and 15 installation crews. The business objective of the
company was to reduce the time between when the com-
plaint is received and when it is resolved. During a recent
year, the company received 50 complaints concerning car-
pet installation. The data from the 50 complaints, organized
in , represent the number of days between the re-
ceipt of a complaint and the resolution of the complaint:

a. Compute the mean, median, first quartile, and third quartile.
b. Compute the range, interquartile range, variance, stan-

dard deviation, and coefficient of variation.
c. Construct a boxplot. Are the data skewed? If so, how?
d. On the basis of the results of (a) through (c), if you had

to tell the president of the company how long a customer
should expect to wait to have a complaint resolved, what
would you say? Explain.

3.64 A manufacturing company produces steel housings
for electrical equipment. The main component part of the
housing is a steel trough that is made of a 14-gauge steel
coil. It is produced using a 250-ton progressive punch press
with a wipe-down operation and two 90-degree forms
placed in the flat steel to make the trough. The distance from
one side of the form to the other is critical because of weath-
erproofing in outdoor applications. The company requires
that the width of the trough is between 8.31 inches and 8.61
inches. Data are collected from a sample of 49 troughs and
stored in , which contains the widths of the troughs
in inches as shown here:

a. Compute the mean, median, range, and standard devia-
tion for the width. Interpret these measures of central ten-
dency and variability.

8.396 8.447 8.405 8.439 8.411 8.427 8.420 8.498 8.409

8.460 8.444 8.429 8.460 8.412 8.420 8.410 8.405 8.323 8.420

8.436 8.413 8.489 8.414 8.481 8.415 8.479 8.429 8.458 8.462

8.476 8.382 8.484 8.403 8.414 8.419 8.385 8.465 8.498 8.447

8.312 8.343 8.317 8.383 8.348 8.410 8.351 8.373 8.481 8.422

Trough

27 4 52 30 22 36 26 20 23 33 68
165 32 29 28 29 26 25 1 14 13 13 10 5
19 126 110 110 29 61 35 94 31 26 5 12 4
54 5 35 137 31 27 152 2 123 81 74 27 11

Furniture

Compare the salaries of Green Belts, managers, quality en-
gineers, and Master Black Belts.

3.62 In New York State, savings banks are permitted to sell
a form of life insurance called savings bank life insurance
(SBLI). The approval process consists of underwriting, which
includes a review of the application, a medical information
bureau check, possible requests for additional medical infor-
mation and medical exams, and a policy compilation stage,
during which the policy pages are generated and sent to the
bank for delivery. The ability to deliver approved policies to
customers in a timely manner is critical to the profitability of
this service to the bank. During a period of one month, a ran-
dom sample of 27 approved policies was selected, and the fol-
lowing were the total processing times (stored in ):

45 48 17 17 17 91 92 63 50 51 69 16 17
73 19 16 64 28 28 31 90 60 56 31 56 22 18

Insurance

3.56 What are the differences among the various measures
of variation, such as the range, interquartile range, variance,
standard deviation, and coefficient of variation, and what
are the advantages and disadvantages of each?

3.57 How does the empirical rule help explain the ways in
which the values in a set of numerical data cluster and dis-
tribute?

3.58 How do the empirical rule and the Chebyshev rule
differ?

3.59 What is meant by the property of shape?

3.60 How do the covariance and the coefficient of correla-
tion differ?

APPLYING THE CONCEPTS
3.61 The American Society for Quality (ASQ) conducted
a salary survey of all its members. ASQ members work in
all areas of manufacturing and service-related institutions,
with a common theme of an interest in quality. For the sur-
vey, emails were sent to 58,614 members, and 7,869 valid
responses were received. The two most common job titles
were manager and quality engineer. Another title is Master
Black Belt, who is a person who takes a leadership role as
the keeper of the Six Sigma process (see Section 17.8). An
additional title is Green Belt, someone who works on Six
Sigma projects part-time. Descriptive statistics concerning
salaries for these four titles are given in the following table:
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b. List the five-number summary.
c. Construct a boxplot and describe its shape.
d. What can you conclude about the number of troughs that

will meet the company’s requirement of troughs being
between 8.31 and 8.61 inches wide?

3.65 The manufacturing company in Problem 3.64 also
produces electric insulators. If the insulators break when in
use, a short circuit is likely to occur. To test the strength of
the insulators, destructive testing is carried out to determine
how much force is required to break the insulators. Force is
measured by observing how many pounds must be applied
to an insulator before it breaks. Data are collected from a
sample of 30 insulators. The file contains the
strengths, as follows:

a. Compute the mean, median, range, and standard devia-
tion for the force needed to break the insulator.

b. Interpret the measures of central tendency and variability
in (a).

c. Construct a boxplot and describe its shape.
d. What can you conclude about the strength of the insula-

tors if the company requires a force measurement of at
least 1,500 pounds before breakage?

3.66 The file contains data on the calories
and total fat (in grams per serving) for a sample of 12 veg-
gie burgers.

Source: Data extracted from “Healthful Burgers That Taste Good,”
Consumer Reports, June 2008, p 8.

a. For each variable, compute the mean, median, first quar-
tile, and third quartile.

b. For each variable, compute the range, interquartile range,
variance, standard deviation, and coefficient of variation.

c. For each variable, construct a boxplot. Are the data
skewed? If so, how?

d. Compute the coefficient of correlation between calories
and total fat.

e. What conclusions can you reach concerning calories and
total fat?

3.67 A quality characteristic of interest for a tea-bag-filling
process is the weight of the tea in the individual bags. If the
bags are underfilled, two problems arise. First, customers may
not be able to brew the tea to be as strong as they wish. Sec-
ond, the company may be in violation of the truth-in-labeling
laws. For this product, the label weight on the package indi-
cates that, on average, there are 5.5 grams of tea in a bag. If
the mean amount of tea in a bag exceeds the label weight, the
company is giving away product. Getting an exact amount
of tea in a bag is problematic because of variation in the tem-
perature and humidity inside the factory, differences in the
density of the tea, and the extremely fast filling operation of
the machine (approximately 170 bags per minute). The file

, as shown below, contains the weights, in grams,Teabags

VeggieBurger

1,820 1,744 1,788 1,688 1,810 1,752 1,680 1,810 1,652 1,736

1,866 1,764 1,734 1,662 1,734 1,774 1,550 1,756 1,762 1,866

1,870 1,728 1,656 1,610 1,634 1,784 1,522 1,696 1,592 1,662

Force

of a sample of 50 tea bags produced in one hour by a single
machine:

a. Compute the mean, median, first quartile, and third quar-
tile.

b. Compute the range, interquartile range, variance, stan-
dard deviation, and coefficient of variation.

c. Interpret the measures of central tendency and variation
within the context of this problem. Why should the com-
pany producing the tea bags be concerned about the cen-
tral tendency and variation?

d. Construct a boxplot. Are the data skewed? If so, how?
e. Is the company meeting the requirement set forth on the

label that, on average, there are 5.5 grams of tea in a bag?
If you were in charge of this process, what changes, if
any, would you try to make concerning the distribution of
weights in the individual bags?

3.68 The manufacturer of Boston and Vermont asphalt
shingles provides its customers with a 20-year warranty
on most of its products. To determine whether a shingle
will last as long as the warranty period, accelerated-life
testing is conducted at the manufacturing plant. Acceler-
ated-life testing exposes a shingle to the stresses it would
be subject to in a lifetime of normal use via an experiment
in a laboratory setting that takes only a few minutes to
conduct. In this test, a shingle is repeatedly scraped with a
brush for a short period of time, and the shingle granules
removed by the brushing are weighed (in grams). Shingles
that experience low amounts of granule loss are expected
to last longer in normal use than shingles that experience
high amounts of granule loss. In this situation, a shingle
should experience no more than 0.8 gram of granule loss
if it is expected to last the length of the warranty period.
The file contains a sample of 170 measurements
made on the company’s Boston shingles and 140 meas-
urements made on Vermont shingles.
a. List the five-number summaries for the Boston shingles

and for the Vermont shingles.
b. Construct side-by-side boxplots for the two brands of

shingles and describe the shapes of the distributions.
c. Comment on the ability of each type of shingle to

achieve a granule loss of 0.8 gram or less.

3.69 The file contains the cost per meal and
the ratings of 50 city and 50 suburban restaurants on their
food, décor, and service (and their summated ratings). Com-
plete the following for the urban and suburban restaurants.

Source: Data extracted from Zagat Survey 2009 New York City
Restaurants and Zagat Survey 2009–2010 Long Island Restaurants.

a. Construct the five-number summary of the cost of a meal.

Restaurants

Granule

5.61 5.45 5.44 5.25 5.56 5.63 5.50 5.57 5.67 5.36
5.77 5.57 5.42 5.58 5.58 5.50 5.32 5.50 5.53 5.58
5.47 5.40 5.47 5.61 5.53 5.32 5.67 5.29 5.49 5.55
5.57 5.40 5.53 5.54 5.55 5.62 5.56 5.46 5.44 5.51
5.65 5.44 5.42 5.40 5.53 5.34 5.54 5.45 5.52 5.41
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b. Construct a boxplot of the cost of a meal. What is the
shape of the distribution?

c. Compute and interpret the correlation coefficient of the
summated rating and the cost of a meal.

3.70 The file contains calories, protein, and cho-
lesterol of popular protein foods (fresh red meats, poultry,
and fish).

Source: U.S. Department of Agriculture.

a. Compute the correlation coefficient between calories and
protein.

b. Compute the correlation coefficient between calories and
cholesterol.

c. Compute the correlation coefficient between protein and
cholesterol.

d. Based on the results of (a) through (c), what conclu-
sions can you reach concerning calories, protein, and
cholesterol?

3.71 The file contains the average price of a
room at two-star, three-star, and four-star hotels in cities
around the world in 2009 in English pounds (about US$1.57
as of October 2010). Complete the following for two-star,
three-star, and four-star hotels.

Source: Data extracted from www.hotels.com/press/hotel-price-index-
2009-h2.html.

a. Compute the mean, median, first quartile, and third quar-
tile.

b. Compute the range, interquartile range, variance, stan-
dard deviation, and coefficient of variation.

c. Interpret the measures of central tendency and variation
within the context of this problem.

d. Construct a boxplot. Are the data skewed? If so, how?
e. Compute the covariance between the average price at

two-star and three-star hotels, between two-star and four-
star hotels, and between three-star and four-star hotels.

f. Compute the coefficient of correlation between the aver-
age price at two-star and three-star hotels, between two-
star and four-star hotels, and between three-star and
four-star hotels.

g. Which do you think is more valuable in expressing the
relationship between the average price of a room at two-
star, three-star, and four-star hotels—the covariance or
the coefficient of correlation? Explain.

h. Based on (f), what conclusions can you reach about the
relationship between the average price of a room at two-
star, three-star, and four-star hotels?

3.72 The file contains the property taxes
per capita for the 50 states and the District of Columbia.
a. Compute the mean, median, first quartile, and third quartile.
b. Compute the range, interquartile range, variance, stan-

dard deviation, and coefficient of variation.
c. Construct a boxplot. Are the data skewed? If so, how?
d. Based on the results of (a) through (c), what conclusions can

you reach concerning property taxes per capita, in thousands
of dollars, for each state and the District of Columbia?

PropertyTaxes

HotelPrices

Protein

3.73 The file includes the total com-
pensation (in millions of $) of CEOs of 197 large public
companies and the investment return in 2009. Complete the
following for the total compensation (in $).

Source: Data extracted from D. Leonard, “Bargains in the Boardroom,”
The New York Times, April 4, 2010, pp. BU1, BU7, BU10, BU11.

a. Compute the mean, median, first quartile, and third quar-
tile.

b. Compute the range, interquartile range, variance, stan-
dard deviation, and coefficient of variation.

c. Construct a boxplot. Are the data skewed? If so, how?
d. Based on the results of (a) through (c), what conclusions

can you reach concerning the total compensation (in
$millions) of CEOs?

e. Compute the correlation coefficient between compensa-
tion and the investment return in 2009.

f. What conclusions can you reach from the results of (e)?

3.74 You are planning to study for your statistics examina-
tion with a group of classmates, one of whom you particu-
larly want to impress. This individual has volunteered to use
Excel or Minitab to get the needed summary information,
tables, and charts for a data set containing several numerical
and categorical variables assigned by the instructor for
study purposes. This person comes over to you with the
printout and exclaims, “I’ve got it all—the means, the medi-
ans, the standard deviations, the boxplots, the pie charts—
for all our variables. The problem is, some of the output
looks weird—like the boxplots for gender and for major and
the pie charts for grade point index and for height. Also, I
can’t understand why Professor Krehbiel said we can’t get
the descriptive stats for some of the variables; I got them for
everything! See, the mean for height is 68.23, the mean for
grade point index is 2.76, the mean for gender is 1.50, the
mean for major is 4.33.” What is your reply?

REPORT WRITING EXERCISES
3.75 The file contains the percentage of al-
cohol, number of calories per 12 ounces, and number of car-
bohydrates (in grams) per 12 ounces for 139 of the
best-selling domestic beers in the United States.

Your task is to write a report based on a complete descrip-
tive evaluation of each of the numerical variables—percent-
age of alcohol, number of calories per 12 ounces, and
number of carbohydrates (in grams) per 12 ounces. Ap-
pended to your report should be all appropriate tables,
charts, and numerical descriptive measures.

Source: Data extracted from www.Beer100.com, March 18, 2010.

TEAM PROJECTS

The file contains information regarding nine
variables from a sample of 184 bond funds:

Fund number—Identification number for each bond fund
Type—Type of bonds comprising the bond fund (inter-

mediate government or short-term corporate)

Bond Funds

DomesticBeer

CEO-Compensation

www.hotels.com/press/hotel-price-index-2009-h2.html
www.hotels.com/press/hotel-price-index-2009-h2.html
www.Beer100.com
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Assets—In millions of dollars
Fees—Sales charges (no or yes)
Expense ratio—Ratio of expenses to net assets
Return 2009—Twelve-month return in 2009
Three-year return—Annualized return, 2007–2009
Five-year return—Annualized return, 2005–2009
Risk—Risk-of-loss factor of the mutual fund (low, aver-

age, or high)

3.76 Complete the following for expense ratio in percent-
age, three-year return, and five-year return.
a. Compute the mean, median, first quartile, and third quartile.
b. Compute the range, interquartile range, variance, stan-

dard deviation, and coefficient of variation.
c. Construct a boxplot. Are the data skewed? If so, how?
d. Based on the results of (a) through (c), what conclusions

can you reach concerning these variables?

3.77 You want to compare bond funds that have fees to
those that do not have fees. For each of these two groups,
use the variables expense ratio, return 2009, three-year re-
turn, and five-year return and complete the following.
a. Compute the mean, median, first quartile, and third quar-

tile.
b. Compute the range, interquartile range, variance, stan-

dard deviation, and coefficient of variation.
c. Construct a boxplot. Are the data skewed? If so, how?
d. Based on the results of (a) through (c), what conclusions

can you reach about differences between bond funds that
have fees and those that do not have fees?

3.78 You want to compare intermediate government to the
short-term corporate bond funds. For each of these two
groups, use the variables expense ratio, three-year return,
and five-year return and complete the following.
a. Compute the mean, median, first quartile, and third quar-

tile.
b. Compute the range, interquartile range, variance, stan-

dard deviation, and coefficient of variation.
c. Construct a boxplot. Are the data skewed? If so, how?
d. Based on the results of (a) through (c), what conclu-

sions can you reach about differences between interme-
diate government and short-term corporate bond
funds?

3.79 You want to compare bond funds based on risk. For
each of these three levels of risk (below average, average,
above average), use the variables expense ratio, return 2009,

three-year return, and five-year return and complete the
following.
a. Compute the mean, median, first quartile, and third quar-

tile.
b. Compute the range, interquartile range, variance, stan-

dard deviation, and coefficient of variation.
c. Construct a boxplot. Are the data skewed? If so, how?
d. Based on the results of (a) through (c), what conclusions

can you reach about differences between bond funds
based on risk?

STUDENT SURVEY DATABASE
3.80 Problem 1.27 on page 14 describes a survey of 62 under-
graduate students (stored in ). For these data,
for each numerical variable, complete the following.
a. Compute the mean, median, first quartile, and third quar-

tile.
b. Compute the range, interquartile range, variance, stan-

dard deviation, and coefficient of variation.
c. Construct a boxplot. Are the data skewed? If so, how?
d. Write a report summarizing your conclusions.

3.81 Problem 1.27 on page 14 describes a survey of 62 un-
dergraduate students (stored in ).
a. Select a sample of undergraduate students at your school

and conduct a similar survey for those students.
b. For the data collected in (a), repeat (a) through (d) of

Problem 3.80.
c. Compare the results of (b) to those of Problem 3.80.

3.82 Problem 1.28 on page 15 describes a survey of 44
MBA students (stored in ). For these data, for
each numerical variable, complete the following.
a. Compute the mean, median, first quartile, and third quar-

tile.
b. Compute the range, interquartile range, variance, stan-

dard deviation, and coefficient of variation.
c. Construct a boxplot. Are the data skewed? If so, how?
d. Write a report summarizing your conclusions.

3.83 Problem 1.28 on page 15 describes a survey of 44
MBA students (stored in ).
a. Select a sample of graduate students from your MBA

program and conduct a similar survey for those students.
b. For the data collected in (a), repeat (a) through (d) of

Problem 3.82.
c. Compare the results of (b) to those of Problem 3.82.

GradSurvey

GradSurvey

UndergradSurvey

UndergradSurvey
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M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
For what variable in the Chapter 2 “Managing Ashland
MultiComm Services” case (see page 74) are numerical de-
scriptive measures needed?

1. For the variable you identify, compute the appropriate
numerical descriptive measures and construct a boxplot.

2. For the variable you identify, construct a graphical dis-
play. What conclusions can you reach from this other plot
that cannot be made from the boxplot?

3. Summarize your findings in a report that can be included
with the task force’s study.

D I G I TA L C A S E
Apply your knowledge about the proper use of numerical
descriptive measures in this continuing Digital Case from
Chapter 2.

Open EndRunGuide.pdf, the EndRun Financial Services
“Guide to Investing.” Reexamine EndRun’s supporting data
for the “More Winners Than Losers” and “The Big Eight
Difference” and then answer the following:

1. Can descriptive measures be computed for any variables?
How would such summary statistics support EndRun’s

claims? How would those summary statistics affect your
perception of EndRun’s record?

2. Evaluate the methods EndRun used to summarize the re-
sults presented on the “Customer Survey Results” page.
Is there anything you would do differently to summarize
these results?

3. Note that the last question of the survey has fewer
responses than the other questions. What factors may have
limited the number of responses to that question?

R E F E R E N C E S
1. Kendall, M. G., A. Stuart, and J. K. Ord, Kendall’s Ad-

vanced Theory of Statistics, Volume 1: Distribution The-
ory, 6th ed. (New York: Oxford University Press, 1994).

2. Microsoft Excel 2010 (Redmond, WA: Microsoft Corpo-
ration, 2010).

3. Minitab Release 16 (State College, PA: Minitab, Inc.,
2010).
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EG3.1 CENTRAL TENDENCY

The Mean, Median, and Mode

In-Depth Excel Use the AVERAGE (for the mean),
MEDIAN, or MODE functions in worksheet formulas to
compute measures of central tendency. Enter these functions
in the form FUNCTION(cell range of the variable). See
Section EG3.2 for an example of their use.

Analysis ToolPak Use Descriptive Statistics to create a
list that includes measures of central tendency. (Section
EG3.2 fully explains this procedure.)

The Geometric Mean

In-Depth Excel Use the GEOMEAN function in a work-
sheet formula in the form =GEOMEAN((1 + (R

1
)),

(1 + (R
2
)), ...(1 + (R

n
))) - 1 to compute the geometric

mean rate of return. For example, to compute this
statistic for Example 3.5 on page 101, enter the formula
=GEOMEAN((1 + (-0.3379)), (1 + (0.2717))) - 1 in
any cell.

EG3.2 VARIATION and SHAPE

The Range, Variance, Standard Deviation,
Coefficient of Variation, and Shape

In-Depth Excel Use the COMPUTE worksheet of the
Descriptive workbook as a model for computing measures
of central tendency, variation, and shape. This worksheet,
shown in Figure 3.2 on page 109, computes the descriptive
statistics for the 2009 return variable for the intermediate
government and short-term corporate bond funds using data
found in columns A and B of the DATA worksheet. The
worksheet uses the VAR (sample variance), STDEV (sam-
ple standard deviation), MIN (minimum value), and MAX
(maximum value) functions to compute measures of varia-
tion for a variable of interest. In row 11, the worksheet takes
the difference between MAX and MIN to compute the
range. In row 4, the worksheet uses the COUNT function to
determine the sample size and then divides the sample stan-
dard deviation by the square root (SQRT) of the sample size
to compute the standard error. (See Section 7.4 to learn
more about the standard error.)

To add the coefficient of variation to the COMPUTE
worksheet, first enter Coefficient of variation in cell A16.
Then, enter the formula =B7/B3 in cell B16 and then copy
it to cell C16. Finally, format cells B16 and C16 for percent-
age display.

Analysis ToolPak Use Descriptive Statistics to create a
list that contains measures of variation and shape along with
central tendency.

For example, to create a worksheet similar to the Figure
3.2 worksheet on page 109 that presents descriptive statis-
tics for the 2009 return for the intermediate government and
short-term corporate bond funds (see page 109), open to the
RETURN2009 worksheet of the Bond Funds workbook
and:

1. Select Data ➔ Data Analysis.

2. In the Data Analysis dialog box, select Descriptive Sta-
tistics from the Analysis Tools list and then click OK.

In the Descriptive Statistics dialog box (shown below):

3. Enter A1:B98 as the Input Range. Click Columns and
check Labels in First Row.

4. Click New Worksheet Ply, check Summary statistics,
and then click OK.

In the new worksheet:

5. Select column C, right-click, and click Delete in the
shortcut menu (to eliminate the duplicate row labels).

6. Adjust the column headings and cell formatting, using
Figure 3.2 as a guide. (See Appendix B for help with these
adjustments.)

To add the coefficient of variation to this worksheet,
first enter Coefficient of variation in cell A16. Then, enter
the formula =B7/B3 in cell B16 and then copy it to cell C16.
Finally, format cells B16 and C16 for percentage display.

Z Scores

In-Depth Excel Use the STANDARDIZE function to
compute Z scores. Enter the function in the form
STANDARDIZE(value, mean, standard deviation), where
value is an X value. Use the TABLE_3.4 worksheet of the



Descriptive workbook as a model for computing Z scores.
The worksheet uses the AVERAGE and STDEV functions
to compute the mean and standard deviation values used in
the STANDARDIZE function.

Shape

In-Depth Excel Use the SKEW and KURT functions to
compute skewness and kurtosis, respectively. Enter these
functions in the form FUNCTION(cell range of the vari-

able). Use the COMPUTE worksheet of the Descriptive
workbook (discussed earlier in this section) as a model for
computing these statistics.

Analysis ToolPak Use Descriptive Statistics to compute
skewness and kurtosis. The Analysis ToolPak instructions
given earlier in this section will compute these statistics as
well.

EG3.3 EXPLORING NUMERICAL DATA

Quartiles

In-Depth Excel As noted on page 114, the Excel
QUARTILE function, entered as QUARTILE(cell range

of data to be summarized, quartile number), uses rules that
differ from the rules listed in Section 3.3 to compute quar-
tiles. To compute quartiles using the Section 3.3 rules, open
to the COMPUTE worksheet of the QUARTILES work-
book. The worksheet contains the values for Example 3.11.
To compute the quartiles for another problem, overwrite
those values (which appear in column A).

Quartile results using the Section 3.3 rules are shown in
column D, the Book Rules column. The column D results
rely on a series of advanced formulas in columns G through
I to implement the Section 3.3 rules. Open to the
COMPUTE_FORMULAS worksheet to examine these
formulas. (A full explanation of the formulas used in that
worksheet is beyond the scope of this book.)

The Interquartile Range

In-Depth Excel Use a worksheet formula that subtracts the
first quartile from the third quartile to compute the in-
terquartile range. For example, to compute this statistic for
Example 3.12 on page 115, open to the COMPUTE work-
sheet of the Quartiles workbook and enter the formula
=D5 – D3 into an empty cell.

The Five-Number Summary and the Boxplot

PHStat2 Use Boxplot to create a five-number summary
and boxplot. For example, to create the Figure 3.4 five-
number summary and boxplot on page 117, open to the
DATA worksheet of the Bond Funds workbook. Select

The boxplot appears on its own chart sheet, separate
from the worksheet that contains the five-number summary.

In-Depth Excel Use the worksheets of the Boxplot workbook
as templates for creating a five-number summary and boxplot.
Use the PLOT_DATA worksheet as a template for creating a
five-number summary and a boxplot in one worksheet from un-
summarized data. Use the PLOT worksheet as a template for
constructing a boxplot from a known five-number summary.

Because Excel does not include a boxplot as one of
its chart types, creating a boxplot requires the advanced
and creative “misuse” of Excel charting features. Open to the
PLOT_FORMULAS worksheet to examine this “misuse.”
(A full explanation is beyond the scope of this book.)

EG3.4 NUMERICAL DESCRIPTIVE
MEASURES for a POPULATION

The Population Mean, Population Variance,
and Population Standard Deviation

In-Depth Excel Use the AVERAGE function to compute the
population mean. Use the VARP and STDEVP functions to
compute the population variance and standard deviation, re-
spectively. Enter these functions in the form AVERAGE(cell

range of the population), VARP(cell range of the popula-

tion), and STDEVP(cell range of the population).
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PHStat ➔ Descriptive Statistics ➔ Boxplot. In the proce-
dure’s dialog box (shown below):

1. Enter F1:F185 as the Raw Data Cell Range and check
First cell contains label.

2. Click Multiple Groups-Stacked and enter B1:B185 as
the Grouping Variable Cell Range.

3. Enter a Title, check Five-Number Summary, and click
OK.
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The Empirical Rule and the Chebyshev Rule

In-Depth Excel Use the COMPUTE worksheet of the
Variability workbook as a template that uses arithmetic
formulas to examine the variability in a distribution.

EG3.5 THE COVARIANCE and the
COEFFICIENT of CORRELATION

The Covariance

In-Depth Excel Use the COMPUTE worksheet of the
Covariance workbook as a template for covariance analysis.
The worksheet contains the Table 3.8 set of 30 values and an-
nual revenues (see page 126). For other problems, overwrite
these values and follow the instructions in the worksheet for

modifying the worksheet, when you have less than or more
than 30 values. (The COMPUTE_FORMULAS worksheet
shows the formulas used in the COMPUTE worksheet.)

The Coefficient of Correlation

In-Depth Excel Use the CORREL function to compute
the coefficient of correlation. Enter this function in the form
CORREL(cell range of the X values, cell range of the Y
values).

Use the COMPUTE worksheet of the Correlation
workbook as a template for the correlation analysis shown
in Figure 3.10 on page 129. In this worksheet, the cell F15
formula =CORREL(A4:A33, B4:B33) computes the coef-
ficient of correlation.

MG3.1 CENTRAL TENDENCY

The Mean, Median, and Mode

Use Descriptive Statistics to compute the mean, the median,
the mode, and selected measures of variation and shape. For
example, to create results similar to Figure 3.2 on page 109
that presents descriptive statistics for the 2009 return for the
intermediate government and short-term corporate bond
funds, open to the Bond Funds worksheet. Select Stat ➔
Basic Statistics ➔ Display Descriptive Statistics. In the
Display Descriptive Statistics dialog box (shown below):

1. Double-click C6 Return 2009 in the variables list to add
'Return 2009' to the Variables box and then press Tab.

2. Double-click C2 Type in the variables list to add Type
to the By variables (optional) box.

3. Click Statistics.

C H A P T E R 3 M I N I TA B G U I D E

In the Display Descriptive Statistics-Statistics dialog box
(shown below):

4. Check Mean, Standard deviation, Variance, Coefficient
of variation, First quartile, Median, Third quartile,
Interquartile range, Mode, Minimum, Maximum,
Range, Skewness, Kurtosis, and N total.

5. Click OK.

6. Back in the Display Descriptive Statistics dialog box,
click OK.

The Geometric Mean

Use Calculator to compute the geometric mean or the geo-
metric mean rate of return. For example, to compute the geo-
metric mean rate of return for Example 3.5 on page 101, open
to the Investments worksheet. Select Calc ➔ Calculator. In
the Calculator dialog box (shown at the top of page 142):

1. Enter C2 in the Store result in variable box and then
press Tab. (C2 is the first empty column on the worksheet
and the result will be placed in row 1 of column C2.)

2. Double-click Geometric mean in the Functions scrolla-
ble list to add GMEAN(number) to the Expression box.
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3. Double-click C1 Rates of Return in the variables list to
alter the expression to GMEAN('Rates of Return').
(If you prefer, you can directly edit the expression as part
of the next step.)

4. Edit the expression so that it reads GMEAN('Rates of
Return') – 1.

5. Click OK.

Shape

Use Descriptive Statistics to compute skewness and kurto-
sis. The instructions in Section MG3.1 for computing the
mean, median, and mode also compute these measures.

MG3.3 EXPLORING NUMERICAL DATA

Quartiles, the Interquartile Range, 
and the Five-Number Summary

Use Descriptive Statistics to compute these measures. The
instructions in Section MG3.1 for computing the mean,
median, and mode also compute these measures.

The Boxplot

Use Boxplot to create a boxplot. For example, to create the
Figure 3.5 boxplots on page 118, open to the Bond Funds
worksheet. Select Graph ➔ Boxplot. In the Boxplots dialog
box:

1. Click With Groups in the One Y gallery and then click
OK.

In the Boxplot-One Y, With Groups dialog box (shown
below):

2. Double-click C6 Return 2009 in the variables list to add
'Return 2009' to the Graph variables box and then press
Tab.

3. Double-click C2 Type in the variables list to add Type
in the Categorical variables box.

4. Click OK.

MG3.2 VARIATION and SHAPE

The Range, Variance, Standard Deviation, 
and Coefficient of Variation

Use Descriptive Statistics to compute these measures of varia-
tion and shape. The instructions in Section MG3.1 for comput-
ing the mean, median, and mode also compute these measures.

Z Scores

Use Standardize to compute Z scores. For example, to
compute the Table 3.4 Z scores shown on page 108, open to
the CEREALS worksheet. Select Calc ➔ Standardize. In
the Standardize dialog box (shown below):

1. Double-click C2 Calories in the variables list to add
Calories to the Input column(s) box and press Tab.

2. Enter C5 in the Store results in box. (C5 is the first
empty column on the worksheet and the Z scores will be
placed in column C5.)

3. Click Subtract mean and divide by standard deviation.

4. Click OK.

5. In the new column C5, enter Z Scores as the name of the
column.

In the boxplot created, pausing the mouse pointer over the
boxplot reveals a number of measures, including the quar-
tiles. For problems that involve single-group data, click
Simple in the One Y gallery in step 1.

To rotate the boxplots 90 degrees (as was done in Figure
3.5), replace step 4 with these steps 4 through 6:

4. Click Scale.

5. In the Axes and Ticks tab of the Boxplot–Scale dialog
box, check Transpose value and category scales and
click OK.

6. Back in the Boxplot-One Y, With Groups dialog box, click OK.
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MG3.4 NUMERICAL DESCRIPTIVE
MEASURES for a POPULATION

The Population Mean, Population Variance,
and Population Standard Deviation

Minitab does not contain commands that compute these
population parameters directly.

The Empirical Rule and the Chebyshev Rule

Manually compute the values needed to apply these rules us-
ing the statistics computed in the Section MG3.1 instruc-
tions.

MG3.5 THE COVARIANCE and the
COEFFICIENT of CORRELATION

The Covariance

Use Covariance to compute the covariance. For example, to
compute the covariance for the Table 3.8 set of 30 values
and annual revenues, open to the NBAValues worksheet.
Select Stat ➔ Basic Statistics ➔ Covariance. In the Co-
variance dialog box (shown below):

1. Double-click C2 Revenue in the variables list to add
Revenue to the Variables box.

2. Double-click C3 Value in the variables list to add Value
to the Variables box.

3. Click OK.
In the table of numbers produced, the covariance is the num-
ber that appears in the cell position that is the intersection of
the two variables (the lower-left cell).

The Coefficient of Correlation

Use Correlation to compute the coefficient of correlation.
For example, to compute the coefficient of correlation
for the set of 30 values and annual revenues shown in Figure
3.10 on page 129, open to the NBAValues worksheet.
Select Stat ➔ Basic Statistics ➔ Correlation. In the Cor-
relation dialog box (similar to the Covariance dialog box):

1. Double-click C2 Revenue in the variables list to add
Revenue to the Variables box.

2. Double-click C3 Value in the variables list to add Value
to the Variables box.

3. Click OK.
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As the marketing manager for M&R Electronics World, you are analyzing the survey
results of an intent-to-purchase study. This study asked the heads of 1,000 households
about their intentions to purchase a big-screen television sometime during the next
12 months. As a follow-up, you plan to survey the same people 12 months later to see
whether they purchased televisions. In addition, for households purchasing big-screen

televisions, you would like to know whether the television they purchased had a faster refresh rate (120 Hz
or higher) or a standard refresh rate (60 Hz), whether they also purchased a Blu-ray disc (BD) player in the
past 12 months, and whether they were satisfied with their purchase of the big-screen television.

You are expected to use the results of this survey to plan a new marketing strategy that will enhance
sales and better target those households likely to purchase multiple or more expensive products. What
questions can you ask in this survey? How can you express the relationships among the various intent-
to-purchase responses of individual households?

In previous chapters, you learned descriptive methods to summarize categorical and numerical
variables. In this chapter, you will learn about probability to answer questions such as the following:

� What is the probability that a household is planning to purchase a
big-screen television in the next year?

� What is the probability that a household will actually purchase 
a big-screen television?

� What is the probability that a household is planning to purchase a
big-screen television and actually purchases the television?

� Given that the household is planning to purchase a big-screen televi-
sion, what is the probability that the purchase is made?

� Does knowledge of whether a household plans to purchase the televi-
sion change the likelihood of predicting whether the household will
purchase the television?

� What is the probability that a household that purchases a big-screen
television will purchase a television with a faster refresh rate?

� What is the probability that a household that purchases a big-screen
television with a faster refresh rate will also purchase a Blu-ray disc
player?

� What is the probability that a household that purchases a big-screen
television will be satisfied with the purchase?

With answers to questions such as these, you can begin to make deci-
sions about your marketing strategy. Should your strategy for selling
more big-screen televisions target those households that have indicated
an intent to purchase? Should you concentrate on selling televisions that
have faster refresh rates? Is it likely that households that purchase big-
screen televisions with faster refresh rates can be easily persuaded to also
purchase Blu-ray disc players?

U S I N G S TAT I S T I C S

@ M&R Electronics World
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T he principles of probability help bridge the worlds of descriptive statistics and
inferential statistics. Reading this chapter will help you learn about different types of
probabilities, how to compute probabilities, and how to revise probabilities in light of

new information. Probability principles are the foundation for the probability distribution, the
concept of mathematical expectation, and the binomial, Poisson, and hypergeometric distribu-
tions, topics that are discussed in Chapter 5.

4.1 Basic Probability Concepts
What is meant by the word probability? A probability is the numeric value representing the
chance, likelihood, or possibility that a particular event will occur, such as the price of a stock
increasing, a rainy day, a defective product, or the outcome five dots in a single toss of a die.
In all these instances, the probability involved is a proportion or fraction whose value ranges
between 0 and 1, inclusive. An event that has no chance of occurring (the impossible event)
has a probability of 0. An event that is sure to occur (the certain event) has a probability of 1.

There are three types of probability:

• A priori
• Empirical
• Subjective

In a priori probability, the probability of an occurrence is based on prior knowledge of the
process involved. In the simplest case, where each outcome is equally likely, the chance of
occurrence of the event is defined in Equation (4.1).

PROBABILITY OF OCCURRENCE

(4.1)

where

number of ways in which the event occurs

total number of possible outcomesT =

X =

Probability of occurrence =
X

T

Consider a standard deck of cards that has 26 red cards and 26 black cards. The probabil-
ity of selecting a black card is because there are black cards and

total cards. What does this probability mean? If each card is replaced after it is
selected, does it mean that 1 out of the next 2 cards selected will be black? No, because you
cannot say for certain what will happen on the next several selections. However, you can say
that in the long run, if this selection process is continually repeated, the proportion of black
cards selected will approach 0.50. Example 4.1 shows another example of computing an
a priori probability.

T = 52
X = 2626>52 = 0.50

A standard six-sided die has six faces. Each face of the die contains either one, two, three, four,
five, or six dots. If you roll a die, what is the probability that you will get a face with five dots?

SOLUTION Each face is equally likely to occur. Because there are six faces, the probability
of getting a face with five dots is 1/6.

EXAMPLE 4.1
Finding A Priori
Probabilities
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The preceding examples use the a priori probability approach because the number of ways the
event occurs and the total number of possible outcomes are known from the composition of
the deck of cards or the faces of the die.

In the empirical probability approach, the probabilities are based on observed data, not
on prior knowledge of a process. Surveys are often used to generate empirical probabilities.
Examples of this type of probability are the proportion of individuals in the Using Statistics
scenario who actually purchase big-screen televisions, the proportion of registered voters who
prefer a certain political candidate, and the proportion of students who have part-time jobs.
For example, if you take a survey of students, and 60% state that they have part-time jobs, then
there is a 0.60 probability that an individual student has a part-time job.

The third approach to probability, subjective probability, differs from the other two
approaches because subjective probability differs from person to person. For example, the
development team for a new product may assign a probability of 0.60 to the chance of success
for the product, while the president of the company may be less optimistic and assign a proba-
bility of 0.30. The assignment of subjective probabilities to various outcomes is usually based
on a combination of an individual’s past experience, personal opinion, and analysis of a partic-
ular situation. Subjective probability is especially useful in making decisions in situations in
which you cannot use a priori probability or empirical probability.

Events and Sample Spaces
The basic elements of probability theory are the individual outcomes of a variable under study.
You need the following definitions to understand probabilities.

EVENT
Each possible outcome of a variable is referred to as an event.
A simple event is described by a single characteristic.

JOINT EVENT
A joint event is an event that has two or more characteristics.

COMPLEMENT
The complement of event A (represented by the symbol ) includes all events that are
not part of A.

A¿

Getting two heads when you toss a coin twice is an example of a joint event because it consists
of heads on the first toss and heads on the second toss.

The complement of a head is a tail because that is the only event that is not a head. The com-
plement of five dots on a die is not getting five dots. Not getting five dots consists of getting
one, two, three, four, or six dots.

For example, when you toss a coin, the two possible outcomes are heads and tails. Each of
these represents a simple event. When you roll a standard six-sided die in which the six faces
of the die contain either one, two, three, four, five, or six dots, there are six possible simple
events. An event can be any one of these simple events, a set of them, or a subset of all of them.
For example, the event of an even number of dots consists of three simple events (i.e., two,
four, or six dots).



The Using Statistics scenario on page 145 concerns M&R Electronics World. Table 4.1 pres-
ents the results of the sample of 1,000 households in terms of purchase behavior for big-screen
televisions.

EXAMPLE 4.2
Events and Sample
Spaces

148 CHAPTER 4 Basic Probability

Contingency Tables and Venn Diagrams
There are several ways in which you can view a particular sample space. One way involves
using a contingency table (see Section 2.2) such as the one displayed in Table 4.1. You get the
values in the cells of the table by subdividing the sample space of 1,000 households according
to whether someone planned to purchase and actually purchased a big-screen television set.
For example, 200 of the respondents planned to purchase a big-screen television set and subse-
quently did purchase the big-screen television set.

A second way to present the sample space is by using a Venn diagram. This diagram graph-
ically represents the various events as “unions” and “intersections” of circles. Figure 4.1 presents
a typical Venn diagram for a two-variable situation, with each variable having only two events
(A and A , B and B ). The circle on the left (the red one) represents all events that are part of A.

The circle on the right (the yellow one) represents all events that are part of B. The area
contained within circle A and circle B (center area) is the intersection of A and B (written as

), since it is part of A and also part of B. The total area of the two circles is the union of
A and B (written as ) and contains all outcomes that are just part of event A, just part of
event B, or part of both A and B. The area in the diagram outside of contains outcomes
that are neither part of A nor part of B.

You must define A and B in order to develop a Venn diagram. You can define either event
as A or B, as long as you are consistent in evaluating the various events. For the big-screen
television example, you can define the events as follows:

In drawing the Venn diagram (see Figure 4.2), you must determine the value of the inter-
section of A and B so that the sample space can be divided into its parts. consists of all
200 households who planned to purchase and actually purchased a big-screen television set.

A ¨ B

A¿ = did not plan to purchase B¿ = did not actually purchase

A = planned to purchase B = actually purchased

A ´ B
A ´ B

A ¨ B

¿¿

T A B L E 4 . 1

Purchase Behavior for
Big-Screen Televisions

PLANNED
TO PURCHASE

ACTUALLY PURCHASED

Yes No Total

Yes 200 50 250
No 100 650 750
Total 300 700 1,000

SAMPLE SPACE
The collection of all the possible events is called the sample space.
The sample space for tossing a coin consists of heads and tails. The sample space 
when rolling a die consists of one, two, three, four, five, and six dots. Example 4.2
demonstrates events and sample spaces.

What is the sample space? Give examples of simple events and joint events.

SOLUTION The sample space consists of the 1,000 respondents. Simple events are “planned
to purchase,” “did not plan to purchase,” “purchased,” and “did not purchase.” The comple-
ment of the event “planned to purchase” is “did not plan to purchase.” The event “planned to
purchase and actually purchased” is a joint event because in this joint event the respondent
must plan to purchase the television and actually purchase it.
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A

A

B

A B

BF I G U R E 4 . 1
Venn diagram for events
A and B

A

A B A′ B ′ = 650

A B = 350

B

50 200 100

F I G U R E 4 . 2
Venn diagram for the
M&R Electronics World
example

The remainder of event A (planned to purchase) consists of the 50 households who planned to
purchase a big-screen television set but did not actually purchase one. The remainder of event
B (actually purchased) consists of the 100 households who did not plan to purchase a big-
screen television set but actually purchased one. The remaining 650 households represent
those who neither planned to purchase nor actually purchased a big-screen television set.

Simple Probability
Now you can answer some of the questions posed in the Using Statistics scenario. Because the
results are based on data collected in a survey (refer to Table 4.1), you can use the empirical
probability approach.

As stated previously, the most fundamental rule for probabilities is that they range in value
from 0 to 1. An impossible event has a probability of 0, and an event that is certain to occur
has a probability of 1.

Simple probability refers to the probability of occurrence of a simple event, P(A).
A simple probability in the Using Statistics scenario is the probability of planning to purchase
a big-screen television. How can you determine the probability of selecting a household that
planned to purchase a big-screen television? Using Equation (4.1) on page 146:

Thus, there is a 0.25 (or 25%) chance that a household planned to purchase a big-screen television.
Example 4.3 illustrates another application of simple probability.

=
250

1,000
= 0.25

P(Planned to purchase) =
Number who planned to purchase

Total number of households

Probability of occurrence =
X

T

In the Using Statistics follow-up survey, additional questions were asked of the 300 households
that actually purchased big-screen televisions. Table 4.2 indicates the consumers’ responses to
whether the television purchased had a faster refresh rate and whether they also purchased a
Blu-ray disc (BD) player in the past 12 months.

Find the probability that if a household that purchased a big-screen television is randomly
selected, the television purchased had a faster refresh rate.

EXAMPLE 4.3
Computing the 
Probability That the
Big-Screen Television
Purchased Had a
Faster Refresh Rate

T A B L E 4 . 2

Purchase Behavior
Regarding Purchasing
a Faster Refresh Rate
Television and Blu-Ray
Disc (BD) Player

REFRESH RATE OF 
TELEVISION PURCHASED

PURCHASED BD PLAYER

Yes No Total

Faster 38 42 80
Standard 70 150 220
Total 108 192 300
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SOLUTION Using the following definitions:

There is a 26.7% chance that a randomly selected big-screen television purchased has a faster
refresh rate.

=
80

300
= 0.267

P(faster refresh rate) =
Number of faster refresh rate televisions

Total number of televisions

B¿ = did not purchase a Blu-ray disc (BD) player

B = purchased a Blu-ray disc (BD) player

A¿ = purchased a television with a standard refresh rate

A = purchased a television with a faster refresh rate

Joint Probability
Whereas simple or marginal probability refers to the probability of occurrence of simple
events, joint probability refers to the probability of an occurrence involving two or more
events. An example of joint probability is the probability that you will get heads on the first
toss of a coin and heads on the second toss of a coin.

In Table 4.1 on page 148, the group of individuals who planned to purchase and actually
purchased a big-screen television consist only of the outcomes in the single cell “yes—planned
to purchase and yes—actually purchased.” Because this group consists of 200 households, the
probability of picking a household that planned to purchase and actually purchased a big-
screen television is

Example 4.4 also demonstrates how to determine joint probability.

=
200

1,000
= 0.20

P(Planned to purchase and actually purchased) =
Planned to purchase and actually purchased

Total number of respondents

In Table 4.2, the purchases are cross-classified as having a faster refresh rate or having a stan-
dard refresh rate and whether the household purchased a Blu-ray disc player. Find the proba-
bility that a randomly selected household that purchased a big-screen television also purchased
a television that had a faster refresh rate and purchased a Blu-ray disc player.

SOLUTION Using Equation (4.1) on page 146,

Therefore, there is a 12.7% chance that a randomly selected household that purchased a big-
screen television purchased a television that had a faster refresh rate and a Blu-ray disc player.

=
38

300
= 0.127

P(television with a faster refresh
rate and Blu-ray disc player) =

Number that purchased a television with a faster
refresh rate and a Blu-ray disc player

Total number of big-screen television purchasers

EXAMPLE 4.4
Determining the 
Joint Probability
That a Household
Purchased a Big-
Screen Television
with a Faster 
Refresh Rate and 
a Blu-ray Disc Player

Marginal Probability
The marginal probability of an event consists of a set of joint probabilities. You can determine
the marginal probability of a particular event by using the concept of joint probability just dis-
cussed. For example, if B consists of two events, B1 and B2, then P(A), the probability of event A,
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MARGINAL PROBABILITY

(4.2)

where B1, B2, . . . , Bk are k mutually exclusive and collectively exhaustive events, defined
as follows:

Two events are mutually exclusive if both the events cannot occur simultaneously.
A set of events is collectively exhaustive if one of the events must occur.

P(A) = P(A and B1) + P(A and B2) + Á + P(A and Bk)

Heads and tails in a coin toss are mutually exclusive events. The result of a coin toss cannot
simultaneously be a head and a tail. Heads and tails in a coin toss are also collectively exhaus-
tive events. One of them must occur. If heads does not occur, tails must occur. If tails does not
occur, heads must occur. Being male and being female are mutually exclusive and collectively
exhaustive events. No person is both (the two are mutually exclusive), and everyone is one or
the other (the two are collectively exhaustive).

You can use Equation (4.2) to compute the marginal probability of “planned to purchase”
a big-screen television:

You get the same result if you add the number of outcomes that make up the simple event
“planned to purchase.”

General Addition Rule
How do you find the probability of event “A or B”? You need to consider the occurrence of either
event A or event B or both A and B. For example, how can you determine the probability that a
household planned to purchase or actually purchased a big-screen television? The event “planned
to purchase or actually purchased” includes all households that planned to purchase and all
households that actually purchased a big-screen television. You examine each cell of the contin-
gency table (Table 4.1 on page 148) to determine whether it is part of this event. From Table 4.1,
the cell “planned to purchase and did not actually purchase” is part of the event because it in-
cludes respondents who planned to purchase. The cell “did not plan to purchase and actually pur-
chased” is included because it contains respondents who actually purchased. Finally, the cell
“planned to purchase and actually purchased” has both characteristics of interest. Therefore, one
way to calculate the probability of “planned to purchase or actually purchased” is

=
350

1,000
= 0.35

=
50

1,000
+

100
1,000

+
200

1,000

to purchase and actually purchased)
purchase and actually purchase) + P(Planned
not actually purchase) + P(Did not plan to

P(Planned to purchase or actually purchased) = P(Planned to purchase and did

=
250

1,000
= 0.25

=
200

1,000
+

50
1,000

+ P(Planned to purchase and did not purchase)
P(Planned to purchase) = P(Planned to purchase and purchased)

consists of the joint probability of event A occurring with event B1 and the joint probability of
event A occurring with event B2. You use Equation (4.2) to compute marginal probabilities.
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Often, it is easier to determine P(A or B), the probability of the event A or B, by using the
general addition rule, defined in Equation (4.3).

GENERAL ADDITION RULE
The probability of A or B is equal to the probability of A plus the probability of B minus
the probability of A and B.

(4.3)P(A or B) = P(A) + P(B) - P(A and B)

In Example 4.3 on page 149, the purchases were cross-classified in Table 4.2 as televisions
that had a faster refresh rate or televisions that had a standard refresh rate and whether the
household purchased a Blu-ray disc (BD) player. Find the probability that among households
that purchased a big-screen television, they purchased a television that had a faster refresh rate
or a BD player.

SOLUTION Using Equation (4.3),

P(Television had a faster refresh
rate or purchased a BD player)

=
P(Television had a faster refresh rate)
+ P(purchased a BD player) - P(Television
had a faster refresh rate and purchased a BD player)

EXAMPLE 4.5
Using the General
Addition Rule for
the Households
That Purchased
Big-Screen
Televisions

Applying Equation (4.3) to the previous example produces the following result:

The general addition rule consists of taking the probability of A and adding it to the
probability of B and then subtracting the probability of the joint event A and B from this
total because the joint event has already been included in computing both the probability of
A and the probability of B. Referring to Table 4.1 on page 148, if the outcomes of the event
“planned to purchase” are added to those of the event “actually purchased,” the joint event
“planned to purchase and actually purchased” has been included in each of these simple
events. Therefore, because this joint event has been double-counted, you must subtract it to
provide the correct result. Example 4.5 illustrates another application of the general
addition rule.

=
350

1,000
= 0.35

=
250

1,000
+

300
1,000

-
200

1,000

purchase and actually purchased)
+ P(Actually purchased) - P(Planned to

P(Planned to purchase or actually purchased) = P(Planned to purchase)

Therefore, of those households that purchased a big-screen television, there is a 50.0% chance
that a randomly selected household purchased a television that had a faster refresh rate or
purchased a BD player.

=
150
300

= 0.50

=
80
300

+
108
300

-
38
300
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Problems for Section 4.1
LEARNING THE BASICS

4.1 Two coins are tossed.
a. Give an example of a simple event.
b. Give an example of a joint event.
c. What is the complement of a head on the first toss?

4.2 An urn contains 12 red balls and 8 white balls. One ball
is to be selected from the urn.
a. Give an example of a simple event.
b. What is the complement of a red ball?

4.3 Consider the following contingency table:

b. Each respondent was classified by the type of car he or she
drives: sedan, SUV, American, European, Asian, or none.

c. People were asked, “Do you currently live in (i) an apart-
ment or (ii) a house?”

d. A product was classified as defective or not defective.

4.7 Which of the following events occur with a probability
of zero? For each, state why or why not.
a. A voter in the United States is registered as a Republican

and as a Democrat.
b. A voter in the United States is female and registered as a

Republican.
c. An automobile is a Ford and a Toyota.
d. An automobile is a Toyota and was manufactured in the

United States.

4.8 Does it take more time to be removed from an email
list than it used to take? A study of 100 large online retailers
revealed the following:

B B¿

A 10 20
A¿ 20 40

B B¿

A 10 30
A¿ 25 35

What is the probability of
a. event A?
b. event
c. event A and B?
d. A or B?

4.4 Consider the following contingency table:

A¿?

What is the probability of
a. event
b. event A and B?
c. event and
d. event or

APPLYING THE CONCEPTS

4.5 For each of the following, indicate whether the type of
probability involved is an example of a priori probability,
empirical probability, or subjective probability.
a. The next toss of a fair coin will land on heads.
b. Italy will win soccer’s World Cup the next time the com-

petition is held.
c. The sum of the faces of two dice will be seven.
d. The train taking a commuter to work will be more than

10 minutes late.

4.6 For each of the following, state whether the events
created are mutually exclusive and collectively exhaustive.
a. Registered voters in the United States were asked whether

they are registered as Republicans or Democrats.

B¿?A¿
B¿?A¿

A¿?

NEED THREE OR MORE CLICKS TO BE REMOVED

YEAR Yes No

2009 39 61
2008 7 93

Source: Data extracted from “More Clicks to Escape an Email List,”
The New York Times, March 29, 2010, p. B2.

a. Give an example of a simple event.
b. Give an example of a joint event.
c. What is the complement of “Needs three or more clicks

to be removed from an email list”?
d. Why is “Needs three or more clicks to be removed from

an email list in 2009” a joint event?

4.9 Referring to the contingency table in Problem 4.8, if a
large online retailer is selected at random, what is the prob-
ability that
a. you needed three or more clicks to be removed from an

email list?
b. you needed three or more clicks to be removed from an

email list in 2009?
c. you needed three or more clicks to be removed from an

email list or were a large online retailer surveyed in 2009?
d. Explain the difference in the results in (b) and (c).

4.10 Do people of different age groups differ in their
response to email messages? A survey by the Center for the
Digital Future of the University of Southern California (data
extracted from A. Mindlin, “Older E-mail Users Favor Fast
Replies,” The New York Times, July 14, 2008, p. B3) re-
ported that 70.7% of users over 70 years of age believe that
email messages should be answered quickly, as compared to
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53.6% of users 12 to 50 years old. Suppose that the survey
was based on 1,000 users over 70 years of age and 1,000
users 12 to 50 years old. The following table summarizes the
results:

COUNTRY

ENGAGEMENT United States Germany Total

Engaged 550 246 796
Not engaged 1,345 1,649 2,994
Total 1,895 1,895 3,790

Source: Data extracted from M. Nink, “Employee Disengagement
Plagues Germany,” Gallup Management Journal, gmj.gallup.com,
April 9, 2009.

AGE OF RESPONDENTS

ANSWERS QUICKLY 12–50 Over 70 Total

Yes 536 707 1,243
No 464 293 757
Total 1,000 1,000 2,000

a. Give an example of a simple event.
b. Give an example of a joint event.
c. What is the complement of a respondent who answers

quickly?
d. Why is a respondent who answers quickly and is over 70

years old a joint event?

4.11 Referring to the contingency table in Problem 4.10, if
a respondent is selected at random, what is the probability
that
a. he or she answers quickly?
b. he or she is over 70 years old?
c. he or she answers quickly or is over 70 years old?
d. Explain the difference in the results in (b) and (c).

4.12 According to a Gallup Poll, the extent to
which employees are engaged with their work-

place varies from country to country. Gallup reports that
the percentage of U.S. workers engaged with their work-
place is more than twice as high as the percentage of
German workers. The study also shows that having more
engaged workers leads to increased innovation, productiv-
ity, and profitability, as well as reduced employee turnover.
The results of the poll are summarized in the following
table:

SELF
Test

GENDER

DINING PREFERENCE Male Female Total

Dine inside 21 12 33
Order inside to go 19 10 29
Order at the 

drive-through 60 78 138
Total 100 100 200

Source: Data extracted from www.qsrmagazine.com/reports/drive-
thru_time_study/2009/2009_charts/whats_your_preferred_way_
to_order_fast_food.html.

If a respondent is selected at random, what is the probability
that he or she
a. prefers to order at the drive-through?
b. is a male and prefers to order at the drive-through?
c. is a male or prefers to order at the drive-through?
d. Explain the difference in the results in (b) and (c).

4.14 A sample of 500 respondents in a large metropolitan
area was selected to study consumer behavior. Among the
questions asked was “Do you enjoy shopping for clothing?”
Of 240 males, 136 answered yes. Of 260 females, 224
answered yes. Construct a contingency table to evaluate the
probabilities. What is the probability that a respondent
chosen at random
a. enjoys shopping for clothing?
b. is a female and enjoys shopping for clothing?
c. is a female or enjoys shopping for clothing?
d. is a male or a female?

4.15 Each year, ratings are compiled concerning the
performance of new cars during the first 90 days of use.
Suppose that the cars have been categorized according to
whether a car needs warranty-related repair (yes or no) and
the country in which the company manufacturing a car is
based (United States or not United States). Based on the data
collected, the probability that the new car needs a warranty
repair is 0.04, the probability that the car was manufactured
by a U.S.-based company is 0.60, and the probability that the
new car needs a warranty repair and was manufactured by a
U.S.-based company is 0.025. Construct a contingency table
to evaluate the probabilities of a warranty-related repair.
What is the probability that a new car selected at random
a. needs a warranty repair?
b. needs a warranty repair and was manufactured by a U.S.-

based company?
c. needs a warranty repair or was manufactured by a U.S.-

based company?
d. needs a warranty repair or was not manufactured by a

U.S.-based company?

If an employee is selected at random, what is the probability
that he or she
a. is engaged with his or her workplace?
b. is a U.S. worker?
c. is engaged with his or her workplace or is a U.S. worker?
d. Explain the difference in the results in (b) and (c).

4.13 What is the preferred way for people to order fast
food? A survey was conducted in 2009, but the sample sizes
were not reported. Suppose the results, based on a sample of
100 males and 100 females, were as follows:

www.qsrmagazine.com/reports/drivethru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_food.html
www.qsrmagazine.com/reports/drivethru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_food.html
www.qsrmagazine.com/reports/drivethru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_food.html
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4.2 Conditional Probability
Each example in Section 4.1 involves finding the probability of an event when sampling from
the entire sample space. How do you determine the probability of an event if you know certain
information about the events involved?

Computing Conditional Probabilities
Conditional probability refers to the probability of event A, given information about the
occurrence of another event, B.

CONDITIONAL PROBABILITY
The probability of A given B is equal to the probability of A and B divided by the
probability of B.

(4.4a)

The probability of B given A is equal to the probability of A and B divided by the
probability of A.

(4.4b)

where

P(A and B) = joint probability of A and B

P(A) = marginal probability of A

P(B) = marginal probability of B

P1B|A2 =
P1A and B2

P1A2

P1A|B2 =
P1A and B2

P1B2

Referring to the Using Statistics scenario involving the purchase of big-screen televi-
sions, suppose you were told that a household planned to purchase a big-screen television.
Now, what is the probability that the household actually purchased the television? In this ex-
ample, the objective is to find P(Actually purchased | Planned to purchase). Here you are
given the information that the household planned to purchase the big-screen television.
Therefore, the sample space does not consist of all 1,000 households in the survey. It consists
of only those households that planned to purchase the big-screen television. Of 250 such
households, 200 actually purchased the big-screen television. Therefore, based on Table 4.1
on page 148, the probability that a household actually purchased the big-screen television
given that he or she planned to purchase is

You can also use Equation (4.4b) to compute this result:

where

planned to purchase

actually purchasedB =
A =

P1B|A2 =
P1A and B2

P1A2

=
200
250

= 0.80

P1Actually purchased ƒPlanned to purchase2 =
Planned to purchase and actually purchased

Planned to purchase
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then

Example 4.6 further illustrates conditional probability.

=
200
250

= 0.80

P1Actually purchased ƒPlanned to purchase2 =
200>1,000

250>1,000

Table 4.2 on page 149 is a contingency table for whether a household purchased a television
with a faster refresh rate and whether the household purchased a Blu-ray disc player. If a
household purchased a television with a faster refresh rate, what is the probability that it also
purchased a Blu-ray disc player?

SOLUTION Because you know that the household purchased a television with a faster
refresh rate, the sample space is reduced to 80 households. Of these 80 households, 38 also
purchased a Blu-ray disc (BD) player. Therefore, the probability that a household
purchased a BD player, given that the household purchased a television with a faster refresh
rate, is

If you use Equation (4.4b) on page 155:

A = purchased a television with a faster refresh rate

B = purchased a BD player

then

Therefore, given that the household purchased a television with a faster refresh rate,
there is a 47.5% chance that the household also purchased a Blu-ray disc player. You can
compare this conditional probability to the marginal probability of purchasing a Blu-ray
disc player, which is or 36%. These results tell you that households that
purchased televisions with a faster refresh rate are more likely to purchase a Blu-ray disc
player than are households that purchased big-screen televisions that have a standard
refresh rate.

108>300 = 0.36,

P1B|A2 =
P1A and B2

P1A2 =
38>300

80>300
= 0.475

=
38
80

= 0.475

P1Purchased BD player | Purchased
television with faster refresh rate) =

Number purchasing television with 
faster refresh rate and BD player

Number purchasing television
with faster refresh rate

EXAMPLE 4.6
Finding the Condi-
tional Probability
of Purchasing
a Blu-ray Disc 
Player

Decision Trees
In Table 4.1 on page 148, households are classified according to whether they planned to
purchase and whether they actually purchased big-screen televisions. A decision tree is an
alternative to the contingency table. Figure 4.3 represents the decision tree for this
example.
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In Figure 4.3, beginning at the left with the entire set of households, there are two
“branches” for whether or not the household planned to purchase a big-screen television. Each
of these branches has two subbranches, corresponding to whether the household actually pur-
chased or did not actually purchase the big-screen television. The probabilities at the end of
the initial branches represent the marginal probabilities of A and The probabilities at the
end of each of the four subbranches represent the joint probability for each combination of
events A and B. You compute the conditional probability by dividing the joint probability by
the appropriate marginal probability.

For example, to compute the probability that the household actually purchased, given that
the household planned to purchase the big-screen television, you take P(Planned to purchase
and actually purchased) and divide by P(Planned to purchase). From Figure 4.3,

Example 4.7 illustrates how to construct a decision tree.

=
200
250

= 0.80

P1Actually purchased ƒPlanned to purchase2 =
200>1,000

250>1,000

A¿.

Entire
Set of

Households

Planned to

Purchase

Did Not Plan
to Purchase

Actually Purchased

Actually Purchased

Did Not ActuallyPurchase

Did Not Actually
Purchase

P(A′) �
 750 
1,000

P(A and B ′)= 50
1,000

P(A′ and B) = 100
1,000

P(A′ and B ′) = 650
1,000

P(A) =  250 
1,000

P(A and B) = 200
1,000

F I G U R E 4 . 3
Decision tree for M&R
Electronics World
example

Using the cross-classified data in Table 4.2 on page 149, construct the decision tree. Use the
decision tree to find the probability that a household purchased a Blu-ray disc player, given
that the household purchased a television with a faster refresh rate.

SOLUTION The decision tree for purchased a Blu-ray disc player and a television with a
faster refresh rate is displayed in Figure 4.4 on page 156. Using Equation (4.4b) on page 155
and the following definitions,

A = purchased a television with a faster refresh rate

B = purchased a Blu-ray disc player

P1B|A2 =
P1A and B2

P1A2 =
38>300

80>300
= 0.475

EXAMPLE 4.7
Constructing the
Decision Tree for
the Households
That Purchased
Big-Screen
Televisions
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Entire
Set of

Households

Purchased Faster 

Refresh Rate Television

Did Not Purchase

Faster Refresh Rate
Television

Purchased BD Player

Purchased BD Player

Did Not PurchaseBD Player

Did Not Purchase
BD Player

P(A′) = 220
300

P(A and B ′) =  42 
300

P(A′ and B) = 70
300

P(A′ and B ′) =  150 
300

P(A) = 80
300

P(A and B) =  38 
300

F I G U R E 4 . 4
Decision tree for
purchased a television
with a faster refresh rate
and a Blu-ray disc (BD)
player

Independence
In the example concerning the purchase of big-screen televisions, the conditional probability
is that the selected household actually purchased the big-screen television,
given that the household planned to purchase. The simple probability of selecting a household
that actually purchased is This result shows that the prior knowledge that
the household planned to purchase affected the probability that the household actually
purchased the television. In other words, the outcome of one event is dependent on the
outcome of a second event.

When the outcome of one event does not affect the probability of occurrence of another
event, the events are said to be independent. Independence can be determined by using
Equation (4.5).

300>1,000 = 0.30.

200>250 = 0.80

INDEPENDENCE
Two events, A and B, are independent if and only if

(4.5)

where

conditional probability of A given B

marginal probability of AP1A2 =

P1A|B2 =

P1A|B2 = P1A2

Example 4.8 demonstrates the use of Equation (4.5).

In the follow-up survey of the 300 households that actually purchased big-screen televisions,
the households were asked if they were satisfied with their purchases. Table 4.3 cross-classi-
fies the responses to the satisfaction question with the responses to whether the television had
a faster refresh rate.

EXAMPLE 4.8
Determining
Independence

T A B L E 4 . 3

Satisfaction with
Purchase of Big-Screen
Televisions

TELEVISION
REFRESH RATE

SATISFIED WITH PURCHASE?

Yes No Total

Faster 64 16 80
Standard 176 44 220
Total 240 60 300
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GENERAL MULTIPLICATION RULE
The probability of A and B is equal to the probability of A given B times the probability
of B.

(4.6)P1A and B2 = P1A|B2P1B2

Determine whether being satisfied with the purchase and the refresh rate of the television
purchased are independent.

SOLUTION For these data,

which is equal to

Thus, being satisfied with the purchase and the refresh rate of the television purchased are
independent. Knowledge of one event does not affect the probability of the other event.

P1Satisfied2 =
240
300

= 0.80

P1Satisfied ƒ faster refresh rate2 =
64>300

80>300
=

64
80

= 0.80

Multiplication Rules
The general multiplication rule is derived using Equation (4.4a) on page 155:

and solving for the joint probability P(A and B).

P1A|B2 =
P1A and B2

P1B2

Example 4.9 demonstrates the use of the general multiplication rule.

Consider the 80 households that purchased televisions that had a faster refresh rate. In Table
4.3 on page 158 you see that 64 households are satisfied with their purchase, and 16 house-
holds are dissatisfied. Suppose 2 households are randomly selected from the 80 households.
Find the probability that both households are satisfied with their purchase.

SOLUTION Here you can use the multiplication rule in the following way. If

then, using Equation (4.6),

The probability that the first household is satisfied with the purchase is 64/80. However,
the probability that the second household is also satisfied with the purchase depends on the
result of the first selection. If the first household is not returned to the sample after the satis-
faction level is determined (i.e., sampling without replacement), the number of households
remaining is 79. If the first household is satisfied, the probability that the second is also
satisfied is 63/79 because 63 satisfied households remain in the sample. Therefore,

P1A and B2 = P1A|B2P1B2

B = first household selected is satisfied

A = second household selected is satisfied

EXAMPLE 4.9
Using the General
Multiplication Rule
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There is a 63.80% chance that both of the households sampled will be satisfied with their
purchase.

P1A and B2 = a63
79
b a64

80
b = 0.6380

The multiplication rule for independent events is derived by substituting P(A) for
in Equation (4.6).P1A|B2

MULTIPLICATION RULE FOR INDEPENDENT EVENTS
If A and B are independent, the probability of A and B is equal to the probability of A
times the probability of B.

(4.7)P1A and B2 = P1A2P1B2

MARGINAL PROBABILITY USING THE GENERAL MULTIPLICATION RULE

(4.8)

where are k mutually exclusive and collectively exhaustive events.B1, B2, Á , Bk

P1A2 = P1A|B12P1B12 + P1A|B22P1B22 + Á + P1A|Bk2P1Bk2

If this rule holds for two events, A and B, then A and B are independent. Therefore, there are
two ways to determine independence:

1. Events A and B are independent if, and only if, 
2. Events A and B are independent if, and only if, 

Marginal Probability Using the General Multiplication Rule
In Section 4.1, marginal probability was defined using Equation (4.2) on page. You can state
the equation for marginal probability by using the general multiplication rule. If

then, using the general multiplication rule, Equation (4.8) defines the marginal probability.

P1A2 = P1A and B12 + P1A and B22 + Á + P1A and Bk2

P1A and B2 = P1A2P1B2.P1A|B2 = P1A2.

To illustrate Equation (4.8), refer to Table 4.1 on page. Let

“planned to purchase”

“actually purchased”

“did not actually purchase”

Then, using Equation (4.8), the probability of planned to purchase is

=
200

1,000
+

50
1,000

=
250

1,000
= 0.25

= a200
300
b a 300

1,000
b + a 50

700
b a 700

1,000
b

P1A2 = P1A|B12P1B12 + P1A|B22P1B22

P1B22 = probability of

P1B12 = probability of

P1A2 = probability of
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Problems for Section 4.2
LEARNING THE BASICS
4.16 Consider the following contingency table:

b. Given that the year 2009 is involved, what is the proba-
bility that three or more clicks are needed to be removed
from an email list?

c. Explain the difference in the results in (a) and (b).
d. Are needing three or more clicks to be removed from an

email list and the year independent?

4.22 Do people of different age groups differ in their re-
sponse to email messages? A survey by the Center for the
Digital Future of the University of Southern California (data
extracted from A. Mindlin, “Older E-mail Users Favor Fast
Replies,” The New York Times, July 14, 2008, p. B3) re-
ported that 70.7% of users over 70 years of age believe that
email messages should be answered quickly, as compared to
53.6% of users 12 to 50 years old. Suppose that the survey
was based on 1,000 users over 70 years of age and 1,000
users 12 to 50 years old. The following table summarizes the
results:

B B¿

A 10 20
A¿ 20 40

What is the probability of
a.
b.
c.
d. Are events A and B independent?

4.17 Consider the following contingency table:

A¿|B¿?
A|B¿?
A|B?

B B¿

A 10 30
A¿ 25 35

What is the probability of
a.
b.
c.
d. Are events A and B independent?

4.18 If and find

4.19 If and A and B are inde-
pendent, find P(A and B).

4.20 If and
are A and B independent?

APPLYING THE CONCEPTS

4.21 Does it take more time to be removed from an email
list than it used to take? A study of 100 large online retailers
revealed the following:

P1A and B2 = 0.2,P1A2 = 0.3, P1B2 = 0.4,

P1A2 = 0.7, P1B2 = 0.6,

P1A|B2.P1B2 = 0.8,P1A and B2 = 0.4

A|B¿?
A¿|B¿?
A|B?

NEED THREE OR MORE CLICKS 
TO BE REMOVED

YEAR Yes No

2009 39 61
2008 7 93

Source: Data extracted from “More Clicks to Escape an Email List,”
The New York Times, March 29, 2010, p. B2.

a. Given that three or more clicks are needed to be removed
from an email list, what is the probability that this
occurred in 2009?

AGE OF RESPONDENTS

ANSWERS QUICKLY

12–50 Over 70 Total

Yes 536 707 1,243
No 464 293 757
Total 1,000 1,000 2,000

a. Suppose you know that the respondent is between 12 and
50 years old. What is the probability that he or she an-
swers quickly?

b. Suppose you know that the respondent is over 70 years
old. What is the probability that he or she answers
quickly?

c. Are the two events, answers quickly and age of respon-
dents, independent? Explain.

4.23 What is the preferred way for people to order fast
food? A survey was conducted in 2009, but the sample sizes
were not reported. Suppose the results, based on a sample of
100 males and 100 females, were as follows:

GENDER

DINING PREFERENCE Male Female Total

Dine inside 21 12 33
Order inside to go 19 10 29
Order at the 

drive-through 60 78 138
Total 100 100 200

Source: Data extracted from www.qsrmagazine.com/reports/drive-
thru_time_study/2009/2009_charts/whats_your_preferred_way_to
_order_fast_food.html.

www.qsrmagazine.com/reports/drivethru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_food.html
www.qsrmagazine.com/reports/drivethru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_food.html
www.qsrmagazine.com/reports/drivethru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_food.html
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a. Given that a respondent is a male, what is the probability
that he prefers to order at the drive-through?

b. Given that a respondent is a female, what is the probabil-
ity that she prefers to order at the drive-through?

c. Is dining preference independent of gender? Explain.

4.24 According to a Gallup Poll, the extent to
which employees are engaged with their work-

place varies from country to country. Gallup reports that the
percentage of U.S. workers engaged with their workplace is
more than twice as high as the percentage of German work-
ers. The study also shows that having more engaged work-
ers leads to increased innovation, productivity, and
profitability, as well as reduced employee turnover. The
results of the poll are summarized in the following table:

SELF
Test

4.26 Each year, ratings are compiled concerning the
performance of new cars during the first 90 days of use.
Suppose that the cars have been categorized according to
whether a car needs warranty-related repair (yes or no) and
the country in which the company manufacturing a car is
based (United States or not United States). Based on the
data collected, the probability that the new car needs a
warranty repair is 0.04, the probability that the car is manu-
factured by a U.S.-based company is 0.60, and the probabil-
ity that the new car needs a warranty repair and was
manufactured by a U.S.-based company is 0.025.
a. Suppose you know that a company based in the United

States manufactured a particular car. What is the proba-
bility that the car needs warranty repair?

b. Suppose you know that a company based in the United
States did not manufacture a particular car. What is the
probability that the car needs warranty repair?

c. Are need for warranty repair and location of the company
manufacturing the car independent?

4.27 In 38 of the 60 years from 1950 through 2009, the
S&P 500 finished higher after the first five days of trading.
In 33 of those 38 years, the S&P 500 finished higher for the
year. Is a good first week a good omen for the upcoming
year? The following table gives the first-week and annual
performance over this 60-year period:

COUNTRY

ENGAGEMENT United States Germany Total

Engaged 550 246 796
Not engaged 1,345 1,649 2,994
Total 1,895 1,895 3,790

Source: Data extracted from M. Nink, “Employee Disengagement
Plagues Germany,” Gallup Management Journal, gmj.gallup.com,
April 9, 2009.

a. Given that a worker is from the United States, what is the
probability that the worker is engaged?

b. Given that a worker is from the United States, what is the
probability that the worker is not engaged?

c. Given that a worker is from Germany, what is the proba-
bility that the worker is engaged?

d. Given that a worker is from Germany, what is the proba-
bility that the worker is not engaged?

4.25 A sample of 500 respondents in a large metropolitan
area was selected to study consumer behavior, with the fol-
lowing results:

ENJOYS SHOPPING
FOR CLOTHING

GENDER

Male Female Total

Yes 136 224 360
No 104 36 140
Total 240 260 500

a. Suppose that the respondent chosen is a female. What is
the probability that she does not enjoy shopping for
clothing?

b. Suppose that the respondent chosen enjoys shopping for
clothing. What is the probability that the individual is a
male?

c. Are enjoying shopping for clothing and the gender of the
individual independent? Explain.

S&P 500’S ANNUAL PERFORMANCE

FIRST WEEK Higher Lower

Higher 33 5
Lower 11 11

a. If a year is selected at random, what is the probability
that the S&P 500 finished higher for the year?

b. Given that the S&P 500 finished higher after the first
five days of trading, what is the probability that it
finished higher for the year?

c. Are the two events “first-week performance” and “an-
nual performance” independent? Explain.

d. Look up the performance after the first five days of 2010
and the 2010 annual performance of the S&P 500 at
finance.yahoo.com. Comment on the results.

4.28 A standard deck of cards is being used to play a
game. There are four suits (hearts, diamonds, clubs, and
spades), each having 13 faces (ace, 2, 3, 4, 5, 6, 7, 8, 9, 10,
jack, queen, and king), making a total of 52 cards. This
complete deck is thoroughly mixed, and you will receive the
first 2 cards from the deck, without replacement (the first
card is not returned to the deck after it is selected).
a. What is the probability that both cards are queens?
b. What is the probability that the first card is a 10 and the

second card is a 5 or 6?
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c. If you were sampling with replacement (the first card is
returned to the deck after it is selected), what would be
the answer in (a)?

d. In the game of blackjack, the face cards (jack, queen,
king) count as 10 points, and the ace counts as either 1 or
11 points. All other cards are counted at their face value.
Blackjack is achieved if 2 cards total 21 points. What is
the probability of getting blackjack in this problem?

4.29 A box of nine gloves contains two left-handed gloves
and seven right-handed gloves.
a. If two gloves are randomly selected from the box, with-

out replacement (the first glove is not returned to the box

after it is selected), what is the probability that both
gloves selected will be right-handed?

b. If two gloves are randomly selected from the box, without
replacement (the first glove is not returned to the box after
it is selected), what is the probability that there will be one
right-handed glove and one left-handed glove selected?

c. If three gloves are selected, with replacement (the gloves
are returned to the box after they are selected), what is
the probability that all three will be left-handed?

d. If you were sampling with replacement (the first glove is
returned to the box after it is selected), what would be the
answers to (a) and (b)?

4.3 Bayes’ Theorem
Bayes’ theorem is used to revise previously calculated probabilities based on new informa-
tion. Developed by Thomas Bayes in the eighteenth century (see references 1, 2, and 7), Bayes’
theorem is an extension of what you previously learned about conditional probability.

You can apply Bayes’ theorem to the situation in which M&R Electronics World is consid-
ering marketing a new model of televisions. In the past, 40% of the new-model televisions
have been successful, and 60% have been unsuccessful. Before introducing the new model tel-
evision, the marketing research department conducts an extensive study and releases a report,
either favorable or unfavorable. In the past, 80% of the successful new-model television(s) had
received favorable market research reports, and 30% of the unsuccessful new-model televi-
sion(s) had received favorable reports. For the new model of television under consideration,
the marketing research department has issued a favorable report. What is the probability that
the television will be successful?

Bayes’ theorem is developed from the definition of conditional probability. To find the con-
ditional probability of B given A, consider Equation (4.4b) (originally presented on page 155
and shown below):

Bayes’ theorem is derived by substituting Equation (4.8) on page 160 for P(A) in the denomi-
nator of Equation (4.4b).

P1B|A2 =
P1A and B2

P1A2 =
P1A|B2P1B2

P1A2

BAYES’ THEOREM

(4.9)

where Bi is the ith event out of k mutually exclusive and collectively exhaustive events.

P1Bi|A2 =
P1A|Bi2P1Bi2

P1A|B12P1B12 + P1A|B22P1B22 + Á + P1A|Bk2P1Bk2

To use Equation (4.9) for the television-marketing example, let

and

P1S¿2 = 0.60 P1F|S¿2 = 0.30

P1S2 = 0.40 P1F|S2 = 0.80

event S¿ = unsuccessful television event F¿ = unfavorable report

event S = successful television event F = favorable report
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Then, using Equation (4.9),

The probability of a successful television, given that a favorable report was received, is
0.64. Thus, the probability of an unsuccessful television, given that a favorable report was
received, is 

Table 4.4 summarizes the computation of the probabilities, and Figure 4.5 presents the
decision tree.

1 - 0.64 = 0.36.

= 0.64

=
0.32

0.32 + 0.18
=

0.32
0.50

=
10.80210.402

10.80210.402 + 10.30210.602

P1S|F2 =
P1F|S2P1S2

P1F|S2P1S2 + P1F|S¿2P1S¿2

T A B L E 4 . 4

Bayes’ Theorem
Calculations for the
Television-Marketing
Example

Event Si

Prior
Probability

P(Si)

Conditional
Probability

P(F ƒSi)

Joint
Probability

P(F ƒSi)P(Si)
Revised Probability

P(Si ƒF)

successful
television

S � 0.40 0.80 0.32
= 0.64

P1S|F2 = 0.32>0.50

unsuccessful
television

S¿� 0.60 0.30 0.18
0.50 = 0.36

P1S¿|F2 = 0.18>0.50

P(S) = 0.40 

P(S ′) = 0.60 

P(S ′ and F ′) = P(F ′|S ′) P(S ′)
= (0.70) (0.60) = 0.42

P(S and F ′) = P(F ′|S) P(S)
= (0.20) (0.40) = 0.08

P(S ′ and F) = P(F|S ′) P(S ′)
= (0.30) (0.60) = 0.18

P(S and F) = P(F|S) P(S)
  = (0.80) (0.40) = 0.32

F I G U R E 4 . 5
Decision tree for
marketing a new
television

The probability that a person has a certain disease is 0.03. Medical diagnostic tests are avail-
able to determine whether the person actually has the disease. If the disease is actually
present, the probability that the medical diagnostic test will give a positive result (indicating
that the disease is present) is 0.90. If the disease is not actually present, the probability of a
positive test result (indicating that the disease is present) is 0.02. Suppose that the medical
diagnostic test has given a positive result (indicating that the disease is present). What is the
probability that the disease is actually present? What is the probability of a positive test
result?

EXAMPLE 4.10
Using Bayes’ 
Theorem in a 
Medical Diagnosis
Problem

Example 4.10 applies Bayes’ theorem to a medical diagnosis problem.
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SOLUTION Let

and

Using Equation (4.9) on page 163,

The probability that the disease is actually present, given that a positive result has occurred
(indicating that the disease is present), is 0.582. Table 4.5 summarizes the computation of the
probabilities, and Figure 4.6 presents the decision tree.

= 0.582

=
0.0270

0.0270 + 0.0194
=

0.0270
0.0464

=
10.90210.032

10.90210.032 + 10.02210.972

P1D|T2 =
P1T|D2P1D2

P1T|D2P1D2 + P1T|D¿2P1D¿2

P1D¿2 = 0.97 P1T|D¿2 = 0.02

P1D2 = 0.03 P1T|D2 = 0.90

event D¿ = does not have disease event T¿ = test is negative

event D = has disease event T = test is positive

T A B L E 4 . 5

Bayes’ Theorem
Calculations for the
Medical Diagnosis
Problem

Event D
i

Prior
Probability

P(D
i
)

Conditional
Probability

P(T | D
i
)

Joint
Probability

P(T | D
i
)P(D

i
)

Revised Probability
P(D

i
| T)

has
disease

D � 0.03 0.90 0.0270
= 0.582

P(D|T2 = 0.0270>0.0464

does not 
have disease

D¿� 0.97 0.02 0.0194
0.0464 = 0.418

P(D¿|T 2 = 0.0194>0.0464

P(D) = 0.03

P(D ′) = 0.97

P(D and T ′) = P(T ′|D) P(D)
= (0.10) (0.03) = 0.0030

P(D ′ and T ) = P(T |D ′) P(D ′)
= (0.02) (0.97) = 0.0194

P(D ′ and T ′) = P(T ′|D ′) P(D ′)
= (0.98) (0.97) = 0.9506

P(D and T ) = P(T |D) P(D)
= (0.90) (0.03) = 0.0270

F I G U R E 4 . 6
Decision tree for the
medical diagnosis
problem

The denominator in Bayes’ theorem represents P(T ), the probability of a positive test re-
sult, which in this case is 0.0464, or 4.64%.
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T H I N K A B O U T T H I S Divine Providence and Spam

Would you ever guess that the essays Divine
Benevolence: Or, An Attempt to Prove That the
Principal End of the Divine Providence and Gov-
ernment Is the Happiness of His Creatures and
An Essay Towards Solving a Problem in the Doc-
trine of Chances were written by the same per-
son? Probably not, and in doing so, you illustrate
a modern-day application of Bayesian statistics:
spam, or junk mail, filters.

In not guessing correctly, you probably
looked at the words in the titles of the essays
and concluded that they were talking about two
different things. An implicit rule you used was
that word frequencies vary by subject matter. A
statistics essay would very likely contain the
word statistics as well as words such as chance,
problem, and solving. An eighteenth-century es-
say about theology and religion would be more
likely to contain the uppercase forms of Divine
and Providence.

Likewise, there are words you would guess
to be very unlikely to appear in either book, such
as technical terms from finance, and words that
are most likely to appear in both—common
words such as a, and, and the. That words would
either be likely or unlikely suggests an applica-
tion of probability theory. Of course, likely and
unlikely are fuzzy concepts, and we might occa-
sionally misclassify an essay if we kept things
too simple, such as relying solely on the occur-
rence of the words Divine and Providence.

For example, a profile of the late Harris Mil-
stead, better known as Divine, the star of
Hairspray and other films, visiting Providence
(Rhode Island), would most certainly not be an
essay about theology. But if we widened the
number of words we examined and found such
words as movie or the name John Waters (Di-
vine’s director in many films), we probably would
quickly realize the essay had something to do
with twentieth-century cinema and little to do
with theology and religion.

We can use a similar process to try to clas-
sify a new email message in your in-box as
either spam or a legitimate message (called
“ham,” in this context). We would first need to
add to your email program a “spam filter” that
has the ability to track word frequencies associ-
ated with spam and ham messages as you iden-
tify them on a day-to-day basis. This would allow
the filter to constantly update the prior probabili-
ties necessary to use Bayes’ theorem. With these
probabilities, the filter can ask, “What is the
probability that an email is spam, given the pres-
ence of a certain word?”

Applying the terms of Equation (4.9)
on page 163, such a Bayesian spam filter would
multiply the probability of finding the word in a
spam email, P(A |B), by the probability that the
email is spam, P(B), and then divide by the prob-
ability of finding the word in an email, the de-
nominator in Equation (4.9). Bayesian spam
filters also use shortcuts by focusing on a small
set of words that have a high probability of being
found in a spam message as well as on a small
set of other words that have a low probability of
being found in a spam message.

As spammers (people who send junk email)
learned of such new filters, they tried to outfox
them. Having learned that Bayesian filters might
be assigning a high P(A|B) value to words com-
monly found in spam, such as Viagra, spammers
thought they could fool the filter by misspelling
the word as Vi@gr@ or V1agra. What they over-
looked was that the misspelled variants were
even more likely to be found in a spam message
than the original word. Thus, the misspelled vari-
ants made the job of spotting spam easier for the
Bayesian filters.

Other spammers tried to fool the filters by
adding “good” words, words that would have a
low probability of being found in a spam mes-
sage, or “rare” words, words not frequently en-
countered in any message. But these spammers

overlooked the fact that the conditional probabil-
ities are constantly updated and that words once
considered “good” would be soon discarded
from the good list by the filter as their P(A|B)
value increased. Likewise, as “rare” words grew
more common in spam and yet stayed rare in
ham, such words acted like the misspelled vari-
ants that others had tried earlier.

Even then, and perhaps after reading about
Bayesian statistics, spammers thought that
they could “break” Bayesian filters by inserting
random words in their messages. Those ran-
dom words would affect the filter by causing it
to see many words whose P(A|B) value would
be low. The Bayesian filter would begin to label
many spam messages as ham and end up
being of no practical use. Spammers again
overlooked that conditional probabilities are
constantly updated.

Other spammers decided to eliminate all or
most of the words in their messages and replace
them with graphics so that Bayesian filters
would have very few words with which to form
conditional probabilities. But this approach
failed, too, as Bayesian filters were rewritten to
consider things other than words in a message.
After all, Bayes’ theorem concerns events, and
“graphics present with no text” is as valid an
event as “some word, X, present in a message.”
Other future tricks will ultimately fail for the
same reason. (By the way, spam filters use non-
Bayesian techniques as well, which makes
spammers’ lives even more difficult.)

Bayesian spam filters are an example of the
unexpected way that applications of statistics
can show up in your daily life. You will discover
more examples as you read the rest of this book.
By the way, the author of the two essays men-
tioned earlier was Thomas Bayes, who is a lot
more famous for the second essay than the first
essay, a failed attempt to use mathematics and
logic to prove the existence of God.

LEARNING THE BASICS
4.30 If

4.31 If

APPLYING THE CONCEPTS

4.32 In Example 4.10 on page 164, suppose that the
probability that a medical diagnostic test will give a posi-

 find P1B|A2.P1A|B¿2 = 0.50,
P1B2 = 0.30, P1A|B2 = 0.60, P1B¿2 = 0.70, and

 find P1B|A2.P1A|B¿2 = 0.40,
P1B2 = 0.05, P1A|B2 = 0.80, P1B¿2 = 0.95, and

tive result if the disease is not present is reduced from
0.02 to 0.01.
a. If the medical diagnostic test has given a positive result

(indicating that the disease is present), what is the proba-
bility that the disease is actually present?

b. If the medical diagnostic test has given a negative result
(indicating that the disease is not present), what is the
probability that the disease is not present?

4.33 An advertising executive is studying television viewing
habits of married men and women during prime-time hours.

Problems for Section 4.3
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Based on past viewing records, the executive has determined
that during prime time, husbands are watching television 60%
of the time. When the husband is watching television, 40% of
the time the wife is also watching. When the husband is not
watching television, 30% of the time the wife is watching tel-
evision.
a. Find the probability that if the wife is watching televi-

sion, the husband is also watching television.
b. Find the probability that the wife is watching television

during prime time.

4.34 Olive Construction Company is determin-
ing whether it should submit a bid for a new

shopping center. In the past, Olive’s main competitor, Base
Construction Company, has submitted bids 70% of the time.
If Base Construction Company does not bid on a job, the
probability that Olive Construction Company will get
the job is 0.50. If Base Construction Company bids on a job,
the probability that Olive Construction Company will
get the job is 0.25.
a. If Olive Construction Company gets the job, what is the

probability that Base Construction Company did not
bid?

b. What is the probability that Olive Construction Company
will get the job?

4.35 Laid-off workers who become entrepreneurs because
they cannot find meaningful employment with another com-
pany are known as entrepreneurs by necessity. The Wall
Street Journal reports that these entrepreneurs by necessity
are less likely to grow into large businesses than are
entrepreneurs by choice (J. Bailey, “Desire—More Than
Need—Builds a Business,” The Wall Street Journal, May
21, 2001, p. B4). This article states that 89% of the entrepre-
neurs in the United States are entrepreneurs by choice and
11% are entrepreneurs by necessity. Only 2% of entrepre-
neurs by necessity expect their new business to employ 20
or more people within five years, whereas 14% of entrepre-
neurs by choice expect to employ at least 20 people within
five years.

SELF
Test

a. If an entrepreneur is selected at random and that individ-
ual expects that his or her new business will employ 20
or more people within five years, what is the probability
that this individual is an entrepreneur by choice?

b. Discuss several possible reasons why entrepreneurs by
choice are more likely than entrepreneurs by necessity to
believe that they will grow their businesses.

4.36 The editor of a textbook publishing company is try-
ing to decide whether to publish a proposed business statis-
tics textbook. Information on previous textbooks published
indicates that 10% are huge successes, 20% are modest
successes, 40% break even, and 30% are losers. However,
before a publishing decision is made, the book will be
reviewed. In the past, 99% of the huge successes received
favorable reviews, 70% of the moderate successes received
favorable reviews, 40% of the break-even books received fa-
vorable reviews, and 20% of the losers received favorable
reviews.
a. If the proposed textbook receives a favorable review, how

should the editor revise the probabilities of the various
outcomes to take this information into account?

b. What proportion of textbooks receives favorable
reviews?

4.37 A municipal bond service has three rating cate-
gories (A, B, and C). Suppose that in the past year, of the
municipal bonds issued throughout the United States,
70% were rated A, 20% were rated B, and 10% were rated
C. Of the municipal bonds rated A, 50% were issued by
cities, 40% by suburbs, and 10% by rural areas. Of the
municipal bonds rated B, 60% were issued by cities, 20%
by suburbs, and 20% by rural areas. Of the municipal
bonds rated C, 90% were issued by cities, 5% by suburbs,
and 5% by rural areas.
a. If a new municipal bond is to be issued by a city, what is

the probability that it will receive an A rating?
b. What proportion of municipal bonds are issued by cities?
c. What proportion of municipal bonds are issued by

suburbs?

4.4 Counting Rules
In Equation (4.1) on page 146, the probability of occurrence of an outcome was defined as the
number of ways the outcome occurs, divided by the total number of possible outcomes. Often,
there are a large number of possible outcomes, and determining the exact number can be diffi-
cult. In such circumstances, rules have been developed for counting the number of possible
outcomes. This section presents five different counting rules.

Counting Rule 1
Counting rule 1 determines the number of possible outcomes for a set of mutually exclusive
and collectively exhaustive events.



Counting Rule 3
The third counting rule involves computing the number of ways that a set of items can be
arranged in order.

Suppose you roll a die twice. How many different possible outcomes can occur?

SOLUTION If a six-sided die is rolled twice, using Equation (4.10), the number of different
outcomes is 62 = 36.

EXAMPLE 4.11
Rolling a Die Twice
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COUNTING RULE 1
If any one of k different mutually exclusive and collectively exhaustive events can occur
on each of n trials, the number of possible outcomes is equal to

(4.10)kn

For example, using Equation (4.10), the number of different possible outcomes from toss-
ing a two-sided coin five times is 25 = 2 * 2 * 2 * 2 * 2 = 32.

Counting Rule 2
The second counting rule is a more general version of the first and allows the number of possi-
ble events to differ from trial to trial.

COUNTING RULE 2
If there are events on the first trial, events on the second trial, ... , and events on
the nth trial, then the number of possible outcomes is

(4.11)1k121k22Á 1kn2
knk2k1

For example, a state motor vehicle department would like to know how many license
plate numbers are available if a license plate number consists of three letters followed by
three numbers (0 through 9). Using Equation (4.11), if a license plate number consists of
three letters followed by three numbers, the total number of possible outcomes is126212621262110211021102 = 17,576,000.

A restaurant menu has a price-fixed complete dinner that consists of an appetizer, an entrée, a
beverage, and a dessert. You have a choice of 5 appetizers, 10 entrées, 3 beverages, and 6
desserts. Determine the total number of possible dinners.

SOLUTION Using Equation (4.11), the total number of possible dinners is1521102132162 = 900.

EXAMPLE 4.12
Determining the
Number of Different
Dinners
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COUNTING RULE 3
The number of ways that all n items can be arranged in order is

(4.12)

where n! is called n factorial, and 0! is defined as 1.

n! = 1n21n - 12Á 112

If a set of six books is to be placed on a shelf, in how many ways can the six books be
arranged?

SOLUTION To begin, you must realize that any of the six books could occupy the first po-
sition on the shelf. Once the first position is filled, there are five books to choose from in
filling the second position. You continue this assignment procedure until all the positions
are occupied. The number of ways that you can arrange six books is

n! = 6! = 162152142132122112 = 720

EXAMPLE 4.13
Using Counting
Rule 3

Counting Rule 4
In many instances you need to know the number of ways in which a subset of an entire
group of items can be arranged in order. Each possible arrangement is called a
permutation.

COUNTING RULE 4: PERMUTATIONS
The number of ways of arranging x objects selected from n objects in order is

(4.13)

where

number of objects

of objects to be arranged

factorial

P = symbol for permutations1

= n1n - 12Á 112n! = n

x = number

n = total

nPx =
n!

1n - x2!

Modifying Example 4.13, if you have six books, but there is room for only four books on the
shelf, in how many ways can you arrange these books on the shelf?

SOLUTION Using Equation (4.13), the number of ordered arrangements of four books
selected from six books is equal to

nPx =
n!

1n - x2! =
6!

16 - 42! =
162152142132122112

122112 = 360

EXAMPLE 4.14
Using Counting
Rule 4

1On many scientific calculators,
there is a button labeled nPr that al-
lows you to compute permutations.
The symbol r is used instead of x.

Counting Rule 5
In many situations, you are not interested in the order of the outcomes but only in the number
of ways that x items can be selected from n items, irrespective of order. Each possible selec-
tion is called a combination.
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COUNTING RULE 5: COMBINATIONS
The number of ways of selecting x objects from n objects, irrespective of order, is equal to

(4.14)

where

number of objects

of objects to be arranged

factorial

C = symbol for combinations2

= n1n - 12Á 112n! = n

x = number

n = total

nCx =
n!

x!1n - x2!

2On many scientific calculators,
there is a button labeled nCr that al-
lows you to compute permutations.
The symbol r is used instead of x.

Modifying Example 4.14, if the order of the books on the shelf is irrelevant, in how many ways
can you arrange these books on the shelf?

SOLUTION Using Equation (4.14), the number of combinations of four books selected from
six books is equal to

nCx =
n!

x!1n - x2! =
6!

4!16 - 42! =
162152142132122112
142132122112122112 = 15

EXAMPLE 4.15
Using Counting
Rule 5

Problems for Section 4.4
APPLYING THE CONCEPTS

4.38 If there are 10 multiple-choice questions
on an exam, each having three possible answers,

how many different sequences of answers are there?

4.39 A lock on a bank vault consists of three dials, each
with 30 positions. In order for the vault to open, each of the
three dials must be in the correct position.
a. How many different possible dial combinations are there

for this lock?
b. What is the probability that if you randomly select a posi-

tion on each dial, you will be able to open the bank vault?
c. Explain why “dial combinations” are not mathematical

combinations expressed by Equation (4.14).

4.40 a. If a coin is tossed seven times, how many different
outcomes are possible?
b. If a die is tossed seven times, how many different out-

comes are possible?
c. Discuss the differences in your answers to (a) and (b).

SELF
Test

4.41 A particular brand of women’s jeans is available in
seven different sizes, three different colors, and three differ-
ent styles. How many different women’s jeans does the store
manager need to order to have one pair of each type?

4.42 You would like to make a salad that consists of
lettuce, tomato, cucumber, and peppers. You go to the super-
market, intending to purchase one variety of each of these
ingredients. You discover that there are eight varieties of let-
tuce, four varieties of tomatoes, three varieties of cucum-
bers, and three varieties of peppers for sale at the
supermarket. If you buy them all, how many different salads
can you make?

4.43 A team is being formed that includes four different
people. There are four different positions on the teams. How
many different ways are there to assign the four people to
the four positions??

4.44 In Major League Baseball, there are five teams in the
Eastern Division of the National League: Atlanta, Florida,

If you compare this rule to counting rule 4, you see that it differs only in the inclusion of a
term x! in the denominator. When permutations were used, all of the arrangements of the x
objects are distinguishable. With combinations, the x! possible arrangements of objects are
irrelevant.
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New York, Philadelphia, and Washington. How many differ-
ent orders of finish are there for these five teams? (Assume
that there are no ties in the standings.) Do you believe that
all these orders are equally likely? Discuss.

4.45 Referring to Problem 4.44, how many different orders
of finish are possible for the first four positions?

4.46 A gardener has six rows available in his vegetable
garden to place tomatoes, eggplant, peppers, cucumbers,
beans, and lettuce. Each vegetable will be allowed one and
only one row. How many ways are there to position these
vegetables in this garden?

4.47 There are eight members of a team. How many ways
are there to select a team leader, assistant team leader, and
team coordinator?

4.48 Four members of a group of 10 people are to be se-
lected to a team. How many ways are there to select these
four members?

4.49 A student has seven books that she would like to
place in her backpack. However, there is room for only four
books. Regardless of the arrangement, how many ways are
there of placing four books into the backpack?

4.50 A daily lottery is conducted in which 2 winning num-
bers are selected out of 100 numbers. How many different
combinations of winning numbers are possible?

4.51 A reading list for a course contains 20 articles.
How many ways are there to choose 3 articles from this
list?

4.5 Ethical Issues and Probability
Ethical issues can arise when any statements related to probability are presented to the public,
particularly when these statements are part of an advertising campaign for a product or service.
Unfortunately, many people are not comfortable with numerical concepts (see reference 5) and
tend to misinterpret the meaning of the probability. In some instances, the misinterpretation is
not intentional, but in other cases, advertisements may unethically try to mislead potential
customers.

One example of a potentially unethical application of probability relates to advertise-
ments for state lotteries. When purchasing a lottery ticket, the customer selects a set of num-
bers (such as 6) from a larger list of numbers (such as 54). Although virtually all participants
know that they are unlikely to win the lottery, they also have very little idea of how unlikely it
is for them to select all 6 winning numbers from the list of 54 numbers. They have even less
of an idea of the probability of winning a consolation prize by selecting either 4 or 5 winning
numbers.

Given this background, you might consider a recent commercial for a state lottery that
stated, “We won’t stop until we have made everyone a millionaire” to be deceptive and possi-
bly unethical. Do you think the state has any intention of ever stopping the lottery, given the
fact that the state relies on it to bring millions of dollars into its treasury? Is it possible that the
lottery can make everyone a millionaire? Is it ethical to suggest that the purpose of the lottery
is to make everyone a millionaire?

Another example of a potentially unethical application of probability relates to an
investment newsletter promising a 90% probability of a 20% annual return on investment.
To make the claim in the newsletter an ethical one, the investment service needs to (a) ex-
plain the basis on which this probability estimate rests, (b) provide the probability
statement in another format, such as 9 chances in 10, and (c) explain what happens to the
investment in the 10% of the cases in which a 20% return is not achieved (e.g., is the entire
investment lost?).

These are serious ethical issues. If you were going to write an advertisement for the state
lottery that ethically describes the probability of winning a certain prize, what would you say?
If you were going to write an advertisement for the investment newsletter that ethically states
the probability of a 20% return on an investment, what would you say?
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As the marketing manager for M&R Electronics World, you
analyzed the survey results of an intent-to-purchase study. This
study asked the heads of 1,000 households about their intentions
to purchase a big-screen television sometime during the next

12 months, and as a follow-up, M&R surveyed the same people 12 months later
to see whether such a television was purchased. In addition, for households
purchasing big-screen televisions, the survey asked whether the television they

purchased had a faster refresh rate, whether they also purchased a Blu-ray disc (BD) player in the
past 12 months, and whether they were satisfied with their purchase of the big-screen television.

By analyzing the results of these surveys, you were able to uncover many pieces of valu-
able information that will help you plan a marketing strategy to enhance sales and better target
those households likely to purchase multiple or more expensive products. Whereas only 30%
of the households actually purchased a big-screen television, if a household indicated that it
planned to purchase a big-screen television in the next 12 months, there was an 80% chance
that the household actually made the purchase. Thus the marketing strategy should target those
households that have indicated an intention to purchase.

You determined that for households that purchased a television that had a faster refresh
rate, there was a 47.5% chance that the household also purchased a Blu-ray disc player. You
then compared this conditional probability to the marginal probability of purchasing a Blu-ray
disc player, which was 36%. Thus, households that purchased televisions that had a faster
refresh rate are more likely to purchase a Blu-ray disc player than are households that pur-
chased big-screen televisions that have a standard refresh rate.

You were also able to apply Bayes’ theorem to M&R Electronics World’s market research
reports. The reports investigate a potential new television model prior to its scheduled release.
If a favorable report was received, then there was a 64% chance that the new television model
would be successful. However, if an unfavorable report was received, there is only a 16%
chance that the model would be successful. Therefore, the marketing strategy of M&R needs
to pay close attention to whether a report’s conclusion is favorable or unfavorable.

U S I N G S TAT I S T I C S @ M&R Electronics World Revisited

S U M M A R Y
This chapter began by developing the basic concepts of
probability. You learned that probability is a numeric value
from 0 to 1 that represents the chance, likelihood, or possi-
bility that a particular event will occur. In addition to simple
probability, you learned about conditional probabilities and
independent events. Bayes’ theorem was used to revise

previously calculated probabilities based on new information.
You also learned about several counting rules. Throughout
the chapter, contingency tables and decision trees were used
to display information. In the next chapter, important dis-
crete probability distributions such as the binomial, Poisson,
and hypergeometric distributions are developed.

K E Y E Q U AT I O N S
Probability of Occurrence

(4.1)

Marginal Probability

(4.2)

General Addition Rule

(4.3)P1A or B2 = P1A2 + P1B2 - P1A and B2

+ Á + P1A and Bk2
P1A2 = P1A and B12 + P1A and B22

Probability of occurrence =
X

T

Conditional Probability

(4.4a)

(4.4b)

Independence

(4.5)P1A|B2 = P1A2

P1B|A2 =
P1A and B2

P1A2

P1A|B2 =
P1A and B2

P1B2
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General Multiplication Rule

(4.6)

Multiplication Rule for Independent Events

(4.7)

Marginal Probability Using the General Multiplication Rule

(4.8)

Bayes’Theorem

(4.9)

P1A|Bi2P1Bi2
P1A|B12P1B12 + P1A|B22P1B22 + Á + P1A|Bk2P1Bk2
P1Bi|A2 =

+ Á + P1A|Bk2P1Bk2
P1A2 = P1A|B12P1B12 + P1A|B22P1B22

P1A and B2 = P1A2P1B2

P1A and B2 = P1A|B2P1B2
Counting Rule 1

(4.10)

Counting Rule 2

(4.11)

Counting Rule 3

(4.12)

Counting Rule 4: Permutations

(4.13)

Counting Rule 5: Combinations

(4.14)nCx =
n!

x!1n - x2!

nPx =
n!

1n - x2!

n! = 1n21n - 12Á 112

1k121k22Á 1kn2

kn
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C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING
4.52 What are the differences between a priori probabil-
ity, empirical probability, and subjective probability?

4.53 What is the difference between a simple event and a
joint event?

4.54 How can you use the general addition rule to find the
probability of occurrence of event A or B?

4.55 What is the difference between mutually exclusive
events and collectively exhaustive events?

4.56 How does conditional probability relate to the con-
cept of independence?

4.57 How does the multiplication rule differ for events that
are and are not independent?

4.58 How can you use Bayes’ theorem to revise probabili-
ties in light of new information?

4.59 In Bayes’ theorem, how does the prior probability
differ from the revised probability?

APPLYING THE CONCEPTS
4.60 A survey by the Pew Research Center (“Snapshots:
Goals of ‘Gen Next’ vs. ‘Gen X,’” USA Today, March 27,
2007, p. 1A) indicated that 81% of 18- to 25-year-olds had
getting rich as a goal, as compared to 62% of 26- to 40-year-
olds. Suppose that the survey was based on 500 respondents
from each of the two groups.
a. Construct a contingency table.
b. Give an example of a simple event and a joint event.
c. What is the probability that a randomly selected respon-

dent has a goal of getting rich?
d. What is the probability that a randomly selected

respondent has a goal of getting rich and is in the
26- to 40-year-old group?

e. Are the events “age group” and “has getting rich as a
goal” independent? Explain.

4.61 The owner of a restaurant serving Continental-style
entrées was interested in studying ordering patterns of pa-
trons for the Friday-to-Sunday weekend time period.
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GENDER

DESSERT ORDERED Male Female Total

Yes 96 40 136
No 224 240 464
Total 320 280 600

BEEF ENTRÉE

DESSERT ORDERED Yes No Total

Yes 71 65 136
No 116 348 464
Total 187 413 600

Records were maintained that indicated the demand for
dessert during the same time period. The owner decided to
study two other variables, along with whether a dessert was
ordered: the gender of the individual and whether a beef
entrée was ordered. The results are as follows:

A waiter approaches a table to take an order for dessert.
What is the probability that the first customer to order at the
table
a. orders a dessert?
b. orders a dessert or has ordered a beef entrée?
c. is a female and does not order a dessert?
d. is a female or does not order a dessert?
e. Suppose the first person from whom the waiter takes the

dessert order is a female. What is the probability that she
does not order dessert?

f. Are gender and ordering dessert independent?
g. Is ordering a beef entrée independent of whether the

person orders dessert?

4.62 Which meal are people most likely to order at a drive-
through? A survey was conducted in 2009, but the sample
sizes were not reported. Suppose the results, based on a
sample of 100 males and 100 females, were as follows:

d. is a male and prefers ordering dinner at the drive-
through?

e. Given that the person selected is a female, what is the
probability that she prefers ordering breakfast at the
drive-through?

4.63 According to a Gallup Poll, companies with
employees who are engaged with their workplace have
greater innovation, productivity, and profitability, as well
as less employee turnover. A survey of 1,895 workers in
Germany found that 13% of the workers were engaged,
67% were not engaged, and 20% were actively disen-
gaged. The survey also noted that 48% of engaged work-
ers strongly agreed with the statement “My current job
brings out my most creative ideas.” Only 20% of the not
engaged workers and 3% of the actively disengaged work-
ers agreed with this statement (data extracted from
M. Nink, “Employee Disengagement Plagues Germany,”
Gallup Management Journal, gmj.gallup.com, April 9,
2009). If a worker is known to strongly agree with the
statement “My current job brings out my most creative
ideas,” what is the probability that the worker is engaged?

4.64 Sport utility vehicles (SUVs), vans, and pickups are
generally considered to be more prone to roll over than cars.
In 1997, 24.0% of all highway fatalities involved rollovers;
15.8% of all fatalities in 1997 involved SUVs, vans, and
pickups, given that the fatality involved a rollover. Given
that a rollover was not involved, 5.6% of all fatalities in-
volved SUVs, vans, and pickups (data extracted from
A. Wilde Mathews, “Ford Ranger, Chevy Tracker Tilt in
Test,” The Wall Street Journal, July 14, 1999, p. A2).
Consider the following definitions:

a. Use Bayes’ theorem to find the probability that a fatality
involved a rollover, given that the fatality involved an
SUV, a van, or a pickup.

b. Compare the result in (a) to the probability that a fatality
involved a rollover and comment on whether SUVs, vans,
and pickups are generally more prone to rollover acci-
dents than other vehicles.

4.65 Enzyme-linked immunosorbent assay (ELISA) is the
most common type of screening test for detecting the HIV
virus. A positive result from an ELISA indicates that the
HIV virus is present. For most populations, ELISA has a
high degree of sensitivity (to detect infection) and speci-
ficity (to detect noninfection). (See “HIV InSite Gateway to
HIV and AIDS Knowledge” at HIVInsite.ucsf.edu.) Sup-
pose the probability that a person is infected with the HIV
virus for a certain population is 0.015. If the HIV virus is
actually present, the probability that the ELISA test will
give a positive result is 0.995. If the HIV virus is not actu-
ally present, the probability of a positive result from an
ELISA is 0.01. If the ELISA has given a positive result, use

B = fatality involved a rollover
A = fatality involved an SUV, van, or pickup

GENDER

MEAL Male Female Total

Breakfast 18 10 28
Lunch 47 52 99
Dinner 29 29 58
Snack/beverage 6 9 15
Total 100 100 200

Source: Data extracted from www.qsrmagazine.com/reports/drive-
thru_time_study/2009/2009_charts/whats_your_preferred_way
_to_order_fast_food.html.

If a respondent is selected at random, what is the probability
that he or she
a. prefers ordering lunch at the drive-through?
b. prefers ordering breakfast or lunch at the drive-through?
c. is a male or prefers ordering dinner at the drive-through?

www.qsrmagazine.com/reports/drivethru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_food.html
www.qsrmagazine.com/reports/drivethru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_food.html
www.qsrmagazine.com/reports/drivethru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_food.html
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Bayes’ theorem to find the probability that the HIV virus is
actually present.

TEAM PROJECT

The file contains information regarding three
categorical variables from a sample of 184 bond funds. The
variables include

Type—Bond fund type (intermediate government or
short-term corporate)

Fees—Sales charges (no or yes)
Risk—Risk-of-loss factor of the bond fund (below aver-

age, average, or above average)

4.66 Construct contingency tables of type and fees, type
and risk, and fees and risk.
a. For each of these contingency tables, compute all the

conditional and marginal probabilities.
b. Based on (a), what conclusions can you reach about

whether these variables are independent?

STUDENT SURVEY DATABASE

4.67 Problem 1.27 on page 14 describes a survey of 62
undergraduate students (see the file ).
For these data, construct contingency tables of gender and
major, gender and graduate school intention, gender and
employment status, gender and computer preference,
class and graduate school intention, class and employ-
ment status, major and graduate school intention, major
and employment status, and major and computer
preference.
a. For each of these contingency tables, compute all the

conditional and marginal probabilities.
b. Based on (a), what conclusions can you reach about

whether these variables are independent?

4.68 Problem 1.27 on page 14 describes a survey of 62
undergraduate students (stored in ).UndergradSurvey

UndergradSurvey

Bond Funds

a. Select a sample of undergraduate students at your school
and conduct a similar survey for those students.

b. For your data, construct contingency tables of gender
and major, gender and graduate school intention, gender
and employment status, gender and computer prefer-
ence, class and graduate school intention, class and em-
ployment status, major and graduate school intention,
major and employment status, and major and computer
preference.

c. Based on (b), what conclusions can you reach about
whether these variables are independent?

d. Compare the results of (c) to those of Problem 4.67 (b).

4.69 Problem 1.28 on page 15 describes a survey of
44 MBA students (stored in ). For these data,
construct contingency tables of gender and graduate ma-
jor, gender and undergraduate major, gender and employ-
ment status, gender and computer preference, graduate
major and undergraduate major, graduate major and em-
ployment status, and graduate major and computer
preference.
a. For each of these contingency tables, compute all the

conditional and marginal probabilities.
b. Based on (b), what conclusions can you reach about

whether these variables are independent?

4.70 Problem 1.28 on page 15 describes a survey of 44
MBA students (stored in ).
a. Select a sample of MBA students from your MBA pro-

gram and conduct a similar survey for those students.
b. For your data, construct contingency tables of gender and

graduate major, gender and undergraduate major, gender
and employment status, gender and computer preference,
graduate major and undergraduate major, graduate major
and employment status, and graduate major and com-
puter preference.

c. Based on (b), what conclusions can you reach about
whether these variables are independent?

d. Compare the results of (c) to those of Problem 4.69 (b).

GradSurvey

GradSurvey

D I G I TA L C A S E
Apply your knowledge about contingency tables and the
proper application of simple and joint probabilities in this
continuing Digital Case from Chapter 3.

Open EndRunGuide.pdf, the EndRun Financial Services
“Guide to Investing,” and read the information about the
Guaranteed Investment Package (GIP). Read the claims and
examine the supporting data. Then answer the following
questions:

1. How accurate is the claim of the probability of suc-
cess for EndRun’s GIP? In what ways is the claim

misleading? How would you calculate and state the
probability of having an annual rate of return not less
than 15%?

2. Using the table found under the “Show Me The Winning
Probabilities” subhead, compute the proper probabilities
for the group of investors. What mistake was made in re-
porting the 7% probability claim?

3. Are there any probability calculations that would be
appropriate for rating an investment service? Why or why
not?
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EG4.1 BASIC PROBABILITY CONCEPTS

Simple and Joint Probability and the General
Addition Rule

PHStat2 Use Simple & Joint Probabilities to compute
basic probabilities. Select PHStat ➔ Probability & Prob.
Distributions ➔ Simple & Joint Probabilities. The proce-
dure inserts a worksheet similar to Figure EG4.1 into the
current workbook. (Unlike with other procedures, no dialog
box is first displayed.) To use the worksheet, fill in the
Sample Space area with your data.

In-Depth Excel Use the COMPUTE worksheet of the
Probabilities workbook as a template for computing
basic probabilities (see Figure EG4.1, below). The work-
sheet contains the Table 4.1 purchase behavior data shown
on page. Overwrite these values when you enter data for
other problems.

Open to the COMPUTE_FORMULAS worksheet to
examine the formulas used in the worksheet, many of which
are shown in the inset to Figure EG4.1.

C H A P T E R 4 E X C E L G U I D E
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F I G U R E E G 4 . 1 COMPUTE worksheet of the Probabilities workbook

EG4.2 CONDITIONAL PROBABILITY

There is no Excel material for this section.

EG4.3 BAYES’ THEOREM

In-Depth Excel Use the COMPUTE worksheet of the
Bayes workbook as a template for computing basic
probabilities (see Figure EG4.2, at right). The worksheet
contains the television-marketing example of Table 4.4 on
page 164. Overwrite these values when you enter data for
other problems.

Open to the COMPUTE_FORMULAS worksheet to
examine the simple arithmetic formulas that compute the
probabilities which are also shown in the inset to Figure EG4.2.

F I G U R E E G 4 . 2 COMPUTE worksheet of the 
Bayes workbook
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EG4.4 COUNTING RULES

Counting Rule 1

In-Depth Excel Use the POWER(k, n) worksheet function
in a cell formula to compute the number of outcomes given
k events and n trials. For example, the formula =POWER(6,
2) computes the answer for Example 4.11 on page 168.

Counting Rule 2

In-Depth Excel Use a formula that takes the product of
successive POWER(k, n) functions to solve problems re-
lated to counting rule 2. For example, the formula
=POWER(26, 3) * POWER(10, 3) computes the answer for
the state motor vehicle department example on page 168.

can be arranged. For example, the formula =FACT(6)
computes 6!

Counting Rule 4

In-Depth Excel Use the PERMUT(n, x) worksheet func-
tion in a cell formula to compute the number of ways of
arranging x objects selected from n objects in order. For
example, the formula =PERMUT(6, 4) computes the answer
for Example 4.14 on page 169.

Counting Rule 5

In-Depth Excel Use the COMBIN(n, x) worksheet func-
tion in a cell formula to compute the number of ways of
arranging x objects selected from n objects, irrespective of
order. For example, the formula =COMBIN(6, 4) computes
the answer for Example 4.15 on page 170.

MG4.1 BASIC PROBABILITY CONCEPTS

There is no Minitab material for this section.

MG4.2 CONDITIONAL PROBABILITY

There is no Minitab material for this section.

MG4.3 BAYES’ THEOREM

There is no Minitab material for this section.

MG4.4 COUNTING RULES

Use Calculator to apply the counting rules. Select Calc ➔
Calculator. In the Calculator dialog box (shown at right):

1. Enter the column name of an empty column in the Store
result in variable box and then press Tab.

2. Build the appropriate expression (as discussed later in this
section) in the Expression box. To apply counting rules 3
through 5, select Arithmetic from the Functions drop-
down list to facilitate the function selection.

C H A P T E R 4 M I N I TA B G U I D E

3. Click OK.

If you have previously used the Calculator during your
Minitab session, you may have to clear the contents of the
Expression box by selecting the contents and pressing Del
before you begin step 2.

Counting Rule 3

In-Depth Excel Use the FACT(n) worksheet function
in a cell formula to compute how many ways n items
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Counting Rule 4

Enter an expression that uses the PERMUTATIONS(n, x)
function to compute the number of ways of arranging x
objects selected from n objects in order. For example, the
expression PERMUTATIONS(6, 4) computes the answer
for Example 4.14 on page 169.

Counting Rule 5

Enter an expression that uses the COMBINATIONS(n, x)
function to compute the number of ways of arranging x
objects selected from n objects, irrespective of order. For
example, the expression COMBINATIONS(6, 4) computes
the answer for Example 4.15 on page 170.

Counting Rule 1

Enter an expression that uses the exponential operator **.
For example, the expression 6 ** 2 computes the answer for
Example 4.11 on page 168.

Counting Rule 2

Enter an expression that uses the exponential operator **.
For example, the expression 26 ** 3 * 10 ** 3 computes the
answer for the state motor vehicle department example on
page 168.

Counting Rule 3

Enter an expression that uses the FACTORIAL(n) function
to compute how many ways n items can be arranged. For
example, the expression FACTORIAL(6) computes 6!
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Learning Objectives
In this chapter, you learn:

• The properties of a probability distribution

• To compute the expected value and variance of a probability distribution

• To calculate the covariance and understand its use in finance

• To compute probabilities from the binomial, Poisson, and hypergeometric
distributions

• How the binomial, Poisson, and hypergeometric distributions can be used 
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You are an accountant for the Saxon Home Improvement Company, which uses 
a state-of-the-art accounting information system to manage its accounting and
financial operations.

Accounting information systems collect, process, store, transform, and 
distribute financial information to decision makers both internal and external to 

a business organization (see reference 7). These systems continuously audit accounting information,
looking for errors or incomplete or improbable information. For example, when customers of the
Saxon Home Improvement Company submit online orders, the company’s accounting information
system reviews the order forms for possible mistakes. Any questionable invoices are tagged and

included in a daily exceptions report. Recent data collected by the company show that the 
likelihood is 0.10 that an order form will be tagged. Saxon would like to

determine the likelihood of finding a certain number of tagged
forms in a sample of a specific size. For example, what would

be the likelihood that none of the order forms are tagged
in a sample of four forms? That one

of the order forms is tagged?

U S I N G S TAT I S T I C S

@ Saxon Home Improvement
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H ow could the Saxon Home Improvement Company determine the solution to this
type of probability problem? One way is to use a model, or small-scale representa-
tion, that approximates the process. By using such an approximation, Saxon man-

agers could make inferences about the actual order process. In this case, the Saxon managers
can use probability distributions, mathematical models suited for solving the type of probabil-
ity problems the managers are facing.

This chapter introduces you to the concept and characteristics of probability distributions.
You will learn how the knowledge about a probability distribution can help you choose be-
tween alternative investment strategies. You will also learn how the binomial, Poisson, and hy-
pergeometric distributions can be applied to help solve business problems.

5.1 The Probability Distribution for a Discrete Random Variable
In Section 1.4, a numerical variable was defined as a variable that yields numerical responses,
such as the number of magazines you subscribe to or your height. Numerical variables are ei-
ther discrete or continuous. Continuous numerical variables produce outcomes that come from
a measuring process (e.g., your height). Discrete numerical variables produce outcomes that
come from a counting process (e.g., the number of magazines you subscribe to). This chapter
deals with probability distributions that represent discrete numerical variables.

T A B L E 5 . 1

Probability Distribution
of the Number of
Interruptions per Day

Interruptions per Day Probability

0 0.35
1 0.25
2 0.20
3 0.10
4 0.05
5 0.05

0 2 3 4 5 X

P (X)

.3

.2

Interruptions per Days

.1

.4

1

F I G U R E 5 . 1
Probability distribution 
of the number 
of interruptions per day

Expected Value of a Discrete Random Variable
The mean, of a probability distribution is the expected value of its random variable. To
calculate the expected value, you multiply each possible outcome, x, by its corresponding
probability, and then sum these products.P1X = xi2,

m,

PROBABILITY DISTRIBUTION FOR A DISCRETE RANDOM VARIABLE
A probability distribution for a discrete random variable is a mutually exclusive list
of all the possible numerical outcomes along with the probability of occurrence of each
outcome.

For example, Table 5.1 gives the distribution of the number of interruptions per day in a large
computer network. The list in Table 5.1 is collectively exhaustive because all possible outcomes
are included. Thus, the probabilities sum to 1. Figure 5.1 is a graphical representation of Table 5.1.
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T A B L E 5 . 2

Computing the 
Expected Value of the
Number of Interruptions
per Day

Interruptions per 
Day 1xi2 P1X = xi2 xiP1X = xi2

0 0.35 10210.352 = 0.00
1 0.25 11210.252 = 0.25
2 0.20 12210.202 = 0.40
3 0.10 13210.102 = 0.30
4 0.05 14210.052 = 0.20
5 0.05 15210.052 = 0.25

1.00 m = E1X2 = 1.40

EXPECTED VALUE, OF A DISCRETE RANDOM VARIABLE

(5.1)

where

outcome of the discrete random variable X

probability of occurrence of the ith outcome of XP1X = xi2 =

xi = the ith

m = E1X2 = a
N

i=1
xi P1X = xi2

m,

For the probability distribution of the number of interruptions per day in a large computer
network (Table 5.1), the expected value is computed as follows, using Equation (5.1), and is
also shown in Table 5.2:

= 1.40

= 0 + 0.25 + 0.40 + 0.30 + 0.20 + 0.25

= 10210.352 + 11210.252 + 12210.202 + 13210.102 + 14210.052 + 15210.052
m = E1X2 = a

N

i=1
xi P1X = xi2

The expected value is 1.40. The expected value of 1.4 for the number of interruptions per
day is not a possible outcome because the actual number of interruptions in a given day must be
an integer value. The expected value represents the mean number of interruptions in a given day.

Variance and Standard Deviation of a Discrete
Random Variable
You compute the variance of a probability distribution by multiplying each possible squared
difference by its corresponding probability, and then summing the
resulting products. Equation (5.2) defines the variance of a discrete random variable.

P1X = xi2,[xi - E1X2]2

VARIANCE OF A DISCRETE RANDOM VARIABLE

(5.2)

where

the ith outcome of the discrete random variable X

of occurrence of the ith outcome of XP1X = xi2 = probability

xi =

s2 = a
N

i=1
[xi - E1X2]2 P1X = xi2
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Equation (5.3) defines the standard deviation of a discrete random variable.

LEARNING THE BASICS
5.1 Given the following probability distributions:

T A B L E 5 . 3

Computing the Variance
and Standard Deviation
of the Number of
Interruptions per Day

Interruptions per 
Day 1xi2 P1X = xi2 xiP1X = xi2 [xi - E1X2]2 P1X = xi2

0 0.35 10210.352 = 0.00 10 - 1.42210.352 = 0.686
1 0.25 11210.252 = 0.25 11 - 1.42210.252 = 0.040
2 0.20 12210.202 = 0.40 12 - 1.42210.202 = 0.072
3 0.10 13210.102 = 0.30 13 - 1.42210.102 = 0.256
4 0.05 14210.052 = 0.20 14 - 1.42210.052 = 0.338
5 0.05 15210.052 = 0.25 15 - 1.42210.052 = 0.648

1.00 m = E1X2 = 1.40 s2 = 2.04

Number of Accidents Daily (X) P1X = xi2
0 0.10
1 0.20
2 0.45
3 0.15
4 0.05
5 0.05

STANDARD DEVIATION OF A DISCRETE RANDOM VARIABLE

(5.3)s = 2s2 = AaNi=1
[xi - E1X 2]2 P1X = xi2

The variance and the standard deviation of the number of interruptions per day are com-
puted as follows and in Table 5.3, using Equations (5.2) and (5.3):

= 2.04

= 0.686 + 0.040 + 0.072 + 0.256 + 0.338 + 0.648

+ 14 - 1.42210.052 + 15 - 1.42210.052
= 10 - 1.42210.352 + 11 - 1.42210.252 + 12 - 1.42210.202 + 13 - 1.42210.102

s2 = a
N

i=1
[xi - E1X2]2 P1X = xi2

and

Thus, the mean number of interruptions per day is 1.4, the variance is 2.04, and the standard
deviation is approximately 1.43 interruptions per day.

s = 2s2 = 22.04 = 1.4283

Distribution A Distribution B

X P1X = xi2 X P1X = xi2
0 0.50 0 0.05
1 0.20 1 0.10
2 0.15 2 0.15
3 0.10 3 0.20
4 0.05 4 0.50

APPLYING THE CONCEPTS

5.2 The following table contains the probability
distribution for the number of traffic accidents

daily in a small city:

SELF
Test

Problems for Section 5.1

a. Compute the expected value for each distribution.
b. Compute the standard deviation for each distribution.
c. Compare the results of distributions A and B.

a. Compute the mean number of accidents per day.
b. Compute the standard deviation.
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5.3 Recently, a regional automobile dealership sent out
fliers to perspective customers, indicating that they had
already won one of three different prizes: a Kia Optima val-
ued at $15,000, a $500 gas card, or a $5 Wal-Mart shopping
card. To claim his or her prize, a prospective customer
needed to present the flier at the dealership’s showroom. The
fine print on the back of the flier listed the probabilities of
winning. The chance of winning the car was 1 out of 31,478,
the chance of winning the gas card was 1 out of 31,478, and
the chance of winning the shopping card was 31,476 out
31,478.
a. How many fliers do you think the automobile dealership

sent out?
b. Using your answer to (a) and the probabilities listed on

the flier, what is the expected value of the prize won by a
prospective customer receiving a flier?

c. Using your answer to (a) and the probabilities listed on
the flier, what is the standard deviation of the value of the
prize won by a prospective customer receiving a flier?

d. Do you think this is an effective promotion? Why or why
not?

5.4 In the carnival game Under-or-Over-Seven, a pair of fair
dice is rolled once, and the resulting sum determines whether
the player wins or loses his or her bet. For example, the player
can bet $1 that the sum will be under 7—that is, 2, 3, 4, 5, or
6. For this bet, the player wins $1 if the result is under 7 and
loses $1 if the outcome equals or is greater than 7. Similarly,
the player can bet $1 that the sum will be over 7—that is, 8, 9,
10, 11, or 12. Here, the player wins $1 if the result is over 7
but loses $1 if the result is 7 or under. A third method of play
is to bet $1 on the outcome 7. For this bet, the player wins $4
if the result of the roll is 7 and loses $1 otherwise.
a. Construct the probability distribution representing the

different outcomes that are possible for a $1 bet on
under 7.

b. Construct the probability distribution representing the dif-
ferent outcomes that are possible for a $1 bet on over 7.

c. Construct the probability distribution representing the
different outcomes that are possible for a $1 bet on 7.

d. Show that the expected long-run profit (or loss) to the
player is the same, no matter which method of play is used.

Arrivals Frequency

0 14
1 31
2 47
3 41
4 29
5 21
6 10
7 5
8 2

5.5 The number of arrivals per minute at a bank located in
the central business district of a large city was recorded
over a period of 200 minutes, with the following results:

a. Compute the expected number of mortgages approved
per week.

b. Compute the standard deviation.

a. Compute the expected number of arrivals per minute.
b. Compute the standard deviation.

5.6 The manager of the commercial mortgage department
of a large bank has collected data during the past two years
concerning the number of commercial mortgages approved
per week. The results from these two years (104 weeks)
indicated the following:

Number of Commercial
Mortgages Approved Frequeny

0 13
1 25
2 32
3 17
4 9
5 6
6 1
7 1

5.2 Covariance and Its Application in Finance
In Section 5.1, the expected value, variance, and standard deviation of a discrete random variable
of a probability distribution are discussed. In this section, the covariance between two variables
is introduced and applied to portfolio management, a topic of great interest to financial analysts.

Covariance
The covariance, , measures the strength of the relationship between two numerical random
variables, X and Y. A positive covariance indicates a positive relationship. A negative covari-
ance indicates a negative relationship. A covariance of 0 indicates that the two variables are in-
dependent. Equation (5.4) defines the covariance for a discrete probability distribution.

sXY
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To illustrate the covariance, suppose that you are deciding between two different invest-
ments for the coming year. The first investment is a mutual fund that consists of the stocks that
comprise the Dow Jones Industrial Average. The second investment is a mutual fund that is ex-
pected to perform best when economic conditions are weak. Table 5.4 summarizes your esti-
mate of the returns (per $1,000 investment) under three economic conditions, each with a
given probability of occurrence.

T A B L E 5 . 4

Estimated Returns for
Each Investment Under
Three Economic
Conditions

Investment

P1xi yi2 Economic Condition Dow Jones Fund Weak-Economy Fund

0.2 Recession -$300 +$200
0.5 Stable economy +100 +50
0.3 Expanding economy +250 -100

COVARIANCE

(5.4)

where

random variable X

outcome of X

random variable Y

outcome of Y

of occurrence of the ith outcome of X and the ith outcome of Y

for X and Yi = 1, 2, Á , N

P1xi yi2 = probability

yi = ith

Y = discrete

xi = ith

X = discrete

sXY = a
N

i=1
[xi - E1X2][yi - E1Y2] P1xi yi2

The expected value and standard deviation for each investment and the covariance of the
two investments are computed as follows:

= -19,275

= -12,045 + 262.5 - 7,492.5

+ 1250 - 6521-100 - 35210.32sXY = 1-300 - 6521200 - 35210.22 + 1100 - 652150 - 35210.52
sY = $105.00

= 11,025

Var1Y2 = s2
Y = 1200 - 352210.22 + 150 - 352210.52 + 1-100 - 352210.32

sX = $193.71

= 37,525

Var1X2 = s2
X = 1-300 - 652210.22 + 1100 - 652210.52 + 1250 - 652210.32

E1Y2 = mY = 1+200210.22 + 150210.52 + 1-100210.32 = $35

E1X2 = mX = 1-300210.22 + 1100210.52 + 1250210.32 = $65

Let X = Dow Jones fund and Y = weak-economy fund
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Thus, the Dow Jones fund has a higher expected value (i.e., larger expected return) than the
weak-economy fund but also has a higher standard deviation (i.e., more risk). The covariance
of between the two investments indicates a negative relationship in which the two in-
vestments are varying in the opposite direction. Therefore, when the return on one investment
is high, typically, the return on the other is low.

Expected Value, Variance, and Standard Deviation 
of the Sum of Two Random Variables
Equations (5.1) through (5.3) define the expected value, variance, and standard deviation of a
probability distribution, and Equation (5.4) defines the covariance between two variables, X
and Y. The expected value of the sum of two random variables is equal to the sum of the ex-
pected values. The variance of the sum of two random variables is equal to the sum of the
variances plus twice the covariance. The standard deviation of the sum of two random vari-
ables is the square root of the variance of the sum of two random variables.

-19,275

EXPECTED VALUE OF THE SUM OF TWO RANDOM VARIABLES

(5.5)

VARIANCE OF THE SUM OF TWO RANDOM VARIABLES

(5.6)

STANDARD DEVIATION OF THE SUM OF TWO RANDOM VARIABLES

(5.7)sX+Y = 2s2
X+Y

Var1X + Y2 = s2
X+Y = s2

X + s2
Y + 2sXY

E1X + Y2 = E1X2 + E1Y2

To illustrate the expected value, variance, and standard deviation of the sum of two ran-
dom variables, consider the two investments previously discussed. If fund and

fund, using Equations (5.5), (5.6), and (5.7),

The expected value of the sum of the Dow Jones fund and the weak-economy fund is $100,
with a standard deviation of $100. The standard deviation of the sum of the two investments is
less than the standard deviation of either single investment because there is a large negative
covariance between the investments.

Portfolio Expected Return and Portfolio Risk
Now that the covariance and the expected value and standard deviation of the sum of two
random variables have been defined, these concepts can be applied to the study of a
group of assets referred to as a portfolio. Investors combine assets into portfolios to re-
duce their risk (see references 1 and 2). Often, the objective is to maximize the return
while minimizing the risk. For such portfolios, rather than study the sum of two random
variables, the investor weights each investment by the proportion of assets assigned to
that investment. Equations (5.8) and (5.9) def ine the portfolio expected return and
portfolio risk.

sX+Y = $100

= 10,000

= 37,525 + 11,025 + 1221-19,2752
s2

X+Y = s2
X + s2

Y + 2sXY

E1X + Y2 = E1X2 + E1Y2 = 65 + 35 = $100

Y = weak-economy
X = Dow Jones
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Problems for Section 5.2
LEARNING THE BASICS
5.7 Given the following probability distributions for vari-
ables X and Y:

Compute
a. and
b. and
c.
d. E1X + Y2.sXY.

sY.sX

E1Y2.E1X2

P(XiYi) X Y

0.2 -100 50
0.4 50 30
0.3 200 20
0.1 300 20

P(XiYi) X Y

0.4 100 200
0.6 200 100

PORTFOLIO EXPECTED RETURN
The portfolio expected return for a two-asset investment is equal to the weight assigned to
asset X multiplied by the expected return of asset X plus the weight assigned to asset Y
multiplied by the expected return of asset Y.

(5.8)

where

portfolio expected return

portion of the portfolio value assigned to asset X

portion of the portfolio value assigned to asset Y

expected return of asset X

expected return of asset Y

PORTFOLIO RISK

(5.9)sp = 2w2s2
X + 11 - w22s2

Y + 2w11 - w2sXY

E1Y2 =

E1X2 =

11 - w2 =

w =

E1P2 =

E1P2 = wE1X2 + 11 - w2E1Y2

In the previous section, you evaluated the expected return and risk of two different
investments, a Dow Jones fund and a weak-economy fund. You also computed the covariance
of the two investments. Now, suppose that you want to form a portfolio of these two invest-
ments that consists of an equal investment in each of these two funds. To compute the portfo-
lio expected return and the portfolio risk, using Equations (5.8) and (5.9), with

and

Thus, the portfolio has an expected return of $50 for each $1,000 invested (a return of 5%) and has
a portfolio risk of $50. The portfolio risk here is smaller than the standard deviation of either invest-
ment because there is a large negative covariance between the two investments. The fact that each
investment performs best under different circumstances reduces the overall risk of the portfolio.

= 22,500 = $50

sp = 210.522137,5252 + 11 - 0.522111,0252 + 210.5211 - 0.521-19,2752
E1P2 = 10.521652 + 11 - 0.521352 = $50

sXY = -19,275,E1X2 = $65, E1Y2 = $35,s2
X = 37,525,s2

Y = 11,025,
w = 0.50,

5.8 Given the following probability distributions for
variables X and Y:

Compute
a. and
b. and
c.
d. E1X + Y2.sXY.

sY.sX

E1Y2.E1X2
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5.13 Suppose that in Problem 5.12 you wanted to create a
portfolio that consists of stock X and stock Y. Compute the
portfolio expected return and portfolio risk for each of the
following percentages invested in stock X:
a. 30%
b. 50%
c. 70%
d. On the basis of the results of (a) through (c), which port-

folio would you recommend? Explain.

5.14 You are trying to develop a strategy for investing in two
different stocks. The anticipated annual return for a $1,000
investment in each stock under four different economic con-
ditions has the following probability distribution:

5.9 Two investments, X and Y, have the following charac-
teristics:

If the weight of portfolio assets assigned to investment X is
0.4, compute the
a. portfolio expected return.
b. portfolio risk.

APPLYING THE CONCEPTS

5.10 The process of being served at a bank consists of two
independent parts—the time waiting in line and the time it
takes to be served by the teller. Suppose that the time waiting
in line has an expected value of 4 minutes, with a standard
deviation of 1.2 minutes, and the time it takes to be served by
the teller has an expected value of 5.5 minutes, with a stan-
dard deviation of 1.5 minutes. Compute the
a. expected value of the total time it takes to be served at the

bank.
b. standard deviation of the total time it takes to be served

at the bank.

5.11 In the portfolio example in this section (see
page 186), half the portfolio assets are invested in the Dow
Jones fund and half in a weak-economy fund. Recalculate
the portfolio expected return and the portfolio risk if
a. 30% of the portfolio assets are invested in the Dow Jones

fund and 70% in a weak-economy fund.
b. 70% of the portfolio assets are invested in the Dow Jones

fund and 30% in a weak-economy fund.
c. Which of the three investment strategies (30%, 50%, or

70% in the Dow Jones fund) would you recommend?
Why?

5.12 You are trying to develop a strategy for
investing in two different stocks. The anticipated

annual return for a $1,000 investment in each stock under
four different economic conditions has the following
probability distribution:

SELF
Test

s2
Y = 15,000, andsXY = 7,500.

E1X2 = $50, E1Y2 = $100,s2
X = 9,000,

Returns

Probability Economic Condition Stock X Stock Y

0.1 Recession -100 50
0.3 Slow growth 0 150
0.3 Moderate growth 80 -20
0.3 Fast growth 150 -100

Compute the
a. expected return for stock X and for stock Y.
b. standard deviation for stock X and for stock Y.
c. covariance of stock X and stock Y.
d. Would you invest in stock X or stock Y? Explain.

5.15 Suppose that in Problem 5.14 you wanted to create a
portfolio that consists of stock X and stock Y. Compute the
portfolio expected return and portfolio risk for each of the
following percentages invested in stock X:
a. 30%
b. 50%
c. 70%
d. On the basis of the results of (a) through (c), which port-

folio would you recommend? Explain.

5.16 You plan to invest $1,000 in a corporate bond fund or in
a common stock fund. The following information about the
annual return (per $1,000) of each of these investments under
different economic conditions is available, along with the
probability that each of these economic conditions will occur:

Compute the
a. expected return for stock X and for stock Y.
b. standard deviation for stock X and for stock Y.
c. covariance of stock X and stock Y.
d. Would you invest in stock X or stock Y? Explain.

Returns

Probability Economic Condition Stock X Stock Y

0.1 Recession -50 -100
0.3 Slow growth 20 50
0.4 Moderate growth 100 130
0.2 Fast growth 150 200

Probability
Economic
Condition

Corporate
Bond Fund

Common
Stock Fund

0.01 Extreme recession –200 –999
0.09 Recession –70 –300
0.15 Stagnation 30 –100
0.35 Slow growth 80 100
0.30 Moderate growth 100 150
0.10 High growth 120 350

Compute the
a. expected return for the corporate bond fund and for the

common stock fund.
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5.3 Binomial Distribution
The next three sections use mathematical models to solve business problems.

MATHEMATICAL MODEL
A mathematical model is a mathematical expression that represents a variable of interest.

First Order Second Order Third Order Fourth Order

Tagged Tagged Not tagged Tagged

What is the probability of having three tagged order forms in a sample of four orders in
this particular sequence? Because the historical probability of a tagged order is 0.10, the prob-
ability that each order occurs in the sequence is

First Order Second Order Third Order Fourth Order

p = 0.10 p = 0.10 1 - p = 0.90 p = 0.10

b. standard deviation for the corporate bond fund and for
the common stock fund.

c. covariance of the corporate bond fund and the common
stock fund.

d. Would you invest in the corporate bond fund or the com-
mon stock fund? Explain.

e. If you chose to invest in the common stock fund in (d),
what do you think about the possibility of losing $999 of
every $1,000 invested if there is an extreme recession?

5.17 Suppose that in Problem 5.16 you wanted to create
a portfolio that consists of the corporate bond fund and

the common stock fund. Compute the portfolio expected
return and portfolio risk for each of the following
situations:
a. $300 in the corporate bond fund and $700 in the common

stock fund.
b. $500 in each fund.
c. $700 in the corporate bond fund and $300 in the common

stock fund.
d. On the basis of the results of (a) through (c), which port-

folio would you recommend? Explain.

When a mathematical expression is available, you can compute the exact probability of
occurrence of any particular outcome of the variable.

The binomial distribution is one of the most useful mathematical models. You use the
binomial distribution when the discrete random variable is the number of events of interest in
a sample of n observations. The binomial distribution has four basic properties:

• The sample consists of a fixed number of observations, n.
• Each observation is classified into one of two mutually exclusive and collectively

exhaustive categories.
• The probability of an observation being classified as the event of interest, is constant

from observation to observation. Thus, the probability of an observation being
classified as not being the event of interest, is constant over all observations.

• The outcome of any observation is independent of the outcome of any other observation.

Returning to the Saxon Home Improvement scenario presented on page 181 concerning
the accounting information system, suppose the event of interest is defined as a tagged order
form. You are interested in the number of tagged order forms in a given sample of orders.

What results can occur? If the sample contains four orders, there could be none, one, two,
three, or four tagged order forms. No other value can occur because the number of tagged
order forms cannot be more than the sample size, n, and cannot be less than zero. Therefore,
the range of the binomial random variable is from 0 to n.

Suppose that you observe the following result in a sample of four orders:

1 - p,

p,
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Each outcome is independent of the others because the order forms were selected from an
extremely large or practically infinite population and each order form could only be selected
once. Therefore, the probability of having this particular sequence is

This result indicates only the probability of three tagged order forms (events of interest)
from a sample of four order forms in a specific sequence. To find the number of ways of
selecting x objects from n objects, irrespective of sequence, you use the rule of combinations
given in Equation (5.10) and previously defined in Equation (4.14) on page 170.

= 0.0009

= 10.10210.10210.10210.902
= 10.102310.9021

pp11 - p2p = p311 - p21

COMBINATIONS
The number of combinations of selecting x objects1 out of n objects is given by

(5.10)

where

is called n factorial. By definition, 0! = 1.n! = 1n21n - 12 Á 112

nCx =
n!

x!1n - x2!

1On many scientific calculators,
there is a button labeled that al-
lows you to compute the number of
combinations. On these calculators,
the symbol r is used instead of x.

nCr

With and there are

such sequences. The four possible sequences are

Sequence with probability

Sequence with probability

Sequence with probability

Sequence with probability

Therefore, the probability of three tagged order forms is equal to

You can make a similar, intuitive derivation for the other possible outcomes of the random
variable—zero, one, two, and four tagged order forms. However, as n, the sample size, gets large,
the computations involved in using this intuitive approach become time-consuming. Equation

= 142 * 10.00092 = 0.0036

1Number of possible sequences2 * 1Probability of a particular sequence2

11 - p2ppp = p311 - p21 = 0.0009

4 = not tagged, tagged, tagged, tagged,

p11 - p2pp = p311 - p21 = 0.0009

3 = tagged, not tagged, tagged, tagged,

pp11 - p2p = p311 - p21 = 0.0009

2 = tagged, tagged, not tagged, tagged,

ppp11 - p2 = p311 - p21 = 0.0009

1 = tagged, tagged, tagged, not tagged,

nCx =
n!

x!1n - x2! =
4!

3!14 - 32! =
4 * 3 * 2 * 1

13 * 2 * 12112 = 4

x = 3,n = 4



If the likelihood of a tagged order form is 0.1, what is the probability that there are three
tagged order forms in the sample of four?

SOLUTION Using Equation (5.11), the probability of three tagged orders from a sample of four is

= 410.1210.1210.1210.92 = 0.0036

=
4!

3!112!10.12310.921
P1X = 3|n = 4,p = 0.12 =

4!

3!14 - 32!10.12311 - 0.124-3

EXAMPLE 5.1
Determining

Given
and p = 0.1n = 4

P(X = 3),
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BINOMIAL DISTRIBUTION

(5.11)

where

that events of interest, given n and

of observations

of an event of interest

of not having an event of interest

of events of interest in the sample 

the number of combinations of x events of interest out of n
observations

n!

x!1n - x2! =

1X = 0, 1, 2, Á , n2x = number

 1 - p = probability

p = probability

n = number

pX = xP1X = x|n,p2 = probability

P1X = x|n,p2 =
n!

x!1n - x2!px11 - p2n-x

Equation (5.11) restates what was intuitively derived previously. The binomial variable X
can have any integer value x from 0 through n. In Equation (5.11), the product

represents the probability of exactly x events of interest from n observations in a particular se-
quence.

The term

is the number of combinations of the x events of interest from the n observations possible.
Hence, given the number of observations, n, and the probability of an event of interest, the
probability of x events of interest is

Example 5.1 illustrates the use of Equation (5.11).

=
n!

x!1n - x2! px11 - p2n-x

P1X = x|n,p2 = 1Number of combinations2*1Probability of a particular combination2

p,

n!

x!1n - x2!

px11 - p2n-x

(5.11) is the mathematical model that provides a general formula for computing any probability
from the binomial distribution with the number of events of interest, x, given n and p.
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Examples 5.2 and 5.3 show the computations for other values of X.

If the likelihood of a tagged order form is 0.1, what is the probability that there are three or
more (i.e., at least three) tagged order forms in the sample of four?

SOLUTION In Example 5.1, you found that the probability of exactly three tagged order
forms from a sample of four is 0.0036. To compute the probability of at least three tagged or-
der forms, you need to add the probability of three tagged order forms to the probability of
four tagged order forms. The probability of four tagged order forms is

Thus, the probability of at least three tagged order forms is

There is a 0.37% chance that there will be at least three tagged order forms in a sample of four.

= 0.0037

= 0.0036 + 0.0001

P1X Ú 32 = P1X = 32 + P1X = 42

= 110.1210.1210.1210.12(1) = 0.0001

=
4!

4!102! 10.12410.920
P1X = 4|n = 4,p = 0.12 =

4!

4!14 - 42!10.12411 - 0.124-4

EXAMPLE 5.2
Determining

Given
and p = 0.1n = 4

P(X Ú 3),

If the likelihood of a tagged order form is 0.1, what is the probability that there are fewer than
three tagged order forms in the sample of four?

SOLUTION The probability that there are fewer than three tagged order forms is

Using Equation (5.11) on page 192, these probabilities are

Therefore, could also be
calculated from its complement, as follows:

= 1 - 0.0037 = 0.9963

P(X 6 3) = 1 - P(X Ú 3)

P1X Ú 32,P1X 6 32 = 0.6561 + 0.2916 + 0.0486 = 0.9963. P(X 6 3)

P1X = 2|n = 4,p = 0.12 =
4!

2!14 - 22! 10.12211 - 0.124-2 = 0.0486

P1X = 1|n = 4,p = 0.12 =
4!

1!14 - 12! 10.12111 - 0.124-1 = 0.2916

P1X = 0|n = 4,p = 0.12 =
4!

0!14 - 02! 10.12011 - 0.124-0 = 0.6561

P1X 6 32 = P1X = 02 + P1X = 12 + P1X = 22

EXAMPLE 5.3
Determining

Given
and p = 0.1n = 4

P(X63),

Computing binomial probabilities become tedious as n gets large. Figure 5.2 shows how
binomial probabilities can be computed by Excel (left) and Minitab (right). Binomial proba-
bilities can also be looked up in a table of probabilities, as discussed in the Binomial online
topic available on this book’s companion website. (See Appendix C to learn how to access the
online topic files.)
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F I G U R E 5 . 2
Excel worksheet and Minitab results for computing binomial probabilities with and p = 0.1n = 4

F I G U R E 5 . 3
Histogram of the
binomial probability
distribution with 
and p = 0.1

n = 4

The shape of a binomial probability distribution depends on the values of n and
Whenever the binomial distribution is symmetrical, regardless of how large or
small the value of n. When the distribution is skewed. The closer is to 0.5 and
the larger the number of observations, n, the less skewed the distribution becomes. For ex-
ample, the distribution of the number of tagged order forms is highly right skewed because

and (see Figure 5.3).n = 4p = 0.1

pp Z 0.5,
p = 0.5,

p.

Observe from Figure 5.3 that unlike the histogram for continuous variables in Section 2.6,
the bars for the values are very thin, and there is a large gap between each pair of values. That
is because the histogram represents a discrete variable. (Theoretically, the bars should have no
width. They should be vertical lines.)

The mean (or expected value) of the binomial distribution is equal to the product of n and
Instead of using Equation (5.1) on page 183 to compute the mean of the probability distri-

bution, you can also use Equation (5.12) to compute the mean for variables that follow the bi-
nomial distribution.

p.
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On the average, over the long run, you theoretically expect
tagged order form in a sample of four orders.

The standard deviation of the binomial distribution can be calculated using Equation (5.13).
14210.12 = 0.4

m = E1X2 = np =

MEAN OF THE BINOMIAL DISTRIBUTION
The mean, of the binomial distribution is equal to the sample size, n, multiplied by the
probability of an event of interest,

(5.12)m = E1X2 = np

p.
m,

STANDARD DEVIATION OF THE BINOMIAL DISTRIBUTION

(5.13)s = 2s2 = 2Var1X2 = 2np11 - p2

The standard deviation of the number of tagged order forms is

You get the same result if you use Equation (5.3) on page 184.
Example 5.4 applies the binomial distribution to service at a fast-food restaurant.

s = 2410.1210.92 = 0.60

EXAMPLE 5.4
Computing
Binomial
Probabilities

Accuracy in taking orders at a drive-through window is important for fast-food chains.
Periodically, QSR Magazine (data extracted from http://www.qsrmagazine.com/reports/
drive-thru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_
food.html) publishes the results of its surveys. Accuracy is measured as the percentage of or-
ders that are filled correctly. Recently, the percentage of orders filled correctly at Wendy’s
was approximately 89%. Suppose that you go to the drive-through window at Wendy’s and
place an order. Two friends of yours independently place orders at the drive-through window
at the same Wendy’s. What are the probabilities that all three, that none of the three, and that
at least two of the three orders will be filled correctly? What are the mean and standard devi-
ation of the binomial distribution for the number of orders filled correctly?

SOLUTION Because there are three orders and the probability of a correct order is
and Using Equations (5.12) and (5.13),

Using Equation (5.11) on page 192,

= 110.89210.89210.892112 = 0.7050

=
3!

3!13 - 32! 10.892310.1120
P1X = 3|n = 3,p = 0.892 =

3!

3!13 - 32! 10.892311 - 0.8923-3

= 20.2937 = 0.5419

= 2310.89210.112
s = 2s2 = 2Var1X2 = 2np11 - p2
m = E1X2 = np = 310.892 = 2.67

p = 0.890.89, n = 3

http://www.qsrmagazine.com/reports/drive-thru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_food.html
http://www.qsrmagazine.com/reports/drive-thru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_food.html
http://www.qsrmagazine.com/reports/drive-thru_time_study/2009/2009_charts/whats_your_preferred_way_to_order_fast_food.html
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In this section, you have been introduced to the binomial distribution. The binomial distri-
bution is an important mathematical model in many business situations.

Problems for Section 5.3
LEARNING THE BASICS
5.18 If and what is the probability that
a.
b.
c.
d.

5.19 Determine the following:
a. For and what is
b. For and what is
c. For and what is
d. For and what is

5.20 Determine the mean and standard deviation of the
random variable X in each of the following binomial distri-
butions:
a. and
b. and
c. and
d. and

APPLYING THE CONCEPTS
5.21 The increase or decrease in the price of a stock be-
tween the beginning and the end of a trading day is as-
sumed to be an equally likely random event. What is the
probability that a stock will show an increase in its clos-
ing price on five consecutive days?

p = 0.50n = 3
p = 0.80n = 5
p = 0.40n = 4
p = 0.10n = 4

P1X = 52?p = 0.83,n = 6
P1X = 82?p = 0.50,n = 10
P1X = 92?p = 0.40,n = 10

P1X = 02?p = 0.12,n = 4

X 7 1?
X 6 2?
X … 3?
X = 4?

p = 0.40,n = 5

5.22 The U.S. Department of Transportation reported that
in 2009, Southwest led all domestic airlines in on-time ar-
rivals for domestic flights, with a rate of 0.825. Using the
binomial distribution, what is the probability that in the
next six flights
a. four flights will be on time?
b. all six flights will be on time?
c. at least four flights will be on time?
d. What are the mean and standard deviation of the number

of on-time arrivals?
e. What assumptions do you need to make in (a) through (c)?

5.23 A student is taking a multiple-choice exam in
which each question has four choices. Assume that the
student has no knowledge of the correct answers to any of
the questions. She has decided on a strategy in which she
will place four balls (marked and D) into a box.
She randomly selects one ball for each question and re-
places the ball in the box. The marking on the ball will de-
termine her answer to the question. There are five
multiple-choice questions on the exam. What is the prob-
ability that she will get
a. five questions correct?
b. at least four questions correct?
c. no questions correct?
d. no more than two questions correct?

A, B, C,

The mean number of orders filled correctly in a sample of three orders is 2.67, and the
standard deviation is 0.5419. The probability that all three orders are filled correctly is 0.7050,
or 70.50%. The probability that none of the orders are filled correctly is 0.0013, or 0.13%. The
probability that at least two orders are filled correctly is 0.9664, or 96.64%.

= 0.9664

= 0.2614 + 0.7050

P1X Ú 22 = P1X = 22 + P1X = 32
= 310.89210.89210.112 = 0.2614

=
3!

2!13 - 22! 10.892210.1121
P1X = 2|n = 3,p = 0.892 =

3!

2!13 - 22! 10.892211 - 0.8923-2

= 111210.11210.11210.112 = 0.0013

=
3!

0!13 - 02! 10.892010.1123
P1X = 0|n = 3,p = 0.892 =

3!

0!13 - 02! 10.892011 - 0.8923-0
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5.24 Investment advisors agree that near-retirees, defined
as people aged 55 to 65, should have balanced portfolios.
Most advisors suggest that the near-retirees have no more
than 50% of their investments in stocks. However, during
the huge decline in the stock market in 2008, 22% of near-
retirees had 90% or more of their investments in stocks
(P. Regnier, “What I Learned from the Crash,” Money, May
2009, p. 114). Suppose you have a random sample of 10
people who would have been labeled as near-retirees in
2008. What is the probability that during 2008
a. none had 90% or more of their investment in stocks?
b. exactly one had 90% or more of his or her investment in

stocks?
c. two or fewer had 90% or more of their investment in

stocks?
d. three or more had 90% or more of their investment in

stocks?

5.25 When a customer places an order with Rudy’s On-
Line Office Supplies, a computerized accounting informa-
tion system (AIS) automatically checks to see if the
customer has exceeded his or her credit limit. Past records
indicate that the probability of customers exceeding their
credit limit is 0.05. Suppose that, on a given day, 20 cus-
tomers place orders. Assume that the number of customers
that the AIS detects as having exceeded their credit limit is
distributed as a binomial random variable.
a. What are the mean and standard deviation of the number

of customers exceeding their credit limits?

b. What is the probability that zero customers will exceed
their limits?

c. What is the probability that one customer will exceed his
or her limit?

d. What is the probability that two or more customers will
exceed their limits?

5.26 In Example 5.4 on page 195, you and two
friends decided to go to Wendy’s. Now, suppose that

instead you go to Popeye’s, which last month filled approxi-
mately 84.8% of orders correctly. What is the probability that
a. all three orders will be filled correctly?
b. none of the three will be filled correctly?
c. at least two of the three will be filled correctly?
d. What are the mean and standard deviation of the binomial

distribution used in (a) through (c)? Interpret these values.

5.27 In Example 5.4 on page 195, you and two friends de-
cided to go to Wendy’s. Now, suppose that instead you go to
McDonald’s, which last month filled approximately 90.1%
of the orders correctly. What is the probability that
a. all three orders will be filled correctly?
b. none of the three will be filled correctly?
c. at least two of the three will be filled correctly?
d. What are the mean and standard deviation of the binomial

distribution used in (a) through (c)? Interpret these values.
e. Compare the result of (a) through (d) with those of

Popeye’s in Problem 5.26 and Wendy’s in Example 5.4
on page 195.

SELF
Test

5.4 Poisson Distribution
Many studies are based on counts of the times a particular event occurs in a given area of
opportunity. An area of opportunity is a continuous unit or interval of time, volume, or any
physical area in which there can be more than one occurrence of an event. Examples of vari-
ables that follow the Poisson distribution are the surface defects on a new refrigerator, the
number of network failures in a day, the number of people arriving at a bank, and the number
of fleas on the body of a dog. You can use the Poisson distribution to calculate probabilities in
situations such as these if the following properties hold:

• You are interested in counting the number of times a particular event occurs in a given area
of opportunity. The area of opportunity is defined by time, length, surface area, and so forth.

• The probability that an event occurs in a given area of opportunity is the same for all the
areas of opportunity.

• The number of events that occur in one area of opportunity is independent of the num-
ber of events that occur in any other area of opportunity.

• The probability that two or more events will occur in an area of opportunity approaches
zero as the area of opportunity becomes smaller.

Consider the number of customers arriving during the lunch hour at a bank located in the
central business district in a large city. You are interested in the number of customers who arrive
each minute. Does this situation match the four properties of the Poisson distribution given ear-
lier? First, the event of interest is a customer arriving, and the given area of opportunity is de-
fined as a one-minute interval. Will zero customers arrive, one customer arrive, two customers
arrive, and so on? Second, it is reasonable to assume that the probability that a customer arrives
during a particular one-minute interval is the same as the probability for all the other one-
minute intervals. Third, the arrival of one customer in any one-minute interval has no effect
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POISSON DISTRIBUTION

(5.14)

where

probability that events in an area of opportunity
given

number of events

constant approximated by 2.71828

of events 1x = 0, 1, 2, Á , q2x = number

e = mathematical

l = expected

l

X = xP1X = x|l2 = the

P1X = x|l2 =
e-llx

x!

on (i.e., is independent of) the arrival of any other customer in any other one-minute interval.
Finally, the probability that two or more customers will arrive in a given time period approaches
zero as the time interval becomes small. For example, the probability is virtually zero that two
customers will arrive in a time interval of 0.01 second. Thus, you can use the Poisson distribu-
tion to determine probabilities involving the number of customers arriving at the bank in a one-
minute time interval during the lunch hour.

The Poisson distribution has one characteristic, called (the Greek lowercase letter
lambda), which is the mean or expected number of events per unit. The variance of a Poisson
distribution is also equal to and the standard deviation is equal to The number of
events, X, of the Poisson random variable ranges from 0 to infinity

Equation (5.14) is the mathematical expression for the Poisson distribution for computing
the probability of X = x events, given that events are expected.l

1q2. 1l.l,

l

To illustrate an application of the Poisson distribution, suppose that the mean number of
customers who arrive per minute at the bank during the noon-to-1 P.M. hour is equal to 3.0.
What is the probability that in a given minute, exactly two customers will arrive? And what is
the probability that more than two customers will arrive in a given minute?

Using Equation (5.14) and the probability that in a given minute exactly two cus-
tomers will arrive is

To determine the probability that in any given minute more than two customers will arrive,

Because in a probability distribution, all the probabilities must sum to 1, the terms on the right
side of the equation also represent the complement of the probability that X is less
than or equal to 2 [i.e., ]. Thus,

Now, using Equation (5.14),

Thus, there is a 57.68% chance that more than two customers will arrive in the same minute.

= 1 - 0.4232 = 0.5768

= 1 - [0.0498 + 0.1494 + 0.2240]

P1X 7 22 = 1 - c e
-3.013.020

0!
+

e-3.013.021
1!

+
e-3.013.022

2!
d

P1X 7 22 = 1 - P1X … 22 = 1 - [P1X = 02 + P1X = 12 + P1X = 22]
1 - P1X … 22P1X 7 22

P1X 7 22 = P1X = 32 + P1X = 42 + Á + P1X = q 2

P1X = 2|l = 32 =
e-3.013.022

2!
=

9

12.7182823122 = 0.2240

l = 3,
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Computing Poisson probabilities can be tedious. Figure 5.4 shows how Poisson
probabilities can be computed by Excel (left) and Minitab (right). Poisson probabilities can
also be looked up in a table of probabilities, as discussed in the Poisson online topic avail-
able on this book’s companion website. (See Appendix C to learn how to access online
topics.)

F I G U R E 5 . 4
Excel worksheet and
Minitab results for
computing Poisson
probabilities with l = 3

The number of work-related injuries per month in a manufacturing plant is known to follow a
Poisson distribution with a mean of 2.5 work-related injuries a month. What is the probability
that in a given month, no work-related injuries occur? That at least one work-related injury
occurs?

SOLUTION Using Equation (5.14) on page 198 with (or Excel, Minitab, or a Pois-
son table lookup), the probability that in a given month no work-related injuries occur is

The probability that there will be no work-related injuries in a given month is 0.0821, or
8.21%. Thus,

The probability that there will be at least one work-related injury is 0.9179, or 91.79%.

= 0.9179

= 1 - 0.0821

P1X Ú 12 = 1 - P1X = 02

P1X = 0|l = 2.52 =
e-2.512.520

0!
=

1

12.7182822.5112 = 0.0821

l = 2.5

EXAMPLE 5.5
Computing
Poisson
Probabilities
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Problems for Section 5.4
LEARNING THE BASICS
5.28 Assume a Poisson distribution.
a. If find
b. If find
c. If find
d. If find

5.29 Assume a Poisson distribution.
a. If find
b. If find
c. If find
d. If find
e. If find

5.30 Assume a Poisson distribution with What is
the probability that
a.
b.
c.
d.

APPLYING THE CONCEPTS
5.31 Assume that the number of network errors experi-
enced in a day on a local area network (LAN) is distributed
as a Poisson random variable. The mean number of network
errors experienced in a day is 2.4. What is the probability
that in any given day
a. zero network errors will occur?
b. exactly one network error will occur?
c. two or more network errors will occur?
d. fewer than three network errors will occur?

5.32 The quality control manager of Marilyn’s
Cookies is inspecting a batch of chocolate-chip

cookies that has just been baked. If the production process is in
control, the mean number of chip parts per cookie is 6.0. What
is the probability that in any particular cookie being inspected
a. fewer than five chip parts will be found?
b. exactly five chip parts will be found?
c. five or more chip parts will be found?
d. either four or five chip parts will be found?

5.33 Refer to Problem 5.32. How many cookies in a batch
of 100 should the manager expect to discard if company
policy requires that all chocolate-chip cookies sold have at
least four chocolate-chip parts?

5.34 The U.S. Department of Transportation maintains sta-
tistics for mishandled bags per 1,000 airline passengers. In
the first nine months of 2009, airlines had mishandled 3.89
bags per 1,000 passengers. What is the probability that in
the next 1,000 passengers, airlines will have

SELF
Test

X … 1?
X 7 1?
X 6 1?
X = 1?

l = 5.0.

P1X … 32.l = 5.0,
P1X Ú 12.l = 4.0,
P1X … 12.l = 0.5,
P1X Ú 32.l = 8.0,
P1X Ú 22.l = 2.0,

P1X = 02.l = 3.7,
P1X = 12.l = 0.5,
P1X = 82.l = 8.0,
P1X = 22.l = 2.5,

a. no mishandled bags?
b. at least one mishandled bag?
c. at least two mishandled bags?

5.35 The U.S. Department of Transportation maintains
statistics for consumer complaints per 100,000 airline pas-
sengers. In the first nine months of 2009, consumer com-
plaints were 0.99 per 100,000 passengers. What is the
probability that in the next 100,000 passengers, there will be
a. no complaints?
b. at least one complaint?
c. at least two complaints?

5.36 Based on past experience, it is assumed that the
number of flaws per foot in rolls of grade 2 paper follows
a Poisson distribution with a mean of 1 flaw per 5 feet of pa-
per (0.2 flaw per foot). What is the probability that in a
a. 1-foot roll, there will be at least 2 flaws?
b. 12-foot roll, there will be at least 1 flaw?
c. 50-foot roll, there will be more than or equal to 5 flaws

and fewer than or equal to 15 flaws?

5.37 J.D. Power and Associates calculates and publishes
various statistics concerning car quality. The initial quality
score measures the number of problems per new car sold.
For 2009 model cars, Ford had 1.02 problems per car and
Dodge had 1.34 problems per car (data extracted from
S. Carty, “U.S. Autos Power Forward with Gains in Quality
Survey,” USA Today, June 23, 2009, p. 3B). Let the random
variable X be equal to the number of problems with a newly
purchased 2009 Ford.
a. What assumptions must be made in order for X to be dis-

tributed as a Poisson random variable? Are these assump-
tions reasonable?

Making the assumptions as in (a), if you purchased a 2009
Ford, what is the probability that the new car will have
b. zero problems?
c. two or fewer problems?
d. Give an operational definition for problem. Why is the

operational definition important in interpreting the initial
quality score?

5.38 Refer to Problem 5.37. If you purchased a 2009
Dodge, what is the probability that the new car will have
a. zero problems?
b. two or fewer problems?
c. Compare your answers in (a) and (b) to those for the Ford

in Problem 5.37 (b) and (c).

5.39 Refer to Problem 5.37. Another article reported that
in 2008, Ford had 1.12 problems per car and Dodge had
1.41 problems per car (data extracted from S. Carty, “Ford
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Moves Up in Quality Survey,” USA Today, June 5, 2008,
p. 3B). If you purchased a 2008 Ford, what is the probability
that the new car will have
a. zero problems?
b. two or fewer problems?
c. Compare your answers in (a) and (b) to those for the

2009 Ford in Problem 5.37 (b) and (c).

5.40 Refer to Problem 5.39. If you purchased a 2008
Dodge, what is the probability that the new car will have
a. zero problems?
b. two or fewer problems?
c. Compare your answers in (a) and (b) to those for the

2009 Dodge in Problem 5.38 (a) and (b).

5.41 A toll-free phone number is available from 9 A.M. to
9 P.M. for your customers to register complaints about a
product purchased from your company. Past history indi-
cates that an average of 0.8 calls is received per minute.
a. What properties must be true about the situation de-

scribed here in order to use the Poisson distribution to
calculate probabilities concerning the number of phone
calls received in a one-minute period?

Assuming that this situation matches the properties discussed
in (a), what is the probability that during a one-minute period
b. zero phone calls will be received?
c. three or more phone calls will be received?
d. What is the maximum number of phone calls that will be

received in a one-minute period 99.99% of the time?

5.5 Hypergeometric Distribution
Both the binomial distribution and the hypergeometric distribution are concerned with the
number of events of interest in a sample containing n observations. One of the differences in
these two probability distributions is in the way the samples are selected. For the binomial dis-
tribution, the sample data are selected with replacement from a finite population or without re-
placement from an infinite population. Thus, the probability of an event of interest, is
constant over all observations, and the outcome of any particular observation is independent of
any other. For the hypergeometric distribution, the sample data are selected without replace-
ment from a finite population. Thus, the outcome of one observation is dependent on the out-
comes of the previous observations.

Consider a population of size N. Let A represent the total number of events of interest in
the population. The hypergeometric distribution is then used to find the probability of X events
of interest in a sample of size n, selected without replacement. Equation (5.15) represents the
mathematical expression of the hypergeometric distribution for finding x events of interest,
given a knowledge of and A.n, N,

p,

HYPERGEOMETRIC DISTRIBUTION

(5.15)

where

events of interest, 
given knowledge of and A

of events of interest in the population

of events that are not of interest in the populationN - A = number

A = number

N = population size

n = sample size

n, N,
P1X = x|n, N, A2 = the probability of x

P1X = x|n, N, A2 =
aA

x
b aN - A

n - x
b

aN

n
b
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Because the number of events of interest in the sample, represented by x, cannot be greater
than the number of events of interest in the population, A, nor can x be greater than the sample
size, n, the range of the hypergeometric random variable is limited to the sample size or to the
number of events of interest in the population, whichever is smaller.

Equation (5.16) defines the mean of the hypergeometric distribution, and Equation (5.17)
defines the standard deviation.

MEAN OF THE HYPERGEOMETRIC DISTRIBUTION

(5.16)

STANDARD DEVIATION OF THE HYPERGEOMETRIC DISTRIBUTION

(5.17)s = AnA1N - A2
N 2 AN - n

N - 1

m = E1X2 =
nA

N

of events of interest in the sample

[see Equation (5.10) on page 191]

x … n

x … A

aA

x
b = ACx

x = number

In Equation (5.17), the expression is a finite population correction factor that

results from sampling without replacement from a finite population.

To illustrate the hypergeometric distribution, suppose that you are forming a team of 8
managers from different departments within your company. Your company has a total of 30
managers, and 10 of these people are from the finance department. If you are to randomly
select members of the team, what is the probability that the team will contain 2 managers
from the finance department? Here, the population of managers within the com-
pany is finite. In addition, are from the finance department. A team of mem-
bers is to be selected.

Using Equation (5.15),

= 0.298

=
a 10!

2!182! b a
1202!
162!1142! b

a 30!

8!1222! b

P1X = 2|n = 8, N = 30, A = 102 =
a10

2
b a20

6
b

a30

8
b

n = 8A = 10
N = 30

AN - n

N - 1
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F I G U R E 5 . 5
Excel worksheet and Minitab results for the team member example

You are a financial analyst facing the task of selecting bond mutual funds to purchase for a
client’s portfolio. You have narrowed the funds to be selected to ten different funds. In order to
diversify your client’s portfolio, you will recommend the purchase of four different funds. Six
of the funds are short-term corporate bond funds. What is the probability that of the four funds
selected, three are short-term corporate bond funds?

SOLUTION Using Equation (5.15) with and A

The probability that of the four funds selected, three are short-term corporate bond funds
is 0.3810, or 38.10%

= 0.3810

=
a 6!

3!132! b a
142!
112!132! b

a 10!

4!162! b

P1X = 3|n = 4, N = 10, A = 62 =
a6

3
b a4

1
b

a10

4
b

= 6,X = 3, n = 4, N = 10,

EXAMPLE 5.6
Computing
Hypergeometric
Probabilities

Thus, the probability that the team will contain two members from the finance department
is 0.298, or 29.8%.

Computing hypergeometric probabilities can be tedious, especially as N gets large. Figure
5.5 shows how the hypergeometric probabilities for the team formation example can be com-
puted by Excel (left) and Minitab (right).

Example 5.6 shows an application of the hypergeometric distribution in portfolio
selection.
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Problems for Section 5.5
LEARNING THE BASICS
5.42 Determine the following:
a. If and find
b. If and find
c. If and find
d. If and find

5.43 Referring to Problem 5.42, compute the mean and
standard deviation for the hypergeometric distributions de-
scribed in (a) through (d).

APPLYING THE CONCEPTS
5.44 An auditor for the Internal Revenue Service
is selecting a sample of 6 tax returns for an audit.

If 2 or more of these returns are “improper,” the entire pop-
ulation of 100 tax returns will be audited. What is the
probability that the entire population will be audited if the
true number of improper returns in the population is
a. 25?
b. 30?
c. 5?
d. 10?
e. Discuss the differences in your results, depending on the

true number of improper returns in the population.

5.45 The dean of a business school wishes to form an
executive committee of 5 from among the 40 tenured
faculty members at the school. The selection is to be ran-
dom, and at the school there are 8 tenured faculty members
in accounting. What is the probability that the committee
will contain
a. none of them?

SELF
Test

P1X = 32.A = 3,n = 3, N = 10,
P1X = 02.A = 3,n = 5, N = 12,

P1X = 12.A = 3,n = 4, N = 6,
P1X = 32.A = 5,n = 4, N = 10,

b. at least 1 of them?
c. not more than 1 of them?
d. What is your answer to (a) if the committee consists of

7 members?

5.46 From an inventory of 30 cars being shipped to a local
automobile dealer, 4 are SUVs. What is the probability that
if 4 cars arrive at a particular dealership,
a. all 4 are SUVs?
b. none are SUVs?
c. at least 1 is an SUV?
d. What are your answers to (a) through (c) if 6 cars being

shipped are SUVs?

5.47 A state lottery is conducted in which 6 winning
numbers are selected from a total of 54 numbers. What is
the probability that if 6 numbers are randomly selected,
a. all 6 numbers will be winning numbers?
b. 5 numbers will be winning numbers?
c. none of the numbers will be winning numbers?
d. What are your answers to (a) through (c) if the 6 winning

numbers are selected from a total of 40 numbers?

5.48 In Example 5.6 on page 203, a financial analyst was
facing the task of selecting bond mutual funds to purchase
for a client’s portfolio. Suppose that the number of funds had
been narrowed to 12 funds instead of the ten funds (still with
6 short-term corporate funds) in Example 5.6. What is the
probability that of the four funds selected,
a. exactly 1 is a short-term corporate bond funds?
b. at least 1 is a short-term corporate bond fund?
c. three are short-term corporate bond funds?
d. Compare the results of (c) to that of Example 5.6.

5.6 Online Topic: Using the Poisson Distribution 
to Approximate the Binomial Distribution

Under certain circumstances, you can use the Poisson distribution to approximate the binomial
distribution. To study this topic, read the Section 5.6 online topic file that is available on this
book’s companion website. (See Appendix C to learn how to access the online topic files.)
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S U M M A R Y
In this chapter, you have studied mathematical expectation
and three important discrete probability distributions: the
binomial, Poisson, and hypergeometric distributions. In the
next chapter, you will study several important continuous
distributions including the normal distribution.

To help decide what probability distribution to use for a
particular situation, you need to ask the following questions:

• Is there a fixed number of observations, n, each of
which is classified as an event of interest or not an
event of interest? Or is there an area of opportunity? If

there is a fixed number of observations, n, each of
which is classified as an event of interest or not an
event of interest, you use the binomial or hypergeomet-
ric distribution. If there is an area of opportunity, you
use the Poisson distribution.

• In deciding whether to use the binomial or hypergeo-
metric distribution, is the probability of an event of
interest constant over all trials? If yes, you can use the
binomial distribution. If no, you can use the hypergeo-
metric distribution.

In the Saxon Home Improvement scenario at the beginning of this
chapter, you were an accountant for the Saxon Home Improvement
Company. The company’s accounting information system automati-
cally reviews order forms from online customers for possible mis-

takes. Any questionable invoices are tagged and included in a daily
exceptions report. Knowing that the probability that an order will be tagged is 0.10, you were
able to use the binomial distribution to determine the chance of finding a certain number of
tagged forms in a sample of size four. There was a 65.6% chance that none of the forms would
be tagged, a 29.2% chance that one would be tagged, and a 5.2% chance that two or more would
be tagged. You were also able to determine that, on average, you would expect 0.4 forms to be
tagged, and the standard deviation of the number of tagged order forms would be 0.6. Now that
you have learned the mechanics of using the binomial distribution for a known probability of
0.10 and a sample size of four, you will be able to apply the same approach to any given proba-
bility and sample size. Thus, you will be able to make inferences about the online ordering
process and, more importantly, evaluate any changes or proposed changes to the process.

U S I N G S TAT I S T I C S @ Saxon Home Improvement Revisited

K E Y E Q U AT I O N S
Expected Value, of a Discrete Random Variable

(5.1)

Variance of a Discrete Random Variable

(5.2)

Standard Deviation of a Discrete Random Variable

(5.3)s = 2s2 = AaN
i=1

[xi - E1X2]2P1X = xi2

s2 = a
N

i=1
[xi - E1X2]2P1X = xi2

m = E1X2 = a
N

i=1
xi P1X = xi2
m, Covariance

(5.4)

Expected Value of the Sum of Two Random Variables

(5.5)

Variance of the Sum of Two Random Variables

(5.6)

Standard Deviation of the Sum of Two Random Variables

(5.7)sX+Y = 2s2
X+Y

Var1X + Y2 = s2
X+Y = s2

X + s2
Y + 2sXY

E1X + Y2 = E1X2 + E1Y2

sXY = a
N

i=1
[xi - E1X2][yi - E1Y2] P1xiyi2
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K E Y T E R M S

Portfolio Expected Return

(5.8)

Portfolio Risk

(5.9)

Combinations

(5.10)

Binomial Distribution

(5.11)

Mean of the Binomial Distribution

(5.12)

Standard Deviation of the Binomial Distribution

(5.13)s = 2s2 = 2Var1X2 = 2np11 - p2

m = E1X2 = np

P1X = x|n,p2 =
n!

x!1n - x2! px11 - p2n-x

nCx =
n!

x!1n - x2!

sp = 2w2s2
X + 11 - w22s2

Y + 2w11 - w2sXY

E1P2 = wE1X2 + 11 - w2E1Y2
Poisson Distribution

(5.14)

Hypergeometric Distribution

(5.15)

Mean of the Hypergeometric Distribution

(5.16)

Standard Deviation of the Hypergeometric Distribution

(5.17)s = AnA1N - A2
N2 AN - n

N - 1

m = E1X2 =
nA

N

P1X = x|n, N, A2 =
aA

x
b aN - A

n - x
b

aN

n
b

P1X = x|l2 =
e-llx

x!

area of opportunity 197
binomial distribution 190
covariance, 185
expected value 182
expected value, of a discrete

random variable 182
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C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING
5.49 What is the meaning of the expected value of a
probability distribution?

5.50 What are the four properties that must be present in
order to use the binomial distribution?

5.51 What are the four properties that must be present in
order to use the Poisson distribution?

5.52 When do you use the hypergeometric distribution in-
stead of the binomial distribution?

APPLYING THE CONCEPTS
5.53 Darwin Head, a 35-year-old sawmill worker, won
$1 million and a Chevrolet Malibu Hybrid by scoring
15 goals within 24 seconds at the Vancouver Canucks
National Hockey League game (B. Ziemer, “Darwin Evolves
into an Instant Millionaire,” Vancouver Sun, February 28,
2008, p. 1). Head said he would use the money to pay off his
mortgage and provide for his children, and he had no plans
to quit his job. The contest was part of the Chevrolet Malibu
Million Dollar Shootout, sponsored by General Motors
Canadian Division. Did GM-Canada risk the $1 million?
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No! GM-Canada purchased event insurance from a company
specializing in promotions at sporting events such as a half-
court basketball shot or a hole-in-one giveaway at the local
charity golf outing. The event insurance company estimates
the probability of a contestant winning the contest, and for a
modest charge, insures the event. The promoters pay the in-
surance premium but take on no added risk as the insurance
company will make the large payout in the unlikely event
that a contestant wins. To see how it works, suppose that the
insurance company estimates that the probability a contest-
ant would win a Million Dollar Shootout is 0.001, and that
the insurance company charges $4,000.
a. Calculate the expected value of the profit made by the

insurance company.
b. Many call this kind of situation a win–win opportunity

for the insurance company and the promoter. Do you
agree? Explain.

5.54 Between 1896 when the Dow Jones Index was created
and 2009, the index rose in 64% of the years (data extracted
from M. Hulbert, “What the Past Can’t Tell Investors,” The
New York Times, January 3, 2010, p. BU2). Based on this in-
formation, and assuming a binomial distribution, what do you
think is the probability that the stock market will rise
a. next year?
b. the year after next?
c. in four of the next five years?
d. in none of the next five years?
e. For this situation, what assumption of the binomial distri-

bution might not be valid?

5.55 In late 2007, it was reported that 79% of U.S. adults
owned a cell phone (data extracted from E. C. Baig, “Tips
Help Navigate Tech-Buying Maze,” USA Today, November
28, 2007, p. 5B). Suppose that by the end of 2009, that per-
centage was 85%. If a sample of 10 U.S. adults is selected,
what is the probability that
a. 8 own a cell phone?
b. at least 8 own a cell phone?
c. all 10 own a cell phone?
d. If you selected the sample in a particular geographical area

and found that none of the 10 respondents owned a cell
phone, what conclusion might you reach about whether the
percentage of cell phone owners in this area was 85%?

5.56 One theory concerning the Dow Jones Industrial Av-
erage is that it is likely to increase during U.S. presidential
election years. From 1964 through 2008, the Dow Jones In-
dustrial Average increased in 9 of the 12 U.S. presidential
election years. Assuming that this indicator is a random
event with no predictive value, you would expect that the in-
dicator would be correct 50% of the time.
a. What is the probability of the Dow Jones Industrial Aver-

age increasing in 9 or more of the 12 U.S. presidential
election years if the probability of an increase in the Dow
Jones Industrial Average is 0.50?

b. What is the probability that the Dow Jones Industrial Aver-
age will increase in 9 or more of the 12 U.S. presidential

election years if the probability of an increase in the Dow
Jones Industrial Average in any year is 0.75?

5.57 Errors in a billing process often lead to customer dis-
satisfaction and ultimately hurt bottom-line profits. An arti-
cle in Quality Progress (L. Tatikonda, “A Less Costly
Billing Process,” Quality Progress, January 2008, pp.
30–38) discussed a company where 40% of the bills pre-
pared contained errors. If 10 bills are processed, what is the
probability that
a. 0 bills will contain errors?
b. exactly 1 bill will contain an error?
c. 2 or more bills will contain errors?
d. What are the mean and the standard deviation of the

probability distribution?

5.58 Refer to Problem 5.57. Suppose that a quality im-
provement initiative has reduced the percentage of bills
containing errors to 20%. If 10 bills are processed, what is
the probability that
a. 0 bills will contain errors?
b. exactly 1 bill will contain an error?
c. 2 or more bills will contain errors?
d. What are the mean and the standard deviation of the

probability distribution?
e. Compare the results of (a) through (c) to those of Prob-

lem 5.57 (a) through (c).

5.59 A study by the Center for Financial Services Innova-
tion showed that only 64% of U.S. income earners aged 15
and older had bank accounts (A. Carrns, “Banks Court a New
Client,” The Wall Street Journal, March 16, 2007, p. D1).

If a random sample of 20 U.S. income earners aged 15
and older is selected, what is the probability that
a. all 20 have bank accounts?
b. no more than 15 have bank accounts?
c. more than 10 have bank accounts?
d. What assumptions did you have to make to answer (a)

through (c)?

5.60 One of the biggest frustrations for the consumer
electronics industry is that customers are accustomed to
returning goods for any reason (C. Lawton, “The War on
Returns,” The Wall Street Journal, May 8, 2008, pp. D1,
D6). Recently, it was reported that returns for “no trouble
found” were 68% of all the returns. Consider a sample of
20 customers who returned consumer electronics pur-
chases. Use the binomial model to answer the following
questions:
a. What is the expected value, or mean, of the binomial dis-

tribution?
b. What is the standard deviation of the binomial distribution?
c. What is the probability that 15 of the 20 customers made

a return for “no trouble found”?
d. What is the probability that no more than 10 of the cus-

tomers made a return for “no trouble found”?
e. What is the probability that 10 or more of the customers

made a return for “no trouble found”?
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5.61 Refer to Problem 5.60. In the same time period, 27%
of the returns were for “buyer’s remorse.”
a. What is the expected value, or mean, of the binomial

distribution?
b. What is the standard deviation of the binomial distribution?
c. What is the probability that none of the 20 customers

made a return for “buyer’s remorse”?
d. What is the probability that no more than 2 of the

customers made a return for “buyer’s remorse”?
e. What is the probability that 3 or more of the customers

made a return for “buyer’s remorse”?

5.62 One theory concerning the S&P 500 Index is that if it in-
creases during the first five trading days of the year, it is likely
to increase during the entire year. From 1950 through 2009, the
S&P 500 Index had these early gains in 38 years. In 33 of these
38 years, the S&P 500 Index increased for the entire year. As-
suming that this indicator is a random event with no predictive
value, you would expect that the indicator would be correct 50%
of the time. What is the probability of the S&P 500 Index in-
creasing in 33 or more years if the true probability of an increase
in the S&P 500 Index is
a. 0.50?
b. 0.70?
c. 0.90?
d. Based on the results of (a) through (c), what do you think

is the probability that the S&P 500 Index will increase if
there is an early gain in the first five trading days of the
year? Explain.

5.63 Spurious correlation refers to the apparent relation-
ship between variables that either have no true relationship
or are related to other variables that have not been measured.
One widely publicized stock market indicator in the United
States that is an example of spurious correlation is the rela-
tionship between the winner of the National Football League
Super Bowl and the performance of the Dow Jones Industrial
Average in that year. The indicator states that when a team
representing the National Football Conference wins the Su-
per Bowl, the Dow Jones Industrial Average will increase in
that year. When a team representing the American Football
Conference wins the Super Bowl, the Dow Jones Industrial
Average will decline in that year. Since the first Super Bowl
was held in 1967 through 2009, the indicator has been cor-
rect 33 out of 43 times. Assuming that this indicator is a ran-
dom event with no predictive value, you would expect that
the indicator would be correct 50% of the time.
a. What is the probability that the indicator would be cor-

rect 33 or more times in 43 years?
b. What does this tell you about the usefulness of this indicator?

5.64 Approximately 300 million golf balls were lost in the
United States in 2009. Assume that the number of golf balls
lost in an 18-hole round is distributed as a Poisson random
variable with a mean of 5 balls.

a. What assumptions need to be made so that the number of
golf balls lost in an 18-hole round is distributed as a Pois-
son random variable?

Making the assumptions given in (a), what is the probability
that
b. 0 balls will be lost in an 18-hole round?
c. 5 or fewer balls will be lost in an 18-hole round?
d. 6 or more balls will be lost in an 18-hole round?

5.65 According to a Virginia Tech survey, college students
make an average of 11 cell phone calls per day. Moreover,
80% of the students surveyed indicated that their parents
pay their cell phone expenses (J. Elliot, “Professor
Researches Cell Phone Usage Among Students,” www.
physorg.com, February 26, 2007).
a. What distribution can you use to model the number of

calls a student makes in a day?
b. If you select a student at random, what is the probability

that he or she makes more than 10 calls in a day? More
than 15? More than 20?

c. If you select a random sample of 10 students, what distri-
bution can you use to model the proportion of students
who have parents who pay their cell phone expenses?

d. Using the distribution selected in (c), what is the proba-
bility that all 10 have parents who pay their cell phone
expenses? At least 9? At least 8?

5.66 Mega Millions is one of the most popular lottery games
in the United States. Virtually all states participate in Mega Mil-
lions. Rules for playing and the list of prizes in most states are
given below (see megamillions.com).

Rules:
• Select five numbers from a pool of numbers from 1 to

52 and one Mega Ball number from a second pool of
numbers from 1 to 52.

• Each wager costs $1.

Prizes:
• Match all five numbers + Mega Ball—win jackpot

(minimum of $12,000,000)
• Match all five numbers—win $250,000
• Match four numbers Mega Ball—win $10,000
• Match four numbers—win $150
• Match three numbers Mega Ball—win $150
• Match two numbers Mega Ball—win $10
• Match three numbers—win $7
• Match one number Mega Ball—win $3
• Match Mega Ball—win $2

Find the probability of winning
a. the jackpot.
b. the $250,000 prize. (Note that this requires matching all

five numbers but not matching the Mega Ball.)
c. $10,000.
d. $150.

+

+
+

+

www.physorg.com
www.physorg.com
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e. $10.
f. $7.
g. $3.
h. $2.
i. nothing.
j. All stores selling Mega Millions tickets are required to

have a brochure that gives complete game rules and

probabilities of winning each prize. (The probability of
having a losing ticket is not given.) The slogan for all lot-
tery games in the state of Ohio is “Play Responsibly.
Odds Are, You’ll Have Fun.” Do you think Ohio’s slogan
and the requirement of making available complete game
rules and probabilities of winning is an ethical approach
to running the lottery system?

M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
The Ashland MultiComm Services (AMS) marketing depart-
ment wants to increase subscriptions for its 3-For-All
telephone, cable, and Internet combined service. AMS
marketing has been conducting an aggressive direct-market-
ing campaign that includes postal and electronic mailings and
telephone solicitations. Feedback from these efforts indicates
that including premium channels in this combined service is
a very important factor for both current and prospective sub-
scribers. After several brainstorming sessions, the marketing
department has decided to add premium cable channels as a
no-cost benefit of subscribing to the 3-For-All service.

The research director, Mona Fields, is planning to con-
duct a survey among prospective customers to determine how
many premium channels need to be added to the 3-For-All
service in order to generate a subscription to the service.
Based on past campaigns and on industry-wide data, she
estimates the following:

d. What does this tell you about the previous estimate of
the proportion of customers who would subscribe to
the 3-For-All service offer?

2. Instead of offering no premium free channels as in Prob-
lem 1, suppose that two free premium channels are in-
cluded in the 3-For-All service offer, Given past results,
what is the probability that
a. fewer than 3 customers will subscribe to the 3-For-All

service offer?
b. 0 customers or 1 customer will subscribe to the 3-For-

All service offer?
c. more than 4 customers will subscribe to the 3-For-All

service offer?
d. Compare the results of (a) through (c) to those of 1.

Suppose that in the actual survey of 50 prospective cus-
tomers, 6 customers subscribe to the 3-For-All service offer.

e. What does this tell you about the previous estimate of
the proportion of customers who would subscribe to
the 3-For-All service offer?

f. What do the results in (e) tell you about the effect of
offering free premium channels on the likelihood of
obtaining subscriptions to the 3-For-All service?

3. Suppose that additional surveys of 50 prospective cus-
tomers were conducted in which the number of free
premium channels was varied. The results were as
follows:

Number of Free
Premium Channels

Probability
of Subscriptions

0 0.02
1 0.04
2 0.06
3 0.07
4 0.08
5 0.085

1. If a sample of 50 prospective customers is selected and no
free premium channels are included in the 3-For-All serv-
ice offer, given past results, what is the probability that
a. fewer than 3 customers will subscribe to the 3-For-All

service offer?
b. 0 customers or 1 customers will subscribe to the

3-For- All service offer?
c. more than 4 customers will subscribe to the 3-For-All

service offer?
Suppose that in the actual survey of 50 prospective cus-
tomers, 4 customers subscribe to the 3-For-All service offer.

Number of Free
Premium Channels

Number
of Subscriptions

1 5
3 6
4 6
5 7

How many free premium channels should the research director
recommend for inclusion in the 3-For-All service? Explain.
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D I G I TA L C A S E
Apply your knowledge about expected value and the covari-
ance in this continuing Digital Case from Chapters 3 and 4.

Open BullsAndBears.pdf, a marketing brochure from
EndRun Financial Services. Read the claims and examine
the supporting data. Then answer the following:

1. Are there any “catches” about the claims the brochure
makes for the rate of return of Happy Bull and Worried
Bear Funds?

2. What subjective data influence the rate-of-return analyses
of these funds? Could EndRun be accused of making
false and misleading statements? Why or why not?

3. The expected-return analysis seems to show that the Wor-
ried Bear Fund has a greater expected return than the
Happy Bull Fund. Should a rational investor never invest
in the Happy Bull Fund? Why or why not?
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EG5.1 THE PROBABILITY DISTRIBUTION
FOR A DISCRETE RANDOM VARIABLE

In-Depth Excel Use the COMPUTE worksheet of the
Discrete Random Variable workbook as a template for com-
puting the expected value, variance, and standard deviation of
a discrete random variable (see Figure EG5.1). The worksheet
contains the data for the Section 5.1 example on page 182 in-
volving the number of interruptions per day in a large com-
puter network. For other problems, overwrite the X and
values in columns A and B, respectively. If a problem has more
or fewer than six outcomes, select the cell range A5:E5 and:
If the problem has more than six outcomes:

1. Right-click and click Insert from the shortcut menu.

2. If a dialog box appears, click Shift cells down and then
click OK.

3. Repeat steps 1 and 2 as many times as necessary.

4. Select the formulas in cell range C4:E4 and copy them
down through the new table rows.

5. Enter the new X and values in columns A and B.

If the problem has fewer than six outcomes, right-click and
click Delete from the shortcut menu. If a dialog box ap-
pears, click Shift cells up and then click OK. Repeat as
many times as necessary and then enter the new X and
values in columns A and B.

P1X2

P1X2

P1X2

In the new worksheet (shown in Figure EG5.2 on page 212):

3. Enter the probabilities and outcomes in the table that be-
gins in cell B3.

4. Enter 0.5 as the Weight assigned to X.

In-Depth Excel Use the COMPUTE worksheet of the
Portfolio workbook, shown in Figure EG5.2, as a template
for performing portfolio analysis. The worksheet contains
the data for the Section 5.2 investment example on page 186.
Overwrite the X and values and the weight assigned to
the X value when you enter data for other problems. If a
problem has more or fewer than three outcomes, first select
row 5, right-click, and click Insert (or Delete) in the short-
cut menu to insert (or delete) rows one at a time. If you

P1X2

C H A P T E R 5 E X C E L G U I D E

F I G U R E E G 5 . 1

Discrete random variable probability worksheet

EG5.2 COVARIANCE AND ITS APPLICATION
IN FINANCE

PHStat2 Use Covariance and Portfolio Analysis to
perform portfolio analysis. For example, to create the port-
folio analysis for the Section 5.2 investment example on
page 186, select PHStat ➔ Decision-Making ➔
Covariance and Portfolio Analysis. In the procedure’s dia-
log box (shown below):

1. Enter 5 as the Number of Outcomes.

2. Enter a Title, check Portfolio Management Analysis,
and click OK.



212 CHAPTER 5 Discrete Probability Distributions

insert rows, select the cell range B4:J4 and copy the con-
tents of this range down through the new table rows.

The worksheet uses the SUMPRODUCT worksheet
function to compute the sum of the products of corresponding
elements of two cell ranges. The worksheet also contains a
Calculations Area that contains various intermediate calcula-
tions. Open the COMPUTE_FORMULAS worksheet to
examine all the formulas used in this area.

EG5.3 BINOMIAL DISTRIBUTION

PHStat2 Use Binomial to compute binomial probabilities.
For example, to create a binomial probabilities table and
histogram for Example 5.3 on page 193, similar to those in
Figures 5.2 and 5.3, select PHStat ➔ Probability & Prob.
Distributions ➔ Binomial. In the procedure’s dialog box
(shown in next column):

1. Enter 4 as the Sample Size.

2. Enter 0.1 as the Prob. of an Event of Interest.

3. Enter 0 as the Outcomes From value and enter 4 as the
(Outcomes) To value.

4. Enter a Title, check Histogram, and click OK.

To add columns to the binomial probabilities table for
and check Cumulative

Probabilities before clicking OK in step 4.

In-Depth Excel Use the BINOMDIST worksheet function
to compute binomial probabilities. Enter the function as
BINOMDIST (X, sample size, cumulative), where X is
the number of events of interest, is the probability of an
event of interest, and cumulative is a True or False value.
(When cumulative is True, the function computes the prob-
ability of X or fewer events of interest; when cumulative is
False, the function computes the probability of exactly X

events of interest.)
Use the COMPUTE worksheet of the Binomial work-

book, shown in Figure 5.2 on page 194, as a template for
computing binomial probabilities. The worksheet contains
the data for the Section 5.3 tagged orders example.
Overwrite these values and adjust the table of probabilities
for other problems. To create a histogram of the probability
distribution, use the instructions in Appendix Section F.5.

EG5.4 POISSON DISTRIBUTION

PHStat2 Use Poisson to compute Poisson probabilities.
For example, to create a Poisson probabilities table similar
to Figure 5.4 on page 199, select PHStat ➔ Probability &
Prob. Distributions ➔ Poisson. In this procedure’s dialog
box (shown the top of the next page):

1. Enter 3 as the Mean/Expected No. of Events of Interest.

2. Enter a Title and click OK.

p

P,

P1Ú X2,P16= X 2, P16 X 2, P17 X 2,

F I G U R E E G 5 . 2

Portfolio analysis worksheet
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To add columns to the Poisson probabilities table for
and check Cumulative

Probabilities before clicking OK in step 2. To create a his-
togram of the probability distribution on a separate chart
sheet, check Histogram before clicking OK in step 2.

In-Depth Excel Use the POISSON worksheet function to
compute Poisson probabilities. Enter the function as
POISSON(X, lambda, cumulative), where X is the number
of events of interest, lambda is the average or expected
number of events of interest, and cumulative is a True or
False value. (When cumulative is True, the function com-
putes the probability of X or fewer events of interest; when
cumulative is False, the function computes the probability
of exactly X events of interest.)

Use the COMPUTE worksheet of the Poisson work-
book, shown in Figure 5.4 on page 199, as a template for
computing Poisson probabilities. The worksheet contains
the entries for the bank customer arrivals problem of Sec-
tion 5.4. To adapt this worksheet to other problems, change
the Mean/Expected number of events of interest value in
cell E4. To create a histogram of the probability distribution,
use the instructions in Appendix Section F.5.

EG5.5 HYPERGEOMETRIC DISTRIBUTION

PHStat2 Use Hypergeometric to compute hypergeometric
probabilities. For example, to create a hypergeometric proba-
bilities table similar to Figure 5.5 on page 203, select PHStat
➔ Probability & Prob. Distributions ➔ Hypergeometric.
In this procedure’s dialog box (shown in the next column):

1. Enter 8 as the Sample Size.

P1ÚX2,P16= X 2, P16 X2, P17X2,

To create a histogram of the probability distribution on a
separate chart sheet, check Histogram before clicking OK
in step 4.

In-Depth Excel Use the HYPGEOMDIST function to
compute hypergeometric probabilities. Enter the function
as HYPGEOMDIST(X, sample size, A, population size),
where X is the number of events of interest and A is the
number of events of interest in the population.

Use the COMPUTE worksheet of the Hyper-
geometric workbook, shown in Figure 5.5 on page 203,
as a template for computing hypergeometric probabilities.
The worksheet contains the data for the Section 5.5 team-
formation example. To create a histogram of the
probability distribution, use the instructions in Appendix
Section F.5.

To adapt this worksheet to other problems, change the
sample size, the number of events of interest, and
population size values in cells B4, B5, and B6, respec-
tively. If a problem has a sample size other than 8, select
row 11, right-click, and click Insert (or Delete) in the
shortcut menu to insert (or delete) rows one at a time.
Then edit the X values in column A and if you inserted
rows, select the cell B10 formula, and copy it down
through the new table rows.

2. Enter 10 as the No. of Events of Interest in Pop.
(population).

3. Enter 30 as the Population Size.

4. Enter a Title and click OK.
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MG5.1 THE PROBABILITY DISTRIBUTION
FOR A DISCRETE RANDOM VARIABLE

Expected Value of a Discrete Random Variable

Use Calculator to compute the expected value of a discrete
random variable. For example, to compute the expected
value for the Section 5.1 example on page 182 involving the
number of interruptions per day in a large computer net-
work, open to the Table_5.1 worksheet. Select Calc ➔
Calculator. In the Calculator dialog box (shown below):

1. Enter C3 in the Store result in variable box and then press
Tab. (C3 is the first empty column on the worksheet.)

2. Double-click C1 X in the variables list to add X to the
Expression box.

3. Click * on the simulated keypad to add * to the
Expression box.

4. Double-click C2 P(X) in the variables list to form the
expression X * 'P(X)' in the Expression box.

5. Check Assign as a formula.

6. Click OK.

MG5.2 COVARIANCE AND ITS
APPLICATION IN FINANCE

There are no Minitab instructions for this section.

MG5.3 BINOMIAL DISTRIBUTION

Use Binomial to compute binomial probabilities. For
example, to compute these probabilities for the Section 5.3
tagged orders example on page 193, open to a new, blank
worksheet and:

1. Enter X as the name of column C1.

2. Enter 0, 1, 2, 3, and 4 in rows 1 to 5 of column C1.

3. Enter P(X) as the name of column C2.

4. Select Calc ➔ Probability Distributions ➔ Binomial.

In the Binomial Distribution dialog box (shown below):

5. Click Probability (to compute the probabilities of
exactly X events of interest for all values of X).

6. Enter 4 (the sample size) in the Number of trials box.

7. Enter 0.1 in the Event probability box.

8. Click Input column and enter C1 in its box.

9. Enter C2 in the first Optional storage box.

10. Click OK.

C H A P T E R 5 M I N I TA B G U I D E

7. Enter X*P(X) as the name for column C3.

8. Reselect Calc ➔ Calculator.

In the Calculator dialog box:

9. Enter C4 in the Store result in variable box and then
press Tab. (C4 is the first empty column on the work-
sheet.)

10. Enter SUM(C3) in the Expression box.

11. If necessary, clear Assign as a formula.

12. Click OK.

Skip step 9 to create the results shown in Figure 5.2 on
page 194.

MG5.4 POISSON DISTRIBUTION

Use Poisson to compute Poisson probabilities. For exam-
ple, to compute these probabilities for the Section 5.4 bank
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customer arrivals example on page 198, open to a new,
blank worksheet and:

1. Enter X as the name of column C1.

2. Enter values 0 through 15 in rows 1 to 16 of column C1.

3. Enter P(X) as the name of column C2.

4. Select Calc ➔ Probability Distributions ➔ Poisson.

In the Poisson Distribution dialog box (shown below):

5. Click Probability (to compute the probabilities of
exactly X events of interest for all values of X).

6. Enter 3 (the value) in the Mean box.

7. Click Input column and enter C1 in its box.

8. Enter C2 in the first Optional storage box.

9. Click OK.

Skip step 8 to create the results shown in Figure 5.4 on
page 199.

MG5.5 HYPERGEOMETRIC DISTRIBUTION

Use Hypergeometric to compute hypergeometric probabil-
ities. For example, to compute these probabilities for the

Section 5.5 team-formation example on page 202, open to a
new, blank worksheet and:

1. Enter X as the name of column C1.

2. Enter the values 0 through 8 in rows 1 to 9 of column C1.

3. Enter P(X) as the name of column C2.

4. Select Calc ➔ Probability Distributions ➔ Hyper-
geometric.

In the Hypergeometric Distribution dialog box (shown
below):

5. Click Probability.

6. Enter 30 in the Population size (N) box.

7. Enter 10 in the Event count in population (M) box.

8. Enter 8 in the Sample size (n) box.

9. Click Input column and enter C1 in its box.

10. Enter C2 in the first Optional storage box.

11. Click OK.

Skip step 10 to create the results shown in Figure 5.5 on
page 203.
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U S I N G S TAT I S T I C S

@ OurCampus!

You are a designer for the OurCampus! website, a social networking site that targets
college students. To attract and retain visitors to the site, you need to make sure that
the exclusive-content daily videos can be quickly downloaded and played in a user’s
browser. Download time, the amount of time, in seconds, that passes from the first
linking to the website home page until the first video is ready to play, is both a function

of the streaming media technology used and the number of simultaneous users of the website.
To check how fast a video downloads, you open a web browser on a PC at the

corporate offices of OurCampus! and measure the download time. Past data
indicate that the mean download time is 7 seconds, and that the

standard deviation is 2 seconds. Approximately two-thirds of the
download times are between 5 and 9 seconds, and about 95% of
the download times are between 3 and 11 seconds. In other
words, the download times are distributed as a bell-shaped
curve, with a clustering around the mean of 7 seconds. How
could you use this information to answer questions about the
download times of the first video?
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I n Chapter 5, Saxon Home Improvement Company managers wanted to be able to answer
questions about the number of tagged items in a given sample size. As an OurCampus!
web designer, you face a different task, one that involves a continuous measurement

because a download time could be any value and not just a whole number. How can you answer
questions, such as the following, about this continuous numerical variable:

• What proportion of the video downloads take more than 9 seconds?
• How many seconds elapse before 10% of the downloads are complete?
• How many seconds elapse before 99% of the downloads are complete?
• How would enhancing the streaming media technology used affect the answers to these

questions?

As in Chapter 5, you can use a probability distribution as a model. Reading this chapter
will help you learn about characteristics of continuous probability distributions and how to use
the normal, uniform, and exponential distributions to solve business problems.

6.1 Continuous Probability Distributions
A probability density function is a mathematical expression that defines the distribution of
the values for a continuous random variable. Figure 6.1 graphically displays three probability
density functions.

Values of X

Panel A
Normal Distribution

Panel B
Uniform Distribution

Panel C
Exponential Distribution

Values of X Values of X

F I G U R E 6 . 1
Three continuous
probability distributions

6.2 The Normal Distribution
The normal distribution (sometimes referred to as the Gaussian distribution) is the most
common continuous distribution used in statistics. The normal distribution is vitally important
in statistics for three main reasons:

• Numerous continuous variables common in business have distributions that closely
resemble the normal distribution.

• The normal distribution can be used to approximate various discrete probability distributions.
• The normal distribution provides the basis for classical statistical inference because of

its relationship to the central limit theorem (which is discussed in Section 7.4).

Panel A depicts a normal distribution. The normal distribution is symmetrical and bell-
shaped, implying that most values tend to cluster around the mean, which, due to the distribu-
tion’s symmetrical shape, is equal to the median. Although the values in a normal distribution
can range from negative infinity to positive infinity, the shape of the distribution makes it very
unlikely that extremely large or extremely small values will occur.

Panel B shows a uniform distribution where each value has an equal probability of occur-
rence anywhere in the range between the smallest value and the largest value. Sometimes re-
ferred to as the rectangular distribution, the uniform distribution is symmetrical, and therefore
the mean equals the median.

Panel C illustrates an exponential distribution. This distribution is skewed to the right, mak-
ing the mean larger than the median. The range for an exponential distribution is zero to positive
infinity, but the distribution’s shape makes the occurrence of extremely large values unlikely.



6.2 The Normal Distribution 219

T A B L E 6 . 1

Amount of Fill in 10,000
Bottles of a Soft Drink

Amount of Fill (liters) Relative Frequency

6 1.025 48>10,000 = 0.0048
1.025 6 1.030 122>10,000 = 0.0122
1.030 6 1.035 325>10,000 = 0.0325
1.035 6 1.040 695>10,000 = 0.0695
1.040 6 1.045 1,198>10,000 = 0.1198
1.045 6 1.050 1,664>10,000 = 0.1664
1.050 6 1.055 1,896>10,000 = 0.1896
1.055 6 1.060 1,664>10,000 = 0.1664
1.060 6 1.065 1,198>10,000 = 0.1198
1.065 6 1.070 695>10,000 = 0.0695
1.070 6 1.075 325>10,000 = 0.0325
1.075 6 1.080 122>10,000 = 0.0122
1.080 or above 48>10,000 = 0.0048
Total 1.0000

The normal distribution is represented by the classic bell shape shown in Panel A of
Figure 6.1. In the normal distribution, you can calculate the probability that values occur within
certain ranges or intervals. However, because probability for continuous variables is measured
as an area under the curve, the exact probability of a particular value from a continuous distri-
bution such as the normal distribution is zero. As an example, time (in seconds) is measured
and not counted. Therefore, you can determine the probability that the download time for a
video on a web browser is between 7 and 10 seconds, or the probability that the download time
is between 8 and 9 seconds, or the probability that the download time is between 7.99 and
8.01 seconds. However, the probability that the download time is exactly 8 seconds is zero.

The normal distribution has several important theoretical properties:

• It is symmetrical, and its mean and median are therefore equal.
• It is bell-shaped in appearance.
• Its interquartile range is equal to 1.33 standard deviations. Thus, the middle 50% of the

values are contained within an interval of two-thirds of a standard deviation below the
mean and two-thirds of a standard deviation above the mean.

• It has an infinite range 

In practice, many variables have distributions that closely resemble the theoretical proper-
ties of the normal distribution. The data in Table 6.1 represent the amount of soft drink in
10,000 1-liter bottles filled on a recent day. The continuous variable of interest, the amount of
soft drink filled, can be approximated by the normal distribution. The measurements of the
amount of soft drink in the 10,000 bottles cluster in the interval 1.05 to 1.055 liters and dis-
tribute symmetrically around that grouping, forming a bell-shaped pattern.

1-q 6 X 6 q2.

Figure 6.2 shows the relative frequency histogram and polygon for the distribution of the
amount filled in 10,000 bottles.

.20
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.15
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0

F I G U R E 6 . 2
Relative frequency
histogram and polygon
of the amount filled in
10,000 bottles of a soft
drink

Source: Data are taken from
Table 6.1.
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For these data, the first three theoretical properties of the normal distribution are approxi-
mately satisfied. However, the fourth one, having an infinite range, is not. The amount filled
in a bottle cannot possibly be zero or below, nor can a bottle be filled beyond its capacity. From
Table 6.1, you see that only 48 out of every 10,000 bottles filled are expected to contain 1.08
liters or more, and an equal number are expected to contain less than 1.025 liters.

The symbol is used to represent a probability density function. The probability
density function for the normal distribution is given in Equation (6.1).

f(X)

A

B

C

F I G U R E 6 . 3
Three normal
distributions

Computing Normal Probabilities
To compute normal probabilities, you first convert a normally distributed random variable, X, to
a standardized normal random variable, Z, using the transformation formula, shown in
Equation (6.2). Applying this formula allows you to look up values in a normal probability table
and avoid the tedious and complex computations that Equation (6.1) would otherwise require.

NORMAL PROBABILITY DENSITY FUNCTION

(6.1)

where

mathematical constant approximated by 2.71828

mathematical constant approximated by 3.14159

mean

standard deviation

any value of the continuous variable, where -q 6 X 6 qX =
s =

m =

p =

e =

f1X2 =
112ps

e-11>2231X-m2>s42

Although Equation (6.1) may look complicated, because e and are mathematical con-
stants, the probabilities of the random variable X are dependent only on the two parameters of
the normal distribution—the mean, and the standard deviation, Every time you specify
particular values of and a different normal probability distribution is generated. Figure 6.3
illustrates this principle. The distributions labeled A and B have the same mean but have
different standard deviations. Distributions A and C have the same standard deviation but
have different means. Distributions B and C have different values for both and s.m

1s21m2s,m

s.m,

p

THE TRANSFORMATION FORMULA
The Z value is equal to the difference between X and the mean, divided by the
standard deviation,

(6.2)Z =
X - m
s

s.
m,

The transformation formula computes a Z value that expresses the difference of the X
value from the mean, in units of the standard deviation (see Section 3.2 on page 101) calledm,
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standardized units. While a random variable, X, has mean, , and standard deviation, the
standardized random variable, Z, always has mean and standard deviation

Then you can determine the probabilities by using Table E.2, the cumulative standard-
ized normal distribution. For example, recall from the Using Statistics scenario on page 217
that past data indicate that the time to download a video is normally distributed, with a mean

seconds and a standard deviation seconds. From Figure 6.4, you see that every
measurement X has a corresponding standardized measurement Z, computed from Equation
(6.2), the transformation formula. Therefore, a download time of 9 seconds is equivalent to
1 standardized unit (1 standard deviation) above the mean because

Z =
9 - 7

2
= +1

s = 2m = 7

s = 1.m = 0
s,m

OurCampus!
Video Download Time

μ – 3σ μ – 2σ μ – 1σ μ μ + 1σ μ + 2σ μ + 3σ

1 3 5 7 9 11 13 X Scale (μ = 7, σ = 2) 

(μ = 0, σ = 1) –3 –2 –1 0 +1 +2 +3 Z Scale

F I G U R E 6 . 4
Transformation of scales

A download time of 1 second is equivalent to –3 standardized units (3 standard deviations)
below the mean because

Figure 6.4 illustrates that the standard deviation is the unit of measurement. In other
words, a time of 9 seconds is 2 seconds (1 standard deviation) higher, or slower, than the mean
time of 7 seconds. Similarly, a time of 1 second is 6 seconds (3 standard deviations) lower, or
faster, than the mean time.

To further illustrate the transformation formula, suppose that another website has a down-
load time for a video that is normally distributed, with a mean seconds and a standard
deviation second. Figure 6.5 shows this distribution.s = 1

m = 4

Z =
1 - 7

2
= -3

X Scale (μ = 4, σ = 1)

Video Download Time
for Another Website

1 2 3 4 5 6 7

Z Scale (μ = 0, σ = 1)–3 –2 –1 0 +1 +2 +3

F I G U R E 6 . 5
A different
transformation of scales
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Comparing these results with those of the OurCampus! website, you see that a download
time of 5 seconds is 1 standard deviation above the mean download time because

A time of 1 second is 3 standard deviations below the mean download time because

With the Z value computed, you look up the normal probability using a table of values
from the cumulative standardized normal distribution, such as Table E.2 in Appendix E. Sup-
pose you wanted to find the probability that the download time for the OurCampus! site is less
than 9 seconds. Recall from page 221 that transforming to standardized Z units, given a
mean seconds and a standard deviation seconds, leads to a Z value of +1.00.

With this value, you use Table E.2 to find the cumulative area under the normal curve less
than (to the left of) To read the probability or area under the curve less than

you scan down the Z column in Table E.2 until you locate the Z value of interest
(in 10ths) in the Z row for 1.0. Next, you read across this row until you intersect the column
that contains the 100ths place of the Z value. Therefore, in the body of the table, the probabil-
ity for corresponds to the intersection of the row with the column
Table 6.2, which reproduces a portion of Table E.2, shows this intersection. The probability
listed at the intersection is 0.8413, which means that there is an 84.13% chance that the down-
load time will be less than 9 seconds. Figure 6.6 graphically shows this probability.

Z = .00.Z = 1.0Z = 1.00

Z = +1.00,
Z = +1.00.

s = 2m = 7
X = 9

Z =
1 - 4

1
= -3

Z =
5 - 4

1
= +1

T A B L E 6 . 2

Finding a Cumulative
Area Under the Normal
Curve

Cumulative Probabilities

Z .00 .01 .02 .03 .04 .05 .06 .07 .08 .09

0.0 .5000 .5040 .5080 .5120 .5160 .5199 .5239 .5279 .5319 .5359
0.1 .5398 .5438 .5478 .5517 .5557 .5596 .5636 .5675 .5714 .5753
0.2 .5793 .5832 .5871 .5910 .5948 .5987 .6026 .6064 .6103 .6141
0.3 .6179 .6217 .6255 .6293 .6331 .6368 .6406 .6443 .6480 .6517
0.4 .6554 .6591 .6628 .6664 .6700 .6736 .6772 .6808 .6844 .6879
0.5 .6915 .6950 .6985 .7019 .7054 .7088 .7123 .7157 .7190 .7224
0.6 .7257 .7291 .7324 .7357 .7389 .7422 .7454 .7486 .7518 .7549
0.7 .7580 .7612 .7642 .7673 .7704 .7734 .7764 .7794 .7823 .7852
0.8 .7881 .7910 .7939 .7967 .7995 .8023 .8051 .8078 .8106 .8133
0.9 .8159 .8186 .8212 .8238 .8264 .8289 .8315 .8340 .8365 .8389
1.0 .8413 .8438 .8461 .8485 .8508 .8531 .8554 .8577 .8599 .8621

Source: Extracted from Table E.2.

X Scale

Z Scale

Area = 0.8413

1 3 5 7 9 11 13

–3.00 –2.00 –1.00 0 +1.00 +2.00 +3.00

Video Download Time
for OurCampus!

F I G U R E 6 . 6
Determining the area
less than Z from
a cumulative
standardized normal
distribution

However, for the other website, you see that a time of 5 seconds is 1 standardized unit
above the mean time of 4 seconds. Thus, the probability that the download time will be less
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OurCampus! Website

3 4 5
7

9
11

+3

+2

+1

0

–1

–2

–3

13

X Scale

Z Scale

Another Web SiteF I G U R E 6 . 7
Demonstrating a
transformation of scales
for corresponding
cumulative portions
under two normal curves

than 5 seconds is also 0.8413. Figure 6.7 shows that regardless of the value of the mean,
and standard deviation, of a normally distributed variable, Equation (6.2) can transform the
X value to a Z value.

s,
m,

Now that you have learned to use Table E.2 with Equation (6.2), you can answer many
questions related to the OurCampus! video download, using the normal distribution.

What is the probability that the video download time for the OurCampus! website will be more
than 9 seconds?

SOLUTION The probability that the download time will be less than 9 seconds is 0.8413 (see
Figure 6.6 on page 222). Thus, the probability that the download time will be at least 9 seconds is
the complement of less than 9 seconds, Figure 6.8 illustrates this result.1 - 0.8413 = 0.1587.

EXAMPLE 6.1
Finding P1X 7 92

X Scale

Z Scale

Area = 0.1587

1 3 5 7 9 11 13

–3.00 –2.00 –1.00 0 +1.00 +2.00 +3.00

OurCampus!
Video Download Time

0.8413

F I G U R E 6 . 8
Finding P1X 7 92

What is the probability that the video download time for the OurCampus! website will be
under 7 seconds or over 9 seconds?

SOLUTION To find this probability, you separately calculate the probability of a download
time less than 7 seconds and the probability of a download time greater than 9 seconds and
then add these two probabilities together. Figure 6.9 on page 224 illustrates this result. Because
the mean is 7 seconds, 50% of download times are under 7 seconds. From Example 6.1, you
know that the probability that the download time is greater than 9 seconds is 0.1587. There-
fore, the probability that a download time is under 7 or over 9 seconds, is
0.5000 + 0.1587 = 0.6587.

P1X 6 7 or X 7 92,

EXAMPLE 6.2
Finding

or X 7 92P1X 6 7
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X Scale

Z Scale

OurCampus!
Video Download Time

Area 0.5000

1 3 5 7 9 11 13

–3.00 –2.00 –1.00 0 +1.00 +2.00 +3.00

Area 0.1587

Area = 0.3413 because
0.8413 – 0.5000 = 0.3413

F I G U R E 6 . 9
Finding

or X 7 92P1X 6 7

What is the probability that video download time for the OurCampus! website will be between
5 and 9 seconds—that is, 

SOLUTION In Figure 6.10, you can see that the area of interest is located between two
values, 5 and 9.

P15 6 X 6 92?EXAMPLE 6.3
Finding
P15 6 X 6 92

X Scale

Z Scale

Cumulative area = 0.8413 because

Area shaded light blue
is 0.8413 – 0.1587 = 0.6826

1 3 5 7 9 11 13

Z = = +1.00

–3.00 –2.00 –1.00 0 +1.00 +2.00 +3.00

Area = 0.1587 because

Z = = –1.00
X – μ

σ
X – μ

σ

F I G U R E 6 . 1 0
Finding P15 6 X 6 92

In Example 6.1 on page 223, you already found that the area under the normal curve less
than 9 seconds is 0.8413. To find the area under the normal curve less than 5 seconds,

Using Table E.2, you look up and find 0.1587. Therefore, the probability that
the download time will be between 5 and 9 seconds is as dis-
played in Figure 6.10.

0.8413 - 0.1587 = 0.6826,
Z = -1.00

Z =
5 - 7

2
= -1.00

The result of Example 6.3 enables you to state that for any normal distribution, 68.26% of the
values will fall within standard deviation of the mean. From Figure 6.11, you can see that
95.44% of the values will fall within standard deviations of the mean. Thus, 95.44% of the
download times are between 3 and 11 seconds. From Figure 6.12, you can see that 99.73% of the
values are within standard deviations above or below the mean. Thus, 99.73% of the down-
load times are between 1 and 13 seconds. Therefore, it is unlikely (0.0027, or only 27 in 10,000)
that a download time will be so fast or so slow that it will take under 1 second or more than 13 sec-
onds. In general, you can use (that is, 3 standard deviations below the mean to 3 standard devia-
tions above the mean) as a practical approximation of the range for normally distributed data.

6s

; 3

; 2
; 1

X Scale

Z Scale

Area below is 0.9772 because

1 3 5 7 9 11 13

Z = = +2.00
X – μ

–3.00 –2.00 –1.00 0 +1.00 +2.00 +3.00

σ

Area below is 0.0228 because

Z = = –2.00
X – μ

σ

F I G U R E 6 . 1 1
Finding P13 6 X 6 112
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X Scale

Z Scale

Area below is 0.99865 because

1 3 5 7 9 11 13

Z = = +3.00
X – μ

–3.00 –2.00 –1.00 0 +1.00 +2.00 +3.00

σ

Area below is 0.00135 because

Z = = –3.00
X – μ

σ

F I G U R E 6 . 1 2
Finding P11 6 X 6 132

Figures 6.10, 6.11, and 6.12 illustrate that for any normal distribution,

• Approximately 68.26% of the values fall within standard deviation of the mean.
• Approximately 95.44% of the values fall within standard deviations of the mean
• Approximately 99.73% of the values fall within standard deviations of the mean.

This result is the justification for the empirical rule presented on page 122. The accuracy of the
empirical rule improves as a data set follows the normal distribution more closely.

Examples 6.1 through 6.3 require you to use the normal distribution Table E.2 to find an
area under the normal curve that corresponds to a specific X value. There are many circum-
stances in which you want to find the X value that corresponds to a specific area. Examples 6.4
and 6.5 illustrate such situations.

;3
;2
;1

EXAMPLE 6.4
Finding the X Value
for a Cumulative
Probability of 0.10

How much time (in seconds) will elapse before the fastest 10% of the downloads of an Our-
Campus! video are complete?

SOLUTION Because 10% of the videos are expected to download in under X seconds, the
area under the normal curve less than this value is 0.1000. Using the body of Table E.2, you
search for the area or probability of 0.1000. The closest result is 0.1003, as shown in Table 6.3
(which is extracted from Table E.2).

T A B L E 6 . 3

Finding a Z Value
Corresponding to a
Particular Cumulative
Area (0.10) Under the
Normal Curve

Cumulative Probabilities

Z .00 .01 .02 .03 .04 .05 .06 .07 .08 .09

. . . . . . . . . . .

. . . . . . . . . . .

. . . . . . . . . . .

. . . . . . . . . . .
-1.5 .0668 .0655 .0643 .0630 .0618 .0606 .0594 .0582 .0571 .0559
-1.4 .0808 .0793 .0778 .0764 .0749 .0735 .0721 .0708 .0694 .0681
-1.3 .0968 .0951 .0934 .0918 .0901 .0885 .0869 .0853 .0838 .0823
-1.2 .1151 .1131 .1112 .1093 .1075 .0156 .0138 .1020 .1003 .0985

Source: Extracted from Table E.2.

X Scale

Z Scale

X 7

–1.28 0

Area is 0.9000

Area is 0.1000

F I G U R E 6 . 1 3
Finding Z to
determine X

Working from this area to the margins of the table, you find that the Z value correspon-
ding to the particular Z row and Z column (.08) is (see Figure 6.13).-1.281-1.22



Although is not known, you can find the corresponding Z value because the area under
the normal curve less than this Z is 0.0250. Using the body of Table 6.4, you search for the
probability 0.0250.

XL

X Scale

Z Scale

XL

Area is 0.9750

7

0–1.96

Area is 0.0250

F I G U R E 6 . 1 4
Finding Z to
determine XL
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Once you find Z, you use the transformation formula Equation (6.2) on page 220 to deter-
mine the X value. Because

then

Substituting and

Thus, 10% of the download times are 4.44 seconds or less.

X = 7 + 1-1.282122 = 4.44 seconds

Z = -1.28,m = 7,s = 2,

X = m + Zs

Z =
X - m
s

In general, you use Equation (6.3) for finding an X value.

FINDING AN X VALUE ASSOCIATED WITH A KNOWN PROBABILITY
The X value is equal to the mean, plus the product of the Z value and the standard
deviation,

(6.3)X = m + Zs

s.
m,

To find a particular value associated with a known probability, follow these steps:

1. Sketch the normal curve and then place the values for the mean and X on the X and Z
scales.

2. Find the cumulative area less than X.
3. Shade the area of interest.
4. Using Table E.2, determine the Z value corresponding to the area under the normal curve

less than X.
5. Using Equation (6.3), solve for X:

X = m + Zs

What are the lower and upper values of X, symmetrically distributed around the mean, that in-
clude 95% of the download times for a video at the OurCampus! website?

SOLUTION First, you need to find the lower value of X (called ). Then, you find the up-
per value of X (called ). Because 95% of the values are between and and because
and are equally distant from the mean, 2.5% of the values are below (see Figure 6.14).XLXU

XLXU,XLXU

XL

EXAMPLE 6.5
Finding the X
Values That Include
95% of the 
Download Times
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F I G U R E 6 . 1 5
Finding Z
to determine XU

Working from the body of the table to the margins of the table, you see that the Z value
corresponding to the particular Z row and Z column (.06) is 

Once you find Z, the final step is to use Equation (6.3) on page 226 as follows:

You use a similar process to find Because only 2.5% of the video downloads take longer
than seconds, 97.5% of the video downloads take less than seconds. From the symmetry of
the normal distribution, you find that the desired Z value, as shown in Figure 6.15, is
(because Z lies to the right of the standardized mean of 0). You can also extract this Z value from
Table 6.5. You can see that 0.975 is the area under the normal curve less than the Z value of +1.96.

+1.96
XUXU

XU.

= 3.08 seconds

= 7 - 3.92

= 7 + 1-1.962122
X = m + Zs

-1.96.1-1.92

X Scale

Z Scale

XU

Area is 0.9750

7

0 +1.96

Area is 0.0250

T A B L E 6 . 4

Finding a Z Value
Corresponding to 
a Cumulative Area
of 0.025 Under the
Normal Curve

Cumulative Area

Z .00 .01 .02 .03 .04 .05 .06 .07 .08 .09

o o o o o o o o o o o
-2.0 .0228 .0222 .0217 .0212 .0207 .0202 .0197 .0192 .0188 .0183
-1.9 .0287 .0281 .0274 .0268 .0262 .0256 .0250 .0244 .0239 .0233
-1.8 .0359 .0351 .0344 .0336 .0329 .0232 .0314 .0307 .0301 .0294
Source: Extracted from Table E.2.

Using Equation (6.3) on page 226,

Therefore, 95% of the download times are between 3.08 and 10.92 seconds.

= 10.92 seconds

= 7 + 3.92

= 7 + 1+1.962122
X = m + Zs

T A B L E 6 . 5

Finding a Z Value
Corresponding to a
Cumulative Area
of 0.975 Under the
Normal Curve

Cumulative Area

Z .00 .01 .02 .03 .04 .05 .06 .07 .08 .09

o o o o o o o o o o o
+1.8 .9641 .9649 .9656 .9664 .9671 .9678 .9686 .9693 .9699 .9706
+1.9 .9713 .9719 .9726 .9732 .9738 .9744 .9750 .9756 .9761 .9767
+2.0 .9772 .9778 .9783 .9788 .9793 .9798 .9803 .9808 .9812 .9817
Source: Extracted from Table E.2.



228 CHAPTER 6 The Normal Distribution and Other Continuous Distributions

T H I N K A B O U T T H I S What Is Normal?
Ironically, the statistician who popularized the
use of “normal” to describe the distribution dis-
cussed in Section 6.2 was someone who saw
the distribution as anything but the everyday, an-
ticipated occurrence that the adjective normal
usually suggests.

Starting with an 1894 paper, Karl Pearson
argued that measurements of phenomena do
not naturally, or “normally,” conform to the
classic bell shape. While this principle under-
lies statistics today, Pearson’s point of view
was radical to contemporaries who saw the
world as standardized and normal. Pearson
changed minds by showing that some popula-
tions are naturally skewed (coining that term in
passing), and he helped put to rest the notion
that the normal distribution underlies all
phenomena.

Today, unfortunately, people still make the
type of mistake that Pearson refuted. As a

student, you are probably familiar with discus-
sions about grade inflation, a real phenomenon
at many schools. But, have you ever realized that
a “proof” of this inflation—that there are “too
few” low grades because grades are skewed to-
ward A’s and B’s—wrongly implies that grades
should be “normally” distributed. By the time you
finish reading this book, you may realize that be-
cause college students represent small nonran-
dom samples, there are plenty of reasons to
suspect that the distribution of grades would not
be “normal.”

Misunderstandings about the normal distri-
bution have occurred both in business and in the
public sector through the years. These misun-
derstandings have caused a number of business
blunders and have sparked several public policy
debates, including the causes of the collapse of
large financial institutions in 2008. According to
one theory, the investment banking industry’s

application of the normal distribution to assess risk
may have contributed to the global collapse (see
“A Finer Formula for Assessing Risks,” The New
York Times, May 11, 2010, p. B2). Using the normal
distribution led these banks to overestimate the
probability of having stable market conditions and
underestimate the chance of unusually large mar-
ket losses. According to this theory, the use of
other distributions that have less area in the mid-
dle of their curves, and, therefore, more in the
“tails” that represent unusual market outcomes,
may have led to less serious losses.

As you study this chapter, make sure you un-
derstand the assumptions that must hold for the
proper use of the “normal” distribution, assump-
tions that were not explicitly verified by the in-
vestment bankers. And, most importantly, always
remember that the name normal distribution
does not mean to suggest normal in the everyday
(dare we say “normal”?!) sense of the word.

Instead of looking up cumulative probabilities in a table, you can use Excel or Minitab
to compute normal probabilities. Figure 6.16 is an Excel worksheet that computes normal
probabilities for problems similar to Examples 6.1 through 6.4. Figure 6.17 shows Minitab
results for Examples 6.1 and 6.4.

F I G U R E 6 . 1 6
Excel worksheet for
computing normal
probabilities

F I G U R E 6 . 1 7
Minitab results for
Examples 6.1 and 6.4
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Use the Visual Explorations Normal Distribution proce-
dure to see the effects of changes in the mean and stan-
dard deviation on the area under a normal distribution
curve. Open the Visual Explorations add-in work-
book (see Appendix Section D.4). Select Add-ins ➔
VisualExplorations ➔ Normal Distribution.

The add-in displays a normal curve for the OurCam-
pus! download example and a floating control panel (see
illustration at right). Use the control panel spinner but-
tons to change the values for the mean, standard devia-
tion, and X value and note the effects of these changes on
the probability of and the corresponding
shaded area under the curve (see illustration at right). If
you prefer to see the normal curve labeled with Z values,
click Z Values.

Click the Reset button to reset the control panel val-
ues or click Help for additional information about the
problem. Click Finish when you are done exploring.

X 6  value

V I S U A L E X P L O R AT I O N S Exploring the Normal Distribution

Problems for Section 6.2
LEARNING THE BASICS
6.1 Given a standardized normal distribution (with a mean
of 0 and a standard deviation of 1, as in Table E.2), what is
the probability that
a. Z is less than 1.57?
b. Z is greater than 1.84?
c. Z is between 1.57 and 1.84?
d. Z is less than 1.57 or greater than 1.84?

6.2 Given a standardized normal distribution (with a mean
of 0 and a standard deviation of 1, as in Table E.2), what is
the probability that
a. Z is between and 1.84?
b. Z is less than or greater than 1.84?
c. What is the value of Z if only 2.5% of all possible Z

values are larger?
d. Between what two values of Z (symmetrically distributed

around the mean) will 68.26% of all possible Z values be
contained?

6.3 Given a standardized normal distribution (with a mean
of 0 and a standard deviation of 1, as in Table E.2), what is
the probability that
a. Z is less than 1.08?
b. Z is greater than 
c. Z is less than or greater than the mean?
d. Z is less than or greater than 1.08?

6.4 Given a standardized normal distribution (with a mean
of 0 and a standard deviation of 1, as in Table E.2), deter-
mine the following probabilities:

-0.21
-0.21

-0.21?

-1.57
-1.57

a.
b.
c.
d. What is the value of Z if only 15.87% of all possible Z

values are larger?

6.5 Given a normal distribution with and
what is the probability that

a.
b.
c. or
d. Between what two X values (symmetrically distributed

around the mean) are 80% of the values?

6.6 Given a normal distribution with and
what is the probability that
a.
b.
c. 5% of the values are less than what X value?
d. Between what two X values (symmetrically distributed

around the mean) are 60% of the values?

APPLYING THE CONCEPTS
6.7 In 2008, the per capita consumption of coffee in the
United States was reported to be 4.2 kg, or 9.24 pounds (data
extracted from en.wikipedia.org/wiki/List_of_countries_
by_coffee_consumption_per_capita). Assume that the per
capita consumption of coffee in the United States is approxi-
mately distributed as a normal random variable, with a mean
of 9.24 pounds and a standard deviation of 3 pounds.

X 6 42?
X 7 43?

s = 4,m = 50

X 7 110?X 6 80
X 6 70?
X 7 75?

s = 10,
m = 100

P1-1.96 6 Z 6 -0.212P1Z6 -0.212P1Z 7 1.082
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a. What is the probability that someone in the United States
consumed more than 10 pounds of coffee in 2008?

b. What is the probability that someone in the United States
consumed between 3 and 5 pounds of coffee in 2008?

c. What is the probability that someone in the United States
consumed less than 5 pounds of coffee in 2008?

d. 99% of the people in the United States consumed less
than how many pounds of coffee?

6.8 Toby’s Trucking Company determined that
the distance traveled per truck per year is normally

distributed, with a mean of 50 thousand miles and a standard
deviation of 12 thousand miles.
a. What proportion of trucks can be expected to travel

between 34 and 50 thousand miles in a year?
b. What percentage of trucks can be expected to travel

either below 30 or above 60 thousand miles in a year?
c. How many miles will be traveled by at least 80% of the

trucks?
d. What are your answers to (a) through (c) if the standard

deviation is 10 thousand miles?

6.9 Consumers spend an average of $21 per week in cash
without being aware of where it goes (data extracted from
“Snapshots: A Hole in Our Pockets,” USA Today, January
18, 2010, p. 1A). Assume that the amount of cash spent
without being aware of where it goes is normally distributed
and that the standard deviation is $5.
a. What is the probability that a randomly selected person

will spend more than $25?
b. What is the probability that a randomly selected person

will spend between $10 and $20?
c. Between what two values will the middle 95% of the

amounts of cash spent fall?

6.10 A set of final examination grades in an introductory
statistics course is normally distributed, with a mean of 73
and a standard deviation of 8.
a. What is the probability that a student scored below 91 on

this exam?
b. What is the probability that a student scored between 65

and 89?
c. The probability is 5% that a student taking the test scores

higher than what grade?
d. If the professor grades on a curve (i.e., gives A’s to the top

10% of the class, regardless of the score), are you better
off with a grade of 81 on this exam or a grade of 68 on a

SELF
Test

different exam, where the mean is 62 and the standard
deviation is 3? Show your answer statistically and
explain.

6.11 A statistical analysis of 1,000 long-distance telephone
calls made from the headquarters of the Bricks and Clicks
Computer Corporation indicates that the length of these
calls is normally distributed, with seconds and

seconds.
a. What is the probability that a call lasted less than 180

seconds?
b. What is the probability that a call lasted between 180 and

300 seconds?
c. What is the probability that a call lasted between 110 and

180 seconds?
d. 1% of all calls will last less than how many seconds?

6.12 In 2008, the per capita consumption of coffee in
Sweden was reported to be 8.2 kg, or 18.04 pounds (data
extracted from en.wikipedia.org/wiki/List_of_countries_
by_coffee_consumption_per_capita). Assume that the per
capita consumption of coffee in Sweden is approximately
distributed as a normal random variable, with a mean of
18.04 pounds and a standard deviation of 5 pounds.
a. What is the probability that someone in Sweden

consumed more than 10 pounds of coffee in 2008?
b. What is the probability that someone in Sweden

consumed between 3 and 5 pounds of coffee in 2008?
c. What is the probability that someone in Sweden con-

sumed less than 5 pounds of coffee in 2008?
d. 99% of the people in Sweden consumed less than how

many pounds of coffee?

6.13 Many manufacturing problems involve the matching
of machine parts, such as shafts that fit into a valve hole.
A particular design requires a shaft with a diameter of
22.000 mm, but shafts with diameters between 21.990 mm
and 22.010 mm are acceptable. Suppose that the manufac-
turing process yields shafts with diameters normally distrib-
uted, with a mean of 22.002 mm and a standard deviation of
0.005 mm. For this process, what is
a. the proportion of shafts with a diameter between 21.99

mm and 22.00 mm?
b. the probability that a shaft is acceptable?
c. the diameter that will be exceeded by only 2% of the shafts?
d. What would be your answers in (a) through (c) if the stan-

dard deviation of the shaft diameters were 0.004 mm?

s = 40
m = 240

6.3 Evaluating Normality
As discussed in Section 6.2, many continuous variables used in business closely follow a nor-
mal distribution. To determine whether a set of data can be approximated by the normal distri-
bution, you either compare the characteristics of the data with the theoretical properties of the
normal distribution or construct a normal probability plot.
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Comparing Data Characteristics to Theoretical Properties
The normal distribution has several important theoretical properties:

• It is symmetrical; thus, the mean and median are equal.
• It is bell-shaped; thus, the empirical rule applies.
• The interquartile range equals 1.33 standard deviations.
• The range is approximately equal to 6 standard deviations.

Many continuous variables have characteristics that approximate these theoretical properties.
However, other continuous variables are often neither normally distributed nor approximately nor-
mally distributed. For such variables, the descriptive characteristics of the data are inconsistent
with the properties of a normal distribution. One approach that you can use to determine whether
a variable follows a normal distribution is to compare the observed characteristics of the variable
with what would be expected if the variable followed a normal distribution. To do so, you can

• Construct charts and observe their appearance. For small- or moderate-sized data sets,
create a stem-and-leaf display or a boxplot. For large data sets, in addition, plot a his-
togram or polygon.

• Compute descriptive statistics and compare these statistics with the theoretical proper-
ties of the normal distribution. Compare the mean and median. Is the interquartile range
approximately 1.33 times the standard deviation? Is the range approximately 6 times the
standard deviation?

• Evaluate how the values are distributed. Determine whether approximately two-thirds of
the values lie between the mean and standard deviation. Determine whether approx-
imately four-fifths of the values lie between the mean and standard deviations.
Determine whether approximately 19 out of every 20 values lie between the mean and

standard deviations.

For example, you can use these techniques to determine whether the returns in 2009 dis-
cussed in Chapters 2 and 3 (stored in ) follow a normal distribution. Figures 6.18
and 6.19 display relevant Excel results for these data, and Figure 6.20 displays a Minitab
boxplot for the same data.

Bond Funds

;2

;1.28
;1

F I G U R E 6 . 1 8
Descriptive statistics for
the 2009 returns

F I G U R E 6 . 1 9
Five-number summary
and boxplot for the 2009
returns
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From Figures 6.18 through 6.20, and from an ordered array of the returns (not shown
here), you can make the following statements:

• The mean of 7.1641 is greater than the median of 6.4. (In a normal distribution, the mean
and median are equal.)

• The boxplot is very right-skewed, with a long tail on the right. (The normal distribution
is symmetrical.)

• The interquartile range of 7.4 is approximately 1.21 standard deviations. (In a normal
distribution, the interquartile range is 1.33 standard deviations.)

• The range of 40.8 is equal to 6.70 standard deviations. (In a normal distribution, the
range is approximately 6 standard deviations.)

• 73.91% of the returns are within standard deviation of the mean. (In a normal distri-
bution, 68.26% of the values lie within standard deviation of the mean.)

• 85.33% of the returns are within standard deviations of the mean. (In a
normal distribution, 80% of the values lie within standard deviations of the
mean.)

• 96.20% of the returns are within standard deviations of the mean. (In a normal
distribution, 95.44% of the values lie within standard deviations of the mean.)

• The skewness statistic is 0.9085 and the kurtosis statistic is 2.456. (In a normal distribu-
tion, each of these statistics equals zero.)

Based on these statements and the criteria given on page 231, you can conclude that the
2009 returns are highly right-skewed and have somewhat more values within standard de-
viation of the mean than expected. The range is higher than what would be expected in a nor-
mal distribution, but this is mostly due to the single outlier at 32. Primarily because of the
skewness, you can conclude that the data characteristics of the 2009 returns differ from the
theoretical properties of a normal distribution.

Constructing the Normal Probability Plot
A normal probability plot is a visual display that helps you evaluate whether the data are
normally distributed. One common plot is called the quantile–quantile plot. To create this
plot, you first transform each ordered value to a Z value. For example, if you have a sample of

the Z value

for the smallest value corresponds to a cumulative area of

The Z value for a cumulative area of 0.05 (from Table E.2) is Table 6.6 illustrates the
entire set of Z values for a sample of n=19.

-1.65.

1

n + 1
=

1

19 + 1
=

1

20
= 0.05.

n=19,

;1

;2
;2

;1.28
;1.28
;1

;1

F I G U R E 6 . 2 0
Minitab boxplot
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T A B L E 6 . 6

Ordered Values and
Corresponding Z Values
for a Sample 
of n = 19

Ordered Value Z Value Ordered Value Z Value

1 -1.65 11 0.13
2 -1.28 12 0.25
3 -1.04 13 0.39
4 -0.84 14 0.52
5 -0.67 15 0.67
6 -0.52 16 0.84
7 -0.39 17 1.04
8 -0.25 18 1.28
9 -0.13 19 1.65

10 -0.00

In a quantile–quantile plot, the Z values are plotted on the X axis, and the corresponding
values of the variable are plotted on the Y axis. If the data are normally distributed, the values
will plot along an approximately straight line.

Figure 6.21 illustrates the typical shape of the quantile–quantile normal probability plot
for a left-skewed distribution (Panel A), a normal distribution (Panel B), and a right-skewed
distribution (Panel C). If the data are left-skewed, the curve will rise more rapidly at first and
then level off. If the data are normally distributed, the points will plot along an approximately
straight line. If the data are right-skewed, the data will rise more slowly at first and then rise at
a faster rate for higher values of the variable being plotted.

F I G U R E 6 . 2 1
Normal probability plots
for a left-skewed
distribution, a normal
distribution, and a right-
skewed distribution

Left-skewed Normal Right-skewed
Panel A Panel B Panel C

Figure 6.22 shows a normal probability plot for the 2009 returns as created using Excel
(left results, a quantile–quantile plot) and Minitab (right results). The Excel quantile–quantile

F I G U R E 6 . 2 2
Excel (quantile–quantile) and Minitab normal probability plots for 2009 returns
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6.19 Thirty companies comprise the DJIA. Just how big
are these companies? One common method for measur-
ing the size of a company is to use its market capitaliza-
tion, which is computed by multiplying the number of
stock shares by the price of a share of stock. On March
29, 2010, the market capitalization of these companies
ranged from Alcoa’s $14.7 billion to ExxonMobil’s
$318.8 billion. The entire population of market capital-
ization values is stored in .
Source: Data extracted from money.cnn.com, March 29, 2010.

Decide whether the market capitalization of companies
in the DJIA appears to be approximately normally distrib-
uted by
a. comparing data characteristics to theoretical properties.
b. constructing a normal probability plot.
c. constructing a histogram.

6.20 One operation of a mill is to cut pieces of steel into
parts that will later be used as the frame for front seats in an
automotive plant. The steel is cut with a diamond saw, and
the resulting parts must be within inch of the length
specified by the automobile company. The data come from
a sample of 100 steel parts and are stored in . The
measurement reported is the difference, in inches, between
the actual length of the steel part, as measured by a laser
measurement device, and the specified length of the steel
part. Determine whether the data appear to be approxi-
mately normally distributed by
a. comparing data characteristics to theoretical properties.
b. constructing a normal probability plot.

6.21 The file contains the yields for a
money market account and a five-year certificate of deposit
(CD) for 25 banks in the United States, as of March 29,
2010.
Source: Data extracted from www.Bankrate.com, March 29, 2010.

For each type of investment, decide whether the data appear
to be approximately normally distributed by
a. comparing data characteristics to theoretical properties.
b. constructing a normal probability plot.

SavingsRate-MMCD

Steel

;0.005

DowMarketCap

Problems for Section 6.3
LEARNING THE BASICS
6.14 Show that for a sample of the smallest and
largest Z values are and and the middle (i.e.,
20th) Z value is 0.00.

6.15 For a sample of list the six Z values.

APPLYING THE CONCEPTS
6.16 The file contains the overall miles per
gallon (MPG) of small SUVs :

24 23 22 21 22 22 18 18 26 26 26 19 19 
19 21 21 21 21 21 18 19 21 22 22 16 16

Source: Data extracted from “Vehicle Ratings,” Consumer Reports, 
April 2010, pp. 33–34.

Decide whether the data appear to be approximately nor-
mally distributed by
a. comparing data characteristics to theoretical properties.
b. constructing a normal probability plot.

6.17 As player salaries have increased, the cost of attend-
ing baseball games has increased dramatically. The file

contains the cost of four tickets, two beers, four soft
drinks, four hot dogs, two game programs, two baseball
caps, and the parking fee for one car for each of the 30
Major League Baseball teams in 2009:

164, 326, 224, 180, 205, 162, 141, 170, 411, 187
185, 165, 151, 166, 114, 158, 305, 145, 161, 170
210, 222, 146, 259, 220, 135, 215, 172, 223, 216

Source: Data extracted from teammarketing.com, April 1, 2009.

Decide whether the data appear to be approximately nor-
mally distributed by
a. comparing data characteristics to theoretical properties.
b. constructing a normal probability plot.

6.18 The file contains the property taxes
per capita for the 50 states and the District of Columbia.
Decide whether the data appear to be approximately normally
distributed by
a. comparing data characteristics to theoretical properties.
b. constructing a normal probability plot.

PropertyTaxes

BBCost

1n-2622010
SUVSELF

Test

n = 6,

+1.96,-1.96
n = 39,

plot shows that the 2009 returns rise slowly at first and then rise more rapidly. Therefore, you
can conclude that the 2009 returns are right-skewed.

The Minitab normal probability plot has the Return 2009 variable on the X axis and the
cumulative percentage for a normal distribution on the Y axis. As is the case with the
quantile–quantile plot, if the data are normally distributed, the points will plot along an ap-
proximately straight line. However, if the data are right-skewed, the curve will rise more
rapidly at first and then level off. If the data are left-skewed, the data will rise more slowly
at first and then rise at a faster rate for higher values of the variable being plotted. Observe
that the values rise more rapidly at first and then level off, indicating a right-skewed
distribution.

www.Bankrate.com
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96 171 202 178 147 102 153 197 127 82
157 185 90 116 172 111 148 213 130 165
141 149 206 175 123 128 144 168 109 167
95 163 150 154 130 143 187 166 139 149

108 119 183 151 114 135 191 137 129 158

6.22 The file contains the electricity costs, in
dollars, during July 2010 for a random sample of 50 one-
bedroom apartments in a large city:

Utility Decide whether the data appear to be approximately nor-
mally distributed by
a. comparing data characteristics to theoretical properties.
b. constructing a normal probability plot.

6.4 The Uniform Distribution
In the uniform distribution, a value has the same probability of occurrence anywhere in the
range between the smallest value, a, and the largest value, b. Because of its shape, the uniform
distribution is sometimes called the rectangular distribution (see Panel B of Figure 6.1 on
page 218). Equation (6.4) defines the probability density function for the uniform distribution.

UNIFORM PROBABILITY DENSITY FUNCTION

(6.4)

where

a = minimum value of X

b = maximum value of X

f 1X 2 =
1

b - a
if a … X … b and 0 elsewhere

MEAN OF THE UNIFORM DISTRIBUTION

(6.5)m =
a + b

2

VARIANCE AND STANDARD DEVIATION OF THE UNIFORM DISTRIBUTION

(6.6a)

(6.6b)s = C1b - a22
12

s2 =
1b - a22

12

Equation (6.5) defines the mean of the uniform distribution.

Equation (6.6) defines the variance and standard deviation of the uniform distribution.

One of the most common uses of the uniform distribution is in the selection of random
numbers. When you use simple random sampling (see Section 7.1), you assume that each ran-
dom number comes from a uniform distribution that has a minimum value of 0 and a maxi-
mum value of 1.
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In this uniform distribution, what is the probability of getting a random number between
0.10 and 0.30? The area between 0.10 and 0.30, depicted in Figure 6.24, is equal to the base
(which is ) times the height (1.0). Therefore,

P10.10 6 X 6 0.302 = 1Base21Height2 = 10.20211.02 = 0.20

0.30 - 0.10 = 0.20

Figure 6.23 illustrates the uniform distribution with and The total area
inside the rectangle is equal to the base (1.0) times the height (1.0). Thus, the resulting area
of 1.0 satisfies the requirement that the area under any probability density function
equals 1.0.

b = 1.a = 0

X

1.0

.10

1.0

.2 .3 .4 .5 .6 .7 .8 .9 1.0

f (X )F I G U R E 6 . 2 3
Probability density
function for a uniform
distribution with 
and b = 1

a = 0

X
.10

1.0

.2 .3 .4 .5 .6 .7 .8 .9 1.0

f (X )F I G U R E 6 . 2 4
Finding

for a uniform
distribution with 
and b = 1

a = 0
0.30)

P(0.10 6 X 6

From Equations (6.5) and (6.6), the mean and standard deviation of the uniform distribu-
tion for and are computed as follows:

and

Thus, the mean is 0.5, and the standard deviation is 0.2887.
Example 6.6 provides another application of the uniform distribution.

s = 20.0833 = 0.2887

=
1

12
= 0.0833

=
11 - 022

12

s2 =
1b - a22

12

=
0 + 1

2
= 0.5

m =
a + b

2

b = 1a = 0

In the Using Statistics scenario on page 217, the download time of videos was assumed to be
normally distributed with a mean of 7 seconds. Suppose that the download time follows a uni-
form (instead of a normal) distribution between 4.5 and 9.5 seconds. What is the probability
that a download time will take more than 9 seconds?

EXAMPLE 6.6
Computing Uniform
Probabilities
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Problems for Section 6.4
LEARNING THE BASICS
6.23 Suppose you select one value from a uniform
distribution with and What is the probability
that the value will be
a. between 5 and 7?
b. between 2 and 3?
c. What is the mean?
d. What is the standard deviation?

APPLYING THE CONCEPTS
6.24 The time between arrivals of customers at
a bank during the noon-to-1 P.M. hour has a

uniform distribution between 0 to 120 seconds. What is the
probability that the time between the arrival of two cus-
tomers will be
a. less than 20 seconds?
b. between 10 and 30 seconds?
c. more than 35 seconds?
d. What are the mean and standard deviation of the time

between arrivals?

6.25 A study of the time spent shopping in a supermar-
ket for a market basket of 20 specific items showed an
approximately uniform distribution between 20 minutes
and 40 minutes. What is the probability that the shopping
time will be

SELF
Test

b = 10.a = 0

a. between 25 and 30 minutes?
b. less than 35 minutes?
c. What are the mean and standard deviation of the shop-

ping time?

6.26 How long does it take you to download a game for
your iPod? According to Apple’s technical support site,
www.apple.com/support/itunes, downloading an iPod
game using a broadband connection should take 3 to
6 minutes. Assume that the download times are uniformly
distributed between 3 and 6 minutes. If you download a
game, what is the probability that the download time will be
a. less than 3.3 minutes?
b. less than 4 minutes?
c. between 4 and 5 minutes?
d. What are the mean and standard deviation of the down-

load times?

6.27 The scheduled commuting time on the Long Island
Railroad from Glen Cove to New York City is 65 minutes.
Suppose that the actual commuting time is uniformly dis-
tributed between 64 and 74 minutes. What is the probability
that the commuting time will be
a. less than 70 minutes?
b. between 65 and 70 minutes?
c. greater than 65 minutes?
d. What are the mean and standard deviation of the com-

muting time?

6.5 The Exponential Distribution
The exponential distribution is a continuous distribution that is right-skewed and ranges from
zero to positive infinity (see Panel C of Figure 6.1 on page 218). The exponential distribution
is widely used in waiting-line (i.e., queuing) theory to model the length of time between ar-
rivals in processes such as customers arriving at a bank’s ATM, patients entering a hospital
emergency room, and hits on a website.

The exponential distribution is defined by a single parameter, the mean number of ar-
rivals per unit of time. The probability density function for the length of time between arrivals
is given by Equation (6.7).

l,

SOLUTION The download time is uniformly distributed from 4.5 to 9.5 seconds. The area
between 9 and 9.5 seconds is equal to 0.5 seconds, and the total area in the distribution is
9.5 – 4.5 = 5 seconds. Therefore, the probability of a download time between 9 and 9.5 sec-
onds is the portion of the area greater than 9, which is equal to 0.5/5.0 = 0.10. Because 9.5 is
the maximum value in this distribution, the probability of a download time above 9 seconds is
0.10. In comparison, if the download time is normally distributed with a mean of 7 seconds
and a standard deviation of 2 seconds (see Example 6.1 on page 223), the probability of a
download time above 9 seconds is 0.1587.

www.apple.com/support/itunes
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MEAN TIME BETWEEN ARRIVALS

(6.8)m =
1

l

STANDARD DEVIATION OF THE TIME BETWEEN ARRIVALS

(6.9)s =
1

l

The standard deviation of the time between arrivals, is given by Equation (6.9).s,

EXPONENTIAL PROBABILITY DENSITY FUNCTION

(6.7)

where

mathematical constant approximated by 2.71828

mean number of arrivals per unit

value of the continuous variable where 0 6 X 6 qX = any

l =
e =

f 1X2 = le-lx for X 7 0

The mean time between arrivals, is given by Equation (6.8).m,

The value is equal to the mean time between arrivals. For example, if the mean num-
ber of arrivals in a minute is then the mean time between arrivals is min-
utes, or 15 seconds. Equation (6.10) defines the cumulative probability that the length of time
before the next arrival is less than or equal to X.

1>l = 0.25l = 4,
1>l

CUMULATIVE EXPONENTIAL PROBABILITY

(6.10)P1arrival time … X 2 = 1 - e-lx

To illustrate the exponential distribution, suppose that customers arrive at a bank’s ATM at
a rate of 20 per hour. If a customer has just arrived, what is the probability that the next
customer will arrive within 6 minutes (i.e., 0.1 hour)? For this example, and
Using Equation (6.10),

= 1 - 0.1353 = 0.8647

= 1 - e-2

P1Arrival time … 0.12 = 1 - e-2010.12

X = 0.1.l = 20

Thus, the probability that a customer will arrive within 6 minutes is 0.8647, or 86.47%. Fig-
ure 6.25 shows this probability as computed by Excel (left results) and Minitab (right results).
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In the ATM example, what is the probability that the next customer will arrive within 3 min-
utes (i.e., 0.05 hour)?

SOLUTION For this example, and Using Equation (6.10),

Thus, the probability that a customer will arrive within 3 minutes is 0.6321, or 63.21%.

= 1 - 0.3679 = 0.6321

= 1 - e-1

P1Arrival time … 0.052 = 1 - e-2010.052
X = 0.05.l = 20

EXAMPLE 6.6
Computing
Exponential
Probabilities

F I G U R E 6 . 2 5
Excel and Minitab results
for finding exponential
probabilities1mean = 1>l2

Problems for Section 6.5
LEARNING THE BASICS
6.28 Given an exponential distribution with , what
is the probability that the arrival time is
a. less than 
b. greater than 
c. between and
d. less than or greater than 

6.29 Given an exponential distribution with what
is the probability that the arrival time is
a. less than 
b. greater than 
c. between and
d. less than or greater than 

6.30 Given an exponential distribution with what is
the probability that the arrival time is
a. less than 
b. greater than 
c. between and
d. less than or greater than 

APPLYING THE CONCEPTS
6.31 Autos arrive at a toll plaza located at the entrance to a
bridge at a rate of 50 per minute during the 5:00-to-6:00 P.M.
hour. If an auto has just arrived,
a. what is the probability that the next auto will arrive

within 3 seconds (0.05 minute)?
b. what is the probability that the next auto will arrive

within 1 second (0.0167 minute)?

X = 0.5?X = 0.3
X = 0.5?X = 0.3

X = 0.3?
X = 0.3?

l = 5,

X = 0.2?X = 0.1
X = 0.2?X = 0.1

X = 0.1?
X = 0.1?

l = 30,

X = 0.2?X = 0.1
X = 0.2?X = 0.1

X = 0.1?
X = 0.1?

l = 10

c. What are your answers to (a) and (b) if the rate of arrival
of autos is 60 per minute?

d. What are your answers to (a) and (b) if the rate of arrival
of autos is 30 per minute?

6.32 Customers arrive at the drive-up window of
a fast-food restaurant at a rate of 2 per minute dur-

ing the lunch hour.
a. What is the probability that the next customer will arrive

within 1 minute?
b. What is the probability that the next customer will arrive

within 5 minutes?
c. During the dinner time period, the arrival rate is 1 per

minute. What are your answers to (a) and (b) for this period?

6.33 Telephone calls arrive at the information desk of a
large computer software company at a rate of 15 per hour.
a. What is the probability that the next call will arrive

within 3 minutes (0.05 hour)?
b. What is the probability that the next call will arrive

within 15 minutes (0.25 hour)?
c. Suppose the company has just introduced an updated ver-

sion of one of its software programs, and telephone calls
are now arriving at a rate of 25 per hour. Given this infor-
mation, what are your answers to (a) and (b)?

6.34 An on-the-job injury occurs once every 10 days on
average at an automobile plant. What is the probability that
the next on-the-job injury will occur within
a. 10 days?
b. 5 days?
c. 1 day?

SELF
Test
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6.35 The time between unplanned shutdowns of a power
plant has an exponential distribution with a mean of
20 days. Find the probability that the time between two
unplanned shutdowns is
a. less than 14 days.
b. more than 21 days.
c. less than 7 days.

6.36 Golfers arrive at the starter’s booth of a public golf
course at a rate of 8 per hour during the Monday-to-Friday
midweek period. If a golfer has just arrived,
a. what is the probability that the next golfer will arrive

within 15 minutes (0.25 hour)?
b. what is the probability that the next golfer will arrive

within 3 minutes (0.05 hour)?

c. The actual arrival rate on Fridays is 15 per hour. What are
your answers to (a) and (b) for Fridays?

6.37 Some Internet companies sell a service that will boost
a website’s traffic by delivering additional unique visitors.
Assume that one such company claims it can deliver
1,000 visitors a day. If this amount of website traffic is ex-
perienced, then the time between visitors has a mean of
1.44 minutes (or 0.6944 per minute). Assume that your
website gets 1,000 visitors a day and that the time between
visitors has an exponential distribution. What is the proba-
bility that the time between two visitors is
a. less than 1 minute?
b. less than 2 minutes?
c. more than 3 minutes?
d. Do you think it is reasonable to assume that the time

between visitors has an exponential distribution?

6.6 Online Topic: The Normal Approximation 
to the Binomial Distribution

In many circumstances, you can use the normal distribution to approximate the binomial dis-
tribution. To study this topic, read the Section 6.6 online topic file that is available on this
book’s companion website. (See Appendix C to learn how to access the online topic files.)

In the OurCampus! scenario, you were a designer for a social net-
working website. You sought to ensure that a video could be down-
loaded quickly for playback in the web browsers of site visitors.
(Quick playback of videos would help attract and retain those visi-

tors.) By running experiments in the corporate offices, you determined that
the amount of time, in seconds, that passes from first linking to the website
until a video is fully displayed is a bell-shaped distribution with a mean
download time of 7 seconds and standard deviation of 2 seconds. Using the

normal distribution, you were able to calculate that approximately 84% of the download times
are 9 seconds or less, and 95% of the download times are between 3.08 and 10.92 seconds.

Now that you understand how to calculate probabilities from the normal distribution, you
can evaluate download times of a video using different web page designs. For example, if the
standard deviation remained at 2 seconds, lowering the mean to 6 seconds would shift the en-
tire distribution lower by 1 second. Thus, approximately 84% of the download times would be
8 seconds or less, and 95% of the download times would be between 2.08 and 9.92 seconds.
Another change that could reduce long download times would be reducing the variation. For
example, consider the case where the mean remained at the original 7 seconds but the standard
deviation was reduced to 1 second. Again, approximately 84% of the download times would
be 8 seconds or less, and 95% of the download times would be between 5.04 and 8.96 seconds.

U S I N G S TAT I S T I C S @ OurCampus! Revisited

S U M M A R Y
In this and the previous chapter, you have learned about
mathematical models called probability distributions and
how they can be used to solve business problems. In Chapter
5, you used discrete probability distributions in situations
where the outcomes come from a counting process (e.g., the
number of courses you are enrolled in, the number of tagged

order forms in a report generated by an accounting informa-
tion system). In this chapter, you learned about continuous
probability distributions where the outcomes come from a
measuring process (e.g., your height, the download time of a
video). Continuous probability distributions come in various
shapes, but the most common and most important in business
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K E Y E Q U AT I O N S
Normal Probability Density Function

(6.1)

Transformation Formula

(6.2)

Finding an X Value Associated with a Known Probability

(6.3)

Uniform Probability Density Function

(6.4)

Mean of the Uniform Distribution

(6.5)m =
a + b

2

f1X2 =
1

b - a

X = m + Zs

Z =
X - m
s

f 1X 2 =
122ps

e-11>2231X-m2>s42
Variance and Standard Deviation of the Uniform
Distribution

(6.6a)

(6.6b)

Exponential Probability Density Function

(6.7)

Mean Time Between Arrivals

(6.8)

Standard Deviation of the Time Between Arrivals

(6.9)

Cumulative Exponential Probability

(6.10)P1arrival time … X 2 = 1 - e-lx

s =
1
l

m =
1
l

f 1X 2 = le-lx for X 7 0

s = A1b - a22
12

s2 =
1b - a22

12

is the normal distribution. The normal distribution is sym-
metrical; thus, its mean and median are equal. It is also bell-
shaped, and approximately 68.26% of its observations are
within 1 standard deviation of the mean, approximately
95.44% of its observations are within 2 standard deviations
of the mean, and approximately 99.73% of its observations
are within 3 standard deviations of the mean. Although many
data sets in business are closely approximated by the normal
distribution, do not think that all data can be approximated

using the normal distribution. In Section 6.3, you learned
about various methods for evaluating normality in order to
determine whether the normal distribution is a reasonable
mathematical model to use in specific situations. In Sections
6.4 and 6.5, you studied continuous distributions that were
not normally distributed—in particular, the uniform and ex-
ponential distributions.

Chapter 7 uses the normal distribution to develop the
subject of statistical inference.

K E Y T E R M S
cumulative standardized normal

distribution 221
exponential distribution 237
normal distribution 218
normal probability plot 232

probability density function 218
probability density function for the

normal distribution 220
quantile–quantile plot 232
rectangular distribution 235

standardized normal random 
variable 220

transformation formula 220
uniform distribution 235

C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING
6.38 Why is only one normal distribution table such as
Table E.2 needed to find any probability under the normal
curve?

6.39 How do you find the area between two values under
the normal curve?

6.40 How do you find the X value that corresponds to a
given percentile of the normal distribution?
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6.41 What are some of the distinguishing properties of a
normal distribution?

6.42 How does the shape of the normal distribution differ
from the shapes of the uniform and exponential distributions?

6.43 How can you use the normal probability plot to eval-
uate whether a set of data is normally distributed?

6.44 Under what circumstances can you use the exponen-
tial distribution?

APPLYING THE CONCEPTS
6.45 An industrial sewing machine uses ball bearings that
are targeted to have a diameter of 0.75 inch. The lower and
upper specification limits under which the ball bearings can
operate are 0.74 inch and 0.76 inch, respectively. Past expe-
rience has indicated that the actual diameter of the ball bear-
ings is approximately normally distributed, with a mean of
0.753 inch and a standard deviation of 0.004 inch. What is
the probability that a ball bearing is
a. between the target and the actual mean?
b. between the lower specification limit and the target?
c. above the upper specification limit?
d. below the lower specification limit?
e. Of all the ball bearings, 93% of the diameters are greater

than what value?

6.46 The fill amount in 2-liter soft drink bottles is nor-
mally distributed, with a mean of 2.0 liters and a standard
deviation of 0.05 liter. If bottles contain less than 95% of the
listed net content (1.90 liters, in this case), the manufacturer
may be subject to penalty by the state office of consumer
affairs. Bottles that have a net content above 2.10 liters may
cause excess spillage upon opening. What proportion of the
bottles will contain
a. between 1.90 and 2.0 liters?
b. between 1.90 and 2.10 liters?
c. below 1.90 liters or above 2.10 liters?
d. At least how much soft drink is contained in 99% of the

bottles?
e. 99% of the bottles contain an amount that is between which

two values (symmetrically distributed) around the mean?

6.47 In an effort to reduce the number of bottles that contain
less than 1.90 liters, the bottler in Problem 6.46 sets the filling
machine so that the mean is 2.02 liters. Under these circum-
stances, what are your answers in Problem 6.46 (a) through (e)?

6.48 An orange juice producer buys all his oranges from a
large orange grove. The amount of juice squeezed from each
of these oranges is approximately normally distributed, with a
mean of 4.70 ounces and a standard deviation of 0.40 ounce.
a. What is the probability that a randomly selected orange

will contain between 4.70 and 5.00 ounces of juice?
b. What is the probability that a randomly selected orange

will contain between 5.00 and 5.50 ounces of juice?
c. At least how many ounces of juice will 77% of the

oranges contain?

d. 80% of the oranges contain between what two values (in
ounces of juice), symmetrically distributed around the
population mean?

6.49 The file contains the percentage alco-
hol, number of calories per 12 ounces, and number of car-
bohydrates (in grams) per 12 ounces for 139 of the
best-selling domestic beers in the United States. For each of
the three variables, decide whether the data appear to be ap-
proximately normally distributed. Support your decision
through the use of appropriate statistics and graphs.
Source: Data extracted from www.Beer100.com, March 18, 2010.

6.50 The evening manager of a restaurant was very
concerned about the length of time some customers were
waiting in line to be seated. She also had some concern
about the seating times—that is, the length of time between
when a customer is seated and the time he or she leaves the
restaurant. Over the course of one week, 100 customers (no
more than 1 per party) were randomly selected, and their
waiting and seating times (in minutes) were recorded in

.
a. Think about your favorite restaurant. Do you think wait-

ing times more closely resemble a uniform, an exponen-
tial, or a normal distribution?

b. Again, think about your favorite restaurant. Do you think
seating times more closely resemble a uniform, an expo-
nential, or a normal distribution?

c. Construct a histogram and a normal probability plot of
the waiting times. Do you think these waiting times more
closely resemble a uniform, an exponential, or a normal
distribution?

d. Construct a histogram and a normal probability plot of
the seating times. Do you think these seating times more
closely resemble a uniform, an exponential, or a normal
distribution?

6.51 All the major stock market indexes posted strong gains
in 2009. The mean one-year return for stocks in the S&P 500,
a group of 500 very large companies, was 23.45%. The mean
one-year return for the NASDAQ, a group of 3,200 small and
medium-sized companies, was 43.89%. Historically, the one-
year returns are approximately normally distributed, the stan-
dard deviation in the S&P 500 is approximately 20%, and the
standard deviation in the NASDAQ is approximately 30%.
a. What is the probability that a stock in the S&P 500

gained value in 2009?
b. What is the probability that a stock in the S&P 500

gained 10% or more?
c. What is the probability that a stock in the S&P 500 lost

20% or more in 2009?
d. What is the probability that a stock in the S&P 500 lost

40% or more?
e. Repeat (a) through (d) for a stock in the NASDAQ.
f. Write a short summary on your findings. Be sure to in-

clude a discussion of the risks associated with a large
standard deviation.

Wait

DomesticBeer

www.Beer100.com
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6.52 The speed in which the home page of a website is
downloaded is an important quality characteristic of that
website. Suppose that the mean time to download the home
page for the Internal Revenue Service is 1.2 seconds. Sup-
pose that the download time is normally distributed, with a
standard deviation of 0.2 second. What is the probability
that a download time is
a. less than 2 seconds?
b. between 1.5 and 2.5 seconds?
c. above 1.8 seconds?
d. 99% of the download times are slower (higher) than how

many seconds ?
e. 95% of the download times are between what two values,

symmetrically distributed around the mean?
f. Suppose that the download times are uniformly distrib-

uted between 0.45 and 1.95 seconds. What are your an-
swers to (a) through (e)?

6.53 Suppose that the mean download time for a commercial
tax preparation site is 2.0 seconds. Suppose that the download
time is normally distributed, with a standard deviation of 0.5
second. What is the probability that a download time is
a. less than 2 seconds?
b. between 1.5 and 2.5 seconds?
c. above 1.8 seconds?
d. 99% of the download times are slower (higher) than how

many seconds ?
e. Suppose that the download times are uniformly distrib-

uted between 1.5 and 2.5 seconds. What are your answers
to (a) through (e)?

f. Compare the results for the IRS site computed in Prob-
lem 6.52 to those of the commercial site.

6.54 (Class Project) According to Burton G. Malkiel, the
daily changes in the closing price of stock follow a random
walk—that is, these daily events are independent of each
other and move upward or downward in a random manner—
and can be approximated by a normal distribution. To test
this theory, use either a newspaper or the Internet to select
one company traded on the NYSE, one company traded on
the American Stock Exchange, and one company traded
on the NASDAQ and then do the following:
1. Record the daily closing stock price of each of these

companies for six consecutive weeks (so that you have
30 values per company).

2. Record the daily changes in the closing stock price of
each of these companies for six consecutive weeks (so
that you have 30 values per company).

For each of your six data sets, decide whether the data are
approximately normally distributed by
a. constructing the stem-and-leaf display, histogram or

polygon, and boxplot.
b. comparing data characteristics to theoretical properties.
c. constructing a normal probability plot.
d. Discuss the results of (a) through (c). What can you say

about your three stocks with respect to daily closing

prices and daily changes in closing prices? Which, if any,
of the data sets are approximately normally distributed?

Note: The random-walk theory pertains to the daily changes in the closing

stock price, not the daily closing stock price.

TEAM PROJECT
The file contains information regarding eight
variables from a sample of 184 bond mutual funds:

Bond Funds

6.55 For the expense ratio, three-year return, and five-year
return, decide whether the data are approximately normally
distributed by
a. comparing data characteristics to theoretical properties.
b. constructing a normal probability plot.

STUDENT SURVEY DATABASE
6.56 Problem 1.27 on page 14 describes a survey of 62 un-
dergraduate students (stored in ). For these
data, for each numerical variable, decide whether the data
are approximately normally distributed by
a. comparing data characteristics to theoretical properties.
b. constructing a normal probability plot.

6.57 Problem 1.27 on page 14 describes a survey of 62
undergraduate students (stored in ).
a. Select a sample of undergraduate students and conduct a

similar survey for those students.
b. For the data collected in (a), repeat (a) and (b) of Problem

6.56.
c. Compare the results of (b) to those of Problem 6.56.

6.58 Problem 1.28 on page 15 describes a survey of 44
MBA students (stored in ). For these data, for
each numerical variable, decide whether the data are ap-
proximately normally distributed by
a. comparing data characteristics to theoretical properties.
b. constructing a normal probability plot.

6.59 Problem 1.28 on page 15 describes a survey of 44
MBA students (stored in ).
a. Select a sample of graduate students and conduct a simi-

lar survey for those students.
b. For the data collected in (a), repeat (a) and (b) of Problem

6.58.
c. Compare the results of (b) to those of Problem 6.58.

GradSurvey

GradSurvey

UndergradSurvey

UndergradSurvey

Type—Type of bonds comprising the bond mutual fund
(intermediate government or short-term corporate)

Assets—In millions of dollars
Fees—Sales charges (no or yes)
Expense ratio—Ratio of expenses to net assets in per-

centage
Return 2009—Twelve-month return in 2009
Three-year return—Annualized return, 2007–2009
Five-year return—Annualized return, 2005–2009
Risk—Risk-of-loss factor of the mutual fund (below av-

erage, average, or above average)
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M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
The AMS technical services department has embarked on a
quality improvement effort. Its first project relates to main-
taining the target upload speed for its Internet service sub-
scribers. Upload speeds are measured on a standard scale in
which the target value is 1.0. Data collected over the past
year indicate that the upload speed is approximately nor-
mally distributed, with a mean of 1.005 and a standard devi-
ation of 0.10. Each day, one upload speed is measured. The
upload speed is considered acceptable if the measurement
on the standard scale is between 0.95 and 1.05.

EXERCISES
1. Assuming that the distribution has not changed from

what it was in the past year, what is the probability that
the upload speed is
a. less than 1.0?
b. between 0.95 and 1.0?
c. between 1.0 and 1.05?
d. less than 0.95 or greater than 1.05?

2. The objective of the operations team is to reduce the
probability that the upload speed is below 1.0. Should the
team focus on process improvement that increases the
mean upload speed to 1.05 or on process improvement
that reduces the standard deviation of the upload speed to
0.075? Explain.

D I G I TA L C A S E
Apply your knowledge about the normal distribution in this
Digital Case, which extends the Using Statistics scenario
from this chapter.

To satisfy concerns of potential customers, the management
of OurCampus! has undertaken a research project to learn
the amount of time it takes users to load a complex video
features page. The research team has collected data and has
made some claims based on the assertion that the data
follow a normal distribution.

Open OC_QRTStudy.pdf, which documents the work
of a quality response team at OurCampus! Read the internal

report that documents the work of the team and their conclu-
sions. Then answer the following:

1. Can the collected data be approximated by the normal dis-
tribution?

2. Review and evaluate the conclusions made by the Our-
Campus! research team. Which conclusions are correct?
Which ones are incorrect?

3. If OurCampus! could improve the mean time by five sec-
onds, how would the probabilities change?
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EG6.1 CONTINUOUS PROBABILITY
DISTRIBUTIONS

There are no Excel Guide instructions for this section.

EG6.2 THE NORMAL DISTRIBUTION

PHStat2 Use Normal to compute normal probabilities. For
example, to create the Figure 6.16 worksheet (see page 228)
that computes probabilities for several Chapter 6 examples,
select PHStat ➔ Probability & Prob. Distributions ➔
Normal. In this procedure’s dialog box (shown below):

1. Enter 7 as the Mean and 2 as the Standard Deviation.

2. Check Probability for: and enter 7 in its box.

3. Check Probability for: and enter 9 in its box.

4. Check X for Cumulative Percentage and enter 10 in its
box.

5. Enter a Title and click OK.

X 7
X6 =

compute the probability of less than or equal to the X value
given, NORMSINV to compute the Z value for the cumulative
percentage, and NORMINV to compute the X value for the
given cumulative probability, mean, and standard deviation.

The worksheet also includes formulas that update prob-
ability labels when an X value is changed. Open to the
COMPUTE_FORMULAS worksheet to examine all
formulas.

EG6.3 EVALUATING NORMALITY

Comparing Data Characteristics to Theoretical
Properties

Use instructions in Sections EG3.1 through EG3.3 in the
Chapter 3 Excel Guide to compare data characteristics to
theoretical properties.

Constructing the Normal Probability Plot

PHStat2 Use Normal Probability Plot to create a normal
probability plot. For example, to create the Figure 6.22 nor-
mal probability plot for the 2009 returns on page 233, open
to the DATA worksheet of the Bond Funds workbook.
Select PHStat ➔ Probability & Prob. Distributions ➔
Normal Probability Plot. In the procedure’s dialog box
(shown below):

1. Enter F1:F185 as the Variable Cell Range.

2. Check First cell contains label.

3. Enter a Title and click OK.

In-Depth Excel Use the NORMDIST worksheet function
to compute normal probabilities. Enter the function as
NORMDIST(X value, mean, standard deviation, True) to
return the cumulative probability for less than or equal to
the specified X value.

Use the COMPUTE worksheet of the Normal work-
book, shown in Figure 6.16 on page 228, as a template for
computing normal probabilities. The worksheet contains the
data for solving the problems in Examples 6.1 through 6.4.
Change the values for the Mean, Standard Deviation, X
Value, From X Value, To X Value, and/or Cumulative Per-
centage to solve similar problems. To solve a problem that is
similar to Example 6.5 on page 226, change the Cumulative
Percentage cell twice, once to determine the lower value of
X and the other time to determine the upper value of X.

The COMPUTE worksheet also uses the STANDARD-
IZE worksheet function to compute Z values, NORMDIST to

In addition to the chart sheet containing the normal proba-
bility plot, the procedure creates a worksheet of plot data
that uses the NORMSINV function to compute the Z values
used in the plot.

In-Depth Excel Create a normal probability plot by first
creating a worksheet that computes Z values for the data
to be plotted and then by creating a chart from that
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worksheet. Use the PLOT_DATA worksheet of the NPP
workbook as a model for computing Z values. This
worksheet contains columns for the rank, proportion, Z
value, and the Return 2009 variable and is the source of
the data for the NORMAL_PLOT chart sheet that
contains the Figure 6.22 normal probability plot (see
page 233). For other problems, paste sorted variable data
in column D, update the number of ranks in column A,
and adjust the formulas in columns B and C. Column B
formulas divide the column A cell by the quantity n + 1
(185 for the 2009 returns data) to compute cumulative
percentages and column C formulas use the NORMSINV
function to compute the Z values for those cumulative
percentages. (Open to the PLOT_FORMULAS work-
sheet in the same workbook to examine these formulas.)

If you have fewer than 184 values, delete rows from the
bottom up. If you have more than 184 values, insert rows
from somewhere inside the body of the table to ensure that
the normal probability plot is properly updated. To create
your own normal probability plot for the Return 2009 vari-
able, select the cell range C1:D185. Then select Insert ➔
Scatter and select the first Scatter gallery choice (Scatter
with only Markers). Relocate the chart to a chart sheet and
adjust the chart formatting by using the instructions in
Appendix F.

EG6.4 THE UNIFORM DISTRIBUTION

There are no Excel Guide instructions for this section.

MG6.1 CONTINUOUS PROBABILITY
DISTRIBUTIONS

There are no Minitab Guide instructions for this section.

MG6.2 THE NORMAL DISTRIBUTION

Use Normal to compute normal probabilities. For exam-
ple, to compute the normal probabilities shown in Figure
6.17 on page 228, open to a new, empty worksheet. Enter
X Value as the name of column C1 and enter 9 in the row
1 cell of column C1. Select Calc ➔ Probability Distrib-
utions ➔ Normal. In the Normal Distribution dialog box
(shown in the next column):

1. Click Cumulative probability.

2. Enter 7 in the Mean box.

3. Enter 2 in the Standard deviation box.

4. Click Input column and enter C1 in its box.

5. Click OK.

In-Depth Excel Use the EXPONDIST worksheet function
to compute an exponential probability. Enter the function as
EXPONDIST(X Value, mean, True). Use the COMPUTE
worksheet of the Exponential workbook, shown in Figure
6.25 on page 239, as a template for computing exponential
probabilities.

EG6.5 THE EXPONENTIAL DISTRIBUTION

PHStat2 Use Exponential to compute an exponential
probability. For example, to create the Figure 6.25 work-
sheet that computes the exponential probability for the bank
ATM example (see page 239), select PHStat ➔ Probability
& Prob. Distributions ➔ Exponential. In the procedure’s
dialog box (shown below):

1. Enter 20 as the Mean per unit (Lambda) and 0.1 as the
X Value.

2. Enter a Title and click OK.

Minitab displays the Example 6.1 probability for a down-
load time that is less than 9 seconds with μ = 7 and σ = 2 (see
in the left portion of Figure 6.17). To compute the normal prob-
ability for Example 6.4, enter Cumulative Percentage as the
name of column C2 and enter 0.1 in the row 1 cell of column
C2. Again select Calc ➔ Probability Distributions ➔
Normal. In the Normal Distribution dialog box:

1. Click Inverse cumulative probability.

2. Enter 7 in the Mean box.
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3. Enter 2 in the Standard deviation box.

4. Click Input column and enter C2 in its box.

5. Click OK.

Minitab displays the Example 6.4 Z value correspon-
ding to a cumulative area of 0.10 (see the right portion of
Figure 6.17).

MG6.3 EVALUATING NORMALITY

Comparing Data Characteristics to Theoretical
Properties

Use instructions in Sections MG3.1 through MG3.3 in the
Chapter 3 Minitab Guide to compare data characteristics to
theoretical properties.

Constructing the Normal Probability Plot

Use Probability Plot to create a normal probability plot.
For example, to create the Figure 6.22 plot for the 2009
returns on page 233, open to the Bond Funds worksheet.
Select Graph ➔ Probability Plot and:

1. In the Probability Plots dialog box, click Single and then
click OK.

In the Probability Plot - Single dialog box (shown below):

2. Double-click C6 Return2009 in the variables list to
add 'Return 2009' to the Graph variables box.

3. Click Distribution.

In the Probability Plot - Distribution dialog box:

4. Click the Distribution tab (shown at the top of the next
column) and select Normal from the Distribution drop-
down list.

5. Click the Data Display tab. Click Symbols only and
clear the Show confidence interval check box.

6. Click OK.

7. Back in the Probability Plot - Single dialog box,
click OK.

MG6.4 THE UNIFORM DISTRIBUTION

There are no Minitab instructions for this section

MG6.5 THE EXPONENTIAL DISTRIBUTION

Use Exponential to compute an exponential probability.
For example, to compute the exponential probability for the
bank ATM example shown in Figure 6.25 worksheet on
page 239, open to a new, blank worksheet. Enter X Value as
the name of column C1 and enter 0.1 in the row 1 cell of
column C1. Select Calc ➔ Probability Distributions ➔
Exponential. In the Exponential Distribution dialog box
(shown below):

1. Click Cumulative probability.

2. Enter 0.05 in the Scale box. (Minitab defines scale as the
mean time between arrivals, 1/ = 1/20 = 0.05, not the
mean number of arrivals, = 20.)

3. Leave the Threshold value as 0.0.

4. Click Input column and enter C1 in its box.

5. Click OK.

l

l
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@ Oxford Cereals

O xford Cereals fills thousands of boxes of cereal during an eight-hour shift. As
the plant operations manager, you are responsible for monitoring the amount of
cereal placed in each box. To be consistent with package labeling, boxes should
contain a mean of 368 grams of cereal. Because of the speed of the process, the
cereal weight varies from box to box, causing some boxes to be underfilled and

others overfilled. If the process is not working properly, the mean weight in the boxes could vary too
much from the label weight of 368 grams to be acceptable.

Because weighing every single box is too time-consuming, costly, and inefficient, you
must take a sample of boxes. For each sample you select, you plan to weigh the

individual boxes and calculate a sample mean. You need to determine the proba-
bility that such a sample mean could have been randomly selected from a

population whose mean is 368 grams. Based on your analysis, you will
have to decide whether to maintain, alter, or shut down the cereal-

filling process.
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I n Chapter 6, you used the normal distribution to study the distribution of video download
times from the OurCampus! website. In this chapter, you need to make a decision about
the cereal-filling process, based on the weights of a sample of cereal boxes packaged at

Oxford Cereals. You will learn different methods of sampling and about sampling distributions
and how to use them to solve business problems.

7.1 Types of Sampling Methods
In Section 1.3, a sample is defined as the portion of a population that has been selected for
analysis. Rather than selecting every item in the population, statistical sampling procedures
focus on collecting a small representative portion of the larger population. The results of the
sample are then used to estimate characteristics of the entire population. There are three main
reasons for selecting a sample:

• Selecting a sample is less time-consuming than selecting every item in the population.
• Selecting a sample is less costly than selecting every item in the population.
• Analyzing a sample is less cumbersome and more practical than analyzing the entire

population.

The sampling process begins by defining the frame, a listing of items that make up the
population. Frames are data sources such as population lists, directories, or maps. Samples are
drawn from frames. Inaccurate or biased results can occur if a frame excludes certain portions
of the population. Using different frames to generate data can lead to different conclusions.

After you select a frame, you draw a sample from the frame. As illustrated in Figure 7.1,
there are two types of samples: nonprobability samples and probability samples.

Types of Samples Used

Nonprobability Samples

Judgment
Sample

Systematic
Sample

Stratified
Sample

Simple
Random
Sample

Cluster
Sample

Probability Samples

Convenience
Sample

F I G U R E 7 . 1
Types of samples

In a nonprobability sample, you select the items or individuals without knowing their
probabilities of selection. Because of this, the theory of statistical inference that has been devel-
oped for probability sampling cannot be applied to nonprobability samples. A common type of
nonprobability sampling is convenience sampling. In convenience sampling, items selected are
easy, inexpensive, or convenient to sample. For example, if you were sampling tires stacked in a
warehouse, it would be much more convenient to sample tires at the top of a stack than tires at
the bottom of a stack. In many cases, participants in the sample select themselves. For example,
many companies conduct surveys by giving visitors to their website the opportunity to complete
survey forms and submit them electronically. The responses to these surveys can provide large
amounts of data quickly and inexpensively, but the sample consists of self-selected web users.
For many studies, only a nonprobability sample such as a judgment sample is available. In a
judgment sample, you get the opinions of preselected experts in the subject matter. Although
the experts may be well informed, you cannot generalize their results to the population.

Nonprobability samples can have certain advantages, such as convenience, speed, and low
cost. However, their lack of accuracy due to selection bias and the fact that the results cannot
be used for statistical inference more than offset these advantages.

In a probability sample, you select items based on known probabilities. Whenever
possible, you should use probability sampling methods. Probability samples allow you to make
inferences about the population of interest. The four types of probability samples most
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commonly used are simple random, systematic, stratified, and cluster samples. These sampling
methods vary in their cost, accuracy, and complexity.

Simple Random Samples
In a simple random sample, every item from a frame has the same chance of selection as
every other item. In addition, every sample of a fixed size has the same chance of selection as
every other sample of that size. Simple random sampling is the most elementary random sam-
pling technique. It forms the basis for the other random sampling techniques.

With simple random sampling, you use n to represent the sample size and N to represent
the frame size. You number every item in the frame from 1 to N. The chance that you will
select any particular member of the frame on the first selection is 

You select samples with replacement or without replacement. Sampling with replacement
means that after you select an item, you return it to the frame, where it has the same probability
of being selected again. Imagine that you have a fishbowl containing N business cards, one card
for each person. On the first selection, you select the card for Judy Craven. You record pertinent
information and replace the business card in the bowl. You then mix up the cards in the bowl and
select a second card. On the second selection, Judy Craven has the same probability of being
selected again, You repeat this process until you have selected the desired sample size, n.

However, usually you do not want the same item to be selected again. Sampling without
replacement means that once you select an item, you cannot select it again. The chance that
you will select any particular item in the frame—for example, the business card for Judy
Craven—on the first selection is The chance that you will select any card not previously
chosen on the second selection is now 1 out of This process continues until you have
selected the desired sample of size n.

Regardless of whether you have sampled with or without replacement, “fishbowl” meth-
ods of sample selection have a major drawback—the ability to thoroughly mix the cards and
randomly select the sample. As a result, fishbowl methods are not very useful. You need to use
less cumbersome and more scientific methods of selection.

One such method uses a table of random numbers (see Table E.1 in Appendix E) for
selecting the sample. A table of random numbers consists of a series of digits listed in a randomly
generated sequence (see reference 8). Because the numeric system uses 10 digits
the chance that you will randomly generate any particular digit is equal to the probability of gen-
erating any other digit. This probability is 1 out of 10. Hence, if you generate a sequence of 800
digits, you would expect about 80 to be the digit 0, 80 to be the digit 1, and so on. Because every
digit or sequence of digits in the table is random, the table can be read either horizontally or verti-
cally. The margins of the table designate row numbers and column numbers. The digits themselves
are grouped into sequences of five in order to make reading the table easier.

To use Table E.1 instead of a fishbowl for selecting the sample, you first need to assign
code numbers to the individual items of the frame. Then you generate the random sample by
reading the table of random numbers and selecting those individuals from the frame whose as-
signed code numbers match the digits found in the table. You can better understand the process
of sample selection by studying Example 7.1.

10, 1, 2, Á , 92,

N - 1.
1>N.

1>N.

1>N.

A company wants to select a sample of 32 full-time workers from a population of 800 full-time
employees in order to collect information on expenditures concerning a company-sponsored
dental plan. How do you select a simple random sample?

SOLUTION The company decides to conduct an e-mail survey. Assuming that not everyone
will respond to the survey, you need to send more than 32 surveys to get the necessary 32 re-
sponses. Assuming that 8 out of 10 full-time workers will respond to such a survey (i.e., a
response rate of 80%), you decide to send 40 surveys. Because you want to send the 40 sur-
veys to 40 different individuals, you should sample without replacement.

The frame consists of a listing of the names and e-mail addresses of all N = 800 full-time
employees taken from the company personnel files. Thus, the frame is a complete listing of the
population. To select the random sample of 40 employees from this frame, you use a table

EXAMPLE 7.1
Selecting a Simple
Random Sample 
by Using a Table
of Random
Numbers
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of random numbers. Because the frame size (800) is a three-digit number, each assigned code
number must also be three digits so that every full-time worker has an equal chance of selection.
You assign a code of 001 to the first full-time employee in the population listing, a code of 002 to
the second full-time employee in the population listing, and so on, until a code of 800 is assigned
to the Nth full-time worker in the listing. Because is the largest possible coded value,
you discard all three-digit code sequences greater than 800 (i.e., 801 through 999 and 000).

To select the simple random sample, you choose an arbitrary starting point from the table
of random numbers. One method you can use is to close your eyes and strike the table of
random numbers with a pencil. Suppose you used this procedure and you selected row 06,
column 05 of Table 7.1 (which is extracted from Table E.1) as the starting point. Although you
can go in any direction, in this example you read the table from left to right, in sequences of
three digits, without skipping.

N = 800

T A B L E 7 . 1

Using a Table of
Random Numbers

Column

00000 00001 11111 11112 22222 22223 33333 33334
Row 12345 67890 12345 67890 12345 67890 12345 67890

01 49280 88924 35779 00283 81163 07275 89863 02348
02 61870 41657 07468 08612 98083 97349 20775 45091
03 43898 65923 25078 86129 78496 97653 91550 08078
04 62993 93912 30454 84598 56095 20664 12872 64647
05 33850 58555 51438 85507 71865 79488 76783 31708

Begin
selection
(row 06,
column 05)

06 97340 03364 88472 04334 63919 36394 11095 92470
07 70543 29776 10087 10072 55980 64688 68239 20461
08 89382 93809 00796 95945 34101 81277 66090 88872
09 37818 72142 67140 50785 22380 16703 53362 44940
10 60430 22834 14130 96593 23298 56203 92671 15925
11 82975 66158 84731 19436 55790 69229 28661 13675
12 39087 71938 40355 54324 08401 26299 49420 59208
13 55700 24586 93247 32596 11865 63397 44251 43189
14 14756 23997 78643 75912 83832 32768 18928 57070
15 32166 53251 70654 92827 63491 04233 33825 69662
16 23236 73751 31888 81718 06546 83246 47651 04877
17 45794 26926 15130 82455 78305 55058 52551 47182
18 09893 20505 14225 68514 46427 56788 96297 78822
19 54382 74598 91499 14523 68479 27686 46162 83554
20 94750 89923 37089 20048 80336 94598 26940 36858
21 70297 34135 53140 33340 42050 82341 44104 82949
22 85157 47954 32979 26575 57600 40881 12250 73742
23 11100 02340 12860 74697 96644 89439 28707 25815
24 36871 50775 30592 57143 17381 68856 25853 35041
25 23913 48357 63308 16090 51690 54607 72407 55538

Source: Data extracted from Rand Corporation, A Million Random Digits with 100,000 Normal Deviates
(Glencoe, IL: The Free Press, 1955) and contained in Table E.1.

The individual with code number 003 is the first full-time employee in the sample (row 06
and columns 05–07), the second individual has code number 364 (row 06 and columns 08–10),
and the third individual has code number 884. Because the highest code for any employee is
800, you discard the number 884. Individuals with code numbers 720, 433, 463, 363, 109, 592,
470, and 705 are selected third through tenth, respectively.

You continue the selection process until you get the required sample size of 40 full-time
employees. If any three-digit sequence repeats during the selection process, you discard the
repeating sequence because you are sampling without replacement.
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Systematic Samples
In a systematic sample, you partition the N items in the frame into n groups of k items, where

You round k to the nearest integer. To select a systematic sample, you choose the first item to
be selected at random from the first k items in the frame. Then, you select the remaining
items by taking every kth item thereafter from the entire frame.

If the frame consists of a listing of prenumbered checks, sales receipts, or invoices, taking
a systematic sample is faster and easier than taking a simple random sample. A systematic
sample is also a convenient mechanism for collecting data from telephone books, class rosters,
and consecutive items coming off an assembly line.

To take a systematic sample of from the population of full-time employ-
ees, you partition the frame of 800 into 40 groups, each of which contains 20 employees. You
then select a random number from the first 20 individuals and include every twentieth individ-
ual after the first selection in the sample. For example, if the first random number you select is
008, your subsequent selections are and 788.

Simple random sampling and systematic sampling are simpler than other, more
sophisticated, probability sampling methods, but they generally require a larger sample size. In
addition, systematic sampling is prone to selection bias. When using systematic sampling, if
there is a pattern in the frame, you could have severe selection biases. To overcome the ineffi-
ciency of simple random sampling and the potential selection bias involved with systematic
sampling, you can use either stratified sampling methods or cluster sampling methods.

Stratified Samples
In a stratified sample, you first subdivide the N items in the frame into separate subpopula-
tions, or strata. A stratum is defined by some common characteristic, such as gender or year
in school. You select a simple random sample within each of the strata and combine the results
from the separate simple random samples. Stratified sampling is more efficient than either
simple random sampling or systematic sampling because you are ensured of the representation
of items across the entire population. The homogeneity of items within each stratum provides
greater precision in the estimates of underlying population parameters.

028, 048, 068, 088, 108, Á , 768,

N = 800n = 40

n - 1

k =
N
n

A company wants to select a sample of 32 full-time workers from a population of 800 full-time
employees in order to estimate expenditures from a company-sponsored dental plan. Of the
full-time employees, 25% are managers and 75% are nonmanagerial workers. How do you
select the stratified sample in order for the sample to represent the correct percentage of man-
agers and nonmanagerial workers?

SOLUTION If you assume an 80% response rate, you need to send 40 surveys to get the nec-
essary 32 responses. The frame consists of a listing of the names and e-mail addresses of all

full-time employees included in the company personnel files. Because 25% of the
full-time employees are managers, you first separate the frame into two strata: a subpopulation
listing of all 200 managerial-level personnel and a separate subpopulation listing of all 600 full-
time nonmanagerial workers. Because the first stratum consists of a listing of 200 managers,
you assign three-digit code numbers from 001 to 200. Because the second stratum contains a
listing of 600 nonmanagerial workers, you assign three-digit code numbers from 001 to 600.

To collect a stratified sample proportional to the sizes of the strata, you select 25% of the
overall sample from the first stratum and 75% of the overall sample from the second stratum.
You take two separate simple random samples, each of which is based on a distinct random
starting point from a table of random numbers (Table E.1). In the first sample, you select
10 managers from the listing of 200 in the first stratum, and in the second sample, you select
30 nonmanagerial workers from the listing of 600 in the second stratum. You then combine the
results to reflect the composition of the entire company.

N = 800

EXAMPLE 7.2
Selecting a
Stratified Sample
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Cluster Samples
In a cluster sample, you divide the N items in the frame into clusters that contain several
items. Clusters are often naturally occurring designations, such as counties, election districts,
city blocks, households, or sales territories. You then take a random sample of one or more
clusters and study all items in each selected cluster.

Cluster sampling is often more cost-effective than simple random sampling, particularly if
the population is spread over a wide geographic region. However, cluster sampling often re-
quires a larger sample size to produce results as precise as those from simple random sampling
or stratified sampling. A detailed discussion of systematic sampling, stratified sampling, and
cluster sampling procedures can be found in reference 1.

Problems for Section 7.1
LEARNING THE BASICS
7.1 For a population containing individuals, what
code number would you assign for
a. the first person on the list?
b. the fortieth person on the list?
c. the last person on the list?

7.2 For a population of verify that by starting in
row 05, column 01 of the table of random numbers (Table
E.1), you need only six rows to select a sample of
without replacement.

7.3 Given a population of starting in row 29, col-
umn 01 of the table of random numbers (Table E.1), and
reading across the row, select a sample of 
a. without replacement.
b. with replacement.

APPLYING THE CONCEPTS
7.4 For a study that consists of personal interviews with
participants (rather than mail or phone surveys), explain
why simple random sampling might be less practical than
some other sampling methods.

7.5 You want to select a random sample of from a pop-
ulation of three items (which are called and C). The rule
for selecting the sample is as follows: Flip a coin; if it is heads,
pick item A; if it is tails, flip the coin again; this time, if it is
heads, choose B; if it is tails, choose C. Explain why this is a
probability sample but not a simple random sample.

7.6 A population has four members (called and D).
You would like to select a random sample of which
you decide to do in the following way: Flip a coin; if it is
heads, the sample will be items A and B; if it is tails, the
sample will be items C and D. Although this is a random
sample, it is not a simple random sample. Explain why.
(Compare the procedure described in Problem 7.5 with the
procedure described in this problem.)

7.7 The registrar of a college with a population of
full-time students is asked by the president to conduct a sur-
vey to measure satisfaction with the quality of life on campus.

N = 4,000

n = 2,
A, B, C,

A, B,
n = 1

N = 15

N = 93,

N = 60

N = 902,

N = 902

Class Designation

Gender Fr. So. Jr. Sr. Total
Female 700 520 500 480 2,200
Male 560 460 400 380 1,800
Total 1,260 980 900 860 4,000

The registrar intends to take a probability sample of
students and project the results from the sample to

the entire population of full-time students.
a. If the frame available from the registrar’s files is an alpha-

betical listing of the names of all registered full-
time students, what type of sample could you take? Discuss.

b. What is the advantage of selecting a simple random
sample in (a)?

c. What is the advantage of selecting a systematic sample in (a)?
d. If the frame available from the registrar’s files is a listing

of the names of all registered full-time stu-
dents compiled from eight separate alphabetical lists,
based on the gender and class designation breakdowns
shown in the class designation table, what type of sample
should you take? Discuss.

e. Suppose that each of the registered full-time
students lived in one of the 10 campus dormitories. Each
dormitory accommodates 400 students. It is college pol-
icy to fully integrate students by gender and class
designation in each dormitory. If the registrar is able to
compile a listing of all students by dormitory, explain
how you could take a cluster sample.

7.8 Prenumbered sales invoices are kept in a
sales journal. The invoices are numbered from

0001 to 5000.
a. Beginning in row 16, column 01, and proceeding hori-

zontally in Table E.1, select a simple random sample of
50 invoice numbers.

b. Select a systematic sample of 50 invoice numbers. Use
the random numbers in row 20, columns 05–07, as the
starting point for your selection.

N = 4,000

N = 4,000

N = 4,000

n = 200

SELF
Test

The following table contains a breakdown of the 4,000 regis-
tered full-time students, by gender and class designation:



7.2 Evaluating Survey Worthiness 255

c. Are the invoices selected in (a) the same as those selected
in (b)? Why or why not?

7.9 Suppose that 5,000 sales invoices are separated into four
strata. Stratum 1 contains 50 invoices, stratum 2 contains 500

invoices, stratum 3 contains 1,000 invoices, and stratum 4 con-
tains 3,450 invoices. A sample of 500 sales invoices is needed.
a. What type of sampling should you do? Why?
b. Explain how you would carry out the sampling according

to the method stated in (a).
c. Why is the sampling in (a) not simple random sampling?

7.2 Evaluating Survey Worthiness
Surveys are used to collect data. Nearly every day, you read or hear about survey or opinion
poll results in newspapers, on the Internet, or on radio or television. To identify surveys that
lack objectivity or credibility, you must critically evaluate what you read and hear by examin-
ing the worthiness of the survey. First, you must evaluate the purpose of the survey, why it was
conducted, and for whom it was conducted.

The second step in evaluating the worthiness of a survey is to determine whether it was
based on a probability or nonprobability sample (as discussed in Section 7.1). You need to
remember that the only way to make valid statistical inferences from a sample to a popula-
tion is through the use of a probability sample. Surveys that use nonprobability sampling
methods are subject to serious, perhaps unintentional, biases that may make the results
meaningless.

Survey Error
Even when surveys use random probability sampling methods, they are subject to potential er-
rors. There are four types of survey errors:

• Coverage error
• Nonresponse error
• Sampling error
• Measurement error

Well-designed surveys reduce or minimize these four types of errors, often at considerable cost.

Coverage Error The key to proper sample selection is having an adequate frame.
Remember that a frame is an up-to-date list of all the items from which you will select the sam-
ple. Coverage error occurs if certain groups of items are excluded from the frame so that they
have no chance of being selected in the sample. Coverage error results in a selection bias. If the
frame is inadequate because certain groups of items in the population were not properly
included, any random probability sample selected will provide only an estimate of the charac-
teristics of the frame, not the actual population.

Nonresponse Error Not everyone is willing to respond to a survey. In fact, research has
shown that individuals in the upper and lower economic classes tend to respond less frequently
to surveys than do people in the middle class. Nonresponse error arises from failure to collect
data on all items in the sample and results in a nonresponse bias. Because you cannot always
assume that persons who do not respond to surveys are similar to those who do, you need to
follow up on the nonresponses after a specified period of time. You should make several
attempts to convince such individuals to complete the survey. The follow-up responses are then
compared to the initial responses in order to make valid inferences from the survey (see refer-
ence 1). The mode of response you use affects the rate of response. Personal interviews and
telephone interviews usually produce a higher response rate than do mail surveys—but at a
higher cost.

Sampling Error As discussed earlier, a sample is selected because it is simpler, less costly,
and more efficient to examine than an entire population. However, chance dictates which indi-
viduals or items will or will not be included in the sample. Sampling error reflects the varia-
tion, or “chance differences,” from sample to sample, based on the probability of particular
individuals or items being selected in the particular samples.

When you read about the results of surveys or polls in newspapers or magazines, there
is often a statement regarding a margin of error, such as “the results of this poll are expected
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to be within percentage points of the actual value.” This margin of error is the sampling
error. You can reduce sampling error by using larger sample sizes, although doing so in-
creases the cost of conducting the survey.

Measurement Error In the practice of good survey research, you design a questionnaire
with the intention of gathering meaningful information. But you have a dilemma here: Getting
meaningful measurements is often easier said than done. Consider the following proverb:

A person with one watch always knows what time it is;

A person with two watches always searches to identify the correct one;

A person with ten watches is always reminded of the difficulty in measuring time.

Unfortunately, the process of measurement is often governed by what is convenient, not
what is needed. The measurements you get are often only a proxy for the ones you really de-
sire. Much attention has been given to measurement error that occurs because of a weakness in
question wording (see reference 2). A question should be clear, not ambiguous. Furthermore,
in order to avoid leading questions, you need to present questions in a neutral manner.

Three sources of measurement error are ambiguous wording of questions, the Hawthorne
effect, and respondent error. As an example of ambiguous wording, several years ago, the U.S. De-
partment of Labor reported that the unemployment rate in the United States had been underesti-
mated for more than a decade because of poor questionnaire wording in the Current Population
Survey. In particular, the wording had led to a significant undercount of women in the labor force.
Because unemployment rates are tied to benefit programs such as state unemployment compensa-
tion, survey researchers had to rectify the situation by adjusting the questionnaire wording.

The Hawthorne effect occurs when a respondent feels obligated to please the interviewer.
Proper interviewer training can minimize the Hawthorne effect.

Respondent error occurs as a result of an overzealous or underzealous effort by the respondent.
You can minimize this error in two ways: (1) by carefully scrutinizing the data and then recontacting
those individuals whose responses seem unusual and (2) by establishing a program of recontacting a
small number of randomly chosen individuals in order to determine the reliability of the responses.

Ethical Issues
Ethical considerations arise with respect to the four types of potential errors that can occur when de-
signing surveys: coverage error, nonresponse error, sampling error, and measurement error. Cover-
age error can result in selection bias and becomes an ethical issue if particular groups or individuals
are purposely excluded from the frame so that the survey results are more favorable to the survey’s
sponsor. Nonresponse error can lead to nonresponse bias and becomes an ethical issue if the spon-
sor knowingly designs the survey so that particular groups or individuals are less likely than others
to respond. Sampling error becomes an ethical issue if the findings are purposely presented without
reference to sample size and margin of error so that the sponsor can promote a viewpoint that might
otherwise be inappropriate. Measurement error becomes an ethical issue in one of three ways: (1) a
survey sponsor chooses leading questions that guide the responses in a particular direction; (2) an
interviewer, through mannerisms and tone, purposely creates a Hawthorne effect or otherwise guides
the responses in a particular direction; or (3) a respondent willfully provides false information.

Ethical issues also arise when the results of nonprobability samples are used to form conclu-
sions about the entire population. When you use a nonprobability sampling method, you need to
explain the sampling procedures and state that the results cannot be generalized beyond the sample.

;4

T H I N K A B O U T T H I S New Media Surveys/Old Sampling Problems

Imagine that you are a software distributor and
you decide to create a “customer experience im-
provement program” that records how your cus-
tomers are using your products, with the goal of
using the collected data to improve your prod-

ucts. Or say that you’re the moderator of an
opinion blog who decides to create an instant
poll to ask your readers about important political
issues. Or you’re a marketer of products aimed
at a specific demographic and decide to create a

page in a social networking site through which
you plan to collect consumer feedback. What
might you have in common with a dead-tree
publication that went out of business over
70 years ago?
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By 1932, before there was ever an Internet—
or even commercial television—a “straw poll”
conducted by the magazine Literary Digest had
successfully predicted five U.S. presidential elec-
tions in a row. For the 1936 election, the maga-
zine promised its largest poll ever and sent about
10 million ballots to people all across the country.
After receiving and tabulating more than 2.3 mil-
lion ballots, the Digest confidently proclaimed that
Alf Landon would be an easy winner over Franklin
D. Roosevelt. As things turned out, FDR won in a
landslide, with Landon receiving the fewest elec-
toral votes in U.S. history. The reputation of the
Literary Digest was ruined; the magazine would
cease publication less than two years later.

The failure of the Literary Digest poll was a
watershed event in the history of sample surveys
and polls. This failure refuted the notion that the
larger the sample is, the better. (Remember this
the next time someone complains about a political
survey’s “small” sample size.) The failure opened
the door to new and more modern methods of
sampling—the theory and concepts this book dis-
cusses in Sections 7.1 and 7.2. Today’s Gallup
polls of political opinion (www.gallup.com) or
Roper (now GfK Roper) Reports about consumer
behavior (www.gfkamerica.com/practice_
areas/roper_consulting/roper_reports) arose,

in part, due to this failure. George Gallup, the
“Gallup” of the poll, and Elmo Roper, of the epony-
mous reports, both first gained widespread public
notice for their correct “scientific” predictions of
the 1936 election.

The failed Literary Digest poll became fod-
der for several postmortems, and the reason for
the failure became almost an urban legend. Typ-
ically, the explanation is coverage error: The bal-
lots were sent mostly to “rich people,” and this
created a frame that excluded poorer citizens
(presumably more inclined to vote for the Demo-
crat Roosevelt than the Republican Landon).
However, later analyses suggest that this was
not true; instead, low rates of response (2.3 mil-
lion ballots represented less than 25% of the
ballots distributed) and/or nonresponse error
(Roosevelt voters were less likely to mail in a
ballot than Landon voters) were significant rea-
sons for the failure (see reference 8).

When Microsoft introduced its new Office
Ribbon interface with Office 2007, a program
manager explained how Microsoft had applied
data collected from its “Customer Experience
Improvement Program” to the redesign of the
user interface. This led others to speculate that
the data were biased toward beginners—who
might be less likely to decline participation in the

program—and that, in turn, had led Microsoft to
make decisions that ended up perplexing more
experienced users. This was another case of
nonresponse error!

The blog moderator’s instant poll mentioned
earlier is targeted to the moderator’s community,
and the social network–based survey is aimed at
“friends” of a product; such polls can also suffer
from nonresponse error, and this fact is often
overlooked by users of these new media. Often,
marketers extol how much they “know” about
survey respondents, thanks to information that
can be “mined” (see Sections 2.7 and 15.7) from
a social network community. But no amount of
information about the respondents can tell mar-
keters who the nonresponders are. Therefore,
new media surveys fall prey to the same old type
of error that may have been fatal to Literary
Digest way back when.

Today, companies establish formal surveys
based on probability sampling and go to great
lengths—and spend large sums—to deal with
coverage error, nonresponse error, sampling er-
ror, and measurement error. Instant polling and
tell-a-friend surveys can be interesting and fun,
but they are not replacements for the methods
discussed in this chapter.

Problems for Section 7.2
APPLYING THE CONCEPTS
7.10 A survey indicates that the vast majority of college
students own their own personal computers. What informa-
tion would you want to know before you accepted the results
of this survey?

7.11 A simple random sample of full-time em-
ployees is selected from a company list containing the
names of all full-time employees in order to
evaluate job satisfaction.
a. Give an example of possible coverage error.
b. Give an example of possible nonresponse error.
c. Give an example of possible sampling error.
d. Give an example of possible measurement error.

7.12 Business Professor Thomas Callarman trav-
eled to China more than a dozen times from 2000

to 2005. He warns people about believing everything they
read about surveys conducted in China and gives two spe-
cific reasons: “First, things are changing so rapidly that
what you hear today may not be true tomorrow. Second, the
people who answer the surveys may tell you what they think
you want to hear, rather than what they really believe”
(T. E. Callarman, “Some Thoughts on China,” Decision
Line, March 2006, pp. 1, 43–44).
a. List the four types of survey error discussed in the para-

graph above.

N = 5,000

n = 300

b. Which of the types of survey error in (a) are the basis for
Professor Callarman’s two reasons to question the
surveys being conducted in China?

7.13 A recent survey of college freshmen investigated the
amount of involvement their parents have with decisions
concerning their education. When asked about the decision
to go to college, 84% said their parents’ involvement was
about right, 10.3% said it was too much, and 5.7% said it
was too little. When it came to selecting individual courses,
72.5% said their parents’ involvement was about right, 3.5%
said it was too much, and 24.0% said it was too little (M. B.
Marklein, “Study: Colleges Shouldn’t Fret Over Hands-on
Parents,” www.usatoday.com, January 23, 2008). What ad-
ditional information would you want to know about the
survey before you accepted the results of the study?

7.14 Recruiters are finding a wealth of unfiltered infor-
mation about candidates on social-networking websites. A
recent survey found that 83% of recruiters use search
engines to learn more about candidates, and 43% elimi-
nated candidates based on information they found (I. Pha-
neuf, “Who’s Googling You?” Job Postings, Spring 2009,
pp. 12–13). What additional information would you want to
know about a survey before you accepted the results of the
study?

SELF
Test

www.gallup.com
www.gfkamerica.com/practice_areas/roper_consulting/roper_reports
www.gfkamerica.com/practice_areas/roper_consulting/roper_reports
www.usatoday.com
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7.3 Sampling Distributions
In many applications, you want to make inferences that are based on statistics calculated from
samples to estimate the values of population parameters. In the next two sections, you will
learn about how the sample mean (a statistic) is used to estimate the population mean (a pa-
rameter) and how the sample proportion (a statistic) is used to estimate the population propor-
tion (a parameter). Your main concern when making a statistical inference is reaching
conclusions about a population, not about a sample. For example, a political pollster is inter-
ested in the sample results only as a way of estimating the actual proportion of the votes that
each candidate will receive from the population of voters. Likewise, as plant operations man-
ager for Oxford Cereals, you are only interested in using the sample mean weight calculated
from a sample of cereal boxes for estimating the mean weight of a population of boxes.

In practice, you select a single random sample of a predetermined size from the popula-
tion. Hypothetically, to use the sample statistic to estimate the population parameter, you could
examine every possible sample of a given size that could occur. A sampling distribution is
the distribution of the results if you actually selected all possible samples. The single result
you obtain in practice is just one of the results in the sampling distribution.

7.4 Sampling Distribution of the Mean
In Chapter 3, several measures of central tendency, including the mean, median, and mode, were
discussed. Undoubtedly, the mean is the most widely used measure of central tendency. The sam-
ple mean is often used to estimate the population mean. The sampling distribution of the mean
is the distribution of all possible sample means if you select all possible samples of a given size.

The Unbiased Property of the Sample Mean
The sample mean is unbiased because the mean of all the possible sample means (of a given
sample size, n) is equal to the population mean, A simple example concerning a population of
four administrative assistants demonstrates this property. Each assistant is asked to apply the
same set of updates to a human resources database. Table 7.2 presents the number of errors made
by each of the administrative assistants. This population distribution is shown in Figure 7.2.

m.

When you have the data from a population, you compute the mean by using Equation (7.1).
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F I G U R E 7 . 2
Number of errors made
by a population of four
administrative assistants

Administrative Assistant Number of Errors

Ann X1 = 3
Bob X2 = 2
Carla X3 = 1
Dave X4 = 4

T A B L E 7 . 2

Number of Errors Made
by Each of Four
Administrative Assistants
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POPULATION MEAN
The population mean is the sum of the values in the population divided by the population
size, N.

(7.1)m =
a
N

i=1
Xi

N

POPULATION STANDARD DEVIATION

(7.2)s = Qa
N

i=1
1Xi - m22

N

You compute the population standard deviation, by using Equation (7.2).s,

Thus, for the data of Table 7.2,

and

If you select samples of two administrative assistants with replacement from this population,
there are 16 possible samples Table 7.3 lists the 16 possible sample out-
comes. If you average all 16 of these sample means, the mean of these values, is equal to 2.5,
which is also the mean of the population, m.

1Nn = 42 = 162.

s = A13 - 2.522 + 12 - 2.522 + 11 - 2.522 + 14 - 2.522
4

= 1.12 errors

m =
3 + 2 + 1 + 4

4
= 2.5 errors

Sample
Administrative

Assistants Sample Outcomes Sample Mean

1 Ann, Ann 3, 3 X1 = 3
2 Ann, Bob 3, 2 X2 = 2.5
3 Ann, Carla 3, 1 X3 = 2
4 Ann, Dave 3, 4 X4 = 3.5
5 Bob, Ann 2, 3 X5 = 2.5
6 Bob, Bob 2, 2 X6 = 2
7 Bob, Carla 2, 1 X7 = 1.5
8 Bob, Dave 2, 4 X8 = 3
9 Carla, Ann 1, 3 X9 = 2

10 Carla, Bob 1, 2 X10 = 1.5
11 Carla, Carla 1, 1 X11 = 1
12 Carla, Dave 1, 4 X12 = 2.5
13 Dave, Ann 4, 3 X13 = 3.5
14 Dave, Bob 4, 2 X14 = 3
15 Dave, Carla 4, 1 X15 = 2.5
16 Dave, Dave 4, 4 X16 = 4

mX = 2.5

T A B L E 7 . 3

All 16 Samples of n = 2
Administrative
Assistants from a
Population of 
N = 4 Administrative
Assistants When
Sampling with
Replacement

Because the mean of the 16 sample means is equal to the population mean, the sample
mean is an unbiased estimator of the population mean. Therefore, although you do not know
how close the sample mean of any particular sample selected comes to the population mean,



F I G U R E 7 . 3
Sampling distribution of
the mean, based on all
possible samples
containing two
administrative assistants
Source: Data are from Table
7.3.
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you are assured that the mean of all the possible sample means that could have been selected is
equal to the population mean.

Standard Error of the Mean
Figure 7.3 illustrates the variation in the sample means when selecting all 16 possible samples.

In this small example, although the sample means vary from sample to sample, depending
on which two administrative assistants are selected, the sample means do not vary as much as the
individual values in the population. That the sample means are less variable than the individual
values in the population follows directly from the fact that each sample mean averages together
all the values in the sample. A population consists of individual outcomes that can take on a wide
range of values, from extremely small to extremely large. However, if a sample contains an ex-
treme value, although this value will have an effect on the sample mean, the effect is reduced be-
cause the value is averaged with all the other values in the sample. As the sample size increases,
the effect of a single extreme value becomes smaller because it is averaged with more values.

The value of the standard deviation of all possible sample means, called the standard er-
ror of the mean, expresses how the sample means vary from sample to sample. As the sample
size increases, the standard error of the mean decreases by a factor equal to the square root of
the sample size.

260 CHAPTER 7 Sampling and Sampling Distributions

Equation (7.3) defines the standard error of the mean when sampling with replacement or
sampling without replacement from large or infinite populations.

Example 7.3 computes the standard error of the mean when the sample selected without
replacement contains less than 5% of the entire population.

Returning to the cereal-filling process described in the Using Statistics scenario on page 249, if
you randomly select a sample of 25 boxes without replacement from the thousands of boxes filled
during a shift, the sample contains much less than 5% of the population. Given that the standard
deviation of the cereal-filling process is 15 grams, compute the standard error of the mean.

SOLUTION Using Equation (7.3) with and the standard error of the mean is

The variation in the sample means for samples of is much less than the variation in the
individual boxes of cereal (i.e., while ).s = 15sX = 3,

n = 25

s
X

=
s1n

=
15125

=
15

5
= 3

s = 15,n = 25

EXAMPLE 7.3
Computing the 
Standard Error
of the Mean

STANDARD ERROR OF THE MEAN
The standard error of the mean, , is equal to the standard deviation in the population,
divided by the square root of the sample size, n.

(7.3)sX =
s1n

s,sX
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Sampling from Normally Distributed Populations
Now that the concept of a sampling distribution has been introduced and the standard error of
the mean has been defined, what distribution will the sample mean, follow? If you are sam-
pling from a population that is normally distributed with mean, and standard deviation,
then regardless of the sample size, n, the sampling distribution of the mean is normally distrib-
uted, with mean, and standard error of the mean, 

In the simplest case, if you take samples of size each possible sample mean is a sin-
gle value from the population because

Therefore, if the population is normally distributed, with mean μ and standard deviation the
sampling distribution for samples of must also follow the normal distribution, with
mean and standard error of the mean In addition, as the sample
size increases, the sampling distribution of the mean still follows a normal distribution, with

but the standard error of the mean decreases, so that a larger proportion of sample
means are closer to the population mean. Figure 7.4 illustrates this reduction in variability.
Note that 500 samples of size 1, 2, 4, 8, 16, and 32 were randomly selected from a normally
distributed population. From the polygons in Figure 7.4, you can see that, although the sam-
pling distribution of the mean is approximately1 normal for each sample size, the sample means
are distributed more tightly around the population mean as the sample size increases.

mX = m,

s
X

= s>11 = s.m
X

= m
n = 1X

s,

X =
a

n

i=1
Xi

n
=

X1

1
= X1

n = 1,
sX = s>1n.mX = m,

s,m,
X,

n = 32

n = 16

n = 8

n = 4

0 Z

n = 2

n = 1

F I G U R E 7 . 4
Sampling distributions 
of the mean from 500
samples of sizes

and 32
selected from a normal
population

n = 1, 2, 4, 8, 16,

To further examine the concept of the sampling distribution of the mean, consider the
Using Statistics scenario described on page 249. The packaging equipment that is filling
368-gram boxes of cereal is set so that the amount of cereal in a box is normally distributed,
with a mean of 368 grams. From past experience, you know the population standard deviation
for this filling process is 15 grams.

1Remember that “only” 500 sam-
ples out of an infinite number of
samples have been selected, so that
the sampling distributions shown
are only approximations of the pop-
ulation distributions.
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If you randomly select a sample of 25 boxes from the many thousands that are filled in
a day and the mean weight is computed for this sample, what type of result could you ex-
pect? For example, do you think that the sample mean could be 368 grams? 200 grams?
365 grams?

The sample acts as a miniature representation of the population, so if the values in the pop-
ulation are normally distributed, the values in the sample should be approximately normally
distributed. Thus, if the population mean is 368 grams, the sample mean has a good chance of
being close to 368 grams.

How can you determine the probability that the sample of 25 boxes will have a mean
below 365 grams? From the normal distribution (Section 6.2), you know that you can find the
area below any value X by converting to standardized Z values:

In the examples in Section 6.2, you studied how any single value, X, differs from the popula-
tion mean. Now, in this example, you want to study how a sample mean, differs from the
population mean. Substituting for for and for in the equation above results in
Equation (7.4).

ssXm,X, m
X

X
X ,

Z =
X - m
s

To find the area below 365 grams, from Equation (7.4),

The area corresponding to in Table E.2 is 0.1587. Therefore, 15.87% of all the pos-
sible samples of 25 boxes have a sample mean below 365 grams.

The preceding statement is not the same as saying that a certain percentage of
individual boxes will contain less than 365 grams of cereal. You compute that percentage
as follows:

The area corresponding to in Table E.2 is 0.4207. Therefore, 42.07% of the
individual boxes are expected to contain less than 365 grams. Comparing these results, you
see that many more individual boxes than sample means are below 365 grams. This result is
explained by the fact that each sample consists of 25 different values, some small and some
large. The averaging process dilutes the importance of any individual value, particularly when
the sample size is large. Thus, the chance that the sample mean of 25 boxes is far away from
the population mean is less than the chance that a single box is far away.

Examples 7.4 and 7.5 show how these results are affected by using different sample
sizes.

Z = -0.20

Z =
X - m
s

=
365 - 368

15
=

-3

15
= -0.20

Z = -1.00

Z = X - mX

s
X

=
365 - 368

15125

=
-3
3

= -1.00

FINDING Z FOR THE SAMPLING DISTRIBUTION OF THE MEAN
The Z value is equal to the difference between the sample mean, , and the population
mean, divided by the standard error of the mean,

(7.4)Z = X - mX

s
X

= X - m
s1n

s
X

.m,
X
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How is the standard error of the mean affected by increasing the sample size from 25 to 100 boxes?

SOLUTION If boxes, then using Equation (7.3) on page 260:

The fourfold increase in the sample size from 25 to 100 reduces the standard error of the mean
by half—from 3 grams to 1.5 grams. This demonstrates that taking a larger sample results in
less variability in the sample means from sample to sample.

s
X

=
s1n

=
151100

=
15
10

= 1.5

n = 100

EXAMPLE 7.4
The Effect of
Sample Size, n, on
the Computation 
of s

X

If you select a sample of 100 boxes, what is the probability that the sample mean is below 365
grams?

SOLUTION Using Equation (7.4) on page 263,

From Table E.2, the area less than is 0.0228. Therefore, 2.28% of the samples of
100 boxes have means below 365 grams, as compared with 15.87% for samples of 25 boxes.

Z = -2.00

Z = X - mX

s
X

=
365 - 368

151100

=
-3
1.5

= -2.00

EXAMPLE 7.5
The Effect of 
Sample Size, n,
on the Clustering 
of Means in the 
Sampling
Distribution

Sometimes you need to find the interval that contains a fixed proportion of the sample
means. To do so, determine a distance below and above the population mean containing a spe-
cific area of the normal curve. From Equation (7.4) on page 262,

Solving for results in Equation (7.5).X

Z =
X - m
s1n

FINDING FOR THE SAMPLING DISTRIBUTION OF THE MEAN

(7.5)X = m + Z
s1n

X

Example 7.6 illustrates the use of Equation (7.5).

In the cereal-filling example, find an interval symmetrically distributed around the population
mean that will include 95% of the sample means, based on samples of 25 boxes.

SOLUTION If 95% of the sample means are in the interval, then 5% are outside the interval.
Divide the 5% into two equal parts of 2.5%. The value of Z in Table E.2 corresponding to an area
of 0.0250 in the lower tail of the normal curve is and the value of Z corresponding to a cu-
mulative area of 0.9750 (i.e., 0.0250 in the upper tail of the normal curve) is The lower
value of (called ) and the upper value of (called ) are found by using Equation (7.5):

Therefore, 95% of all sample means, based on samples of 25 boxes, are between 362.12 and
373.88 grams.

XU = 368 + 11.962 15125
= 368 + 5.88 = 373.88

XL = 368 + 1-1.962 15125
= 368 - 5.88 = 362.12

XUXXLX
+1.96.

-1.96,

EXAMPLE 7.6
Determining the
Interval That 
Includes a Fixed 
Proportion of the
Sample Means
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Sampling from Non-Normally Distributed 
Populations—The Central Limit Theorem
Thus far in this section, only the sampling distribution of the mean for a normally distributed
population has been considered. However, in many instances, either you know that the popula-
tion is not normally distributed or it is unrealistic to assume that the population is normally dis-
tributed. An important theorem in statistics, the Central Limit Theorem, deals with this situation.

THE CENTRAL LIMIT THEOREM
The Central Limit Theorem states that as the sample size (i.e., the number of values in
each sample) gets large enough, the sampling distribution of the mean is approximately
normally distributed. This is true regardless of the shape of the distribution of the individual
values in the population.

What sample size is large enough? A great deal of statistical research has gone into this is-
sue. As a general rule, statisticians have found that for many population distributions, when
the sample size is at least 30, the sampling distribution of the mean is approximately normal.
However, you can apply the Central Limit Theorem for even smaller sample sizes if the popu-
lation distribution is approximately bell-shaped. In the case in which the distribution of a
variable is extremely skewed or has more than one mode, you may need sample sizes larger
than 30 to ensure normality in the sampling distribution of the mean.

Figure 7.5 illustrates the application of the Central Limit Theorem to different populations.
The sampling distributions from three different continuous distributions (normal, uniform, and
exponential) for varying sample sizes are displayed.1n = 2, 5, 302

Population

Values of X

Values of X

Values of X

Values of X
Panel A

Normal Population
Panel B
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Exponential Population
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Values of X Values of X

Values of X Values of X
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Distribution of X

Sampling
Distribution of X

Sampling
Distribution of X
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Distribution of X
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Distribution of X

Sampling
Distribution of X
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n = 2

n = 5

n = 30 n = 30 n = 30

n = 5 n = 5

Sampling
Distribution of X

n = 2

Sampling
Distribution of X

n = 2

F I G U R E 7 . 5
Sampling distribution of
the mean for different
populations for samples
of and 30n = 2, 5,
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Use the Visual Explorations Two Dice Probability proce-
dure to observe the effects of simulated throws on the fre-
quency distribution of the sum of the two dice. Open the
Visual Explorations add-in workbook (see Appendix
Section D.4) and:

1. Select Add-Ins ➔ VisualExplorations ➔ Two Dice
Probability

2. Click the Tally button to tally a set of throws in the
frequency distribution table and histogram. Option-
ally, click the spinner buttons to adjust the number of
throws per tally (round).

3. Repeat step 2 as many times as necessary.
4. Click Finish to end the simulation.

V I S U A L E X P L O R AT I O N S Exploring Sampling Distributions

In each of the panels, because the sample mean is an unbiased estimator of the population
mean, the mean of any sampling distribution is always equal to the mean of the population.

Panel A of Figure 7.5 shows the sampling distribution of the mean selected from a nor-
mal population. As mentioned earlier in this section, when the population is normally dis-
tributed, the sampling distribution of the mean is normally distributed for any sample size.
[You can measure the variability by using the standard error of the mean, Equation (7.3), on
page 260.]

Panel B of Figure 7.5 depicts the sampling distribution from a population with a uniform
(or rectangular) distribution (see Section 6.4). When samples of size are selected, there
is a peaking, or central limiting, effect already working. For the sampling distribution
is bell-shaped and approximately normal. When the sampling distribution looks very
similar to a normal distribution. In general, the larger the sample size, the more closely the
sampling distribution will follow a normal distribution. As with all other cases, the mean of
each sampling distribution is equal to the mean of the population, and the variability decreases
as the sample size increases.

Panel C of Figure 7.5 presents an exponential distribution (see Section 6.5). This popula-
tion is extremely right-skewed. When the sampling distribution is still highly right-
skewed but less so than the distribution of the population. For the sampling distribution
is slightly right-skewed. When the sampling distribution looks approximately normal.
Again, the mean of each sampling distribution is equal to the mean of the population, and the
variability decreases as the sample size increases.

Using the results from the normal, uniform, and exponential distributions, you can reach
the following conclusions regarding the Central Limit Theorem:

• For most population distributions, regardless of shape, the sampling distribution of the
mean is approximately normally distributed if samples of at least size 30 are selected.

• If the population distribution is fairly symmetrical, the sampling distribution of the
mean is approximately normal for samples as small as size 5.

• If the population is normally distributed, the sampling distribution of the mean is nor-
mally distributed, regardless of the sample size.

The Central Limit Theorem is of crucial importance in using statistical inference to reach
conclusions about a population. It allows you to make inferences about the population mean
without having to know the specific shape of the population distribution.

n = 30,
n = 5,

n = 2,

n = 30,
n = 5,

n = 2
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Problems for Section 7.4
LEARNING THE BASICS
7.15 Given a normal distribution with and

if you select a sample of what is the prob-
ability that is
a. less than 95?
b. between 95 and 97.5?
c. above 102.2?
d. There is a 65% chance that is above what value?

7.16 Given a normal distribution with and
if you select a sample of what is the probability
that is
a. less than 47?
b. between 47 and 49.5?
c. above 51.1?
d. There is a 35% chance that is above what value?

APPLYING THE CONCEPTS
7.17 For each of the following three populations, indicate what
the sampling distribution for samples of 25 would consist of:
a. Travel expense vouchers for a university in an academic year
b. Absentee records (days absent per year) in 2010 for em-

ployees of a large manufacturing company.
c. Yearly sales (in gallons) of unleaded gasoline at service

stations located in a particular state.

7.18 The following data represent the number of days absent
per year in a population of six employees of a small company:

a. Assuming that you sample without replacement, select
all possible samples of and construct the sampling
distribution of the mean. Compute the mean of all the
sample means and also compute the population mean.
Are they equal? What is this property called?

b. Repeat (a) for all possible samples of 
c. Compare the shape of the sampling distribution of the

mean in (a) and (b). Which sampling distribution has less
variability? Why?

d. Assuming that you sample with replacement, repeat (a)
through (c) and compare the results. Which sampling distri-
butions have the least variability—those in (a) or (b)? Why?

7.19 The diameter of a brand of Ping-Pong balls is approx-
imately normally distributed, with a mean of 1.30 inches
and a standard deviation of 0.04 inch. If you select a random
sample of 16 Ping-Pong balls,
a. what is the sampling distribution of the mean?

n = 3.

n = 2

1 3 6 7 9 10

X

X
n = 100,

s = 5,m = 50

X

X
n = 25,s = 10,

m = 100

b. what is the probability that the sample mean is less than
1.28 inches?

c. what is the probability that the sample mean is between
1.31 and 1.33 inches?

d. The probability is 60% that the sample mean will be be-
tween what two values, symmetrically distributed around
the population mean?

7.20 The U.S. Census Bureau announced that the median
sales price of new houses sold in 2009 was $215,600, and
the mean sales price was $270,100 (www.census.gov/
newhomesales, March 30, 2010). Assume that the standard
deviation of the prices is $90,000.
a. If you select samples of describe the shape of the

sampling distribution of .
b. If you select samples of describe the shape of

the sampling distribution of .
c. If you select a random sample of what is the prob-

ability that the sample mean will be less than $300,000?
d. If you select a random sample of what is the

probability that the sample mean will be between
$275,000 and $290,000?

7.21 Time spent using e-mail per session is normally dis-
tributed, with minutes and minutes. If you se-
lect a random sample of 25 sessions,
a. what is the probability that the sample mean is between

7.8 and 8.2 minutes?
b. what is the probability that the sample mean is between

7.5 and 8 minutes?
c. If you select a random sample of 100 sessions, what is

the probability that the sample mean is between 7.8 and
8.2 minutes?

d. Explain the difference in the results of (a) and (c).

7.22 The amount of time a bank teller spends with
each customer has a population mean, = 3.10

minutes and a standard deviation, = 0.40 minute. If you
select a random sample of 16 customers,
a. what is the probability that the mean time spent per cus-

tomer is at least 3 minutes?
b. there is an 85% chance that the sample mean is less than

how many minutes?
c. What assumption must you make in order to solve (a)

and (b)?
d. If you select a random sample of 64 customers, there is

an 85% chance that the sample mean is less than how
many minutes?

s,
m,

s = 2m = 8

n = 100,

n = 100,
X

n = 100,
X
n = 2,

7.5 Sampling Distribution of the Proportion
Consider a categorical variable that has only two categories, such as the customer prefers your
brand or the customer prefers the competitor’s brand. You are interested in the proportion of
items belonging to one of the categories—for example, the proportion of customers that prefer

SELF
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your brand. The population proportion, represented by is the proportion of items in the en-
tire population with the characteristic of interest. The sample proportion, represented by p, is
the proportion of items in the sample with the characteristic of interest. The sample propor-
tion, a statistic, is used to estimate the population proportion, a parameter. To calculate the
sample proportion, you assign one of two possible values, 1 or 0, to represent the presence or
absence of the characteristic. You then sum all the 1 and 0 values and divide by n, the sample
size. For example, if, in a sample of five customers, three preferred your brand and two did
not, you have three 1s and two 0s. Summing the three 1s and two 0s and dividing by the sam-
ple size of 5 results in a sample proportion of 0.60.

p,

SAMPLE PROPORTION

(7.6)p =
X
n

=
Number of items having the characteristic of interest

Sample size

The sample proportion, p, will be between 0 and 1. If all items have the characteristic, you
assign each a score of 1, and p is equal to 1. If half the items have the characteristic, you as-
sign half a score of 1 and assign the other half a score of 0, and p is equal to 0.5. If none of the
items have the characteristic, you assign each a score of 0, and p is equal to 0.

In Section 7.4, you learned that the sample mean, is an unbiased estimator of the popu-
lation mean, Similarly, the statistic p is an unbiased estimator of the population proportion,

By analogy to the sampling distribution of the mean, whose standard error is
the standard error of the proportion, is given in Equation (7.7).sp,

sX =
s1n

,p.

m.
X

STANDARD ERROR OF THE PROPORTION

(7.7)sp = Ap11 - p2
n

The sampling distribution of the proportion follows the binomial distribution, as dis-
cussed in Section 5.3 when sampling with replacement (or without replacement from ex-
tremely large populations). However, you can use the normal distribution to approximate the
binomial distribution when and are each at least 5. In most cases in which infer-
ences are made about the proportion, the sample size is substantial enough to meet the condi-
tions for using the normal approximation (see reference 1). Therefore, in many instances, you
can use the normal distribution to estimate the sampling distribution of the proportion.

Substituting p for for and for in Equation (7.4) on page 262

results in Equation (7.8).

s1nAp11 - p2
n

m,X ,p

n11-p2np

FINDING Z FOR THE SAMPLING DISTRIBUTION OF THE PROPORTION

(7.8)Z =
p - p

Ap11 - p2
n

To illustrate the sampling distribution of the proportion, suppose that the manager of the lo-
cal branch of a bank determines that 40% of all depositors have multiple accounts at the bank.
If you select a random sample of 200 depositors, because andnp = 200(0.40) = 80 Ú 5
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the sample size is large enough to assume that the sam-
pling distribution of the proportion is approximately normally distributed. Then, you can
calculate the probability that the sample proportion of depositors with multiple accounts is less
than 0.30 by using Equation (7.8):

Using Table E.2, the area under the normal curve less than is 0.0019. Therefore, if
the population proportion of items of interest is 0.40, only 0.19% of the samples of
would be expected to have sample proportions less than 0.30.

n = 200
-2.89

= -2.89

=
0.30 - 0.40

A10.40210.602
200

=
-0.10

A0.24

200

=
-0.10

0.0346

Z =
p - p

Ap11 - p2
n

n11 - p2 = 20010.602 = 120 Ú 5,

Problems for Section 7.5
LEARNING THE BASICS
7.23 In a random sample of 64 people, 48 are classified as
“successful.”
a. Determine the sample proportion, p, of “successful” people.
b. If the population proportion is 0.70, determine the stan-

dard error of the proportion.

7.24 A random sample of 50 households was selected for
a telephone survey. The key question asked was, “Do you or
any member of your household own a cellular telephone that
you can use to access the Internet?” Of the 50 respondents,
20 said yes and 30 said no.
a. Determine the sample proportion, p, of households with

cellular telephones that can be used to access the Internet.
b. If the population proportion is 0.45, determine the stan-

dard error of the proportion.

7.25 The following data represent the responses (Y for yes
and N for no) from a sample of 40 college students to the
question “Do you currently own shares in any stocks?”

on election night. Assuming a two-candidate election, if a
specific candidate receives at least 55% of the vote in the
sample, that candidate will be forecast as the winner of the
election. If you select a random sample of 100 voters, what
is the probability that a candidate will be forecast as the
winner when
a. the population percentage of her vote is 50.1%?
b. the population percentage of her vote is 60%?
c. the population percentage of her vote is 49% (and she

will actually lose the election)?
d. If the sample size is increased to 400, what are your

answers to (a) through (c)? Discuss.

7.27 You plan to conduct a marketing experiment in which
students are to taste one of two different brands of soft
drink. Their task is to correctly identify the brand tasted.
You select a random sample of 200 students and assume that
the students have no ability to distinguish between the two
brands. (Hint: If an individual has no ability to distinguish
between the two soft drinks, then the two brands are equally
likely to be selected.)
a. What is the probability that the sample will have between

50% and 60% of the identifications correct?
b. The probability is 90% that the sample percentage is con-

tained within what symmetrical limits of the population
percentage?

c. What is the probability that the sample percentage of cor-
rect identifications is greater than 65%?

d. Which is more likely to occur—more than 60% correct
identifications in the sample of 200 or more than 55%
correct identifications in a sample of 1,000? Explain.

N N Y N N Y N Y N Y N N Y N Y Y N N N Y
N Y N N N N Y N N Y Y N N N Y N N Y N N

a. Determine the sample proportion, p, of college students
who own shares of stock.

b. If the population proportion is 0.30, determine the stan-
dard error of the proportion.

APPLYING THE CONCEPTS
7.26 A political pollster is conducting an analy-
sis of sample results in order to make predictions

SELF
Test
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7.28 In a recent survey of full-time female workers ages 22
to 35 years, 46% said that they would rather give up some of
their salary for more personal time. (Data extracted from
“I’d Rather Give Up,” USA Today, March 4, 2010, p. 1B.)
Suppose you select a sample of 100 full-time female work-
ers 22 to 35 years old.
a. What is the probability that in the sample, fewer than

50% would rather give up some of their salary for more
personal time?

b. What is the probability that in the sample, between 40%
and 50% would rather give up some of their salary for
more personal time?

c. What is the probability that in the sample, more than
40% would rather give up some of their salary for more
personal time?

d. If a sample of 400 is taken, how does this change your
answers to (a) through (c)?

7.29 Companies often make flextime scheduling available
to help recruit and keep female employees who have chil-
dren. Other workers sometimes view these flextime sched-
ules as unfair. An article in USA Today indicates that 25% of
male employees state that they have to pick up the slack for
moms working flextime schedules. (Data extracted from D.
Jones, “Poll Finds Resentment of Flextime,” www.usato-
day.com, May 11, 2007.) Suppose you select a random sam-
ple of 100 male employees working for companies offering
flextime.
a. What is the probability that 25% or fewer male employ-

ees will indicate that they have to pick up the slack for
moms working flextime?

b. What is the probability that 20% or fewer male employ-
ees will indicate that they have to pick up the slack for
moms working flextime?

c. If a random sample of 500 is taken, how does this change
your answers to (a) and (b)?

7.30 According to Gallup’s poll on consumer behavior,
36% of Americans say they will consider only cars manufac-
tured by an American company when purchasing a new car.
(Data extracted from The Gallup Poll, www.gallup.com,
March 31, 2010.) If you select a random sample of
200 Americans,
a. what is the probability that the sample will have between

30% and 40% who say they will consider only cars man-
ufactured by an American company when purchasing a
new car?

b. the probability is 90% that the sample percentage will be
contained within what symmetrical limits of the popula-
tion percentage?

c. the probability is 95% that the sample percentage will be
contained within what symmetrical limits of the popula-
tion percentage?

7.31 The Agency for Healthcare Research and Quality re-
ports that medical errors are responsible for injury to 1 out
of every 25 hospital patients in the United States. (Data ex-
tracted from M. Ozan-Rafferty, “Hospitals: Never Have a
Never Event,” The Gallup Management Journal, gmj.
gallup.com, May 7, 2009.) These errors are tragic and ex-
pensive. Preventable health care–related errors cost an esti-
mated $29 billion each year in the United States. Suppose
that you select a sample of 100 U.S. hospital patients.
a. What is the probability that the sample percentage reporting

injury due to medical errors will be between 5% and 10%?
b. The probability is 90% that the sample percentage will be

within what symmetrical limits of the population
percentage?

c. The probability is 95% that the sample percentage will
be within what symmetrical limits of the population
percentage?

d. Suppose you selected a sample of 400 U.S. hospital
patients. How does this change your answers in (a)
through (c)?

7.32 A survey of 2,250 American adults reported that 59%
got news both online and offline in a typical day. (Data ex-
tracted from “How Americans Get News in a Typical Day,”
USA Today, March 10, 2010, p. 1A.)
a. Suppose that you take a sample of 100 American adults.

If the population proportion of American adults who get
news both online and offline in a typical day is 0.59,
what is the probability that fewer than half in your
sample will get news both online and offline in a typi-
cal day?

b. Suppose that you take a sample of 500 American adults.
If the population proportion of American adults who get
news both online and offline in a typical day is 0.59,
what is the probability that fewer than half in your sam-
ple will get news both online and offline in a typical
day?

c. Discuss the effect of sample size on the sampling distri-
bution of the proportion in general and the effect on the
probabilities in (a) and (b).

7.6 Online Topic: Sampling from Finite Populations
In this section, sampling without replacement from finite populations is discussed. To study this
topic, read the Section 7.6 online topic file that is available on this book’s companion website.
(See Appendix C to learn how to access the online topic files.)

www.usatoday.com
www.usatoday.com
www.gallup.com
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S U M M A R Y
You have learned that in many business situations, the pop-
ulation is so large that you cannot gather information on
every item. Instead, statistical sampling procedures focus on
selecting a small representative group of the larger popula-
tion. The results of the sample are then used to estimate
characteristics of the entire population. Selecting a sample
is less time-consuming, less costly, and more practical than
analyzing the entire population.

In this chapter, you studied four common probability
sampling methods—simple random, systematic, stratified,

and cluster sampling. You also studied the sampling distri-
bution of the sample mean and the sampling distribution of
the sample proportion and their relationship to the Central
Limit Theorem. You learned that the sample mean is an un-
biased estimator of the population mean, and the sample
proportion is an unbiased estimator of the population pro-
portion. In the next five chapters, the techniques of confi-
dence intervals and tests of hypotheses commonly used for
statistical inference are discussed.

K E Y E Q U AT I O N S
Population Mean

(7.1)

Population Standard Deviation

(7.2)

Standard Error of the Mean

(7.3)

Finding Z for the Sampling Distribution of the Mean

(7.4)
Z =

X - mX

sX

=
X - m
s1n

s
X =

s1n

s = Qa
N

i=1
1Xi - m22

N

m =
a
N

i=1
Xi

N

Finding for the Sampling Distribution of the Mean

(7.5)

Sample Proportion

(7.6)

Standard Error of the Proportion

(7.7)

Finding Z for the Sampling Distribution of the Proportion

(7.8)Z =
p - p

Ap11 - p2
n

sp = Ap11 - p2
n

p =
X
n

X = m + Z
s1n

X

As the plant operations manager for Oxfords Cereals, you were
responsible for monitoring the amount of cereal placed in each
box. To be consistent with package labeling, boxes should
contain a mean of 368 grams of cereal. Thousands of boxes

are produced during a shift, and weighing every single box was determined
to be too time-consuming, costly, and inefficient. Instead, a sample of boxes

was selected. Based on your analysis of the sample, you had to decide whether to maintain,
alter, or shut down the process.

Using the concept of the sampling distribution of the mean, you were able to determine prob-
abilities that such a sample mean could have been randomly selected from a population with a
mean of 368 grams. Specifically, if a sample of size is selected from a population with a
mean of 368 and standard deviation of 15, you calculated the probability of selecting a sample
with a mean of 365 grams or less to be 15.87%. If a larger sample size is selected, the sample mean
should be closer to the population mean. This result was illustrated when you calculated the prob-
ability if the sample size were increased to Using the larger sample size, you determined
the probability of selecting a sample with a mean of 365 grams or less to be 2.28%.

n = 100.

n = 25

U S I N G S TAT I S T I C S @ Oxford Cereals Revisited
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K E Y T E R M S
Central Limit Theorem 264
cluster 254
cluster sample 254
convenience sampling 250
coverage error 255
frame 250
judgment sample 250
margin of error 256
measurement error 256
nonprobability sample 250

nonresponse bias 255
nonresponse error 255
probability sample 250
sampling distribution 258
sampling distribution of the mean 258
sampling distribution of the

proportion 267
sampling error 255
sampling with replacement 251
sampling without replacement 251

selection bias 255
simple random sample 251
standard error of the mean 260
standard error of the proportion 267
strata 253
stratified sample 253
systematic sample 253
table of random numbers 251
unbiased 258

C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING
7.33 Why is the sample mean an unbiased estimator of the
population mean?

7.34 Why does the standard error of the mean decrease as
the sample size, n, increases?

7.35 Why does the sampling distribution of the mean follow
a normal distribution for a large enough sample size, even
though the population may not be normally distributed?

7.36 What is the difference between a population distribu-
tion and a sampling distribution?

7.37 Under what circumstances does the sampling
distribution of the proportion approximately follow the nor-
mal distribution?

7.38 What is the difference between probability sampling
and nonprobability sampling?

7.39 What are some potential problems with using “fish-
bowl” methods to select a simple random sample?

7.40 What is the difference between sampling with
replacement versus sampling without replacement?

7.41 What is the difference between a simple random sam-
ple and a systematic sample?

7.42 What is the difference between a simple random
sample and a stratified sample?

7.43 What is the difference between a stratified sample
and a cluster sample?

APPLYING THE CONCEPTS
7.44 An industrial sewing machine uses ball bearings that
are targeted to have a diameter of 0.75 inch. The lower and
upper specification limits under which the ball bearing can
operate are 0.74 inch (lower) and 0.76 inch (upper). Past

experience has indicated that the actual diameter of the ball
bearings is approximately normally distributed, with a mean
of 0.753 inch and a standard deviation of 0.004 inch. If you
select a random sample of 25 ball bearings, what is the
probability that the sample mean is
a. between the target and the population mean of 0.753?
b. between the lower specification limit and the target?
c. greater than the upper specification limit?
d. less than the lower specification limit?
e. The probability is 93% that the sample mean diameter

will be greater than what value?

7.45 The fill amount of bottles of a soft drink is normally
distributed, with a mean of 2.0 liters and a standard devia-
tion of 0.05 liter. If you select a random sample of 25 bot-
tles, what is the probability that the sample mean will be
a. between 1.99 and 2.0 liters?
b. below 1.98 liters?
c. greater than 2.01 liters?
d. The probability is 99% that the sample mean amount of

soft drink will be at least how much?
e. The probability is 99% that the sample mean amount of soft

drink will be between which two values (symmetrically dis-
tributed around the mean)?

7.46 An orange juice producer buys oranges from a large
orange grove that has one variety of orange. The amount of
juice squeezed from these oranges is approximately nor-
mally distributed, with a mean of 4.70 ounces and a standard
deviation of 0.40 ounce. Suppose that you select a sample of
25 oranges.
a. What is the probability that the sample mean amount of

juice will be at least 4.60 ounces?
b. The probability is 70% that the sample mean amount

of juice will be contained between what two values sym-
metrically distributed around the population mean?

c. The probability is 77% that the sample mean amount of
juice will be greater than what value?
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7.47 In Problem 7.46, suppose that the mean amount
of juice squeezed is 5.0 ounces.
a. What is the probability that the sample mean amount of

juice will be at least 4.60 ounces?
b. The probability is 70% that the sample mean amount of

juice will be contained between what two values symmet-
rically distributed around the population mean?

c. The probability is 77% that the sample mean amount of
juice will be greater than what value?

7.48 Junk bonds reported strong returns in 2009. The
population of junk bonds earned a mean return of 57.5%
in 2009. (Data extracted from The Wall Street Journal,
January 4, 2010, p. R1.) Assume that the returns for junk
bonds were distributed as a normal random variable, with
a mean of 57.5 and a standard deviation of 20. If you se-
lected a random sample of 16 junk bonds from this popu-
lation, what is the probability that the sample would have
a mean return
a. less than 50?
b. between 40 and 60?
c. greater than 40?

7.49 The article mentioned in Problem 7.48 reported that
Treasury bonds had a mean return of -9.3% in 2009. As-
sume that the returns for the Treasury bonds were distrib-
uted as a normal random variable, with a mean of -9.3 and
a standard deviation of 10. If you select an individual Trea-
sury bond from this population, what is the probability that
it would have a return
a. less than 0 (i.e., a loss)?
b. between -10 and -20?
c. greater than 5?
If you selected a random sample of four Treasury bonds
from this population, what is the probability that the sample
would have a mean return
d. less than 0—that is, a loss?
e. between -10 and -20?
f. greater than 5?
g. Compare your results in parts (d) through (f) to those in

(a) through (c).

7.50 (Class Project) The table of random numbers is an
example of a uniform distribution because each digit is
equally likely to occur. Starting in the row corresponding
to the day of the month in which you were born, use the
table of random numbers (Table E.1) to take one digit at a
time.

Select five different samples each of and
Compute the sample mean of each sample. De-

velop a frequency distribution of the sample means for the
results of the entire class, based on samples of sizes

and
What can be said about the shape of the sampling dis-

tribution for each of these sample sizes?

n = 10.n = 2, n = 5,

n = 10.
n = 2, n = 5,

Number of Cars Probability

0 0.25
1 0.40
2 0.20
3 0.10
4 0.04
5 0.01

You can use the table of random numbers (Table E.1) to se-
lect samples from this distribution by assigning numbers as
follows:
1. Start in the row corresponding to the day of the month in

which you were born.
2. Select a two-digit random number.
3. If you select a random number from 00 to 24, record a

length of 0; if from 25 to 64, record a length of 1; if from
65 to 84, record a length of 2; if from 85 to 94, record a
length of 3; if from 95 to 98, record a length of 4; if 99,
record a length of 5.

Select samples of and Compute
the mean for each sample. For example, if a sample of size
2 results in the random numbers 18 and 46, these would cor-
respond to lengths 0 and 1, respectively, producing a sample
mean of 0.5. If each student selects five different samples
for each sample size, a frequency distribution of the sample
means (for each sample size) can be developed from the re-
sults of the entire class. What conclusions can you reach
concerning the sampling distribution of the mean as the
sample size is increased?

7.53 (Class Project) Using Table E.1, simulate the selec-
tion of different-colored balls from a bowl, as follows:

1. Start in the row corresponding to the day of the month
in which you were born.
2. Select one-digit numbers.
3. If a random digit between 0 and 6 is selected, consider
the ball white; if a random digit is a 7, 8, or 9, consider
the ball red.

Select samples of and digits.
In each sample, count the number of white balls and com-
pute the proportion of white balls in the sample. If each stu-
dent in the class selects five different samples for each
sample size, a frequency distribution of the proportion of

n = 50n = 10, n = 25,

n = 10.n = 2, n = 5,

7.51 (Class Project) Toss a coin 10 times and record the
number of heads. If each student performs this experiment
five times, a frequency distribution of the number of
heads can be developed from the results of the entire
class. Does this distribution seem to approximate the
normal distribution?

7.52 (Class Project) The number of cars waiting in line at
a car wash is distributed as follows:
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M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
Continuing the quality improvement effort first described in
the Chapter 6 Managing Ashland MultiComm Services case,
the target upload speed for AMS Internet service subscribers
has been monitored. As before, upload speeds are measured
on a standard scale in which the target value is 1.0. Data col-
lected over the past year indicate that the upload speeds are
approximately normally distributed, with a mean of 1.005
and a standard deviation of 0.10.

EXERCISE

1. Each day, at 25 random times, the upload speed is meas-
ured. Assuming that the distribution has not changed

from what it was in the past year, what is the probability
that the upload speed is
a. less than 1.0?
b. between 0.95 and 1.0?
c. between 1.0 and 1.05?
d. less than 0.95 or greater than 1.05?
e. Suppose that the mean upload speed of today’s sample

of 25 is 0.952. What conclusion can you reach about
the upload speed today based on this result? Explain.

2. Compare the results of AMS1 (a) through (d) to those of
AMS1. in Chapter 6 on page 244. What conclusions can
you reach concerning the differences?

D I G I TA L C A S E
Apply your knowledge about sampling distributions in this
Digital Case, which reconsiders the Oxford Cereals Using
Statistics scenario.

The advocacy group Consumers Concerned About Cereal
Cheaters (CCACC) suspects that cereal companies,
including Oxford Cereals, are cheating consumers by pack-
aging cereals at less than labeled weights. Recently, the
group investigated the package weights of two popular
Oxford brand cereals. Open CCACC.pdf to examine the
group’s claims and supporting data, and then answer the
following questions:
1. Are the data collection procedures that the CCACC uses

to form its conclusions flawed? What procedures could
the group follow to make its analysis more rigorous?

2. Assume that the two samples of five cereal boxes (one
sample for each of two cereal varieties) listed on the
CCACC website were collected randomly by
organization members. For each sample, do the
following:

a. Calculate the sample mean.
b. Assume that the standard deviation of the process is 15
grams and the population mean is 368 grams. Calculate
the percentage of all samples for each process that have a
sample mean less than the value you calculated in (a).
c. Again, assuming that the standard deviation is 15
grams, calculate the percentage of individual boxes of ce-
real that have a weight less than the value you calculated
in (a).

3. What, if any, conclusions can you form by using your
calculations about the filling processes for the two differ-
ent cereals?

4. A representative from Oxford Cereals has asked that the
CCACC take down its page discussing shortages in Ox-
ford Cereals boxes. Is that request reasonable? Why or
why not?

5. Can the techniques discussed in this chapter be used to
prove cheating in the manner alleged by the CCACC?
Why or why not?

white balls (for each sample size) can be developed from the
results of the entire class. What conclusions can you reach
about the sampling distribution of the proportion as the
sample size is increased?

7.54 (Class Project) Suppose that step 3 of Problem
7.53 uses the following rule: “If a random digit between

0 and 8 is selected, consider the ball to be white; if a ran-
dom digit of 9 is selected, consider the ball to be red.”
Compare and contrast the results in this problem and
those in Problem 7.53.
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EG7.1 TYPES OF SAMPLING METHODS

Simple Random Samples

PHStat2 Use Random Sample Generation to create a
random sample without replacement. For example, to select
the Example 7.1 sample of 40 workers on page 251, select
PHStat ➔ Sampling ➔ Random Sample Generation. In
the procedure’s dialog box (shown below):

1. Enter 40 as the Sample Size.

2. Click Generate list of random numbers and enter 800
as the Population Size.

3. Enter a Title and click OK.

contains a column heading in cell A1, select Data ➔ Data
Analysis. In the Data Analysis dialog box, select Sampling
from the Analysis Tools list and then click OK. In the pro-
cedure’s dialog box (see below):

1. Enter A1:A201 as the Input Range and check Labels.

2. Click Random and enter 20 as the Number of
Samples.

3. Click New Worksheet Ply and then click OK.

C H A P T E R 7 E X C E L G U I D E

In-Depth Excel Use the RANDBETWEEN worksheet
function to select a random integer that can be used to se-
lect an item from a frame. Enter the function as RAND-
BETWEEN(1, population size).

Use the COMPUTE worksheet of the Random
workbook as a template for creating a random sample.
This worksheet contains 40 copies of the formula
=RANDBETWEEN(1, 800) in column B and provides an
alternative way to selecting the sample desired in Example
7.1 on page 251. Because the RANDBETWEEN function
samples with replacement, add additional copies of the for-
mula in new column B rows until you have the sample size
without replacement that Example 7.1 needs.

Analysis ToolPak Use Sampling to create a random sam-
ple with replacement. For example, to select a random sam-
ple of n = 20 from a cell range A1:A201 of 200 values that

EG7.2 EVALUATING SURVEY WORTHINESS

There are no Excel Guide instructions for this section.

EG7.3 SAMPLING DISTRIBUTIONS

There are no Excel Guide instructions for this section.

EG7.4 SAMPLING DISTRIBUTION of the
MEAN

PHStat2 Use Sampling Distributions Simulation to cre-
ate a simulated sampling distribution. For example, to cre-
ate 100 samples of n = 30 from a uniformly distributed
population, select PHStat ➔ Sampling ➔ Sampling Dis-
tributions Simulation. In the procedure’s dialog box
(shown at the top of page 276):

1. Enter 100 as the Number of Samples.

2. Enter 30 as the Sample Size.

3. Click Uniform.

4. Enter a Title and click OK.



The sample means, overall mean, and standard error of
the mean can be found starting in row 34 of the worksheet
that the procedure creates.

Analysis ToolPak Use Random Number Generation to
create a simulated sampling distribution. For example, to
create 100 samples of sample size 30 from a uniformly dis-
tributed population, select Data ➔ Data Analysis. In the
Data Analysis dialog box, select Random Number Genera-
tion from the Analysis Tools list and then click OK. In the
procedure’s dialog box (shown at the top of the next column):

1. Enter 100 as the Number of Variables

2. Enter 30 as the Number of Random Numbers.

3. Select Uniform from the Distribution drop-down list.

4. Keep the Parameters values as is.

5. Click New Worksheet Ply and then click OK.

Use the formulas that appear in rows 35 through 39 in
the SDS_FORMULAS worksheet of the SDS workbook
as models if you want to compute sample means, the overall
mean, and the standard error of the mean.

If, for other problems, you select Discrete in step 3,
you must be open to a worksheet that contains a cell
range of X and values. Enter this cell range as the
Value and Probability Input Range (not shown when
Uniform has been selected) in the Parameters section of
the dialog box.

EG7.5 SAMPLING DISTRIBUTION of the
PROPORTION

There are no Excel Guide instructions for this section.

P1X2

MG7.1 TYPES OF SAMPLING METHODS

Simple Random Samples

Use Sample From Columns to create a random sample
with or without replacement. For example, to select the Ex-
ample 7.1 sample of 40 workers on page 251, first create the
list of 800 employee numbers in column C1. Select Calc ➔
Make Patterned Data ➔ Simple Set of Numbers. In the
Simple Set of Numbers dialog box (shown at right):

1. Enter C1 in the Store patterned data in box.

2. Enter 1 in the From first value box.

3. Enter 800 in the To last value box.

4. Click OK.

C H A P T E R 7 M I N I TA B G U I D E

With the worksheet containing the column C1 list still open:

5. Select Calc ➔ Random Data ➔ Sample from
Columns.

276 CHAPTER 7 Sampling and Sampling Distributions
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In the Sample From Columns dialog box (shown below):

6. Enter 40 in the Number of rows to sample box.

7. Enter C1 in the From columns box.

8. Enter C2 in the Store samples in box.

9. Click OK.

the worksheet with the 100 samples, enter Sample Means
as the name of column C31. Select Calc ➔ Row Statistics.
In the Row Statistics dialog box (shown below):

6. Click Mean.

7. Enter C1-C30 in the Input variables box.

8. Enter C31 in the Store result in box.

9. Click OK.

MG7.2 EVALUATING SURVEY WORTHINESS

There are no Minitab Guide instructions for this section.

MG7.3 SAMPLING DISTRIBUTIONS

There are no Minitab Guide instructions for this section.

MG7.4 SAMPLING DISTRIBUTION of the
MEAN

Use Uniform to create a simulated sampling distribution
from a uniformly distributed population. For example, to
create 100 samples of n = 30 from a uniformly distributed
population, open to a new, empty worksheet. Select Calc ➔
Random Data ➔ Uniform. In the Uniform Distribution di-
alog box (shown below):

1. Enter 100 in the Number of rows of data to generate box.

2. Enter C1-C30 in the Store in column(s) box (to store
the results in the first 30 columns).

3. Enter 0.0 in the Lower endpoint box.

4. Enter 1.0 in the Upper endpoint box.

5. Click OK.

10. With the mean for each of the 100 row-wise samples in
column C31, select Stat ➔ Basic Statistics ➔ Display
Descriptive Statistics.

11. In the Display Descriptive Statistics dialog box, enter
C31 in the Variables box and click Statistics.

12. In the Display Descriptive Statistics - Statistics dialog
box, select Mean and Standard deviation and then
click OK.

13. Back in the Display Descriptive Statistics dialog box,
click OK.

While still open to the worksheet created in steps 1 through 13,
select Graph ➔ Histogram and in the Histograms dialog box,
click Simple and then click OK. In the Histogram - Simple
dialog box:

1. Enter C31 in the Graph variables box.

2. Click OK.

Sampling from Normally Distributed Populations

Use Normal to create a simulated sampling distribution from
a normally distributed population. For example, to create 100
samples of n = 30 from a normally distributed population,
open to a new, empty worksheet. Select Calc ➔ Random
Data ➔ Normal. In the Normal Distribution dialog box:

1. Enter 100 in the Number of rows of data to generate box.

2. Enter C1-C30 in the Store in column(s) box (to store
the results in the first 30 columns).

3. Enter a value for μ in the Mean box.

4. Enter a value for σ in the Standard deviation box.

5. Click OK.

The 100 samples of n = 30 are entered row-wise in columns
C1 through C30. To compute statistics, select Calc ➔ Row
Statistics and follow steps 6 through 13 from the set of in-
structions for a uniformly distributed population.

The 100 samples of n = 30 are entered row-wise in
columns C1 through C30, an exception to the rule used in
this book to enter data column-wise. (Row-wise data
facilitates the computation of means.) While still opened to
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Learning Objectives
In this chapter, you learn:

• To construct and interpret confidence interval estimates for the mean and the
proportion

• How to determine the sample size necessary to develop a confidence interval
estimate for the mean or proportion

• How to use confidence interval estimates in auditing
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U S I N G S TAT I S T I C S

@ Saxon Home Improvement

Saxon Home Improvement distributes home improvement supplies in the northeastern
United States. As a company accountant, you are responsible for the accuracy of the
integrated inventory management and sales information system. You could review the
contents of each and every record to check the accuracy of this system, but such a
detailed review would be time-consuming and costly. A better approach is to use statisti-

cal inference techniques to draw conclusions about the population of all records from a relatively small
sample collected during an audit. At the end of each month, you could select a sample of the sales
invoices to estimate the following:

� The mean dollar amount listed on the sales invoices for the month
� The proportion of invoices that contain errors that violate the internal control policy of the

warehouse
� The total dollar amount listed on the sales invoices for the month
� Any differences between the dollar amounts on the sales invoices and the amounts entered into the

sales information system

How accurate are the results from the sample, and how do you use this information? Is the sample size
large enough to give you the information you need?

279
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I n Section 7.4, you used the Central Limit Theorem and knowledge of the population distri-
bution to determine the percentage of sample means that are within certain distances of the
population mean. For instance, in the cereal-filling example used throughout Chapter 7

(see Example 7.6 on page 263), you can conclude that 95% of all sample means are between
362.12 and 373.88 grams. This is an example of deductive reasoning because the conclusion is
based on taking something that is true in general (for the population) and applying it to some-
thing specific (the sample means).

Getting the results that Saxon Home Improvement needs requires inductive reasoning. In-
ductive reasoning lets you use some specifics to make broader generalizations. You cannot
guarantee that the broader generalizations are absolutely correct, but with a careful choice of
the specifics and a rigorous methodology, you can get useful conclusions. As a Saxon account-
ant, you need to use inferential statistics, which uses sample results (the “some specifics”) to
estimate (the making of “broader generalizations”) unknown population parameters such as a
population mean or a population proportion. Note that statisticians use the word estimate in
the same sense of the everyday usage: something you are reasonably certain about but cannot
flatly say is absolutely correct.

You estimate population parameters by using either point estimates or interval estimates.
A point estimate is the value of a single sample statistic, such as a sample mean. A confidence
interval estimate is a range of numbers, called an interval, constructed around the point esti-
mate. The confidence interval is constructed such that the probability that the interval includes
the population parameter is known.

Suppose you want to estimate the mean GPA of all the students at your university. The
mean GPA for all the students is an unknown population mean, denoted by You select a
sample of students and compute the sample mean, denoted by to be 2.80. As a point esti-
mate of the population mean, you ask how accurate is the 2.80 value as an estimate of the
population mean, By taking into account the variability from sample to sample (see Sec-
tion 7.4, concerning the sampling distribution of the mean), you can construct a confidence in-
terval estimate for the population mean to answer this question.

When you construct a confidence interval estimate, you indicate the confidence of cor-
rectly estimating the value of the population parameter, This allows you to say that there is
a specified confidence that is somewhere in the range of numbers defined by the interval.

After studying this chapter, you might find that a 95% confidence interval for the mean
GPA at your university is You can interpret this interval estimate by stat-
ing that you are 95% confident that the mean GPA at your university is between 2.75 and 2.85.

In this chapter, you learn to construct a confidence interval for both the population mean
and population proportion. You also learn how to determine the sample size that is necessary
to construct a confidence interval of a desired width.

12.75 … m … 2.852.
m

m.

m?
m,

X ,
m.

8.1 Confidence Interval Estimate for the Mean ( Known)s
In Section 7.4, you used the Central Limit Theorem and knowledge of the population distribu-
tion to determine the percentage of sample means that are within certain distances of the pop-
ulation mean. Suppose that in the cereal-filling example, you wished to estimate the
population mean, using the information from a single sample. Thus, rather than taking

to find the upper and lower limits around as in Section 7.4, you substi-
tute the sample mean, for the unknown and use as an interval to
estimate the unknown Although in practice you select a single sample of n values and com-
pute the mean, in order to understand the full meaning of the interval estimate, you need to
examine a hypothetical set of all possible samples of n values.

Suppose that a sample of boxes has a mean of 362.3 grams. The interval devel-
oped to estimate is or The estimate of is

356.42 … m … 368.18

m362.3 ; 5.88.362.3 ; 11.9621152>11252m

n = 25

X ,
m.

X ; 11.9621s>1n2mX ,
m,m ; 11.9621s>1n2
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368

368.18362.3356.42
X1 = 362.3

362.12 373.88

375.38369.5363.62

365.88360354.12

368362.12356.24

379.76373.88368

X2 = 369.5

X3 = 360

X4 = 362.12

X5 = 373.88

F I G U R E 8 . 1
Confidence interval
estimates for five
different samples of

taken from a
population where

and s = 15m = 368

n = 25

Because the population mean, (equal to 368), is included within the interval, this sample
results in a correct statement about (see Figure 8.1).m

m

To continue this hypothetical example, suppose that for a different sample of
boxes, the mean is 369.5. The interval developed from this sample is

or The estimate is

Because the population mean, (equal to 368), is also included within this interval, this state-
ment about is correct.

Now, before you begin to think that correct statements about are always made by devel-
oping a confidence interval estimate, suppose a third hypothetical sample of boxes is
selected and the sample mean is equal to 360 grams. The interval developed here is

or In this case, the estimate of is

This estimate is not a correct statement because the population mean, is not included in the
interval developed from this sample (see Figure 8.1). Thus, for some samples, the interval esti-
mate for is correct, but for others it is incorrect. In practice, only one sample is selected, and
because the population mean is unknown, you cannot determine whether the interval estimate
is correct. To resolve this problem of sometimes having an interval that provides a correct
estimate and sometimes having an interval that does not, you need to determine the proportion
of samples producing intervals that result in correct statements about the population mean,
To do this, consider two other hypothetical samples: the case in which grams
and the case in which grams. If the interval is

or This leads to the following interval:

Because the population mean of 368 is at the upper limit of the interval, the statement is
correct (see Figure 8.1).

When the interval is or The
interval estimate for the mean is

368.00 … m … 379.76

373.88 ; 5.88.373.88 ; 11.9621152>11252,X = 373.88,

356.24 … m … 368.00

362.12 ; 5.88.11.9621152>11252, 362.12 ;X = 362.12,X = 373.88
X = 362.12

m.

m

m,

354.12 … m … 365.88

m360 ; 5.88.360 ; 11.9621152>11252,
n = 25

m

m

m

363.62 … m … 375.38

369.5 ; 5.88.

369.5 ; 11.9621152>11252

n = 25
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In this case, because the population mean of 368 is included at the lower limit of the interval,
the statement is correct.

In Figure 8.1, you see that when the sample mean falls somewhere between 362.12 and
373.88 grams, the population mean is included somewhere within the interval. In Example 7.6
on page 263, you found that 95% of the sample means are between 362.12 and 373.88 grams.
Therefore, 95% of all samples of boxes have sample means that will result in intervals
that include the population mean.

Because, in practice, you select only one sample of size n, and is unknown, you never
know for sure whether your specific interval includes the population mean. However, if you
take all possible samples of n and compute their 95% confidence intervals, 95% of the inter-
vals will include the population mean, and only 5% of them will not. In other words, you have
95% confidence that the population mean is somewhere in your interval.

Consider once again the first sample discussed in this section. A sample of boxes
had a sample mean of 362.3 grams. The interval constructed to estimate is

The interval from 356.42 to 368.18 is referred to as a 95% confidence interval. The following
contains an interpretation of the interval that most business professionals will understand. (For
a technical discussion of different ways to interpret confidence intervals, see reference 3.)

“I am 95% confident that the mean amount of cereal in the population of boxes is
somewhere between 356.42 and 368.18 grams.”

To assist in your understanding of the meaning of the confidence interval, the following
example concerns the order-filling process at a website. Filling orders consists of several steps,
including receiving an order, picking the parts of the order, checking the order, packing, and
shipping the order. The file contains the time, in minutes, to fill orders for a population
of orders on a recent day. Although in practice the population characteristics are rarely
known, for this population of orders, the mean, is known to be equal to 69.637 minutes, and
the standard deviation, is known to be equal to 10.411 minutes and the population is
normally distributed. To illustrate how the sample mean and sample standard deviation can vary
from one sample to another, 20 different samples of were selected from the population
of 200 orders, and the sample mean and sample standard deviation (and other statistics) were
calculated for each sample. Figure 8.2 shows these results.

n = 10

s,
m,

N = 200
Order

 356.42 … m … 368.18

 362.3 ; 5.88

 362.3 ; 11.9621152>12252
m

n = 25

a>2
n = 25

F I G U R E 8 . 2
Sample statistics and
95% confidence intervals
for 20 samples of 
randomly selected from
the population of

ordersN = 200

n = 10
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From Figure 8.2, you can see the following:

• The sample statistics differ from sample to sample. The sample means vary from 61.10
to 76.26 minutes, the sample standard deviations vary from 6.50 to 14.10 minutes, the
sample medians vary from 59.70 to 80.60 minutes, and the sample ranges vary from
21.50 to 41.60 minutes.

• Some of the sample means are greater than the population mean of 69.637 minutes, and
some of the sample means are less than the population mean.

• Some of the sample standard deviations are greater than the population standard devia-
tion of 10.411 minutes, and some of the sample standard deviations are less than the
population standard deviation.

• The variation in the sample ranges is much more than the variation in the sample stan-
dard deviations.

The variation of sample statistics from sample to sample is called sampling error. Sam-
pling error is the variation that occurs due to selecting a single sample from the population.
The size of the sampling error is primarily based on the amount of variation in the population
and on the sample size. Large samples have less sampling error than small samples, but large
samples cost more to select.

The last column of Figure 8.2 contains 95% confidence interval estimates of the population
mean order-filling time, based on the results of those 20 samples of Begin by examining
the first sample selected. The sample mean is 74.15 minutes, and the interval estimate for the pop-
ulation mean is 67.6973 to 80.6027 minutes. In a typical study, you would not know for sure
whether this interval estimate is correct because you rarely know the value of the population mean.
However, for this example concerning the order-filling times, the population mean is known to be
69.637 minutes. If you examine the interval 67.6973 to 80.6027 minutes, you see that the popula-
tion mean of 69.637 minutes is located between these lower and upper limits. Thus, the first
sample provides a correct estimate of the population mean in the form of an interval estimate.
Looking over the other 19 samples, you see that similar results occur for all the other samples
except for samples 2, 5, and 12. For each of the intervals generated (other than samples 2, 5, and
12), the population mean of 69.637 minutes is located somewhere within the interval.

For sample 2, the sample mean is 61.10 minutes, and the interval is 54.6473 to 67.5527 min-
utes; for sample 5, the sample mean is 62.18, and the interval is between 55.7273 and 68.6327;
for sample 12, the sample mean is 76.26, and the interval is between 69.8073 and 82.7127 min-
utes. The population mean of 69.637 minutes is not located within any of these intervals, and the
estimate of the population mean made using these intervals is incorrect. Although 3 of the 20
intervals did not include the population mean, if you had selected all the possible samples of

from a population of 95% of the intervals would include the population mean.
In some situations, you might want a higher degree of confidence of including the popula-

tion mean within the interval (such as 99%). In other cases, you might accept less confidence
(such as 90%) of correctly estimating the population mean. In general, the level of confidence
is symbolized by where is the proportion in the tails of the distribution
that is outside the confidence interval. The proportion in the upper tail of the distribution is

and the proportion in the lower tail of the distribution is You use Equation (8.1) to
construct a confidence interval estimate for the mean with known.s11 - a2 * 100%

a>2.a>2,

a11 - a2 * 100%,

N = 200,n = 10

n = 10.

CONFIDENCE INTERVAL FOR THE MEAN ( KNOWN)

or

(8.1)

where is the value corresponding to an upper-tail probability of from the 
standardized normal distribution (i.e., a cumulative area of ).1 - a>2

a>2Za>2

X - Za>2
s1n

… m … X + Za>2
s1n

X ; Za>2
s1n

s



A paper manufacturer has a production process that operates continuously throughout an en-
tire production shift. The paper is expected to have a mean length of 11 inches, and the stan-
dard deviation of the length is 0.02 inch. At periodic intervals, a sample is selected to
determine whether the mean paper length is still equal to 11 inches or whether something has
gone wrong in the production process to change the length of the paper produced. You select a
random sample of 100 sheets, and the mean paper length is 10.998 inches. Construct a 95%
confidence interval estimate for the population mean paper length.

SOLUTION Using Equation (8.1) on page 283, with for 95% confidence,

Thus, with 95% confidence, you conclude that the population mean is between 10.9941 and
11.0019 inches. Because the interval includes 11, the value indicating that the production
process is working properly, you have no reason to believe that anything is wrong with the
production process.

10.9941 … m … 11.0019

= 10.998 ; 0.0039

X ; Za>2
s1n

= 10.998 ; 11.962 0.021100

Za>2 = 1.96

EXAMPLE 8.1
Estimating the
Mean Paper 
Length with 95%
Confidence
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The value of needed for constructing a confidence interval is called the critical value
for the distribution. 95% confidence corresponds to an value of 0.05. The critical Z value
corresponding to a cumulative area of 0.975 is 1.96 because there is 0.025 in the upper tail of
the distribution, and the cumulative area less than is 0.975.

There is a different critical value for each level of confidence, A level of confi-
dence of 95% leads to a Z value of 1.96 (see Figure 8.3). 99% confidence corresponds to an
value of 0.01. The Z value is approximately 2.58 because the upper-tail area is 0.005 and the
cumulative area less than is 0.995 (see Figure 8.4).Z = 2.58

a

1 - a.
Z = 1.96

a

Za>2

X

0–1.96 +1.96

.475.475

Z

.025 .025

F I G U R E 8 . 3
Normal curve for
determining the Z value
needed for 95%
confidence

X

0–2.58 +2.58

.495.495

Z

.005 .005

F I G U R E 8 . 4
Normal curve for
determining the Z value
needed for 99%
confidence

Now that various levels of confidence have been considered, why not make the confidence
level as close to 100% as possible? Before doing so, you need to realize that any increase in
the level of confidence is achieved only by widening (and making less precise) the confidence
interval. There is no “free lunch” here. You would have more confidence that the population
mean is within a broader range of values; however, this might make the interpretation of the
confidence interval less useful. The trade-off between the width of the confidence interval and
the level of confidence is discussed in greater depth in the context of determining the sample
size in Section 8.4. Example 8.1 illustrates the application of the confidence interval estimate.
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To see the effect of using a 99% confidence interval, examine Example 8.2.

Construct a 99% confidence interval estimate for the population mean paper length.

SOLUTION Using Equation (8.1) on page 283, with for 99% confidence,

Once again, because 11 is included within this wider interval, you have no reason to believe
that anything is wrong with the production process.

10.9928 … m … 11.0032

= 10.998 ; 0.00516

X ; Za>2
s1n

= 10.998 ; 12.582 0.021100

Za>2 = 2.58

EXAMPLE 8.2
Estimating the
Mean Paper 
Length with 99%
Confidence

As discussed in Section 7.4, the sampling distribution of the sample mean, is normally
distributed if the population for your characteristic of interest, X, follows a normal distribu-
tion. And, if the population of X does not follow a normal distribution, the Central Limit
Theorem almost always ensures that is approximately normally distributed when n is large.
However, when dealing with a small sample size and a population that does not follow a
normal distribution, the sampling distribution of is not normally distributed, and therefore
the confidence interval discussed in this section is inappropriate. In practice, however, as long
as the sample size is large enough and the population is not very skewed, you can use the
confidence interval defined in Equation (8.1) to estimate the population mean when is
known. To assess the assumption of normality, you can evaluate the shape of the sample data
by constructing a histogram, stem-and-leaf display, boxplot, or normal probability plot.

Can You Ever Know the Population Standard Deviation?
To solve Equation 8.1, you must know the value for the population standard deviation. To
know implies that you know all the values in the entire population. (How else would you
know the value of this population parameter?) If you knew all the values in the entire popula-
tion, you could directly compute the population mean. There would be no need to use the
inductive reasoning of inferential statistics to estimate the population mean. In other words, if
you knew you really do not have a need to use Equation 8.1 to construct a “confidence in-
terval estimate of the mean ( known).”

More significantly, in virtually all real-world business situations, you would never know the
standard deviation of the population. In business situations, populations are often too large to ex-
amine all the values. So why study the confidence interval estimate of the mean ( known) at all?
This method serves as an important introduction to the concept of a confidence interval because it
uses the normal distribution, which has already been thoroughly discussed in Chapters 6 and 7. In
the next section, you will see that constructing a confidence interval estimate when is not known
requires another distribution (the t distribution) not previously mentioned in this book.

Because the confidence interval concept is a very important concept to understand when read-
ing the rest of this book, review this section carefully to understand the underlying concept—even
if you never have a practical reason to use the confidence interval estimate of the mean ( known).s

s

s

s
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s

s,

s

X

X

X ,

Problems for Section 8.1
LEARNING THE BASICS
8.1 If and construct a 95% confi-
dence interval estimate for the population mean, 

8.2 If and construct a 99%
confidence interval estimate for the population mean, m.

n = 36,X = 125,s = 24,

m.
n = 64,X = 85,s = 8,

8.3 Why is it not possible in Example 8.1 on page 284 to
have 100% confidence? Explain.

8.4 Is it true in Example 8.1 on page 284 that you do not
know for sure whether the population mean is between
10.9941 and 11.0019 inches? Explain.
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APPLYING THE CONCEPTS
8.5 A market researcher selects a simple random sample of

customers from a population of 2 million cus-
tomers. After analyzing the sample, she states that she has
95% confidence that the mean annual income of the 2 mil-
lion customers is between $70,000 and $85,000. Explain the
meaning of this statement.

8.6 Suppose that you are going to collect a set of data, ei-
ther from an entire population or from a random sample
taken from that population.
a. Which statistical measure would you compute first: the

mean or the standard deviation? Explain.
b. What does your answer to (a) tell you about the “practi-

cality” of using the confidence interval estimate formula
given in Equation (8.1)?

8.7 Consider the confidence interval estimate discussed in
Problem 8.5. Suppose that the population mean annual in-
come is $71,000. Is the confidence interval estimate stated
in Problem 8.5 correct? Explain.

8.8 You are working as an assistant to the dean of institutional
research at your university. The dean wants to survey members
of the alumni association who obtained their baccalaureate de-
grees 5 years ago to learn what their starting salaries were in
their first full-time job after receiving their degrees. A sample
of 100 alumni is to be randomly selected from the list of 2,500
graduates in that class. If the dean’s goal is to construct a 95%
confidence interval estimate for the population mean starting
salary, why is it not possible that you will be able to use Equa-
tion (8.1) on page 283 for this purpose? Explain.

n = 100

8.9 The manager of a paint supply store wants to estimate
the actual amount of paint contained in 1-gallon cans pur-
chased from a nationally known manufacturer. The manu-
facturer’s specifications state that the standard deviation of
the amount of paint is equal to 0.02 gallon. A random sam-
ple of 50 cans is selected, and the sample mean amount of
paint per 1-gallon can is 0.995 gallon.
a. Construct a 99% confidence interval estimate for the

population mean amount of paint included in a 1-gallon
can.

b. On the basis of these results, do you think that the man-
ager has a right to complain to the manufacturer? Why?

c. Must you assume that the population amount of paint per
can is normally distributed here? Explain.

d. Construct a 95% confidence interval estimate. How does
this change your answer to (b)?

8.10 The quality control manager at a light bulb
factory needs to estimate the mean life of a large

shipment of light bulbs. The standard deviation is 100
hours. A random sample of 64 light bulbs indicated a sam-
ple mean life of 350 hours.
a. Construct a 95% confidence interval estimate for the

population mean life of light bulbs in this shipment.
b. Do you think that the manufacturer has the right to state

that the light bulbs have a mean life of 400 hours?
Explain.

c. Must you assume that the population light bulb life is
normally distributed? Explain.

d. Suppose that the standard deviation changes to 80 hours.
What are your answers in (a) and (b)?

SELF
Test

8.2 Confidence Interval Estimate for the Mean ( Unknown)s
In the previous section, you learned that in most business situations, you do not know the popu-
lation standard deviation. This section discusses a method of constructing a confidence interval es-
timate of that uses the sample statistic S as an estimate of the population parameter .

Student’s t Distribution
At the start of the twentieth century, William S. Gosset was working at Guinness in Ireland,
trying to help brew better beer less expensively (see reference 4). As he had only small sam-
ples to study, he needed to find a way to make inferences about means without having to know

Writing under the pen name “Student,”1 Gosset solved this problem by developing what to-
day is known as the Student’s t distribution, or the t distribution, for short.

If the random variable X is normally distributed, then the following statistic:

has a t distribution with degrees of freedom. This expression has the same form as the
Z statistic in Equation (7.4) on page 262, except that S is used to estimate the unknown s.

n - 1

t =
X - m

S1n

s.

sm

s,

1Guinness considered all research
conducted to be proprietary and a
trade secret. The firm prohibited its
employees from publishing their re-
sults. Gosset circumvented this ban
by using the pen name “Student” to
publish his findings.
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Properties of the t Distribution
The t distribution is very similar in appearance to the standardized normal distribution. Both
distributions are symmetrical and bell-shaped, with the mean and the median equal to zero.
However, the t distribution has more area in the tails and less in the center than does the stan-
dardized normal distribution (see Figure 8.5). This is due to the fact that because S is used to
estimate the unknown the values of t are more variable than those for Z.s,

Standardized normal distribution 

t distribution
for 5 degrees 
of freedom

F I G U R E 8 . 5
Standardized normal
distribution and t
distribution for 5 degrees
of freedom

The degrees of freedom, are directly related to the sample size, n. The concept of
degrees of freedom is discussed further on page 288. As the sample size and degrees of freedom in-
crease, S becomes a better estimate of and the t distribution gradually approaches the standard-
ized normal distribution, until the two are virtually identical. With a sample size of about 120 or
more, S estimates closely enough so that there is little difference between the t and Z distributions.

As stated earlier, the t distribution assumes that the random variable X is normally distrib-
uted. In practice, however, when the sample size is large enough and the population is not very
skewed, in most cases you can use the t distribution to estimate the population mean when is
unknown. When dealing with a small sample size and a skewed population distribution, the con-
fidence interval estimate may not provide a valid estimate of the population mean. To assess the
assumption of normality, you can evaluate the shape of the sample data by constructing a his-
togram, stem-and-leaf display, boxplot, or normal probability plot. However, the ability of any
of these graphs to help you evaluate normality is limited when you have a small sample size.

You find the critical values of t for the appropriate degrees of freedom from the table of the
t distribution (see Table E.3). The columns of the table present the most commonly used cumu-
lative probabilities and corresponding upper-tail areas. The rows of the table represent the de-
grees of freedom. The critical t values are found in the cells of the table. For example, with 99
degrees of freedom, if you want 95% confidence, you find the appropriate value of t, as shown
in Table 8.1. The 95% confidence level means that 2.5% of the values (an area of 0.025) are in

s

s

s,

n - 1,

T A B L E 8 . 1

Determining the Critical
Value from the t Table for
an Area of 0.025 in Each
Tail with 99 Degrees of
Freedom

Cumulative Probabilities

.75 .90 .95 .975 .99 .995

Upper-Tail Areas

Degrees of Freedom .25 .10 .05 .025 .01 .005

1 1.0000 3.0777 6.3138 12.7062 31.8207 63.6574
2 0.8165 1.8856 2.9200 4.3027 6.9646 9.9248
3 0.7649 1.6377 2.3534 3.1824 4.5407 5.8409
4 0.7407 1.5332 2.1318 2.7764 3.7469 4.6041
5 0.7267 1.4759 2.0150 2.5706 3.3649 4.0322
. . . . . . .
. . . . . . .
. . . . . . .

96 0.6771 1.2904 1.6609 1.9850 2.3658 2.6280
97 0.6770 1.2903 1.6607 1.9847 2.3654 2.6275
98 0.6770 1.2902 1.6606 1.9845 2.3650 2.6269
99 0.6770 1.2902 1.6604 1.9842 2.3646 2.6264

100 0.6770 1.2901 1.6602 1.9840 2.3642 2.6259
Source: Extracted from Table E.3.
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+1.9842 t

.025

Cumulative
area
0.975

F I G U R E 8 . 6
t distribution with 99
degrees of freedom

Note that for a 95% confidence interval, you will always have a cumulative probability of
0.975 and an upper-tail area of 0.025. Similarly, for a 99% confidence interval, you will have
0.995 and 0.005, and for a 90% confidence interval you will have 0.95 and 0.05.

The Concept of Degrees of Freedom
In Chapter 3, you learned that the numerator of the sample variance, [see Equation (3.6) on
page 103], requires the computation

In order to compute you first need to know Therefore, only of the sample values
are free to vary. This means that you have degrees of freedom. For example, suppose a sam-
ple of five values has a mean of 20. How many values do you need to know before you can deter-
mine the remainder of the values? The fact that and also tells you that

because

Thus, when you know four of the values, the fifth one is not free to vary because the sum must
be 100. For example, if four of the values are 18, 24, 19, and 16, the fifth value must be 23 so
that the sum is 100.

The Confidence Interval Statement
Equation (8.2) defines the confidence interval estimate for the mean with
unknown.

s11 - a2 * 100%

a
n

i=1
Xi

n
= X

a
n

i=1
Xi = 100

X = 20n = 5

n - 1
n - 1X .S 2,

a
n

i=1
1Xi - X 22

S2

CONFIDENCE INTERVAL FOR THE MEAN ( UNKNOWN)

or

(8.2)

where is the critical value corresponding to an upper-tail probability of (i.e., a
cumulative area of ) from the t distribution with degrees of freedom.n - 11 - a>2 a>2ta>2

X - ta>2
S1n

… m … X + ta>2
S1n

X ; ta>2
S1n

s

each tail of the distribution. Looking in the column for a cumulative probability of 0.975 and an
upper-tail area of 0.025 in the row corresponding to 99 degrees of freedom gives you a critical
value for t of 1.9842 (see Figure 8.6). Because t is a symmetrical distribution with a mean of 0,
if the upper-tail value is the value for the lower-tail area (lower 0.025) is
A t value of means that the probability that t is less than is 0.025, or 2.5%.-1.9842-1.9842

-1.9842.+ 1.9842,
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To illustrate the application of the confidence interval estimate for the mean when the
standard deviation is unknown, recall the Saxon Home Improvement scenario presented on
page 279. Using the Define, Collect, Organize, Visualize, and Analyze steps first discussed in
Chapter 2, you define the variable of interest as the dollar amount listed on the sales invoices
for the month. Your business objective is to estimate the mean dollar amount. Then, you col-
lect the data by selecting a sample of 100 sales invoices from the population of sales invoices
during the month. Once you have collected the data, you organize the data in a worksheet. You
can construct various graphs (not shown here) to better visualize the distribution of the dollar
amounts. To analyze the data, you compute the sample mean of the 100 sales invoices to be
equal to $110.27 and the sample standard deviation to be equal to $28.95. For 95% confidence,
the critical value from the t distribution (as shown in Table 8.1 on page 287) is 1.9842. Using
Equation (8.2),

Figure 8.7 shows this confidence interval estimate of the mean dollar amount as computed by
Excel (left results) and Minitab (right results).

104.53 … m … 116.01

= 110.27 ; 5.74

= 110.27 ; 11.98422 28.952100

X ; ta>2
S1n

F I G U R E 8 . 7
Excel worksheet and Minitab confidence interval estimate for the mean sales invoice amount for the Saxon Home
Improvement Company

Thus, with 95% confidence, you conclude that the mean amount of all the sales
invoices is between $104.53 and $116.01. The 95% confidence level indicates that if you
selected all possible samples of 100 (something that is never done in practice), 95% of the
intervals developed would include the population mean somewhere within the interval. The
validity of this confidence interval estimate depends on the assumption of normality for
the distribution of the amount of the sales invoices. With a sample of 100, the normality as-
sumption is not overly restrictive (see the Central Limit Theorem on page 264), and the use
of the t distribution is likely appropriate. Example 8.3 further illustrates how you construct
the confidence interval for a mean when the population standard deviation is unknown.
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A manufacturing company produces electric insulators. Using the Define, Collect, Organize,
Visualize, and Analyze steps first discussed in Chapter 2, you define the variable of interest as
the strength of the insulators. If the insulators break when in use, a short circuit is likely. To test
the strength of the insulators, you carry out destructive testing to determine how much force is
required to break the insulators. You measure force by observing how many pounds are applied
to the insulator before it breaks. You collect the data by selecting 30 insulators to be used in the
experiment. You organize the data collected in a worksheet. Table 8.2 lists 30 values from this
experiment, which are stored in . To analyze the data, you need to construct a 95% confi-
dence interval estimate for the population mean force required to break the insulator.

Force

EXAMPLE 8.3
Estimating the
Mean Force
Required to Break
Electric Insulators

T A B L E 8 . 2

Force (in Pounds)
Required to Break
Insulators

1,870 1,728 1,656 1,610 1,634 1,784 1,522 1,696 1,592 1,662
1,866 1,764 1,734 1,662 1,734 1,774 1,550 1,756 1,762 1,866
1,820 1,744 1,788 1,688 1,810 1,752 1,680 1,810 1,652 1,736

SOLUTION To visualize the data, you construct a boxplot of the force, as displayed in
Figure 8.8, and a normal probability plot, as shown in Figure 8.9. To analyze the data, you con-
struct the confidence interval estimate shown in Figure 8.10. In each figure, Excel results are
on the left and Minitab results are on the right.

F I G U R E 8 . 8
Boxplots for the amount of force required to break electric insulators

F I G U R E 8 . 9
Normal probability plots for the amount of force required to break electric insulators
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F I G U R E 8 . 1 0
Confidence interval estimate for the mean amount of force required to break electric insulators

Figure 8.10 shows that the sample mean is pounds and the sample standard devi-
ation is pounds. Using Equation (8.2) on page 288 to construct the confidence
interval, you need to determine the critical value from the t table, using the row for 29 degrees
of freedom. For 95% confidence, you use the column corresponding to an upper-tail area of
0.025 and a cumulative probability of 0.975. From Table E.3, you see that Thus,
using and

You conclude with 95% confidence that the mean breaking force required for the popula-
tion of insulators is between 1,689.96 and 1,756.84 pounds. The validity of this confidence in-
terval estimate depends on the assumption that the force required is normally distributed.
Remember, however, that you can slightly relax this assumption for large sample sizes. Thus,
with a sample of 30, you can use the t distribution even if the amount of force required is only
slightly left-skewed. From the boxplot displayed in Figure 8.8 and the normal probability plot
shown in Figure 8.9, the amount of force required appears only slightly left-skewed. Thus, the
t distribution is appropriate for these data.

 1,689.96 … m … 1,756.84

= 1,723.4 ; 33.44

= 1,723.4 ; 12.0452289.55230

X ; ta>2
S1n

ta>2 = 2.0452,X = 1,723.4, S = 89.55, n = 30,
ta>2 = 2.0452.

S = 89.55
X = 1,723.4

The interpretation of the confidence interval when is unknown is the same as when is
known. To illustrate the fact that the confidence interval for the mean varies more when is un-
known, return to the example concerning the order-filling times discussed in Section 8.1 on
pages 282–283. Suppose that, in this case, you do not know the population standard deviation
and instead use the sample standard deviation to construct the confidence interval estimate of
the mean. Figure 8.11 on page 292 shows the results for each of 20 samples of orders.

In Figure 8.11, observe that the standard deviation of the samples varies from 6.25 (sam-
ple 17) to 14.83 (sample 3). Thus, the width of the confidence interval developed varies from
8.94 in sample 17 to 21.22 in sample 3. Because you know that the population mean order time

minutes, you can see that the interval for sample and the inter-
val for sample do not correctly estimate the population mean. All the other10156.41 - 68.692 8169.68 - 85.482m = 69.637

n = 10

s

ss
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F I G U R E 8 . 1 1
Confidence interval
estimates of the mean 
for 20 samples of

randomly
selected from the
population of 
orders with unknowns

N = 200

n = 10,

intervals correctly estimate the population mean. Once again, remember that in practice you
select only one sample, and you are unable to know for sure whether your one sample provides
a confidence interval that includes the population mean.

Problems for Section 8.2
LEARNING THE BASICS
8.11 If and and assuming that
the population is normally distributed, construct a 95% con-
fidence interval estimate for the population mean, 

8.12 Determine the critical value of t in each of the follow-
ing circumstances:
a.
b.
c.
d.
e.

8.13 Assuming that the population is normally distributed,
construct a 95% confidence interval estimate for the popu-
lation mean for each of the following samples:

Sample A:
Sample B:

Explain why these two samples produce different confidence
intervals even though they have the same mean and range.

1 2 3 4 5 6 7 8
1 1 1 1 8 8 8 8

1 - a = 0.90, n = 16
1 - a = 0.95, n = 65
1 - a = 0.95, n = 32
1 - a = 0.99, n = 10
1 - a = 0.95, n = 10

m.

n = 36,X = 75, S = 24,

8.14 Assuming that the population is normally distributed,
construct a 95% confidence interval for the population mean,
based on the following sample of size

Change the number 20 to 7 and recalculate the confidence
interval. Using these results, describe the effect of an outlier
(i.e., an extreme value) on the confidence interval.

APPLYING THE CONCEPTS
8.15 A stationery store wants to estimate the mean retail
value of greeting cards that it has in its inventory. A random
sample of 100 greeting cards indicates a mean value of
$2.55 and a standard deviation of $0.44.
a. Assuming a normal distribution, construct a 95% confi-

dence interval estimate for the mean value of all greeting
cards in the store’s inventory.

b. Suppose there are 2,500 greeting cards in the store’s in-
ventory. How are the results in (a) useful in assisting the
store owner to estimate the total value of the inventory?

4, 5, 6, 201, 2, 3,
n = 7:
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8.16 Southside Hospital in Bay Shore, New York,
commonly conducts stress tests to study the heart

muscle after a person has a heart attack. Members of the diag-
nostic imaging department conducted a quality improvement
project with the objective of reducing the turnaround time for
stress tests. Turnaround time is defined as the time from when
a test is ordered to when the radiologist signs off on the test re-
sults. Initially, the mean turnaround time for a stress test was
68 hours. After incorporating changes into the stress-test
process, the quality improvement team collected a sample of
50 turnaround times. In this sample, the mean turnaround
time was 32 hours, with a standard deviation of 9 hours.
(Data extracted from E. Godin, D. Raven, C. Sweetapple, and
F. R. Del Guidice, “Faster Test Results,” Quality Progress,
January 2004, 37(1), pp. 33–39.)
a. Construct a 95% confidence interval estimate for the

population mean turnaround time.
b. Interpret the interval constructed in (a).
c. Do you think the quality improvement project was a

success?

8.17 The U.S. Department of Transportation requires tire
manufacturers to provide tire performance information on
the sidewall of a tire to better inform prospective customers
as they make purchasing decisions. One very important
measure of tire performance is the tread wear index, which
indicates the tire’s resistance to tread wear compared with a
tire graded with a base of 100. A tire with a grade of 200
should last twice as long, on average, as a tire graded with a
base of 100. A consumer organization wants to estimate the
actual tread wear index of a brand name of tires that claims
“graded 200” on the sidewall of the tire. A random sample of

indicates a sample mean tread wear index of 195.3
and a sample standard deviation of 21.4.
a. Assuming that the population of tread wear indexes is

normally distributed, construct a 95% confidence in-
terval estimate for the population mean tread wear in-
dex for tires produced by this manufacturer under this
brand name.

b. Do you think that the consumer organization should ac-
cuse the manufacturer of producing tires that do not meet
the performance information provided on the sidewall of
the tire? Explain.

c. Explain why an observed tread wear index of 210 for a
particular tire is not unusual, even though it is outside the
confidence interval developed in (a).

8.18 The file contains the amount that a sample
of nine customers spent for lunch ($) at a fast-food restaurant

a. Construct a 95% confidence interval estimate for the pop-
ulation mean amount spent for lunch ($) at a fast-food
restaurant, assuming a normal distribution.

b. Interpret the interval constructed in (a).

4.20   5.03   5.86   6.45   7.38   7.54   8.46   8.47   9.87

FastFood

n = 18

SELF
Test

8.19 The file contains the overall miles per gallon
(MPG) of 2010 family sedans.

Source: Data extracted from “Vehicle Ratings,” Consumer Reports, April
2010, p. 29.

a. Construct a 95% confidence interval estimate for the
population mean MPG of 2010 family sedans, assuming
a normal distribution.

b. Interpret the interval constructed in (a).
c. Compare the results in (a) to those in Problem 8.20(a).

8.20 The file contains the overall miles per gallon
(MPG) of 2010 small SUVs.

Source: Data extracted from “Vehicle Ratings,” Consumer Reports, April
2010, pp. 33–34.

a. Construct a 95% confidence interval estimate for the
population mean MPG of 2010 small SUVs, assuming a
normal distribution.

b. Interpret the interval constructed in (a).
c. Compare the results in (a) to those in Problem 8.19(a).

8.21 Is there a difference in the yields of different types of
investments? The file contains the
yields for a money market account and a five-year certificate
of deposit (CD) for 25 banks in the United States, as of
March 29, 2010.
Source: Data extracted from www.Bankrate.com, March 29, 2010.

a. Construct a 95% confidence interval estimate for the
mean yield of money market accounts.

b. Construct a 95% confidence interval estimate for the
mean yield of five-year certificates of deposits.

c. Compare the results of (a) and (b).

8.22 One of the major measures of the quality of service
provided by any organization is the speed with which it re-
sponds to customer complaints. A large family-held depart-
ment store selling furniture and flooring, including carpet,
had undergone a major expansion in the past several years.
In particular, the flooring department had expanded from
2 installation crews to an installation supervisor, a measurer,
and 15 installation crews. The store had the business objec-
tive of improving its response to complaints. The variable of
interest was defined as the number of days between when the
complaint was made and when it was resolved. Data were
collected from 50 complaints that were made in the last year.
The data were stored in , and are as follows:Furniture

SavingsRate-MMCD

19 21  21 21 21  21  18  19 21 22 22  16 16
24  23  22 21 22 22  18 18  26  26  26  19  19

SUV

22  22  44 32 20 20  22 20 39 20
24  21  22 23 24 34  34 34 20 20

Sedans

54 5 35 137 31 27 152 2 123 81 74 27
11 19 126 110 110 29 61 35 94 31 26 5
12 4 165 32 29 28 29 26 25 1 14 13
13 10 5 27 4 52 30 22 36 26 20 23
33 68

www.Bankrate.com


294 CHAPTER 8 Confidence Interval Estimation

a. Construct a 95% confidence interval estimate for the
population mean number of days between the receipt of a
complaint and the resolution of the complaint.

b. What assumption must you make about the population
distribution in order to construct the confidence interval
estimate in (a)?

c. Do you think that the assumption needed in order to con-
struct the confidence interval estimate in (a) is valid? Ex-
plain.

d. What effect might your conclusion in (c) have on the
validity of the results in (a)?

8.23 In NewYork State, savings banks are permitted to sell a
form of life insurance called savings bank life insurance
(SBLI). The approval process consists of underwriting, which
includes a review of the application, a medical information bu-
reau check, possible requests for additional medical informa-
tion and medical exams, and a policy compilation stage in
which the policy pages are generated and sent to the bank for
delivery. The ability to deliver approved policies to customers
in a timely manner is critical to the profitability of this service
to the bank. During a period of one month, a random sample
of 27 approved policies was selected, and the total processing
time, in days, was as shown below and stored in :

a. Construct a 95% confidence interval estimate for the
population mean processing time.

b. What assumption must you make about the population
distribution in order to construct the confidence interval
estimate in (a)?

c. Do you think that the assumption needed in order to
construct the confidence interval estimate in (a) is valid?
Explain.

45 48 17 17 17 91 92 63 50 51 69 16 17
73 19 16 64 28 28 31 90 60 56 31 56 22 18

Insurance

8.24 The file contains the cost per ounce
($) for a sample of 14 dark chocolate bars:

Source: Data extracted from “Dark Chocolate: Which Bars Are Best?”
Consumer Reports, September 2007, p. 8.

a. Construct a 95% confidence interval estimate for the
population cost per ounce ($) of dark chocolate bars.

b. What assumption do you need to make about the popula-
tion distribution to construct the interval in (a)?

c. Given the data presented, do you think the assumption
needed in (a) is valid? Explain.

8.25 One operation of a mill is to cut pieces of steel into
parts that are used in the frame for front seats in an automo-
bile. The steel is cut with a diamond saw, and the resulting
parts must be cut to be within inch of the length
specified by the automobile company. The measurement re-
ported from a sample of 100 steel parts (stored in ) is
the difference, in inches, between the actual length of the
steel part, as measured by a laser measurement device, and
the specified length of the steel part. For example, the first
observation, represents a steel part that is 0.002
inch shorter than the specified length.
a. Construct a 95% confidence interval estimate for the

population mean difference between the actual length of
the steel part and the specified length of the steel part.

b. What assumption must you make about the population
distribution in order to construct the confidence interval
estimate in (a)?

c. Do you think that the assumption needed in order to construct
the confidence interval estimate in (a) is valid? Explain.

d. Compare the conclusions reached in (a) with those of
Problem 2.41 on page 55.

-0.002,

Steel

;0.005

0.57   1.51   0.57   0.55   0.86   1.41   0.90
0.68   0.72   0.92   1.14   1.42   0.94   0.77

DarkChocolate

8.3 Confidence Interval Estimate for the Proportion
The concept of a confidence interval also applies to categorical data. With categorical data,
you want to estimate the proportion of items in a population having a certain characteristic of
interest. The unknown population proportion is represented by the Greek letter The point
estimate for is the sample proportion, where n is the sample size and X is the num-
ber of items in the sample having the characteristic of interest. Equation (8.3) defines the con-
fidence interval estimate for the population proportion.

p = X>n,p

p.

CONFIDENCE INTERVAL ESTIMATE FOR THE PROPORTION

or

(8.3)p - Za>2Ap11 - p2
n

… p … p + Za>2Ap11 - p2
n

p ; Za>2Ap11 - p2
n
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where

Note: To use this equation for the confidence interval, the sample size n must be large
enough to ensure that both X and are greater than 5.n - X

n = sample size

Za>2 = critical value from the standardized normal distribution

p = population proportion

p = sample proportion =
X
n

=
Number of items having the characteristic

sample size

You can use the confidence interval estimate for the proportion defined in Equation (8.3)
to estimate the proportion of sales invoices that contain errors (see the Saxon Home Improve-
ment scenario on page 279). Using the Define, Collect, Organize, Visualize, and Analyze
steps, you define the variable of interest as whether the invoice contains errors (yes or no).
Then, you collect the data from a sample of 100 sales invoices. The results, which you organ-
ize and store in a worksheet, show that 10 invoices contain errors. To analyze the data, you
compute, for these data, Since both X and using
Equation (8.3) and for 95% confidence,

Therefore, you have 95% confidence that the population proportion of all sales invoices containing
errors is between 0.0412 and 0.1588. This means that between 4.12% and 15.88% of all the
sales invoices contain errors. Figure 8.12 shows a confidence interval estimate for this example.
(Excel results are on the left and Minitab results are on the right.)

 0.0412 … p … 0.1588

= 0.10 ; 0.0588

= 0.10 ; 11.96210.032
= 0.10 ; 11.962A10.10210.902

100

p ; Za>2Ap11 - p2
n

Za>2 = 1.96,
n - X are 7 5,p = X>n = 10>100 = 0.10.

F I G U R E 8 . 1 2
Confidence interval estimate for the proportion of sales invoices that contain errors

Example 8.4 illustrates another application of a confidence interval estimate for the
proportion.
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The operations manager at a large newspaper wants to estimate the proportion of newspapers
printed that have a nonconforming attribute. Using the Define, Collect, Organize, Visualize,
and Analyze steps, you define the variable of interest as whether the newspaper has excessive
ruboff, improper page setup, missing pages, or duplicate pages. You collect the data by select-
ing a random sample of newspapers from all the newspapers printed during a single
day. You organize the results, which show that 35 newspapers contain some type of non-
conformance, in a worksheet. To analyze the data, you need to construct and interpret a 90%
confidence interval for the proportion of newspapers printed during the day that have a non-
conforming attribute.

SOLUTION Using Equation (8.3),

You conclude with 90% confidence that the population proportion of all newspapers printed
that day with nonconformities is between 0.1308 and 0.2192. This means that between 13.08%
and 21.92% of the newspapers printed on that day have some type of nonconformance.

 0.1308 … p … 0.2192

= 0.175 ; 0.0442

= 0.175 ; 11.645210.02692
= 0.175 ; 11.6452A10.175210.8252

200

p ; Za>2Ap11 - p2
n

p =
X
n

=
35
200

= 0.175, and with a 90% level of confidence Za>2 = 1.645

n = 200

EXAMPLE 8.4
Estimating the
Proportion of 
Nonconforming
Newspapers
Printed

Equation (8.3) contains a Z statistic because you can use the normal distribution to approx-
imate the binomial distribution when the sample size is sufficiently large. In Example 8.4, the
confidence interval using Z provides an excellent approximation for the population proportion
because both X and are greater than 5. However, if you do not have a sufficiently large
sample size, you should use the binomial distribution rather than Equation (8.3) (see refer-
ences 1, 2, and 7). The exact confidence intervals for various sample sizes and proportions of
successes have been tabulated by Fisher and Yates (reference 2).

n - X

Problems for Section 8.3
LEARNING THE BASICS
8.26 If and construct a 95% confidence
interval estimate for the population proportion.

8.27 If and construct a 99% confidence
interval estimate for the population proportion.

APPLYING THE CONCEPTS
8.28 The telephone company has the business objective
of wanting to estimate the proportion of households that
would purchase an additional telephone line if it were
made available at a substantially reduced installation cost.
Data are collected from a random sample of 500 house-
holds. The results indicate that 135 of the households

X = 25,n = 400

X = 50,n = 200

would purchase the additional telephone line at a reduced
installation cost.
a. Construct a 99% confidence interval estimate for the

population proportion of households that would purchase
the additional telephone line.

b. How would the manager in charge of promotional programs
concerning residential customers use the results in (a)?

8.29 In a survey of 1,200 social media users, 76% said it is
okay to friend co-workers, but 56% said it is not okay to
friend your boss. (Data extracted from “Facebook Etiquette
at Work,” USA Today, March 24, 2010, p. 1B.)
a. Construct a 95% confidence interval estimate for the

population proportion of social media users who would
say it is okay to friend co-workers.
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b. Construct a 95% confidence interval estimate for the
population proportion of social media users who would
say it is not okay to friend their boss.

c. Write a short summary of the information derived from
(a) and (b).

8.30 Have you ever negotiated a pay raise? According to
an Accenture survey, 52% of U.S. workers have (J. Yang and
K. Carter, “Have You Ever Negotiated a Pay Raise?” www.
usatoday.com, May 22, 2009).
a. Suppose that the survey had a sample size of

Construct a 95% confidence interval for the proportion
of all U.S. workers who have negotiated a pay raise.

b. Based on (a), can you claim that more than half of all
U.S. workers have negotiated a pay raise?

c. Repeat parts (a) and (b), assuming that the survey had a
sample size of 

d. Discuss the effect of sample size on confidence interval
estimation.

8.31 In a survey of 1,000 airline travelers, 760 responded
that the airline fee that is most unreasonable is additional
charges to redeem points/miles. (Data extracted from
“Which Airline Fee Is Most Unreasonable?” USA Today,
December 2, 2008, p. B1.) Construct a 95% confidence in-
terval estimate for the population proportion of airline trav-
elers who think that the airline fee that is most unreasonable
is additional charges to redeem points/miles.

n = 5,000.

n = 500.

8.32 In a survey of 2,395 adults, 1,916 reported that
e-mails are easy to misinterpret, but only 1,269 reported that
telephone conversations are easy to misinterpret. (Data
extracted from “Open to Misinterpretation,” USA Today,
July 17, 2007, p. 1D.)
a. Construct a 95% confidence interval estimate for the

population proportion of adults who report that e-mails
are easy to misinterpret.

b. Construct a 95% confidence interval estimate for the
population proportion of adults who report that telephone
conversations are easy to misinterpret.

c. Compare the results of (a) and (b).

8.33 What are the most preferred forms of recognition in
the workplace? In a survey by Office Arrow, 163 of 388
administrative professionals responded that verbal recogni-
tion is the most preferred form of recognition, and 74
responded that cash bonuses are most preferred. (Data
extracted from “Most Preferred Forms of Recognition at
Workplace,” USA Today, May 4, 2009, p. 1B.)
a. Construct a 95% confidence interval estimate for the

population proportion of administrative professionals
who prefer verbal recognition.

b. Construct a 95% confidence interval estimate for the
population proportion of administrative professionals
who prefer cash bonuses.

c. Interpret the intervals in (a) and (b).
d. Explain the difference in the results in (a) and (b).

8.4 Determining Sample Size
In each confidence interval developed so far in this chapter, the sample size was reported along
with the results, with little discussion of the width of the resulting confidence interval. In the
business world, sample sizes are determined prior to data collection to ensure that the confi-
dence interval is narrow enough to be useful in making decisions. Determining the proper sam-
ple size is a complicated procedure, subject to the constraints of budget, time, and the amount
of acceptable sampling error. In the Saxon Home Improvement example, if you want to esti-
mate the mean dollar amount of the sales invoices, you must determine in advance how large a
sampling error to allow in estimating the population mean. You must also determine, in advance,
the level of confidence (i.e., 90%, 95%, or 99%) to use in estimating the population parameter.

Sample Size Determination for the Mean
To develop an equation for determining the appropriate sample size needed when constructing
a confidence interval estimate for the mean, recall Equation (8.1) on page 283:

The amount added to or subtracted from is equal to half the width of the interval. This quan-
tity represents the amount of imprecision in the estimate that results from sampling error.2 The
sampling error, e, is defined as

e = Za>2
s1n

X

X ; Za>2
s1n

2In this context, some statisticians
refer to e as the margin of error.

www.usatoday.com
www.usatoday.com
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Solving for n gives the sample size needed to construct the appropriate confidence interval es-
timate for the mean. “Appropriate” means that the resulting interval will have an acceptable
amount of sampling error.

3You use Z instead of t because, to
determine the critical value of t, you
need to know the sample size, but
you do not know it yet. For most
studies, the sample size needed is
large enough that the standardized
normal distribution is a good approx-
imation of the t distribution.

SAMPLE SIZE DETERMINATION FOR THE MEAN
The sample size, n, is equal to the product of the value squared and the standard
deviation, squared, divided by the square of the sampling error, e.

(8.4)n =
Z2
a>2s2

e2

s,
Za>2

To compute the sample size, you must know three factors:

1. The desired confidence level, which determines the value of the critical value from
the standardized normal distribution3

2. The acceptable sampling error, e
3. The standard deviation,

In some business-to-business relationships that require estimation of important parameters,
legal contracts specify acceptable levels of sampling error and the confidence level required. For
companies in the food and drug sectors, government regulations often specify sampling errors
and confidence levels. In general, however, it is usually not easy to specify the three factors
needed to determine the sample size. How can you determine the level of confidence and sam-
pling error? Typically, these questions are answered only by a subject matter expert (i.e., an indi-
vidual very familiar with the variables under study). Although 95% is the most common
confidence level used, if more confidence is desired, then 99% might be more appropriate; if less
confidence is deemed acceptable, then 90% might be used. For the sampling error, you should
think not of how much sampling error you would like to have (you really do not want any error)
but of how much you can tolerate when reaching conclusions from the confidence interval.

In addition to specifying the confidence level and the sampling error, you need an esti-
mate of the standard deviation. Unfortunately, you rarely know the population standard devia-
tion, In some instances, you can estimate the standard deviation from past data. In other
situations, you can make an educated guess by taking into account the range and distribution
of the variable. For example, if you assume a normal distribution, the range is approximately
equal to (i.e., around the mean) so that you estimate as the range divided by 6. If
you cannot estimate in this way, you can conduct a small-scale study and estimate the stan-
dard deviation from the resulting data.

To explore how to determine the sample size needed for estimating the population mean,
consider again the audit at Saxon Home Improvement. In Section 8.2, you selected a sample
of 100 sales invoices and constructed a 95% confidence interval estimate for the population
mean sales invoice amount. How was this sample size determined? Should you have selected a
different sample size?

Suppose that, after consulting with company officials, you determine that a sampling er-
ror of no more than is desired, along with 95% confidence. Past data indicate that the
standard deviation of the sales amount is approximately $25. Thus, and

(for 95% confidence). Using Equation (8.4),

= 96.04

n =
Z2
a>2s2

e2
=
11.962212522
1522

Za>2 = 1.96
e = $5,s = $25,

;$5

s

s;3s6s

s.

s

Za>2,
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Because the general rule is to slightly oversatisfy the criteria by rounding the sample size up to
the next whole integer, you should select a sample of size 97. Thus, the sample of size
used on page 289 is slightly more than what is necessary to satisfy the needs of the company,
based on the estimated standard deviation, desired confidence level, and sampling error. Be-
cause the calculated sample standard deviation is slightly higher than expected, $28.95 com-
pared to $25.00, the confidence interval is slightly wider than desired. Figure 8.13 shows a
worksheet solution for determining the sample size.

n = 100

F I G U R E 8 . 1 3
Worksheet for
determining sample size
for estimating the mean
sales invoice amount for
the Saxon Home
Improvement Company

Example 8.5 illustrates another application of determining the sample size needed to de-
velop a confidence interval estimate for the mean.

Returning to Example 8.3 on page 290, suppose you want to estimate, with 95% confidence,
the population mean force required to break the insulator to within pounds. On the basis
of a study conducted the previous year, you believe that the standard deviation is 100 pounds.
Determine the sample size needed.

SOLUTION Using Equation (8.4) on page 298 and and for
95% confidence,

Therefore, you should select a sample of 62 insulators because the general rule for determin-
ing sample size is to always round up to the next integer value in order to slightly oversatisfy
the criteria desired. An actual sampling error slightly larger than 25 will result if the sample
standard deviation calculated in this sample of 62 is greater than 100 and slightly smaller if the
sample standard deviation is less than 100.

= 61.47

n =
Z2
a>2s2

e2
=
11.9622110022
12522

Za>2 = 1.96e = 25,s = 100,

;25
EXAMPLE 8.5
Determining the
Sample Size for the
Mean

Sample Size Determination for the Proportion
So far in this section, you have learned how to determine the sample size needed for estimat-
ing the population mean. Now suppose that you want to determine the sample size necessary
for estimating a population proportion.

To determine the sample size needed to estimate a population proportion, you use a
method similar to the method for a population mean. Recall that in developing the sample size
for a confidence interval for the mean, the sampling error is defined by

e = Za>2
s2n

p,
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SAMPLE SIZE DETERMINATION FOR THE PROPORTION
The sample size n is equal to the product of squared, the population proportion, and
1 minus the population proportion, divided by the square of the sampling error, e.

(8.5)n =
Z2
a>2p11 - p2

e2

p,
p,Za>2

To determine the sample size, you must know three factors:

1. The desired confidence level, which determines the value of the critical value from
the standardized normal distribution

2. The acceptable sampling error (or margin of error), e
3. The population proportion,

In practice, selecting these quantities requires some planning. Once you determine the de-
sired level of confidence, you can find the appropriate value from the standardized nor-
mal distribution. The sampling error, e, indicates the amount of error that you are willing to
tolerate in estimating the population proportion. The third quantity, is actually the popula-
tion parameter that you want to estimate! Thus, how do you state a value for what you are try-
ing to determine?

Here you have two alternatives. In many situations, you may have past information or rel-
evant experience that provides an educated estimate of Or, if you do not have past informa-
tion or relevant experience, you can try to provide a value for that would never
underestimate the sample size needed. Referring to Equation (8.5), you can see that the quan-
tity appears in the numerator. Thus, you need to determine the value of that will
make the quantity as large as possible. When the product
achieves its maximum value. To show this result, consider the following values of along
with the accompanying products of 

When then

When then

When then

When then

When then

Therefore, when you have no prior knowledge or estimate for the population proportion,
you should use for determining the sample size. Using produces the

largest possible sample size and results in the narrowest and most precise confidence interval.
This increased precision comes at the cost of spending more time and money for an increased
sample size. Also, note that if you use and the proportion is different from 0.5, you
will overestimate the sample size needed, because you will get a confidence interval narrower
than originally intended.

p = 0.5

p = 0.5p = 0.5p,

p11 - p2 = 10.1210.92 = 0.09.p = 0.1,

p11 - p2 = 10.3210.72 = 0.21.p = 0.3,

p11 - p2 = 10.5210.52 = 0.25.p = 0.5,

p11 - p2 = 10.7210.32 = 0.21.p = 0.7,

p11 - p2 = 10.9210.12 = 0.09.p = 0.9,

p11 - p2: p,
p11 - p2p = 0.5,p11 - p2 pp11 - p2

p

p.

p,

Za>2

p

Za>2,

When estimating a proportion, you replace with Thus, the sampling error is

Solving for n, you have the sample size necessary to develop a confidence interval estimate
for a proportion.

e = Za>2Ap11 - p2
n

1p11 - p2.s
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Returning to the Saxon Home Improvement scenario on page 279, suppose that the
auditing procedures require you to have 95% confidence in estimating the population
proportion of sales invoices with errors to within The results from past months indicate
that the largest proportion has been no more than 0.15. Thus, using Equation (8.5) with

and for 95% confidence,

Because the general rule is to round the sample size up to the next whole integer to slightly
oversatisfy the criteria, a sample size of 100 is needed. Thus, the sample size needed to sat-
isfy the requirements of the company, based on the estimated proportion, desired confi-
dence level, and sampling error, is equal to the sample size taken on page 295. The actual
confidence interval is narrower than required because the sample proportion is 0.10,
whereas 0.15 was used for in Equation (8.5). Figure 8.14 shows a worksheet solution for
determining the sample size.

p

= 99.96

=
11.962210.15210.852

10.0722

n =
Z2
a>2p11 - p2

e2

Za>2 = 1.96e = 0.07,p = 0.15,

;0.07.

F I G U R E 8 . 1 4
Worksheet for
determining sample size
for estimating the
proportion of sales
invoices with errors for
the Saxon Home
Improvement Company

Example 8.6 provides another application of determining the sample size for estimating
the population proportion.

You want to have 90% confidence of estimating the proportion of office workers who respond
to e-mail within an hour to within Because you have not previously undertaken such a
study, there is no information available from past data. Determine the sample size needed.

SOLUTION Because no information is available from past data, assume that Using
Equation (8.5) on page 300 and and for 90% confidence,

Therefore, you need a sample of 271 office workers to estimate the population proportion to
within with 90% confidence.;0.05

= 270.6

=
11.6452210.50210.502

10.0522

n =
Z 2
a>2p11 - p2

e2

Za>2 = 1.645e = 0.05,p = 0.50,
p = 0.50.

;0.05.
EXAMPLE 8.6
Determining the
Sample Size for the
Population
Proportion



Problems for Section 8.4
LEARNING THE BASICS
8.34 If you want to be 95% confident of estimating the
population mean to within a sampling error of and the
standard deviation is assumed to be 15, what sample size is
required?

8.35 If you want to be 99% confident of estimating the
population mean to within a sampling error of and the
standard deviation is assumed to be 100, what sample size
is required?

8.36 If you want to be 99% confident of estimating the
population proportion to within a sampling error of
what sample size is needed?

8.37 If you want to be 95% confident of estimating the
population proportion to within a sampling error of
and there is historical evidence that the population propor-
tion is approximately 0.40, what sample size is needed?

APPLYING THE CONCEPTS
8.38 A survey is planned to determine the mean
annual family medical expenses of employees of a

large company. The management of the company wishes to
be 95% confident that the sample mean is correct to within

of the population mean annual family medical ex-
penses. A previous study indicates that the standard devia-
tion is approximately $400.
a. How large a sample is necessary?
b. If management wants to be correct to within how

many employees need to be selected?

8.39 If the manager of a paint supply store wants to esti-
mate, with 95% confidence, the mean amount of paint in a
1-gallon can to within gallon and also assumes that
the standard deviation is 0.02 gallon, what sample size is
needed?

8.40 If a quality control manager wants to estimate, with
95% confidence, the mean life of light bulbs to within

hours and also assumes that the population standard
deviation is 100 hours, how many light bulbs need to be
selected?

8.41 If the inspection division of a county weights and
measures department wants to estimate the mean amount of
soft-drink fill in 2-liter bottles to within liter with
95% confidence and also assumes that the standard devia-
tion is 0.05 liter, what sample size is needed?

8.42 A consumer group wants to estimate the mean elec-
tric bill for the month of July for single-family homes in a
large city. Based on studies conducted in other cities, the
standard deviation is assumed to be $25. The group wants to
estimate, with 99% confidence, the mean bill for July to
within .;$5

;0.01

;20

;0.004

;$25,

;$50

SELF
Test

;0.02

;0.04,

;20

;5

a. What sample size is needed?
b. If 95% confidence is desired, how many homes need to

be selected?

8.43 An advertising agency that serves a major radio sta-
tion wants to estimate the mean amount of time that the sta-
tion’s audience spends listening to the radio daily. From past
studies, the standard deviation is estimated as 45 minutes.
a. What sample size is needed if the agency wants to be

90% confident of being correct to within minutes?
b. If 99% confidence is desired, how many listeners need to

be selected?

8.44 A growing niche in the restaurant business is gourmet-
casual breakfast, lunch, and brunch. Chains in this group in-
clude EggSpectation and Panera Bread. Suppose that the mean
per-person check for EggSpectation is approximately $12.50,
and the mean per-person check for Panera Bread is $7.50.
a. Assuming a standard deviation of $2.00, what sample

size is needed to estimate, with 95% confidence, the
mean per-person check for EggSpectation to within

b. Assuming a standard deviation of $2.50, what sample size
is needed to estimate, with 95% confidence, the mean per-
person check for EggSpectation to within

c. Assuming a standard deviation of $3.00, what sample size
is needed to estimate, with 95% confidence, the mean
per-person check for EggSpectation to within

d. Discuss the effect of variation on the sample size needed.

8.45 What proportion of Americans get most of their news
from the Internet? According to a poll conducted by Pew
Research Center, 40% get most of their news from the
Internet. (Data extracted from “Drill Down,” The New York
Times, January 5, 2009, p. B3.)
a. To conduct a follow-up study that would provide 95%

confidence that the point estimate is correct to within
of the population proportion, how large a sample

size is required?
b. To conduct a follow-up study that would provide 99%

confidence that the point estimate is correct to within
of the population proportion, how many people

need to be sampled?
c. To conduct a follow-up study that would provide 95%

confidence that the point estimate is correct to within
of the population proportion, how large a sample

size is required?
d. To conduct a follow-up study that would provide 99%

confidence that the point estimate is correct to within
of the population proportion, how many people

need to be sampled?
;0.02

;0.02

;0.04

;0.04

;$0.25?

;$0.25?

;$0.25?

;5

e. Discuss the effects on sample size requirements of
changing the desired confidence level and the acceptable
sampling error.
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8.46 A survey of 1,000 adults was conducted in March
2009 concerning “green practices.” In response to the
question of what was the most beneficial thing to do for the
environment, 28% said buying renewable energy, 19% said
using greener transportation, and 7% said selecting
minimal or reduced packaging. (Data extracted from “En-
vironmentally Friendly Choices,” USA Today, March 31,
2009, p. D1.) Construct a 95% confidence interval estimate
of the population proportion of who said that the most ben-
eficial thing to do for the environment was
a. buy renewable energy.
b. use greener transportation.
c. select minimal or reduced packaging.
d. You have been asked to update the results of this study. De-

termine the sample size necessary to estimate, with 95%
confidence, the population proportions in (a) through (c)
to within

8.47 In a study of 500 executives, 315 stated that their com-
pany informally monitored social networking sites to stay on
top of information related to their company. (Data extracted
from “Checking Out the Buzz,” USA Today, June 26, 2009,
p. 1B.)
a. Construct a 95% confidence interval for the proportion

of companies that informally monitored social network-
ing sites to stay on top of information related to their
company.

b. Interpret the interval constructed in (a).
c. If you wanted to conduct a follow-up study to estimate

the population proportion of companies that informally
monitored social networking sites to stay on top of

;0.02.

information related to their company to within
with 95% confidence, how many executives would you
survey?

8.48 In response to the question “How do you judge a
company?” 84% said the most important way was how a
company responded to a crisis. (Data extracted from “How
Do You Judge a Company?” USA Today, December 22,
2008, p. 1B.)
a. If you conduct a follow-up study to estimate the popula-

tion proportion of individuals who said that the most im-
portant way to judge a company was how the company
responded to a crisis, would you use a of 0.84 or 0.50
in the sample size formula? Discuss.

b. Using your answer to (a), find the sample size necessary
to estimate, with 95% certainty, the population propor-
tion to within 

8.49 There are many reasons adults use credit cards. A re-
cent survey (“Why Adults Use Credit Cards,” USA Today,
October 18, 2007, p. 1D) found that 66% of adults used
credit cards for convenience.
a. To conduct a follow-up study that would provide 99%

confidence that the point estimate is correct to within
of the population proportion, how many people

need to be sampled?
b. To conduct a follow-up study that would provide 99%

confidence that the point estimate is correct to within
of the population proportion, how many people

need to be sampled?
c. Compare the results of (a) and (b).

;0.05

;0.03

;0.03.

p

;0.01

8.5 Applications of Confidence Interval Estimation in Auditing
Auditing is one of the areas in business that makes widespread use of probability sampling
methods in order to construct confidence interval estimates.

AUDITING
Auditing is the collection and evaluation of evidence about information related to an
economic entity, such as a sole business proprietor, a partnership, a corporation, or a
government agency, in order to determine and report on how well the information
corresponds to established criteria.

Auditors rarely examine a complete population of information. Instead, they rely on esti-
mation techniques based on the probability sampling methods you have studied in this text.
The following list contains some of the reasons sampling is used in auditing:

• Sampling is less time-consuming.
• Sampling is less costly.
• Sampling provides an objective way of estimating the sample size in advance.
• Sampling provides results that are objective and defensible. Because the sample size is

based on demonstrable statistical principles, the audit is defensible before one’s superi-
ors and in a court of law.

• Sampling provides an estimate of the sampling error and therefore allows auditors to
generalize their findings to the population with a known sampling error.



• Sampling is often more accurate than other methods for drawing conclusions about large
populations. Examining every item in large populations is time-consuming and there-
fore often subject to more nonsampling error than is statistical sampling.

• Sampling allows auditors to combine, and then evaluate collectively, samples from dif-
ferent individuals.

Estimating the Population Total Amount
In auditing applications, you are often more interested in developing estimates of the popula-
tion total amount than in the population mean. Equation (8.6) shows how to estimate a
population total amount.

ESTIMATING THE POPULATION TOTAL
The point estimate for the population total is equal to the population size, N, times the
sample mean.

(8.6)Total = NX

Equation (8.7) defines the confidence interval estimate for the population total.

CONFIDENCE INTERVAL ESTIMATE FOR THE TOTAL

(8.7)

where is the critical value corresponding to an upper-tail probability of from the t
distribution with degrees of freedom (i.e., a cumulative area of ).1 - a>2n - 1

a>2ta>2

NX ; N1 ta>22 S1nAN - n

N - 1

To demonstrate the application of the confidence interval estimate for the population total
amount, return to the Saxon Home Improvement scenario on page 279. In addition to estimat-
ing the mean dollar amount in Section 8.2 on page 289, one of the auditing tasks defined in
the business problem is to estimate the total dollar amount of all sales invoices for the month.
If there are 5,000 invoices for that month and then using Equation (8.6),

Since and then using Equation (8.7) with for 95% confi-
dence and 99 degrees of freedom,

Therefore, with 95% confidence, you estimate that the total amount of sales invoices is be-
tween $522,914.28 and $579,785.72. Figure 8.15 shows a worksheet solution for constructing
this confidence interval estimate.

Example 8.7 further illustrates the population total.

$522,914.28 … Population total … $579,785.72

= 551,350 ; 28,435.72

= 551,350 ; 28,721.29510.990052
NX ; N1ta>22 S1nAN - n

N - 1
= 551,350 ; 15,000211.98422 28.951100A5,000 - 100

5,000 - 1

ta>2 = 1.9842S = $28.95,n = 100

NX = 15,00021$110.272 = $551,350

X = $110.27,
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F I G U R E 8 . 1 5
Worksheet for the
confidence interval
estimate of the total
amount of all invoices for
the Saxon Home
Improvement Company

An auditor is faced with a population of 1,000 vouchers and wants to estimate the total value
of the population of vouchers. A sample of 50 vouchers is selected, with the following results:

Construct a 95% confidence interval estimate of the total amount for the population of vouchers.

SOLUTION Using Equation (8.6) on page 304, the point estimate of the population total is

From Equation (8.7) on page 304 a 95% confidence interval estimate of the population total
amount is

Therefore, with 95% confidence, you estimate that the total amount of the vouchers is between
$1,000,558 and $1,152,222.

$1,000,558 … Population total … $1,152,222

= 1,076,390 ; 75,832

= 1,076,390 ; 77,762.878 10.975172
11,000211,076.392 ; 11,000212.00962 273.62150 A1,000 - 50

1,000 - 1

NX = 11,000211,076.392 = $1,076,390

Standard deviation 1S2 = $273.62
 Mean voucher amount 1X 2 = $1,076.39

EXAMPLE 8.7
Developing a 
Confidence
Interval Estimate 
for the Population
Total

Difference Estimation
An auditor uses difference estimation when he or she believes that errors exist in a set of
items and he or she wants to estimate the magnitude of the errors based only on a sample. The
following steps are used in difference estimation:

1. Determine the sample size required.
2. Calculate the differences between the values reached during the audit and the original val-

ues recorded. The difference in value i, denoted is equal to 0 if the auditor finds that
the original value is correct, is a positive value when the audited value is larger than the
original value, and is negative when the audited value is smaller than the original value.

3. Compute the mean difference in the sample, by dividing the total difference by the sam-
ple size, as shown in Equation (8.8).

D,

Di,



4In the numerator, there are 100
differences. Each of the last 88 is
equal to 10 - 0.922.

4. Compute the standard deviation of the differences, as shown in Equation (8.9).
Remember that any item that is not in error has a difference value of 0.

SD,

MEAN DIFFERENCE

(8.8)

where Di = Audited value - Original value

D =
a

n

i=1
Di

n

STANDARD DEVIATION OF THE DIFFERENCE

(8.9)SD = Qa
n

i=1
1Di - D22
n - 1

5. Use Equation (8.10) to construct a confidence interval estimate of the total difference in
the population.

CONFIDENCE INTERVAL ESTIMATE FOR THE TOTAL DIFFERENCE

(8.10)

where is the critical value corresponding to an upper-tail probability of from the t
distribution with degrees of freedom (i.e., a cumulative area of ).1 - a>2n - 1

a>2ta>2

ND ; N1ta>22 SD1nAN - n

N - 1

The auditing procedures for Saxon Home Improvement require a 95% confidence interval
estimate of the difference between the audited dollar amounts on the sales invoices and the
amounts originally entered into the integrated inventory and sales information system. The
data are collected by taking a sample of 100 sales invoices. The results of the sample are or-
ganized and stored in the workbook. There are 12 invoices in which the audited dol-
lar amount on the sales invoice and the amount originally entered into the integrated inventory
management and sales information system are different. These 12 differences are

PlumbInv

$9.03 $7.47 $17.32 $8.30 $5.21 $10.80 $6.22 $5.63 $4.97 $7.43 $2.99 $4.63

The other 88 invoices are not in error. Each of their differences is 0. Thus, to analyze the
data, you compute

and4

SD = Qa
n

i=1
1Di - D22
n - 1

D =
a

n

i=1
Di

n
=

90
100

= 0.90
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Using Equation (8.10), you construct the 95% confidence interval estimate for the total
difference in the population of 5,000 sales invoices, as follows:

Thus, the auditor estimates with 95% confidence that the total difference between the sales in-
voices, as determined during the audit, and the amount originally entered into the accounting sys-
tem is between $1,797.09 and $7,202.91. Figure 8.16 shows the worksheet results for these data.

$1,797.09 … Total difference … $7,202.91

= 4,500 ; 2,702.91

15,000210.902 ; 15,000211.98422 2.7521100A5,000 - 100

5,000 - 1

SD = 2.752

= A19.03 - 0.922 + 17.47 - 0.922 + Á + 10 - 0.922
100 - 1

F I G U R E 8 . 1 6
Worksheet for the total
difference between the
invoice amounts found
during audit and the
amounts entered into the
accounting system for
the Saxon Home
Improvement Company

In the previous example, all 12 differences are positive because the audited amount on the
sales invoice is more than the amount originally entered into the accounting system. In some
circumstances, you could have negative errors. Example 8.8 illustrates such a situation.

Returning to Example 8.7 on page 305, suppose that 14 vouchers in the sample of 50 vouchers
contain errors. The values of the 14 errors are listed below and stored in . Observe that
two differences are negative:

DiffTest

EXAMPLE 8.8
Difference
Estimation

$75.41 $38.97 $108.54 -$37.18 $62.75 $118.32 -$88.84
$127.74 $55.42 $39.03 $29.41 $47.99 $28.73 $84.05

Construct a 95% confidence interval estimate for the total difference in the population of
1,000 vouchers.

SOLUTION For these data,

D =
a

n

i=1
Di

n
=

690.34
50

= 13.8068



and

Using Equation (8.10) on page 306, construct the confidence interval estimate for the total dif-
ference in the population, as follows:

Therefore, with 95% confidence, you estimate that the total difference in the population of
vouchers is between $3,434.40 and $24,179.20.

$3,434.40 … Total difference … $24,179.20

= 13,806.8 ; 10,372.4

11,0002113.80682 ; 11,000212.0096237.427250 A1,000 - 50

1,000 - 1

= 37.427

= A175.41 - 13.806822 + 138.97 - 13.806822 + Á + 10 - 13.806822
50 - 1

SD = Qa
n

i=1
1Di - D22
n - 1

One-Sided Confidence Interval Estimation of the Rate of
Noncompliance with Internal Controls
Organizations use internal control mechanisms to ensure that individuals act in accordance
with company guidelines. For example, Saxon Home Improvement requires that an authorized
warehouse-removal slip be completed before goods are removed from the warehouse. During
the monthly audit of the company, the auditing team is charged with the task of estimating the
proportion of times goods were removed without proper authorization. This is referred to as
the rate of noncompliance with the internal control. To estimate the rate of noncompliance, au-
ditors take a random sample of sales invoices and determine how often merchandise was
shipped without an authorized warehouse-removal slip. The auditors then compare their re-
sults with a previously established tolerable exception rate, which is the maximum allowable
proportion of items in the population not in compliance. When estimating the rate of noncom-
pliance, it is commonplace to use a one-sided confidence interval. That is, the auditors esti-
mate an upper bound on the rate of noncompliance. Equation (8.11) defines a one-sided
confidence interval for a proportion.

ONE-SIDED CONFIDENCE INTERVAL FOR A PROPORTION

(8.11)

where value corresponding to a cumulative area of from the
standardized normal distribution (i.e., a right- tail probability of ).a

11 - a2Za = the

Upper bound = p + ZaAp11 - p2
n AN - n

N - 1

If the tolerable exception rate is higher than the upper bound, the auditor concludes that
the company is in compliance with the internal control. If the upper bound is higher than the
tolerable exception rate, the auditor has failed to prove that the company is in compliance. The
auditor may then request a larger sample.

Suppose that in the monthly audit, you select 400 sales invoices from a population of
10,000 invoices. In the sample of 400 sales invoices, 20 are in violation of the internal control.

308 CHAPTER 8 Confidence Interval Estimation



Problems for Section 8.5 309

Problems for Section 8.5
LEARNING THE BASICS

8.50 A sample of 25 is selected from a population of 500
items. The sample mean is 25.7, and the sample standard de-
viation is 7.8. Construct a 99% confidence interval estimate
for the population total.

8.51 Suppose that a sample of 200 (stored in ) is
selected from a population of 10,000 items. Of these, 10
items are found to have the following errors:

13.76 42.87 34.65 11.09 14.54
22.87 25.52 9.81 10.03 15.49

Construct a 95% confidence interval estimate for the total
difference in the population.

8.52 If and calculate the
upper bound for a one-sided confidence interval estimate

N = 5,000,p = 0.04, n = 300,

ItemErr

for the population proportion, using the following levels
of confidence:
a. 90%
b. 95%
c. 99%

APPLYING THE CONCEPTS
8.53 A stationery store wants to estimate the total retail
value of the 1,000 greeting cards it has in its inventory. Con-
struct a 95% confidence interval estimate for the population
total value of all greeting cards that are in inventory if a ran-
dom sample of 100 greeting cards indicates a mean value of
$2.55 and a standard deviation of $0.44.

8.54 The personnel department of a large corpo-
ration employing 3,000 workers wants to estimate

the family dental expenses of its employees to determine the

SELF
Test

p,

If the tolerable exception rate for this internal control is 6%, what should you conclude? Use a
95% level of confidence.

The one-sided confidence interval is computed using and
Using Equation (8.11),

Thus, you have 95% confidence that the rate of noncompliance is less than 6.76%. Because
the tolerable exception rate is 6%, the rate of noncompliance may be too high for this internal
control. In other words, it is possible that the noncompliance rate for the population is higher
than the rate deemed tolerable. Therefore, you should request a larger sample.

In many cases, the auditor is able to conclude that the rate of noncompliance with the com-
pany’s internal controls is acceptable. Example 8.9 illustrates such an occurrence.

= 0.05 + 1.64510.0109210.982 = 0.05 + 0.0176 = 0.0676

Upper bound = p + ZaAp11 - p2
n AN - n

N - 1
= 0.05 + 1.645A0.0511 - 0.052

400 A10,000 - 400

10,000 - 1

Za = 1.645.
p = 20>400 = 0.05

A large electronics firm writes 1 million checks a year. An internal control policy for the com-
pany is that the authorization to sign each check is granted only after an invoice has been ini-
tialed by an accounts payable supervisor. The company’s tolerable exception rate for this
control is 4%. If control deviations are found in 8 of the 400 invoices sampled, what should the
auditor do? To solve this, use a 95% level of confidence.

SOLUTION The auditor constructs a 95% one-sided confidence interval for the proportion
of invoices in noncompliance and compares this to the tolerable exception rate. Using Equa-
tion (8.11) on page 308, and for 95% confidence,

The auditor concludes with 95% confidence that the rate of noncompliance is less than 3.15%.
Because this is less than the tolerable exception rate, the auditor concludes that the internal
control compliance is adequate. In other words, the auditor is more than 95% confident that
the rate of noncompliance is less than 4%.

= 0.02 + 1.64510.007210.99982 = 0.02 + 0.0115 = 0.0315

Upper bound = p + ZaAp11 - p2
n AN - n

N - 1
= 0.02 + 1.645A0.0211 - 0.022

400 A1,000,000 - 400

1,000,000 - 1

Za = 1.645p = 8>400 = 0.02,

EXAMPLE 8.9
Estimating the Rate
of Noncompliance



feasibility of providing a dental insurance plan. A random sam-
ple of 10 employees (stored in the file ) reveals the fol-
lowing family dental expenses (in dollars) for the preceding year:

Construct a 90% confidence interval estimate for the total
family dental expenses for all employees in the preceding year.

8.55 A branch of a chain of large electronics stores is con-
ducting an end-of-month inventory of the merchandise in
stock. There were 1,546 items in inventory at that time. A
sample of 50 items was randomly selected, and an audit was
conducted, with the following results:

Value of Merchandise

Construct a 95% confidence interval estimate for the total
value of the merchandise in inventory at the end of the month.

8.56 A customer in the wholesale garment trade is often
entitled to a discount for a cash payment for goods. The
amount of discount varies by vendor. A sample of 150 items
selected from a population of 4,000 invoices at the end of a
period of time (stored in ) revealed that in 13
cases, the customer failed to take the discount to which he
or she was entitled. The amounts (in dollars) of the 13 dis-
counts that were not taken were as follows:

6.45 15.32 97.36 230.63 104.18 84.92 132.76
66.12 26.55 129.43 88.32 47.81 89.01

Construct a 99% confidence interval estimate for the popu-
lation total amount of discounts not taken.

8.57 Econe Dresses is a small company that manufactures
women’s dresses for sale to specialty stores. It has 1,200 in-
ventory items, and the historical cost is recorded on a first-
in, first-out (FIFO) basis. In the past, approximately 15% of
the inventory items were incorrectly priced. However, any
misstatements were usually not significant. A sample of 120
items was selected (see the file), and the historical costFifo

Discount

X = $252.28 S = $93.67

110 362 246 85 510 208 173 425 316 179

Dental

Construct a 95% confidence interval estimate for the total
population difference in the historical cost and audited value.

8.58 Tom and Brent’s Alpine Outfitters conducts an annual
audit of its financial records. An internal control policy for the
company is that a check can be issued only after the accounts
payable manager initials the invoice. The tolerable exception
rate for this internal control is 0.04. During an audit, a sample
of 300 invoices is examined from a population of 10,000 in-
voices, and 11 invoices are found to violate the internal control.
a. Calculate the upper bound for a 95% one-sided confi-

dence interval estimate for the rate of noncompliance.
b. Based on (a), what should the auditor conclude?

8.59 An internal control policy for Rhonda’s Online Fash-
ion Accessories requires a quality assurance check before a
shipment is made. The tolerable exception rate for this inter-
nal control is 0.05. During an audit, 500 shipping records
were sampled from a population of 5,000 shipping records,
and 12 were found that violated the internal control.
a. Calculate the upper bound for a 95% one-sided confi-

dence interval estimate for the rate of noncompliance.
b. Based on (a), what should the auditor conclude?

Sample
Number

Historical
Cost ($)

Audited
Value ($)

Sample
Number

Historical
Cost ($)

Audited
Value ($)

5 261 240 60 21 210
9 87 105 73 140 152

17 201 276 86 129 112
18 121 110 95 340 216
28 315 298 96 341 402
35 411 356 107 135 97
43 249 211 119 228 220
51 216 305

8.6 Confidence Interval Estimation and Ethical Issues
Ethical issues related to the selection of samples and the inferences that accompany them can
occur in several ways. The major ethical issue relates to whether confidence interval estimates
are provided along with the point estimates. Providing a point estimate without also including
the confidence interval limits (typically set at 95%), the sample size used, and an interpreta-
tion of the meaning of the confidence interval in terms that a person untrained in statistics can
understand raises ethical issues. Failure to include a confidence interval estimate might mis-
lead the user of the results into thinking that the point estimate is all that is needed to predict
the population characteristic with certainty.

When media outlets publicize the results of a political poll, they often overlook including
this information. Sometimes, the results of a poll include the sampling error, but the sampling
error is often presented in fine print or as an afterthought to the story being reported. A fully
ethical presentation of poll results would give equal prominence to the confidence levels, sam-
ple size, sampling error, and confidence limits of the poll.

310 CHAPTER 8 Confidence Interval Estimation

of each item was compared with the audited value. The re-
sults indicated that 15 items differed in their historical costs
and audited values. These values were as follows:
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S U M M A R Y
This chapter discusses confidence intervals for estimating the
characteristics of a population, along with how you can deter-
mine the necessary sample size. You learned how to apply
these methods to numerical and categorical data. Table 8.3 on
page 312 provides a list of topics covered in this chapter.

To determine what equation to use for a particular
situation, you need to answer these questions:

• Are you constructing a confidence interval, or are you
determining sample size?

• Do you have a numerical variable, or do you have a
categorical variable?

• If you are constructing confidence intervals in
auditing, are you trying to estimate the population
total, the difference between an audited value and an
actual value, or the rate of noncompliance?

The next four chapters develop a hypothesis-testing
approach to making decisions about population
parameters.

8.7 Online Topic: Estimation and Sample Size Determination 
for Finite Populations

In this section, confidence intervals are developed and the sample size is determined for
situations in which sampling is done without replacement from a finite population. To study
this topic, read the Section 8.7 online topic file that is available on this book’s companion
website. (See Appendix C to learn how to access the online topic files from the companion
website.)

In the Saxon Home Improvement scenario, you were an accountant
for a distributor of home improvement supplies in the northeastern
United States. You were responsible for the accuracy of the integrated
inventory management and sales information system. You used con-

fidence interval estimation techniques to draw conclusions about the
population of all records from a relatively small sample collected during an
audit.

At the end of the month, you collected a random sample of 100 sales invoices and made
the following inferences:

• With 95% confidence, you concluded that the mean amount of all the sales invoices is
between $104.53 and $116.01.

• With 95% confidence, you concluded that between 4.12% and 15.88% of all the sales
invoices contain errors.

• With 95% confidence, you concluded that the total amount of all the sales invoices is
between $522,914 and $579,786.

• With 95% confidence, you concluded that the total difference between the actual and
audited amounts of sales invoices was between $1,797.09 and $7,202.91.

These estimates provide an interval of values that you believe contain the true population pa-
rameters. If these intervals are too wide (i.e., the sampling error is too large) for the types of
decisions Saxon Home Improvement needs to make, you will need to take a larger sample. You
can use the sample size formulas in Section 8.4 to determine the number of sales invoices to
sample to ensure that the size of the sampling error is acceptable.

U S I N G S TAT I S T I C S @ Saxon Home Improvement Revisited

When you prepare your own point estimates, always state the interval estimate in a promi-
nent place and include a brief explanation of the meaning of the confidence interval. In addi-
tion, make sure you highlight the sample size and sampling error.



T A B L E 8 . 3

Summary of Topics in
Chapter 8

Type of Data

Type of Analysis Numerical Categorical

Confidence interval for a
population parameter

Confidence interval
estimate for the mean
(Sections 8.1 and 8.2)

Confidence interval
estimate for the proportion
(Section 8.3)

Confidence interval estimate
for the total and mean
difference (Section 8.5)

One-sided confidence
interval estimate for the
proportion (Section 8.5)

Determining sample size Sample size determination
for the mean (Section 8.4)

Sample size determination
for the proportion
(Section 8.4)

Confidence Interval for the Mean ( Known)

or

(8.1)

Confidence Interval for the Mean ( Unknown)

or

(8.2)

Confidence Interval Estimate for the Proportion

or

(8.3)

Sample Size Determination for the Mean

(8.4)

Sample Size Determination for the Proportion

(8.5)n =
Z 2
a>2p11 - p2

e2

n =
Z 2
a>2s2

e2

p - Za>2Ap11 - p2
n

… p … p + Za>2Ap11 - p2
n

p ; Za>2Ap11 - p2
n

X - ta>2
S2n

… m … X + ta>2
S1n

X ; ta>2
S1n

s

X - Za>2
s2n

… m … X + Za>2
s1n

X ; Za>2
s1n

s Estimating the Population Total

(8.6)

Confidence Interval Estimate for the Total

(8.7)

Mean Difference

(8.8)

Standard Deviation of the Difference

(8.9)

Confidence Interval Estimate for the Total Difference

(8.10)

One-Sided Confidence Interval for a Proportion

(8.11)Upper bound = p + ZaAp11 - p2
n AN - n

N - 1

ND ; N1 ta>22 SD1nAN - n

N - 1

SD = Qa
n

i=1
1Di - D22
n - 1

D =
a

n

i=1
Di

n

NX ; N1 ta>22 S1nAN - n

N - 1

Total = NX

K E Y E Q U AT I O N S
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auditing 303
confidence interval estimate 280
critical value 284
degrees of freedom 286

difference estimation 305
level of confidence 283
margin of error 297
one-sided confidence interval 308

K E Y T E R M S
point estimate 280
sampling error 297
Student’s t distribution 286
total amount 304

CHECKING YOUR UNDERSTANDING
8.60 Why can you never really have 100% confidence of
correctly estimating the population characteristic of interest?

8.61 When are you able to use the t distribution to develop
the confidence interval estimate for the mean?

8.62 Why is it true that for a given sample size, n, an
increase in confidence is achieved by widening (and mak-
ing less precise) the confidence interval?

8.63 Under what circumstances do you use a one-sided con-
fidence interval instead of a two-sided confidence interval?

8.64 When would you want to estimate the population
total instead of the population mean?

8.65 How does difference estimation differ from estimation
of the mean?

APPLYING THE CONCEPTS
8.66 You work in the corporate office for a nationwide
convenience store franchise that operates nearly 10,000
stores. The per-store daily customer count has been steady,
at 900, for some time (i.e., the mean number of customers
in a store in one day is 900). To increase the customer count,
the franchise is considering cutting coffee prices by approx-
imately half. The 12-ounce size will now be $0.59 instead of
$0.99, and the 16-ounce size will be $0.69 instead of $1.19.
Even with this reduction in price, the franchise will have a
40% gross margin on coffee. To test the new initiative, the
franchise has reduced coffee prices in a sample of 34 stores,
where customer counts have been running almost exactly at
the national average of 900. After four weeks, the sample
stores stabilize at a mean customer count of 974 and a stan-
dard deviation of 96. This increase seems like a substantial
amount to you, but it also seems like a pretty small sample.
Is there some way to get a feel for what the mean per-store
count in all the stores will be if you cut coffee prices nation-
wide? Do you think reducing coffee prices is a good strat-
egy for increasing the mean customer count?

8.67 What do Americans do to conserve energy? A survey
of 500 adults (data extracted from “Going on an Energy
Diet,” USA Today, April 16, 2009, p. 1A) found the follow-
ing percentages:

C H A P T E R R E V I E W P R O B L E M S
Turn off lights, power strips, unplug things: 73%
Recycle aluminum, plastic, newspapers, cardboard: 47%
Recycle harder-to-recycle products: 36%
Buy products with least packaging: 34%
Ride a bike or walk: 23%

a. Construct 95% confidence interval estimates for the pop-
ulation proportion of what adults do to conserve energy.

b. What conclusions can you reach concerning what adults
do to conserve energy?

8.68 A market researcher for a consumer electronics
company wants to study the television viewing habits of
residents of a particular area. A random sample of 40 re-
spondents is selected, and each respondent is instructed to
keep a detailed record of all television viewing in a particu-
lar week. The results are as follows:
• Viewing time per week: hours, hours.
• 27 respondents watch the evening news on at least three

weeknights.
a. Construct a 95% confidence interval estimate for the

mean amount of television watched per week in this area.
b. Construct a 95% confidence interval estimate for the

population proportion who watch the evening news on at
least three weeknights per week.

Suppose that the market researcher wants to take another
survey in a different location. Answer these questions:
c. What sample size is required to be 95% confident of es-

timating the population mean viewing time to within
hours assuming that the population standard devia-

tion is equal to five hours?
d. How many respondents need to be selected to be 95%

confident of being within of the population pro-
portion who watch the evening news on at least three
weeknights if no previous estimate is available?

e. Based on (c) and (d), how many respondents should the
market researcher select if a single survey is being con-
ducted?

8.69 The real estate assessor for a county government
wants to study various characteristics of single-family
houses in the county. A random sample of 70 houses reveals
the following:
• Heated area of the houses (in square feet):

• 42 houses have central air-conditioning.
X = 1,759, S = 380.

;0.035

;2

S = 3.8X = 15.3



a. Construct a 99% confidence interval estimate for the
population mean heated area of the houses.

b. Construct a 95% confidence interval estimate for the
population proportion of houses that have central air-con-
ditioning.

8.70 The personnel director of a large corporation wishes
to study absenteeism among clerical workers at the corpora-
tion’s central office during the year. A random sample of 25
clerical workers reveals the following:
• Absenteeism: days, days.
• 12 clerical workers were absent more than 10 days.
a. Construct a 95% confidence interval estimate for the

mean number of absences for clerical workers during
the year.

b. Construct a 95% confidence interval estimate for the
population proportion of clerical workers absent more
than 10 days during the year.

Suppose that the personnel director also wishes to take a
survey in a branch office. Answer these questions:
c. What sample size is needed to have 95% confidence in

estimating the population mean absenteeism to within
days if the population standard deviation is esti-

mated to be 4.5 days?
d. How many clerical workers need to be selected to have

90% confidence in estimating the population proportion
to within if no previous estimate is available?

e. Based on (c) and (d), what sample size is needed if a sin-
gle survey is being conducted?

8.71 The market research director for Dotty’s Depart-
ment Store wants to study women’s spending on cosmet-
ics. A survey of the store’s customers is designed in order
to estimate the proportion of women who purchase their
cosmetics primarily from Dotty’s Department Store and
the mean yearly amount that women spend on cosmetics.
A previous survey found that the standard deviation of the
amount women spend on cosmetics in a year is approxi-
mately $18.
a. What sample size is needed to have 99% confidence of es-

timating the population mean amount spent to within
b. How many of the store’s credit card holders need to be

selected to have 90% confidence of estimating the popu-
lation proportion to within 

8.72 The branch manager of a nationwide bookstore
chain (located near a college campus) wants to study char-
acteristics of her store’s customers. She decides to focus
on two variables: the amount of money spent by cus-
tomers (on items other than textbooks) and whether the
customers would consider purchasing educational DVDs
related to graduate preparation exams, such as the GMAT,
GRE, or LSAT. The results from a sample of 70 customers
are as follows:
• Amount spent: 
• 28 customers stated that they would consider purchasing

the educational DVDs.

X = $28.52, S = $11.39.

;0.045?

;$5?

;0.075

;1.5

S = 4.0X = 9.7

a. Construct a 95% confidence interval estimate for the
population mean amount spent in the bookstore.

b. Construct a 90% confidence interval estimate for the
population proportion of customers who would consider
purchasing educational DVDs.

Assume that the branch manager of another store in the chain
(also located close to a college campus) wants to conduct a
similar survey in his store. Answer the following questions:
c. What sample size is needed to have 95% confidence of

estimating the population mean amount spent in this
store to within if the standard deviation is assumed
to be $10?

d. How many customers need to be selected to have 90%
confidence of estimating the population proportion who
would consider purchasing the educational DVDs to
within

e. Based on your answers to (c) and (d), how large a sample
should the manager take?

8.73 The branch manager of an outlet (Store 1) of a
nationwide chain of pet supply stores wants to study charac-
teristics of her customers. In particular, she decides to focus
on two variables: the amount of money spent by customers
and whether the customers own only one dog, only one cat,
or more than one dog and/or cat. The results from a sample
of 70 customers are as follows:
• Amount of money spent:
• 37 customers own only a dog.
• 26 customers own only a cat.
• 7 customers own more than one dog and/or cat.
a. Construct a 95% confidence interval estimate for the

population mean amount spent in the pet supply store.
b. Construct a 90% confidence interval estimate for the

population proportion of customers who own only a cat.
The branch manager of another outlet (Store 2) wishes to
conduct a similar survey in his store. The manager does not
have access to the information generated by the manager of
Store 1. Answer the following questions:
c. What sample size is needed to have 95% confidence of

estimating the population mean amount spent in this
store to within if the standard deviation is esti-
mated to be $10?

d. How many customers need to be selected to have 90%
confidence of estimating the population proportion of
customers who own only a cat to within 

e. Based on your answers to (c) and (d), how large a sample
should the manager take?

8.74 Scarlett and Heather, the owners of an upscale
restaurant in Dayton, Ohio, want to study the dining charac-
teristics of their customers. They decide to focus on two
variables: the amount of money spent by customers and
whether customers order dessert. The results from a sample
of 60 customers are as follows:
• Amount spent:
• 18 customers purchased dessert.

X = $38.54, S = $7.26.

;0.045?

;$1.50

X = $21.34, S = $9.22.

;0.04?

;$2
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a. Construct a 95% confidence interval estimate for the pop-
ulation mean amount spent per customer in the restaurant.

b. Construct a 90% confidence interval estimate for the pop-
ulation proportion of customers who purchase dessert.

Jeanine, the owner of a competing restaurant, wants to con-
duct a similar survey in her restaurant. Jeanine does not
have access to the information that Scarlett and Heather
have obtained from the survey they conducted. Answer the
following questions:
c. What sample size is needed to have 95% confidence of

estimating the population mean amount spent in her
restaurant to within assuming that the standard
deviation is estimated to be $8?

d. How many customers need to be selected to have 90%
confidence of estimating the population proportion of
customers who purchase dessert to within 

e. Based on your answers to (c) and (d), how large a sample
should Jeanine take?

8.75 The manufacturer of Ice Melt claims that its product
will melt snow and ice at temperatures as low as Fahren-
heit. A representative for a large chain of hardware stores is
interested in testing this claim. The chain purchases a large
shipment of 5-pound bags for distribution. The representa-
tive wants to know, with 95% confidence and within 
what proportion of bags of Ice Melt perform the job as
claimed by the manufacturer.
a. How many bags does the representative need to test?

What assumption should be made concerning the popu-
lation proportion? (This is called destructive testing; i.e.,
the product being tested is destroyed by the test and is
then unavailable to be sold.)

b. Suppose that the representative tests 50 bags, and 42 of
them do the job as claimed. Construct a 95% confidence
interval estimate for the population proportion that will
do the job as claimed.

c. How can the representative use the results of (b) to deter-
mine whether to sell the Ice Melt product?

8.76 An auditor needs to estimate the percentage of times
a company fails to follow an internal control procedure. A
sample of 50 from a population of 1,000 items is selected,
and in 7 instances, the internal control procedure was not
followed.
a. Construct a 90% one-sided confidence interval estimate

for the population proportion of items in which the inter-
nal control procedure was not followed.

b. If the tolerable exception rate is 0.15, what should the
auditor conclude?

8.77 An auditor for a government agency needs to evaluate
payments for doctors’ office visits paid by Medicare in a par-
ticular zip code during the month of June. A total of 25,056
visits occurred during June in this area. The auditor wants to
estimate the total amount paid by Medicare to within
with 95% confidence. On the basis of past experience, she
believes that the standard deviation is approximately $30.

;$5

;0.05,

0¡

;0.04?

;$1.50,

a. What sample size should she select?
Using the sample size selected in (a), an audit is conducted,
with the following results:

Amount of Reimbursement

In 12 of the office visits, an incorrect amount of reimburse-
ment was provided. For the 12 office visits in which there
was an incorrect reimbursement, the differences between
the amount reimbursed and the amount that the auditor
determined should have been reimbursed were as follows
(and stored in ):

b. Construct a 90% confidence interval estimate for the pop-
ulation proportion of reimbursements that contain errors.

c. Construct a 95% confidence interval estimate for the
population mean reimbursement per office visit.

d. Construct a 95% confidence interval estimate for the popu-
lation total amount of reimbursements for this geographic
area in June.

e. Construct a 95% confidence interval estimate for the total
difference between the amount reimbursed and the amount
that the auditor determined should have been reimbursed.

8.78 A home furnishings store that sells bedroom furniture
is conducting an end-of-month inventory of the beds
(mattress, bed spring, and frame) in stock. An auditor for the
store wants to estimate the mean value of the beds in stock
at that time. She wants to have 99% confidence that her
estimate of the mean value is correct to within On
the basis of past experience, she estimates that the standard
deviation of the value of a bed is $200.
a. How many beds should she select?
b. Using the sample size selected in (a), an audit was

conducted, with the following results:

Construct a 99% confidence interval estimate for the total
value of the beds in stock at the end of the month if there
were 258 beds in stock.

8.79 A quality characteristic of interest for a tea-bag-filling
process is the weight of the tea in the individual bags. In this
example, the label weight on the package indicates that the
mean amount is 5.5 grams of tea in a bag. If the bags are un-
derfilled, two problems arise. First, customers may not be
able to brew the tea to be as strong as they wish. Second, the
company may be in violation of the truth-in-labeling laws. On
the other hand, if the mean amount of tea in a bag exceeds the
label weight, the company is giving away product. Getting an
exact amount of tea in a bag is problematic because of varia-
tion in the temperature and humidity inside the factory,
differences in the density of the tea, and the extremely fast
filling operation of the machine (approximately 170 bags per
minute). The following data (stored in ) are theTeabags

X = $1,654.27 S = $184.62

;$100.

$17 $25 $14 -$10 $20 $40 $35 $30 $28 $22 $15 $5

Medicare

X = $93.70 S = $34.55



weights, in grams, of a sample of 50 tea bags produced in one
hour by a single machine:

a. Construct a 99% confidence interval estimate for the
population mean weight of the tea bags.

b. Is the company meeting the requirement set forth on the
label that the mean amount of tea in a bag is 5.5 grams?

c. Do you think the assumption needed to construct the
confidence interval estimate in (a) is valid?

8.80 A manufacturing company produces steel housings for
electrical equipment. The main component part of the hous-
ing is a steel trough that is made from a 14-gauge steel coil. It
is produced using a 250-ton progressive punch press with a
wipe-down operation that puts two 90-degree forms in the flat
steel to make the trough. The distance from one side of the
form to the other is critical because of weatherproofing in
outdoor applications. The widths (in inches), shown below
and stored in , are from a sample of 49 troughs:

a. Construct a 95% confidence interval estimate for the
mean width of the troughs.

b. Interpret the interval developed in (a).
c. Do you think the assumption needed to construct the

confidence interval estimate in (a) in valid?

8.81 The manufacturer of Boston and Vermont asphalt
shingles knows that product weight is a major factor in a
customer’s perception of quality. The last stage of the
assembly line packages the shingles before they are placed
on wooden pallets. Once a pallet is full (a pallet for most
brands holds 16 squares of shingles), it is weighed, and the
measurement is recorded. The file contains the
weight (in pounds) from a sample of 368 pallets of Boston
shingles and 330 pallets of Vermont shingles.
a. For the Boston shingles, construct a 95% confidence

interval estimate for the mean weight.
b. For the Vermont shingles, construct a 95% confidence in-

terval estimate for the mean weight.
c. Do you think the assumption needed to construct the

confidence interval estimates in (a) and (b) is valid?
d. Based on the results of (a) and (b), what conclusions can

you reach concerning the mean weight of the Boston and
Vermont shingles?

8.82 The manufacturer of Boston and Vermont asphalt shin-
gles provides its customers with a 20-year warranty on most of
its products. To determine whether a shingle will last the entire

Pallet

8.396  8.447  8.405  8.439  8.411  8.427  8.420  8.498  8.409
8.460  8.444  8.429  8.460  8.412  8.420  8.410  8.405  8.323  8.420
8.436  8.413  8.489  8.414  8.481  8.415  8.479  8.429  8.458  8.462
8.476  8.382  8.484  8.403  8.414  8.419  8.385  8.465  8.498  8.447
8.312  8.343  8.317  8.383  8.348  8.410  8.351  8.373  8.481  8.422

Trough

5.61 5.45 5.44 5.25 5.56 5.63 5.50 5.57 5.67 5.36
5.77 5.57 5.42 5.58 5.58 5.50 5.32 5.50 5.53 5.58
5.47 5.40 5.47 5.61 5.53 5.32 5.67 5.29 5.49 5.55
5.57 5.40 5.53 5.54 5.55 5.62 5.56 5.46 5.44 5.51
5.65 5.44 5.42 5.40 5.53 5.34 5.54 5.45 5.52 5.41

warranty period, accelerated-life testing is conducted at the
manufacturing plant. Accelerated-life testing exposes the shin-
gle to the stresses it would be subject to in a lifetime of normal
use via a laboratory experiment that takes only a few minutes
to conduct. In this test, a shingle is repeatedly scraped with a
brush for a short period of time, and the shingle granules re-
moved by the brushing are weighed (in grams). Shingles that
experience low amounts of granule loss are expected to last
longer in normal use than shingles that experience high
amounts of granule loss. In this situation, a shingle should
experience no more than 0.8 grams of granule loss if it is ex-
pected to last the length of the warranty period. The file

contains a sample of 170 measurements made on the
company’s Boston shingles and 140 measurements made on
Vermont shingles.
a. For the Boston shingles, construct a 95% confidence in-

terval estimate for the mean granule loss.
b. For the Vermont shingles, construct a 95% confidence in-

terval estimate for the mean granule loss.
c. Do you think the assumption needed to construct the con-

fidence interval estimates in (a) and (b) is valid?
d. Based on the results of (a) and (b), what conclusions can

you reach concerning the mean granule loss of the
Boston and Vermont shingles?

REPORT WRITING EXERCISE
8.83 Referring to the results in Problem 8.80 concerning
the width of a steel trough, write a report that summarizes
your conclusions.

TEAM PROJECT
8.84 Refer to the team project on page 73 that uses the data
in . Construct all appropriate confidence inter-
val estimates of the population characteristics of below-
average-risk, average-risk, and above-average-risk bond
funds. Include these estimates in a report to the vice presi-
dent for research at the financial investment service.

STUDENT SURVEY DATABASE
8.85 Problem 1.27 on page 14 describes a survey of 62 un-
dergraduate students (stored in ).
a. For these data, for each variable, construct a 95% confi-

dence interval estimate for the population characteristic.
b. Write a report that summarizes your conclusions.

8.86 Problem 1.27 on page 14 describes a survey of 62 un-
dergraduate students (stored in ).
a. Select a sample of undergraduate students at your school

and conduct a similar survey for those students.
b. For the data collected in (a), repeat (a) and (b) of Problem

8.85.
c. Compare the results of (b) to those of Problem 8.85.

8.87 Problem 1.28 on page 15 describes a survey of 44
MBA students (stored in ).
a. For these data, for each variable, construct a 95% confi-

dence interval estimate for the population characteristic.
b. Write a report that summarizes your conclusions.

GradSurvey

UndergradSurvey

UndergradSurvey

Bond Funds

Granule
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8.88 Problem 1.28 on page 15 describes a survey of 44
MBA students (stored in ).
a. Select a sample of graduate students in your MBA pro-

gram and conduct a similar survey for those students.

GradSurvey

b. For the data collected in (a), repeat (a) and (b) of Problem
8.87.

c. Compare the results of (b) to those of Problem 8.87.

M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
The marketing department has been considering ways to
increase the number of new subscriptions to the 3-For-All
cable/phone/Internet service. Following the suggestion of
Assistant Manager Lauren Adler, the department staff de-
signed a survey to help determine various characteristics of
households who subscribe to cable television service from
Ashland. The survey consists of the following 10 questions:
1. Does your household subscribe to telephone service

from Ashland?
(1) Yes (2) No

2. Does your household subscribe to Internet service from
Ashland?
(1) Yes (2) No

3. What type of cable television service do you have?
(1) Basic
(2) Enhanced
(If Basic, skip to question 5.)

4. How often do you watch the cable television stations that
are only available with enhanced service?
(1) Every day
(2) Most days
(3) Occasionally or never

5. How often do you watch premium or on-demand
services that require an extra fee?
(1) Almost every day
(2) Several times a week
(3) Rarely
(4) Never

6. Which method did you use to obtain your current AMS
subscription?
(1) AMS toll-free phone number
(2) AMS website
(3) Direct mail reply card
(4) Good Tunes & More promotion
(5) Other

7. Would you consider subscribing to the 3-For-All
cable/phone/Internet service for a trial period if a dis-
count were offered?
(1) Yes (2) No
(If no, skip to question 9.)

8. If purchased separately, cable, Internet, and phone serv-
ices would currently cost $24.99 per week. How much
would you be willing to pay per week for the 3-For-All
cable/phone/Internet service?

9. Does your household use another provider of telephone
service?
(1) Yes (2) No

10. AMS may distribute Ashland Gold Cards that would pro-
vide discounts at selected Ashland-area restaurants for
subscribers who agree to a two-year subscription contract
to the 3-For-All service. Would being eligible to receive a
Gold Card cause you to agree to the two-year term?
(1) Yes (2) No

Of the 500 households selected that subscribe to cable tele-
vision service from Ashland, 82 households either refused
to participate, could not be contacted after repeated at-
tempts, or had telephone numbers that were not in service.
The summary results are as follows:

Household has AMS Telephone Service Frequency

Yes 83
No 335
Household has AMS Internet Service Frequency
Yes 262
No 156
Type of Cable Service Frequency
Basic 164
Enhanced 254
Watches Enhanced Programming Frequency
Every day 50
Most days 144
Occasionally or never 60
Watches Premium or On-Demand
Services Frequency

Almost every day 14
Several times a week 35
Almost never 313
Never 56
Method Used to Obtain Current AMS
Subscription Frequency
Toll-free phone number 230
AMS website 106
Direct mail 46
Good Tunes & More 10
Other 26
Would Consider Discounted Trial
Offer Frequency
Yes 40
No 378



EXERCISE
1. Analyze the results of the survey of Ashland households

that receive AMS cable television service. Write a re-
port that discusses the marketing implications of the
survey results for Ashland MultiComm Services.

Trial Weekly Rate ($) Willing to Pay (stored in )AMS8

23.50   19.50   21.75 22.00   24.00   23.25   19.50   20.75   18.25   21.50
16.75   19.00   22.25   21.00   16.75   19.00   22.25   21.00   19.50   22.75
18.25   21.00   18.50   20.75   21.25   22.25   22.75   21.75   19.50   20.75
23.00   20.00   22.75   20.00   20.00   24.50   17.50   22.25   18.00   21.00

Uses Another Phone Service Provider Frequency

Yes 354
No 64

Gold Card Leads to Two-Year
Agreement Frequency

Yes 38
No 380
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D I G I TA L C A S E
Apply your knowledge about confidence interval estimation
in this Digital Case, which extends the OurCampus! Digital
Case from Chapter 6.

Among its other features, the OurCampus! website allows cus-
tomers to purchase OurCampus! LifeStyles merchandise on-
line. To handle payment processing, the management of
OurCampus! has contracted with the following firms:

• PayAFriend (PAF) This is an online payment system
with which customers and businesses such as OurCampus!
register in order to exchange payments in a secure and con-
venient manner, without the need for a credit card.

• Continental Banking Company (Conbanco) This pro-
cessing services provider allows OurCampus! customers
to pay for merchandise using nationally recognized credit
cards issued by a financial institution.

To reduce costs, management is considering eliminating
one of these two payment systems. However, Lorraine
Hildick of the sales department suspects that customers use

the two forms of payment in unequal numbers and that
customers display different buying behaviors when using the
two forms of payment. Therefore, she would like to first
determine the following:

• The proportion of customers using PAF and the propor-
tion of customers using a credit card to pay for their
purchases.

• The mean purchase amount when using PAF and the
mean purchase amount when using a credit card.

Assist Ms. Hildick by preparing an appropriate
analysis. Open PaymentsSample.pdf, read Ms. Hildick’s
comments, and use her random sample of 50 transactions as
the basis for your analysis. Summarize your findings to
determine whether Ms. Hildick’s conjectures about
OurCampus! customer purchasing behaviors are correct. If
you want the sampling error to be no more than $3 when
estimating the mean purchase amount, is Ms. Hildick’s
sample large enough to perform a valid analysis?
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EG8.1 CONFIDENCE INTERVAL ESTIMATE
for the MEAN ( KNOWN)

PHStat2 Use Estimate for the Mean, sigma known to
compute the confidence interval estimate for the mean when

is known. For example, to compute the estimate for the
Example 8.1 mean paper length problem on page 284, select
PHStat ➔ Confidence Intervals ➔ Estimate for the
Mean, sigma known. In the procedure’s dialog box (shown
below):

1. Enter 0.02 as the Population Standard Deviation.

2. Enter 95 as the Confidence Level percentage.

3. Click Sample Statistics Known and enter 100 as the
Sample Size and 10.998 as the Sample Mean.

4. Enter a Title and click OK.

For problems that use unsummarized data, click
Sample Statistics Unknown and enter the Sample Cell
Range in step 3.

s

s
interval estimates for other problems, change the
Population Standard Deviation, Sample Mean, Sample
Size, and Confidence Level values in cells B4 through B7,
respectively. To examine all the formulas in the worksheet,
open to the COMPUTE_FORMULAS worksheet.

EG8.2 CONFIDENCE INTERVAL ESTIMATE
for the MEAN ( UNKNOWN)

PHStat2 Use Estimate for the Mean, sigma unknown to
compute the confidence interval estimate for the mean when

is unknown. For example, to compute the Figure 8.7 esti-
mate for the mean sales invoice amount (see page 289), se-
lect PHStat ➔ Confidence Intervals ➔ Estimate for the
Mean, sigma unknown. In the procedure’s dialog box
(shown below):

1. Enter 95 as the Confidence Level percentage.

2. Click Sample Statistics Known and enter 100 as the
Sample Size, 110.27 as the Sample Mean, and 28.95 as
the Sample Std. Deviation.

3. Enter a Title and click OK.

For problems that use unsummarized data, click Sample
Statistics Unknown and enter the Sample Cell Range in
step 3.

s

s

In-Depth Excel Use the CONFIDENCE worksheet func-
tion to compute the half-width of a confidence interval. En-
ter the function as CONFIDENCE(1 – confidence level,
population standard deviation, sample size).

Use the COMPUTE worksheet of the CIE sigma
known workbook as a template for computing confidence
interval estimates when is known. The worksheet also
uses NORMSINV(cumulative percentage) to compute the
Z value in cell B11 for one-half of the value.

The worksheet contains the data for the Example 8.1
mean paper length problem. To compute confidence

11 - a2
s In-Depth Excel Use the COMPUTE worksheet of the

CIE sigma unknown workbook, shown in Figure 8.7 on
page 289, as a template for computing confidence interval
estimates when is unknown. The worksheet contains the
data for the Section 8.2 example for estimating the mean

s
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sales invoice amount. In cell B12, the worksheet uses
TINV(1 – confidence level, degrees of freedom) to deter-
mine the critical value from the t distribution.

To compute confidence interval estimates for other
problems, change the Sample Standard Deviation, Sample
Mean, Sample Size, and Confidence Level values in cells
B4 through B7, respectively.

EG8.3 CONFIDENCE INTERVAL ESTIMATE
for the PROPORTION

PHStat2 Use Estimate for the Proportion to compute the
confidence interval estimate for the proportion. For exam-
ple, to compute the Figure 8.12 estimate for the proportion
of in-error sales invoices (see page 295), select PHStat ➔
Confidence Intervals ➔ Estimate for the Proportion. In
the procedure’s dialog box (shown below):

1. Enter 100 as the Sample Size.

2. Enter 10 as the Number of Successes.

3. Enter 95 as the Confidence Level percentage.

4. Enter a Title and click OK.

EG8.4 DETERMINING SAMPLE SIZE

Sample Size Determination for the Mean

PHStat2 Use Determination for the Mean to compute the
sample size needed for estimating the mean. For example,
to determine the sample size for the mean sales invoice
amount, shown in Figure 8.13 on page 299, select PHStat
➔ Sample Size ➔ Determination for the Mean. In the
procedure’s dialog box (shown below):

1. Enter 25 as the Population Standard Deviation.

2. Enter 5 as the Sampling Error.

3. Enter 95 as the Confidence Level percentage.

4. Enter a Title and click OK.

In-Depth Excel Use the COMPUTE worksheet of the
CIE Proportion workbook, shown in Figure 8.12 on page
295, as a template for computing confidence interval esti-
mates for the proportion. The worksheet contains the data
for the Figure 8.12 estimate for the proportion of in-error
sales invoices. In cell B10, the worksheet uses
NORMSINV((1 – confidence level) / 2) to compute the Z
value and, in cell B11, uses SQRT(sample proportion *
(1 – sample proportion) / sample size) to compute the stan-
dard error of the proportion.

To compute confidence interval estimates for other
problems, change the Sample Size, Number of
Successes, and Confidence Level values in cells B4
through B6.

In-Depth Excel Use the COMPUTE worksheet of the
Sample Size Mean workbook, shown in Figure 8.13 on
page 299, as a template for determining the sample size
needed for estimating the mean. The worksheet contains the
data for the Section 8.4 mean sales invoice amount problem.
In cell B9, the worksheet uses NORMSINV((1 –
confidence level) / 2) to compute the Z value and, in cell
B13, uses ROUNDUP(calculated sample size, 0) to round
up the calculated sample size to the next higher integer. To
compute confidence interval estimates for other problems,
change the Population Standard Deviation, Sampling Er-
ror, and Confidence Level values in cells B4 through B6.

Sample Size Determination for the Proportion

PHStat2 Use Determination for the Proportion to com-
pute the sample size needed for estimating the proportion.
For example, to determine the sample size for the proportion
of in-error sales invoices, shown in Figure 8.14 on page 301,
select PHStat ➔ Sample Size ➔ Determination for the
Proportion. In the procedure’s dialog box (shown on page
321):

1. Enter 0.15 as the Estimate of True Proportion.

2. Enter 0.07 as the Sampling Error.

3. Enter 95 as the Confidence Level percentage.

4. Enter a Title and click OK.
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In-Depth Excel Use the NORMSINV and ROUNDUP
functions to help determine the sample size needed for esti-
mating the proportion. Enter NORMSINV((1 – confidence

level)/2) to compute the Z value and enter
ROUNDUP(calculated sample size, 0) to round up the cal-
culated sample size to the next higher integer.

Use the COMPUTE worksheet of the Sample Size
Proportion workbook, shown in Figure 8.14 on page 301,
as a template for determining the sample size needed for es-
timating the proportion. The worksheet contains the data for
the Section 8.4 in-error sales invoice problem. The work-
sheet uses the NORMSINV and ROUNDUP functions in
the same way as discussed in the “Sample Size Determina-
tion for the Mean” In-Depth Excel instructions. To compute
confidence interval estimates for other problems, change
the Estimate of True Proportion, Sampling Error, and
Confidence Level in cells B4 through B6.

EG8.5 APPLICATIONS of CONFIDENCE
INTERVAL ESTIMATION in AUDITING

Estimating the Population Total Amount

PHStat2 Use Estimate for the Population Total to com-
pute the confidence interval estimate for the population total.
For example, to compute the Figure 8.15 estimate for the to-
tal of all sales invoices (see page 305), select PHStat ➔
Confidence Intervals ➔ Estimate for the Population Total.
In the procedure’s dialog box (shown in the right column):

1. Enter 5000 as the Population Size.

2. Enter 95 as the Confidence Level percentage.

3. Click Sample Statistics Known and enter 100 as the
Sample Size, 110.27 as the Sample Mean, and 28.95 as
the Sample Standard Deviation.

4. Enter a Title and click OK.

In-Depth Excel Use the COMPUTE worksheet of the
CIE Total workbook, shown in Figure 8.15 on page 305,
as a template for computing confidence interval estimates
for the population total. The worksheet contains the data for
the Figure 8.15 estimate for the total amount of all sales
invoices. In cell B15, the worksheet uses TINV(1 –
confidence level, degrees of freedom) to determine the t
value. To compute confidence interval estimates for other
problems, change the Population Size, Sample Mean,
Sample Size, Sample Standard Deviation, and
Confidence Level values in cells B4 through B8.

Difference Estimation

PHStat2 Use Estimate for the Total Difference to com-
pute the confidence interval estimate for the total differ-
ence. For example, to compute the Figure 8.16 estimate for
the total difference in the Saxon Home Improvement invoice
auditing example (see page 307), open to the DATA work-
sheet of the PlumbInv workbook. Select PHStat ➔
Confidence Intervals ➔ Estimate for the Total Differ-
ence. In the procedure’s dialog box (shown on page 322):

1. Enter 100 as the Sample Size.

2. Enter 5000 as the Population Size.

3. Enter 95 as the Confidence Level percentage.

4. Enter A1:A13 as the Differences Cell Range and check
First cell contains label.

5. Enter a Title and click OK.
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the data for the Figure 8.16 Saxon Home Improvement in-
voice auditing example, including the difference data from

.
In the worksheet, the Sum of Differences in cell B9 and

the Standard Deviation of Differences in cell B12 rely on
computations found in the DIFFERENCES worksheet. To
examine the formulas used in that worksheet, open to the
DIFFERENCES_FORMULAS worksheet in the same
workbook.

Computing the total difference confidence interval esti-
mate for other problems requires changes to both the COM-
PUTE and DIFFERENCES worksheets. First, in the
COMPUTE worksheet, change the Population Size,
Sample Size, and Confidence Level in cells B4 through
B6, respectively. Then, in the DIFFERENCES worksheet,
enter the differences in column A and adjust the column B
formulas so that there is a column B formula for each dif-
ference listed. If there are more than 12 differences, select
cell B13 and copy down through all the rows. If there are
fewer than 12 differences, delete formulas in column B from
the bottom up, starting with cell B13, until there are as
many formulas as there are difference values.

PlumbInv

This procedure creates a worksheet containing the results
and a second worksheet that contains computations that help
to calculate the standard deviation of the differences. (The
In-Depth Excel section that follows discusses contents of
the second worksheet.)

In-Depth Excel Use the COMPUTE worksheet of the
CIE Total Difference workbook, shown in Figure 8.16 on
page 307, as a template for computing confidence interval
estimates for the total difference. The worksheet contains

C H A P T E R 8 M I N I TA B G U I D E

MG8.1 CONFIDENCE INTERVAL ESTIMATE
for the MEAN ( KNOWN)

Use 1-Sample Z to compute a confidence interval estimate
for the mean when σ is known. For example, to compute the
estimate for the Example 8.1 mean paper length problem on
page 284, select Stat ➔ Basic Statistics ➔ 1-Sample Z. In
the 1-Sample Z (Test and Confidence Interval) dialog box
(shown below):

1. Click Summarized data.

2. Enter 100 in the Sample size box and 10.998 in the
Mean box.

3. Enter 0.02 in the Standard deviation box.

4. Click Options.

s
In the 1-Sample Z – Options dialog box (shown below):

5. Enter 95.0 in the Confidence level box.

6. Select not equal from the Alternative drop-down list.

7. Click OK.

8. Back in the original dialog box, click OK.

For problems that use unsummarized data, click Samples in
columns in step 1 and, in step 2, enter the name of the col-
umn that contains the data  in the Samples in columns box.
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In the 1 Proportion - Options dialog box (shown below):

4. Enter 95.0 in the Confidence level box.

5. Select not equal from the Alternative drop-down list.

6. Check Use test and interval based on normal distri-
bution.

7. Click OK (to return to the previous dialog box).

8. Back in the original dialog box, click OK.

For problems that use unsummarized data, click Samples in
columns in step 1 and, in step 2, enter the name of the col-
umn that contains the data.

MG8.4 DETERMINING SAMPLE SIZE

There are no Minitab instructions for this section.

MG8.5 APPLICATIONS of CONFIDENCE
INTERVAL ESTIMATION in AUDITING

There are no Minitab instructions for this section.

MG8.2 CONFIDENCE INTERVAL ESTIMATE
for the MEAN ( UNKNOWN)

Use 1-Sample t to compute a confidence interval estimate
for the mean when σ is unknown. For example, to compute
the Figure 8.7 estimate for the mean sales invoice amount
(see page 289), select Stat ➔ Basic Statistics ➔ 1-Sample
t. In the 1-Sample t (Test and Confidence Interval) dialog
box (shown below):

1. Click Summarized data.

2. Enter 100 in the Sample size box, 110.27 in the Mean
box, and 28.95 in the Standard deviation box.

3. Click Options.

s

In the 1-Sample t - Options dialog box (similar to the
1-Sample Z - Options dialog box on page 322):

4. Enter 95.0 in the Confidence level box.

5. Select not equal from the Alternative drop-down list.

6. Click OK.

7. Back in the original dialog box, click OK.

For problems that use unsummarized data, click Samples in
columns in step 1 and, in step 2, enter the name of the col-
umn that contains the data. To create a boxplot of the type
shown in Figure 8.9 on page 290, replace step 7 with these
steps 7 through 9:

7. Back in the original dialog box, click Graphs.

8. In the 1-Sample t - Graphs dialog box, check Boxplot of
data and then click OK.

9. Back in the original dialog box, click OK.

MG8.3 CONFIDENCE INTERVAL ESTIMATE
for the PROPORTION

Use 1 Proportion to compute the confidence interval esti-
mate for the population proportion. For example, to compute
the Figure 8.12 estimate for the proportion of in-error sales

invoices (see page 295), select Stat ➔ Basic Statistics ➔
1 Proportion. In the 1 Proportion dialog box (shown below):

1. Click Summarized data.

2. Enter 10 in the Number of events box and 100 in the
Number of trials box.

3. Click Options.
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Learning Objectives
In this chapter, you learn:

• The basic principles of hypothesis testing

• How to use hypothesis testing to test a mean or proportion

• The assumptions of each hypothesis-testing procedure, how to evaluate them,
and the consequences if they are seriously violated

• How to avoid the pitfalls involved in hypothesis testing

• Ethical issues involved in hypothesis testing
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U S I N G S TAT I S T I C S

@ Oxford Cereals, Part II

A s in Chapter 7, you again find yourself as plant operations manager for Oxford
Cereals. You are responsible for monitoring the amount in each cereal box filled.
Company specifications require a mean weight of 368 grams per box. It is your
responsibility to adjust the process when the mean fill weight in the population of
boxes differs from 368 grams. How can you make the decision about whether to

adjust the process when you are unable to weigh every single box as it is being filled? You begin by
selecting and weighing a random sample of 25 cereal boxes. After computing the sample mean, how
do you proceed?
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I n Chapter 7, you learned methods to determine whether the value of a sample mean is
consistent with a known population mean. In this Oxford Cereals scenario, you want to
use a sample mean to validate a claim about the population mean, a somewhat different

problem. For this type of problem, you use an inferential method called hypothesis testing.
Hypothesis testing requires that you state a claim unambiguously. In this scenario, the claim is
that the population mean is 368 grams. You examine a sample statistic to see if it better sup-
ports the stated claim, called the null hypothesis, or the mutually exclusive alternative hypoth-
esis (for this scenario, that the population mean is not 368 grams).

In this chapter, you will learn several applications of hypothesis testing. You will learn how
to make inferences about a population parameter by analyzing differences between the results
observed, the sample statistic, and the results you would expect to get if an underlying hypoth-
esis were actually true. For the Oxford Cereals scenario, hypothesis testing allows you to infer
one of the following:

• The mean weight of the cereal boxes in the sample is a value consistent with what you
would expect if the mean of the entire population of cereal boxes is 368 grams.

• The population mean is not equal to 368 grams because the sample mean is significantly
different from 368 grams.

9.1 Fundamentals of Hypothesis-Testing Methodology
Hypothesis testing typically begins with a theory, a claim, or an assertion about a particular
parameter of a population. For example, your initial hypothesis in the cereal example is that the
process is working properly, so the mean fill is 368 grams, and no corrective action is needed.

The Null and Alternative Hypotheses
The hypothesis that the population parameter is equal to the company specification is referred
to as the null hypothesis. A null hypothesis is often one of status quo and is identified by the
symbol Here the null hypothesis is that the filling process is working properly, and there-
fore the mean fill is the 368-gram specification provided by Oxford Cereals. This is stated as

Even though information is available only from the sample, the null hypothesis is stated in
terms of the population parameter because your focus is on the population of all cereal boxes.
You use the sample statistic to make inferences about the entire filling process. One inference
may be that the results observed from the sample data indicate that the null hypothesis is false.
If the null hypothesis is considered false, something else must be true.

Whenever a null hypothesis is specified, an alternative hypothesis is also specified, and it
must be true if the null hypothesis is false. The alternative hypothesis, is the opposite of
the null hypothesis, . This is stated in the cereal example as

The alternative hypothesis represents the conclusion reached by rejecting the null hypoth-
esis. The null hypothesis is rejected when there is sufficient evidence from the sample data that
the null hypothesis is false. In the cereal example, if the weights of the sampled boxes are suf-
ficiently above or below the expected 368-gram mean specified by Oxford Cereals, you reject
the null hypothesis in favor of the alternative hypothesis that the mean fill is different from
368 grams. You stop production and take whatever action is necessary to correct the problem.
If the null hypothesis is not rejected, you should continue to believe that the process is working
correctly and therefore no corrective action is necessary. In this second circumstance, you have
not proven that the process is working correctly. Rather, you have failed to prove that it is
working incorrectly, and therefore you continue your belief (although unproven) in the null
hypothesis.

H1 : m Z 368

H0

H1,

H0 : m = 368

H0.



You are the manager of a fast-food restaurant. You want to determine whether the waiting time
to place an order has changed in the past month from its previous population mean value of
4.5 minutes. State the null and alternative hypotheses.

SOLUTION The null hypothesis is that the population mean has not changed from its previ-
ous value of 4.5 minutes. This is stated as

The alternative hypothesis is the opposite of the null hypothesis. Because the null hypothesis
is that the population mean is 4.5 minutes, the alternative hypothesis is that the population
mean is not 4.5 minutes. This is stated as

H1 : m Z 4.5

H0 : m = 4.5

EXAMPLE 9.1
The Null and 
Alternative
Hypotheses
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In hypothesis testing, you reject the null hypothesis when the sample evidence suggests
that it is far more likely that the alternative hypothesis is true. However, failure to reject the
null hypothesis is not proof that it is true. You can never prove that the null hypothesis is cor-
rect because the decision is based only on the sample information, not on the entire popula-
tion. Therefore, if you fail to reject the null hypothesis, you can only conclude that there is
insufficient evidence to warrant its rejection. The following key points summarize the null and
alternative hypotheses:

• The null hypothesis, represents the current belief in a situation.
• The alternative hypothesis, is the opposite of the null hypothesis and represents a re-

search claim or specific inference you would like to prove.
• If you reject the null hypothesis, you have statistical proof that the alternative hypothe-

sis is correct.
• If you do not reject the null hypothesis, you have failed to prove the alternative hypothe-

sis. The failure to prove the alternative hypothesis, however, does not mean that you have
proven the null hypothesis.

• The null hypothesis, always refers to a specified value of the population parameter
(such as ), not a sample statistic (such as ).

• The statement of the null hypothesis always contains an equal sign regarding the speci-
fied value of the population parameter (e.g., grams).

• The statement of the alternative hypothesis never contains an equal sign regarding the
specified value of the population parameter (e.g., grams).H1 : m Z 368

H0 : m = 368

Xm

H0,

H1,
H0,

The Critical Value of the Test Statistic
The logic of hypothesis testing involves determining how likely the null hypothesis is to be true
by considering the data collected in a sample. In the Oxford Cereal Company scenario, the null
hypothesis is that the mean amount of cereal per box in the entire filling process is 368 grams
(the population parameter specified by the company). You select a sample of boxes from the
filling process, weigh each box, and compute the sample mean. This statistic is an estimate of
the corresponding parameter (the population mean, ). Even if the null hypothesis is true, the
statistic (the sample mean, ) is likely to differ from the value of the parameter (the population
mean, ) because of variation due to sampling. However, you expect the sample statistic to be
close to the population parameter if the null hypothesis is true. If the sample statistic is close to
the population parameter, you have insufficient evidence to reject the null hypothesis. For
example, if the sample mean is 367.9, you might conclude that the population mean has not
changed (i.e., ) because a sample mean of 367.9 is very close to the hypothesized value
of 368. Intuitively, you think that it is likely that you could get a sample mean of 367.9 from a
population whose mean is 368.

However, if there is a large difference between the value of the statistic and the hypothe-
sized value of the population parameter, you might conclude that the null hypothesis is false.
For example, if the sample mean is 320, you might conclude that the population mean is not
368 (i.e., ) because the sample mean is very far from the hypothesized value of 368.m Z 368

m = 368

m
X

m
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In such a case, you conclude that it is very unlikely to get a sample mean of 320 if the popula-
tion mean is really 368. Therefore, it is more logical to conclude that the population mean is
not equal to 368. Here you reject the null hypothesis.

However, the decision-making process is not always so clear-cut. Determining what is
“very close” and what is “very different” is arbitrary without clear definitions. Hypothesis-
testing methodology provides clear definitions for evaluating differences. Furthermore, it en-
ables you to quantify the decision-making process by computing the probability of getting a
certain sample result if the null hypothesis is true. You calculate this probability by determin-
ing the sampling distribution for the sample statistic of interest (e.g., the sample mean) and
then computing the particular test statistic based on the given sample result. Because the sam-
pling distribution for the test statistic often follows a well-known statistical distribution, such
as the standardized normal distribution or t distribution, you can use these distributions to help
determine whether the null hypothesis is true.

Regions of Rejection and Nonrejection
The sampling distribution of the test statistic is divided into two regions, a region of rejection
(sometimes called the critical region) and a region of nonrejection (see Figure 9.1). If the test
statistic falls into the region of nonrejection, you do not reject the null hypothesis. In the Ox-
ford Cereals scenario, you conclude that there is insufficient evidence that the population mean
fill is different from 368 grams. If the test statistic falls into the rejection region, you reject the
null hypothesis. In this case, you conclude that the population mean is not 368 grams.

Region of
Rejection

Region of
Nonrejection

Critical
Value

Region of
Rejection

Critical
Value

μ X

F I G U R E 9 . 1
Regions of rejection
and nonrejection in
hypothesis testing

The region of rejection consists of the values of the test statistic that are unlikely to occur
if the null hypothesis is true. These values are much more likely to occur if the null hypothesis
is false. Therefore, if a value of the test statistic falls into this rejection region, you reject the
null hypothesis because that value is unlikely if the null hypothesis is true.

To make a decision concerning the null hypothesis, you first determine the critical value
of the test statistic. The critical value divides the nonrejection region from the rejection region.
Determining the critical value depends on the size of the rejection region. The size of the re-
jection region is directly related to the risks involved in using only sample evidence to make
decisions about a population parameter.

Risks in Decision Making Using Hypothesis Testing
Using hypothesis testing involves the risk of reaching an incorrect conclusion. You might
wrongly reject a true null hypothesis, or, conversely, you might wrongly not reject a false
null hypothesis, These types of risk are called Type I and Type II errors.H0.

H0,

TYPE I AND TYPE II ERRORS
A Type I error occurs if you reject the null hypothesis, when it is true and should not
be rejected. A Type I error is a “false alarm.” The probability of a Type I error occurring is
A Type II error occurs if you do not reject the null hypothesis, when it is false and
should be rejected. A Type II error represents a “missed opportunity” to take some corrective
action. The probability of a Type II error occurring is b.

H0,
a.

H0,



9.1 Fundamentals of Hypothesis-Testing Methodology 329

In the Oxford Cereals scenario, you would make a Type I error if you concluded that the
population mean fill is not 368 when it is 368. This error causes you to needlessly adjust the
filling process (the “false alarm”) even though the process is working properly. In the same
scenario, you would make a Type II error if you concluded that the population mean fill is 368
when it is not 368. In this case, you would allow the process to continue without adjustment,
even though an adjustment is needed (the “missed opportunity”).

Traditionally, you control the Type I error by determining the risk level, (the lowercase
Greek letter alpha) that you are willing to have of rejecting the null hypothesis when it is true.
This risk, or probability, of committing a Type I error is called the level of significance ( ). Be-
cause you specify the level of significance before you perform the hypothesis test, you directly
control the risk of committing a Type I error. Traditionally, you select a level of 0.01, 0.05, or
0.10. The choice of a particular risk level for making a Type I error depends on the cost of mak-
ing a Type I error. After you specify the value for you can then determine the critical values
that divide the rejection and nonrejection regions. You know the size of the rejection region be-
cause is the probability of rejection when the null hypothesis is true. From this, you can then
determine the critical value or values that divide the rejection and nonrejection regions.

The probability of committing a Type II error is called the risk. Unlike a Type I error,
which you control through the selection of the probability of making a Type II error
depends on the difference between the hypothesized and actual values of the population
parameter. Because large differences are easier to find than small ones, if the difference
between the hypothesized and actual value of the population parameter is large, is small.
For example, if the population mean is 330 grams, there is a small chance that you will
conclude that the mean has not changed from 368. However, if the difference between the
hypothesized and actual value of the parameter is small, is large. For example, if the pop-
ulation mean is actually 367 grams, there is a large chance that you will conclude that
the mean is still 368 grams.

1b2b

1b2 b

a,
b

a

a,

a

a

PROBABILITY OF TYPE I AND TYPE II ERRORS
The level of significance ( ) of a statistical test is the probability of committing a Type I
error.
The risk is the probability of committing a Type II error.B

A

The complement of the probability of a Type I error, is called the confidence
coefficient. The confidence coefficient is the probability that you will not reject the null hy-
pothesis, when it is true and should not be rejected. In the Oxford Cereals scenario, the
confidence coefficient measures the probability of concluding that the population mean fill is
368 grams when it is actually 368 grams.

The complement of the probability of a Type II error, is called the power of a
statistical test. The power of a statistical test is the probability that you will reject the null hy-
pothesis when it is false and should be rejected. In the Oxford Cereals scenario, the power of
the test is the probability that you will correctly conclude that the mean fill amount is not 368
grams when it actually is not 368 grams. For an extended discussion of the power of a statisti-
cal test, read the Section 9.6 online topic file that is available in on this book’s companion
website. (See Appendix C to learn how to access the online topic files.)

11 - b2,

H0,

11 - a2,

COMPLEMENTS OF TYPE I AND TYPE II ERRORS
The confidence coefficient, is the probability that you will not reject the null
hypothesis, when it is true and should not be rejected.
The power of a statistical test, is the probability that you will reject the null
hypothesis when it is false and should be rejected.

11 - b2,H0,
11 - a2,

Risks in Decision Making: A Delicate Balance Table 9.1 illustrates the results of the
two possible decisions (do not reject or reject ) that you can make in any hypothesis test.
You can make a correct decision or make one of two types of errors.

H0H0
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T A B L E 9 . 1

Hypothesis Testing and
Decision Making

Actual Situation

Statistical Decision TrueH0 FalseH0

Do not reject H0 Correct decision
Confidence = 11 - a2 Type II error

P1Type II error2 = b

Reject H0 Type I error
P1Type I error2 = a

Correct decision
Power = 11 - b2

One way to reduce the probability of making a Type II error is by increasing the sample
size. Large samples generally permit you to detect even very small differences between the hy-
pothesized values and the actual population parameters. For a given level of increasing the
sample size decreases and therefore increases the power of the statistical test to detect that
the null hypothesis, is false.

However, there is always a limit to your resources, and this affects the decision of how large a
sample you can select. For any given sample size, you must consider the trade-offs between the two
possible types of errors. Because you can directly control the risk of Type I error, you can reduce
this risk by selecting a smaller value for For example, if the negative consequences associated
with making a Type I error are substantial, you could select instead of 0.05. However,
when you decrease you increase so reducing the risk of a Type I error results in an increased
risk of a Type II error. However, to reduce you could select a larger value for Therefore, if it is
important to try to avoid a Type II error, you can select of 0.05 or 0.10 instead of 0.01.

In the Oxford Cereals scenario, the risk of a Type I error occurring involves concluding
that the mean fill amount has changed from the hypothesized 368 grams when it actually has
not changed. The risk of a Type II error occurring involves concluding that the mean fill
amount has not changed from the hypothesized 368 grams when it actually has changed. The
choice of reasonable values for and depends on the costs inherent in each type of error.
For example, if it is very costly to change the cereal-filling process, you would want to be very
confident that a change is needed before making any changes. In this case, the risk of a Type I
error occurring is more important, and you would choose a small However, if you want to
be very certain of detecting changes from a mean of 368 grams, the risk of a Type II error oc-
curring is more important, and you would choose a higher level of 

Now that you have been introduced to hypothesis testing, recall that in the Using Statistics
scenario on page 325, the business problem facing Oxford Cereals is to determine whether the
cereal-filling process is working properly (i.e., whether the mean fill throughout the entire pack-
aging process remains at the specified 368 grams, and no corrective action is needed). To evaluate
the 368-gram requirement, you select a random sample of 25 boxes, weigh each box, compute
the sample mean, and then evaluate the difference between this sample statistic and the hypoth-
esized population parameter by comparing the sample mean weight (in grams) to the expected
population mean of 368 grams specified by the company. The null and alternative hypotheses are

When the standard deviation, is known (which rarely occurs), you use the Z test for the
mean if the population is normally distributed. If the population is not normally distributed, you
can still use the Z test if the sample size is large enough for the Central Limit Theorem to take effect
(see Section 7.4). Equation (9.1) defines the test statistic for determining the difference be-
tween the sample mean, and the population mean, when the standard deviation, is known.s,m,X ,

ZSTAT

s,

H1 : m Z 368

H0 : m = 368

X ,

a.

a.

ba

a

a.b,
b,a,

a = 0.01
a.

H0,
b

a,

Z TEST FOR THE MEAN ( KNOWN)

(9.1)ZSTAT =
X - m
s1n

s
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In Equation (9.1), the numerator measures the difference between the observed sample
mean, and the hypothesized mean, The denominator is the standard error of the mean, so

represents the difference between and in standard error units.

Hypothesis Testing Using the Critical Value Approach
The critical value approach compares the computed test statistic value from Equation (9.1)
to critical values that divide the normal distribution into regions of rejection and nonrejection.
The critical values are expressed as standardized Z values that are determined by the level of
significance.

For example, if you use a level of significance of 0.05, the size of the rejection region is
0.05. Because the rejection region is divided into the two tails of the distribution, you divide
the 0.05 into two equal parts of 0.025 each. For this two-tail test, a rejection region of 0.025 in
each tail of the normal distribution results in a cumulative area of 0.025 below the lower criti-
cal value and a cumulative area of 0.975 below the upper critical value (which
leaves an area of 0.025 in the upper tail). According to the cumulative standardized normal dis-
tribution table (Table E.2), the critical values that divide the rejection and nonrejection regions
are and Figure 9.2 illustrates that if the mean is actually 368 grams, as
claims, the values of the test statistic have a standardized normal distribution centered at

(which corresponds to an value of 368 grams). Values of greater than or
less than indicate that is sufficiently different from the hypothesized that it
is unlikely that such an value would occur if were true.H0X

m = 368X-1.96
+1.96ZSTATXZ = 0

ZSTAT

H0+1.96.-1.96

11 - 0.0252

ZSTAT

mXZSTAT

m.X ,

Region of
Rejection

Region of
Nonrejection

Critical
Value

Region of
Rejection

Critical
Value

–1.96 0 +1.96 Z
.025 .025

368

.95

X

F I G U R E 9 . 2
Testing a hypothesis
about the mean (
known) at the 0.05 level
of significance

s

Therefore, the decision rule is

Suppose that the sample of 25 cereal boxes indicates a sample mean, of 372.5 grams,
and the population standard deviation, is 15 grams. Using Equation (9.1) on page 330,

Because is between and you do not reject (see Figure 9.3).
You continue to believe that the mean fill amount is 368 grams. To take into account the
possibility of a Type II error, you state the conclusion as “there is insufficient evidence that the
mean fill is different from 368 grams.”

Exhibit 9.1 summarizes the critical value approach to hypothesis testing. Steps 1 though 4
correspond to the Define task, step 5 combines the Collect and Organize tasks, and step 6 cor-
responds to the Visualize and Analyze tasks of the business problem-solving methodology first
introduced in Chapter 2.

H0+1.96,-1.96ZSTAT = +1.50

ZSTAT = X - m
s1n

-
372.5 - 368

15125

= +1.50

s,
X

otherwise, do not reject H0.

or if ZSTAT 6 -1.96;

Reject H0 if ZSTAT 7 +1.96



State the critical value approach to hypothesis testing at Oxford Cereals.

SOLUTION
Step 1: State the null and alternative hypotheses. The null hypothesis, is always stated as a

mathematical expression, using population parameters. In testing whether the mean
fill is 368 grams, the null hypothesis states that equals 368. The alternative hypoth-
esis, is also stated as a mathematical expression, using population parameters.
Therefore, the alternative hypothesis states that is not equal to 368 grams.

Step 2: Choose the level of significance and the sample size. You choose the level of signifi-
cance, according to the relative importance of the risks of committing Type I and
Type II errors in the problem. The smaller the value of the less risk there is of mak-
ing a Type I error. In this example, making a Type I error means that you conclude that
the population mean is not 368 grams when it is 368 grams. Thus, you will take cor-
rective action on the filling process even though the process is working properly. Here,

is selected. The sample size, n, is 25.
Step 3: Select the appropriate test statistic. Because is known from information about the

filling process, you use the normal distribution and the test statistic.
Step 4: Determine the rejection region. Critical values for the appropriate test statistic are

selected so that the rejection region contains a total area of when is true and the
nonrejection region contains a total area of when is true. Because
in the cereal example, the critical values of the test statistic are and

The rejection region is therefore or The non-
rejection region is 

Step 5: Collect the sample data and compute the value of the test statistic. In the cereal
example, and the value of the test statistic is 

Step 6: State the statistical decision and the managerial conclusion. First, determine whether
the test statistic has fallen into the rejection region or the nonrejection region. For the
cereal example, is in the region of nonrejection becauseZSTAT = +1.50

ZSTAT = +1.50.X = 372.5,

-1.96 … ZSTAT … +1.96.
ZSTAT 7 +1.96.ZSTAT 6 -1.96+1.96.

-1.96ZSTAT

a = 0.05H01 - a
H0a

ZSTAT

s

a = 0.05

a,
a,

m

H1,
m

H0,

EXAMPLE 9.2
Applying the
Critical Value
Approach to
Hypothesis Testing
at Oxford Cereals
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0–1.96 +1.96+1.50 Z
Region of
Rejection

Region of
Nonrejection

Region of
Rejection

.025.025

.95

F I G U R E 9 . 3
Testing a hypothesis
about the mean cereal
weight ( known) at the
0.05 level of significance

s

EXHIBIT 9.1 THE CRITICAL VALUE APPROACH TO HYPOTHESIS TESTING
1. State the null hypothesis, and the alternative hypothesis,
2. Choose the level of significance, and the sample size, n. The level of significance is

based on the relative importance of the risks of committing Type I and Type II errors in
the problem.

3. Determine the appropriate test statistic and sampling distribution.
4. Determine the critical values that divide the rejection and nonrejection regions.
5. Collect the sample data, organize the results, and compute the value of the test statistic.
6. Make the statistical decision and state the managerial conclusion. If the test statistic

falls into the nonrejection region, you do not reject the null hypothesis. If the test sta-
tistic falls into the rejection region, you reject the null hypothesis. The managerial
conclusion is written in the context of the real-world problem.

a,
H1.H0,



You are the manager of a fast-food restaurant. The business problem is to determine whether
the population mean waiting time to place an order has changed in the past month from its pre-
vious population mean value of 4.5 minutes. From past experience, you can assume that the
population is normally distributed, with a population standard deviation of 1.2 minutes. You
select a sample of 25 orders during a one-hour period. The sample mean is 5.1 minutes. Use
the six-step approach listed in Exhibit 9.1 on page 332 to determine whether there is evidence
at the 0.05 level of significance that the population mean waiting time to place an order has
changed in the past month from its previous population mean value of 4.5 minutes.

SOLUTION
Step 1: The null hypothesis is that the population mean has not changed from its previous

value of 4.5 minutes:

The alternative hypothesis is the opposite of the null hypothesis. Because the null
hypothesis is that the population mean is 4.5 minutes, the alternative hypothesis is that
the population mean is not 4.5 minutes:

Step 2: You have selected a sample of The level of significance is 0.05 (i.e., ).
Step 3: Because is assumed known, you use the normal distribution and the test statistic.
Step 4: Because the critical values of the test statistic are and

The rejection region is or The nonrejection region is

Step 5: You collect the sample data and compute Using Equation (9.1) on page 330,
you compute the test statistic:

Step 6: Because you reject the null hypothesis. You conclude that
there is evidence that the population mean waiting time to place an order has changed
from its previous value of 4.5 minutes. The mean waiting time for customers is longer
now than it was last month. As the manager, you would now want to determine how
waiting time could be reduced to improve service.

ZSTAT = +2.50 7 +1.96,

ZSTAT = X - m
s1n

=
5.1 - 4.5

1.2125

= +2.50

X = 5.1.
-1.96 … ZSTAT … +1.96

ZSTAT 7 +1.96.ZSTAT 6 -1.96
+1.96.-1.96ZSTATa = 0.05,

ZSTATs

a = 0.05n = 25.

H1 : m Z 4.5

H0 : m = 4.5

EXAMPLE 9.3
Testing and
Rejecting a Null
Hypothesis
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Because the test statistic falls into the nonre-
jection region, the statistical decision is to not reject the null hypothesis, The
managerial conclusion is that insufficient evidence exists to prove that the mean fill is
different from 368 grams. No corrective action on the filling process is needed.

H0.
-1.96 … ZSTAT = +1.50 … +1.96.

Hypothesis Testing Using the p-Value Approach
Using the p-value to determine rejection and nonrejection is another approach to hypothesis testing.

p-VALUE
The p-value is the probability of getting a test statistic equal to or more extreme than the
sample result, given that the null hypothesis, is true. The p-value is also known as the
observed level of significance.

H0,

The decision rules for rejecting in the p-value approach are

• If the p-value is greater than or equal to do not reject the null hypothesis.
• If the p-value is less than reject the null hypothesis.a,

a,

H0
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In this example, the observed sample mean is 372.5 grams, 4.5 grams above the hypothesized
value, and the p-value is 0.1336. Thus, if the population mean is 368 grams, there is a 13.36%
chance that the sample mean differs from 368 grams by at least 4.5 grams (i.e., is grams
or grams). Therefore, even though 372.5 is above the hypothesized value of 368, a result
as extreme as or more extreme than 372.5 is not highly unlikely when the population mean is 368.

Unless you are dealing with a test statistic that follows the normal distribution, you will
only be able to approximate the p-value from the tables of the distribution. However, Excel and
Minitab can compute the p-value for any hypothesis test, and this allows you to substitute the
p-value approach for the critical value approach when you do hypothesis testing.

Figure 9.5 shows the results for the cereal-filling example discussed in this section, as
computed by Excel (left results) and Minitab (right results). These results include the test
statistic and critical values.

ZSTAT

… 363.5
Ú 372.5

–1.50 0 +1.50 Z
.0668 .0668

.8664

F I G U R E 9 . 4
Finding a p-value for a
two-tail test

Many people confuse these rules, mistakenly believing that a high p-value is reason for rejec-
tion. You can avoid this confusion by remembering the following:

If the p-value is low, then must go.H0

To understand the p-value approach, consider the Oxford Cereals scenario. You tested
whether the mean fill was equal to 368 grams. The test statistic resulted in a value of

and you did not reject the null hypothesis because was less than the upper criti-
cal value of and greater than the lower critical value of 

To use the p-value approach for the two-tail test, you find the probability of getting a test
statistic that is equal to or more extreme than 1.50 standard error units from the center of a
standardized normal distribution. In other words, you need to compute the probability of a
value greater than along with the probability of a value less than Table E.2
shows that the probability of a value below is 0.0668. The probability of a value
below is 0.9332, and the probability of a value above is
Therefore, the p-value for this two-tail test is (see Figure 9.4). Thus,
the probability of a test statistic equal to or more extreme than the sample result is 0.1336.
Because 0.1336 is greater than you do not reject the null hypothesis.a = 0.05,

0.0668 + 0.0668 = 0.1336
1 - 0.9332 = 0.0668.+1.50+1.50

-1.50ZSTAT

-1.50.ZSTAT+1.50,
ZSTAT

ZSTAT

-1.96.+1.96
+1.50+1.50,

ZSTAT

F I G U R E 9 . 5
Excel and Minitab results for the Z test for the mean ( known) for the cereal-filling examples
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EXHIBIT 9.2 THE p-VALUE APPROACH TO HYPOTHESIS TESTING
1. State the null hypothesis, and the alternative hypothesis,
2. Choose the level of significance, and the sample size, n. The level of significance is

based on the relative importance of the risks of committing Type I and Type II errors in
the problem.

3. Determine the appropriate test statistic and the sampling distribution.
4. Collect the sample data, compute the value of the test statistic, and compute the p-value.
5. Make the statistical decision and state the managerial conclusion. If the p-value is

greater than or equal to do not reject the null hypothesis. If the p-value is less than
reject the null hypothesis. The managerial conclusion is written in the context of the

real-world problem.
a,

a,

a,
H1.H0,

Exhibit 9.2 summarizes the p-value approach to hypothesis testing.

You are the manager of a fast-food restaurant. The business problem is to determine whether the
population mean waiting time to place an order has changed in the past month from its previous
value of 4.5 minutes. From past experience, you can assume that the population standard deviation
is 1.2 minutes and the population waiting time is normally distributed.You select a sample of 25 or-
ders during a one-hour period. The sample mean is 5.1 minutes. Use the five-step p-value approach
of Exhibit 9.2 to determine whether there is evidence that the population mean waiting time to place
an order has changed in the past month from its previous population mean value of 4.5 minutes.

SOLUTION
Step 1: The null hypothesis is that the population mean has not changed from its previous

value of 4.5 minutes:

The alternative hypothesis is the opposite of the null hypothesis. Because the null
hypothesis is that the population mean is 4.5 minutes, the alternative hypothesis is that
the population mean is not 4.5 minutes:

Step 2: You have selected a sample of and you have chosen a 0.05 level of signifi-
cance (i.e., ).

Step 3: Select the appropriate test statistic. Because is assumed known, you use the normal
distribution and the test statistic.

Step 4: You collect the sample data and compute Using Equation (9.1) on page 330,
you compute the test statistic as follows:

To find the probability of getting a test statistic that is equal to or more extreme
than 2.50 standard error units from the center of a standardized normal distribution,
you compute the probability of a value greater than along with the proba-
bility of a value less than From Table E.2, the probability of a value
below is 0.0062. The probability of a value below is 0.9938. Therefore,
the probability of a value above is Thus, the p-value for
this two-tail test is 

Step 5: Because the p-value you reject the null hypothesis. You con-
clude that there is evidence that the population mean waiting time to place an order has
changed from its previous population mean value of 4.5 minutes. The mean waiting
time for customers is longer now than it was last month.

= 0.0124 6 a = 0.05,
0.0062 + 0.0062 = 0.0124.

1 - 0.9938 = 0.0062.+2.50
+2.50-2.50

ZSTAT-2.50.ZSTAT

+2.50ZSTAT

ZSTAT

ZSTAT = X - m
s1n

=
5.1 - 4.5

1.2125

= +2.50

X = 5.1.
ZSTAT

s

a = 0.05
n = 25,

H1 : m Z 4.5

H0 : m = 4.5

EXAMPLE 9.4
Testing and
Rejecting a Null
Hypothesis Using
the p-Value
Approach
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A Connection Between Confidence Interval Estimation 
and Hypothesis Testing
This chapter and Chapter 8 discuss confidence interval estimation and hypothesis testing, the two
major elements of statistical inference. Although confidence interval estimation and hypothesis
testing share the same conceptual foundation, they are used for different purposes. In Chapter 8,
confidence intervals estimated parameters. In this chapter, hypothesis testing makes decisions
about specified values of population parameters. Hypothesis tests are used when trying to deter-
mine whether a parameter is less than, more than, or not equal to a specified value. Proper inter-
pretation of a confidence interval, however, can also indicate whether a parameter is less than,
more than, or not equal to a specified value. For example, in this section, you tested whether the
population mean fill amount was different from 368 grams by using Equation (9.1) on page 330:

Instead of testing the null hypothesis that grams, you can reach the same
conclusion by constructing a confidence interval estimate of If the hypothesized value of

is contained within the interval, you do not reject the null hypothesis because 368
would not be considered an unusual value. However, if the hypothesized value does not fall
into the interval, you reject the null hypothesis because grams is then considered an
unusual value. Using Equation (8.1) on page 283 and the following data:

for a confidence level of 95% (i.e., ),

so that

Because the interval includes the hypothesized value of 368 grams, you do not reject the
null hypothesis. There is insufficient evidence that the mean fill amount over the entire filling
process is not 368 grams. You reached the same decision by using two-tail hypothesis testing.

Can You Ever Know the Population Standard Deviation?
The end of Section 8.1 on page 285 discussed how learning a confidence interval estimation
method that required knowing the population standard deviation, served as an effective in-
troduction to the concept of a confidence interval. That passage then revealed that you would
be unlikely to use that procedure for most practical applications for several reasons.

Likewise, for most practical applications, you are unlikely to use a hypothesis-testing
method that requires knowing If you knew the population standard deviation, you would
also know the population mean and would not need to form a hypothesis about the mean and
then test that hypothesis. So why study a hypothesis testing of the mean that requires that is
known? Using such a test makes it much easier to explain the fundamentals of hypothesis test-
ing. With a known population standard deviation, you can use the normal distribution and
compute p-values using the tables of the normal distribution.

Because it is important that you understand the concept of hypothesis testing when read-
ing the rest of this book, review this section carefully—even if you anticipate never having a
practical reason to use the test represented by Equation (9.1).

s

s.

s,

366.62 … m … 378.38

372.5 ; 5.88

372.5 ; 11.962 15225

X ; Za>2
s1n

a = 0.05

n = 25, X = 372.5 grams,s = 15 grams

m = 368

m = 368
m.

m = 368

ZSTAT =
X - m
s1n
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Problems for Section 9.1
LEARNING THE BASICS
9.1 If you use a 0.05 level of significance in a (two-tail)
hypothesis test, what will you decide if 

9.2 If you use a 0.05 level of significance in a (two-tail)
hypothesis test, what will you decide if 

9.3 If you use a 0.10 level of significance in a (two-tail)
hypothesis test, what is your decision rule for rejecting a
null hypothesis that the population mean is 500 if you use
the Z test?

9.4 If you use a 0.01 level of significance in a (two-tail)
hypothesis test, what is your decision rule for rejecting

if you use the Z test?

9.5 What is your decision in Problem 9.4 if

9.6 What is the p-value if, in a two-tail hypothesis test,

9.7 In Problem 9.6, what is your statistical decision if you
test the null hypothesis at the 0.10 level of significance?

9.8 What is the p-value if, in a two-tail hypothesis test,

APPLYING THE CONCEPTS
9.9 In the U.S. legal system, a defendant is presumed
innocent until proven guilty. Consider a null hypothesis,
that the defendant is innocent, and an alternative hypothesis,

that the defendant is guilty. A jury has two possible
decisions: Convict the defendant (i.e., reject the null
hypothesis) or do not convict the defendant (i.e., do not re-
ject the null hypothesis). Explain the meaning of the risks of
committing either a Type I or Type II error in this example.

9.10 Suppose the defendant in Problem 9.9 is presumed
guilty until proven innocent, as in some other judicial
systems. How do the null and alternative hypotheses differ
from those in Problem 9.9? What are the meanings of the
risks of committing either a Type I or Type II error here?

9.11 Many consumer groups feel that the U.S. Food and
Drug Administration (FDA) drug approval process is too
easy and, as a result, too many drugs are approved that are
later found to be unsafe. On the other hand, a number of
industry lobbyists have pushed for a more lenient approval
process so that pharmaceutical companies can get new
drugs approved more easily and quickly. Consider a null
hypothesis that a new, unapproved drug is unsafe and an al-
ternative hypothesis that a new, unapproved drug is safe.
a. Explain the risks of committing a Type I or Type II error.
b. Which type of error are the consumer groups trying to

avoid? Explain.
c. Which type of error are the industry lobbyists trying to

avoid? Explain.

H1,

H0,

ZSTAT = -1.38?

ZSTAT = + 2.00?

ZSTAT = -2.61?

H0 : m = 12.5

ZSTAT = + 2.21?

ZSTAT = -0.76?

d. How would it be possible to lower the chances of both
Type I and Type II errors?

9.12 As a result of complaints from both students and
faculty about lateness, the registrar at a large university
wants to determine whether the scheduled break between
classes should be changed and, therefore, is ready to under-
take a study. Until now, the registrar has believed that there
should be 20 minutes between scheduled classes. State the
null hypothesis, and the alternative hypothesis,

9.13 Do students at your school study more than, less
than, or about the same as students at other business
schools? BusinessWeek reported that at the top 50 business
schools, students studied an average of 14.6 hours per
week. (Data extracted from “Cracking the Books,” Special
Report/Online Extra, www.businessweek.com, March 19,
2007.) Set up a hypothesis test to try to prove that the
mean number of hours studied at your school is different
from the 14.6-hour-per-week benchmark reported by
BusinessWeek.
a. State the null and alternative hypotheses.
b. What is a Type I error for your test?
c. What is a Type II error for your test?

9.14 The quality-control manager at a light bulb
factory needs to determine whether the mean life of

a large shipment of light bulbs is equal to 375 hours. The pop-
ulation standard deviation is 100 hours. A random sample of
64 light bulbs indicates a sample mean life of 350 hours.
a. At the 0.05 level of significance, is there evidence that

the mean life is different from 375 hours?
b. Compute the p-value and interpret its meaning.
c. Construct a 95% confidence interval estimate of the pop-

ulation mean life of the light bulbs.
d. Compare the results of (a) and (c). What conclusions do

you reach?

9.15 Suppose that in Problem 9.14, the standard deviation
is 120 hours.
a. Repeat (a) through (d) of Problem 9.14, assuming a stan-

dard deviation of 120 hours.
b. Compare the results of (a) to those of Problem 9.14.

9.16 The manager of a paint supply store wants to deter-
mine whether the mean amount of paint contained in
1-gallon cans purchased from a nationally known manu-
facturer is actually 1 gallon. You know from the manufac-
turer’s specifications that the standard deviation of the
amount of paint is 0.02 gallon. You select a random sam-
ple of 50 cans, and the mean amount of paint per 1-gallon
can is 0.995 gallon.
a. Is there evidence that the mean amount is different from

1.0 gallon? (Use )
b. Compute the p-value and interpret its meaning.

a = 0.01.

SELF
Test

H1.H0,

www.businessweek.com
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c. Construct a 99% confidence interval estimate of the pop-
ulation mean amount of paint.

d. Compare the results of (a) and (c). What conclusions do
you reach?

9.17 Suppose that in Problem 9.16, the standard deviation
is 0.012 gallon.

a. Repeat (a) through (d) of Problem 9.16, assuming a stan-
dard deviation of 0.012 gallon.

b. Compare the results of (a) to those of Problem 9.16.

9.2 t Test of Hypothesis for the Mean ( Unknown)s
In virtually all hypothesis-testing situations concerning the population mean, you do not
know the population standard deviation, Instead, you use the sample standard deviation, S.
If you assume that the population is normally distributed, the sampling distribution of the mean
follows a t distribution with degrees of freedom, and you use the t test for the mean. If
the population is not normally distributed, you can still use the t test if the sample size is large
enough for the Central Limit Theorem to take effect (see Section 7.4). Equation (9.2) defines
the test statistic for determining the difference between the sample mean, , and the popula-
tion mean, when using the sample standard deviation, S.m,

X

n - 1

s.
m,

t TEST FOR THE MEAN ( UNKNOWN)

(9.2)

where the test statistic follows a t distribution having degrees of freedom.n - 1tSTAT

tSTAT = X - m
S1n

s

To illustrate the use of the t test for the mean, return to the Chapter 8 Saxon Home Improve-
ment scenario on page 279. The business objective is to determine whether the mean amount per
sales invoice is unchanged from the $120 of the past five years. As an accountant for the com-
pany, you need to determine whether this amount changes. In other words, the hypothesis test is
used to try to determine whether the mean amount per sales invoice is increasing or decreasing.

The Critical Value Approach
To perform this two-tail hypothesis test, you use the six-step method listed in Exhibit 9.1 on
page 332.

Step 1 You define the following hypotheses:

The alternative hypothesis contains the statement you are trying to prove. If the null
hypothesis is rejected, then there is statistical evidence that the population mean
amount per sales invoice is no longer $120. If the statistical conclusion is “do not
reject ” then you will conclude that there is insufficient evidence to prove that the
mean amount differs from the long-term mean of $120.

Step 2 You collect the data from a sample of sales invoices.You decide to use
Step 3 Because is unknown, you use the t distribution and the test statistic. You must

assume that the population of sales invoices is normally distributed because the sam-
ple size of 12 is too small for the Central Limit Theorem to take effect. This assump-
tion is discussed on page 340.

Step 4 For a given sample size, n, the test statistic follows a t distribution with
degrees of freedom. The critical values of the t distribution with degrees
of freedom are found in Table E.3, as illustrated in Table 9.2 and Figure 9.6. The alter-
native hypothesis, has two tails. The area in the rejection region of theH1 : m Z $120,

12 - 1 = 11
n - 1tSTAT

tSTATs

a = 0.05.n = 12

H0,

H1 : m Z $120

H0 : m = $120
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t distribution’s left (lower) tail is 0.025, and the area in the rejection region of the t dis-
tribution’s right (upper) tail is also 0.025.

From the t table as given in Table E.3, a portion of which is shown in Table 9.2,
the critical values are The decision rule is

otherwise, do not reject H0.

or if tSTAT 7 +2.2010;

Reject H0 if tSTAT 6 -2.2010

;2.2010.

T A B L E 9 . 2

Determining the
Critical Value from the
t Table for an Area of
0.025 in Each Tail, with
11 Degrees of
Freedom

Cumulative Probabilities

.75 .90 .95 .975 .99 .995

Upper-Tail Areas

Degrees of Freedom .25 .10 .05 .025 .01 .005

1 1.0000 3.0777 6.3138 12.7062 31.8207 63.6574
2 0.8165 1.8856 2.9200 4.3027 6.9646 9.9248
3 0.7649 1.6377 2.3534 3.1824 4.5407 5.8409
4 0.7407 1.5332 2.1318 2.7764 3.7469 4.6041
5 0.7267 1.4759 2.0150 2.5706 3.3649 4.0322
6 0.7176 1.4398 1.9432 2.4469 3.1427 3.7074
7 0.7111 1.4149 1.8946 2.3646 2.9980 3.4995
8 0.7064 1.3968 1.8595 2.3060 2.8965 3.3554
9 0.7027 1.3830 1.8331 2.2622 2.8214 3.2498

10 0.6998 1.3722 1.8125 2.2281 2.7638 3.1693
11 0.6974 1.3634 1.7959 2.2010 2.7181 3.1058

Source: Extracted from Table E.3.

Step 5 You organize and store the data from a random sample of 12 sales invoices in :

Using Equations (3.1) and (3.7) on pages 97 and 103,

From Equation (9.2) on page 338,

tSTAT = X - m
S2n

=
112.85 - 120

20.80212

= -1.1908

X = $112.85 and S = $20.80

93.32 91.97 111.56 75.71 128.58 135.11

108.98 152.22 111.45 110.59 127.46 107.26

Invoices

Region of
Rejection

Region of
Nonrejection

Critical
Value

Region of
Rejection

Critical
Value

–2.2010 0 +2.2010 t
.025 .025

$120 X

.95

F I G U R E 9 . 6
Testing a hypothesis
about the mean 
( unknown) at the 0.05
level of significance with
11 degrees of freedom

s



F I G U R E 9 . 7
Excel and Minitab results for the t test of sales invoices
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Figure 9.7 shows the results for this test of hypothesis, as computed by Excel and Minitab.

Step 6 Because you do not reject You have
insufficient evidence to conclude that the mean amount per sales invoice differs from
$120. The audit suggests that the mean amount per invoice has not changed.

The p-Value Approach
To perform this two-tail hypothesis test, you use the five-step method listed in Exhibit 9.2 on
page 335.

Step 1–3 These steps are the same as in the critical value approach.
Step 4 From the Figure 9.7 results, the and p-value
Step 5 Because the p-value of 0.2588 is greater than you do not reject The data

provide insufficient evidence to conclude that the mean amount per sales invoice differs
from $120. The audit suggests that the mean amount per invoice has not changed. The
p-value indicates that if the null hypothesis is true, the probability that a sample of 12
invoices could have a sample mean that differs by $7.15 or more from the stated $120
is 0.2588. In other words, if the mean amount per sales invoice is truly $120, then there
is a 25.88% chance of observing a sample mean below $112.85 or above $127.15.

In the preceding example, it is incorrect to state that there is a 25.88% chance that the null hy-
pothesis is true. Remember that the p-value is a conditional probability, calculated by
assuming that the null hypothesis is true. In general, it is proper to state the following:

If the null hypothesis is true, there is a (p-value) × 100% chance of observing a test
statistic at least as contradictory to the null hypothesis as the sample result.

Checking the Normality Assumption
You use the t test when the population standard deviation, is not known and is estimated
using the sample standard deviation, S. To use the t test, you assume that the data represent a
random sample from a population that is normally distributed. In practice, as long as the sam-
ple size is not very small and the population is not very skewed, the t distribution provides a
good approximation of the sampling distribution of the mean when is unknown.

There are several ways to evaluate the normality assumption necessary for using the t test.
You can examine how closely the sample statistics match the normal distribution’s theoretical
properties. You can also construct a histogram, stem-and-leaf display, boxplot, or normal prob-
ability plot to visualize the distribution of the sales invoice amounts. For details on evaluating
normality, see Section 6.3 on pages 230–234.

s

s,

H0.a = 0.05,
= 0.2588.tSTAT = -1.19

H0.-2.2010 6 tSTAT = -1.1908 6 2.2010,
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Figures 9.8 through 9.10 show the descriptive statistics, boxplot, and normal probability
plot for the sales invoice data.

F I G U R E 9 . 8
Excel and Minitab descriptive statistics for the sales invoice data

F I G U R E 9 . 9
Excel and Minitab boxplots for the sales invoice data

The mean is very close to the median, and the points on the normal probability plots on page
342 appear to be increasing approximately in a straight line. The boxplots appear to be approxi-
mately symmetrical. Thus, you can assume that the population of sales invoices is approximately
normally distributed. The normality assumption is valid, and therefore the auditor’s results are valid.

The t test is a robust test. A robust test does not lose power if the shape of the population
departs somewhat from a normal distribution, particularly when the sample size is large
enough to enable the test statistic t to be influenced by the Central Limit Theorem (see Section
7.4). However, you can reach erroneous conclusions and can lose statistical power if you use
the t test incorrectly. If the sample size, n, is small (i.e., less than 30) and you cannot easily
make the assumption that the underlying population is at least approximately normally distrib-
uted, then nonparametric testing procedures are more appropriate (see references 1 and 2).



F I G U R E 9 . 1 0
Excel and Minitab normal probability plots for the sales invoice data
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Problems for Section 9.2
LEARNING THE BASICS
9.18 If, in a sample of selected from a normal pop-
ulation, and what is the value of if
you are testing the null hypothesis

9.19 In Problem 9.18, how many degrees of freedom does
the t test have?

9.20 In Problems 9.18 and 9.19, what are the critical val-
ues of t if the level of significance, is 0.05 and the
alternative hypothesis, is

9.21 In Problems 9.18, 9.19, and 9.20, what is your statis-
tical decision if the alternative hypothesis, is

9.22 If, in a sample of selected from a left-skewed
population, and would you use the t test
to test the null hypothesis Discuss.

9.23 If, in a sample of selected from a left-skewed
population, and would you use the t test to
test the null hypothesis Discuss.

APPLYING THE CONCEPTS
9.24 You are the manager of a restaurant for a
fast-food franchise. Last month, the mean waiting

time at the drive-through window for branches in your geo-
graphical region, as measured from the time a customer
places an order until the time the customer receives the
order, was 3.7 minutes. You select a random sample of 64
orders. The sample mean waiting time is 3.57 minutes, with
a sample standard deviation of 0.8 minute.

SELF
Test

H0 : m = 60?
S = 21,X = 65,

n = 160

H0 : m = 60?
S = 21,X = 65,

n = 16

m Z 50?H1,

m Z 50?H1,
a,

H0 : m = 50?
tSTATS = 12,X = 56

n = 16

a. At the 0.05 level of significance, is there evidence that
the population mean waiting time is different from
3.7 minutes?

b. Because the sample size is 64, do you need to be con-
cerned about the shape of the population distribution
when conducting the t test in (a)? Explain.

9.25 A manufacturer of chocolate candies uses machines
to package candies as they move along a filling line. Al-
though the packages are labeled as 8 ounces, the company
wants the packages to contain a mean of 8.17 ounces so that
virtually none of the packages contain less than 8 ounces. A
sample of 50 packages is selected periodically, and the
packaging process is stopped if there is evidence that the
mean amount packaged is different from 8.17 ounces. Sup-
pose that in a particular sample of 50 packages, the mean
amount dispensed is 8.159 ounces, with a sample standard
deviation of 0.051 ounce.
a. Is there evidence that the population mean amount is

different from 8.17 ounces? (Use a 0.05 level of
significance.)

b. Determine the p-value and interpret its meaning.

9.26 A stationery store wants to estimate the mean retail
value of greeting cards that it has in its inventory. A random
sample of 100 greeting cards indicates a mean value of
$2.55 and a standard deviation of $0.44.
a. Is there evidence that the population mean retail value of

the greeting cards is different from $2.50? (Use a 0.05
level of significance.)

b. Determine the p-value and interpret its meaning.
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9.27 The U.S. Department of Transportation requires tire
manufacturers to provide performance information on tire
sidewalls to help prospective buyers make their purchas-
ing decisions. One very important piece of information is
the tread wear index, which indicates the tire’s resistance
to tread wear. A tire with a grade of 200 should last twice
as long, on average, as a tire with a grade of 100.

A consumer organization wants to test the actual tread
wear index of a brand name of tires that claims “graded
200” on the sidewall of the tire. A random sample of
indicates a sample mean tread wear index of 195.3 and a
sample standard deviation of 21.4.
a. Is there evidence that the population mean tread wear index

is different from 200? (Use a 0.05 level of significance.)
b. Determine the p-value and interpret its meaning.

9.28 The file contains the amount that a sample
of nine customers spent for lunch ($) at a fast-food restaurant:

a. At the 0.05 level of significance, is there evidence that
the mean amount spent for lunch is different from $6.50?

b. Determine the p-value in (a) and interpret its meaning.
c. What assumption must you make about the population

distribution in order to conduct the t test in (a) and (b)?
d. Because the sample size is 9, do you need to be con-

cerned about the shape of the population distribution
when conducting the t test in (a)? Explain.

9.29 In New York State, savings banks are permitted to sell
a form of life insurance called savings bank life insurance
(SBLI). The approval process consists of underwriting, which
includes a review of the application, a medical information
bureau check, possible requests for additional medical infor-
mation and medical exams, and a policy compilation stage in
which the policy pages are generated and sent to the bank for
delivery. The ability to deliver approved policies to customers
in a timely manner is critical to the profitability of this serv-
ice. During a period of one month, a random sample of 27 ap-
proved policies is selected, and the total processing time, in
days, is recorded (and stored in ):

a. In the past, the mean processing time was 45 days. At the
0.05 level of significance, is there evidence that the mean
processing time has changed from 45 days?

b. What assumption about the population distribution is
needed in order to conduct the t test in (a)?

c. Construct a boxplot or a normal probability plot to evalu-
ate the assumption made in (b).

d. Do you think that the assumption needed in order to con-
duct the t test in (a) is valid? Explain.

9.30 The following data (in ) represent the amount of
soft-drink filled in a sample of 50 consecutive 2-liter bottles.
The results, listed horizontally in the order of being filled, were

Drink

45 48 17 17 17 91 92 63 50 51 69 16 17

73 19 16 64 28 28 31 90 60 56 31 56 22 18

Insurance

4.20 5.03 5.86 6.45 7.38 7.54 8.46 8.47 9.87

FastFood

n = 18

a. At the 0.05 level of significance, is there evidence that the
mean amount of soft drink filled is different from 2.0 liters?

b. Determine the p-value in (a) and interpret its meaning.
c. In (a), you assumed that the distribution of the amount of

soft drink filled was normally distributed. Evaluate this
assumption by constructing a boxplot or a normal
probability plot.

d. Do you think that the assumption needed in order to con-
duct the t test in (a) is valid? Explain.

e. Examine the values of the 50 bottles in their sequential
order, as given in the problem. Does there appear to be a
pattern to the results? If so, what impact might this pat-
tern have on the validity of the results in (a)?

9.31 One of the major measures of the quality of service
provided by any organization is the speed with which it
responds to customer complaints. A large family-held de-
partment store selling furniture and flooring, including
carpet, had undergone a major expansion in the past several
years. In particular, the flooring department had expanded
from 2 installation crews to an installation supervisor, a
measurer, and 15 installation crews. The store had the busi-
ness objective of improving its response to complaints. The
variable of interest was defined as the number of days
between when the complaint was made and when it was
resolved. Data were collected from 50 complaints that were
made in the past year. The data, stored in , are as
follows:

a. The installation supervisor claims that the mean number
of days between the receipt of a complaint and the reso-
lution of the complaint is 20 days. At the 0.05 level of
significance, is there evidence that the claim is not true
(i.e., that the mean number of days is different from 20)?

b. What assumption about the population distribution is
needed in order to conduct the t test in (a)?

c. Construct a boxplot or a normal probability plot to evalu-
ate the assumption made in (b).

d. Do you think that the assumption needed in order to con-
duct the t test in (a) is valid? Explain.

9.32 A manufacturing company produces steel housings
for electrical equipment. The main component part of the
housing is a steel trough that is made out of a 14-gauge steel

33 68

13 10 5 27 4 52 30 22 36 26 20 23

12 4 165 32 29 28 29 26 25 1 14 13

11 19 126 110 110 29 61 35 94 31 26 5

54 5 35 137 31 27 152 2 123 81 74 27

Furniture

1.963 1.957 1.951 1.951 1.947 1.941 1.941 1.938 1.908 1.894

1.994 1.986 1.984 1.981 1.973 1.975 1.971 1.969 1.966 1.967

2.012 2.012 2.012 2.010 2.005 2.003 1.999 1.996 1.997 1.992

2.031 2.029 2.025 2.029 2.023 2.020 2.015 2.014 2.013 2.014

2.109 2.086 2.066 2.075 2.065 2.057 2.052 2.044 2.036 2.038
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coil. It is produced using a 250-ton progressive punch press
with a wipe-down operation that puts two 90-degree forms
in the flat steel to make the trough. The distance from one
side of the form to the other is critical because of weather-
proofing in outdoor applications. The company requires that
the width of the trough be between 8.31 inches and 8.61
inches. The file contains the widths of the troughs,
in inches, for a sample of 

a. At the 0.05 level of significance, is there evidence that the
mean width of the troughs is different from 8.46 inches?

b. What assumption about the population distribution is
needed in order to conduct the t test in (a)?

c. Evaluate the assumption made in (b).
d. Do you think that the assumption needed in order to con-

duct the t test in (a) is valid? Explain.

9.33 One operation of a steel mill is to cut pieces of steel
into parts that are used in the frame for front seats in an au-
tomobile. The steel is cut with a diamond saw and requires
the resulting parts must be cut to be within inch of
the length specified by the automobile company. The file

contains a sample of 100 steel parts. The measure-
ment reported is the difference, in inches, between the ac-
tual length of the steel part, as measured by a laser
measurement device, and the specified length of the steel
part. For example, a value of –0.002 represents a steel part
that is 0.002 inch shorter than the specified length.
a. At the 0.05 level of significance, is there evidence that

the mean difference is not equal to 0.0 inches?
b. Construct a 95% confidence interval estimate of the pop-

ulation mean. Interpret this interval.

Steel

; 0.005

8.396 8.447 8.405 8.439 8.411 8.427 8.420 8.498 8.409

8.460 8.444 8.429 8.460 8.412 8.420 8.410 8.405 8.323 8.420

8.436 8.413 8.489 8.414 8.481 8.415 8.479 8.429 8.458 8.462

8.476 8.382 8.484 8.403 8.414 8.419 8.385 8.465 8.498 8.447

8.312 8.343 8.317 8.383 8.348 8.410 8.351 8.373 8.481 8.422

n = 49:
Trough

c. Compare the conclusions reached in (a) and (b).
d. Because do you have to be concerned about the

normality assumption needed for the t test and t interval?

9.34 In Problem 3.67 on page 135, you were introduced to
a tea-bag-filling operation. An important quality character-
istic of interest for this process is the weight of the tea in the
individual bags. The file contains an ordered array
of the weight, in grams, of a sample of 50 tea bags produced
during an eight-hour shift.
a. Is there evidence that the mean amount of tea per bag is

different from 5.5 grams? (Use .)
b. Construct a 99% confidence interval estimate of the popu-

lation mean amount of tea per bag. Interpret this interval.
c. Compare the conclusions reached in (a) and (b).

9.35 Although many people think they can put a meal on
the table in a short period of time, an article reported that
they end up spending about 40 minutes doing so. (Data
extracted from N. Hellmich, “Americans Go for the Quick
Fix for Dinner,” USA Today, February 14, 2006.) Suppose
another study is conducted to test the validity of this state-
ment. A sample of 25 people is selected, and the length of
time to prepare and cook dinner (in minutes) is recorded,
with the following results (in ):

a. Is there evidence that the population mean time to pre-
pare and cook dinner is different from 40 minutes?
Use the p-value approach and a level of signif icance
of 0.05.

b. What assumption about the population distribution is
needed in order to conduct the t test in (a)?

c. Make a list of the various ways you could evaluate the as-
sumption noted in (b).

d. Evaluate the assumption noted in (b) and determine
whether the t test in (a) is valid.

45.2 55.3 52.1 55.1 38.8 43.1 39.2 58.6 49.8 43.2 47.9 46.6

44.0 51.9 49.7 40.0 55.5 33.0 43.4 41.3 45.2 40.7 41.1 49.1 30.9

Dinner

a = 0.01

Teabags

n = 100,

9.3 One-Tail Tests
In Section 9.1, hypothesis testing was used to examine the question of whether the population
mean amount of cereal filled is 368 grams. The alternative hypothesis con-
tains two possibilities: Either the mean is less than 368 grams or the mean is more than 368
grams. For this reason, the rejection region is divided into the two tails of the sampling distri-
bution of the mean. In Section 9.2, a two-tail test was used to determine whether the mean
amount per invoice had changed from $120.

In contrast to these two examples, many situations require an alternative hypothesis that
focuses on a particular direction. For example, the population mean is less than a specified
value. One such situation involves the business problem concerning the service time at the
drive-through window of a fast-food restaurant. The speed with which customers are served is
of critical importance to the success of the service (see www.qsrmagazine.com/reports/
drive-thru_time_study). In one past study, McDonald’s had a mean service time of 174.22
seconds, which was only ninth best in the industry. Suppose that McDonald’s began a quality
improvement effort to reduce the service time by deploying an improved drive-through service
process in a sample of 25 stores. Because McDonald’s would want to institute the new process

1H1 : m Z 3682

www.qsrmagazine.com/reports/drive-thru_time_study
www.qsrmagazine.com/reports/drive-thru_time_study
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in all of its stores only if the test sample saw a decreased drive-through time, the entire rejec-
tion region is located in the lower tail of the distribution.

The Critical Value Approach
You wish to determine whether the new drive-through process has a mean that is less than
174.22 seconds. To perform this one-tail hypothesis test, you use the six-step method listed in
Exhibit 9.1 on page 332.

Step 1 You define the null and alternative hypotheses:

The alternative hypothesis contains the statement for which you are trying to find evi-
dence. If the conclusion of the test is “reject ” there is statistical evidence that the
mean drive-through time is less than the drive-through time in the old process. This
would be reason to change the drive-through process for the entire population of
stores. If the conclusion of the test is “do not reject ” then there is insufficient evi-
dence that the mean drive-through time in the new process is significantly less than the
drive-through time in the old process. If this occurs, there would be insufficient reason
to institute the new drive-through process in the population of stores.

Step 2 You collect the data by selecting a drive-through time sample of stores. You
decide to use 

Step 3 Because is unknown, you use the t distribution and the test statistic. You need
to assume that the service time is normally distributed because only a sample of 25
drive-through times is selected.

Step 4 The rejection region is entirely contained in the lower tail of the sampling distribution of
the mean because you want to reject only when the sample mean is significantly less
than 174.22 seconds. When the entire rejection region is contained in one tail of the sam-
pling distribution of the test statistic, the test is called a one-tail test, or directional test. If
the alternative hypothesis includes the less than sign, the critical value of t is negative. As
shown in Table 9.3 and Figure 9.11, because the entire rejection region is in the lower tail
of the t distribution and contains an area of 0.05, due to the symmetry of the t distribution,
the critical value of the t test statistic with degrees of freedom is
The decision rule is

otherwise, do not reject H0.

Reject H0 if tSTAT 6 -1.7109;

-1.7109.25 - 1 = 24

H0

tSTATs

a = 0.05.
n = 25

H0,

H0,

H1 : m 6 174.22

H0 : m Ú 174.22

Cumulative Probabilities

.75 .90 .95 .975 .99 .995

Upper-Tail Areas

Degrees of Freedom .25 .10 .05 .025 .01 .005

1 1.0000 3.0777 6.3138 12.7062 31.8207 63.6574
2 0.8165 1.8856 2.9200 4.3027 6.9646 9.9248
3 0.7649 1.6377 2.3534 3.1824 4.5407 5.8409
. . . . . . .
. . . . . . .
. . . . . . .

23 0.6853 1.3195 1.7139 2.0687 2.4999 2.8073
24 0.6848 1.3178 1.7109 2.0639 2.4922 2.7969
25 0.6844 1.3163 1.7081 2.0595 2.4851 2.7874

Source: Extracted from Table E.3.

T A B L E 9 . 3

Determining the Critical
Value from the t Table for
an Area of 0.05 in the
Lower Tail, with 24
Degrees of Freedom



F I G U R E 9 . 1 1
One-tail test of
hypothesis for a mean (
unknown) at the 0.05
level of significance

s

0–1.7109 t
Region of
Rejection

Region of
Nonrejection

.05

.95

Step 5 From the sample of 25 stores you selected, you find that the sample mean service time
at the drive-through equals 162.96 seconds and the sample standard deviation equals
20.2 seconds. Using and Equation (9.2) on page 338,

Step 6 Because you reject the null hypothesis (see Figure 9.11).
You conclude that the mean service time at the drive-through is less than 174.22 seconds.
There is sufficient evidence to change the drive-through process for the entire population
of stores.

The p-Value Approach
Use the five steps listed in Exhibit 9.2 on page 335 to illustrate the t test for the drive-through
time study using the p-value approach.

Step 1–3 These steps are the same as in the critical value approach on page 332.
Step 4 (see step 5 of the critical value approach). Because the alternative

hypothesis indicates a rejection region entirely in the lower tail of the sampling dis-
tribution, to compute the p-value, you need to find the probability that the test
statistic will be less than –2.7871. Figure 9.12 shows that the p-value is 0.0051.

tSTAT

tSTAT = -2.7871

tSTAT = -2.7871 6 - 1.7109,

tSTAT = X - m
S1n

=
162.96 - 174.22

20.2125

= -2.7871

n = 25, X = 162.96, S = 20.2,
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F I G U R E 9 . 1 2
Excel and Minitab t test results for the drive-through time study

Step 5 The p-value of 0.0051 is less than (see Figure 9.13). You reject and
conclude that the mean service time at the drive-through is less than 174.22 sec-
onds. There is sufficient evidence to change the drive-through process for the entire
population of stores.

H0a = 0.05



9.3 One-Tail Tests 347

–2.7871

.9949

t

0.0051

F I G U R E 9 . 1 3
Determining the p-value
for a one-tail test

A company that manufactures chocolate bars is particularly concerned that the mean weight of a
chocolate bar is not greater than 6.03 ounces. A sample of 50 chocolate bars is selected; the sam-
ple mean is 6.034 ounces, and the sample standard deviation is 0.02 ounces. Using the
level of significance, is there evidence that the population mean weight of the chocolate bars is
greater than 6.03 ounces?

SOLUTION Using the critical value approach, listed in Exhibit 9.1 on page 332,

Step 1 First, you define your hypotheses:

Step 2 You collect the data from a sample of You decide to use 
Step 3 Because is unknown, you use the t distribution and the test statistic.
Step 4 The rejection region is entirely contained in the upper tail of the sampling distribution

of the mean because you want to reject only when the sample mean is significantly
greater than 6.03 ounces. Because the entire rejection region is in the upper tail of the
t distribution and contains an area of 0.01, the critical value of the t distribution with

degrees of freedom is 2.4049 (see Table E.3).
The decision rule is

Step 5 From your sample of 50 chocolate bars, you find that the sample mean weight is
6.034 ounces, and the sample standard deviation is 0.02 ounces. Using

and Equation (9.2) on page 338,

Step 6 Because or using Microsoft Excel or Minitab, the p-value is
you do not reject the null hypothesis. There is insufficient evidence to

conclude that the population mean weight is greater than 6.03 ounces.
0.0818 7 0.01,

tSTAT = 1.414 6 2.4049,

tSTAT = X - m
S1n

=
6.034 - 6.03

0.02150

= 1.414

X = 6.034, S = 0.02,
n = 50,

otherwise, do not reject H0.

Reject H0 if tSTAT 7 2.4049;

50 - 1 = 49

H0

tSTATs

a = 0.01.n = 50.

H1 : m 7 6.03

H0 : m … 6.03

a = 0.01

EXAMPLE 9.5
A One-Tail Test for
the Mean

To perform one-tail tests of hypotheses, you must properly formulate and A summary
of the null and alternative hypotheses for one-tail tests is as follows:

• The null hypothesis, represents the status quo or the current belief in a situation.
• The alternative hypothesis, is the opposite of the null hypothesis and represents a

research claim or specific inference you would like to prove.
• If you reject the null hypothesis, you have statistical proof that the alternative hypothe-

sis is correct.
• If you do not reject the null hypothesis, you have failed to prove the alternative

hypothesis. The failure to prove the alternative hypothesis, however, does not mean that
you have proven the null hypothesis.

• The null hypothesis always refers to a specified value of the population parameter (such
as ), not to a sample statistic (such as ).Xm

H1,
H0,

H1.H0
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Problems for Section 9.3
LEARNING THE BASICS
9.36 In a one-tail hypothesis test where you reject only
in the upper tail, what is the p-value if 

9.37 In Problem 9.36, what is your statistical decision if
you test the null hypothesis at the 0.05 level of significance?

9.38 In a one-tail hypothesis test where you reject only
in the lower tail, what is the p-value if 

9.39 In Problem 9.38, what is your statistical decision if
you test the null hypothesis at the 0.01 level of significance?

9.40 In a one-tail hypothesis test where you reject only
in the lower tail, what is the p-value if 

9.41 In Problem 9.40, what is the statistical decision if you
test the null hypothesis at the 0.01 level of significance?

9.42 In a one-tail hypothesis test where you reject only
in the upper tail, what is the critical value of the t-test statistic
with 10 degrees of freedom at the 0.01 level of significance?

9.43 In Problem 9.42, what is your statistical decision if

9.44 In a one-tail hypothesis test where you reject only in
the lower tail, what is the critical value of the test statistic
with 20 degrees of freedom at the 0.01 level of significance?

9.45 In Problem 9.44, what is your statistical decision if

APPLYING THE CONCEPTS
9.46 In a recent year, the Federal Communications Com-
mission reported that the mean wait for repairs for Verizon
customers was 36.5 hours. In an effort to improve this
service, suppose that a new repair service process was
developed. This new process, used for a sample of 100
repairs, resulted in a sample mean of 34.5 hours and a sam-
ple standard deviation of 11.7 hours.
a. Is there evidence that the population mean amount is less

than 36.5 hours? (Use a 0.05 level of significance.)
b. Determine the p-value and interpret its meaning.

9.47 In a recent year, the Federal Communications Com-
mission reported that the mean wait for repairs for AT&T
customers was 25.3 hours. In an effort to improve this serv-
ice, suppose that a new repair service process was devel-
oped. This new process, used for a sample of 100 repairs,
resulted in a sample mean of 22.3 hours and a sample stan-
dard deviation of 8.3 hours.

tSTAT = -1.15?

tSTAT

H0

tSTAT = +2.39?

H0

ZSTAT = +1.38?
H0

ZSTAT = -1.38?
H0

ZSTAT = +2.00?
H0

a. Is there evidence that the population mean amount is less
than 25.3 hours? (Use a 0.05 level of significance.)

b. Determine the p-value and interpret its meaning.

9.48 Southside Hospital in Bay Shore, New York,
commonly conducts stress tests to study the heart

muscle after a person has a heart attack. Members of the diag-
nostic imaging department conducted a quality improvement
project with the objective of reducing the turnaround time for
stress tests. Turnaround time is defined as the time from when
a test is ordered to when the radiologist signs off on the test
results. Initially, the mean turnaround time for a stress test was
68 hours. After incorporating changes into the stress-test
process, the quality improvement team collected a sample of
50 turnaround times. In this sample, the mean turnaround
time was 32 hours, with a standard deviation of 9 hours. (Data
extracted from E. Godin, D. Raven, C. Sweetapple, and
F. R. Del Guidice, “Faster Test Results,” Quality Progress,
January 2004, 37(1), pp. 33–39.)
a. If you test the null hypothesis at the 0.01 level of signifi-

cance, is their evidence that the new process has reduced
turnaround time?

b. Interpret the meaning of the p-value in this problem.

9.49 You are the manager of a restaurant that delivers pizza
to college dormitory rooms. You have just changed your de-
livery process in an effort to reduce the mean time between
the order and completion of delivery from the current 25
minutes. A sample of 36 orders using the new delivery
process yields a sample mean of 22.4 minutes and a sample
standard deviation of 6 minutes.
a. Using the six-step critical value approach, at the 0.05

level of significance, is there evidence that the popula-
tion mean delivery time has been reduced below the pre-
vious population mean value of 25 minutes?

b. At the 0.05 level of significance, use the five-step
p-value approach.

c. Interpret the meaning of the p-value in (b).
d. Compare your conclusions in (a) and (b).

9.50 The per-store daily customer count (i.e., the mean
number of customers in a store in one day) for a nationwide
convenience store chain that operates nearly 10,000 stores
has been steady, at 900, for some time. To increase the cus-
tomer count, the chain is considering cutting prices for cof-
fee beverages by approximately half. The small size will now
be $0.59 instead of $0.99, and the medium size will be $0.69
instead of $1.19. Even with this reduction in price, the chain
will have a 40% gross margin on coffee. To test the new

SELF
Test

• The statement of the null hypothesis always contains an equal sign regarding the
specified value of the parameter (e.g., ).

• The statement of the alternative hypothesis never contains an equal sign regarding the
specified value of the parameter (e.g., ).H1 : m 6 174.22

H0 : m Ú 174.22
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initiative, the chain has reduced coffee prices in a sample of
34 stores, where customer counts have been running almost
exactly at the national average of 900. After four weeks, the
sample stores stabilize at a mean customer count of 974 and
a standard deviation of 96. This increase seems like a sub-
stantial amount to you, but it also seems like a pretty small
sample. Do you think reducing coffee prices is a good strat-
egy for increasing the mean customer count?
a. State the null and alternative hypotheses.
b. Explain the meaning of the Type I and Type II errors in

the context of this scenario.
c. At the 0.01 level of significance, is there evidence that

reducing coffee prices is a good strategy for increasing
the mean customer count?

d. Interpret the meaning of the p-value in (c).

9.51 The population mean waiting time to check out of a
supermarket has been 10.73 minutes. Recently, in an effort

to reduce the waiting time, the supermarket has experi-
mented with a system in which there is a single waiting
line with multiple checkout servers. A sample of 100 cus-
tomers was selected, and their mean waiting time to check
out was 9.52 minutes, with a sample standard deviation of
5.8 minutes.
a. At the 0.05 level of significance, using the critical value

approach to hypothesis testing, is there evidence that the
population mean waiting time to check out is less than
10.73 minutes?

b. At the 0.05 level of significance, using the p-value ap-
proach to hypothesis testing, is there evidence that the
population mean waiting time to check out is less than
10.73 minutes?

c. Interpret the meaning of the p-value in this problem.
d. Compare your conclusions in (a) and (b).

9.4 Z Test of Hypothesis for the Proportion
In some situations, you want to test a hypothesis about the proportion of events of interest in
the population, rather than test the population mean. To begin, you select a random sample
and compute the sample proportion, You then compare the value of this statistic to
the hypothesized value of the parameter, in order to decide whether to reject the null hy-
pothesis. If the number of events of interest (X) and the number of events that are not of inter-
est are each at least five, the sampling distribution of a proportion approximately
follows a normal distribution. You use the Z test for the proportion given in Equation (9.3) to
perform the hypothesis test for the difference between the sample proportion, p, and the
hypothesized population proportion, p.

1n - X2
p,

p = X>n.
p,

Z TEST FOR THE PROPORTION

(9.3)

where

The test statistic approximately follows a standardized normal distribution when
X and are each at least 5.1n - X2ZSTAT

p = Hypothesized proportion of events of interest in the population

p = Sample proportion =
X
n

=
Number of events of interest in the sample

Sample size

ZSTAT =
p - p

Ap11 - p2
n

Alternatively, by multiplying the numerator and denominator by n, you can write the test
statistic in terms of the number of events of interest, X, as shown in Equation (9.4).

ZSTAT

Z TEST FOR THE PROPORTION IN TERMS OF THE NUMBER OF EVENTS 
OF INTEREST

(9.4)ZSTAT =
X - np1np11 - p2
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The Critical Value Approach
To illustrate the Z test for a proportion, consider a survey conducted for American Express
that sought to determine the reasons adults wanted Internet access while on vacation. (Data
extracted from “Wired Vacationers,” USA Today, June 4, 2010, p. 1A.) Of 2,000 adults,
1,540 said that they wanted Internet access so they could check personal e-mail while on va-
cation. A survey conducted in the previous year indicated that 75% of adults wanted Internet
access so they could check personal e-mail while on vacation. Is there evidence that the per-
centage of adults who wanted Internet access to check personal e-mail while on vacation has
changed from the previous year? To investigate this question, the null and alternative hy-
potheses are follows:

(i.e., the proportion of adults who want Internet access to check personal
email while on vacation has not changed from the previous year)

(i.e., the proportion of adults who want Internet access to check personal
email while on vacation has changed from the previous year)

Because you are interested in determining whether the population proportion of adults
who want Internet access to check personal email while on vacation has changed from 0.75 in
the previous year, you use a two-tail test. If you select the level of significance, the
rejection and nonrejection regions are set up as in Figure 9.14, and the decision rule is

otherwise, do not reject H0.

Reject H0 if ZSTAT 6 -1.96 or if ZSTAT 7 +1.96;

a = 0.05

H1 :p Z 0.75

H0 :p = 0.75

0–1.96 +1.96 Z
Region of
Rejection

Region of
Nonrejection

Region of
Rejection

.95

F I G U R E 9 . 1 4
Two-tail test of
hypothesis for the
proportion at the 0.05
level of significance

Because 1,540 of the 2,000 adults stated that they wanted Internet access to check personal
email while on vacation,

Since X = 1,540 and n – X = 460, each > 5, using Equation (9.3),

or, using Equation (9.4),

Because you reject There is evidence that the population propor-
tion of all adults who want Internet access to check personal e-mail while on vacation has
changed from 0.75 in the previous year. Figure 9.15 presents results for these data, as
computed by Excel and Minitab.

H0.ZSTAT = 2.0656 7 1.96,

ZSTAT =
X - np2np11 - p2 =

1,540 - 12,000210.75222,00010.75210.252 =
40

19.3649
= 2.0656

ZSTAT =
p - p

Ap11 - p2
n

=
0.77 - 0.75

A0.7511 - 0.752
2,000

=
0.02

0.0097
= 2.0656

p =
1,540

2,000
= 0.77
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F I G U R E 9 . 1 5
Excel and Minitab results for the Z test for whether the proportion of adults who want Internet access to check
personal email while on vacation has changed from the previous year

The p-Value Approach
As an alternative to the critical value approach, you can compute the p-value. For this two-tail
test in which the rejection region is located in the lower tail and the upper tail, you need to find
the area below a Z value of –2.0656 and above a Z value of +2.0656. Figure 9.15 reports a
p-value of 0.0389. Because this value is less than the selected level of significance
you reject the null hypothesis.

1a = 0.052,

A fast-food chain has developed a new process to ensure that orders at the drive-through are
filled correctly. The business problem is defined as determining whether the new process
can increase the percentage of orders processed correctly. The previous process filled orders
correctly 85% of the time. Data are collected from a sample of 100 orders using the new
process. The results indicate that 94 orders were filled correctly. At the 0.01 level of signifi-
cance, can you conclude that the new process has increased the proportion of orders filled
correctly?

SOLUTION The null and alternative hypotheses are

(i.e., the population proportion of orders filled correctly using the new
process is less than or equal to 0.85)

(i.e., the population proportion of orders filled correctly using the new
process is greater than 0.85)

Since X = 94 and n – X = 6, both > 5, using Equation (9.3) on page 349,

The p-value for is 0.0059.
Using the critical value approach, you reject if Using the p-value approach,

you reject if p-value Because or the p-value
you reject You have evidence that the new process has increased the pro-

portion of correct orders above 0.85.
H0.= 0.0059 6 0.01,

ZSTAT = 2.52 7 2.336 0.01.H0

ZSTAT 7 2.33.H0

ZSTAT 7 2.52

ZSTAT =
p - p

Ap11 - p2
n

=
0.94 - 0.85

A0.8511 - 0.852
100

=
0.09

0.0357
= 2.52

p =
X
n

=
94
100

= 0.94

H1 :p 7 0.85

H0 :p … 0.85

EXAMPLE 9.6
Testing a
Hypothesis for 
a Proportion
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Problems for Section 9.4
LEARNING THE BASICS
9.52 If, in a random sample of 400 items, 88 are defective,
what is the sample proportion of defective items?

9.53 In Problem 9.52, if the null hypothesis is that 20% of the
items in the population are defective, what is the value of

9.54 In Problems 9.52 and 9.53, suppose you are testing
the null hypothesis against the two-tail alter-
native hypothesis and you choose the level of
significance What is your statistical decision?

APPLYING THE CONCEPTS
9.55 The U.S. Department of Education reports that 46%
of full-time college students are employed while attending
college. (Data extracted from “The Condition of Education
2009,” National Center for Education Statistics, nces.ed.
gov.) A recent survey of 60 full-time students at Miami Uni-
versity found that 29 were employed.
a. Use the five-step p-value approach to hypothesis testing

and a 0.05 level of significance to determine whether the
proportion of full-time students at Miami University is
different from the national norm of 0.46.

b. Assume that the study found that 36 of the 60 full-time
students were employed and repeat (a). Are the conclu-
sions the same?

9.56 Online magazines make it easy for readers to link to
an advertiser’s website directly from an advertisement placed
in the digital magazine. A recent survey indicated that 56%
of online magazine readers have clicked on an advertisement
and linked directly to the advertiser’s website. The survey
was based on a sample size of (Data extracted
from “Metrics,” EContent, January/February, 2007, p. 20.)
a. Use the five-step p-value approach to try to determine

whether there is evidence that more than half of all the
readers of online magazines have linked to an advertiser’s
website. (Use the 0.05 level of significance.)

b. Suppose that the sample size was only and, as be-
fore, 56% of the online magazine readers indicated that
they had clicked on an advertisement to link directly to the
advertiser’s website. Use the five-step p-value approach to
try to determine whether there is evidence that more than
half of all the readers of online magazines have linked to an
advertiser’s website. (Use the 0.05 level of significance.)

c. Discuss the effect that sample size has on hypothesis testing.
d. What do you think are your chances of rejecting any null

hypothesis concerning a population proportion if a sam-
ple size of is used?

9.57 One of the issues facing organizations is increasing
diversity throughout the organization. One of the ways to
evaluate an organization’s success at increasing diversity is to
compare the percentage of employees in the organization in
a particular position with a specific background to the

n = 20

n = 100,

n = 6,403.

a = 0.05.
H1 :p Z 0.20

H0 :p = 0.20

ZSTAT?

percentage in a particular position with that specific back-
ground in the general workforce. Recently, a large academic
medical center determined that 9 of 17 employees in a partic-
ular position were female, whereas 55% of the employees for
this position in the general workforce were female. At the
0.05 level of significance, is there evidence that the propor-
tion of females in this position at this medical center is differ-
ent from what would be expected in the general workforce?

9.58 Of 1,000 respondents aged 24 to 35, 65%
reported that they preferred to “look for a job in a

place where I would like to live” rather than “look for the best
job I can find, the place where I live is secondary.” (Data
extracted from L. Belkin, “What Do Young Jobseekers Want?
(Something Other Than a Job),” The New York Times,
September 6, 2007, p. G2.) At the 0.05 level of significance, is
there evidence that the proportion of all young jobseekers aged
24 to 35 who preferred to “look for a job in a place where I
would like to live” rather than “look for the best job I can find,
the place where I live is secondary” is different from 60%?

9.59 The telephone company wants to investigate the desir-
ability of beginning a marketing campaign that would offer
customers the right to purchase an additional telephone line at
a substantially reduced installation cost. The campaign will be
initiated if there is evidence that more than 20% of the cus-
tomers would consider purchasing an additional telephone line
if it were made available at a substantially reduced installation
cost. A random sample of 500 households is selected. The re-
sults indicate that 135 of the households would purchase the
additional telephone line at a reduced installation cost.
a. At the 0.05 level of significance, is there evidence that

more than 20% of the customers would purchase the ad-
ditional telephone line?

b. How would the manager in charge of promotional programs
concerning residential customers use the results in (a)?

9.60 A study by the Pew Internet and American Life Pro-
ject (pewinternet.org) found that Americans had a complex
and ambivalent attitude toward technology. (Data extracted
from M. Himowitz, “How to Tell What Kind of Tech User
You Are,” Newsday, May 27, 2007, p. F6.) The study re-
ported that 8% of the respondents were “Omnivores” who
are gadget lovers, text messengers, and online gamers (often
with their own blogs or web pages), video makers, and
YouTube posters. You believe that the percentage of students
at your school who are Omnivores is greater than 8%, and
you plan to carry out a study to prove that this is so.
a. State the null and alternative hypotheses.
b. You select a sample of 200 students at your school and find

that 30 students can be classified as Omnivores. Use either
the six-step critical value hypothesis-testing approach or
the five-step p-value approach to determine at the 0.05
level of significance whether there is evidence that the per-
centage of Omnivores at your school is greater than 8%.

SELF
Test
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9.5 Potential Hypothesis-Testing Pitfalls and Ethical Issues
To this point, you have studied the fundamental concepts of hypothesis testing. You have used
hypothesis testing to analyze differences between sample statistics and hypothesized population
parameters in order to make business decisions concerning the underlying population charac-
teristics. You have also learned how to evaluate the risks involved in making these decisions.

When planning to carry out a hypothesis test based on a survey, research study, or de-
signed experiment, you must ask several questions to ensure that you use proper methodology.
You need to raise and answer questions such as the following in the planning stage:

• What is the goal of the survey, study, or experiment? How can you translate the goal into
a null hypothesis and an alternative hypothesis?

• Is the hypothesis test a two-tail test or one-tail test?
• Can you select a random sample from the underlying population of interest?
• What types of data will you collect in the sample? Are the variables numerical or categorical?
• At what level of significance should you conduct the hypothesis test?
• Is the intended sample size large enough to achieve the desired power of the test for the

level of significance chosen?
• What statistical test procedure should you use and why?
• What conclusions and interpretations can you reach from the results of the hypothesis test?

Failing to consider these questions early in the planning process can lead to biased or in-
complete results. Proper planning can help ensure that the statistical study will provide objec-
tive information needed to make good business decisions.

Statistical Significance Versus Practical Significance
You need to make a distinction between the existence of a statistically significant result and its
practical significance in a field of application. Sometimes, due to a very large sample size, you
may get a result that is statistically significant but has little practical significance. For exam-
ple, suppose that prior to a national marketing campaign focusing on a series of expensive tel-
evision commercials, you believe that the proportion of people who recognize your brand is
0.30. At the completion of the campaign, a survey of 20,000 people indicates that 6,168 recog-
nized your brand. A one-tail test trying to prove that the proportion is now greater than 0.30
results in a p-value of 0.0047, and the correct statistical conclusion is that the proportion of
consumers recognizing your brand name has now increased. Was the campaign successful?
The result of the hypothesis test indicates a statistically significant increase in brand aware-
ness, but is this increase practically important? The population proportion is now estimated at

or 30.84%. This increase is less than 1% more than the hypothesized
value of 30%. Did the large expenses associated with the marketing campaign produce a result
with a meaningful increase in brand awareness? Because of the minimal real-world impact that
an increase of less than 1% has on the overall marketing strategy and the huge expenses asso-
ciated with the marketing campaign, you should conclude that the campaign was not success-
ful. On the other hand, if the campaign increased brand awareness from 30% to 50%, you
could conclude that the campaign was successful.

Reporting of Findings
In conducting research, you should document both good and bad results. You should not just
report the results of hypothesis tests that show statistical significance but omit those for which
there is insufficient evidence in the findings. In instances in which there is insufficient evi-
dence to reject you must make it clear that this does not prove that the null hypothesis is
true. What the result does indicate is that with the sample size used, there is not enough infor-
mation to disprove the null hypothesis.

H0,

6,168>20,000 = 0.3084,
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Ethical Issues
You need to distinguish between poor research methodology and unethical behavior. Ethical
considerations arise when the hypothesis-testing process is manipulated. Some of the areas
where ethical issues can arise include the use of human subjects in experiments, the data col-
lection method, the type of test (one-tail or two-tail test), the choice of the level of significance,
the cleansing and discarding of data, and the failure to report pertinent findings.

9.6 Online Topic: The Power of a Test
Section 9.1 defines Type I and Type II errors and the power of a test. To examine the power of
a test in greater depth, read the Section 9.6 online topic file that is available on this book’s
companion website. (See Appendix C to learn how to access the online topic files.)

As the plant operations manager for Oxford Cereals, you were
responsible for the cereal-filling process. It was your
responsibility to adjust the process when the mean fill weight
in the population of boxes deviated from the company speci-

fication of 368 grams. Because weighing all the cereal boxes would be too
time-consuming and impractical, you needed to select and weigh a sample
of boxes and conduct a hypothesis test.

You determined that the null hypothesis should be that the population mean fill was
368 grams. If the mean weight of the sampled boxes were sufficiently above or below the
expected 368-gram mean specified by Oxford Cereals, you would reject the null hypothesis in
favor of the alternative hypothesis that the mean fill was different from 368 grams. If this hap-
pened, you would stop production and take whatever action is necessary to correct the prob-
lem. If the null hypothesis was not rejected, you would continue to believe in the status
quo—that the process was working correctly—and therefore take no corrective action.

Before proceeding, you considered the risks involved with hypothesis tests. If you rejected
a true null hypothesis, you would make a Type I error and conclude that the population mean
fill was not 368 when it actually was 368. This error would result in adjusting the filling
process even though the process was working properly. If you did not reject a false null hy-
pothesis, you would make a Type II error and conclude that the population mean fill was 368
when it actually was not 368. Here, you would allow the process to continue without adjust-
ment even though the process was not working properly.

After collecting a random sample of 25 cereal boxes, you used the six-step critical value ap-
proach to hypothesis testing. Because the test statistic fell into the nonrejection region, you did not
reject the null hypothesis. You concluded that there was insufficient evidence to prove that the
mean fill differed from 368 grams. No corrective action on the filling process was needed.

U S I N G S TAT I S T I C S @ Oxford Cereals, Part II Revisited



Chapter Review Problems 355

S U M M A R Y
This chapter presented the foundation of hypothesis testing.
You learned how to perform tests on the population mean
and on the population proportion. The chapter developed
both the critical value approach and the p-value approach to
hypothesis testing.

In deciding which test to use, you should ask the fol-
lowing question: Does the test involve a numerical variable

or a categorical variable? If the test involves a numerical
variable, use the t test for the mean. If the test involves a cat-
egorical variable, use the Z test for the proportion. Table 9.4
provides a list of hypothesis tests covered in the chapter.

T A B L E 9 . 4

Summary of Topics in
Chapter 9

Type of Data

Type of Analysis Numerical Categorical

Hypothesis test concerning
a single parameter

t test of hypothesis for the
mean (Section 9.2)

Z test of hypothesis for the
proportion (Section 9.4)

K E Y E Q U AT I O N S
Z Test for the Mean ( Known)

(9.1)

t Test for the Mean ( Unknown)

(9.2)tSTAT = X - m
S1n

S

ZSTAT = X - m
s1n

S Z Test for the Proportion

(9.3)

Z Test for the Proportion in Terms of the Number of Events
of Interest

(9.4)ZSTAT =
X - np2np11 - p2

ZSTAT =
p - p

Ap11 - p2
n

K E Y T E R M S
alternative hypothesis 326

risk 329
confidence coefficient 329
critical value 328
directional test 345
hypothesis testing 326
level of significance ( ) 329
null hypothesis 3261H02

a

b

1H12 one-tail test 345
p-value 333
power of a statistical test 329
region of nonrejection 328
region of rejection 328
robust 341
sample proportion 349
t test for the mean 338

test statistic 328
two-tail test 331
Type I error 328
Type II error 328
Z test for the mean 330
Z test for the proportion 349

C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING
9.61 What is the difference between a null hypothesis,
and an alternative hypothesis,

9.62 What is the difference between a Type I error and a
Type II error?

H1?
H0,

9.63 What is meant by the power of a test?

9.64 What is the difference between a one-tail test and a
two-tail test?

9.65 What is meant by a p-value?
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9.66 How can a confidence interval estimate for the popu-
lation mean provide conclusions for the corresponding two-
tail hypothesis test for the population mean?

9.67 What is the six-step critical value approach to
hypothesis testing?

9.68 What is the five-step p-value approach to hypothesis
testing?

APPLYING THE CONCEPTS
9.69 An article in Marketing News (T. T. Semon, “Con-
sider a Statistical Insignificance Test,” Marketing News,
February 1, 1999) argued that the level of significance used
when comparing two products is often too low—that is,
sometimes you should be using an value greater than 0.05.
Specifically, the article recounted testing the proportion of
potential customers with a preference for product 1 over
product 2. The null hypothesis was that the population pro-
portion of potential customers preferring product 1 was
0.50, and the alternative hypothesis was that it was not equal
to 0.50. The p-value for the test was 0.22. The article sug-
gested that, in some cases, this should be enough evidence
to reject the null hypothesis.
a. State, in statistical terms, the null and alternative

hypotheses for this example.
b. Explain the risks associated with Type I and Type II

errors in this case.
c. What would be the consequences if you rejected the null

hypothesis for a p-value of 0.22?
d. Why do you think the article suggested raising the value

of ?
e. What would you do in this situation?
f. What is your answer in (e) if the p-value equals 0.12?

What if it equals 0.06?

9.70 La Quinta Motor Inns developed a computer model to
help predict the profitability of sites that are being considered
as locations for new hotels. If the computer model predicts
large profits, La Quinta buys the proposed site and builds a
new hotel. If the computer model predicts small or moderate
profits, La Quinta chooses not to proceed with that site. (Data
extracted from S. E. Kimes and J. A. Fitzsimmons, “Selecting
Profitable Hotel Sites at La Quinta Motor Inns,” Interfaces,
Vol. 20, March–April 1990, pp. 12–20.) This decision-mak-
ing procedure can be expressed in the hypothesis-testing
framework. The null hypothesis is that the site is not a prof-
itable location. The alternative hypothesis is that the site is a
profitable location.
a. Explain the risks associated with committing a Type I

error in this case.
b. Explain the risks associated with committing a Type II

error in this case.
c. Which type of error do you think the executives at La

Quinta Motor Inns want to avoid? Explain.
d. How do changes in the rejection criterion affect the prob-

abilities of committing Type I and Type II errors?

a

a

9.71 Webcredible, a UK-based consulting firm specializ-
ing in websites, intranets, mobile devices, and applications,
conducted a survey of 1,132 mobile phone users between
February and April 2009. The survey found that 52% of mo-
bile phone users are now using the mobile Internet. (Data
extracted from “Email and Social Networking Most Popular
Mobile Internet Activities,” www.webcredible.co.uk, May
13, 2009.) The authors of the article imply that the survey
proves that more than half of all mobile phone users are now
using the mobile Internet.
a. Use the five-step p-value approach to hypothesis testing

and a 0.05 level of significance to try to prove that more
than half of all mobile phone users are now using the mo-
bile Internet.

b. Based on your result in (a), is the claim implied by the
authors valid?

c. Suppose the survey found that 53% of mobile phone users
are now using the mobile Internet. Repeat parts (a) and (b).

d. Compare the results of (b) and (c).

9.72 The owner of a gasoline station wants to study gaso-
line purchasing habits of motorists at his station. He selects
a random sample of 60 motorists during a certain week,
with the following results:
• The amount purchased was gallons,

gallons.
• Eleven motorists purchased premium-grade gasoline.
a. At the 0.05 level of significance, is there evidence that the

population mean purchase was different from 10 gallons?
b. Determine the p-value in (a).
c. At the 0.05 level of significance, is there evidence that

less than 20% of all the motorists at the station purchased
premium-grade gasoline?

d. What is your answer to (a) if the sample mean equals
10.3 gallons?

e. What is your answer to (c) if 7 motorists purchased pre-
mium-grade gasoline?

9.73 An auditor for a government agency is assigned the
task of evaluating reimbursement for office visits to
physicians paid by Medicare. The audit was conducted on
a sample of 75 of the reimbursements, with the following
results:
• In 12 of the office visits, there was an incorrect amount

of reimbursement.
• The amount of reimbursement was

a. At the 0.05 level of significance, is there evidence that
the population mean reimbursement was less than $100?

b. At the 0.05 level of significance, is there evidence that
the proportion of incorrect reimbursements in the popu-
lation was greater than 0.10?

c. Discuss the underlying assumptions of the test used in (a).
d. What is your answer to (a) if the sample mean equals $90?
e. What is your answer to (b) if 15 office visits had incor-

rect reimbursements?

S = $34.55.
X = $93.70,

S = 3.1X = 11.3

www.webcredible.co.uk
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9.74 A bank branch located in a commercial district of a city
had the business objective of improving the process for serv-
ing customers during the noon-to-1:00 P.M. lunch period. The
waiting time (defined as the time the customer enters the line
until he or she reaches the teller window) of all customers
during this hour is recorded over a period of a week. Data
were collected from a random sample of 15 customers, and
the results are organized (and stored in ) as follows:

a. At the 0.05 level of significance, is there evidence that
the population mean waiting time is less than 5 minutes?

b. What assumption about the population distribution is
needed in order to conduct the t test in (a)?

c. Construct a boxplot or a normal probability plot to evalu-
ate the assumption made in (b).

d. Do you think that the assumption needed in order to con-
duct the t test in (a) is valid? Explain.

e. As a customer walks into the branch office during the
lunch hour, she asks the branch manager how long she
can expect to wait. The branch manager replies, “Almost
certainly not longer than 5 minutes.” On the basis of the
results of (a), evaluate this statement.

9.75 A manufacturing company produces electrical insula-
tors. If the insulators break when in use, a short circuit is
likely to occur. To test the strength of the insulators, destruc-
tive testing is carried out to determine how much force is
required to break the insulators. Force is measured by
observing the number of pounds of force applied to the insu-
lator before it breaks. The following data (stored in )
are from 30 insulators subjected to this testing:

a. At the 0.05 level of significance, is there evidence that
the population mean force is greater than 1,500 pounds?

b. What assumption about the population distribution is
needed in order to conduct the t test in (a)?

c. Construct a histogram, boxplot, or normal probability
plot to evaluate the assumption made in (b).

d. Do you think that the assumption needed in order to con-
duct the t test in (a) is valid? Explain.

9.76 An important quality characteristic used by the manu-
facturer of Boston and Vermont asphalt shingles is the
amount of moisture the shingles contain when they are pack-
aged. Customers may feel that they have purchased a prod-
uct lacking in quality if they find moisture and wet shingles
inside the packaging. In some cases, excessive moisture can
cause the granules attached to the shingle for texture and col-
oring purposes to fall off the shingle, resulting in appearance
problems. To monitor the amount of moisture present, the

1,820 1,744 1,788 1,688 1,810 1,752 1,680 1,810 1,652 1,736

1,866 1,764 1,734 1,662 1,734 1,774 1,550 1,756 1,762 1,866

1,870 1,728 1,656 1,610 1,634 1,784 1,522 1,696 1,592 1,662

Force

4.50 6.10 0.38 5.12 6.46 6.19 3.79

4.21 5.55 3.02 5.13 4.77 2.34 3.54 3.20

Bank1

company conducts moisture tests. A shingle is weighed and
then dried. The shingle is then reweighed, and, based on the
amount of moisture taken out of the product, the pounds of
moisture per 100 square feet are calculated. The company
would like to show that the mean moisture content is less
than 0.35 pound per 100 square feet. The file in-
cludes 36 measurements (in pounds per 100 square feet) for
Boston shingles and 31 for Vermont shingles.
a. For the Boston shingles, is there evidence at the 0.05

level of significance that the population mean moisture
content is less than 0.35 pound per 100 square feet?

b. Interpret the meaning of the p-value in (a).
c. For the Vermont shingles, is there evidence at the 0.05

level of significance that the population mean moisture
content is less than 0.35 pound per 100 square feet?

d. Interpret the meaning of the p-value in (c).
e. What assumption about the population distribution is

needed in order to conduct the t tests in (a) and (c)?
f. Construct histograms, boxplots, or normal probability

plots to evaluate the assumption made in (a) and (c).
g. Do you think that the assumption needed in order to con-

duct the t tests in (a) and (c) is valid? Explain.

9.77 Studies conducted by the manufacturer of Boston and
Vermont asphalt shingles have shown product weight to be
a major factor in the customer’s perception of quality. More-
over, the weight represents the amount of raw materials be-
ing used and is therefore very important to the company
from a cost standpoint. The last stage of the assembly line
packages the shingles before the packages are placed on
wooden pallets. Once a pallet is full (a pallet for most
brands holds 16 squares of shingles), it is weighed, and the
measurement is recorded. The file contains the
weight (in pounds) from a sample of 368 pallets of Boston
shingles and 330 pallets of Vermont shingles.
a. For the Boston shingles, is there evidence that the popu-

lation mean weight is different from 3,150 pounds?
b. Interpret the meaning of the p-value in (a).
c. For the Vermont shingles, is there evidence that the pop-

ulation mean weight is different from 3,700 pounds?
d. Interpret the meaning of the p-value in (c).
e. In (a) through (d), do you have to worry about the nor-

mality assumption? Explain.

9.78 The manufacturer of Boston and Vermont asphalt
shingles provides its customers with a 20-year warranty on
most of its products. To determine whether a shingle will
last through the warranty period, accelerated-life testing is
conducted at the manufacturing plant. Accelerated-life test-
ing exposes the shingle to the stresses it would be subject to
in a lifetime of normal use in a laboratory setting via an ex-
periment that takes only a few minutes to conduct. In this
test, a shingle is repeatedly scraped with a brush for a short
period of time, and the shingle granules removed by the
brushing are weighed (in grams). Shingles that experience
low amounts of granule loss are expected to last longer in

Pallet

Moisture



358 CHAPTER 9 Fundamentals of Hypothesis Testing: One-Sample Tests

M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
Continuing its monitoring of the upload speed first
described in the Chapter 6 Managing Ashland Multi-
Comm Services case on page 244, the technical opera-
tions department wants to ensure that the mean target
upload speed for all Internet service subscribers is at least
0.97 on a standard scale in which the target value is 1.0.
Each day, upload speed was measured 50 times, with the
following results (stored in ).AMS9

Calculate the sample statistics and determine whether there is
evidence that the population mean upload speed is less than
0.97. Write a memo to management that summarizes your
conclusions.

1.052 0.678 1.162 0.808 1.012 0.859 0.951 1.112 1.003 0.972

1.223 1.024 0.884 0.799 0.870 0.898 0.621 0.818 1.113 1.286

1.012 0.695 0.869 0.734 1.131 0.993 0.762 0.814 1.108 0.805

1.091 1.086 1.141 0.931 0.723 0.934 1.060 1.047 0.800 0.889
0.854 1.023 1.005 1.030 1.219 0.977 1.044 0.778 1.122 1.114

Apply your knowledge about hypothesis testing in this
Digital Case, which continues the cereal-fill-packaging
dispute first discussed in the Digital Case from Chapter 7.

In response to the negative statements made by the
Concerned Consumers About Cereal Cheaters (CCACC) in
the Chapter 7 Digital Case, Oxford Cereals recently
conducted an experiment concerning cereal packaging. The
company claims that the results of the experiment refute the
CCACC allegations that Oxford Cereals has been cheating
consumers by packaging cereals at less than labeled
weights.

Open OxfordCurrentNews.pdf, a portfolio of current
news releases from Oxford Cereals. Review the relevant

D I G I TA L C A S E
press releases and supporting documents. Then answer the
following questions:

1. Are the results of the experiment valid? Why or why not?
If you were conducting the experiment, is there anything
you would change?

2. Do the results support the claim that Oxford Cereals is not
cheating its customers?

3. Is the claim of the Oxford Cereals CEO that many cereal
boxes contain more than 368 grams surprising? Is it true?

4. Could there ever be a circumstance in which the results of
the Oxford Cereals experiment and the CCACC’s results
are both correct? Explain
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normal use than shingles that experience high amounts of
granule loss. The file contains a sample of 170
measurements made on the company’s Boston shingles and
140 measurements made on Vermont shingles.
a. For the Boston shingles, is there evidence that the popu-

lation mean granule loss is different from 0.50 grams?
b. Interpret the meaning of the p-value in (a).
c. For the Vermont shingles, is there evidence that the pop-

ulation mean granule loss is different from 0.50 grams?

Granule

d. Interpret the meaning of the p-value in (c).
e. In (a) through (d), do you have to worry about the nor-

mality assumption? Explain.

REPORT WRITING EXERCISE
9.79 Referring to the results of Problems 9.76 through
9.78 concerning Boston and Vermont shingles, write a re-
port that evaluates the moisture level, weight, and granule
loss of the two types of shingles.



EG9.1 FUNDAMENTALS of HYPOTHESIS-
TESTING METHODOLOGY

PHStat2 Use Z Test for the Mean, sigma known to
perform the Z test for the mean when is known. For
example, to perform the Z test for the Figure 9.5 cereal-fill-
ing example on page 334, select PHStat ➔ One-Sample
Tests ➔ Z Test for the Mean, sigma known. In the proce-
dure’s dialog box (shown below):

1. Enter 368 as the Null Hypothesis.

2. Enter 0.05 as the Level of Significance.

3. Enter 15 as the Population Standard Deviation.

4. Click Sample Statistics Known and enter 25 as the
Sample Size and 372.5 as the Sample Mean.

5. Click Two-Tail Test.

6. Enter a Title and click OK.

s

For problems that use unsummarized data, click Sample
Statistics Unknown in step 4 and enter the cell range of the
unsummarized data as the Sample Cell Range.

In-Depth Excel Use the COMPUTE worksheet of the Z
Mean workbook, shown in Figure 9.5 on page 334, as a
template for performing the two-tail Z test. The worksheet
contains the data for the Section 9.1 cereal-filling example.
For other problems, change the values in cells B4 through
B8 as necessary.

In cells B15 and B16, NORMSINV(level of signifi-

cance / 2) and NORMSINV(1 - level of significance / 2)
computes the lower and upper critical values. The
expression 2 * (1 � NORMSDIST (absolute value of the

Z test statistic)) computes the p-value for the two-tail test in
cell B17. In cell A18, IF(p-value level of significance,
display reject message, display do not reject message) de-
termines which message to display in the cell.

EG9.2 t TEST of HYPOTHESIS for the
MEAN ( UNKNOWN)

PHStat2 Use t Test for the Mean, sigma unknown to
perform the t test for the mean when is unknown. For ex-
ample, to perform the t test for the Figure 9.7 sales invoice
example on page 340, select PHStat ➔ One-Sample Tests
➔ t Test for the Mean, sigma unknown. In the procedure’s
dialog box (shown on the top of page 360):

1. Enter 120 as the Null Hypothesis.

2. Enter 0.05 as the Level of Significance.

3. Click Sample Statistics Known and enter 12 as the
Sample Size, 112.85 as the Sample Mean, and 20.8 as
the Sample Standard Deviation.

4. Click Two-Tail Test.

5. Enter a Title and click OK.

s

s

6
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For problems that use unsummarized data, click Sample
Statistics Unknown in step 3 and enter the cell range of the
unsummarized data as the Sample Cell Range.

In-Depth Excel Use the COMPUTE worksheet of the T
mean workbook, shown in Figure 9.7 on page 340, as a
template for performing the two-tail t test. The worksheet
contains the data for the Section 9.2 sales invoice example.
For other problems, change the values in cells B4 through
B8 as necessary.

In cells B16 and B17, the worksheet uses the expres-
sions -TINV(level of significance, degrees of freedom) and
TINV(level of significance, degrees of freedom) to com-
pute the lower and upper critical values, respectively. In cell
B18, the worksheet uses TDIST(absolute value of the t test

statistic, degrees of freedom, 2) to compute the p-value. The
worksheet also uses an IF function to determine which mes-
sage to display in cell A19.

EG9.3 ONE-TAIL TESTS

PHStat2 Click either Lower-Tail Test or Upper-Tail Test
in the procedure dialog boxes discussed in Sections EG9.1
and EG9.2 to perform a one-tail test. For example, to per-
form the Figure 9.12 one-tail test for the drive-through time
study example on page 346, select PHStat ➔ One-Sample

Tests ➔ t Test for the Mean, sigma unknown. In the pro-
cedure’s dialog box (shown below):
1. Enter 174.22 as the Null Hypothesis.

2. Enter 0.05 as the Level of Significance.

3. Click Sample Statistics Known and enter 25 as the
Sample Size, 162.96 as the Sample Mean, and 20.2 as
the Sample Standard Deviation.

4. Click Lower-Tail Test.
5. Enter a Title and click OK.

In-Depth Excel Modify the functions discussed in
Section EG9.1 and EG9.2 to perform one-tail tests. For
the Section EG9.1 Z test, enter NORMSINV(level of

significance) or NORMSINV(1 � level of significance)
to compute the lower-tail or upper-tail critical value.
Enter NORMSDIST(Z test statistic) or 1 � NORMS-
DIST(absolute value of the Z test statistic) to compute
the lower-tail or upper-tail p-value. For the Section EG9.2
t test, enter -TINV(2 * level of significance, degrees of

freedom) or TINV(2 * level of significance, degrees of

freedom) to compute the lower-tail or upper-tail critical
values.

Computing p-values is more complex. If the t test sta-
tistic is less than zero, the lower-tail p-value is equal to
TDIST(absolute value of the t test statistic, degrees of
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freedom, 1), and the upper-tail p-value is equal to 1 �
TDIST(absolute value of the t test statistic, degrees of

freedom, 1). If the t test statistic is greater than or equal to
zero, the values are reversed.

Use the COMPUTE_LOWER worksheet or the
COMPUTE_UPPER worksheet of the Z Mean workbook
or the T mean workbook as a template for performing one-
tail t tests. Open the COMPUTE_ALL_FORMULAS work-
sheet of either workbook to examine all formulas.

EG9.4 Z TEST of HYPOTHESIS
for the PROPORTION

PHStat2 Use Z Test for the Proportion to perform the Z
test of hypothesis for the proportion. For example, to per-
form the Z test for the Figure 9.15 vacation Internet access
study example on page 351, select PHStat ➔ One-Sample
Tests ➔ Z Test for the Proportion. In the procedure’s dia-
log box (shown in the right column):
1. Enter 0.75 as the Null Hypothesis.

2. Enter 0.05 as the Level of Significance.

3. Enter 1540 as the Number of Items of Interest.

4. Enter 2000 as the Sample Size.

5. Click Two-Tail Test.
6. Enter a Title and click OK.

In-Depth Excel Use the COMPUTE worksheet of the Z
Proportion workbook, shown in Figure 9.15 on page 351,
as a template for performing the two-tail Z test. The work-
sheet contains the data for the Section 9.4 vacation Internet

access study example. For other problems, change the val-
ues in cells B4 through B7 as necessary.

The worksheet uses NORMSINV(level of signifi-

cance / 2) and NORMSINV(1 - level of significance / 2)
to compute the lower and upper critical values in cells
B15 and B16. In cell B17, the worksheet uses the expres-
sion 2 * (1 � NORMSDIST(absolute value of the Z test

statistic) to compute the p-value. The worksheet also uses
an IF function to determine which message to display in
cell A18.

Use the COMPUTE_LOWER worksheet or
COMPUTE_UPPER worksheet as a template for
performing one-tail tests. Open to the COMPUTE_ALL_
FORMULAS worksheet to examine all formulas in the
one-tail test worksheets.
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C H A P T E R 9 M I N I TA B G U I D E

MG9.1 FUNDAMENTALS of HYPOTHESIS-
TESTING METHODOLOGY

Use 1-Sample Z to perform the Z test for the mean when
is known. For example, to perform the Z test for the Figure
9.5 cereal-filling example on page 334, select Stat ➔ Basic
Statistics ➔ 1-Sample Z. In the “1-Sample Z (Test and
Confidence Interval)” dialog box (shown below):

1. Click Summarized data.

2. Enter 25 in the Sample size box and 372.5 in the Mean
box.

3. Enter 15 in the Standard deviation box.

4. Check Perform hypothesis test and enter 368 in the
Hypothesized mean box.

5. Click Options.

s

In the 1-Sample t (Test and Confidence Interval) dialog box
(shown below):

1. Click Summarized data.

2. Enter 12 in the Sample size box, 112.85 in the Mean
box, and 20.8 in the Standard deviation box.

3. Check Perform hypothesis test and enter 120 in the
Hypothesized mean box.

4. Click Options.
In the 1-Sample t - Options dialog box:

5. Enter 95.0 in the Confidence level box.

6. Select not equal from the Alternative drop-down list.

7. Click OK.

8. Back in the original dialog box, click OK.

In the 1-Sample Z - Options dialog box:

6. Enter 95.0 in the Confidence level box.

7. Select not equal from the Alternative drop-down list.

8. Click OK.

9. Back in the original dialog box, click OK.

For problems that use unsummarized data, open the
worksheet that contains the data and replace steps 1 and 2
with these steps:

1. Click Samples in columns.

2. Enter the name of the column containing the unsumma-
rized data in the Samples in column box.

MG9.2 t TEST of HYPOTHESIS
for the MEAN ( UNKNOWN)

Use t Test for the Mean, sigma unknown to perform the t
test for the mean when is unknown. For example, to per-
form the t test for the Figure 9.7 sales invoice example on
page 340, select Stat ➔ Basic Statistics ➔ 1-Sample t.

s

s

For problems that use unsummarized data, open the
worksheet that contains the data and replace steps 1 and 2
with these steps:

1. Click Samples in columns.

2. Enter the name of the column containing the unsumma-
rized in the Samples in column box.

To create a boxplot of the unsummarized data, replace
step 8 with the following steps 8 through 10:

8. Back in the original dialog box, click Graphs.

9. In the 1-Sample t - Graphs dialog box, check Boxplot of
data and then click OK.

10. Back in the original dialog box, click OK.

MG9.3 ONE-TAIL TESTS

To perform a one-tail test for 1-Sample Z, select less than
or greater than from the drop-down list in step 7 of the Sec-
tion MG9.1 instructions.

To perform a one-tail test for 1-Sample t, select less
than or greater than from the drop-down list in step 6 of
the Section MG9.2 instructions.
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MG9.4 Z TEST of HYPOTHESIS
for the PROPORTION

Use 1 Proportion to perform the Z test of hypothesis for the
proportion. For example, to perform the Z test for the Figure
9.15 vacation Internet access study example on page 351, se-
lect Stat ➔ Basic Statistics ➔ 1 Proportion. In the 1 Propor-
tion (Test and Confidence Interval) dialog box (shown below):

1. Click Summarized data.

2. Enter 1540 in the Number of events box and 2000 in
the Number of trials box.

3. Check Perform hypothesis test and enter 0.75 in the
Hypothesized proportion box.

4. Click Options.

7. Check Use test and interval based on normal distri-
bution.

8. Click OK.

9. Back in the original dialog box, click OK.

To perform a one-tail test, select less than or greater
than from the drop-down list in step 6. For problems that
use unsummarized data, open the worksheet that contains
the data and replace steps 1 and 2 with these steps:

1. Click Samples in columns.

2. Enter the name of the column containing the unsumma-
rized in the Samples in column box.

In the 1-Proportion - Options dialog box (shown in right
column):

5. Enter 95.0 in the Confidence level box.

6. Select not equal from the Alternative drop-down list.
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In this chapter, you learn how to use hypothesis testing for comparing 
the difference between:

• The means of two independent populations

• The means of two related populations

• The proportions of two independent populations

• The variances of two independent populations
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Does the type of display used in a supermarket affect the sales of products? As the
regional sales manager for BLK Beverages, you want to compare the sales volume of
BLK Cola when the product is placed in the normal shelf location to the sales volume
when the product is featured in a special end-aisle display. To test the effectiveness of
the end-aisle displays, you select 20 stores from the Food Pride supermarket chain that

all experience similar storewide sales volumes. You then randomly assign 10 of the 20 stores to sample
1 and 10 stores to sample 2. The managers of the 10 stores in sample 1 place the BLK Cola in the 
normal shelf location, alongside the other cola products. The 10 stores in sample 2 use the special end-
aisle promotional display. At the end of one week, the sales of BLK Cola are recorded. How can you
determine whether sales of BLK Cola using the end-aisle displays are the same as those when the cola
is placed in the normal shelf location? How can you decide if the variability in BLK Cola sales from
store to store is the same for the two types of displays? How could you use the answers to these 
questions to improve sales of BLK Cola?

U S I N G S TAT I S T I C S

@ BLK Beverages

365
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H ypothesis testing provides a confirmatory approach to data analysis. In Chapter 9,
you learned a variety of commonly used hypothesis-testing procedures that relate to
a single sample of data selected from a single population. In this chapter, you learn

how to extend hypothesis testing to two-sample tests that compare statistics from samples of
data selected from two populations. One such test for the BLK Beverages scenario would be
“Are the mean weekly sales of BLK Cola when using the normal shelf location (one
population) equal to the mean weekly sales of BLK Cola when using an end-aisle display (a
second population)?”

10.1 Comparing the Means of Two Independent Populations
In Sections 8.1 and 9.1, you learned that in almost all cases, you would not know the popula-
tion standard deviation of the population under study. Likewise, when you take a random sam-
ple from each of two independent populations, you almost always do not know the standard
deviations of either population. However, you also need to know whether you can assume that
the variances in the two populations are equal because the method you use to compare the
means of each population depends on whether you can assume that the variances of the two
populations are equal.

Pooled-Variance t Test for the Difference
Between Two Means
If you assume that the random samples are independently selected from two populations and
that the populations are normally distributed and have equal variances, you can use a
pooled-variance t test to determine whether there is a significant difference between the
means of the two populations. If the populations are not normally distributed, the pooled-
variance t test can still be used if the sample sizes are large enough (typically for each
sample1).

Using subscripts to distinguish between the population mean of the first population,
and the population mean of the second population, the null hypothesis of no difference in
the means of two independent populations can be stated as

and the alternative hypothesis, that the means are not the same, can be stated as

To test the null hypothesis, use the pooled-variance t test statistic shown in Equation
(10.1). The pooled-variance t test gets its name from the fact that the test statistic pools, or
combines, the two sample variances and to compute the best estimate of the
variance common to both populations, under the assumption that the two population
variances are equal.2

S2
p,S2

2S2
1

tSTAT

H1: m1 Z m2 or m1 - m2 Z 0

H0: m1 = m2 or m1 - m2 = 0

m2,
m1,

Ú 30

Worksheet data for samples
taken from two independent
populations can be stored
either in stacked or unstacked
format, as discussed in Section
2.3. Examples throughout this
chapter use unstacked data,
although by using the
techniques discussed in either
Section EG2.3 (for Excel ) or
MG2.3 (for Minitab), you can
rearrange unstacked data as
stacked data or rearrange
stacked data as unstacked
data.

1Review the Section 7.4 discussion
about the Central Limit Theorem
on page 264 to understand more
about “large enough” sample sizes.

POOLED-VARIANCE t TEST FOR THE DIFFERENCE BETWEEN TWO MEANS

(10.1)

where

and

X1 = mean of the  sample taken from population 1

S2
p = pooled variance

S2
p =
1n1 - 12S2

1 + 1n2 - 12S2
2

1n1 - 12 + 1n2 - 12

tSTAT =
1X1 - X22 - 1m1 - m22

AS2
pa 1

n1
+

1
n2
b

2When the two sample sizes are
equal (i.e., ), the equation
for the pooled variance can be sim-
plified to

S2
p =

S2
1 + S2

2

2

n1 = n2
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For a given level of significance, in a two-tail test, you reject the null hypothesis if the
computed test statistic is greater than the upper-tail critical value from the t distribution
or if the computed test statistic is less than the lower-tail critical value from the t
distribution. Figure 10.1 displays the regions of rejection.

tSTAT

tSTAT

a,

0–tα/2 +tα/2 t
Region of
Rejection

Critical
Value

Region of
Nonrejection

Critical
Value

Region of
Rejection

α/2 α/2
1 – α

F I G U R E 1 0 . 1
Regions of rejection and
nonrejection for the
pooled-variance t test for
the difference between
the means (two-tail test)

The test statistic follows a t distribution with degrees of freedom.n1 + n2 - 2tSTAT

n2 = size of the sample taken from population 2

S2
2 = variance of the sample taken from population 2

X2 = mean of the sample taken from population 2

n1 = size of the sample taken from population 1

S2
1 = variance of the sample taken from population 1

In a one-tail test in which the rejection region is in the lower tail, you reject the null hypothesis
if the computed test statistic is less than the lower-tail critical value from the t distribution. In a
one-tail test in which the rejection region is in the upper tail, you reject the null hypothesis if the
computed test statistic is greater than the upper-tail critical value from the t distribution.

To demonstrate the pooled-variance t test, return to the BLK Beverages scenario on page
365. You define the business objective as determining whether the mean weekly sales of BLK
Cola are the same when using a normal shelf location and when using an end-aisle display.
There are two populations of interest. The first population is the set of all possible weekly sales
of BLK Cola if all the Food Pride Supermarkets used the normal shelf location. The second
population is the set of all possible weekly sales of BLK Cola if all the Food Pride Supermar-
kets used the end-aisle displays. You collect the data from a sample of 10 Food Pride
Supermarkets that have been assigned a normal shelf location and another sample of 10 Food
Pride Supermarkets that have been assigned an end-aisle display. You organize and store the re-
sults in . Table 10.1 contains the BLK Cola sales (in number of cases) for the two samples.Cola

tSTAT

tSTAT

T A B L E 1 0 . 1

Comparing BLK Cola
Weekly Sales from Two
Different Display Locations
(in number of cases)

Display Location

Normal End-Aisle

22 34 52 62 30 52 71 76 54 67
40 64 84 56 59 83 66 90 77 84

The null and alternative hypotheses are

Assuming that the samples are from normal populations having equal variances, you can use
the pooled-variance t test. The test statistic follows a t distribution with 10 + 10 - 2 = 18tSTAT

H1: m1 Z m2 or m1 - m2 Z 0

H0: m1 = m2 or m1 - m2 = 0
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degrees of freedom. Using an level of significance, you divide the rejection region into
the two tails for this two-tail test (i.e., two equal parts of 0.025 each). Table E.3 shows that the
critical values for this two-tail test are and As shown in Figure 10.2, the deci-
sion rule is

otherwise do not reject H0.

or if tSTAT 6 -2.1009;

Reject H0 if tSTAT 7 +2.1009

-2.1009.+2.1009

a = 0.05

F I G U R E 1 0 . 2
Two-tail test of
hypothesis for the
difference between the
means at the 0.05 level
of significance with 18
degrees of freedom

F I G U R E 1 0 . 3
Excel and Minitab results for the pooled-variance t test for the BLK Cola display locations

From Figure 10.3, the computed test statistic for this test is and the p-value
is 0.0070.

-3.0446tSTAT

Using Equation (10.1) on page 366 and the descriptive statistics provided in Figure 10.3,

where

=
9118.726422 + 9112.543322

9 + 9
= 254.0056

S2
p =
1n1 - 12S2

1 + 1n2 - 12S2
2

1n1 - 12 + 1n2 - 12

tSTAT =
1X1 - X22 - 1m1 - m22

A S2
pa 1

n1
+

1
n2
b

–2.1009 +2.10090 t

.025 .025

Region of
Rejection

Critical
Value

Region of
Nonrejection

Critical
Value

Region of
Rejection

.95
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Therefore,

You reject the null hypothesis because and the p-value is
0.0070. In other words, the probability that or is equal to
0.0070. This p-value indicates that if the population means are equal, the probability of
observing a difference this large or larger in the two sample means is only 0.0070. Because the
p-value is less than there is sufficient evidence to reject the null hypothesis. You can
conclude that the mean sales are different for the normal shelf location and the end-aisle
location. Based on these results, the sales are lower for the normal location (i.e., higher for the
end-aisle location).

In testing for the difference between the means, you assume that the populations are nor-
mally distributed, with equal variances. For situations in which the two populations have equal
variances, the pooled-variance t test is robust (i.e., not sensitive) to moderate departures from
the assumption of normality, provided that the sample sizes are large. In such situations, you can
use the pooled-variance t test without serious effects on its power. However, if you cannot assume
that both populations are normally distributed, you have two choices. You can use a nonparamet-
ric procedure, such as the Wilcoxon rank sum test (see Section 12.6), that does not depend on the
assumption of normality for the two populations, or you can use a normalizing transformation
(see reference 6) on each of the outcomes and then use the pooled-variance t test.

To check the assumption of normality in each of the two populations, construct the
boxplot of the sales for the two display locations shown in Figure 10.4. For these two small
samples, there appears to be only moderate departure from normality, so the assumption of
normality needed for the t test is not seriously violated.

a = 0.05,

tSTAT 6 -3.0446tSTAT 7 3.0446
tSTAT = -3.0446 6 -2.1009

tSTAT =
150.3 - 72.02 - 0.0

A254.0056a 1

10
+

1

10
b

=
-21.7150.801

= -3.0446

F I G U R E 1 0 . 4
Excel and Minitab boxplots of the sales for the two display locations

Example 10.1 provides another application of the pooled-variance t test.

You and some friends have decided to test the validity of an advertisement by a local pizza
restaurant, which says it delivers to the dormitories faster than a local branch of a national
chain. Both the local pizza restaurant and national chain are located across the street from your
college campus. You define the variable of interest as the delivery time, in minutes, from the
time the pizza is ordered to when it is delivered. You collect the data by ordering 10 pizzas
from the local pizza restaurant and 10 pizzas from the national chain at different times. You
organize and store the data in . Table 10.2 shows the delivery times.PizzaTime

EXAMPLE 10.1
Testing for the
Difference in the
Mean Delivery 
Times
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T A B L E 1 0 . 2

Delivery Times (in
minutes) for Local Pizza
Restaurant and National
Pizza Chain

Local Chain

16.8 18.1 22.0 19.5
11.7 14.1 15.2 17.0
15.6 21.8 18.7 19.5
16.7 13.9 15.6 16.5
17.5 20.8 20.8 24.0

At the 0.05 level of significance, is there evidence that the mean delivery time for the local
pizza restaurant is less than the mean delivery time for the national pizza chain?

SOLUTION Because you want to know whether the mean is lower for the local pizza
restaurant than for the national pizza chain, you have a one-tail test with the following null and
alternative hypotheses:

(The mean delivery time for the local pizza restaurant is equal to or greater
than the mean delivery time for the national pizza chain.)

(The mean delivery time for the local pizza restaurant is less than the mean
delivery time for the national pizza chain.)

Figure 10.5 displays the results for the pooled-variance t test for these data.

H1: m1 6 m2

H0: m1 Ú m2

F I G U R E 1 0 . 5
Excel and Minitab results for the pooled-variance t test for the pizza delivery time data

To illustrate the computations, using Equation (10.1) on page 366,

tSTAT =
1X1 - X22 - 1m1 - m22

A S2
pa 1

n1
+

1
n2
b
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where

Therefore,

You do not reject the null hypothesis because The p-value (as
computed in Figure 10.5) is 0.0598. This p-value indicates that the probability that

is equal to 0.0598. In other words, if the population means are equal, the prob-
ability that the sample mean delivery time for the local pizza restaurant is at least 2.18 minutes
faster than the national chain is 0.0598. Because the p-value is greater than there is in-
sufficient evidence to reject the null hypothesis. Based on these results, there is insufficient evi-
dence for the local pizza restaurant to make the advertising claim that it has a faster delivery time.

a = 0.05,

tSTAT 6 -1.6341

tSTAT = -1.6341 7 -1.7341.

tSTAT =
116.7 - 18.882 - 0.0

A8.8987a 1

10
+

1

10
b

=
-2.1821.7797

= -1.6341

=
913.095522 + 912.866222

9 + 9
= 8.8987

S2
p =
1n1 - 12S2

1 + 1n2 - 12S2
2

1n1 - 12 + 1n2 - 12

Confidence Interval Estimate for the Difference
Between Two Means
Instead of, or in addition to, testing for the difference in the means of two independent populations,
you can use Equation (10.2) to develop a confidence interval estimate of the difference in the means.

CONFIDENCE INTERVAL ESTIMATE FOR THE DIFFERENCE IN THE MEANS
OF TWO INDEPENDENT POPULATIONS

or

(10.2)

where is the critical value of the t distribution, with degrees of freedom,
for an area of in the upper tail.a>2 n1 + n2 - 2ta>2

1X1 - X22 - ta>2AS2
pa 1

n1
+

1
n2
b … m1 - m2 … 1X1 - X22 + ta>2AS2

pa 1
n1

+
1
n2
b

1X1 - X22 ; ta>2AS2
pa 1

n1
+

1
n2
b

For the sample statistics pertaining to the two aisle locations reported in Figure 10.3 on
page 368, using 95% confidence, and Equation (10.2),

Therefore, you are 95% confident that the difference in mean sales between the normal aisle
location and the end-aisle location is between cases of cola and cases of cola.
In other words, the end-aisle location sells, on average, 6.73 to 36.67 cases more than the nor-
mal aisle location. From a hypothesis-testing perspective, because the interval does not include
zero, you reject the null hypothesis of no difference between the means of the two populations.

-6.73-36.67

-36.67 … m1 - m2 … -6.73

-21.7 ; 14.97

-21.7 ; 12.1009217.12752
150.3 - 72.02 ; 12.10092A254.0056a 1

10
+

1

10 b
= 18 degrees of freedom, t0.025 = 2.1009

X1 = 50.3, n1 = 10, X2 = 72.0, n2 = 10, S2
p = 254.0056, and with 10 + 10 - 2
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SEPARATE-VARIANCE t TEST FOR THE DIFFERENCE BETWEEN TWO MEANS

(10.3)

where

n2 = size of the sample taken from population 2

S2
2 = variance of the sample taken from population 2

X 2 = mean of the sample taken from population 2

n1 = size of the sample taken from population 1

S2
1 = variance of the sample taken from population 1

X 1 = mean of the sample taken from population 1

tSTAT =
1X 1 - X22 - 1m1 - m22

AS 2
1

n1
+ S 2

2

n2

COMPUTING DEGREES OF FREEDOM IN THE SEPARATE-VARIANCE t TEST

(10.4)V =
aS2

1

n1
+

S2
2

n2
b2

aS2
1

n1
b2

n1 - 1
+
aS2

2

n2
b2

n2 - 1

t Test for the Difference Between Two Means, Assuming
Unequal Variances
If you cannot make the assumption that the two independent populations have equal variances, you
cannot pool the two sample variances into the common estimate and therefore cannot use the
pooled-variance t test. Instead, you use the separate-variance t test developed by Satterthwaite (see
reference 5). Equation (10.3) defines the test statistic for the separate-variance t test.

S2
p

The separate-variance t test statistic approximately follows a t distribution with V degrees of
freedom equal to the integer portion of the following computation.

For a given level of significance α, you reject the null hypothesis if the computed t test statis-
tic is greater than the upper-tail critical value ta/2 from the t distribution with V degrees of free-
dom or if the computed t test statistic is less than the lower-tail critical value - ta/2 from the t
distribution with V degrees of freedom. Thus, the decision rule is

Recall the Using Statistics scenario for this chapter that concerned the display location of
BLK Cola. Using Equation (10.4), the separate-variance t test statistic tSTAT is approximated by a t
distribution with V = 15 degrees of freedom, the integer portion of the following computation:

V =
aS2

1

n1
+

S2
2

n2
b2

aS2
1

n1
b2

n1 - 1
+
aS2

2

n2
b2

n2 - 1

otherwise, do not reject H0.

or if t 6 - ta>2;
Reject H0 if t 7 ta>2
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Using , the upper and lower critical values for this two-tail test found in Table E.3 are
+2.1315 and -2.1315. As depicted in Figure 10.6, the decision rule is

otherwise do not reject H0.

or if tSTAT 6 -2.1315;

Reject H0 if tSTAT 7 +2.1315

a = 0.05

=
a350.6778

10
+

157.3333

10
b2

a350.6778

10
b2

9
+
a157.3333

10
b2

9

= 15.72

F I G U R E 1 0 . 6
Two-tail test of
hypothesis for the
difference between the
means at the 0.05 level
of significance with 15
degrees of freedom

Using Equation (10.3) on page 372 and the descriptive statistics provided in Figure 10.3,

Using a 0.05 level of significance, you reject the null hypothesis because t = -3.04 < -2.1315.
Figure 10.7 on page 374 displays the separate-variance t test results for the display location
data.

In Figure 10.7, the test statistic and the p-value is
Thus, the results for the separate-variance t test are almost exactly the same as those of the
pooled-variance t test. The assumption of equality of population variances had no apprecia-
ble effect on the results. Sometimes, however, the results from the pooled-variance and
separate-variance t tests conflict because the assumption of equal variances is violated.
Therefore, it is important that you evaluate the assumptions and use those results as a guide
in selecting a test procedure. In Section 10.4, the F test for the ratio of two variances is used
to determine whether there is evidence of a difference in the two population variances. The
results of that test can help you determine which of the t tests—pooled-variance or separate-
variance—is more appropriate.

0.0082 6 0.05.tSTAT = -3.0446

=
50.3 - 72

A a350.6778

10
+

157.3333

10
b

=
-21.7250.801

= -3.04

tSTAT =
1X1 - X22 - 1m1 - m22

AS2
1

n1
+ S2

2

n2

–2.1315 +2.13150 t

.025 .025

Region of
Rejection

Critical
Value

Region of
Nonrejection

Critical
Value

Region of
Rejection

.95

X1 – X2
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F I G U R E 1 0 . 7
Excel and Minitab results for the separate-variance t test for the display location data

T H I N K A B O U T T H I S “This Call May Be Monitored ... ”

When talking with a customer service represen-
tative by phone, you may have heard a “This call
may be monitored ... ” message. Typically, the
message explains that the monitoring is for
“quality assurance purposes,” but do companies
really monitor your calls to improve quality?

From a past student, we’ve discovered
that at least one large financial services com-
pany really does monitor the quality of calls.
This student was asked to develop an im-
proved training program for a call center that
was hiring people to answer phone calls cus-
tomers make about outstanding loans. For
feedback and evaluation, she planned to ran-
domly select phone calls received by each
new employee and rate the employee on 10
aspects of the call, including whether the em-
ployee maintained a pleasant tone with the
customer.

Who You Gonna Call?
The former student presented her plan to her boss
for approval, but her boss, quoting a famous statis-
tician, said, “In God we trust, all others must bring
data.” Her boss wanted proof that her new training
program would improve customer service. Faced
with this request, who would you call? She called
her business statistics professor, one of the co-au-
thors of this book. “Hey, Professor, you’ll never be-
lieve why I called. I work for a large company, and
in the project I am currently working on, I have to
put some of the statistics you taught us to work!
Can you help?” Together they formulated this test:

• Randomly assign the 60 most recent hires
to two training programs. Assign half to the
preexisting training program and the other
half to the new training program.

• At the end of the first month, compare the
mean score for the 30 employees in the new

training program against the mean score for
the 30 employees in the preexisting training
program.

She listened as her professor explained, “What
you are trying to show is that the mean score from
the new training program is higher than the mean
score from the current program. You can make the
null hypothesis that the means are equal and see if
you can reject it in favor of the alternative that the
mean score from the new program is higher.”

“Or, as you used to say, ‘if the p-value is low,
must go!’—yes, I do remember!” she replied.

Her professor chuckled and added, “If you can
reject you will have the evidence to present
to your boss.” She thanked him for his help and
got back to work, with the newfound confidence
that she would be able to successfully apply the
t test that compares the means of two
independent populations.

H0,

H0

Problems for Section 10.1
LEARNING THE BASICS
10.1 If you have samples of and in
performing the pooled-variance t test, how many degrees of
freedom do you have?

10.2 Assume that you have a sample of with the
sample mean and a sample standard deviationX1 = 42,

n1 = 8,

n2 = 15,n1 = 12

and you have an independent sample of
from another population with a sample mean of
and a sample standard deviation
a. What is the value of the pooled-variance test

statistic for testing 
b. In finding the critical value, how many degrees of free-

dom are there?

H0: m1 = m2?
tSTAT

S2 = 5.
X2 = 34
n2 = 15S1 = 4,



Problems for Section 10.1 375

c. Using the level of significance what is the criti-
cal value for a one-tail test of the hypothesis
against the alternative,

d. What is your statistical decision?

10.3 What assumptions about the two populations are nec-
essary in Problem 10.2?

10.4 Referring to Problem 10.2, construct a 95% confi-
dence interval estimate of the population mean difference
between and

10.5 Referring to Problem 10.2, if and
how many degrees of freedom do you have?

10.6 Referring to Problem 10.2, if and at the
0.01 level of significance, is there evidence that

APPLYING THE CONCEPTS
10.7 According to a recent study, when shopping online for
luxury goods, men spend a mean of $2,401, whereas women
spend a mean of $1,527. (Data extracted from R. A. Smith,
“Fashion Online: Retailers Tackle the Gender Gap,” The Wall
Street Journal, March 13, 2008, pp. D1, D10.) Suppose that
the study was based on a sample of 600 men and 700 females,
and the standard deviation of the amount spent was $1,200
for men and $1,000 for women.
a. State the null and alternative hypothesis if you want to

determine whether the mean amount spent is higher for
men than for women.

b. In the context of this study, what is the meaning of the Type I
error?

c. In the context of this study, what is the meaning of the
Type II error?

d. At the 0.01 level of significance, is there evidence that
the mean amount spent is higher for men than for
women?

10.8 A recent study (“Snack Ads Spur Children to Eat
More,” The New York Times, July 20, 2009, p. B3) found that
children who watched a cartoon with food advertising ate,
on average, 28.5 grams of Goldfish crackers as compared to
an average of 19.7 grams of Goldfish crackers for children
who watched a cartoon without food advertising. Although
there were 118 children in the study, neither the sample size
in each group nor the sample standard deviations were re-
ported. Suppose that there were 59 children in each group,
and the sample standard deviation for those children who
watched the food ad was 8.6 grams and the sample standard
deviation for those children who did not watch the food ad
was 7.9 grams.
a. Assuming that the population variances are equal and

is there evidence that the mean amount of
Goldfish crackers eaten was significantly higher for the
children who watched food ads?

b. Assuming that the population variances are equal,
construct a 95% confidence interval estimate of the dif-
ference between the mean amount of Goldfish crackers

a = 0.05,

m1 7 m2?
n2 = 4,n1 = 5

n2 = 4,n1 = 5

m2.m1

H1: m1 7 m2?
H0: m1 … m2

a = 0.01, eaten by the children who watched and did not watch the
food ad.

c. Compare the results of (a) and (b) and discuss.

10.9 A problem with a telephone line that prevents a
customer from receiving or making calls is upsetting to
both the customer and the telephone company. The file

contains samples of 20 problems reported to two
different offices of a telephone company and the time to
clear these problems (in minutes) from the customers’
lines:

Central Office I Time to Clear Problems (minutes)

Central Office II Time to Clear Problems (minutes)

a. Assuming that the population variances from both of-
fices are equal, is there evidence of a difference in the
mean waiting time between the two offices? (Use

)
b. Find the p-value in (a) and interpret its meaning.
c. What other assumption is necessary in (a)?
d. Assuming that the population variances from both offices

are equal, construct and interpret a 95% confidence in-
terval estimate of the difference between the population
means in the two offices.

10.10 The Computer Anxiety Rating Scale
(CARS) measures an individual’s level of computer

anxiety, on a scale from 20 (no anxiety) to 100 (highest level
of anxiety). Researchers at Miami University administered
CARS to 172 business students. One of the objectives of the
study was to determine whether there is a difference in the
level of computer anxiety experienced by female and male
business students. They found the following:

SELF
Test

a = 0.05.

3.75 0.65 1.92 0.60 1.53 4.23 0.08 1.48 1.65 0.72

7.55 3.75 0.10 1.10 0.60 0.52 3.30 2.10 0.58 4.02

1.02 0.53 0.93 1.60 0.80 1.05 6.32 3.93 5.45 0.97

1.48 1.75 0.78 2.85 0.52 1.60 4.15 3.97 1.48 3.10

Phone

Males Females

X 40.26 36.85
S 13.35 9.42
n 100 72

Source: Data extracted from T. Broome and D. Havelka, “Determinants of
Computer Anxiety in Business Students,” The Review of Business
Information Systems, Spring 2002, 6(2), pp. 9–16.

a. At the 0.05 level of significance, is there evidence of a
difference in the mean computer anxiety experienced by
female and male business students?

b. Determine the p-value and interpret its meaning.
c. What assumptions do you have to make about the two

populations in order to justify the use of the t test?

10.11 An important feature of digital cameras is battery life,
the number of shots that can be taken before the battery needs
to be recharged. The file contains the batteryDigitalCameras
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a. Assuming that the population variances from both
conditions are equal, is there evidence of a difference in
the mean surface hardness between untreated and treated
steel plates? (Use )

b. Determine the p-value in (a) and interpret its meaning.
c. In addition to equal variances, what other assumption is

necessary in (a)?
d. Construct and interpret a 95% confidence interval

estimate of the difference between the population means
from treated and untreated steel plates.

10.15 Repeat Problem 10.14 (a), assuming that the popu-
lation variances from untreated and treated steel plates are not
equal. Compare the results with those of Problem 10.14 (a).

10.16 Do young children use cell phones? Apparently so,
according to a recent study (A. Ross, “Message to Santa;
Kids Want a Phone,” Palm Beach Post, December 16, 2008,
pp. 1A, 4A), which stated that cell phone users under 12
years of age averaged 137 calls per month as compared to
231 calls per month for cell phone users 13 to 17 years of
age. No sample sizes were reported. Suppose that the results
were based on samples of 50 cell phone users in each group
and that the sample standard deviation for cell phone users
under 12 years of age was 51.7 calls per month and the sam-
ple standard deviation for cell phone users 13 to 17 years of
age was 67.6 calls per month.
a. Assuming that the variances in the populations of cell

phone users are equal, is there evidence of a difference in
the mean cell phone usage between cell phone users un-
der 12 years of age and cell phone users 13 to 17 years of
age? (Use a 0.05 level of significance.)

b. In addition to equal variances, what other assumption is
necessary in (a)?

10.17 Nondestructive evaluation is a method that is used
to describe the properties of components or materials with-
out causing any permanent physical change to the units. It
includes the determination of properties of materials and the
classification of flaws by size, shape, type, and location.
This method is most effective for detecting surface flaws
and characterizing surface properties of electrically conduc-
tive materials. Data were collected that classified each com-
ponent as having a flaw or not, based on manual inspection

a = 0.05.

Untreated Treated

164.368 177.135 158.239 150.226
159.018 163.903 138.216 155.620
153.871 167.802 168.006 151.233
165.096 160.818 149.654 158.653
157.184 167.433 145.456 151.204
154.496 163.538 168.178 150.869
160.920 164.525 154.321 161.657
164.917 171.230 162.763 157.016
169.091 174.964 161.020 156.670
175.276 166.311 167.706 147.920

life of 29 subcompact cameras and 16 compact cameras.
(Data extracted from “Digital Cameras,” Consumer Reports,
July 2009, pp. 28–29.)
a. Assuming that the population variances from both types

of digital cameras are equal, is there evidence of a differ-
ence in the mean battery life between the two types of
digital cameras 

b. Determine the p-value in (a) and interpret its meaning.
c. Assuming that the population variances from both types

of digital cameras are equal, construct and interpret a
95% confidence interval estimate of the difference be-
tween the population mean battery life of the two types
of digital cameras.

10.12 A bank with a branch located in a commercial
district of a city has the business objective of developing an
improved process for serving customers during the noon-to-
1 P.M. lunch period. Management decides to first study the
waiting time in the current process. The waiting time is
defined as the time that elapses from when the customer
enters the line until he or she reaches the teller window. Data
are collected from a random sample of 15 customers, and the
results (in minutes) are as follows (and stored in ):

Suppose that another branch, located in a residential area,
is also concerned with improving the process of serving
customers in the noon-to-1 P.M. lunch period. Data are
collected from a random sample of 15 customers, and the
results are as follows (and stored in ):

a. Assuming that the population variances from both banks
are equal, is there evidence of a difference in the mean
waiting time between the two branches? (Use )

b. Determine the p-value in (a) and interpret its meaning.
c. In addition to equal variances, what other assumption is

necessary in (a)?
d. Construct and interpret a 95% confidence interval

estimate of the difference between the population means
in the two branches.

10.13 Repeat Problem 10.12 (a), assuming that the
population variances in the two branches are not equal.
Compare the results with those of Problem 10.12 (a).

10.14 In intaglio printing, a design or figure is carved
beneath the surface of hard metal or stone. The business
objective of an intaglio printing company is to determine
whether there are differences in the mean surface hardness
of steel plates, based on two different surface conditions—
untreated and treated by lightly polishing with emery paper.
An experiment is designed in which 40 steel plates are
randomly assigned—20 plates are untreated and 20 plates
are treated. The results of the experiment (stored in )
are as follows:

Intaglio

a = 0.05.

10.49 6.68 5.64 4.08 6.17 9.91 5.47

9.66 5.90 8.02 5.79 8.73 3.82 8.01 8.35

Bank2

4.50 6.10 0.38 5.12 6.46 6.19 3.79

4.21 5.55 3.02 5.13 4.77 2.34 3.54 3.20

Bank1

1a = 0.052?
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and operator judgment, and the data also reported the size
of the crack in the material. Do the components classified as
unflawed have a smaller mean crack size than components
classified as flawed? The results in terms of crack size (in
inches) are stored in . (Data extracted from B. D. Olin
and W. Q. Meeker, “Applications of Statistical Methods to
Nondestructive Evaluation,” Technometrics, 38, 1996,
p. 101.)

Crack

a. Assuming that the population variances are equal, is
there evidence that the mean crack size is smaller for the
unflawed specimens than for the flawed specimens? (Use

)
b. Repeat (a), assuming that the population variances are

not equal.
c. Compare the results of (a) and (b).

a = 0.05.

10.2 Comparing the Means of Two Related Populations
The hypothesis-testing procedures presented in Section 10.1 enable you to make comparisons
and examine differences in the means of two independent populations. In this section, you will
learn about a procedure for analyzing the difference between the means of two populations
when you collect sample data from populations that are related—that is, when results of the
first population are not independent of the results of the second population.

There are two situations that involve related data between populations. Either you take
repeated measurements from the same set of items or individuals or you match items or
individuals according to some characteristic. In either situation, you are interested in the
difference between the two related values rather than the individual values themselves.

When you take repeated measurements on the same items or individuals, you assume
that the same items or individuals will behave alike if treated alike. Your objective is to show
that any differences between two measurements of the same items or individuals are due to
different treatment conditions. For example, when performing a taste-testing experiment
comparing two beverages, you can use each person in the sample as his or her own control so
that you can have repeated measurements on the same individual.

Another example of repeated measurements involves the pricing of the same goods from
two different vendors. For example, have you ever wondered whether new textbook prices at a
local college bookstore are different from the prices offered at a major online retailer? You
could take two independent samples, that is, select two different sets of textbooks, and then
use the hypothesis tests discussed in Section 10.1.

However, by random chance, the first sample may have many large-format hardcover text-
books and the second sample may have many small trade paperback books. This would imply that
the first set of textbooks will always be more expensive than the second set of textbooks, regard-
less of where they are purchased. That observation means that using the Section 10.1 tests would
not be a good choice. The better choice would be to use two related samples, that is, to determine
the price of the same sample of textbooks at both the local bookstore and the online retailer.

The second situation that involves related data between populations is when you have
matched samples. Here items or individuals are paired together according to some
characteristic of interest. For example, in test marketing a product in two different advertising
campaigns, a sample of test markets can be matched on the basis of the test market population
size and/or demographic variables. By accounting for the differences in test market population
size and/or demographic variables, you are better able to measure the effects of the two
different advertising campaigns.

Regardless of whether you have matched samples or repeated measurements, the objective is
to study the difference between two measurements by reducing the effect of the variability that is
due to the items or individuals themselves. Table 10.3 shows the differences in the individual val-
ues for two related populations. To read this table, let represent the n values
from a sample. And let represent either the corresponding n matched values
from a second sample or the corresponding n repeated measurements from the initial sample.
Then, will represent the corresponding set of n difference scores such that

D1 = X11 - X21, D2 = X12 - X22, Á , and Dn = X1n - X2n.

D1, D2, Á , Dn

X21, X22, Á , X2n

X11, X12, Á , X1n
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Paired t Test
If you assume that the difference scores are randomly and independently selected from a
population that is normally distributed, you can use the paired t test for the mean difference
in related populations to determine if there is a significant population mean difference. As with
the one-sample t test developed in Section 9.2 [see Equation (9.2) on page 338], the paired t
test statistic follows the t distribution with degrees of freedom. Although the paired t
test assumes that the population is normally distributed, you can use this test as long as the
sample size is not very small and the population is not highly skewed.

To test the null hypothesis that there is no difference in the means of two related populations:

against the alternative that the means are not the same:

you compute the test statistic using Equation (10.5).tSTAT

H1: mD Z 0

H0: mD = 0 1where mD = m1 - m22

n - 1

T A B L E 1 0 . 3

Determining the
Difference Between Two
Related Samples

Sample

Value 1 2 Difference

1 X11 X21 D1 = X11 - X21
2 X12 X22 D2 = X12 - X22
. . . .
. . . .
. . . .
ii X1i X2i Di = X1i - X2i
. . . .
. . . .
. . . .
n X1n X2n Dn = X1n - X2n

PAIRED t TEST FOR THE MEAN DIFFERENCE

(10.5)

where

The test statistic follows a t distribution with degrees of freedom.n - 1tSTAT

SD = Qa
n

i=1
1Di - D22
n - 1

D =
a

n

i=1
Di

n

mD = hypothesized mean difference

tSTAT = D - mD

SD2n

To test for the mean difference between two related populations, you treat the difference
scores, each as values from a single sample.Di,
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For a two-tail test with a given level of significance, you reject the null hypothesis if the
computed test statistic is greater than the upper-tail critical value from the t distribution,
or if the computed test statistic is less than the lower-tail critical value from the t dis-
tribution. The decision rule is

You can use the paired t test for the mean difference to investigate a question raised earlier
in this section: Are new textbook prices at a local college bookstore different from the prices
offered at a major online retailer?

In this repeated-measurements experiment, you use one set of textbooks. For each
textbook, you determine the price at the local bookstore and the price at the online re-
tailer. By determining the two prices for the same textbooks, you can reduce the variabil-
ity in the prices compared with what would occur if you used two independent sets of
textbooks. This approach focuses on the differences between the prices of the same text-
books offered by the two retailers.

You collect data by conducting an experiment from a sample of n = 19 textbooks used
primarily in business school courses during the summer 2010 semester at a local college. You
determine the college bookstore price and the online price (which includes shipping costs, if
any). You organize and store the data in . Table 10.4 shows the results.BookPrices

otherwise, do not reject H0.

or if tSTAT 6 - ta>2;
Reject H0 if tSTAT 7 ta>2

- ta>2tSTAT

ta>2tSTAT

a,

T A B L E 1 0 . 4

Prices of Textbooks at
the College Bookstore
and at an Online Retailer

Author Title Bookstore Online

Pride Business 10/e 132.75 136.91
Carroll Business and Society 201.50 178.58
Quinn Ethics for the Information Age 80.00 65.00
Bade Foundations of Microeconomics 5/e 153.50 120.43
Case Principles of Macroeconomics 9/e 153.50 217.99
Brigham Financial Management 13/e 216.00 197.10
Griffin Organizational Behavior 9/e 199.75 168.71
George Understanding and Managing Organizational Behavior 5/e 147.00 178.63
Grewal Marketing 2/e 132.00 95.89
Barlow Abnormal Psychology 182.25 145.49
Foner Give Me Liberty: Seagull Ed. (V2) 2/e 45.50 37.60
Federer Mathematical Interest Theory 2/e 89.95 91.69
Hoyle Advanced Accounting 9/e 123.02 148.41
Haviland Talking About People 4/e 57.50 53.93
Fuller Information Systems Project Management 88.25 83.69
Pindyck Macroeconomics 7/e 189.25 133.32
Mankiw Macroeconomics 7/e 179.25 151.48
Shapiro Multinational Financial Management 9/e 210.25 147.30
Losco American Government 2010 Edition 66.75 55.16

Your objective is to determine whether there is any difference in the mean textbook price
between the college bookstore and the online retailer. In other words, is there evidence that the
mean price is different between the two sellers of textbooks? Thus, the null and alternative
hypotheses are

(There is no difference in the mean price between the college bookstore and
the online retailer.)

(There is a difference in the mean price between the college bookstore and
online retailer.)
H1: mD Z 0

H0: mD = 0
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Choosing the level of significance and assuming that the differences are
normally distributed, you use the paired t test [Equation (10.5)]. For a sample of n = 19
textbooks, there are degrees of freedom. Using Table E.3, the decision rule is

For the differences (see Table 10.4), the sample mean difference is

and

From Equation (10.5) on page 378,

Because you do not reject the null hypothesis, (see
Figure 10.8). There is insufficient evidence of a difference in the mean price of textbooks
purchased at the college bookstore and the online retailer.

H0-2.1009 6 tSTAT = 1.8132 6 2.1009,

tSTAT =
D - mD

SD2n

=
12.6663 - 0

30.4488219

= 1.8132

SD = Qa
n

i=1
1Di - D22
n - 1

= 30.4488

D =
a

n

i=1
Di

n
=

240.66
19

= 12.6663

n = 19

otherwise, do not reject H0.

or if tSTAT 6 -2.1009;

Reject H0 if tSTAT 7 2.1009

n - 1 = 18

a = 0.05

–2.1009 +2.10090 t

.025 .025

Region of
Rejection

Critical
Value

Region of
Nonrejection

Critical
Value

Region of
Rejection

.95

F I G U R E 1 0 . 8
Two-tail paired t test at
the 0.05 level of
significance with 18
degrees of freedom

Figure 10.9 presents the results for this example, computing both the t test statistic and the
p-value. Because the you do not reject The p-value
indicates that if the two sources for textbooks have the same population mean price, the
probability that one source would have a sample mean $12.67 more than the other is 0.0865.
Because this probability is greater than you conclude that there is insufficient evi-
dence to reject the null hypothesis.

a = 0.05,

H0.p-value = 0.0865 7 a = 0.05,
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To evaluate the validity of the assumption of normality, you construct a boxplot of the
differences, as shown in Figure 10.10.

F I G U R E 1 0 . 9
Excel and Minitab paired t test results for the textbook price data

For an Excel boxplot of the
differences, use column C of
the PtCalcs worksheet,
discussed in the Section
EG10.2 In-Depth Excel
instructions.

F I G U R E 1 0 . 1 0
Excel and Minitab boxplots for the textbook price data

The Figure 10.10 boxplots show approximate symmetry except for one extreme value.
Thus, the data do not greatly contradict the underlying assumption of normality. If a boxplot,
histogram, or normal probability plot reveals that the assumption of underlying normality in the
population is severely violated, then the t test may be inappropriate, especially if the sample size
is small. If you believe that the t test is inappropriate, you can use either a nonparametric proce-
dure that does not make the assumption of underlying normality (see Section 12.8) or make a
data transformation (see reference 6) and then recheck the assumptions to determine whether
you should use the t test.
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Recall from Example 10.1 on page 369 that a local pizza restaurant situated across the street
from your college campus advertises that it delivers to the dormitories faster than the local
branch of a national pizza chain. In order to determine whether this advertisement is valid, you
and some friends have decided to order 10 pizzas from the local pizza restaurant and 10 pizzas
from the national chain. In fact, each time you ordered a pizza from the local pizza restaurant,
at the same time, your friends ordered a pizza from the national pizza chain. Thus, you have
matched samples. For each of the 10 times that pizzas were ordered, you have one
measurement from the local pizza restaurant and one from the national chain. At the 0.05 level
of significance, is the mean delivery time for the local pizza restaurant less than the mean de-
livery time for the national pizza chain?

SOLUTION Use the paired t test to analyze the Table 10.5 data (stored in ).
Figure 10.11 shows the paired t test results for the pizza delivery data.

PizzaTime

EXAMPLE 10.2
Paired t Test of
Pizza Delivery
Times

T A B L E 1 0 . 5

Delivery Times for Local
Pizza Restaurant and
National Pizza Chain

Time Local Chain Difference

1 16.8 22.0 -5.2
2 11.7 15.2 -3.5
3 15.6 18.7 -3.1
4 16.7 15.6 1.1
5 17.5 20.8 -3.3
6 18.1 19.5 -1.4
7 14.1 17.0 -2.9
8 21.8 19.5 2.3
9 13.9 16.5 -2.6
10 20.8 24.0 -3.2

-21.8

F I G U R E 1 0 . 1 1
Excel and Minitab paired t test results for the pizza delivery data
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The null and alternative hypotheses are

(Mean delivery time for the local pizza restaurant is greater than or equal to
the mean delivery time for the national pizza chain.)

(Mean delivery time for the local pizza restaurant is less than the mean
delivery time for the national pizza chain.)

Choosing the level of significance and assuming that the differences are normally
distributed, you use the paired t test [Equation (10.5) on page 378]. For a sample of de-
livery times, there are degrees of freedom. Using Table E.3, the decision rule is

To illustrate the computations, for differences (see Table 10.5), the sample mean difference is

and the sample standard deviation of the difference is

From Equation (10.5) on page 378,

Because is less than you reject the null hypothesis, (the p-value
is ). There is evidence that the mean delivery time is lower for the local pizza
restaurant than for the national pizza chain.

This conclusion is different from the one you reached in Example 10.1 on page 369 when
you used the pooled-variance t test for these data. By pairing the delivery times, you are able
to focus on the differences between the two pizza delivery services and not the variability
created by ordering pizzas at different times of day. The paired t test is a more powerful
statistical procedure that is better able to detect the difference between the two pizza delivery
services because you are controlling for the time of day they were ordered.

0.0070 6 0.05
H0-1.8331,tSTAT = -3.0448

tSTAT =
D - mD

SD1n

=
-2.18 - 0

2.2641110

= -3.0448

SD = Qa
n

i=1
1Di - D22
n - 1

= 2.2641

D =
a

n

i=1
Di

n
=

-21.8
10

= -2.18

n = 10

otherwise, do not reject H0.

Reject H0 if tSTAT 6 - t0.05 = -1.8331;

n - 1 = 9
n = 10

a = 0.05

H1: mD 6 0

H0: mD Ú 0

Confidence Interval Estimate for the Mean Difference
Instead of, or in addition to, testing for the difference between the means of two related populations,
you can use Equation (10.6) to construct a confidence interval estimate for the mean difference.

CONFIDENCE INTERVAL ESTIMATE FOR THE MEAN DIFFERENCE

or

(10.6)

where is the critical value of the t distribution, with degrees of freedom, for an
area of in the upper tail.a>2 n - 1ta>2

D - ta>2
SD1n

… mD … D + ta>2
SD1n

D ; ta>2
SD1n
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Recall the example comparing textbook prices on page 379. Using Equation (10.6),
and (for 95% confidence and

degrees of freedom),

Thus, with 95% confidence, the mean difference in textbook prices between the college
bookstore and the online retailer is between –$2.0094 and $27.342. Because the interval
estimate contains zero, you can conclude that there is insufficient evidence of a difference in
the population means. There is insufficient evidence of a difference in the mean prices of text-
books at the college bookstore and the online retailer.

-2.0094 … mD … 27.342

12.6663 ; 14.6757

12.6663 ; 12.1009230.4488219

n - 1 = 18
ta>2 = 2.1009D = 12.6663, SD = 30.4488, n = 19,

Problems for Section 10.2
LEARNING THE BASICS
10.18 An experimental design for a paired t test has 20
pairs of identical twins. How many degrees of freedom are
there in this t test?

10.19 Fifteen volunteers are recruited to participate in an ex-
periment. A measurement is made (such as blood pressure) be-
fore each volunteer is asked to read a particularly upsetting
passage from a book and after each volunteer reads the passage
from the book. In the analysis of the data collected from this
experiment, how many degrees of freedom are there in the test?

APPLYING THE CONCEPTS
10.20 Nine experts rated two brands of Colombian
coffee in a taste-testing experiment. A rating on a 7-

point scale (1 = extremely unpleasing, 7 = extremely pleasing)
is given for each of four characteristics: taste, aroma, richness,
and acidity. The following data (stored in ) display the
ratings accumulated over all four characteristics.

Coffee

SELF
Test

a. At the 0.05 level of significance, is there evidence of a
difference in the mean ratings between the two brands?

Brand

Expert A B

C.C. 24 26
S.E. 27 27
E.G. 19 22
B.L. 24 27
C.M. 22 25
C.N. 26 27
G.N. 27 26
R.M. 25 27
P.V. 22 23

b. What assumption is necessary about the population dis-
tribution in order to perform this test?

c. Determine the p-value in (a) and interpret its meaning.
d. Construct and interpret a 95% confidence interval estimate

of the difference in the mean ratings between the two brands.

10.21 In industrial settings, alternative methods often ex-
ist for measuring variables of interest. The data in

(coded to maintain confidentiality) represent
measurements in-line that were collected from an analyzer
during the production process and from an analytical lab.
(Data extracted from M. Leitnaker, “Comparing Measure-
ment Processes: In-line Versus Analytical Measurements,”
Quality Engineering, 13, 2000–2001, pp. 293–298.)
a. At the 0.05 level of significance, is there evidence of a

difference in the mean measurements in-line and from an
analytical lab?

b. What assumption is necessary about the population
distribution in order to perform this test?

c. Use a graphical method to evaluate the validity of the
assumption in (a).

d. Construct and interpret a 95% confidence interval
estimate of the difference in the mean measurements
in-line and from an analytical lab.

10.22 Is there a difference in the prices at a warehouse
club such as Costco and store brands? To investigate this, a
random sample of 10 purchases was selected, and the prices
were compared. (Data extracted from “Shop Smart and Save
Big,” Consumer Reports, May 2009, p. 17.) The prices for
the products are stored in .
a. At the 0.05 level of significance, is there evidence of a

difference between the mean price of Costco purchases
and store-brand purchases?

b. What assumption is necessary about the population dis-
tribution in order to perform this test?

Shopping1

Measurement
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c. Construct a 95% confidence interval estimate of the
mean difference in price between Costco and store
brands. Interpret the interval.

d. Compare the results of (a) and (c).

10.23 In tough economic times, the business staff at
magazines are challenged to sell advertising space in their
publications. Thus, one indicator of a weak economy is the
decline in the number of “ad pages” that magazines have
sold. The file contains the number of ad pages
found in the May 2008 and May 2009 issues of 12 men’s
magazines. (Data extracted from W. Levith, “Magazine
Monitor,” Mediaweek, April 20, 2009, p. 53.)
a. At the 0.05 level of significance, is there evidence that

the mean number of ad pages was higher in May 2008
than in May 2009?

b. What assumption is necessary about the population
distribution in order to perform this test?

c. Use a graphical method to evaluate the validity of the
assumption in (b).

d. Construct and interpret a 95% confidence interval
estimate of the difference in the mean number of ad pages
in men’s magazines between May 2008 and May 2009.

10.24 Multiple myeloma, or blood plasma cancer, is
characterized by increased blood vessel formulation (angio-
genesis) in the bone marrow that is a predictive factor in
survival. One treatment approach used for multiple
myeloma is stem cell transplantation with the patient’s own
stem cells. The following data (stored in ) repre-
sent the bone marrow microvessel density for patients who
had a complete response to the stem cell transplant (as
measured by blood and urine tests). The measurements were
taken immediately prior to the stem cell transplant and at the
time the complete response was determined.
a. At the 0.05 level of significance, is there evidence that the

mean bone marrow microvessel density is higher before
the stem cell transplant than after the stem cell transplant?

b. Interpret the meaning of the p-value in (a).
c. Construct and interpret a 95% confidence interval esti-

mate of the mean difference in bone marrow microvessel
density before and after the stem cell transplant.

d. What assumption is necessary about the population dis-
tribution in order to perform the test in (a)?

Myeloma

Ad Pages

Patient Before After

1 158 284
2 189 214
3 202 101
4 353 227
5 416 290
6 426 176
7 441 290

Source: Data extracted from S. V. Rajkumar, R. Fonseca, T.
E. Witzig, M. A. Gertz, and P. R. Greipp, “Bone Marrow
Angiogenesis in Patients Achieving Complete Response
After Stem Cell Transplantation for Multiple Myeloma,”
Leukemia, 1999, 13, pp. 469–472.

10.25 Over the past year, the vice president for human re-
sources at a large medical center has run a series of three-
month workshops aimed at increasing worker motivation
and performance. To check the effectiveness of the work-
shops, she selected a random sample of 35 employees from
the personnel files. She collected the employee performance
ratings recorded before and after workshop attendance and
stored the paired ratings, along with descriptive statistics
and the results of a paired t test in the Perform Excel work-
book (Perform.xls) and in the Perform Minitab project
(Perform.mpj). Review her results and state your findings
and conclusions in a report to the vice president for human
resources.

10.26 The data in represent the compressive
strength, in thousands of pounds per square inch (psi), of
40 samples of concrete taken two and seven days after
pouring.
Source: Data extracted from O. Carrillo-Gamboa and R. F. Gunst,
“Measurement-Error-Model Collinearities,” Technometrics, 34, 1992,
pp. 454–464.

a. At the 0.01 level of significance, is there evidence that
the mean strength is lower at two days than at seven
days?

b. What assumption is necessary about the population dis-
tribution in order to perform this test?

c. Find the p-value in (a) and interpret its meaning.

Concrete1

10.3 Comparing the Proportions of Two Independent Populations
Often, you need to make comparisons and analyze differences between two population propor-
tions. You can perform a test for the difference between two proportions selected from inde-
pendent populations by using two different methods. This section presents a procedure whose
test statistic, is approximated by a standardized normal distribution. In Section 12.1, a
procedure whose test statistic, is approximated by a chi-square distribution is used. As
you will see when you read that section, the results from these two tests are equivalent.

x2
STAT,

ZSTAT,
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H0:p1 = p2 H0:p1 Ú p2 H0:p1 … p2

H1:p1 Z p2 H1:p1 6 p2 H1:p1 7 p2
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Under the null hypothesis in the Z test for the difference between two proportions, you as-
sume that the two population proportions are equal Because the pooled estimate
for the population proportion is based on the null hypothesis, you combine, or pool, the two
sample proportions to compute an overall estimate of the common population proportion.
This estimate is equal to the number of items of interest in the two samples combined

divided by the total sample size from the two samples combined 
As shown in the following table, you can use this Z test for the difference between popula-

tion proportions to determine whether there is a difference in the proportion of items of inter-
est in the two populations (two-tail test) or whether one population has a higher proportion of
items of interest than the other population (one-tail test):

1n1 + n22.1X1 + X22
p,

1p1 = p22.

Z TEST FOR THE DIFFERENCE BETWEEN TWO PROPORTIONS

(10.7)

with

where

The test statistic approximately follows a standardized normal distribution.ZSTAT

p = pooled estimate of the population proportion of items of interest

p2 = proportion of items of interest in population 2

n2 = sample size of sample 2

X2 = number of items of interest in sample 2

p2 = proportion of items of interest in sample 2

p1 = proportion of items of interest in population 1

n1 = sample size of sample 1

X1 = number of items of interest in sample 1

p1 = proportion of items of interest in sample 1

p =
X1 + X2

n1 + n2
p1 =

X1

n1
p2 =

X2

n2

ZSTAT =
1p1 - p22 - 1p1 - p22

Ap11 - p2a 1
n1

+
1
n2
b

Z Test for the Difference Between Two Proportions
In evaluating differences between two population proportions, you can use a Z test for the dif-
ference between two proportions. The test statistic is based on the difference between
two sample proportions This test statistic, given in Equation (10.7), approximately
follows a standardized normal distribution for large enough sample sizes.

1p1 - p22.
ZSTAT

where

p2 = proportion of items of interest in population 2

p1 = proportion of items of interest in population 1
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To test the null hypothesis that there is no difference between the proportions of two independ-
ent populations:

against the alternative that the two population proportions are not the same:

You use the test statistic, given by Equation (10.7). For a given level of significance,
you reject the null hypothesis if the computed test statistic is greater than the upper-

tail critical value from the standardized normal distribution or if the computed test sta-
tistic is less than the lower-tail critical value from the standardized normal distribution.

To illustrate the use of the Z test for the equality of two proportions, suppose that you are
the manager of T.C. Resort Properties, a collection of five upscale resort hotels located on
two tropical islands. On one of the islands, T.C. Resort Properties has two hotels, the Beach-
comber and the Windsurfer. You have defined the business objective as improving the return
rate of guests at the Beachcomber and the Windsurfer hotels. On the questionnaire completed
by hotel guests upon their departure, one question asked is whether the guest is likely to re-
turn to the hotel. Responses to this and other questions were collected from 227 guests at the
Beachcomber and 262 guests at the Windsurfer. The results for this question indicated that
163 of 227 guests at the Beachcomber responded yes, they were likely to return to the hotel
and 154 of 262 guests at the Windsurfer responded yes, they were likely to return to the hotel.
At the 0.05 level of significance, is there evidence of a significant difference in guest satis-
faction (as measured by the likelihood to return to the hotel) between the two hotels?

The null and alternative hypotheses are

Using the 0.05 level of significance, the critical values are and (see Figure
10.12), and the decision rule is

otherwise, do not reject H0.

or if ZSTAT 7 +1.96;

Reject H0 if ZSTAT 6 -1.96

+1.96-1.96

H1 :p1 Z p2 or p1 - p2 Z 0

H0:p1 = p2 or p1 - p2 = 0

ZSTAT

ZSTATa,
ZSTAT

H1:p1 Z p2

H0:p1 = p2

–1.96 +1.960 Z

Region of
Rejection

Critical
Value

Region of
Nonrejection

Critical
Value

Region of
Rejection

.025.025
.95

F I G U R E 1 0 . 1 2
Regions of rejection and
nonrejection when
testing a hypothesis for
the difference between
two proportions at the
0.05 level of significance

Using Equation (10.7) on page 386,

ZSTAT =
1p1 - p22 - 1p1 - p22

Ap11 - p2a 1
n1

+
1
n2
b
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F I G U R E 1 0 . 1 3
Excel and Minitab Z test results for the difference between two proportions for the hotel guest satisfaction problem

where

and

so that

Using the 0.05 level of significance, you reject the null hypothesis because
The p-value is 0.0026 (computed using Table E.2 or from

Figure 10.13) and indicates that if the null hypothesis is true, the probability that a
test statistic is less than is 0.0013, and, similarly, the probability that a test
statistic is greater than is 0.0013. Thus, for this two-tail test, the p-value is

Because you reject the null hypothesis.
There is evidence to conclude that the two hotels are significantly different with respect to
guest satisfaction; a greater proportion of guests are willing to return to the Beachcomber
than to the Windsurfer.

0.0026 6 a = 0.05,0.0013 + 0.0013 = 0.0026.
+3.0088

ZSTAT-3.0088
ZSTAT

ZSTAT = +3.0088 7 +1.96.

=
0.1303
0.0432

= +3.0088

=
0.130320.00187

=
0.1303210.228210.00822

ZSTAT =
10.7181 - 0.58782 - 102

A0.648311 - 0.64832a 1
227

+
1

262 b

p =
X1 + X2

n1 + n2
=

163 + 154
227 + 262

=
317
489

= 0.6483

p1 =
X1

n1
=

163
227

= 0.7181 p2 =
X2

n2
=

154
262

= 0.5878
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A growing concern about privacy on the Internet has led more people to monitor their online
identities. (Data extracted from Drilling Down, “Managing Reputations on Social Sites,” The
New York Times, June 14, 2010, pp. B2B.) The survey reported that 44% of Internet users ages
18 to 29 have taken steps to restrict the amount of information available about themselves on-
line as compared to 20% of Internet users older than 65 who have done the same thing. The
sample size in each group was not reported. Suppose that the survey consisted of 100 individu-
als in each age group. At the 0.05 level of significance, is the proportion of Internet users ages
18 to 29 who have taken steps to restrict the amount of information available about themselves
online greater than the proportion of Internet users older than 65 who have done the same thing?

SOLUTION Because you want to know whether there is evidence that the proportion in the
18-to-29 age group is greater than in the over-65 age group, you have a one-tail test. The null
and alternative hypotheses are

(The proportion of Internet users ages 18 to 29 who have taken steps to re-
strict the amount of information available about themselves online is less than or equal to
the proportion of Internet users older than 65 who have done the same thing.)

(The proportion of Internet users ages 18 to 29 who have taken steps to re-
strict the amount of information available about themselves online is greater than the pro-
portion of Internet users older than 65 who have done the same thing.)

Using the 0.05 level of significance, for the one-tail test in the upper tail, the critical value is
The decision rule is

Using Equation (10.7) on page 386,

where

and

so that

=
0.24

0.06597
= +3.638

=
0.2420.004352

=
0.24210.2176210.022

ZSTAT =
10.44 - 0.202 - 102

A0.3211 - 0.322a 1

100
+

1

100
b

p =
X1 + X2

n1 + n2
=

44 + 20

100 + 100
=

64

200
= 0.32

p1 =
X1

n1
=

44

100
= 0.44 p2 =

X2

n2
=

20

100
= 0.20

ZSTAT =
1 p1 - p22 - 1p1 - p22

Ap11 - p2a 1
n1

+
1
n2
b

otherwise, do not reject H0.

Reject H0 if ZSTAT 7 +1.645;

+1.645.

H1:p1 7 p2

H0:p1 … p2

EXAMPLE 10.3
Testing for the
Difference
Between
Two Proportions



CONFIDENCE INTERVAL ESTIMATE FOR THE DIFFERENCE BETWEEN TWO
PROPORTIONS

or

(10.8)… 1p1 - p22 + Za>2Ap111 - p12
n1

+
p211 - p22

n2

1 p1 - p22 - Za>2Ap111 - p12
n1

+
p211 - p22

n2

… 1p1 - p22

1 p1 - p22 ; Za>2Ap111 - p12
n1

+
p211 - p22

n2
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Confidence Interval Estimate for the Difference Between
Two Proportions
Instead of, or in addition to, testing for the difference between the proportions of two inde-
pendent populations, you can construct a confidence interval estimate for the difference
between the two proportions using Equation (10.8).

Using the 0.05 level of significance, you reject the null hypothesis because
The p-value is approximately 0.0001. Therefore, if the null hy-

pothesis is true, the probability that a test statistic is greater than is approxi-
mately 0.0001 (which is less than ). You conclude that there is evidence that the
proportion of Internet users ages 18 to 29 who have taken steps to restrict the amount of infor-
mation available about themselves online is greater than the proportion of Internet users older
than 65 who have done the same thing.

a = 0.05
+3.638ZSTAT

ZSTAT = +3.638 7 +1.645.

To construct a 95% confidence interval estimate for the population difference between the
proportion of guests who would return to the Beachcomber and who would return to the Wind-
surfer, you use the results on page 387 or from Figure 10.13 on page 388:

Using Equation (10.8),

Thus, you have 95% confidence that the difference between the population proportion of
guests who would return to the Beachcomber and the Windsurfer is between 0.0468 and
0.2138. In percentages, the difference is between 4.68% and 21.38%. Guest satisfaction is
higher at the Beachcomber than at the Windsurfer.

0.0468 … 1p1 - p22 … 0.2138

0.1303 ; 0.0835

0.1303 ; 11.96210.04262
10.7181 - 0.58782 ; 11.962A0.718111 - 0.71812

227
+

0.587811 - 0.58782
262

p1 =
X1

n1
=

163
227

= 0.7181 p2 =
X2

n2
=

154
262

= 0.5878
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Problems for Section 10.3
LEARNING THE BASICS
10.27 Let and
a. At the 0.05 level of significance, is there evidence of a

significant difference between the two population pro-
portions?

b. Construct a 95% confidence interval estimate for the dif-
ference between the two population proportions.

10.28 Let and
a. At the 0.01 level of significance, is there evidence of a sig-

nificant difference between the two population proportions?
b. Construct a 99% confidence interval estimate for the

difference between the two population proportions.

APPLYING THE CONCEPTS
10.29 A survey of 500 shoppers was taken in a large met-
ropolitan area to determine various information about con-
sumer behavior. Among the questions asked was, “Do you
enjoy shopping for clothing?” Of 240 males, 136 answered
yes. Of 260 females, 224 answered yes.
a. Is there evidence of a significant difference between

males and females in the proportion who enjoy shopping
for clothing at the 0.01 level of significance?

b. Find the p-value in (a) and interpret its meaning.
c. Construct and interpret a 99% confidence interval estimate

for the difference between the proportion of males and fe-
males who enjoy shopping for clothing.

d. What are your answers to (a) through (c) if 206 males en-
joyed shopping for clothing?

10.30 Does it take more effort to be removed from an
email list than it used to? A study of 100 large online retail-
ers revealed the following:

X2 = 25.n1 = 100, X1 = 45, n2 = 50,

X2 = 30.n1 = 100, X1 = 50, n2 = 100,

actual consumption/delivery date. In other cases, people do
not want a delay. An article in the Journal of Marketing
Research reported on an experiment in which 50 individuals
were told that they had just purchased a ticket to a concert and
50 were told that they had just purchased a personal digital
assistant (PDA). The participants were then asked to indicate
their preferences for attending the concert or receiving the
PDA. Did they prefer tonight or tomorrow, or would they pre-
fer to wait two to four weeks? The individuals were told to ig-
nore their schedule constraints in order to better measure their
willingness to delay the consumption/delivery of their pur-
chase. The following table gives partial results of the study:

NEED THREE OR MORE CLICKS 
TO BE REMOVED

YEAR Yes No
2009 39 61
2008 7 93

Source: Data extracted from “More Clicks to Escape an Email
List,” The New York Times, March 29, 2010, p. B2.

When to Receive Purchase Concert PDA

Tonight or tomorrow 28 47
Two to four weeks 22 3
Total 50 50

Source: Data adapted from O. Amir and D. Ariely, “Decisions by
Rules: The Case of Unwillingness to Pay for Beneficial Delays,”
Journal of Marketing Research, February 2007, Vol. XLIV, pp.
142–152.

a. What proportion of the participants would prefer to delay
the date of the concert?

b. What proportion of the participants would prefer to delay
receipt of a new PDA?

c. Using the 0.05 level of significance, is there evidence of
a significant difference in the proportion willing to delay
the date of the concert and the proportion willing to de-
lay receipt of a new PDA?

10.32 Do people of different age groups differ in
their beliefs about response time to email mes-

sages? A survey by the Center for the Digital Future of the
University of Southern California reported that 70.7% of
users over 70 years of age believe that email messages should
be answered quickly as compared to 53.6% of users 12 to
50 years old. (Data extracted from A. Mindlin, “Older E-mail
Users Favor Fast Replies,” The NewYork Times, July 14, 2008,
p. B3.) Suppose that the survey was based on 1,000 users over
70 years of age and 1,000 users 12 to 50 years old.
a. At the 0.01 level of significance, is there evidence of a

significant difference between the two age groups in the
proportion that believe that email messages should be an-
swered quickly?

b. Find the p-value in (a) and interpret its meaning.

10.33 A survey was conducted of 665 consumer
magazines on the practices of their websites. Of these, 273
magazines reported that online-only content is copy-edited
as rigorously as print content; 379 reported that online-only
content is fact-checked as rigorously as print content. (Data
extracted from S. Clifford, “Columbia Survey Finds a Slack

SELF
Test

a. Set up the null and alternative hypotheses to try to deter-
mine whether it takes more effort to be removed from an
email list than it used to.

b. Conduct the hypothesis test defined in (a), using the 0.05
level of significance.

c. Does the result of your test in (b) make it appropriate to
claim that it takes more effort to be removed from an
email list than it used to?

10.31 Some people enjoy the anticipation of an upcoming
product or event and prefer to pay in advance and delay the
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Editing Process of Magazine Web Sites,” The New York
Times, March 1, 2010, p. B6.) Suppose that a sample of 500
newspapers revealed that 252 reported that online-only con-
tent is copy-edited as rigorously as print content and 296 re-
ported that online-only content is fact-checked as rigorously
as print content.
a. At the 0.05 level of significance, is there evidence of a

difference between consumer magazines and newspapers
in the proportion of online-only content that is copy-ed-
ited as rigorously as print content ?

b. Find the p-value in (a) and interpret its meaning.
c. At the 0.05 level of significance, is there evidence of a

difference between consumer magazines and newspapers
in the proportion of online-only content that is fact-
checked as rigorously as print content?

10.34 How do Americans feel about ads on websites? A
survey of 1,000 adult Internet users found that 670 op-
posed ads on websites. (Data extracted from S. Clifford,
“Tacked for Ads? Many Americans Say No Thanks,” The
New York Times, September 30, 2009, p. B3.). Suppose that
a survey of 1,000 Internet users age 12–17 found that 510
opposed ads on websites

a. At the 0.05 level of significance, is there evidence of a
difference between adult Internet users and Internet users
age 12–17 in the proportion who oppose ads?

b. Find the p-value in (a) and interpret its meaning.

10.35 Where people turn for news is different for various
age groups. (Data extracted from “Cellphone Users Who
Access News on Their Phones,” USA Today, March 1, 2010,
p. 1A.) A study was conducted on the use of cell phones for
accessing news. The study reported that 47% of users under
age 50 and 15% of users age 50 and over accessed news on
their cell phones. Suppose that the survey consisted of 1,000
users under age 50, of whom 470 accessed news on their
cell phones, and 891 users age 50 and over, of whom 134
accessed news on their cell phones.
a. Is there evidence of a significant difference in the propor-

tion of users under age 50 and users 50 years and older that
accessed the news on their cell phones? (Use )

b. Determine the p-value in (a) and interpret its meaning.
c. Construct and interpret a 95% confidence interval esti-

mate for the difference between the population propor-
tion of users under 50 years old and those 50 years or
older who access the news on their cell phones.

a = 0.05.

10.4 F Test for the Ratio of Two Variances
Often you need to determine whether two independent populations have the same variability.
By testing variances, you can detect differences in the variability in two independent popula-
tions. One important reason to test for the difference between the variances of two populations
is to determine whether to use the pooled-variance t test (which assumes equal variances) or
the separate-variance t test (which does not assume equal variances) while comparing the
means of two independent populations.

The test for the difference between the variances of two independent populations is
based on the ratio of the two sample variances. If you assume that each population is nor-
mally distributed, then the ratio follows the F distribution (see Table E.5). The critical
values of the F distribution in Table E.5 depend on the degrees of freedom in the two sam-
ples. The degrees of freedom in the numerator of the ratio are for the first sample, and the
degrees of freedom in the denominator are for the second sample. The first sample taken
from the first population is defined as the sample that has the larger sample variance. The
second sample taken from the second population is the sample with the smaller sample vari-
ance. Equation (10.9) defines the F test for the ratio of two variances.

S2
1>S2

2

F TEST STATISTIC FOR TESTING THE RATIO OF TWO VARIANCES
The test statistic is equal to the variance of sample 1 (the larger sample variance)
divided by the variance of sample 2 (the smaller sample variance).

(10.9)

where

variance of sample 1 (the larger sample variance)

variance of sample 2 (the smaller sample variance)S2
2 =

S2
1 =

FSTAT =
S2

1

S2
2

FSTAT
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For a given level of significance, to test the null hypothesis of equality of population
variances:

against the alternative hypothesis that the two population variances are not equal:

you reject the null hypothesis if the computed test statistic is greater than the upper-tail
critical value, from the F distribution, with degrees of freedom in the numerator
and degrees of freedom in the denominator. Thus, the decision rule is

To illustrate how to use the F test to determine whether the two variances are equal, return
to the BLK Beverages scenario on page 365 concerning the sales of BLK Cola in two different
display locations. To determine whether to use the pooled-variance t test or the separate-
variance t test in Section 10.1, you can test the equality of the two population variances. The
null and alternative hypotheses are

Because you are defining sample 1 as the group with the larger sample variance, the rejec-
tion region in the upper tail of the F distribution contains Using the level of significance

the rejection region in the upper tail contains 0.025 of the distribution.
Because there are samples of 10 stores for each of the two display locations, there are

degrees of freedom in the numerator (the sample with the larger variance) and also
in the denominator (the sample with the smaller variance). the upper-tail critical value of
the F distribution, is found directly from Table E.5, a portion of which is presented in Table
10.6. Because there are 9 degrees of freedom in the numerator and 9 degrees of freedom in the
denominator, you find the upper-tail critical value, by looking in the column labeled 9
and the row labeled 9. Thus, the upper-tail critical value of this F distribution is 4.03. There-
fore, the decision rule is

otherwise, do not reject H0.

Reject H0 if FSTAT 7 F0.025 = 4.03;

Fa>2,

Fa>2,
10-1 = 9

a = 0.05,
a>2.

H1:s
2
1 Z s2

2

H0:s
2
1 = s2

2

otherwise, do not reject H0.

Reject H0 if FSTAT 7 Fa>2;
n2 - 1

n1 - 1Fa>2,
FSTAT

H1:s
2
1 Z s2

2

H0:s
2
1 = s2

2

a,

sample size selected from population 1

sample size selected from population 2

degrees of freedom from sample 1 (i.e., the numerator degrees of freedom)

degrees of freedom from sample 2 (i.e., the denominator degrees of freedom)

The test statistic follows an F distribution with and degrees of
freedom.

n2 - 1n1 - 1FSTAT

n2 - 1 =

n1 - 1 =

n2 =

n1 =
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Excel and Minitab F test results for the BLK Cola sales data

Using Equation (10.9) on page 392 and the cola sales data (see Table 10.1 on page 367),

so that

Because you do not reject Figure 10.14 shows the results for this
test, including the p-value, 0.248. Because you conclude that there is no evidence
of a significant difference in the variability of the sales of cola for the two display locations.

0.248 7 0.05,
H0.FSTAT = 2.2289 6 4.03,

=
350.6778

157.3333
= 2.2289

FSTAT =
S2

1

S2
2

S2
1 = 118.726422 = 350.6778 S2

2 = 112.543322 = 157.3333

Cumulative Probabilities = 0.975
Upper-Tail Area = 0.025 

Numerator df1

Denominator df2 1 2 3 ... 7 8 9

1 647.80 799.50 864.20 ... 948.20 956.70 963.30
2 38.51 39.00 39.17 ... 39.36 39.37 39.39
3 17.44 16.04 15.44 ... 14.62 14.54 14.47
. . . . . . . .
. . . . . . . .
. . . . . . . .
7 8.07 6.54 5.89 ... 4.99 4.90 4.82
8 7.57 6.06 5.42 ... 4.53 4.43 4.36
9 7.21 5.71 5.08 ... 4.20 4.10 4.03

Source: Extracted from Table E.5.

T A B L E 1 0 . 6

Finding the Upper-Tail
Critical Value of F with
9 and 9 Degrees of
Freedom for an Upper-
Tail Area of 0.025

In testing for a difference between two variances using the F test described in this section,
you assume that each of the two populations is normally distributed. The F test is very sensi-
tive to the normality assumption. If boxplots or normal probability plots suggest even a mild
departure from normality for either of the two populations, you should not use the F test.



10.4 F Test for the Ratio of Two Variances 395

A professor in the accounting department of a business school would like to determine
whether there is more variability in the final exam scores of students taking the introductory
accounting course who are not majoring in accounting than for students taking the course who
are majoring in accounting. Random samples of 13 non-accounting majors and 10 accounting
majors are selected from the professor’s class roster in his large lecture, and the following
results are computed based on the final exam scores:

At the 0.05 level of significance, is there evidence that there is more variability in the final
exam scores of students taking the introductory accounting course who are not majoring in ac-
counting than for students taking the course who are majoring in accounting? Assume that the
population final exam scores are normally distributed.

SOLUTION The null and alternative hypotheses are

The test statistic is given by Equation (10.9) on page 392:

You use Table E.5 to find the upper critical value of the F distribution. With
degrees of freedom in the numerator, degrees of freedom in the de-
nominator, and the upper-tail critical value, is 3.07. The decision rule is

From Equation (10.9) on page 392,

Because you reject Using a 0.05 level of significance, you con-
clude that there is evidence that there is more variability in the final exam scores of students
taking the introductory accounting course who are not majoring in accounting than for
students taking the course who are majoring in accounting.

H0.FSTAT = 5.7589 7 3.07,

=
210.2

36.5
= 5.7589

FSTAT =
S2

1

S2
2

otherwise, do not reject H0.

Reject H0 if FSTAT 7 3.07;

F0.05,a = 0.05,
n2 - 1 = 10 - 1 = 9

n1 - 1 = 13 - 1 = 12

FSTAT =
S2

1

S2
2

FSTAT

H1:s
2
NA 7 s2

A

H0:s
2
NA … s2

A

Accounting : n2 = 10 S2
2 = 36.5

Non-accounting : n1 = 13 S2
1 = 210.2

EXAMPLE 10.4
A One-Tail Test for
the Difference
Between Two
Variances

If this happens, you should use the Levene test (see Section 11.1) or a nonparametric approach
(see references 1 and 2).

In testing for the equality of variances as part of assessing the validity of the pooled-vari-
ance t test procedure, the F test is a two-tail test with in the upper tail. However, when you
are interested in examining the variability in situations other than the pooled-variance t test,
the F test is often a one-tail test. Example 10.4 illustrates a one-tail test.

a>2
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Line A Line B

X 8.005 7.997
S 0.012 0.005
n 11 16

Males Females

X 40.26 36.85

S 13.35 9.42
n 100 72

Source: Data extracted from T. Broome and D. Havelka, “Determinants
of Computer Anxiety in Business Students,” The Review of Business
Information Systems, Spring 2002, 6(2), pp. 9–16.

a. At the 0.05 level of significance, is there evidence of a
difference in the variability of the computer anxiety ex-
perienced by males and females?

b. Interpret the p-value.
c. What assumption do you need to make about the two

populations in order to justify the use of the F test?
d. Based on (a) and (b), which t test defined in Section 10.1

should you use to test whether there is a significant dif-
ference in mean computer anxiety for female and male
students?

a. At the 0.05 level of significance, is there evidence that the
variance in line A is greater than the variance in line B?

b. Interpret the p-value.
c. What assumption do you need to make in (a) about the

two populations in order to justify your use of the F test?

10.46 The Computer Anxiety Rating Scale
(CARS) measures an individual’s level of com-

puter anxiety, on a scale from 20 (no anxiety) to 100 (highest
level of anxiety). Researchers at Miami University adminis-
tered CARS to 172 business students. One of the objectives
of the study was to determine whether there is a difference
between the level of computer anxiety experienced by female
students and male students. They found the following:

SELF
Test

Problems for Section 10.4
LEARNING THE BASICS
10.36 Determine the upper-tail critical values of F in each
of the following two-tail tests.
a.
b.
c.

10.37 Determine the upper-tail critical value of F in each
of the following one-tail tests.
a.
b.

10.38 The following information is available for two samples
selected from independent normally distributed populations:

a. Which sample variance do you place in the numerator of

b. What is the value of 

10.39 The following information is available for two samples
selected from independent normally distributed populations:

What is the value of if you are testing the null
hypothesis

10.40 In Problem 10.39, how many degrees of freedom are
there in the numerator and denominator of the F test?

10.41 In Problems 10.39 and 10.40, what is the upper-tail
critical value for F if the level of significance, is 0.05 and
the alternative hypothesis is 

10.42 In Problems 10.39 through 10.41, what is your
statistical decision?

10.43 The following information is available for two samples
selected from independent but very right-skewed populations:

Should you use the F test to test the null hypothesis of
equality of variances? Discuss.

10.44 In Problem 10.43, assume that two samples are se-
lected from independent normally distributed populations.
a. At the 0.05 level of significance, is there evidence of a

difference between and
b. Suppose that you want to perform a one-tail test. At the

0.05 level of significance, what is the upper-tail critical

s2
2?s2

1

Population B : n2 = 13 S2
2 = 36.4

Population A : n1 = 16 S2
1 = 47.3

H1:s
2
1 Z s2

2?
a,

H0:s
2
1 = s2

2?
FSTAT

Population B : n2 = 25 S2
2 = 133.7

Population A : n1 = 25 S2
1 = 161.9

FSTAT?
FSTAT?

Population B : n2 = 25 S2
2 = 25

Population A : n1 = 25 S2
1 = 16

a = 0.01, n1 = 16, n2 = 21
a = 0.05, n1 = 16, n2 = 21

a = 0.01, n1 = 16, n2 = 21
a = 0.05, n1 = 16, n2 = 21
a = 0.10, n1 = 16, n2 = 21

value of F to determine whether there is evidence that
What is your statistical decision?

APPLYING THE CONCEPTS
10.45 Shipments of meat, meat by-products, and other in-
gredients are mixed together in several filling lines at a pet
food canning factory. Operations managers suspect that,
although the mean amount filled per can of pet food is
usually stable, the variability of the cans filled in line A is
greater than that of line B. The following data from a sam-
ple of 8-ounce cans is as follows:

s2
1 7 s2

2?
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10.47 A bank with a branch located in a commercial district
of a city has the business objective of improving the process
for serving customers during the noon-to-1 P.M. lunch period.
To do so, the waiting time (defined as the time elapsed from
when the customer enters the line until he or she reaches the
teller window) needs to be shortened to increase customer sat-
isfaction. A random sample of 15 customers is selected (and
stored in ), and the results (in minutes) are as follows:

Suppose that another branch, located in a residential area, is
also concerned with the noon-to-1 P.M. lunch period. A random
sample of 15 customers is selected (and stored in ), and
the results (in minutes) are as follows:

a. Is there evidence of a difference in the variability of the
waiting time between the two branches? (Use )

b. Determine the p-value in (a) and interpret its meaning.
c. What assumption about the population distribution of the

two banks is necessary in (a)? Is the assumption valid for
these data?

d. Based on the results of (a), is it appropriate to use the pooled-
variance t test to compare the means of the two branches?

10.48 An important feature of digital cameras is battery
life, the number of shots that can be taken before the battery
needs to be recharged. The file contains bat-
tery life information for 29 subcompact cameras and 16
compact cameras. (Data extracted from “Digital Cameras,”
Consumer Reports, July 2009, pp. 28–29.)
a. Is there evidence of a difference in the variability of the

battery life between the two types of digital cameras?
(Use )

b. Determine the p-value in (a) and interpret its meaning.
a = 0.05.

DigitalCameras

a = 0.05.

10.49 6.68 5.64 4.08 6.17 9.91 5.47

9.66 5.90 8.02 5.79 8.73 3.82 8.01 8.35

Bank2

4.50 6.10 0.38 5.12 6.46 6.19 3.79

4.21 5.55 3.02 5.13 4.77 2.34 3.54 3.20

Bank1

c. What assumption about the population distribution of the
two types of cameras is necessary in (a)? Is the assump-
tion valid for these data?

d. Based on the results of (a), which t test defined in Sec-
tion 10.1 should you use to compare the mean battery life
of the two types of cameras?

10.49 Do young children use cell phones? Apparently so,
according to a recent study (A. Ross, “Message to Santa;
Kids Want a Phone,” Palm Beach Post, December 16, 2008,
pp. 1A, 4A), which stated that cell phone users under
12 years of age averaged 137 calls per month as compared
to 231 calls per month for cell phone users 13 to 17 years of
age. No sample sizes were reported. Suppose that the results
were based on samples of 50 cell phone users in each group
and that the sample standard deviation for cell phone users
under 12 years of age was 51.7 calls per month and the sam-
ple standard deviation for cell phone users 13 to 17 years of
age was 67.6 calls per month.
a. Using a 0.05 level of significance, is there evidence of a

difference in the variances of cell phone usage between
cell phone users under 12 years of age and cell phone
users 13 to 17 years of age?

b. On the basis of the results in (a), which t test defined in
Section 10.1 should you use to compare the means of the
two groups of cell phone users? Discuss.

10.50 Is there a difference in the variation of the yield of
five-year CDs at different times? The file con-
tains the yields for a five-year certificate of deposit (CD) for
25 banks in the United States, as of March 29, 2010 and Au-
gust 23, 2010. (Data extracted from www.Bankrate.com,
March 29, 2010 and August 23, 2010.) At the 0.05 level of
significance, is there evidence of a difference in the vari-
ance of the yield of five-year CDs on March 29, 2010 and
August 23, 2010? Assume that the population yields are
normally distributed.

CD-FiveYear

I
n the Using Statistics scenario, you were the regional sales manager
for BLK Beverages. You compared the sales volume of BLK Cola
when the product is placed in the normal shelf location to the sales
volume when the product is featured in a special end-aisle display.

An experiment was performed in which 10 stores used the normal shelf
location and 10 stores used the end-aisle displays. Using a t test for the
difference between two means, you were able to conclude that the mean

U S I N G S TAT I S T I C S @ BLK Beverages Revisited

www.Bankrate.com
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T A B L E 1 0 . 7

Summary of Topics in
Chapter 10

Types of Data

Type of Analysis Numerical Categorical

Comparing two
populations

t tests for the difference in the means 
of two independent populations 
(Section 10.1)

Z test for the difference
between two proportions
(Section 10.3)

Paired t test (Section 10.2)

F test for the ratio of two variances
(Section 10.4)

S U M M A R Y
In this chapter, you were introduced to a variety of two-sam-
ple tests. For situations in which the samples are independ-
ent, you learned statistical test procedures for analyzing
possible differences between means, variances, and propor-
tions. In addition, you learned a test procedure that is fre-
quently used when analyzing differences between the means
of two related samples. Remember that you need to select
the test that is most appropriate for a given set of conditions
and to critically investigate the validity of the assumptions
underlying each of the hypothesis-testing procedures.

Table 10.7 provides a list of topics covered in this chap-
ter. The roadmap in Figure 10.15 illustrates the steps needed
in determining which two-sample test of hypothesis to use.
The following are the questions you need to consider:

1. What type of data do you have? If you are dealing with cat-
egorical variables, use the Z test for the difference between
two proportions. (This test assumes independent samples.)

2. If you have a numerical variable, determine whether
you have independent samples or related samples. If
you have related samples, and you can assume approxi-
mate normality, use the paired t test.

3. If you have independent samples, is your focus on vari-
ability or central tendency? If the focus is on variability,
and you can assume approximate normality, use the F
test.

4. If your focus is central tendency and you can assume
approximate normality, determine whether you can as-
sume that the variances of the two populations are
equal. (This assumption can be tested using the F
test.)

5. If you can assume that the two populations have equal
variances, use the pooled-variance t test. If you cannot
assume that the two populations have equal variances,
use the separate-variance t test.

sales using end-aisle location are higher than the mean sales for the normal shelf location.
A confidence interval allowed you to infer with 95% confidence that the end-aisle location
sells, on average, 6.73 to 36.67 cases more than the normal shelf location. You also per-
formed the F test for the difference between two variances to see if the store-to-store vari-
ability in sales in stores using the end-aisle location differed from the store-to-store
variability in sales in stores using the normal shelf location. You concluded that there was
no significant difference in the variability of the sales of cola for the two display locations.
As regional sales manager, your next step in increasing sales is to convince more stores to
use the special end-aisle display.
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2    2 2  2
No Yes

Categorical Numerical

Yes No

Central
Tendency Variability

Z test for the
difference

between two
proportions

Type
of

Data

Independent
Samples?

σ1 = σ2?

Focus

F Test
for σ1 = σ2

Separate-Variance
t Test

Pooled-Variance
t Test

Two-Sample
Procedures

Paired
t Test

2 2

F I G U R E 1 0 . 1 5
Roadmap for selecting a
two-sample test of
hypothesis

K E Y E Q U AT I O N S
Pooled-Variance t Test for the Difference Between Two
Means

(10.1)

Confidence Interval Estimate for the Difference in the
Means of Two Independent Populations

(10.2)

or

… 1X1 - X22 + ta>2AS2
pa 1

n1
+

1
n2
b

1X1 - X22 - ta>2AS2
pa 1

n1
+

1
n2
b … m1 - m2

1X1 - X22 ; ta>2AS2
pa 1

n1
+

1
n2
b

tSTAT =
1X1 - X22 - 1m1 - m22

AS2
pa 1

n1
+

1
n2
b

Separate-Variance t Test for the Difference Between Two
Means

(10.3)

Computing Degrees of Freedom in the Separate-Variance t

Test

(10.4)

Paired t Test for the Mean Difference

(10.5)tSTAT =
D - mD

SD1n

V =
aS2

1

n1
+

S2
2

n2
b2

aS2
1

n1
b2

n1 - 1
+
aS2

2

n2
b2

n2 - 1

tSTAT =
( X1 - X2) - (m1 - m2)

AS2
1

n1
+ S2

2

n2
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Confidence Interval Estimate for the Mean Difference

(10.6)

or

Z Test for the Difference Between Two Proportions

(10.7)

Confidence Interval Estimate for the Difference Between
Two Proportions

(10.8)1p1 - p22 ; Za>2A ap111 - p12
n1

+
p211 - p22

n2
b

ZSTAT =
1p1 - p22 - 1p1 - p22
Ap11 - p2a 1

n1
+

1

n2
b

D - ta>2
SD1n

… mD … D + ta>2
SD1n

D ; ta>2
SD1n

or

F Test Statistic for Testing the Ratio of Two Variances

(10.9)FSTAT =
S2

1

S2
2

… 1p1 - p22 + Za>2Ap111 - p12
n1

+
p211 - p22

n2

1p1 - p22 - Za>2Ap111 - p12
n1

+
p211 - p22

n1
… 1p1 - p22

K E Y T E R M S
F distribution 392
F test for the ratio of two variances 392
matched samples 377
paired t test for the mean 

difference 378

pooled-variance t test 366
repeated measurements 377
robust 369
separate-variance t test 372
two-sample test 366

Z test for the difference between two
proportions 386

CHECKING YOUR UNDERSTANDING
10.51 What are some of the criteria used in the selection
of a particular hypothesis-testing procedure?

10.52 Under what conditions should you use the pooled-
variance t test to examine possible differences in the means
of two independent populations?

10.53 Under what conditions should you use the F test to
examine possible differences in the variances of two inde-
pendent populations?

10.54 What is the distinction between two independent
populations and two related populations?

10.55 What is the distinction between repeated measure-
ments and matched items?

10.56 When you have two independent populations, ex-
plain the similarities and differences between the test of

C H A P T E R R E V I E W P R O B L E M S
hypothesis for the difference between the means and the confi-
dence interval estimate for the difference between the means.

10.57 Under what conditions should you use the paired
t test for the mean difference between two related
populations?

APPLYING THE CONCEPTS
10.58 The per-store daily customer count (i.e., the mean
number of customers in a store in one day) for a nationwide
convenience store chain that operates nearly 10,000 stores
has been steady, at 900, for some time. To increase the cus-
tomer count, the chain is considering cutting prices for cof-
fee beverages. The small size will now be $0.59 instead of
$0.99, and medium size will be $0.69 instead of $1.19. Even
with this reduction in price, the chain will have a 40% gross
margin on coffee. The question to be determined is how
much to cut prices to increase the daily customer count
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Job Title
Sample

Size Mean
Standard
Deviation

Black Belt 219 87,342 20,955
Green belt 34 65,679 18,137

Source: Data extracted from J. D. Conklin, “Salary Survey: Holding
Steady,” Quality Progress, December 2009, pp. 20–53.

without reducing the gross margin on coffee sales too much.
The chain decides to carry out an experiment in a sample of
30 stores where customer counts have been running almost
exactly at the national average of 900. In 15 of the stores,
the price of a small coffee will now be $0.59 instead of
$0.99, and in 15 other stores, the price of a small coffee will
now be $0.79. After four weeks, the 15 stores that priced the
small coffee at $0.59 had a mean daily customer count of
964 and a standard deviation of 88, and the 15 stores that
priced the small coffee at $0.79 had a mean daily customer
count of 941 and a standard deviation of 76. Analyze these
data (use the 0.05 level of significance) and answer the fol-
lowing questions.
a. Does reducing the price of a small coffee to either $0.59 or

$0.79 increase the mean per-store daily customer count?
b. If reducing the price of a small coffee to either $0.59 or

$0.79 increases the mean per-store daily customer count,
is there any difference in the mean per-store daily cus-
tomer count between stores in which a small coffee was
priced at $0.59 and stores in which a small coffee was
priced at $0.79?

c. What price do you recommend that a small coffee should
be sold for?

10.59 A study conducted in March 2009 found that about
half of U.S. adults trusted the U.S. government more than U.S.
business to solve the economic problems of the United States.
However, when the population is subdivided by political party
affiliation, the results are very different. The study showed
that 72% of Democrats trusted the government more, but only
29% of Republicans trusted the government more. Suppose
that you are in charge of updating the study. You will take a
national sample of Democrats and a national sample of Re-
publicans and then try to use the results to show statistical ev-
idence that the proportion of Democrats trusting the
government more than business is greater than the proportion
of Republicans trusting the government more than business.
a. What are the null and alternative hypotheses?
b. What is a Type I error in the context of this study?
c. What is a Type II error in the context of this study?

10.60 The American Society for Quality (ASQ) conducted
a salary survey of all its members. ASQ members work in
all areas of manufacturing and service-related institutions,
with a common theme of an interest in quality. Two job ti-
tles are black belt and green belt. (See Section 17.8, for a
description of these titles in a Six Sigma quality improve-

ment initiative.) Descriptive statistics concerning salaries
for these two job titles are given in the following table:
a. Using a 0.05 level of significance, is there a difference in the

variability of salaries between black belts and green belts?
b. Based on the result of (a), which t test defined in Section

10.1 is appropriate for comparing mean salaries?
c. Using a 0.05 level of significance, is there a difference

between the mean salary of black belts and green belts?

10.61 Do male and female students study the same
amount per week? In 2007, 58 sophomore business students
were surveyed at a large university that has more than 1,000
sophomore business students each year. The file
contains the gender and the number of hours spent studying
in a typical week for the sampled students.
a. At the 0.05 level of significance, is there a difference in

the variance of the study time for male students and fe-
male students?

b. Using the results of (a), which t test is appropriate for com-
paring the mean study time for male and female students?

c. At the 0.05 level of significance, conduct the test
selected in (b).

d. Write a short summary of your findings.

10.62 Two professors wanted to study how students from
their two universities compared in their capabilities of using
Excel spreadsheets in undergraduate information systems
courses. (Data extracted from H. Howe and M. G. Simkin,
“Factors Affecting the Ability to Detect Spreadsheet Errors,”
Decision Sciences Journal of Innovative Education, January
2006, pp. 101–122.) A comparison of the student demo-
graphics was also performed. One school is a state university
in the western United States, and the other school is a state

StudyTime

School
Sample

Size Mean
Standard
Deviation

Western 93 2.6 2.4
Eastern 135 4.0 2.1

university in the eastern United States. The following table
contains information regarding the ages of the students:
a. Using a 0.01 level of significance, is there evidence of a

difference in the variances of the age of students at the
western school and at the eastern school?

b. Discuss the practical implications of the test performed
in (a). Address, specifically, the impact equal (or un-
equal) variances in age has on teaching an undergraduate
information systems course.

c. To test for a difference in the mean age of students, is it
most appropriate to use the pooled-variance t test or the
separate-variance t test?

School
Sample

Size Mean
Standard
Deviation

Western 93 23.28 6.29
Eastern 135 21.16 1.32
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The following table contains information regarding the
years of spreadsheet usage of the students:
d. Using a 0.01 level of significance, is there evidence of a dif-

ference in the variances of the years of spreadsheet usage of
students at the western school and at the eastern school?

e. Based on the results of (d), use the most appropriate test
to determine, at the 0.01 level of significance, whether
there is evidence of a difference in the mean years of
spreadsheet usage of students at the western school and
at the eastern school.

10.63 The file contains the ratings for food,
décor, service, and the price per person for a sample of 50
restaurants located in a city and 50 restaurants located in a
suburb. Completely analyze the differences between city
and suburban restaurants for the variables food rating, décor
rating, service rating, and cost per person, using 
Source: Data extracted from Zagat Survey 2010: New York City
Restaurants and Zagat Survey 2009–2010: Long Island Restaurants.

10.64 A computer information systems professor is
interested in studying the amount of time it takes students
enrolled in the introduction to computers course to write
and run a program in Visual Basic. The professor hires you
to analyze the following results (in minutes) from a random
sample of nine students (the data are stored in the file):

a. At the 0.05 level of significance, is there evidence that
the population mean amount is greater than 10 minutes?
What will you tell the professor?

b. Suppose that the professor, when checking her results, re-
alizes that the fourth student needed 51 minutes rather
than the recorded 15 minutes to write and run the Visual
Basic program. At the 0.05 level of significance, reana-
lyze the question posed in (a), using the revised data.
What will you tell the professor now?

c. The professor is perplexed by these paradoxical results and
requests an explanation from you regarding the justification
for the difference in your findings in (a) and (b). Discuss.

d. A few days later, the professor calls to tell you that the
dilemma is completely resolved. The original number 15
(the fourth data value) was correct, and therefore your
findings in (a) are being used in the article she is writing
for a computer journal. Now she wants to hire you to
compare the results from that group of introduction to
computers students against those from a sample of 11
computer majors in order to determine whether there is
evidence that computer majors can write a Visual Basic
program in less time than introductory students. For the
computer majors, the sample mean is 8.5 minutes, and
the sample standard deviation is 2.0 minutes. At the 0.05
level of significance, completely analyze these data.
What will you tell the professor?

e. A few days later, the professor calls again to tell you that
a reviewer of her article wants her to include the p-value
for the “correct” result in (a). In addition, the professor

10 13 9 15 12 13 11 13 12

VB

a = 0.05.

Restaurants

inquires about an unequal-variances problem, which the
reviewer wants her to discuss in her article. In your own
words, discuss the concept of p-value and also describe
the unequal-variances problem. Then, determine the p-
value in (a) and discuss whether the unequal-variances
problem had any meaning in the professor’s study.

10.65 An article (A. Jennings, “What’s Good for a Busi-
ness Can Be Hard on Friends,” The New York Times, August
4, 2007, pp. C1–C2) reported that according to a poll, the
mean number of cell phone calls per month was 290 for 18-
to 24-year-olds and 194 for 45- to 54-year-olds, whereas the
mean number of text messages per month was 290 for 18-
to 24-year-olds and 57 for 45- to 54-year-olds. Suppose that
the poll was based on a sample of 100 18- to 24-year-olds
and 100 45- to 54-year-olds and that the standard deviation
of the number of cell phone calls per month was 100 for 18-
to 24-year-olds and 90 for 45- to 54-year-olds, whereas the
standard deviation of the number of text messages per
month was 90 for 18- to 24-year-olds and 77 for 45- to 54-
year-olds. Assume a level of significance of 0.05.
a. Is there evidence of a difference in the variances of the

number of cell phone calls per month for 18- to 24-year-
olds and for 45- to 54-year-olds?

b. Is there evidence of a difference in the mean number of
cell phone calls per month for 18- to 24-year-olds and for
45- to 54-year-olds?

c. Construct and interpret a 95% confidence interval estimate
for the difference in the mean number of cell phone calls
per month for 18- to 24-year-olds and 45- to 54-year-olds.

d. Is there evidence of a difference in the variances of the
number of text messages per month for 18- to 24-year-
olds and 45- to 54-year-olds?

e. Is there evidence of a difference in the mean number of
text messages per month for 18- to 24-year-olds and 45-
to 54-year-olds?

f. Construct and interpret a 95% confidence interval estimate
for the difference in the mean number of text messages per
month for 18- to 24-year-olds and 45- to 54-year-olds.

g. Based on the results of (a) through (f), what conclusions
can you make concerning cell phone and text message us-
age between 18- to 24-year-olds and 45- to 54-year-olds?

10.66 The lengths of life (in hours) of a sample of 40 100-
watt light bulbs produced by manufacturer A and a sample
of 40 100-watt light bulbs produced by manufacturer B are
stored in . Completely analyze the differences be-
tween the lengths of life of the bulbs produced by the two
manufacturers. (Use )

10.67 A hotel manager looks to enhance the initial impres-
sions that hotel guests have when they check in. Contributing
to initial impressions is the time it takes to deliver a guest’s
luggage to the room after check-in. A random sample of 20
deliveries on a particular day were selected in Wing A of the
hotel, and a random sample of 20 deliveries were selected in
Wing B. The results are stored in . Analyze the dataLuggage

a = 0.05.

Bulbs
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What Tweens Did in the Past Week Boys Girls

Played a game on a video game
system

498 243

Read a book for fun 276 324
Gave product advice to parents 186 181
Shopped at a mall 144 262

and determine whether there is a difference in the mean de-
livery time in the two wings of the hotel. (Use )

10.68 According to Census estimates, there are about 20
million children between 8 and 12 years old (referred to as
tweens) in the United States in 2009. A recent survey of
1,223 8- to 12-year-old children (S. Jayson, “It’s Cooler
Than Ever to Be a Tween,” USA Today, February 4, 2009,
pp. 1A, 2A) reported the following results. Suppose the
survey was based on 600 boys and 623 girls.

a = 0.05.
10.71 There are a tremendous number of mutual funds from
which an investor can choose. Each mutual fund has its own
mix of different types of investments. The data in
present the 3-year annualized return, 5-year annualized re-
turn, 10-year annualized return, and expense ratio (in %) for
the 10 best mutual funds according to the U.S. News & World
Report score for large cap value and large cap growth mutual
funds. (Data extracted from K. Shinkle, “The Best Funds for
the Long Term, U.S. News & World Report, Summer 2010,
pp. 52–56.) Analyze the data and determine whether any dif-
ferences exist between large cap value and large cap growth
mutual funds. (Use the 0.05 level of significance.)

REPORT WRITING EXERCISE
10.72 Referring to the results of Problems 10.69 and
10.70 concerning the weight and granule loss of Boston and
Vermont shingles, write a report that summarizes your
conclusions.

TEAM PROJECT
The file contains information regarding eight
variables from a sample of 184 bond mutual funds:

Type—Type of bonds comprising the bond fund (inter-
mediate government or short-term corporate)
Assets—In millions of dollars
Fees—Sales charges (no or yes)
Expense ratio—Ratio of expenses to net assets, in
percentage
Return 2009—Twelve-month return in 2009
Three-year return—Annualized return, 2007–2009
Five-year return—Annualized return, 2005–2009
Risk—Risk-of-loss factor of the mutual fund (below
average, average, or above average)

10.73 Completely analyze the differences between bond
mutual funds without fees and bond mutual funds with fees
in terms of 2009 return, three-year return, five-year return,
and expense ratio. Write a report summarizing your findings.

10.74 Completely analyze the difference between inter-
mediate government bond mutual funds and short-term cor-
porate bond mutual funds in terms of 2009 return,
three-year return, five-year return, and expense ratio. Write
a report summarizing your findings.

STUDENT SURVEY DATABASE
10.75 Problem 1.27 on page 14 describes a survey of 62
undergraduate students (stored in ).
a. At the 0.05 level of significance, is there evidence of a

difference between males and females in grade point av-
erage, expected starting salary, number of social net-
working sites registered for, age, spending on textbooks
and supplies, text messages sent in a week, and the
wealth needed to feel rich?

b. At the 0.05 level of significance, is there evidence of a
difference between students who plan to go to graduate

UndergradSurvey

Bond Funds

BestFunds

For each type of activity, determine whether there is a
difference between boys and girls at the 0.05 level of
significance.

10.69 The manufacturer of Boston and Vermont asphalt
shingles knows that product weight is a major factor in the
customer’s perception of quality. Moreover, the weight rep-
resents the amount of raw materials being used and is there-
fore very important to the company from a cost standpoint.
The last stage of the assembly line packages the shingles be-
fore they are placed on wooden pallets. Once a pallet is full
(a pallet for most brands holds 16 squares of shingles), it is
weighed, and the measurement is recorded. The file
contains the weight (in pounds) from a sample of 368 pal-
lets of Boston shingles and 330 pallets of Vermont shingles.
Completely analyze the differences in the weights of the
Boston and Vermont shingles, using 

10.70 The manufacturer of Boston and Vermont asphalt
shingles provides its customers with a 20-year warranty on
most of its products. To determine whether a shingle will
last as long as the warranty period, the manufacturer con-
ducts accelerated-life testing. Accelerated-life testing ex-
poses the shingle to the stresses it would be subject to in a
lifetime of normal use in a laboratory setting via an experi-
ment that takes only a few minutes to conduct. In this test,
a shingle is repeatedly scraped with a brush for a short pe-
riod of time, and the shingle granules removed by the
brushing are weighed (in grams). Shingles that experience
low amounts of granule loss are expected to last longer in
normal use than shingles that experience high amounts of
granule loss. In this situation, a shingle should experience
no more than 0.8 grams of granule loss if it is expected to
last the length of the warranty period. The file
contains a sample of 170 measurements made on the com-
pany’s Boston shingles and 140 measurements made on
Vermont shingles. Completely analyze the differences in
the granule loss of the Boston and Vermont shingles, using
a = 0.05.

Granule

a = 0.05.

Pallet
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school and those who do not plan to go to graduate school
in grade point average, expected starting salary, number
of social networking sites registered for, age, spending on
textbooks and supplies, text messages sent in a week, and
the wealth needed to feel rich?

10.76 Problem 1.27 on page 14 describes a survey of 62
undergraduate students (stored in ).
a. Select a sample of undergraduate students at your school

and conduct a similar survey for them.
b. For the data collected in (a), repeat (a) and (b) of Problem

10.75.
c. Compare the results of (b) to those of Problem 10.75.

10.77 Problem 1.28 on page 15 describes a survey of 44
MBA students (stored in ). For these data, atGradSurvey

UndergradSurvey

the 0.05 level of significance, is there evidence of a differ-
ence between males and females in age, undergraduate
grade point average, graduate grade point average, ex-
pected salary upon graduation, spending on textbooks and
supplies, text messages sent in a week, and the wealth
needed to feel rich?

10.78 Problem 1.28 on page 15 describes a survey of 44
MBA students (stored in ).
a. Select a sample of graduate students in your MBA

program and conduct a similar survey for those
students.

b. For the data collected in (a), repeat Problem 10.77.
c. Compare the results of (b) to those of Problem 10.77.

GradSurvey

M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
AMS communicates with customers who subscribe to cable
television services through a special secured email system
that sends messages about service changes, new features,
and billing information to in-home digital set-top boxes for
later display. To enhance customer service, the operations
department established the business objective of reducing
the amount of time to fully update each subscriber’s set of
messages. The department selected two candidate messag-
ing systems and conducted an experiment in which 30 ran-
domly chosen cable subscribers were assigned one of the
two systems (15 assigned to each system). Update times
were measured, and the results are organized in Table
AMS10.1 (and stored in ).AMS10

EXERCISES
1. Analyze the data in Table AMS10.1 and write a report

to the computer operations department that indicates
your findings. Include an appendix in which you dis-
cuss the reason you selected a particular statistical test
to compare the two independent groups of callers.

2. Suppose that instead of the research design described
in the case, there were only 15 subscribers sampled,
and the update process for each subscriber e-mail was
measured for each of the two messaging systems. Sup-
pose the results were organized in Table AMS10.1—
making each row in the table a pair of values for an
individual subscriber. Using these suppositions, reana-
lyze the Table AMS10.1 data and write a report for
presentation to the team that indicates your findings.

T A B L E A M S 1 0 . 1

Download Time for Two
Different E-mail
Interfaces

Email Interface 1 Email Interface 2

4.13 3.71
3.75 3.89
3.93 4.22
3.74 4.57
3.36 4.24
3.85 3.90
3.26 4.09
3.73 4.05
4.06 4.07
3.33 3.80
3.96 4.36
3.57 4.38
3.13 3.49
3.68 3.57
3.63 4.74
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D I G I TA L C A S E
Apply your knowledge about hypothesis testing in this Digi-
tal Case, which continues the cereal-fill packaging dispute
Digital Case from Chapters 7 and 9.

Even after the recent public experiment about cereal box
weights, Consumers Concerned About Cereal Cheaters
(CCACC) remains convinced that Oxford Cereals has mis-
led the public. The group has created and circulated
MoreCheating.pdf, a document in which it claims that ce-

real boxes produced at Plant Number 2 in Springville weigh
less than the claimed mean of 368 grams. Review this docu-
ment and then answer the following questions:

1. Do the CCACC’s results prove that there is a statistically
significant difference in the mean weights of cereal boxes
produced at Plant Numbers 1 and 2?

2. Perform the appropriate analysis to test the CCACC’s hypoth-
esis. What conclusions can you reach based on the data?
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EG10.1 COMPARING the MEANS of TWO
INDEPENDENT POPULATIONS

Pooled-Variance t Test for the Difference
Between Two Means

PHStat2 Use Pooled-Variance t Test to perform the pooled-
variance t test. For example, to perform the Figure 10.3 pooled-
variance t test for the BLK Cola data shown on page 365, open to
the DATA worksheet of the COLA workbook. Select PHStat
➔ Two-Sample Tests (Unsummarized Data) ➔ Pooled-Vari-
ance tTest. In the procedure’s dialog box (shown below):

1. Enter 0 as the Hypothesized Difference.

2. Enter 0.05 as the Level of Significance.

3. Enter A1:A11 as the Population 1 Sample Cell Range.

4. Enter B1:B11 as the Population 2 Sample Cell Range.

5. Check First cells in both ranges contain label.

6. Click Two-Tail Test.

7. Enter a Title and click OK.

expressions -TINV(level of significance, degrees of free-

dom) and TINV(level of significance, degrees of freedom)
to compute the lower and upper critical values. In cell B26,
TDIST(absolute value of the t test statistic, degrees of free-

dom, 2) computes the p-value.
For other problems, use the COMPUTE worksheet with

either unsummarized or summarized data. For unsumma-
rized data, keep the formulas that calculate the sample size,
sample mean, and sample standard deviation in cell ranges
B7:B9 and B11:B13 and change the data in columns A and
B in the DATACOPY worksheet. For summarized data, re-
place the formulas in cell ranges B7:B9 and B11:B13 with
the sample statistics and ignore the DATACOPY worksheet.

Use the similar COMPUTE_LOWER or COM-
PUTE_UPPER worksheets in the same workbook as tem-
plates for performing one-tail pooled-variance t tests. These
worksheets can also use either unsummarized or
summarized data.

Analysis ToolPak Use t-Test: Two-Sample Assuming
Equal Variances to perform the pooled-variance t test for
unsummarized data. For example, to create results equiva-
lent to those in the Figure 10.3 pooled-variance t test for the
BLK Cola example on page 368, open to the DATA work-
sheet of the COLA workbook and:

1. Select Data ➔ Data Analysis.

2. In the Data Analysis dialog box, select t-Test: Two-
Sample Assuming Equal Variances from the Analysis
Tools list and then click OK.

In the procedure’s dialog box (shown below):

3. Enter A1:A11 as the Variable 1 Range and enter B1:B11
as the Variable 2 Range.

4. Enter 0 as the Hypothesized Mean Difference.

5. Check Labels and enter 0.05 as Alpha.

6. Click New Worksheet Ply.

7. Click OK.

C H A P T E R 1 0 E X C E L G U I D E

For problems that use summarized data, select PHStat ➔
Two-Sample Tests (Summarized Data) ➔ Pooled-Variance
t Test. In that procedure’s dialog box, enter the hypothesized
difference and level of significance, as well as the sample size,
sample mean, and sample standard deviation for each sample.

In-Depth Excel Use the COMPUTE worksheet of the
Pooled-Variance T workbook, shown in Figure 10.3 on
page 368, as a template for performing the two-tail pooled-
variance t test. The worksheet contains data and formulas to
use the unsummarized data for the BLK Cola example. In
cell B24 and B25, respectively, the worksheet uses the



Chapter 10 Excel Guide 407

Results (shown below) appear in a new worksheet that
contains both two-tail and one-tail test critical values and
p-values. Unlike Figure 10.3, only the positive (upper) criti-
cal value is listed for the two-tail test.

Confidence Interval Estimate for the Difference
Between Two Means

PHStat2 Use the PHStat2 instructions for the pooled-vari-
ance t test. In step 7, also check Confidence Interval Esti-
mate and enter a Confidence Level in its box, in addition
to entering a Title and clicking OK.

In-Depth Excel Use the In-Depth Excel instructions for
the pooled-variance t test. The worksheets in the Pooled-
Variance T workbook include a confidence interval esti-
mate for the difference between two means in the cell range
D3:E16.

t Test for the Difference Between Two Means
Assuming Unequal Variances

PHStat2 Use Separate-Variance t Test to perform this t
test. For example, to perform the Figure 10.7 separate-vari-
ance t test for the BLK Cola data on page 374, open to the
DATA worksheet of the COLA workbook. Select PHStat
➔ Two-Sample Tests (Unsummarized Data) ➔ Sepa-
rate-Variance t Test. In the procedure’s dialog box (shown
at the top of the right column):

1. Enter 0 as the Hypothesized Difference.

2. Enter 0.05 as the Level of Significance.

3. Enter A1:A11 as the Population 1 Sample Cell Range.

4. Enter B1:B11 as the Population 2 Sample Cell Range.

5. Check First cells in both ranges contain label.

6. Click Two-Tail Test.

7. Enter a Title and click OK.

For problems that use summarized data, select PHStat
➔ Two-Sample Tests (Summarized Data) ➔ Separate-
Variance t Test. In that procedure’s dialog box, enter the hy-
pothesized difference and the level of significance, as well
as the sample size, sample mean, and sample standard devi-
ation for each group.

In-Depth Excel Use the COMPUTE worksheet of the
Separate-Variance T workbook, shown in Figure 10.7 on
page 374, as a template for performing the two-tail
separate-variance t test. The worksheet contains data and
formulas to use the unsummarized data for the BLK Cola
example. In cells B25 and B26, respectively, -TINV(level

of significance, degrees of freedom) and TINV(level of

significance, degrees of freedom) computes the lower and
upper critical values. In cell B27, the worksheet uses
TDIST(absolute value of the t test statistic, degrees of

freedom, 2) to compute the p-value.
For other problems, use the COMPUTE worksheet with

either unsummarized or summarized data. For unsumma-
rized data, keep the formulas that calculate the sample size,
sample mean, and sample standard deviation in cell ranges
B7:B9 and B11:B13 and change the data in columns A and
B in the DATACOPY worksheet. For summarized data, re-
place the formulas in cell ranges B7:B9 and B11:B13 with
the sample statistics and ignore the DATACOPY worksheet.
Use the similar COMPUTE_LOWER or COM-
PUTE_UPPER worksheets in the same workbook as tem-
plates for performing one-tail t tests.

Analysis ToolPak Use t-Test: Two-Sample Assuming Un-
equal Variances to perform the separate-variance t test for
unsummarized data. For example, to create results equiva-
lent to those in the Figure 10.7 separate-variance t test for
the BLK Cola data on page 374, open to the DATA work-
sheet of the COLA workbook and:

1. Select Data ➔ Data Analysis.

2. In the Data Analysis dialog box, select t-Test: Two-Sam-
ple Assuming Unequal Variances from the Analysis
Tools list and then click OK.
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In the procedure’s dialog box (shown below):

3. Enter A1:A11 as the Variable 1 Range and enter B1:B11
as the Variable 2 Range.

4. Enter 0 as the Hypothesized Mean Difference.

5. Check Labels and enter 0.05 as Alpha.

6. Click New Worksheet Ply.

7. Click OK.

Results (shown below) appear in a new worksheet that
contains both two-tail and one-tail test critical values and
p-values. Unlike Figure 10.7, only the positive (upper)
critical value is listed for the two-tail test. Because the
Analysis ToolPak uses table lookups to approximate the
critical values and the p-value, the results will differ slightly
from the values shown in Figure 10.7.

EG10.2 COMPARING the MEANS of TWO
RELATED POPULATIONS

Paired t Test

PHStat2 Use Paired t Test to perform the paired t test. For
example, to perform the Figure 10.9 paired t test for the text-
book price data on page 381, open to the DATA worksheet
of the BookPrices workbook. Select PHStat ➔ Two-Sam-
ple Tests (Unsummarized Data) ➔ Paired t Test. In the
procedure’s dialog box (shown in the right column):

1. Enter 0 as the Hypothesized Mean Difference.

2. Enter 0.05 as the Level of Significance.

3. Enter C1:C20 as the Population 1 Sample Cell Range.

4. Enter D1:D20 as the Population 2 Sample Cell Range.

5. Check First cells in both ranges contain label.

6. Click Two-Tail Test.

7. Enter a Title and click OK.

The procedure creates two worksheets, one of which is
similar to the PtCalcs worksheet discussed in the following
In-Depth Excel section. For problems that use summarized
data, select PHStat ➔ Two-Sample Tests (Summarized
Data) ➔ Paired t Test. In that procedure’s dialog box, enter
the hypothesized mean difference and the level of signifi-
cance, as well as the sample size, sample mean, and sample
standard deviation for each sample.

In-Depth Excel Use the COMPUTE and PtCalcs work-
sheets of the Paired T workbook, as a template for per-
forming the two-tail paired t test. The PtCalcs worksheet
contains the differences and other intermediate calculations
that allow the COMPUTE worksheet, shown in Figure 10.9
on page 381, to compute the sample size, and

The COMPUTE and PtCalcs worksheets contain the data
and formulas for the unsummarized data for the textbook
prices example. In cells B16 and B17, respectively, the COM-
PUTE worksheet uses -TINV(level of significance, degrees

of freedom) and TINV(level of significance, degrees of free-

dom) to compute the lower and upper critical values. In cell
B18, the worksheet uses TDIST(absolute value of the t test

statistic, degrees of freedom, 2) to compute the p-value.
For other problems, paste the unsummarized data into

columns A and B of the PtCalcs worksheet. For sample sizes
greater than 19, select the cell range C20:D20 and copy the
formulas in those cells down through the last data row. For
sample sizes less than 19, delete the column C and D formu-
las for which there are no column A and B values. If you
know the sample size, and values, you can ignore the
PtCalcs worksheet and enter the values in cells B8, B9, and
B11 of the COMPUTE worksheet, overwriting the formulas
that those cells contain. Use the COMPUTE_LOWER or
COMPUTE_UPPER worksheets in the same workbook as
templates for performing one-tail tests.

SDD,

SD.D,
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Analysis ToolPak Use t-Test: Paired Two Sample for
Means to perform the paired t test for unsummarized data. For
example, to create results equivalent to those in the Figure
10.9 paired t test for the textbook price data on page 381, open
to the DATA worksheet of the BookPrices workbook and:

1. Select Data ➔ Data Analysis.

2. In the Data Analysis dialog box, select t-Test: Paired
Two Sample for Means from the Analysis Tools list
and then click OK.

In the procedure’s dialog box (shown below):

3. Enter C1:C20 as the Variable 1 Range and enter D1:D20
as the Variable 2 Range.

4. Enter 0 as the Hypothesized Mean Difference.

5. Check Labels and enter 0.05 as Alpha.

6. Click New Worksheet Ply.

7. Click OK.

Results (shown below) appear in a new worksheet that
contains both two-tail and one-tail test critical values and
p-values. Unlike Figure 10.9, only the positive (upper)
critical value is listed for the two-tail test.

Z test for the hotel guest satisfaction survey on page 388, se-
lect PHStat ➔ Two-Sample Tests (Summarized Data) ➔
Z Test for Differences in Two Proportions. In the proce-
dure’s dialog box (shown below):

1. Enter 0 as the Hypothesized Difference.

2. Enter 0.05 as the Level of Significance.

3. For the Population 1 Sample, enter 163 as the Number
of Items of Interest and 227 as the Sample Size.

4. For the Population 2 Sample, enter 154 as the Number
of Items of Interest and 262 as the Sample Size.

5. Click Two-Tail Test.

6. Enter a Title and click OK.

In-Depth Excel Use the COMPUTE worksheet of the Z

Two Proportions workbook, shown in Figure 10.13 on
page 388, as a template for performing the two-tail Z test for
the difference between two proportions. The worksheet
contains data for the hotel guest satisfaction survey. In cells
B21 and B22 respectively, the worksheet uses NORMSINV
(level of significance/2) and NORMSINV(1 - level of

significance/2) to compute the lower and upper critical
values. In cell B23, the worksheet uses the expression 2 *
(1 - NORMSDIST(absolute value of the Z test statistic)) to
compute the p-value.

For other problems, change the values in cells B4, B5, B7,
B8, B10, and B11 as necessary. Use the similar COM-
PUTE_LOWER or COMPUTE_UPPER worksheets in the
same workbook as templates for performing one-tail separate-
variance t tests.

Confidence Interval Estimate for the Difference
Between Two Proportions

PHStat2 Use the PHStat2 instructions for the Z test for the
difference between two proportions. In step 6, also check

EG10.3 COMPARING the PROPORTIONS of
TWO INDEPENDENT POPULATIONS

Z Test for the Difference Between Two
Proportions

PHStat2 Use Z Test for Differences in Two Proportions to
perform this Z test. For example, to perform the Figure 10.13
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For problems that use summarized data, select PHStat ➔
Two-Sample Tests (Summarized Data) ➔ F Test for
Differences in Two Variances. In that procedure’s dialog
box, enter the level of significance and the sample size
and sample variance for each sample.

In-Depth Excel Use the COMPUTE worksheet of the F
Two Variances workbook, shown in Figure 10.14 on page
394, as a template for performing the two-tail F test for the
ratio of two variances. The worksheet contains data and for-
mulas for using the unsummarized data for the BLK Cola
example. In cell B18, the worksheet uses FINV(level of sig-

nificance / 2, population 1 sample degrees of freedom,
population 2 sample degrees of freedom) to compute the
upper critical value and in cell B19 uses the equivalent of
the expression 2 * FDIST(F test statistic, population 1

Confidence Interval Estimate and enter a Confidence Level
in its box, in addition to entering a Title and clicking OK.

In-Depth Excel Use the In-Depth Excel instructions for
the Z test for the difference between two proportions. The
worksheets in the Z Two Proportions workbook include a
confidence interval estimate for the difference between two
means in the cell range D3:E16.

EG10.4 F TEST for the RATIO of TWO VARI-
ANCES

PHStat2 Use F Test for Differences in Two Variances to
perform this F test. For example, to perform the Figure
10.14 F test for the BLK Cola sales data on page 394,
open to the DATA worksheet of the COLA workbook.
Select PHStat ➔ Two-Sample Tests (Unsummarized
Data) ➔ F Test for Differences in Two Variances. In
the procedure’s dialog box (shown below):

1. Enter 0.05 as the Level of Significance.

2. Enter A1:A11 as the Population 1 Sample Cell Range.

3. Enter B1:B11 as the Population 2 Sample Cell Range.

4. Check First cells in both ranges contain label.

5. Click Two-Tail Test.

6. Enter a Title and click OK.

sample degrees of freedom, population 2 sample degrees of

freedom) to compute the p-value.
For other problems using unsummarized data, paste the

unsummarized data into columns A and B of the DATACOPY
worksheet. For summarized data, replace the COMPUTE
worksheet formulas in cell ranges B6:B7 and B9:B10 with the
sample statistics and ignore the DATACOPY worksheet. Use
the similar COMPUTE_UPPER worksheet in the same
workbook as a template for performing the upper-tail test.

Analysis ToolPak Use the F-Test Two-Sample for Vari-
ances procedure to perform the F test for the difference be-
tween two variances for unsummarized data. For example,
to create results equivalent to those in the Figure 10.14 F
test for the BLK Cola sales data on page 394, open to the
DATA worksheet of the COLA workbook and:

1. Select Data ➔ Data Analysis.

2. In the Data Analysis dialog box, select F-Test Two-
Sample for Variances from the Analysis Tools list and
then click OK.

In the procedure’s dialog box (shown below):

3. Enter A1:A11 as the Variable 1 Range and enter B1:B11
as the Variable 2 Range.

4. Check Labels and enter 0.05 as Alpha.

5. Click New Worksheet Ply.

6. Click OK.

Results (shown below) appear in a new worksheet and
include only the one-tail test p-value (0.124104), which
must be doubled for the two-tail test shown in Figure 10.14
on page 394.



MG10.1 COMPARING the MEANS of TWO
INDEPENDENT POPULATIONS

Pooled-Variance t Test for the Difference
Between Two Means

Use 2-Sample t to perform the pooled-variance t test. For
example, to perform the Figure 10.3 pooled-variance t test
for the BLK Cola data shown on page xx, open to the Cola
worksheet. Select Stat ➔ Basic Statistics ➔ 2-Sample t.
In the 2-Sample t (Test and Confidence Interval) dialog box
(shown below):

1. Click Samples in different columns and press Tab.

2. Double-click C1 Normal in the variables list to add
Normal to the First box.

3. Double-click C2 End-Aisle in the variables list to add
'End-Aisle' to the Second box.

4. Check Assume equal variances.

5. Click Graphs.

7. Back in the 2-Sample t (Test and Confidence Interval)
dialog box, click Options.

In the 2-Sample t - Options dialog box (shown below):

8. Enter 95.0 in the Confidence level box.

9. Enter 0.0 in the Test difference box.

10. Select not equal from the Alternative drop-down list
(to perform the two-tail test).

11. Click OK.

12. Back in the 2-Sample t (Test and Confidence Interval)
dialog box, click OK.

C H A P T E R 1 0 M I N I TA B G U I D E

In the 2-Sample t - Graphs dialog box (not shown):

6. Check Boxplots of data and then click OK.

7. Back in the 2-Sample t (Test and Confidence Interval)
dialog box, click OK.

For stacked data, use these replacement steps 1 through 3:

1. Click Samples in one column.

2. Enter the name of the column that contains the measure-
ment in the Samples box.

3. Enter the name of the column that contains the sample
names in the Subscripts box.

Confidence Interval Estimate for the Difference
Between Two Means

Use the instructions for the pooled-variance t test, replacing
step 7 with these steps 7 through 12:

To perform a one-tail test, select less than or greater than
in step 10.

t Test for the Difference Between Two Means,
Assuming Unequal Variances

Use the instructions for the pooled-variance t test with this
replacement step 4:

4. Clear Assume equal variances.

MG10.2 COMPARING the MEANS of TWO
RELATED POPULATIONS

Paired t Test

Use Paired t to perform the paired t test. For example, to
perform the Figure 10.9 paired t test for the textbook price
data on page 381, open to the BookPrices worksheet. Se-
lect Stat ➔ Basic Statistics ➔ Paired t. In the Paired t
(Test and Confidence Interval) dialog box (shown on the top
of page 412):

1. Click Samples in columns and press Tab.

2. Double-click C3 Bookstore in the variables list to enter
Bookstore in the First sample box.

3. Double-click C4 Online in the variables list to enter
Online in the Second sample box.

4. Click Graphs.

Chapter 10 Minitab Guide 411
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In the Paired t - Graphs dialog box (not shown):

5. Check Boxplots of differences and then click OK.

6. Back in the Paired t (Test and Confidence Interval) dia-
log box, click OK.

Confidence Interval Estimate for the Mean
Difference

Use the instructions for the paired t test, replacing step 6
with these steps 6 through 11:

6. Back in the Paired t (Test and Confidence Interval) dia-
log box, click Options.

In the Paired t - Options dialog box (not shown):

7. Enter 95.0 in the Confidence level box.

8. Enter 0.0 in the Test difference box.

9. Select not equal from the Alternative drop-down list
(to perform the two-tail test).

10. Click OK.

11. Back in the Paired t (Test and Confidence Interval) dia-
log box, click OK.

To perform a one-tail test, select less than or greater than
in step 9.

MG10.3 COMPARING the PROPORTIONS of
TWO INDEPENDENT POPULATIONS

Z Test for the Difference Between Two
Proportions

Use 2 Proportions to perform this Z test. For example, to
perform the Figure 10.13 Z test for the hotel guest satisfac-
tion survey on page 388, select Stat ➔ Basic Statistics ➔
2 Proportions. In the 2 Proportions (Test and Confidence
Interval) dialog box (shown at the top of the right column):

1. Click Summarized data.

2. In the First row, enter 163 in the Events box and 227 in
the Trials box.

3. In the Second row, enter 154 in the Events box and 262
in the Trials box.

4. Click Options.

In the 2 Proportions - Options dialog box (shown below):

5. Enter 95.0 in the Confidence level box.

6. Enter 0.0 in the Test difference box.

7. Select not equal from the Alternative drop-down list.

8. Check Use pooled estimate of p for test.

9. Click OK.

10. Back in the 2 Proportions (Test and Confidence Interval)
dialog box, click OK.

Confidence Interval Estimate for the Difference
Between Two Proportions

Use the “Z Test for the Difference Between Two Propor-
tions” instructions above to compute the confidence inter-
val estimate.

MG10.4 F TEST for the RATIO of TWO
VARIANCES

Use 2 Variances to perform this F test. For example, to per-
form the Figure 10.14 F test for the BLK Cola sales data on
page 394, open to the COLA worksheet. Select Stat ➔
Basic Statistics ➔ 2 Variances. In the 2 Variances (Test and
Confidence) dialog box (shown on page 413):

1. Select Samples in different columns from the Data
drop-down list and press Tab.

2. Double-click C1 Normal in the variables list to add
Normal to the First box.

3. Double-click C2 End-Aisle in the variables list to add
'End-Aisle' to the Second box.

4. Click Graphs.
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In the 2 Variances - Graph dialog box (not shown):
5. Clear all check boxes

6. Click OK.

7. Back in the 2 Variances (Test and Confidence) dialog
box, click OK.
For summarized data, select Sample standard deviations

or Sample variances in step 1 and enter the sample size and
the sample statistics for the two variables in lieu of steps 2 and
3. For stacked data, use these replacement steps 1 through 3:

1. Select Samples in one column from the Data drop-
down list.

2. Enter the name of the column that contains the measure-
ment in the Samples box.

3. Enter the name of the column that contains the sample
names in the Subscripts box.

If you use an older version of Minitab, you will see a 2
Variances dialog box instead of the 2 Variances (Test and
Confidence) dialog box shown and described in this section.
This older dialog box is similar to the dialog boxes shown in
the preceding three sections: You click either Samples in
different columns or Summarized data and then make en-
tries similar to the ones described in the previous sections.
The results created using older versions differ slightly from
the Minitab results shown in Figure 10.14.
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Learning Objectives
In this chapter, you learn:

• The basic concepts of experimental design

• How to use the one-way analysis of variance to test for differences among the
means of several groups

• When and how to use a randomized block design

• How to use the two-way analysis of variance and interpret the interaction effect

• How to perform multiple comparisons in a one-way analysis of variance, 
a randomized block design, and a two-way analysis of variance

Analysis of Variance11



U S I N G S TAT I S T I C S

@ Perfect Parachutes

Y ou are the production manager at the Perfect Parachutes Company. Parachutes are
woven in your factory using a synthetic fiber purchased from one of four different
suppliers. Strength of these fibers is an important characteristic that ensures quality
parachutes. You need to decide whether the synthetic fibers from each of your four
suppliers result in parachutes of equal strength. Furthermore, your factory uses two

types of looms to produce parachutes, the Jetta and the Turk. You need to establish that the parachutes
woven on both types of looms are equally strong. You also want to know if any differences in the
strength of the parachute that can be attributed to the four suppliers are dependent on the type of loom
used. How would you go about finding this information?

415
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I n Chapter 10, you used hypothesis testing to reach conclusions about possible differences
between two populations. As a manager at Perfect Parachutes, you need to design an ex-
periment to test the strength of parachutes woven from the synthetic fibers from the four

suppliers. That is, you need to evaluate differences among more than two populations, or
groups. (Populations are called groups in this chapter.)

This chapter begins by examining a completely randomized design that has one factor
(which supplier to use) and several groups (the four suppliers). The randomized block design,
which is an extension of the paired t test of Section 10.2, is discussed next. Then the com-
pletely randomized design is extended to the factorial design, in which more than one factor is
simultaneously studied in a single experiment. For example, an experiment incorporating the
four suppliers and the two types of looms would help you determine which supplier and type
of loom to use in order to manufacture the strongest parachutes. Throughout the chapter,
emphasis is placed on the assumptions behind the use of the various testing procedures.

11.1 The Completely Randomized Design: 
One-Way Analysis of Variance

In many situations, you need to examine differences among more than two groups. The groups in-
volved are classified according to levels of a factor of interest. For example, a factor such as the price
for which a product is sold may have several groups defined by numerical levels such as $0.59,
$0.79, and $0.99, and a factor such as preferred supplier for a parachute manufacturer may have sev-
eral groups defined by categorical levels such as Supplier 1, Supplier 2, Supplier 3, and Supplier 4.
When there is only one factor, the experimental design is called a completely randomized design.

One-Way ANOVA F Test for Differences Among 
More Than Two Means
When you are analyzing a numerical variable and certain assumptions are met, you use the analysis
of variance (ANOVA) to compare the means of the groups. The ANOVA procedure used for the
completely randomized design is referred to as the one-way ANOVA, and it is an extension of the
pooled variance t test for the difference between two means discussed in Section 10.1. Although
ANOVA is an acronym for analysis of variance, the term is misleading because the objective in
ANOVA is to analyze differences among the group means, not the variances. However, by analyzing
the variation among and within the groups, you can reach conclusions about possible differences in
group means. In ANOVA, the total variation is subdivided into variation that is due to differences
among the groups and variation that is due to differences within the groups (see Figure 11.1).
Within-group variation measures random variation. Among-group variation is due to differences
from group to group. The symbol c is used to indicate the number of groups.

Organize multiple-sample
data as unstacked data, one
column per group, in order to
make best use of the Excel
and Minitab procedures
that support the methods
discussed in this chapter.
For more information about
unstacked (and stacked) data,
review Section 2.3.

Partitioning the Total Variation
SST = SSA + SSW

Among-Group
Variation (SSA)

df = c – 1

Within-Group
Variation (SSW )

df = n – c

Total Variation 
(SST )

df = n – 1

F I G U R E 1 1 . 1
Partitioning the total
variation in a completely
randomized design

Assuming that the c groups represent populations whose values are randomly and inde-
pendently selected, follow a normal distribution, and have equal variances, the null hypothesis
of no differences in the population means:

is tested against the alternative that not all the c population means are equal:

H1: Not all mj are equal 1where j = 1, 2, Á , c2.

H0: m1 = m2 = Á = mc
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To perform an ANOVA test of equality of population means, you subdivide the total variation
in the values into two parts—that which is due to variation among the groups and that which is
due to variation within the groups. The total variation is represented by the sum of squares total
(SST). Because the population means of the c groups are assumed to be equal under the null hy-
pothesis, you compute the total variation among all the values by summing the squared differences
between each individual value and the grand mean, . The grand mean is the mean of all the val-
ues in all the groups combined. Equation (11.1) shows the computation of the total variation.

X

TOTAL VARIATION IN ONE-WAY ANOVA

(11.1)

where

c = number of groups

1that is, n = n1 + n2 + Á + nc2
n = total number of values in all groups combined

nj = number of values in group j

Xij = ith value in group j

X =
a

c

j=1
a
nj

i=1
Xij

n
= Grand mean

SST =a
c

j=1
a
nj

i=1
1Xij - X 22

You compute the among-group variation, usually called the sum of squares among
groups (SSA), by summing the squared differences between the sample mean of each group,

and the grand mean, weighted by the sample size, in each group. Equation (11.2)
shows the computation of the among-group variation.

nj,X ,Xj,

AMONG-GROUP VARIATION IN ONE-WAY ANOVA

(11.2)

where

X = grand mean

Xj = sample mean of group j

nj = number of values in group j

c = number of groups

SSA = a
c

j=1
nj1Xj - X 22

The within-group variation, usually called the sum of squares within groups (SSW),
measures the difference between each value and the mean of its own group and sums the
squares of these differences over all groups. Equation (11.3) shows the computation of the
within-group variation.

WITHIN-GROUP VARIATION IN ONE-WAY ANOVA

(11.3)SSW = a
c

j=1
a
nj

i=1
1Xij - Xj22
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Because you are comparing c groups, there are degrees of freedom associated with
the sum of squares among groups. Because each of the c groups contributes degrees of
freedom, there are degrees of freedom associated with the sum of squares within
groups. In addition, there are degrees of freedom associated with the sum of squares to-
tal because you are comparing each value, to the grand mean, based on all n values.

If you divide each of these sums of squares by its respective degrees of freedom, you have
three variances, which in ANOVA are called mean square terms: MSA (mean square among),
MSW (mean square within), and MST (mean square total).

X ,Xij,
n - 1

n - c
nj - 1

c - 1

Although you want to compare the means of the c groups to determine whether a differ-
ence exists among them, the name ANOVA comes from the fact that you are comparing vari-
ances. If the null hypothesis is true and there are no differences in the c group means, all three
mean squares (or variances)—MSA, MSW, and MST—provide estimates of the overall vari-
ance in the data. Thus, to test the null hypothesis:

against the alternative:

you compute the one-way ANOVA test statistic as the ratio of MSA to MSW, as in
Equation (11.5).

FSTAT

H1: Not all mj are equal 1where j = 1, 2, Á , c2

H0: m1 = m2 = Á = mc

where

X j = sample mean of group j

Xij = ith value in group j

MEAN SQUARES IN ONE-WAY ANOVA

(11.4a)

(11.4b)

(11.4c)MST =
SST

n - 1

MSW =
SSW

n - c

MSA =
SSA

c - 1

ONE-WAY ANOVA TEST STATISTIC

(11.5)FSTAT =
MSA

MSW

FSTAT

The test statistic follows an F distribution, with degrees of freedom in the
numerator and degrees of freedom in the denominator. For a given level of significance,

you reject the null hypothesis if the test statistic computed in Equation (11.5) is
greater than the upper-tail critical value, from the F distribution with degrees of
freedom in the numerator and in the denominator (see Table E.5). Thus, as shown in
Figure 11.2, the decision rule is

otherwise, do not reject H0.

Reject H0 if FSTAT 7 Fa;

n - c
c - 1Fa,

FSTATa,
n - c

c - 1FSTAT
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(1 – α)

0 FFα

α

Region of
Rejection

Region of
Nonrejection

Critical
Value

F I G U R E 1 1 . 2
Regions of rejection and
nonrejection when using
ANOVA

If the null hypothesis is true, the computed test statistic is expected to be approxi-
mately equal to 1 because both the numerator and denominator mean square terms are estimat-
ing the overall variance in the data. If is false (and there are differences in the group
means), the computed test statistic is expected to be larger than 1 because the numerator,
MSA, is estimating the differences among groups in addition to the overall variability in the
values, while the denominator, MSW, is measuring only the overall variability in the values.
Thus, when you use the ANOVA procedure, you reject the null hypothesis at a selected level of
significance, only if the computed test statistic is greater than the upper-tail criti-
cal value of the F distribution having and degrees of freedom, as illustrated in
Figure 11.2.

The results of an analysis of variance are usually displayed in an ANOVA summary
table, as shown in Table 11.1. The entries in this table include the sources of variation (i.e.,
among-groups, within-groups, and total), the degrees of freedom, the sums of squares, the
mean squares (i.e., the variances), and the computed test statistic. The p-value, the
probability of having an value as large as or larger than the one computed, given that
the null hypothesis is true, usually appears also. The p-value allows you to reach
conclusions about the null hypothesis without needing to refer to a table of critical values
of the F distribution. If the p-value is less than the chosen level of significance, , you re-
ject the null hypothesis.

a

FSTAT

FSTAT

n - cc - 1
Fa,FSTATa,

FSTAT

H0

FSTAT

T A B L E 1 1 . 1

Analysis-of-Variance
Summary Table

Source
Degrees of 
Freedom

Sum of 
Squares

Mean Square
(Variance) F

Among groups c - 1 SSA
MSA =

SSA

c - 1
FSTAT =

MSA

MSW
Within groups n - c SSW

MSW =
SSW

n - c
Total n - 1 SST

To illustrate the one-way ANOVA F test, return to the Perfect Parachutes scenario (see
page 415). You define the business problem as whether significant differences exist in the
strength of parachutes woven using synthetic fiber purchased from each of the four suppliers.
The strength of the parachutes is measured by placing them in a testing device that pulls on
both ends of a parachute until it tears apart. The amount of force required to tear the para-
chute is measured on a tensile-strength scale, where the larger the value, the stronger the
parachute.

Five parachutes are woven using the fiber supplied by each group—Supplier 1, Supplier 2,
Supplier 3, and Supplier 4. You perform the experiment of testing the strength of each of the
20 parachutes by collecting the tensile strength measurement of each parachute. Results are or-
ganized by group and stored in . Those results, along with the sample mean and the
sample standard deviation of each group are shown in Figure 11.3.

Parachute
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In Figure 11.3, observe that there are differences in the sample means for the four suppli-
ers. For Supplier 1, the mean tensile strength is 19.52. For Supplier 2, the mean tensile strength
is 24.26. For Supplier 3, the mean tensile strength is 22.84, and for Supplier 4, the mean ten-
sile strength is 21.16. What you need to determine is whether these sample results are suffi-
ciently different to conclude that the population means are not all equal.

A scatter plot or main effects plot enables you to visualize the data and see how the meas-
urements of tensile strength distribute. You can also observe differences among the groups as
well as within groups. If the sample sizes in each group were larger, you could construct stem-
and-leaf displays, boxplots, and normal probability plots.

Figure 11.4 shows an Excel scatter plot and a Minitab main effects plot for the four
suppliers.

F I G U R E 1 1 . 3
Tensile strength for
parachutes woven with
synthetic fibers from four
different suppliers, along
with the sample mean
and sample standard
deviation

F I G U R E 1 1 . 4
Excel scatter plot and Minitab main effects plot of tensile strengths for four different suppliers

The null hypothesis states that there is no difference in mean tensile strength among the
four suppliers:

The alternative hypothesis states that at least one of the suppliers differs with respect to the
mean tensile strength:

To construct the ANOVA summary table, you first compute the sample means in each
group (see Figure 11.3 above). Then you compute the grand mean by summing all 20 values
and dividing by the total number of values:

X =
a

c

j=1
a
nj

i=1
Xij

n
=

438.9
20

= 21.945

H1: Not all the means are equal.

H0: m1 = m2 = m3 = m4
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Then, using Equations (11.1) through (11.3) on page 417, you compute the sum of squares:

You compute the mean squares by dividing the sum of squares by the corresponding degrees
of freedom [see Equation (11.4) on page 418]. Because and

so that using Equation (11.5) on page 418,

For a selected level of significance, you find the upper-tail critical value, from
the F distribution using Table E.5. A portion of Table E.5 is presented in Table 11.2. In the
parachute supplier example, there are 3 degrees of freedom in the numerator and 16 de-
grees of freedom in the denominator. the upper-tail critical value at the 0.05 level of
significance, is 3.24.

Fa,

Fa,a,

FSTAT =
MSA

MSW
=

21.0952
6.0940

= 3.4616

MSW =
SSW

n - c
=

97.5040
20 - 4

= 6.0940

MSA =
SSA

c - 1
=

63.2855
4 - 1

= 21.0952

n = 20,c = 4

= 160.7895

= 118.5 - 21.94522 + 124 - 21.94522 + Á + 120.4 - 21.94522
SST = a

c

j=1
a
nj

i=1
1Xij - X 22

= 97.5040

+ 120.6 - 22.8422 + Á + 122.9 - 22.8422 + 125.4 - 21.1622 + Á + 120.4 - 21.1622
= 118.5 - 19.5222 + Á + 118 - 19.5222 + 126.3 - 24.2622 + Á + 124.5 - 24.2622

SSW = a
c

j=1
a
nj

i=1
1Xij - X j22

= 63.2855

+ (5)(22.84 - 21.945)2 + 152121.16 - 21.94522
SSA = a

c

j=1
nj 1Xj - X 22 = 152119.52 - 21.94522 + 152124.26 - 21.94522

T A B L E 1 1 . 2

Finding the Critical 
Value of F with 3 and 
16 Degrees of Freedom
at the 0.05 Level of
Significance

Cumulative Probabilities
Upper-Tail Area

Numerator df1

� 0.05
� 0.95

Denominator df2 1 2 3 4 5 6 7 8 9

. . . . . . . . . .

. . . . . . . . . .

. . . . . . . . . .
11 4.84 3.98 3.59 3.36 3.20 3.09 3.01 2.95 2.90
12 4.75 3.89 3.49 3.26 3.11 3.00 2.91 2.85 2.80
13 4.67 3.81 3.41 3.18 3.03 2.92 2.83 2.77 2.71
14 4.60 3.74 3.34 3.11 2.96 2.85 2.76 2.70 2.65
15 4.54 3.68 3.29 3.06 2.90 2.79 2.71 2.64 2.59
16 4.49 3.63 3.24 3.01 2.85 2.74 2.66 2.59 2.54

Source: Extracted from Table E.5.
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Because is greater than you reject the null hypothesis (see
Figure 11.5). You conclude that there is a significant difference in the mean tensile strength
among the four suppliers.

Fa = 3.24,FSTAT = 3.4616

0 3.24 F
.05.95

Region of
Rejection

Region of
Nonrejection

Critical
Value

F I G U R E 1 1 . 5
Regions of rejection and
nonrejection for the one-
way ANOVA at the 0.05
level of significance, with
3 and 16 degrees of
freedom

The p-value, or probability of getting a computed statistic of 3.4616 or larger when
the null hypothesis is true, is 0.0414. Because this p-value is less than the specified of 0.05,
you reject the null hypothesis. The p-value 0.0414 indicates that there is a 4.14% chance of ob-
serving differences this large or larger if the population means for the four suppliers are all
equal. After performing the one-way ANOVA and finding a significant difference among the
suppliers, you still do not know which suppliers differ. All you know is that there is sufficient
evidence to state that the population means are not all the same. In other words, one or more
population means are significantly different. To determine which suppliers differ, you can use
a multiple comparisons procedure such as the Tukey-Kramer procedure.

Multiple Comparisons: The Tukey-Kramer Procedure
In the Perfect Parachutes scenario on page 415, you used the one-way ANOVA F test to deter-
mine that there was a difference among the suppliers. The next step is to construct multiple
comparisons to determine which suppliers are different.

Although many procedures are available (see references 5, 6, and 10), this text uses the
Tukey-Kramer multiple comparisons procedure for one-way ANOVA to determine
which of the c means are significantly different. The Tukey-Kramer procedure enables you

a

FSTAT

F I G U R E 1 1 . 6
Excel and Minitab ANOVA results for the parachute experiment

Figure 11.6 shows the ANOVA results for the parachute experiment, including the p-value.
In Figure 11.6, what Table 11.1 (see page 419) labels Among Groups is labeled Between
Groups in the Excel results and Factor in the Minitab results. What Table 11.1 labels Within
Groups is labeled Error in the Minitab results.
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to simultaneously make comparisons between all pairs of groups. You use the following
four steps to construct the comparisons:

1. Compute the absolute mean differences, (where ), among all
pairs of sample means.

2. Compute the critical range for the Tukey-Kramer procedure, using Equation (11.6).

c1c - 12>2j Z j¿ƒ Xj - X j¿ ƒ

CRITICAL RANGE FOR THE TUKEY-KRAMER PROCEDURE

(11.6)

where is the upper-tail critical value from a Studentized range distribution having c
degrees of freedom in the numerator and degrees of freedom in the denominator.
(Values for the Studentized range distribution are found in Table E.7.)

n - c
Qa

Critical range = QaAMSW

2
a 1

nj
+

1
nj¿
b

If the sample sizes differ, you compute a critical range for each pairwise comparison of sample
means.

3. Compare each of the pairs of means against its corresponding critical range.
You declare a specific pair significantly different if the absolute difference in the sample
means, is greater than the critical range.

4. Interpret the results.

In the parachute example, there are four suppliers. Thus, there are pair-
wise comparisons. To apply the Tukey-Kramer multiple comparisons procedure, you first com-
pute the absolute mean differences for all six pairwise comparisons. Multiple comparisons refer
to the fact that you are simultaneously making an inference about all six of these comparisons:

1.
2.
3.
4.
5.
6.

You need to compute only one critical range because the sample sizes in the four groups
are equal. From the ANOVA summary table (Figure 11.6 on page 422), and

From Table E.7, for and the
upper-tail critical value of the test statistic, is 4.05 (see Table 11.3).

n - c = 20 - 4 = 16, Qa,a = 0.05, c = 4,nj = nj¿ = 5.
MSW = 6.094

ƒ X 3 - X 4 ƒ = ƒ22.84 - 21.16 ƒ = 1.68
ƒ X 2 - X 4 ƒ = ƒ24.26 - 21.16 ƒ = 3.10
ƒ X 2 - X 3 ƒ = ƒ24.26 - 22.84 ƒ = 1.42
ƒ X 1 - X 4 ƒ = ƒ19.52 - 21.16 ƒ = 1.64
ƒ X 1 - X 3 ƒ = ƒ19.52 - 22.84 ƒ = 3.32
ƒ X 1 - X 2 ƒ = ƒ19.52 - 24.26 ƒ = 4.74

414 - 12>2 = 6

ƒXj - Xj¿ ƒ ,

c1c - 12>2

T A B L E 1 1 . 3

Finding the Studentized
Range, Statistic for

with 4 and 16
Degrees of Freedom
a = 0.05,

Qa, Numerator df1

Upper-Tail Area � 0.05
Cumulative Probabilities � 0.95

Denominator df2 2 3 4 5 6 7 8 9

. . . . . . . . .

. . . . . . . . .

. . . . . . . . .
11 3.11 3.82 4.26 4.57 4.82 5.03 5.20 5.35
12 3.08 3.77 4.20 4.51 4.75 4.95 5.12 5.27
13 3.06 3.73 4.15 4.45 4.69 4.88 5.05 5.19
14 3.03 3.70 4.11 4.41 4.64 4.83 4.99 5.13
15 3.01 3.67 4.08 4.37 4.60 4.78 4.94 5.08
16 3.00 3.65 4.05 4.33 4.56 4.74 4.90 5.03

Source: Extracted from Table E.7.
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F I G U R E 1 1 . 7
Excel and Minitab Tukey-Kramer procedure results for the parachute experiment

From Equation (11.6),

Because there is a significant difference between the means of Suppliers 1 and
2. All other pairwise differences are less than 4.4712. With 95% confidence, you can conclude
that parachutes woven using fiber from Supplier 1 have a lower mean tensile strength than
those from Supplier 2, but there are no statistically significant differences between Suppliers 1
and 3, Suppliers 1 and 4, Suppliers 2 and 3, Suppliers 2 and 4, and Suppliers 3 and 4. Note that
by using you are able to make all six of the comparisons with an overall error rate
of only 5%. These results are shown in Figure 11.7.

a = 0.05,

4.74 7 4.4712,

Critical range = 4.05A a6.094
2
b a1

5
+

1
5
b = 4.4712

The Figure 11.7 Excel results follow the steps used on page 423 for evaluating the com-
parisons. Each mean is computed, and the absolute differences are determined, the critical
range is computed, and then each comparison is declared significant (means are different) or
not significant (means are not different). The Minitab results show the comparisons in the form
of interval estimates. Each interval is computed. Any interval that does not include 0 is consid-
ered significant. Thus, the only significant comparison is supplier 1 versus supplier 2 since its
interval 0.269 to 9.211 does not include 0.

Online Topic: The Analysis of Means (ANOM)
The analysis of means (ANOM) provides an alternative approach that allows you to determine
which, if any, of the c groups has a mean significantly different from the overall mean of all
the group means combined. To study this topic, download the ANOM online topic file that is
available in MyStatLab and on this book’s companion website. (Visit www.mystatlab.com, or
see Appendix C to learn how to access the online topic files from the companion website.)

ANOVA Assumptions
In Chapters 9 and 10, you learned about the assumptions required in order to use each hypothesis-
testing procedure and the consequences of departures from these assumptions. To use the one-way
ANOVA F test, you must make the following assumptions about the populations:

• Randomness and independence
• Normality
• Homogeneity of variance

www.mystatlab.com
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The first assumption, randomness and independence, is critically important. The validity of
any experiment depends on random sampling and/or the randomization process. To avoid biases
in the outcomes, you need to select random samples from the c groups or use the randomization
process to randomly assign the items to the c levels of the factor. Selecting a random sample, or
randomly assigning the levels, ensures that a value from one group is independent of any other
value in the experiment. Departures from this assumption can seriously affect inferences from
the ANOVA. These problems are discussed more thoroughly in references 5 and 10.

The second assumption, normality, states that the sample values in each group are from a
normally distributed population. Just as in the case of the t test, the one-way ANOVA F test is
fairly robust against departures from the normal distribution. As long as the distributions are
not extremely different from a normal distribution, the level of significance of the ANOVA F
test is usually not greatly affected, particularly for large samples. You can assess the normality
of each of the c samples by constructing a normal probability plot or a boxplot.

The third assumption, homogeneity of variance, states that the variances of the c groups
are equal (i.e., ). If you have equal sample sizes in each group, infer-
ences based on the F distribution are not seriously affected by unequal variances. However, if
you have unequal sample sizes, unequal variances can have a serious effect on inferences from
the ANOVA procedure. Thus, when possible, you should have equal sample sizes in all groups.
You can use the Levene test for homogeneity of variance presented next to test whether the
variances of the c groups are equal.

When only the normality assumption is violated, you can use the Kruskal-Wallis rank test,
a nonparametric procedure discussed in Section 12.7. When only the homogeneity-of-variance
assumption is violated, you can use procedures similar to those used in the separate-variance t
test of Section 10.1 (see references 1 and 2). When both the normality and homogeneity-of-
variance assumptions have been violated, you need to use an appropriate data transformation
that both normalizes the data and reduces the differences in variances (see reference 6) or use
a more general nonparametric procedure (see references 2 and 3).

Levene Test for Homogeneity of Variance
Although the one-way ANOVA F test is relatively robust with respect to the assumption of
equal group variances, large differences in the group variances can seriously affect the level of
significance and the power of the F test. One powerful yet simple procedure for testing the
equality of the variances is the modified Levene test (see references 1 and 7). To test for the
homogeneity of variance, you use the following null hypothesis:

against the alternative hypothesis:

To test the null hypothesis of equal variances, you first compute the absolute value of the differ-
ence between each value and the median of the group. Then you perform a one-way ANOVA on
these absolute differences. Most statisticians suggest using a level of significance of
when performing the ANOVA. To illustrate the modified Levene test, return to the Perfect Para-
chutes scenario concerning the tensile strength of parachutes first presented in Table 11.2 on
page 421. Table 11.4 summarizes the absolute differences from the median of each supplier.

a = 0.05

H1: Not alls2
j are equal 1 j = 1, 2, 3, Á , c2

H0:s
2
1 = s2

2 = Á = s2
c

s2
1 = s2

2 = Á = s2
c

T A B L E 1 1 . 4

Absolute Differences
from the Median Tensile
Strength for Four
Suppliers

Supplier 1 
(Median )� 18.5

Supplier 2 
(Median )� 24.5

Supplier 3 
(Median )� 22.9

Supplier 4 
(Median )� 20.4

ƒ18.5 - 18.5 ƒ = 0.0 ƒ26.3 - 24.5 ƒ = 1.8 ƒ20.6 - 22.9 ƒ = 2.3 ƒ25.4 - 20.4 ƒ = 5.0
ƒ24.0 - 18.5 ƒ = 5.5 ƒ25.3 - 24.5 ƒ = 0.8 ƒ25.2 - 22.9 ƒ = 2.3 ƒ19.9 - 20.4 ƒ = 0.5
ƒ17.2 - 18.5 ƒ = 1.3 ƒ24.0 - 24.5 ƒ = 0.5 ƒ20.8 - 22.9 ƒ = 2.1 ƒ22.6 - 20.4 ƒ = 2.2
ƒ19.9 - 18.5 ƒ = 1.4 ƒ21.2 - 24.5 ƒ = 3.3 ƒ 24.7 - 22.9 ƒ = 1.8 ƒ17.5 - 20.4 ƒ = 2.9
ƒ18.0 - 18.5 ƒ = 0.5 ƒ24.5 - 24.5 ƒ = 0.0 ƒ22.9 - 22.9 ƒ = 0.0 ƒ20.4 - 20.4 ƒ = 0.0



For fast-food restaurants, the drive-through window is an increasing source of revenue. The
chain that offers the fastest service is likely to attract additional customers. Each month QSR
Magazine, www.qsrmagazine.com, publishes its results of drive-through service times (from
menu board to departure) at fast-food chains. In a recent month, the mean time was 134.09
seconds for Wendy’s, 163.17 seconds for Taco Bell, 166.65 seconds for Burger King, 174.22
seconds for McDonald’s, and 194.58 seconds for KFC. Suppose the study was based on 20
customers for each fast-food chain. Table 11.5 contains the ANOVA table for this problem.

EXAMPLE 11.1
ANOVA of the
Speed of Drive-
Through Service at
Fast-Food Chains
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F I G U R E 1 1 . 8
Excel and Minitab Levene test results for the absolute differences for the parachute experiment

T A B L E 1 1 . 5

ANOVA Summary 
Table of Drive-Through
Service Times at 
Fast-Food Chains

Source
Degrees of 
Freedom

Sum of 
Squares

Mean
Squares F p-value

Among chains 4 38,191.9096 9,547.9774 73.1086 0.0000
Within chains 95 12,407.00 130.60

Using the absolute differences given in Table 11.4, you perform a one-way ANOVA (see
Figure 11.8).

From the Figure 11.8 Excel results, observe that (Excel labels this
value F. Minitab labels the value Test statistic and reports a value of 0.21.) Because

(or the ), you do not reject There is
no evidence of a significant difference among the four variances. In other words, it is rea-
sonable to assume that the materials from the four suppliers produce parachutes with an
equal amount of variability. Therefore, the homogeneity-of-variance assumption for the
ANOVA procedure is justified.

Example 11.1 illustrates another example of the one way ANOVA.

H0.p-value = 0.8902 7 0.05FSTAT = 0.2068 6 3.2389

FSTAT = 0.2068.

At the 0.05 level of significance, is there evidence of a difference in the mean drive-
through service times of the five chains?

SOLUTION

Decision rule: If p-value reject Because the p-value is virtually 0, which is
less than reject

You have sufficient evidence to conclude that the mean drive-through times of the five
chains are not all equal.

H0.a = 0.05,
H0.6 0.05,

where j = 1, 2, 3, 4, 5H1: Not all mj are equal

4 = McDonalds, 5 = KFC
where 1 = Wendy s, 2 = Taco Bell, 3 = Burger King,H0: m1 = m2 = m3 = m4 = m5

www.qsrmagazine.com
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To determine which of the means are significantly different from one another, use the
Tukey-Kramer procedure [Equation (11.6) on page 423] to establish the critical range:

Critical value of Q with 5 and 95 degrees of freedom

Any observed difference greater than 10.02 is considered significant. The mean drive-
through service times are different between Wendy’s (mean of 134.09 seconds) and each of the
other four chains and between KFC (mean of 194.58 seconds) and the other four chains. In addi-
tion, the mean drive-through service time is different between McDonald’s and Taco Bell. Thus,
with 95% confidence, you can conclude that the mean drive-through service time for Wendy’s is
faster than those of Burger King, Taco Bell, McDonald’s, and KFC. The mean drive-through
service time for KFC is slower than those of Wendy’s, Burger King, Taco Bell, McDonald’s. In
addition, the mean drive-through service time for McDonald’s is slower than for Taco Bell.

= 10.02

Critical range = QaA aMSW

2
b a 1

nj
+

1
nj¿
b = 13.922A a130.6

2
b a 1

20
+

1
20
b

L 3.92

Problems for Section 11.1
LEARNING THE BASICS
11.1 An experiment has a single factor with five groups
and seven values in each group.
a. How many degrees of freedom are there in determining

the among-group variation?
b. How many degrees of freedom are there in determining

the within-group variation?
c. How many degrees of freedom are there in determining

the total variation?

11.2 You are working with the same experiment as in
Problem 11.1.
a. If and what is SSW?
b. What is MSA?
c. What is MSW?
d. What is the value of 

11.3 You are working with the same experiment as in
Problems 11.1 and 11.2.
a. Construct the ANOVA summary table and fill in all val-

ues in the table.
b. At the 0.05 level of significance, what is the upper-tail

critical value from the F distribution?
c. State the decision rule for testing the null hypothesis that

all five groups have equal population means.
d. What is your statistical decision?

11.4 Consider an experiment with three groups, with seven
values in each.
a. How many degrees of freedom are there in determining

the among-group variation?
b. How many degrees of freedom are there in determining

the within-group variation?
c. How many degrees of freedom are there in determining

the total variation?

FSTAT?

SST = 210,SSA = 60

11.5 Consider an experiment with four groups, with eight
values in each. For the ANOVA summary table below, fill in
all the missing results:

Source
Degrees of
Freedom

Sum of 
Squares

Mean
Square

(Variance) F

Among
groups

c - 1 = ? SSA = ? MSA = 80 FSTAT = ?

Within
groups

n - c = ? SSW = 560 MSW = ?

Total n - 1 = ? SST = ?

11.6 You are working with the same experiment as in
Problem 11.5.
a. At the 0.05 level of significance, state the decision rule

for testing the null hypothesis that all four groups have
equal population means.

b. What is your statistical decision?
c. At the 0.05 level of significance, what is the upper-tail

critical value from the Studentized range distribution?
d. To perform the Tukey-Kramer procedure, what is the crit-

ical range?

APPLYING THE CONCEPTS
11.7 The Computer Anxiety Rating Scale (CARS) meas-
ures an individual’s level of computer anxiety, on a scale
from 20 (no anxiety) to 100 (highest level of anxiety).
Researchers at Miami University administered CARS to
172 business students. One of the objectives of the study was
to determine whether there are differences in the amount of
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computer anxiety experienced by students with different ma-
jors. They found the following:

a. At the 0.05 level of significance, is there evidence of a
difference in the mean waiting times in the four locations?

b. If appropriate, determine which locations differ in mean
waiting time.

c. At the 0.05 level of significance, is there evidence of a
difference in the variation in waiting time among the four
locations?

11.10 A manufacturer of pens has hired an advertising
agency to develop an advertising campaign for the upcoming
holiday season. To prepare for this project, the research director
decides to initiate a study of the effect of advertising on prod-
uct perception. An experiment is designed to compare five dif-
ferent advertisements. Advertisement A greatly undersells the
pen’s characteristics. Advertisement B slightly undersells
the pen’s characteristics. Advertisement C slightly oversells the
pen’s characteristics. Advertisement D greatly oversells the
pen’s characteristics. Advertisement E attempts to correctly
state the pen’s characteristics. A sample of 30 adult respon-
dents, taken from a larger focus group, is randomly assigned to
the five advertisements (so that there are 6 respondents to
each). After reading the advertisement and developing a sense
of “product expectation,” all respondents unknowingly receive
the same pen to evaluate. The respondents are permitted to test
the pen and the plausibility of the advertising copy. The respon-
dents are then asked to rate the pen from 1 to 7 (lowest to high-
est) on the product characteristic scales of appearance,
durability, and writing performance. The combined scores of
three ratings (appearance, durability, and writing performance)
for the 30 respondents (stored in ) are as follows:Pen

Source
Degrees of
Freedom

Sum of
Squares

Mean
Squares F

Among majors 5 3,172
Within majors 166 21,246

Total 171 24,418

Major n Mean

Marketing 19 44.37
Management 11 43.18
Other 14 42.21
Finance 45 41.80
Accountancy 36 37.56
MIS 47 32.21

Source: Data Extracted from T. Broome and D. Havelka, “Determinants
of Computer Anxiety in Business Students,” The Review of Business
Information Systems, Spring 2002, 6(2), pp. 9–16.

a. Complete the ANOVA summary table.
b. At the 0.05 level of significance, is there evidence of a

difference in the mean computer anxiety experienced by
different majors?

c. If the results in (b) indicate that it is appropriate, use the
Tukey-Kramer procedure to determine which majors dif-
fer in mean computer anxiety. Discuss your findings.

11.8 Students in a business statistics course per-
formed a completely randomized design to test the

strength of four brands of trash bags. One-pound weights were
placed into a bag, one at a time, until the bag broke. A total of
40 bags, 10 for each brand, were used. The data in
give the weight (in pounds) required to break the trash bags.
a. At the 0.05 level of significance, is there evidence of a dif-

ference in the mean strength of the four brands of trash bags?
b. If appropriate, determine which brands differ in mean

strength.
c. At the 0.05 level of significance, is there evidence of a

difference in the variation in strength among the four
brands of trash bags?

d. Which brand(s) should you buy, and which brand(s)
should you avoid? Explain.

11.9 A hospital conducted a study of the waiting time in its
emergency room. The hospital has a main campus and three
satellite locations. Management had a business objective of
reducing waiting time for emergency room cases that did
not require immediate attention. To study this, a random
sample of 15 emergency room cases that did not require im-
mediate attention at each location were selected on a partic-
ular day, and the waiting time (measured from check-in to
when the patient was called into the clinic area) was meas-
ured. The results are stored in .ERWaiting

Trashbags

SELF
Test

A B C D E

15 16 8 5 12
18 17 7 6 19
17 21 10 13 18
19 16 15 11 12
19 19 14 9 17
20 17 14 10 14

a. At the 0.05 level of significance, is there evidence of a
difference in the mean rating of the pens following exposure
to five advertisements?

b. If appropriate, determine which advertisements differ in
mean ratings.

c. At the 0.05 level of significance, is there evidence of a
difference in the variation in ratings among the five
advertisements?

d. Which advertisement(s) should you use, and which ad-
vertisement(s) should you avoid? Explain.

11.11 The per-store daily customer count (i.e., the mean num-
ber of customers in a store in one day) for a nationwide conven-
ience store chain that operates nearly 10,000 stores has been
steady, at 900, for some time. To increase the customer count,
the chain is considering cutting prices for coffee beverages. The
question to be determined is how much to cut prices to increase
the daily customer count without reducing the gross margin on
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coffee sales too much.You decide to carry out an experiment in
a sample of 24 stores where customer counts have been run-
ning almost exactly at the national average of 900. In 6 of the
stores, the price of a small coffee will now be $0.59, in 6 stores
the price of a small coffee will now be $0.69, in 6 stores, the
price of a small coffee will now be $0.79, and in 6 stores, the
price of a small coffee will now be $0.89. After four weeks of
selling the coffee at the new price, the daily customer count in
the stores was recorded and stored in .
a. At the 0.05 level of significance, is there evidence of a

difference in the daily customer count based on the price
of a small coffee?

b. If appropriate, determine which prices differ in daily cus-
tomer counts.

c. At the 0.05 level of significance, is there evidence of a
difference in the variation in daily customer count among
the different prices?

d. What effect does your result in (c) have on the validity of
the results in (a) and (b)?

11.12 Integrated circuits are manufactured on silicon wafers
through a process that involves a series of steps. An experiment
was carried out to study the effect on the yield of using three
methods in the cleansing step (coded to maintain confidential-
ity). The results (stored in ) are as follows:Yield-OneWay

CoffeeSales

of the cats was then presented with 3 ounces of the selected
food in a dish at feeding time. The researchers defined the vari-
able to be measured as the number of ounces of food that the
cat consumed within a 10-minute time interval that began when
the filled dish was presented. The results for this experiment
are summarized in the following table and stored in .CatFood

New1 New2 Standard

38 29 31
34 35 23
38 34 38
34 20 29
19 35 32
28 37 30

Source: Data Extracted from J. Ramirez and W. Taam, “An Autologistic
Model for Integrated Circuit Manufacturing,” Journal of Quality
Technology, 2000, 32, pp. 254–262.

a. At the 0.05 level of significance, is there evidence of a
difference in the mean yield among the methods used in
the cleansing steps?

b. If appropriate, determine which methods differ in mean
yields.

c. At the 0.05 level of significance, is there evidence of a differ-
ence in the variation in yields among the different methods?

d. What effect does your result in (c) have on the validity of
the results in (a) and (b)?

11.13 A pet food company has a business objective of ex-
panding its product line beyond its current kidney- and
shrimp-based cat foods. The company developed two new
products, one based on chicken livers and the other based on
salmon. The company conducted an experiment to compare
the two new products with its two existing ones, as well as a
generic beef-based product sold in a supermarket chain.

For the experiment, a sample of 50 cats from the popula-
tion at a local animal shelter was selected. Ten cats were ran-
domly assigned to each of the five products being tested. Each

Kidney Shrimp Chicken Liver Salmon Beef

2.37 2.26 2.29 1.79 2.09
2.62 2.69 2.23 2.33 1.87
2.31 2.25 2.41 1.96 1.67
2.47 2.45 2.68 2.05 1.64
2.59 2.34 2.25 2.26 2.16
2.62 2.37 2.17 2.24 1.75
2.34 2.22 2.37 1.96 1.18
2.47 2.56 2.26 1.58 1.92
2.45 2.36 2.45 2.18 1.32
2.32 2.59 2.57 1.93 1.94

a. At the 0.05 level of significance, is there evidence of a
difference in the mean amount of food eaten among the
various products?

b. If appropriate, which products appear to differ signifi-
cantly in the mean amount of food eaten?

c. At the 0.05 level of significance, is there evidence of a
significant difference in the variation in the amount of
food eaten among the various products?

d. What should the pet food company conclude? Fully describe
the pet food company’s options with respect to the products.

11.14 A sporting goods manufacturing company wanted
to compare the distance traveled by golf balls produced us-
ing four different designs. Ten balls were manufactured with
each design and were brought to the local golf course for the
club professional to test. The order in which the balls were
hit with the same club from the first tee was randomized so
that the pro did not know which type of ball was being hit.
All 40 balls were hit in a short period of time, during which
the environmental conditions were essentially the same. The
results (distance traveled in yards) for the four designs are
stored in and shown in the following table.Golfball

Design

1 2 3 4

206.32 217.08 226.77 230.55
207.94 221.43 224.79 227.95
206.19 218.04 229.75 231.84
204.45 224.13 228.51 224.87
209.65 211.82 221.44 229.49
203.81 213.90 223.85 231.10
206.75 221.28 223.97 221.53
205.68 229.43 234.30 235.45
204.49 213.54 219.50 228.35
210.86 214.51 233.00 225.09
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a. At the 0.05 level of significance, is there evidence of a
difference in the mean distances traveled by the golf balls
with different designs?

b. If the results in (a) indicate that it is appropriate, use the
Tukey-Kramer procedure to determine which designs
differ in mean distances.

c. What assumptions are necessary in (a)?
d. At the 0.05 level of significance, is there evidence of a

difference in the variation of the distances traveled by the
golf balls with different designs?

e. What golf ball design should the manufacturing manager
choose? Explain.

11.2 The Randomized Block Design
Section 11.1 discussed how to use the one-way ANOVA F test to evaluate differences among
the means of more than two independent groups. Section 10.2 discussed how to use the paired
t test to evaluate the difference between the means of two groups when you had repeated meas-
urements or matched samples. The randomized block design evaluates differences among
more than two groups that contain matched samples or repeated measures that have been
placed in blocks. Blocks are heterogeneous sets of items or individuals that have been either
matched or on whom repeated measurements have been taken. Blocking removes as much
variability as possible from the measure of random error so that the differences among the
groups are more evident.

Although blocks are used in a randomized block design, the focus of the analysis is on the
differences among the different groups. As is the case in completely randomized designs,
groups are often different levels pertaining to a factor of interest. A randomized block design
is often more efficient statistically than a completely randomized design and therefore pro-
duces more precise results (see references 5, 6, and 10). For example, if the factor of interest is
advertising medium, three groups could be subject to the following different levels: television,
radio, and newspaper. Different cities could be used as blocks. The variability among the dif-
ferent cities is therefore removed from the random error in order to better detect differences
among the three advertising mediums.

To compare a completely randomized design with a randomized block design, return to
the Perfect Parachutes scenario on page 415. Suppose that a completely randomized design is
used with 12 parachutes woven during a 24-hour period. Any variability among the shifts of
workers becomes part of the random error, and therefore differences among the four suppliers
might be difficult to detect. To reduce the random error, a randomized block experiment is de-
signed, in which three shifts of workers are used and four parachutes are woven during each
shift (one parachute using fibers from Supplier 1, one parachute using fibers from Supplier 2,
etc.). The three shifts are considered blocks, but the factor of interest is still the four suppliers.
The advantage of the randomized block design is that the variability among the three shifts is
removed from the random error. Therefore, this design should provide more precise results
concerning differences among the four suppliers.

Testing for Factor and Block Effects
Recall from Figure 11.1 on page 416 that, in the completely randomized design, the total vari-
ation (SST) is subdivided into variation due to differences among the c groups (SSA) and varia-
tion due to differences within the c groups (SSW). Within-group variation is considered
random variation, and among-group variation is due to differences from group to group.

To remove the effects of the blocking from the random variation component in the ran-
domized block design, the within-group variation (SSW) is subdivided into variation due to
differences among the blocks (SSBL) and random variation (SSE). Therefore, as presented in
Figure 11.9, in a randomized block design, the total variation is the sum of three components:
among-group variation (SSA), among-block variation (SSBL), and random variation (SSE).



11.2 The Randomized Block Design 431

Partitioning the Total Variation
SST = SSA + SSBL + SSE

Among-Group Variation (SSA)
d.f. = c – 1

Among-Block Variation (SSBL)
d.f. = r – 1

Random Variation (SSE)
d.f. = (r – 1) (c – 1)

Total Variation (SST)
d.f. = n – 1

F I G U R E 1 1 . 9
Partitioning the total
variation in a randomized
block model

The following definitions are needed to develop the ANOVA procedure for the random-
ized block design:

The total variation, also called sum of squares total (SST), is a measure of the variation
among all the values. You compute SST by summing the squared differences between each in-
dividual value and the grand mean, that is based on all n values. Equation (11.7) shows the
computation for total variation.

X ,

a
c

j=1
a

r

i=1
Xij = grand total

X .j = mean of all the values for group j

Xi. = mean of all the values in block i

Xij = value in the ith block for the jth group

n = total number of values 1where n = rc2
c = number of groups

r = number of blocks

TOTAL VARIATION IN THE RANDOMIZED BLOCK DESIGN

(11.7)

where

(

(

i.e., the grand mean)

)

X =
a

c

j=1
a

r

i=1
Xij

rc

SST =a
c

j=1
a

r

i=1
1Xij - X 22

You compute the among-group variation, also called the sum of squares among groups
(SSA), by summing the squared differences between the sample mean of each group, and
the grand mean, weighted by the number of blocks, r. Equation (11.8) shows the computa-
tion for the among-group variation.

X ,
X .j,

AMONG-GROUP VARIATION IN THE RANDOMIZED BLOCK DESIGN

(11.8)

where

X .j =
a

r

i=1
Xij

r

SSA = ra
c

j=1
1X .j - X22
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You compute the among-block variation, also called the sum of squares among blocks
(SSBL), by summing the squared differences between the mean of each block, and the
grand mean, weighted by the number of groups, c. Equation (11.9) shows the computation
for the among-block variation.

X ,
Xi.,

AMONG-BLOCK VARIATION IN THE RANDOMIZED BLOCK DESIGN

(11.9)

where

Xi. =
a

c

j=1
Xij

c

SSBL = ca
r

i=1
1Xi. - X22

You compute the random variation, also called the sum of squares error (SSE), by sum-
ming the squared differences among all the values after the effect of the groups and blocks
have been accounted for. Equation (11.10) shows the computation for random variation.

RANDOM VARIATION IN THE RANDOMIZED BLOCK DESIGN

(11.10)SSE = a
c

j=1
a

r

i=1
1Xij - X .j - Xi. + X22

Because you are comparing c groups, there are degrees of freedom associated with
the sum of squares among groups (SSA). Similarly, because there are r blocks, there are
degrees of freedom associated with the sum of squares among blocks (SSBL). Moreover, there
are degrees of freedom associated with the sum of squares total (SST) because you
are comparing each value, to the grand mean, based on all n values. Therefore, because
the degrees of freedom for each source of variation must add to the degrees of freedom for the
total variation, you compute the degrees of freedom for the sum of squares error (SSE) compo-
nent by subtraction and algebraic manipulation. Thus, the degrees of freedom associated with
the sum of squares error is 

If you divide each of the sum of squares by its associated degrees of freedom, you have
the three variances, or mean square terms (MSA, MSBL, and MSE). Equations (11.11a–c) pro-
vide the mean square terms needed for the ANOVA table.

1r - 121c - 12.

X ,Xij,
n - 1

r - 1
c - 1

MEAN SQUARES IN THE RANDOMIZED BLOCK DESIGN

(11.11a)

(11.11b)

(11.11c)MSE =
SSE

1r - 121c - 12

MSBL =
SSBL

r - 1

MSA =
SSA

c - 1

In a randomized block design you first test for a factor effect—that is, you test for any dif-
ferences among the c group means. If the assumptions of the analysis of variance are valid, the
null hypothesis of no differences in the c group means:
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is tested against the alternative that not all the c group means are equal:

by computing the test statistic given in Equation (11.12).FSTAT

H1: Not all m.j are equal 1where j = 1, 2, Á , c2

H: m.1 = m.2 = Á = m.c

FSTAT STATISTIC FOR FACTOR EFFECT

(11.12)FSTAT =
MSA

MSE

The test statistic follows an F distribution with degrees of freedom for the
MSA term and degrees of freedom for the MSE term. For a given level of sig-
nificance you reject the null hypothesis if the computed test statistic is greater than
the upper-tail critical value, from the F distribution with and de-
grees of freedom (see Table E.5). The decision rule is:

To examine whether the randomized block design was advantageous to use as compared
to a completely randomized design, some statisticians suggest that you perform the F test for
block effects. The null hypothesis of no block effects:

is tested against the alternative:

using the test statistic for block effect given in Equation (11.13).FSTAT

H1: Not all mi. are equal 1where i = 1, 2, Á , r2

H0: m1. = m2. = Á = mr.

otherwise, do not reject H0.

Reject H0 if FSTAT 7 Fa;

1r - 121c - 12c - 1Fa,
FSTATa,

1r - 121c - 12 c - 1FSTAT

FSTAT STATISTIC FOR BLOCK EFFECT

(11.13)FSTAT =
MSBL

MSE

You reject the null hypothesis at the level of significance if the computed test sta-
tistic is greater than the upper-tail critical value from the F distribution with and

degrees of freedom (see Table E.5). That is, the decision rule is

The results of the analysis-of-variance procedure are usually displayed in an ANOVA sum-
mary table, as shown in Table 11.6.

otherwise, do not reject H0.

Reject H0 if FSTAT 7 Fa;

1r - 121c - 12 r - 1Fa
FSTATa

T A B L E 1 1 . 6

Analysis-of-Variance
Table for the
Randomized Block
Design

Source
Degrees of 
Freedom

Sum of 
Squares

Mean Square
(Variance) F

Among
groups (A)

c - 1 SSA
MSA =

SSA

c - 1
FSTAT =

MSA

MSE
Among
blocks (BL)

r - 1 SSBL
MSBL =

SSBL

r - 1
FSTAT =

MSBL

MSE

Error (r – 1)(c -1) SSE MSE =
SSE

1r - 121c - 12
Total rc - 1 SST
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To illustrate the randomized block design, suppose that the customer service director for a
fast-food chain has the business objective of wanting to improve service at four restaurants in
the chain. The customer service director hires six evaluators with varied experiences in food-
service evaluations to act as raters of service at the four restaurants. To reduce the effect of the
variability from rater to rater, you use a randomized block design, with raters serving as the
blocks. The four restaurants are the groups of interest.

The six raters evaluate the service at each of the four restaurants in a random order. A rating
scale from 0 (low) to 100 (high) is used. Table 11.7 summarizes the results (stored in ),
along with the group totals, group means, block totals, block means, grand total, and grand mean.

FFChain

T A B L E 1 1 . 7

Ratings at Four
Restaurants of a 
Fast-Food Chain

RESTAURANTS

RATERS A B C D Totals Means

1 70 61 82 74 287 71.75
2 77 75 88 76 316 79.00
3 76 67 90 80 313 78.25
4 80 63 96 76 315 78.75
5 84 66 92 84 326 81.50
6 78 68 98 86 330 82.50

Totals 465 400 546 476 1,887
Means 77.50 66.67 91.00 79.33 78.625

In addition, from Table 11.7,

and

Figure 11.10 shows the results for this randomized block design.

X =
a

c

j=1
a

r

i=1
Xij

rc
=

1,887

24
= 78.625

r = 6 c = 4 n = rc = 24

F I G U R E 1 1 . 1 0
Excel and Minitab randomized block design results for the fast-food chain study
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Because or because the you re-
ject and conclude that there is evidence of a difference in the mean ratings among the
different restaurants. The extremely small p-value indicates that if the means from the four
restaurants are equal, there is virtually no chance that you will get differences as large or larger
among the sample means, as observed in this study. You conclude that the mean ratings among
the four restaurants are different.

As a check on the effectiveness of blocking, you can test for a difference among the raters.
The decision rule, using the 0.05 level of significance, is to reject the null hypothesis

if the computed test statistic is greater than 2.90, the upper-
tail critical value from the F distribution with 5 and 15 degrees of freedom (see Figure 11.12).

FSTAT1H0: m1. = m2. = Á = m6.2

H0

p-value = 0.000 6 0.05,FSTAT = 39.7581 7 Fa = 3.29,

Region of
Rejection

Region of
Nonrejection

Critical
Value

0 2.90 F
.05.95

F I G U R E 1 1 . 1 2
Regions of rejection and
nonrejection for the fast-
food chain study at the
0.05 level of significance
with 5 and 15 degrees of
freedom

0 3.29 F
.05.95

Region of
Rejection

Region of
Nonrejection

Critical
Value

F I G U R E 1 1 . 1 1
Regions of rejection and
nonrejection for the fast-
food chain study at the
0.05 level of significance
with 3 and 15 degrees of
freedom

Because or because the you re-
ject and conclude that there is evidence of a difference among the raters. Thus, you
conclude that the blocking has been advantageous in reducing the random error.

To measure the increase in precision from blocking, you use Equation (11.14) to calculate
the estimated relative efficiency (RE) of the randomized block design as compared with the
completely randomized design.

H0

p-value = 0.0205 6 0.05,FSTAT = 3.7818 7 Fa = 2.90

ESTIMATED RELATIVE EFFICIENCY

(11.14)RE =
1r - 12MSBL + r1c - 12MSE

1rc - 12MSE

Using Figure 11.12,

A relative efficiency of 1.6 means that it would take 1.6 times as many observations in a one-
way ANOVA design as compared to the randomized block design in order to have the same
precision in comparing the restaurants.

The assumptions of the one-way analysis of variance (randomness and independence,
normality, and homogeneity of variance) also apply to the randomized block design. If the

RE =
152156.6752 + 162132114.9862

1232114.9862 = 1.60

Using the 0.05 level of significance to test for differences among the restaurants, you
reject the null hypothesis if the computed test statistic is
greater than 3.29, the upper-tail critical value from the F distribution with 3 and 15 degrees of
freedom in the numerator and denominator, respectively (see Figure 11.11).

FSTAT1H0: m.1 = m.2 = m.3 = m.42
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normality assumption is violated, you can use the Friedman rank test (see Online Section 12.9).
In addition, you need to assume that there is no interacting effect between the groups and the
blocks. In other words, you need to assume that any differences between the groups (the restau-
rants) are consistent across the entire set of blocks (the raters). The concept of interaction is dis-
cussed further in Section 11.3.

Multiple Comparisons: The Tukey Procedure
As in the case of the completely randomized design, once you reject the null hypothesis of no
differences between the groups, you need to determine which groups are significantly different
from the others. For the randomized block design, you can use a procedure developed by Tukey
(see reference 10). Equation (11.15) gives the critical range for the Tukey multiple comparisons
procedure for randomized block designs.

CRITICAL RANGE FOR THE RANDOMIZED BLOCK DESIGN

(11.15)

where is the upper-tail critical value from a Studentized range distribution having c
degrees of freedom in the numerator and degrees of freedom in the
denominator. Values for the Studentized range distribution are found in Table E.7.

1r - 121c - 12Qa

Critical range = QaAMSE
r

To perform the multiple comparisons, you do the following:

1. Compute the absolute mean differences, (where ), among all
pairs of sample means.

2. Compute the critical range for the Tukey procedure using Equation (11.15).
3. Compare each of the pairs against the critical range. If the absolute difference

in a specific pair of sample means, such as is greater than the critical range,
then group j and group are significantly different.

4. Interpret the results.

To apply the Tukey procedure, return to the fast-food chain study. Because there are four
restaurants, there are possible pairwise comparisons. From Figure 11.10 on
page 434, the absolute mean differences are

1.
2.
3.
4.
5.
6.

Locate and in Figure 11.10 to determine the critical range. From
Table E.7 the upper-tail critical value of
the test statistic with 4 and 15 degrees of freedom, is 4.08. Using Equation (11.15),

All pairwise comparisons except are greater than the critical range. Therefore, you
conclude with 95% confidence that there is evidence of a significant difference in the mean rating
between all pairs of restaurant branches except for branches A and D. In addition, branch C has
the highest ratings (i.e., is most preferred), and branch B has the lowest (i.e., is least preferred).

|X .1 - X .4|

Critical range = 4.08A14.986
6

= 6.448

3for a = .05, c = 4, and 1r - 121c - 12 = 154, Qa,
r = 6MSE = 14.986

|X .3 - X .4| = |91.00 - 79.33| = 11.67
|X .2 - X .4| = |66.67 - 79.33| = 12.66
|X .2 - X .3| = |66.67 - 91.00| = 24.33
|X .1 - X .4| = |77.50 - 79.33| =  1.83
|X .1 - X .3| = |77.50 - 91.00| = 13.50
|X .1 - X .2| = |77.50 - 66.67| = 10.83

414 - 12>2 = 6

j¿
|X .j - X .j¿|,

c1c - 12>2

c1c - 12>2j Z j¿ƒX .J - X.J¿ ƒ
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Problems for Section 11.2
LEARNING THE BASICS
11.15 Given a randomized block experiment with five
groups and seven blocks, answer the following:
a. How many degrees of freedom are there in determining

the among-group variation?
b. How many degrees of freedom are there in determining

the among-block variation?
c. How many degrees of freedom are there in determining

the random variation?
d. How many degrees of freedom are there in determining

the total variation?

11.16 From Problem 11.15, if and

a. what is SSE?
b. what are MSA, MSBL, and MSE?
c. what is the value of the test statistic for the factor

effect?
d. what is the value of the test statistic for the block

effect?

11.17 From Problems 11.15 and 11.16,
a. construct the ANOVA summary table and fill in all val-

ues in the body of the table.
b. at the 0.05 level of significance, is there evidence of a

difference in the group means?
c. at the 0.05 level of significance, is there evidence of a

difference due to blocks?

11.18 From Problems 11.15, 11.16, and 11.17,
a. to perform the Tukey procedure, how many degrees of

freedom are there in the numerator, and how many
degrees of freedom are there in the denominator of the
Studentized range distribution?

b. at the 0.05 level of significance, what is the upper-tail
critical value from the Studentized range distribution?

c. to perform the Tukey procedure, what is the critical range?

11.19 Given a randomized block experiment with three
groups and seven blocks,
a. how many degrees of freedom are there in determining the

among-group variation?
b. how many degrees of freedom are there in determining

the among-block variation?
c. how many degrees of freedom are there in determining

the random variation?
d. how many degrees of freedom are there in determining

the total variation?

11.20 From Problem 11.19, if and the random-
ized block statistic is 6.0,
a. what are MSE and SSE?
b. what is SSBL if the test statistic for block effect is 4.0?FSTAT

FSTAT

SSA = 36

FSTAT

FSTAT

SST = 210,
SSA = 60, SSBL = 75,

c. what is SST?
d. at the 0.01 level of significance, is there evidence of an

effect due to groups, and is there evidence of an effect
due to blocks?

11.21 Given a randomized block experiment with four
groups and eight blocks, in the following ANOVA summary
table, fill in all the missing results.

Source
Degrees of 
Freedom

Sum
of Squares

Mean
Square

(Variance) F

Among
groups c - 1 = ? SSA = ? MSA = 80 FSTAT = ?
Among
blocks r - 1 = ? SSBL = 540 MSBL = ? FSTAT = 5.0
Error 1r - 12(c - 1) SSE = ? MSE = ?
Total rc - 1 = ? SST = ?

11.22 From Problem 11.21,
a. at the 0.05 level of significance, is there evidence of a

difference among the four group means?
b. at the 0.05 level of significance, is there evidence of an

effect due to blocks?

APPLYING THE CONCEPTS
11.23 Nine experts rated four brands of Colombian cof-
fee in a taste-testing experiment. A rating on a 7-point
scale
is given for each of four characteristics: taste, aroma, rich-
ness, and acidity. The following data (stored in ) dis-
play the summated ratings, accumulated over all four
characteristics.

Coffee

11 = extremely unpleasing, 7 = extremely pleasing2

BRAND

EXPERT A B C D

C.C. 24 26 25 22
S.E. 27 27 26 24
E.G. 19 22 20 16
B.L. 24 27 25 23
C.M. 22 25 22 21
C.N. 26 27 24 24
G.N. 27 26 22 23
R.M. 25 27 24 21
P.V. 22 23 20 19

At the 0.05 level of significance, completely analyze the
data to determine whether there is evidence of a difference
in the summated ratings of the four brands of Colombian
coffee and, if so, which of the brands are rated highest (i.e.,
best). What can you conclude?
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11.24 Which cell phone service has the highest
rating? The data in represent the mean

ratings for Verizon, AT&T, T-Mobile, and Sprint in 19 dif-
ferent cities.
Source: Data extracted from “Best Cell-Phone Service,” Consumer
Reports, January 2009, pp. 28–32.

a. At the 0.05 level of significance, determine whether
there is evidence of a difference in the mean cell rating
for the four cell phone services.

b. If appropriate, use the Tukey procedure to determine
which cell phone services’ mean ratings differ. Again, use
a 0.05 level of significance.

11.25 How different are the rates of return of money
market accounts and certificates of deposit that vary in
length of their term? The data in contain these
rates for banks in a suburban area. (Data extracted from
“Consumer Money Rates,” Newsday, June 24, 2010, p. A43.)
a. At the 0.05 level of significance, determine whether

there is evidence of a difference in the mean rates for
these investments.

b. What assumptions are necessary to perform this test?
c. If appropriate, use the Tukey procedure to determine

which investments differ.
d. Do you think that there was a significant block effect in

this experiment? Explain.

11.26 Is there a difference in the prices if you shop as an
impulsive shopper, if you shop as a savvy shopper, if you
shop at a warehouse club such as Costco, or if you purchase
store brands? To investigate this, a random sample of 10 pur-
chases was selected, and the prices were compared. (Data ex-
tracted from “Shop Smart and Save Big,” Consumer Reports,
May 2009, p. 17.) The prices for the products are stored in

.
a. At the 0.05 level of significance, is there evidence of a dif-

ference between the mean price of an impulsive shopper, a
savvy shopper, a shopper at a warehouse club such as
Costco, or a purchaser of store brands?

b. What assumptions are necessary to perform this test?
c. If appropriate, use the Tukey procedure to determine

which types of shopping differ. 1Use a = 0.05.2

Shopping2

1Use a = 0.05.2

MMCD Rate

CellRating
SELF
Test

d. Do you think that there was a significant block effect in
this experiment? Explain.

11.27 Philips Semiconductors is a leading European
manufacturer of integrated circuits. Integrated circuits are
produced on silicon wafers, which are ground to target
thickness early in the production process. The wafers are
positioned in different locations on a grinder and kept in
place using vacuum decompression. One of the goals of
process improvement is to reduce the variability in the
thickness of the wafers in different positions and in differ-
ent batches. Data were collected from a sample of
30 batches. In each batch, the thickness of the wafers on
positions 1 and 2 (outer circle), 18 and 19 (middle circle),
and 28 (inner circle) was measured and stored in .
At the 0.01 level of significance, completely analyze the
data to determine whether there is evidence of a difference
in the mean thickness of the wafers for the five positions
and, if so, which of the positions are different. What can
you conclude?
Source: Data extracted from K. C. B. Roes and R. J. M. M. Does,
“Shewhart-Type Charts in Nonstandard Situations,” Technometrics,
37, 1995, pp. 15–24.

11.28 The data in represent the compressive
strength in thousands of pounds per square inch of 40 sam-
ples of concrete taken 2, 7, and 28 days after pouring.
Source: Data extracted from O. Carrillo-Gamboa and R. F. Gunst,
“Measurement-Error-Model Collinearities,” Technometrics, 34, 1992,
pp. 454–464.

a. At the 0.05 level of significance, is there evidence of a
difference in the mean compressive strength after 2, 7,
and 28 days?

b. If appropriate, use the Tukey procedure to determine the days
that differ in mean compressive strength.

c. Determine the relative efficiency of the randomized
block design as compared with the completely random-
ized (one-way ANOVA) design.

d. Construct boxplots of the compressive strength for the
different time periods.

e. Based on the results of (a), (b), and (d), is there a pattern
in the compressive strength over the three time periods?

1Use a = 0.05.2

Concrete2

Circuits

11.3 The Factorial Design: Two-Way Analysis of Variance
In Section 11.1, you learned about the completely randomized design. In this section, the
single-factor completely randomized design is extended to the two-factor factorial design, in
which two factors are simultaneously evaluated. Each factor is evaluated at two or more levels.
For example, in the Perfect Parachutes scenario on page 415, the company faces the business
problem of simultaneously evaluating four suppliers and two types of looms to determine
which supplier and which loom produce the strongest parachutes. Although this section uses
only two factors, factorial designs for three or more factors are also possible (see references 4,
5, 6, 7, and 10).
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To analyze data from a two-factor factorial design, you use two-way ANOVA. The
following definitions are needed to develop the two-way ANOVA procedure:

Xij. =
a
n¿

k=1
Xijk

n¿
= mean of the cell ij, the combination of the ith level of factor A

X .j. =
a

r

i=1
a
n¿

k=1
Xijk

rn¿
= mean of the jth level of factor B 1where j = 1, 2, Á , c2

Xi.. =
a

c

j=1
a
n¿

k=1
Xijk

cn¿
= mean of the ith level of factor A 1where i = 1, 2, Á , r2

X =
a

r

i=1
a

c

j=1
a
n¿

k=1
Xijk

rcn¿
= grand mean

Xijk = value of the kth observation for level i of factor A and level j of factor B

n = number of values in the entire experiment 1where n = rcn¿2
of factor A and a particular level of factor B)

n¿ = number of values (replicates2 for each cell (combination of a particular level

c = number of levels of factor B

r = number of levels of factor A

Partitioning the Total Variation
SST = SSA + SSB  + SSAB + SSE

Factor A Variation (SSA)
df = r – 1 

Factor B Variation (SSB)
df = c – 1 

Interaction (SSAB)
df = (r – 1)(c – 1)

Random Variation (SSE)
df = rc (n′ – 1) 

Total Variation (SST)
df = n – 1 

F I G U R E 1 1 . 1 3
Partitioning the total
variation in a two-factor
factorial design

Because of the complexity of these computations, you should use only computerized
methods when performing this analysis. However, to help explain the two-way ANOVA, the
decomposition of the total variation is illustrated. In this discussion, only cases in which there
are an equal number of replicates (sample sizes ) for each combination of the levels of fac-
tor A with those of factor B are considered. (See references 1 and 6 for a discussion of two-
factor factorial designs with unequal sample sizes.)

Testing for Factor and Interaction Effects
There is an interaction between factors A and B if the effect of factor A is dependent on the
level of factor B. Thus, when dividing the total variation into different sources of variation, you
need to account for a possible interaction effect, as well as for factor A, factor B, and random
error. To accomplish this, the total variation (SST) is subdivided into sum of squares due to fac-
tor A (or SSA), sum of squares due to factor B (or SSB), sum of squares due to the interaction
effect of A and B (or SSAB), and sum of squares due to random variation (or SSE). This
decomposition of the total variation (SST) is displayed in Figure 11.13.

n¿

and the jth level of factor B
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The sum of squares total (SST) represents the total variation among all the values around
the grand mean. Equation (11.16) shows the computation for total variation.

TOTAL VARIATION IN TWO-WAY ANOVA

(11.16)SST = a
r

i=1
a

c

j=1
a
n¿

k=1
1Xijk - X 22

The sum of squares due to factor A (SSA) represents the differences among the various
levels of factor A and the grand mean. Equation (11.17) shows the computation for factor A
variation.

FACTOR A VARIATION

(11.17)SSA = cn¿a
r

i=1
1Xi.. - X22

FACTOR B VARIATION

(11.18)SSB = rn¿a
c

j=1
1X .j. - X 22

INTERACTION VARIATION

(11.19)SSAB = n¿a
r

i=1
a

c

j=1
1X ij. - Xi.. - X .j. + X 22

The sum of squares error (SSE) represents random variation—that is, the differences
among the values within each cell and the corresponding cell mean. Equation (11.20) shows
the computation for random variation.

RANDOM VARIATION IN TWO-WAY ANOVA

(11.20)SSE = a
r

i=1
a

c

j=1
a
n¿

k=1
1Xijk - Xij.22

Because there are r levels of factor A, there are degrees of freedom associated with
SSA. Similarly, because there are c levels of factor B, there are degrees of freedom
associated with SSB. Because there are replicates in each of the rc cells, there are
degrees of freedom associated with the SSE term. Carrying this further, there are degrees
of freedom associated with the sum of squares total (SST) because you are comparing each

n - 1
rc1n¿ - 12n¿

c - 1
r - 1

The sum of squares due to factor B (SSB) represents the differences among the various
levels of factor B and the grand mean. Equation (11.18) shows the computation for factor B
variation.

The sum of squares due to interaction (SSAB) represents the interacting effect of
specific combinations of factor A and factor B. Equation (11.19) shows the computation for
interaction variation.
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value, to the grand mean, based on all n values. Therefore, because the degrees of free-
dom for each of the sources of variation must add to the degrees of freedom for the total varia-
tion (SST), you can calculate the degrees of freedom for the interaction component (SSAB) by
subtraction. The degrees of freedom for interaction are

If you divide each sum of squares by its associated degrees of freedom, you have the four
variances or mean square terms (MSA, MSB, MSAB, and MSE). Equations (11.21a–d) give the
mean square terms needed for the two-way ANOVA table.

1r - 121c - 12.

X ,Xijk,

MEAN SQUARES IN TWO-WAY ANOVA

(11.21a)

(11.21b)

(11.21c)

(11.21d)MSE =
SSE

rc1n¿ - 12

MSAB =
SSAB

1r - 121c - 12

MSB =
SSB

c - 1

MSA =
SSA

r - 1

There are three different tests to perform in a two-way ANOVA:

1. To test the hypothesis of no difference due to factor A:

against the alternative:

you use the test statistic in Equation (11.22).FSTAT

H1: Not all mi.. are equal

H0: m1.. = m2.. = Á = mr..

F TEST FOR FACTOR A EFFECT

(11.22)FSTAT =
MSA

MSE

You reject the null hypothesis at the level of significance if

where is the upper-tail critical value from an F distribution with and
degrees of freedom.

2. To test the hypothesis of no difference due to factor B:

against the alternative:

you use the test statistic in Equation (11.23).FSTAT

H1: Not all m.j. are equal

H0: m.1. = m.2. = Á = m.c.

rc1n¿ - 12r - 1Fa

FSTAT =
MSA

MSE
7 Fa

a

F TEST FOR FACTOR B EFFECT

(11.23)FSTAT =
MSB

MSE



The Excel version of
Parachute2 contains
unstacked data, while the
Minitab version contains
stacked data.
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You reject the null hypothesis at the level of significance if

where is the upper-tail critical value from an F distribution with and
degrees of freedom.

3. To test the hypothesis of no interaction of factors A and B:

against the alternative:

you use the test statistic in Equation (11.24).FSTAT

H1: The interaction of A and B is not equal to zero

H0: The interaction of A and B is equal to zero

rc1n¿ - 12c - 1Fa

FSTAT =
MSB

MSE
7 Fa

a

F TEST FOR INTERACTION EFFECT

(11.24)FSTAT =
MSAB

MSE

You reject the null hypothesis at the level of significance if

where is the upper-tail critical value from an F distribution with and
degrees of freedom.

Table 11.8 presents the entire two-way ANOVA table.

rc1n¿ - 12 1r - 121c - 12Fa

FSTAT =
MSAB

MSE
7 Fa

a

T A B L E 1 1 . 8

Analysis of Variance
Table for the Two-Factor
Factorial Design

Source
Degrees

of Freedom
Sum

of Squares
Mean Square

(Variance) F

A r - 1 SSA
MSA =

SSA

r - 1
FSTAT =

MSA

MSE
B c - 1 SSB

MSB =
SSB

c - 1
FSTAT =

MSB

MSE
AB 1r - 121c - 12 SSAB

MSAB =
SSAB

1r - 121c - 12 FSTAT =
MSAB

MSE

Error rc1n¿ - 12 SSE MSE =
SSE

rc1n¿ - 12
Total n - 1 SST

To illustrate a two-way ANOVA, return to the Perfect Parachutes scenario on page 415.
As production manager at Perfect Parachutes, the business problem you decided to examine
involved not just the different suppliers but also whether parachutes woven on the Jetta
looms are as strong as those woven on the Turk looms. In addition, you need to determine
whether any differences among the four suppliers in the strength of the parachutes are de-
pendent on the type of loom being used. Thus, you have decided to collect the data by per-
forming an experiment in which five different parachutes from each supplier are
manufactured on each of the two different looms. The results are organized in Table 11.9 and
stored in .Parachute2
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T A B L E 1 1 . 9

Tensile Strengths of
Parachutes Woven by
Two Types of Looms,
Using Synthetic Fibers
from Four Suppliers

SUPPLIER

LOOM 1 2 3 4

Jetta 20.6 22.6 27.7 21.5
Jetta 18.0 24.6 18.6 20.0
Jetta 19.0 19.6 20.8 21.1
Jetta 21.3 23.8 25.1 23.9
Jetta 13.2 27.1 17.7 16.0

Turk 18.5 26.3 20.6 25.4
Turk 24.0 25.3 25.2 19.9
Turk 17.2 24.0 20.8 22.6
Turk 19.9 21.2 24.7 17.5
Turk 18.0 24.5 22.9 20.4

Figure 11.14 presents the results for this example. In the Excel results, the A, B, and Error
sources of variation in Table 11.8 on page 442 are labeled Sample, Columns, and Within,
respectively. In the Minitab results, factor names are used to label the A and B sources of
variation.

F I G U R E 1 1 . 1 4
Excel and Minitab two-way ANOVA results for the parachute loom and supplier experiment

To interpret the results, you start by testing whether there is an interaction effect between
factor A (loom) and factor B (supplier). If the interaction effect is significant, further analysis
will focus on this interaction. If the interaction effect is not significant, you can focus on the
main effects—potential differences in looms (factor A) and potential differences in suppliers
(factor B).
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Using the 0.05 level of significance, to determine whether there is evidence of an interac-
tion effect, you reject the null hypothesis of no interaction between loom and supplier if the
computed statistic is greater than 2.9011, the upper-tail critical value from the F distri-
bution, with 3 and 32 degrees of freedom (see Figures 11.14 and 11.15).1

FSTAT

Region of
Rejection

Region of
Nonrejection

Critical
Value

0 2.9011 F
.05.95

F I G U R E 1 1 . 1 5
Regions of rejection and
nonrejection at the 0.05
level of significance, with
3 and 32 degrees of
freedom

0 4.1491 F
.05.95

Region of
Rejection

Region of
Nonrejection

Critical
Value

F I G U R E 1 1 . 1 6
Regions of rejection and
nonrejection at the 0.05
level of significance, with
1 and 32 degrees of
freedom

1Table E.5 does not provide the
upper-tail critical values from the F
distribution with 32 degrees of free-
dom in the denominator. When the
desired degrees of freedom are not
provided in the table, use the p-value
computed by Excel or Minitab.

Because or the you do not reject
You conclude that there is insufficient evidence of an interaction effect between loom and

supplier. You can now focus on the main effects.
Using the 0.05 level of significance and testing for a difference between the two looms

(factor A), you reject the null hypothesis if the computed test statistic is greater than
4.1491, the (approximate) upper-tail critical value from the F distribution with 1 and 32 de-
grees of freedom (see Figures 11.14 and 11.16). Because or the

you do not reject You conclude that there is insufficient evi-
dence of a difference in the mean tensile strengths of the parachutes manufactured between the
two looms.

H0.p-value = 0.3750 7 0.05,
FSTAT = 0.8096 6 4.1491

FSTAT

H0.
p-value = 0.9984 7 0.05,FSTAT = 0.0111 6 2.9011

Using the 0.05 level of significance and testing for a difference among the suppliers (fac-
tor B), you reject the null hypothesis of no difference if the computed test statistic is
greater than 2.9011, the upper-tail critical value from the F distribution with 3 degrees of free-
dom in the numerator and 32 degrees of freedom in the denominator (see Figures 11.14 and
11.15). Because or the reject You
conclude that there is evidence of a difference in the mean tensile strength of the parachutes
among the suppliers.

Multiple Comparisons: The Tukey Procedure
If one or both of the factor effects are significant and there is no significant interaction ef-
fect, when there are more than two levels of a factor, you can determine the particular lev-
els that are significantly different by using the Tukey multiple comparisons procedure
for two-way ANOVA (see references 6 and 10). Equation (11.25) gives the critical range
for factor A.

H0.p-value = 0.0049 6 0.05,FSTAT = 5.1999 7 2.9011

FSTAT
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CRITICAL RANGE FOR FACTOR A

(11.25)

where is the upper-tail critical value from a Studentized range distribution having r
and degrees of freedom. (Values for the Studentized range distribution are
found in Table E.7.)

rc1n¿ - 12Qa

Critical range = QaAMSE

cn¿

Equation (11.26) gives the critical range for factor B.

CRITICAL RANGE FOR FACTOR B

(11.26)

where is the upper-tail critical value from a Studentized range distribution having c and
degrees of freedom. (Values for the Studentized range distribution are found in

Table E.7.)
rc1n¿ - 12Qa

Critical range = QaAMSE

rn¿

To use the Tukey procedure, return to the parachute manufacturing data of Table 11.9 on
page 443. In the ANOVA summary table in Figure 11.14 on page 443, the interaction effect is
not significant. Using there is no evidence of a significant difference between the
two looms (Jetta and Turk) that comprise factor A, but there is evidence of a significant differ-
ence among the four suppliers that comprise factor B. Thus, you can use the Tukey multiple
comparisons procedure to determine which of the four suppliers differ.

Because there are four suppliers, there are pairwise comparisons. Using
the calculations presented in Figure 11.14, the absolute mean differences are as follows:

1.
2.
3.
4.
5.
6.

To determine the critical range, refer to Figure 11.14 to find
and From Table E.7 [for and ], the

upper-tail critical value of the Studentized range distribution with 4 and 32 degrees of freedom
is approximately 3.84. Using Equation (11.26),

Because only the means of Suppliers 1 and 2 are different. You can conclude that
the mean tensile strength is lower for Supplier 1 than for Supplier 2, but there are no statisti-
cally significant differences between Suppliers 1 and 3, Suppliers 1 and 4, Suppliers 2 and 3,
Suppliers 2 and 4, and Suppliers 3 and 4. Note that by using you are able to make
all six comparisons with an overall error rate of only 5%.

Visualizing Interaction Effects: The Cell Means Plot
You can get a better understanding of the interaction effect by plotting the cell means, the means
of all possible factor-level combinations. Figure 11.17 presents a cell means plot that uses the
cell means for the loom/supplier combinations shown in Figure 11.14 on page 443. From the plot
of the mean tensile strength for each combination of loom and supplier, observe that the two lines
(representing the two looms) are roughly parallel. This indicates that the difference between the
mean tensile strengths of the two looms is virtually the same for the four suppliers. In other
words, there is no interaction between these two factors, as was indicated by the F test.

a = 0.05,

4.93 7 3.56,

Critical range = 3.84A8.6123
10

= 3.56

Qa,rc1n¿ - 12 = 32a = 0.05, c = 4,n¿ = 5.c = 4,
MSE = 8.6123, r = 2,

ƒX .3. - X .4. ƒ = ƒ22.41 - 20.83 ƒ = 1.58
ƒX .2. - X .4. ƒ = ƒ23.90 - 20.83 ƒ = 3.07
ƒX .2. - X .3. ƒ = ƒ23.90 - 22.41 ƒ = 1.49
ƒX .1. - X .4. ƒ = ƒ18.97 - 20.83 ƒ = 1.86
ƒX .1. - X .3. ƒ = ƒ18.97 - 22.41 ƒ = 3.44
ƒX .1. - X .2. ƒ = ƒ18.97 - 23.90 ƒ = 4.93

414 - 12>2 = 6

a = 0.05,



LENGTH OF COURSE

TYPE OF COURSE Condensed Regular

Traditional 26 18 34 28
Traditional 27 24 24 21
Traditional 25 19 35 23
Traditional 21 20 31 29
Traditional 21 18 28 26

Online 27 21 24 21
Online 29 32 16 19
Online 30 20 22 19
Online 24 28 20 24
Online 30 29 23 25

T A B L E 1 1 . 1 0

ACT Scores for
Different Types and
Lengths of Courses

A nationwide company specializing in preparing students for college and graduate school en-
trance exams, such as the SAT, ACT, and LSAT, had the business objective of improving its
ACT preparatory course. Two factors of interest to the company are the length of the course (a
condensed 10-day period or a regular 30-day period) and the type of course (traditional class-
room or online distance learning). The company collected data by randomly assigning
10 clients to each of the four cells that represent a combination of length of the course and type
of course. The results are organized in the file and presented in Table 11.10.

What are the effects of the type of course and the length of the course on ACT scores?
ACT

EXAMPLE 11.2
Interpreting
Significant
Interaction Effects

446 CHAPTER 11 Analysis of Variance

F I G U R E 1 1 . 1 7
Excel cell means plot of
tensile strength based on
loom and supplier

Interpreting Interaction Effects
What is the interpretation if there is an interaction? In such a situation, some levels of factor A
would respond better with certain levels of factor B. For example, with respect to tensile
strength, suppose that some suppliers were better for the Jetta loom and other suppliers were
better for the Turk loom. If this were true, the lines of Figure 11.17 would not be nearly as par-
allel, and the interaction effect might be statistically significant. In such a situation, the differ-
ence between the looms is no longer the same for all suppliers. Such an outcome would also
complicate the interpretation of the main effects because differences in one factor (the loom)
would not be consistent across the other factor (the supplier).

Example 11.2 illustrates a situation with a significant interaction effect.
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SOLUTION The cell means plot presented in Figure 11.18 shows a strong interaction be-
tween the type of course and the length of the course. The nonparallel lines indicate that the
effect of condensing the course depends on whether the course is taught in the traditional
classroom or by online distance learning. The online mean score is higher when the course is
condensed to a 10-day period, whereas the traditional mean score is higher when the course
takes place over the regular 30-day period.

F I G U R E 1 1 . 1 8
Cell means plot of ACT
scores

To verify the somewhat subjective analysis provided by interpreting the cell means plot,
you begin by testing whether there is a statistically significant interaction between factor A
(length of course) and factor B (type of course). Using a 0.05 level of significance, you reject
the null hypothesis because or the p-value equals 0.000 6 0.05FSTAT = 24.2569 7 4.1132

F I G U R E 1 1 . 1 9
Excel and Minitab two-way ANOVA results for ACT scores



F I G U R E 1 1 . 2 0
Excel and Minitab one-way ANOVA results and Tukey-Kramer worksheets for the ACT scores
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(see Figure 11.19). Thus, the hypothesis test confirms the interaction evident in the cell means
plot. The existence of this significant interaction effect complicates the interpretation of the
hypothesis tests concerning the two main effects. You cannot directly conclude that there is no
effect with respect to length of course and type of course, even though both have

Given that the interaction is significant, you can reanalyze the data with the two factors
collapsed into four groups of a single factor rather than a two-way ANOVA with two levels of
each of the two factors (see ). Group 1 is traditional condensed. Group 2 is tradi-
tional regular. Group 3 is online condensed. Group 4 is online regular. Figure 11.20 shows the
results for this example.

ACT-OneWay

p-values 7 0.05.

From Figure 11.20, because or
there is evidence of a significant difference in the four groups (traditional condensed, tradi-
tional regular, online condensed, and online regular). Traditional condensed is different
from traditional regular and from online condensed. Traditional regular is also different
from online regular, and online condensed is also different from online regular. Thus,
whether condensing a course is a good idea depends on whether the course is offered in a
traditional classroom or as an online distance learning course. To ensure the highest mean
ACT scores, the company should use the traditional approach for courses that are given
over a 30-day period but use the online approach for courses that are condensed into a
10-day period.

p-value = 0.0003 6 0.05,FSTAT = 8.2239 7 2.8663
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Problems for Section 11.3
LEARNING THE BASICS
11.29 Consider a two-factor factorial design with three
levels in factor A, three levels in factor B, and four replicates
in each of the nine cells.
a. How many degrees of freedom are there in determining

the factor A variation and the factor B variation?
b. How many degrees of freedom are there in determining

the interaction variation?
c. How many degrees of freedom are there in determining

the random variation?
d. How many degrees of freedom are there in determining

the total variation?

11.30 Assume that you are working with the results from
Problem 11.29, if SSA � 120, SSB � 110, SSE � 270, and
SST � 540.
a. What is SSAB?
b. What are MSA and MSB?
c. What is MSAB?
d. What is MSE?

11.31 Assume that you are working with the results from
Problems 11.29 and 11.30.
a. What is the value of the test statistic for the inter-

action effect?
b. What is the value of the test statistic for the factor

A effect?
c. What is the value of the test statistic for the fac-

tor B effect?
d. Form the ANOVA summary table and fill in all values in

the body of the table.

11.32 Given the results from Problems 11.29 through 11.31,
a. at the 0.05 level of significance, is there an effect due to

factor A?
b. at the 0.05 level of significance, is there an effect due to

factor B?
c. at the 0.05 level of significance, is there an interaction

effect?

11.33 Given a two-way ANOVA with two levels for factor
A, five levels for factor B, and four replicates in each of the
10 cells, with SSA = 18, SSB = 64, SSE = 60, and SST = 150,
a. form the ANOVA summary table and fill in all values in

the body of the table.
b. at the 0.05 level of significance, is there an effect due to

factor A?
c. at the 0.05 level of significance, is there an effect due to

factor B?
d. at the 0.05 level of significance, is there an interaction

effect?

11.34 Given a two-factor factorial experiment and the
ANOVA summary table that follows, fill in all the missing
results:

FSTAT

FSTAT

FSTAT

Source
Degrees of
Freedom

Sum of
Squares

Mean
Square

(Variance) F

A r - 1 = 2 SSA = ? MSA = 80 FSTAT = ?

B c - 1 = ? SSB = 220 MSB = ? FSTAT = 11.0

AB (r - 1)(c - 1) = 8 SSAB = ? MSAB = 10 FSTAT = ?

Error rc1n¿ - 12 = 30 SSE = ? MSE = ?

Total n - 1 = ? SST = ?

11.35 Given the results from Problem 11.34,
a. at the 0.05 level of significance, is there an effect due to

factor A?
b. at the 0.05 level of significance, is there an effect due to

factor B?
c. at the 0.05 level of significance, is there an interaction effect?

APPLYING THE CONCEPTS
11.36 The effects of developer strength (factor A) and
development time (factor B) on the density of photo-
graphic plate film were being studied. Two strengths and
two development times were used, and four replicates in
each of the four cells were evaluated. The results (with
larger being best) are stored in and shown in the
following table:

Photo

DEVELOPMENT TIME (MINUTES)

DEVELOPER STRENGTH 10 14

1 0 1
1 5 4
1 2 3
1 4 2

2 4 6
2 7 7
2 6 8
2 5 7

At the 0.05 level of significance,
a. is there an interaction between developer strength and de-

velopment time?
b. is there an effect due to developer strength?
c. is there an effect due to development time?
d. Plot the mean density for each developer strength for

each development time.
e. What can you conclude about the effect of developer

strength and development time on density?

11.37 A chef in a restaurant that specializes in pasta dishes
was experiencing difficulty in getting brands of pasta to be al
dente—that is, cooked enough so as not to feel starchy or
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hard but still feel firm when bitten into. She decided to con-
duct an experiment in which two brands of pasta, one Ameri-
can and one Italian, were cooked for either 4 or 8 minutes.
The variable of interest was weight of the pasta because cook-
ing the pasta enables it to absorb water. A pasta with a faster
rate of water absorption may provide a shorter interval in
which the pasta is al dente, thereby increasing the chance that
it might be overcooked. The experiment was conducted by us-
ing 150 grams of uncooked pasta. Each trial began by bring-
ing a pot containing 6 quarts of cold, unsalted water to a
moderate boil. The 150 grams of uncooked pasta was added
and then weighed after a given period of time by lifting the
pasta from the pot via a built-in strainer. The results (in terms
of weight in grams) for two replicates of each type of pasta
and cooking time are stored in and are as follows:Pasta

At the 0.05 level of significance,
a. is there an interaction between brand of pain reliever and

water temperature?
b. is there an effect due to brand?
c. is there an effect due to water temperature?
d. Plot the mean dissolving time for each brand for each

water temperature.
e. Discuss the results of (a) through (d).

11.39 Integrated circuits are manufactured on silicon
wafers through a process that involves a series of steps. An
experiment was carried out to study the effect of the cleans-
ing and etching steps on the yield (coded to maintain confi-
dentiality). The results (stored in ) are as follows:Yield

COOKING TIME (MINUTES)

TYPE OF PASTA 4 8

American 265 310
American 270 320

Italian 250 300
Italian 245 305

At the 0.05 level of significance,
a. is there an interaction between type of pasta and cooking

time?
b. is there an effect due to type of pasta?
c. is there an effect due to cooking time?
d. Plot the mean weight for each type of pasta for each

cooking time.
e. What conclusions can you reach concerning the importance

of each of these two factors on the weight of the pasta?

11.38 A student team in a business statistics
course performed a factorial experiment to investi-

gate the time required for pain-relief tablets to dissolve in a
glass of water. The two factors of interest were brand name
(Equate, Kroger, or Alka-Seltzer) and water temperature (hot
or cold). The experiment consisted of four replicates for each
of the six factor combinations. The following data (stored in

) show the time a tablet took to dissolve (in sec-
onds) for the 24 tablets used in the experiment:
PainRelief

SELF
Test

BRAND OF PAIN-RELIEF TABLET

WATER Equate Kroger Alka-Seltzer

Cold 85.87 75.98 100.11
Cold 78.69 87.66 99.65
Cold 76.42 85.71 100.83
Cold 74.43 86.31 94.16

Hot 21.53 24.10 23.80
Hot 26.26 25.83 21.29
Hot 24.95 26.32 20.82
Hot 21.52 22.91 23.21

ETCHING STEP

CLEANSING STEP New Standard

New 1 38 34
New 1 34 19
New 1 38 28

New 2 29 20
New 2 35 35
New 2 34 37

Standard 31 29
Standard 23 32
Standard 38 30
Source: Extracted from J. Ramirez and W. Taam, “An Autologistic Model
for Integrated Circuit Manufacturing,” Journal of Quality Technology,
2000, 32, pp. 254–262.

At the 0.05 level of significance,
a. is there an interaction between the cleansing step and the

etching step?
b. is there an effect due to the cleansing step?
c. is there an effect due to the etching step?
d. Plot the mean yield for each cleansing step for each etch-

ing step.
e. Discuss the results of (a) through (d).

11.40 An experiment was conducted to try to resolve a
problem of brake discs overheating at high speed on con-
struction equipment. Five different brake discs were meas-
ured by two different temperature gauges. The temperature
of each brake disc and gauge combination was measured at
eight different times and the results stored in
Source: Data extracted from M. Awad, T. P. Erdmann, V. Shansal, and
B. Barth, “A Measurement System Analysis Approach for Hard-to-
Repeat Events,” Quality Engineering, 21, 2009, pp. 300–305.

At the 0.05 level of significance,
a. is there an interaction between the brake discs and the

gauges?
b. is there an effect due to brake discs?
c. is there an effect due to the gauges?
d. Plot the mean temperature for each brake disc for each gauge.
e. Discuss the results of (a) through (d).

Brakes
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In the Using Statistics scenario, you were the production manager at
the Perfect Parachutes Company. You performed an experiment to
determine whether there was a difference in the strength of para-
chutes woven from synthetic fibers from four different suppliers.

Using the one-way ANOVA, you were able to determine that there was a
difference in the mean strength of the parachutes from the different suppli-
ers. You then were able to conclude that the mean strength of parachutes

woven from synthetic fibers from supplier 1 was less than for supplier 2. Further experimenta-
tion was carried out to study the effect of the loom. You determined that there was no interac-
tion between the supplier and loom and there was no difference in mean strength between the
looms. Your next step as production manager is to investigate reasons the mean strength of
parachutes woven from synthetic fibers from supplier 1 was less than for supplier 2 and possi-
bly reduce the number of suppliers.

U S I N G S TAT I S T I C S @ Perfect Parachutes Revisited

S U M M A R Y
In this chapter, various statistical procedures were used to
analyze the effect of one or two factors of interest. The as-
sumptions required for using these procedures were dis-
cussed in detail. Remember that you need to critically

T A B L E 1 1 . 1 1

Summary of Topics in
Chapter 11

Type of Analysis (numerical data only) Number of Factors

Comparing more than two groups One-way analysis of variance (Section 11.1)
Randomized block design (Section 11.2)
Two-way analysis of variance (Section 11.3)

investigate the validity of the assumptions underlying the
hypothesis-testing procedures. Table 11.11 summarizes the
topics covered in this chapter.

K E Y E Q U AT I O N S
Total Variation in One-Way ANOVA

(11.1)

Among-Group Variation in One-Way ANOVA

(11.2)

Within-Group Variation in One-Way ANOVA

(11.3)SSW = a
c

j=1
a
nj

i=1
1Xij - Xj22

SSA = a
c

j=1
nj1Xj - X22

SST = a
c

j=1
a
nj

i=1
1Xij - X22

Mean Squares in One-Way ANOVA

(11.4a)

(11.4b)

(11.4c)

One-Way ANOVA F
STAT

Test Statistic

(11.5)FSTAT =
MSA

MSW

MST =
SST

n - 1

MSW =
SSW

n - c

MSA =
SSA

c - 1
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Critical Range for the Tukey-Kramer Procedure

(11.6)

Total Variation in the Randomized Block Design

(11.7)

Among-Group Variation in the Randomized Block Design

(11.8)

Among-Block Variation in the Randomized Block Design

(11.9)

Random Variation in the Randomized Block Design

(11.10)

Mean Squares in the Randomized Block Design

(11.11a)

(11.11b)

(11.11c)

F
STAT

Statistic for Factor Effect

(11.12)

F
STAT

Statistic for Block Effects

(11.13)

Estimated Relative Efficiency

(11.14)

Critical Range for the Randomized Block Design

(11.15)

Total Variation in Two-Way ANOVA

(11.16)SST = a
r

i=1
a

c

j=1
a
n¿

k=1
1Xijk - X22

Critical range = QaAMSE
r

RE =
(r - 1)MSBL + r(c - 1)MSE

(rc - 1)MSE

FSTAT =
MSBL

MSE

FSTAT =
MSA

MSE

MSE =
SSE

(r - 1)(c - 1)

MSBL =
SSBL

r - 1

MSA =
SSA

c - 1

SSE = a
c

j=1
a

r

i=1
(Xij - X .j - X i. + X)2

SSBL = ca
r

i=1
(Xi. - X)2

SSA = ra
c

j=1
(X .j - X)2

SST = a
c

j=1
a

r

i=1
(Xij - X)2

Critical range = QaAMSW

2
a 1

nj
+

1
nj¿
b

Factor A Variation

(11.17)

Factor B Variation

(11.18)

Interaction Variation

(11.19)

Random Variation in Two-Way ANOVA

(11.20)

Mean Squares in Two-Way ANOVA

(11.21a)

(11.21b)

(11.21c)

(11.21d)

F Test for Factor A Effect

(11.22)

F Test for Factor B Effect

(11.23)

F Test for Interaction Effect

(11.24)

Critical Range for Factor A

(11.25)

Critical Range for Factor B

(11.26)Critical range = QaAMSE

rn¿

Critical range = QaAMSE

cn¿

FSTAT =
MSAB

MSE

FSTAT =
MSB

MSE

FSTAT =
MSA

MSE

MSE =
SSE

rc1n¿ - 12

MSAB =
SSAB

1r - 121c - 12

MSB =
SSB

c - 1

MSA =
SSA

r - 1

SSE = a
r

i=1
a

c

j=1
a
n¿

k=1
1Xijk - Xij.22

SSAB = n¿a
r

i=1
a

c

j=1
1X ij. - X i.. - X .j. + X 22

SSB = rn¿a
c

j=1
1X .j. - X 22

SSA = cn¿a
r

i=1
1X i.. - X22
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K E Y T E R M S
among-block variation 432
among-group variation 416
analysis of variance (ANOVA) 416
ANOVA summary table 419
blocks 430
cell means 445
completely randomized design 416
critical range 423
estimated relative efficiency (RE) 435
F distribution 418
factor 416
grand mean, 417
group 416
homogeneity of variance 425
interaction 439
level 416
Levene test 425

X

main effect 443
mean square 418
multiple comparisons 422
normality 425
one-way ANOVA 416
randomized block design 430
randomness and independence 425
replicate 439
Studentized range distribution 423
sum of squares among 

blocks (SSBL) 432
sum of squares among 

groups (SSA) 417
sum of squares due to 

factor A (SSA) 440
sum of squares due to 

factor B (SSB) 440

sum of squares due to 
interaction (SSAB) 440

sum of squares error (SSE) 432
sum of squares total (SST) 417
sum of squares within 

groups (SSW) 417
total variation 417
Tukey multiple comparisons procedure

for randomized block designs 436
Tukey multiple comparisons procedure

for two-way ANOVA 444
Tukey-Kramer multiple comparisons

procedure for one-way
ANOVA 422

two-factor factorial design 438
two-way ANOVA 439
within-group variation 416

C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING
11.41 In a one-way ANOVA, what is the difference be-
tween the among-groups variance MSA and the within-
groups variance MSW?

11.42 What is the difference between the completely random-
ized one-way ANOVA design and the randomized block design?

11.43 What are the distinguishing features of the com-
pletely randomized design, randomized block design, and
two-factor factorial designs?

11.44 What are the assumptions of ANOVA?

11.45 Under what conditions should you use the one-way
ANOVA F test to examine possible differences among the
means of c independent populations?

11.46 When and how should you use multiple comparison
procedures for evaluating pairwise combinations of the
group means?

11.47 What is the difference between the randomized
block design and the two-factor factorial design?

11.48 What is the difference between the one-way ANOVA
F test and the Levene test?

11.49 Under what conditions should you use the two-way
ANOVA F test to examine possible differences among the
means of each factor in a factorial design?

11.50 What is meant by the concept of interaction in a
two-factor factorial design?

11.51 How can you determine whether there is an interac-
tion in the two-factor factorial design?

APPLYING THE CONCEPTS
11.52 The operations manager for an appliance manufac-
turer wants to determine the optimal length of time for the
washing cycle of a household clothes washer. An experiment
is designed to measure the effect of detergent brand and wash-
ing cycle time on the amount of dirt removed from standard
household laundry loads. Four brands of detergent (A, B, C,
and D) and four levels of washing cycle (18, 20, 22, and 24
minutes) are specifically selected for analysis. In order to run
the experiment, 32 standard household laundry loads (having
equal weight and dirt) are randomly assigned, 2 each, to the 16
detergent/washing cycle time combinations. The results, in
pounds of dirt removed (stored in ), are as follows:Laundry

WASHING CYCLE TIME 
(IN MINUTES)

DETERGENT BRAND 18 20 22 24

A 0.11 0.13 0.17 0.17
A 0.09 0.13 0.19 0.18

B 0.12 0.14 0.17 0.19
B 0.10 0.15 0.18 0.17

C 0.08 0.16 0.18 0.20
C 0.09 0.13 0.17 0.16

D 0.11 0.12 0.16 0.15
D 0.13 0.13 0.17 0.17
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At the 0.05 level of significance,
a. is there an interaction between detergent brand and wash-

ing cycle time?
b. is there an effect due to detergent brand?
c. is there an effect due to washing cycle time?
d. Plot the mean amount of dirt removed (in pounds) for

each detergent brand for each washing cycle time.
e. If appropriate, use the Tukey procedure to determine dif-

ferences between detergent brands and between washing
cycle times.

f. What washing cycle time should be used for this type of
household clothes washer?

g. Repeat the analysis, using washing cycle time as the only
factor. Compare your results to those of (c), (e), and (f).

11.53 The quality control director for a clothing manu-
facturer wants to study the effect of operators and ma-
chines on the breaking strength (in pounds) of wool serge
material. A batch of the material is cut into square-yard
pieces, and these pieces are randomly assigned, 3 each, to
each of the 12 combinations of 4 operators and 3 machines
chosen specifically for the experiment. The results (stored
in ) are as follows:Breakstw

11.54 An operations manager wants to examine the effect
of air-jet pressure (in pounds per square inch [psi]) on the
breaking strength of yarn. Three different levels of air-jet
pressure are to be considered: 30 psi, 40 psi, and 50 psi. A
random sample of 18 yarns are selected from the same
batch, and the yarns are randomly assigned, 6 each, to the
3 levels of air-jet pressure. The breaking strength scores are
in the file .
a. Is there evidence of a significant difference in the vari-

ances of the breaking strengths for the three air-jet pres-
sures? (Use .)

b. At the 0.05 level of significance, is there evidence of a
difference among mean breaking strengths for the three
air-jet pressures?

c. If appropriate, use the Tukey-Kramer procedure to deter-
mine which air-jet pressures significantly differ with
respect to mean breaking strength. (Use )

d. What should the operations manager conclude?

11.55 Suppose that, when setting up his experiment in
Problem 11.54, the operations manager had access to only
six samples of yarn from the batch but was able to divide
each yarn sample into three parts and randomly assign
them, one each, to the three air-jet pressure levels. Thus, in-
stead of the one-factor completely randomized design
model in Problem 11.54, he used a randomized block design
with the six yarn samples being the blocks and one yarn part
each assigned to the three air-jet pressure levels. The break-
ing-strength scores are stored in .
a. At the 0.05 level of significance, is there evidence of a

difference in the mean breaking strengths for the three
air-jet pressures?

b. If appropriate, use the Tukey procedure to determine the
air-jet pressures that differ in mean breaking strength.
(Use α = 0.05.)

c. At the 0.05 level of significance, is there evidence of a
blocking effect?

d. Determine the relative efficiency of the randomized block
design as compared with the completely randomized design.

e. Compare your result in (a) with your result in Problem
11.54 (b). Given your results in (c) and (d), what do you
think happened? What can you conclude about the “im-
pact of blocking” when the blocks themselves are not
really different from each other?

11.56 Suppose that, when setting up the experiment in
Problem 11.54, the operations manager is able to study the ef-
fect of side-to-side aspect in addition to air-jet pressure. Thus,
instead of the one-factor completely randomized design in
Problem 11.54, a two-factor factorial design was used, with
the first factor, side-to-side aspect, having two levels (nozzle
and opposite) and the second factor, air-jet pressure, having
three levels (30 psi, 40 psi, and 50 psi). A sample of 18 yarns
is randomly assigned, 3 to each of the 6 side-to-side aspect

Yarn

a = 0.05.

a = 0.05

Yarn

MACHINE

OPERATOR I II III

A 115 111 109
A 115 108 110
A 119 114 107

B 117 105 110
B 114 102 113
B 114 106 114

C 109 100 103
C 110 103 102
C 106 101 105

D 112 105 108
D 115 107 111
D 111 107 110

At the 0.05 level of significance,
a. is there an interaction between operator and machine?
b. is there an effect due to operator?
c. is there an effect due to machine?
d. Plot the mean breaking strength for each operator for

each machine.
e. If appropriate, use the Tukey procedure to examine dif-

ferences among operators and among machines.
f. What can you conclude about the effects of operators and

machines on breaking strength? Explain.
g. Repeat the analysis, using machines as the only factor.

Compare your results to those of (c), (e), and (f).
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At the 0.05 level of significance,
a. is there an interaction between side-to-side aspect and

air-jet pressure?
b. is there an effect due to side-to-side aspect?
c. is there an effect due to air-jet pressure?
d. Plot the mean yarn breaking strength for each level of

side-to-side aspect for each level of air-jet pressure.
e. If appropriate, use the Tukey procedure to study differ-

ences among the air-jet pressures.
f. On the basis of the results of (a) through (e), what conclu-

sions can you reach concerning yarn breaking strength?
Discuss.

g. Compare your results in (a) through (f) with those from
the completely randomized design in Problem 11.55.
Discuss fully.

11.57 A pet food company has the business objective of
having the weight of a can of cat food come as close to the
specified weight as possible. Realizing that the size of the
pieces of meat contained in a can and the can fill height
could impact the weight of a can, a team studying the weight
of canned cat food wondered whether the current larger
chunk size produced higher can weight and more variability.
The team decided to study the effect on weight of a cutting
size that was finer than the current size. In addition, the
team slightly lowered the target for the sensing mechanism
that determines the fill height in order to determine the
effect of the fill height on can weight.

Twenty cans were filled for each of the four combina-
tions of piece size (fine and current) and fill height (low and
current). The contents of each can were weighed, and the
amount above or below the label weight of 3 ounces was
recorded as the variable coded weight. For example, a can
containing 2.90 ounces was given a coded weight of
Results were stored in .

Analyze these data and write a report for presentation to
the team. Indicate the importance of the piece size and the
fill height on the weight of the canned cat food. Be sure to
include a recommendation for the level of each factor that
will come closest to meeting the target weight and the limi-
tations of this experiment, along with recommendations for
future experiments that might be undertaken.

CatFood2

-0.10.

11.58 A hotel wanted to develop a new system for deliver-
ing room service breakfasts. In the current system, an order
form is left on the bed in each room. If the customer wishes
to receive a room service breakfast, he or she places the or-
der form on the doorknob before 11 P.M. The current system
requires customers to select a 15-minute interval for desired
delivery time (6:30–6:45 A.M., 6:45–7:00 A.M., etc.). The
new system is designed to allow the customer to request a
specific delivery time. The hotel wants to measure the dif-
ference between the actual delivery time and the requested
delivery time of room service orders for breakfast. (A nega-
tive time means that the order was delivered before the re-
quested time. A positive time means that the order was
delivered after the requested time.) The factors included
were the menu choice (American or Continental) and the
desired time period in which the order was to be delivered
(Early Time Period [6:30–8:00 A.M.] or Late Time Period
[8:00–9:30 A.M.]). Ten orders for each combination of menu
choice and desired time period were studied on a particular
day. The data (stored in ) are as follows:Breakfast

AIR-JET PRESSURE

SIDE-TO-SIDE ASPECT 30 psi 40 psi 50 psi

Nozzle 25.5 24.8 23.2
Nozzle 24.9 23.7 23.7
Nozzle 26.1 24.4 22.7

Opposite 24.7 23.6 22.6
Opposite 24.2 23.3 22.8
Opposite 23.6 21.4 24.9

DESIRED TIME

TYPE OF BREAKFAST
Early Time

Period
Late Time

Period

Continental 1.2 -2.5
Continental 2.1 3.0
Continental 3.3 -0.2
Continental 4.4 1.2
Continental 3.4 1.2
Continental 5.3 0.7
Continental 2.2 -1.3
Continental 1.0 0.2
Continental 5.4 -0.5
Continental 1.4 3.8

American 4.4 6.0
American 1.1 2.3
American 4.8 4.2
American 7.1 3.8
American 6.7 5.5
American 5.6 1.8
American 9.5 5.1
American 4.1 4.2
American 7.9 4.9
American 9.4 4.0

At the 0.05 level of significance,
a. is there an interaction between type of breakfast and de-

sired time?
b. is there an effect due to type of breakfast?
c. is there an effect due to desired time?
d. Plot the mean delivery time difference for each desired

time for each type of breakfast.
e. On the basis of the results of (a) through (d), what con-

clusions can you reach concerning delivery time differ-
ence? Discuss.

and pressure level combinations. The breaking-strength
scores (stored in ) are as follows:Yarn
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11.59 Refer to the room service experiment in Problem 11.58.
Now suppose that the results are as follows (and stored in

). Repeat (a) through (e), using these data, and com-
pare the results to those of (a) through (e) of Problem 11.58.
Breakfast2

11.62 In a recent wine tasting held by the J. S. Wine Club,
club members rated eight wines. Information concerning
the country of origin and the price were not known to the
club members until after the tasting took place. The wines
rated (and the prices paid for them) were

• French white, $10.59
• Italian white, $8.50
• Italian red, $8.50
• French burgundy (red), $10.69
• French burgundy (red), $11.75
• California Beaujolais (red), $10.50
• French white, $9.75
• California white, $13.59

The summated ratings over several characteristics for the 12
club members are in the data file
a. At the 0.01 level of significance, is there evidence of a

difference in the mean rating scores among the wines?
b. What assumptions are necessary in order to do (a) of this

problem? Comment on the validity of these assumptions.
c. If appropriate, use the Tukey procedure to determine the

wines that differ in mean rating. (Use α = 0.01.)
d. Based upon your results in (c), do you think that country

of origin, type of wine, or price has had an effect on the
ratings?

e. Determine the relative efficiency of the randomized block
design as compared with the completely randomized design.

11.63 Ignore the blocking variable in Problem 11.62.
a. “Erroneously” reanalyze the data as a one-factor com-

pletely randomized design where the one factor brands of
wines has eight levels, and each level contains a sample
of 12 independent values.

b. Compare the SSBL and SSE terms in Problem 11.62 (a)
to the SSW term in (a). Discuss.

c. Using the results in Problem 11.62 (a) and this problem,
describe the issues that can arise when analyzing data if
the wrong procedures are applied.

TEAM PROJECT
The file contains information regarding eight
variables from a sample of 184 bond mutual funds:

Type—Type of bonds comprising the bond mutual fund
(intermediate government or short-term corporate)

Assets—In millions of dollars
Fees—Sales charges (no or yes)
Expense ratio—Ratio of expenses to net assets in percentage
Return 2009—Twelve-month return in 2009
Three-year return—Annualized return, 2007–2009
Five-year return—Annualized return, 2005–2009
Risk—Risk-of-loss factor of the bond mutual fund (be-

low average, average, or above average)

11.64 Completely analyze the difference between below-
average-risk, average-risk, and above-average-risk bond mutual
funds in terms of 2009 return, three-year return, five-year return,
and expense ratio. Write a report summarizing your findings.

Bond Funds

Wine

11.60 There are a tremendous number of mutual funds
from which an investor can choose. Each mutual fund has
its own mix of different types of investments. The data in

represent the 3-year annualized return, 5-year
annualized return, 10-year annualized return, and expense
ratio (in %) for the 10 mutual funds rated best by the U.S.
News & World Report for foreign large-cap blend, small-cap
blend, mid-cap blend, large-cap blend, and diversified
emerging markets categories. (Data extracted from K. Shin-
kle, “The Best Funds for the Long Term, U.S. News & World
Report, Summer 2010, pp. 52–56.) Analyze the data and de-
termine whether any differences exist between foreign
large-cap blend, small-cap blend, mid-cap blend, large-cap
blend, and diversified emerging market mutual funds. (Use
the 0.05 level of significance.)

11.61 The data in represent the 3-year annu-
alized return, 5-year annualized return, 10-year annualized
return, and expense ratio (in %) for the 10 mutual funds
rated best by the U.S. News & World Report for intermediate
municipal bond, short-term bond, and intermediate-term
bond categories. (Data extracted from K. Shinkle, “The Best
Funds for the Long Term, U.S. News & World Report, Sum-
mer 2010, pp. 52–56.) Analyze the data and determine
whether any differences exist between intermediate munici-
pal bond, short-term bond, and intermediate-term bond
mutual funds. (Use the 0.05 level of significance.)

BestFunds3

BestFunds2

DESIRED TIME

TYPE OF BREAKFAST Early Late

Continental 1.2 -0.5
Continental 2.1 5.0
Continental 3.3 1.8
Continental 4.4 3.2
Continental 3.4 3.2
Continental 5.3 2.7
Continental 2.2 0.7
Continental 1.0 2.2
Continental 5.4 1.5
Continental 1.4 5.8

American 4.4 6.0
American 1.1 2.3
American 4.8 4.2
American 7.1 3.8
American 6.7 5.5
American 5.6 1.8
American 9.5 5.1
American 4.1 4.2
American 7.9 4.9
American 9.4 4.0
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c. Compare the results of (b) to those of Problem 11.65.

11.67 Problem 1.28 on page 15 describes a survey of 44
MBA students (stored in ). For these data, at the
0.05 level of significance,
a. is there evidence of a difference, based on undergraduate

major, in age, undergraduate grade point average, graduate
grade point average, expected salary upon graduation, num-
ber of text messages sent in a typical week, spending on
textbooks and supplies, and the wealth needed to feel rich?

b. is there evidence of a difference, based on graduate major,
in age, undergraduate grade point average, graduate grade
point average, expected salary upon graduation, number
of text messages sent in a typical week, spending on text-
books and supplies, and the wealth needed to feel rich?

c. is there evidence of a difference, based on employment sta-
tus, in age, undergraduate grade point average, graduate
grade point average, expected salary upon graduation, num-
ber of text messages sent in a typical week, spending on
textbooks and supplies, and the wealth needed to feel rich?

11.68 Problem 1.28 on page 15 describes a survey of 44
MBA students (stored in ).
a. Select a sample of graduate students in your MBA pro-

gram and conduct a similar survey for those students.
b. For the data collected in (a), repeat (a) through (c) of

Problem 11.67.
c. Compare the results of (b) to those of Problem 11.67.

GradSurvey

GradSurvey

STUDENT SURVEY DATABASE
11.65 Problem 1.27 on page 14 describes a survey of 62 under-
graduate students (stored in ). For these data,
a. at the 0.05 level of significance, is there evidence of a dif-

ference based on academic major in grade point average,
expected starting salary, age, number of social network-
ing sites registered for, spending on textbooks and sup-
plies, number of text messages sent in a typical week, and
the wealth needed to feel rich?

b. at the 0.05 level of significance, is there evidence of a dif-
ference based on graduate school intention in grade point
average, expected starting salary, age, number of social net-
working sites registered for, spending on textbooks and sup-
plies, number of text messages sent in a typical week, and
the wealth needed to feel rich?

c. at the 0.05 level of significance, is there evidence of a dif-
ference based on employment status in grade point average,
expected starting salary, age, number of social networking
sites registered for, spending on textbooks and supplies,
number of text messages sent in a typical week, and the
wealth needed to feel rich?

11.66 Problem 1.27 on page 14 describes a survey of 62
undergraduate students (stored in ).
a. Select a sample of undergraduate students at your school

and conduct a similar survey for those students.
b. For the data collected in (a), repeat (a) through (c) of

Problem 11.65.

UndergradSurvey

UndergradSurvey

M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
Phase 1
The computer operations department had a business objec-
tive of reducing the amount of time to fully update each sub-
scriber’s set of messages in a special secured e-mail system.
An experiment was conducted in which 24 subscribers were
selected and three different messaging systems were used.
Eight subscribers were assigned to each system, and the up-
date times were measured. The results (stored in )
are presented in Table AMS11.1.

AMS11-1

T A B L E A M S 1 1 . 1

Update Times for Three Different Systems

System1 System2 System3

38.8 41.8 32.9
42.1 36.4 36.1
45.2 39.1 39.2
34.8 28.7 29.3
48.3 36.4 41.9
37.8 36.1 31.7
41.1 35.8 35.2
43.6 33.7 38.1

EXERCISE
1. Analyze the data in Table AMS11.1 and write a report to

the computer operations department that indicates your
findings. Include an appendix in which you discuss the
reason you selected a particular statistical test to compare
the three e-mail interfaces.

DO NOT CONTINUE UNTIL THE PHASE 1 EXERCISE
HAS BEEN COMPLETED.

Phase 2
After analyzing the data in Table AMS11.1, the computer
operations department team decided to also study the effect
of the connection media used (cable or fiber).

The team designed a study in which a total of 30 sub-
scribers were chosen. The subscribers were randomly as-
signed to one of the three messaging systems so that there
were five subscribers in each of the six combinations of the
two factors—messaging system and media used. Measure-
ments were taken on the updated time. Table AMS11.2 sum-
marizes the results (stored in ).AMS11-2



R E F E R E N C E S
1. Berenson, M. L., D. M. Levine, and M. Goldstein,

Intermediate Statistical Methods and Applications: A
Computer Package Approach (Upper Saddle River, NJ:
Prentice Hall, 1983).

2. Conover, W. J., Practical Nonparametric Statistics,
3rd ed. (New York: Wiley, 2000).

3. Daniel, W. W., Applied Nonparametric Statistics, 2nd ed.
(Boston: PWS Kent, 1990).

4. Gitlow, H. S., and D. M. Levine, Six Sigma for Green
Belts and Champions: Foundations, DMAIC, Tools,
Cases, and Certification (Upper Saddle River, NJ: Fi-
nancial Times/Prentice Hall, 2005).

5. Hicks, C. R., and K. V. Turner, Fundamental Concepts in
the Design of Experiments, 5th ed. (New York: Oxford
University Press, 1999).

6. Kutner, M. H, J. Neter, C. Nachtsheim, and W. Li,
Applied Linear Statistical Models, 5th ed. (New York:
McGraw-Hill-Irwin, 2005).

7. Levine, D. M., Statistics for Six Sigma Green Belts (Up-
per Saddle River, NJ: Financial Times/Prentice Hall,
2006).

8. Microsoft Excel 2010 (Redmond, WA: Microsoft Corp.,
2010).

9. Minitab Release 16 (State College, PA: Minitab, Inc.,
2010).

10. Montgomery, D. M., Design and Analysis of Experi-
ments, 6th ed. (New York: Wiley, 2005).

458 CHAPTER 11 Analysis of Variance

EXERCISE
2. Completely analyze these data and write a report to the

team that indicates the importance of each of the two fac-
tors and/or the interaction between them on the length of
the call. Include recommendations for future experiments
to perform.

T A B L E A M S 1 1 . 2

Update Times (in seconds), Based on Messaging
System and Media Used

INTERFACE

MEDIA System1 System2 System3

Cable 4.56 4.17 3.53
4.90 4.28 3.77
4.18 4.00 4.10
3.56 3.96 2.87
4.34 3.60 3.18

Fiber 4.41 3.79 4.33
4.08 4.11 4.00
4.69 3.58 4.31
5.18 4.53 3.96
4.85 4.02 3.32

D I G I TA L C A S E
Apply your knowledge about ANOVA in this Digital Case,
which continues the cereal-fill packaging dispute Digital
Case from Chapters 7, 9, and 10.

After reviewing CCACC’s latest document (see the Digital
Case for Chapter 10 on page 405), Oxford Cereals has re-
leased SecondAnalysis.pdf, a press kit that Oxford Cereals
has assembled to refute the claim that it is guilty of using se-
lective data. Review the Oxford Cereals press kit and then
answer the following questions.

1. Does Oxford Cereals have a legitimate argument? Why or
why not?

2. Assuming that the samples Oxford Cereals has posted
were randomly selected, perform the appropriate analysis
to resolve the ongoing weight dispute.

3. What conclusions can you reach from your results? If you
were called as an expert witness, would you support the
claims of the CCACC or the claims of Oxford Cereals?
Explain.



EG11.1 The COMPLETELY RANDOMIZED
DESIGN: ONE-WAY ANALYSIS of
VARIANCE

One-Way ANOVA F Test for Differences Among
More Than Two Means

PHStat2 Use One-Way ANOVA to perform the one-way
ANOVA F test. For example, to perform the Figure 11.6
one-way ANOVA for the parachute experiment on page 422,
open to the DATA worksheet of the Parachute workbook.
Select PHStat ➔ Multiple-Sample Tests ➔ One-Way
ANOVA. In the procedure’s dialog box (shown below):

1. Enter 0.05 as the Level of Significance.

2. Enter A1:D6 as the Group Data Cell Range.

3. Check First cells contain label.

4. Enter a Title, clear the Tukey-Kramer Procedure
check box, and click OK.

data cell range) � DEVSQ(group 2 data cell range) . . .
� DEVSQ(group n data cell range) to compute SSA, the
sum of squares among groups in cell B13. The worksheet
also uses the FINV and FDIST worksheet functions to
compute the F critical value and the p-value in cells F13
and G13, respectively.

Modifying the One-Way ANOVA workbook for use
with other problems is a bit more difficult than modifica-
tions discussed in the Excel Guide in previous chapters, but
it can be done using these steps:

1. Paste the data for the problem into the ASFData work-
sheet, overwriting the parachute experiment data.

In the COMPUTE worksheet (see Figure 11.6):

2. Edit the SST formula =DEVSQ(ASFData!A1:D6) in
cell B16 to use the cell range of the new data just pasted
into the ASFData worksheet.

3. Edit the cell B13 SSA formula so there are as many
DEVSQ(group n data cell range) terms as there are
groups.

4. Change the level of significance in cell G17, if necessary.

5. If the problem contains three groups, select row 8, right-
click, and select Delete from the shortcut menu.

6. If the problem contains more than four groups, select
row 8, right-click, and click Insert from the shortcut
menu. Repeat this step as many times as necessary.

7. If the problem contains more than four groups, cut and
paste the formulas in columns B through E of the new
last row of the summary table to the cell range B8:E8.
(These formulas were in row 8 before you inserted new
rows.) For each new row inserted, enter formulas in
columns B through E that refer to the next subsequent
column in the ASFData worksheet.

8. Adjust table formatting as necessary.

Open to the COMPUTE_FORMULAS worksheet of
the One-Way ANOVA workbook to examine the details of
other formulas used in the COMPUTE worksheet. Of note
is the expression COUNTA(ASFData!1:1), a novel way to
determine the number of groups by counting the number of
column heading entries found in row 1 of the ASFData
worksheet.

Analysis ToolPak Use Anova: Single Factor to perform
the one-way ANOVA F test. For example, to perform the
Figure 11.6 one-way ANOVA for the parachute experiment
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In addition to the worksheet shown in Figure 11.6, this
procedure creates an ASFData worksheet to hold the data
used for the test. See the following In-Depth Excel section
for a complete description of this worksheet.

In-Depth Excel Use the COMPUTE worksheet of the
One-Way ANOVA workbook, shown in Figure 11.6 on
page 422, as a template for performing the one-way
ANOVA F test. The worksheet performs the test for the Sec-
tion 11.1 parachute experiment, using the data in the
ASFData worksheet. The SSA in cell B13 is labeled
Between Groups (not Among Groups) for consistency with
the Analysis ToolPak results.

In cell B16, the worksheet uses DEVSQ(cell range of

data of all groups) to compute SST, the total variation, and
uses an expression in the form SST � DEVSQ(group 1



The Analysis ToolPak creates a worksheet that is visu-
ally similar to Figure 11.6 but a worksheet that does not in-
clude any cell formulas. The ToolPak worksheet also does
not contain the level of significance in row 17.

Multiple Comparisons: The Tukey-Kramer
Procedure

PHStat2 Use the PHStat2 instructions for the one-way
ANOVA F test to perform the Tukey-Kramer procedure, but
in step 4, check Tukey-Kramer Procedure instead of clear-
ing this check box. The procedure creates a worksheet iden-
tical to the one shown in Figure 11.7 on page 424 and
discussed in the following In-Depth Excel section. To com-
plete the worksheet, enter the Studentized Range Q statis-
tic (look up the value using Table E.7 on pages 809–810) for
the level of significance and the numerator and denomina-
tor degrees of freedom that are given in the worksheet.

In-Depth Excel To perform the Tukey-Kramer procedure,
first use the In-Depth Excel instructions for the one-way
ANOVA F test. Then open to the appropriate “TK”
worksheet in the One-Way ANOVA workbook and enter
the Studentized Range Q statistic (look up the value using
Table E.7 on pages 809–810) for the level of significance
and the numerator and denominator degrees of freedom that
are given in the worksheet.

For example, to create the Figure 11.7 Tukey-Kramer
worksheet for the parachute experiment on page 424, use the
one-way ANOVA instructions and then open to the TK4
worksheet. Enter the Studentized Range Q statistic (look up
the value using Table E.7 on pages 809–810) in cell B15 for

the level of significance and the numerator and denominator
degrees of freedom that are given in cells B11 through B13.

Other TK worksheets can be used for problems using
three (TK3), four (TK4), five (TK5), six (TK6), or seven
(TK7) groups. When you use either the TK5, TK6, and
TK7 worksheets, you must also enter the name, sample
mean, and sample size for the fifth and, if applicable, sixth
and seventh groups. Open to the TK4_FORMULAS work-
sheet of the One-Way ANOVA workbook to examine the
details of all the formulas found in a TK worksheet.

Analysis ToolPak Adapt the previous In-Depth Excel in-
structions to perform the Tukey-Kramer procedure in con-
junction with using the Anova: Single Factor procedure.
Transfer selected values from the ToolPak results worksheet
to one of the TK worksheets in the One-Way ANOVA work-
book. For example, to perform the Figure 11.7 Tukey-
Kramer procedure for the parachute experiment on page 424:

1. Use the Anova: Single Factor procedure, as described
earlier in this section to create a worksheet that contains
ANOVA results for the parachute experiment.

2. Record the name, sample size (in the Count column),
and sample mean (in the Average column) of each
group. Also record the MSW value, found in the cell that
is the intersection of the MS column and Within
Groups row, and the denominator degrees of freedom,
found in the cell that is the intersection of the df column
and Within Groups row.

3. Open to the TK4 worksheet of the One-Way ANOVA
workbook.

In the TK4 worksheet:

4. Overwrite the formulas in cell range A5:C8 by entering
the name, sample mean, and sample size of each group
into that range.

5. Enter 0.05 in cell B11 (the level of significance used in
the Anova: Single Factor procedure).

6. Enter 4 in cell B12 as the Numerator d.f. (equal to the
number of groups).

7. Enter 16 in cell B13 as the Denominator d.f.

8. Enter 6.094 in cell B14 as the MSW.

9. Enter 4.05 in cell B15 as the Q Statistic. (Look up the
Studentized Range Q statistic using Table E.7 on
pages 809–810.)

Levene Test for Homogeneity of Variance

PHStat2 Use Levene Test to perform this test. For exam-
ple, to perform the Figure 11.8 Levene test for the para-
chute experiment on page 426, open to the DATA
worksheet of the Parachute workbook. Select PHStat ➔
Multiple-Sample Tests ➔ Levene Test. In the procedure’s
dialog box (shown on page 461):

1. Enter 0.05 as the Level of Significance.

2. Enter A1:D6 as the Sample Data Cell Range.
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on page 422, open to the DATA worksheet of the
Parachute workbook and:

1. Select Data ➔ Data Analysis.

2. In the Data Analysis dialog box, select Anova: Single
Factor from the Analysis Tools list and then click OK.

In the procedure’s dialog box (shown below):

3. Enter A1:D6 as the Input Range.

4. Click Columns, check Labels in First Row, and enter
0.05 as Alpha.

5. Click New Worksheet Ply.

6. Click OK.
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3. Check First cells contain label.

4. Enter a Title and click OK.

This procedure works only with data in which the
sample sizes of each group are equal. The procedure cre-
ates a worksheet that performs the Table 11.4 absolute dif-
ferences computations (see page 425) as well as the
worksheet shown in Figure 11.8 (see page 426). (See the
following In-Depth Excel section for a description of these
worksheets.)

In-Depth Excel Use the COMPUTE worksheet of the
Levene workbook, shown in Figure 11.8 on page 426, as
a template for performing the Levene test. The worksheet
performs the test using the data in the AbsDiffs
worksheet, which computes absolute differences based on
values in the DATA worksheet.

The COMPUTE worksheet shares its design with the
COMPUTE worksheet of the One-Way ANOVA work-
book. For other problems in which the absolute differences
are already known, paste the absolute differences into the
AbsDiffs worksheet. Otherwise, paste the problem data
into the DATA worksheet, add formulas to compute the
median for each group, and adjust the AbsDiffs worksheet
as necessary. For example, for the parachute experiment
data, the following steps 1 through 7 were done with the
workbook open to the DATA worksheet.

1. Enter the label Medians in cell A7, the first empty cell
in column A.

2. Enter the formula =MEDIAN(A2:A6) in cell A8. (Cell
range A2:A6 contains the data for the first group, Sup-
plier 1.)

3. Copy the cell A8 formula across through column D.

4. Open to the AbsDiffs worksheet.

In the AbsDiffs worksheet:

5. Enter row 1 column headings AbsDiff1, AbsDiff2,
AbsDiff3, and AbsDiff4 in columns A through D.

6. Enter the formula =ABS(DATA!A2 – DATA!A8) in
cell A2. Copy this formula down through row 6. This
formula computes the absolute difference of the first
data value (DATA!A2) and the median of the Supplier
1 group data (DATA!A8).

7. Copy the formulas now in cell range A2:A6 across
through column D. Absolute differences now appear in
the cell range A2:D6.

Analysis ToolPak Use Anova: Single Factor with absolute
difference data to perform the Levene test. If the absolute differ-
ences have not already been computed, use steps 1 through 7 of
the preceding In-Depth Excel instructions to compute them.

EG11.2 The RANDOMIZED BLOCK DESIGN

In-Depth Excel Use the COMPUTE worksheet of the
Randomized Block workbook, shown in Figure 11.10 on
page 434, as a model for analyzing randomized block de-
signs. The worksheet uses the data for the fast-food chain
study example of Section 11.2 that is in the Data
worksheet. In the ANOVA summary table of this work-
sheet, the source labeled Among groups (A) in Table 11.6
on page 433 is labeled Columns, and the source Among
blocks (BL) is labeled Rows.

In cell B23, the worksheet uses DEVSQ(cell range of

all data) to compute SST. In cell B19, a formula subtracts
the list of DEVSQs for each group from SST to compute
SSA. In cell B20, a formula subtracts the list of DEVSQs for
each block from SST to compute SSBL. In cell B21, a for-
mula subtracts SSA and SSBL from SST to compute SSE.

Open to the COMPUTE_FORMULAS worksheet to
examine the formulas used in the COMPUTE worksheet.
Modifying the COMPUTE worksheet workbook for use
with other problems is both challenging and beyond the
scope of this book. To attempt a modification, study and
then modify the Section EG11.3 In-Depth Excel instruc-
tions or, better, use the Analysis ToolPak instructions to cre-
ate the worksheet results.

Analysis ToolPak Use Anova: Two-Factor Without
Replication to analyze a randomized block design. This
procedure requires that the labels that identify blocks appear
stacked in column A and that group names appear in row 1,
starting with cell B1.

For example, to create a worksheet similar to Figure 11.10
on page 434 that analyzes the randomized block design for the
fast-food chain study example of Section 11.2, open to the
DATA worksheet of the FFChain workbook and:

1. Select Data ➔ Data Analysis.

2. In the Data Analysis dialog box, select Anova: Two-
Factor Without Replication from the Analysis Tools list
and then click OK.

In the procedure’s dialog box (shown on page 462):

3. Enter A1:E7 as the Input Range.

4. Check Labels and enter 0.05 as Alpha.

5. Click New Worksheet Ply.

6. Click OK.



The Analysis ToolPak creates a worksheet that is visu-
ally similar to Figure 11.10 but contains only values and
does not include any cell formulas. The ToolPak worksheet
also does not contain the level of significance in row 24.

EG11.3 The FACTORIAL DESIGN: TWO-WAY
ANALYSIS of VARIANCE

PHStat2 Use Two-Way ANOVA with replication to per-
form a two-way ANOVA. This procedure requires that the
labels that identify factor A appear stacked in column A,
followed by columns for factor B. For example, to perform
the Figure 11.14 two-way ANOVA for the supplier and
loom parachute example on page 443, open to the DATA
worksheet of the Parachute2 workbook. Select PHStat
➔ Multiple-Sample Tests ➔ Two-Way ANOVA. In the
procedure’s dialog box (shown below):

1. Enter 0.05 as the Level of Significance.

2. Enter A1:E11 as the Sample Data Cell Range.

3. Check First cells contain label.

4. Enter a Title and click OK.

In cell B30, the worksheet uses DEVSQ(cell range of

all data) to compute SST. In cell B25, a formula subtracts
the list of DEVSQs for each level of Factor A from SST to
compute SSA. In cell B26, a formula subtracts the list of
DEVSQs for each level of Factor B from SST to compute
SSB. In cell B28, a formula adds the DEVSQs for each com-
bination of levels of the two factors to compute SSE. In cell
B27, a formula subtracts SSA, SSB, and SSE from SST to
compute SSAB.

Modifying the Two-Way ANOVA workbook for use
with other problems with different r and c values can be dif-
ficult. For example, in the COMPUTE worksheet, because
Factor A has 2 levels (r = 2) and Factor B has 4 levels (c =
4), the formula for SSE in cell B28 contains 8 (r times c)
different DEVSQ terms. For another problem in which

and the formula would expand to 16 different
DEVSQ terms—quite a lot to enter correctly! You should
use PHStat2 or the Analysis ToolPak for such complicated
problems.

For problems similar to the supplier and loom parachute
example of Section 11.3, use the following steps to modify
the Two-Way ANOVA workbook:
1. Paste the data for the problem into the TWAData

worksheet, overwriting the parachute experiment
data.

In the COMPUTE worksheet (see Figure 11.14 on page 443):

2. Select the cell range E1:E20 (the current Supplier 4
column).

3. For problems in which right-click and select
Insert from the shortcut menu. In the Insert dialog box,
click Shift cells right and click OK. Repeat this step as
many times as necessary.

4. For problems in which right-click and select
Delete from the shortcut menu. In the Delete dialog box,
click Shift cells left and click OK.

5. For problems in which select cell range D1:D20,
right-click, and select Delete from the shortcut menu. In
the Delete dialog box, again click Shift cells left and
click OK.

6. For problems in which select the cell range
A10:G15 (which includes the current Turk rows).
Right-click and select Insert from the shortcut menu.
In the Insert dialog box, click Shift cells down and
click OK. Repeat the previous sentence as many times
as necessary. Enter new row labels in the new column A
cells as necessary.

7. Edit the formulas in the top table area. Remember
that each cell range in every formula in this area
refers to a cell range on the TWAData worksheet that
contains the range that hold the n’ number of cells
for a unique combination of a Factor A level and a
Factor B level.

8. Edit the column B formulas for SSA, SSB, SSE, and SST
that appear in the ANOVA summary table at the bottom

r 7 2,

c = 2,

c 6 4,

c 7 4,

c = 4,r = 4
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See the following In-Depth Excel section for a complete
description of the worksheets.

In-Depth Excel Use the COMPUTE worksheet of the
Two-Way ANOVA workbook, shown in Figure 11.14 on
page 443, as a model for performing a two-way ANOVA.
The worksheet performs the test for the supplier and loom
parachute example of Section 11.3. In the ANOVA sum-
mary table of this worksheet, the source labeled A in Table
11.8 on page 442 is labeled Sample, source B is labeled
Columns, source AB is labeled Interaction, and source
Error is labeled Within.



of the worksheet. (The formula for SSAB does not need
to be edited.) As noted earlier, this step becomes harder
as the product of r and c increases.

Open to the COMPUTE_FORMULAS worksheet of
the Two-Way ANOVA workbook to examine the formulas
used in the COMPUTE worksheet. Of special note is the
complex expression INT(COUNTA(TWAData!A:A) /
COUNTIF(TWAData!A:A, TWAData!A2)) - 1 in cell
C25 that computes 

Analysis ToolPak Use Anova: Two-Factor With Repli-
cation to perform a two-way ANOVA. This procedure re-
quires that the labels that identify factor A appear stacked in
column A, followed by columns for factor B. For example,
to create a worksheet that performs the two-way ANOVA for
the supplier and loom parachute example of Section 11.3,
similar to Figure 11.14 on page 443, open to the DATA
worksheet of the Parachute2 workbook and:

1. Select Data ➔ Data Analysis.

2. In the Data Analysis dialog box, select Anova: Two-
Factor With Replication from the Analysis Tools list
and then click OK.

In the procedure’s dialog box (shown below):

3. Enter A1:E11 as the Input Range.

4. Enter 5 as the Rows per sample.

5. Enter 0.05 as Alpha.

6. Click New Worksheet Ply.

7. Click OK.

r - 1.
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The Analysis ToolPak creates a worksheet that is visually
similar to Figure 11.14 on page 443 but contains only values
and does not include any cell formulas. This worksheet also
does not contain the level of significance in row 31.

Visualizing Interaction Effects: The Cell Means Plot

PHStat2 Use the PHStat2 instructions for the two-way
ANOVA. In step 4, check Cell Means Plot before
clicking OK.

In-Depth Excel Create a cell means plot from a two-way
ANOVA results worksheet. To organize the data, insert a
new worksheet and first copy and paste the Factor B level
names to row 1 of the new worksheet and then copy and use
Paste Special to transfer the values in the Average rows data
for each Factor B level to the new worksheet. (See Appen-
dix Section F.6 to learn more about the Paste Special
command.)

For example, to create the Figure 11.17 cell means
plot for the mean tensile strength for suppliers and looms
on page 446, open to the COMPUTE worksheet of the
Two-Way ANOVA workbook (shown in Figure 11.14 on
page 443) and:

1. Insert a new worksheet.

2. Copy and paste the cell range B3:E3 of the COMPUTE
worksheet (the Factor B level names) to cell B1 of the
new worksheet.

3. Copy the cell range B7:E7 of the COMPUTE worksheet
(the AVERAGE row for the Jetta level of Factor A) and
paste to cell B2 of the new worksheet, using the Paste
Special Values option.

4. Copy the cell range B13:E13 of the COMPUTE work-
sheet (the AVERAGE row for the Turk level of Factor A)
and paste to cell B3 of a new worksheet, using the Paste
Special Values option.

5. Enter Jetta in cell B3 and Turk in cell A3 of the new
worksheet as labels for the Factor A levels.

6. Select the cell range A1:E3.

7. Select Insert ➔ Line and select the fourth 2-D Line
gallery choice (Line with Markers).

8. Relocate the chart to a chart sheet and adjust the chart
formatting by using the instructions in Appendix Section
F.4.

Analysis ToolPak Use the In-Depth Excel instructions for
creating a cell means plot.



MG11.1 The COMPLETELY RANDOMIZED
DESIGN: ONE-WAY ANALYSIS of
VARIANCE

Use Main Effects Plot to create a main effects plot and use
One-Way (Unstacked) or One-Way to perform the one-way
ANOVA F test. (Main Effects Plot requires stacked data.)

For example, to create the Figure 11.4 main effect plot
for the Section 11.1 parachute experiment on page 420,
open to the ParachuteStacked worksheet. Select Stat ➔
ANOVA ➔ Main Effects Plot. In the Main Effects Plot dia-
log box (shown below):

1. Double-click C2 Strength in the variables list to add
Strength to the Responses box and press Tab.

2. Double-click C1 Supplier in the variables list to add
Supplier to the Factors box.

3. Click OK.

In the One-Way Multiple Comparisons dialog box (not
shown):

4. Clear all check boxes.

5. Click OK.

6. Back in the original dialog box, click Graphs.

In the One-Way Analysis of Variance - Graphs dialog box
(not shown):

7. Check Boxplots of data.

8. Click OK.

9. Back in the original dialog box, click OK.

For problems that use stacked data, select Stat ➔
ANOVA ➔ One-Way and in step 1 enter the name of the
column that contains the measurements in the Response
box and enter the name of the column that contains the fac-
tor names in the Factor box.

Multiple Comparisons: The Tukey-Kramer
Procedure

Use the previous set of instructions to perform the Tukey-
Kramer procedure, replacing step 4 with:

4. Check Tukey’s, family error rate and enter 5 in its box.
(A family error rate of 5 produces comparisons with an
overall confidence level of 95%.)

Levene Test for Homogeneity of Variance

Use Test for Equal Variances to perform the Levene test.
The procedure requires stacked data (see Section MG2.3 on
page 87). For example, to perform the Figure 11.8 Levene
test for the parachute experiment on page 426, open to the
ParachuteStacked worksheet, which contains the data of
the Parachute worksheet in stacked order. Select Stat ➔
ANOVA ➔ Test for Equal Variances. In the Test for Equal
Variances dialog box (shown at the top of page 465):

1. Double-click C2 Strength in the variables list to add
Strength to the Response box

2. Double-click C1 Supplier in the variables list to add
Supplier to the Factor box.

3. Enter 95.0 in the Confidence level box.

4. Click OK.

C H A P T E R 1 1 M I N I TA B G U I D E

To perform the Figure 11.6 one-way ANOVA for the para-
chute experiment on page xx, open to the PARACHUTE
worksheet. Select Stat ➔ANOVA ➔ One-Way (Unstacked).
In the One-Way Analysis of Variance dialog box (shown
below):

1. Enter 'Supplier 1'-'Supplier 4' in the Responses (in
separate columns) box.

2. Enter 95.0 in the Confidence level box.

3. Click Comparisons.
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The Levene test results shown in Figure 11.8 on
page 426 will be part of the results of this procedure.

MG11.2 The RANDOMIZED BLOCK DESIGN

Use Two-Way to analyze a randomized block design. For ex-
ample, to create a worksheet similar to Figure 11.10 on page
434 that analyzes the randomized block design for the fast-
food chain study example of Section 11.2, open to the
FFChain worksheet. Select Stat ➔ANOVA ➔ Two-Way. In
the Two-Way Analysis of Variance dialog box (shown below):

1. Double-click C3 Rating in the variables list to add
Rating to the Response box.

2. Double-click C1 Rater in the variables list to add
Rater to the Row factor box.

3. Double-click C2 Restaurant in the variables list to
add Restaurant to the Column factor box.

4. Check Display means for both the row and column
factors.

5. Check Fit Additive Model.

6. Enter 95.0 in the Confidence level box.

7. Click OK.

MG11.3 The FACTORIAL DESIGN: TWO-WAY
ANALYSIS of VARIANCE

Use Two-Way to perform a two-way ANOVA. This proce-
dure requires stacked data. For example, to perform the
Figure 11.14 two-way ANOVA for the supplier and loom
parachute example on page 443, open to the Parachute2

worksheet. Select Stat ➔ ANOVA ➔ Two-Way. In the
Two-Way Analysis of Variance dialog box (shown below):

1. Double-click C3 Strength in the variables list to add
Strength to the Response box.

2. Double-click C1 Loom in the variables list to add
Loom to the Row factor box.

3. Double-click C2 Supplier in the variables list to add
Supplier to the Column factor box.

4. Check Display Means for both the row and column
factors.

5. Enter 95.0 in the Confidence level box.

6. Click OK.

Visualizing Interaction Effects: The Cell Means
Plot

Use Interactions Plot to create a cell means plot. This pro-
cedure requires stacked data. For example, to create a plot
similar to the Figure 11.17 cell means plot of tensile
strength based on loom and supplier on page 446, open to
the Parachute2 worksheet. Select Stat ➔ ANOVA ➔ In-
teractions Plot. In the Interactions Plot dialog box (shown
below):

1. Double-click C3 Strength in the variables list to add
Strength to the Responses box and press Tab.

2. Double-click C1 Loom in the variables list to add
Loom to the Factors box.

3. Double-click C2 Supplier in the variables list to add
Supplier to the Factors box.

4. Clear Display full interaction plot matrix.

5. Click OK.
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Learning Objectives
In this chapter, you learn:

• How and when to use the chi-square test for contingency tables

• How to use the Marascuilo procedure for determining pairwise differences when
evaluating more than two proportions

• How and when to use the McNemar test

• How to use the chi-square test for a variance or standard deviation

• How and when to use nonparametric tests

Chi-Square Tests and
Nonparametric Tests12
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U S I N G S TAT I S T I C S

@ T.C. Resort Properties

You are the manager of T.C. Resort Properties, a collection of five upscale hotels
located on two tropical islands. Guests who are satisfied with the quality of services
during their stay are more likely to return on a future vacation and to recommend the
hotel to friends and relatives. You have defined the business objective as improving
the return rate at the hotels. To assess the quality of services being provided by your

hotels, guests are encouraged to complete a satisfaction survey when they check out. You need to 
analyze the data from these surveys to determine the overall satisfaction with the services provided,
the likelihood that the guests will return to the hotel, and the reasons some guests indicate that they
will not return. For example, on one island, T.C. Resort Properties operates the Beachcomber and
Windsurfer hotels. Is the perceived quality at the Beachcomber Hotel the same as at the Windsurfer
Hotel? If there is a difference, how can you use this information to improve the overall quality of 
service at T.C. Resort Properties? Furthermore, if guests indicate that they are not planning to return,
what are the most common reasons given for this decision? Are the reasons given unique to a certain
hotel or common to all hotels operated by T.C. Resort Properties?



468 CHAPTER 12 Chi-Square Tests and Nonparametric Tests

I n the preceding three chapters, you used hypothesis-testing procedures to analyze both
numerical and categorical data. Chapter 9 presented some one-sample tests, and Chapter
10 developed several two-sample tests. Chapter 11 discussed the analysis of variance

(ANOVA), which you use to study one or two factors of interest. This chapter extends hypoth-
esis testing to analyze differences between population proportions based on two or more sam-
ples, to test the hypothesis of independence in the joint responses to two categorical variables,
and to test for a population variance or standard deviation. The chapter concludes with non-
parametric tests as alternatives to several hypothesis tests considered in Chapters 10 and 11.

12.1 Chi-Square Test for the Difference Between 
Two Proportions

In Section 10.3, you studied the Z test for the difference between two proportions. In this sec-
tion, the data are examined from a different perspective. The hypothesis-testing procedure uses
a test statistic that is approximated by a chi-square distribution. The results of this test
are equivalent to those of the Z test described in Section 10.3.

If you are interested in comparing the counts of categorical responses between two inde-
pendent groups, you can develop a two-way contingency table (see Section 2.2) to display the
frequency of occurrence of items of interest and items not of interest for each group. In
Chapter 4, contingency tables were used to define and study probability.

To illustrate the contingency table, return to the Using Statistics scenario concerning T.C.
Resort Properties. On one of the islands, T.C. Resort Properties has two hotels (the Beach-
comber and the Windsurfer). You define the business objective as improving the quality of serv-
ice at T.C. Resort Properties. You collect data from customer satisfaction surveys and focus on
the responses to the single question “Are you likely to choose this hotel again?” You organize
the results of the survey and determine that 163 of 227 guests at the Beachcomber responded
yes to “Are you likely to choose this hotel again?” and 154 of 262 guests at the Windsurfer re-
sponded yes to “Are you likely to choose this hotel again?” You want to analyze the results to
determine whether, at the 0.05 level of significance, there is evidence of a significant difference
in guest satisfaction (as measured by likelihood to return to the hotel) between the two hotels.

The contingency table displayed in Table 12.1, which has two rows and two columns, is
called a contingency table. The cells in the table indicate the frequency for each row
and column combination.

2 * 2

x21x22

T A B L E 1 2 . 1

Layout of a 
Contingency Table

2 * 2

COLUMN VARIABLE (GROUP)

ROW VARIABLE 1 2 Totals

Items of interest X1 X2 X
Items not of interest n1 - X1 n2 - X2 n - X
Totals n1 n2 n

where

n = n1 + n2 = total sample size

n2 = sample size in group 2

n1 = sample size in group 1

n - X = 1n1 - X12 + 1n2 - X22, the total number of items that are not of interest

X = X1 + X2, the total number of items of interest

n2 - X2 = number of items that are not of interest in group 2

n1 - X1 = number of items that are not of interest in group 1

X2 = number of items of interest in group 2

X1 = number of items of interest in group 1
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Table 12.2 contains the contingency table for the hotel guest satisfaction study. The con-
tingency table has two rows, indicating whether the guests would return to the hotel or would
not return to the hotel, and two columns, one for each hotel. The cells in the table indicate the
frequency of each row and column combination. The row totals indicate the number of guests
who would return to the hotel and those who would not return to the hotel. The column totals
are the sample sizes for each hotel location.

T A B L E 1 2 . 2

Contingency Table
for the Hotel Guest
Satisfaction Survey

2 * 2

HOTEL

CHOOSE HOTEL AGAIN? Beachcomber Windsurfer Total

Yes 163 154 317
No 64 108 172
Total 227 262 489

To test whether the population proportion of guests who would return to the Beachcomber,
is equal to the population proportion of guests who would return to the Windsurfer, you

can use the test for the difference between two proportions. To test the null hypothesis that
there is no difference between the two population proportions:

against the alternative that the two population proportions are not the same:

you use the test statistic, shown in Equation (12.1).x2
STAT

H1:p1 Z p2

H0:p1 = p2

X2
p2,p1,

TEST FOR THE DIFFERENCE BETWEEN TWO PROPORTIONS
The test statistic is equal to the squared difference between the observed and expected
frequencies, divided by the expected frequency in each cell of the table, summed over all
cells of the table.

(12.1)

where

observed frequency in a particular cell of a contingency table

expected frequency in a particular cell if the null hypothesis is true

The test statistic approximately follows a chi-square distribution with 1 degree of
freedom.1

x2
STAT

fe =

fo =

x2
STAT = a

all cells

1fo - fe22
fe

x2
STAT

x2

To compute the expected frequency, in any cell, you need to understand that if the null
hypothesis is true, the proportion of items of interest in the two populations will be equal. Then
the sample proportions you compute from each of the two groups would differ from each other
only by chance. Each would provide an estimate of the common population parameter,
A statistic that combines these two separate estimates together into one overall estimate of the
population parameter provides more information than either of the two separate estimates
could provide by itself. This statistic, given by the symbol represents the estimated overall
proportion of items of interest for the two groups combined (i.e., the total number of items of
interest divided by the total sample size). The complement of represents the esti-
mated overall proportion of items that are not of interest in the two groups. Using the notation
presented in Table 12.1 on page 468, Equation (12.2) defines p.

1 - p,p,

p,

p.

fe,

1In general, the degrees of freedom in
a contingency table are equal to
(number of rows - 1) multiplied by
(number of columns - 1).
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To compute the expected frequency, for cells that involve items of interest (i.e., the cells
in the first row in the contingency table), you multiply the sample size (or column total) for a
group by To compute the expected frequency, for cells that involve items that are not of in-
terest (i.e., the cells in the second row in the contingency table), you multiply the sample size (or
column total) for a group by

The test statistic shown in Equation (12.1) on page 469 approximately follows a
chi-square distribution (see Table E.4) with 1 degree of freedom. Using a level of signifi-
cance you reject the null hypothesis if the computed test statistic is greater than the
upper-tail critical value from the distribution with 1 degree of freedom. Thus, the decision rule is

Figure 12.1 illustrates the decision rule.

otherwise, do not reject H0.

Reject H0 if x2
STAT 7 x2

a;

x2
x2
a,x2

STATa,
(x2)

x2
STAT

1 - p.

fe,p.

fe,

0
α

Region of
Nonrejection

Critical
Value

Region of
Rejection

(1 – α)
2χ

F I G U R E 1 2 . 1
Regions of rejection and
nonrejection when using
the chi-square test for
the difference between
two proportions, with
level of significance a

COMPUTING THE ESTIMATED OVERALL PROPORTION FOR TWO GROUPS

(12.2)p =
X1 + X2

n1 + n2
=

X
n

If the null hypothesis is true, the computed test statistic should be close to zero be-
cause the squared difference between what is actually observed in each cell, and what is the-
oretically expected, should be very small. If is false, then there are differences in the
population proportions, and the computed test statistic is expected to be large. However,
what is a large difference in a cell is relative. The same actual difference between and from
a cell with a small number of expected frequencies contributes more to the test statistic
than a cell with a large number of expected frequencies.

To illustrate the use of the chi-square test for the difference between two proportions, re-
turn to the Using Statistics scenario concerning T.C. Resort Properties on page 467 and the
corresponding contingency table displayed in Table 12.2 on page 469. The null hypothesis

states that there is no difference between the proportion of guests who are
likely to choose either of these hotels again. To begin,

is the estimate of the common parameter the population proportion of guests who are
likely to choose either of these hotels again if the null hypothesis is true. The estimated pro-
portion of guests who are not likely to choose these hotels again is the complement of

Multiplying these two proportions by the sample size for the Beach-
comber Hotel gives the number of guests expected to choose the Beachcomber again and the
number not expected to choose this hotel again. In a similar manner, multiplying the two pro-
portions by the Windsurfer Hotel’s sample size yields the corresponding expected frequencies
for that group.

p, 1 - 0.6483 = 0.3517.

p,p

p =
X1 + X2

n1 + n2
=

163 + 154
227 + 262

=
317
489

= 0.6483

1H0:p1 = p22

x2
STAT

fefo
x2

STAT

H0fe,
fo,

x2
STAT
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Compute the expected frequencies for each of the four cells of Table 12.2 on page 469.

SOLUTION

Yes—Beachcomber: and so

Yes—Windsurfer: and so

No—Beachcomber: and so

No—Windsurfer: and so

Table 12.3 presents these expected frequencies next to the corresponding observed frequencies.

fe = 92.16n2 = 262,1 - p = 0.3517

fe = 79.84n1 = 227,1 - p = 0.3517

fe = 169.84n2 = 262,p = 0.6483

fe = 147.16n1 = 227,p = 0.6483

EXAMPLE 12.1
Computing the
Expected
Frequencies

T A B L E 1 2 . 3

Comparing the
Observed and
Expected
Frequencies

1fe2
1fo2

HOTEL

BEACHCOMBER WINDSURFER

CHOOSE HOTEL AGAIN? Observed Expected Observed Expected Total

Yes 163 147.16 154 169.84 317
No 64 79.84 108 92.16 172
Total 227 227.00 262 262.00 489

To test the null hypothesis that the population proportions are equal:

against the alternative that the population proportions are not equal:

you use the observed and expected frequencies from Table 12.3 to compute the test
statistic given by Equation (12.1) on page 469. Table 12.4 presents the calculations.

x2
STAT

H1:p1 Z p2

H0:p1 = p2

T A B L E 1 2 . 4

Computing the 
Test Statistic for 
the Hotel Guest
Satisfaction Survey

x2
STAT

fo fe 1fo - fe2 1fo - fe22 1fo - fe22>fe

163 147.16 15.84 250.91 1.71
154 169.84 -15.84 250.91 1.48
64 79.84 -15.84 250.91 3.14

108 92.16 15.84 250.91 2.72
9.05

The chi-square distribution is a right-skewed distribution whose shape depends
solely on the number of degrees of freedom. You find the critical value for the test from
Table E.4, a portion of which is presented as Table 12.5.

x2
1x22

T A B L E 1 2 . 5

Finding the Critical 
Value from the 
Chi-Square Distribution
with 1 Degree of
Freedom, Using the 
0.05 Level of 
Significance

Cumulative Probabilities

.005 .01 ... .95 .975 .99 .995

Upper-Tail Area

Degrees of Freedom .995 .99 ... .05 .025 .01 .005

1 ... 3.841 5.024 6.635 7.879
2 0.010 0.020 ... 5.991 7.378 9.210 10.597
3 0.072 0.115 ... 7.815 9.348 11.345 12.838
4 0.207 0.297 ... 9.488 11.143 13.277 14.860
5 0.412 0.554 ... 11.071 12.833 15.086 16.750
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These results include the expected frequencies, degrees of freedom, and p-value.

The computed test statistic is 9.0526, which is greater than the critical value of 3.8415 (or
the ), so you reject the null hypothesis that there is no difference in
guest satisfaction between the two hotels. The p-value, equal to 0.0026, is the probability of ob-
serving sample proportions as different as or more different from the actual difference between
the Beachcomber and Windsurfer observed in the sample data, if the10.718 - 0.588 = 0.132

p-value = 0.0026 6 0.05
x2

STAT

x2
STAT,

The values in Table 12.5 refer to selected upper-tail areas of the distribution. A
contingency table has degree of freedom. Using with 1 degree
of freedom, the critical value of from Table 12.5 is 3.841. You reject if the computed

test statistic is greater than 3.841 (see Figure 12.2). Because you
reject You conclude that the proportion of guests who would return to the Beachcomber is
different from the proportion of guests who would return to the Windsurfer.

H0.
x2

STAT = 9.05 7 3.841,x2
STAT

H0x2
a = 0.05,12 - 1212 - 12 = 1

2 * 2x2

Region of
Nonrejection

Critical
Value

Region of
Rejection

0 3.841

.05
.95

2χ

F I G U R E 1 2 . 2
Regions of rejection and
nonrejection when
finding the critical
value with 1 degree of
freedom, at the 0.05
level of significance

x2

Figure 12.3 shows the results for the Table 12.2 guest satisfaction contingency table on
page 469.

F I G U R E 1 2 . 3
Excel and Minitab chi-square test results for the two-hotel guest satisfaction data
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population proportions for the Beachcomber and Windsurfer hotels are equal. Thus, there is
strong evidence to conclude that the two hotels are significantly different with respect to guest
satisfaction, as measured by whether a guest is likely to return to the hotel again. From Table 12.3
on page 471 you can see that a greater proportion of guests are likely to return to the Beach-
comber than to the Windsurfer.

For the test to give accurate results for a table, you must assume that each ex-
pected frequency is at least 5. If this assumption is not satisfied, you can use alternative proce-
dures, such as Fisher’s exact test (see references 1, 2, and 4).

In the hotel guest satisfaction survey, both the Z test based on the standardized normal dis-
tribution (see Section 10.3) and the test based on the chi-square distribution provide the
same conclusion. You can explain this result by the interrelationship between the standardized
normal distribution and a chi-square distribution with 1 degree of freedom. For such situations,
the test statistic is the square of the test statistic. For instance, in the guest
satisfaction study, the computed test statistic is and the computed test sta-
tistic is 9.0526. Except for rounding error, this 9.0526 value is the square of [i.e.,

]. Also, if you compare the critical values of the test statistics from
the two distributions, at the 0.05 level of significance, the value of 3.841 with 1 degree of
freedom is the square of the Z value of Furthermore, the p-values for both tests are
equal. Therefore, when testing the null hypothesis of equality of proportions:

against the alternative that the population proportions are not equal:

the Z test and the test are equivalent.
If you are interested in determining whether there is evidence of a directional difference,

such as you must use the Z test, with the entire rejection region located in one tail of
the standardized normal distribution.

In Section 12.2, the test is extended to make comparisons and evaluate differences be-
tween the proportions among more than two groups. However, you cannot use the Z test if
there are more than two groups.

x2

p1 7 p2,

x2

H1:p1 Z p2

H0:p1 = p2

;1.96.
x2

1+3.008822 � 9.0526
+3.0088
x2

STAT+3.0088ZSTAT

ZSTATx2
STAT

x2

2 * 2x2

Problems for Section 12.1
LEARNING THE BASICS
12.1 Determine the critical value of with 1 degree of
freedom in each of the following circumstances:
a.
b.
c.

12.2 Determine the critical value of with 1 degree of
freedom in each of the following circumstances:
a.
b.
c.

12.3 Use the following contingency table:

a = 0.01
a = 0.025
a = 0.05

x2

a = 0.10
a = 0.005
a = 0.01

x2

a. Compute the expected frequency for each cell.
b. Compare the observed and expected frequencies for

each cell.
c. Compute Is it significant at 

12.4 Use the following contingency table:

a = 0.05?x2
STAT.

A B Total

1 20 30 50
2 30 20 50
Total 50 50 100

A B Total

1 20 30 50
2 30 45 75
Total 50 75 125

a. Compute the expected frequency for each cell.
b. Compute Is it significant at 

APPLYING THE CONCEPTS
12.5 A sample of 500 shoppers was selected in a large
metropolitan area to determine various information con-
cerning consumer behavior. Among the questions asked

a = 0.05?x2
STAT.



474 CHAPTER 12 Chi-Square Tests and Nonparametric Tests

was, “Do you enjoy shopping for clothing?” The results are
summarized in the following contingency table:

ENJOY SHOPPING
FOR CLOTHING

GENDER

Male Female Total

Yes 136 224 360
No 104 36 140
Total 240 260 500

a. Is there evidence of a significant difference between the
proportion of males and females who enjoy shopping for
clothing at the 0.01 level of significance?

b. Determine the p-value in (a) and interpret its meaning.
c. What are your answers to (a) and (b) if 206 males en-

joyed shopping for clothing and 34 did not?
d. Compare the results of (a) through (c) to those of Prob-

lem 10.29 (a), (b), and (d) on page 391.

12.6 Has the ease of removing your name from an e-mail
list changed? A study of 100 large online retailers revealed
the following:

NEED THREE OR MORE 
CLICKS TO BE REMOVED

YEAR Yes No

2009 39 61
2008 7 93

Source: Data extracted from “More Clicks to Escape an Email List,”
The NewYork Times, March 29, 2010, p. B2.

a. Set up the null and alternative hypotheses to try to deter-
mine whether the effort it takes to be removed from an
e-mail list has changed.

b. Conduct the hypothesis test defined in (a), using the 0.05
level of significance.

c. Why shouldn’t you compare the results in (a) to those of
Problem 10.30 (b) on page 391?

12.7 A survey was conducted of 665 consumer magazines
on the practices of their websites. Of these, 273 magazines
reported that online-only content is copy-edited as rigor-
ously as print content; 379 reported that online-only content
is fact-checked as rigorously as print content. (Data ex-
tracted from S. Clifford, “Columbia Survey Finds a Slack
Editing Process of Magazine Web Sites,” The New York
Times, March 1, 2010, p. B6.) Suppose that a sample of 500
newspapers revealed that 252 reported that online-only con-
tent is copy-edited as rigorously as print content and 296 re-
ported that online-only content is fact-checked as rigorously
as print content.
a. At the 0.05 level of significance, is there evidence of a

difference between consumer magazines and newspapers

in the proportion of online-only content that is copy-
edited as rigorously as print content ?

b. Find the p-value in (a) and interpret its meaning.
c. At the 0.05 level of significance, is there evidence of a

difference between consumer magazines and newspapers
in the proportion of online-only content that is fact-
checked as rigorously as print content?

d. Find the p-value in (c) and interpret its meaning.

12.8 Do people of different age groups differ in
their response to e-mail messages? A survey by

the Center for the Digital Future of the University of South-
ern California reported that 70.7% of users over age 70 be-
lieve that e-mail messages should be answered quickly, as
compared to 53.6% of users 12 to 50 years old. (Data
extracted from A. Mindlin, “Older E-mail Users Favor Fast
Replies,” The New York Times, July 14, 2008, p. B3.) Sup-
pose that the survey was based on 1,000 users over age 70
and 1,000 users 12 to 50 years old.
a. At the 0.01 level of significance, is there evidence of a

significant difference between the two age groups in their
belief that e-mail messages should be answered quickly?

b. Find the p-value in (a) and interpret its meaning.
c. Compare the results of (a) and (b) to those of Problem

10.32 on page 391.

12.9 Different age groups use different media sources
for news. A study on this issue explored the use of cell
phones for accessing news. The study reported that 47%
of users under age 50 and 15% of users age 50 and over
accessed news on their cell phones. (Data extracted from
“Cellphone Users Who Access News on Their Phones,”
USA Today, March 1, 2010, p. 1A.) Suppose that the sur-
vey consisted of 1,000 users under age 50, of whom 470
accessed news on their cell phones, and 891 users age 50
and over, of whom 134 accessed news on their cell
phones.
a. Construct a contingency table.
b. Is there evidence of a significant difference in the propor-

tion that accessed the news on their cell phones between
users under age 50 and users 50 years and older? (Use

)
c. Determine the p-value in (b) and interpret its meaning.
d. Compare the results of (b) and (c) to those of Problem

10.35 (a) and (b) on page 392.

12.10 How do Americans feel about ads on websites? A
survey of 1,000 adult Internet users found that 670 opposed
ads on websites. (Data extracted from S. Clifford, “Tracked
for Ads? Many Americans Say No Thanks,” The New York
Times, September 30, 2009, p. B3.) Suppose that a survey of
1,000 Internet users age 12–17 found that 510 opposed ads
on websites.
a. At the 0.05 level of significance, is there evidence of a

difference between adult Internet users and Internet users
age 12–17 in the proportion who oppose ads?

b. Find the p-value in (a) and interpret its meaning.

a = 0.05.

2 * 2

SELF
Test
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12.2 Chi-Square Test for Differences Among 
More Than Two Proportions

In this section, the test is extended to compare more than two independent populations. The
letter c is used to represent the number of independent populations under consideration. Thus,
the contingency table now has two rows and c columns. To test the null hypothesis that there
are no differences among the c population proportions:

against the alternative that not all the c population proportions are equal:

you use Equation (12.1) on page 469:

where

observed frequency in a particular cell of a contingency table

expected frequency in a particular cell if the null hypothesis is true

If the null hypothesis is true and the proportions are equal across all c populations, the c
sample proportions should differ only by chance. In such a situation, a statistic that combines
these c separate estimates into one overall estimate of the population proportion, provides
more information than any one of the c separate estimates alone. To expand on Equation (12.2)
on page 470, the statistic in Equation (12.3) represents the estimated overall proportion for
all c groups combined.

p

p,

fe =
2 * cfo =

x2
STAT = a

all cells

1fo - fe22
fe

H1: Not allpj are equal 1where j = 1, 2, Á , c2

H0:p1 = p2 = Á = pc

x2

COMPUTING THE ESTIMATED OVERALL PROPORTION FOR c GROUPS

(12.3)p =
X1 + X2 + Á + Xc

n1 + n2 + Á + nc
=

X
n

To compute the expected frequency, for each cell in the first row in the contingency
table, multiply each sample size (or column total) by To compute the expected frequency,
for each cell in the second row in the contingency table, multiply each sample size (or column
total) by The test statistic shown in Equation (12.1) on page 469 approximately
follows a chi-square distribution, with degrees of freedom equal to the number of rows in the
contingency table minus 1, multiplied by the number of columns in the table minus 1. For a

contingency table, there are degrees of freedom:

Using the level of significance you reject the null hypothesis if the computed test
statistic is greater than the upper-tail critical value from a chi-square distribution with

degrees of freedom. Therefore, the decision rule is

otherwise, do not reject H0.

Reject H0 if x2
STAT 7 x2

a;

c - 1
x2
a,

x2
STATa,

Degrees of freedom = 12 - 121c - 12 = c - 1

c - 12 * c

11 - p2.
fe,p.

fe,
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0
α

Region of
Nonrejection

Critical
Value

Region of
Rejection

χ2

(1 – α)

F I G U R E 1 2 . 4
Regions of rejection and
nonrejection when
testing for differences
among c proportions
using the testx2

To illustrate the test for equality of proportions when there are more than two groups,
return to the Using Statistics scenario on page 467 concerning T.C. Resort Properties. Once
again, you define the business objective as improving the quality of service, but this time, three
hotels located on a different island are to be surveyed. Data are collected from customer satis-
faction surveys at these three hotels. You organize the responses into the contingency table
shown in Table 12.6.

x2

T A B L E 1 2 . 6

Contingency Table
for Guest Satisfaction
Survey

2 * 3

HOTEL

CHOOSE HOTEL AGAIN? Golden Palm Palm Royale Palm Princess Total

Yes 128 199 186 513
No 88 33 66 187
Total 216 232 252 700

Because the null hypothesis states that there are no differences among the three hotels in
the proportion of guests who would likely return again, you use Equation (12.3) to calculate an
estimate of the population proportion of guests who would likely return again:

The estimated overall proportion of guests who would not be likely to return again is the
complement, or 0.267. Multiplying these two proportions by the sample size for each
hotel yields the expected number of guests who would and would not likely return.

11 - p2,

= 0.733

=
1128 + 199 + 1862
1216 + 232 + 2522 =

513
700

p =
X1 + X2 + Á + Xc

n1 + n2 + Á + nc
=

X
n

p,

Compute the expected frequencies for each of the six cells in Table 12.6.

SOLUTION

Yes—Golden Palm: and so

Yes—Palm Royale: and so

Yes—Palm Princess: and so

No—Golden Palm: and so

No—Palm Royale: and so

No—Palm Princess: and so fe = 67.32n3 = 252,1 - p = 0.267

fe = 61.98n2 = 232,1 - p = 0.267

fe = 57.70n1 = 216,1 - p = 0.267

fe = 184.68n3 = 252,p = 0.733

fe = 170.02n2 = 232,p = 0.733

fe = 158.30n1 = 216,p = 0.733

EXAMPLE 12.2
Computing the
Expected
Frequencies

Figure 12.4 illustrates this decision rule.
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T A B L E 1 2 . 7

Contingency Table of
Expected Frequencies
from a Guest Satisfaction
Survey of Three Hotels

HOTEL

CHOOSE HOTEL AGAIN? Golden Palm Palm Royale Palm Princess Total

Yes 158.30 170.02 184.68 513
No 57.70 61.98 67.32 187
Total 216.00 232.00 252.00 700

Table 12.7 presents these expected frequencies.

To test the null hypothesis that the proportions are equal:

against the alternative that not all three proportions are equal:

you use the observed frequencies from Table 12.6 and the expected frequencies from Table
12.7 to compute the test statistic [given by Equation (12.1) on page 469]. Table 12.8
presents the calculations.

x2
STAT

H1: Not allpj are equal 1where j = 1, 2, 32

H0:p1 = p2 = p3

T A B L E 1 2 . 8

Computing the 
Test Statistic for the
Guest Satisfaction 
Survey of Three Hotels

x2
STAT

fo fe 1fo - fe2 1fo - fe22 1fo - fe22>fe

128 158.30 -30.30 918.09 5.80
199 170.02 28.98 839.84 4.94
186 184.68 1.32 1.74 0.01
88 57.70 30.30 918.09 15.91
33 61.98 -28.98 839.84 13.55
66 67.32 -1.32 1.74 0.02

40.23

You use Table E.4 to find the critical value of the test statistic. In the guest satisfaction
survey, because there are three hotels, there are degrees of freedom.
Using the critical value with 2 degrees of freedom is 5.991 (see Figure 12.5).
Because the computed test statistic is 40.23, which is greater than this critical value, you
reject the null hypothesis.

x2
STAT

x2a = 0.05,
12 - 1213 - 12 = 2
x2

0 5.991

Region of
Nonrejection

Critical
Value

Region of
Rejection

.05.95
χ2

F I G U R E 1 2 . 5
Regions of rejection and
nonrejection when
testing for differences in
three proportions at the
0.05 level of significance,
with 2 degrees of
freedom

Figure 12.6 shows the results for this problem. The results also report the p-value. Because
the p-value is (approximately) 0.0000, less than you reject the null hypothesis. Fur-
ther, this p-value indicates that there is virtually no chance that there will be differences this
large or larger among the three sample proportions, if the population proportions for the three
hotels are equal. Thus, there is sufficient evidence to conclude that the hotel properties are dif-
ferent with respect to the proportion of guests who are likely to return.

a = 0.05,
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F I G U R E 1 2 . 6
Excel and Minitab chi-square test results for the Table 12.6 guest satisfaction data

For the test to give accurate results when dealing with contingency tables, all ex-
pected frequencies must be large. The definition of “large” has led to research among statisti-
cians. Some statisticians (see reference 5) have found that the test gives accurate results as long
as all expected frequencies are at least 0.5. Other statisticians, more conservative in their ap-
proach, believe that no more than 20% of the cells should contain expected frequencies less
than 5, and no cells should have expected frequencies less than 1 (see reference 3). As a rea-
sonable compromise between these points of view, to assure the validity of the test, you should
make sure that each expected frequency is at least 1. To do this, you may need to collapse two
or more low-expected-frequency categories into one category in the contingency table before
performing the test. If combining categories is undesirable, you can use one of the available
alternative procedures (see references 1, 2, and 7).

The Marascuilo Procedure
Rejecting the null hypothesis in a test of equality of proportions in a table only
allows you to reach the conclusion that not all c population proportions are equal. To deter-
mine which proportions differ, you use a multiple comparisons procedure such as the
Marascuilo procedure.

The Marascuilo procedure enables you to make comparisons between all pairs of groups.
First, you compute the sample proportions. Then, you use Equation (12.4) to compute the crit-
ical ranges for the Marascuilo procedure. You compute a different critical range for each pair-
wise comparison of sample proportions.

2 * cx2

2 * cx2

CRITICAL RANGE FOR THE MARASCUILO PROCEDURE

(12.4)Critical range = 2x2
aApj11 - pj2

nj
+

pj¿11 - pj¿2
nj¿

Then, you compare each of the pairs of sample proportions against its
corresponding critical range. You declare a specific pair significantly different if the absolute
difference in the sample proportions, is greater than its critical range.ƒpj - pj¿ ƒ ,

c1c - 12>2
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To apply the Marascuilo procedure, return to the guest satisfaction survey. Using the
test, you concluded that there was evidence of a significant difference among the population
proportions. From Table 12.6 on page 476, the three sample proportions are

Next, you compute the absolute differences in sample proportions and their corresponding
critical ranges. Because there are three hotels, there are pairwise compar-
isons. Using Table E.4 and an overall level of significance of 0.05, the upper-tail critical value
for a chi-square distribution having degrees of freedom is 5.991. Thus,

2x2
a = 25.991 = 2.4477

1c - 12 = 2

13213 - 12>2 = 3

p3 =
X3

n3
=

186
252

= 0.7381

p2 =
X2

n2
=

199
232

= 0.8578

p1 =
X1

n1
=

128
216

= 0.5926

x2

Absolute Difference in Proportions Critical Range

ƒpj - pj¿ ƒ 2.4477Apj(1 - pj)

nj
+

pj ¿(1 - pj ¿)

nj ¿

ƒp1 - p2 ƒ = ƒ0.5926 - 0.8578 ƒ = 0.2652 2.4477A (0.5926)(0.4074)

216
+ (0.8578)(0.1422)

232
= 0.0992

ƒp1 - p3 ƒ = ƒ0.5926 - 0.7381 ƒ = 0.1455 2.4477A (0.5926)(0.4074)

216
+ (0.7381)(0.2619)

252
= 0.1063

ƒp2 - p3 ƒ = ƒ0.8578 - 0.7381 ƒ = 0.1197 2.4477A (0.8578)(0.1422)

232
+ (0.7381)(0.2619)

252
= 0.0880

Figure 12.7 shows the Excel results for this example.

Minitab does not contain a
command to perform the
Marascuilo procedure.

F I G U R E 1 2 . 7
Excel Marascuilo
procedure results
worksheet for the guest
satisfaction survey

As the final step, you compare the absolute differences to the critical ranges. If the ab-
solute difference is greater than its critical range, the proportions are significantly different. At
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the 0.05 level of significance, you can conclude that guest satisfaction is higher at the Palm
Royale than at either the Golden Palm or the Palm Princess

and that guest satisfaction is also higher at the Palm Princess than at the Golden
Palm. These results clearly suggest that you should investigate possible reasons for these dif-
ferences. In particular, you should try to determine why satisfaction is significantly lower at
the Golden Palm than at the other two hotels.

Online Topic: The Analysis of Proportions (ANOP)
The ANOP procedure provides a confidence interval approach that allows you to determine
which, if any, of the c groups has a proportion significantly different from the overall mean of
all the group proportions combined. To study this topic, read the ANOP online topic file that
is available on this book’s companion website. (See Appendix C to learn how to access the on-
line topic files.)

1p3 = 0.7382 1p1 = 0.59321p2 = 0.8582

Problems for Section 12.2
LEARNING THE BASICS
12.11 Consider a contingency table with two rows and five
columns.
a. How many degrees of freedom are there in the contin-

gency table?
b. Determine the critical value for 
c. Determine the critical value for 

12.12 Use the following contingency table:

a = 0.01.
a = 0.05.

a. Compute the expected frequencies for each cell.
b. Compute Is it significant at 

12.13 Use the following contingency table:

a = 0.05?x2
STAT.

A B C Total

1 10 30 50 90
2 40 45 50 135
Total 50 75 100 225

A B C Total

1 20 30 25 75
2 30 20 25 75
Total 50 50 50 150

a. Compute the expected frequencies for each cell.
b. Compute Is it significant at 
c. If appropriate, use the Marascuilo procedure and

to determine which groups are different.

APPLYING THE CONCEPTS
12.14 How do Americans feel about online ads tailored to
their individual interests? A survey of 1,000 adult Internet
users found that 55% of the 18 to 24 year olds, 59% of 25 to
34 year olds, 66% of 35 to 49 year olds, 77% of 50 to 64

a = 0.05

a = 0.05?x2
STAT.

year olds, and 82% of 65 to 89 year olds opposed such ads.
(Data extracted from S. Clifford, “Tracked for Ads? Many
Americans Say No Thanks,” The New York Times, Septem-
ber 30, 2009, p. B3.) Suppose that the survey was based on
200 respondents in each of five age groups: 18 to 24, 25 to
34, 35 to 49, 50 to 64, and 65 to 89.
a. At the 0.05 level of significance, is there evidence of a

difference among the age groups in the opposition to ads
on web pages tailored to their interests?

b. Determine the p-value in (a) and interpret its meaning.
c. If appropriate, use the Marascuilo procedure and

= 0.05 to determine which age groups are different.

12.15 How do Americans feel about online discounts tai-
lored to their individual interests? A survey of 1,000 adult
Internet users found that 37% of the 18 to 24 year olds, 44%
of 25 to 34 year olds, 50% of 35 to 49 year olds, 58% of 50
to 64 year olds, and 70% of 65 to 89 year olds opposed such
discounts. (Data extracted from S. Clifford, “Tracked for
Ads? Many Americans Say No Thanks,” The New York
Times, September 30, 2009, p. B3.) Suppose that the survey
was based on 200 respondents in each of five age groups: 18
to 24, 25 to 34, 35 to 49, 50 to 64, and 65 to 89.
a. At the 0.05 level of significance, is there evidence of a

difference among the age groups in the opposition to dis-
counts on web pages tailored to their interests?

b. Compute the p-value and interpret its meaning.
c. If appropriate, use the Marascuilo procedure and

to determine which age groups are different.

12.16 More shoppers do the majority of their
grocery shopping on Saturday than any other day

of the week. However, is there a difference in the various
age groups in the proportion of people who do the majority
of their grocery shopping on Saturday? A study showed the
results for the different age groups. (Data extracted from
“Major Shopping by Day,” Progressive Grocer Annual

SELF
Test

a = 0.05

a
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Report, April 30, 2002.) The data were reported as percent-
ages, and no sample sizes were given:

AGE

MAJOR SHOPPING DAY Under 35 35–54 Over 54

Saturday 24% 28% 12%
A day other than 

Saturday
76% 72% 88%

Assume that 200 shoppers for each age group were
surveyed.
a. Is there evidence of a significant difference among the

age groups with respect to major grocery shopping day?
(Use )

b. Determine the p-value in (a) and interpret its meaning.
c. If appropriate, use the Marascuilo procedure and

to determine which age groups are different.
d. Discuss the managerial implications of (a) and (c). How

can grocery stores use this information to improve mar-
keting and sales? Be specific.

12.17 Repeat (a) and (b) of Problem 12.16, assuming that
only 50 shoppers for each age group were surveyed. Discuss
the implications of sample size on the test for differences
among more than two populations.

x2

a = 0.05

a = 0.05.

12.18 Is there a generation gap in music? A study reported
that 45% of 16 to 29 year olds, 42% of 30 to 49 year olds,
and 33% of 50 to 64 year olds often listened to rock music.
(Data extracted from A. Tugend, “Bridging the Workplace
Generation Gap: It Starts with a Text,” The New York Times,
November 7, 2009, p. B5.) Suppose that the study was based
on a sample of 200 respondents in each group.
a. Is there evidence of a significant difference among the

age groups with respect to the proportion who often lis-
tened to rock music? (Use )

b. Determine the p-value in (a) and interpret its meaning.
c. If appropriate, use the Marascuilo procedure and

to determine which age groups are different.

12.19 Is there a generation gap in music? A study reported
that 25% of 16 to 29 year olds, 21% of 30 to 49 year olds,
and 31% of 50 to 64 year olds often listened to country mu-
sic. (Data extracted from A. Tugend, “Bridging the Work-
place Generation Gap: It Starts with a Text,” The New York
Times, November 7, 2009, p. B5.) Suppose that the study
was based on a sample of 200 respondents in each group.
a. Is there evidence of a significant difference among the

age groups with respect to the proportion who often lis-
tened to country music? (Use )

b. Determine the p-value in (a) and interpret its meaning.
c. If appropriate, use the Marascuilo procedure and

to determine which age groups are different.a = 0.05.

a = 0.05.

a = 0.05.

a = 0.05.

12.3 Chi-Square Test of Independence
In Sections 12.1 and 12.2, you used the test to evaluate potential differences among popula-
tion proportions. For a contingency table that has r rows and c columns, you can generalize the

test as a test of independence for two categorical variables.
For a test of independence, the null and alternative hypotheses follow:

Once again, you use Equation (12.1) on page 469 to compute the test statistic:

You reject the null hypothesis at the level of significance if the computed value of the test
statistic is greater than the upper-tail critical value from a chi-square distribution with

degrees of freedom (see Figure 12.8 on page 482). Thus, the decision rule is

The test of independence is similar to the test for equality of proportions. The test
statistics and the decision rules are the same, but the null and alternative hypotheses and con-
clusions are different. For example, in the guest satisfaction survey of Sections 12.1 and 12.2,
there is evidence of a significant difference between the hotels with respect to the proportion

x2x2

otherwise, do not reject H0.

Reject H0 if x2
STAT 7 x2

a;

1r - 121c - 12 x2
a,

x2
STATa

x2
STAT = a

all cells

1fo - fe22
fe

H1: The two categorical variables are dependent 1i.e., there is a relationship between them2.
H0: The two categorical variables are independent 1i.e., there is no relationship between them2.

x2

x2
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Contingency Table of
Primary Reason for Not
Returning and Hotel

PRIMARY REASON FOR 
NOT RETURNING

HOTEL

Golden Palm Palm Royale Palm Princess Total

Price 23 7 37 67
Location 39 13 8 60
Room accommodation 13 5 13 31
Other 13 8 8 29
Total 88 33 66 187

482 CHAPTER 12 Chi-Square Tests and Nonparametric Tests

of guests who would return. From a different viewpoint, you could conclude that there is a sig-
nificant relationship between the hotels and the likelihood that a guest would return. However,
the two types of tests differ in how the samples are selected.

In a test for equality of proportions, there is one factor of interest, with two or more levels.
These levels represent samples drawn from independent populations. The categorical re-
sponses in each group or level are classified into two categories, such as item of interest and
not an item of interest. The objective is to make comparisons and evaluate differences between
the proportions of the items of interest among the various levels. However, in a test for inde-
pendence, there are two factors of interest, each of which has two or more levels. You select
one sample and tally the joint responses to the two categorical variables into the cells of a con-
tingency table.

To illustrate the test for independence, suppose that, in the survey on hotel guest satis-
faction, respondents who stated that they were not likely to return were asked what was the pri-
mary reason for their unwillingness to return to the hotel. Table 12.9 presents the resulting

contingency table.
In Table 12.9, observe that of the primary reasons for not planning to return to the hotel,

67 were due to price, 60 were due to location, 31 were due to room accommodation, and 29
were due to other reasons. As in Table 12.6 on page 476, there were 88 guests at the Golden
Palm, 33 guests at the Palm Royale, and 66 guests at the Palm Princess who were not planning

4 * 3

x2

0
α

Region of
Nonrejection

Critical
Value

Region of
Rejection

2χ
(1 – α)

F I G U R E 1 2 . 8
Regions of rejection and
nonrejection when
testing for independence
in an contingency
table, using the testx2

r * c

to return. The observed frequencies in the cells of the contingency table represent the
joint tallies of the sampled guests with respect to primary reason for not returning and the ho-
tel where they stayed. The null and alternative hypotheses are

To test this null hypothesis of independence against the alternative that there is a relationship
between the two categorical variables, you use Equation (12.1) on page 469 to compute the test
statistic:

x2
STAT = a

all cells

1fo - fe22
fe

H1: There is a relationship between the primary reason for not returning and the hotel.

H0: There is no relationship between the primary reason for not returning and the hotel.

4 * 3
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where

observed frequency in a particular cell of the contingency table

expected frequency in a particular cell if the null hypothesis of independence is true

To compute the expected frequency, in any cell, you use the multiplication rule for in-
dependent events discussed on page 160 [see Equation (4.7)]. For example, under the null hy-
pothesis of independence, the probability of responses expected in the upper-left-corner cell
representing primary reason of price for the Golden Palm is the product of the two separate
probabilities and Here, the proportion of reasons that are due to
price, is and the proportion of all responses from the Golden
Palm, is If the null hypothesis is true, then the primary
reason for not returning and the hotel are independent:

The expected frequency is the product of the overall sample size, n, and this probability,
The values for the remaining cells are calculated in a similar man-

ner (see Table 12.10).
Equation (12.5) presents a simpler way to compute the expected frequency.

fe187 * 0.1686 = 31.53.

= 0.1686

= 10.35832 * 10.47062
P1Price and Golden Palm2 = P1Price2 * P1Golden Palm2

88>187 = 0.4706.P1Golden Palm2,67>187 = 0.3583,P1Price2, P1Golden Palm2.P1Price2

fe,

fe =
r * cfo =

COMPUTING THE EXPECTED FREQUENCY
The expected frequency in a cell is the product of its row total and column total, divided
by the overall sample size.

(12.5)

where

sum of the frequencies in the row

sum of the frequencies in the column

overall sample sizen =
Column total =

Row total =

fe =
Row total * Column total

n

For example, using Equation (12.5) for the upper-left-corner cell (price for the Golden Palm),

and for the lower-right-corner cell (other reason for the Palm Princess),

Table 12.10 lists the entire set of values.fe

fe =
Row total * Column total

n
=
12921662

187
= 10.24

fe =
Row total * Column total

n
=
16721882

187
= 31.53

T A B L E 1 2 . 1 0

Contingency Table of
Expected Frequencies
of Primary Reason for
Not Returning with Hotel

PRIMARY REASON FOR 
NOT RETURNING

HOTEL

Golden Palm Palm Royale Palm Princess Total

Price 31.53 11.82 23.65 67
Location 28.24 10.59 21.18 60
Room accommodation 14.59 5.47 10.94 31
Other 13.65 5.12 10.24 29
Total 88.00 33.00 66.00 187



Using the level of significance, the upper-tail critical value from the chi-
square distribution with 6 degrees of freedom is 12.592 (see Table E.4). Because

you reject the null hypothesis of independence (see Figure 12.9).x2
STAT = 27.41 7 12.592,

a = 0.05

T A B L E 1 2 . 1 1

Computing the 
Test Statistic for the Test
of Independence

x2
STAT

Cell fo fe 1fo - fe2 1fo - fe22 1fo - fe22>fe

Price/Golden Palm 23 31.53 -8.53 72.76 2.31
Price/Palm Royale 7 11.82 -4.82 23.23 1.97
Price/Palm Princess 37 23.65 13.35 178.22 7.54
Location/Golden Palm 39 28.24 10.76 115.78 4.10
Location/Palm Royale 13 10.59 2.41 5.81 0.55
Location/Palm Princess 8 21.18 -13.18 173.71 8.20
Room/Golden Palm 13 14.59 -1.59 2.53 0.17
Room/Palm Royale 5 5.47 -0.47 0.22 0.04
Room/Palm Princess 13 10.94 2.06 4.24 0.39
Other/Golden Palm 13 13.65 -0.65 0.42 0.03
Other/Palm Royale 8 5.12 2.88 8.29 1.62
Other/Palm Princess 8 10.24 -2.24 5.02 0.49

27.41

0

Region of
Nonrejection Critical

Value

Region of
Rejection

χ2

.05

12.592

F I G U R E 1 2 . 9
Regions of rejection and
nonrejection when
testing for independence
in the hotel guest
satisfaction survey
example at the 0.05 level
of significance, with 6
degrees of freedom
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To perform the test of independence, you use the test statistic shown in Equation (12.1)
on page 469. The test statistic approximately follows a chi-square distribution, with de-
grees of freedom equal to the number of rows in the contingency table minus 1, multiplied by
the number of columns in the table minus 1:

Table 12.11 illustrates the computations for the test statistic.x2
STAT

= 14 - 1213 - 12 = 6

Degrees of freedom = 1r - 121c - 12

x2
STAT

x2
STAT

The results for this test, shown in Figure 12.10, include the p-value, 0.0001. Since
, you reject the null hypothesis of independence. Using the p-value

approach, you reject the null hypothesis of independence because the
The p-value indicates that there is virtually no chance of having a relationship

this strong or stronger between the hotel and the primary reasons for not returning in a sample,
if the primary reasons for not returning are independent of the specific hotels in the entire pop-
ulation. Thus, there is strong evidence of a relationship between primary reason for not return-
ing and the hotel.

Examination of the observed and expected frequencies (see Table 12.11 above) reveals
that price is underrepresented as a reason for not returning to the Golden Palm (i.e.,
and ) but is overrepresented at the Palm Princess. Guests are more satisfied with thefe = 31.53

fo = 23

0.0001 6 0.05.
p-value =

x2
STAT = 27.4104 7 12.592



Problems for Section 12.3 485

price at the Golden Palm than at the Palm Princess. Location is overrepresented as a reason for
not returning to the Golden Palm but greatly underrepresented at the Palm Princess. Thus,
guests are much more satisfied with the location of the Palm Princess than with that of the
Golden Palm.

To ensure accurate results, all expected frequencies need to be large in order to use the
test when dealing with contingency tables. As in the case of contingency tables in
Section 12.2, all expected frequencies should be at least 1. For contingency tables in which one
or more expected frequencies are less than 1, you can use the chi-square test after collapsing
two or more low-frequency rows into one row (or collapsing two or more low-frequency
columns into one column). Merging rows or columns usually results in expected frequencies
sufficiently large to assure the accuracy of the test.x2

2 * cr * c
x2

F I G U R E 1 2 . 1 0
Excel and Minitab chi-square test results for the Table 12.9 primary reason for not returning and hotel data

Problems for Section 12.3
LEARNING THE BASICS
12.20 If a contingency table has three rows and four
columns, how many degrees of freedom are there for the
test of independence?

12.21 When performing a test of independence in a
contingency table with r rows and c columns, determine the

x2

x2

upper-tail critical value of the test statistic in each of the fol-
lowing circumstances:
a. rows, columns
b. rows, columns
c. rows, columns
d. rows, columns
e. rows, columnsc = 3a = 0.01, r = 6

c = 6a = 0.01, r = 3
c = 6a = 0.01, r = 4
c = 5a = 0.01, r = 4
c = 5a = 0.05, r = 4



TYPE OF
DESSERT

TYPE OF ENTRÉE

Beef Poultry Fish Pasta Total

Ice cream 13 8 12 14 47
Cake 98 12 29 6 145
Fruit 8 10 6 2 26
None 124 98 149 41 412
Total 243 128 196 63 630

At the 0.05 level of significance, is there evidence of a
relationship between type of dessert and type of entrée?

12.23 Is there a generation gap in the type of music that
people listen to? The following table represents the type of
favorite music for a sample of 1,000 respondents classified
according to their age group:

FAVORITE
TYPE

AGE

16–29 30–49 50–64 65 and over Total

Rock 71 62 51 27 211
Rap or hip-hop 40 21 7 3 71
Rhythm and 

blues
48 46 46 40 180

Country 43 53 59 79 234
Classical 22 28 33 46 129
Jazz 18 26 36 43 123
Salsa 8 14 18 12 52
Total 250 250 250 250 1000

STRESS LEVEL

COMMUTING TIME High Moderate Low Total

Under 15 min. 9 5 18 32
15–45 min. 17 8 28 53
Over 45 min. 18 6 7 31
Total 44 19 53 116

At the 0.05 level of significance, is there evidence of a
significant relationship between the age group and where
people primarily get their news? If so, explain the
relationship.

12.26 USA Today reported on when the decision of
what to have for dinner is made. Suppose the results were
based on a survey of 1,000 respondents and considered
whether the household included any children under 18
years old. The results are cross-classified in the following
table:

AGE GROUP

MEDIA Under 36 36–50 50�

Local TV 107 119 133
National TV 73 102 127
Radio 75 97 109
Local newspaper 52 79 107
Internet 95 83 76

At the 0.05 level of significance, is there evidence of a
significant relationship between when the decision is made
of what to have for dinner and the type of household?

486 CHAPTER 12 Chi-Square Tests and Nonparametric Tests

a. At the 0.01 level of significance, is there evidence of a
significant relationship between commuting time and
stress level?

b. What is your answer to (a) if you use the 0.05 level of
significance?

12.25 Where people turn for news is different for various
age groups. A study indicated where different age groups
primarily get their news:

TYPE OF HOUSEHOLD

WHEN DECISION
MADE

One
Adult/No
Children

Two or
More

Adults/
Children

Two or
More

Adults/No
Children

Just before eating 162 54 154
In the afternoon 73 38 69
In the morning 59 58 53
A few days before 21 64 45
The night before 15 50 45
Always eat the same 

thing on this night
2 16 2

Not sure 7 6 7

Source: Data extracted from “What’s for Dinner,” www.usatoday.com,
January 10, 2000.

APPLYING THE CONCEPTS
12.22 The owner of a restaurant serving Continental-style
entrées has the business objective of learning more about
the patterns of patron demand during the Friday-to-Sunday
weekend time period. Data were collected from 630
customers on the type of entrée ordered and the type of
dessert ordered and organized into the following table:

At the 0.05 level of significance, is there evidence of a
relationship between favorite type of music and age group?

12.24 A large corporation is interested in de-
termining whether a relationship exists between

the commuting time of its employees and the level of
stress-related problems observed on the job. A study of
116 workers reveals the following:

SELF
Test

www.usatoday.com
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12.4 McNemar Test for the Difference Between 
Two Proportions (Related Samples)

In Section 10.3, you used the Z test, and in Section 12.1, you used the chi-square test to exam-
ine whether there was a difference in the proportion of items of interest between two popula-
tions. These tests require independent samples from each population. However, sometimes
when you are testing differences between the proportion of items of interest, the data are
collected from repeated measurements or matched samples. For example, in marketing, these
situations can occur when you want to determine whether there has been a change in attitude,
perception, or behavior from one time period to another. To test whether there is evidence of a
difference between the proportions when the data have been collected from two related
samples, you can use the McNemar test.

Table 12.12 presents the table needed for the McNemar test.2 * 2

T A B L E 1 2 . 1 2

Contingency Table
for the McNemar Test
2 * 2

CONDITION (GROUP) 2

CONDITION (GROUP) 1 Yes No Totals

Yes A B A + B
No C D C + D
Totals A + C B + D n

where

number of respondents who answer yes to condition 1 and yes to condition 2

number of respondents who answer yes to condition 1 and no to condition 2

number of respondents who answer no to condition 1 and yes to condition 2

number of respondents who answer no to condition 1 and no to condition 2

number of respondents in the sample

The sample proportions are

The population proportions are

When testing differences between the proportions, you can use a two-tail test or a one-tail
test. In both cases, you use a test statistic that approximately follows the normal distribution.
Equation (12.6) presents the McNemar test statistic used to test H0:p1 = p2.

p2 = proportion in the population who would answer yes to condition 2

p1 = proportion in the population who would answer yes to condition 1

p2 =
A + C

n
= proportion of respondents in the sample who answer yes to condition 2

p1 =
A + B

n
= proportion of respondents in the sample who answer yes to condition 1

n =
D =
C =
B =
A =

McNEMAR TEST STATISTIC

(12.6)

where the test statistic is approximately normally distributed.ZSTAT

ZSTAT =
B - C2B + C

To illustrate the McNemar test, suppose that the business problem facing a cell phone provider
was to determine the effect of a marketing campaign on the brand loyalty of cell phone customers.



Data were collected from participants. In the study, the participants were initially asked
to state their preferences for two competing cell phone providers, Sprint and Verizon. Initially, 282
panelists said they preferred Sprint and 318 said they preferred Verizon. After exposing the set of
participants to an intensive marketing campaign strategy for Verizon, the same 600 participants
are again asked to state their preferences. Of the 282 panelists who previously preferred Sprint,
246 maintained their brand loyalty, but 36 switched their preference to Verizon. Of the 318 partici-
pants who initially preferred Verizon, 306 remained brand loyal, but 12 switched their preference
to Sprint. These results are organized into the contingency table presented in Table 12.13.

You use the McNemar test for these data because you have repeated measurements from
the same set of panelists. Each participant gave a response about whether he or she preferred

n = 600

T A B L E 1 2 . 1 3

Brand Loyalty of Cell
Phone Providers

AFTER MARKETING CAMPAIGN

BEFORE MARKETING CAMPAIGN Sprint Verizon Total

Sprint 246 36 282
Verizon 12 306 318
Total 258 342 600

Sprint or Verizon before exposure to the intensive marketing campaign and then again after
exposure to the campaign.

To determine whether the intensive marketing campaign was effective, you want to inves-
tigate whether there is a difference between the population proportion who favor Sprint before
the campaign, π1, versus the proportion who favor Sprint after the campaign, The null and
alternative hypotheses are

Using a 0.05 level of significance, the critical values are and (see Figure 12.11),
and the decision rule is

otherwise, do not reject H0.

Reject H0 if ZSTAT 6 -1.96 or if ZSTAT 7 +1.96;

+1.96-1.96

H1:p1 Z p2

H0:p1 = p2

p2.

488 CHAPTER 12 Chi-Square Tests and Nonparametric Tests

+1.96–1.96 0

Do not
reject

H0

.025.025
Z

Reject H0Reject H0

F I G U R E 1 2 . 1 1
Two-tail McNemar test at
the 0.05 level of
significance

For the data in Table 12.13,

so that

Using Equation (12.6),

Because you reject Using the p-value approach (see Figure
12.12), the p-value is 0.0005. Because you reject You can conclude thatH0.0.0005 6 0.05,

H0.ZSTAT = 3.4641 7 1.96,

Z =
B - C2B + C

=
36 - 12236 + 12

=
24248

= 3.4641

p1 =
A + B

n
=

246 + 36
600

=
282
600

= 0.47 and p2 =
A + C

n
=

246 + 12
600

=
258
600

= 0.43

A = 246 B = 36 C = 12 D = 306
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Minitab does not contain a
command to perform the
McNemar test.

F I G U R E 1 2 . 1 2
Excel results for the
McNemar test for brand
loyalty of cell phone
providers

the population proportion who prefer Sprint before the intensive marketing campaign is differ-
ent from the population proportion who prefer Sprint after exposure to the intensive Verizon
marketing campaign. In fact, from Figure 12.12, observe that preference for Verizon increased
after exposure to the intensive marketing campaign.

Problems for Section 12.4
LEARNING THE BASICS
12.27 Given the following table for two related samples:

preferred Brand A increased as a result of an advertising
campaign. A random sample of 200 coffee drinkers was se-
lected. The results indicating preference for Brand A or
Brand B prior to the beginning of the advertising campaign
and after its completion are shown in the following table:

GROUP 2

GROUP 1 Yes No Total

Yes 46 25 71
No 16 59 75
Total 62 84 146

a. Compute the McNemar test statistic.
b. At the 0.05 level of significance, is there evidence of a

difference between group 1 and group 2?

APPLYING THE CONCEPTS
12.28 A market researcher wanted to determine
whether the proportion of coffee drinkers who

SELF
Test

PREFERENCE
PRIOR TO
ADVERTISING
CAMPAIGN

PREFERENCE AFTER
COMPLETION OF

ADVERTISING CAMPAIGN

Brand A Brand B Total

Brand A 101 9 110
Brand B 22 68 90
Total 123 77 200

a. At the 0.05 level of significance, is there evidence that
the proportion of coffee drinkers who prefer Brand A is



lower at the beginning of the advertising campaign than
at the end of the advertising campaign?

b. Compute the p-value in (a) and interpret its meaning.

12.29 Two candidates for governor participated in a tele-
vised debate. A political pollster recorded the preferences of
500 registered voters in a random sample prior to and after
the debate:

PREFERENCE
PRIOR TO DEBATE

PREFERENCE AFTER DEBATE

Candidate A Candidate B Total

Candidate A 269 21 290
Candidate B 36 174 210
Total 305 195 500

PREFERENCE PRIOR 
TO ADVERTISING

PREFERENCE AFTER 
ADVERTISING

Brand A Brand B Total

Brand A 55 5 60
Brand B 15 25 40
Total 70 30 100

12.31 The CEO of a large metropolitan health-care facil-
ity would like to assess the effect of the recent implementa-
tion of the Six Sigma management approach on customer
satisfaction. A random sample of 100 patients is selected
from a list of patients who were at the facility the past week
and also a year ago:

SATISFIED NOW

SATISFIED LAST YEAR Yes No Total

Yes 67 5 72
No 20 8 28
Total 87 13 100

a. At the 0.05 level of significance, is there evidence that
satisfaction was lower last year, prior to introduction of
Six Sigma management?

b. Compute the p-value in (a) and interpret its meaning.

12.32 The personnel director of a large department store
wants to reduce absenteeism among sales associates. She
decides to institute an incentive plan that provides financial
rewards for sales associates who are absent fewer than
five days in a given calendar year. A sample of 100 sales
associates selected at the end of the second year reveals the
following:
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YEAR 2

YEAR 1
Days

Absent
<5 Days

Absent
» 5

Total

Days Absent<5 32 4 36
Days Absent» 5 25 39 64

Total 57 43 100

12.5 Chi-Square Test for the Variance or Standard Deviation
When analyzing numerical data, sometimes you need to test a hypothesis about the population
variance or standard deviation. For example, in the cereal-filling process described in Section
9.1, you assumed that the population standard deviation, was equal to 15 grams. To deter-
mine whether the variability of the process has changed, you need to test whether the standard
deviation has changed from the previously specified level of 15 grams.

Assuming that the data are normally distributed, you use the test for the variance or
standard deviation defined in Equation (12.7) to test whether the population variance or stan-
dard deviation is equal to a specified value.

X2

s,

a. At the 0.01 level of significance, is there evidence of a
difference in the proportion of voters who favored Candi-
date A prior to and after the debate?

b. Compute the p-value in (a) and interpret its meaning.

12.30 A taste-testing experiment compared two brands of
Chilean merlot wines. After the initial comparison, 60 pre-
ferred Brand A, and 40 preferred Brand B. The 100 respon-
dents were then exposed to a very professional and powerful
advertisement promoting Brand A. The 100 respondents
were then asked to taste the two wines again and declare
which brand they preferred. The results are shown in the
following table:

a. At the 0.05 level of significance, is there evidence that
the proportion who preferred Brand A was lower before
the advertising than after the advertising?

b. Compute the p-value in (a) and interpret its meaning.

a. At the 0.05 level of significance, is there evidence that
the proportion of employees absent fewer than five days
was lower in year 1 than in year 2?

b. Compute the p-value in (a) and interpret its meaning.
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TEST FOR THE VARIANCE OR STANDARD DEVIATION

(12.7)

where

size

variance

population variance

The test statistic follows a chi-square distribution with degrees of freedom.n - 1x2
STAT

s2 = hypothesized

S2 = sample

n = sample

x2
STAT =

1n - 12S2

s2

x2

To apply the test of hypothesis, return to the cereal-filling example. You are interested
in determining whether the standard deviation has changed from the previously specified
level of 15 grams. Thus, you use a two-tail test with the following null and alternative
hypotheses:

If you select a sample of 25 cereal boxes, you reject the null hypothesis if the computed
test statistic falls into either the lower or upper tail of a chi-square distribution with

degrees of freedom, as shown in Figure 12.13. From Equation (12.7), observe
that the test statistic falls into the lower tail of the chi-square distribution if the sample
standard deviation (S) is sufficiently smaller than the hypothesized of 15 grams, and it falls
into the upper tail if S is sufficiently larger than 15 grams. From Table 12.14 (or Table E.4), if
you select a level of significance of 0.05, the lower and upper critical values are 12.401 and
39.364, respectively. Therefore, the decision rule is

otherwise, do not reject H0.

Reject H0 if x2
STAT 6 12.401 or if x2

STAT 7 39.364;

s

x2
STAT

25 - 1 = 24
x2

STAT

H1:s
2 Z 225 1that is,s Z 15 grams2

H0:s
2 = 225 1that is,s = 15 grams2

F I G U R E 1 2 . 1 3
Determining the lower
and upper critical values
of a chi-square
distribution with 24
degrees of freedom
corresponding to a 0.05
level of significance for a
two-tail test of
hypothesis about a
population variance or
standard deviation

12.401 39.3640

Region of
Rejection

Region of
Nonrejection

Region of
Rejection

.95 .025.025
�2



T A B L E 1 2 . 1 4

Finding the Critical
Values Corresponding to
a 0.05 Level of
Significance for a 
Two-Tail Test from the
Chi-Square Distribution
with 24 Degrees of
Freedom

Cumulative Area

.005 .01 .025 .05 .10 .90 .95 .975

Upper-Tail Areas

Degrees of
Freedom .995 .99 .975 .95 .90 .10 .05 .025

1 ... ... 0.001 0.004 0.016 2.706 3.841 5.024
2 0.010 0.020 0.051 0.103 0.211 4.605 5.991 7.378
3 0.072 0.115 0.216 0.352 0.584 6.251 7.815 9.348
. . . . . . . . .
. . . . . . . . .
. . . . . . . . .
23 9.260 10.196 11.689 13.091 14.848 32.007 35.172 38.076
24 9.886 10.856 12.401 13.848 15.659 33.196 36.415 39.364
25 10.520 11.524 13.120 14.611 16.473 34.382 37.652 40.646

Source: Extracted from Table E.4.

Suppose that in the sample of 25 cereal boxes, the standard deviation, S, is 17.7 grams.
Using Equation (12.7),

Because or because the (see
Figure 12.14), you do not reject You conclude that there is insufficient evidence that the pop-
ulation standard deviation is different from 15 grams.

H0.
p-value = 0.0956 7 0.0512.401 6 x2

STAT = 33.42 6 39.364,

x2
STAT =

1n - 12S2

s2
=
125 - 12117.722

11522 = 33.42
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Minitab does not contain 
a command that directly
performs this test.

F I G U R E 1 2 . 1 4
Excel results for the 
chi-square test for the
standard deviation of the
cereal-filling process

In testing a hypothesis about a population variance or standard deviation, you assume that
the values in the population are normally distributed. However, the chi-square test statistic for
the variance or standard deviation is very sensitive to departures from this assumption (i.e., it
is not a robust test). Thus, if the population is not normally distributed, particularly for small
sample sizes, the accuracy of the test can be seriously affected.
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Problems for Section 12.5
LEARNING THE BASICS
12.33 Determine the lower- and upper-tail critical values
of for each of the following two-tail tests:
a.
b.
c.

12.34 Determine the lower- and upper-tail critical values
of for each of the following two-tail tests:
a.
b.
c.

12.35 You are working with a sample of selected
from an underlying normal population, What is
the value of if you are testing the null hypothesis

12.36 You are working with a sample of selected
from an underlying normal population, What is the
value of if you are testing the null hypothesis

12.37 In Problem 12.36, how many degrees of freedom are
there in the hypothesis test?

12.38 In Problems 12.36 and 12.37, what are the critical
values from Table E.4 if the level of significance is

and is as follows:
a.
b.

12.39 In Problems 12.36, 12.37, and 12.38, what is your
statistical decision if is
a.
b.

12.40 If, in a sample of size selected from a very
left-skewed population, the sample standard deviation is

would you use the hypothesis test given in Equation
(12.7) to test Discuss.

APPLYING THE CONCEPTS
12.41 A manufacturer of candy must monitor the tempera-
ture at which the candies are baked. Too much variation will
cause inconsistency in the taste of the candy. Past records
show that the standard deviation of the temperature has been

A random sample of 30 batches of candy is selected,
and the sample standard deviation of the temperature is

a. At the 0.05 level of significance, is there evidence that
the population standard deviation has increased above

b. What assumption do you need to make in order to per-
form this test?

c. Compute the p-value in (a) and interpret its meaning.

1.2�F?

2.1�F.

1.2�F.

H0:s = 20?
S = 24,

n = 16

s 6 12?
s Z 12?

H1

s 6 12?
s Z 12?

H1a = 0.05

H0:s = 12?
x2

STAT

S = 10.
n = 16

H0:s = 100?
x2

STAT

S = 150.
n = 25

a = 0.10, n = 16
a = 0.05, n = 20
a = 0.01, n = 24
x2

a = 0.10, n = 14
a = 0.05, n = 17
a = 0.01, n = 26
x2

12.42 A market researcher for an automobile
manufacturer intends to conduct a nationwide

survey concerning car repairs. Among the questions in-
cluded in the survey is the following: “What was the cost
of all repairs performed on your car last year?” In order to
determine the sample size necessary, the researcher needs
to provide an estimate of the standard deviation. Using his
past experience and judgment, he estimates that the stan-
dard deviation of the amount of repairs is $200. Suppose
that a small-scale study of 25 auto owners selected at ran-
dom indicates a sample standard deviation of $237.52.
a. At the 0.05 level of significance, is there evidence that

the population standard deviation is different from
$200?

b. What assumption do you need to make in order to per-
form this test?

c. Compute the p-value in part (a) and interpret its meaning.

12.43 The marketing manager of a branch office of a lo-
cal telephone operating company wants to study character-
istics of residential customers served by her office. In
particular, she wants to estimate the mean monthly cost of
calls within the local calling region. In order to determine
the sample size necessary, she needs an estimate of the
standard deviation. On the basis of her past experience and
judgment, she estimates that the standard deviation is equal
to $12. Suppose that a small-scale study of 15 residential
customers indicates a sample standard deviation of $9.25.
a. At the 0.10 level of significance, is there evidence that

the population standard deviation is different from $12?
b. What assumption do you need to make in order to per-

form this test?
c. Compute the p-value in (a) and interpret its meaning.

12.44 A manufacturer of doorknobs has a production
process that is designed to provide a doorknob with a target
diameter of 2.5 inches. In the past, the standard deviation of
the diameter has been 0.035 inch. In an effort to reduce the
variation in the process, various studies have resulted in a
redesigned process. A sample of 25 doorknobs produced un-
der the new process indicates a sample standard deviation of
0.025 inch.
a. At the 0.05 level of significance, is there evidence that

the population standard deviation is less than 0.035 inch
in the new process?

b. What assumption do you need to make in order to per-
form this test?

c. Compute the p-value in (a) and interpret its meaning.

12.45 A manufacturing company produces steel hous-
ings for electrical equipment. The main component part of
the housing is a steel trough that is made out of a
14-gauge steel coil. It is produced using a 250-ton pro-
gressive punch press with a wipe-down operation that

SELF
Test



puts two 90-degree forms in the flat steel to make the
trough. The distance from one side of the form to the
other is critical because of weatherproofing in outdoor ap-
plications. The company requires that the width of the
trough must be between 8.31 inches and 8.61 inches. In
the past, the standard deviation of the width of the trough
has been 0.05 inch. The file contains the widths
of the troughs, in inches, for a sample of

a. At the 0.05 level of significance, is there evidence that
the standard deviation of the width of the troughs is dif-
ferent from 0.05 inch?

8.498 8.447 8.436 8.413 8.489 8.414 8.481

8.422 8.476 8.382 8.484 8.403 8.414 8.419 8.385 8.465

8.312 8.343 8.317 8.383 8.348 8.410 8.351 8.373 8.481

n = 25:
Trough2

b. What assumption about the population distribution is
needed in order to conduct the test in (a)?

12.46 An important quality characteristic of interest in a
teabag filling process is the weight of the tea in the indi-
vidual bags. The weight of the teabags should be as con-
sistent as possible. In the past, the standard deviation of
the weight of the teabags has been 0.05 grams. The file

contains an ordered array of the weight, in
grams, of a sample of 20 tea bags produced during an
eight-hour shift. Is there evidence that the standard devia-
tion of the amount of tea per bag is greater than 0.05
grams? (Use )a = 0.01.

Teabags2

12.6 Wilcoxon Rank Sum Test: Nonparametric Analysis 
for Two Independent Populations

“A nonparametric procedure is a statistical procedure that has (certain) desirable properties
that hold under relatively mild assumptions regarding the underlying population(s) from which
the data are obtained.”

—Myles Hollander and Douglas A. Wolfe (reference 4, p. 1)

In Section 10.1, you used the t test for the difference between the means of two independent
populations. If sample sizes are small and you cannot assume that the data in each sample are
from normally distributed populations, you have two choices:

• Use a nonparametric procedure such as the Wilcoxon rank sum test, which does not
depend on the assumption of normality for the two populations.

• Use the pooled-variance t test, following a normalizing transformation on the data (see
reference 10).

This section introduces the Wilcoxon rank sum test for testing whether there is a differ-
ence between two medians. The Wilcoxon rank sum test is almost as powerful as the pooled-
variance and separate-variance t tests discussed in Section 10.1 under conditions appropriate
to these tests and is likely to be more powerful when the assumptions of those t tests are not
met. In addition, you can use the Wilcoxon rank sum test when you have only ordinal data, as
often happens in consumer behavior and marketing research.

To perform the Wilcoxon rank sum test, you replace the values in the two samples of size
and with their combined ranks (unless the data contained the ranks initially). You begin

by defining as the total sample size. Next, you assign the ranks so that rank 1 is
given to the smallest of the n combined values, rank 2 is given to the second smallest, and so
on, until rank n is given to the largest. If several values are tied, you assign each value the av-
erage of the ranks that otherwise would have been assigned had there been no ties.

Whenever the two sample sizes are unequal, represents the smaller sample and the
larger sample. The Wilcoxon rank sum test statistic, is defined as the sum of the ranks as-
signed to the values in the smaller sample. (For equal-sized samples, either sample may be
used for determining ) For any integer value n, the sum of the first n consecutive integers is

Therefore, plus the sum of the ranks assigned to the items in the second
sample, must equal You can use Equation (12.8) to check the accuracy of your
rankings.

n1n + 12>2.
n2T2,T1n1n + 12>2.

T1.
n1

T1,
n2n1

n = n1 + n2

n2n1
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CHECKING THE RANKINGS

(12.8)T1 + T2 =
n1n + 12

2

When and are both you use Table E.6 to find the critical values of the test sta-
tistic For a two-tail test, you reject the null hypothesis (see Panel A of Figure 12.15) if the
computed value of is greater than or equal to the upper critical value, or if is less than or
equal to the lower critical value. For one-tail tests having the alternative hypothesis

[i.e., the median of population 1 is less than the median of population 2
], you reject the null hypothesis if the observed value of is less than or equal to the

lower critical value (see Panel B of Figure 12.15). For one-tail tests having the alternative hy-
pothesis you reject the null hypothesis if the observed value of equals or is
greater than the upper critical value (see Panel C of Figure 12.15).

T1H1: M1 7 M2,

T11M22
1M12H1: M1 6 M2

T1T1

T1.
…10,n2n1

Region of Rejection Region of Nonrejection

0–Z +Z 0–Z 0 +Z

Panel A Panel B Panel C

H1: M1 < M2H1: M1 ≠ M2

μT1
μT1

μT1
T1L

T1L

H1: M1 > M2

T1U
T1U

F I G U R E 1 2 . 1 5
Regions of rejection and
nonrejection using the
Wilcoxon rank sum test

For large sample sizes, the test statistic is approximately normally distributed, with the
mean, equal to

mT1
=

n11n + 12
2

mT1
,

T1

LARGE SAMPLE WILCOXON RANK SUM TEST

(12.9)

where the test statistic approximately follows a standardized normal distribution.ZSTAT

ZSTAT =
T1 -

n11n + 12
2

An1n21n + 12
12

and the standard deviation, equal to

Therefore, Equation (12.9) defines the standardized Z test statistic.

sT1
= An1n21n + 12

12

sT1
,



You use Equation (12.9) for testing the null hypothesis when the sample sizes are outside
the range of Table E.6. Based on the level of significance selected, you reject the null hy-
pothesis if the test statistic falls in the rejection region.

To study an application of the Wilcoxon rank sum test, return to the Using Statistics scenario
of Chapter 10 concerning sales of BLK Cola for the normal shelf display and end-aisle locations
(see page 365). If you cannot assume that the populations are normally distributed, you can use
the Wilcoxon rank sum test to evaluate possible differences in the median sales for the two dis-
play locations.2 The data (stored in ) and the combined ranks are shown in Table 12.15.Cola

ZSTAT

a,
2To test for differences in the
median sales between the two
locations, you must assume that the
distributions of sales in both popu-
lations are identical except for dif-
ferences in central tendency (i.e.,
the medians).

T A B L E 1 2 . 1 5

Forming the Combined
Rankings

Sales

Normal Display1n1 � 102 Combined
Ranking

End-Aisle Display1n2 � 102 Combined
Ranking

22 1.0 52 5.5
34 3.0 71 14.0
52 5.5 76 15.0
62 10.0 54 7.0
30 2.0 67 13.0
40 4.0 83 17.0
64 11.0 66 12.0
84 18.5 90 20.0
56 8.0 77 16.0
59 9.0 84 18.5

Source: Data are taken from Table 10.1 on page 367.
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Because you have not stated in advance which display location is likely to have a higher
median, you use a two-tail test with the following null and alternative hypotheses:

Now you need to compute the sum of the ranks assigned to the smaller sample. When
the sample sizes are equal, as in this example, you can define either sample as the group from
which to compute Choosing the normal display as the first sample,

As a check on the ranking procedure, you compute from

and then use Equation (12.8) on page 495 to show that the sum of the first integers in
the combined ranking is equal to 

Next, you use Table E.6 to determine the lower- and upper-tail critical values for the test
statistic From Table 12.16, a portion of Table E.6, observe that for a level of significance of
0.05, the critical values are 78 and 132. The decision rule is

T1.

210 = 210

72 + 138 =
201212

2
= 210

T1 + T2 =
n1n + 12

2

T1 + T2:
n = 20

T2 = 5.5 + 14 + 15 + 7 + 13 + 17 + 12 + 20 + 16 + 18.5 = 138

T2

T1 = 1 + 3 + 5.5 + 10 + 2 + 4 + 11 + 18.5 + 8 + 9 = 72

T1.

T1,

H1: M1 Z M2 1the median sales are not equal2
H0: M1 = M2 1the median sales are equal2
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otherwise, do not reject H0.

Reject H0 if T1 … 78 or if T1 Ú 132;

n1

One- Two- 4 5 6 7 8 9 10
n2 Tail Tail (Lower, Upper)

.05 .10 16,40 24,51 33,63 43,76 54,90 66,105
9 .025 .05 14,42 22,53 31,65 40,79 51,93 62,109

.01 .02 13,43 20,55 28,68 37,82 47,97 59,112

.005 .01 11,45 18,57 26,70 35,84 45,99 56,115

.05 .10 17,43 26,54 35,67 45,81 56,96 69,111 82,128
10 .025 .05 15,45 23,57 32,70 42,84 53,99 65,115 78,132

.01 .02 13,47 21,59 29,73 39,87 49,103 61,119 74,136

.005 .01 12,48 19,61 27,75 37,89 47,105 58,122 71,139

Source: Extracted from Table E.6.

AT A B L E 1 2 . 1 6

Finding the Lower-
and Upper-Tail Critical
Values for the Wilcoxon
Rank Sum Test
Statistic, Where

and
a = 0.05
n1 = 10, n2 = 10,

T1,

Because the test statistic you reject There is evidence of a signifi-
cant difference in the median sales for the two display locations. Because the sum of the
ranks is lower for the normal display, you conclude that median sales are lower for the
normal display.

Figure 12.16 shows the Wilcoxon rank sum test results (Excel) and the Mann-Whitney
test results (Minitab) for the BLK Cola sales data. Although the Mann-Whitney test com-
putes a different test statistic, the test is numerically equivalent to the Wilcoxon rank sum
test (see references 1, 2, and 9). From the Figure 12.16 Excel results, you reject the null
hypothesis because the p-value is 0.0126, which is less than This p-value indi-
cates that if the medians of the two populations are equal, the chance of finding a differ-
ence at least this large in the samples is only 0.0126. The Figure 12.16 Minitab results
report “The test is significant at 0.0139.” The slight difference in the results is due to the
fact that Minitab is computing an exact probability and Excel is using the normal approxi-
mation. Minitab also computes the p-value adjusted for ties.

a = 0.05.

H0.T1 = 72 6 78,

F I G U R E 1 2 . 1 6
Wilcoxon rank sum test (Excel) and Mann-Whitney test (Minitab) results for the BLK Cola sales data



Problems for Section 12.6
LEARNING THE BASICS
12.47 Using Table E.6, determine the lower- and upper-tail
critical values for the Wilcoxon rank sum test statistic, in
each of the following two-tail tests:
a.
b.
c.
d. Given your results in (a) through (c), what do you

conclude regarding the width of the region of nonrejec-
tion as the selected level of significance, gets
smaller?

12.48 Using Table E.6, determine the lower-tail critical
value for the Wilcoxon rank sum test statistic, in each of
the following one-tail tests:
a.
b.
c.
d.

12.49 The following information is available for two sam-
ples selected from independent populations:

Sample 1: Assigned ranks:

Sample 2: Assigned ranks: 

What is the value of if you are testing the null hypothesis
H0: M1 = M2?

T1

7 16 12 9 3 14 13 6 15n2 = 9

4 1 8 2 5 10 11n1 = 7

a = 0.005, n1 = 6, n2 = 8
a = 0.01, n1 = 6, n2 = 8
a = 0.025, n1 = 6, n2 = 8
a = 0.05, n1 = 6, n2 = 8

T1,

a,

a = 0.01, n1 = 6, n2 = 8
a = 0.05, n1 = 6, n2 = 8
a = 0.10, n1 = 6, n2 = 8

T1,

12.50 In Problem 12.49, what are the lower- and upper-tail
critical values for the test statistic from Table E.6 if you
use a 0.05 level of significance and the alternative hypothe-
sis is 

12.51 In Problems 12.49 and 12.50, what is your statisti-
cal decision?

12.52 The following information is available for two sam-
ples selected from independent and similarly shaped right-
skewed populations:

Sample 1: 

Sample 2: 

a. Replace the observed values with the corresponding ranks
(where smallest value;
largest value) in the combined samples.

b. What is the value of the test statistic 
c. Compute the value of the sum of the ranks in the

larger sample.
d. To check the accuracy of your rankings, use Equation

(12.8) on page 495 to demonstrate that

12.53 From Problem 12.52, at the 0.05 level of significance,
determine the lower-tail critical value for the Wilcoxon rank

T1 + T2 =
n1n + 12

2

T2,
T1?

n = n1 + n2 = 11 =1 =

n2 = 6 2.8 4.4 4.4 5.2 6.0 18.5

n1 = 5 1.1 2.3 2.9 3.6 14.7

H1: M1 Z M2?

T1
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Table E.6 shows the lower and upper critical values of the Wilcoxon rank sum test statis-
tic, but only for situations in which both and are less than or equal to 10. If either one
or both of the sample sizes are greater than 10, you must use the large-sample Z approximation
formula [Equation (12.9) on page 495]. However, you can also use this approximation formula
for small sample sizes. To demonstrate the large-sample Z approximation formula, consider
the BLK Cola sales data. Using Equation (12.9),

Because the critical value of Z at the 0.05 level of signifi-
cance , you reject H0.p-value = 0.0126 6 0.05)(or

ZSTAT = -2.4946 6 -1.96,

=
72 - 105
13.2288

= -2.4946

=
72 -

11021212
2

A110211021212
12

ZSTAT =
T1 -

n11n + 12
2

An1n21n + 12
12

n2n1T1,
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sum test statistic, if you want to test the null hypothesis,
against the one-tail alternative,

12.54 In Problems 12.52 and 12.53, what is your statisti-
cal decision?

APPLYING THE CONCEPTS
12.55 A vice president for marketing recruits 20 college
graduates for management training. Each of the 20 individuals
is randomly assigned, 10 each, to one of two groups. A “tradi-
tional” method of training (T) is used in one group, and an
“experimental” method (E) is used in the other. After the grad-
uates spend six months on the job, the vice president ranks
them on the basis of their performance, from 1 (worst) to 20
(best), with the following results (stored in the file ):

T: 1 2 3 5 9 10 12 13 14 15

E:

Is there evidence of a difference in the median performance
between the two methods? (Use )

12.56 Wine experts Gaiter and Brecher use a six-category
scale when rating wines: Yech, OK, Good, Very Good, Deli-
cious, and Delicious! (Data extracted from D. Gaiter and J.
Brecher, “A Good U.S. Cabernet Is Hard to Find,” The Wall
Street Journal, May 19, 2006, p. W7.) Suppose Gaiter and
Brecher tested a random sample of eight inexpensive Cali-
fornia Cabernets and a random sample of eight inexpensive
Washington Cabernets. Inexpensive is defined as a sug-
gested retail value in the United States of under $20. The
data, stored in , are as follows:

California—Good, Delicious, Yech, OK, OK, Very Good,
Yech, OK

Washington—Very Good, OK, Delicious!, Very Good,
Delicious, Good, Delicious, Delicious!

a. Are the data collected by rating wines using this scale
nominal, ordinal, interval, or ratio?

b. Why is the two-sample t test defined in Section 10.1 in-
appropriate to test the mean rating of California Caber-
nets versus Washington Cabernets?

c. Is there evidence of a significance difference in the me-
dian rating of California Cabernets and Washington
Cabernets? (Use )

12.57 A problem with a telephone line that prevents a cus-
tomer from receiving or making calls is upsetting to both the
customer and the telephone company. The file con-
tains samples of 20 problems reported to two different
offices of a telephone company and the time to clear these
problems (in minutes) from the customers’ lines:

Central Office I Time to Clear Problems (Minutes)

1.02 0.53 0.93 1.60 0.80 1.05 6.32 3.93 5.45 0.97

1.48 1.75 0.78 2.85 0.52 1.60 4.15 3.97 1.48 3.10

Phone

a = 0.05.

Cabernet

a = 0.05.

4 6 7 8 11 16 17 18 19 20

TestRank

H1: M1 6 M2.H0: M1 Ú M2,
T1, Central Office II Time to Clear Problems (Minutes)

a. Is there evidence of a difference in the median time to
clear problems between offices? (Use )

b. What assumptions must you make in (a)?
c. Compare the results of (a) with those of Problem 10.9(a)

on page 375.

12.58 The management of a hotel has the busi-
ness objective of increasing the return rate for

hotel guests. One aspect of first impressions by guests
relates to the time it takes to deliver a guest’s luggage to the
room after check-in to the hotel. A random sample of 20 de-
liveries on a particular day were selected in Wing A of the
hotel, and a random sample of 20 deliveries were selected in
Wing B. The results are stored in .
a. Is there evidence of a difference in the median delivery

times in the two wings of the hotel? (Use )
b. Compare the results of (a) with those of Problem 10.67

on page 402.

12.59 The lengths of life (in hours) of a sample of 40 100-
watt light bulbs produced by Manufacturer A and a sample
of 40 100-watt light bulbs produced by Manufacturer B are
stored in .
a. Using a 0.05 level of significance, is there evidence of a

difference in the median life of bulbs produced by the
two manufacturers?

b. What assumptions must you make in (a)?
c. Compare the results of (a) with those of Problem 10.66

(a) on page 402. Discuss.

12.60 Nondestructive evaluation is used to measure the
properties of components or materials without causing
any permanent physical change to the components or ma-
terials. It includes the determination of properties of ma-
terials and the classification of flaws by size, shape, type,
and location. Nondestructive evaluation is very effective
for detecting surface flaws and characterizing surface
properties of electrically conductive materials. Data were
collected that classified each component as having a flaw
or not, based on manual inspection and operator judg-
ment, and also reported the size of the crack in the mate-
rial. The results in terms of crack size (in inches) are
stored in and shown below. (Data extracted from B.
D. Olin and W. Q. Meeker, “Applications of Statistical
Methods to Nondestructive Evaluation,” Technometrics,
38, 1996, p. 101.)

Unflawed

0.041  0.041  0.042  0.043  0.045  0.057  0.063  0.074  0.076

0.003  0.004  0.012  0.014  0.021 0.023  0.024  0.030  0.034

Crack

Bulbs

a = 0.05.

Luggage

SELF
Test

a = 0.05.

3.75 0.65 1.92 0.60 1.53 4.23 0.08 1.48 1.65 0.72

7.55 3.75 0.10 1.10 0.60 0.52 3.30 2.10 0.58 4.02
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Flawed

a. Using a 0.05 level of significance, is there evidence that
the median crack size is smaller for unflawed compo-
nents than for flawed components?

b. What assumptions must you make in (a)?
c. Compare the results of (a) with those of Problem 10.17

(a) on page 376. Discuss.

12.61 A bank with a branch located in a commercial dis-
trict of a city has developed an improved process for serv-
ing customers during the noon-to-1 P.M. lunch period. The
bank has the business objective of reducing the waiting time
(defined as the time elapsed from when the customer enters
the line until he or she reaches the teller window) to increase
customer satisfaction. A random sample of 15 customers is
selected (and stored in ); the results (in minutes) are
as follows:

4.50 6.10 0.38 5.12 6.46 6.19 3.79

4.21 5.55 3.02 5.13 4.77 2.34 3.54 3.20

Bank1

0.160  0.306  0.328  0.440

0.096  0.100  0.102  0.103  0.105  0.114  0.119  0.120  0.130

0.073  0.073  0.078  0.079  0.079  0.083  0.090  0.095  0.095

0.046  0.046  0.052  0.055  0.058  0.060  0.060  0.070  0.071

0.022  0.026  0.026  0.030  0.031  0.034  0.042  0.043  0.044

Another branch, located in a residential area, is also con-
cerned with the noon-to-1 P.M. lunch period. A random sam-
ple of 15 customers is selected (and stored in the file

); the results (in minutes) are as follows:

a. Is there evidence of a difference in the median waiting
time between the two branches? (Use )

b. What assumptions must you make in (a)?
c. Compare the results (a) with those of Problem 10.12 (a)

on page 376. Discuss.

12.62 Digital cameras have taken over the majority of the
point-and-shoot camera market. One of the important features
of a camera is the battery life, as measured by the number of
shots taken until the battery needs to be recharged. The file

contains the battery life of 29 subcompact
cameras and 16 compact cameras. (Data extracted from “Dig-
ital Cameras,” Consumer Reports, July 2009, pp. 28–29.)
a. Is there evidence of a difference in the median battery

life between subcompact cameras and compact cameras?
(Use )

b. What assumptions must you make in (a)?
c. Compare the results of (a) with those of Problem 10.11

(a) on page 376. Discuss.

a = 0.05.

DigitalCameras

a = 0.05.

10.49 6.68 5.64 4.08 6.17 9.91 5.47

9.66 5.90 8.02 5.79 8.73 3.82 8.01 8.35

Bank2

12.7 Kruskal-Wallis Rank Test: Nonparametric Analysis 
for the One-Way ANOVA

If the normality assumption of the one-way ANOVA F test is violated, you can use the
Kruskal-Wallis rank test. The Kruskal-Wallis rank test for differences among c medians
(where ) is an extension of the Wilcoxon rank sum test for two independent populations,
discussed in Section 12.6. Thus, the Kruskal-Wallis test has the same power relative to the one-
way ANOVA F test that the Wilcoxon rank sum test has relative to the t test.

You use the Kruskal-Wallis rank test to test whether c independent groups have equal
medians. The null hypothesis is

and the alternative hypothesis is

To use the Kruskal-Wallis rank test, you first replace the values in the c samples with their
combined ranks (if necessary). Rank 1 is given to the smallest of the combined values and rank
n to the largest of the combined values (where ). If any values are
tied, you assign each of them the mean of the ranks they would have otherwise been assigned
if ties had not been present in the data.

The Kruskal-Wallis test is an alternative to the one-way ANOVA F test. Instead of com-
paring each of the c group means against the grand mean, the Kruskal-Wallis test compares
the mean rank in each of the c groups against the overall mean rank, based on all n combined
values. Equation (12.10) defines the Kruskal-Wallis test statistic, H.

n = n1 + n2 + Á + nc

H1: Not all Mj are equal 1where j = 1, 2, Á , c2.

H0: M1 = M2 = Á = Mc

c 7 2
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KRUSKAL-WALLIS RANK TEST FOR DIFFERENCES AMONG C MEDIANS

(12.10)

where

total number of values over the combined samples

number of values in the jth sample ( )

sum of the ranks assigned to the jth sample

square of the sum of the ranks assigned to the jth sample

number of groupsc =

T2
j =

Tj =

j = 1, 2, Á , cnj =

n =

H = c 12

n1n + 12a
c

j=1

T
2

j

nj
d - 31n + 12

If there is a significant difference among the c groups, the mean rank differs considerably
from group to group. In the process of squaring these differences, the test statistic H becomes
large. If there are no differences present, the test statistic H is small because the mean of the
ranks assigned in each group should be very similar from group to group.

As the sample sizes in each group get large (i.e., at least 5), you can approximate the test
statistic, H, by the chi-square distribution with degrees of freedom. Thus, you reject the
null hypothesis if the computed value of H is greater than the upper-tail critical value (see
Figure 12.17). Therefore, the decision rule is

otherwise, do not reject H0.

Reject H0 if H 7 x2
a;

c - 1

Region of
Rejection

Region of
Nonrejection

Critical
Value

0
α1 – α

χ2χ2
α

F I G U R E 1 2 . 1 7
Determining the
rejection region for the
Kruskal-Wallis test

To illustrate the Kruskal-Wallis rank test for differences among c medians, return to the
Using Statistics scenario from Chapter 11 on page 415, concerning the strength of parachutes.
If you cannot assume that the tensile strength of the parachutes is normally distributed in all c
groups, you can use the Kruskal-Wallis rank test.

The null hypothesis is that the median tensile strengths of parachutes for the four
suppliers are equal. The alternative hypothesis is that at least one of the suppliers differs
from the others:

Table 12.17 presents the data (stored in the file ), along with the corresponding
ranks.

Parachute

H1: Not all Mj are equal 1where j = 1, 2, 3, 42.
H0: M1 = M2 = M3 = M4
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Tensile Strength and
Ranks of Parachutes
Woven from Synthetic
Fibers from Four
Suppliers

Supplier

1 2 3 4

Amount Rank Amount Rank Amount Rank Amount Rank

18.5 4 26.3 20 20.6 8 25.4 19
24.0 13.5 25.3 18 25.2 17 19.9 5.5
17.2 1 24.0 13.5 20.8 9 22.6 11
19.9 5.5 21.2 10 24.7 16 17.5 2
18.0 3 24.5 15 22.9 12 20.4 7

502 CHAPTER 12 Chi-Square Tests and Nonparametric Tests

In converting the 20 tensile strengths to ranks, observe in Table 12.17 that the third para-
chute for Supplier 1 has the lowest tensile strength, 17.2. It is assigned a rank of 1. The fourth
value for Supplier 1 and the second value for Supplier 4 each have a value of 19.9. Because
they are tied for ranks 5 and 6, each is assigned the rank 5.5. Finally, the first value for Sup-
plier 2 is the largest value, 26.3, and is assigned a rank of 20.

After all the ranks are assigned, you compute the sum of the ranks for each group:

Rank sums:

As a check on the rankings, recall from Equation (12.8) on page 495 that for any integer n, the
sum of the first n consecutive integers is Therefore,

To test the null hypothesis of equal population medians, you calculate the test statistic H using
Equation (12.10) on page 501:

The test statistic H approximately follows a chi-square distribution with degrees of
freedom. Using a 0.05 level of significance, the upper-tail critical value of the chi-square dis-
tribution with degrees of freedom, is 7.815 (see Table 12.18). Because the computed
value of the test statistic is greater than the critical value, you reject the null hypoth-
esis and conclude that the median tensile strength is not the same for all the suppliers. You reach
the same conclusion by using the p-value approach, because, as shown in Figure 12.18,

At this point, you could simultaneously compare all pairs of sup-
pliers to determine which ones differ (see reference 2).
p-value = 0.0484 6 0.05.

H = 7.8886
c - l = 3

x2
a,

c - l

= a 12
420
b12,481.12 - 63 = 7.8886

= e 12

12021212 c
12722

5
+
176.522

5
+
16222

5
+
144.522

5
d f - 31212

H = c 12

n1n + 12a
c

j=1

T 2
j

nj
d - 31n + 12

210 = 210

27 + 76.5 + 62 + 44.5 =
12021212

2

T1 + T2 + T3 + T4 =
n1n + 12

2

n1n + 12>2.

T1 = 27 T2 = 76.5 T3 = 62 T4 = 44.5
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T A B L E 1 2 . 1 8

Finding the Upper-
Tail Critical Value for the
Kruskal-Wallis Rank Test,
at the 0.05 Level of
Significance with 3
Degrees of Freedom

x2
a,

Cumulative Area

.005 .01 .025 .05 .10 .25 .75 .90 .95 .975

Upper-Tail Area

Degrees
of Freedom .995 .99 .975 .95 .90 .75 .25 .10 .05 .025

1 — — 0.001 0.004 0.016 0.102 1.323 2.706 3.841 5.024
2 0.010 0.020 0.051 0.103 0.211 0.575 2.773 4.605 5.991 7.378
3 0.072 0.115 0.216 0.352 0.584 1.213 4.108 6.251 7.815 9.348
4 0.207 0.297 0.484 0.711 1.064 1.923 5.385 7.779 9.488 11.143
5 0.412 0.554 0.831 1.145 1.610 2.675 6.626 9.236 11.071 12.833
Source: Extracted from Table E.4.

F I G U R E 1 2 . 1 8
Excel and Minitab Kruskal-Wallis rank test results for differences among the four median tensile strengths
of parachutes

The following assumptions are needed to use the Kruskal-Wallis rank test:

• The c samples are randomly and independently selected from their respective populations.
• The underlying variable is continuous.
• The data provide at least a set of ranks, both within and among the c samples.
• The c populations have the same variability.
• The c populations have the same shape.

The Kruskal-Wallis procedure makes less stringent assumptions than does the F test. If
you ignore the last two assumptions (variability and shape), you can still use the Kruskal-
Wallis rank test to determine whether at least one of the populations differs from the other
populations in some characteristic—such as central tendency, variation, or shape.

To use the F test, you must assume that the c samples are from normal populations that
have equal variances. When the more stringent assumptions of the F test hold, you should use
the F test instead of the Kruskal-Wallis test because it has slightly more power to detect signif-
icant differences among groups. However, if the assumptions of the F test do not hold, you
should use the Kruskal-Wallis test.



Kidney Shrimp Chicken Liver Salmon Beef

2.37 2.26 2.29 1.79 2.09
2.62 2.69 2.23 2.33 1.87
2.31 2.25 2.41 1.96 1.67
2.47 2.45 2.68 2.05 1.64
2.59 2.34 2.25 2.26 2.16
2.62 2.37 2.17 2.24 1.75
2.34 2.22 2.37 1.96 1.18
2.47 2.56 2.26 1.58 1.92
2.45 2.36 2.45 2.18 1.32
2.32 2.59 2.57 1.93 1.94

Problems for Section 12.7
LEARNING THE BASICS
12.63 What is the upper-tail critical value from the chi-
square distribution if you use the Kruskal-Wallis rank test
for comparing the medians in six populations at the 0.01
level of significance?

12.64 For this problem, use the results of Problem 12.63.
a. State the decision rule for testing the null hypothesis that

all six groups have equal population medians.
b. What is your statistical decision if the computed value of

the test statistic H is 13.77?

APPLYING THE CONCEPTS
12.65 A pet food company has the business objective of ex-
panding its product line beyond its current kidney- and
shrimp-based cat foods. The company developed two new
products—one based on chicken livers and the other based on
salmon. The company conducted an experiment to compare
the two new products with its two existing ones as well as a
generic beef-based product sold in a supermarket chain.

For the experiment, a sample of 50 cats from the population
at a local animal shelter was selected. Ten cats were randomly
assigned to each of the five products being tested. Each of the
cats was then presented with 3 ounces of the selected food in a
dish at feeding time. The researchers defined the variable to be
measured as the number of ounces of food that the cat con-
sumed within a 10-minute time interval that began when the
filled dish was presented. The results for this experiment are
summarized in the following table and stored in :CatFood

c. Which test is more appropriate for these data, the
Kruskal-Wallis rank test or the one-way ANOVA F test?
Explain.

12.66 A hospital conducted a study of the wait-
ing time in its emergency room. The hospital has a

main campus, along with three satellite locations. Manage-
ment had a business objective of reducing waiting time for
emergency room cases that did not require immediate atten-
tion. To study this, a random sample of 15 emergency room
cases at each location were selected on a particular day, and
the waiting time (recorded from check-in to when the
patient was called into the clinic area) was measured. The
results are stored in .
a. At the 0.05 level of significance, is there evidence of a

difference in the median waiting times in the four
locations?

b. Compare the results of (a) with those of Problem 11.9 (a)
on page 428.

12.67 The per-store daily customer count (i.e., the mean
number of customers in a store in one day) for a nationwide
convenience store chain that operates nearly 10,000 stores
has been steady, at 900, for some time. To increase the cus-
tomer count, the chain is considering cutting prices for cof-
fee beverages. Management needs to determine how much
prices can be cut in order to increase the daily customer
count without reducing the gross margin on coffee sales too
much. You decide to carry out an experiment in a sample of
24 stores where customer counts have been running almost
exactly at the national average of 900. In 6 of the stores, a
small coffee will be $0.59, in another 6 stores the price will
be $0.69, in a third group of 6 stores, the price will be $0.79,
and in a fourth group of 6 stores, the price will now be
$0.89. After four weeks, the daily customer count in the
stores is stored in .
a. At the 0.05 level of significance, is there evidence of a

difference in the daily customer count based on the price
of a small coffee?

b. Compare the results of (a) with those of Problem 11.11
(a) on page 428.

12.68 An advertising agency has been hired by a
manufacturer of pens to develop an advertising campaign
for the upcoming holiday season. To prepare for this proj-
ect, the research director decides to initiate a study of the
effect of advertising on product perception. An experiment
is designed to compare five different advertisements.
Advertisement A greatly undersells the pen’s character-
istics. Advertisement B slightly undersells the pen’s
characteristics. Advertisement C slightly oversells the
pen’s characteristics. Advertisement D greatly oversells the

CoffeeSales

ERWaiting

SELF
Test
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a. At the 0.05 level of significance, is there evidence of a
significant difference in the median amount of food eaten
among the various products?

b. Compare the results of (a) with those of Problem 11.13
(a) on page 429.
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pen’s characteristics. Advertisement E attempts to correctly
state the pen’s characteristics. A sample of 30 adult respon-
dents, taken from a larger focus group, is randomly as-
signed to the five advertisements (so that there are six
respondents to each). After reading the advertisement and
developing a sense of product expectation, all respondents
unknowingly receive the same pen to evaluate. The respon-
dents are permitted to test the pen and the plausibility of
the advertising copy. The respondents are then asked to rate
the pen from 1 to 7 on the product characteristic scales of
appearance, durability, and writing performance. The
combined scores of three ratings (appearance, durability,
and writing performance) for the 30 respondents (stored in

) are as follows:Pen

A B C D E

15 16 8 5 12
18 17 7 6 19
17 21 10 13 18
19 16 15 11 12
19 19 14 9 17
20 17 14 10 14

c. Which test is more appropriate for these data, the
Kruskal-Wallis rank test or the one-way ANOVA F test?
Explain.

12.69 A sporting goods manufacturing company wanted
to compare the distance traveled by golf balls produced
using each of four different designs. Ten balls of each design
were manufactured and brought to the local golf course for
the club professional to test. The order in which the balls
were hit with the same club from the first tee was random-
ized so that the pro did not know which type of ball was
being hit. All 40 balls were hit in a short period of time, dur-
ing which the environmental conditions were essentially the
same. The results (distance traveled in yards) for the four
designs are stored in :
a. At the 0.05 level of significance, is there evidence of a

difference in the median distances traveled by the golf
balls with different designs?

b. Compare the results of (a) with those of Problem 11.14
(a) on page 429.

12.70 Students in a business statistics course performed an
experiment to test the strength of four brands of trash bags.
One-pound weights were placed into a bag, one at a time,
until the bag broke. A total of 40 bags were used (10 for each
brand). The file gives the weight (in pounds)
required to break the trash bags.
a. At the 0.05 level of significance, is there evidence of a

difference in the median strength of the four brands of
trash bags?

b. Compare the results in (a) to those in Problem 11.8 (a) on
page 428.

Trashbags

Golfball

12.8 Online Topic: Wilcoxon Signed Ranks Test:
Nonparametric Analysis for Two Related Populations

In Section 10.2, you used the paired t test to compare the means of two populations when
you had repeated measures or matched samples. The paired t test assumes that the data are
measured on an interval or a ratio scale and are normally distributed. If you cannot make
these assumptions, you can use the nonparametric Wilcoxon signed ranks test to test for
the median difference. To study this topic, read the Section 12.8 online topic file that is
available on this book’s companion website. (See Appendix C to learn how to access the
online topic files.)

a. At the 0.05 level of significance, is there evidence of a
difference in the median ratings of the five advertise-
ments?

b. Compare the results of (a) with those of Problem 11.10
(a) on page 428.



S U M M A R Y
Figure 12.19 presents a roadmap for this chapter. First, you
used hypothesis testing for analyzing categorical response
data from two independent samples and from more than
two independent samples. In addition, the rules of probabil-
ity from Section 4.2 were extended to the hypothesis of
independence in the joint responses to two categorical vari-
ables. You also used the McNemar test to study situations

where the samples were not independent. In addition, you
used the chi-square distribution to test a variance or stan-
dard deviation. You also studied two nonparametric tests.
You used the Wilcoxon rank sum test when the assumptions
of the t test for two independent samples were violated and
the Kruskal-Wallis test when the assumptions of the one-
way ANOVA F test were violated.

12.9 Online Topic: Friedman Rank Test: Nonparametric
Analysis for the Randomized Block Design

When analyzing a randomized block design, sometimes the data consist of only the ranks
within each block. Other times, you cannot assume that the data from each of the c groups
are from normally distributed populations. In these situations, you can use the Friedman
rank test. To study this topic, read the Section 12.9 online topic file that is available on
this book’s companion website. (See Appendix C to learn how to access the online topic
files.)

In the Using Statistics scenario, you were the manager of T.C. Resort
Properties, a collection of five upscale hotels located on two tropical
islands. To assess the quality of services being provided by your
hotels, guests are encouraged to complete a satisfaction survey when

they check out. You analyzed the data from these surveys to determine the
overall satisfaction with the services provided, the likelihood that the
guests will return to the hotel, and the reasons given by some guests for

not wanting to return.
On one island, T.C. Resort Properties operates the Beachcomber and Windsurfer hotels.

You performed a chi-square test for the difference in two proportions and concluded that a
greater proportion of guests are willing to return to the Beachcomber Hotel than to the
Windsurfer. On the other island, T.C. Resort Properties operates the Golden Palm, Palm
Royale, and Palm Princess hotels. To see if guest satisfaction was the same among the three
hotels, you performed a chi-square test for the differences among more than two proportions.
The test confirmed that the three proportions are not equal, and guests are most likely to
return to the Palm Royale and least likely to return to the Golden Palm.

In addition, you investigated whether the reasons given for not returning to the Golden
Palm, Palm Royale, and Palm Princess were unique to a certain hotel or common to all three
hotels. By performing a chi-square test of independence, you determined that the reasons given
for wanting to return or not depended on the hotel where the guests had been staying. By exam-
ining the observed and expected frequencies, you concluded that guests were more satisfied
with the price at the Golden Palm and were much more satisfied with the location of the Palm
Princess. Guest satisfaction with room accommodations was not significantly different among
the three hotels.

U S I N G S TAT I S T I C S @ T.C. Resort Properties Revisited
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χ2 Tests of Independence Tests for Proportions

2

Yes

3 or More1

No

Z Test for a
Proportion

(see Section 9.4)

Number of
Samples

McNemar
Test

Independent
Samples

r × c
Tables

2 × c
Tables

2 × 2
Tables

Wilcoxon
Rank Sum Test

Wilcoxon
Signed Ranks Test

(Online Section 12.8)

Friedman Test
(Online Section 12.9)

Kruskal-Wallis
Test

χ2 Test for
�1 = �2

Z Test for
�1 = �2

(see Section 10.3)

Types of
Tests

Contingency
Tables

Nonparametric
Tests

χ2 Test for
�1 = �2 = . . .  = �c

Marascuilo
Procedure

Categorical
Data Procedures

Other χ2

Tests

Test for a
Variance or

Standard Deviation

F I G U R E 1 2 . 1 9
Roadmap of Chapter 12

K E Y E Q U AT I O N S

Test for the Difference Between Two Proportions

(12.1)

Computing the Estimated Overall Proportion for Two
Groups

(12.2)p =
X1 + X2

n1 + n2
=

X
n

x2
STAT = a

all cells

1f0 - fe22
fe

X2 Computing the Estimated Overall Proportion for c Groups

(12.3)

Critical Range for the Marascuilo Procedure

(12.4)Critical range = 2x2
aApj11 - pj2

nj
+

pj¿11 - pj¿2
nj¿

p =
X1 + X2 + Á + Xc

n1 + n2 + Á + nc
=

X
n



PIZZERIA

GENDER Pizza Hut Other Total

Female 4 13 17
Male 6 12 18
Total 10 25 35
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chi-square distribution 470
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C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING

12.71 Under what conditions should you use the test to
determine whether there is a difference between the propor-
tions of two independent populations?

12.72 Under what conditions should you use the test to
determine whether there is a difference among the propor-
tions of more than two independent populations?

12.73 Under what conditions should you use the test of
independence?

12.74 Under what conditions should you use the McNe-
mar test?

12.75 What is a nonparametric procedure?

12.76 Under what conditions should you use the Wilcoxon
rank sum test instead of the t test for the difference between
the means?

12.77 Under what conditions should you use the Kruskal-
Wallis rank test instead of the one-way ANOVA?

x2

x2

x2

APPLYING THE CONCEPTS

12.78 Undergraduate students at Miami University in
Oxford, Ohio, were surveyed in order to evaluate the effect
of gender and price on purchasing a pizza from Pizza Hut.
Students were told to suppose that they were planning to
have a large two-topping pizza delivered to their residence
that evening. The students had to decide between ordering
from Pizza Hut at a reduced price of $8.49 (the regular price
for a large two-topping pizza from the Oxford Pizza Hut at
this time was $11.49) and ordering a pizza from a different
pizzeria. The results from this question are summarized in
the following contingency table:
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Computing the Expected Frequency

(12.5)

McNemar Test Statistic

(12.6)

Test for the Variance or Standard Deviation

(12.7)

Checking the Rankings

(12.8)T1 + T2 =
n1n + 12

2

x2
STAT =

1n - 12S2

s2

X2

ZSTAT =
B - C2B + C

fe =
Row total * Column total

n

Large Sample Wilcoxon Rank Sum Test

(12.9)

Kruskal-Wallis Rank Test for Differences Among c

Medians

(12.10)H = c 12

n1n + 12a
c

j=1

T2
j

nj
d - 31n + 12

ZSTAT =
T1 -

n11n + 12
2

An1 n21n + 12
12
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a. At the 0.05 level of significance, is there evidence of a
relationship between attitude toward self-managed work
teams and type of job?

The survey also asked respondents about their attitudes
toward instituting a policy whereby an employee could take
one additional vacation day per month without pay. The re-
sults, cross-classified by type of job, are as follows:

For each type of activity, determine whether there is a
difference between boys and girls at the 0.05 level of
significance.

12.80 A company is considering an organizational change
involving the use of self-managed work teams. To assess the
attitudes of employees of the company toward this change, a
sample of 400 employees is selected and asked whether they
favor the institution of self-managed work teams in the
organization. Three responses are permitted: favor, neutral,
or oppose. The results of the survey, cross-classified by type
of job and attitude toward self-managed work teams, are
summarized as follows:

A subsequent survey evaluated purchase decisions at
other prices. These results are summarized in the following
contingency table:

PRICE

PIZZERIA $8.49 $11.49 $14.49 Total

Pizza Hut 10 5 2 17
Other 25 23 27 75
Total 35 28 29 92

a. Using a 0.05 level of significance and using the data in
the first contingency table, is there evidence of a
significant difference between males and females in their
pizzeria selection?

b. What is your answer to (a) if nine of the male students
selected Pizza Hut and nine selected another pizzeria?

c. Using a 0.05 level of significance and using the data in
the second contingency table, is there evidence of a
difference in pizzeria selection based on price?

d. Determine the p-value in (c) and interpret its meaning.

12.79 According to U.S. Census estimates, there were about
20 million children between 8 and 12 years old (referred to as
tweens) in the United States in 2009. A recent survey of 1,223
8- to 12-year-old children (S. Jayson, “It’s Cooler Than Ever
to Be a Tween,” USA Today, February 4, 2009, pp. 1A, 2A)
reported the following results. Suppose that the survey was
based on 600 boys and 623 girls.

What Tweens Did in the Past Week Boys Girls

Played a game on a video 
game system

498 243

Read a book for fun 276 324
Gave product advice to parents 186 181
Shopped at a mall 144 262

SELF-MANAGED WORK TEAMS

TYPE OF JOB Favor Neutral Oppose Total

Hourly worker 108 46 71 225
Supervisor 18 12 30 60
Middle

management
35 14 26 75

Upper
management

24 7 9 40

Total 185 79 136 400

VACATION TIME WITHOUT PAY

TYPE OF JOB Favor Neutral Oppose Total

Hourly worker 135 23 67 225
Supervisor 39 7 14 60
Middle

management
47 6 22 75

Upper
management

26 6 8 40

Total 247 42 111 400

b. At the 0.05 level of significance, is there evidence of a
relationship between attitude toward vacation time with-
out pay and type of job?

12.81 A company that produces and markets continuing
education programs on DVDs for the educational testing
industry has traditionally mailed advertising to prospective
customers. A market research study was undertaken to
compare two approaches: mailing a sample DVD upon re-
quest that contained highlights of the full DVD and sending
an e-mail containing a link to a website from which sample
material could be downloaded. Of those who responded to
either the mailing or the e-mail, the results were as follows
in terms of purchase of the complete DVD:

TYPE OF MEDIA USED

PURCHASED Mailing E-mail Total

Yes 26 11 37
No 227 247 474
Total 253 258 511



a. Is there evidence of a difference in the proportion of re-
spondents who prefer Apple before and after viewing the
ads? (Use )

b. Compute the p-value and interpret its meaning.
c. Show how the following table was derived from the table

above:

a = 0.05.

MANUFACTURER

PREFERENCE Apple Dell Total

Before ad 100 100 200
After ad 108 92 200
Total 208 192 400

SALES APPROACH

ACTION
Targeted
E-mail

More
Complete

DVD
Telephone

Call Total

Purchase 5 17 18 40
Don’t
purchase

153 141 140 434

Total 158 158 158 474

PREFERENCE BEFORE 
TASTE TEST

PREFERENCE AFTER 
TASTE TEST

Coca-Cola Pepsi Total

Coca-Cola 104 6 110
Pepsi 14 76 90
Total 118 82 200

SOFT DRINK

PREFERENCE Coca-Cola Pepsi Total

Before taste test 110 90 200
After taste test 118 82 200
Total 228 172 400

PREFERENCE
AFTER ADS

PREFERENCE BEFORE ADS Apple Dell Total

Apple 97 3 100
Dell 11 89 100
Total 108 92 200

510 CHAPTER 12 Chi-Square Tests and Nonparametric Tests

a. At the 0.05 level of significance, is there evidence of a
difference in the proportion of DVDs purchased on the
basis of the type of media used?

b. On the basis of the results of (a), which type of media
should the company use in the future? Explain the ration-
ale for your decision.

The company also wanted to determine which of three
sales approaches should be used to generate sales among
those who either requested the sample DVD by mail or
downloaded the sample DVD but did not purchase the full
DVD: (1) targeted e-mail, (2) a DVD that contained addi-
tional features, or (3) a telephone call to prospective cus-
tomers. The 474 respondents who did not initially purchase
the full DVD were randomly assigned to each of the three
sales approaches. The results, in terms of purchases of
the full-program DVD, are as follows:

a. Is there evidence of a difference in the proportion of re-
spondents who prefer Coca-Cola before and after the
taste tests? (Use )

b. Compute the p-value and interpret its meaning.
c. Show how the following table was derived from the table

above:

a = 0.10.

c. At the 0.05 level of significance, is there evidence of a
difference in the proportion of DVDs purchased on the
basis of the sales strategy used?

d. On the basis of the results of (c), which sales approach do
you think the company should use in the future? Explain
the rationale for your decision.

12.82 A market researcher investigated consumer prefer-
ences for Coca-Cola and Pepsi before a taste test and after a
taste test. The following table summarizes the results from a
sample of 200 consumers:

d. Using the second table, is there evidence of a difference
in preference for Coca-Cola before and after the taste
test? (Use )

e. Determine the p-value and interpret its meaning.
f. Explain the difference in the results of (a) and (d). Which

method of analyzing the data should you use? Why?

12.83 A market researcher was interested in studying the
effect of advertisements on brand preference of people pur-
chasing a new personal computer. Prospective purchasers of
new computers were first asked whether they preferred
Apple or Dell and then watched video advertisements of
comparable models of the two brands. After viewing the
ads, the prospective customers again indicated their prefer-
ences. The results are summarized in the following table:

a = 0.05.

d. Using the second table, is there evidence of a difference
in preference for Apple before and after viewing the ads?
(Use )

e. Determine the p-value and interpret its meaning.
f. Explain the difference in the results of (a) and (d).

Which method of analyzing the data should you use?
Why?

a = 0.05.
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STUDENT SURVEY DATABASE

12.87 Problem 1.27 on page 14 describes a survey of 62
undergraduate students (stored in ). For
these data, construct contingency tables, using gender, ma-
jor, plans to go to graduate school, and employment status.
(You need to construct six tables, taking two variables at a
time.) Analyze the data at the 0.05 level of significance to
determine whether any significant relationships exist among
these variables.

12.88 Problem 1.27 on page 14 describes a survey of 62
undergraduate students (stored in ).
a. Select a sample of undergraduate students at your school

and conduct a similar survey for those students.
b. For the data collected in (a), repeat Problem 12.87.
c. Compare the results of (b) to those of Problem 12.87.

12.89 Problem 1.28 on page 15 describes a survey of 44
MBA students (see the file ). For these data,
construct contingency tables, using gender, undergraduate
major, graduate major, and employment status. (You need to
construct six tables, taking two variables at a time.) Analyze
the data at the 0.05 level of significance to determine
whether any significant relationships exist among these
variables.

12.90 Problem 1.28 on page 15 describes a survey of 44
MBA students (stored in ).
a. Select a sample of graduate students in your MBA

program and conduct a similar survey for those
students.

b. For the data collected in (a), repeat Problem 12.89.
c. Compare the results of (b) to those of Problem 12.89.

GradSurvey

GradSurvey

UndergradSurvey

UndergradSurvey

TEAM PROJECT
The file contains information regarding eight
variables from a sample of 184 bond mutual funds:

Type—Type of bonds comprising the bond mutual fund
(intermediate government or short-term corporate)

Assets—In millions of dollars
Fees—Sales charges (no or yes)
Expense ratio—Ratio of expenses to net assets in

percentage
Return 2009—Twelve-month return in 2009
Three-year return—Annualized return, 2007–2009
Five-year return—Annualized return, 2005–2009
Risk—Risk-of-loss factor of the bond mutual fund (below

average, average, or above average)
12.84 a. Construct a contingency table, using fees

as the row variable and type as the column
variable.

b. At the 0.05 level of significance, is there evidence
of a significant relationship between the type of
bond mutual fund and whether there is a fee?

12.85 a. Construct a contingency table, using fees
as the row variable and risk as the column
variable.

b. At the 0.05 level of significance, is there evi-
dence of a significant relationship between the
perceived risk of a bond mutual fund and
whether there is a fee?

12.86 a. Construct a contingency table, using risk
as the row variable and category as the column
variable.

b. At the 0.05 level of significance, is there evidence
of a significant relationship between the category
of a bond mutual fund and its perceived risk?

3 * 2

2 * 3

2 * 2

Bond Funds

M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
Phase 1
Reviewing the results of its research, the marketing depart-
ment team concluded that a segment of Ashland households
might be interested in a discounted trial subscription to the
AMS 3-For-All cable/phone/Internet service. The team
decided to test various discounts before determining the
type of discount to offer during the trial period. It decided
to conduct an experiment using three types of discounts
plus a plan that offered no discount during the trial period:

1. No discount for the 3-For-All cable/phone/Internet
service. Subscribers would pay $24.99 per week for the
3-For-All cable/phone/Internet service during the 90-day
trial period.

2. Moderate discount for the 3-For-All cable/phone/Inter-
net service. Subscribers would pay $19.99 per week for

the 3-For-All cable/phone/Internet service during the
90-day trial period.

3. Substantial discount for the 3-For-All cable/phone/In-
ternet service. Subscribers would pay $14.99 per week
for the 3-For-All cable/phone/Internet service during
the 90-day trial period.

4. Discount restaurant card. Subscribers would be given a
card providing a discount of 15% at selected restaurants
in Ashland during the trial period.

Each participant in the experiment was randomly
assigned to a discount plan. A random sample of 100 sub-
scribers to each plan during the trial period was tracked to
determine how many would continue to subscribe to the
3-For-All service after the trial period. Table AMS12.1
summarizes the results.



METHOD FOR CURRENT SUBSCRIPTION

GOLD
CARD

Toll-Free
Phone

AMS
Website

Direct Mail
Reply Card

Good Tunes
& More Other Total

Yes 10 20 5 1 2 38

No 220 86 41 9 24 380

Total 230 106 46 10 26 418

D I G I TA L C A S E
Apply your knowledge of testing for the difference between
two proportions in this Digital Case, which extends the T.C.
Resort Properties Using Statistics scenario of this chapter.

As T.C. Resort Properties seeks to improve its customer
service, the company faces new competition from SunLow

Resorts. SunLow has recently opened resort hotels on the
islands where T.C. Resort Properties has its five hotels.
SunLow is currently advertising that a random survey of
300 customers revealed that about 60% of the customers
preferred its “Concierge Class” travel reward program over
the T.C. Resorts “TCRewards Plus” program.

T A B L E A M S 1 2 . 1

Number of Subscribers Who Continue Subscriptions
After Trial Period with Four Discount Plans

CONTINUE
SUBSCRIPTIONS
AFTER TRIAL
PERIOD

DISCOUNT PLANS

No
Discount

Moderate
Discount

Substantial
Discount

Restaurant
Card Total

Yes 24 30 38 51 143

No 76 70 62 49 257

Total 100 100 100 100 400

HAS AMS TELE-
PHONE SERVICE

HAS AMS
INTERNET SERVICE

Yes No Total

Yes 55 28 83
No 207 128 335
Total 262 156 418

DISCOUNT TRIAL

TYPE OF SERVICE Yes No Total

Basic 8 156 164
Enhanced 32 222 254
Total 40 378 418

WATCHES PREMIUM OR ON-DEMAND SERVICES

TYPE OF
SERVICE

Almost
Every Day

Several
Times a Week

Almost
Never Never Total

Basic 2 5 127 30 164
Enhanced 12 30 186 26 254
Total 14 35 313 56 418

WATCHES PREMIUM OR ON-DEMAND SERVICES

DISCOUNT
Almost

Every Day
Several

Times a Week
Almost
Never Never Total

Yes 4 5 27 4 40

No 10 30 286 52 378

Total 14 35 313 56 418

METHOD FOR CURRENT SUBSCRIPTION

DIS-
COUNT

Toll-Free
Phone

AMS
Website

Direct Mail
Reply Card

Good Tunes
& More Other Total

Yes 11 21 5 1 2 40

No 219 85 41 9 24 378

Total 230 106 46 10 26 418
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Exercise
1. Analyze the results of the experiment. Write a report to

the team that includes your recommendation for which
discount plan to use. Be prepared to discuss the limita-
tions and assumptions of the experiment.

Phase 2
The marketing department team discussed the results of the
survey presented in Chapter 8, on pages 317–318. The team
realized that the evaluation of individual questions was
providing only limited information. In order to further
understand the market for the 3-For-All cable/phone/Inter-
net service, the data were organized in the following contin-
gency tables:

Exercise
2. Analyze the results of the contingency tables. Write a

report for the marketing department team and discuss the
marketing implications of the results for Ashland Multi-
Comm Services.
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Open and review ConciergeClass.pdf, an electronic
brochure that describes the Concierge Class program and
compares it to the T.C. Resorts program. Then answer the
following questions:
1. Are the claims made by SunLow valid?

2. What analyses of the survey data would lead to a more fa-
vorable impression about T.C. Resort Properties?

3. Perform one of the analyses identified in your answer to
step 2.

4. Review the data about the T.C. Resorts properties
customers presented in this chapter. Are there any other
questions that you might include in a future survey of
travel reward programs? Explain.
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EG12.1 CHI-SQUARE TEST for the
DIFFERENCE BETWEEN TWO
PROPORTIONS

PHStat2 Use Chi-Square Test for Differences in Two
Proportions to perform this chi-square test. For example, to
perform the Figure 12.3 test for the two-hotel guest satisfac-
tion data on page 472, select PHStat ➔ Two-Sample Tests
(Summarized Data) ➔ Chi-Square Test for Differences
in Two Proportions. In the procedure’s dialog box, enter
0.05 as the Level of Significance, enter a Title, and click
OK. In the new worksheet:

1. Read the yellow note about entering values and then
press the Delete key to delete the note.

2. Enter Hotel in cell B4 and Choose Again? in cell A5.

3. Enter Beachcomber in cell B5 and Windsurfer in
cell C5.

4. Enter Yes in cell A6 and No in cell A7.

5. Enter 163, 64, 154, and 108 in cells B6, B7, C6, and C7,
respectively.

In-Depth Excel Use the COMPUTE worksheet of the
Chi-Square workbook, shown in Figure 12.3 on page 472,
as a template for performing this test. The worksheet
contains the Table 12.3 two-hotel guest satisfaction data.
Use the CHIINV and CHIDIST functions to help perform
the chi-square test for the difference between two propor-
tions. In cell B24, the worksheet uses CHIINV(level of sig-

nificance, degrees of freedom) to compute the critical value
for the test and in cell B26 uses CHIDIST(chi-square test

statistic, degrees of freedom) to compute the p-value. Open
to the COMPUTE_FORMULAS worksheet to examine
the other formulas used in the worksheet.

For other problems, change the Observed Frequencies
cell counts and row and column labels in rows 4 through 7.

EG12.2 CHI-SQUARE TEST for
DIFFERENCES AMONG MORE
THAN TWO PROPORTIONS

PHStat2 Use Chi-Square Test to perform the test for dif-
ferences among more than two proportions. For example, to
perform the Figure 12.6 test for the three-hotel guest
satisfaction data on page 478, select PHStat ➔ Multiple-
Sample Tests ➔ Chi-Square Test. In the procedure’s dia-
log box (shown in the right column):

1. Enter 0.05 as the Level of Significance.

2. Enter 2 as the Number of Rows.

3. Enter 3 as the Number of Columns.

4. Enter a Title and click OK.

C H A P T E R 1 2 E X C E L G U I D E

In the new worksheet:

5. Read the yellow note about entering values and then
press the Delete key to delete the note.

6. Enter the Table 12.6 data on page 476, including row and
column labels, in rows 4 through 7.

In-Depth Excel Use the ChiSquare2x3 worksheet of the
Chi-Square Worksheets workbook, shown in Figure 12.6 on
page 478, as a model for this chi-square test. The worksheet
contains the data for Table 12.6 guest satisfaction data (see
page 476). The worksheet uses formulas to compute the
expected frequencies and the intermediate results for the chi-
square test statistic in much the same way as the COMPUTE
worksheet of the Chi-Square workbook discussed in the Sec-
tion EG12.1 In-Depth Excel instructions and shown in Figure
12.3 on page 472. (Open to the ChiSquare2x3 _FORMULAS
worksheet to examine all the formulas used in the worksheet.)

For other problems, change the Observed Fre-
quencies cell counts and row and column labels in rows 4
through 7. For problems, use the ChiSquare2x4
worksheet. For problems, use the ChiSquare2x5
worksheet. In either case, enter the contingency table data
for the problem in the rows 4 through 7 Observed Frequen-
cies area.

The Marascuilo Procedure

PHStat2 Modify the PHStat2 instructions for the chi-
square test to include the Marascuilo procedure to test for

2 * 5
2 * 4

2 * 3



Chapter 12 Excel Guide 515

the difference among more than two proportions (see page
514). In step 4, enter a Title, check Marascuilo Procedure,
and then click OK.

In-Depth Excel Use the Marascuilo worksheet linked to a
particular chi-square worksheet in the Chi-Square
Wooksheets workbook to perform the Marascuilo procedure.

For example, Figure 12.7 on page 479 shows the
Marascuilo2x3 worksheet, which is linked to the
ChiSquare2x3 worksheet. This Marascuilo worksheet uses
values from the ChiSquare2x3 worksheet to compute group
sample proportions in cells B7 through B9 (shown in Figure
12.7) and to compute the critical range in rows 13, 14, and
16. In column D, the worksheet uses IF functions in the
form IF(absolute difference > critical range, display “Sig-

nificant”, display “Not significant”) to indicate which pairs
of groups are significantly different. (Open to the
Marascuilo2x3_ FORMULAS worksheet to examine all
the formulas used in the worksheet.)

EG12.3 CHI-SQUARE TEST
of INDEPENDENCE

PHStat2 Use Chi-Square Test to perform the chi-square test
of independence. For example, to perform the Figure 12.10
test for the survey data concerning three hotels on page 485,
select PHStat ➔ Multiple-Sample Tests ➔ Chi-Square
Test. In the procedure’s dialog box (shown below):

1. Enter 0.05 as the Level of Significance.

2. Enter 4 as the Number of Rows.

3. Enter 3 as the Number of Columns.

4. Enter a Title and click OK.

In the new worksheet:

5. Read the yellow note about entering values and then
press the Delete key to delete the note.

6. Enter the Table 12.9 data on page 482, including row and
column labels, in rows 4 through 9.

2 * c

In-Depth Excel Use one of the worksheets in the
Chi-Square worksheets workbook to perform the chi-
square test of independence. For example, Figure 12.10 on
page 485 shows the ChiSquare4x3 worksheet that contains
the data for Table 12.9 not-returning survey (see page 482).
The worksheet computes the expected frequencies and the
intermediate results for the chi-square test statistic in much
the same way as the COMPUTE worksheet of the Chi-
Square workbook discussed in the Section EG12.1 In-Depth
Excel instructions.

For other problems, change the Observed
Frequencies cell counts and row and column labels in rows
4 through 9. For problems, use the ChiSquare3x4
worksheet. For problems, use the ChiSquare4x3
worksheet. For problems, use the ChiSquare7x3
worksheet. For problems, use the ChiSquare8x3
worksheet. In each case, enter the contingency table data
for the problem in the Observed Frequencies area.

EG12.4 McNEMAR TEST for the
DIFFERENCE BETWEEN TWO
PROPORTIONS (RELATED SAMPLES)

PHStat2 Use McNemar Test to perform the McNemar test.
For example, to perform the Figure 12.12 test for the brand
loyalty of cell phone providers (see page 489), select PHStat
➔ Two-Sample Tests (Summarized Data) ➔ McNemar
Test. In the procedure’s dialog box (shown below):

1. Enter 0.05 as the Level of Significance.

2. Click Two-Tail Test.

3. Enter a Title and click OK.

In the new worksheet:

4. Read the yellow note about entering values and then
press the Delete key to delete the note.

5. Enter the Table 12.13 data (see page 488), including row
and column labels, in rows 4 through 7.

8 * 3
7 * 3
4 * 3
3 * 4

4 * 3

r * c
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In-Depth Excel Use the COMPUTE worksheet of the
McNemar workbook, shown in Figure 12.12 on page 489,
as a template for performing the McNemar test. The work-
sheet contains the data of Table 12.13 concerning brand
loyalty for cell phone providers (see page 488). In cells B20
and B19, respectively, the worksheet uses the expressions
NORMSINV((1 � level of significance) / 2) and
NORMSINV(level of significance / 2) to compute the up-
per and lower critical values. In cell B21, the expression 2 *
(1 � NORMSDIST(absolute value of the Z test statistic))
computes the p-value.

In-Depth Excel Use the COMPUTE worksheet of the
Chi-Square Variance workbook, shown in Figure 12.14 on
page 492, as a template for performing the chi-square test.
The worksheet contains the data for the cereal-filling
process example. In cells B15 and B16, respectively, the
worksheet uses the expressions CHIINV(1 � half area, de-

grees of freedom) and enter CHIINV(half area, degrees of

freedom) to compute the lower and upper critical values. In
B17, the expression CHIDIST( test statistic, degrees of

freedom) helps to compute the p-value.
To perform the test for other problems, change the null

hypothesis, level of significance, sample size, and sample
standard deviation in the cell range B4:B7. (Open to the
COMPUTE_ FORMULAS worksheet to examine the de-
tails of all formulas used in the COMPUTE worksheet.)

EG12.6 WILCOXON RANK SUM TEST:
NONPARAMETRIC ANALYSIS for
TWO INDEPENDENT POPULATIONS

PHStat2 Use Wilcoxon Rank Sum Test to perform the
Wilcoxon rank sum test. For example, to perform the Figure
12.16 test for the BLK Cola sales data on page 498, open to
the DATA worksheet of the Cola workbook. Select PHStat
➔ Two-Sample Tests (Unsummarized Data) ➔ Wilcoxon
Rank Sum Test. In the procedure’s dialog box (shown below):

1. Enter 0.05 as the Level of Significance.

2. Enter A1:A11 as the Population 1 Sample Cell Range.

3. Enter B1:B11 as the Population 2 Sample Cell Range.

4. Check First cells in both ranges contain label.

5. Click Two-Tail Test.

6. Enter a Title and click OK.

X2

EG12.5 CHI-SQUARE TEST for the VARIANCE
or STANDARD DEVIATION

PHStat2 Use Chi-Square Test for the Variance to per-
form this chi-square test. For example, to perform the test
for the Section 12.5 cereal-filling process example, select
PHStat ➔ One-Sample Tests ➔ Chi-Square Test for the
Variance. In the procedure’s dialog box (shown below):

1. Enter 225 as the Null Hypothesis.

2. Enter 0.05 as the Level of Significance.

3. Enter 25 as the Sample Size.

4. Enter 17.7 as the Sample Standard Deviation.

5. Select Two-Tail Test.

6. Enter a Title and click OK.

To perform the McNemar two-tail test for other prob-
lems, change the row 4 through 7 entries in the Observed
Frequencies area and enter the level of significance for the
test in cell B11. For one-tail tests, change the Observed Fre-
quencies area and level of significance in the COMPUTE_
ALL worksheet in the McNemar workbook. (Open to the
COMPUTE_ALL_FORMULAS worksheet to examine
the formulas used in the worksheet.)

The procedure creates a worksheet similar to Figure
12.14 on page 492.

The procedure creates a worksheet that contains sorted
ranks in addition to the worksheet shown in Figure 12.16.
Both of these worksheets are discussed in the following In-
Depth Excel instructions.



In-Depth Excel Use the COMPUTE worksheet of the
Wilcoxon workbook, shown in Figure 12.16 on page 498, as
a template for performing the two-tail Wilcoxon rank sum
test. The worksheet contains data and formulas to use the un-
summarized data for the BLK Cola sales example. In cells
B22 and B21, respectively, the worksheet uses NORMSINV
((1 � level of significance) / 2) and NORMSINV(level of

significance / 2) to compute the upper and lower critical
values. In cell B23, 2 * (1 � NORMSDIST(absolute value

of the Z test statistic)) computes the p-value.
For other problems, use the COMPUTE worksheet with

either unsummarized or summarized data. For summarized
data, overwrite the formulas that compute the Sample Size
and Sum of Ranks in cells B7, B8, B10, and B11, with the
values for these statistics.

For unsummarized data, first open to the SortedRanks
worksheet and enter the sorted values for both groups in
stacked format. Use column A for the sample names and
column B for the sorted values. Assign a rank for each value
and enter the ranks in column C of the same worksheet.
Then open to the COMPUTE worksheet (or the similar
COMPUTE_ALL worksheet, if performing a one-tail test)
and edit the formulas in cells B7, B8, B10, and B11. Enter
COUNTIF(cell range for all sample names, sample name

to be matched ) functions to compute the sample size for a
sample. Enter SUMIF(cell range for all sample names,
sample name to be matched, cell range in which to select

cells for summing) functions to compute the sum of ranks
for a sample. For example, in the current COMPUTE work-
sheet, the formula =COUNTIF(SortedRanks!A2:A21,
"Normal") in cell B7 counts the number of occurrences of
the sample name “Normal” in column A to compute the
sample size of the Population 1 Sample. The formula
=SUMIF(SortedRanks!A2:A21, "Normal", C2:C21) in
cell B8 computes the sum of ranks for the Population 1
Sample by summing the column C ranks for rows in which
the column A value is Normal.

EG12.7 KRUSKAL-WALLIS RANK TEST:
NONPARAMETRIC ANALYSIS
for the ONE-WAY ANOVA

PHStat2 Use Kruskal-Wallis Rank Test to perform the
Kruskal-Wallis rank test. For example, to perform the
Figure 12.18 Kruskal-Wallis rank test for differences among
the four median tensile strengths of parachutes on page 503,
open to the DATA worksheet of the Parachute workbook.
Select PHStat ➔ Multiple-Sample Tests ➔ Kruskal-
Wallis Rank Test. In the procedure’s dialog box (shown in
the right column):

1. Enter 0.05 as the Level of Significance.

2. Enter A1:D6 as the Sample Data Cell Range.

3. Check First cells contain label.

4. Enter a Title and click OK.

The procedure creates a worksheet that contains sorted
ranks in addition to the worksheet shown in Figure 12.18 on
page 503. Both of these worksheets are discussed in the fol-
lowing In-Depth Excel instructions.

In-Depth Excel Use the KruskalWallis4 worksheet of the
Kruskal-Wallis Worksheets workbook, shown in Figure
12.18 on page 503, as a model for performing the Kruskal-
Wallis rank test. The worksheet contains the data and for-
mulas to use the unsummarized data for the Section 12.7
four-supplier parachute example. In cell B13, the worksheet
uses CHIINV(level of significance, number of groups - 1)
to compute the critical value and, in cell B14, CHIDIST(H
test statistic, number of groups - 1) computes the p-value.

For other problems with four groups, use the
KruskalWallis4 worksheet with either unsummarized or
summarized data. For summarized data, overwrite the for-
mulas that display the group names and compute the
Sample Size and Sum of Ranks in columns D, E, and F
with the values for these statistics.

For unsummarized data, first open to the SortedRanks
worksheet and enter the sorted values for both groups in
stacked format. Use column A for the sample names and
column B for the sorted values. Assign ranks for each value
and enter the ranks in column C of the same worksheet. Also
paste your unsummarized stacked data in columns, starting
with Column E. (The row 1 cells, starting with cell E1, are
used to identify each group.) Then open to the KruskalWal-
lis4 worksheet (or the similar KruskalWallis3 worksheet,
if using three groups) and edit the formulas in columns E
and F. Enter COUNTIF(cell range for all group names,
group name to be matched) functions to compute the sam-
ple size for a group. Enter SUMIF(cell range for all group

names, group name to be matched, cell range in which to

select cells for summing) functions to compute the sum of
ranks for a group. (Open to the Kruskal Wallis4_
FORMULAS worksheet to examine all current formulas.)
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C H A P T E R 1 2 M I N I TA B G U I D E

MG12.1 CHI-SQUARE TEST for the
DIFFERENCE BETWEEN TWO
PROPORTIONS

Use Chi-Square Test (Two-Way Table in Worksheet) to
perform the chi-square test with summarized data. For ex-
ample, to perform the Figure 12.3 test for the two-hotel
guest satisfaction data on page 472, open to the Two-Hotel
Survey worksheet. Select Stat ➔ Tables ➔ Chi-Square
Test (Two-Way Table in Worksheet). In the Chi-Square
Test (Table in Worksheet) dialog box (shown below):

1. Double-click C2 Beachcomber in the variables list to
add Beachcomber to the Columns containing the
table box.

2. Double-click C3 Windsurfer in the variables list to
add Windsurfer to the Columns containing the table
box.

3. Click OK.

Minitab can also perform a chi-square test for the dif-
ference between two proportions using unsummarized
data. Use the Section MG2.2 instructions for using Cross
Tabulation and Chi-Square to create contingency tables
(see page 87), replacing step 4 with these steps 4 though 7:

4. Click Chi-Square.

In the Cross Tabulation - Chi-Square dialog box:

5. Select Chi-Square analysis, Expected cell counts, and
Each cell’s contribution to the Chi-Square statistic.

6. Click OK.

7. Back in the original dialog box, click OK.

MG12.2 CHI-SQUARE TEST for
DIFFERENCES AMONG MORE
THAN TWO PROPORTIONS

Use Chi-Square Test (Two-Way Table in Worksheet) to
perform the chi-square test with summarized data. Use
modified Section MG2.2 instructions on the page 87 for us-
ing Cross Tabulation and Chi-Square to perform the chi-
square test with unsummarized data. See Section MG12.1
for detailed instructions.

To perform the Figure 12.6 test for the guest satisfac-
tion data concerning three hotels on page 478, open to the
Three-Hotel Survey worksheet, select Stat ➔ Tables ➔
Chi-Square Test (Two-Way Table in Worksheet), and add
the names of columns 2 through 4 to the Columns contain-
ing the table box.

The Marascuilo Procedure

There are no Minitab Guide instructions for this section.

MG12.3 CHI-SQUARE TEST
of INDEPENDENCE

Again, as in Section MG12.2, use either Chi-Square Test
(Two-Way Table in Worksheet) for summarized data or the
modified instructions for using Cross Tabulation and
Chi-Square for unsummarized data to perform this test.

MG12.4 MCNEMAR TEST for the
DIFFERENCE BETWEEN 
TWO PROPORTIONS
(RELATED SAMPLES)

There are no Minitab Guide instructions for this section.

MG12.5 CHI-SQUARE TEST for the
VARIANCE or STANDARD
DEVIATION

There are no Minitab Guide instructions for this section.



MG12.6 WILCOXON RANK SUM TEST:
NONPARAMETRIC ANALYSIS for
TWO INDEPENDENT
POPULATIONS

Use Mann-Whitney to perform a test numerically equiv-
alent to the Wilcoxon rank sum test. For example, to per-
form the Figure 12.16 test for the BLK Cola sales data on
page 498, open to the Cola worksheet. Select Stat ➔
Nonparametrics ➔ Mann-Whitney. In the Mann-
Whitney dialog box (shown below):

1. Double-click C1 Normal in the variables list to add
Normal in the First Sample box.

2. Double-click C2 End-Aisle in the variables list to add
‘EndAisle’ in the Second Sample box.

3. Enter 95.0 in the Confidence level box.

4. Select not equal in the Alternative drop-down list.

5. Click OK.

MG12.7 KRUSKAL-WALLIS RANK TEST:
NONPARAMETRIC ANALYSIS
for the ONE-WAY ANOVA

Use Kruskal-Wallis to perform the Kruskal-Wallis rank
test. For example, to perform the Figure 12.18 Kruskal-
Wallis rank test for differences among the four median
tensile strengths of parachutes on page 503, open to the
ParachuteStacked worksheet. Select Stat ➔ Nonparam-
etrics ➔ Kruskal-Wallis. In the Kruskal-Wallis dialog
box (shown below):

1. Double-click C2 Strength in the variables list to add
Strength in the Response box.

2. Double-click C1 Supplier in the variables list to add
Supplier in the Factor box.

3. Click OK.
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Learning Objectives
In this chapter, you learn:

• How to use regression analysis to predict the value of a dependent variable
based on an independent variable

• The meaning of the regression coefficients b0 and b1

• How to evaluate the assumptions of regression analysis and know what to do if
the assumptions are violated

• How to make inferences about the slope and correlation coefficient

• How to estimate mean values and predict individual values

Simple Linear
Regression13



T he sales for Sunflowers Apparel, a chain of upscale clothing stores for women,
have increased during the past 12 years as the chain has expanded the number of
stores. Until now, Sunflowers managers selected sites based on subjective factors,
such as the availability of a good lease or the perception that a location seemed
ideal for an apparel store. As the new director of planning, you need to develop

a systematic approach that will lead to making better decisions during the site-selection process. As
a starting point, you believe that the size of the store significantly contributes to store sales, and you
want to use this relationship in the decision-making process. How can you use statistics so that you
can forecast the annual sales of a proposed store based on the size of that store?

U S I N G S TAT I S T I C S

@ Sunflowers Apparel

521
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I n this chapter and the next two chapters, you learn how regression analysis enables you
to develop a model to predict the values of a numerical variable, based on the value of
other variables.
In regression analysis, the variable you wish to predict is called the dependent variable.

The variables used to make the prediction are called independent variables. In addition to
predicting values of the dependent variable, regression analysis also allows you to identify the
type of mathematical relationship that exists between a dependent variable and an independent
variable, to quantify the effect that changes in the independent variable have on the dependent
variable, and to identify unusual observations. For example, as the director of planning, you
might want to predict sales for a Sunflowers store based on the size of the store. Other exam-
ples include predicting the monthly rent of an apartment based on its size and predicting the
monthly sales of a product in a supermarket based on the amount of shelf space devoted to the
product.

This chapter discusses simple linear regression, in which a single numerical independent
variable, X, is used to predict the numerical dependent variable Y, such as using the size of a
store to predict the annual sales of the store. Chapters 14 and 15 discuss multiple regression
models, which use several independent variables to predict a numerical dependent variable, Y.
For example, you could use the amount of advertising expenditures, price, and the amount of
shelf space devoted to a product to predict its monthly sales.

13.1 Types of Regression Models
In Section 2.6, you used a scatter plot (also known as a scatter diagram) to examine the rela-
tionship between an X variable on the horizontal axis and a Y variable on the vertical axis. The
nature of the relationship between two variables can take many forms, ranging from simple to
extremely complicated mathematical functions. The simplest relationship consists of a straight-
line relationship, or linear relationship. Figure 13.1 illustrates a straight-line relationship.

Y

0

ΔX = “change in X”
ΔY = “change in Y”

0 X

β0

F I G U R E 1 3 . 1
A straight-line
relationship

Equation (13.1) represents the straight-line (linear) model.

SIMPLE LINEAR REGRESSION MODEL

(13.1)

where

intercept for the population
slope for the population
random error in Y for observation i
dependent variable (sometimes referred to as the response variable) for 
observation i
independent variable (sometimes referred to as the predictor, or 
explanatory variable) for observation i

Xi =

Yi =
ei =
b1 =
b0 = Y

Yi = b0 + b1Xi + ei
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The portion of the simple linear regression model expressed in Equation
(13.1) is a straight line. The slope of the line, represents the expected change in Y per unit
change in X. It represents the mean amount that Y changes (either positively or negatively) for
a one-unit change in X. The Y intercept, represents the mean value of Y when X equals 0.
The last component of the model, represents the random error in Y for each observation, i.
In other words, is the vertical distance of the actual value of above or below the expected
value of on the line.

The selection of the proper mathematical model depends on the distribution of the X and
Y values on the scatter plot. Figure 13.2 illustrates six different types of relationships.

Yi

Yiei

ei,
b0,

b1,
Yi = b0 + b1Xi

Y

Panel A
Positive linear relationship

X

Y

Panel B
Negative linear relationship

X

Y

Panel F
No relationship between X and Y

X

Y

Panel C
Positive curvilinear relationship

X

Y

Panel D
U-shaped curvilinear relationship

X

Y

Panel E
Negative curvilinear relationship

X

F I G U R E 1 3 . 2
Six types of relationships
found in scatter plots

In Panel A, the values of Y are generally increasing linearly as X increases. This panel is similar
to Figure 13.3 on page 524, which illustrates the positive relationship between the square footage of
the store and the annual sales at branches of the Sunflowers Apparel women’s clothing store chain.

Panel B is an example of a negative linear relationship. As X increases, the values of Y are
generally decreasing. An example of this type of relationship might be the price of a particular
product and the amount of sales.

Panel C shows a positive curvilinear relationship between X and Y. The values of Y in-
crease as X increases, but this increase tapers off beyond certain values of X. An example of a
positive curvilinear relationship might be the age and maintenance cost of a machine. As a ma-
chine gets older, the maintenance cost may rise rapidly at first but then level off beyond a cer-
tain number of years.

Panel D shows a U-shaped relationship between X and Y. As X increases, at first Y gener-
ally decreases; but as X continues to increase, Y not only stops decreasing but actually in-
creases above its minimum value. An example of this type of relationship might be the number
of errors per hour at a task and the number of hours worked. The number of errors per hour de-
creases as the individual becomes more proficient at the task, but then it increases beyond a
certain point because of factors such as fatigue and boredom.
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Panel E illustrates an exponential relationship between X and Y. In this case, Y decreases
very rapidly as X first increases, but then it decreases much less rapidly as X increases further.
An example of an exponential relationship could be the value of an automobile and its age.
The value drops drastically from its original price in the first year, but it decreases much less
rapidly in subsequent years.

Finally, Panel F shows a set of data in which there is very little or no relationship between
X and Y. High and low values of Y appear at each value of X.

Although scatter plots are useful in visually displaying the mathematical form of a rela-
tionship, more sophisticated statistical procedures are available to determine the most appro-
priate model for a set of variables. The rest of this chapter discusses the model used when there
is a linear relationship between variables.

F I G U R E 1 3 . 3
Scatter plot for the
Sunflowers Apparel data

13.2 Determining the Simple Linear Regression Equation
In the Sunflowers Apparel scenario on page 521, the business objective of the director of
planning is to forecast annual sales for all new stores, based on store size. To examine
the relationship between the store size in square feet and its annual sales, data were col-
lected from a sample of 14 stores. Table 13.1 shows the organized data, which are stored
in .

Figure 13.3 displays the scatter plot for the data in Table 13.1. Observe the increasing rela-
tionship between square feet and annual sales As the size of the store increases,1Y 2.1X2

Site

T A B L E 1 3 . 1

Square Footage (in
Thousands of Square
Feet) and Annual Sales
(in Millions of Dollars) for
a Sample of 14 Branches
of Sunflowers Apparel

Store
Square Feet
(Thousands)

Annual Sales (in
Millions of Dollars) Store

Square Feet
(Thousands)

Annual Sales (in
Millions of Dollars)

1 1.7 3.7 8 1.1 2.7
2 1.6 3.9 9 3.2 5.5
3 2.8 6.7 10 1.5 2.9
4 5.6 9.5 11 5.2 10.7
5 1.3 3.4 12 4.6 7.6
6 2.2 5.6 13 5.8 11.8
7 1.3 3.7 14 3.0 4.1
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annual sales increase approximately as a straight line. Thus, you can assume that a straight line
provides a useful mathematical model of this relationship. Now you need to determine the spe-
cific straight line that is the best fit to these data.

The Least-Squares Method
In the preceding section, a statistical model is hypothesized to represent the relationship be-
tween two variables, square footage and sales, in the entire population of Sunflowers Apparel
stores. However, as shown in Table 13.1, the data are collected from a random sample of stores.
If certain assumptions are valid (see Section 13.4), you can use the sample Y intercept, and
the sample slope, as estimates of the respective population parameters, and Equa-
tion (13.2) uses these estimates to form the simple linear regression equation. This straight
line is often referred to as the prediction line.

b1.b0b1,
b0,

SIMPLE LINEAR REGRESSION EQUATION: THE PREDICTION LINE
The predicted value of Y equals the Y intercept plus the slope multiplied by the value of X.

(13.2)

where

predicted value of Y for observation i
value of X for observation i

sample Y intercept

sample slopeb1 =
b0 =
Xi =
YNi =

YNi = b0 + b1Xi

Equation (13.2) requires you to determine two regression coefficients— (the sample Y
intercept) and (the sample slope). The most common approach to finding and is us-
ing the least-squares method. This method minimizes the sum of the squared differences be-
tween the actual values and the predicted values using the simple linear regression
equation [i.e., the prediction line; see Equation (13.2)]. This sum of squared differences is
equal to

Because

Because this equation has two unknowns, and the sum of squared differences depends
on the sample Y intercept, and the sample slope, The least-squares method determines
the values of and that minimize the sum of squared differences around the prediction line.
Any values for and other than those determined by the least-squares method result in a
greater sum of squared differences between the actual values and the predicted values
Figure 13.41 presents the simple linear regression model for the Table 13.l Sunflowers
Apparel data.

1YNi2.1Yi2
b1b0

b1b0

b1.b0,
b1,b0

a
n

i=1
1Yi - YNi22 = a

n

i=1
[Yi - 1b0 + b1Xi2]2

YNi = b0 + b1Xi,

a
n

i=1
1Yi - YNi22

1YNi21Yi2
b1b0b1

b0

1The equations used to compute
these results are shown in Examples
13.3 and 13.4 on pages 528–530 and
535–536.You should use software to
do these computations for large data
sets, given the complex nature of the
computations.
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F I G U R E 1 3 . 4
Excel and Minitab simple linear regression models for the Sunflowers Apparel data

In Figure 13.4, observe that and Using Equation (13.2) on page
525, the prediction line for these data is

The slope, is This means that for each increase of 1 unit in X, the predicted value
of Y is estimated to increase by 1.6699 units. In other words, for each increase of 1.0 thousand
square feet in the size of the store, the predicted annual sales are estimated to increase by
1.6699 millions of dollars. Thus, the slope represents the portion of the annual sales that are
estimated to vary according to the size of the store.

The Y intercept, is The Y intercept represents the predicted value of Y when
X equals 0. Because the square footage of the store cannot be 0, this Y intercept has little or no
practical interpretation. Also, the Y intercept for this example is outside the range of the ob-
served values of the X variable, and therefore interpretations of the value of should be made
cautiously. Figure 13.5 displays the actual values and the prediction line. To illustrate a situa-
tion in which there is a direct interpretation for the Y intercept, see Example 13.1.b0,

b0

+0.9645.b0,

+1.6699.b1,

YNi = 0.9645 + 1.6699Xi

b1 = 1.6699.b0 = 0.9645

F I G U R E 1 3 . 5
Scatter plot and
prediction line for
Sunflowers Apparel data



A statistics professor wants to use the number of hours a student studies for a statistics final
exam to predict the final exam score A regression model was fit based on data col-
lected from a class during the previous semester, with the following results:

What is the interpretation of the Y intercept, and the slope,

SOLUTION The Y intercept indicates that when the student does not study for
the final exam, the predicted final exam score is 35.0. The slope indicates that for each
increase of one hour in studying time, the predicted change in the final exam score is In
other words, the final exam score is predicted to increase by a mean of 3 points for each one-
hour increase in studying time.

+3.0.
b1 = 3

b0 = 35.0

b1?b0,

YNi = 35.0 + 3Xi

1Y2.1X2EXAMPLE 13.1
Interpreting the Y
Intercept, and
the Slope, b1

b0,
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Return to the Sunflowers Apparel scenario on page 521. Example 13.2 illustrates how you
use the prediction line to predict the annual sales.

Use the prediction line to predict the annual sales for a store with 4,000 square feet.

SOLUTION You can determine the predicted value by substituting (thousands of
square feet) into the simple linear regression equation:

Thus, a store with 4,000 square feet has predicted annual sales of $7,644,000.

YNi = 0.9645 + 1.6699142 = 7.644 or $7,644,000

YNi = 0.9645 + 1.6699Xi

X = 4

EXAMPLE 13.2
Predicting Annual
Sales Based on
Square Footage

Predictions in Regression Analysis: 
Interpolation Versus Extrapolation
When using a regression model for prediction purposes, you should consider only the
relevant range of the independent variable in making predictions. This relevant range in-
cludes all values from the smallest to the largest X used in developing the regression model.
Hence, when predicting Y for a given value of X, you can interpolate within this relevant
range of the X values, but you should not extrapolate beyond the range of X values. When
you use the square footage to predict annual sales, the square footage (in thousands of
square feet) varies from 1.1 to 5.8 (see Table 13.1 on page 524). Therefore, you should pre-
dict annual sales only for stores whose size is between 1.1 and 5.8 thousands of square feet.
Any prediction of annual sales for stores outside this range assumes that the observed rela-
tionship between sales and store size for store sizes from 1.1 to 5.8 thousand square feet is
the same as for stores outside this range. For example, you cannot extrapolate the linear re-
lationship beyond 5,800 square feet in Example 13.2. It would be improper to use the pre-
diction line to forecast the sales for a new store containing 8,000 square feet because the
relationship between sales and store size may have a point of diminishing returns. If that is
true, as square footage increases beyond 5,800 square feet, the effect on sales may become
smaller and smaller.



Compute the Y intercept, and the slope, for the Sunflowers Apparel data.

SOLUTION In Equations (13.3) and (13.4), five quantities need to be computed to deter-

mine and These are n, the sample size; the sum of the X values; the sum

of the Y values; the sum of the squared X values; and the sum of the product of

X and Y. For the Sunflowers Apparel data, the number of square feet is used to predict the
annual sales in a store. Table 13.2 presents the computations of the sums needed for the

site selection problem. The table also includes the sum of the squared Y values that will

be used to compute SST in Section 13.3.

a
n

i=1
Y2

i ,

1Y2 1X2
a

n

i=1
XiYi,a

n

i=1
X 2

i ,

a
n

i=1
Yi,a

n

i=1
Xi,b0.b1

b1,b0,EXAMPLE 13.3
Computing the Y
Intercept, b0, and
the Slope, b1
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COMPUTATIONAL FORMULA FOR THE SLOPE, 

(13.3)

where

SSX = a
n

i=1
1Xi - X 22 = a

n

i=1
X2

i -
aa

n

i=1
Xib

2

n

SSXY = a
n

i=1
1Xi - X 21Yi - Y 2 = a

n

i=1
XiYi -

aa
n

i=1
Xib aa

n

i=1
Yib

n

b1 =
SSXY

SSX

b1

COMPUTATIONAL FORMULA FOR THE Y INTERCEPT,

(13.4)

where

X =
a

n

i=1
Xi

n

Y =
a

n

i=1
Yi

n

b0 = Y - b1 X

b0

Computing the Y Intercept, b0, and the Slope, b1
For small data sets, you can use a hand calculator to compute the least-squares regres-
sion coeff icients. Equations (13.3) and (13.4) give the values of and which
minimize

a
n

i=1
1Yi - YNi22 = a

n

i=1
[Yi - 1b0 + b1Xi2]2

b1,b0
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T A B L E 1 3 . 2

Computations for 
the Sunflowers 
Apparel Data

Store Square Feet (X) Annual Sales (Y) X2 Y2 XY

1 1.7 3.7 2.89 13.69 6.29
2 1.6 3.9 2.56 15.21 6.24
3 2.8 6.7 7.84 44.89 18.76
4 5.6 9.5 31.36 90.25 53.20
5 1.3 3.4 1.69 11.56 4.42
6 2.2 5.6 4.84 31.36 12.32
7 1.3 3.7 1.69 13.69 4.81
8 1.1 2.7 1.21 7.29 2.97
9 3.2 5.5 10.24 30.25 17.60

10 1.5 2.9 2.25 8.41 4.35
11 5.2 10.7 27.04 114.49 55.64
12 4.6 7.6 21.16 57.76 34.96
13 5.8 11.8 33.64 139.24 68.44
14 3.0 4.1 9.00 16.81 12.30
Totals 40.9 81.8 157.41 594.90 302.30

Using Equations (13.3) and (13.4), you can compute and

Therefore,

=
63.32715
37.92358

b1 =
SSXY

SSX

= 37.92358

= 157.41 - 119.48642

= 157.41 -
140.922

14

SSX = a
n

i=1
1Xi - X22 = a

n

i=1
X 2

i -
aa

n

i=1
Xib

2

n

= 63.32715

= 302.3 - 238.97285

SSXY = 302.3 -
140.92181.82

14

SSXY = a
n

i=1
(Xi - X )(Yi - Y ) = a

n

i=1
XiYi -

aa
n

i=1
Xib aa

n

i=1
Yib

n

b1:b0

And,

X =
a

n

i=1
Xi

n
=

40.9
14

= 2.92143

Y =
a

n

i=1
Yi

n
=

81.8
14

= 5.842857

= 1.6699
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Therefore,

= 0.9645

= 5.842857 - 11.6699212.921432
b0 = Y - b1 X

Use the Visual Explorations Simple Linear Regression
procedure to create a prediction line that is as close as
possible to the prediction line defined by the least-
squares solution. Open the Visual Explorations add-in
workbook (see Appendix Section D.4) and select Add-ins
➔ VisualExplorations ➔ Simple Linear Regression.

In the Simple Linear Regression dialog box (shown below):

1. Click for the spinner buttons for b1 slope (the slope of
the prediction line), and b0 intercept (the Y intercept
of the prediction line) to change the prediction line.

2. Using the visual feedback of the chart, try to create a
prediction line that is as close as possible to the pre-
diction line defined by the least-squares estimates. In
other words, try to make the Difference from Target
SSE value as small as possible. (See page 533 for an
explanation of SSE.)

V I S U A L E X P L O R AT I O N S Exploring Simple Linear Regression
Coefficients

At any time, click Reset to reset the and values or
Solution to reveal the prediction line defined by the
least-squares method. Click Finish when you are fin-
ished with this exercise.

Using Your Own Regression Data

Select Simple Linear Regression with your worksheet
data from the VisualExplorations menu to explore the
simple linear regression coefficients using data you sup-
ply from a worksheet. In the procedure’s dialog box, en-
ter the cell range of your Y variable as the Y Variable
Cell Range and the cell range of your X variable as the
X Variable Cell Range. Click First cells in both ranges
contain a label, enter a Title, and click OK. After the
scatter plot appears onscreen, continue with the step 1
and step 2 instructions.

b0b1
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Problems for Section 13.2
LEARNING THE BASICS
13.1 Fitting a straight line to a set of data yields the follow-
ing prediction line:

a. Interpret the meaning of the Y intercept,
b. Interpret the meaning of the slope, 
c. Predict the value of Y for

13.2 If the values of X in Problem 13.1 range from 2 to 25,
should you use this model to predict the mean value of Y
when X equals
a. 3?
b.
c. 0?
d. 24?

13.3 Fitting a straight line to a set of data yields the follow-
ing prediction line:

a. Interpret the meaning of the Y intercept,
b. Interpret the meaning of the slope, 
c. Predict the value of Y for

APPLYING THE CONCEPTS
13.4 The marketing manager of a large super-
market chain would like to use shelf space to pre-

dict the sales of pet food. A random sample of 12
equal-sized stores is selected, with the following results
(stored in ):Petfood

SELF
Test

X = 6.
b1.

b0.

YNi = 16 - 0.5Xi

-3?

X = 3.
b1.

b0.

YNi = 2 + 5Xi

Store Shelf Space (X) (Feet) Weekly Sales (Y ) ($)

1 5 160
2 5 220
3 5 140
4 10 190
5 10 240
6 10 260
7 15 230
8 15 270
9 15 280

10 20 260
11 20 290
12 20 310

a. Construct a scatter plot.
For these data, and

b. Interpret the meaning of the slope, in this problem.
c. Predict the weekly sales of pet food for stores with 8 feet

of shelf space for pet food.

b1,
b1 = 7.4.b0 = 145

13.5 Zagat’s publishes restaurant ratings for various loca-
tions in the United States. The file contains the
Zagat rating for food, décor, service, and the cost per person
for a sample of 100 restaurants located in New York City and
in a suburb of New York City. Develop a regression model to
predict the price per person, based on a variable that repre-
sents the sum of the ratings for food, décor, and service.
Sources: Extracted from Zagat Survey 2010, New York City
Restaurants; and Zagat Survey 2009–2010, Long Island Restaurants.

a. Construct a scatter plot.
For these data, and
b. Assuming a linear cost relationship, use the least-squares

method to compute the regression coefficients and
c. Interpret the meaning of the Y intercept, and the

slope, in this problem.
d. Predict the cost per person for a restaurant with a sum-

mated rating of 50.

13.6 The owner of a moving company typically has his
most experienced manager predict the total number of labor
hours that will be required to complete an upcoming move.
This approach has proved useful in the past, but the owner
has the business objective of developing a more accurate
method of predicting labor hours. In a preliminary effort to
provide a more accurate method, the owner has decided to
use the number of cubic feet moved as the independent vari-
able and has collected data for 36 moves in which the origin
and destination were within the borough of Manhattan in
New York City and in which the travel time was an insignif-
icant portion of the hours worked. The data are stored in

.
a. Construct a scatter plot.
b. Assuming a linear relationship, use the least-squares

method to determine the regression coefficients and
c. Interpret the meaning of the slope, in this problem.
d. Predict the labor hours for moving 500 cubic feet.

13.7 A critically important aspect of customer service in a
supermarket is the waiting time at the checkout (defined as
the time the customer enters the line until he or she is served).
Data were collected during time periods in which a constant
number of checkout counters were open. The total number of
customers in the store and the waiting times (in minutes) were
recorded. The results are stored in .
a. Construct a scatter plot.
b. Assuming a linear relationship, use the least-squares

method to determine the regression coefficients and
c. Interpret the meaning of the slope, in this problem.
d. Predict the waiting time when there are 20 customers in

the store.

13.8 The value of a sports franchise is directly related to
the amount of revenue that a franchise can generate. The
file represents the value in 2010 (in millionsBBRevenue

b1,
b1.b0

Supermarket

b1,
b1.b0

Moving

b1,
b0,

b1.b0

b1 = 1.2409.b0 = -28.1975

Restaurants
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e. Why would it not be appropriate to use the model to predict
the monthly rent for apartments that have 500 square feet?

f. Your friends Jim and Jennifer are considering signing a
lease for an apartment in this residential neighborhood.
They are trying to decide between two apartments, one
with 1,000 square feet for a monthly rent of $1,275 and
the other with 1,200 square feet for a monthly rent of
$1,425. Based on (a) through (d), which apartment do
you think is a better deal?

13.10 A company that holds the DVD distribution rights to
movies previously released only in theaters wants to estimate
sales revenue of DVDs based on box office success. The box
office gross (in $millions) for each of 22 movies in the year
that they were released and the DVD revenue (in $millions)
in the following year are shown below and stored in .Movie

Sources: Data extracted from www.the-numbers.com/market/
movies2008.php; and www.the-numbers.com/dvd/charts/
annual/2009.php.
For these data,
a. construct a scatter plot.
b. assuming a linear relationship, use the least-squares

method to determine the regression coefficients and
c. interpret the meaning of the slope, in this problem.
d. predict the sales revenue for a movie DVD that had a box

office gross of $75 million.

b1,
b1.b0

Rent ($) Size (Square Feet)

950 850
1,600 1,450
1,200 1,085
1,500 1,232

950 718
1,700 1,485
1,650 1,136

935 726
875 700

1,150 956
1,400 1,100
1,650 1,285
2,300 1,985
1,800 1,369
1,400 1,175
1,450 1,225
1,100 1,245
1,700 1,259
1,200 1,150
1,150 896
1,600 1,361
1,650 1,040
1,200 755

800 1,000
1,750 1,200

of dollars) and the annual revenue (in millions of dollars)
for the 30 major league baseball franchises. (Data
extracted from www.forbes.com/2010/04/07/most-valu-
able-baseball-teams-business-sportsmoney-baseball-
valuations-10_values.html.) Suppose you want to develop
a simple linear regression model to predict franchise
value based on annual revenue generated.
a. Construct a scatter plot.
b. Use the least-squares method to determine the regression

coefficients and
c. Interpret the meaning of and in this problem.
d. Predict the value of a baseball franchise that generates

$150 million of annual revenue.

13.9 An agent for a residential real estate company in a
large city would like to be able to predict the monthly rental
cost for apartments, based on the size of an apartment, as
defined by square footage. The agent selects a sample of 25
apartments in a particular residential neighborhood and
gathers the following data (stored in ).Rent

b1b0

b1.b0

a. Construct a scatter plot.
b. Use the least-squares method to determine the regression

coefficients and
c. Interpret the meaning of and in this problem.
d. Predict the monthly rent for an apartment that has 1,000

square feet.

b1b0

b1.b0

Title Gross DVD Revenue

Bolt 109.92 81.60
Madagascar: Escape 
2 Africa

177.02 107.54

Quantum of Solace 166.82 44.41
Beverly Hills Chihuahua 93.78 60.21
Marley and Me 106.66 62.82
High School Musical 3 
Senior Year

90.22 58.81

Bedtime Stories 85.54 48.79
Role Models 66.70 38.78
Pineapple Express 87.34 44.67
Eagle Eye 101.40 34.88
Fireproof 33.26 31.05
Momma Mia! 144.13 33.14
Seven Pounds 60.15 27.12
Australia 46.69 28.16
Valkyrie 60.73 26.43
Saw V 56.75 26.10
The Curious Case of 
Benjamin Button

79.30 42.04

Max Payne 40.68 25.03
Body of Lies 39.32 21.45
Nights in Rodanthe 41.80 17.51
Lakeview Terrace 39.26 21.08
The Spirit 17.74 18.78

www.forbes.com/2010/04/07/most-valuable-baseball-teams-business-sportsmoney-baseballvaluations-10_values.html
www.forbes.com/2010/04/07/most-valuable-baseball-teams-business-sportsmoney-baseballvaluations-10_values.html
www.forbes.com/2010/04/07/most-valuable-baseball-teams-business-sportsmoney-baseballvaluations-10_values.html
www.the-numbers.com/market/movies2008.php
www.the-numbers.com/market/movies2008.php
www.the-numbers.com/dvd/charts/annual/2009.php
www.the-numbers.com/dvd/charts/annual/2009.php
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13.3 Measures of Variation
When using the least-squares method to determine the regression coefficients for a set of data,
you need to compute three measures of variation. The first measure, the total sum of squares
(SST ), is a measure of variation of the values around their mean, . The total variation, or
total sum of squares, is subdivided into explained variation and unexplained variation. The
explained variation, or regression sum of squares (SSR), represents variation that is explained
by the relationship between X and Y, and the unexplained variation, or error sum of squares
(SSE), represents variation due to factors other than the relationship between X and Y.
Figure 13.6 shows these different measures of variation.

YYi

Y

0
X

Error sum
of squares

    (Yi –Yi)
2 = SSE

Xi

Yi

Y

Yi = b0 + b1Xi

Total sum of squares

∑ (Yi –Y )2 = SST Regression sum
of squares

     (Yi –Y )2 = SSR

n

i =1

∑
n

i =1

∑
n

i =1

F I G U R E 1 3 . 6
Measures of variation

Computing the Sum of Squares
The regression sum of squares is based on the difference between (the predicted
value of Y from the prediction line) and (the mean value of Y). The error sum of squares

represents the part of the variation in Y that is not explained by the regression. It
is based on the difference between and Equations (13.5), (13.6), (13.7), and (13.8) define
these measures of variation and the total sum of squares (SST).

YNiYi

1SSE2 Y
YNi1SSR2

MEASURES OF VARIATION IN REGRESSION
The total sum of squares is equal to the regression sum of squares plus the error sum
of squares

(13.5)SST = SSR + SSE

1SSE2. 1SSR2

TOTAL SUM OF SQUARES 
The total sum of squares is equal to the sum of the squared differences between each
observed value of Y and the mean value of Y.

(13.6)= a
n

i=1
1Yi - Y 22

SST = Total sum of squares

1SST2
1SST2
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REGRESSION SUM OF SQUARES 
The regression sum of squares is equal to the sum of the squared differences between
each predicted value of Y and the mean value of Y.

(13.7)=a
n

i=1
1YNi - Y 22

SSR = Explained variation or regression sum of squares

1SSR2
1SSR2

ERROR SUM OF SQUARES 
The error sum of squares is equal to the sum of the squared differences between each
observed value of Y and the predicted value of Y.

(13.8)=a
n

i=1
1Yi - YNi22

SSE = Unexplained variation or error sum of squares

1SSE2
1SSE2

Figure 13.7 shows the sum of squares portion of the Figure 13.4 results for the Sunflowers
Apparel data. The total variation, is equal to 116.9543. This amount is subdivided into the
sum of squares explained by the regression equal to 105.7476, and the sum of squares
unexplained by the regression equal to 11.2067. From Equation (13.5) on page 533:

116.9543 = 105.7476 + 11.2067

SST = SSR + SSE

1SSE2, 1SSR2,SST,

F I G U R E 1 3 . 7
Excel and Minitab sum of squares portion for the Sunflowers Apparel data

The Coefficient of Determination
By themselves, and provide little information. However, the ratio of the regres-
sion sum of squares to the total sum of squares measures the proportion of varia-
tion in Y that is explained by the independent variable X in the regression model. This ratio,
called the coefficient of determination, is defined in Equation (13.9).r2,

1SST21SSR2 SSTSSR, SSE,

COEFFICIENT OF DETERMINATION
The coefficient of determination is equal to the regression sum of squares (i.e., explained
variation) divided by the total sum of squares (i.e., total variation).

(13.9)

The coefficient of determination measures the proportion of variation in Y that is
explained by the variation in the independent variable X in the regression model.

r2 =
Regression sum of squares

Total sum of squares
=

SSR

SST
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For the Sunflowers Apparel data, with and

Therefore, 90.42% of the variation in annual sales is explained by the variability in the size of
the store as measured by the square footage. This large indicates a strong linear relationship
between these two variables because the regression model has explained 90.42% of the vari-
ability in predicting annual sales. Only 9.58% of the sample variability in annual sales is due
to factors other than what is accounted for by the linear regression model that uses square
footage.

Figure 13.8 presents the regression statistics table portion of the Figure 13.4 results for the
Sunflowers Apparel data. This table contains the coefficient of determination (labeled R
Square in Excel and R-Sq in Minitab).

r2

r2 =
105.7476
116.9543

= 0.9042

SST = 116.9543,
SSR = 105.7476, SSE = 11.2067,

COMPUTATIONAL FORMULA FOR SST

(13.10)SST = a
n

i=1
1Yi - Y 22 = a

n

i=1
Y2

i -
aa

n

i=1
Yib

2

n

COMPUTATIONAL FORMULA FOR SSR

(13.11)= b0a
n

i=1
Yi + b1a

n

i=1
XiYi -

aa
n

i=1
Yib

2

n

SSR = a
n

i=1
1YNi - Y 22

F I G U R E 1 3 . 8 Excel and Minitab regression statistics for the Sunflowers Apparel data

Compute the coefficient of determination, for the Sunflowers Apparel data.

SOLUTION You can compute SST, SSR, and SSE, which are defined in Equations (13.6),
(13.7), and (13.8) on pages 533 and 534, by using Equations (13.10), (13.11), and (13.12).

r2,EXAMPLE 13.4
Computing the
Coefficient of
Determination

COMPUTATIONAL FORMULA FOR SSE

(13.12)SSE = a
n

i=1
1Yi - YNi22 = a

n

i=1
Y2

i - b0a
n

i=1
Yi - b1a

n

i=1
XiYi
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Using the summary results from Table 13.2 on page 529,

Therefore,

r2 =
105.74726

116.95429
= 0.9042

= 11.2067

= 594.9 - 10.96452181.82 - 11.669921302.32
= a

n

i=1
Y2

i - b0a
n

i=1
Yi - b1a

n

i=1
XiYi

SSE = a
n

i=1
1Yi - YNi22

= 105.74726

= 10.96452181.82 + 11.669921302.32 -
181.822

14

= b0a
n

i=1
Yi + b1a

n

i=1
XiYi -

aa
n

i=1
Yib

2

n

SSR = a
n

i=1
1YNi - Y 22

= 116.95429

= 594.9 - 477.94571

= 594.9 -
181.822

14

SST = a
n

i=1
(Yi - Y )2 = a

n

i=1
Y 2

i -
aa

n

i=1
Yib

2

n

Standard Error of the Estimate
Although the least-squares method produces the line that fits the data with the minimum
amount of prediction error, unless all the observed data points fall on a straight line, the pre-
diction line is not a perfect predictor. Just as all data values cannot be expected to be exactly
equal to their mean, neither can all the values in a regression analysis be expected to fall ex-
actly on the prediction line. Figure 13.5 on page 526 illustrates the variability around the pre-
diction line for the Sunflowers Apparel data. Observe that many of the actual values of Y fall
near the prediction line, but none of the values are exactly on the line.

The standard error of the estimate measures the variability of the actual Y values from
the predicted Y values in the same way that the standard deviation in Chapter 3 measures the
variability of each value around the sample mean. In other words, the standard error of the es-
timate is the standard deviation around the prediction line, whereas the standard deviation in
Chapter 3 is the standard deviation around the sample mean. Equation (13.13) defines the
standard error of the estimate, represented by the symbol SYX.
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STANDARD ERROR OF THE ESTIMATE

(13.13)

where

actual value of Y for a given
predicted value of Y for a given

error sum of squaresSSE =

XiYNi =
XiYi =

SYX = A SSE

n - 2
= Qa

n

i=1
1Yi - YNi22
n - 2

From Equation (13.8) and Figure 13.4 or Figure 13.7 on pages 526 or 534,
Thus,

This standard error of the estimate, equal to 0.9664 millions of dollars (i.e., $966,400), is la-
beled Standard Error in the Figure 13.8 Excel results and S in the Minitab results. The stan-
dard error of the estimate represents a measure of the variation around the prediction line. It is
measured in the same units as the dependent variable Y. The interpretation of the standard er-
ror of the estimate is similar to that of the standard deviation. Just as the standard deviation
measures variability around the mean, the standard error of the estimate measures variability
around the prediction line. For Sunflowers Apparel, the typical difference between actual an-
nual sales at a store and the predicted annual sales using the regression equation is approxi-
mately $966,400.

SYX = A11.2067
14 - 2

= 0.9664

SSE = 11.2067.

Problems for Section 13.3
LEARNING THE BASICS
13.11 How do you interpret a coefficient of determination,

equal to 0.80?

13.12 If and determine SST, then com-
pute the coefficient of determination, and interpret its
meaning.

13.13 If and compute the coeffi-
cient of determination, and interpret its meaning.

13.14 If and compute the coeffi-
cient of determination, and interpret its meaning.

13.15 If why is it impossible for to equal
110?

APPLYING THE CONCEPTS
13.16 In Problem 13.4 on page 531, the marketing
manager used shelf space for pet food to predict

SELF
Test

SSTSSR = 120,

r2,
SSR = 30,SSE = 10

r2,
SST = 88,SSR = 66

r2,
SSE = 4,SSR = 36

r2,

weekly sales (stored in ). For those data,
and

a. Determine the coefficient of determination, and inter-
pret its meaning.

b. Determine the standard error of the estimate.
c. How useful do you think this regression model is for pre-

dicting sales?

13.17 In Problem 13.5 on page 531, you used the sum-
mated rating to predict the cost of a restaurant meal (stored
in ). For those data, and

a. Determine the coefficient of determination, and inter-
pret its meaning.

b. Determine the standard error of the estimate.
c. How useful do you think this regression model is for pre-

dicting audited sales?

13.18 In Problem 13.6 on page 531, an owner of a mov-
ing company wanted to predict labor hours, based on the

r2,
SST = 15,890.11

SSR = 6,951.3963Restaurants

r2,
SST = 30,025.SSR = 20,535

Petfood
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cubic feet moved (stored in ). Using the results of
that problem,
a. determine the coefficient of determination, and inter-

pret its meaning.
b. determine the standard error of the estimate.
c. How useful do you think this regression model is for pre-

dicting labor hours?

13.19 In Problem 13.7 on page 531, you used the number
of customers to predict the waiting time at the checkout line
in a supermarket (stored in ). Using the results
of that problem,
a. determine the coefficient of determination, and inter-

pret its meaning.
b. determine the standard error of the estimate.
c. How useful do you think this regression model is for pre-

dicting the waiting time at the checkout line in a super-
market?

13.20 In Problem 13.8 on page 531, you used annual rev-
enues to predict the value of a baseball franchise (stored in

). Using the results of that problem,
a. determine the coefficient of determination, and inter-

pret its meaning.
b. determine the standard error of the estimate.

r2,
BBRevenue

r2,

Supermarket

r2,

Moving c. How useful do you think this regression model is for pre-
dicting the value of a baseball franchise?

13.21 In Problem 13.9 on page 532, an agent for a real
estate company wanted to predict the monthly rent for apart-
ments, based on the size of the apartment (stored in ).
Using the results of that problem,
a. determine the coefficient of determination, and inter-

pret its meaning.
b. determine the standard error of the estimate.
c. How useful do you think this regression model is for pre-

dicting the monthly rent?
d. Can you think of other variables that might explain the

variation in monthly rent?

13.22 In Problem 13.10 on page 532, you used box office
gross to predict DVD revenue (stored in ). Using the
results of that problem,
a. determine the coefficient of determination, and inter-

pret its meaning.
b. determine the standard error of the estimate.
c. How useful do you think this regression model is for pre-

dicting DVD revenue?
d. Can you think of other variables that might explain the

variation in DVD revenue?

r2,

Movie

r2,

Rent

13.4 Assumptions
When hypothesis testing and the analysis of variance were discussed in Chapters 9 through 12,
the importance of the assumptions to the validity of any conclusions reached was emphasized.
The assumptions necessary for regression are similar to those of the analysis of variance
because both are part of the general category of linear models (reference 4).

The four assumptions of regression (known by the acronym LINE) are as follows:

• Linearity
• Independence of errors
• Normality of error
• Equal variance

The first assumption, linearity, states that the relationship between variables is linear.
Relationships between variables that are not linear are discussed in Chapter 15.

The second assumption, independence of errors, requires that the errors are inde-
pendent of one another. This assumption is particularly important when data are collected over
a period of time. In such situations, the errors in a specific time period are sometimes corre-
lated with those of the previous time period.

The third assumption, normality, requires that the errors are normally distributed
at each value of X. Like the t test and the ANOVA F test, regression analysis is fairly robust
against departures from the normality assumption. As long as the distribution of the errors
at each level of X is not extremely different from a normal distribution, inferences about

and are not seriously affected.
The fourth assumption, equal variance, or homoscedasticity, requires that the vari-

ance of the errors be constant for all values of X. In other words, the variability of Y
values is the same when X is a low value as when X is a high value. The equal-variance as-
sumption is important when making inferences about and If there are serious depar-
tures from this assumption, you can use either data transformations or weighted
least-squares methods (see reference 4).

b1.b0

1ei2
b1b0

1ei2

1ei2
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13.5 Residual Analysis
Sections 13.2 and 13.3 developed a regression model using the least-squares method for the
Sunflowers Apparel data. Is this the correct model for these data? Are the assumptions
presented in Section 13.4 valid? Residual analysis visually evaluates these assumptions and
helps you to determine whether the regression model that has been selected is appropriate.

The residual, or estimated error value, is the difference between the observed and
predicted values of the dependent variable for a given value of A residual appears on a
scatter plot as the vertical distance between an observed value of Y and the prediction line.
Equation (13.14) defines the residual.

Xi.(YNi)
1Yi2ei,

RESIDUAL
The residual is equal to the difference between the observed value of Y and the predicted
value of Y.

(13.14)ei = Yi - YNi

Evaluating the Assumptions
Recall from Section 13.4 that the four assumptions of regression (known by the acronym
LINE) are linearity, independence, normality, and equal variance.

Linearity To evaluate linearity, you plot the residuals on the vertical axis against the
corresponding values of the independent variable on the horizontal axis. If the linear model
is appropriate for the data, you will not see any apparent pattern in the plot. However, if the
linear model is not appropriate, in the residual plot, there will be a relationship between the
values and the residuals, 

You can see such a pattern in Figure 13.9. Panel A shows a situation in which, although
there is an increasing trend in Y as X increases, the relationship seems curvilinear because the
upward trend decreases for increasing values of X. This quadratic effect is highlighted in Panel
B, where there is a clear relationship between and By plotting the residuals, the linear
trend of X with Y has been removed, thereby exposing the lack of fit in the simple linear
model. Thus, a quadratic model is a better fit and should be used in place of the simple linear
model. (See Section 15.1 for further discussion of fitting curvilinear models.)

ei.Xi

ei.
Xi

Xi

Y

Panel A Panel B
X

0

e

X

F I G U R E 1 3 . 9
Studying the
appropriateness of the
simple linear regression
model

To determine whether the simple linear regression model is appropriate, return to the
evaluation of the Sunflowers Apparel data. Figure 13.10 displays the predicted annual sales
values and residuals.
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F I G U R E 1 3 . 1 1
Plot of residuals against
the square footage of a
store for the Sunflowers
Apparel data

Independence You can evaluate the assumption of independence of the errors by plotting
the residuals in the order or sequence in which the data were collected. If the values of Y are
part of a time series (see Section 2.6), one residual may sometimes be related to the previous
residual. If this relationship exists between consecutive residuals (which violates the assump-
tion of independence), the plot of the residuals versus the time in which the data were col-
lected will often show a cyclical pattern. Because the Sunflowers Apparel data were collected
during the same time period, you do not need to evaluate the independence assumption for
these data.

F I G U R E 1 3 . 1 0
Table of residuals for the
Sunflowers Apparel data

To assess linearity, the residuals are plotted against the independent variable (store size, in
thousands of square feet) in Figure 13.11. Although there is widespread scatter in the residual
plot, there is no clear pattern or relationship between the residuals and The residuals appear
to be evenly spread above and below 0 for different values of X. You can conclude that the
linear model is appropriate for the Sunflowers Apparel data.

Xi.
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T A B L E 1 3 . 3

Frequency Distribution 
of 14 Residual Values for
the Sunflowers Apparel
Data

Residuals Frequency

but less than -1.75-2.25 1
but less than -1.25-1.75 0
but less than -0.75-1.25 3
but less than -0.25-0.75 1
but less than +0.25-0.25 2
but less than +0.75+0.25 3
but less than +1.25+0.75 4

14

Normality You can evaluate the assumption of normality in the errors by organizing the
residuals into a frequency distribution as shown in Table 13.3. You cannot construct a mean-
ingful histogram because the sample size is too small. And with such a small sample size
( ), it can be difficult to evaluate the normality assumption by using a stem-and-leaf
display (see Section 2.5), a boxplot (see Section 3.3), or a normal probability plot (see
Section 6.3).

n = 14

F I G U R E 1 3 . 1 2
Excel and Minitab normal probability plots of the residuals for the Sunflowers Apparel data

From the normal probability plot of the residuals in Figure 13.12, the data do not ap-
pear to depart substantially from a normal distribution. The robustness of regression
analysis with modest departures from normality enables you to conclude that you should
not be overly concerned about departures from this normality assumption in the Sunflow-
ers Apparel data.

Equal Variance You can evaluate the assumption of equal variance from a plot of the
residuals with For the Sunflowers Apparel data of Figure 13.11 on page 540, there do not
appear to be major differences in the variability of the residuals for different values.
Thus, you can conclude that there is no apparent violation in the assumption of equal vari-
ance at each level of X.

To examine a case in which the equal-variance assumption is violated, observe Figure 13.13,
which is a plot of the residuals with for a hypothetical set of data. This plot is fan shaped
because the variability of the residuals increases dramatically as X increases. Because this plot
shows unequal variances of the residuals at different levels of X, the equal-variance assumption
is invalid.

Xi

Xi

Xi.
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Is there any evidence of a pattern in the residuals? Explain.

13.24 The following results show the X values, residuals,
and a residual plot from a regression analysis:

Is there any evidence of a pattern in the residuals? Explain.

Problems for Section 13.5
LEARNING THE BASICS
13.23 The following results provide the X values, residu-
als, and a residual plot from a regression analysis:

APPLYING THE CONCEPTS
13.25 In Problem 13.5 on page 531, you used the summated
rating to predict the cost of a restaurant meal. Perform a
residual analysis for these data (stored in ).
Evaluate whether the assumptions of regression have been
seriously violated.

13.26 In Problem 13.4 on page 531, the marketing
manager used shelf space for pet food to predict

weekly sales. Perform a residual analysis for these data
(stored in ). Evaluate whether the assumptions of
regression have been seriously violated.

13.27 In Problem 13.7 on page 531, you used the number
of customers to predict the waiting time at a supermarket
checkout. Perform a residual analysis for these data (stored
in ). Based on these results, evaluate whether
the assumptions of regression have been seriously violated.

13.28 In Problem 13.6 on page 531, the owner of a moving
company wanted to predict labor hours based on the cubic
feet moved. Perform a residual analysis for these data (stored
in ). Based on these results, evaluate whether the as-
sumptions of regression have been seriously violated.

13.29 In Problem 13.9 on page 532, an agent for a real es-
tate company wanted to predict the monthly rent for apart-
ments, based on the size of the apartments. Perform a
residual analysis for these data (stored in ). Based on
these results, evaluate whether the assumptions of regres-
sion have been seriously violated.

13.30 In Problem 13.8 on page 531, you used annual rev-
enues to predict the value of a baseball franchise. Perform a
residual analysis for these data (stored in ).
Based on these results, evaluate whether the assumptions of
regression have been seriously violated.

13.31 In Problem 13.10 on page 532, you used box office
gross to predict DVD revenue. Perform a residual analysis
for these data (stored in ). Based on these results,
evaluate whether the assumptions of regression have been
seriously violated.

Movie

BBRevenue

Rent

Moving

Supermarket

Petfood

SELF
Test

Restaurants

Residuals

0

X

F I G U R E 1 3 . 1 3
Violation of equal
variance
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Customers and Sales 
for a Period of 15
Consecutive Weeks

Week Customers Sales ($Thousands) Week Customers Sales ($Thousands)

1 794 9.33 9 880 12.07
2 799 8.26 10 905 12.55
3 837 7.48 11 886 11.92
4 855 9.08 12 843 10.27
5 845 9.83 13 904 11.80
6 844 10.09 14 950 12.15
7 863 11.01 15 841 9.64
8 875 11.49
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13.6 Measuring Autocorrelation: The Durbin-Watson Statistic
One of the basic assumptions of the regression model is the independence of the errors. This
assumption is sometimes violated when data are collected over sequential time periods
because a residual at any one time period may tend to be similar to residuals at adjacent time
periods. This pattern in the residuals is called autocorrelation. When a set of data has
substantial autocorrelation, the validity of a regression model is in serious doubt.

Residual Plots to Detect Autocorrelation
As mentioned in Section 13.5, one way to detect autocorrelation is to plot the residuals in
time order. If a positive autocorrelation effect exists, there will be clusters of residuals with
the same sign, and you will readily detect an apparent pattern. If negative autocorrelation ex-
ists, residuals will tend to jump back and forth from positive to negative to positive, and so
on. This type of pattern is very rarely seen in regression analysis. Thus, the focus of this sec-
tion is on positive autocorrelation. To illustrate positive autocorrelation, consider the follow-
ing example.

The business problem faced by the manager of a package delivery store is to predict
weekly sales. In approaching this problem, she has decided to develop a regression model to
use the number of customers making purchases as an independent variable. Data are collected
for a period of 15 weeks. Table 13.4 organizes the data (stored in ).CustSale

Because the data are collected over a period of 15 consecutive weeks at the same store,
you need to determine whether autocorrelation is present. Figure 13.14 presents results for
these data.

F I G U R E 1 3 . 1 4
Excel and Minitab regression results for the Table 13.4 package delivery store data
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F I G U R E 1 3 . 1 5
Residual plot for the
Table 13.4 package
delivery store data

The Durbin-Watson Statistic
The Durbin-Watson statistic is used to measure autocorrelation. This statistic measures the
correlation between each residual and the residual for the previous time period. Equation
(13.15) defines the Durbin-Watson statistic.

DURBIN-WATSON STATISTIC

(13.15)

where

residual at the time period iei =

D =
a

n

i=2
1ei - ei-122

a
n

i=1
e2

i

In Equation (13.15), the numerator, represents the squared difference

between two successive residuals, summed from the second value to the nth value and the

a
n

i=2
1ei - ei-122,

From Figure 13.14, observe that is 0.6574, indicating that 65.74% of the variation in
sales is explained by variation in the number of customers. In addition, the Y intercept,
is and the slope, is 0.0308. However, before using this model for prediction,
you must perform a residual analysis. Because the data have been collected over a consecu-
tive period of 15 weeks, in addition to checking the linearity, normality, and equal-variance
assumptions, you must investigate the independence-of-errors assumption. To do this, you
plot the residuals versus time in Figure 13.15 to help examine whether a pattern exists. In
Figure 13.15, you can see that the residuals tend to fluctuate up and down in a cyclical
pattern. This cyclical pattern provides strong cause for concern about the existence of
autocorrelation in the residuals and, therefore, a violation of the independence-of-errors
assumption.

b1,-16.0322,
b0,

r2
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F I G U R E 1 3 . 1 6
Excel Durbin-Watson
statistic worksheet for 
the package delivery
store data

Minitab reports the Durbin-
Watson statistic as part of its
regression results. See
Section MG13.6 for more
information. You need to determine when the autocorrelation is large enough to conclude that there

is significant positive autocorrelation. After computing D, you compare it to the critical
values of the Durbin-Watson statistic found in Table E.8, a portion of which is presented in
Table 13.5. The critical values depend on the significance level chosen, n, the sample
size, and k, the number of independent variables in the model (in simple linear regression,

).k = 1

a,

T A B L E 1 3 . 5

Finding Critical Values
of the Durbin-Watson
Statistic

a = .05

k = 1 k = 2 k = 3 k = 4 k = 5

n dL dU dL dU dL dU dL dU dL dU

15 1.08 1.36 .95 1.54 .82 1.75 .69 1.97 .56 2.21
16 1.10 1.37 .98 1.54 .86 1.73 .74 1.93 .62 2.15
17 1.13 1.38 1.02 1.54 .90 1.71 .78 1.90 .67 2.10
18 1.16 1.39 1.05 1.53 .93 1.69 .82 1.87 .71 2.06

In Table 13.5, two values are shown for each combination of (level of significance), n
(sample size), and k (number of independent variables in the model). The first value, repre-
sents the lower critical value. If D is below you conclude that there is evidence of positive
autocorrelation among the residuals. If this occurs, the least-squares method used in this chap-
ter is inappropriate, and you should use alternative methods (see reference 4). The second
value, represents the upper critical value of D, above which you would conclude that there
is no evidence of positive autocorrelation among the residuals. If D is between and you
are unable to arrive at a definite conclusion.

For the package delivery store data, with one independent variable and 15 values
and Because you conclude that there is

positive autocorrelation among the residuals. The least-squares regression analysis of the data
is inappropriate because of the presence of significant positive autocorrelation among the
residuals. In other words, the independence-of-errors assumption is invalid. You need to use
alternative approaches, discussed in reference 4.

D = 0.8830 6 1.08,dU = 1.36.1n = 152, dL = 1.08
1k = 12

dU,dL

dU,

dL,
dL,

a

denominator, represents the sum of the squared residuals. This means that value of the

Durbin-Watson statistic, D, will approach 0 if successive residuals are positively autocorre-
lated. If the residuals are not correlated, the value of D will be close to 2. (If the residuals are
negatively autocorrelated, D will be greater than 2 and could even approach its maximum
value of 4.) For the package delivery store data, the Durbin-Watson statistic, D, is 0.8830. (See
the Figure 13.16 Excel results below or the Figure 13.14 Minitab results on page 543.)

a
n

i=1
e2

i ,
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Months
Distribution Cost 

($Thousands)
Number

of Orders

1 52.95 4,015
2 71.66 3,806
3 85.58 5,309
4 63.69 4,262
5 72.81 4,296
6 68.44 4,097
7 52.46 3,213
8 70.77 4,809
9 82.03 5,237

10 74.39 4,732
11 70.84 4,413
12 54.08 2,921
13 62.98 3,977
14 72.30 4,428
15 58.99 3,964
16 79.38 4,582
17 94.44 5,582
18 59.74 3,450
19 90.50 5,079
20 93.24 5,735
21 69.33 4,269
22 53.71 3,708
23 89.18 5,387
24 66.80 4,161

LEARNING THE BASICS
13.32 The residuals for 10 consecutive time periods are as
follows:

Problems for Section 13.6

Time Period Residual Time Period Residual

1 -5 6 +1
2 -4 7 +2
3 -3 8 +3
4 -2 9 +4
5 -1 10 +5

June 25, 2010. (Data extracted from Energy Information Ad-
ministration, U.S. Department of Energy, www.eia.doe.gov.)
a. Construct a scatter plot with the price of oil on the hori-

zontal axis and the price of gasoline on the vertical axis.
b. Use the least-squares method to develop a simple linear

regression equation to predict the price of a gallon of
gasoline using the price of a barrel of crude oil as the in-
dependent variable.

c. Interpret the meaning of the slope, b1, in this problem.
d. Plot the residuals versus the time period.
e. Compute the Durbin-Watson statistic.
f. At the 0.05 level of significance, is there evidence of pos-

itive autocorrelation among the residuals?
g. Based on the results of (d) through (f), is there reason to

question the validity of the model?

13.36 A mail-order catalog business that sells per-
sonal computer supplies, software, and hardware

maintains a centralized warehouse for the distribution of prod-
ucts ordered. Management is currently examining the process
of distribution from the warehouse and is interested in studying
the factors that affect warehouse distribution costs. Currently, a
small handling fee is added to the order, regardless of the
amount of the order. Data that indicate the warehouse distribu-
tion costs and the number of orders received have been collected
over the past 24 months and stored in . The results areWarecost

SELF
Test

a. Plot the residuals over time. What conclusion can you
reach about the pattern of the residuals over time?

b. Based on (a), what conclusion can you reach about the
autocorrelation of the residuals?

13.33 The residuals for 15 consecutive time periods are as
follows:

Time Period Residual Time Period Residual

1 +4 9 +6
2 -6 10 -3
3 -1 11 +1
4 -5 12 +3
5 +2 13 0
6 +5 14 -4
7 -2 15 -7
8 +7

a. Plot the residuals over time. What conclusion can you
reach about the pattern of the residuals over time?

b. Compute the Durbin-Watson statistic. At the 0.05 level of
significance, is there evidence of positive autocorrelation
among the residuals?

c. Based on (a) and (b), what conclusion can you reach
about the autocorrelation of the residuals?

APPLYING THE CONCEPTS
13.34 In Problem 13.4 on page 531 concerning pet food
sales, the marketing manager used shelf space for pet food
to predict weekly sales.
a. Is it necessary to compute the Durbin-Watson statistic in

this case? Explain.
b. Under what circumstances is it necessary to compute the

Durbin-Watson statistic before proceeding with the least-
squares method of regression analysis?

13.35 What is the relationship between the price of crude oil
and the price you pay at the pump for gasoline? The file

contains the price ($) for a barrel of crude oil
(Cushing, Oklahoma spot price) and a gallon of gasoline (New
York Harbor Conventional spot price) for 104 weeks ending

Oil & Gas

www.eia.doe.gov
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a. Assuming a linear relationship, use the least-squares
method to find the regression coefficients and

b. Predict the monthly warehouse distribution costs when
the number of orders is 4,500.

c. Plot the residuals versus the time period.
d. Compute the Durbin-Watson statistic. At the 0.05 level of

significance, is there evidence of positive autocorrelation
among the residuals?

e. Based on the results of (c) and (d), is there reason to
question the validity of the model?

13.37 A freshly brewed shot of espresso has three distinct
components: the heart, body, and crema. The separation of
these three components typically lasts only 10 to 20 seconds.
To use the espresso shot in making a latte, a cappuccino, or an-
other drink, the shot must be poured into the beverage during
the separation of the heart, body, and crema. If the shot is used
after the separation occurs, the drink becomes excessively bit-
ter and acidic, ruining the final drink. Thus, a longer separation
time allows the drink-maker more time to pour the shot and en-
sure that the beverage will meet expectations. An employee at
a coffee shop hypothesized that the harder the espresso
grounds were tamped down into the portafilter before brewing,
the longer the separation time would be. An experiment using
24 observations was conducted to test this relationship. The in-
dependent variable Tamp measures the distance, in inches,
between the espresso grounds and the top of the portafilter
(i.e., the harder the tamp, the larger the distance). The depend-
ent variable Time is the number of seconds the heart, body, and
crema are separated (i.e., the amount of time after the shot is
poured before it must be used for the customer’s beverage).
The data are stored in and are shown below:
a. Use the least-squares method to develop a simple regres-

sion equation with Time as the dependent variable and
Tamp as the independent variable.

b. Predict the separation time for a tamp distance of 0.50 inch.
c. Plot the residuals versus the time order of experimenta-

tion. Are there any noticeable patterns?
d. Compute the Durbin-Watson statistic. At the 0.05 level of

significance, is there evidence of positive autocorrelation
among the residuals?

Espresso

b1.b0

e. Based on the results of (c) and (d), is there reason to
question the validity of the model?

13.38 The owner of a chain of ice cream stores has the
business objective of improving the forecast of daily sales
so that staffing shortages can be minimized during the sum-
mer season. The owner has decided to begin by developing
a simple linear regression model to predict daily sales based
on atmospheric temperature. A sample of 21 consecutive
days is selected, and the results are stored in .
(Hint: Determine which are the independent and dependent
variables.)
a. Assuming a linear relationship, use the least-squares

method to compute the regression coefficients b0
and b1.

b. Predict the sales for a day in which the temperature is
83°F.

c. Plot the residuals versus the time period.
d. Compute the Durbin-Watson statistic. At the 0.05 level of

significance, is there evidence of positive autocorrelation
among the residuals?

e. Based on the results of (c) and (d), is there reason to
question the validity of the model?

IceCream

Shot
Tamp

(Inches)
Time

(Seconds) Shot
Tamp

(Inches)
Time

(Seconds)

1 0.20 14 13 0.50 18
2 0.50 14 14 0.50 13
3 0.50 18 15 0.35 19
4 0.20 16 16 0.35 19
5 0.20 16 17 0.20 17
6 0.50 13 18 0.20 18
7 0.20 12 19 0.20 15
8 0.35 15 20 0.20 16
9 0.50 9 21 0.35 18

10 0.35 15 22 0.35 16
11 0.50 11 23 0.35 14
12 0.50 16 24 0.35 16

13.7 Inferences About the Slope and Correlation Coefficient
In Sections 13.1 through 13.3, regression was used solely for descriptive purposes. You learned
how the least-squares method determines the regression coefficients and how to predict Y for
a given value of X. In addition, you learned how to compute and interpret the standard error of
the estimate and the coefficient of determination.

When residual analysis, as discussed in Section 13.5, indicates that the assumptions of a
least-squares regression model are not seriously violated and that the straight-line model is ap-
propriate, you can make inferences about the linear relationship between the variables in the
population.
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Return to the Sunflowers Apparel scenario on page 521. To test whether there is a signifi-
cant linear relationship between the size of the store and the annual sales at the 0.05 level of
significance, refer to the t test results shown in Figure 13.17.

F I G U R E 1 3 . 1 7
Excel and Minitab t test
results for the slope for
the Sunflowers Apparel
data

From Figure 13.17,

and

Using the 0.05 level of significance, the critical value of t with degrees of freedom
is 2.1788. Because or because the p-value is approximately 0,
which is less than you reject (see Figure 13.18). Hence, you can conclude that
there is a significant linear relationship between mean annual sales and the size of the store.

H0a = 0.05,
tSTAT = 10.6411 7 2.1788

n - 2 = 12

=
1.6699 - 0

0.1569
= 10.6411

tSTAT =
b1 - b1

Sb1

b1 = +1.6699 n = 14 Sb1
= 0.1569

t Test for the Slope
To determine the existence of a significant linear relationship between the X and Y variables,
you test whether (the population slope) is equal to 0. The null and alternative hypotheses
are as follows:

If you reject the null hypothesis, you conclude that there is evidence of a linear relationship.
Equation (13.16) defines the test statistic.

H1: b1 Z 0 3There is a linear relationship 1the slope is not zero2.4
H0: b1 = 0 3There is no linear relationship 1the slope is zero2.4

b1

TESTING A HYPOTHESIS FOR A POPULATION SLOPE, USING THE t TEST
The test statistic equals the difference between the sample slope and hypothesized
value of the population slope divided by the standard error of the slope.

(13.16)

where

The test statistic follows a t distribution with degrees of freedom.n - 2tSTAT

SSX = a
n

i=1
1Xi - X 22

Sb1
=

SYX2SSX

tSTAT =
b1 - b1

Sb1

tSTAT

b1,
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TESTING A HYPOTHESIS FOR A POPULATION SLOPE, USING THE F TEST
The test statistic is equal to the regression mean square divided by the
mean square error

(13.17)

where

The test statistic follows an F distribution with 1 and degrees of freedom.n - 2FSTAT

MSE =
SSE

n - 2

MSR =
SSR

1
= SSR

FSTAT =
MSR

MSE

1MSE2. 1MSR2FSTAT

b1,

–2.1788 +2.17880 t

Region of
Nonrejection

Region of
Rejection

Critical
Value

Critical
Value

Region of
Rejection

F I G U R E 1 3 . 1 8
Testing a hypothesis
about the population
slope at the 0.05 level 
of significance, with 12
degrees of freedom

F Test for the Slope
As an alternative to the t test, in simple linear regression, you can use an F test to determine
whether the slope is statistically significant. In Section 10.4, you used the F distribution to test
the ratio of two variances. Equation (13.17) defines the F test for the slope as the ratio of the
variance that is due to the regression divided by the error variance 1MSE = S2

YX2.1MSR2

Using a level of significance the decision rule is

Table 13.6 organizes the complete set of results into an analysis of variance (ANOVA)
table.

otherwise, do not reject H0.

Reject H0 if FSTAT 7 Fa;

a,

T A B L E 1 3 . 6

ANOVA Table for Testing
the Significance of a
Regression Coefficient

Source df Sum of Squares Mean Square (Variance) F

Regression 1 SSR MSR =
SSR

1
= SSR FSTAT =

MSR

MSE

Error n - 2 SSE MSE =
SSE

n - 2
Total n - 1 SST

Figure 13.19, a completed ANOVA table for the Sunflowers sales data, shows that the
computed test statistic is 113.2335 and the p-value is approximately 0.FSTAT
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Confidence Interval Estimate for the Slope
As an alternative to testing for the existence of a linear relationship between the variables, you
can construct a confidence interval estimate of using Equation (13.18).b1

CONFIDENCE INTERVAL ESTIMATE OF THE SLOPE, 
The confidence interval estimate for the population slope can be constructed by taking
the sample slope, and adding and subtracting the critical t value multiplied by the
standard error of the slope.

(or) (13.18)

where

critical value corresponding to an upper-tail probability of from the t
distribution with degrees of freedom (i.e., a cumulative area of ).1 - a>2n - 2

a>2ta>2 =

b1 - ta>2Sb1
… b1 … b1 + ta>2Sb1

b1 ; ta>2Sb1

b1,

b1

From the Figure 13.17 results on page 548,

To construct a 95% confidence interval estimate, and from Table E.3,
Thus,

1.3280 … b1 … 2.0118

= 1.6699 ; 0.3419

b1 ; ta>2Sb1
= 1.6699 ; 12.1788210.15692

ta>2 = 2.1788.
a>2 = 0.025,

b1 = 1.6699 n = 14 Sb1
= 0.1569

0 F4.75

Region of
Rejection

Critical
Value

Region of
Nonrejection

F I G U R E 1 3 . 2 0
Regions of rejection and
nonrejection when
testing for the
significance of the slope
at the 0.05 level of
significance, with 1 and
12 degrees of freedom

F I G U R E 1 3 . 1 9
Excel and Minitab F test results for the Sunflowers Apparel data

Using a level of significance of 0.05, from Table E.5, the critical value of the F distribu-
tion, with 1 and 12 degrees of freedom, is 4.75 (see Figure 13.20). Because

or because the p-value you reject and
conclude that there is a significant linear relationship between the size of the store and annual
sales. Because the F test in Equation (13.17) on page 549 is equivalent to the t test in Equation
(13.16) on page 548, you reach the same conclusion.

H0= 0.0000 6 0.05,FSTAT = 113.2335 7 4.75



13.7 Inferences About the Slope and Correlation Coefficient 551

Therefore, you estimate with 95% confidence that the population slope is between 1.3280 and
2.0118. Because these values are both above 0, you conclude that there is a significant linear
relationship between annual sales and the size of the store. Had the interval included 0, you
would have concluded that no significant relationship exists between the variables. The confi-
dence interval indicates that for each increase of 1,000 square feet, predicted annual sales are
estimated to increase by at least $1,328,000 but no more than $2,011,800.

t Test for the Correlation Coefficient
In Section 3.5 on page 127, the strength of the relationship between two numerical variables
was measured using the correlation coefficient, r. The values of the coefficient of correlation
range from for a perfect negative correlation to for a perfect positive correlation. You
can use the correlation coefficient to determine whether there is a statistically significant
linear relationship between X and Y. To do so, you hypothesize that the population correlation
coefficient, is 0. Thus, the null and alternative hypotheses are

Equation (13.19) defines the test statistic for determining the existence of a significant
correlation.

H1: r Z 0 1correlation2
H0: r = 0 1no correlation2

r,

+1-1

TESTING FOR THE EXISTENCE OF CORRELATION

(13.19a)

where

The test statistic follows a t distribution with degrees of freedom. r is
calculated as follows:

(13.19b)

where

SY = Qa
n

i=1
1Yi - Y22
n - 1

SX = Qa
n

i=1
1Xi - X22
n - 1

cov1X, Y2 =
a

n

i=1
1Xi - X21Yi - Y2

n - 1

r =
cov1X,Y2

SXSY

n - 2tSTAT

r = -2r2 if b1 6 0

r = + 2r2 if b1 7 0

tSTAT =
r - r

A1 - r2

n - 2

In the Sunflowers Apparel problem, and (see Figure 13.4 on
page 526). Because the correlation coefficient for annual sales and store size is theb1 7 0,

b1 = +1.6699r2 = 0.9042
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Problems for Section 13.7
LEARNING THE BASICS
13.39 You are testing the null hypothesis that there is no
linear relationship between two variables, X and Y. From
your sample of you determine that 
a. What is the value of the t test statistic 
b. At the level of significance, what are the criti-

cal values?
c. Based on your answers to (a) and (b), what statistical de-

cision should you make?

13.40 You are testing the null hypothesis that there is no
linear relationship between two variables, X and Y. From
your sample of you determine that and

a. What is the value of 
b. At the level of significance, what are the criti-

cal values?
c. Based on your answers to (a) and (b), what statistical de-

cision should you make?
d. Construct a 95% confidence interval estimate of the pop-

ulation slope, 

13.41 You are testing the null hypothesis that there is no
linear relationship between two variables, X and Y. From
your sample of you determine that and

a. What is the value of 
b. At the level of significance, what is the critical

value?
c. Based on your answers to (a) and (b), what statistical de-

cision should you make?
d. Compute the correlation coefficient by first computing

and assuming that is negative.
e. At the 0.05 level of significance, is there a significant

correlation between X and Y?

b1

r2

a = 0.05
FSTAT?

SSE = 40.
SSR = 60n = 20,

b1.

a = 0.05
tSTAT?

Sb1
= 1.5.

b1 = +4.5n = 18,

a = 0.05
tSTAT?

r = 0.80.n = 10,

APPLYING THE CONCEPTS
13.42 In Problem 13.4 on page 531, the marketing
manager used shelf space for pet food to predict

weekly sales. The data are stored in . From the
results of that problem, and
a. At the 0.05 level of significance, is there evidence of a

linear relationship between shelf space and sales?
b. Construct a 95% confidence interval estimate of the pop-

ulation slope, 

13.43 In Problem 13.5 on page 531, you used the summated
rating of a restaurant to predict the cost of a meal. The data
are stored in . Using the results of that problem,

and
a. At the 0.05 level of significance, is there evidence of a

linear relationship between the summated rating of a
restaurant and the cost of a meal?

b. Construct a 95% confidence interval estimate of the
population slope, 

13.44 In Problem 13.6 on page 531, the owner of a moving
company wanted to predict labor hours, based on the num-
ber of cubic feet moved. The data are stored in .
Use the results of that problem.
a. At the 0.05 level of significance, is there evidence of a

linear relationship between the number of cubic feet
moved and labor hours?

b. Construct a 95% confidence interval estimate of the
population slope, 

13.45 In Problem 13.7 on page 531, you used the number of
customers to predict the waiting time on the checkout line.
The data are stored in . Use the results of that
problem.

Supermarket

b1.

Moving

b1.

Sb1
= 0.1421.b1 = 1.2409

Restaurants

b1.

Sb1
= 1.59.b1 = 7.4

Petfood

SELF
Test

positive square root of that is, Using Equation (13.19a) to test
the null hypothesis that there is no correlation between these two variables results in the fol-
lowing observed t statistic:

Using the 0.05 level of significance, because you reject the null
hypothesis. You conclude that there is a significant association between annual sales and store
size. This test statistic is equivalent to the test statistic found when testing whether
the population slope, is equal to zero.b1,

tSTATtSTAT

tSTAT = 10.6411 7 2.1788,

=
0.9509 - 0

A1 - 10.950922
14 - 2

= 10.6411

tSTAT =
r - 0

A1 - r2

n - 2

r = +10.9042 = +0.9509.r2,



Problems for Section 13.7 553

a. At the 0.05 level of significance, is there evidence of a
linear relationship between the number of customers and
the waiting time on the checkout line?

b. Construct a 95% confidence interval estimate of the pop-
ulation slope, 

13.46 In Problem 13.8 on page 531, you used annual rev-
enues to predict the value of a baseball franchise. The data
are stored in . Use the results of that problem.
a. At the 0.05 level of significance, is there evidence of a

linear relationship between annual revenue and franchise
value?

b. Construct a 95% confidence interval estimate of the pop-
ulation slope, 

13.47 In Problem 13.9 on page 532, an agent for a real es-
tate company wanted to predict the monthly rent for apart-
ments, based on the size of the apartment. The data are
stored in . Use the results of that problem.
a. At the 0.05 level of significance, is there evidence of a

linear relationship between the size of the apartment and
the monthly rent?

b. Construct a 95% confidence interval estimate of the pop-
ulation slope, 

13.48 In Problem 13.10 on page 532, you used box office
gross to predict DVD revenue. The data are stored in .
Use the results of that problem.
a. At the 0.05 level of significance, is there evidence of a

linear relationship between box office gross and DVD
revenue?

b. Construct a 95% confidence interval estimate of the pop-
ulation slope, 

13.49 The volatility of a stock is often measured by its
beta value. You can estimate the beta value of a stock by
developing a simple linear regression model, using the
percentage weekly change in the stock as the dependent
variable and the percentage weekly change in a market in-
dex as the independent variable. The S&P 500 Index is a
common index to use. For example, if you wanted to esti-
mate the beta for Disney, you could use the following
model, which is sometimes referred to as a market model:

The least-squares regression estimate of the slope is the
estimate of the beta value for Disney. A stock with a beta
value of 1.0 tends to move the same as the overall market. A
stock with a beta value of 1.5 tends to move 50% more than
the overall market, and a stock with a beta value of 0.6 tends
to move only 60% as much as the overall market. Stocks with
negative beta values tend to move in the opposite direction of
the overall market. The following table gives some beta val-
ues for some widely held stocks as of July 7, 2010:
a. For each of the six companies, interpret the beta value.
b. How can investors use the beta value as a guide for

investing?

b1

+b11% weekly change in S & P 500 index2 + e

1% weekly change in Disney2 = b0

b1.

Movie

b1.

Rent

b1.

BBRevenue

b1.

Company Ticker Symbol Beta

Procter & Gamble PG 0.53
AT&T T 0.65
Disney DIS 1.25
Apple AAPL 1.43
eBay EBAY 1.75
Ford F 2.75
Source: Data extracted from finance.yahoo.com, July 7, 2010.

Name Ticker Symbol Description

Daily Small 
Cap 3x Fund

TNA 300% of the Russell
2000 Index

Daily India 
Bull 2x Fund

INDL 200% of the Indus 
India Index

13.50 Index funds are mutual funds that try to mimic the
movement of leading indexes, such as the S&P 500 or the
Russell 2000. The beta values (as described in Problem 13.49)
for these funds are therefore approximately 1.0, and the
estimated market models for these funds are approximately

Leveraged index funds are designed to magnify the move-
ment of major indexes. Direxion Funds is a leading provider
of leveraged index and other alternative-class mutual fund
products for investment advisors and sophisticated investors.
Two of the company’s funds are shown in the following table.
(Data extracted from www.direxionfunds.com, July 7,
2010.)

0.0 + 1.01% weekly change in the index2
1% weekly change in index fund2 =

The estimated market models for these funds are approxi-
mately

.0

Thus, if the Russell 2000 Index gains 10% over a period of
time, the leveraged mutual fund TNA gains approximately
30%. On the downside, if the same index loses 20%, TNA
loses approximately 60%.
a. The objective of the Direxion Funds Large Cap Bull 3x fund,

BGU, is 300% of the performance of the Russell 1000 In-
dex. What is its approximate market model?

b. If the Russell 1000 Index gains 10% in a year, what
return do you expect BGU to have?

c. If the Russell 1000 Index loses 20% in a year, what re-
turn do you expect BGU to have?

d. What type of investors should be attracted to leveraged
index funds? What type of investors should stay away
from these funds?

1% weekly change in the Indus India Index21% weekly change in INDL2 = 0.0 + 2
1% weekly change in the Russell 200021% weekly change in TNA2 = 0.0 + 3.0

www.direxionfunds.com
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13.51 The file contains the calories and sugar, in
grams, in one serving of seven breakfast cereals:

Cereals a. Compute the coefficient of correlation between first
weekend gross and the U.S. gross, first weekend gross
and the worldwide gross, and the U.S. gross and world-
wide gross.

b. At the 0.05 level of significance, is there a significant
linear relationship between first weekend gross and the
U.S. gross, first weekend gross and the worldwide gross,
and the U.S. gross and worldwide gross?

13.53 College basketball is big business, with coaches’
salaries, revenues, and expenses in millions of dollars. The
file contains the coaches’ salary and rev-
enue for college basketball at 60 of the 65 schools that
played in the 2009 NCAA men’s basketball tournament.
(Data extracted from “Compensation for Division I Men’s
Basketball Coaches,” USA Today, April 2, 2010, p. 8C; and
C. Isadore, “Nothing but Net: Basketball Dollars by School,”
money.cnn.com/2010/03/18/news/companies/basketball_
profits/.)
a. Compute and interpret the coefficient of correlation, r.
b. At the 0.05 level of significance, is there a significant

linear relationship between a coach’s salary and revenue?

13.54 College football players trying out for the NFL are
given the Wonderlic standardized intelligence test. The file

lists the average Wonderlic scores of football
players trying out for the NFL and the graduation rates for
football players at the schools they attended. (Data extracted
from S. Walker, “The NFL’s Smartest Team,” The Wall Street
Journal, September 30, 2005, pp. W1, W10.)
a. Compute and interpret the coefficient of correlation, r.
b. At the 0.05 level of significance, is there a significant

linear relationship between the average Wonderlic score
of football players trying out for the NFL and the gradua-
tion rates for football players at selected schools?

c. What conclusions can you reach about the relationship
between the average Wonderlic score of football players
trying out for the NFL and the graduation rates for foot-
ball players at selected schools?

Wonderlic

College Basketball

Cereal Calories Sugar

Kellogg’s All Bran 80 6
Kellogg’s Corn Flakes 100 2
Wheaties 100 4
Nature’s Path Organic

Multigrain Flakes
110 4

Kellogg’s Rice Krispies 130 4
Post Shredded Wheat

Vanilla Almond
190 11

Kellogg Mini Wheats 200 10

a. Compute and interpret the coefficient of correlation, r.
b. At the 0.05 level of significance, is there a significant

linear relationship between calories and sugar?

13.52 Movie companies need to predict the gross receipts of
an individual movie once the movie has debuted. The follow-
ing results (stored in ) are the first weekend
gross, the U.S. gross, and the worldwide gross (in $millions) of
the six Harry Potter movies that debuted from 2001 to 2009:

PotterMovies

Title
First

Weekend U.S. Gross
Worldwide

Gross

Sorcerer’s Stone 90.295 317.558 976.458
Chamber of Secrets 88.357 261.988 878.988
Prisoner of 

Azkaban
93.687 249.539 795.539

Goblet of Fire 102.335 290.013 896.013
Order of the 

Phoenix
77.108 292.005 938.469

Half-Blood Prince 77.836 301.460 934.601
Source: Data extracted from www.the-numbers.com/interactive/
comp-Harry-Potter.php.

13.8 Estimation of Mean Values and Prediction 
of Individual Values

In Chapter 8, you studied the concept of the confidence interval estimate of the population mean. In
Example 13.2 on page 527, you used the prediction line to predict the mean value of Y for a given
X . The annual sales for stores with 4,000 square feet was predicted to be 7.644 millions of dollars
($7,644,000). This estimate, however, is a point estimate of the population mean. This section
presents methods to develop a confidence interval estimate for the mean response for a given X
and for developing a prediction interval for an individual response, Y, for a given value of X.

The Confidence Interval Estimate
Equation (13.20) defines the confidence interval estimate for the mean response for a
given X.

www.the-numbers.com/interactive/comp-Harry-Potter.php
www.the-numbers.com/interactive/comp-Harry-Potter.php
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CONFIDENCE INTERVAL ESTIMATE FOR THE MEAN OF Y

(13.20)

where

critical value corresponding to an upper-tail probability of from the t
distribution with degrees of freedom (i.e., a cumulative area of ).1 - a>2n - 2

a>2ta>2 =

SSX = a
n

i=1
1Xi - X22

mY|X=Xi
= mean value of Y when X = Xi

Xi = given value of X

n = sample size

SYX = standard error of the estimate

YNi = predicted value of Y; YN i = b0 + b1Xi

hi =
1
n

+
1Xi - X 22

SSX

YNi - ta>2SYX1hi … mY ƒ X=Xi
… - YNi + ta>2SYX1hi

YNi ; ta>2SYX1hi

The width of the confidence interval in Equation (13.20) depends on several factors. Increased
variation around the prediction line, as measured by the standard error of the estimate, results in a
wider interval. As you would expect, increased sample size reduces the width of the interval. In
addition, the width of the interval varies at different values of X . When you predict Y for values of
X close to the interval is narrower than for predictions for X values further away from

In the Sunflowers Apparel example, suppose you want to construct a 95% confidence
interval estimate of the mean annual sales for the entire population of stores that contain 4,000
square feet Using the simple linear regression equation,

Also, given the following:

From Table E.3, Thus,

where

so that

= 7.6439 ; 0.6728

= 7.6439 ; (2.1788)(0.9664)C 1
14

+
14 - 2.921422

37.9236

YNi ; ta>2SYXC1
n

+
1Xi - X 22

SSX

hi =
1
n

+
1Xi - X 22

SSX

YNi ; ta>2SYX2hi

ta>2 = 2.1788.

SSX = a
n

i=1
1Xi - X22 = 37.9236

X = 2.9214 SYX = 0.9664

= 0.9645 + 1.6699142 = 7.6439 1millions of dollars2
YNi = 0.9645 + 1.6699Xi

1X = 42.

X .X ,
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so

Therefore, the 95% confidence interval estimate is that the mean annual sales are between
$6,971,100 and $8,316,700 for the population of stores with 4,000 square feet.

The Prediction Interval
In addition to constructing a confidence interval for the mean value of Y, you can also
construct a prediction interval for an individual value of Y. Although the form of this inter-
val is similar to that of the confidence interval estimate of Equation (13.20), the prediction
interval is predicting an individual value, not estimating a mean. Equation (13.21) defines
the prediction interval for an individual response, Y, at a given value, denoted by
YX=Xi

.
Xi,

6.9711 … mY!X=4 … 8.3167

PREDICTION INTERVAL FOR AN INDIVIDUAL RESPONSE, Y

(13.21)

where

future value of Y when
critical value corresponding to an upper-tail probability of from the t

distribution with degrees of freedom (i.e., a cumulative area of )

In addition, and are defined as in Equation (13.20) on page 555.Xihi, Yi
N , SYX, n,

1 - a>2n - 2
a>2ta>2 =

X = XiYX=Xi
=

YNi - ta>2SYX11 + hi … YX=Xi
… YNi + ta/2SYX11 + hi

YNi ; ta>2SYX11 + hi

To construct a 95% prediction interval of the annual sales for an individual store that con-
tains 4,000 square feet you first compute Using the prediction line:

Also, given the following:

From Table E.3, Thus,

where

hi =
1
n

+
(Xi - X )2

a
n

i=1
1Xi - X 22

YNi ; ta>2SYX21 + hi

ta>2 = 2.1788.

SSX = a
n

i=1
1Xi - X 22 = 37.9236

X = 2.9214 SYX = 0.9664

= 7.6439 1millions of dollars2
= 0.9645 + 1.6699142

YNi = 0.9645 + 1.6699Xi

YNi.1X = 42,
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so that

so

Therefore, with 95% confidence, you predict that the annual sales for an individual store with
4,000 square feet is between $5,433,500 and $9,854,300.

Figure 13.21 presents results for the confidence interval estimate and the prediction interval
for the Sunflowers Apparel data. If you compare the results of the confidence interval estimate
and the prediction interval, you see that the width of the prediction interval for an individual store
is much wider than the confidence interval estimate for the mean. Remember that there is much
more variation in predicting an individual value than in estimating a mean value.

5.4335 … YX=4 … 9.8543

= 7.6439 ; 2.2104

= 7.6439 ; (2.1788)(0.9664)C1 +
1

14
+
14 - 2.921422

37.9236

YNi ; ta>2SYXC1 +
1
n

+
1Xi - X 22

SSX

F I G U R E 1 3 . 2 1
Excel and Minitab confidence interval estimate and prediction interval results for the Sunflowers Apparel data

Problems for Section 13.8
LEARNING THE BASICS
13.55 Based on a sample of the least-squares
method was used to develop the following prediction line:

.
In addition,

a. Construct a 95% confidence interval estimate of the pop-
ulation mean response for 

b. Construct a 95% prediction interval of an individual
response for X = 2.

X = 2.

SYX = 1.0 X = 2 a
n

i=1
1Xi - X 22 = 20

YNi = 5 + 3Xi

n = 20,

13.56 Based on a sample of the least-squares
method was used to develop the following prediction line:

.
In addition,

a. Construct a 95% confidence interval estimate of the
population mean response for 

b. Construct a 95% prediction interval of an individual re-
sponse for X = 4.

X = 4.

SYX = 1.0 X = 2 a
n

i=1
1Xi - X22 = 20

YNi = 5 + 3Xi

n = 20,
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c. Compare the results of (a) and (b) with those of Problem
13.55 (a) and (b). Which intervals are wider? Why?

APPLYING THE CONCEPTS
13.57 In Problem 13.5 on page 531, you used the summated
rating of a restaurant to predict the cost of a meal. The data
are stored in . For these data, and

when
a. Construct a 95% confidence interval estimate of the

mean cost of a meal for restaurants that have a summated
rating of 50.

b. Construct a 95% prediction interval of the cost of a meal
for an individual restaurant that has a summated rating
of 50

c. Explain the difference in the results in (a) and (b).

13.58 In Problem 13.4 on page 531, the marketing
manager used shelf space for pet food to predict

weekly sales. The data are stored in . For these
data, and when
a. Construct a 95% confidence interval estimate of the

mean weekly sales for all stores that have 8 feet of shelf
space for pet food.

b. Construct a 95% prediction interval of the weekly sales
of an individual store that has 8 feet of shelf space for pet
food.

c. Explain the difference in the results in (a) and (b).

13.59 In Problem 13.7 on page 531, you used the total
number of customers in the store to predict the waiting time
at the checkout counter. The data are stored in

.
a. Construct a 95% confidence interval estimate of the

mean waiting time for all customers when there are 20
customers in the store.

b. Construct a 95% prediction interval of the waiting time
for an individual customer when there are 20 customers
in the store.

c. Why is the interval in (a) narrower than the interval in (b)?

Supermarket

X = 8.hi = 0.1373SYX = 30.81
Petfood

SELF
Test

X = 50.hi = 0.026844
SYX = 9.5505Restaurants

13.60 In Problem 13.6 on page 531, the owner of a moving
company wanted to predict labor hours based on the num-
ber of cubic feet moved. The data are stored in .
a. Construct a 95% confidence interval estimate of the

mean labor hours for all moves of 500 cubic feet.
b. Construct a 95% prediction interval of the labor hours of

an individual move that has 500 cubic feet.
c. Why is the interval in (a) narrower than the interval in (b)?

13.61 In Problem 13.9 on page 532, an agent for a real
estate company wanted to predict the monthly rent for apart-
ments, based on the size of an apartment. The data are
stored in .
a. Construct a 95% confidence interval estimate of the

mean monthly rental for all apartments that are 1,000
square feet in size.

b. Construct a 95% prediction interval of the monthly rental
for an individual apartment that is 1,000 square feet in size.

c. Explain the difference in the results in (a) and (b).

13.62 In Problem 13.8 on page 531, you predicted the value
of a baseball franchise, based on current revenue. The data
are stored in .
a. Construct a 95% confidence interval estimate of the

mean value of all baseball franchises that generate $200
million of annual revenue.

b. Construct a 95% prediction interval of the value of an
individual baseball franchise that generates $200 million
of annual revenue.

c. Explain the difference in the results in (a) and (b).

13.63 In Problem 13.10 on page 532, you used box office
gross to predict DVD revenue. The data are stored in

. The company is about to release a movie on DVD
that had a box office gross of $75 million.
a. What is the predicted DVD revenue?
b. Which interval is more useful here, the confidence inter-

val estimate of the mean or the prediction interval for an
individual response? Explain.

c. Construct and interpret the interval you selected in (b).

Movie

BBRevenue

Rent

Moving

13.9 Pitfalls in Regression
Some of the pitfalls involved in using regression analysis are as follows:

• Lacking awareness of the assumptions of least-squares regression
• Not knowing how to evaluate the assumptions of least-squares regression
• Not knowing what the alternatives are to least-squares regression if a particular assump-

tion is violated
• Using a regression model without knowledge of the subject matter
• Extrapolating outside the relevant range
• Concluding that a significant relationship identified in an observational study is due to a

cause-and-effect relationship

The widespread availability of spreadsheet and statistical applications has made regres-
sion analysis much more feasible today than it once was. However, many users with access to
such applications do not understand how to use regression analysis properly. Someone who is
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T A B L E 1 3 . 7

Four Sets of Artificial
Data

Data Set A Data Set B Data Set C Data Set D

Xi Yi Xi Yi Xi Yi Xi Yi

10 8.04 10 9.14 10 7.46 8 6.58
14 9.96 14 8.10 14 8.84 8 5.76
5 5.68 5 4.74 5 5.73 8 7.71
8 6.95 8 8.14 8 6.77 8 8.84
9 8.81 9 8.77 9 7.11 8 8.47

12 10.84 12 9.13 12 8.15 8 7.04
4 4.26 4 3.10 4 5.39 8 5.25
7 4.82 7 7.26 7 6.42 19 12.50

11 8.33 11 9.26 11 7.81 8 5.56
13 7.58 13 8.74 13 12.74 8 7.91
6 7.24 6 6.13 6 6.08 8 6.89

Source: Data extracted from F. J. Anscombe, “Graphs in Statistical Analysis,” The American Statistician, 27
(1973), 17–21.

Anscombe (reference 1) showed that all four data sets given in Table 13.7 have the
following identical results:

If you stopped the analysis at this point, you would fail to observe the important differences
among the four data sets.

From the scatter plots of Figure 13.22 and the residual plots of Figure 13.23 on page 560,
you see how different the data sets are. Each has a different relationship between X and Y. The
only data set that seems to approximately follow a straight line is data set A. The residual plot
for data set A does not show any obvious patterns or outlying residuals. This is certainly not
true for data sets B, C, and D. The scatter plot for data set B shows that a curvilinear regres-
sion model is more appropriate. This conclusion is reinforced by the residual plot for data set
B. The scatter plot and the residual plot for data set C clearly show an outlying observation. In
this case, one approach used is to remove the outlier and reestimate the regression model (see
reference 4). The scatter plot for data set D represents a situation in which the model is heavily
dependent on the outcome of a single data point ( and ). Any regression
model with this characteristic should be used with caution.

Y8 = 12.50X8 = 19

SST = Total variation = a
n

i=1
1Yi - Y 22 = 41.27

SSE = Unexplained variation = a
n

i=1
1Yi - YNi22 = 13.76

SSR = Explained variation = a
n

i=1
1YNi - Y 22 = 27.51

r2 = 0.667

Sb1
= 0.118

SYX = 1.237

YNi = 3.0 + 0.5Xi

not familiar with either the assumptions of regression or how to evaluate the assumptions can-
not be expected to know what the alternatives to least-squares regression are if a particular as-
sumption is violated.

The data in Table 13.7 (stored in ) illustrate the importance of using scatter
plots and residual analysis to go beyond the basic number crunching of computing the Y
intercept, the slope, and r2.

Anscombe
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In summary, scatter plots and residual plots are of vital importance to a complete
regression analysis. The information they provide is so basic to a credible analysis that you
should always include these graphical methods as part of a regression analysis. Thus, a strat-
egy you can use to help avoid the pitfalls of regression is as follows:

1. Start with a scatter plot to observe the possible relationship between X and Y.
2. Check the assumptions of regression (linearity, independence, normality, equal variance)

by performing a residual analysis that includes the following:
a. Plotting the residuals versus the independent variable to determine whether the linear

model is appropriate and to check for equal variance
b. Constructing a histogram, stem-and-leaf display, boxplot, or normal probability plot of

the residuals to check for normality
c. Plotting the residuals versus time to check for independence (this step is necessary only

if the data are collected over time)
3. If there are violations of the assumptions, use alternative methods to least-squares

regression or alternative least-squares models (see reference 4).
4. If there are no violations of the assumptions, carry out tests for the significance of the

regression coefficients and develop confidence and prediction intervals.
5. Avoid making predictions and forecasts outside the relevant range of the independent

variable.



I
n the Sunflowers Apparel scenario, you were the director of planning
for a chain of upscale clothing stores for women. Until now, Sunflow-
ers managers selected sites based on factors such as the availability
of a good lease or a subjective opinion that a location seemed like a

good place for a store. To make more objective decisions, you developed a
regression model to analyze the relationship between the size of a store and
its annual sales. The model indicated that about 90.4% of the variation in

sales was explained by the size of the store. Furthermore, for each increase of 1,000 square
feet, mean annual sales were estimated to increase by $1.67 million. You can now use your
model to help make better decisions when selecting new sites for stores as well as to forecast
sales for existing stores.
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T H I N K A B O U T T H I S By Any Other Name

You may not have frequently heard the phrase
“regression model” outside a classroom, but the
basic concepts of regression can be found un-
der a variety of names in many sectors of the
economy:

• Advertising and marketing Managers use
econometric models (in other words, regres-
sion models) to determine the effect of an
advertisement on sales, based on a set of
factors. In one recent example, the number
of tweets that mention specific products
was used to make accurate prediction of
sales trends. (See H. Rui, A. Whinston, and E.
Winkler, “Follow the Tweets,” The Wall Street
Journal, November 30, 2009, p. R4.) Also,
managers use data mining to predict pat-
terns of behavior of what customers will buy
in the future, based on historic information
about the consumer.

• Finance Any time you read about a finan-
cial “model,” you should assume that some
type of regression model is being used. For
example, a New York Times article on June
18, 2006, titled “An Old Formula That Points
to New Worry” by Mark Hulbert (p. BU8), dis-
cusses a market timing model that predicts
the returns of stocks in the next three to five
years, based on the dividend yield of the
stock market and the interest rate of 90-day
Treasury bills.

• Food and beverage Enologix, a California
consulting company, has developed a “for-
mula” (a regression model) that predicts a
wine’s quality index, based on a set of
chemical compounds found in the wine.
(See D. Darlington, “The Chemistry of a
Wine,” The New York Times Magazine,
August 7, 2005, pp. 36–39.)

• Government The Bureau of Labor Statistics
uses hedonic models, a type of regression
model, to adjust and manage its consumer
price index (“Hedonic Quality Adjustment in
the CPI,” Consumer Price Index, stat.bls.
gov/cpi/cpihqaitem.htm).

• Transportation Bing Travel uses data min-
ing and predictive technologies to objec-
tively predict airfare pricing. (See C. Elliott,
“Bing Travel’s Crean: We Save the Average
Couple $50 per Trip,” Elliott Blog, www.el-
liott.org/first-person/bing-travel-we-
save-the-average-couple-50-per-trip/.)

• Real estate Zillow.com uses information
about the features contained in a home and
its location to develop estimates about the
market value of the home, using a “formula”
built with a proprietary model.

In a more general way, regression models
are part of the “quants” movement that revolu-
tionized Wall Street investing before moving on to

90+

other fields (see S. Baker, “Why Math Will Rock
Your World: More Math Geeks Are Calling the
Shots in Business. Is Your Industry Next?”
BusinessWeek, January 23, 2006, pp. 54–62).
While the methods, including advanced regres-
sion models, that the quants used in Wall Street
operations have been seen by some as the cause
of the 2007 economic meltdown (see S. Patter-
son, The Quants: How a New Breed of Math
Whizzes Conquered Wall Street and Nearly De-
stroyed It, New York: Crown Business, 2010), the
rise of quants reflects a growing use of regres-
sion and other statistical techniques in business.

In his landmark 2006 BusinessWeek article,
Baker predicted that statistics and probability
will become core skills for businesspeople and
consumers. He claimed that those who would
become successful would know how to use sta-
tistics, whether they are building financial mod-
els or making marketing plans. More recent
articles, including S. Lohr’s “For Today’s Gradu-
ate, Just One Word: Statistics” (The New York
Times, August 6, 2009, pp. A1, A3) confirm
Baker’s prediction and discussed how statistics
is being used to “mine” large data sets to dis-
cover patterns, often using regression models.
Hal Varian, the chief economist at Google, is
quoted in that article as saying, “I keep saying
that the sexy job in the next ten years will be
statisticians.”

6. Keep in mind that the relationships identified in observational studies may or may not be
due to cause-and-effect relationships. Remember that, although causation implies
correlation, correlation does not imply causation.

www.elliott.org/first-person/bing-travel-wesave-the-average-couple-50-per-trip/
www.elliott.org/first-person/bing-travel-wesave-the-average-couple-50-per-trip/
www.elliott.org/first-person/bing-travel-wesave-the-average-couple-50-per-trip/
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S U M M A R Y
As you can see from the chapter roadmap in Figure 13.24,
this chapter develops the simple linear regression model and
discusses the assumptions and how to evaluate them. Once
you are assured that the model is appropriate, you can predict

values by using the prediction line and test for the signifi-
cance of the slope. In Chapter 14, regression analysis is ex-
tended to situations in which more than one independent
variable is used to predict the value of a dependent variable.

Yes

Yes

Yes

Yes

No

Regression Correlation

No

No

No
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Roadmap for simple
linear regression
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K E Y E Q U AT I O N S
Simple Linear Regression Model

(13.1)

Simple Linear Regression Equation: The Prediction Line

(13.2)

Computational Formula for the Slope,

(13.3)

Computational Formula for the Y Intercept,

(13.4)

Measures of Variation in Regression

(13.5)

Total Sum of Squares (SST)

(13.6)

Regression Sum of Squares (SSR)

(13.7)

Error Sum of Squares (SSE)

(13.8)

Coefficient of Determination

(13.9)

Computational Formula for SST

(13.10)SST = a
n

i=1
1Yi - Y22 = a

n

i=1
Y2

i -
aa

n

i=1
Yib

2

n

r2 =
Regression sum of squares

Total sum of squares
=

SSR

SST

= a
n

i=1
1Yi - YNi22

SSE = Unexplained variation or error sum of squares

= a
n

i=1
1YNi - Y22

SSR = Explained variation or regression sum of squares

SST = Total sum of squares = a
n

i=1
1Yi - Y22

SST = SSR + SSE

b0 = Y - b1 X

b0

b1 =
SSXY

SSX

b1

YNi = b0 + b1Xi

Yi = b0 + b1Xi + ei

Computational Formula for SSR

(13.11)

Computational Formula for SSE

(13.12)

Standard Error of the Estimate

(13.13)

Residual

(13.14)

Durbin-Watson Statistic

(13.15)

Testing a Hypothesis for a Population Slope,
Using the t Test

(13.16)

Testing a Hypothesis for a Population Slope,
Using the F Test

(13.17)

Confidence Interval Estimate of the Slope,

(13.18)b1 - ta>2Sb1
… b1 … b1 + ta>2Sb1

b1 ; ta>2Sb1

B1

FSTAT =
MSR

MSE

B1,

tSTAT =
b1 - b1

Sb1

B1,

D =
a

n

i=2
1ei - ei-122

a
n

i=1
e2

i

ei = Yi - YNi

SYX = A SSE

n - 2
= Qa

n

i=1
1Yi - YNi22
n - 2

SSE = a
n

i=1
1Yi - Yi

N22 = a
n

i=1
Yi

2 - b0a
n

i=1
Yi - b1a

n

i=1
XiYi

= b0a
n

i=1
Yi + b1a

n

i=1
XiYi -

aa
n

i=1
Yib

2

n

SSR = a
n

i=1
(YNi - Y)2
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Testing for the Existence of Correlation

(13.19a)

(13.19b)

Confidence Interval Estimate for the Mean of Y

(13.20)YNi - ta>2SYX2hi … mY ƒ X=Xi
… YNi + ta>2 SYX2hi

YNi ; ta>2SYX2hi

r =
cov1X,Y2

SXSY

tSTAT =
r - r

A1 - r2

n - 2

Prediction Interval for an Individual Response, Y

(13.21)
YNi - ta>2SYX21 + hi … YX=Xi

… YNi + ta>2SYX21 + hi

YNi ; ta>2SYX21 + hi
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CHAPTER REVIEW PROBLEMS
CHECKING YOUR UNDERSTANDING
13.64 What is the interpretation of the Y intercept and the
slope in the simple linear regression equation?

13.65 What is the interpretation of the coefficient of de-
termination?

13.66 When is the unexplained variation (i.e., error sum
of squares) equal to 0?

13.67 When is the explained variation (i.e., regression
sum of squares) equal to 0?

13.68 Why should you always carry out a residual analy-
sis as part of a regression model?

13.69 What are the assumptions of regression analysis?

13.70 How do you evaluate the assumptions of regression
analysis?

13.71 When and how do you use the Durbin-Watson statistic?

13.72 What is the difference between a confidence
interval estimate of the mean response, and a
prediction interval of 

APPLYING THE CONCEPTS
13.73 Researchers from the Pace University Lubin School
of Business conducted a study on Internet-supported
courses. In one part of the study, four numerical variables
were collected on 108 students in an introductory manage-
ment course that met once a week for an entire semester. One
variable collected was hit consistency. To measure hit consis-

YX=Xi
?

mY|X=Xi
,
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Customer

Number
of

Cases

Delivery
Time

(Minutes) Customer

Number
of

Cases

Delivery
Time

(Minutes)

1 52 32.1 11 161 43.0
2 64 34.8 12 184 49.4
3 73 36.2 13 202 57.2
4 85 37.8 14 218 56.8
5 95 37.8 15 243 60.6
6 103 39.7 16 254 61.2
7 116 38.5 17 267 58.2
8 121 41.9 18 275 63.1
9 143 44.2 19 287 65.6

10 157 47.1 20 298 67.3

tency, the researchers did the following: If a student did not
visit the Internet site between classes, the student was given
a 0 for that time period. If a student visited the Internet site
one or more times between classes, the student was given a 1
for that time period. Because there were 13 time periods, a
student’s score on hit consistency could range from 0 to 13.

The other three variables included the student’s course
average, the student’s cumulative grade point average
(GPA), and the total number of hits the student had on the
Internet site supporting the course. The following table
gives the correlation coefficient for all pairs of variables.
Note that correlations marked with an * are statistically sig-
nificant, using a = 0.001:

a. Use the least-squares method to compute the regression
coefficients and

b. Interpret the meaning of and in this problem.
c. Predict the delivery time for 150 cases of soft drink.
d. Should you use the model to predict the delivery time for

a customer who is receiving 500 cases of soft drink? Why
or why not?

e. Determine the coefficient of determination, and
explain its meaning in this problem.

f. Perform a residual analysis. Is there any evidence of a
pattern in the residuals? Explain.

g. At the 0.05 level of significance, is there evidence of a
linear relationship between delivery time and the number
of cases delivered?

h. Construct a 95% confidence interval estimate of the
mean delivery time for 150 cases of soft drink and a 95%
prediction interval of the delivery time for a single deliv-
ery of 150 cases of soft drink.

13.75 Measuring the height of a California redwood tree
is a very difficult undertaking because these trees grow to
heights of over 300 feet. People familiar with these trees
understand that the height of a California redwood tree is
related to other characteristics of the tree, including the
diameter of the tree at the breast height of a person. The data
in represent the height (in feet) and diameter (in
inches) at the breast height of a person for a sample of
21 California redwood trees.
a. Assuming a linear relationship, use the least-squares

method to compute the regression coefficients b0 and b1.
State the regression equation that predicts the height of a
tree based on the tree’s diameter at breast height of a
person.

b. Interpret the meaning of the slope in this equation.
c. Predict the height for a tree that has a breast diameter of

25 inches.
d. Interpret the meaning of the coefficient of determination

in this problem.
e. Perform a residual analysis on the results and determine

the adequacy of the model.
f. Determine whether there is a significant relationship be-

tween the height of redwood trees and the breast height
diameter at the 0.05 level of significance.

g. Construct a 95% confidence interval estimate of the pop-
ulation slope between the height of the redwood trees and
breast diameter.

13.76 You want to develop a model to predict the selling
price of homes based on assessed value. A sample of 30
recently sold single-family houses in a small city is selected
to study the relationship between selling price (in thousands
of dollars) and assessed value (in thousands of dollars). The
houses in the city were reassessed at full value one year
prior to the study. The results are in . (Hint: First,
determine which are the independent and dependent
variables.)

House1

Redwood

r2,

b1b0

b1.b0

Variable Correlation

Course Average, Cumulative GPA 0.72*
Course Average, Total Hits 0.08
Course Average, Hit Consistency 0.37*
Cumulative GPA, Total Hits 0.12
Cumulative GPA, Hit Consistency 0.32*
Total Hits & Hit Consistency 0.64*
Source: Data extracted from D. Baugher, A. Varanelli, and E. Weisbord,
“Student Hits in an Internet-Supported Course: How Can Instructors
Use Them and What Do They Mean?” Decision Sciences Journal of
Innovative Education, 1 (Fall 2003), 159–179.

a. What conclusions can you reach from this correlation
analysis?

b. Are you surprised by the results, or are they consistent
with your own observations and experiences?

13.74 Management of a soft-drink bottling company has
the business objective of developing a method for allocating
delivery costs to customers. Although one cost clearly re-
lates to travel time within a particular route, another variable
cost reflects the time required to unload the cases of soft
drink at the delivery point. To begin, management decided
to develop a regression model to predict delivery time based
on the number of cases delivered. A sample of 20 deliveries
within a territory was selected. The delivery times and the
number of cases delivered were organized in the following
table (and stored in ):Delivery
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a. Construct a scatter plot and, assuming a linear relation-
ship, use the least-squares method to compute the
regression coefficients

b. Interpret the meaning of the intercept, and the
slope, in this problem.

c. Use the prediction line developed in (a) to predict the
selling price for a house whose assessed value is
$170,000.

d. Determine the coefficient of determination, and
interpret its meaning in this problem.

e. Perform a residual analysis on your results and evaluate
the regression assumptions.

f. At the 0.05 level of significance, is there evidence of a
linear relationship between selling price and assessed
value?

g. Construct a 95% confidence interval estimate of the
population slope.

13.77 You want to develop a model to predict the assessed
value of houses, based on heating area. A sample of 15 sin-
gle-family houses in a city is selected. The assessed value
(in thousands of dollars) and the heating area of the houses
(in thousands of square feet) are recorded; the results are
stored in . (Hint: First, determine which are the
independent and dependent variables.)
a. Construct a scatter plot and, assuming a linear

relationship, use the least-squares method to compute the
regression coefficients

b. Interpret the meaning of the intercept, and the
slope, in this problem.

c. Use the prediction line developed in (a) to predict the
assessed value for a house whose heating area is 1,750
square feet.

d. Determine the coefficient of determination, and inter-
pret its meaning in this problem.

e. Perform a residual analysis on your results and evaluate
the regression assumptions.

f. At the 0.05 level of significance, is there evidence of a
linear relationship between assessed value and heating
area?

13.78 The director of graduate studies at a large college of
business would like to predict the grade point average (GPA)
of students in an MBA program based on Graduate Manage-
ment Admission Test (GMAT) score. A sample of 20 stu-
dents who have completed two years in the program is
selected. The results are stored in . (Hint: First, de-
termine which are the independent and dependent variables.)
a. Construct a scatter plot and, assuming a linear relation-

ship, use the least-squares method to compute the
regression coefficients

b. Interpret the meaning of the intercept, and the
slope, in this problem.

c. Use the prediction line developed in (a) to predict the
GPA for a student with a GMAT score of 600.

d. Determine the coefficient of determination, and
interpret its meaning in this problem.

r2,

b1,
b0,Y

b0 and b1.

GPIGMAT

r2,

b1,
b0,Y

b0 and b1.

House2

r2,

b1,
b0,Y

b0 and b1.

e. Perform a residual analysis on your results and evaluate
the regression assumptions.

f. At the 0.05 level of significance, is there evidence of a
linear relationship between GMAT score and GPA?

g. Construct a 95% confidence interval estimate of the
mean GPA of students with a GMAT score of 600 and a
95% prediction interval of the GPA for a particular stu-
dent with a GMAT score of 600.

h. Construct a 95% confidence interval estimate of the pop-
ulation slope.

13.79 An accountant for a large department store would
like to develop a model to predict the amount of time it
takes to process invoices. Data are collected from the past
32 working days, and the number of invoices processed and
completion time (in hours) are stored in . (Hint:
First, determine which are the independent and dependent
variables.)
a. Assuming a linear relationship, use the least-squares

method to compute the regression coefficients
b. Interpret the meaning of the Y intercept, and the

slope, in this problem.
c. Use the prediction line developed in (a) to predict the

amount of time it would take to process 150 invoices.
d. Determine the coefficient of determination, and inter-

pret its meaning.
e. Plot the residuals against the number of invoices

processed and also against time.
f. Based on the plots in (e), does the model seem appro-

priate?
g. Based on the results in (e) and (f), what conclusions can

you make about the validity of the prediction made in (c)?

13.80 On January 28, 1986, the space shuttle Challenger
exploded, and seven astronauts were killed. Prior to the
launch, the predicted atmospheric temperature was for
freezing weather at the launch site. Engineers for Morton
Thiokol (the manufacturer of the rocket motor) prepared
charts to make the case that the launch should not take place
due to the cold weather. These arguments were rejected, and
the launch tragically took place. Upon investigation after the
tragedy, experts agreed that the disaster occurred because of
leaky rubber O-rings that did not seal properly due to the
cold temperature. Data indicating the atmospheric tempera-
ture at the time of 23 previous launches and the O-ring
damage index are stored in .

Note: Data from flight 4 is omitted due to unknown O-ring condition.

Sources: Data extracted from Report of the Presidential Commission
on the Space Shuttle Challenger Accident, Washington, DC, 1986,
Vol. II (H1–H3); and Vol. IV (664), and Post Challenger Evaluation
of Space Shuttle Risk Assessment and Management, Washington,
DC, 1988, pp. 135–136.

a. Construct a scatter plot for the seven flights in which
there was O-ring damage (O-ring damage index ).
What conclusions, if any, can you reach about the rela-
tionship between atmospheric temperature and O-ring
damage?

Z 0

O-Ring

r2,

b1,
b0,

b0 and b1.

Invoice
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b. Construct a scatter plot for all 23 flights.
c. Explain any differences in the interpretation of the rela-

tionship between atmospheric temperature and O-ring
damage in (a) and (b).

d. Based on the scatter plot in (b), provide reasons why a
prediction should not be made for an atmospheric tem-
perature of 31°F, the temperature on the morning of the
launch of the Challenger.

e. Although the assumption of a linear relationship may not
be valid for the set of 23 flights, fit a simple linear re-
gression model to predict O-ring damage, based on at-
mospheric temperature.

f. Include the prediction line found in (e) on the scatter plot
developed in (b).

g. Based on the results in (f), do you think a linear model is
appropriate for these data? Explain.

h. Perform a residual analysis. What conclusions do you
reach?

13.81 Crazy Dave, a well-known baseball analyst, would
like to study various team statistics for the 2009 baseball
season to determine which variables might be useful in pre-
dicting the number of wins achieved by teams during the
season. He has decided to begin by using a team’s earned
run average (ERA), a measure of pitching performance, to
predict the number of wins. The data for the 30 Major
League Baseball teams are stored in . (Hint: First,
determine which are the independent and dependent
variables.)
a. Assuming a linear relationship, use the least-squares

method to compute the regression coefficients and
b. Interpret the meaning of the Y intercept, and the

slope, in this problem.
c. Use the prediction line developed in (a) to predict the

number of wins for a team with an ERA of 4.50.
d. Compute the coefficient of determination, and inter-

pret its meaning.
e. Perform a residual analysis on your results and determine

the adequacy of the fit of the model.
f. At the 0.05 level of significance, is there evidence of a

linear relationship between the number of wins and the
ERA?

g. Construct a 95% confidence interval estimate of the
mean number of wins expected for teams with an ERA
of 4.50.

h. Construct a 95% prediction interval of the number of
wins for an individual team that has an ERA of 4.50.

i. Construct a 95% confidence interval estimate of the
population slope.

j. The 30 teams constitute a population. In order to use
statistical inference, as in (f) through (i), the data must
be assumed to represent a random sample. What “popu-
lation” would this sample be drawing conclusions
about?

k. What other independent variables might you consider for
inclusion in the model?

r2,
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13.82 Can you use the annual revenues generated by Na-
tional Basketball Association (NBA) franchises to predict
franchise values? Figure 2.15 on page 57 shows a scatter
plot of revenue with franchise value, and Figure 3.10 on page
129, shows the correlation coefficient. Now, you want to de-
velop a simple linear regression model to predict franchise
values based on revenues. (Franchise values and revenues
are stored in .)
a. Assuming a linear relationship, use the least-squares

method to compute the regression coefficients and
b. Interpret the meaning of the Y intercept, and the

slope, in this problem.
c. Predict the value of an NBA franchise that generates

$150 million of annual revenue.
d. Compute the coefficient of determination, and inter-

pret its meaning.
e. Perform a residual analysis on your results and evaluate

the regression assumptions.
f. At the 0.05 level of significance, is there evidence of a

linear relationship between the annual revenues gener-
ated and the value of an NBA franchise?

g. Construct a 95% confidence interval estimate of the
mean value of all NBA franchises that generate $150 mil-
lion of annual revenue.

h. Construct a 95% prediction interval of the value of an
individual NBA franchise that generates $150 million of
annual revenue.

i. Compare the results of (a) through (h) to those of baseball
franchises in Problems 13.8, 13.20, 13.30, 13.46, and
13.62 and European soccer teams in Problem 13.83.

13.83 In Problem 13.82 you used annual revenue to de-
velop a model to predict the franchise value of National
Basketball Association (NBA) teams. Can you also use the
annual revenues generated by European soccer teams to
predict franchise values? (European soccer team values and
revenues are stored in .)
a. Repeat Problem 13.82 (a) through (h) for the European

soccer teams.
b. Compare the results of (a) to those of baseball franchises

in Problems 13.8, 13.20, 13.30, 13.46, and 13.62 and
NBA franchises in Problem 13.82.

13.84 During the fall harvest season in the United States,
pumpkins are sold in large quantities at farm stands. Often,
instead of weighing the pumpkins prior to sale, the farm
stand operator will just place the pumpkin in the appropri-
ate circular cutout on the counter. When asked why this was
done, one farmer replied, “I can tell the weight of the
pumpkin from its circumference.” To determine whether
this was really true, a sample of 23 pumpkins were meas-
ured for circumference and weighed; the results are stored
in .
a. Assuming a linear relationship, use the least-squares

method to compute the regression coefficients and
b. Interpret the meaning of the slope, , in this problem.b1

b1.b0

Pumpkin

SoccerValues
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c. Predict the weight for a pumpkin that is 60 centimeters in
circumference.

d. Do you think it is a good idea for the farmer to sell
pumpkins by circumference instead of weight? Explain.

e. Determine the coefficient of determination, , and inter-
pret its meaning.

f. Perform a residual analysis for these data and evaluate
the regression assumptions.

g. At the 0.05 level of significance, is there evidence of a
linear relationship between the circumference and weight
of a pumpkin?

h. Construct a 95% confidence interval estimate of the pop-
ulation slope, .

13.85 Can demographic information be helpful in
predicting sales at sporting goods stores? The file
contains the monthly sales totals from a random sample of
38 stores in a large chain of nationwide sporting goods
stores. All stores in the franchise, and thus within the
sample, are approximately the same size and carry the same
merchandise. The county or, in some cases, counties in
which the store draws the majority of its customers is
referred to here as the customer base. For each of the 38
stores, demographic information about the customer base is
provided. The data are real, but the name of the franchise is
not used, at the request of the company. The data set
contains the following variables:

Sales—Latest one-month sales total (dollars)
Age—Median age of customer base (years)
HS—Percentage of customer base with a high school

diploma
College—Percentage of customer base with a college

diploma
Growth—Annual population growth rate of customer

base over the past 10 years
Income—Median family income of customer base

(dollars)
a. Construct a scatter plot, using sales as the dependent

variable and median family income as the independent
variable. Discuss the scatter plot.

b. Assuming a linear relationship, use the least-squares
method to compute the regression coefficients and

c. Interpret the meaning of the Y intercept, , and the
slope, , in this problem.

d. Compute the coefficient of determination, , and inter-
pret its meaning.

e. Perform a residual analysis on your results and determine
the adequacy of the fit of the model.

f. At the 0.05 level of significance, is there evidence of a
linear relationship between the independent variable and
the dependent variable?

g. Construct a 95% confidence interval estimate of the pop-
ulation slope and interpret its meaning.

r2
b1

b0
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13.86 For the data of Problem 13.85, repeat (a) through
(g), using Age as the independent variable.

13.87 For the data of Problem 13.85, repeat (a) through
(g), using HS as the independent variable.

13.88 For the data of Problem 13.85, repeat (a) through
(g), using College as the independent variable.

13.89 For the data of Problem 13.85, repeat (a) through
(g), using Growth as the independent variable.

13.90 The file includes the total com-
pensation (in $) of CEOs of 197 large public companies and
their investment return in 2009.
Source: Data extracted from D. Leonard, “Bargains in the
Boardroom,” The New York Times, April 4, 2010, pp. BU1, BU7,
BU10, BU11.

a. Compute the correlation coefficient between compensa-
tion and the investment return in 2009.

b. At the 0.05 level of significance, is the correlation be-
tween compensation and the investment return in 2009
statistically significant?

c. Write a short summary of your findings in (a) and (b).
Do the results surprise you?

13.91 Refer to the discussion of beta values and market
models in Problem 13.49 on page 553. The S&P 500 Index
tracks the overall movement of the stock market by con-
sidering the stock prices of 500 large corporations. The
f ile contains 2009 weekly data for the S&P
500 and three companies. The following variables are
included:

WEEK—Week ending on date given
S&P—Weekly closing value for the S&P 500 Index
GE—Weekly closing stock price for General Electric
DISC—Weekly closing stock price for Discovery Com-

munications
AAPL—Weekly closing stock price for Apple

Source: Data extracted from finance.yahoo.com, June 3, 2010.

a. Estimate the market model for GE. (Hint: Use the per-
centage change in the S&P 500 Index as the independent
variable and the percentage change in GE’s stock price as
the dependent variable.)

b. Interpret the beta value for GE.
c. Repeat (a) and (b) for Discovery.
d. Repeat (a) and (b) for Apple.
e. Write a brief summary of your findings.

REPORT WRITING EXERCISE
13.92 In Problems 13.85 through 13.89, you developed
regression models to predict monthly sales at a sporting
goods store. Now, write a report based on the models you
developed. Append to your report all appropriate charts and
statistical information.

StockPrices

CEO-Compensation
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M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
To ensure that as many trial subscriptions to the 3-For-All
service as possible are converted to regular subscriptions,
the marketing department works closely with the customer
support department to accomplish a smooth initial process
for the trial subscription customers. To assist in this effort,
the marketing department needs to accurately forecast the
monthly total of new regular subscriptions.

A team consisting of managers from the marketing and
customer support departments was convened to develop a
better method of forecasting new subscriptions. Previously,
after examining new subscription data for the prior three
months, a group of three managers would develop a
subjective forecast of the number of new subscriptions.
Livia Salvador, who was recently hired by the company to
provide expertise in quantitative forecasting methods, sug-
gested that the department look for factors that might help
in predicting new subscriptions.

Members of the team found that the forecasts in the
past year had been particularly inaccurate because in some
months, much more time was spent on telemarketing than
in other months. Livia collected data (stored in )
for the number of new subscriptions and hours spent on
telemarketing for each month for the past two years.

AMS13

EXERCISES
1. What criticism can you make concerning the method of

forecasting that involved taking the new subscriptions
data for the prior three months as the basis for future pro-
jections?

2. What factors other than number of telemarketing hours
spent might be useful in predicting the number of new
subscriptions? Explain.

3. a. Analyze the data and develop a regression model to
predict the number of new subscriptions for a month,
based on the number of hours spent on telemarketing
for new subscriptions.

b. If you expect to spend 1,200 hours on telemarketing
per month, estimate the number of new subscriptions
for the month. Indicate the assumptions on which this
prediction is based. Do you think these assumptions
are valid? Explain.

c. What would be the danger of predicting the number of
new subscriptions for a month in which 2,000 hours
were spent on telemarketing?

D I G I TA L C A S E
Apply your knowledge of simple linear regression in this
Digital Case, which extends the Sunflowers Apparel Using
Statistics scenario from this chapter.

Leasing agents from the Triangle Mall Management
Corporation have suggested that Sunflowers consider sev-
eral locations in some of Triangle’s newly renovated
lifestyle malls that cater to shoppers with higher-than-mean
disposable income. Although the locations are smaller than
the typical Sunflowers location, the leasing agents argue
that higher-than-mean disposable income in the surround-
ing community is a better predictor than store size of higher
sales. The leasing agents maintain that sample data from 14
Sunflowers stores prove that this is true.

Open Triangle_Sunflower.pdf and review the leasing
agents’ proposal and supporting documents. Then answer
the following questions:

1. Should mean disposable income be used to predict sales
based on the sample of 14 Sunflowers stores?

2. Should the management of Sunflowers accept the claims
of Triangle’s leasing agents? Why or why not?

3. Is it possible that the mean disposable income of the
surrounding area is not an important factor in leasing
new locations? Explain.

4. Are there any other factors not mentioned by the leasing
agents that might be relevant to the store leasing
decision?
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EG13.1 TYPES of REGRESSION MODELS

There are no Excel Guide instructions for this section.

EG13.2 DETERMINING the SIMPLE LINEAR
REGRESSION EQUATION

PHStat2 Use Simple Linear Regression to perform a
simple linear regression analysis. For example, to perform
the Figure 13.4 analysis of the Sunflowers Apparel data on
page 526, open to the DATA worksheet of the Site work-
book. Select PHStat ➔ Regression ➔ Simple Linear
Regression. In the procedure’s dialog box (shown below):

1. Enter C1:C15 as the Y Variable Cell Range.

2. Enter B1:B15 as the X Variable Cell Range.

3. Check First cells in both ranges contain label.

4. Enter 95 as the Confidence level for regression coeffi-
cients.

5. Check Regression Statistics Table and ANOVA and
Coefficients Table.

6. Enter a Title and click OK.
The procedure creates a worksheet that contains a copy

of your data as well as the worksheet shown in Figure 13.4.

modify step 6 by checking the Scatter Plot output option
before clicking OK.

In-Depth Excel Use the COMPUTE worksheet of the
Simple Linear Regression workbook, shown in Figure 13.4
on page 526, as a template for performing simple linear
regression. Columns A through I of this worksheet duplicate
the visual design of the Analysis ToolPak regression
worksheet. The worksheet uses the regression data in the
SLRDATA worksheet to perform the regression analysis for
the Table 13.1 Sunflowers Apparel data.

Not shown in Figure 13.4 is the Calculations area in
columns K through M. This area contains an array formula
in the cell range L2:M6 that contains the expression
LINEST(cell range of Y variable, cell range of X variable,
True, True) to compute the and coefficients in cells
L2 and M2, the and standard errors in cells L3 and
M3, and the standard error of the estimate in cells L4 and
M4, the F test statistic and error df in cells L5 and M5, and

and in cells L6 and M6. In cell L9, the expressionSSESSR

r2
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For more information about these worksheets, read the fol-
lowing In-Depth Excel section.

To create a scatter plot that contains a prediction line
and regression equation similar to Figure 13.5 on page 526,

TINV(1 � confidence level, Error degrees of freedom)
computes the critical value for the t test.

To perform simple linear regression for other data, paste
the regression data into the SLRDATA worksheet. Paste the
values for the X variable into column A and the values for
the Y variable into column B. Open to the COMPUTE work-
sheet. First, enter the confidence level in cell L8. Then edit
the array formula: Select the cell range L2:M6, edit the cell
ranges in the formulas, and then, while holding down the
Control and Shift keys (or the Apple key on a Mac), press
the Enter key. (Open the COMPUTE_FORMULAS work-
sheet to examine all the formulas in the worksheet, some of
which are discussed in later sections of this Excel Guide.)

To create a scatter plot that contains a prediction line
and regression equation similar to Figure 13.5 on page 526,
first use the Section EG2.6 In-Depth Excel scatter plot in-
structions with the Table 13.1 Sunflowers Apparel data to
create a basic plot. Then select the plot and:

1. Select Layout ➔ Trendline and select More Trendline
Options from the Trendline gallery.

In the Format Trendline dialog box (shown on page 572):

2. Click Trendline Options in the left pane. In the Trend-
line Options pane on the right, click Linear, check
Display Equation on chart, check Display R-squared
value on chart, and then click Close.

For scatter plots of other data, if the X axis does not ap-
pear at the bottom of the plot, right-click the Y axis and



If you use either Section EG13.2 PHStat2 or In-Depth
Excel instructions, formulas used to compute these mea-
sures are in the COMPUTE worksheet that is created. For-
mulas in cells B5, B7, B13, C12, C13, D12, and E12 copy
values computed by the array formula in cell range L2:M6.
The cell F12 formula, in the form (F test statistic,
1, error degrees of freedom), computes the p-value for the
F test for the slope, discussed in Section 13.7.

EG13.4 ASSUMPTIONS

There are no Excel Guide instructions for this section.

EG13.5 RESIDUAL ANALYSIS

PHStat2 Use the Section EG13.2 PHStat2 instructions.
Modify step 5 by checking Residuals Table and Residual
Plot in addition to checking Regression Statistics Table
and ANOVA and Coefficients Table.

In-Depth Excel Use the RESIDUALS worksheet of the
Simple Linear Regression workbook, shown in Figure
13.10 on page 540, as a template for creating a residuals
worksheet. This worksheet computes the residuals for the
regression analysis for the Table 13.1 Sunflowers Apparel
data. In column C, the worksheet computes the predicted Y
values (labeled Predicted Annual Sales in Figure 13.10) by
first multiplying the X values by the coefficient in cell
B18 of the COMPUTE worksheet and then adding the
coefficient (in cell B17 of COMPUTE). In column E, the
worksheet computes residuals by subtracting the predicted
Y values from the Y values.

For other problems, modify this worksheet by pasting
the X values into column B and the Y values into column D.
Then, for sample sizes smaller than 14, delete the extra
rows. For sample sizes greater than 14, copy the column C
and E formulas down through the row containing the last
pair and X and Y values and add the new observation num-
bers in column A.

Analysis ToolPak Use the Section EG13.2 Analysis Tool-
Pak instructions. Modify step 5 by checking Residuals and
Residual Plots before clicking New Worksheet Ply and
then OK.

To create a scatter plot similar to Figure 13.11, use the
original X variable and the residuals (plotted as the Y vari-
able) as the chart data.

EG13.6 MEASURING AUTOCORRELATION:
the DURBIN-WATSON STATISTIC

PHStat2 Use the PHStat2 instructions at the beginning of
Section EG13.2. Modify step 6 by checking the Durbin-
Watson Statistic output option before clicking OK.

b0
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click Format Axis from the shortcut menu. In the Format
Axis dialog box, click Axis Options in the left pane. In the
Axis Options pane on the right, click Axis value and in its
box enter the value shown in the dimmed Minimum box at
the top of the pane. Then click Close.

Analysis ToolPak Use Regression to perform simple
linear regression. For example, to perform the Figure 13.4
analysis of the Sunflowers Apparel data (see page 526), open
to the DATA worksheet of the Site workbook and:

1. Select Data ➔ Data Analysis.

2. In the Data Analysis dialog box, select Regression from
the Analysis Tools list and then click OK.

In the Regression dialog box (see below):

3. Enter C1:C15 as the Input Y Range and enter B1:B15
as the Input X Range.

4. Check Labels and check Confidence Level and enter
95 in its box.

5. Click New Worksheet Ply and then click OK.

EG13.3 MEASURES of VARIATION

The measures of variation are computed as part of creating
the simple linear regression worksheet using the Section
EG13.2 instructions.



In-Depth Excel Use the DURBIN_WATSON worksheet
of the Simple Linear Regression workbook, similar to the
worksheet shown in Figure 13.16 on page 545, as a template
for computing the Durbin-Watson statistic. The worksheet
computes the statistic for the package delivery simple linear
regression model. In cell B3, the worksheet uses the
expression SUMXMY2(cell range of the second through

last residual, cell range of the first through the second-to-

last residual) to compute the sum of squared difference of
the residuals, the numerator in Equation (13.15) on page 544,
and in cell B4 uses SUMSQ(cell range of the residuals) to
compute the sum of squared residuals, the denominator in
Equation (13.15).

To compute the Durbin-Watson statistic for other
problems, first create the simple linear regression model
and the RESIDUALS worksheet for the problem, using the
instructions in Sections EG13.2 and EG13.5. Then open the
DURBIN_WATSON worksheet and edit the formulas in cell
B3 and B4 to point to the proper cell ranges of the new
residuals.

EG13.7 INFERENCES ABOUT the SLOPE
and CORRELATION COEFFICIENT

The t test for the slope and F test for the slope are included
in the worksheet created by using the Section EG13.2
instructions. The t test computations in the worksheets
created by using the PHStat2 and In-Depth Excel
instructions are discussed in Section EG13.2. The F test
computations are discussed in Section EG13.3.

EG13.8 ESTIMATION of MEAN VALUES
and PREDICTION of INDIVIDUAL
VALUES

PHStat2 Use the Section EG13.2 PHStat2 instructions but
replace step 6 with these steps 6 and 7:

6. Check Confidence Int. Est. & Prediction Int. for
and enter 4 in its box. Enter 95 as the percentage for
Confidence level for intervals.

X �
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7. Enter a Title and click OK.

The additional worksheet created is discussed in the
following In-Depth Excel instructions.

In-Depth Excel Use the CIEandPI worksheet of the
Simple Linear Regression workbook, shown in Figure
13.21 on page 557, as a template for computing confidence
interval estimates and prediction intervals. The worksheet
contains the data and formulas for the Section 13.8
examples that use the Table 13.1 Sunflowers Apparel data.
The worksheet uses the expression TINV(1 � confidence

level, degrees of freedom) to compute the t critical value in
cell B10 and the expression TREND(Y variable cell range,
X variable cell range, X value) to compute the predicted Y
value for the X value in cell B15. In cell B12, the expression
DEVSQ(X variable cell range) computes the SSX value that
is used, in turn, to help compute the h statistic.

To compute a confidence interval estimate and predic-
tion interval for other problems:

1. Paste the regression data into the SLRData worksheet.
Use column A for the X variable data and column B for
the Y variable data.

2. Open to the CIEandPI worksheet.

In the CIEandPI worksheet:

3. Change values for the X Value and Confidence Level,
as is necessary.

4. Edit the cell ranges used in the cell B15 formula that
uses the TREND function to refer to the new cell ranges
for the Y and X variables.
To create a scatter plot similar to Figure 13.11 on page 540,

use the original X variable and the residuals (plotted as the
Y variable) as the chart data.
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MG13.1 TYPES of REGRESSION MODELS

There are no Minitab Guide instructions for this section.

MG13.2 DETERMINING the SIMPLE LINEAR
REGRESSION EQUATION

Use Regression to perform a simple linear regression
analysis. For example, to perform the Figure 13.4 analysis
of the Sunflowers Apparel data on page 526, open to the Site
worksheet. Select Stat ➔ Regression ➔ Regression. In the
Regression dialog box (shown below):

1. Double-click C3 Annual Sales in the variables list to
add 'Annual Sales' to the Response box.

2. Double-click C2 Square Feet in the variables list to
add 'Square Feet' to the Predictors box.

3. Click Graphs.

C H A P T E R 1 3 M I N I TA B G U I D E

8. Back in the Regression dialog box, click Results.

In the Regression - Results dialog box (not shown):

9. Click Regression equation, table of coefficients, s,
R-squared, and basic analysis of variance and then
click OK.

10. Back in the Regression dialog box, click Options.
In the Regression - Options dialog box (shown below):

11. Check Fit Intercept.

12. Clear all the Display and Lack of Fit Test check boxes.

13. Enter 4 in the Prediction intervals for new observa-
tions box.

14. Enter 95 in the Confidence level box.

15. Click OK.

16. Back in the Regression dialog box, click OK.

In the Regression - Graphs dialog box (shown below):

4. Click Regular (in Residuals for Plots) and Individual
Plots (in Residual Plots).

5. Check Histogram of residuals, Normal plot of residu-
als, Residuals versus fits, and Residuals versus order
and then press Tab.

6. Double-click C2 Square Feet in the variables list to
add 'Square Feet' in the Residuals versus the variables
box.

7. Click OK.

To create a scatter plot that contains a prediction line
and regression equation similar to Figure 13.5 on page 526,
use the Section MG2.6 scatter plot instructions with the
Table 13.1 Sunflowers Apparel data.

MG13.3 MEASURES of VARIATION

The measures of variation are computed in the Analysis of
Variance table that is part of the simple linear regression re-
sults created using the Section MG13.2 instructions.

MG13.4 ASSUMPTIONS

There are no Minitab Guide instructions for this section.

MG13.5 RESIDUAL ANALYSIS

Selections in step 5 of the Section MG13.2 instructions cre-
ate the residual plots and normal probability plots necessary
for residual analysis. To create the list of residual values
similar to column E in Figure 13.10 on page 540, replace step
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15 of the Section MG13.2 instructions with these steps 15
through 17:

15. Click Storage.

16. In the Regression - Storage dialog box, check Residuals
and then click OK.

17. Back in the Regression dialog box, click OK.

MG13.6 MEASURING AUTOCORRELATION:
the DURBIN-WATSON STATISTIC

To compute the Durbin-Watson statistic, use the Section
MG13.2 instructions but check Durbin-Watson statistic
(in the Regression - Options dialog box) as part of step 12.

MG13.7 INFERENCES ABOUT the SLOPE
and CORRELATION COEFFICIENT

The t test for the slope and F test for the slope are included in
the results created by using the Section MG13.2 instructions.

MG13.8 ESTIMATION of MEAN VALUES
and PREDICTION of INDIVIDUAL
VALUES

The confidence interval estimate and prediction interval are
included in the results created by using the Section MG13.2
instructions.
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Learning Objectives
In this chapter, you learn:

• How to develop a multiple regression model

• How to interpret the regression coefficients

• How to determine which independent variables to include in the regression model

• How to determine which independent variables are most important in predicting
a dependent variable

• How to use categorical independent variables in a regression model

• How to predict a categorical dependent variable using logistic regression

Introduction to Multiple
Regression14



You are the marketing manager for OmniFoods, a large
food products company. The company is planning a
nationwide introduction of OmniPower, a new high-
energy bar. Originally marketed to runners, mountain
climbers, and other athletes, high-energy bars are now

popular with the general public. OmniFoods is anxious to
capture a share of this thriving market.

Because the marketplace already contains
several successful energy bars, you need to

develop an effective marketing strategy. In
particular, you need to determine the effect

that price and in-store promotions will
have on sales of OmniPower. Before
marketing the bar nationwide, you plan
to conduct a test-market study of Om-
niPower sales, using a sample of 34
stores in a supermarket chain. How
can you extend the linear regression

methods discussed in Chapter 13 to in-
corporate the effects of price and promotion
into the same model? How can you use this
model to improve the success of the nation-
wide introduction of OmniPower?

U S I N G S TAT I S T I C S

@ OmniFoods
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C hapter 13 focused on simple linear regression models that use one numerical inde-
pendent variable, X, to predict the value of a numerical dependent variable, Y. Often
you can make better predictions by using more than one independent variable. This

chapter introduces you to multiple regression models that use two or more independent vari-
ables to predict the value of a dependent variable.

14.1 Developing a Multiple Regression Model
The business objective facing the marketing manager at OmniFoods is to develop a model to
predict monthly sales volume per store of OmniPower bars and to determine what variables
influence sales. Two independent variables are considered here: the price of an OmniPower bar,
as measured in cents and the monthly budget for in-store promotional expenditures,
measured in dollars In-store promotional expenditures typically include signs and
displays, in-store coupons, and free samples. The dependent variable Y is the number of
OmniPower bars sold in a month. Data are collected from a sample of 34 stores in a supermar-
ket chain selected for a test-market study of OmniPower. All the stores selected have approxi-
mately the same monthly sales volume. The data are organized and stored in and
presented in Table 14.1.

OmniPower

1X22.
1X12,

T A B L E 1 4 . 1

Monthly OmniPower
Sales, Price, and
Promotional
Expenditures

Store Sales Price Promotion Store Sales Price Promotion

1 4,141 59 200 18 2,730 79 400
2 3,842 59 200 19 2,618 79 400
3 3,056 59 200 20 4,421 79 400
4 3,519 59 200 21 4,113 79 600
5 4,226 59 400 22 3,746 79 600
6 4,630 59 400 23 3,532 79 600
7 3,507 59 400 24 3,825 79 600
8 3,754 59 400 25 1,096 99 200
9 5,000 59 600 26 761 99 200

10 5,120 59 600 27 2,088 99 200
11 4,011 59 600 28 820 99 200
12 5,015 59 600 29 2,114 99 400
13 1,916 79 200 30 1,882 99 400
14 675 79 200 31 2,159 99 400
15 3,636 79 200 32 1,602 99 400
16 3,224 79 200 33 3,354 99 600
17 2,295 79 400 34 2,927 99 600

Visualizing Multiple Regression Data
With the special case of two independent variables and one dependent variable, you can
visualize your data with a three-dimensional scatter plot. Figure 14.1 on page 579 presents
a three-dimensional Minitab plot of the OmniPower data. This figure shows the points plot-
ted at a height equal to their sales with drop lines down to their promotion expense and
price values.

Interpreting the Regression Coefficients
When there are several independent variables, you can extend the simple linear regression
model of Equation (13.1) on page 522 by assuming a linear relationship between each inde-
pendent variable and the dependent variable. For example, with k independent variables, the
multiple regression model is expressed in Equation (14.1).



14.1 Developing a Multiple Regression Model 579

Excel does not include the
capability to create three-
dimensional scatter plots.

F I G U R E 1 4 . 1
Minitab three-
dimensional plot of
monthly OmniPower
sales, price, and
promotional
expenditures

MULTIPLE REGRESSION MODEL WITH k INDEPENDENT VARIABLES

(14.1)

where

intercept

slope of Y with variable holding variables constant

slope of Y with variable holding variables constant

slope of Y with variable holding variables constant
.
.
.

slope of Y with variable holding variables constant

random error in Y for observation iei =

X1, X2, X3, Á , Xk-1Xk,bk =

X1, X2, X4, Á , XkX3,b3 =

X1, X3, Á , XkX2,b2 =

X2, X3, Á , XkX1,b1 =

b0 = Y

Yi = b0 + b1X1i + b2X2i + b3X3i + Á + bkXki + ei

Equation (14.2) defines the multiple regression model with two independent variables.

MULTIPLE REGRESSION MODEL WITH TWO INDEPENDENT VARIABLES

(14.2)

where

intercept

slope of Y with variable holding variable constant

slope of Y with variable holding variable constant

random error in Y for observation iei =

X1X2,b2 =

X2X1,b1 =

b0 = Y

Yi = b0 + b1X1i + b2X2i + ei
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F I G U R E 1 4 . 2
Excel and Minitab results for the OmniPower sales data multiple regression model

Compare the multiple regression model to the simple linear regression model [Equation
(13.1) on page 522]:

In the simple linear regression model, the slope, represents the change in the mean of Y
per unit change in X and does not take into account any other variables. In the multiple regres-
sion model with two independent variables [Equation (14.2)], the slope, represents the
change in the mean of Y per unit change in taking into account the effect of 

As in the case of simple linear regression, you use the least-squares method to compute
sample regression coefficients ( and ) as estimates of the population parameters
( and ). Equation (14.3) defines the regression equation for a multiple regression
model with two independent variables.

b2b0, b1,
b2b0, b1,

X2.X1,
b1,

b1,

Yi = b0 + b1Xi + ei

MULTIPLE REGRESSION EQUATION WITH TWO INDEPENDENT VARIABLES

(14.3)YNi = b0 + b1X1i + b2X2i

Figure 14.2 shows Excel and Minitab results for the OmniPower sales data multiple
regression model. From Figure 14.2, the computed values of the three regression
coefficients are

Therefore, the multiple regression equation is

where

predicted monthly sales of OmniPower bars for store i

price of OmniPower bar (in cents) for store i

monthly in-store promotional expenditures (in dollars) for store iX2i =

X1i =

YNi =

YNi = 5,837.5208 - 53.2173X1i + 3.6131X2i

b0 = 5,837.5208 b1 = -53.2173 b2 = 3.6131
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The sample Y intercept estimates the number of OmniPower bars sold
in a month if the price is $0.00 and the total amount spent on promotional expenditures is also
$0.00. Because these values of price and promotion are outside the range of price and promo-
tion used in the test-market study, and because they make no sense in the context of the prob-
lem, the value of has little or no practical interpretation.

The slope of price with OmniPower sales indicates that, for a given
amount of monthly promotional expenditures, the predicted sales of OmniPower are estimated
to decrease by 53.2173 bars per month for each 1-cent increase in the price. The slope of
monthly promotional expenditures with OmniPower sales indicates that, for a
given price, the estimated sales of OmniPower are predicted to increase by 3.6131 bars for
each additional $1 spent on promotions. These estimates allow you to better understand the
likely effect that price and promotion decisions will have in the marketplace. For example, a
10-cent decrease in price is predicted to increase sales by 532.173 bars, with a fixed amount of
monthly promotional expenditures. A $100 increase in promotional expenditures is predicted
to increase sales by 361.31 bars, for a given price.

Regression coefficients in multiple regression are called net regression coefficients; they
estimate the predicted change in Y per unit change in a particular X, holding constant the ef-
fect of the other X variables. For example, in the study of OmniPower bar sales, for a store with
a given amount of promotional expenditures, the estimated sales are predicted to decrease by
53.2173 bars per month for each 1-cent increase in the price of an OmniPower bar. Another
way to interpret this “net effect” is to think of two stores with an equal amount of promotional
expenditures. If the first store charges 1 cent more than the other store, the net effect of this
difference is that the first store is predicted to sell 53.2173 fewer bars per month than the
second store. To interpret the net effect of promotional expenditures, you can consider two
stores that are charging the same price. If the first store spends $1 more on promotional
expenditures, the net effect of this difference is that the first store is predicted to sell 3.6131
more bars per month than the second store.

Predicting the Dependent Variable Y
You can use the multiple regression equation to predict values of the dependent variable. For
example, what are the predicted sales for a store charging 79 cents during a month in which
promotional expenditures are $400? Using the multiple regression equation,

with and

Thus, you predict that stores charging 79 cents and spending $400 in promotional expenditures
will sell 3,078.57 OmniPower bars per month.

After you have developed the regression equation, done a residual analysis (see Section
14.3), and determined the significance of the overall fitted model (see Section 14.2), you can
construct a confidence interval estimate of the mean value and a prediction interval for an in-
dividual value. You should rely on software to do these computations for you, given the com-
plex nature of the computations. Figure 14.3 presents an Excel worksheet that computes a
confidence interval estimate and a prediction interval for the OmniPower sales data. (The
Minitab results in Figure 14.2 include these computations.)

= 3,078.57

YNi = 5,837.5208 - 53.2173(79) + 3.613114002
X2i = 400,X1i = 79

YNi = 5,837.5208 - 53.2173X1i + 3.6131X2i

1b2 = 3.61312

1b1 = -53.21732b0

1b0 = 5,837.52082
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F I G U R E 1 4 . 3
Excel confidence interval
estimate and prediction
interval worksheet for the
OmniPower sales data

Problems for Section 14.1
LEARNING THE BASICS
14.1 For this problem, use the following multiple regres-
sion equation:

a. Interpret the meaning of the slopes.
b. Interpret the meaning of the Y intercept.

14.2 For this problem, use the following multiple regres-
sion equation:

YNi = 50 - 2X1i + 7X2i

YNi = 10 + 5X1i + 3X2i

a. Interpret the meaning of the slopes.
b. Interpret the meaning of the Y intercept.

APPLYING THE CONCEPTS
14.3 A shoe manufacturer is considering developing a new
brand of running shoes. The business problem facing the
marketing analyst is to determine which variables should be
used to predict durability (i.e., the effect of long-term im-
pact). Two independent variables under consideration are

(FOREIMP), a measurement of the forefoot shock-
absorbing capability, and (MIDSOLE), a measurementX2

X1

The 95% confidence interval estimate of the mean OmniPower sales for all stores
charging 79 cents and spending $400 in promotional expenditures is 2,854.07 to 3,303.08
bars. The prediction interval for an individual store is 1,758.01 to 4,399.14 bars.
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Variable Coefficients
Standard

Error t Statistic p-Value

Intercept -0.02686 0.06905 -0.39 0.7034
Foreimp 0.79116 0.06295 12.57 0.0000
Midsole 0.60484 0.07174 8.43 0.0000

a. State the multiple regression equation.
b. Interpret the meaning of the slopes, and in this

problem.

14.4 A mail-order catalog business selling per-
sonal computer supplies, software, and hardware

maintains a centralized warehouse. Management is cur-
rently examining the process of distribution from the ware-
house. The business problem facing management relates to
the factors that affect warehouse distribution costs. Cur-
rently, a small handling fee is added to each order, regard-
less of the amount of the order. Data collected over the past
24 months (stored in ) indicate the warehouse
distribution costs (in thousands of dollars), the sales (in
thousands of dollars), and the number of orders received.
a. State the multiple regression equation.
b. Interpret the meaning of the slopes, and in this

problem.
c. Explain why the regression coefficient, has no practi-

cal meaning in the context of this problem.
d. Predict the monthly warehouse distribution cost when

sales are $400,000 and the number of orders is 4,500.
e. Construct a 95% confidence interval estimate for the

mean monthly warehouse distribution cost when sales are
$400,000 and the number of orders is 4,500.

f. Construct a 95% prediction interval for the monthly
warehouse distribution cost for a particular month when
sales are $400,000 and the number of orders is 4,500.

g. Explain why the interval in (e) is narrower than the inter-
val in (f).

14.5 How does horsepower and weight affect the mileage
of family sedans? Data from a sample of twenty 2010 fam-
ily sedans were collected and organized and stored in

. (Data extracted from “Top 2010 Cars,”
Consumer Reports, April 2010, pp. 38–70.) Develop a re-
gression model to predict mileage (as measured by miles
per gallon) based on the horsepower of the car’s engine and
the weight of the car (in pounds).
a. State the multiple regression equation.
b. Interpret the meaning of the slopes, and in this

problem.
c. Explain why the regression coefficient, has no practi-

cal meaning in the context of this problem.
b0,

b2,b1

Auto2010

b0,

b2,b1

WareCost

SELF
Test

b2,b1

of the change in impact properties over time. The dependent
variable Y is LTIMP, a measure of the shoe’s durability after
a repeated impact test. Data are collected from a random
sample of 15 types of currently manufactured running
shoes, with the following results:

d. Predict the miles per gallon for cars that have 190 horse-
power and weigh 3,500 pounds.

e. Construct a 95% confidence interval estimate for the
mean miles per gallon for cars that have 190 horsepower
and weigh 3,500 pounds.

f. Construct a 95% prediction interval for the miles per gal-
lon for an individual car that has 190 horsepower and
weighs 3,500 pounds.

14.6 The business problem facing a consumer products
company is to measure the effectiveness of different types
of advertising media in the promotion of its products.
Specifically, the company is interested in the effectiveness
of radio advertising and newspaper advertising (including
the cost of discount coupons). During a one month test
period, data were collected from a sample of 22 cities with
approximately equal populations. Each city is allocated a
specific expenditure level for radio advertising and for
newspaper advertising. The sales of the product (in thou-
sands of dollars) and also the levels of media expendi-
ture (in thousands of dollars) during the test month are
recorded, with the following results shown below and stored
in :Advertise

City
Sales

($Thousands)

Radio
Adverting

($Thousands)

Newspaper
Advertising

($Thousands)

1 973 0 40
2 1,119 0 40
3 875 25 25
4 625 25 25
5 910 30 30
6 971 30 30
7 931 35 35
8 1,177 35 35
9 882 40 25

10 982 40 25
11 1,628 45 45
12 1,577 45 45
13 1,044 50 0
14 914 50 0
15 1,329 55 25
16 1,330 55 25
17 1,405 60 30
18 1,436 60 30
19 1,521 65 35
20 1,741 65 35
21 1,866 70 40
22 1,717 70 40

a. State the multiple regression equation.
b. Interpret the meaning of the slopes, and in this

problem.
c. Interpret the meaning of the regression coefficient,
d. Which type of advertising is more effective? Explain.

b0.

b2,b1
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14.7 The business problem facing the director of broad-
casting operations for a television station was the issue of
standby hours (i.e., hours in which unionized graphic artists
at the station are paid but are not actually involved in any
activity) and what factors were related to standby hours. The
study included the following variables:

Standby hours (Y )—Total number of standby hours in a
week

Total staff present —Weekly total of people-days
Remote hours —Total number of hours worked by

employees at locations away from the central plant

Data were collected for 26 weeks; these data are organized
and stored in .
a. State the multiple regression equation.
b. Interpret the meaning of the slopes, and in this

problem.
c. Explain why the regression coefficient, has no practi-

cal meaning in the context of this problem.
d. Predict the standby hours for a week in which the total

staff present have 310 people-days and the remote hours
are 400.

e. Construct a 95% confidence interval estimate for the mean
standby hours for weeks in which the total staff present
have 310 people-days and the remote hours are 400.

b0,

b2,b1

Standby

1X22
1X12

f. Construct a 95% prediction interval for the standby hours
for a single week in which the total staff present have 310
people-days and the remote hours are 400.

14.8 Nassau County is located approximately 25 miles east
of New York City. The data organized and stored in
include the appraised value, land area of the property in
acres, and age, in years, for a sample of 30 single-family
homes located in Glen Cove, a small city in Nassau County.
Develop a multiple linear regression model to predict ap-
praised value based on land area of the property and age, in
years.
a. State the multiple regression equation.
b. Interpret the meaning of the slopes, and in this

problem.
c. Explain why the regression coefficient, has no practi-

cal meaning in the context of this problem.
d. Predict the appraised value for a house that has a land

area of 0.25 acres and is 45 years old.
e. Construct a 95% confidence interval estimate for the

mean appraised value for houses that have a land area of
0.25 acres and are 45 years old.

f. Construct a 95% prediction interval estimate for the ap-
praised value for an individual house that has a land area
of 0.25 acres and is 45 years old.

b0,

b2,b1

GlenCove

14.2 r 2, Adjusted r 2, and the Overall F Test
This section discusses three methods you can use to evaluate the overall multiple regression
model: the coefficient of multiple determination, the adjusted and the overall F test.

Coefficient of Multiple Determination
Recall from Section 13.3 that the coefficient of determination, measures the proportion of
the variation in Y that is explained by the independent variable X in the simple linear regres-
sion model. In multiple regression, the coefficient of multiple determination represents the
proportion of the variation in Y that is explained by the set of independent variables. Equation
(14.4) defines the coefficient of multiple determination for a multiple regression model with
two or more independent variables.

r2,

r2,r2,

COEFFICIENT OF MULTIPLE DETERMINATION
The coefficient of multiple determination is equal to the regression sum of squares (SSR)
divided by the total sum of squares (SST).

(14.4)

where

regression sum of squares

total sum of squaresSST =

SSR =

r2 =
Regression sum of squares

Total sum of squares
=

SSR

SST



14.2 , Adjusted , and the Overall F Test 585r 2r 2

In the OmniPower example, from Figure 14.2 on page 580, and
Thus,

The coefficient of multiple determination indicates that 75.77% of the varia-
tion in sales is explained by the variation in the price and in the promotional expenditures. The
coefficient of multiple determination also appears in the Figure 14.2 results on page 580, and is
labeled R Square in the Excel results and R-Sq in the Minitab results.

Adjusted
When considering multiple regression models, some statisticians suggest that you should use
the adjusted to take into account both the number of independent variables in the model
and the sample size. Reporting the adjusted is extremely important when you are comparing
two or more regression models that predict the same dependent variable but have a different
number of independent variables. Equation (14.5) defines the adjusted r2.

r2
r 2

r2

1r2 = 0.75772
r2 =

SSR

SST
=

39,472,730.77

52,093,677.44
= 0.7577

SST = 52,093,677.44.
SSR = 39,472,730.77

ADJUSTED

(14.5)

where k is the number of independent variables in the regression equation.

r2
adj = 1 - c11 - r22 n - 1

n - k - 1
d

r 2

Thus, for the OmniPower data, because and

Therefore, 74.21% of the variation in sales is explained by the multiple regression model—
adjusted for the number of independent variables and sample size. The adjusted also appears
in the Figure 14.2 results on page 580, and is labeled Adjusted R Square in the Excel results and
R-Sq(adj) in the Minitab results.

Test for the Significance of the Overall Multiple Regression
Model
You use the overall F test to determine whether there is a significant relationship between the
dependent variable and the entire set of independent variables (the overall multiple regression
model). Because there is more than one independent variable, you use the following null and
alternative hypotheses:

(There is no linear relationship between the dependent
variable and the independent variables.)

(There is a linear relationship between the
dependent variable and at least one of the
independent variables.)

H1: At least one bj Z 0, j = 1, 2, Á , k

H0: b1 = b2 = Á = bk = 0

r2

= 0.7421

= 1 - 0.2579

= 1 - c10.2423233
31
d

r2
adj = 1 - c11 - 0.75772 34 - 1

34 - 2 - 1
d

k = 2,r2 = 0.7577, n = 34,
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T A B L E 1 4 . 2

ANOVA Summary Table
for the Overall F Test

Source
Degrees of 
Freedom Sum of Squares Mean Squares (Variance) F

Regression k SSR MSR =
SSR

k
FSTAT =

MSR

MSE

Error n - k - 1 SSE MSE =
SSE

n - k - 1

Total n - 1 SST

0 3.32

.95

.05

Region of
Nonrejection

F

Critical
Value

Region of
Rejection

F I G U R E 1 4 . 4
Testing for the
significance of a set of
regression coefficients at
the 0.05 level of
significance, with 2 and
31 degrees of freedom

OVERALL F TEST
The test statistic is equal to the regression mean square (MSR) divided by the mean
square error (MSE).

(14.6)

where

test statistic from an F distribution with k and degrees of
freedom

number of independent variables in the regression modelk =

n - k - 1FSTAT =

FSTAT =
MSR

MSE

FSTAT

The decision rule is

Using a 0.05 level of significance, the critical value of the F distribution with 2 and 31 de-
grees of freedom found from Table E.5 is approximately 3.32 (see Figure 14.4 below). From
Figure 14.2 on page 580, the test statistic given in the ANOVA summary table is 48.4771.
Because or because the you reject and con-
clude that at least one of the independent variables (price and/or promotional expenditures) is
related to sales.

H0p-value = 0.000 6 0.05,48.4771 7 3.32,
FSTAT

otherwise, do not reject H0.

Reject H0 at the a level of significance if FSTAT 7 Fa;

Equation (14.6) defines the overall F test statistic. Table 14.2 presents the ANOVA
summary table.
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Problems for Section 14.2
LEARNING THE BASICS
14.9 The following ANOVA summary table is for a multi-
ple regression model with two independent variables:

a. Determine the regression mean square (MSR) and the
mean square error (MSE).

b. Compute the overall test statistic.
c. Determine whether there is a significant relationship be-

tween Y and the two independent variables at the 0.05
level of significance.

d. Compute the coefficient of multiple determination,
and interpret its meaning.

e. Compute the adjusted 

14.10 The following ANOVA summary table is for a mul-
tiple regression model with two independent variables:

r2.

r2,

FSTAT

Source
Degrees of 
Freedom

Sum of
Squares

Mean
Squares F

Regression 2 60
Error 18 120
Total 20 180

Source
Degrees of 
Freedom

Sum of
Squares

Mean
Squares F

Regression 2 30
Error 10 120
Total 12 150

a. Determine the regression mean square (MSR) and the
mean square error (MSE).

b. Compute the overall test statistic.
c. Determine whether there is a significant relationship be-

tween Y and the two independent variables at the 0.05
level of significance.

d. Compute the coefficient of multiple determination,
and interpret its meaning.

e. Compute the adjusted 

APPLYING THE CONCEPTS
14.11 Eileen M. Van Aken and Brian M. Kleiner, professors
at Virginia Polytechnic Institute and State University, investi-
gated the factors that contribute to the effectiveness of teams.
(Data extracted from “Determinants of Effectiveness for Cross-
Functional Organizational Design Teams,” Quality Manage-
ment Journal, 4 (1997), 51–79.) The researchers studied 34
independent variables, such as team skills, diversity, meeting
frequency, and clarity in expectations. For each of the teams
studied, each of the variables was given a value of 1 through
100, based on the results of interviews and survey data, where

r2.

r2,

FSTAT

100 represents the highest rating. The dependent variable, team
performance, was also given a value of 1 through 100, with 100
representing the highest rating. Many different regression mod-
els were explored, including the following:

Model 1

Model 2

Model 3

a. Interpret the adjusted for each of the three models.
b. Which of these three models do you think is the best pre-

dictor of team performance?
14.12 In Problem 14.3 on page 582, you predicted the dura-

bility of a brand of running shoe, based on the forefoot
shock-absorbing capability and the change in impact
properties over time. The regression analysis resulted in
the following ANOVA summary table:

r2

r2
adj = 0.97

+ b2 1Clarity in expectations2 + e
Team performance = b0 + b1 1Team skills2

r2
adj = 0.78

Team performance = b0 + b1 1Clarity in expectations2 + e

r2
adj = 0.68

Team performance = b0 + b1 1Team skills2 + e

Source
Degrees of 
Freedom

Sum of
Squares

Mean
Squares F p-Value

Regression 2 12.61020 6.30510 97.69 0.0001
Error 12 0.77453 0.06454
Total 14 13.38473

a. Determine whether there is a significant relationship be-
tween durability and the two independent variables at the
0.05 level of significance.

b. Interpret the meaning of the p-value.
c. Compute the coefficient of multiple determination,

and interpret its meaning.
d. Compute the adjusted 

14.13 In Problem 14.5 on page 583, you used horsepower
and weight to predict mileage (stored in ). Using
the results from that problem,
a. determine whether there is a significant relationship be-

tween mileage and the two independent variables (horse-
power and weight) at the 0.05 level of significance.

b. interpret the meaning of the p-value.
c. compute the coefficient of multiple determination,

and interpret its meaning.
d. compute the adjusted r2.

r2,

Auto2010

r2.

r2,
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14.14 In Problem 14.4 on page 583, you used
sales and number of orders to predict distribution

costs at a mail-order catalog business (stored in ).
Use the results from that problem.
a. Determine whether there is a significant relationship

between distribution costs and the two independent
variables (sales and number of orders) at the 0.05 level of
significance.

b. Interpret the meaning of the p-value.
c. Compute the coefficient of multiple determination,

and interpret its meaning.
d. Compute the adjusted 

14.15 In Problem 14.7 on page 584, you used the total staff
present and remote hours to predict standby hours (stored in

). Use the results from that problem.
a. Determine whether there is a significant relationship be-

tween standby hours and the two independent variables
(total staff present and remote hours) at the 0.05 level of
significance.

b. Interpret the meaning of the p-value.
c. Compute the coefficient of multiple determination,

and interpret its meaning.
d. Compute the adjusted r2.

r2,

Standby

r2.

r2,

WareCost

SELF
Test

14.16 In Problem 14.6 on page 583, you used radio adver-
tising and newspaper advertising to predict sales (stored in

). Use the results from that problem.
a. Determine whether there is a significant relationship be-

tween sales and the two independent variables (radio ad-
vertising and newspaper advertising) at the 0.05 level of
significance.

b. Interpret the meaning of the p-value.
c. Compute the coefficient of multiple determination,

and interpret its meaning.
d. Compute the adjusted 

14.17 In Problem 14.8 on page 584, you used the land area of
a property and the age of a house to predict appraised value
(stored in ). Use the results from that problem.
a. Determine whether there is a significant relationship be-

tween appraised value and the two independent variables
(land area of a property and age of a house) at the 0.05
level of significance.

b. Interpret the meaning of the p-value.
c. Compute the coefficient of multiple determination,

and interpret its meaning.
d. Compute the adjusted r2.

r2,

GlenCove

r2.

r2,

Advertise

14.3 Residual Analysis for the Multiple Regression Model
In Section 13.5, you used residual analysis to evaluate the fit of the simple linear regression
model. For the multiple regression model with two independent variables, you need to con-
struct and analyze the following residual plots:

1. Residuals versus
2. Residuals versus
3. Residuals versus
4. Residuals versus time

The first residual plot examines the pattern of residuals versus the predicted values of Y. If the
residuals show a pattern for the predicted values of Y, there is evidence of a possible curvilinear ef-
fect (see Section 15.1) in at least one independent variable, a possible violation of the assumption
of equal variance (see Figure 13.13 on page 542), and/or the need to transform the Y variable.

The second and third residual plots involve the independent variables. Patterns in the plot
of the residuals versus an independent variable may indicate the existence of a curvilinear
effect and, therefore, the need to add a curvilinear independent variable to the multiple regres-
sion model (see Section 15.1).

The fourth plot is used to investigate patterns in the residuals in order to validate the inde-
pendence assumption when the data are collected in time order. Associated with this residual
plot, as in Section 13.6, you can compute the Durbin-Watson statistic to determine the exis-
tence of positive autocorrelation among the residuals.

Figure 14.5 presents the residual plots for the OmniPower sales example. There is very lit-
tle or no pattern in the relationship between the residuals and the predicted value of Y, the
value of (price), or the value of (promotional expenditures). Thus, you can conclude that
the multiple regression model is appropriate for predicting sales. There is no need to plot the
residuals versus time because the data were not collected in time order.

X2X1

X2i

X1i

YNi
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F I G U R E 1 4 . 5
Residual plots for the OmniPower sales data: Panel A, residuals versus predicted Y; Panel B, residuals versus price;
Panel C, residuals versus promotional expenditures

Problems for Section 14.3
APPLYING THE CONCEPTS
14.18 In Problem 14.4 on page 583, you used sales and
number of orders to predict distribution costs at a mail-or-
der catalog business (stored in ).
a. Plot the residuals versus .
b. Plot the residuals versus
c. Plot the residuals versus
d. Plot the residuals versus time.
e. In the residual plots created in (a) through (d), is there

any evidence of a violation of the regression assump-
tions? Explain.

f. Determine the Durbin-Watson statistic.
g. At the 0.05 level of significance, is there evidence of pos-

itive autocorrelation in the residuals?

14.19 In Problem 14.5 on page 583, you used horsepower
and weight to predict mileage (stored in ).Auto2010

X2i.
X1i.
YNi

WareCost

a. Plot the residuals versus
b. Plot the residuals versus
c. Plot the residuals versus
d. In the residual plots created in (a) through (c), is there any

evidence of a violation of the regression assumptions?
Explain.

e. Should you compute the Durbin-Watson statistic for
these data? Explain.

14.20 In Problem 14.6 on page 583, you used radio adver-
tising and newspaper advertising to predict sales (stored in

).
a. Perform a residual analysis on your results.
b. If appropriate, perform the Durbin-Watson test, using

c. Are the regression assumptions valid for these data?
a = 0.05.

Advertise

X2i.
X1i.
YNi

Panel A

Panel B Panel C
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14.21 In Problem 14.7 on page 584, you used the total
staff present and remote hours to predict standby hours
(stored in ).
a. Perform a residual analysis on your results.
b. If appropriate, perform the Durbin-Watson test, using

c. Are the regression assumptions valid for these data?
a = 0.05.

Standby

14.4 Inferences Concerning the Population Regression
Coefficients

In Section 13.7, you tested the slope in a simple linear regression model to determine the
significance of the relationship between X and Y. In addition, you constructed a confidence
interval estimate of the population slope. This section extends those procedures to multiple
regression.

Tests of Hypothesis
In a simple linear regression model, to test a hypothesis concerning the population slope,
you used Equation (13.16) on page 548:

Equation (14.7) generalizes this equation for multiple regression.

tSTAT =
b1 - b1

Sb1

b1,

14.22 In Problem 14.8 on page 584, you used the land area
of a property and the age of a house to predict appraised
value (stored in ).
a. Perform a residual analysis on your results.
b. If appropriate, perform the Durbin-Watson test, using

c. Are the regression assumptions valid for these data?
a = 0.05.

GlenCove

TESTING FOR THE SLOPE IN MULTIPLE REGRESSION

(14.7)

where

slope of variable j with Y, holding constant the effects of all other
independent variables

standard error of the regression coefficient

test statistic for a t distribution with degrees of freedom

number of independent variables in the regression equation

hypothesized value of the population slope for variable j, holding
constant the effects of all other independent variables

bj =

k =

n-k-1tSTAT =

bjSbj
=

bj =

tSTAT =
bj - bj

Sbj

To determine whether variable (amount of promotional expenditures) has a significant
effect on sales, taking into account the price of OmniPower bars, the null and alternative
hypotheses are

From Equation (14.7) and Figure 14.2 on page 580,

=
3.6131 - 0

0.6852
= 5.2728

tSTAT =
b2 - b2

Sb2

H1: b2 Z 0

H0: b2 = 0

X2
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If you select a level of significance of 0.05, the critical values of t for 31 degrees of freedom
from Table E.3 are and (see Figure 14.6).+2.0395-2.0395

–2.0395 +2.03950 t
Region of
Rejection

Critical
Value

Region of
Nonrejection

Critical
Value

Region of
Rejection

F I G U R E 1 4 . 6
Testing for significance of
a regression coefficient
at the 0.05 level of
significance, with 31
degrees of freedom

From Figure 14.2 on page 580, observe that the computed test statistic is 5.2728. Be-
cause or because the p-value is approximately zero, you reject
and conclude that there is a significant relationship between the variable (promotional ex-
penditures) and sales, taking into account the price, The extremely small p-value allows
you to strongly reject the null hypothesis that there is no linear relationship between sales and
promotional expenditures. Example 14.1 presents the test for the significance of the slope
of sales with price.

b1,

X1.
X2

H0tSTAT = 5.2728 7 2.0395
tSTAT

At the 0.05 level of significance, is there evidence that the slope of sales with price is different
from zero?

SOLUTION From Figure 14.2 on page 580, (the critical value
for ) or the p-value Thus, there is a significant relationship be-
tween price, and sales, taking into account the promotional expenditures, X2.X1,

= 0.0000 6 0.05.a = 0.05
tSTAT = -7.7664 6 -2.0395

EXAMPLE 14.1
Testing for the
Significance of the
Slope of Sales with
Price

As shown with these two independent variables, the test of significance for a specific regres-
sion coefficient in multiple regression is a test for the significance of adding that variable into
a regression model, given that the other variable is included. In other words, the t test for the
regression coefficient is actually a test for the contribution of each independent variable.

Confidence Interval Estimation
Instead of testing the significance of a population slope, you may want to estimate the value of
a population slope. Equation (14.8) defines the confidence interval estimate for a population
slope in multiple regression.

CONFIDENCE INTERVAL ESTIMATE FOR THE SLOPE

(14.8)

where is the critical value corresponding to an upper-tail probability of from the
t distribution with degrees of freedom (i.e., a cumulative area of and
k is the number of independent variables.

1 - a>2),n-k-1
a>2ta>2

bj ; ta>2Sbj

To construct a 95% confidence interval estimate of the population slope, (the effect of
price, on sales, Y, holding constant the effect of promotional expenditures, ), the criticalX2X1,

b1



Construct a 95% confidence interval estimate of the population slope of sales with promo-
tional expenditures.

SOLUTION The critical value of t at the 95% confidence level, with 31 degrees of freedom,
is 2.0395 (see Table E.3). Using Equation (14.8) and Figure 14.2 on page 580,

Thus, taking into account the effect of price, the estimated effect of each additional dollar of
promotional expenditures is to increase mean sales by approximately 2.22 to 5.01 bars. You
have 95% confidence that this interval correctly estimates the relationship between these vari-
ables. From a hypothesis-testing viewpoint, because this confidence interval does not include
0, you can conclude that the regression coefficient, has a significant effect.b2,

 2.2156 … b2 … 5.0106

 3.6131 ; 1.3975

 3.6131 ; 12.0395210.68522
b2 ; ta>2Sb2

EXAMPLE 14.2
Constructing a
Confidence Interval
Estimate for the
Slope of Sales with
Promotional
Expenditures
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value of t at the 95% confidence level with 31 degrees of freedom is 2.0395 (see Table E.3).
Then, using Equation (14.8) and Figure 14.2 on page 580,

Taking into account the effect of promotional expenditures, the estimated effect of a 1-
cent increase in price is to reduce mean sales by approximately 39.2 to 67.2 bars. You have
95% confidence that this interval correctly estimates the relationship between these variables.
From a hypothesis-testing viewpoint, because this confidence interval does not include 0, you
conclude that the regression coefficient, has a significant effect.

Example 14.2 constructs and interprets a confidence interval estimate for the slope of
sales with promotional expenditures.

b1,

-67.1925 … b1 … -39.2421

-53.2173 ; 13.9752

-53.2173 ; 12.0395216.85222
b1 ; ta>2Sb1

Problems for Section 14.4
LEARNING THE BASICS
14.23 Use the following information from a multiple re-
gression analysis:

a. Which variable has the largest slope, in units of a t statistic?
b. Construct a 95% confidence interval estimate of the pop-

ulation slope, 
c. At the 0.05 level of significance, determine whether

each independent variable makes a significant contribu-
tion to the regression model. On the basis of these re-
sults, indicate the independent variables to include in
this model.

b1.

n = 25 b1 = 5 b2 = 10 Sb1
= 2 Sb2

= 8

14.24 Use the following information from a multiple re-
gression analysis:

a. Which variable has the largest slope, in units of a t
statistic?

b. Construct a 95% confidence interval estimate of the pop-
ulation slope, 

c. At the 0.05 level of significance, determine whether
each independent variable makes a significant contribu-
tion to the regression model. On the basis of these
results, indicate the independent variables to include in
this model.

b1.

n = 20 b1 = 4 b2 = 3 Sb1
= 1.2 Sb2

= 0.8
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APPLYING THE CONCEPTS
14.25 In Problem 14.3 on page 582, you predicted the dura-
bility of a brand of running shoe, based on the forefoot
shock-absorbing capability (FOREIMP) and the change in
impact properties over time (MIDSOLE) for a sample of 15
pairs of shoes. Use the following results:

Variable Coefficient
Standard

Error t Statistic p-value

Intercept -0.02686 0.06905 -0.39 0.7034
Foreimp 0.79116 0.06295 12.57 0.0000
Midsole 0.60484 0.07174 8.43 0.0000

a. Construct a 95% confidence interval estimate of the pop-
ulation slope between durability and forefoot shock-ab-
sorbing capability.

b. At the 0.05 level of significance, determine whether each
independent variable makes a significant contribution to
the regression model. On the basis of these results, indi-
cate the independent variables to include in this model.

14.26 In Problem 14.4 on page 583, you used
sales and number of orders to predict distribution

costs at a mail-order catalog business (stored in ).
Use the results from that problem.
a. Construct a 95% confidence interval estimate of the pop-

ulation slope between distribution cost and sales.
b. At the 0.05 level of significance, determine whether each

independent variable makes a significant contribution to
the regression model. On the basis of these results, indi-
cate the independent variables to include in this model.

14.27 In Problem 14.5 on page 583, you used horsepower
and weight to predict mileage (stored in ). Use
the results from that problem.

Auto2010

WareCost

SELF
Test

a. Construct a 95% confidence interval estimate of the pop-
ulation slope between mileage and horsepower.

b. At the 0.05 level of significance, determine whether each
independent variable makes a significant contribution to
the regression model. On the basis of these results, indi-
cate the independent variables to include in this model.

14.28 In Problem 14.6 on page 583, you used radio adver-
tising and newspaper advertising to predict sales (stored in

). Use the results from that problem.
a. Construct a 95% confidence interval estimate of the pop-

ulation slope between sales and radio advertising.
b. At the 0.05 level of significance, determine whether each

independent variable makes a significant contribution to
the regression model. On the basis of these results, indi-
cate the independent variables to include in this model.

14.29 In Problem 14.7 on page 584, you used the total num-
ber of staff present and remote hours to predict standby hours
(stored in ). Use the results from that problem.
a. Construct a 95% confidence interval estimate of the pop-

ulation slope between standby hours and total number of
staff present.

b. At the 0.05 level of significance, determine whether each
independent variable makes a significant contribution to
the regression model. On the basis of these results, indi-
cate the independent variables to include in this model.

14.30 In Problem 14.8 on page 584, you used land area of
a property and age of a house to predict appraised value
(stored in ). Use the results from that problem.
a. Construct a 95% confidence interval estimate of the pop-

ulation slope between appraised value and land area of a
property.

b. At the 0.05 level of significance, determine whether each
independent variable makes a significant contribution to
the regression model. On the basis of these results, indi-
cate the independent variables to include in this model.

GlenCove

Standby

Advertise

14.5 Testing Portions of the Multiple Regression Model
In developing a multiple regression model, you want to use only those independent variables
that significantly reduce the error in predicting the value of a dependent variable. If an
independent variable does not improve the prediction, you can delete it from the multiple
regression model and use a model with fewer independent variables.

The partial F test is an alternative method to the t test discussed in Section 14.4 for
determining the contribution of an independent variable. Using this method, you determine the
contribution to the regression sum of squares made by each independent variable after all the
other independent variables have been included in the model. The new independent variable is
included only if it significantly improves the model.

To conduct partial F tests for the OmniPower sales example, you need to evaluate the con-
tribution of promotional expenditures after price has been included in the model,
and also evaluate the contribution of price after promotional expenditures have been
included in the model.

1X221X12
1X121X22



DETERMINING THE CONTRIBUTION OF AN INDEPENDENT VARIABLE TO
THE REGRESSION MODEL

(14.9)SSR1Xj|All Xs except j2 = SSR 1All Xs2 - SSR 1All Xs except j2

If there are two independent variables, you use Equations (14.10a) and (14.10b) to
determine the contribution of each.

CONTRIBUTION OF VARIABLE GIVEN THAT HAS BEEN INCLUDED

(14.10a)

CONTRIBUTION OF VARIABLE GIVEN THAT HAS BEEN INCLUDED

(14.10b)SSR1X2|X12 = SSR1X1 and X22 - SSR1X12
X1X2,

SSR1X1|X22 = SSR1X1 and X22 - SSR1X22
X2X1,

The term SSR represents the sum of squares due to regression for a model that
includes only the independent variable (promotional expenditures). Similarly,
represents the sum of squares due to regression for a model that includes only the independent
variable (price). Figures 14.7 and 14.8 present results for these two models.

From Figure 14.7, and from Figure 14.2 on page 580, SSR (
and Then, using Equation (14.10a),

= 24,556,916.67

= 39,472,730.77 - 14,915,814.10

SSR1X1|X22 = SSR1X1 andX22 - SSR1X22
X2) = 39,472,730.77.

X1SSR1X22 = 14,915,814.10
X1

SSR1X12X2

1X22

In general, if there are several independent variables, you determine the contribution of
each independent variable by taking into account the regression sum of squares of a model that
includes all independent variables except the one of interest, j. This regression sum of squares
is denoted SSR (all Xs except j). Equation (14.9) determines the contribution of variable j,
assuming that all other variables are already included.

594 CHAPTER 14 Introduction to Multiple Regression

F I G U R E 1 4 . 7
Excel and Minitab regression results for a simple linear regression model of sales with promotional expenditures,
SSR1X22
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F I G U R E 1 4 . 8
Excel and Minitab regression results for a simple linear regression model of sales with price, SSR1X12

T A B L E 1 4 . 3

ANOVA Table Dividing
the Regression Sum of
Squares into
Components to
Determine the
Contribution of 
Variable X1

Source
Degrees of 
Freedom

Sum of 
Squares

Mean Square
(Variance) F

Regression 2 39,472,730.77 19,736,365.39b X2

X1|X2
r b1

1
r b14,915,814.10

24,556,916.67
r 24,556,916.67 60.32

Error 31 12,620,946.67 407,127.31
Total 33 52,093,677.44

To determine whether significantly improves the model after has been included, you
divide the regression sum of squares into two component parts, as shown in Table 14.3.

X2X1

PARTIAL F TEST STATISTIC

(14.11)

The partial F test statistic follows an F distribution with 1 and degrees of freedom.n-k-1

FSTAT =
SSR1Xj|All Xs except j2

MSE

The null and alternative hypotheses to test for the contribution of to the model are

Equation (14.11) defines the partial F test statistic for testing the contribution of an
independent variable.

H1: Variable X1 significantly improves the model after variable X2 has been included.

H0: Variable X1 does not significantly improve the model after variable X2 has been included.

X1

From Table 14.3,

The partial test statistic has 1 and degrees of freedom. Us-
ing a level of significance of 0.05, the critical value from Table E.5 is approximately 4.17
(see Figure 14.9).

n-k-1 = 34-2-1 = 31FSTAT

FSTAT =
24,556,916.67

407,127.31
= 60.32



0 4.17 F
Region of
Rejection

Region of
Nonrejection

Critical
Value

F I G U R E 1 4 . 9
Testing for the
contribution of a
regression coefficient to
a multiple regression
model at the 0.05 level
of significance, with 1
and 31 degrees of
freedom

Because the computed partial test statistic (60.32) is greater than this critical F value
(4.17), you reject You can conclude that the addition of variable (price) significantly
improves a regression model that already contains variable (promotional expenditures).

To evaluate the contribution of variable (promotional expenditures) to a model in which
variable (price) has been included, you need to use Equation (14.10b). First, from Figure 14.8
on page 595, observe that Second, from Table 14.3, observe that
SSR( and Then, using Equation (14.10b) on page 594,

To determine whether significantly improves a model after has been included, you can
divide the regression sum of squares into two component parts, as shown in Table 14.4.

X1X2

SSR1X2|X12 = 39,472,730.77 - 28,153,486.15 = 11,319,244.62

X2) = 39,472,730.77.X1

SSR1X12 = 28,153,486.15.
X1

X2

X2

X1H0.
FSTAT
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The null and alternative hypotheses to test for the contribution of to the model are

Using Equation (14.11) and Table 14.4,

In Figure 14.9, you can see that, using a 0.05 level of significance, the critical value of F,
with 1 and 31 degrees of freedom, is approximately 4.17. Because the computed partial
test statistic (27.80) is greater than this critical value (4.17), you reject You can conclude
that the addition of variable (promotional expenditures) significantly improves the multiple
regression model already containing (price).

Thus, by testing for the contribution of each independent variable after the other has been
included in the model, you determine that each of the two independent variables significantly
improves the model. Therefore, the multiple regression model should include both price,
and promotional expenditures,

The partial F-test statistic developed in this section and the t-test statistic of Equation
(14.7) on page 590 are both used to determine the contribution of an independent variable to a

X2.
X1,

X1

X2

H0.
FSTAT

FSTAT =
11,319,244.62

407,127.31
= 27.80

H1: Variable X2 significantly improves the model after variable X1 has been included.

H0: Variable X2 does not significantly improve the model after variable X1 has been included.

X2

T A B L E 1 4 . 4

ANOVA Table Dividing
the Regression Sum of
Squares into
Components to
Determine the
Contribution of 
Variable X2

Source
Degrees of 
Freedom

Sum of 
Squares

Mean Square
(Variance) F

Regression 2 39,472,730.77 19,736,365.39b X1

X2|X1
r b1

1
r b28,153,486.15

11,319,244.62
r 11,319,244.62 27.80

Error 31 12,620,946.67 407,127.31
Total 33 52,093,677.44
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1This relationship holds only when
the statistic has 1 degree of
freedom in the numerator.

FSTAT

RELATIONSHIP BETWEEN A t STATISTIC AND AN F STATISTIC

(14.12)t2
STAT = FSTAT

Coefficients of Partial Determination
Recall from Section 14.2 that the coefficient of multiple determination, measures the
proportion of the variation in Y that is explained by variation in the independent variables. The
coefficients of partial determination ( and ) measure the proportion of the variation
in the dependent variable that is explained by each independent variable while controlling for,
or holding constant, the other independent variable. Equation (14.13) defines the coefficients
of partial determination for a multiple regression model with two independent variables.

r2
Y2.1r2

Y1.2

r2,

COEFFICIENTS OF PARTIAL DETERMINATION FOR A MULTIPLE
REGRESSION MODEL CONTAINING TWO INDEPENDENT VARIABLES

(14.13a)

and

(14.13b)

where

sum of squares of the contribution of variable to the
regression model, given that variable has been included in
the model

total sum of squares for Y

regression sum of squares when variables and are both
included in the multiple regression model

sum of squares of the contribution of variable to the
regression model, given that variable has been included in
the model

X1

X2SSR1X2|X12 =

X2X1SSR1X1 and X22 =

SST =

X2

X1SSR1X1|X22 =

r2
Y2.1 =

SSR1X2|X12
SST - SSR1X1 and X22 + SSR1X2|X12

r2
Y1.2 =

SSR1X1|X22
SST - SSR1X1 and X22 + SSR1X1|X22

multiple regression model. The hypothesis tests associated with these two statistics always
result in the same decision (i.e., the p-values are identical). The test statistics for the
OmniPower regression model are and and the corresponding test
statistics are 60.32 and 27.80. Equation (14.12) states this relationship between t and F.1

FSTAT+5.2728,-7.7664
tSTAT

For the OmniPower sales example,

= 0.4728

r2
Y2.1 =

11,319,244.62

52,093,677.44 - 39,472,730.77 + 11,319,244.62

= 0.6605

r2
Y1.2 =

24,556,916.67

52,093,677.44 - 39,472,730.77 + 24,556,916.67



COEFFICIENT OF PARTIAL DETERMINATION FOR A MULTIPLE REGRESSION
MODEL CONTAINING k INDEPENDENT VARIABLES

(14.14)r2
Yj.(All variables except j)

=
SSR(Xj|All Xs except j)

SST - SSR(All Xs) + SSR(Xj|All Xs except j)
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The coefficient of partial determination, of variable Y with while holding constant
is 0.6605. Thus, for a given (constant) amount of promotional expenditures, 66.05% of the
variation in OmniPower sales is explained by the variation in the price. The coefficient of
partial determination, of variable Y with while holding constant is 0.4728. Thus,
for a given (constant) price, 47.28% of the variation in sales of OmniPower bars is explained
by variation in the amount of promotional expenditures.

Equation (14.14) defines the coefficient of partial determination for the jth variable in a
multiple regression model containing several (k) independent variables.

X1X2r2
Y2.1,

X2X1r2
Y1.2,

Source
Degrees

of Freedom
Sum of 
Squares

Mean
Squares F

Regression 2 60
Error 18 120
Total 20 180

Problems for Section 14.5
LEARNING THE BASICS
14.31 The following is the ANOVA summary table for a
multiple regression model with two independent variables:

Source
Degrees

of Freedom
Sum of 
Squares

Mean
Squares F

Regression 2 30
Error 10 120
Total 12 150

b. compute the coefficients of partial determination,
and and interpret their meaning.

APPLYING THE CONCEPTS
14.33 In Problem 14.5 on page 583, you used horsepower
and weight to predict mileage (stored in ). Use the
results from that problem.
a. At the 0.05 level of significance, determine whether each

independent variable makes a significant contribution to
the regression model. On the basis of these results, indicate
the most appropriate regression model for this set of data.

b. Compute the coefficients of partial determination,
and and interpret their meaning.

14.34 In Problem 14.4 on page 583, you used
sales and number of orders to predict distribution

costs at a mail-order catalog business (stored in ).
Use the results from that problem.
a. At the 0.05 level of significance, determine whether each

independent variable makes a significant contribution to
the regression model. On the basis of these results,
indicate the most appropriate regression model for this
set of data.

b. Compute the coefficients of partial determination,
and and interpret their meaning.

14.35 In Problem 14.7 on page 584, you used the total staff
present and remote hours to predict standby hours (stored in

). Use the results from that problem.
a. At the 0.05 level of significance, determine whether each

independent variable makes a significant contribution to
the regression model. On the basis of these results, indicate
the most appropriate regression model for this set of data.

Standby

r2
Y2.1,

r2
Y1.2

WareCost

SELF
Test

r2
Y2.1,

r2
Y1.2

Auto2010

r2
Y2.1,

r2
Y1.2

If and
a. determine whether there is a significant relationship

between Y and each independent variable at the 0.05
level of significance.

b. compute the coefficients of partial determination,
and and interpret their meaning.

14.32 The following is the ANOVA summary table for a
multiple regression model with two independent variables:

r2
Y2.1,

r2
Y1.2

SSR1X22 = 25,SSR1X12 = 45

If and
a. determine whether there is a significant relationship

between Y and each independent variable at the 0.05
level of significance.

SSR1X22 = 15,SSR1X12 = 20
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b. Compute the coefficients of partial determination,
and and interpret their meaning.

14.36 In Problem 14.6 on page 583, you used radio adver-
tising and newspaper advertising to predict sales (stored in

). Use the results from that problem.
a. At the 0.05 level of significance, determine whether each

independent variable makes a significant contribution to
the regression model. On the basis of these results,
indicate the most appropriate regression model for this
set of data.

b. Compute the coefficients of partial determination,
and and interpret their meaning.r2

Y2.1,
r2

Y1.2

Advertise

r2
Y2.1,

r2
Y1.2 14.37 In Problem 14.8 on page 584, you used land area of a

property and age of a house to predict appraised value
(stored in ). Use the results from that problem.
a. At the 0.05 level of significance, determine whether each

independent variable makes a significant contribution to
the regression model. On the basis of these results,
indicate the most appropriate regression model for this
set of data.

b. Compute the coefficients of partial determination,
and and interpret their meaning.r2

Y2.1,
r2

Y1.2

GlenCove

14.6 Using Dummy Variables and Interaction Terms
in Regression Models

The multiple regression models discussed in Sections 14.1 through 14.5 assumed that each in-
dependent variable is a numerical variable. For example, in Section 14.1, you used price and
promotional expenditures, two numerical independent variables, to predict the monthly sales
of OmniPower energy bars. However, for some models, you might want to include the effect of
a categorical independent variable. For example, to predict the monthly sales of the Om-
niPower bars, you might want to include the categorical variable shelf location (not end-aisle
or end-aisle) in the model.

Dummy Variables
To include a categorical independent variable in a regression model, you use a dummy
variable. A dummy variable recodes the categories of a categorical variable using the numeric
values 0 and 1. Where appropriate, the value of 0 is assigned to the absence of a characteristic
and the value 1 is assigned to the presence of the characteristic. If a given categorical
independent variable has only two categories, such as shelf location in the previous example,
then you can define one dummy variable, to represent the two categories as

To illustrate using dummy variables in regression, consider a business problem that involves
developing a model for predicting the assessed value of houses ($000), based on the size of the
house (in thousands of square feet) and whether the house has a fireplace. To include the cate-
gorical variable for the presence of a fireplace, the dummy variable is defined as

Data collected from a sample of 15 houses are organized and stored in . Table 14.5
presents the data. In the last column of Table 14.5, you can see how the categorical values are
converted to numerical values.

Assuming that the slope of assessed value with the size of the house is the same for houses
that have and do not have a fireplace, the multiple regression model is

Yi = b0 + b1X1i + b2X2i + ei

House3

X2 = 1 if the house has a fireplace

X2 = 0 if the house does not have a fireplace

X2

Xd = 1 if the observation is in category 2 1end-aisle in the example2
Xd = 0 if the observation is in category 1 1not end-aisle in the example2

Xd,
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T A B L E 1 4 . 5

Predicting Assessed
Value, Based on Size of
House and Presence of a
Fireplace

Assessed Value Size Fireplace Fireplace Coded

234.4 2.00 Yes 1
227.4 1.71 No 0
225.7 1.45 No 0
235.9 1.76 Yes 1
229.1 1.93 No 0
220.4 1.20 Yes 1
225.8 1.55 Yes 1
235.9 1.93 Yes 1
228.5 1.59 Yes 1
229.2 1.50 Yes 1
236.7 1.90 Yes 1
229.3 1.39 Yes 1
224.5 1.54 No 0
233.8 1.89 Yes 1
226.8 1.59 No 0

where

assessed value, in thousands of dollars, for house i

intercept

size of the house, in thousands of square feet, for house i

slope of assessed value with size of the house, holding constant the presence or
absence of a fireplace

dummy variable representing the absence or presence of a fireplace for house i

net effect of the presence of a fireplace on assessed value, holding constant the size
of the house

random error in Y for house i

Figure 14.10 presents the regression results for this model.

ei =

b2 =

X2i =

b1 =

X1i =

b0 = Y

Yi =

From Figure 14.10, the regression equation is

YNi = 200.0905 + 16.1858X1i + 3.8530X2i
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For houses without a fireplace, you substitute into the regression equation:

For houses with a fireplace, you substitute into the regression equation:

In this model, the regression coefficients are interpreted as follows:

= 203.9435 + 16.1858X1i

= 200.0905 + 16.1858X1i + 3.8530(1)

YNi = 200.0905 + 16.1858X1i + 3.8530X2i

X2 = 1

= 200.0905 + 16.1858X1i

= 200.0905 + 16.1858X1i + 3.8530(0)

YNi = 200.0905 + 16.1858X1i + 3.8530X2i

X2 = 0

• Holding constant whether a house has a fireplace, for each increase of 1.0 thousand square
feet in the size of the house, the predicted assessed value is estimated to increase by
16.1858 thousand dollars (i.e., $16,185.80).

• Holding constant the size of the house, the presence of a fireplace is estimated to increase
the predicted assessed value of the house by 3.8530 thousand dollars (i.e., $3,853).

In Figure 14.10, the test statistic for the slope of the size of the house with assessed
value is 6.2871, and the p-value is approximately 0.000; the test statistic for presence of a
fireplace is 3.1042, and the p-value is 0.0091. Thus, each of the two variables makes a signifi-
cant contribution to the model at the 0.01 level of significance. In addition, the coefficient of
multiple determination indicates that 81.11% of the variation in assessed value is explained by
variation in the size of the house and whether the house has a fireplace.

tSTAT

tSTAT

Define a multiple regression model using sales as the dependent variable and package design
and price as independent variables. Package design is a three-level categorical variable with
designs A, B, or C.

SOLUTION To model the three-level categorical variable package design, two dummy
variables, and are needed:

Thus, if observation i uses package design A, then and if observation i uses
package design B, then and and if observation i uses package design C, then

A third independent variable is used for price:

Thus, the regression model for this example is

where

sales for observation i

intercept

difference between the predicted sales of design A and the predicted sales of
design C, holding price constant

difference between the predicted sales of design B and the predicted sales of
design C, holding price constant

slope of sales with price, holding the package design constant

random error in Y for observation iei =

b3 =

b2 =

b1 =
b0 = Y

Yi =

Yi = b0 + b1X1i + b2X2i + b3X3i + ei

X3i = price for observation i

X1i = X2i = 0.
X2i = 1;X1i = 0

X2i = 0;X1i = 1

X2i = 1 if package design B is used in observation i; 0 otherwise

X1i = 1 if package design A is used in observation i; 0 otherwise

X2,X1

EXAMPLE 14.3
Modeling a 
Three-Level
Categorical
Variable



To test for the existence of an interaction, you use the null hypothesis:

versus the alternative hypothesis:

In Figure 14.11, the test statistic for the interaction of size and fireplace is 1.4834. Be-
cause or the p-value you do not reject the null
hypothesis. Therefore, the interaction does not make a significant contribution to the model,

= 0.1661 7 0.05,tSTAT = 1.4834 6 2.201
tSTAT

H1: b3 Z 0.

H0: b3 = 0

F I G U R E 1 4 . 1 1
Excel and Minitab regression results for a model that includes size, presence of fireplace, and interaction of size 
and fireplace
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Interactions
In all the regression models discussed so far, the effect an independent variable has on the
dependent variable has been assumed to be independent of the other independent variables in
the model. An interaction occurs if the effect of an independent variable on the dependent vari-
able changes according to the value of a second independent variable. For example, it is possi-
ble for advertising to have a large effect on the sales of a product when the price of a product is
low. However, if the price of the product is too high, increases in advertising will not dramati-
cally change sales. In this case, price and advertising are said to interact. In other words, you
cannot make general statements about the effect of advertising on sales. The effect that adver-
tising has on sales is dependent on the price. You use an interaction term (sometimes referred
to as a cross-product term) to model an interaction effect in a regression model.

To illustrate the concept of interaction and use of an interaction term, return to the exam-
ple concerning the assessed values of homes discussed on pages 599–601. In the regression
model, you assumed that the effect the size of the home has on the assessed value is independ-
ent of whether the house has a fireplace. In other words, you assumed that the slope of as-
sessed value with size is the same for houses with fireplaces as it is for houses without
fireplaces. If these two slopes are different, an interaction exists between the size of the home
and the fireplace.

To evaluate whether an interaction exists, you first define an interaction term that is the prod-
uct of the independent variable (size of house) and the dummy variable (FireplaceCoded).
You then test whether this interaction variable makes a significant contribution to the regression
model. If the interaction is significant, you cannot use the original model for prediction. For the
data of Table 14.5 on page 600, you define the following:

Figure 14.11 presents the results for this regression model, which includes the size of the
house, the presence of a fireplace, and the interaction of and (defined as ).X3X2X1X2,X1,

X3 = X1 * X2

X2X1
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The business problem facing a real estate developer involves predicting heating oil
consumption in single-family houses. The independent variables considered are atmospheric
temperature, and the amount of attic insulation, Data are collected from a sample of 15
single-family houses. Of the 15 houses selected, houses 1, 4, 6, 7, 8, 10, and 12 are ranch-style
houses. The data are organized and stored in . Develop and analyze an appropriate
regression model, using these three independent variables and (where is the
dummy variable for ranch-style houses).

SOLUTION Define a dummy variable for ranch-style house, as follows:

Assuming that the slope between heating oil consumption and atmospheric temperature,
and between heating oil consumption and the amount of attic insulation, is the same for

both styles of houses, the regression model is

where

monthly heating oil consumption, in gallons, for house i

intercept

slope of heating oil consumption with atmospheric temperature, holding con-
stant the effect of attic insulation and the style of the house

slope of heating oil consumption with attic insulation, holding constant the ef-
fect of atmospheric temperature and the style of the house

incremental effect of the presence of a ranch-style house, holding constant the
effect of atmospheric temperature and attic insulation

random error in Y for house i

Figure 14.12 presents results for this regression model.

ei =

b3 =

b2 =

b1 =
b0 = Y

Yi =

Yi = b0 + b1X1i + b2X2i + b3X3i + ei

X2,X1,

X3 = 1 if the style is ranch

X3 = 0 if the style is not ranch

X3,

X3X3X1, X2,
HeatingOil

X2.X1,

EXAMPLE 14.4
Studying a
Regression Model
That Contains a
Dummy Variable

given that size and presence of a fireplace are already included. You can conclude that the
slope of assessed value with size is the same for houses with fireplaces and without fireplaces.

Regression models can have several numerical independent variables. Example 14.4
illustrates a regression model in which there are two numerical independent variables and a
categorical independent variable.

F I G U R E 1 4 . 1 2
Excel and Minitab results for a regression model that includes temperature, insulation, and ranch-style for 
the heating oil data



For the data of Example 14.4, determine whether adding the interaction terms make a
significant contribution to the regression model.

SOLUTION To evaluate possible interactions between the independent variables, three inter-
action terms are constructed as follows: and
The regression model is now

where is temperature, is insulation, is the dummy variable ranch style, is the inter-
action between temperature and insulation, is the interaction between temperature and
ranch style, and is the interaction between insulation and ranch style. Figure 14.13 presents
the results for this regression model.

X6

X5

X4X3X2X1

Yi = b0 + b1X1i + b2X2i + b3X3i + b4X4i + b5X5i + b6X6i + ei

X6 = X2 * X3.X4 = X1 * X2, X5 = X1 * X3,

EXAMPLE 14.5
Evaluating a
Regression Model
with Several
Interactions
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From the results in Figure 14.12, the regression equation is

For houses that are not ranch style, because the regression equation reduces to

For houses that are ranch style, because the regression equation reduces to

In this model, the regression coefficients are interpreted as follows:

• Holding constant the attic insulation and the house style, for each additional 1°F increase
in atmospheric temperature, you estimate that the predicted heating oil consumption
decreases by 5.5251 gallons.

• Holding constant the atmospheric temperature and the house style, for each additional
1-inch increase in attic insulation, you estimate that the predicted heating oil consump-
tion decreases by 21.3761 gallons.

• measures the effect on oil consumption of having a ranch-style house com-
pared with having a house that is not ranch style Thus, with atmospheric tem-
perature and attic insulation held constant, you estimate that the predicted heating oil
consumption is 38.9727 gallons less for a ranch-style house than for a house that is not
ranch style.

The three test statistics representing the slopes for temperature, insulation, and ranch
style are and Each of the corresponding p-values is extremely
small (less than 0.001). Thus, each of the three variables makes a significant contribution to
the model. In addition, the coefficient of multiple determination indicates that 98.84% of the
variation in oil usage is explained by variation in temperature, insulation, and whether the
house is ranch style.

-4.6627.-27.0267, -14.7623,
tSTAT

1X3 = 02. 1X3 = 12b3

YNi = 553.5674 - 5.5251X1i - 21.3761X2i

X3 = 1,

YNi = 592.5401 - 5.5251X1i - 21.3761X2i

X3 = 0,

YNi = 592.5401 - 5.5251X1i - 21.3761X2i - 38.9727X3i

Before you can use the model in Example 14.4, you need to determine whether the inde-
pendent variables interact with each other. In Example 14.5, three interaction terms are added
to the model.
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F I G U R E 1 4 . 1 3
Excel and Minitab regression results for a model that includes temperature, insulation, the dummy variable
ranch-style, the interaction of temperature and insulation, the interaction of temperature and ranch-style, 
and the interaction of insulation and ranch-style, X6

X5;X4;X3;
X2;X1;

To test whether the three interactions significantly improve the regression model, you use
the partial F test. The null and alternative hypotheses are

From Figure 14.13,

and from Figure 14.12 on page 603, with 3 degrees of
freedom. Thus,

The difference in degrees of freedom is 
To use the partial F test for the simultaneous contribution of three variables to a model,

you use an extension of Equation (14.11) on page 616.2 The partial test statistic is

You compare the computed test statistic to the critical F value for 3 and 8 degrees of
freedom. Using a level of significance of 0.05, the critical F value from Table E.5 is 4.07.
Because you conclude that the interactions do not make a significant
contribution to the model, given that the model already includes temperature, insulation,

and whether the house is ranch style, Therefore, the multiple regression model using
and but no interaction terms is the better model. If you rejected this null hypothesis,

you would then test the contribution of each interaction separately in order to determine which
interaction terms to include in the model.

X3X1, X2,
X3.X2;

X1;
FSTAT = 1.8115 6 4.07,

FSTAT

FSTAT =
[SSR1X1, X2, X3, X4, X5, X62 - SSR1X1, X2, X32]>3

MSE1X1, X2, X3, X4, X5, X62 =
1,103.6724>3

203.0809
= 1.8115

FSTAT

6 - 3 = 3.

SSR1X1, X2, X3, X4, X5, X62 - SSR1X1, X2, X32 = 234,510.5818 - 233,406.9094 = 1,103.6724.

SSR 1X1, X2, X32 = 233,406.9094

SSR1X1, X2, X3, X4, X5, X62 = 234,510.5818 with 6 degrees of freedom

and>or X1 interacts with X3, and>or X2 interacts with X3.2
H1: b4 Z 0 and>or b5 Z 0 and>or b6 Z 0 1X1 interacts with X2,

H0 : b4 = b5 = b6 = 0 1There are no interaction among X1, X2, and X3.2

2In general, if a model has several
independent variables and you
want to test whether additional
independent variables contribute
to the model, the numerator of the
F test is SSR(for all independent
variables) minus SSR(for the
initial set of variables) divided by
the number of independent vari-
ables whose contribution is being
tested.



Store
Shelf Space 

(Feet) Location
Weekly
Sales ($)

1 5 Back 160
2 5 Front 220
3 5 Back 140
4 10 Back 190
5 10 Back 240
6 10 Front 260
7 15 Back 230
8 15 Back 270
9 15 Front 280

10 20 Back 260
11 20 Back 290
12 20 Front 310

For (a) through (m), do not include an interaction term.
a. State the multiple regression equation that predicts

weekly sales based on shelf space and location.
b. Interpret the regression coefficients in (a).
c. Predict the weekly sales of pet food for a store with 8 feet

of shelf space situated at the back of the aisle. Construct
a 95% confidence interval estimate and a 95% prediction
interval.
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Problems for Section 14.6
LEARNING THE BASICS
14.38 Suppose is a numerical variable and is a
dummy variable and the regression equation for a sample of

is

a. Interpret the regression coefficient associated with
variable

b. Interpret the regression coefficient associated with
variable

c. Suppose that the test statistic for testing the
contribution of variable is 3.27. At the 0.05 level of
significance, is there evidence that variable makes a
significant contribution to the model?

APPLYING THE CONCEPTS
14.39 The chair of the accounting department plans to de-
velop a regression model to predict the grade point average
in accounting for those students who are graduating and
have completed the accounting major, based on the student’s
SAT score and whether the student received a grade of B or
higher in the introductory statistics course ( and

).
a. Explain the steps involved in developing a regression

model for these data. Be sure to indicate the particular
models you need to evaluate and compare.

b. Suppose the regression coefficient for the variable
whether the student received a grade of B or higher in the
introductory statistics course is How do you inter-
pret this result?

14.40 A real estate association in a suburban community
would like to study the relationship between the size of a
single-family house (as measured by the number of rooms)
and the selling price of the house (in thousands of dollars).
Two different neighborhoods are included in the study, one
on the east side of the community and the other on the
west side A random sample of 20 houses was
selected, with the results stored in . For (a)
through (k), do not include an interaction term.
a. State the multiple regression equation that predicts the

selling price, based on the number of rooms and the
neighborhood.

b. Interpret the regression coefficients in (a).
c. Predict the selling price for a house with nine rooms

that is located in an east-side neighborhood. Construct
a 95% confidence interval estimate and a 95%
prediction interval.

d. Perform a residual analysis on the results and determine
whether the regression assumptions are valid.

e. Is there a significant relationship between selling price
and the two independent variables (rooms and neighbor-
hood) at the 0.05 level of significance?

Neighbor

1=12. 1=02

+0.30.

1 = yes
0 = no

X2

X2

tSTAT

X2.

X1.

YNi = 6 + 4X1i + 2X2i

n = 20

X2X1

f. At the 0.05 level of significance, determine whether
each independent variable makes a contribution to the
regression model. Indicate the most appropriate regres-
sion model for this set of data.

g. Construct and interpret a 95% confidence interval esti-
mate of the population slope for the relationship between
selling price and number of rooms.

h. Construct and interpret a 95% confidence interval esti-
mate of the population slope for the relationship between
selling price and neighborhood.

i. Compute and interpret the adjusted 
j. Compute the coefficients of partial determination and

interpret their meaning.
k. What assumption do you need to make about the slope

of selling price with number of rooms?
l. Add an interaction term to the model and, at the 0.05

level of significance, determine whether it makes a sig-
nificant contribution to the model.

m. On the basis of the results of (f) and (l), which model is
most appropriate? Explain.

14.41 The marketing manager of a large supermarket
chain faced the business problem of determining the effect
on the sales of pet food of shelf space and whether the prod-
uct was placed at the front or back of the aisle.
Data are collected from a random sample of 12 equal-sized
stores. The results are shown in the following table (and or-
ganized and stored in ):Petfood

1=021=12

r2.
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d. Perform a residual analysis on the results and determine
whether the regression assumptions are valid.

e. Is there a significant relationship between additional
drilling time and the two independent variables (depth
and type of drilling hole) at the 0.05 level of signifi-
cance?

f. At the 0.05 level of significance, determine whether
each independent variable makes a contribution to the
regression model. Indicate the most appropriate regres-
sion model for this set of data.

g. Construct a 95% confidence interval estimate of the
population slope for the relationship between additional
drilling time and depth.

h. Construct a 95% confidence interval estimate of the
population slope for the relationship between additional
drilling time and the type of hole drilled.

i. Compute and interpret the adjusted 
j. Compute the coefficients of partial determination and

interpret their meaning.
k. What assumption do you need to make about the slope

of additional drilling time with depth?
l. Add an interaction term to the model and, at the 0.05

level of significance, determine whether it makes a sig-
nificant contribution to the model.

m. On the basis of the results of (f) and (l), which model is
most appropriate? Explain.

14.43 The owner of a moving company typically has his
most experienced manager predict the total number of labor
hours that will be required to complete an upcoming move.
This approach has proved useful in the past, but the owner
has the business objective of developing a more accurate
method of predicting labor hours. In a preliminary effort to
provide a more accurate method, the owner has decided to
use the number of cubic feet moved and whether there is an
elevator in the apartment building as the independent vari-
ables and has collected data for 36 moves in which the ori-
gin and destination were within the borough of Manhattan
in New York City and the travel time was an insignificant
portion of the hours worked. The data are organized and
stored in. For (a) through (k), do not include an interaction
term .
a. State the multiple regression equation for predicting la-

bor hours, using the number of cubic feet moved and
whether there is an elevator.

b. Interpret the regression coefficients in (a).
c. Predict the labor hours for moving 500 cubic feet in an

apartment building that has an elevator and construct a
95% confidence interval estimate and a 95% prediction
interval.

d. Perform a residual analysis on the results and determine
whether the regression assumptions are valid.

e. Is there a significant relationship between labor hours
and the two independent variables (cubic feet moved and
whether there is an elevator in the apartment building) at
the 0.05 level of significance?

Moving

r2.

d. Perform a residual analysis on the results and determine
whether the regression assumptions are valid.

e. Is there a significant relationship between sales and the
two independent variables (shelf space and aisle position)
at the 0.05 level of significance?

f. At the 0.05 level of significance, determine whether each
independent variable makes a contribution to the
regression model. Indicate the most appropriate
regression model for this set of data.

g. Construct and interpret 95% confidence interval estimates
of the population slope for the relationship between sales
and shelf space and between sales and aisle location.

h. Compare the slope in (b) with the slope for the simple
linear regression model of Problem 13.4 on page 531.
Explain the difference in the results.

i. Compute and interpret the meaning of the coefficient of
multiple determination,

j. Compute and interpret the adjusted 
k. Compare with the value computed in Problem

13.16 (a) on page 537.
l. Compute the coefficients of partial determination and

interpret their meaning.
m. What assumption about the slope of shelf space with

sales do you need to make in this problem?
n. Add an interaction term to the model and, at the 0.05

level of significance, determine whether it makes a
significant contribution to the model.

o. On the basis of the results of (f) and (n), which model is
most appropriate? Explain.

14.42 In mining engineering, holes are often drilled
through rock, using drill bits. As a drill hole gets deeper, ad-
ditional rods are added to the drill bit to enable additional
drilling to take place. It is expected that drilling time in-
creases with depth. This increased drilling time could be
caused by several factors, including the mass of the drill
rods that are strung together. The business problem relates
to whether drilling is faster using dry drilling holes or wet
drilling holes. Using dry drilling holes involves forcing
compressed air down the drill rods to flush the cuttings and
drive the hammer. Using wet drilling holes involves forcing
water rather than air down the hole. Data have been col-
lected from a sample of 50 drill holes that contains measure-
ments of the time to drill each additional 5 feet (in minutes),
the depth (in feet), and whether the hole was a dry drilling
hole or a wet drilling hole. The data are organized and stored
in. Develop a model to predict additional drilling time,
based on depth and type of drilling hole (dry or wet). For (a)
through (k) do not include an interaction term .
Source: Data extracted from R. Penner and D. G. Watts, “Mining
Information,” The American Statistician, 45, 1991, pp. 4–9.

a. State the multiple regression equation.
b. Interpret the regression coefficients in (a).
c. Predict the additional drilling time for a dry drilling hole

at a depth of 100 feet. Construct a 95% confidence inter-
val estimate and a 95% prediction interval.

Drill

r2r2
r2.

r2.
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f. At the 0.05 level of significance, determine whether
each independent variable makes a contribution to the
regression model. Indicate the most appropriate regres-
sion model for this set of data.

g. Construct a 95% confidence interval estimate of the
population slope for the relationship between labor
hours and cubic feet moved.

h. Construct a 95% confidence interval estimate for the re-
lationship between labor hours and the presence of an el-
evator.

i. Compute and interpret the adjusted 
j. Compute the coefficients of partial determination and

interpret their meaning.
k. What assumption do you need to make about the slope

of labor hours with cubic feet moved?
l. Add an interaction term to the model and, at the 0.05

level of significance, determine whether it makes a sig-
nificant contribution to the model.

m. On the basis of the results of (f) and (l), which model is
most appropriate? Explain.

14.44 In Problem 14.4 on page 583, you used sales
and orders to predict distribution cost (stored in
). Develop a regression model to predict distribu-

tion cost that includes sales, orders, and the interaction of
sales and orders.
a. At the 0.05 level of significance, is there evidence that

the interaction term makes a significant contribution to
the model?

b. Which regression model is more appropriate, the one
used in (a) or the one used in Problem 14.4? Explain.

14.45 Zagat’s publishes restaurant ratings for various loca-
tions in the United States. The file contains the
Zagat rating for food, décor, service, and cost per person for
a sample of 50 restaurants located in a city and 50 restau-
rants located in a suburb. Develop a regression model to
predict the cost per person, based on a variable that repre-
sents the sum of the ratings for food, décor, and service and
a dummy variable concerning location (city vs. suburban).
For (a) through (m), do not include an interaction term.
Sources: Extracted from Zagat Survey 2010, NewYork City Restaurants;
and Zagat Survey 2009–2010, Long Island Restaurants.

a. State the multiple regression equation.
b. Interpret the regression coefficients in (a).
c. Predict the cost for a restaurant with a summated rating

of 60 that is located in a city and construct a 95% confi-
dence interval estimate and a 95% prediction interval.

d. Perform a residual analysis on the results and determine
whether the regression assumptions are satisfied.

e. Is there a significant relationship between price and the
two independent variables (summated rating and loca-
tion) at the 0.05 level of significance?

f. At the 0.05 level of significance, determine whether each
independent variable makes a contribution to the regres-
sion model. Indicate the most appropriate regression
model for this set of data.

Restaurants

WareCost

SELF
Test

r2.

g. Construct a 95% confidence interval estimate of the
population slope for the relationship between cost and
summated rating.

h. Compare the slope in (b) with the slope for the simple
linear regression model of Problem 13.5 on page 531.
Explain the difference in the results.

i. Compute and interpret the meaning of the coefficient of
multiple determination.

j. Compute and interpret the adjusted 
k. Compare with the value computed in Problem 13.17

(b) on page 537.
l. Compute the coefficients of partial determination and

interpret their meaning.
m. What assumption about the slope of cost with summated

rating do you need to make in this problem?
n. Add an interaction term to the model and, at the 0.05

level of significance, determine whether it makes a sig-
nificant contribution to the model.

o. On the basis of the results of (f) and (n), which model is
most appropriate? Explain.

14.46 In Problem 14.6 on page 583, you used radio adver-
tising and newspaper advertising to predict sales (stored in

). Develop a regression model to predict sales
that includes radio advertising, newspaper advertising, and
the interaction of radio advertising and newspaper
advertising.
a. At the 0.05 level of significance, is there evidence that

the interaction term makes a significant contribution to
the model?

b. Which regression model is more appropriate, the one
used in this problem or the one used in Problem 14.6?
Explain.

14.47 In Problem 14.5 on page 583, horsepower and weight
were used to predict miles per gallon (stored in ).
Develop a regression model that includes horsepower,
weight, and the interaction of horsepower and weight to
predict miles per gallon.
a. At the 0.05 level of significance, is there evidence that

the interaction term makes a significant contribution to
the model?

b. Which regression model is more appropriate, the one
used in this problem or the one used in Problem 14.5?
Explain.

14.48 In Problem 14.7 on page 584, you used total staff
present and remote hours to predict standby hours (stored in

). Develop a regression model to predict standby
hours that includes total staff present, remote hours, and the
interaction of total staff present and remote hours.
a. At the 0.05 level of significance, is there evidence that

the interaction term makes a significant contribution to
the model?

b. Which regression model is more appropriate, the one
used in this problem or the one used in Problem 14.7?
Explain.

Standby

Auto2010

Advertise

r2r2
r2.
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14.49 The director of a training program for a large insur-
ance company has the business objective of determining
which training method is best for training underwriters. The
three methods to be evaluated are traditional, CD-ROM
based, and Web based. The 30 trainees are divided into three
randomly assigned groups of 10. Before the start of the
training, each trainee is given a proficiency exam that meas-
ures mathematics and computer skills. At the end of the
training, all students take the same end-of-training exam.
The results are organized and stored in .

Develop a multiple regression model to predict the
score on the end-of-training exam, based on the score on the
proficiency exam and the method of training used. For (a)
through (k), do not include an interaction term.
a. State the multiple regression equation.
b. Interpret the regression coefficients in (a).
c. Predict the end-of-training exam score for a student

with a proficiency exam score of 100 who had Web-
based training.

d. Perform a residual analysis on your results and determine
whether the regression assumptions are valid.

e. Is there a significant relationship between the end-of-
training exam score and the independent variables (profi-
ciency score and training method) at the 0.05 level of
significance?

Underwriting

f. At the 0.05 level of significance, determine whether
each independent variable makes a contribution to the
regression model. Indicate the most appropriate regres-
sion model for this set of data.

g. Construct and interpret a 95% confidence interval esti-
mate of the population slope for the relationship
between the end-of-training exam score and the profi-
ciency exam score.

h. Construct and interpret a 95% confidence interval esti-
mate of the population slope for the relationship between
the end-of-training exam score and type of training
method.

i. Compute and interpret the adjusted 
j. Compute the coefficients of partial determination and

interpret their meaning.
k. What assumption about the slope of proficiency score

with end-of-training exam score do you need to make in
this problem?

l. Add interaction terms to the model and, at the 0.05 level
of significance, determine whether any interaction terms
make a significant contribution to the model.

m. On the basis of the results of (f) and (l), which model is
most appropriate? Explain.

r2.

14.7 Logistic Regression
The discussion of the simple linear regression model in Chapter 13 and the multiple regression
models in Sections 14.1 through 14.6 only considered numerical dependent variables.
However, in many instances, the dependent variable is a categorical variable that takes on one
of only two possible values such as a customer prefers Brand A or a customer prefers Brand B.
Using a categorical dependent variable violates the normality assumption of least-squares and
can also result in predicted Y values that are impossible.

An alternative approach to least-squares regression originally applied to survival data in
the health sciences (see reference 1), logistic regression, enables you to use regression models
to predict the probability of a particular categorical response for a given set of independent
variables. The logistic regression model uses the odds ratio, which represents the probability
of an event of interest compared with the probability of not having an event of interest.
Equation (14.15) defines the odds ratio.

ODDS RATIO

(14.15)Odds ratio =
Probability of an event of interest

1 - Probability of an event of interest

Using Equation (14.15), if the probability of an event of interest is 0.50, the odds ratio is

Odds ratio =
0.50

1 - 0.50
= 1.0, or 1 to 1



Once you have computed the estimated odds ratio, you use Equation (14.19) to find the
estimated probability of an event of interest.

ESTIMATED PROBABILITY OF AN EVENT OF INTEREST

(14.19)Estimated probability of an event of interest =
Estimated odds ratio

1 + Estimated odds ratio

To illustrate the logistic regression model, the marketing department for a credit card com-
pany wants to organize a campaign to convince existing holders of the company’s standard
credit card to upgrade to the company’s premium card for a nominal annual fee. The marketing
department begins with the question “Which of the existing standard credit cardholders should
be the target for the campaign?”

The department has access to data from a sample of 30 cardholders who were contacted
during last year’s campaign. That data indicates whether the cardholder upgraded to a premium

Once you have determined the logistic regression equation, you use Equation (14.18) to
compute the estimated odds ratio.

ESTIMATED ODDS RATIO

(14.18)Estimated odds ratio = eln(Estimated odds ratio)

610 CHAPTER 14 Introduction to Multiple Regression

If the probability of an event of interest is 0.75, the odds ratio is

The logistic regression model is based on the natural logarithm (ln) of this odds ratio.3

Equation (14.16) defines the logistic regression model for k independent variables.

Odds ratio =
0.75

1 - 0.75
= 3.0, or 3 to 1

LOGISTIC REGRESSION MODEL

(14.16)

where

number of independent variables in the model

random error in observation iei =

k =

ln(Odds ratio) = b0 + b1X1i + b2X2i + Á + bkXki + ei

LOGISTIC REGRESSION EQUATION

(14.17)ln(Estimated odds ratio) = b0 + b1X1i + b2X2i + Á + bkXki

In Sections 13.2 and 14.1, the method of least squares was used to develop a regression
equation. In logistic regression, a mathematical method called maximum likelihood estimation
is usually used to develop a regression equation to predict the natural logarithm of this odds
ratio. Equation (14.17) defines the logistic regression equation.

3For more information on loga-
rithms, see Appendix Section A.3.
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F I G U R E 1 4 . 1 4
Minitab logistic
regression results for the
credit card marketing
data

card ( no, yes). The department wants to predict the categorical variable (i.e., did the
customer upgrade to a premium card?) using two independent variables: total amount of credit
card purchases (in thousands of dollars) in the prior year and whether the cardholder or-
dered additional credit cards (at extra cost) for other members of the household ( no,

yes). Figure 14.14 presents results for the logistic regression model, the data for which are
stored in .Logpurch

1=
X2: 0=

(X1),

1=0=

In this model, the regression coefficients are interpreted as follows:

• The regression constant is This means that for a credit cardholder who did
not charge any purchases last year and who does not have additional cards, the
estimated natural logarithm of the odds ratio of purchasing the premium card is

• The regression coefficient is 0.13947. This means that holding constant the effect of
whether the credit cardholder has additional cards for members of the household, for
each increase of $1,000 in annual credit card spending using the company’s card, the es-
timated natural logarithm of the odds ratio of purchasing the premium card increases by
0.13947. Therefore, cardholders who charged more in the previous year are more likely
to upgrade to a premium card.

• The regression coefficient is 2.774. This means that holding constant the annual credit
card spending, the estimated natural logarithm of the odds ratio of purchasing the pre-
mium card increases by 2.774 for a credit cardholder who has additional cards for mem-
bers of the household compared with one who does not have additional cards. Therefore,
cardholders possessing additional cards for other members of the household are much
more likely to upgrade to a premium card.

The regression coefficients suggest that the credit card company should develop a marketing
campaign that targets cardholders who tend to charge large amounts to their cards, and to
households that possess more than one card.

As was the case with least-squares regression models, a main purpose of performing
logistic regression analysis is to provide predictions of a dependent variable. For example,
consider a cardholder who charged $36,000 last year and possesses additional cards for
members of the household. What is the probability the cardholder will upgrade to the

b2

b1

-6.940.

-6.940.b0

Excel does not contain any
logistic regression functions,
but logistic regression analysis
can be done using the Excel
Solver add-in (beyond the
scope of this book).



premium card during the marketing campaign? Using Equation (14.17) on
page 610, and the results displayed in Figure 14.14 on page 611,

Then, using Equation (14.18) on page 610,

Therefore, the odds are 2.3512 to 1 that a credit cardholder who spent $36,000 last year
and has additional cards will purchase the premium card during the campaign. Using Equation
(14.19) on page 610, you can convert this odds ratio to a probability:

Thus, the estimated probability is 0.7016 that a credit cardholder who spent $36,000 last year
and has additional cards will purchase the premium card during the campaign. In other words,
you predict 70.16% of such individuals will purchase the premium card.

Now that you have used the logistic regression model for prediction, you need to
determine whether or not the model is a good-fitting model. The deviance statistic is
frequently used to determine whether or not the current model provides a good fit to the data.
This statistic measures the fit of the current model compared with a model that has as many
parameters as there are data points (what is called a saturated model). The deviance statistic
follows a chi-square distribution with degrees of freedom. The null and alternative
hypotheses are

When using the deviance statistic for logistic regression, the null hypothesis represents a good-
fitting model, which is the opposite of the null hypothesis when using the overall F test for the
multiple regression model (see Section 14.2). Using the α level of significance, the decision
rule is

The critical value for a statistic with degrees of freedom is
40.113 (see Table E.4). From Figure 14.14 on page 611, the deviance or
the p-value Thus, you do not reject and you conclude that the model is a
good-fitting one.

Now that you have concluded that the model is a good-fitting one, you need to evaluate
whether each of the independent variables makes a significant contribution to the model in
the presence of the others. As was the case with linear regression in Sections 13.7 and 14.4,
the test statistic is based on the ratio of the regression coefficient to the standard error of the
regression coefficient. In logistic regression, this ratio is defined by the Wald statistic,
which approximately follows the normal distribution. From Figure 14.14, the Wald statistic
(labeled Z) is 2.05 for and 2.33 for Each of these is greater than the critical value of
+1.96 for the normal distribution at the 0.05 level of significance (the p-values are 0.04 and
0.02). You can conclude that each of the two independent variables makes a contribution to
the model in the presence of the other. Therefore, you should include both these independent
variables in the model.

X2.X1

H0,= 0.828 7 0.05.
= 20.08 6 40.113,

n-k-1 = 30-2-1 = 27x2

Otherwise, do not reject Ho.

Reject H0 if deviance 7 x2
a

H1: The model is not a good-fitting model.

H0: The model is a good-fitting model.

n-k-1

= 0.7016

estimated probability of purchasing premium card =
2.3512

1 + 2.3512

Estimated odds ratio = e0.85492 = 2.3512

= 0.85492

ln(estimated odds of purchasing versus not purchasing) = -6.94 + (0.13947)(36) + (2.774)(1)

X1 = 36, X2 = 1,
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Problems for Section 14.7
LEARNING THE BASICS
14.50 Interpret the meaning of a slope coefficient equal
to 2.2 in logistic regression.

14.51 Given an estimated odds ratio of 2.5, compute the
estimated probability of an event of interest.

14.52 Given an estimated odds ratio of 0.75, compute the
estimated probability of an event of interest.

14.53 Consider the following logistic regression equation:

a. Interpret the meaning of the logistic regression coefficients.
b. If and compute the estimated odds

ratio and interpret its meaning.
c. On the basis of the results of (b), compute the estimated

probability of an event of interest.

APPLYING THE CONCEPTS
14.54 Refer to Figure 14.14 on page 611.
a. Predict the probability that a cardholder who charged

$36,000 last year and does not have any additional credit
cards for members of the household will purchase the
premium card during the marketing campaign.

b. Compare the results in (a) with those for a person with
additional credit cards.

c. Predict the probability that a cardholder who charged
$18,000 and does not have any additional credit cards for
members of the household will purchase the premium
card during the marketing campaign.

d. Compare the results of (a) and (c) and indicate what im-
plications these results might have for the strategy for the
marketing campaign.

14.55 Undergraduate students at Miami University in Ox-
ford, Ohio, were surveyed in order to evaluate the effect of
price on the purchase of a pizza from Pizza Hut. The stu-
dents were asked to suppose that they were going to have a
large two-topping pizza delivered to their residence. Then
they were asked to select from either Pizza Hut or another
pizzeria of their choice. The price they would have to pay to
get a Pizza Hut pizza differed from survey to survey. For ex-
ample, some surveys used the price $11.49. Other prices in-
vestigated were $8.49, $9.49, $10.49, $12.49, $13.49, and
$14.49. The dependent variable for this study is whether or
not a student will select Pizza Hut. Possible independent
variables are the price of a Pizza Hut pizza and the gender
of the student. The data set has 220 observations
and three variables:

Gender ( male, female)

Price (8.49, 9.49, 10.49, 11.49, 12.49, 13.49, or 14.49)

Purchase ( the student selected Pizza Hut, the stu-
dent selected another pizzeria)

0=1=

0=1=

PizzaHut

X2 = 1.5,X1 = 2

ln(Estimated odds ratio) = 0.1 + 0.5X1i + 0.2X2i

a. Develop a logistic regression model to predict the
probability that a student selects Pizza Hut based on the
price of the pizza. Is price an important indicator of pur-
chase selection?

b. Develop a logistic regression model to predict the proba-
bility that a student selects Pizza Hut based on the price
of the pizza and the gender of the student. Is price an
important indicator of purchase selection? Is gender an
important indicator of purchase selection?

c. Compare the results from (a) and (b). Which model
would you choose? Discuss.

d. Using the model selected in (c), predict the probability
that a student will select Pizza Hut if the price is $8.99.

e. Using the model selected in (c), predict the probability
that a student will select Pizza Hut if the price is $11.49.

f. Using the model selected in (c), predict the probability
that a student will select Pizza Hut if the price is $13.99.

14.56 The director of graduate studies at a college of business
wants to predict the success of students in an MBA program us-
ing two independent variables, undergraduate grade point aver-
age (GPA) and GMAT score. A random sample of 30 students
(stored in ) indicates that 20 successfully completed the
program (coded as 1) and 10 did not (coded as 0).

MBA

Success
in MBA
Program

Under-
graduate

GPA
GMAT
Score

Success
in MBA
Program

Under-
graduate

GPA
GMAT
Score

0 2.93 617 1 3.17 639
0 3.05 557 1 3.24 632
0 3.11 599 1 3.41 639
0 3.24 616 1 3.37 619
0 3.36 594 1 3.46 665
0 3.41 567 1 3.57 694
0 3.45 542 1 3.62 641
0 3.60 551 1 3.66 594
0 3.64 573 1 3.69 678
0 3.57 536 1 3.70 624
1 2.75 688 1 3.78 654
1 2.81 647 1 3.84 718
1 3.03 652 1 3.77 692
1 3.10 608 1 3.79 632
1 3.06 680 1 3.97 784

a. Develop a logistic regression model to predict the probabil-
ity of successful completion of the MBA program based on
undergraduate grade point average and GMAT score.

b. Explain the meaning of the regression coefficients for the
model in (a).

c. Predict the probability of successful completion of the
program for a student with an undergraduate grade point
average of 3.25 and a GMAT score of 600.

d. At the 0.05 level of significance, is there evidence that a
logistic regression model that uses undergraduate grade



I
n the Using Statistics scenario, you were the marketing manager for
OmniFoods, a large food products company planning a nationwide
introduction of a new high-energy bar, OmniPower. You needed to
determine the effect that price and in-store promotions would have

on sales of OmniPower in order to develop an effective marketing strategy.
A sample of 34 stores in a supermarket chain was selected for a test-mar-
ket study. The stores charged between 59 and 99 cents per bar and were

given an in-store promotion budget between $200 and $600.
At the end of the one-month test-market study, you performed a multiple regression analy-

sis on the data. Two independent variables were considered: the price of an OmniPower bar and
the monthly budget for in-store promotional expenditures. The dependent variable was the num-
ber of OmniPower bars sold in a month. The coefficient of determination indicated that 75.8%
of the variation in sales was explained by knowing the price charged and the amount spent on
in-store promotions. The model indicated that the predicted sales of OmniPower are estimated
to decrease by 532 bars per month for each 10-cent increase in the price, and the predicted sales
are estimated to increase by 361 bars for each additional $100 spent on promotions.

After studying the relative effects of price and promotion, OmniFoods needs to set price and
promotion standards for a nationwide introduction (obviously, lower prices and higher promotion
budgets lead to more sales, but they do so at a lower profit margin). You determined that if stores
spend $400 a month for in-store promotions and charge 79 cents, the 95% confidence interval es-
timate of the mean monthly sales is 2,854 to 3,303 bars. OmniFoods can multiply the lower and
upper bounds of this confidence interval by the number of stores included in the nationwide intro-
duction to estimate total monthly sales. For example, if 1,000 stores are in the nationwide intro-
duction, then total monthly sales should be between 2.854 million and 3.308 million bars.

U S I N G S TAT I S T I C S @ OmniFoods Revisited

S U M M A R Y
In this chapter, you learned how multiple regression models
allow you to use two or more independent variables to pre-
dict the value of a dependent variable. You also learned how
to include categorical independent variables and interaction

terms in regression models. In addition, you used the logis-
tic regression model to predict a categorical dependent vari-
able. Figure 14.15 presents a roadmap of the chapter.
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whether the customer had previously stayed at the hotel. The
data are stored in the file .
a. Develop a logistic regression model to predict the probabil-

ity that the customer will be satisfied ( unfavorable,
favorable), based on the delivery time difference and

whether the customer had previously stayed at the hotel.
b. Explain the meaning of the regression coefficients for the

model in (a).
c. Predict the probability that the customer will be satisfied

if the delivery time difference is �3 minutes and he or
she did not previously stay at the hotel.

d. At the 0.05 level of significance, is there evidence that a
logistic regression model that uses delivery time differ-
ence and whether the customer had previously stayed at
the hotel is a good-fitting model?

e. At the 0.05 level of significance, is there evidence that both
independent variables (delivery time difference and whether
the customer had previously stayed at the hotel) make a
significant contribution to the logistic regression model?

1 =
0 =

Satisfaction

point average and GMAT score to predict probability of
success in the MBA program is a good-fitting model?

e. At the 0.05 level of significance, is there evidence that under-
graduate grade point average and GMAT score each make a
significant contribution to the logistic regression model?

f. Develop a logistic regression model that includes only
undergraduate grade point average to predict probability
of success in the MBA program.

g. Develop a logistic regression model that includes only
GMAT score to predict probability of success in the
MBA program.

h. Compare the models in (a), (f), and (g). Evaluate the dif-
ferences among the models.

14.57 A hotel has designed a new system for room service
delivery of breakfast that allows the customer to select a
specific delivery time. The difference between the actual
and requested delivery times was recorded (a negative time
means that the breakfast was delivered before the requested
time) for 30 deliveries on a particular day along with
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No

No

No

No

Yes

Yes

Yes

Yes

Predict
Y

Estimate
βj

Is the
Dependent

Variable
Numerical

?

Multiple
Regression

Determine Whether
Interaction Term(s)

Are Significant

 Fit the
Selected Model

Does the
Model Contain

Dummy Variables
and/or Interaction

Terms
?

Residual
Analysis

Test Portions
of Model

Logistic
Regression

Use Model for
Prediction and

Estimation

Are the
Assumptions
of Regression

Satisfied
?

 Test Overall
Model Significance

H0: β1 = β2 = . . .  = βk = 0

Is Overall
Model

Significant
?

Estimate
μ
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Roadmap for multiple
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Multiple Regression Model with k Independent Variables

(14.1)

Multiple Regression Model with Two Independent Variables

(14.2)

Multiple Regression Equation with Two Independent
Variables

(14.3)

Coefficient of Multiple Determination

(14.4)

Adjusted

(14.5)

Overall F Test

(14.6)

Testing for the Slope in Multiple Regression

(14.7)

Confidence Interval Estimate for the Slope

(14.8)

Determining the Contribution of an Independent Variable
to the Regression Model

(14.9)

Contribution of Variable Given That Has Been
Included

(14.10a)

Contribution of Variable Given That Has Been
Included

(14.10b)SSR1X2|X12 = SSR1X1 and X22 - SSR1X12

X1X2,

SSR1X1|X22 = SSR1X1 and X22 - SSR1X22

X2X1,

SSR(Xj|All Xs except j) = SSR (All Xs) - SSR (All Xs except j)

bj ; ta>2Sbj

tSTAT =
bj - bj

Sbj

FSTAT =
MSR

MSE

r2
adj = 1 - c11 - r22 n - 1

n - k - 1
d

r 2

r2 =
Regression sum of squares

Total sum of squares
=

SSR

SST

YNi = b0 + b1X1i + b2 X2i

Yi = b0 + b1X1i + b2X2i + ei

Yi = b0 + b1X1i + b2X2i + b3X3i + Á + bkXki + ei

K E Y E Q U AT I O N S
Partial F Test Statistic

(14.11)

Relationship Between a t Statistic and an F Statistic

(14.12)

Coefficients of Partial Determination for a Multiple
Regression Model Containing Two Independent Variables

(14.13a)

and

(14.13b)

Coefficient of Partial Determination for a Multiple
Regression Model Containing k Independent Variables

(14.14)

Odds Ratio

(14.15)

Logistic Regression Model

(14.16)

Logistic Regression Equation

(14.17)

Estimated Odds Ratio

(14.18)

Estimated Probability of an Event of Interest

(14.19)

Estimated probability of an event of interest =
Estimated odds ratio

1+Estimated odds ratio

Estimated odds ratio = eln(Estimated odds ratio)

ln(Estimated odds ratio) = b0 + b1X1i + b2X2i + Á + bkXki

ln(Odds ratio) = b0 + b1X1i + b2X2i + Á + bkXki + ei

Odds ratio =
Probability of an event of interest

1 - Probability of an event of interest

r 2
Yj.1All variables except j2 =

SSR1Xj|All Xs except j2
SST - SSR1All Xs2 + SSR1Xj|All Xs except j2

r2
Y2.1 =

SSR1X2|X12
SST - SSR1X1 and X22 + SSR1X2|X12

r2
Y1.2 =

SSR1X1|X22
SST - SSR1X1 and X22 + SSR1X1|X22

t2STAT = FSTAT

FSTAT =
SSR1Xj|All Xs except j2

MSE
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K E Y T E R M S

C H A P T E R R E V I E W P R O B L E M S

adjusted 585
coefficient of multiple 

determination 584
coefficient of partial

determination 597
cross-product term 602

r2 deviance statistic 612
dummy variable 599
interaction 602
interaction term 602
logistic regression 609
multiple regression model 578

net regression coefficient 581
odds ratio 609
overall F test 585
partial F test 593
Wald statistic 612

CHECKING YOUR UNDERSTANDING
14.58 What is the difference between and adjusted 

14.59 How does the interpretation of the regression coef-
ficients differ in multiple regression and simple linear re-
gression?

14.60 How does testing the significance of the entire mul-
tiple regression model differ from testing the contribution of
each independent variable?

14.61 How do the coefficients of partial determination
differ from the coefficient of multiple determination?

14.62 Why and how do you use dummy variables?

14.63 How can you evaluate whether the slope of the de-
pendent variable with an independent variable is the same
for each level of the dummy variable?

14.64 Under what circumstances do you include an inter-
action term in a regression model?

14.65 When a dummy variable is included in a regression
model that has one numerical independent variable, what as-
sumption do you need to make concerning the slope be-
tween the dependent variable, Y, and the numerical
independent variable, X?

14.66 When do you use logistic regression?

APPLYING THE CONCEPTS
14.67 Increasing customer satisfaction typically results
in increased purchase behavior. For many products, there
is more than one measure of customer satisfaction. In
many of these instances, purchase behavior can increase
dramatically with an increase in any one of the customer
satisfaction measures, not necessarily all of them at the
same time. Gunst and Barry (“One Way to Moderate
Ceiling Effects,” Quality Progress, October 2003, pp.
83–85) consider a product with two satisfaction measures,

and that range from the lowest level of satisfaction,
1, to the highest level of satisfaction, 7. The dependent
variable, Y, is a measure of purchase behavior, with the

X2,X1

r2?r2

highest value generating the most sales. The following re-
gression equation is presented:

Suppose that is the perceived quality of the product
and is the perceived value of the product. (Note: If the
customer thinks the product is overpriced, he or she per-
ceives it to be of low value and vice versa.)
a. What is the predicted purchase behavior when

and
b. What is the predicted purchase behavior when

and
c. What is the predicted purchase behavior when

and
d. What is the predicted purchase behavior when

and
e. What is the regression equation when What is

the slope for now?
f. What is the regression equation when What is

the slope for now?
g. What is the regression equation when What is

the slope for now?
h. What is the regression equation when What is

the slope for now?
i. Discuss the implications of (a) through (h) within the

context of increasing sales for this product with two cus-
tomer satisfaction measures.

14.68 The owner of a moving company typically has his
most experienced manager predict the total number of labor
hours that will be required to complete an upcoming move.
This approach has proved useful in the past, but the owner
has the business objective of developing a more accurate
method of predicting labor hours. In a preliminary effort to
provide a more accurate method, the owner has decided to
use the number of cubic feet moved and the number of
pieces of large furniture as the independent variables and
has collected data for 36 moves in which the origin and
destination were within the borough of Manhattan in New
York City and the travel time was an insignificant portion of
the hours worked. The data are organized and stored in

.Moving

X2

X1 = 7?
X2

X1 = 2?
X1

X2 = 7?
X1

X2 = 2?
X2 = 7?

X1 = 7
X2 = 2?

X1 = 7
X2 = 7?

X1 = 2
X2 = 2?

X1 = 2

X2

X1

YNi = -3.888 + 1.449 X1i + 1.462 X2i - 0.190 X1i X2i



a. State the multiple regression equation.
b. Interpret the meaning of the slopes in this equation.
c. Predict the labor hours for moving 500 cubic feet with

two large pieces of furniture.
d. Perform a residual analysis on your results and determine

whether the regression assumptions are valid.
e. Determine whether there is a significant relationship be-

tween labor hours and the two independent variables (the
number of cubic feet moved and the number of pieces of
large furniture) at the 0.05 level of significance.

f. Determine the p-value in (e) and interpret its meaning.
g. Interpret the meaning of the coefficient of multiple deter-

mination in this problem.
h. Determine the adjusted 
i. At the 0.05 level of significance, determine whether each

independent variable makes a significant contribution to
the regression model. Indicate the most appropriate re-
gression model for this set of data.

j. Determine the p-values in (i) and interpret their meaning.
k. Construct a 95% confidence interval estimate of the pop-

ulation slope between labor hours and the number of cu-
bic feet moved. How does the interpretation of the slope
here differ from that in Problem 13.44 on page 552?

l. Compute and interpret the coefficients of partial determi-
nation.

14.69 Professional basketball has truly become a sport
that generates interest among fans around the world. More
and more players come from outside the United States to
play in the National Basketball Association (NBA). You
want to develop a regression model to predict the number of
wins achieved by each NBA team, based on field goal
(shots made) percentage for the team and for the opponent.
The data are stored in .
a. State the multiple regression equation.
b. Interpret the meaning of the slopes in this equation.
c. Predict the number of wins for a team that has a field

goal percentage of 45% and an opponent field goal per-
centage of 44%.

d. Perform a residual analysis on your results and determine
whether the regression assumptions are valid.

e. Is there a significant relationship between number of
wins and the two independent variables (field goal per-
centage for the team and for the opponent) at the 0.05
level of significance?

f. Determine the p-value in (e) and interpret its meaning.
g. Interpret the meaning of the coefficient of multiple

determination in this problem.
h. Determine the adjusted 
i. At the 0.05 level of significance, determine whether each

independent variable makes a significant contribution to
the regression model. Indicate the most appropriate re-
gression model for this set of data.

j. Determine the p-values in (i) and interpret their meaning.
k. Compute and interpret the coefficients of partial

determination.

r2.

NBA2010

r2.

14.70 A sample of 30 recently sold single-family houses
in a small city is selected. Develop a model to predict the
selling price (in thousands of dollars), using the assessed
value (in thousands of dollars) as well as time (in months
since reassessment). The houses in the city had been re-
assessed at full value one year prior to the study. The results
are stored in .
a. State the multiple regression equation.
b. Interpret the meaning of the slopes in this equation.
c. Predict the selling price for a house that has an assessed value

of $170,000 and was sold 12 months after reassessment.
d. Perform a residual analysis on your results and deter-

mine whether the regression assumptions are valid.
e. Determine whether there is a significant relationship be-

tween selling price and the two independent variables
(assessed value and time period) at the 0.05 level of
significance.

f. Determine the p-value in (e) and interpret its meaning.
g. Interpret the meaning of the coefficient of multiple deter-

mination in this problem.
h. Determine the adjusted 
i. At the 0.05 level of significance, determine whether each

independent variable makes a significant contribution to
the regression model. Indicate the most appropriate re-
gression model for this set of data.

j. Determine the p-values in (i) and interpret their meaning.
k. Construct a 95% confidence interval estimate of the pop-

ulation slope between selling price and assessed value.
How does the interpretation of the slope here differ from
that in Problem 13.76 on page 565?

l. Compute and interpret the coefficients of partial determi-
nation.

14.71 Measuring the height of a California redwood tree
is very difficult because these trees grow to heights over
300 feet. People familiar with these trees understand that
the height of a California redwood tree is related to other
characteristics of the tree, including the diameter of the tree
at the breast height of a person (in inches) and the thickness
of the bark of the tree (in inches). The file contains
the height, diameter at breast height of a person, and bark
thickness for a sample of 21 California redwood trees.
a. State the multiple regression equation that predicts the

height of a tree, based on the tree’s diameter at breast
height and the thickness of the bark.

b. Interpret the meaning of the slopes in this equation.
c. Predict the height for a tree that has a breast height diam-

eter of 25 inches and a bark thickness of 2 inches.
d. Interpret the meaning of the coefficient of multiple deter-

mination in this problem.
e. Perform a residual analysis on the results and determine

whether the regression assumptions are valid.
f. Determine whether there is a significant relationship be-

tween the height of redwood trees and the two
independent variables (breast-height diameter and bark
thickness) at the 0.05 level of significance.

Redwood

r2.

House1
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House
Assessed Value
($Thousands)

Size of House
(Thousands of
Square Feet)

Age
(Years)

1 184.4 2.00 3.42
2 177.4 1.71 11.50
3 175.7 1.45 8.33
4 185.9 1.76 0.00
5 179.1 1.93 7.42
6 170.4 1.20 32.00
7 175.8 1.55 16.00
8 185.9 1.93 2.00
9 178.5 1.59 1.75

10 179.2 1.50 2.75
11 186.7 1.90 0.00
12 179.3 1.39 0.00
13 174.5 1.54 12.58
14 183.8 1.89 2.75
15 176.8 1.59 7.17

g. Construct a 95% confidence interval estimate of the pop-
ulation slope between the height of redwood trees and
breast-height diameter and between the height of red-
wood trees and the bark thickness.

h. At the 0.05 level of significance, determine whether each
independent variable makes a significant contribution to
the regression model. Indicate the independent variables
to include in this model.

i. Construct a 95% confidence interval estimate of the
mean height for trees that have a breast-height diameter
of 25 inches and a bark thickness of 2 inches, along with
a prediction interval for an individual tree.

j. Compute and interpret the coefficients of partial determi-
nation.

14.72 Develop a model to predict the assessed value (in
thousands of dollars), using the size of the houses (in thou-
sands of square feet) and the age of the houses (in years)
from the following table (stored in ):House2

j. Determine the p-values in (i) and interpret their meaning.
k. Construct a 95% confidence interval estimate of the

population slope between assessed value and size. How
does the interpretation of the slope here differ from that
of Problem 13.77 on page 566?

l. Compute and interpret the coefficients of partial deter-
mination.

m. The real estate assessor’s office has been publicly quoted
as saying that the age of a house has no bearing on its as-
sessed value. Based on your answers to (a) through (l),
do you agree with this statement? Explain.

14.73 Crazy Dave, a well-known baseball analyst, wants
to determine which variables are important in predicting a
team’s wins in a given season. He has collected data related
to wins, earned run average (ERA), and runs scored for the
2009 season (stored in ). Develop a model to pre-
dict the number of wins based on ERA and runs scored.
a. State the multiple regression equation.
b. Interpret the meaning of the slopes in this equation.
c. Predict the number of wins for a team that has an ERA

of 4.50 and has scored 750 runs.
d. Perform a residual analysis on the results and determine

whether the regression assumptions are valid.
e. Is there a significant relationship between number of

wins and the two independent variables (ERA and runs
scored) at the 0.05 level of significance?

f. Determine the p-value in (e) and interpret its meaning.
g. Interpret the meaning of the coefficient of multiple de-

termination in this problem.
h. Determine the adjusted 
i. At the 0.05 level of significance, determine whether

each independent variable makes a significant contribu-
tion to the regression model. Indicate the most appropri-
ate regression model for this set of data.

j. Determine the p-values in (i) and interpret their meaning.
k. Construct a 95% confidence interval estimate of the

population slope between wins and ERA.
l. Compute and interpret the coeff icients of partial

determination.
m. Which is more important in predicting wins—pitching,

as measured by ERA, or offense, as measured by runs
scored? Explain.

14.74 Referring to Problem 14.73, suppose that in addition to
using ERA to predict the number of wins, Crazy Dave wants to
include the league ( American, National) as an inde-
pendent variable. Develop a model to predict wins based on ERA
and league. For (a) through (k), do not include an interaction term.
a. State the multiple regression equation.
b. Interpret the slopes in (a).
c. Predict the number of wins for a team with an ERA of

4.50 in the American League. Construct a 95%
confidence interval estimate for all teams and a 95%
prediction interval for an individual team.

d. Perform a residual analysis on the results and determine
whether the regression assumptions are valid.

1 =0 =

r2.

BB2009

a. State the multiple regression equation.
b. Interpret the meaning of the slopes in this equation.
c. Predict the assessed value for a house that has a size of

1,750 square feet and is 10 years old.
d. Perform a residual analysis on the results and determine

whether the regression assumptions are valid.
e. Determine whether there is a significant relationship be-

tween assessed value and the two independent variables
(size and age) at the 0.05 level of significance.

f. Determine the p-value in (e) and interpret its meaning.
g. Interpret the meaning of the coefficient of multiple deter-

mination in this problem.
h. Determine the adjusted 
i. At the 0.05 level of significance, determine whether each

independent variable makes a significant contribution to
the regression model. Indicate the most appropriate
regression model for this set of data.

r2.



e. Is there a significant relationship between wins and the
two independent variables (ERA and league) at the 0.05
level of significance?

f. At the 0.05 level of significance, determine whether each
independent variable makes a contribution to the regres-
sion model. Indicate the most appropriate regression
model for this set of data.

g. Construct a 95% confidence interval estimate of the pop-
ulation slope for the relationship between wins and ERA.

h. Construct a 95% confidence interval estimate of the
population slope for the relationship between wins and
league.

i. Compute and interpret the adjusted 
j. Compute and interpret the coefficients of partial

determination.
k. What assumption do you have to make about the slope of

wins with ERA?
l. Add an interaction term to the model and, at the 0.05

level of significance, determine whether it makes a sig-
nificant contribution to the model.

m.On the basis of the results of (f) and (l), which model is
most appropriate? Explain.

14.75 You are a real estate broker who wants to compare
property values in Glen Cove and Roslyn (which are located
approximately 8 miles apart). In order to do so, you will

r2.

analyze the data in , a file that includes samples
of houses from Glen Cove and Roslyn. Making sure to in-
clude the dummy variable for location (Glen Cove or
Roslyn), develop a regression model to predict appraised
value, based on the land area of a property, the age of a
house, and location. Be sure to determine whether any inter-
action terms need to be included in the model.

14.76 A recent article discussed a metal deposition
process in which a piece of metal is placed in an acid bath
and an alloy is layered on top of it. The business objective
of engineers working on the process was to reduce varia-
tion in the thickness of the alloy layer. To begin, the tem-
perature and the pressure in the tank holding the acid bath
are to be studied as independent variables. Data are col-
lected from 50 samples. The results are organized and
stored in . (Data extracted from J. Conklin, “It’s
a Marathon, Not a Sprint,” Quality Progress, June 2009,
pp. 46–49.)

Develop a multiple regression model that uses tempera-
ture and the pressure in the tank holding the acid bath to
predict the thickness of the alloy layer. Be sure to perform a
thorough residual analysis. The article suggests that there is
a significant interaction between the pressure and the tem-
perature in the tank. Do you agree?

Thickness

GCRoslyn

M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
In its continuing study of the 3-For-All subscription
solicitation process, a marketing department team wants to
test the effects of two types of structured sales presentations
(personal formal and personal informal) and the number of
hours spent on telemarketing on the number of new
subscriptions. The staff has recorded these data in the file

for the past 24 weeks.AMS14

Analyze these data and develop a multiple regres-
sion model to predict the number of new subscriptions
for a week, based on the number of hours spent on
telemarketing and the sales presentation type. Write a
report, giving detailed f indings concerning the regres-
sion model used.

D I G I TA L C A S E
Apply your knowledge of multiple regression models in this
Digital Case, which extends the OmniFoods Using Statistics
scenario from this chapter.

To ensure a successful test marketing of its OmniPower energy
bars, the OmniFoods marketing department has contracted with
In-Store Placements Group (ISPG), a merchandising consul-
tancy. ISPG will work with the grocery store chain that is con-
ducting the test-market study. Using the same 34-store sample
used in the test-market study, ISPG claims that the choice of
shelf location and the presence of in-store OmniPower coupon
dispensers both increase sales of the energy bars.

Open Omni_ISPGMemo.pdf to review the ISPG claims
and supporting data. Then answer the following questions:

1. Are the supporting data consistent with ISPG’s claims?
Perform an appropriate statistical analysis to confirm
(or discredit) the stated relationship between sales and
the two independent variables of product shelf location
and the presence of in-store OmniPower coupon
dispensers.

2. If you were advising OmniFoods, would you recom-
mend using a specific shelf location and in-store coupon
dispensers to sell OmniPower bars?

3. What additional data would you advise collecting in
order to determine the effectiveness of the sales
promotion techniques used by ISPG?

620 CHAPTER 14 Introduction to Multiple Regression
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EG14.1 DEVELOPING a MULTIPLE
REGRESSION MODEL

Interpreting the Regression Coefficients

PHStat2 Use Multiple Regression to perform a multiple
regression analysis. For example, to perform the Figure 14.2
analysis of the OmniPower sales data on page 580, open to
the DATA worksheet of the OmniPower workbook. Select
PHStat ➔ Regression ➔ Multiple Regression, and in the
procedure’s dialog box (shown below):

1. Enter A1:A35 as the Y Variable Cell Range.

2. Enter B1:C35 as the X Variables Cell Range.

3. Check First cells in both ranges contain label.

4. Enter 95 as the Confidence level for regression coeffi-
cients.

5. Check Regression Statistics Table and ANOVA and
Coefficients Table.

6. Enter a Title and click OK.

regression. Columns A through I of this worksheet duplicate
the visual design of the Analysis ToolPak regression work-
sheet. The worksheet uses the regression data in the
MRData worksheet to perform the regression analysis for
the OmniPower sales data.

Figure 14.2 does not show the columns K through N
Calculations area. This area contains a LINEST(cell range

of Y variable, cell range of X variable, True, True) array
formula in the cell range L2:N6 and calculations for the t
test of the slope (see Section 13.7 on page 548). The array
formula computes the and coefficients in cells L2,
M2, and N2; the and standard error in cells L3,
M3, and N3; and the standard error of the estimate in
cells L4 and M4; the F test statistic and error df in cells L5
and M5; and SSR and SSE in cells L6 and M6. (The rest of
the cell range, N4, N5, and N6, displays the #N/A message.
This is not an error.)

Open to the COMPUTE_FORMULAS worksheet to
examine all the formulas in the worksheet, some of which
are discussed in the Chapter 13 Excel Guide In-Depth Excel
sections.

To perform multiple regression analyses for other data,
paste the regression data into the MRData worksheet. Paste
the values for the Y variable into column A. Paste the values
for the X variables into consecutive columns, starting with col-
umn B. Open to the COMPUTE worksheet. First, enter the
confidence level in cell L8. Then, edit the correct 5-row-by–
3-column array of cells that starts with cell L2. First adjust the
range of the array, adding a column for each independent vari-
able in excess of two. Then, edit the cell ranges in the array
formula, and then, while holding down the Control and Shift
keys (or the Apple key on a Mac), press the Enter key.

Analysis ToolPak Use Regression to perform a multiple
regression analysis. For example, to perform the Figure 14.2
analysis of the OmniPower sales data on page 580, open to
the DATA worksheet of the OmniPower workbook and:

1. Select Data ➔ Data Analysis.

2. In the Data Analysis dialog box, select Regression from
the Analysis Tools list and then click OK.

In the Regression dialog box (shown on page 623):

3. Enter A1:A35 as the Input Y Range and enter B1:C35
as the Input X Range.

4. Check Labels and check Confidence Level and enter
95 in its box.

5. Click New Worksheet Ply.

6. Click OK.

r2
b0b2, b1,

b0b2, b1,

C H A P T E R 1 4 E X C E L G U I D E

The procedure creates a worksheet that contains a copy
of your data in addition to the regression results worksheet
shown in Figure 14.2. For more information about these
worksheets, read the following In-Depth Excel section.

In-Depth Excel Use the COMPUTE worksheet of the
Multiple Regression workbook, partially shown in Figure
14.2 on page 580, as a template for performing multiple
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Predicting the Dependent Variable Y

PHStat2 Use the “Interpreting the Regression Coeffi-
cients” PHStat2 instructions but replace step 6 with the fol-
lowing steps 6 through 8:

6. Check Confidence Interval Estimate & Prediction In-
terval and enter 95 as the percentage for Confidence
level for intervals.

7. Enter a Title and click OK.

8. In the new worksheet, enter 79 in cell B6 and enter 400
in cell B7.

These steps create a new worksheet that is discussed in the
following In-Depth Excel instructions.

In-Depth Excel Use the CIEandPI worksheet of the
Multiple Regression workbook, shown in Figure 14.3 on
page 582, as a template for computing confidence interval
estimates and prediction intervals for a multiple regression
model with two independent variables. The worksheet con-
tains the data and formulas for the OmniPower sales exam-
ple shown in Figure 14.3. The worksheet uses several array
formulas to use functions that perform matrix operations to
compute the matrix product (in cell range B9:D11), the
inverse of the matrix (in cell range B13:D15), the prod-
uct of multiplied by the inverse of (in cell range
B17:D17), and the predicted Y (in cell B21). (Open to the
CIEandPI_FORMULAS worksheet to examine all
formulas.)

Modifying this worksheet for other models with more
than two independent variables requires knowledge that is
beyond the scope of this book. For other models with two
independent variables, paste the data for those variables into
columns B and C of the MRArray worksheet and adjust
the number of entries in column A (all of which are 1). Then
open to the COMPUTE worksheet and edit the array for-
mula in cell range B9:D11 and edit the labels in cells A6
and A7.

EG14.2 r2, ADJUSTED r2, and the 
OVERALL F TEST

The coefficient of multiple determination, the adjusted
and the overall F test are all computed as part of creatingr2,

r2,

X¿XX¿G
X¿X

X¿X

the multiple regression results worksheet using the Section
EG14.1 instructions. If you use either the PHStat2 or In-
Depth Excel instructions, formulas are used to compute
these results in the COMPUTE worksheet. Formulas in
cells B5, B7, B13, C12, C13, D12, and E12 copy values
computed by an array formula in cell range L2:N6 and in
cell F12, the expression FDIST(F test statistic, 1, error de-

grees of freedom) computes the p-value for the overall F
test.

EG14.3 RESIDUAL ANALYSIS for the
MULTIPLE REGRESSION MODEL

PHStat2 Use the Section EG14.1 “Interpreting the Regres-
sion Coefficients” PHStat2 instructions. Modify step 5 by
checking Residuals Table and Residual Plots in addition to
checking Regression Statistics Table and ANOVA and Co-
efficients Table.

In-Depth Excel Create a worksheet that calculates residu-
als and then create a scatter plot of the original X variable
and the residuals (plotted as the Y variable).

Use the RESIDUALS worksheet of the Multiple Re-
gression workbook as a template for creating a residuals
worksheet. The formulas in this worksheet compute the
residuals for the multiple regression model for the Om-
niPower sales example by using the regression data in the
MRData worksheet in the same workbook. In column D,
the worksheet computes the predicted Y values by multiply-
ing the values by the coefficient and the values by
the coefficient and adding these products to the coef-
ficient. In column F, the worksheet computes residuals by
subtracting the predicted Y values from the Y values. (Open
to the RESIDUALS_FORMULAS worksheet to examine
all formulas.) For other problems, modify this worksheet as
follows:

1. If the number of independent variables is greater than 2,
select column D, right-click, and click Insert from the
shortcut menu. Repeat this step as many times as neces-
sary to create the additional columns to hold all the X
variables.

2. Paste the data for the X variables into columns, starting
with column B.

3. Paste Y values in column E (or in the second-to-last col-
umn if there are more than two X variables).

4. For sample sizes smaller than 34, delete the extra rows.
For sample sizes greater than 34, copy the predicted Y
and residuals formulas down through the row containing
the last pair of X and Y values. Also, add the new obser-
vation numbers in column A.

To create residual plots, use copy-and-paste special val-
ues (see Appendix Section F.6) to paste data values on a new
worksheet in the proper order before applying the Section
EG2.6 scatter plot instructions.

b0b2

X2b1X1



Analysis ToolPak Use the Section EG14.1 Analysis Tool-
Pak instructions. Modify step 5 by checking Residuals and
Residual Plots before clicking New Worksheet Ply and
then OK. (Note that the Residuals Plots option creates
residual plots only for each independent variable.)

EG14.4 INFERENCES CONCERNING 
the POPULATION REGRESSION
COEFFICIENTS

The regression results worksheets created by using the
EG14.1 instructions include the information needed to
make the inferences discussed in Section 14.4.

EG14.5 TESTING PORTIONS of the
MULTIPLE REGRESSION MODEL

PHStat2 Use the Section EG14.1 “Interpreting the Regres-
sion Coefficients” PHStat2 instructions but modify step 6
by checking Coefficients of Partial Determination before
you click OK.

In-Depth Excel You compute the coefficients of partial de-
termination by using a two-step process. You first use the
Section EG14.1 In-Depth Excel instructions to create all
possible regression results worksheets in a copy of the
Multiple Regression workbook. For example, if you have
two independent variables, you perform three regression
analyses: Y with and Y with and Y with to cre-
ate three regression results worksheets. Then open to the
CPD worksheet for the number of independent variables
(CPD_2, CPD_3, and CPD_4 worksheets are included)
and follow the italicized instructions to copy and paste spe-
cial values from the regression results worksheets. The
CPD_2 worksheet contains the data to compute the coeffi-
cients of partial determination for the OmniPower regres-
sion model used as an example in Section 14.5.

EG14.6 USING DUMMY VARIABLES
and INTERACTION TERMS 
in REGRESSION MODELS

Dummy Variables

Use Find and Replace to create a dummy variable from a
two-level categorical variable. Before using Find and Re-
place, copy and paste the categorical values to another col-
umn in order to preserve the original values.

X2,X1,X2,X1

For example, to create a dummy variable named Fire-
placeCoded from the two-level categorical variable Fire-
place as shown in Table 14.5 on page 600, open to the DATA
worksheet of the House3 workbook and:

1. Copy and paste the Fireplace values in column C to col-
umn D (the first empty column).

2. Select column D.

3. Press Ctrl+H (the keyboard shortcut for Find and
Replace).

In the Find and Replace dialog box:

4. Enter Yes in the Find what box and enter 1 in the
Replace with box.

5. Click Replace All. If a message box to confirm the re-
placement appears, click OK to continue.

6. Enter No in the Find what box and enter 0 in the
Replace with box.

7. Click Replace All. If a message box to confirm the
replacement appears, click OK to continue.

8. Click Close.

Categorical variables that have more than two levels
require the use of formulas in multiple columns. For
example, to create the dummy variables for Example 14.3
on page 601, two columns are needed. Assume that the three-
level categorical variable mentioned in the example
is in Column D of the opened worksheet. A first new
column that contains formulas in the form

and a second new
column that contains formulas in the form

would properly
create the two dummy variables that the example requires.

Interactions

To create an interaction term, add a column of formulas that
multiply one independent variable by another. For example,
if the first independent variable appeared in column B and
the second independent variable appeared in column C, en-
ter the formula in the row 2 cell of an empty
new column and then copy the formula down through all
rows of data to create the interaction.

EG14.7 LOGISTIC REGRESSION

There are no Excel Guide instructions for this section.

= B2 * C2

=IF(column D cell = second level, 1, 0)

=IF(column D cell = first level, 1, 0)
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MG14.1 DEVELOPING a MULTIPLE
REGRESSION MODEL

Visualizing Multiple Regression Data

Use 3D Scatterplot to create a three-dimensional plot for
the special case of a regression model that contains two in-
dependent variables. For example, to create the Figure 14.1
plot on page 579 for the OmniPower sales data, open the
OmniPower worksheet. Select Graph ➔ 3D Scatterplot.
In the 3D Scatterplots dialog box, click Simple and then
click OK. In the 3D Scatterplot - Simple dialog box (shown
below):

1. Double-click C1 Sales in the variables list to add Sales
to the Z variable box.

2. Double-click C2 Price in the variables list to add
Price to the Y variable box.

3. Double-click C3 Promotion in the variables list to add
Promotion to the X variable box.

4. Click Data View.

3. Double-click C3 Promotion in the variables list to add
Promotion to the Predictors box.

4. Click Graphs.

In the Regression - Graphs dialog box (shown below):

5. Click Regular and Individual Plots.

6. Check Histogram of residuals and clear all the other
check boxes.

7. Click anywhere inside the Residuals versus the vari-
ables box.

8. Double-click C2 Price in the variables list to add
Price in the Residuals versus the variables box.

9. Double-click C3 Promotion in the variables list to add
Promotion in the Residuals versus the variables box.

10. Click OK.

C H A P T E R 1 4 M I N I TA B G U I D E

In the 3D Scatterplot - Data View dialog box:

5. Check Symbols and Project lines.

6. Click OK.

7. Back in the 3D Scatterplot - Simple dialog box, click
OK.

Interpreting the Regression coefficients

Use Regression to perform a multiple regression analysis.
For example, to perform the Figure 14.2 analysis of the Om-
niPower sales data on page 580, open to the OmniPower
worksheet. Select Stat ➔ Regression ➔ Regression. In the
Regression dialog box (shown at the top of the next column):

1. Double-click C1 Sales in the variables list to add Sales
to the Response box.

2. Double-click C2 Price in the variables list to add Price
to the Predictors box.

11. Back in the Regression dialog box, click Results.

In the Regression - Results dialog box (not shown):

12. Click In addition, the full table of fits and residuals
and then click OK.

13. Back in the Regression dialog box, click Options.
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same project file. For example, if you have two independent
variables, you perform three regression analyses—Y with
and Y with and Y with —to create three sets of re-
gression results. With those results you can then compute
the partial F test and the coefficients of partial determina-
tion using the instructions in Section 14.5.

MG14.6 USING DUMMY VARIABLES and
INTERACTION TERMS in
REGRESSION MODELS

Dummy Variables

Use Text to Numeric to create a dummy variable. For ex-
ample, to create a dummy variable named FireplaceCoded
from the categorical variable Fireplace (see Table 14.5 on
page 600), open to the House3 worksheet and select Data ➔
Code ➔ Text to Numeric. In the Code - Text to Numeric
dialog box (shown below):

1. Double-click C3 Fireplace in the variables list to add
Fireplace to the Code data from columns box and
press Tab.

2. Enter C4 in the Store coded data in columns box and
press Tab. (Column C4 is the first empty column in the
worksheet.)

3. In the first row, enter Yes in the Original Values (eg, red
“light blue”) box and enter 1 in the New box.

4. In the second row, enter No in the Original Values (eg,
red “light blue”) box and enter 0 in the New box.

5. Click OK.

X2X1,X2,
X1

In the Regression - Options dialog box (shown below):

14. Check Fit Intercept.

15. Clear all the Display and Lack of Fit Test check boxes.

16. Enter 79 and 400 in the Prediction intervals for new
observations box.

17. Enter 95 in the Confidence level box.

18. Click OK.

19. Back in the Regression dialog box, click OK.

The results in the Session Window will include a table of
residuals that is not shown in Figure 14.2.

MG14.2 r2, ADJUSTED r2, and the
OVERALL F TEST

The coefficient of multiple determination, the adjusted
and the overall F test are all computed as part of creating

the multiple regression results using the Section MG14.1 in-
structions.

MG14.3 RESIDUAL ANALYSIS for the
MULTIPLE REGRESSION MODEL

Residual analysis results are created using the Section
MG14.1 instructions.

MG14.4 INFERENCES CONCERNING 
the POPULATION REGRESSION
COEFFICIENTS

The regression results created by using the MG14.1 instruc-
tions include the information needed to make the inferences
discussed in Section 14.4.

MG14.5 TESTING PORTIONS of the
MULTIPLE REGRESSION MODEL

You compute the coefficients of partial determination by us-
ing a two-step process. You first use the Section MG14.1 in-
structions to create all possible regression results in the

r2,
r2,

6. Enter FireplaceCoded as the name of column C4.

Interactions

Use Calculator to add a new column that contains the prod-
uct of multiplying one independent variable by another to
create an interaction term. For example, to create an interac-
tion term of size and the dummy variable FireplaceCoded
(see Table 14.5 on page 600), open to the House3 worksheet.
Use the “Dummy Variables” instructions in the preceding



CHAPTER 14 Minitab Guide 627

part to create the FireplaceCoded column in the worksheet.
Select Calc ➔ Calculator. In the Calculator dialog box
(shown below):

1. Enter C5 in the Store result in variable box and press
Tab.

2. Enter Size FireplaceCoded in the Expression box.

3. Click OK.

*

Logpurch worksheet. Select Stat ➔ Regression ➔ Bi-
nary Logistic Regression. In the Binary Logistic Regres-
sion dialog box (shown below):

1. Click Response in response/frequency format and
press Tab.

2. Double-click C1 Upgraded in the variables list to add
Upgraded in the Response box.

3. Click inside the Model box.

4. Double-click C2 Purchases in the variables list to add
Purchases to the Model box.

5. Double-click C3 Extra Cards in the variables list to
add 'Extra Cards' to the Model box and press Tab.

6. Double-click C3 Extra Cards in the variables list to
add 'Extra Cards' to the Factors box (because Extra
Cards is a categorical variable).

7. Click OK.

4. Enter Size*FireplaceCoded as the name for column
C5.

MG14.7 LOGISTIC REGRESSION

Use Binary Logistic Regression to perform a logistic re-
gression. For example, to perform the Figure 14.14 analysis
of the credit card marketing data on page 611, open to
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Learning Objectives
In this chapter, you learn:

• To use quadratic terms in a regression model

• To use transformed variables in a regression model

• To measure the correlation among independent variables

• To build a regression model using either the stepwise or best-subsets approach

• To avoid the pitfalls involved in developing a multiple regression model
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A s part of your job as the operations manager at WHIT-DT, your business objective
is to reduce unnecessary labor expenses. Currently, the unionized graphic artists at
the television station receive hourly pay for a significant number of hours during
which they are idle. These hours are called standby hours. You have collected data
concerning standby hours and four factors that you suspect are related to the

excessive number of standby hours the station is currently experiencing: the total number of staff
present, remote hours, Dubner hours, and total labor hours.

You plan to build a multiple regression model to help determine which factors most heavily affect
standby hours. You believe that an appropriate model will help you to predict the number of future
standby hours, identify the root causes of excessive numbers of standby hours, and allow you to reduce
the total number of future standby hours. How do you build the model with the most appropriate mix
of independent variables? Are there statistical techniques that can help you identify a “best” model
without having to consider all possible models? How do you begin?

U S I N G S TAT I S T I C S

@ WHIT-DT
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C hapter 14 discussed multiple regression models with two independent variables. This
chapter extends regression analysis to models containing more than two independent
variables. The chapter introduces you to various topics related to model building to

help you learn to develop the best model when confronted with a set of data (such as the one
described in the WHIT-DT scenario) that has many independent variables. These topics include
quadratic independent variables, transformations of the dependent or independent variables,
stepwise regression, and best-subsets regression.

15.1 The Quadratic Regression Model
The simple regression model discussed in Chapter 13 and the multiple regression model discussed
in Chapter 14 assume that the relationship between Y and each independent variable is linear.
However, in Section 13.1, several different types of nonlinear relationships between variables were
introduced. One of the most common nonlinear relationships is a quadratic, or curvilinear, rela-
tionship between two variables in which Y increases (or decreases) at a changing rate for various
values of X (see Figure 13.2, Panels C–E, on page 523). You can use the quadratic regression
model defined in Equation (15.1) to analyze this type of relationship between X and Y.

Finding the Regression Coefficients and Predicting Y
To illustrate the quadratic regression model, consider a study that examined the business
problem facing a concrete supplier of how adding fly ash affects the strength of concrete. (Fly
ash is an inexpensive industrial waste by-product that can be used as a substitute for Portland
cement, a more expensive ingredient of concrete.) Batches of concrete were prepared in which
the percentage of fly ash ranged from 0% to 60%. Data were collected from a sample of
18 batches and organized and stored in . Table 15.1 summarizes the results.FlyAsh

QUADRATIC REGRESSION MODEL

(15.1)

where

intercept
coefficient of the linear effect on Y
coefficient of the quadratic effect on Y
random error in Y for observation iei =

b2 =
b1 =
b0 = Y

Yi = b0 + b1X1i + b2X 2
1i + ei

QUADRATIC REGRESSION EQUATION

(15.2)YNi = b0 + b1X1i + b2X 2
1i

This quadratic regression model is similar to the multiple regression model with two
independent variables [see Equation (14.2) on page 579] except that the second independent vari-
able, the quadratic term, is the square of the first independent variable. Once again, you use the
least-squares method to compute sample regression coefficients ( and ) as estimates of
the population parameters ( and ). Equation (15.2) defines the regression equation for
the quadratic model with an independent variable and a dependent variable (Y ).(X1)

b2b0, b1,
b2b0, b1,

In Equation (15.2), the first regression coefficient, represents the Y intercept; the second
regression coefficient, represents the linear effect; and the third regression coefficient,
represents the quadratic effect.

b2,b1,
b0,
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T A B L E 1 5 . 1

Fly Ash Percentage and
Strength of 18 Batches of
28-Day-Old Concrete

Fly Ash % Strength (psi) Fly Ash % Strength (psi)

0 4,779 40 5,995
0 4,706 40 5,628
0 4,350 40 5,897

20 5,189 50 5,746
20 5,140 50 5,719
20 4,976 50 5,782
30 5,110 60 4,895
30 5,685 60 5,030
30 5,618 60 4,648

F I G U R E 1 5 . 1
Scatter plot of fly ash
percentage (X ) and
strength (Y )

By creating the scatter plot in Figure 15.1 to visualize these data, you will be better able to
select the proper model for expressing the relationship between fly ash percentage and
strength.

Figure 15.1 indicates an initial increase in the strength of the concrete as the percentage
of fly ash increases. The strength appears to level off and then drop after achieving
maximum strength at about 40% fly ash. Strength for 50% fly ash is slightly below strength
at 40%, but strength at 60% fly ash is substantially below strength at 50%. Therefore, you
should fit a quadratic model, not a linear model, to estimate strength based on fly ash
percentage.

Figure 15.2 on page 632 shows regression results for these data.
From Figure 15.2,

Therefore, the quadratic regression equation is

where

predicted strength for sample i
percentage of fly ash for sample iX1i =

YNi =

YNi = 4,486.3611 + 63.0052X1i - 0.8765X2
1i

b0 = 4,486.3611 b1 = 63.0052 b2 = -0.8765
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F I G U R E 1 5 . 2
Excel and Minitab regression results for the concrete strength data

Figure 15.3 is a scatter plot of this quadratic regression equation that shows the fit of the
quadratic regression model to the original data.

F I G U R E 1 5 . 3
Scatter plot showing the
quadratic relationship
between fly ash
percentage and strength
for the concrete data

From the quadratic regression equation and Figure 15.3, the Y intercept
is the predicted strength when the percentage of fly ash is 0. To interpret the coefficients
and observe that after an initial increase, strength decreases as fly ash percentage increases.
This nonlinear relationship is further demonstrated by predicting the strength for fly ash per-
centages of 20, 40, and 60. Using the quadratic regression equation,

for

for

and for 

Yi
N = 4,486.3611 + 63.00521602 - 0.876516022 = 5,111.273

X1i = 60,

Yi
N = 4,486.3611 + 63.00521402 - 0.876514022 = 5,604.169

X1i = 40,

Yi
N = 4,486.3611 + 63.00521202 - 0.876512022 = 5,395.865

X1i = 20,

Yi
N = 4,486.3611 + 63.0052X1i - 0.8765X 2

1i

b2,
b1

1b0 = 4,486.36112
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Thus, the predicted concrete strength for 40% fly ash is 208.304 psi above the predicted
strength for 20% fly ash, but the predicted strength for 60% fly ash is 492.896 psi below the
predicted strength for 40% fly ash.

Testing for the Significance of the Quadratic Model
After you calculate the quadratic regression equation, you can test whether there is a signifi-
cant overall relationship between strength, Y, and fly ash percentage, The null and alterna-
tive hypotheses are as follows:

Equation (14.6) on page 586 defines the overall test statistic used for this test:

From the Figure 15.2 results on page 632,

If you choose a level of significance of 0.05, from Table E.5, the critical value of the F distri-
bution, with 2 and 15 degrees of freedom, is 3.68 (see Figure 15.4). Because

or because the p-value you reject the null
hypothesis and conclude that there is a significant overall relationship between strength
and fly ash percentage.

1H02
= 0.0004 6 0.05,FSTAT = 13.8351 7 3.68,

FSTAT =
MSR

MSE
=

1,347,736.745

97,414.4674
= 13.8351

FSTAT =
MSR

MSE

FSTAT

H1: b1 and>or b2 Z 0 1There is an overall relationship between X1 and Y.2
H0: b1 = b2 = 0 1There is no overall relationship between X1 and Y.2

X1.

0 F3.68

Region of
Nonrejection

Region of
Rejection

Critical
Value

F I G U R E 1 5 . 4
Testing for the existence
of the overall relationship
at the 0.05 level of
significance, with 2 and
15 degrees of freedom

Testing the Quadratic Effect
In using a regression model to examine a relationship between two variables, you want to find
not only the most accurate model but also the simplest model that expresses that relationship.
Therefore, you need to examine whether there is a significant difference between the quadratic
model:

and the linear model:

In Section 14.4, you used the t test to determine whether each independent variable makes
a significant contribution to the regression model. To test the significance of the contribution
of the quadratic effect, you use the following null and alternative hypotheses:

H1 : Including the quadratic effect significantly improves the model 1b2 Z 02.
H0 : Including the quadratic effect does not significantly improve the model 1b2 = 02.

Yi = b0 + b1X1i + ei

Yi = b0 + b1X1i + b2X2
1i + ei



A real estate developer studying the business problem of estimating the consumption of
heating oil by single-family houses has decided to examine the effect of atmospheric
temperature and the amount of attic insulation on heating oil consumption. Data are collected
from a random sample of 15 single-family houses. The data are organized and stored in

. Figure 15.6 shows the regression results for a multiple regression model using the
two independent variables: atmospheric temperature and attic insulation.
HeatingOil

EXAMPLE 15.1
Studying the
Quadratic Effect in
a Multiple
Regression Model
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The standard error of each regression coefficient and its corresponding test statistic are
part of the regression results (see Figure 15.2 on page 632). Equation (14.7) on page 590 defines
the test statistic:

If you select the 0.05 level of significance, then from Table E.3, the critical values for the t
distribution with 15 degrees of freedom are and (see Figure 15.5).+2.1315-2.1315

=
-0.8765 - 0

0.1966
= -4.4578

tSTAT =
b2 - b2

Sb2

tSTAT

tSTAT

–2.1315 +2.13150

Region of
Rejection

Region of
Nonrejection

Critical
Value

Region of
Rejection

Critical
Value

t

F I G U R E 1 5 . 5
Testing for the
contribution of the
quadratic effect to a
regression model at the
0.05 level of significance,
with 15 degrees of
freedom

Because or because the p-value you
reject and conclude that the quadratic model is significantly better than the linear model
for representing the relationship between strength and fly ash percentage.

Example 15.1 provides an additional illustration of a possible quadratic effect.

H0

= 0.0005 6 0.05,tSTAT = -4.4578 6 - 2.1315

F I G U R E 1 5 . 6
Excel and Minitab regression results for the multiple linear regression model predicting monthly consumption of
heating oil
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The residual plot for attic insulation (not shown here) contained some evidence of a quad-
ratic effect. Thus, the real estate developer reanalyzed the data by adding a quadratic term for
attic insulation to the multiple regression model. At the 0.05 level of significance, is there evi-
dence of a significant quadratic effect for attic insulation?

SOLUTION Figure 15.7 shows the results for this regression model.

F I G U R E 1 5 . 7
Excel and Minitab results for the multiple regression model with a quadratic term for attic insulation

The multiple regression equation is

To test for the significance of the quadratic effect,

From Figure 15.7 and Table E.3, (or the p-value �
). Therefore, you do not reject the null hypothesis. You conclude that there is

insufficient evidence that the quadratic effect for attic insulation is different from zero. In the
interest of keeping the model as simple as possible, you should use the multiple regression
equation shown in Figure 15.6:

Yi
N = 562.1510 - 5.4366X1i - 20.0123X2i

0.1249 7 0.05
-2.2010 6 tSTAT = 1.6611 6 2.2010

H1 : Including the quadratic effect significantly improves the model 1b3 Z 02.
H0 : Including the quadratic effect does not significantly improve the model 1b3 = 02.

Yi
N = 624.5864 - 5.3626X1i - 44.5868X2i + 1.8667X2

2i

The Coefficient of Multiple Determination
In the multiple regression model, the coefficient of multiple determination, (see Section
14.2), represents the proportion of variation in Y that is explained by variation in the independ-
ent variables. Consider the quadratic regression model you used to predict the strength of
concrete using fly ash and fly ash squared.You compute by using Equation (14.4) on page 616:

From Figure 15.2 on page 632,

Thus,

r2 =
SSR

SST
=

2,695,473.897

4,156,690.5
= 0.6485

SST = 4,156,690.5SSR = 2,695,473.897

r2 =
SSR

SST

r2

r2
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This coefficient of multiple determination indicates that 64.85% of the variation in strength is
explained by the quadratic relationship between strength and the percentage of fly ash. You
should also compute to account for the number of independent variables and the sample
size. In the quadratic regression model, because there are two independent variables,
and Thus, using Equation (14.5) on page 585,

= 0.6016

= 1 - 0.3984

= 1 - c11 - 0.6485217
15
d

r2
adj = 1 - c11 - r22 1n - 12

1n - k - 12 d

X2
1.

X1k = 2
r2

adj

Problems for Section 15.1
LEARNING THE BASICS
15.1 The following is the quadratic regression equation for
a sample of 

a. Predict Y for
b. Suppose that the computed test statistic for the

quadratic regression coefficient is 2.35. At the 0.05 level
of significance, is there evidence that the quadratic
model is better than the linear model?

c. Suppose that the computed test statistic for the
quadratic regression coefficient is 1.17. At the 0.05 level
of significance, is there evidence that the quadratic
model is better than the linear model?

d. Suppose the regression coefficient for the linear effect is
Predict Y for

APPLYING THE CONCEPTS
15.2 Businesses actively recruit business students with
well-developed higher-order cognitive skills (HOCS) such
as problem identification, analytical reasoning, and content
integration skills. Researchers conducted a study to see if
improvement in students’ HOCS was related to the students’
GPA. (Data extracted from R. V. Bradley, C. S. Sankar, H. R.
Clayton, V. W. Mbarika, and P. K. Raju, “A Study on the Im-
pact of GPA on Perceived Improvement of Higher-Order
Cognitive Skills,” Decision Sciences Journal of Innovative
Education, January 2007, 5(1), pp 151–168.) The re-
searchers conducted a study in which business students
were taught using the case study method. Using data col-
lected from 300 business students, the following quadratic
regression equation was derived:

where the dependent variable HOCS measured the improve-
ment in higher-order cognitive skills, with 1 being the

HOCS = -3.48 + 4.531GPA2 - 0.681GPA22

X1 = 2.-3.0.

tSTAT

tSTAT

X1 = 2.

Yi
N = 5 + 3X1i + 1.5X 2

1i

n = 25:

lowest improvement in HOCS and 5 being the highest
improvement in HOCS.
a. Construct a table of predicted HOCS, using GPA equal to

b. Plot the values in the table constructed in (a), with GPA on
the horizontal axis and predicted HOCS on the vertical axis.

c. Discuss the curvilinear relationship between students’
GPA and their predicted improvement in HOCS.

d. The researchers reported that the model had an of 0.07
and an adjusted of 0.06. What does this tell you about
the scatter of individual HOCS scores around the curvi-
linear relationship plotted in (b) and discussed in (c)?

15.3 A national chain of consumer electronics stores had
the business objective of determining the effectiveness of
newspaper advertising. To promote sales, the chain relies
heavily on local newspaper advertising to support its modest
exposure in nationwide television commercials. A sample of
20 cities with similar populations and monthly sales totals
were assigned different newspaper advertising budgets for
one month. The following table (stored in ) sum-
marizes the sales (in $millions) and the newspaper advertis-
ing budgets (in $thousands) observed during the study:

Advertising

r2
r2

2.0, 2.1, 2.2, Á , 4.0.

Sales
Newspaper
Advertising Sales

Newspaper
Advertising

6.14 5 6.84 15
6.04 5 6.66 15
6.21 5 6.95 20
6.32 5 6.65 20
6.42 10 6.83 20
6.56 10 6.81 20
6.67 10 7.03 25
6.35 10 6.88 25
6.76 15 6.84 25
6.79 15 6.99 25
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a. Construct a scatter plot for newspaper advertising and
sales.

b. Fit a quadratic regression model and state the quadratic
regression equation.

c. Predict the monthly sales for a city with newspaper ad-
vertising of $20,000.

d. Perform a residual analysis on the results and determine
whether the regression assumptions are valid.

e. At the 0.05 level of significance, is there a significant
quadratic relationship between monthly sales and news-
paper advertising?

f. At the 0.05 level of significance, determine whether the
quadratic model is a better fit than the linear model.

g. Interpret the meaning of the coefficient of multiple deter-
mination.

h. Compute the adjusted 

15.4 Is the number of calories in a beer related to the num-
ber of carbohydrates and/or the percentage of alcohol in the
beer? Data concerning 139 of the best-selling domestic
beers in the United States are stored in . The
values for three variables are included: the number of calo-
ries per 12 ounces, the alcohol percentage, and the number
of carbohydrates (in grams) per 12 ounces. (Data extracted
from www.Beer100.com, March 18, 2010.)
a. Perform a multiple linear regression analysis, using

calories as the dependent variable and percentage alco-
hol and number of carbohydrates as the independent
variables.

b. Add quadratic terms for alcohol percentage and the num-
ber of carbohydrates.

c. Which model is better, the one in (a) or (b)?
d. Write a short summary concerning the relationship be-

tween the number of calories in a beer and the alcohol
percentage and number of carbohydrates.

15.5 The per-store daily customer count (i.e., the mean
number of customers in a store in one day) for a nationwide
convenience store chain that operates nearly 10,000 stores
has been steady, at 900, for some time. To increase the cus-
tomer count, the chain is considering cutting prices for cof-
fee beverages. The question to be determined is how much
prices should be cut to increase the daily customer count
without reducing the gross margin on coffee sales too
much. You decide to carry out an experiment in a sample of
24 stores where customer counts have been running almost
exactly at the national average of 900. In 6 of the stores,
the price of a small coffee will now be $0.59, in 6 stores the
price of a small coffee will now be $0.69, in 6 stores,
the price of a small coffee will now be $0.79, and in 6
stores, the price of a small coffee will now be $0.89. After
four weeks at the new prices, the daily customer count in
the stores is determined and is stored in .
a. Construct a scatter plot for price and sales.

CoffeeSales2

DomesticBeer

r2.

b. Fit a quadratic regression model and state the quadratic
regression equation.

c. Predict the weekly sales for a small coffee priced at
79 cents.

d. Perform a residual analysis on the results and determine
whether the regression model is valid.

e. At the 0.05 level of significance, is there a significant
quadratic relationship between weekly sales and price?

f. At the 0.05 level of significance, determine whether the
quadratic model is a better fit than the linear model.

g. Interpret the meaning of the coefficient of multiple deter-
mination.

h. Compute the adjusted 
i. Compare the results of (a) through (h) to those of Prob-

lem 11.11 on page 428.

15.6 An agronomist designed a study in which
tomatoes were grown using six different

amounts of fertilizer: 0, 20, 40, 60, 80, and 100 pounds
per 1,000 square feet. These fertilizer application rates
were then randomly assigned to plots of land. The results
including the yield of tomatoes (in pounds) are stored in

and are listed here:Tomato

SELF
Test

r2.

Fertilizer Application Fertilizer Application

Plot Rate Yield Plot Rate Yield

1 0 6 7 60 46
2 0 9 8 60 50
3 20 19 9 80 48
4 20 24 10 80 54
5 40 32 11 100 52
6 40 38 12 100 58

a. Construct a scatter plot for fertilizer application rate and
yield.

b. Fit a quadratic regression model and state the quadratic
regression equation.

c. Predict the yield for a plot of land fertilized with 70
pounds per 1,000 square feet.

d. Perform a residual analysis on the results and determine
whether the regression model is valid.

e. At the 0.05 level of significance, is there a significant
overall relationship between the fertilizer application rate
and tomato yield?

f. What is the p-value in (e)? Interpret its meaning.
g. At the 0.05 level of significance, determine whether

there is a significant quadratic effect.
h. What is the p-value in (g)? Interpret its meaning.
i. Interpret the meaning of the coefficient of multiple deter-

mination.
j. Compute the adjusted r2.

www.Beer100.com


Given the following values for Y and X , use a square-root transformation for the X variable:EXAMPLE 15.2
Using the 
Square-Root
Transformation

15.2 Using Transformations in Regression Models
This section introduces regression models in which the independent variable, the dependent
variable, or both are transformed in order to either overcome violations of the assumptions of
regression or to make a model whose form is not linear into a linear model. Among the many
transformations available (see reference 1) are the square-root transformation and transforma-
tions involving the common logarithm (base 10) and the natural logarithm (base e).1

The Square-Root Transformation
The square-root transformation is often used to overcome violations of the equal-variance
assumption as well as to transform a model whose form is not linear into a linear model.
Equation (15.3) shows a regression model that uses a square-root transformation of the
independent variable.

Construct a scatter plot for X and Y and for the square root of X and Y.

SOLUTION Figure 15.8 displays both scatter plots.

1For more information on loga-
rithms, see Appendix Section A.3.

Y X Y X

42.7 1 100.4 3
50.4 1 104.7 4
69.1 2 112.3 4
79.8 2 113.6 5
90.0 3 123.9 5

REGRESSION MODEL WITH A SQUARE-ROOT TRANSFORMATION

(15.3)Yi = b0 + b12X1i + ei

Example 15.2 illustrates the use of a square-root transformation.

638 CHAPTER 15 Multiple Regression Model Building

15.7 An auditor for a county government would like to de-
velop a model to predict county taxes, based on the age of
single-family houses. She selects a random sample of 19
single-family houses, and the results are stored in .
a. Construct a scatter plot of age and county taxes.
b. Fit a quadratic regression model and state the quadratic

regression equation.
c. Predict the county taxes for a house that is 20 years old.
d. Perform a residual analysis on the results and determine

whether the regression model is valid.

Taxes

e. At the 0.05 level of significance, is there a significant
overall relationship between age and county taxes?

f. What is the p-value in (e)? Interpret its meaning.
g. At the 0.05 level of significance, determine whether the

quadratic model is superior to the linear model.
h. What is the p-value in (g)? Interpret its meaning.
i. Interpret the meaning of the coefficient of multiple

determination.
j. Compute the adjusted r2.
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F I G U R E 1 5 . 8
Example 15.2 scatter
plots of X and Y and
the square root of X
and Y

You can see that the square-root transformation has transformed a nonlinear relationship
into a linear relationship.

The Log Transformation
The logarithmic transformation is often used to overcome violations to the equal-variance
assumption. You can also use the logarithmic transformation to change a nonlinear model into
a linear model. Equation (15.4) shows a multiplicative model.

ORIGINAL MULTIPLICATIVE MODEL

(15.4)Yi = b0 X b1
1i X b2

2i ei
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Given the following values for Y and X, use a natural logarithm transformation for the Y
variable:

EXAMPLE 15.3
Using the Natural
Log Transformation

Construct a scatter plot for X and Y and for X and the natural logarithm of Y.

SOLUTION Figure 15.9 displays both scatter plots. The plots show that the natural logarithm
transformation has transformed a nonlinear relationship into a linear relationship.

Y X Y X

0.7 1 4.8 3
0.5 1 12.9 4
1.6 2 11.5 4
1.8 2 32.1 5
4.2 3 33.9 5

TRANSFORMED MULTIPLICATIVE MODEL

(15.5)

= logb0 + b1log X1i + b2logX2i + log ei

= logb0 + log1X b1

1i 2 + log1X b2

2i 2 + log ei

logYi = log1b0 X b1
1i X b2

2i ei2

ORIGINAL EXPONENTIAL MODEL

(15.6)Yi = eb0+b1X1i+b2X2i ei

TRANSFORMED EXPONENTIAL MODEL

(15.7)

= b0 + b1X1i + b2X2i + ln ei

= ln1eb0+b1X1i+b2X2i2 + ln ei

ln Yi = ln1eb0+b1X1i+b2X2i ei2

Thus, Equation (15.5) is linear in the logarithms. Similarly, you can transform the
exponential model shown in Equation (15.6) to a linear form by taking the natural logarithm of
both sides of the equation. Equation (15.7) is the transformed model.

Example 15.3 illustrates the use of a natural log transformation.

By taking base 10 logarithms of both the dependent and independent variables, you can
transform Equation (15.4) to the model shown in Equation (15.5).
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F I G U R E 1 5 . 9
Example 15.3 scatter
plots of X and Y and
X and the natural
logarithm of Y

Problems for Section 15.2
LEARNING THE BASICS
15.8 Consider the following regression equation:

a. Predict the value of Y when and
b. Interpret the meaning of the regression coefficients

and

15.9 Consider the following regression equation:

a. Predict the value of Y when and
b. Interpret the meaning of the regression coefficients

and b2.b0, b1,

X2 = 5.2.X1 = 8.5

ln Yi
N = 4.62 + 0.5X1i + 0.7X2i

b2.b0, b1,

X2 = 5.2.X1 = 8.5

log Yi
N = log 3.07 + 0.9 log X1i + 1.41 log X2i

APPLYING THE CONCEPTS
15.10 Using the data of Problem 15.4 on
page 637, stored in , perform a

square-root transformation on each of the independent
variables (percentage alcohol and number of carbohy-
drates). Using calories as the dependent variable and the
transformed independent variables, perform a multiple
regression analysis.
a. State the regression equation.
b. Perform a residual analysis of the results and determine

whether the regression model is valid.
c. At the 0.05 level of significance, is there a significant

relationship between calories and the square root of the

DomesticBeer
SELF
Test
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15.3 Collinearity
One important problem in the application of multiple regression analysis involves the possible
collinearity of the independent variables. This condition refers to situations in which two or
more of the independent variables are highly correlated with each other. In such situations,
collinear variables do not provide unique information, and it becomes difficult to separate the
effects of such variables on the dependent variable. When collinearity exists, the values of the
regression coefficients for the correlated variables may fluctuate drastically, depending on
which independent variables are included in the model.

One method of measuring collinearity is to determine the variance inflationary factor
(VIF) for each independent variable. Equation (15.8) defines the variance inflationary
factor for variable j.

VIFj,

VARIANCE INFLATIONARY FACTOR

(15.8)

where

is the coefficient of multiple determination for a regression model, using
variable as the dependent variable and all other X variables as independent
variables.

Xj

R2
j

VIFj =
1

1 - R2
j

percentage of alcohol and the square root of the number
of carbohydrates?

d. Interpret the meaning of the coefficient of determination,
in this problem.

e. Compute the adjusted 
f. Compare your results with those in Problem 15.4. Which

model is better? Why?

15.11 Using the data of Problem 15.4 on page 637, stored
in , perform a natural logarithmic transfor-
mation of the dependent variable (calories). Using the
transformed dependent variable and the percentage
of alcohol and the number of carbohydrates as the
independent variables, perform a multiple regression
analysis.
a. State the regression equation.
b. Perform a residual analysis of the results and determine

whether the regression assumptions are valid.
c. At the 0.05 level of significance, is there a significant

relationship between the natural logarithm of calo-
ries and the percentage of alcohol and the number of
carbohydrates?

d. Interpret the meaning of the coefficient of determination,
in this problem.

e. Compute the adjusted 
f. Compare your results with those in Problems 15.4 and

15.10. Which model is best? Why?

15.12 Using the data of Problem 15.6 on page 637, stored
in , perform a natural logarithm transformation
of the dependent variable (yield). Using the transformed
dependent variable and the fertilizer application rate
as the independent variable, perform a regression analysis.

Tomato

r2.
r2,

DomesticBeer

r2.
r2,

a. State the regression equation.
b. Predict the yield when 55 pounds of fertilizer is applied

per 1,000 square feet.
c. Perform a residual analysis of the results and determine

whether the regression assumptions are valid.
d. At the 0.05 level of significance, is there a significant

relationship between the natural logarithm of yield and
the fertilizer application rate?

e. Interpret the meaning of the coefficient of determination,
in this problem.

f. Compute the adjusted 
g. Compare your results with those in Problem 15.6. Which

model is better? Why?

15.13 Using the data of Problem 15.6 on page 637, stored
in , perform a square-root transformation of the
independent variable (fertilizer application rate). Using
yield as the dependent variable and the transformed
independent variable, perform a regression analysis.
a. State the regression equation.
b. Predict the yield when 55 pounds of fertilizer is applied

per 1,000 square feet.
c. Perform a residual analysis of the results and determine

whether the regression model is valid.
d. At the 0.05 level of significance, is there a significant re-

lationship between yield and the square root of the fertil-
izer application rate?

e. Interpret the meaning of the coefficient of determination,
in this problem.

f. Compute the adjusted 
g. Compare your results with those of Problems 15.6 and

15.12. Which model is best? Why?
h. How much fertilizer should you apply in order to grow

the most tomatoes?

r2.
r2,

Tomato

r2.
r2,
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If there are only two independent variables, is the coefficient of determination
between and It is identical to which is the coefficient of determination between
and If there are three independent variables, then is the coefficient of multiple
determination of with and is the coefficient of multiple determination of
with and and is the coefficient of multiple determination of with and X2.X1X3R2

3X3;X1

X2X3; R2
2X2X1

R2
1X1.

X2R2
2,X2.X1

R2
1

If a set of independent variables is uncorrelated, each is equal to 1. If the set is highly
correlated, then a might even exceed 10. Marquardt (see reference 2) suggests that if
is greater than 10, there is too much correlation between the variable and the other
independent variables. However, other statisticians suggest a more conservative criterion. Snee
(see reference 5) recommends using alternatives to least-squares regression if the maximum

exceeds 5.
You need to proceed with extreme caution when using a multiple regression model that

has one or more large VIF values. You can use the model to predict values of the dependent
variable only in the case where the values of the independent variables used in the prediction
are in the relevant range of the values in the data set. However, you cannot extrapolate to val-
ues of the independent variables not observed in the sample data. And because the independ-
ent variables contain overlapping information, you should always avoid interpreting the
regression coefficient estimates separately because there is no way to accurately estimate
the individual effects of the independent variables. One solution to the problem is to delete the
variable with the largest VIF value. The reduced model (i.e., the model with the independent
variable with the largest VIF value deleted) is often free of collinearity problems. If you
determine that all the independent variables are needed in the model, you can use methods
discussed in reference 1.

In the OmniPower sales data (see Section 14.1), the correlation between the two independ-
ent variables, price and promotional expenditure, is Because there are only two
independent variables in the model, from Equation (15.8) on page 642:

Thus, you can conclude that you should not be concerned with collinearity for the OmniPower
sales data.

In models containing quadratic and interaction terms, collinearity is usually present. The
linear and quadratic terms of an independent variable are usually highly correlated with each
other, and an interaction term is often correlated with one or both of the independent variables
making up the interaction. Thus, you cannot interpret individual parameter estimates
separately. You need to interpret the linear and quadratic parameter estimates together in order
to understand the nonlinear relationship. Likewise, you need to interpret an interaction
parameter estimate in conjunction with the two parameter estimates associated with the
variables comprising the interaction. In summary, large VIFs in quadratic or interaction mod-
els do not necessarily mean that the model is not a good one. They do, however, require you to
carefully interpret the parameter estimates.

= 1.009

VIF1 = VIF2 =
1

1 - 1-0.096822

-0.0968.

VIFj

Xj

VIFjVIFj

VIFj

Problems for Section 15.3
LEARNING THE BASICS
15.14 If the coefficient of determination between two
independent variables is 0.20, what is the VIF?

15.15 If the coefficient of determination between two
independent variables is 0.50, what is the VIF?

APPLYING THE CONCEPTS
15.16 Refer to Problem 14.4 on page 583. Per-
form a multiple regression analysis using the data

in and determine the VIF for each independent
variable in the model. Is there reason to suspect the exis-
tence of collinearity?

WareCost

SELF
Test
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T A B L E 1 5 . 2

Predicting Standby Hours
Based on Total Staff
Present, Remote Hours,
Dubner Hours, and Total
Labor Hours

Week
Standby
Hours

Total Staff
Present

Remote
Hours

Dubner
Hours

Total Labor
Hours

1 245 338 414 323 2,001
2 177 333 598 340 2,030
3 271 358 656 340 2,226
4 211 372 631 352 2,154
5 196 339 528 380 2,078
6 135 289 409 339 2,080
7 195 334 382 331 2,073
8 118 293 399 311 1,758
9 116 325 343 328 1,624

10 147 311 338 353 1,889
11 154 304 353 518 1,988
12 146 312 289 440 2,049
13 115 283 388 276 1,796
14 161 307 402 207 1,720
15 274 322 151 287 2,056
16 245 335 228 290 1,890
17 201 350 271 355 2,187
18 183 339 440 300 2,032
19 237 327 475 284 1,856
20 175 328 347 337 2,068
21 152 319 449 279 1,813
22 188 325 336 244 1,808
23 188 322 267 253 1,834
24 197 317 235 272 1,973
25 261 315 164 223 1,839
26 232 331 270 272 1,935

15.4 Model Building
This chapter and Chapter 14 have introduced you to many different topics in regression
analysis, including quadratic terms, dummy variables, and interaction terms. In this section,
you learn a structured approach to building the most appropriate regression model. As you will
see, successful model building incorporates many of the topics you have studied so far.

To begin, refer to the WHIT-DT scenario introduced on page 629, in which four independ-
ent variables (total staff present, remote hours, Dubner hours, and total labor hours) are
considered in the business problem that involves developing a regression model to predict
standby hours of unionized graphic artists. Data are collected over a period of 26 weeks and
organized and stored in . Table 15.2 summarizes the data.Standby

15.17 Refer to Problem 14.5 on page 583. Perform a
multiple regression analysis using the data in and
determine the VIF for each independent variable in the
model. Is there reason to suspect the existence of collinearity?

15.18 Refer to Problem 14.6 on page 583. Perform a multi-
ple regression analysis using the data in and
determine the VIF for each independent variable in the
model. Is there reason to suspect the existence of collinearity?

Advertise

Auto2010

15.19 Refer to Problem 14.7 on page 584. Perform a multi-
ple regression analysis using the data in and
determine the VIF for each independent variable in the
model. Is there reason to suspect the existence of collinearity?

15.20 Refer to Problem 14.8 on page 584. Perform a
multiple regression analysis using the data in and
determine the VIF for each independent variable in the
model. Is there reason to suspect the existence of collinearity?

GlenCove

Standby



15.4 Model Building 645

To develop a model to predict the dependent variable, standby hours in the WHIT-DT
scenario, you need to be guided by a general problem-solving strategy or heuristic. One
heuristic appropriate for building regression models uses the principle of parsimony.

Parsimony guides you to select the regression model with the fewest independent
variables that can predict the dependent variable adequately. Regression models with fewer
independent variables are easier to interpret, particularly because they are less likely to be af-
fected by collinearity problems (described in Section 15.3).

The selection of an appropriate model when many independent variables are under
consideration involves complexities that are not present with a model that has only two
independent variables. The evaluation of all possible regression models is more computation-
ally complex. And, although you can quantitatively evaluate competing models, there may not
be a uniquely best model but several equally appropriate models.

To begin analyzing the standby-hours data, you compute the variance inflationary factors
[see Equation (15.8) on page 642] to measure the amount of collinearity among the independ-
ent variables. The values for the four VIFs for this model appear in Figure 15.10, along with
the results for the model that uses the four independent variables.

F I G U R E 1 5 . 1 0
Excel and Minitab regression results for predicting standby hours based on four independent variables (Excel results
contain additional worksheets for Durbin-Watson statistic and VIF inset)

Observe that all the VIF values in Figure 15.10 are relatively small, ranging from a high of
1.999 for the total labor hours to a low of 1.233 for remote hours. Thus, on the basis of the
criteria developed by Snee that all VIF values should be less than 5.0 (see reference 5), there is
little evidence of collinearity among the set of independent variables.
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F I G U R E 1 5 . 1 1
Excel (PHStat2) and Minitab stepwise regression results for the standby-hours data

The Stepwise Regression Approach to Model Building
You continue your analysis of the standby-hours data by attempting to determine whether a
subset of all independent variables yields an adequate and appropriate model. The first
approach described here is stepwise regression, which attempts to find the “best” regression
model without examining all possible models.

The first step of stepwise regression is to find the best model that uses one independent
variable. The next step is to find the best of the remaining independent variables to add to the
model selected in the first step. An important feature of the stepwise approach is that an
independent variable that has entered into the model at an early stage may subsequently be re-
moved after other independent variables are considered. Thus, in stepwise regression, variables
are either added to or deleted from the regression model at each step of the model-building
process. The t test for the slope (see Section 14.4) or the partial test statistic (see Section
14.5) is used to determine whether variables are added or deleted. The stepwise procedure
terminates with the selection of a best-fitting model when no additional variables can be added
to or deleted from the last model evaluated. Figure 15.11 shows the Excel (using PHStat2) and
Minitab stepwise regression results for the standby-hours data.

FSTAT

Figure 15.11 contains an
Excel worksheet created by
PHStat2. Although manually
creating stepwise results in
Excel is not impossible to do,
the decision making inherent
in adding and deleting
variables and the need to cut
and paste or delete partial
regression results in order to
report results makes relying
on an add-in such as PHStat2
the only practical choice.

For this example, a significance level of 0.05 is used to enter a variable into the model or
to delete a variable from the model. The first variable entered into the model is total staff, the
variable that correlates most highly with the dependent variable standby hours. Because the
p-value of 0.0011 is less than 0.05, total staff is included in the regression model.

The next step involves selecting a second independent variable for the model. The second
variable chosen is one that makes the largest contribution to the model, given that the first
variable has been selected. For this model, the second variable is remote hours. Because the
p-value of 0.0269 for remote hours is less than 0.05, remote hours is included in the regression
model.

After the remote hours variable is entered into the model, the stepwise procedure
determines whether total staff is still an important contributing variable or whether it can be
eliminated from the model. Because the p-value of 0.0001 for total staff is less than 0.05, total
staff remains in the regression model.
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The next step involves selecting a third independent variable for the model. Because none
of the other variables meets the 0.05 criterion for entry into the model, the stepwise procedure
terminates with a model that includes total staff present and the number of remote hours.

This stepwise regression approach to model building was originally developed more than
four decades ago, when regression computations on computers were time-consuming and
costly. Although stepwise regression limited the evaluation of alternative models, the method
was deemed a good trade-off between evaluation and cost.

Given the ability of today’s computers to perform regression computations at very low cost
and high speed, stepwise regression has been superseded to some extent by the best-subsets ap-
proach, discussed next, which evaluates a larger set of alternative models. Stepwise regression
is not obsolete, however. Today, many businesses use stepwise regression as part of the research
technique called data mining (see Online Section 15.7), which tries to identify significant sta-
tistical relationships in very large data sets that contain extremely large numbers of variables.

The Best-Subsets Approach to Model Building
The best-subsets approach evaluates all possible regression models for a given set of
independent variables. Figure 15.12 presents best-subsets regression results of all possible
regression models for the standby-hours data.

F I G U R E 1 5 . 1 2
Excel and Minitab best-subsets regression results for the standby-hours data

A criterion often used in model building is the adjusted which adjusts the of each
model to account for the number of independent variables in the model as well as for the
sample size (see Section 14.2). Because model building requires you to compare models with
different numbers of independent variables, the adjusted is more appropriate than Refer-
ring to Figure 15.12, you see that the adjusted reaches a maximum value of 0.5513 when all
four independent variables plus the intercept term (for a total of five estimated parameters) are
included in the model.

r2
r2.r2

r2r2,



648 CHAPTER 15 Multiple Regression Model Building

A second criterion often used in the evaluation of competing models is the statistic
developed by Mallows (see reference 1). The statistic, defined in Equation (15.9),
measures the differences between a fitted regression model and a true model, along with
random error.

Cp

Cp

Using Equation (15.9) to compute for the model containing total staff and remote
hours,

so that

When a regression model with k independent variables contains only random differences
from a true model, the mean value of is the number of parameters. Thus, in
evaluating many alternative regression models, the goal is to find models whose is close to
or less than In Figure 15.12, you see that only the model with all four independent vari-
ables considered contains a value close to or below Therefore, using the crite-
rion, you should choose that model.

Although it is not the case here, the statistic often provides several alternative models
for you to evaluate in greater depth. Moreover, the best model or models using the criterion
might differ from the model selected using the adjusted and/or the model selected using the
stepwise procedure. (Note here that the model selected using stepwise regression has a
value of 8.4193, which is substantially above the suggested criterion of for that
model.) Remember that there may not be a uniquely best model, but there may be several
equally appropriate models. Final model selection often involves using subjective criteria, such
as parsimony, interpretability, and departure from model assumptions (as evaluated by residual
analysis).

When you have finished selecting the independent variables to include in the model, you
should perform a residual analysis to evaluate the regression assumptions, and because the
data were collected in time order, you also need to compute the Durbin-Watson statistic to de-
termine whether there is autocorrelation in the residuals (see Section 13.6). From Figure 15.10
on page 645, you see that the Durbin-Watson statistic, D, is 2.2197. Because D is greater than
2.0, there is no indication of positive correlation in the residuals. Figure 15.13 presents the
plots used in the residual analysis.

k + 1 = 3
Cp

r2
Cp

Cp

Cpk + 1.Cp

k + 1.
Cp

k + 1,Cp

= 8.4193

Cp =
11 - 0.48992126 - 52

1 - 0.6231
- [26 - 212 + 12]

n = 26 k = 2 T = 4 + 1 = 5 R2
k = 0.4899 R2

T = 0.6231

Cp

STATISTIC

(15.9)

where

number of independent variables included in a regression model
total number of parameters (including the intercept) to be estimated in the
full regression model
coefficient of multiple determination for a regression model that has k
independent variables
coefficient of multiple determination for a full regression model that 
contains all T estimated parameters

R2
T =

R2
k =

T =
k =

Cp =
11 - R2

k21n - T2
1 - R2

T

- [n - 21k + 12]
Cp
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F I G U R E 1 5 . 1 3
Residual plots for the
standby-hours data 
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T A B L E 1 5 . 3

Partial Results from
Best-Subsets Regression

Number of Variables r 2 Adjusted r 2 Cp Variables Included

1 0.121 0.119 113.9 X4
1 0.093 0.090 130.4 X1

1 0.083 0.080 136.2 X3

2 0.214 0.210 62.1 X3, X4

2 0.191 0.186 75.6 X1, X3

2 0.181 0.177 81.0 X1, X4

3 0.285 0.280 22.6 X1, X3, X4

3 0.268 0.263 32.4 X3, X4, X5

3 0.240 0.234 49.0 X2, X3, X4

4 0.308 0.301 11.3 X1, X2, X3, X4

4 0.304 0.297 14.0 X1, X3, X4, X6

4 0.296 0.289 18.3 X1, X3, X4, X5

5 0.317 0.308 8.2 X1, X2, X3, X4, X5

5 0.315 0.306 9.6 X1, X2, X3, X4, X6

5 0.313 0.304 10.7 X1, X3, X4, X5, X6

6 0.323 0.313 6.8 X1, X2, X3, X4, X5, X6

6 0.319 0.309 9.0 X1, X2, X3, X4, X5, X7

6 0.317 0.306 10.4 X1, X2, X3, X4, X6, X7

7 0.324 0.312 8.0 X1, X2, X3, X4, X5, X6, X7

of 8.0. One way you can choose among the two models is to select the model with the largest
adjusted —that is, the model with six independent variables. Another way to select a final
model is to determine whether the models contain a subset of variables that are common.
Then you test whether the contribution of the additional variables is significant. In this
case, because the models differ only by the inclusion of variable in the full model, you
test whether variable makes a significant contribution to the regression model, given
that the variables and are already included in the model. If the contri-
bution is statistically significant, then you should include variable in the regression
model. If variable does not make a statistically significant contribution, you should not
include it in the model.

X7

X7

X6X1, X2, X3, X4, X5,
X7

X7

r2

None of the residual plots versus the total staff, the remote hours, the Dubner hours, and
the total labor hours reveal apparent patterns. In addition, a histogram of the residuals (not
shown here) indicates only moderate departure from normality, and a plot of the residuals ver-
sus the predicted values of Y (also not shown here) does not show evidence of unequal vari-
ance. Thus, from Figure 15.10 on page 645, the regression equation is

Example 15.4 presents a situation in which there are several alternative models in which
the statistic is close to or less than k + 1.Cp

Yi
N = -330.8318 + 1.2456X1i - 0.1184X2i - 0.2971X3i + 0.1305X4i

Table 15.3 shows results from a best-subsets regression analysis of a regression model with
seven independent variables. Determine which regression model you would choose as the best
model.

SOLUTION From Table 15.3, you need to determine which models have values that are
less than or close to Two models meet this criterion. The model with six independent
variables has a value of 6.8, which is less than
and the full model with seven independent variables has a valueCp1X1, X2, X3, X4, X5, X6, X72

k + 1 = 6 + 1 = 7,Cp1X1, X2, X3, X4, X5, X62
k + 1.

Cp

EXAMPLE 15.4
Choosing Among
Alternative
Regression
Models



15.4 Model Building 651

Figure 15.14 represents a roadmap for the steps involved in model building.

E X H I B I T 1 5 . 1
Steps Involved in Model Building

1. Compile a list of all independent variables under consideration.
2. Fit a regression model that includes all the independent variables under consideration

and determine the VIF for each independent variable. Three possible results can occur:
a. None of the independent variables has a in this case, proceed to step 3.
b. One of the independent variables has a in this case, eliminate that inde-

pendent variable and proceed to step 3.
c. More than one of the independent variables has a in this case, eliminate

the independent variable that has the highest VIF and repeat step 2.
3. Perform a best-subsets regression with the remaining independent variables and

determine the statistic and/or the adjusted for each model.
4. List all models that have close to or less than and/or a high adjusted 
5. From the models listed in step 4, choose a best model.
6. Perform a complete analysis of the model chosen, including a residual analysis.
7. Depending on the results of the residual analysis, add quadratic and/or interaction

terms, transform variables, and reanalyze the data.
8. Use the selected model for prediction and inference.

r2.k + 1Cp

r2Cp

VIF 7 5;

VIF 7 5;
VIF 7 5;

F I G U R E 1 5 . 1 4
Roadmap for model
building

Yes

No No

Yes

Choose Independent
Variables to Be

Considered

Run Regression Model
with All Independent
Variables to Find VIFs

Are
Any

VIFs > 5
?

Does
More

Than One X
Variable Have

VIF > 5
?

Eliminate X Variable
with Largest VIF

Eliminate
This X Variable

Run Best-Subsets
Regression to Obtain
Best Models with k

Terms for a Given Number
of Independent Variables

List All Models That
Have Cp Close to or

Less Than k + 1

Choose a “Best” Model
Among These Models

Do a Complete Analysis of
This Model, Including

Residual Analysis

Depending on Results of
Residual Analysis,

Add Quadratic and/or
Interaction Terms, or
Transform Variables

Use Selected Model for
Prediction and

Confidence Interval
Estimation

Exhibit 15.1 summarizes the steps involved in model building.



Problems for Section 15.4
LEARNING THE BASICS
15.21 You are considering four independent variables for
inclusion in a regression model. You select a sample of

with the following results:

1. The model that includes independent variables A and B
has a value equal to 4.6.

2. The model that includes independent variables A and C
has a value equal to 2.4.

3. The model that includes independent variables A, B, and
C has a value equal to 2.7.

a. Which models meet the criterion for further consid-
eration? Explain.

b. How would you compare the model that contains
independent variables A, B, and C to the model that
contains independent variables A and B? Explain.

15.22 You are considering six independent variables for
inclusion in a regression model. You select a sample of

with the following results:

a. Compute the value for this two-independent-variable
model.

b. Based on your answer to (a), does this model meet the
criterion for further consideration as the best model?
Explain.

Cp

k = 2˚ T = 6 + 1 = 7˚ R2
k = 0.274˚ R2

T = 0.653

n = 40,

Cp

Cp

Cp

n = 30,

APPLYING THE CONCEPTS
15.23 In Problems 13.85 through 13.89 on page 568, you
constructed simple linear regression models to investigate
the relationship between demographic information and
monthly sales for a chain of sporting goods stores using the
data in . Develop the most appropriate multiple re-
gression model to predict a store’s monthly sales. Be sure to
include a thorough residual analysis. In addition, provide a
detailed explanation of the results, including a comparison
of the most appropriate multiple regression model to the
best simple linear regression model.

15.24 You need to develop a model to predict the selling
price of houses in a small city, based on assessed value, time
in months since the house was reassessed, and whether the
house is new A sample of 30 recently
sold single-family houses that were reassessed at full value
one year prior to the study is selected and the results are
stored in . Develop the most appropriate multiple
regression model to predict selling price. Be sure to perform
a thorough residual analysis. In addition, provide a detailed
explanation of the results.

15.25 The human resources (HR) director for a large
company that produces highly technical industrial
instrumentation devices has the business objective of im-
proving recruiting decisions concerning sales managers.

House1

10 = no, 1 = yes2.

Sporting
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Model Validation
The final step in the model-building process is to validate the selected regression model. This
step involves checking the model against data that were not part of the sample analyzed. The
following are several ways of validating a regression model:

• Collect new data and compare the results.
• Compare the results of the regression model to previous results.
• If the data set is large, split the data into two parts and cross-validate the results.

Perhaps the best way of validating a regression model is by collecting new data. If the results
with new data are consistent with the selected regression model, you have strong reason to be-
lieve that the fitted regression model is applicable in a wide set of circumstances.

If it is not possible to collect new data, you can use one of the two other approaches. In
one approach, you compare your regression coefficients and predictions to previous results. If
the data set is large, you can use cross-validation. First, you split the data into two parts. Then
you use the first part of the data to develop the regression model. You then use the second part
of the data to evaluate the predictive ability of the regression model.
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The company has 45 sales regions, each headed by a sales
manager. Many of the sales managers have degrees in
electrical engineering and, due to the technical nature of
the product line, several company officials believe that
only applicants with degrees in electrical engineering
should be considered. At the time of their application,
candidates are asked to take the Strong-Campbell Interest
Inventory Test and the Wonderlic Personnel Test. Due to
the time and money involved with the testing, some dis-
cussion has taken place about dropping one or both of the
tests. To start, the HR director gathered information on
each of the 45 current sales managers, including years of
selling experience, electrical engineering background, and
the scores from both the Wonderlic and Strong-Campbell
tests. The HR director has decided to use regression mod-
eling to predict a dependent variable of “sales index”
score, which is the ratio of the regions’ actual sales di-
vided by the target sales. The target values are constructed
each year by upper management, in consultation with the
sales managers, and are based on past performance and
market potential within each region. The file
contains information on the 45 current sales managers.
The following variables are included:

Sales—Ratio of yearly sales divided by the target sales
value for that region. The target values were mutually
agreed-upon “realistic expectations.”

Managers

Wonder—Score from the Wonderlic Personnel Test. The
higher the score, the higher the applicant’s perceived
ability to manage.

SC—Score on the Strong-Campbell Interest Inventory Test.
The higher the score, the higher the applicant’s perceived
interest in sales.

Experience—Number of years of selling experience prior to
becoming a sales manager.

Engineer—Dummy variable that equals 1 if the sales
manager has a degree in electrical engineering and 0
otherwise.

a. Develop the most appropriate regression model to predict
sales.

b. Do you think that the company should continue adminis-
tering both the Wonderlic and Strong-Campbell tests?
Explain.

c. Do the data support the argument that electrical
engineers outperform the other sales managers? Would
you support the idea to hire only electrical engineers?
Explain.

d. How important is prior selling experience in this case?
Explain.

e. Discuss in detail how the HR director should incorporate
the regression model you developed into the recruiting
process.

15.5 Pitfalls in Multiple Regression and Ethical Issues
Pitfalls in Multiple Regression
Model building is an art as well as a science. Different individuals may not always agree on
the best multiple regression model. To try to construct a best regression model, you should use
the process described in Exhibit 15.1 on page 651. In doing so, you must avoid certain pitfalls
that can interfere with the development of a useful model. Section 13.9 discussed pitfalls in
simple linear regression and strategies for avoiding them. Now that you have studied a variety
of multiple regression models, you need to take some additional precautions. To avoid pitfalls
in multiple regression, you also need to

• Interpret the regression coefficient for a particular independent variable from a perspec-
tive in which the values of all other independent variables are held constant.

• Evaluate residual plots for each independent variable.
• Evaluate interaction and quadratic terms.
• Compute the VIF for each independent variable before determining which independent

variables to include in the model.
• Examine several alternative models, using best-subsets regression.
• Validate the model before implementing it.



I
n the Using Statistics scenario, you were the operations manager of
WHIT-DT, looking for ways to reduce labor expenses. You needed to
determine which variables have an effect on standby hours, the time
during which unionized graphic artists are idle but are getting paid.

You have collected data concerning standby hours and the total number of
staff present, remote hours, Dubner hours, and total labor hours over a
period of 26 weeks.

You performed a multiple regression analysis on the data. The coefficient of multiple
determination indicated that 62.31% of the variation in standby hours can be explained by
variation in the total number of staff present, remote hours, Dubner hours, and total labor
hours. The model indicated that standby hours are estimated to increase by 1.2456 hours for
each additional staff hour holding constant the other independent variables; to decrease by
0.1184 hour for each additional remote hour holding constant the other independent vari-
ables; to decrease by 0.2974 hour for each additional Dubner hour holding constant the other
independent variables; and to increase by 0.1305 hour for each additional labor hour holding
constant the other independent variables. Each of the four independent variables had a signif-
icant effect on standby hours holding constant the other independent variables. This regres-
sion model enables you to predict standby hours based on the total number of staff present,
remote hours, Dubner hours, and total labor hours. It also enables you to investigate how
changing each of these four independent variables could affect standby hours.
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15.6 Online Topic: Influence Analysis
Influence analysis measures the influence of individual observations on a regression model. To
study this topic, read the Section 15.6 online topic file that is available on this book’s compan-
ion website. (See Appendix C to learn how to access the online topic files.)

15.7 Online Topic: Analytics and Data Mining
Analytics and data mining are methods that are used with very large data sets to present sum-
mary results and to discern patterns that may exist. To study this topic, read the Section 15.7
online topic file that is available on this book’s companion website. (See Appendix C to learn
how to access the online topic files.)

U S I N G S TAT I S T I C S @ WHIT-DT Revisited

Ethical Issues
Ethical issues arise when a user who wants to make predictions manipulates the develop-
ment process of the multiple regression model. The key here is intent. In addition to the situ-
ations discussed in Section 13.9, unethical behavior occurs when someone uses multiple
regression analysis and willfully fails to remove from consideration independent variables
that exhibit a high collinearity with other independent variables or willfully fails to use methods
other than least-squares regression when the assumptions necessary for least-squares regres-
sion are seriously violated.
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S U M M A R Y
In this chapter, various multiple regression topics were
considered (see Figure 15.15), including quadratic regres-

sion models, transformations, collinearity, and model
building.
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K E Y E Q U AT I O N S
Quadratic Regression Model

(15.1)

Quadratic Regression Equation

(15.2)

Regression Model with a Square-Root Transformation

(15.3)
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(15.4)

Transformed Multiplicative Model
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K E Y T E R M S
best-subsets approach 647

statistic 648
collinearity 642
cross-validation 652

Cp

data mining 647
logarithmic transformation 639
parsimony 645
quadratic regression model 630

quadratic term 630
square-root transformation 638
stepwise regression 646
variance inflationary factor (VIF) 642

C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING
15.26 How can you evaluate whether collinearity exists in
a multiple regression model?

15.27 What is the difference between stepwise regression
and best-subsets regression?

15.28 How do you choose among models according to the
statistic in best-subsets regression?

APPLYING THE CONCEPTS
15.29 Crazy Dave has expanded his analysis, presented in
Problem 14.73 on page 619, of which variables are impor-
tant in predicting a team’s wins in a given baseball season.
He has collected data in related to wins, ERA,
saves, runs scored, hits allowed, walks allowed, and errors
for the 2009 season.

BB2009

Cp

a. Develop the most appropriate multiple regression model
to predict a team’s wins. Be sure to include a thorough
residual analysis. In addition, provide a detailed explana-
tion of the results.

b. Develop the most appropriate multiple regression model
to predict a team’s ERA on the basis of hits allowed,
walks allowed, errors, and saves. Be sure to include a
thorough residual analysis. In addition, provide a detailed
explanation of the results.

15.30 Professional basketball has truly become a sport
that generates interest among fans around the world. More
and more players come from outside the United States to
play in the National Basketball Association (NBA). Many
factors could impact the number of wins achieved by each
NBA team. In addition to the number of wins, the file

contains team statistics for points per game (forNBA2010
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Chapter Review Problems 657

team, opponent, and the difference between team and
opponent), field goal (shots made) percentage (for team, op-
ponent, and the difference between team and opponent),
steals per game (for team, opponent, and the difference
between team and opponent), rebounds per game (for team,
opponent, and the difference between team and opponent).
a. Consider team points per game, opponent points per

game, team field goal percentage, opponent field goal
percentage, steals per game, and rebounds per game as
independent variables for possible inclusion in the multi-
ple regression model. Develop the most appropriate mul-
tiple regression model to predict the number of wins.

b. Consider the difference between team points and oppo-
nent points per game, the difference between team field
goal percentage and opponent field goal percentage, the
difference in team and opponent steals, and the differ-
ence between team and opponent rebounds per game as
independent variables for possible inclusion in the multi-
ple regression model. Develop the most appropriate mul-
tiple regression model to predict the number of wins.

c. Compare the results of (a) and (b). Which model is better
for predicting the number of wins? Explain.

15.31 Hemlock Farms is a community located in the
Pocono Mountains area of eastern Pennsylvania. The
file contains information on homes that
were recently for sale. The variables included were

List Price—Asking price of the house
Hot Tub—Whether the house has a hot tub, with

and
Lake View—Whether the house has a lake view, with

and
Bathrooms—Number of bathrooms
Bedrooms—Number of bedrooms
Loft/Den—Whether the house has a loft or den, with

and
Finished basement—Whether the house has a finished

basement, with and
Acres—Number of acres for the property

Develop the most appropriate multiple regression model to
predict the asking price. Be sure to perform a thorough
residual analysis. In addition, provide a detailed explanation
of your results.

15.32 Nassau County is located approximately 25 miles
east of New York City. Data in are from a sample
of 30 single-family homes located in Glen Cove. Variables
included are the appraised value, land area of the property
(acres), interior size of the house (square feet), age (years),
number of rooms, number of bathrooms, and number of cars
that can be parked in the garage.
a. Develop the most appropriate multiple regression model

to predict appraised value.
b. Compare the results in (a) with those of Problems 15.33

(a) and 15.34 (a).

GlenCove

1 = Yes0 = No

1 = Yes0 = No

1 = Yes0 = No

1 = Yes
0 = No

HemlockFarms

15.33 Data similar to those in Problem 15.32 are available
for homes located in Roslyn (approximately 8 miles from
Glen Cove) and are stored in .
a. Perform an analysis similar to that of Problem 15.32.
b. Compare the results in (a) with those of Problems 15.32

(a) and 15.34 (a).

15.34 Data similar to Problem 15.32 are available for
homes located in Freeport (located approximately 20 miles
from Roslyn) and are stored in .
a. Perform an analysis similar to that of Problem 15.32.
b. Compare the results in (a) with those of Problems 15.32

(a) and 15.33 (a).

15.35 You are a real estate broker who wants to compare
property values in Glen Cove and Roslyn (which are located
approximately 8 miles apart). Use the data in .
Make sure to include the dummy variable for location (Glen
Cove or Roslyn) in the regression model.
a. Develop the most appropriate multiple regression model

to predict appraised value.
b. What conclusions can you reach concerning the differ-

ences in appraised value between Glen Cove and
Roslyn?

15.36 You are a real estate broker who wants to compare
property values in Glen Cove, Freeport, and Roslyn. Use the
data in .
a. Develop the most appropriate multiple regression model

to predict appraised value.
b. What conclusions can you reach concerning the differ-

ences in appraised value between Glen Cove, Freeport,
and Roslyn?

15.37 Over the past 30 years, public awareness and con-
cern about air pollution have escalated dramatically. Ven-
turi scrubbers are used for the removal of submicron
particulate matter from smoke stacks. An experiment was
conducted to determine the effect of air flow rate, water
flow rate (liters/minute), recirculating water flow rate
(liters/minute), and orifice size (mm) in the air side of the
pneumatic nozzle on the performance of the scrubber, as
measured by the number of transfer units. The results are
stored in .

Develop the most appropriate multiple regression
model to predict the number of transfer units. Be sure to
perform a thorough residual analysis. In addition, provide a
detailed explanation of your results.
Source: Data extracted from D. A. Marshall, R. J. Sumner, and C. A.
Shook, “Removal of Particles with an Ejector Venturi Scrubber,”
Environmental Progress, 14 (1995), 28–32.

15.38 A recent article (J. Conklin, “It’s a Marathon, Not
a Sprint,” Quality Progress, June 2009, pp. 46–49) dis-
cussed a metal deposition process in which a piece of
metal is placed in an acid bath and an alloy is layered on
top of it. The key quality characteristic is the thickness of

SiO2

Scrubber

GCFreeRoslyn

GCRoslyn

Freeport

Roslyn



the alloy layer. The file contains the following
variables:

Thickness—Thickness of the alloy layer
Catalyst—Catalyst concentration in the acid bath
pH—pH level of the acid bath
Pressure—Pressure in the tank holding the acid bath
Temp—Temperature in the tank holding the acid bath
Voltage—Voltage applied to the tank holding the acid

bath

Develop the most appropriate multiple regression model to
predict the thickness of the alloy layer. Be sure to perform a
thorough residual analysis. The article suggests that there is
a significant interaction between the pressure and the tem-
perature in the tank. Do you agree?

15.39 A headline in The New York Times on March 4,
1990, read: “Wine equation puts some noses out of joint.”
The article explained that Professor Orley Ashenfelter, a
Princeton University economist, had developed a multiple
regression model to predict the quality of French Bordeaux,
based on the amount of winter rain, the average temperature
during the growing season, and the harvest rain. The multi-
ple regression equation is

where

logarithmic index of quality
winter rain (October through March), in millimeters
average temperature during the growing season
(April through September), in degrees Celsius
harvest rain (August to September), in millimeters

You are at a cocktail party, sipping a glass of wine,
when one of your friends mentions to you that she has read
the article. She asks you to explain the meaning of the

HR =

TMP =
WR =

Q =

Q = -12.145 + 0.00117WR + 0.6164TMP -  0.00386HR

Thickness coefficients in the equation and also asks you about analy-
ses that might have been done and were not included in the
article. What is your reply?

REPORT WRITING EXERCISE
15.40 In Problem 15.23 on page 652, you developed a
multiple regression model to predict monthly sales at
sporting goods stores for the data stored in . Now
write a report based on the model you developed. Append
all appropriate charts and statistical information to your
report.

TEAM PROJECT
15.41 The file contains information regard-
ing eight variables from a sample of 184 bond mutual funds:

Type—Type of bonds comprising the bond mutual fund
(intermediate government or short-term corporate)

Assets—In millions of dollars
Fees—Sales charges (no or yes)
Expense ratio—Ratio of expenses to net assets in

percentage
Return 2009—Twelve-month return in 2009
Three-year return—Annualized return, 2007–2009
Five-year return—Annualized return, 2005–2009
Risk—Risk-of-loss factor of the bond mutual fund

(below average, average, or above average)

Develop regression models to predict the 2009 return,
the three-year return, and the five-year return, based on
fees, expense ratio, type, and risk. (For the purpose of this
analysis, combine below-average risk and average risk into
one category.) Be sure to perform a thorough residual analy-
sis. In addition, provide a detailed explanation of your re-
sults. Append all appropriate charts and statistical
information to your report.

Bond Funds

Sporting

T H E M O U N TA I N S TAT E S P O TAT O C O M PA N Y
Mountain States Potato Company sells a by-product of its
potato-processing operation, called a filter cake, to area
feedlots as cattle feed. The business problem faced by the
feedlot owners is that the cattle are not gaining weight as
quickly as they once were. The feedlot owners believe that
the root cause of the problem is that the percentage of solids
in the filter cake is too low.

Historically, the percentage of solids in the filter cakes
ran slightly above 12%. Lately, however, the solids are

running in the 11% range. What is actually affecting the
solids is a mystery, but something has to be done quickly.
Individuals involved in the process were asked to identify
variables that might affect the percentage of solids. This
review turned up the six variables (in addition to the per-
centage of solids) listed in the table on page 659. Data col-
lected by monitoring the process several times daily for
20 days are stored in .Potato
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Variable Comments

SOLIDS Percentage of solids in the filter cake.
PH Acidity. This measure of acidity indicates bacterial action in the clarifier

and is controlled by the amount of downtime in the system. As bacterial
action progresses, organic acids are produced that can be measured using
pH.

LOWER Pressure of the vacuum line below the fluid line on the rotating drum.
UPPER Pressure of the vacuum line above the fluid line on the rotating drum.
THICK Filter cake thickness, measured on the drum.
VARIDRIV Setting used to control the drum speed. May differ from DRUMSPD due

to mechanical inefficiencies.
DRUMSPD Speed at which the drum is rotating when collecting the filter cake.

Measured with a stopwatch.

1. Thoroughly analyze the data and develop a regression
model to predict the percentage of solids.

2. Write an executive summary concerning your findings
to the president of the Mountain States Potato Company.

Include specific recommendations on how to get the per-
centage of solids back above 12%.

D I G I TA L C A S E
Apply your knowledge of multiple regression model building
in this Digital Case, which extends the Chapter 14 Omni-
Foods Using Statistics scenario.

Still concerned about ensuring a successful test marketing
of its OmniPower energy bars, the marketing department of
OmniFoods has contacted Connect2Coupons (C2C), an-
other merchandising consultancy. C2C suggests that earlier
analysis done by In-Store Placements Group (ISPG) was
faulty because it did not use the correct type of data. C2C
claims that its Internet-based viral marketing will have an
even greater effect on OmniPower energy bar sales, as new
data from the same 34-store sample will show. In response,
ISPG says its earlier claims are valid and has reported to the
OmniFoods marketing department that it can discern no

simple relationship between C2C’s viral marketing and in-
creased OmniPower sales.

Open OmniPowerForum15.pdf to review all the claims
made in a private online forum and chat hosted on the Omni-
Foods corporate website. Then answer the following:

1. Which of the claims are true? False? True but misleading?
Support your answer by performing an appropriate statis-
tical analysis.

2. If the grocery store chain allowed OmniFoods to use an
unlimited number of sales techniques, which techniques
should it use? Explain.

3. If the grocery store chain allowed OmniFoods to use only
one sales technique, which technique should it use?
Explain.
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C H A P T E R 1 5 E X C E L G U I D E

EG15.1 The QUADRATIC REGRESSION
MODEL

To the worksheet that contains your regression data, add a
new column of formulas that computes the square of one of
the independent variables to create a quadratic term. For ex-
ample, to create a quadratic term for the Section 15.1 fly ash
analysis, open to the DATA worksheet of the FlyAsh work-
book. That worksheet contains the independent variable
FlyAsh% in column A and the dependent variable Strength
in column B. While the quadratic term FlyAsh%^2 could
be created in any column, a good practice is to place inde-
pendent variables in contiguous columns. (You must follow
this practice if you are using the Analysis ToolPak Regres-
sion procedure.) To do so, first select column B (Strength),
right-click, and click Insert from the shortcut menu to add
a new column B. (Strength becomes column C.) Enter the
label FlyAsh%^2 in cell B1 and then enter the formula
=A2^2 in cell B2. Copy this formula down the column
through all the data rows.

To perform a regression analysis using this new vari-
able, apply the Section EG14.1 instructions on page 622.

EG15.2 USING TRANSFORMATIONS
in REGRESSION MODELS

The Square-Root Transformation

To the worksheet that contains your regression data, add a
new column of formulas that computes the square root of
one of the independent variables to create a square-root
transformation. For example, to create a square root trans-
formation in a blank column D for an independent variable
in a column C, enter the formula =SQRT(C2) in cell D2 of
that worksheet and copy the formula down through all data
rows. If the rightmost column in the worksheet contains the
dependent variable, first select that column, right-click, and
click Insert from the shortcut menu and place the transfor-
mation in that new column.

The Log Transformation

To the worksheet that contains your regression data, add a
new column of formulas that compute the common (base
10) logarithm or natural logarithm (base e) of one of the in-
dependent variables to create a log transformation. For ex-
ample, to create a common logarithm transformation in a
blank column D for an independent variable in a column C,
enter the formula =LOG(C2) in cell D2 of that worksheet
and copy the formula down through all data rows. To create

a natural logarithm transformation in a blank column D for
an independent variable in a column C, enter the formula
=LN(C2) in cell D2 of that worksheet and copy the formula
down through all data rows.

If the dependent variable appears in a column to the
immediate right of the independent variable being transformed,
first select the dependent variable column, right-click, and
click Insert from the shortcut menu and then place the trans-
formation of the independent variable in that new column.

EG15.3 COLLINEARITY

PHStat2 To compute the variance inflationary factor, use
the Section EG14.1 “Interpreting the Regression Coeffi-
cients” PHStat2 instructions on page 622 but modify step 6
by checking Variance Inflationary Factor (VIF) before
you click OK. The VIF will appear in cell B9 of the regression
results worksheet, immediately following the Regression
Statistics area.

In-Depth Excel To compute the variance inflationary
factor, first use the Section EG14.1 “Interpreting the
Regression Coefficients” In-Depth Excel instructions on
page 622 to create regression results worksheets for every
combination of independent variables in which one serves
as the dependent variable. Then, in each of the regression re-
sults worksheets, enter the label VIF in cell A9 and enter the
formula =1/(1 - B5) in cell B9 to compute the VIF.

EG15.4 MODEL BUILDING

The Stepwise Regression Approach to Model
Building

PHStat2 Use Stepwise Regression to use the stepwise
regression approach to model building. For example, to
create the Figure 15.11 stepwise analysis of the standby-
hours data on page 646, open to the DATA worksheet of
the Standby workbook. Select PHStat ➔ Regression ➔
Stepwise Regression. In the procedure’s dialog box (shown
on page 661):

1. Enter A1:A27 as the Y Variable Cell Range.

2. Enter B1:E27 as the X Variables Cell Range.

3. Check First cells in both ranges contain label.

4. Enter 95 as the Confidence level for regression
coefficients.

5. Click p values as the Stepwise Criteria.



6. Click General Stepwise and keep the pair of .05 values
as the p value to enter and the p value to remove.

7. Enter a Title and click OK.

The Best-Subsets Approach to Model Building

PHStat2 Use Best Subsets to use a best-subsets approach
to model building. For example, to create the Figure 15.12
best subsets analysis of the standby-hours data on page 647,
open to the DATA worksheet of the Standby workbook.
Select PHStat ➔ Regression ➔ Best Subsets. In the proce-
dure’s dialog box (shown below):

1. Enter A1:A27 as the Y Variable Cell Range.

2. Enter B1:E27 as the X Variables Cell Range.

3. Check First cells in each range contains label.

4. Enter 95 as the Confidence level for regression coeffi-
cients.

5. Enter a Title and click OK.

This procedure may take a noticeable amount of time to cre-
ate its results. The procedure finishes when the statement
“Stepwise ends” (as shown in row 29 in the Figure 15.11
Excel results on page 646) is added to the stepwise regres-
sion results worksheet.

This procedure creates many regression results work-
sheets (seen as a flickering in the Excel windows) as it eval-
uates each subset of independent variables.

C H A P T E R 1 5 M I N I TA B G U I D E

MG15.1 The QUADRATIC REGRESSION
MODEL

Use Calculator to compute the square of one of the inde-
pendent variables to create a quadratic term. For example, to
create a quadratic term for the Section 15.1 fly ash analysis,
open to the FlyAsh worksheet. Select Calc ➔ Calculator.
In the Calculator dialog box (shown in the right column):

1. Enter C3 in the Store result in variable box and press
Tab.

2. Double-click C1 Fly Ash% in the variables list to add
'Fly Ash%' to the Expression box.

3. Click ** and then 2 on the simulated calculator keypad
to add **2 to the Expression box.

4. Click OK.

5. Enter Fly Ash%^2 as the name for column C3.
To perform a regression analysis using this new variable, see
Section MG14.1 on page 625.
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MG15.2 USING TRANSFORMATIONS
in REGRESSION MODELS

Use Calculator to transform a variable. Open to the work-
sheet that contains your regression data. Select Calc ➔
Calculator. In the Calculator dialog box:

1. Enter the name of the empty column that will contain
the transformed values in the Store result in variable
box and press Tab.

2. Select All functions from the Functions drop-down list.

3. In the list of functions, select one of these choices:
Square root, Log base 10, or Natural log (log base e).
Selecting these choices enters SQRT(number),
LOGTEN(number), or LN(number), respectively, in
the Expression box.

4. Double-click the name of the variable to be transformed
in the variables list to replace number with the variable
name in the Expression box.

5. Click OK.

6. Enter a column name for the transformed values.

To perform a regression analysis using this new variable,
see Section MG14.1 on page 625.

MG15.3 COLLINEARITY

To compute the variance inflationary factor, modify the Sec-
tion MG14.1 “Interpreting the Regression Coefficients” in-
structions on page 625. In step 15, check Variance inflation
factors while clearing the other Display and Lack of Fit
Test check boxes in the Regression - Options dialog box.

MG15.4 MODEL BUILDING

The Stepwise Regression Approach to Model
Building

Use Stepwise to use the stepwise regression approach to
model building. For example, to create the Figure 15.11
stepwise analysis of the standby-hours data on page 646, open
to the Standby worksheet. Select Stat ➔ Regression ➔
Stepwise. In the Stepwise Regression dialog box (shown in
the right column):

1. Double-click C1 Standby in the variables list to add
Standby in the Response box.

2. Enter C2-C5 in the Predictors box. (Entering C2-C5 is
a shortcut way of referring to the four variables in
columns 2 through 5. This shortcut avoids having to dou-
ble-click the name of each of these variables in order to
add them to the Predictors box.)

3. Click Methods.

8. Back in the Stepwise Regression dialog box, click OK.

The Best-Subsets Approach to Model Building

Use Best Subsets to use a best-subsets approach to model
building. For example, to create the Figure 15.12 stepwise
analysis of the standby-hours data on page 647, open to the
Standby worksheet. Select Stat ➔ Regression ➔ Best
Subsets. In the Best Subsets Regression dialog box (shown
on page 663):

1. Double-click C1 Standby in the variables list to add
Standby in the Response box.

2. Enter C2-C5 in the Free Predictors box. (Entering
C2-C5 is a shortcut way of referring to the four variables
in columns 2 through 5 as explained in the previous set
of instructions.)
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In the Stepwise-Methods dialog box (shown below):

4. Click Use alpha values.

5. Click Stepwise.

6. Enter 0.05 in the Alpha to enter box and 0.05 in the
Alpha to remove box.

7. Click OK.
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6. Check Fit intercept

7. Click OK.

8. Back in the Best Subsets Regression dialog box, click
OK.

3. Click Options.

In the Best Subsets Regression - Options dialog box
(shown in the right column):

4. Enter 1 in the Minimum box and keep the Maximum
box empty.

5. Enter 3 in the Models of each size to print box.
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Learning Objectives
In this chapter, you learn:

• About different time-series forecasting models—moving averages, exponential
smoothing, the linear trend, the quadratic trend, the exponential trend—and the
autoregressive models and least-squares models for seasonal data

• To choose the most appropriate time-series forecasting model

Time-Series Forecasting16



Y ou are a financial analyst for The Principled, a large financial services company.
You need to better evaluate investment opportunities for your clients. To assist in
the forecasting, you have collected time-series data on the three-month U.S. Trea-
sury bill rate and revenues of two large well-known companies, The Coca-Cola
Company, and Wal-Mart Stores, Inc. Each time series has unique characteristics.

You understand that you can use several different types of forecasting models. How do you decide
which type of forecasting is best? How do you use the information gained from the forecasting models
to evaluate investment opportunities for your clients?

U S I N G S TAT I S T I C S

@ The Principled

665
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I n Chapters 13 through 15, you used regression analysis as a tool for model building and
prediction. In this chapter, regression analysis and other statistical methodologies are ap-
plied to time-series data. A time series is a set of numerical data collected over time. Due

to differences in the features of data for various investments described in the Using Statistics
scenario, you need to consider several different approaches to forecasting time-series data.

This chapter begins with an introduction to the importance of business forecasting (see
Section 16.1) and a description of the components of time-series models (see Section 16.2).
The coverage of forecasting models begins with annual time-series data. Section 16.3 presents
moving averages and exponential smoothing methods for smoothing a series. This is followed
by least-squares trend fitting and forecasting in Section 16.4 and autoregressive modeling in
Section 16.5. Section 16.6 discusses how to choose among alternative forecasting models.
Section 16.7 develops models for monthly and quarterly time series.

16.1 The Importance of Business Forecasting
Forecasting is done by monitoring changes that occur over time and projecting into the future.
Forecasting is commonly used in both the for-profit and not-for-profit sectors of the economy.
For example, marketing executives of a retailing corporation forecast product demand, sales
revenues, consumer preferences, inventory, and so on in order to make decisions regarding
product promotions and strategic planning. Government officials forecast unemployment, in-
flation, industrial production, and revenues from income taxes in order to formulate policies.
And the administrators of a college or university forecast student enrollment in order to plan
for the construction of dormitories and academic facilities, plan for student and faculty recruit-
ment, and make assessments of other needs.

There are two common approaches to forecasting: qualitative and quantitative.
Qualitative forecasting methods are especially important when historical data are unavail-
able. Qualitative forecasting methods are considered to be highly subjective and judgmental.

Quantitative forecasting methods make use of historical data. The goal of these methods
is to use past data to predict future values. Quantitative forecasting methods are subdivided into
two types: time series and causal. Time-series forecasting methods involve forecasting future
values based entirely on the past and present values of a variable. For example, the daily closing
prices of a particular stock on the New York Stock Exchange constitute a time series. Other ex-
amples of economic or business time series are the consumer price index (CPI), the quarterly
gross domestic product (GDP), and the annual sales revenues of a particular company.

Causal forecasting methods involve the determination of factors that relate to the vari-
able you are trying to forecast. These include multiple regression analysis with lagged vari-
ables, econometric modeling, leading indicator analysis, and other economic barometers that
are beyond the scope of this text (see references 2–4). The primary emphasis in this chapter is
on time-series forecasting methods.

16.2 Component Factors of Time-Series Models
Time-series forecasting assumes that the factors that have influenced activities in the past and
present will continue to do so in approximately the same way in the future. Time-series fore-
casting seeks to identify and isolate these component factors in order to make predictions. Typ-
ically, the following four factors are examined in time-series models:

• Trend
• Cyclical effect
• Irregular or random effect
• Seasonal effect

A trend is an overall long-term upward or downward movement in a time series. Trend is
not the only component factor that can influence data in a time series. The cyclical effect
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depicts the up-and-down swings or movements through the series. Cyclical movements vary in
length, usually lasting from 2 to 10 years. They differ in intensity and are often correlated with
a business cycle. In some time periods, the values are higher than would be predicted by a trend
line (i.e., they are at or near the peak of a cycle). In other time periods, the values are lower than
would be predicted by a trend line (i.e., they are at or near the bottom of a cycle). Any data that
do not follow the trend modified by the cyclical component are considered part of the irregular
effect, or random effect. When you have monthly or quarterly data, an additional component,
the seasonal effect, is considered, along with the trend, cyclical, and irregular effects.

Your first step in a time-series analysis is to plot the data and observe whether any patterns
exist over time. You must determine whether there is a long-term upward or downward move-
ment in the series (i.e., a trend). If there is no obvious long-term upward or downward trend,
then you can use moving averages or exponential smoothing to smooth the series (see Section
16.3). If a trend is present, you can consider several time-series forecasting methods. (See Sec-
tions 16.4 and 16.5 for forecasting annual data and Section 16.7 for forecasting monthly or
quarterly time series.)

16.3 Smoothing an Annual Time Series
One of the investments considered in The Principled scenario is three-month U.S. Treasury
bills. Table 16.1 gives the rate for three-month U.S. Treasury bills at the end of the year from
1991 to 2009 (stored in ). Figure 16.1 presents the time-series plot.Treasury

T A B L E 1 6 . 1

Rate for Three-Month
U.S. Treasury Bills from
1991 to 2009

Year Rate Year Rate Year Rate

1991 5.38 1997 5.06 2003 1.01
1992 3.43 1998 4.78 2004 1.37
1993 3.00 1999 4.64 2005 3.15
1994 4.25 2000 5.82 2006 4.73
1995 5.49 2001 3.40 2007 4.36
1996 5.01 2002 1.61 2008 1.37

2009 0.15
Source: Board of Governors of the Federal Reserve System, www.federalreserve.gov.

F I G U R E 1 6 . 1
Plot of three-month U.S.
Treasury bill rate from
1991 to 2009

www.federalreserve.gov


The following data represent total revenues (in $millions) for a fast-food store over the 11-year
period 2000 to 2010:

Compute the five-year moving averages for this annual time series.

SOLUTION To compute the five-year moving averages, you first compute the total for the
five years and then divide this total by 5. The first of the five-year moving averages is

The moving average is centered on the middle value—the third year of this time series. To
compute the second of the five-year moving averages, you compute the total of the second
through sixth years and divide this total by 5:

MA152 =
Y2 + Y3 + Y4 + Y5 + Y6

5
=

5.0 + 7.0 + 6.0 + 8.0 + 9.0
5

=
35.0

5
= 7.0

MA152 =
Y1 + Y2 + Y3 + Y4 + Y5

5
=

4.0 + 5.0 + 7.0 + 6.0 + 8.0
5

=
30.0

5
= 6.0

4.0 5.0 7.0 6.0 8.0 9.0 5.0 2.0 3.5 5.5 6.5

EXAMPLE 16.1
Computing
Five-Year Moving
Averages
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When you examine annual data, your visual impression of the long-term trend in the se-
ries is sometimes obscured by the amount of variation from year to year. Often, you cannot
judge whether any long-term upward or downward trend exists in the series. To get a better
overall impression of the pattern of movement in the data over time, you can use the methods
of moving averages or exponential smoothing.

Moving Averages
Moving averages for a chosen period of length L consist of a series of means, each computed
over time for a sequence of L observed values. Moving averages, represented by the symbol

can be greatly affected by the value chosen for L, which should be an integer value that
corresponds to, or is a multiple of, the estimated average length of a cycle in the time series.

To illustrate, suppose you want to compute five-year moving averages from a series that
has years. Because the five-year moving averages consist of a series of means
computed by averaging consecutive sequences of five values. You compute the first five-year
moving average by summing the values for the first five years in the series and dividing by 5:

You compute the second five-year moving average by summing the values of years 2
through 6 in the series and then dividing by 5:

You continue this process until you have computed the last of these five-year moving aver-
ages by summing the values of the last 5 years in the series (i.e., years 7 through 11) and then
dividing by 5:

When you have annual time-series data, L should be an odd number of years. By follow-
ing this rule, you are unable to compute any moving averages for the first years or
the last years of the series. Thus, for a five-year moving average, you cannot make
computations for the first two years or the last two years of the series.

When plotting moving averages, you plot each of the computed values against the middle
year of the sequence of years used to compute it. If and the first moving aver-
age is centered on the third year, the second moving average is centered on the fourth year, and
the last moving average is centered on the ninth year. Example 16.1 illustrates the computation
of five-year moving averages.

L = 5,n = 11

1L - 12>2 1L - 12>2

MA152 =
Y7 + Y8 + Y9 + Y10 + Y11

5

MA152 =
Y2 + Y3 + Y4 + Y5 + Y6

5

MA152 =
Y1 + Y2 + Y3 + Y4 + Y5

5

L = 5,n = 11

MA1L2,
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This moving average is centered on the new middle value—the fourth year of the time
series. The remaining moving averages are

These moving averages are centered on their respective middle values—the fifth, sixth, seventh,
eighth, and ninth years in the time series. When you use the five-year moving averages, you are
unable to compute a moving average for the first two or last two values in the time series.

MA152 =
Y7 + Y8 + Y9 + Y10 + Y11

5
=

5.0 + 2.0 + 3.5 + 5.5 + 6.5
5

=
22.5

5
= 4.5

MA152 =
Y6 + Y7 + Y8 + Y9 + Y10

5
=

9.0 + 5.0 + 2.0 + 3.5 + 5.5
5

=
25.0

5
= 5.0

MA152 =
Y5 + Y6 + Y7 + Y8 + Y9

5
=

8.0 + 9.0 + 5.0 + 2.0 + 3.5
5

=
27.5

5
= 5.5

MA152 =
Y4 + Y5 + Y6 + Y7 + Y8

5
=

6.0 + 8.0 + 9.0 + 5.0 + 2.0
5

=
30.0

5
= 6.0

MA152 =
Y3 + Y4 + Y5 + Y6 + Y7

5
=

7.0 + 6.0 + 8.0 + 9.0 + 5.0
5

=
35.0

5
= 7.0

In practice, you can avoid the tedious computations by using Excel or Minitab to compute
moving averages. Figure 16.2 presents the annual three-month U.S. Treasury bill rate data from
1991 through 2009, the computations for three- and seven-year moving averages, and a plot of
the original data and the moving averages.

F I G U R E 1 6 . 2
Excel worksheet with
superimposed chart for
the three-year and
seven-year moving
averages for the three-
month U.S. Treasury bill
rate

In Figure 16.2, there is no three-year moving average for the first year and the last year,
and there is no seven-year moving average for the first three years and last three years. Both
the three-year and seven-year moving averages have smoothed out the large amount of varia-
tion that exists in the three-month U.S. Treasury bill rates. The seven-year moving average
smoothes the series more than the three-year moving average because the period is longer.
However, the longer the period, the smaller the number of moving averages you can compute.
Therefore, selecting moving averages that are longer than seven years is usually undesirable
because too many moving average values are missing at the beginning and end of the series.
The selection of L, the length of the period used for constructing the averages, is highly sub-
jective. If cyclical fluctuations are present in the data, choose an integer value of L that corre-
sponds to (or is a multiple of) the estimated length of a cycle in the series. For annual
time-series data that has no obvious cyclical fluctuations, most people choose three years, five
years, or seven years as the value of L, depending on the amount of smoothing desired and the
amount of data available.
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F I G U R E 1 6 . 3
Excel worksheet with
superimposed chart for
the exponentially
smoothed series
( and

) of the 
three-month U.S.
Treasury bill rates

W = 0.25
W = 0.50

Exponential Smoothing
Exponential smoothing consists of a series of exponentially weighted moving averages. The
weights assigned to the values change so that the most recent value receives the highest weight,
the previous value receives the second-highest weight, and so on, with the first value receiving
the lowest weight. Throughout the series, each exponentially smoothed value depends on all
previous values, which is an advantage of exponential smoothing over the method of moving
averages. Exponential smoothing also allows you to compute short-term (one period into the
future) forecasts when the presence and type of long-term trend in a time series is difficult to
determine.

The equation developed for exponentially smoothing a series in any time period, i, is based
on only three terms—the current value in the time series, the previously computed expo-
nentially smoothed value, and an assigned weight or smoothing coefficient, W. You use
Equation (16.1) to exponentially smooth a time series.

Ei-1;
Yi;

Computing an Exponentially Smoothed Value in Time Period i

(16.1)

where

value of the exponentially smoothed series being computed in time period i

value of the exponentially smoothed series already computed in time
period

observed value of the time series in period i

subjectively assigned weight or smoothing coefficient .
Although W can approach 1.0, in virtually all business applications,
W … 0.5.

1where 0 6 W 6 12W =

Yi =

i - 1
Ei-1 =

Ei =

Ei = WYi + 11 - W2Ei-1 i = 2, 3, 4, Á

E1 = Y1

Choosing the weight or smoothing coefficient (i.e., W) that you assign to the time series is
critical. Unfortunately, this selection is somewhat subjective. If your goal is to smooth a series
by eliminating unwanted cyclical and irregular variations in order to see the overall long-term
tendency of the series, you should select a small value for W (close to 0). If your goal is fore-
casting future short-term directions, you should choose a large value for W (close to 0.5).
Figure 16.3 shows a worksheet that presents the exponentially smoothed values (with smooth-
ing coefficients and ), the three-month U.S. Treasury bill rates from 1991
to 2009, and a plot of the original data and the two exponentially smoothed time series.

W = 0.25W = 0.50
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To illustrate these exponential smoothing computations for a smoothing coefficient of
you begin with the initial value as the first smoothed value

Then, using the value of the time series for 1992 you smooth
the series for 1992 by computing

To smooth the series for 1993:

To smooth the series for 1994:

You continue this process until you have computed the exponentially smoothed values for all
19 years in the series, as shown in Figure 16.3.

To use exponential smoothing for forecasting, you use the smoothed value in the current
time period as the forecast of the value in the following period ( ).YNi+1

= 10.25214.252 + 10.75214.422 = 4.38

E1994 = WY1994 + 11 - W2E1993

= 10.25213.02 + 10.75214.892 = 4.42

E1993 = WY1993 + 11 - W2E1992

= 10.25213.432 + 10.75215.382 = 4.89

E1992 = WY1992 + 11 - W2E1991

1Y1992 = 3.432,1E1991 = 5.382. Y1991 = 5.38W = 0.25,

FORECASTING TIME PERIOD 

(16.2)YNi+1 = Ei

i + 1

To forecast the three-month U.S. Treasury bill rates at the end of 2010, using a smoothing
coefficient of you use the smoothed value for 2009 as its estimate. Figure 16.3
shows that this value is 2.30. (How close is this forecast? Look up the three-month U.S. Trea-
sury bill rate at www.federalreserve.gov to find out.) When the value for 2010 becomes avail-
able, you can use Equation (16.1) to make a forecast for 2011 by computing the smoothed
value for 2010, as follows:

Or, in terms of forecasting, you compute the following:

YN2011 = WY2010 + (1 - W )YN2010

New forecast = 1W21Current value2 + 11 - W21Current forecast2

E2010 = WY2010 + 11 - W2E2009

Current smoothed value = 1W21Current value2 + 11 - W21Previous smoothest value2

W = 0.25,

Problems for Section 16.3
LEARNING THE BASICS
16.1 If you are using exponential smoothing for fore-
casting an annual time series of revenues, what is your
forecast for next year if the smoothed value for this year is
$32.4 million?

16.2 Consider a nine-year moving average used to smooth
a time series that was first recorded in 2002.
a. Which year serves as the first centered value in the

smoothed series?

b. How many years of values in the series are lost when
computing all the nine-year moving averages?

16.3 You are using exponential smoothing on an annual
time series concerning total revenues (in millions of
dollars). You decide to use a smoothing coefficient of

and the exponentially smoothed value for 2010
is
a. What is the smoothed value of this series in 2010?
b. What is the smoothed value of this series in 2011 if the

value of the series in that year is $11.5 million?

E2010 = 10.202112.12 + 10.80219.42.W = 0.20,

www.federalreserve.gov
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Year Attendance

2001 1.44
2002 1.60
2003 1.52
2004 1.48
2005 1.38
2006 1.40
2007 1.40
2008 1.36
2009 1.42

Source: Data extracted from Motion Picture Association of America,
www.mpaa.org.

Year Accidents

2001 200
2002 186
2003 235
2004 204
2005 253
2006 237
2007 240
2008 211
2009 195

Source: Data extracted from C. Graves, “On-Track Incidents Decrease
in Sprint Cup,” USA Today, December 16, 2008, p. 1C; and usatoday.
com/sports/graphics/2009/nascar-crash-database/flash.htm.

APPLYING THE CONCEPTS
16.4 The following data (stored in

) represent the yearly movie atten-
dance (in billions) from 2001 to 2009:

Attendance

MovieSELF
Test

which show the performance of a broad measure of stock
performance (by percentage) for each decade from the
1830s through the 2000s:

a. Plot the time series.
b. Fit a three-year moving average to the data and plot the

results.
c. Using a smoothing coefficient of exponen-

tially smooth the series and plot the results.
d. What is your exponentially smoothed forecast for 2010?
e. Repeat (c) and (d), using 
f. Compare the results of (d) and (e).

16.5 The following data, stored in , provide the
number of accidents in the NASCAR Sprint Cup series from
2001 to 2009:

NASCAR

W = 0.25.

W = 0.50,

a. Plot the time series.
b. Fit a three-year moving average to the data and plot the

results.
c. Using a smoothing coefficient of exponen-

tially smooth the series and plot the results.
d. What is your exponentially smoothed forecast for 2010?
e. Repeat (c) and (d), using 
f. Compare the results of (d) and (e).

16.6 How have stocks performed in the past? The follow-
ing table presents the data stored in ,Stock Performance

W = 0.25.

W = 0.50,

Decade
Performance

(%) Decade
Performance

(%)

1830s 2.8 1920s 13.3
1840s 12.8 1930s -2.2
1850s 6.6 1940s 9.6
1860s 12.5 1950s 18.2
1870s 7.5 1960s 8.3
1880s 6.0 1970s 6.6
1890s 5.5 1980s 16.6
1900s 10.9 1990s 17.6
1910s 2.2 2000s* -0.5

*Through December 15, 2009.

Source: T. Lauricella, “Investors Hope the ‘10s Beat the ‘00s,” The
Wall Street Journal, December 21, 2009, pp. C1, C2.

a. Plot the time series.
b. Fit a three-period moving average to the data and plot the

results.
c. Using a smoothing coefficient of exponen-

tially smooth the series and plot the results.
d. What is your exponentially smoothed forecast for the 2010s?
e. Repeat (c) and (d), using 
f. Compare the results of (d) and (e).
g. What conclusions can you reach concerning how stocks

have performed in the past?

16.7 The following data (stored in ) represent
the sixth-month Eurodollar deposit rate from 2001 to 2009:

EuroDollar

W = 0.25.

W = 0.50,

Year EuroDollar Rate

2001 3.65
2002 1.81
2003 1.16
2004 1.72
2005 3.71
2006 5.27
2007 5.27
2008 3.48
2009 1.51

Source: www.federalreserve.gov/releases/h15/data/Annual/
H15_ED_M6.txt.

a. Plot the data.
b. Fit a three-year moving average to the data and plot the

results.
c. Using a smoothing coefficient of exponen-

tially smooth the series and plot the results.
d. What is your exponentially smoothed forecast for 2010?
e. Repeat (c) and (d), using a smoothing coefficient of

f. Compare the results of (d) and (e).
W = 0.25.

W = 0.50,

www.mpaa.org
www.federalreserve.gov/releases/h15/data/Annual/H15_ED_M6.txt
www.federalreserve.gov/releases/h15/data/Annual/H15_ED_M6.txt
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16.8 The file contains the number of audits of cor-
porations with assets of more than $250 million conducted
by the Internal Revenue Service. (Data extracted from K.
McCoy, “IRS Audits Big Firms Less Often,” USA Today,
April 15, 2010, p. 1B.)
a. Plot the data.
b. Fit a three-year moving average to the data and plot the

results.

Audits c. Using a smoothing coefficient of exponen-
tially smooth the series and plot the results.

d. What is your exponentially smoothed forecast for 2010?
e. Repeat (c) and (d), using a smoothing coefficient of

f. Compare the results of (d) and (e).
W = 0.25.

W = 0.50,

16.4 Least-Squares Trend Fitting and Forecasting
Trend is the component factor of a time series most often used to make intermediate and long-
range forecasts. To get a visual impression of the overall long-term movements in a time se-
ries, you construct a time-series plot. If a straight-line trend adequately fits the data, you can
use a linear trend model [see Equation (16.3) and Section 13.2]. If the time-series data indicate
some long-run downward or upward quadratic movement, you can use a quadratic trend model
[see Equation (16.4) and Section 15.1]. When the time-series data increase at a rate such that
the percentage difference from value to value is constant, you can use an exponential trend
model [see Equation (16.5)].

The Linear Trend Model
The linear trend model:

is the simplest forecasting model. Equation (16.3) defines the linear trend forecasting
equation.

Yi = b0 + b1Xi + ei

LINEAR TREND FORECASTING EQUATION

(16.3)YNi = b0 + b1Xi

Recall that in linear regression analysis, you use the method of least squares to compute
the sample slope, and the sample Y intercept, You then substitute the values for X into
Equation (16.3) to predict Y.

When using the least-squares method for fitting trends in a time series, you can
simplify the interpretation of the coefficients by assigning coded values to the X (time)
variable. You assign consecutively numbered integers, starting with 0, as the coded values
for the time periods. For example, in time-series data that have been recorded annually for
15 years, you assign the coded value 0 to the first year, the coded value 1 to the second
year, the coded value 2 to the third year, and so on, concluding by assigning 14 to the
fifteenth year.

In The Principled scenario on page 665, one of the companies of interest is The Coca-Cola
Company. Founded in 1886 and headquartered in Atlanta, Georgia, Coca-Cola manufactures,
distributes, and markets more than 3,300 beverages in over 200 countries worldwide. Some of
its brands include Barq’s, Dasani, Full Throttle, Glacéau Vitaminwater, Minute Maid,
Powerade, and Sprite in addition to Coca-Cola. According to The Coca-Cola Company’s
website (www.thecoca-colacompany.com), revenues in 2009 topped $31 billion. Table 16.2
lists The Coca-Cola Company’s gross revenues (in billions of dollars) from 1995 to 2009
(stored in ).Coca-Cola

b0.b1,

www.thecoca-colacompany.com
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T A B L E 1 6 . 2

Revenues (in Billions of
Dollars) for The Coca-
Cola Company
(1995–2009)

Year Revenue Year Revenue

1995 18.0 2003 21.0
1996 18.5 2004 21.9
1997 18.9 2005 23.1
1998 18.8 2006 24.1
1999 19.8 2007 28.9
2000 20.5 2008 31.9
2001 20.1 2009 31.0
2002 19.6

Source: Data extracted from Mergent’s Handbook of Common Stocks, 2006; and 
www.thecoca-colacompany.com.

F I G U R E 1 6 . 4
Excel and Minitab regression results for a linear trend model to forecast revenues (in billions of dollars) for The Coca-
Cola Company

You interpret the regression coefficients as follows:

• The Y intercept, is the predicted revenues (in billions of dollars) at The
Coca-Cola Company during the origin or base year, 1995.

• The slope, indicates that revenues are predicted to increase by 0.915 bil-
lion dollars per year.

To project the trend in the revenues at Coca-Cola to 2010, you substitute the code
for 2010, into the linear trend forecasting equation:

The trend line is plotted in Figure 16.5, along with the observed values of the time series.
There is a strong upward linear trend, and is 0.7938, indicating that more than 79% of the
variation in revenues is explained by the linear trend of the time series. To investigate whether
a different trend model might provide a better fit, a quadratic trend model and an exponential
trend model are fitted next.

r2

YNi = 16.0017 + 0.91501152 = 29.7267 billions of dollars

X16 = 15,

b1 = 0.9150,

b0 = 16.0017,

Figure 16.4 presents the regression results for the simple linear regression that uses the
consecutive coded values 0 through 14 as the X (coded year) variable. These results produce
the following linear trend forecasting equation:

where represents 1995.X1 = 0

YNi = 16.0017 + 0.9150Xi

www.thecoca-colacompany.com


16.4 Least-Squares Trend Fitting and Forecasting 675

F I G U R E 1 6 . 5
Plot of the linear trend
forecasting equation for
The Coca-Cola Company
revenue data

QUADRATIC TREND FORECASTING EQUATION

(16.4)

where

estimated Y intercept

estimated linear effect on 

estimated quadratic effect on Yb2 =

Yb1 =

b0 =

YNi = b0 + b1Xi + b2X 2
i

Figure 16.6 presents the regression results for the quadratic trend model used to forecast
revenues at The Coca-Cola Company.

The Quadratic Trend Model
A quadratic trend model:

is the simplest nonlinear model. Using the least-squares method described in Section 15.1, you
can develop a quadratic trend forecasting equation, as presented in Equation (16.4).

YNi = b0 + b1Xi + b2X 2
i + ei

F I G U R E 1 6 . 6
Excel and Minitab regression results for the quadratic trend model to forecast revenues for The Coca-Cola Company
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The model in Equation (16.5) is not in the form of a linear regression model. To transform
this nonlinear model to a linear model, you use a base 10 logarithm transformation.1 Taking
the logarithm of each side of Equation (16.5) results in Equation (16.6).

In Figure 16.6,

where the year coded 0 is 1995.
To compute a forecast using the quadratic trend equation, you substitute the appropriate

coded X value into this equation. For example, to forecast the trend in revenues for 2010 (i.e.,
),

Figure 16.7 plots the quadratic trend forecasting equation along with the time series for the ac-
tual data. This quadratic trend model provides a better fit (adjusted ) to the time
series than does the linear trend model. The test statistic for the contribution of the quad-
ratic term to the model is 5.3063 (p-value ).= 0.0002

tSTAT

r2 = 0.9281

YNi = 19.0879 - 0.50941152 + 0.108711522 = 35.9044

X = 15

YNi = 19.0879 - 0.5094Xi + 0.1017X 2
i

F I G U R E 1 6 . 7
Plot of the quadratic
trend forecasting
equation for The 
Coca-Cola Company
revenue data

The Exponential Trend Model
When a time series increases at a rate such that the percentage difference from value to value is
constant, an exponential trend is present. Equation (16.5) defines the exponential trend model.

EXPONENTIAL TREND MODEL

(16.5)

where
intercept

is the annual compound growth rate (in %)1b1 - 12 * 100%

b0 = Y

Yi = b0b
Xi
1 ei

1Alternatively, you can use base
e logarithms. For more information
on logarithms, see Section A.3 in
Appendix A.
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Equation (16.6) is a linear model you can estimate using the least-squares method, with log
as the dependent variable and as the independent variable. This results in Equation (16.7).Xi1Yi2

TRANSFORMED EXPONENTIAL TREND MODEL

(16.6)

= log1b02 + Xi log1b12 + log1ei2
= log1b02 + log1bXi

1 2 + log1ei2
log1Yi2 = log1b0b

Xi
1 ei2

EXPONENTIAL TREND FORECASTING EQUATION

(16.7a)

where

estimate of and thus 

estimate of and thus 

therefore,

(16.7b)

where

is the estimated annual compound growth rate (in %)(bN1 - 1) * 100%

YNi = bN 0bN 1
Xi

10b1 = bN 1log1b12b1 =
10b0 = bN 0log1b02b0 =

log(YNi2 = b0 + b1Xi

Figure 16.8 shows the regression results for an exponential trend model of revenues at The
Coca-Cola Company.

F I G U R E 1 6 . 8
Excel and Minitab regression results for an exponential model to forecast revenues for The Coca-Cola Company

Using Equation (16.7a) and the results from Figure 16.8,

where the year coded 0 is 1995.
You compute the values for and by taking the antilog of the regression coefficients

( and ):

b1
N = antilog(b1) = antilog10.01682 = 100.0168 = 1.0394

bN 0 = antilog(b0) = antilog11.22522 = 101.2252 = 16.7958

b1b0

bN 1bN 0

log(YNi2 = 1.2252 + 0.0168Xi
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Model Selection Using First, Second, 
and Percentage Differences
You have used the linear, quadratic, and exponential models to forecast revenues for The Coca-
Cola Company. How can you determine which of these models is the most appropriate model?
In addition to visually inspecting time-series plots and comparing adjusted values, you can
compute and examine first, second, and percentage differences. The identifying features of lin-
ear, quadratic, and exponential trend models are as follows:

• If a linear trend model provides a perfect fit to a time series, then the first differences are
constant. Thus,

• If a quadratic trend model provides a perfect fit to a time series, then the second differ-
ences are constant. Thus,

31Y3 - Y22 - 1Y2 - Y124 = 31Y4 - Y32 - 1Y3 - Y224 = Á = 31Yn - Yn-12 - 1Yn-1 - Yn-224

1Y2 - Y12 = 1Y3 - Y22 = Á = 1Yn - Yn-12

r2

Thus, using Equation (16.7b), the exponential trend forecasting equation is

where the year coded 0 is 1995.
The Y intercept, billions of dollars, is the revenue forecast for the base

year 1995. The value is the annual compound growth rate in
revenues at The Coca-Cola Company.

For forecasting purposes, you substitute the appropriate coded X values into either Equa-
tion (16.7a) or Equation (16.7b). For example, to forecast revenues for 2010 (i.e., )
using Equation (16.7a),

Figure 16.9 plots the exponential trend forecasting equation, along with the time-series
data. The adjusted for the exponential trend model (0.8277) is greater than the adjusted
for the linear trend model (0.7779) but less than the quadratic model (0.9281).

r2r2

YNi = antilog11.47722 = 101.4772 = 30.0054 billions of dollars

log(YNi2 = 1.2252 + 0.01681152 = 1.4772

X = 15

1bN 1 - 12 * 100% = 3.94%
bN 0 =  16.7958

YNi = 116.7958211.03942Xi

F I G U R E 1 6 . 9
Plot of the exponential
trend forecasting
equation for The Coca-
Cola Company revenues
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• If an exponential trend model provides a perfect fit to a time series, then the percentage
differences between consecutive values are constant. Thus,

Although you should not expect a perfectly fitting model for any particular set of time-series
data, you can consider the first differences, second differences, and percentage differences as
guides in choosing an appropriate model. Examples 16.2, 16.3, and 16.4 illustrate linear, quad-
ratic, and exponential trend models that have perfect (or nearly perfect) fits to their respective
data sets.

Y2 - Y1

Y1
* 100% =

Y3 - Y2

Y2
* 100% = Á =

Yn - Yn-1

Yn-1
* 100%

The following time series represents the number of passengers per year (in millions) on ABC
Airlines:

EXAMPLE 16.2
A Linear Trend
Model with a
Perfect Fit

Year

2001 2002 2003 2004 2005 2006 2007 2008 2009 2010

Passengers 30.0 33.0 36.0 39.0 42.0 45.0 48.0 51.0 54.0 57.0

Year

2001 2002 2003 2004 2005 2006 2007 2008 2009 2010

Passengers 30.0 31.0 33.5 37.5 43.0 50.0 58.5 68.5 80.0 93.0

Using first differences, show that the linear trend model provides a perfect fit to these data.

SOLUTION The following table shows the solution:

Year

2001 2002 2003 2004 2005 2006 2007 2008 2009 2010

Passengers 30.0 33.0 36.0 39.0 42.0 45.0 48.0 51.0 54.0 57.0
First
differences 3.0 3.0 3.0 3.0 3.0 3.0 3.0 3.0 3.0

The differences between consecutive values in the series are the same throughout. Thus, ABC Air-
lines shows a linear growth pattern. The number of passengers increases by 3 million per year.

The following time series represents the number of passengers per year (in millions) on XYZ
Airlines:

EXAMPLE 16.3
A Quadratic Trend
Model with a
Perfect Fit

Using second differences, show that the quadratic trend model provides a perfect fit to
these data.

SOLUTION The following table shows the solution:

Year

2001 2002 2003 2004 2005 2006 2007 2008 2009 2010

Passengers 30.0 31.0 33.5 37.5 43.0 50.0 58.5 68.5 80.0 93.0
First differences 1.0 2.5 4.0 5.5 7.0 8.5 10.0 11.5 13.0
Second differences 1.5 1.5 1.5 1.5 1.5 1.5 1.5 1.5
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The second differences between consecutive pairs of values in the series are the same throughout.
Thus, XYZ Airlines shows a quadratic growth pattern. Its rate of growth is accelerating over time.

The following time series represents the number of passengers per year (in millions) for EXP
Airlines:

EXAMPLE 16.4
An Exponential
Trend Model 
with an Almost
Perfect Fit

Using percentage differences, show that the exponential trend model provides almost a per-
fect fit to these data.

SOLUTION The following table shows the solution:

The percentage differences between consecutive values in the series are approximately the
same throughout. Thus, EXP Airlines shows an exponential growth pattern. Its rate of growth
is approximately 5% per year.

Figure 16.10 shows a worksheet that compares the first, second, and percentage differ-
ences for the revenues data at The Coca-Cola Company. Neither the first differences, second
differences, nor percentage differences are constant across the series. Therefore, other models
(including those considered in Section 16.5) may be more appropriate.

F I G U R E 1 6 . 1 0
Worksheet that compares
first, second, and per-
centage differences in
revenues (in billions of
dollars) for The Coca-
Cola Company

Year

2001 2002 2003 2004 2005 2006 2007 2008 2009 2010

Passengers 30.0 31.5 33.1 34.8 36.5 38.3 40.2 42.2 44.3 46.5
First differences 1.5 1.6 1.7 1.7 1.8 1.9 2.0 2.1 2.2
Percentage
differences 5.0 5.1 5.1 4.9 4.9 5.0 5.0 5.0 5.0

Year

2001 2002 2003 2004 2005 2006 2007 2008 2009 2010

Passengers 30.0 31.5 33.1 34.8 36.5 38.3 40.2 42.2 44.3 46.5
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Problems for Section 16.4
LEARNING THE BASICS
16.9 If you are using the method of least squares for fitting
trends in an annual time series containing 25 consecutive
yearly values,
a. what coded value do you assign to X for the first year in

the series?
b. what coded value do you assign to X for the fifth year in

the series?
c. what coded value do you assign to X for the most recent

recorded year in the series?
d. what coded value do you assign to X if you want to

project the trend and make a forecast five years beyond
the last observed value?

16.10 The linear trend forecasting equation for an annual
time series containing 22 values (from 1989 to 2010) on
total revenues (in millions of dollars) is

a. Interpret the Y intercept,
b. Interpret the slope, 
c. What is the fitted trend value for the fifth year?
d. What is the fitted trend value for the most recent year?
e. What is the projected trend forecast three years after the

last value?

16.11 The linear trend forecasting equation for an annual
time series containing 42 values (from 1969 to 2010) on net
sales (in billions of dollars) is

a. Interpret the Y intercept,
b. Interpret the slope, 
c. What is the fitted trend value for the tenth year?
d. What is the fitted trend value for the most recent year?
e. What is the projected trend forecast two years after the

last value?

APPLYING THE CONCEPTS
16.12 Bed Bath & Beyond is a nationwide chain
of retail stores that sell a wide assortment of

merchandise, including domestics merchandise and home
furnishings, as well as food, giftware, and health and beauty
care items. The following data (stored in ) show
the number of stores open at the end of the fiscal year from
1993 to 2010:
a. Plot the data.
b. Compute a linear trend forecasting equation and plot the

results.
c. Compute a quadratic trend forecasting equation and plot

the results.
d. Compute an exponential trend forecasting equation and

plot the results.

Bed & Bath

SELF
Test

b1.
b0.

YNi = 1.2 + 0.5Xi

b1.
b0.

YNi = 4.0 + 1.5Xi

e. Using the forecasting equations in (b) through (d), what
are your annual forecasts of the number of stores open
for 2011 and 2012?

f. How can you explain the differences in the three
forecasts in (e)? What forecast do you think you should
use? Why?

16.13 Gross domestic product (GDP) is a major indicator
of a nation’s overall economic activity. It consists of
personal consumption expenditures, gross domestic
investment, net exports of goods and services, and
government consumption expenditures. The GDP (in
billions of current dollars) for the United States from 1980
to 2009 is stored in .
Source: Data extracted from Bureau of Economic Analysis, U.S.
Department of Commerce, www.bea.gov.

a. Plot the data.
b. Compute a linear trend forecasting equation and plot the

trend line.
c. What are your forecasts for 2010 and 2011?
d. What conclusions can you reach concerning the trend in

GDP?

16.14 The data in represent federal receipts
from 1978 through 2009, in billions of current dollars, from
individual and corporate income tax, social insurance,
excise tax, estate and gift tax, customs duties, and federal
reserve deposits.
Source: Data extracted from Tax Policy Center, www.taxpolicycenter.
org.

a. Plot the series of data.
b. Compute a linear trend forecasting equation and plot the

trend line.
c. What are your forecasts of the federal receipts for 2010

and 2011?
d. What conclusions can you reach concerning the trend in

federal receipts?

FedReceipt

GDP

Year Stores Open Year Stores Open

1993 38 2002 396
1994 45 2003 519
1995 61 2004 629
1996 80 2005 721
1997 108 2006 809
1998 141 2007 888
1999 186 2008 971
2000 241 2009 1,037
2001 311 2010 1,100

Source: Data extracted from Bed Bath & Beyond Annual Report,
2005, 2007, 2009, 2010.

www.bea.gov
www.taxpolicycenter.org
www.taxpolicycenter.org
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16.15 The data in represent the amount of oil, in
billions of barrels, held in the U.S. strategic oil reserve,
from 1981 through 2009.
a. Plot the data.
b. Compute a linear trend forecasting equation and plot the

trend line.
c. Compute a quadratic trend forecasting equation and plot

the results.
d. Compute an exponential trend forecasting equation and

plot the results.
e. Which model is the most appropriate?
f. Using the most appropriate model, forecast the number

of barrels, in billions, for 2010. Check how accurate your
forecast is by locating the true value for 2010 on the
Internet or in a library.

g. The actual physical capacity of the strategic oil reserve
is 727 billion barrels of oil. If you knew that before
making a forecast in (f), how would that change your
forecast?

16.16 The data shown in the following table (and stored in
) represent the yearly amount of solar power in-

stalled (in megawatts) in the United States from 2000
through 2008:

Solar Power

Strategic

a. Plot the data.
b. Compute a linear trend forecasting equation and plot the

trend line.
c. Compute a quadratic trend forecasting equation and plot

the results.
d. Compute an exponential trend forecasting equation and

plot the results.
e. Using the models in (b) through (d), what are your annual

trend forecasts of the yearly amount of solar power installed
(in megawatts) in the United States in 2009 and 2010?

16.17 Electronics are being recycled more and more due
to increased requirements of states and the availability of
more companies doing the recycling. The data in the
following table (and stored in ) represent the tonsE-Cycling

Year
Amount of Solar 
Power Installed

2000 18
2001 27
2002 44
2003 68
2004 83
2005 100
2006 140
2007 210
2008 250

Source: Data extracted from P. Davidson, “Glut of Rooftop Solar
Systems Sinks Price,” USA Today, January 13, 2009, p. 1B.

of electronic items recycled from 1999 to 2007 (the last year
for which data was available):

Year Recycled Amount

1999 157
2000 190
2001 210
2002 250
2003 290
2004 320
2005 345
2006 377
2007 414

Source: Environmental Protection Agency, 2010.

a. Plot the data.
b. Compute a linear trend forecasting equation and plot the

trend line.
c. Compute a quadratic trend forecasting equation and plot

the results.
d. Compute an exponential trend forecasting equation and

plot the results.
e. Which model is the most appropriate?
f. Using the most appropriate model, forecast the tons of

electronic items recycled in 2008.

16.18 The data in the following table (and stored in
) represent the average salary of Major League

Baseball players on opening day from 2000 to 2010:
BBSalaries

Year Salary ($millions)

2000 1.99
2001 2.29
2002 2.38
2003 2.58
2004 2.49
2005 2.63
2006 2.83
2007 2.92
2008 3.13
2009 3.26
2010 3.27

Source: Data extracted from “Baseball Salaries,” USA Today,
April 6, 2009, p. 6C; and mlb.com.

a. Plot the data.
b. Compute a linear trend forecasting equation and plot the

trend line.
c. Compute a quadratic trend forecasting equation and plot

the results.
d. Compute an exponential trend forecasting equation and

plot the results.
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e. Which model is the most appropriate?
f. Using the most appropriate model, forecast the average

salary for 2011.

16.19 The following data (stored in ) represent the
price in London for an ounce of silver (in U.S. $) on the last
day of the year from 1999 to 2009:

Silver

a. Plot the data.
b. Compute a linear trend forecasting equation and plot the

trend line.
c. Compute a quadratic trend forecasting equation and plot

the results.
d. Compute an exponential trend forecasting equation and

plot the results.
e. Which model is the most appropriate?
f. Using the most appropriate model, forecast the price of

silver at the end of 2010.

16.20 The data in reflect the annual values of the
consumer price index (CPI) in the United States over the
45-year period 1965 through 2009, using 1982 through 1984
as the base period. This index measures the average change
in prices over time in a fixed “market basket” of goods and
services purchased by all urban consumers, including urban
wage earners (i.e., clerical, professional, managerial, and
technical workers; self-employed individuals; and short-term
workers), unemployed individuals, and retirees.
Source: Data extracted from Bureau of Labor Statistics, U.S.
Department of Labor, www.bls.gov.

a. Plot the data.
b. Describe the movement in this time series over the

45-year period.
c. Compute a linear trend forecasting equation and plot the

trend line.
d. Compute a quadratic trend forecasting equation and plot

the results.
e. Compute an exponential trend forecasting equation and

plot the results.
f. Which model is the most appropriate?

CPI-U

Year Price ($)

1999 5.330
2000 4.570
2001 4.520
2002 4.670
2003 5.965
2004 6.815
2005 8.830
2006 12.900
2007 14.760
2008 10.790
2009 16.990

Source: Data extracted from
http://www.kitco.com/gold.londonfix.html.

g. Using the most appropriate model, forecast the CPI for
2010 and 2011.

16.21 Although you should not expect a perfectly fitting
model for any time-series data, you can consider the first
differences, second differences, and percentage differences
for a given series as guides in choosing an appropriate
model. For this problem, use each of the time series pre-
sented in the following table and stored in :Tsmodel1

Year

2000 2001 2002 2003 2004

Time series I 10.0 15.1 24.0 36.7 53.8
Time series II 30.0 33.1 36.4 39.9 43.9
Time series III 60.0 67.9 76.1 84.0 92.2

Year

2005 2006 2007 2008 2009

Time series I 74.8 100.0 129.2 162.4 199.0
Time series II 48.2 53.2 58.2 64.5 70.7
Time series III 100.0 108.0 115.8 124.1 132.0

a. Determine the most appropriate model.
b. Compute the forecasting equation.
c. Forecast the value for 2010.

16.22 A time-series plot often helps you determine the
appropriate model to use. For this problem, use each of the
time series presented in the following table and stored in

.TsModel2

Year

2000 2001 2002 2003 2004

Time series I 100.0 115.2 130.1 144.9 160.0
Time series II 100.0 115.2 131.7 150.8 174.1

Year

2005 2006 2007 2008 2009

Time series I 175.0 189.8 204.9 219.8 235.0
Time series II 200.0 230.8 266.1 305.5 351.8

a. Plot the observed data (Y) over time (X) and plot the
logarithm of the observed data (log Y) over time (X) to
determine whether a linear trend model or an exponential
trend model is more appropriate. (Hint: If the plot of log
Y vs. X appears to be linear, an exponential trend model
provides an appropriate fit.)

b. Compute the appropriate forecasting equation.
c. Forecast the value for 2010.

http://www.kitco.com/gold.londonfix.html
www.bls.gov


684 CHAPTER 16 Time-Series Forecasting

16.5 Autoregressive Modeling for Trend Fitting and Forecasting
Frequently, the values of a time series are highly correlated with the values that precede and
succeed them. This type of correlation is called autocorrelation. Autoregressive modeling2 is
a technique used to forecast time series with autocorrelation. A first-order autocorrelation
refers to the association between consecutive values in a time series. A second-order autocor-
relation refers to the relationship between values that are two periods apart. A pth-order
autocorrelation refers to the correlation between values in a time series that are p periods
apart. You can take into account the autocorrelation in data by using autoregressive modeling
methods.

Equations (16.8), (16.9), and (16.10) define three autoregressive models. Equation (16.8)
defines the first-order autoregressive model and is similar in form to the simple linear
regression model [Equation (13.1) on page 522]. Equation (16.9) defines the second-order
autoregressive model and is similar to the multiple regression model with two independent
variables [Equation (14.2) on page 579]. Equation (16.10) defines the pth-order autoregres-
sive model and is similar to the multiple regression model [Equation (14.1) on page 579]. In
the equations for the autoregressive models, represent the parameters and

represent the corresponding estimates. In contrast, in the equations for the
regression models, represent the regression parameters and
represent the corresponding estimates.

b0, b1, Á , bkb0, b1, Á , bk,
a0, a1, Á , ap

A0, A1, Á , Ap,

2The exponential smoothing model
described in Section 16.3 and the
autoregressive models described in
this section are special cases of au-
toregressive integrated moving aver-
age (ARIMA) models developed by
Box and Jenkins (see reference 2).

FIRST-ORDER AUTOREGRESSIVE MODEL

(16.8)

SECOND-ORDER AUTOREGRESSIVE MODEL

(16.9)

pTH-ORDER AUTOREGRESSIVE MODELS

(16.10)

where

observed value of the series at time i

observed value of the series at time 

observed value of the series at time 

observed value of the series at time 

autoregression parameters to be estimated from 
least-squares regression analysis

a nonautocorrelated random error component (with
and constant variance)mean = 0

di =

A0, A1, A2, Á , Ap =

i - pYi-p =

i - 2Yi-2 =

i - 1Yi-1 =

Yi =

Yi = A0 + A1Yi-1 + A2Yi-2 + Á + ApYi-p + di

Yi = A0 + A1Yi-1 + A2Yi-2 + di

Yi = A0 + A1Yi-1 + di

Selecting an appropriate autoregressive model can be complicated. You must weigh
the advantages that are due to simplicity against the concern of not taking into account
important autocorrelation in the data. You also must be concerned with selecting a higher-
order model that requires estimates of numerous unnecessary parameters—especially if n,
the number of values in the series, is small. The reason for this concern is that when
computing an estimate of you lose p out of the n data values when comparing each data
value with the data value p periods earlier. Examples 16.5 and 16.6 illustrate this loss of
data values.

Ap,
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Consider the following series of consecutive annual values:n = 7EXAMPLE 16.5
Comparison
Schema for a 
First-Order
Autoregressive
Model

Year

1 2 3 4 5 6 7

Series 31 34 37 35 36 43 40

Show the comparisons needed for a first-order autoregressive model.

Year First-Order Autoregressive Model

i 1Yi vs. Yi-12
1 314 Á
2 344 31
3 374 34
4 354 37
5 364 35
6 434 36
7 404 43

SOLUTION Because there is no value recorded prior to this value is not used for regres-
sion analysis. Therefore, the first-order autoregressive model is based on six pairs of values.

Y1,

Consider the following series of consecutive annual values:n = 7EXAMPLE 16.6
Comparison
Schema for a
Second-Order
Autoregressive
Model

Year

1 2 3 4 5 6 7

Series 31 34 37 35 36 43 40

Show the comparisons needed for a second-order autoregressive model.

Year Second-Order Autoregressive Model

i 1Yi vs. Yi-1 and Yi vs. Yi-22
1 314 Á and 314 Á
2 344 31  and 344 Á
3 374 34  and 374 31
4 354 37  and 354 34
5 364 35  and 364 37
6 434 36  and 434 35
7 404 43  and 404 36

SOLUTION Because no value is recorded prior to two values are not used when
performing regression analysis. Therefore, the second-order autoregressive model is based on
five pairs of values.

Y1,
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After selecting a model and using the least-squares method to compute estimates of the
parameters, you need to determine the appropriateness of the model. Either you can select a
particular pth-order autoregressive model based on previous experiences with similar data or
start with a model that contains several autoregressive parameters and then eliminate the
higher-order parameters that do not significantly contribute to the model. In this latter
approach, you use a t test for the significance of the highest-order autoregressive parame-
ter in the current model under consideration. The null and alternative hypotheses are

Equation (16.11) defines the test statistic.

H1: Ap Z 0

H0: Ap = 0

Ap,

t TEST FOR SIGNIFICANCE OF THE HIGHEST-ORDER AUTOREGRESSIVE
PARAMETER,

(16.11)

where

hypothesized value of the highest-order parameter, in the
autoregressive model

estimate of the highest-order parameter, in the autoregressive model

standard deviation of 

The test statistic follows a t distribution with degrees of freedom.3n - 2p - 1tSTAT

apSap
=

Ap,ap =

Ap,Ap =

tSTAT =
ap - Ap

Sap

Ap

For a given level of significance, you reject the null hypothesis if the test statistic
is greater than the upper-tail critical value from the t distribution or if the test statistic is
less than the lower-tail critical value from the t distribution. Thus, the decision rule is

Figure 16.11 illustrates the decision rule and regions of rejection and nonrejection.

otherwise, do not reject H0.

Reject H0 if tSTAT 6 - ta>2 or if tSTAT 7 ta>2;

tSTAT

tSTATa,

3In addition to the degrees of
freedom lost for each of the p popu-
lation parameters you are estimat-
ing, p additional degrees of freedom
are lost because there are p fewer
comparisons to be made from the
original n values in the time series.

Region of
Rejection

Region of
Nonrejection

Critical
Value

Region of
Rejection

Critical
Value

0 t+t–t

Ap = 0

α/2

α/2 α/2

α/2
1 – α

F I G U R E 1 6 . 1 1
Rejection regions for a
two-tail test for the
significance of the
highest-order
autoregressive
parameter, Ap

If you do not reject the null hypothesis that you conclude that the selected model
contains too many estimated autoregressive parameters. You then discard the highest-order
term and estimate an autoregressive model of order using the least-squares method. Youp - 1,

Ap = 0,
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then repeat the test of the hypothesis that the new highest-order parameter is 0. This testing
and modeling continues until you reject When this occurs, you can conclude that the
remaining highest-order parameter is significant, and you can use that model for forecasting
purposes.

Equation (16.12) defines the fitted pth-order autoregressive equation.

H0.

FITTED pTH-ORDER AUTOREGRESSIVE EQUATION

(16.12)

where

fitted values of the series at time i

observed value of the series at time 

observed value of the series at time 

observed value of the series at time 

regression estimates of the parameters A0, A1, A2, Á , Apa0, a1, a2, Á , ap =

i - pYi-p =

i - 2Yi-2 =

i - 1Yi-1 =

YNi =

YNi = a0 + a1Yi-1 + a2Yi-2 + Á + apYi-p

You use Equation (16.13) to forecast j years into the future from the current nth time
period.

pTH-ORDER AUTOREGRESSIVE FORECASTING EQUATION

(16.13)

where

regression estimates of the parameters 

number of years into the future

forecast of from the current time period for

observed value for for j - p … 0Yn+ j-pYNn+ j-p =

j - p 7 0Yn+ j-pYNn+ j-p =

j =

A0, A1, A2, Á , Apa0, a1, a2, Á , ap =

YNn+ j = a0 + a1YNn+ j-1 + a2YNn+ j-2 + Á + apYNn+ j-p

Thus, to make forecasts j years into the future, using a third-order autoregressive model,
you need only the most recent values ( and ) and the regression estimates

and
To forecast one year ahead, Equation (16.13) becomes

To forecast two years ahead, Equation (16.13) becomes

To forecast three years ahead, Equation (16.13) becomes

and so on.
Autoregressive modeling is a powerful forecasting technique for time series that have

autocorrelation. Exhibit 16.1 summarizes the steps to follow when constructing autoregressive
models.

YNn+3 = a0 + a1YNn+2 + a2YNn+1 + a3Yn

YNn+2 = a0 + a1YNn+1 + a2Yn + a3Yn-1

YNn+1 = a0 + a1Yn + a2Yn-1 + a3Yn-2

a3.a0, a1, a2,
Yn-2Yn, Yn-1,p = 3



Selecting an autoregressive model that best fits the annual time series begins with the
third-order autoregressive model shown in Figure 16.13 on page 689.

From Figure 16.13, the fitted third-order autoregressive equation is

where the first year in the series is 1998.

YNi = -11.6000 + 1.0259Yi-1 - 0.8876Yi-2 + 1.5180Yi-3
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E X H I B I T 1 6 . 1

Guide to Autoregressive Modeling

1. Choose a value for p, the highest-order parameter in the autoregressive model to be
evaluated, realizing that the t test for significance is based on degrees of
freedom.

2. Create a set of p lagged predictor variables such that the first lagged predictor vari-
able lags by one time period, the second variable lags by two time periods, and so on
and the last predictor variable lags by p time periods (see Figure 16.12).

3. Perform a least-squares analysis of the multiple regression model containing all
p lagged predictor variables (using Excel or Minitab).

4. Test for the significance of the highest-order autoregressive parameter in the model.
a. If you do not reject the null hypothesis, discard the pth variable and repeat steps 3

and 4. The test for the significance of the new highest-order parameter is based on
a t distribution whose degrees of freedom are revised to correspond with the
revised number of predictors.

b. If you reject the null hypothesis, select the autoregressive model with all p predic-
tors for fitting [see Equation (16.12)] and forecasting [see Equation (16.13)].

Ap,

n - 2p - 1

To demonstrate the autoregressive modeling approach, return to the time series concern-
ing the revenues for The Coca-Cola Company over the 15-year period 1995 through 2009.
Figure 16.12 displays a worksheet that organizes the data for the first-order, second-order, and
third-order autoregressive models. The worksheet contains the lagged predictor variables
Lag1, Lag2, and Lag3 in columns C, D, and E. Use all three lagged predictors to fit the third-
order autoregressive model. Use only Lag1 and Lag2 to fit the second-order autoregressive
model, and use only Lag1 to fit the first-order autoregressive models. Thus, out of
values, or 3 values out of are lost in the comparisons needed for developing
the first-order, second-order, and third-order autoregressive models.

n = 15p = 1, 2,
n = 15

F I G U R E 1 6 . 1 2
Worksheet data for
developing first-order,
second-order, and third-
order autoregressive
models on revenues for
The Coca-Cola Company
(1995–2009)

Sections EG16.5 and MG16.5
discuss an automated way of
creating lagged predictor
variables that are mentioned
in step 2 of Exhibit 16.1.



16.5 Autoregressive Modeling for Trend Fitting and Forecasting 689

F I G U R E 1 6 . 1 3
Excel and Minitab regression results for the third-order autoregressive model for The Coca-Cola Company revenues

Next, you test for the significance of the highest-order parameter. The highest-order
parameter estimate, for the fitted third-order autoregressive model is 1.518, with a standard
error of 0.6955.

To test the null hypothesis:

against the alternative hypothesis:

using Equation (16.11) on page 686 and the worksheet results given in Figure 16.13,

Using a 0.05 level of significance, the two-tail t test with 8 degrees of freedom has critical
values of Because or because the p-value �

you do not reject You conclude that the third-order parameter of the
autoregressive model is not significant and can be deleted.

Next, you fit a second-order autoregressive model (see Figure 16.14).

H0.0.0606 7 0.05,
-2.306 6 tSTAT = 2.1827 6 +2.306;2.306.

tSTAT =
a3 - A3

Sa3

=
1.518 - 0

0.6955
= 2.1827

H1: A3 Z 0

H0: A3 = 0

a3,
A3,

F I G U R E 1 6 . 1 4
Excel and Minitab regression results for the second-order autoregressive model for the Coca-Cola Company revenue
data
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The fitted second-order autoregressive equation is

where the first year of the series is 1997.
From Figure 16.14, the highest-order parameter estimate is with a stan-

dard error of 0.6115.
To test the null hypothesis:

against the alternative hypothesis:

using Equation (16.11) on page 686,

Using the 0.05 level of significance, the two-tail t test with 10 degrees of freedom has crit-
ical values of Because or because the
p-value you do not reject You conclude that the second-order parame-
ter of the autoregressive model is not significant and should be deleted from the model. You
then fit a first-order autoregressive model (see Figure 16.15).

H0.= 0.5397 7 0.05,
-2.2281 6 tSTAT = -0.635 6 2.2281;2.2281.

tSTAT =
a2 - A2

Sa2

=
-0.3883 - 0

0.6115
= -0.635

H1: A2 Z 0

H0: A2 = 0

a2 = -0.3883,

YNi = 1.6349 + 1.339Yi-1 - 0.3883 Yi-2

F I G U R E 1 6 . 1 5
Excel and Minitab regression results for the first-order autoregressive model for the Coca-Cola 
Company revenue data

From Figure 16.15, the fitted first-order autoregressive equation is

where the first year of the series is 1996.
From Figure 16.15, the highest-order parameter estimate is with a standard

error of 0.1025.
To test the null hypothesis:

against the alternative hypothesis:

using Equation (16.11) on page 686,

tSTAT =
a1 - A1

Sa1

=
1.0694 - 0

0.1025
= 10.4314

H1: A1 Z 0

H0: A1 = 0

a1 = 1.0694,

YNi = -0.5836 + 1.0694Yi-1
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Using the 0.05 level of significance, the two-tail t test with 12 degrees of freedom has
critical values of Because or because the p-value =

you reject You conclude that the first-order parameter of the autoregres-
sive model is significant and should remain in the model.

The model-building approach has led to the selection of the first-order autoregressive
model as the most appropriate for the given data. Using the estimates and

as well as the most recent data value the forecasts of revenues from
Equation (16.13) on page 687 at The Coca-Cola Company for 2010 and 2011 are

Therefore,

Figure 16.16 displays the actual and predicted Y values from the first-order autoregressive
model.

 2011: 2 years ahead, YN16 = -0.5836 + 1.0694132.56782 = 34.2444 billions of dollars

 2010: 1 year ahead, YN15 = -0.5836 + 1.0694131.02 = 32.5678 billions of dollars

YNn+ j = -0.5836 + 1.0694 YNn+ j-1

Y14 = 31.0,a1 = 1.0694,
a0 = -0.5836

H0.0.0000 6 0.05,
tSTAT = 10.4314 7 2.1788;2.1788.

F I G U R E 1 6 . 1 6
Plot of actual and
predicted revenues from
a first-order autoregres-
sive model at The Coca-
Cola Company

Problems for Section 16.5
LEARNING THE BASICS
16.23 You are given an annual time series with 40
consecutive values and asked to fit a fifth-order autoregres-
sive model.
a. How many comparisons are lost in developing the autore-

gressive model?
b. How many parameters do you need to estimate?
c. Which of the original 40 values do you need for

forecasting?
d. State the fifth-order autoregressive model.
e. Write an equation to indicate how you would forecast j

years into the future.

16.24 A third-order autoregressive model is fitted to an
annual time series with 17 values and has the following
estimated parameters and standard errors:

At the 0.05 level of significance, test the appropriateness of
the fitted model.

16.25 Refer to Problem 16.24. The three most recent val-
ues are

Forecast the values for the next year and the following year.

Y15 = 23 Y16 = 28 Y17 = 34

Sa3
= 0.10Sa2

= 0.30Sa1
= 0.50

a3 = 0.24a2 = 0.80a1 = 1.80a0 = 4.50



16.26 Refer to Problem 16.24. Suppose, when testing for
the appropriateness of the fitted model, the standard errors are

a. What conclusions can you reach?
b. Discuss how to proceed if forecasting is still your main

objective.

APPLYING THE CONCEPTS
16.27 Refer to the data given in Problem 16.15 on page 682
that represent the amount of oil (in billions of barrels) held in
the U.S. strategic reserve from 1981 through 2009 (stored in

).
a. Fit a third-order autoregressive model to the amount of

oil and test for the significance of the third-order autore-
gressive parameter. (Use )

b. If necessary, fit a second-order autoregressive model to
the amount of oil and test for the significance of the
second-order autoregressive parameter. (Use )

c. If necessary, fit a first-order autoregressive model to the
amount of oil and test for the significance of the first-or-
der autoregressive parameter. (Use )

d. If appropriate, forecast the barrels held in 2010.
e. The actual physical capacity of the strategic oil reserve is

727 billion barrels of oil. If you knew that before making
a forecast in (d), how would that change your forecast?

16.28 Refer to the data given in Problem 16.12
on page 681 that represent the number of stores

open for Bed Bath & Beyond from 1993 through 2010
(stored in ).
a. Fit a third-order autoregressive model to the number of

stores and test for the significance of the third-order
autoregressive parameter. (Use )

b. If necessary, fit a second-order autoregressive model to
the number of stores and test for the significance of the
second-order autoregressive parameter. (Use )

c. If necessary, fit a first-order autoregressive model to the
number of stores and test for the significance of the first-
order autoregressive parameter. (Use )

d. If appropriate, forecast the number of stores open in 2011
and 2012.

16.29 Refer to the data given in Problem 16.17 on page 682
that represent the tons of electronic items recycled from 1999
to 2007 (stored in ).E-Cycling

a = 0.05.

a = 0.05.

a = 0.05.

Bed & Bath

SELF
Test

a = 0.05.

a = 0.05.

a = 0.05.

Strategic

Sa1
= 0.45 Sa2

= 0.35 Sa3
= 0.15

a. Fit a third-order autoregressive model to the tons of elec-
tronic items recycled and test for the significance of the
third-order autoregressive parameter. (Use )

b. If necessary, fit a second-order autoregressive model to
the tons of electronic items recycled and test for the sig-
nificance of the second-order autoregressive parameter.
(Use )

c. If necessary, fit a first-order autoregressive model to the
tons of electronic items recycled and test for the signifi-
cance of the first-order autoregressive parameter. (Use

)
d. Forecast the tons of electronic items recycled for 2008.

16.30 Refer to the data given in Problem 16.18 on page 682
(stored in ) that represent the average baseball
salary from 2000 through 2010.
a. Fit a third-order autoregressive model to the average

baseball salary and test for the significance of the third-
order autoregressive parameter. (Use )

b. If necessary, fit a second-order autoregressive model to
the average baseball salary and test for the significance
of the second-order autoregressive parameter. (Use

)
c. If necessary, fit a first-order autoregressive model

to the average baseball salary and test for the signifi-
cance of the first-order autoregressive parameter. (Use

)
d. Forecast the average baseball salary for 2011.

16.31 Refer to the data given in Problem 16.16 on page 682
(and stored in ) that represent the yearly amount
of solar power installed (in megawatts) in the United States
from 2000 through 2008.
a. Fit a third-order autoregressive model to the amount of

solar power installed and test for the significance of the
third-order autoregressive parameter. (Use )

b. If necessary, fit a second-order autoregressive model to
the amount of solar power installed and test for the sig-
nificance of the second-order autoregressive parameter.
(Use )

c. If necessary, fit a first-order autoregressive model to the
amount of solar power installed and test for the signifi-
cance of the first-order autoregressive parameter. (Use

)
d. Forecast the yearly amount of solar power installed (in

megawatts) in the United States in 2009 and 2010.

a = 0.05.

a = 0.05.

a = 0.05.

SolarPower

a = 0.05.

a = 0.05.

a = 0.05.

BBSalaries

a = 0.05.

a = 0.05.

a = 0.05.

16.6 Choosing an Appropriate Forecasting Model
In Sections 16.4 and 16.5, you studied six time-series methods for forecasting: the linear trend
model, the quadratic trend model, and the exponential trend model in Section 16.4; and the
first-order, second-order, and pth-order autoregressive models in Section 16.5. Is there a best
model? Among these models, which one should you select for forecasting? The following
guidelines are provided for determining the adequacy of a particular forecasting model. These

692 CHAPTER 16 Time-Series Forecasting
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F I G U R E 1 6 . 1 7
Residual analysis for
studying error patterns

guidelines are based on a judgment of how well the model fits the data and assume that you
can use past data to predict future values of the time series:

• Perform a residual analysis.
• Measure the magnitude of the residuals through squared differences.
• Measure the magnitude of the residuals through absolute differences.
• Use the principle of parsimony.

A discussion of these guidelines follows.

Performing a Residual Analysis
Recall from Sections 13.5 and 14.3 that residuals are the differences between observed and
predicted values. After fitting a particular model to a time series, you plot the residuals over
the n time periods. As shown in Figure 16.17 Panel A, if the particular model fits adequately,
the residuals represent the irregular component of the time series. Therefore, they should be
randomly distributed throughout the series. However, as illustrated in the three remaining pan-
els of Figure 16.17, if the particular model does not fit adequately, the residuals may show a
systematic pattern, such as a failure to account for trend (Panel B), a failure to account for
cyclical variation (Panel C), or, with monthly or quarterly data, a failure to account for sea-
sonal variation (Panel D).

Measuring the Magnitude of the Residuals Through Squared
or Absolute Differences
If, after performing a residual analysis, you still believe that two or more models appear to fit
the data adequately, you can use additional methods for model selection. Numerous measures
based on the residuals are available (see references 1 and 4).

In regression analysis (see Section 13.3), you have already used the standard error of the
estimate For a particular model, this measure is based on the sum of squared differences
between the actual and predicted values in a time series. If a model fits the time-series data
perfectly, then the standard error of the estimate is zero. If a model fits the time-series data
poorly, then is large. Thus, when comparing the adequacy of two or more forecasting
models, you can select the model with the minimum as most appropriate.

However, a major drawback to using when comparing forecasting models is that
whenever there is a large difference between even a single and , the value of becomes
overly inflated because the differences between and are squared. For this reason, many
statisticians prefer the mean absolute deviation (MAD). Equation (16.14) defines the MAD
as the mean of the absolute differences between the actual and predicted values in a time
series.

YNiY
i

SYXYNiY
i

SYX

SYX

SYX

1SYX2.
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Residual plots for four forecasting methods
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MEAN ABSOLUTE DEVIATION

(16.14)MAD =
a

n

i=1
|Yi - YNi|

n

If a model fits the time-series data perfectly, the MAD is zero. If a model fits the time-
series data poorly, the MAD is large. When comparing two or more forecasting models, you
can select the one with the minimum MAD as the most appropriate model.

Using the Principle of Parsimony
If, after performing a residual analysis and comparing the and MAD measures, you still be-
lieve that two or more models appear to adequately fit the data, you can use the principle of parsi-
mony for model selection. As first explained in Section 15.4, parsimony guides you to select the
regression model with the fewest independent variables that can predict the dependent variable ad-
equately. In general, the principle of parsimony guides you to select the least complex regression
model. Among the six forecasting models studied in this chapter, most statisticians consider the
least-squares linear and quadratic models and the first-order autoregressive model as simpler than
the second- and pth-order autoregressive models and the least-squares exponential model.

A Comparison of Four Forecasting Methods
Consider once again The Coca-Cola Company’s revenue data. To illustrate the model selection
process, you can compare four of the forecasting models used in Sections 16.4 and 16.5: the
linear model, the quadratic model, the exponential model, and the first-order autoregressive
model. (There is no need to further study the second-order or third-order autoregressive mod-
els for this time series because these models did not significantly improve the fit compared to
the first-order autoregressive model.)

SYX
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F I G U R E 1 6 . 1 9
Table that summarizes
and compares four
forecasting methods,
using SSE, and MADSYX,

Problems for Section 16.6
LEARNING THE BASICS
16.32 The following residuals are from a linear trend
model used to forecast sales:

a. Compute and interpret your findings.SYX

2.0 -0.5  1.5  1.0  0.0  1.0 -3.0  1.5 -4.5  2.0  0.0 -1.0

b. Compute the MAD and interpret your findings.

16.33 Refer to Problem 16.32. Suppose the first residual
is 12.0 (instead of 2.0) and the last residual is (in-
stead of ).
a. Compute and interpret your findings
b. Compute the MAD and interpret your findings.

SYX

-1.0
-11.0

Figure 16.18 displays the residual plots for the four models. In reaching conclusions from
these residual plots, you must use caution because there are only 15 values for the linear model,
the quadratic model, and the exponential model and only 14 values for the first-order autoregres-
sive model.

In Figure 16.18, observe that the residuals in the linear model, quadratic model, and expo-
nential model are positive for the early years, negative for the intermediate years, and positive
again for the latest years. For the autoregressive model, the residuals do not exhibit any sys-
tematic pattern.

To summarize, on the basis of the residual analysis of all four forecasting models, it
appears that the first-order autoregressive model is the most appropriate, and the linear, quad-
ratic, and exponential models are less appropriate. For further verification, you can compare
the magnitude of the residuals in the four models. Figure 16.19 shows the actual values
along with the predicted values the residuals the error sum of squares (SSE), the
standard error of the estimate and the mean absolute deviation (MAD) for each of the
four models.

For this time series, and MAD provide fairly similar results. A comparison of the
and MAD clearly indicates that the linear model provides the poorest fit followed by the
exponential model. The first-order autoregressive model and the quadratic model provide the
best fit. Although the quadratic model has a lower SSE and the MAD for the first-order
autoregressive model was slightly lower. Since the residual analysis showed a pattern in the
residuals for the quadratic model, but not for the first-order autoregressive model, you should
choose the first-order autoregressive model as the best model.

After you select a particular forecasting model, you need to continually monitor your
forecasts. If large errors between forecasted and actual values occur, the underlying structure
of the time series may have changed. Remember that the forecasting methods presented in this
chapter assume that the patterns inherent in the past will continue into the future. Large fore-
casting errors are an indication that this assumption may no longer be true.

SYX,

SYXSYX

1SYX2,
1ei2,YNi

1Yi2
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APPLYING THE CONCEPTS
16.34 Refer to the results in Problem 16.13 on page 681
(see ).
a. Perform a residual analysis.
b. Compute the standard error of the estimate 
c. Compute the MAD.
d. On the basis of (a) through (c), are you satisfied

with your linear trend forecasts in Problem 16.13?
Discuss.

16.35 Refer to the results in Problem 16.15 on page 682 and
Problem 16.27 on page 692 concerning the number of barrels
of oil in the U.S. strategic oil reserve (stored in ).
a. Perform a residual analysis for each model.
b. Compute the standard error of the estimate for

each model.
c. Compute the MAD for each model.
d. On the basis of (a) through (c) and the principle of

parsimony, which forecasting model would you select?
Discuss.

16.36 Refer to the results in Problem 16.12 on
page 681 and Problem 16.28 on page 692 con-

cerning the number of Bed Bath & Beyond stores open
(stored in ).
a. Perform a residual analysis for each model.
b. Compute the standard error of the estimate for

each model.
c. Compute the MAD for each model.
d. On the basis of (a) through (c) and the principle of parsi-

mony, which forecasting model would you select? Discuss.

1SYX2
Bed & Bath

SELF
Test

1SYX2
Strategic

1SYX2.
GDP

16.37 Refer to the results in Problem 16.17 on page 682
and Problem 16.29 on page 692 concerning the amount of
electronic items recycled (stored in ).
a. Perform a residual analysis for each model.
b. Compute the standard error of the estimate for

each model.
c. Compute the MAD for each model.
d. On the basis of (a) through (c) and the principle of parsi-

mony, which forecasting model would you select? Discuss.

16.38 Refer to the results in Problem 16.18 on page 682
and Problem 16.30 on page 692 concerning the average
baseball salary (stored in ).
a. Perform a residual analysis for each model.
b. Compute the standard error of the estimate for

each model.
c. Compute the MAD for each model.
d. On the basis of (a) through (c) and the principle of

parsimony, which forecasting model would you select?
Discuss.

16.39 Refer to the results in Problem 16.16 on page 682
and Problem 16.31 on page 692 concerning the yearly
amount of solar power installed (in megawatts) in the United
States from 2000 through 2008 (stored in ).
a. Perform a residual analysis for each model.
b. Compute the standard error of the estimate for

each model.
c. Compute the MAD for each model.
d. On the basis of (a) through (c) and the principle of parsi-

mony, which forecasting model would you select? Discuss.

1SYX2
SolarPower

1SYX2
BBSalaries

1SYX2
E-Cycling

16.7 Time-Series Forecasting of Seasonal Data
So far, this chapter has focused on forecasting annual data. However, many time series are col-
lected quarterly or monthly, and others are collected weekly, daily, and even hourly. When a
time series is collected quarterly or monthly, you must consider the impact of seasonal effects.
In this section, regression model building is used to forecast monthly or quarterly data.

One of the companies of interest in the Using Statistics scenario is Wal-Mart Stores, Inc.
In 2010, Wal-Mart Stores, Inc., operated more than 8,000 retail units in 15 countries and had
revenues that exceeded $400 billion (Wal-Mart Stores, Inc., investor.walmartstores.com).
Wal-Mart revenues are highly seasonal, and therefore you need to analyze quarterly
revenues. The fiscal year for the company ends January 31. Thus, the fourth quarter of 2010
includes November and December 2009 as well as January 2010. Table 16.3 lists the

T A B L E 1 6 . 3

Quarterly Revenues for
Wal-Mart Stores, Inc., in
Billions of Dollars
(2005–2010)

Year

Quarter 2005 2006 2007 2008 2009 2010

1 64.8 71.6 79.6 86.4 95.3 93.5
2 69.7 76.8 84.5 93.0 102.7 100.9
3 68.5 75.4 83.5 91.9 98.6 99.4
4 82.2 88.6 98.1 107.3 107.9 113.7

Source: Data extracted from Wal-Mart Stores, Inc., investor.walmartstores.com.
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F I G U R E 1 6 . 2 0
Plot of quarterly
revenues for Wal-Mart
Stores, Inc., in billions of
dollars (2005–2010)

quarterly revenues, in billions of dollars, from 2005 to 2010 (stored in ).
Figure 16.20 displays the time series.

WalMart

Least-Squares Forecasting with Monthly or Quarterly Data
To develop a least-squares regression model that includes a seasonal component, the least-
squares exponential trend fitting method used in Section 16.4 is combined with dummy vari-
ables (see Section 14.6) to model the seasonal component.

Equation (16.15) defines the exponential trend model for quarterly data.

EXPONENTIAL MODEL WITH QUARTERLY DATA

(16.15)

where

coded quarterly value,

if first quarter, 0 if not first quarter

if second quarter, 0 if not second quarter

if third quarter, 0 if not third quarter

intercept

quarterly compound growth rate (in %)

multiplier for first quarter relative to fourth quarter

multiplier for second quarter relative to fourth quarter

multiplier for third quarter relative to fourth quarter

value of the irregular component for time period iei =

b4 =

b3 =

b2 =

1b1 - 12 * 100% =

b0 = Y

Q3 = 1

Q2 = 1

Q1 = 1

i = 0, 1, 2, ÁXi =

Yi = b0b
Xi
1 b

Q1
2 b

Q2
3 b

Q3
4 ei

The model in Equation (16.15) is not in the form of a linear regression model. To trans-
form this nonlinear model to a linear model, you use a base 10 logarithmic transformation.4

Taking the logarithm of each side of Equation (16.15) results in Equation (16.16).

4Alternatively, you can use base e
logarithms. For more information
on logarithms, see Section A.3 in
Appendix A.
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(16.16)

= log1b02 + Xi log1b12 + Q1 log1b22 + Q2 log1b32 + Q3 log1b42 + log1ei2
= log1b02 + log1bXi

1 2 + log1bQ1
2 2 + log1bQ2

3 2 + log1bQ3
4 2 + log1ei2

log1Yi2 = log1b0b
Xi
1 b

Q1
2 b

Q2
3 b

Q3
4 ei2

Equation (16.16) is a linear model that you can estimate using least-squares regression.
Performing the regression analysis using as the dependent variable and and

as the independent variables results in Equation (16.17).Q3

Xi, Q1, Q2,log1Yi2

EXPONENTIAL GROWTH WITH QUARTERLY DATA FORECASTING EQUATION

(16.17)

where

estimate of and thus 

estimate of and thus 

estimate of and thus 

estimate of and thus 

estimate of and thus 10b4 = bN 4log1b42b4 =

10b3 = bN 3log1b32b3 =

10b2 = bN 2log1b22b2 =

10b1 = bN 1log1b12b1 =

10b0 = b0
Nlog1b02b0 =

log(YNi) = b0 + b1Xi + b2Q1 + b3Q2 + b4Q3
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Equation (16.18) is used for monthly data.

EXPONENTIAL MODEL WITH MONTHLY DATA

(16.18)

where

coded monthly value,

if January, 0 if not January

if February, 0 if not February

if March, 0 if not March
.
.
.

if November, 0 if not November

intercept

monthly compound growth rate (in %)

multiplier for January relative to December

multiplier for February relative to December

multiplier for March relative to December
.
.
.

multiplier for November relative to December

value of the irregular component for time period iei =

b12 =

b4 =

b3 =

b2 =

1b1 - 12 * 100% =

b0 = Y

M11 = 1

M3 = 1

M2 = 1

M1 = 1

i = 0, 1, 2, ÁXi =

Yi = b0b
Xi
1 b

M1
2 b

M2
3 b

M3
4 b

M4
5 b

M5
6 b

M6
7 b

M7
8 b

M8
9 b

M9
10 b

M10
11 b

M11
12 ei
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The model in Equation (16.18) is not in the form of a linear regression model. To trans-
form this nonlinear model into a linear model, you can use a base 10 logarithm transformation.
Taking the logarithm of each side of Equation (16.18) results in Equation (16.19).

TRANSFORMED EXPONENTIAL MODEL WITH MONTHLY DATA

(16.19)

+ M11 log1b122 + log1ei2
+ M7 log1b82 + M8 log1b92 + M9 log1b102 + M10 log1b112
+ M3 log1b42 + M4 log1b52 + M5 log1b62 + M6 log1b72

= log1b02 + Xi log1b12 + M1 log1b22 + M2 log1b32
log1Yi2 = log1b0b

Xi
1 b

M1
2 b

M2
3 b

M3
4 b

M4
5 b

M5
6 b

M6
7 b

M7
8 b

M8
9 b

M9
10 b

M10
11 b

M11
12 ei2

Equation (16.19) is a linear model that you can estimate using the least-squares method.
Performing the regression analysis using as the dependent variable and
and as the independent variables results in Equation (16.20).M11

Xi, M1, M2, Á ,log1Yi2

EXPONENTIAL GROWTH WITH MONTHLY DATA FORECASTING EQUATION

(16.20)

where

estimate of and thus 

estimate of and thus 

estimate of and thus 

estimate of and thus 
.
.
.

estimate of and thus 10b12 = bN 12log1b122b12 =

10b3 = bN 3log1b32b3 =

10b2 = bN 2log1b22b2 =

10b1 = bN 1log1b12b1 =

10b0 = bN0log1b02b0 =

+ b8M7 + b9M8 + b10M9 + b11M10 + b12M11

log(YNi) = b0 + b1Xi + b2M1 + b3M2 + b4M3 + b5M4 + b6M5 + b7M6

and are the three dummy variables needed to represent the four quarter periods
in a quarterly time series. are the 11 dummy variables needed to repre-
sent the 12 months in a monthly time series. In building the model, you use instead of

values and then find the regression coefficients by taking the antilog of the regression coef-
ficients developed from Equations (16.17) and (16.20).

Although at first glance these regression models look imposing, when fitting or forecast-
ing in any one time period, the values of all or all but one of the dummy variables in the model
are equal to zero, and the equations simplify dramatically. In establishing the dummy vari-
ables for quarterly time-series data, the fourth quarter is the base period and has a coded value
of zero for each dummy variable. With a quarterly time series, Equation (16.17) reduces as
follows:

For any first quarter:

For any second quarter:

For any third quarter:

For any fourth quarter: log1YNi2 = b0 + b1Xi

log1YN i2 = b0 + b1Xi + b4

log1YNi2 = b0 + b1Xi + b3

log1YNi2 = b0 + b1Xi + b2

Yi

log1Yi2
M1, M2, M3, Á , M11

Q3Q1, Q2,
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When establishing the dummy variables for each month, December serves as the base pe-
riod and has a coded value of 0 for each dummy variable. For example, with a monthly time
series, Equation (16.20) reduces as follows:

For any January:

For any February:
.
.
.

For any November:

For any December: 

To demonstrate the process of model building and least-squares forecasting with a quar-
terly time series, return to the Wal-Mart Stores, Inc., revenue data (in billions of dollars) origi-
nally displayed in Table 16.3 on page 696. The data are from the first quarter of 2005 through
the last quarter of 2010. Figure 16.21 shows the regression results for the quarterly exponen-
tial trend model.

log1YNi2 = b0 + b1Xi

log1YNi2 = b0 + b1Xi + b12

log1YNi2 = b0 + b1Xi + b3

log1YNi2 = b0 + b1Xi + b2

F I G U R E 1 6 . 2 1
Excel and Minitab regression results for the quarterly revenue data for Wal-Mart Stores, Inc.

From Figure 16.21, the model fits the data extremely well. The coefficient of determina-
tion the adjusted and the overall F test results in an test
statistic of 104.6677 (p-value ). At the 0.05 level of significance, each regression
coefficient is highly statistically significant and contributes to the model. The following
summary includes the antilogs of all the regression coefficients:

= 0.000
FSTATr2 = 0.9474,r2 = 0.9566,

Regression Coefficient bi = log BN i BN i = antilog (bi) = 10bi

interceptb0: Y 1.8881 77.2859
coded quarterb1: 0.0083 1.0193
first quarterb2: -0.0618 0.8674
second quarterb3: -0.0391 0.9139
third quarterb4: -0.0557 0.8796

The interpretations for and are as follows:

• The Y intercept, (in billions of dollars), is the unadjusted forecast for
quarterly revenues in the first quarter of 2005, the initial quarter in the time series.
Unadjusted means that the seasonal component is not incorporated in the forecast.

b0
N = 77.2859

bN 4bN 0 , bN 1, bN 2 , bN 3 ,
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• The value is the estimated quarterly com-
pound growth rate in revenues, after adjusting for the seasonal component.

• is the seasonal multiplier for the first quarter relative to the fourth quarter;
it indicates that there is 13.26% less revenue for the first quarter than for the fourth
quarter.

• is the seasonal multiplier for the second quarter relative to the fourth quar-
ter; it indicates that there is 8.61% less revenue for the second quarter than for the fourth
quarter.

• is the seasonal multiplier for the third quarter relative to the fourth quarter;
it indicates that there is 12.04% less revenue for the third quarter than for the fourth
quarter. Thus, the fourth quarter, which includes the holiday shopping season, has the
strongest sales.

Using the regression coefficients and Equation (16.17) on page 698, you
can make forecasts for selected quarters. As an example, to predict revenues for the fourth
quarter of 2010 

Thus,

The predicted revenue for the fourth quarter of fiscal 2010 is $119.9499 billion. To make a
forecast for a future time period, such as the first quarter of fiscal 2011 

Thus,

The predicted revenue for the first quarter of fiscal 2011 is $106.0474 billion.

YNi = 102.0255 = 106.0474

= 2.0255

= 1.8881 + 10.008321242 + 1-0.06182112
log1YNi2 = b0 + b1Xi + b2Q1

1Xi = 24, Q1 = 12,
log1Yi

N 2 = 102.079 = 119.9499

= 2.079

= 1.8881 + 10.008321232
log1Yi

N 2 = b0 + b1Xi

1Xi = 232,
b0, b1, b2, b3, b4,

b4
N = 0.8796

b3
N = 0.9139

b2
N = 0.8674

1b1
N - 12 * 100% =  0.0193, or 1.93%,

Problems for Section 16.7
LEARNING THE BASICS
16.40 In forecasting a monthly time series over a five-year
period from January 2006 to December 2010, the exponen-
tial trend forecasting equation for January is

Take the antilog of the appropriate coefficient from this
equation and interpret the
a. Y intercept,
b. monthly compound growth rate.
c. January multiplier.

16.41 In forecasting daily time-series data, how many
dummy variables are needed to account for the seasonal
component day of the week?

bN0.

log YNi = 2.0 + 0.01Xi + 0.10 (January)

16.42 In forecasting a quarterly time series over the five-
year period from the first quarter of 2006 through the fourth
quarter of 2010, the exponential trend forecasting equation
is given by

where quarter zero is the first quarter of 2006. Take the an-
tilog of the appropriate coefficient from this equation and
interpret the
a. Y intercept,
b. quarterly compound growth rate.
c. second-quarter multiplier.

bN0.

log Yi
N = 3.0 + 0.10Xi - 0.25Q1 + 0.20Q2 + 0.15Q3
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16.43 Refer to the exponential model given in Problem
16.42.
a. What is the fitted value of the series in the fourth quarter

of 2008?
b. What is the fitted value of the series in the first quarter of

2008?
c. What is the forecast in the fourth quarter of 2010?
d. What is the forecast in the first quarter of 2011?

APPLYING THE CONCEPTS
16.44 The data in are quarterly rev-
enues (in millions of dollars) for Toys R Us from

1996 through 2008.
Source: Data extracted from Standard & Poor’s Stock Reports,
November 1995, November 1998, and April 2002, New York:
McGraw-Hill, Inc.; and Toys R Us, Inc., www.toysrus.com.

a. Do you think that the revenues for Toys R Us are subject
to seasonal variation? Explain.

b. Plot the data. Does this chart support your answer in (a)?
c. Develop an exponential trend forecasting equation with

quarterly components.
d. Interpret the quarterly compound growth rate.
e. Interpret the quarterly multipliers.
f. What are the forecasts for all four quarters of 2009?

16.45 Are gasoline prices higher during the height of the
summer vacation season than at other times? The data in

give the mean monthly prices (in dollars per
gallon) for unleaded gasoline in the United States from
January 2006 to April 2010.
Source: Data extracted from Energy Information Administration, U.S.
Department of Energy, www.eia.doe.gov.

a. Construct a time-series plot.
b. Develop an exponential trend forecasting equation with

monthly components.
c. Interpret the monthly compound growth rate.
d. Interpret the monthly multipliers.
e. Write a short summary of your findings.

16.46 The data in show the average traffic on
Google recorded at the beginning of each month from
January 2004 to August 2010 for searches from the United
States concerning travel (scaled to the average traffic for the
entire time period based on a fixed point at the beginning of
the time period).
Source: Data downloaded from Google Trends, www.google.com/
trends, August 13, 2010.

a. Plot the time-series data.
b. Develop an exponential trend forecasting equation with

monthly components.
c. What is the fitted value in August 2010?
d. What are the forecasts for the last four months of 2010?
e. Interpret the monthly compound growth rate.
f. Interpret the July multiplier.

16.47 The following data (stored in ) are monthly
credit card charges (in millions of dollars) for a popular

Credit

Travel

GasPrices

Toys R UsSELF
Test

a. Construct the time-series plot.
b. Describe the monthly pattern that is evident in the data.
c. In general, would you say that the overall dollar amounts

charged on the bank’s credit cards are increasing or
decreasing? Explain.

d. Note that the December 2009 charges were more than
$63 million, but those for February 2010 were less than
$40 million. Was February’s total close to what you
would have expected?

e. Develop an exponential trend forecasting equation with
monthly components.

f. Interpret the monthly compound growth rate.
g. Interpret the January multiplier.
h. What is the predicted value for March 2010?
i. What is the predicted value for April 2010?
j. How can this type of time-series forecasting benefit the

bank?

16.48 The data in represent the price in London
for an ounce of silver (in U.S. $) at the end of each quarter
from 2004 through 2009.
Source: Data extracted from http://www.kitco.com/gold.londonfix.
html.

a. Plot the data.
b. Develop an exponential trend forecasting equation with

quarterly components.
c. Interpret the quarterly compound growth rate.
d. Interpret the first quarter multiplier.
e. What is the fitted value for the last quarter of 2009?
f. What are the forecasts for all four quarters of 2010?
g. Were the forecasts in (f) accurate? Explain.

16.49 The data in represent the price in London for
an ounce of gold (in U.S. $) at the end of each quarter from
2004 through 2009.
Source: Data extracted from http://www.kitco.com/gold.londonfix.
html.

Gold

Silver-Q

Year

Month 2008 2009 2010

January 31.9 39.4 45.0
February 27.0 36.2 39.6
March 31.3 40.5
April 31.0 44.6
May 39.4 46.8
June 40.7 44.7
July 42.3 52.2
August 49.5 54.0
September 45.0 48.8
October 50.0 55.8
November 50.9 58.7
December 58.5 63.4

credit card issued by a large bank (the name of which is not
disclosed, at its request):

www.toysrus.com
www.eia.doe.gov
http://www.kitco.com/gold.londonfix.html
http://www.kitco.com/gold.londonfix.html
www.google.com/trends
www.google.com/trends
http://www.kitco.com/gold.londonfix.html
http://www.kitco.com/gold.londonfix.html
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a. Plot the data.
b. Develop an exponential trend forecasting equation with

quarterly components.
c. Interpret the quarterly compound growth rate.

d. Interpret the first quarter multiplier.
e. What is the fitted value for the last quarter of 2009?
f. What are the forecasts for all four quarters of 2010?
g. Were the forecasts in (f) accurate? Explain.

16.8 Online Topic: Index Numbers
Index numbers measure the value of an item (or group of items) at a particular point in time as
a percentage of the value of an item (or group of items) at another point in time. To study this
topic, read the Section 16.8 online topic file that is available on this book’s companion web-
site. (See Appendix Section C to learn how to access the online topic files.)

T H I N K A B O U T T H I S Let the Model User Beware

When you use a model, you must always review
the assumptions built into the model and must
always reflect how novel or changing circum-
stances may render the model less useful. No
model can completely remove the risk involved
in making a decision.

Implicit in the time-series models developed
in this chapter is that past data can be used to
help predict the future. While using past data in
this way is a legitimate application of time-series
models, every so often, a crisis in financial mar-
kets illustrates that using models that rely on the
past to predict the future is not without risk.

For example, during August 2007, many
hedge funds suffered unprecedented losses.

Apparently, many hedge fund managers used
models that based their investment strategy
on trading patterns over long time periods.
These models did not—and could not—reflect
trading patterns contrary to historical patterns
(G. Morgenson, “A Week When Risk Came
Home to Roost,” The New York Times, August
12, 2007, pp. B1, B7). When fund managers in
early August 2007 needed to sell stocks due to
losses in their fixed income portfolios, stocks
that were previously stronger became weaker,
and weaker ones became stronger—the re-
verse of what the models expected. Making
matters worse was the fact that many fund
managers were using similar models and

rigidly made investment decisions solely
based on what those models said. These simi-
lar actions multiplied the effect of the selling
pressure, an effect that the models had not
considered and that therefore could not be
seen in the models’ results.

This example illustrates that using models
does not absolve you of the responsibility of be-
ing a thoughtful decision maker. Do go ahead
and use models—when appropriately used, they
will enhance your decision making—but don’t
use them mindlessly, for, in the words of a fa-
mous public service announcement, “a mind is a
terrible thing to waste.”

I
n the Using Statistics scenario, you were the financial analyst for The
Principled, a large financial services company. You needed to fore-
cast the interest rate for three-month Treasury bills and revenues for
Coca-Cola and Wal-Mart to better evaluate investment opportunities

for your clients.
For three-month Treasury bills, you used moving averages and expo-

nential smoothing methods to develop forecasts. You predicted that the
interest rate for three-month Treasury bills at the end of 2010 would be 2.3%.

For The Coca-Cola Company, you used least-squares linear, quadratic, and exponential
models and autoregressive models to develop forecasts. You evaluated these alternative models
and determined that the first-order autoregressive model gave the best forecast, according to
several criteria. You predicted that the revenue of The Coca-Cola Company would be $32.5678
billion in 2010 and $34.2444 billion in 2011.

For Wal-Mart Stores, Inc., you used a least-squares regression model with seasonal com-
ponents to develop forecasts. You predicted that Wal-Mart Stores would have revenues of
$106.0474 billion in the first quarter of fiscal 2011.

Given these forecasts, you now need to determine whether your clients should invest, and
if so, how much they should invest in Treasury bills and in these companies.

U S I N G S TAT I S T I C S @ The Principled Revisited



S U M M A R Y
In this chapter, you studied smoothing techniques, least-
squares trend fitting, autoregressive models, and forecasting
of seasonal data. Figure 16.22 provides a summary chart for
the time-series methods discussed in this chapter.

When using time-series forecasting, you need to plot
the time series and answer the following question: Is there a
trend in the data? If there is a trend, then you can use the au-
toregressive model or the linear, quadratic, or exponential

trend models. If there is no obvious trend in the time-series
plot, then you should use moving averages or exponential
smoothing to smooth out the effect of random effects and
possible cyclical effects. After smoothing the data, if a trend
is still not present, then you can use exponential smoothing
to forecast short-term future values. If smoothing the data
reveals a trend, then you can use the autoregressive model,
or the linear, quadratic, or exponential trend models.
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Yes No

Yes No

Exponential
Smoothing

Moving
Averages

Annual
Data?

Least-Squares
Forecasting

Forecasting
Models

Linear
Trend

Quadratic
Trend

Autoregressive
Models

Exponential
Trend

Model
Selection

Time-Series
Forecasting

Trend
?

F I G U R E 1 6 . 2 2
Summary chart of time-
series forecasting
methods

K E Y E Q U AT I O N S
Computing an Exponentially Smoothed Value
in Time Period i

(16.1)

Forecasting Time Period

(16.2)YNi+1 = Ei

i + 1

Ei = WYi + 11 - W2Ei-1 i = 2, 3, 4, Á

E1 = Y1

Linear Trend Forecasting Equation

(16.3)

Quadratic Trend Forecasting Equation

(16.4)

Exponential Trend Model

(16.5)Yi = b0b
Xi
1 ei

YNi = b0 + b1Xi + b2X
2
i

YNi = b0 + b1Xi
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Transformed Exponential Trend Model

(16.6)

Exponential Trend Forecasting Equation

(16.7a)

(16.7b)

First-Order Autoregressive Model

(16.8)

Second-Order Autoregressive Model

(16.9)

pth-Order Autoregressive Models

(16.10)

t Test for Significance of the Highest-Order Autoregressive
Parameter,

(16.11)

Fitted pth-Order Autoregressive Equation

(16.12)

pth-Order Autoregressive Forecasting Equation

(16.13)

Mean Absolute Deviation

(16.14)MAD =
a

n

i=1
|Yi - NYi|

n

YNn+ j = a0 + a1YNn+ j-1 + a2YNn+ j-2 + Á + apYNn+ j-p

YNi = a0 + a1Yi-1 + a2Yi-2 + Á + apYi-p

tSTAT =
ap - Ap

Sap

Ap

Yi = A0 + A1Yi-1 + A2Yi-2 + Á + ApYi-p + di

Yi = A0 + A1Yi-1 + A2Yi-2 + di

Yi = A0 + A1Yi-1 + di

YNi = bN 0 b1
X

N i

log1YNi2 = b0 + b1Xi

= log1b02 + Xilog1b12 + log1ei2
= log1b02 + log1bXi

1 2 + log1ei2
log1Yi2 = log1b0b

Xi
1 ei2

Exponential Model with Quarterly Data

(16.15)

Transformed Exponential Model with Quarterly Data

(16.16)

Exponential Growth with Quarterly Data Forecasting
Equation

(16.17)

Exponential Model with Monthly Data

(16.18)

Transformed Exponential Model with Monthly Data

(16.19)

Exponential Growth with Monthly Data Forecasting
Equation

(16.20)
+ b7M6 + b8M7 + b9M8 + b10M9 + b11M10 + b12M11

log (YNi) = b0 + b1Xi + b2M1 + b3M2 + b4M3 + b5M4 + b6M5

+ M10 log1b112 + M11 log1b122 + log1ei2
+ M7 log1b82 + M8 log1b92 + M9 log1b102
+ M3 log1b42 + M4 log1b52 + M5 log1b62 + M6 log1b72

= log1b02 + Xi log1b12 + M1 log1b22 + M2 log1b32
log1Yi2 = log1b0b

Xi
1 b

M1
2 b

M2
3 b

M3
4 b

M4
5 b

M5
6 b

M6
7 b

M7
8 b

M8
9 b

M9
10b

M10
11 b

M11
12 ei2

Yi = b0b
Xi
1 b

M1
2 b

M2
3 b

M3
4 b

M4
5 b

M5
6 b

M6
7 b

M7
8 b

M8
9 b

M9
10 b

M10
11 b

M11
12 ei

log(YNi) = b0 + b1Xi + b2Q1 + b3Q2 + b4Q3

+ Q2 log1b32 + Q3 log1b42 + log1ei2
= log1b02 + Xi log1b12 + Q1 log1b22

+ log1bQ3
4 2 + log1ei2

= log1b02 + log1bXi
1 2 + log1bQ1

2 2 + log1bQ2
3 2

log1Yi2 = log1b0b
Xi
1 b

Q1
2 b

Q2
3 b

Q3
4 ei2

Yi = b0b
Xi
1 b

Q1
2 b

Q2
3 b

Q3
4 ei

K E Y T E R M S
autoregressive modeling 684
causal forecasting method 666
cyclical effect 666
exponential smoothing 670
exponential trend model 676
first-order autocorrelation 684
first-order autoregressive

model 684
forecasting 666
irregular effect 667
linear trend model 673

mean absolute deviation
(MAD) 693

moving averages 668
parsimony 694
pth-order autocorrelation 684
pth-order autoregressive

model 684
quadratic trend model 675
qualitative forecasting method 666
quantitative forecasting 

method 666

random effect 667
seasonal effect 667
second-order autocorrelation 684
second-order autoregressive

model 684
time series 666
time-series forecasting 

method 666
trend 666
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C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING
16.50 What is a time series?

16.51 What are the different components of a time-series
model?

16.52 What is the difference between moving averages
and exponential smoothing?

16.53 Under what circumstances is the exponential trend
model most appropriate?

16.54 How does the least-squares linear trend forecasting
model developed in this chapter differ from the least-
squares linear regression model considered in Chapter 13?

16.55 How does autoregressive modeling differ from the
other approaches to forecasting?

16.56 What are the different approaches to choosing an
appropriate forecasting model?

16.57 What is the major difference between using and
MAD for evaluating how well a particular model fits the
data?

16.58 How does forecasting for monthly or quarterly data
differ from forecasting for annual data?

APPLYING THE CONCEPTS
16.59 The following table (stored in ) represents the
annual incidence rates (per 100,000 persons) of reported
acute poliomyelitis recorded over five-year periods from
1915 to 1955:

Polio

SYX

1984–2008. The workforce variable reports the number of
people in the population who have a job or are actively
looking for a job.
Source: Data extracted from Bureau of Labor Statistics, U.S. Department
of Labor, www.bls.gov.

a. Plot the time series for the U.S. civilian noninstitutional
population of people 16 years and older.

b. Compute the linear trend forecasting equation.
c. Forecast the U.S. civilian noninstitutional population of

people 16 years and older for 2009 and 2010.
d. Repeat (a) through (c) for the U.S. civilian noninstitu-

tional workforce of people 16 years and older.

16.61 The monthly wellhead and residential prices for nat-
ural gas (dollars per thousand cubic feet) in the United
States from 2008 through 2009 are stored in .
Source: Data extracted from Energy Information Administration, U.S.
Department of Energy, www.eia.gov, Natural Gas Monthly, July 2010.

For the wellhead price and the residential, price:
a. Do you think the price for natural gas has a seasonal

component?
b. Plot the time series. Does this chart support your answer

in (a)?
c. Compute an exponential trend forecasting equation for

monthly data.
d. Interpret the monthly compound growth rate.
e. Interpret the month multipliers. Do the multipliers sup-

port your answers in (a) and (b)?
f. Compare the results for the wellhead prices and the resi-

dential prices.

16.62 The data in the following table (stored in
) represent the gross revenues (in billions of

current dollars) of McDonald’s Corporation from 1975
through 2009:

McDonalds

Natural Gas

Year 1915 1920 1925 1930 1935 1940 1945 1950 1955

Rate 3.1 2.2 5.3 7.5 8.5 7.4 10.3 22.1 17.6

Source: Data extracted from B. Wattenberg, ed., The Statistical
History of the United States: From Colonial Times to the Present, ser.
B303 (New York: Basic Books, 1976).

a. Plot the data.
b. Compute the linear trend forecasting equation and plot

the trend line.
c. What are your forecasts for 1960, 1965, and 1970?
d. Using a library or the Internet, find the actually reported

incidence rates of acute poliomyelitis for 1960, 1965, and
1970. Record your results.

e. Why are the forecasts you made in (c) not useful? Discuss.

16.60 The U.S. Department of Labor gathers and
publishes statistics concerning the labor market. The file

contains data on the size of the U.S. civilian
noninstitutional population of people 16 years and over
(in thousands) and the U.S. civilian noninstitutional work-
force of people 16 years and over (in thousands) for

Workforce

Year Revenues Year Revenues Year Revenues

1975 1.0 1987 4.9 1999 13.3
1976 1.2 1988 5.6 2000 14.2
1977 1.4 1989 6.1 2001 14.8
1978 1.7 1990 6.8 2002 15.2
1979 1.9 1991 6.7 2003 16.8
1980 2.2 1992 7.1 2004 18.6
1981 2.5 1993 7.4 2005 19.8
1982 2.8 1994 8.3 2006 20.9
1983 3.1 1995 9.8 2007 22.8
1984 3.4 1996 10.7 2008 23.5
1985 3.8 1997 11.4 2009 22.7
1986 4.2 1998 12.4

Source: Data extracted from Moody’s Handbook of Common Stocks,
1980, 1989, and 1999; Mergent’s Handbook of Common Stocks,
Spring 2002; and www.mcdonalds.com.

www.bls.gov
www.eia.gov
www.mcdonalds.com.
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a. Plot the data.
b. Compute the linear trend forecasting equation.
c. Compute the quadratic trend forecasting equation.
d. Compute the exponential trend forecasting equation.
e. Determine the best-fitting autoregressive model, using

f. Perform a residual analysis for each of the models in (b)
through (e).

g. Compute the standard error of the estimate and the
MAD for each corresponding model in (f).

h. On the basis of your results in (f) and (g), along with a
consideration of the principle of parsimony, which
model would you select for purposes of forecasting?
Discuss.

i. Using the selected model in (h), forecast gross revenues
for 2010.

16.63 Teachers’ Retirement System of the City of New
York offers several types of investments for its members.
Among the choices are investments with fixed and variable
rates of return. There are several categories of variable-
return investments. The Diversified Equity Fund consists of
investments that are primarily made in stocks, and the Sta-
ble-Value Fund consists of investments in corporate bonds
and other types of lower-risk instruments. The data stored in

represent the value of a unit of each type of vari-
able-return investment at the beginning of each year from
1984 to 2010.

Source: Data extracted from Teachers’ Retirement System of the City of
New York, www.trs.nyc.ny.us.

For each of the two time series,
a. plot the data.
b. compute the linear trend forecasting equation.

TRSNYC

1SYX2

a = 0.05.

c. compute the quadratic trend forecasting equation.
d. compute the exponential trend forecasting equation.
e. determine the best-fitting autoregressive model, using

f. Perform a residual analysis for each of the models in (b)
through (e).

g. Compute the standard error of the estimate and the
MAD for each corresponding model in (f).

h. On the basis of your results in (f) and (g), along with a
consideration of the principle of parsimony, which model
would you select for purposes of forecasting? Discuss.

i. Using the selected model in (h), forecast the unit values
for 2011.

j. Based on the results of (a) through (i), what investment
strategy would you recommend for a member of the
Teachers’ Retirement System of the City of New York?
Explain.

REPORT WRITING EXERCISE
16.64 As a consultant to an investment company trading
in various currencies, you have been assigned the task of
studying long-term trends in the exchange rates of the Cana-
dian dollar, the Japanese yen, and the English pound. Data
from 1980 to 2009 are stored in , where the Cana-
dian dollar, the Japanese yen, and the English pound are
expressed in units per U.S. dollar.

Develop a forecasting model for the exchange rate of
each of these three currencies and provide forecasts for
2010 and 2011 for each currency. Write an executive sum-
mary for a presentation to be given to the investment com-
pany. Append to this executive summary a discussion
regarding possible limitations that may exist in these
models.

Currency

1SYX2

a = 0.05.

M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
As part of the continuing strategic initiative to increase sub-
scribers to the 3-For-All cable/phone/Internet services, the
marketing department is closely monitoring the number of
subscribers. To help do so, forecasts are to be developed for
the number of subscribers in the future. To accomplish this
task, the number of subscribers for the most recent 24-month
period has been determined and is stored in .

EXERCISES
1. Analyze these data and develop a model to forecast the

number of subscribers. Present your findings in a report

AMS16

that includes the assumptions of the model and its limita-
tions. Forecast the number of subscribers for the next four
months.

2. Would you be willing to use the model developed to fore-
cast the number of subscribers one year into the future?
Explain.

3. Compare the trend in the number of subscribers to the
number of new subscribers per month stored in

. What explanation can you provide for any dif-
ferences?
AMS13

www.trs.nyc.ny.us
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D I G I TA L C A S E
Apply your knowledge about time-series forecasting in this
Digital Case.

The Ashland Herald competes for readers in the Tri-Cities
area with the newer Oxford Glen Journal (OGJ). Recently,
the circulation staff at the OGJ claimed that their newspa-
per’s circulation and subscription base is growing faster
than that of the Herald and that local advertisers would do
better if they transferred their advertisements from the
Herald to the OGJ. The circulation department of the
Herald has complained to the Ashland Chamber of Com-
merce about OGJ’s claims and has asked the chamber to in-
vestigate, a request that was welcomed by OGJ’s
circulation staff.

Open ACC_Mediation216.pdf to review the circula-
tion dispute information collected by the Ashland Chamber
of Commerce. Then answer the following:

1. Which newspaper would you say has the right to claim
the fastest-growing circulation and subscription base?
Support your answer by performing and summarizing an
appropriate statistical analysis.

2. What is the single most positive fact about the Herald’s
circulation and subscription base? What is the single most
positive fact about the OGJ’s circulation and subscription
base? Explain your answers.

3. What additional data would be helpful in investigating
the circulation claims made by the staffs of each newspaper?
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EG16.1 The IMPORTANCE of BUSINESS
FORECASTING

There are no Excel Guide instructions for this section.

EG16.2 COMPONENT FACTORS of
TIME-SERIES MODELS

There are no Excel Guide instructions for this section.

EG16.3 SMOOTHING an ANNUAL
TIME SERIES

Moving Averages

In-Depth Excel Use the COMPUTE worksheet of the
Moving Averages workbook, shown in Figure 16.2 on
page 669, as a template for creating moving averages. The
worksheet uses a series of AVERAGE(cell range that con-

tains a sequence of L observed values) functions to com-
pute moving averages for time-series data. For time periods
in which no moving average can be computed, the
worksheet uses the special worksheet value #N/A (not
available).

For other problems, paste the time-series data into
columns A and B and adjust the moving average entries in
columns C and D. The COMPUTE worksheet also contains
a superimposed chart, an exception to the general rule in
this book that places each chart on its own chart sheet. To
use this chart for other problems, double-click the chart
titles and labels to change them to appropriate values. (The
plot of points changes automatically when you change the
data.)

To create the chart from scratch on its own chart sheet,
open to the COMPUTE worksheet and:

1. Select the cell range A1:D20, the cell range of the time-
series data and the moving averages.

2. Select Insert ➔ Scatter and select the second Scatter
gallery choice in the second row of choices (Scatter
with Straight Lines and Markers).

3. Relocate the chart to a chart sheet and adjust the chart
formatting by using the instructions in Appendix Section
F.4 on page 815, ignoring the instruction to select None
from the Legend gallery.

Exponential Smoothing

In-Depth Excel Use the COMPUTE worksheet of
the Exponential Smoothing workbook, shown in
Figure 16.3 on page 670, as a template for creating
exponentially smoothed values. In this worksheet,
cells C2 and D2 contain the formula =B2, cell C3
contains the formula =0.5 * B3 + 0.5 * C2, and cell
D3 contains the formula =0.25 * B3 + 0.75 * D2. The
other formulas in columns C and D are the result of
copying the C3 and D3 formulas down the columns.
(Note that in the C3 and D3 formulas, the expression

has been simplif ied to the values 0.5 and 0.75,
respectively.)

For other problems with fewer than 20 time periods,
delete the excess rows. For problems with more than 20 time
periods, select row 20, right-click, and click Insert in the
shortcut menu. Repeat as many times as there are new rows.
Then select cell range C19:D19 and copy the contents of
this range down through the new table rows.

The COMPUTE worksheet also contains a superim-
posed chart, an exception to the general rule in this book
that places each chart on its own chart sheet. To use this
chart for other problems, double-click the chart titles and la-
bels to change them to appropriate values. (The plot of
points changes automatically when you change the data.) To
create the chart from scratch on its own chart sheet, open to
the COMPUTE worksheet and select the cell range
A1:D20, the cell range of the time-series data and the mov-
ing averages. Select Insert ➔ Scatter and select the second
Scatter gallery choice in the second row of choices (Scatter
with Straight Lines and Markers). Relocate the chart to a
chart sheet and adjust the chart formatting by using the in-
structions in Appendix Section F.4 on page 815, ignoring
the instruction to select None from the Legend gallery.

Analysis ToolPak Use Exponential Smoothing to create
exponentially smoothed values. For example, to create the
column C exponentially smoothed Three-Month U.S. Trea-
sury bill rates (smoothing coefficient ), shown in
Figure 16.3 on page 670, open to the DATA worksheet of
the Treasury workbook and:

1. Select Data ➔ Data Analysis.

2. In the Data Analysis dialog box, select Exponential
Smoothing from the Analysis Tools list and then
click OK.

W = 0.50

1 - W
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In the Exponential Smoothing dialog box (shown below):

3. Enter B1:B20 as the Input Range.

4. Enter 0.5 as the Damping factor. (The damping factor
is equal to )

5. Check Labels, enter C1 as the Output Range, and click
OK.

1 - W.

Section EG15.1 instructions to create the squared coded
variable.

To plot the quadratic trend, modify the Section EG13.2
In-Depth Excel instructions on page 571. Choose the poly-
nomial type (not linear) by clicking Polynomial instead of
Linear in step 2.

The Exponential Trend Model

Due to the limitations of Excel, creating an exponential
trend model requires more work than creating the other
trend models. First, modify the Section EG13.5 and
EG13.2 instructions (see pages 572 and 571) to use the
cell range of the log Y values as the Y variable cell range
and the cell range of the coded variable as the X variable
cell range. (The Y variable cell range and the X variable
cell range are called the Y Variable Cell Range and X
Variable Cell Range in the PHStat2 instructions, called
the cell range of Y variable and cell range of X variable
in the In-Depth Excel instructions, and called the Input Y
Range and Input X Range in the Analysis ToolPak instruc-
tions.) Use the Section EG15.2 instructions on page 660 to
create the log Y values.

Using the modified instructions will create a regression
results worksheet for a simple linear regression model and
create additional columns for the logs of the residuals and
the logs of the predicted Y values in a residual worksheet if
using the PHStat2 or In-Depth Excel instructions, or in the
RESIDUAL OUTPUT area in the regression results work-
sheet, if using the Analysis ToolPak instructions. (If using
the Analysis ToolPak instructions, note that the additional
column for the logs of the residuals has the misleading label
Residuals, and not the label LOG(Residuals), as one
might expect.)

To these results, add a column that contains the origi-
nal (untransformed) Y values and a column of formulas
that use the POWER function to transform the logs of the
predicted Y values to the predicted Y values. To do so, first
copy the original Y values to the empty column in the
residuals worksheet (if using PHStat2 or In-Depth Excel)
or a column to the right of RESIDUALS OUTPUT area (if
using the Analysis ToolPak instructions). Then create a
new column that contains formulas in the form
=POWER(10, log of predicted value) to compute the
predicted Y values.

Use columns F and G of the RESIDUALS worksheet
of the Exponential Trend workbook as a model for creat-
ing the two additional columns. This worksheet contains the
values needed to create the Figure 16.9 plot that fits an ex-
ponential trend forecasting equation for The Coca-Cola
Company revenues (see page 678). (In this worksheet, the
formula =POWER(10, C2) was entered in cell G2 and
copied down through row 16.)

In the new column C:

6. Copy the last formula in cell C19 to cell C20.

7. Enter the column heading ES(W =.50) in cell C1,
replacing the #N/A value.

For other problems, to create exponentially smoothed values
using a smoothing coefficient of enter 0.75 as
the damping factor in step 4. (The damping factor is equal
to )

EG16.4 LEAST-SQUARES TREND FITTING
and FORECASTING

The Linear Trend Model

Modify the Section EG13.2 instructions (see page 571) to
create a linear trend model. Use the cell range of the coded
variable as the X variable cell range (called the X Variable
Cell Range in the PHStat2 instructions, called the cell
range of X variable in the In-Depth Excel instructions, and
called the Input X Range in the Analysis ToolPak instruc-
tions). If you need to create coded values, enter them man-
ually in a column. (If you have many coded values, you can
use Home ➔ Fill (in the Editing group) ➔ Series and in
the Series dialog box, click Columns and Linear, and
select appropriate values for Step value and Stop value.

The Quadratic Trend Model

Modify the Section EG15.1 instructions (see page 660) to
create a quadratic trend model. Use the cell range of the
coded variable and the squared coded variable as the X vari-
ables cell range (called the X Variables Cell Range in the
PHStat2 instructions, called the cell range of X variables
in the In-Depth Excel instructions, and called the Input X
Range in the Analysis ToolPak instructions). Use the

1 - W.

W = 0.25,
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Using the original X (time) variable column, the origi-
nal Y variable column, and the predicted Y variable column,
in that order, in the RESIDUALS worksheet, create and
modify a scatter plot using the instructions given below.
(Use these instructions even if you originally used PHStat2
or Analysis ToolPak to create the data for this plot.) For ex-
ample, to create an exponential trend plot for The Coca-
Cola Company revenue, open to the RESIDUALS
worksheet of the Exponential Trend workbook. Select
cell range B1:B16 and while holding down the Ctrl key,
select the cell range F1:G16 and:

1. Select Insert ➔ Scatter and select the first Scatter
gallery choice (Scatter with only Markers).

2. Right-click one of the predicted revenues data points
(typically a reddish square) and select Format Data
Series from the shortcut menu.

3. Click Marker Options in the left pane and in the
Marker Options right pane click None.

4. Back in the left pane, click Line Style and in the Line
Style right pane enter 2 as the Width. Click OK.

5. Relocate the chart to a chart sheet and adjust the chart
formatting by using the instructions in Appendix Sec-
tion F.4 on page 815.

Model Selection Using First, Second, 
and Percentage Differences

Use arithmetic formulas to compute the first, second, and
percentage differences. Use division formulas to compute
the percentage differences and use subtraction formulas
to compute the first and second differences. Use the
COMPUTE worksheet of the Differences workbook,
shown in Figure 16.10 on page 680 as a model for devel-
oping a differences worksheet. (Open to the COM-
PUTE_FORMULAS worksheet to see all formulas
used.)

EG16.5 AUTOREGRESSIVE MODELING
for TREND FITTING and
FORECASTING

Creating Lagged Predictor Variables

Create lagged predictor variables by creating a column of
formulas that refer to a previous row’s (previous time pe-
riod’s) Y value. Enter the special worksheet value #N/A (not
available) for the cells in the column to which lagged values
do not apply.

Use the COMPUTE worksheet of the Lagged Pre-
dictors workbook, shown in Figure 16.12 on page 688 as a
model for developing lagged predictor variables for the

first-order, second-order, and third-order autoregressive
models. When using lagged predictor variables, you select
or refer to only those rows that contain lagged values. Un-
like the general case in this book, you do not include rows
that contain #N/A, nor do you include the row 1 column
heading.

Autoregressive Modeling

Modify the Section EG14.1 instructions (see page 622) to
create a third-order or second-order autoregressive model.
Use the cell range of the first-order, second-order, and
third-order lagged predictor variables as the X variables
cell range for the third-order model. Use the cell range of
the first-order and second-order lagged predictor
variables as the X variables cell range for the second-or-
der model (The X variables cell range is the X Variables
Cell Range in the PHStat2 instructions, called the cell
range of X variables in the In-Depth Excel instructions,
and called the Input X Range in the Analysis ToolPak in-
structions.) If using the PHStat2 instructions, omit step 3
(clear, do not check, First cells in both ranges contain
label). If using the Analysis ToolPak instructions, do not
check Labels in step 4.

Modify the Section EG13.2 instructions (see page 571)
to create a first-order autoregressive model. Use the cell
range of the first-order lagged predictor variable as the X
variable cell range (called the X Variable Cell Range in
the PHStat2 instructions, called the cell range of X
variable in the In-Depth Excel instructions, and called the
Input X Range in the Analysis ToolPak instructions). If
using the PHStat2 instructions, omit step 3 (clear, do not
check, First cells in both ranges contain label). If using
the Analysis ToolPak instructions, do not check Labels
in step 4.

EG16.6 CHOOSING an APPROPRIATE
FORECASTING MODEL

Measuring the Magnitude of the Residuals
Through Squared or Absolute Differences

Use a two-part process to compute the mean absolute devia-
tion (MAD). First, perform the appropriate residual analysis
using either the Section EG13.5 or Section EG14.3 instruc-
tions (see pages 572 and 623). Then, add a column (or
columns) of formulas to compute the mean absolute devia-
tion (MAD) to the table that includes the residuals (in a
residuals worksheet if using the PHStat2 or In-Depth Excel
instructions or as part of a regression results worksheet if
using the Analysis ToolPak instructions).

For a linear, quadratic, or autoregressive model, add a
column of formulas in the form =ABS(residual cell) to
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compute the absolute value of the residuals and then add the
single formula in the form =AVERAGE(cell range of the

absolute values of the residuals) to compute the MAD.
For an exponential model, you must first create the

additional columns for the logs of the residuals and the
logs of the “predicted Y” values using the “The
Exponential Trend Model” instructions in Section EG16.4
on page 710. (As explained in that section, use columns F
and G of the RESIDUALS worksheet of the Exponential
Trend workbook as a model for creating the two
additional columns.) To these two columns, add a third
column of formulas in the form =ABS(original Y value

cell – predicted Y value cell) to calculate the absolute
value of the residuals. At the end of this column, add a
single formula in the form =AVERAGE(cell range of

residual absolute values) to compute the MAD. Use
column H of the RESIDUALS worksheet of the
Exponential Trend workbook as a model for creating
this third column. In this worksheet, the formula
=ABS(F2 - G2) was entered in cell H2 and copied down
through row 15, and the single formula
=AVERAGE(H2:H15) was entered in cell H16.

A Comparison of Four Forecasting Methods

When you compare the four forecasting models, you use
residual analysis to examine the models. Use the instruc-
tions in Section EG13.5 on page 572 to create residual plots
for the linear trend model or first-order autoregressive mod-
els. Use the instructions in Section EG14.3 on page 623 to
create residual plots for the quadratic trend model.

As is the case in other instructions in this Excel Guide,
creating residual plots for the exponential trend model
requires additional work. First create the additional
columns for the logs of the residuals and the logs of the

predicted Y values using the “The Exponential Trend
Model” instructions of Section EG16.4 on page 710. (As
explained in that section, use columns F and G of the
RESIDUALS worksheet of the Exponential Trend
workbook as a model for creating the two additional
columns.)

To these two columns, add a third column of formulas
in the form =original Y value cell - predicted Y value cell

to calculate the residuals. Use column I of the
RESIDUALS worksheet of the Exponential Trend
workbook as a model for creating this third column. Then
select the original X (time) variable column and the new
column of computed residuals, in that order, and use the
Section EG2.6 instructions for creating a scatter plot to
create the exponential trend residual plot.

EG16.7 TIME-SERIES FORECASTING
of SEASONAL DATA

Least-Squares Forecasting with Monthly 
or Quarterly Data

To develop a least-squares regression model for monthly or
quarterly data, add columns of formulas that use the IF
function to create dummy variables for the quarterly or
monthly data. Enter all formulas in the form
=IF(comparison, 1, 0).

Figure EG16.1 shows the first four rows of columns
F through K of a data worksheet that contains dummy
variables. Columns F, G, and H contain the quarterly
dummy variables Q1, Q2, and Q3 that are based on
column B coded quarter values (not shown). Columns J
and K contain the two monthly variables M1 and M6 that
are based on column C month values (also not shown).

F I G U R E E G 1 6 . 1 Dummy variable formulas for quarterly and monthly data
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MG16.1 The IMPORTANCE of BUSINESS
FORECASTING

There are no Minitab Guide instructions for this section.

MG16.2 COMPONENT FACTORS of
TIME-SERIES MODELS

There are no Minitab Guide instructions for this section.

MG16.3 SMOOTHING AN ANNUAL 
TIME SERIES

Moving Averages

Use Moving Average to compute moving averages. For ex-
ample, to compute the moving averages shown in column C
of Figure 16.2 on page 669, open to the Treasury work-
sheet. Select Stat ➔ Time Series ➔ Moving Average. In
the Moving Average dialog box (shown below):

1. Double-click C2 Rate in the variables list to add Rate
to the Variable box.

2. Enter 3 in the MA length box.

3. Check Center the moving averages.

4. Click Results.

Exponential Smoothing

Use Single Exp Smoothing to compute exponential
smoothed values. For example, to compute the exponential
smoothed values shown in column C of Figure 16.3 on
page 670, open to the Treasury worksheet. Select Stat ➔
Time Series ➔ Single Exp Smoothing. In the Single
Exponential Smoothing dialog box (shown below):

1. Double-click C2 Rate in the variables list to add Rate
to the Variable box.

2. Click Use and enter 0.50 in its box (for a W value of
0.50).

3. Click Options.

5. In the Moving Average - Results dialog box (not shown),
click Summary table and results table and then click
OK.

6. Back in the Moving Average dialog box, click OK.

For a seven-year moving average, enter 7 in the MA length
box in step 2.

4. In the Single Exponential Smoothing - Options dialog
box, enter 1 in the Use average of first K observations
box and then click OK.

5. Back in the Single Exponential Smoothing dialog box,
click Results.

6. In the Single Exponential Smoothing - Results dialog
box, click Summary table and results table and then
click OK.

7. Back in the Single Exponential Smoothing dialog box,
click OK.

For a W value of 0.25, enter 0.25 in step 2.

MG16.4 LEAST-SQUARES TREND FITTING
and FORECASTING

In Chapters 13 through 15, you used Minitab for the simple
linear regression model and for a variety of multiple
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8. Reselect Stat ➔ Time Series ➔ Lag. In the Lag
dialog box, enter C6 in the Store lags in box, press
Tab, and enter 3 in the Lag box (for a 3-period lag).
Click OK.

9. In the worksheet, enter Lag3 as the name for column
C6.

Autoregressive Modeling

Modify the Section MG14.1 “Interpreting the Regression
Coefficients” instructions (see page 625) to create a third-
order or second-order autoregressive model. Add the
names of the columns containing the first-order, second-
order, and third-order lagged predictor variables to the
Predictors box for the third-order model. Add the names
of the columns containing the first-order, and second-or-
der lagged predictor variables to the Predictors box for
the second-order model.

Modify the Section MG13.2 instructions (see page 573)
to create a first-order autoregressive model. In step 2, add
the name of the column containing the first-order lagged
predictor variable to the Predictors box.

MG16.6 CHOOSING an APPROPRIATE
FORECASTING MODEL

A Comparison of Four Forecasting Methods

When you compare the four forecasting models, you use
residual analysis to examine the models. Use the instructions
in Section MG13.5 on page 574 to create residual plots for
the linear trend model or first-order autoregressive models.
Use the instructions in Section MG14.1 on page 625 to
create residual plots for the quadratic and the exponential
trend models.

MG16.7 TIME-SERIES FORECASTING
of SEASONAL DATA

Least-Squares Forecasting with Monthly 
or Quarterly Data

Use Calculator to create dummy variables for the quarterly
or monthly data. For example, to create the dummy quarterly
variable Q1 for the Wal-Mart Stores quarterly revenues
shown in Table 16.3 on page 696, open to the WalMart

regression models. In this chapter, time-series models were
developed assuming either a linear, quadratic, or exponential
trend. For the linear trend model, see Section MG13.2 on
page 573. For the quadratic and the exponential trend mod-
els, see Sections MG15.1 and MG15.2 on pages 661–662.

MG16.5 AUTOREGRESSIVE MODELING for
TREND FITTING and FORECASTING

Creating Lagged Predictor Variables

Use Lag to create lagged predictor variables for autoregres-
sive models. For example, to create the lagged variables
shown in Figure 16.12 on page 688, open to the Coca-Cola
worksheet. Select Stat ➔ Time Series ➔ Lag. In the Lag
dialog box (shown below):

1. Double-click C3 Revenues in the variables list to add
Revenues to the Series box.

2. Enter C4 in the Store lags in box and press Tab.

3. Enter 1 in the Lag box (for a one-period lag).

4. Click OK.

5. In the worksheet, enter Lag1 as the name for column
C4.

6. Again select Stat ➔ Time Series ➔ Lag. In the Lag di-
alog box, enter C5 in the Store lags in box, press Tab,
and enter 2 in the Lag box (for a 2-period lag). Click
OK.

7. In the worksheet, enter Lag2 as the name for column
C5.
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worksheet. Select Calc ➔ Calculator. In the Calculator
dialog box:

1. Enter C5 in the Store result in variable box.

2. Enter IF(Quarter=1,1,0) in the Expression box.

3. Click OK.

4. Enter Q1 as the name for column C5.

In step 2, use the expression IF(Quarter=2,1,0) to create
the dummy quarterly variable Q2 or use IF(Quarter=3,1,0)
to create the quarterly variable Q3.

For monthly variables, first convert the values to text, if
necessary, using Change Data Type (see Section MG1.2 on
page 22). Then select Calc ➔ Calculator and enter
expressions such as IF(Month="January",1,0) in the
Expression box.
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Y ou find yourself managing the Beachcomber Hotel, 
one of the resorts owned by T.C. Resort Properties (see
Chapter 12). Your business objective is to continually
improve the quality of service that your guests receive
so that overall guest satisfaction increases. To help you

achieve this improvement, T.C. Resort Properties has provided its
managers with training in Six Sigma. In order to meet the business ob-

jective of increasing the return rate of guests at your hotel, you have
decided to focus on the critical first impressions of the service that
your hotel provides. Is the assigned hotel room ready when a guest
checks in? Are all expected amenities, such as extra towels and a
complimentary guest basket, in the room when the guest first
walks in? Are the video-entertainment center and high-speed
Internet access working properly? And do guests receive their lug-
gage in a reasonable amount of time?

To study these guest satisfaction issues, you have embarked
on an improvement project that focuses on the readiness of the
room and the time it takes to deliver luggage. You would like to
learn the following:

� Are the proportion of rooms ready and the time required to
deliver luggage to the rooms acceptable?

� Are the proportion of rooms ready and the luggage delivery
time consistent from day to day, or are they increasing or
decreasing?

� On the days when the proportion of rooms that are not ready or
the time to deliver luggage is greater than normal, are these
fluctuations due to a chance occurrence, or are there funda-
mental flaws in the processes used to make rooms ready and to
deliver luggage?
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A ll companies, whether they manufacture products or provide services, as T.C. Resort
Properties does in the Beachcomber Hotel scenario, understand that quality is essen-
tial for survival in the global economy. Quality has an impact on our everyday work

and personal lives in many ways: in the design, production, and reliability of our automobiles;
in the services provided by hotels, banks, schools, retailers, and telecommunications compa-
nies; in the continuous improvement in integrated circuits that makes for more capable
consumer electronics and computers; and in the availability of new technology and equipment
that has led to improved diagnosis of illnesses and improved delivery of health care services.

In this chapter you will learn how to develop and analyze control charts, a statistical tool
that is widely used for quality improvement. You will then learn how businesses and organiza-
tions around the world are using control charts as part of two important quality improvement
approaches: total quality management (TQM) and Six Sigma.

17.1 The Theory of Control Charts
A process is the value-added transformation of inputs to outputs. The inputs and outputs of a
process can involve machines, materials, methods, measurement, people, and the environment.
Each of the inputs is a source of variability. Variability in the output can result in poor service
and poor product quality, both of which often decrease customer satisfaction.

Control charts, developed by Walter Shewhart in the 1920s (see reference 17), are com-
monly used statistical tools for monitoring and improving processes. A control chart analyzes
a process in which data are collected sequentially over time. You use a control chart to study
past performance, to evaluate present conditions, or to predict future outcomes. You use con-
trol charts at the beginning of quality improvement efforts to study an existing process (such
charts are called Phase 1 control charts). Information gained from analyzing Phase 1 control
charts forms the basis for process improvement. After improvements to the process are imple-
mented, you then use control charts to monitor the processes to ensure that the improvements
continue (these charts are called Phase 2 control charts).

Different types of control charts allow you to analyze different types of critical-to-quality
(CTQ in Six Sigma lingo—see Section 17.8) variables—for categorical variables, such as the
proportion of hotel rooms that are nonconforming in terms of the availability of amenities and
the working order of all appliances in the room; for discrete variables such as the number of
hotel guests registering complaints in a week; and for continuous variables, such as the length
of time required for delivering luggage to the room.

In addition to providing a visual display of data representing a process, a principal focus of a
control chart is the attempt to separate special causes of variation from common causes of variation.

THE TWO TYPES OF CAUSES OF VARIATION
Special causes of variation represent large fluctuations or patterns in data that are not part
of a process. These fluctuations are often caused by unusual events and represent either
problems to correct or opportunities to exploit. Some organizations refer to special causes of
variation as assignable causes of variation.

Common causes of variation represent the inherent variability that exists in a process.
These fluctuations consist of the numerous small causes of variability that operate
randomly or by chance. Some organizations refer to common causes of variation as
chance causes of variation.

Walter Shewhart (see reference 17) developed an experiment that illustrates the distinction
between common and special causes of variation. The experiment asks you to repeatedly write
the letter A in a horizontal line across a piece of paper:

When you do this, you immediately notice that the A’s are all similar but not exactly the same. In
addition, you may notice some difference in the size of the A’s from letter to letter. This difference is

AAAAAAAAAAAAAAAAA
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due to common cause variation. Nothing special happened that caused the differences in the size of
the A. You probably would have a hard time trying to explain why the largest A is bigger than the
smallest A. These types of differences almost certainly represent common cause variation.

However, if you did the experiment over again but wrote half of the A’s with your right
hand and the other half of the A’s with your left hand, you would almost certainly see a very
big difference in the A’s written with each hand. In this case, the hand that you used to write
the A’s is the source of the special cause variation.

Common and special cause variation have a crucial difference. Common causes of varia-
tion can be reduced only by changing the process. (Such systemic changes are the responsibil-
ity of management.) In contrast, because special causes of variation are not part of a process,
special causes are correctable or exploitable without changing that process. (In the example,
changing the hand to write the A’s corrects the special cause variation but does nothing to
change the underlying process of handwriting.)

Control charts allow you to monitor a process and identify the presence or absence of special
causes. By doing so, control charts help prevent two types of errors. The first type of error involves
the belief that an observed value represents special cause variation when it is due to the common
cause variation of the process. Treating common cause variation as special cause variation often re-
sults in overadjusting a process. This overadjustment, known as tampering, increases the variation
in the process. The second type of error involves treating special cause variation as common cause
variation. This error results in not taking immediate corrective action when necessary. Although
both of these types of errors can occur even when using a control chart, they are far less likely.

To construct a control chart, you collect samples from the output of a process over time. The
samples used for constructing control charts are known as subgroups. For each subgroup (i.e.,
sample), you calculate a sample statistic. Commonly used statistics include the sample proportion
for a categorical variable (see Section 17.2), the number of nonconformities (see Section 17.4),
and the mean and range of a numerical variable (see Section 17.5). You then plot the values over
time and add control limits around the center line of the chart. The most typical form of a control
chart sets control limits that are within standard deviations1 of the statistical measure of inter-
est. Equation (17.1) defines, in general, the upper and lower control limits for control charts.

;3

1Recall from Section 6.2 that in the
normal distribution, in-
cludes almost all (99.73%) of the
values in the population.

m ; 3s

CONSTRUCTING CONTROL LIMITS

(17.1)

so that

Upper control limit (UCL) Process mean standard deviations

Lower control limit (LCL) Process mean standard deviations-3=

+3=

Process mean ;3 standard deviations

When these control limits are set, you evaluate the control chart by trying to find whether
any pattern exists in the values over time and by determining whether any points fall outside
the control limits. Figure 17.1 illustrates three different patterns.

UCL

X

Center
Line

Common cause variation
only: No points outside
3σ limits; no pattern
over time

LCL

Time
Panel A

X
Special cause
variation

Special cause variation

Time
Panel B

X Pattern over time:
Special cause variation

Time
Panel C

F I G U R E 1 7 . 1
Three control chart
patterns
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In Panel A of Figure 17.1, there is no apparent pattern in the values over time and there are
no points that fall outside the 3 standard deviation control limits. The process appears stable
and contains only common cause variation. Panel B, on the contrary, contains two points that
fall outside the 3 standard deviation control limits. You should investigate these points to try to
determine the special causes that led to their occurrence. Although Panel C does not have any
points outside the control limits, it has a series of consecutive points above the mean value (the
center line) as well as a series of consecutive points below the mean value. In addition, a long-
term overall downward trend is clearly visible. You should investigate the situation to try to
determine what may have caused this pattern.

Detecting a pattern is not always so easy. The following simple rule (see references 9, 13,
and 19) can help you to detect a trend or a shift in the mean level of a process:

Eight or more consecutive points that lie above the center line or eight or more consecutive
points that lie below the center line.2

A process whose control chart indicates an out-of-control condition (i.e., a point outside
the control limits or a series of points that exhibits a pattern) is said to be out of control. An out-
of-control process contains both common causes of variation and special causes of variation.
Because special causes of variation are not part of the process design, an out-of-control process
is unpredictable. When you determine that a process is out of control, you must identify the spe-
cial causes of variation that are producing the out-of-control conditions. If the special causes
are detrimental to the quality of the product or service, you need to implement plans to elimi-
nate this source of variation. When a special cause increases quality, you should change the
process so that the special cause is incorporated into the process design. Thus, this beneficial
special cause now becomes a common cause source of variation, and the process is improved.

A process whose control chart does not indicate any out-of-control conditions is said to be
in control. An in-control process contains only common causes of variation. Because these
sources of variation are inherent to the process itself, an in-control process is predictable. In-
control processes are sometimes said to be in a state of statistical control. When a process is
in control, you must determine whether the amount of common cause variation in the process
is small enough to satisfy the customers of the products or services. If the common cause
variation is small enough to consistently satisfy the customers, you then use control charts to
monitor the process on a continuing basis to make sure the process remains in control. If the
common cause variation is too large, you need to alter the process itself.

2This rule is often referred to as the
runs rule. A similar rule that some
companies use is called the trend
rule: eight or more consecutive
points that increase in value or
eight or more consecutive points
that decrease in value. Some statis-
ticians (see reference 5) have criti-
cized the trend rule. It should be
used only with extreme caution.

17.2 Control Chart for the Proportion: The p Chart
Various types of control charts are used to monitor processes and determine whether special
cause variation is present in a process. Attribute control charts are used for categorical or
discrete variables. This section introduces the p chart, which is used for categorical variables.
The p chart gets its name from the fact that you plot the proportion of items in a sample that
are in a category of interest. For example, sampled items are often classified according to
whether they conform or do not conform to operationally defined requirements. Thus, the
p chart is frequently used to monitor and analyze the proportion of nonconforming items in
repeated samples (i.e., subgroups) selected from a process.

To begin the discussion of p charts, recall that you studied proportions and the binomial
distribution in Section 5.3. Then, in Equation (7.6) on page 267, the sample proportion is
defined as and the standard deviation of the sample proportion is defined in Equa-
tion (7.7) on page 267 as

Using Equation (17.1) on page 719, control limits for the proportion of nonconforming3 items
from the sample data are established in Equation (17.2).

sp = Ap11 - p2
n

p = X>n,3In this chapter, and in quality man-
agement, the phrase proportion of
nonconforming items is often used,
although the p chart can be used to
monitor any proportion of interest.
Recall that in the earlier discus-
sions of the binomial distribution in
Section 5.3, the phrase proportion
of items of interest was used.
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CONTROL LIMITS FOR THE p CHART

(17.2)

For equal 

or, in general,

where

number of nonconforming items in subgroup i

sample (or subgroup) size for subgroup i

proportion of nonconforming items in subgroup i

number of subgroups selected

mean subgroup size

proportion of nonconforming items in the k subgroups combined

Any negative value for the LCL means that the LCL does not exist.

p =

n =

k =

pi =
Xi

ni
=

ni =

Xi =

n =
a

k

i=1
ni

k
 and p =

a
k

i=1
Xi
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ni

n = ni  and p =
a

k

i=1
pi

k

ni,

LCL = p - 3Ap11 - p2
n

UCL = p + 3Ap11 - p2
n

p ; 3Ap11 - p2
n

To show the application of the p chart, return to the Beachcomber Hotel scenario on
page 717. During the process improvement effort in the Measure phase of Six Sigma (see
Section 17.8), a nonconforming room was operationally defined as the absence of an
amenity or an appliance not in working order upon check-in. During the Analyze phase of
Six Sigma, data on the nonconformances were collected daily from a sample of 200 rooms
(stored in ). Table 17.1 on page 722 lists the number and proportion of nonconform-
ing rooms for each day in the four-week period.

For these data, and, because the are equal, 

Thus,

p =
a

k

i=1
pi

k
=

2.315

28
= 0.0827

ni = n = 200.nik = 28, a
k

i=1
pi = 2.315

Hotel1
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F I G U R E 1 7 . 2
Excel and Minitab p charts for the nonconforming hotel rooms

T A B L E 1 7 . 1

Nonconforming Hotel
Rooms at Check-in over 
28-Day Period

Day
(i)

Rooms
Studied (ni)

Rooms Not
Ready (Xi)

Proportion
( pi)

Day
(i)

Rooms
Studied (ni)

Rooms Not
Ready (Xi)

Proportion
( pi)

1 200 16 0.080 15 200 18 0.090
2 200 7 0.035 16 200 13 0.065
3 200 21 0.105 17 200 15 0.075
4 200 17 0.085 18 200 10 0.050
5 200 25 0.125 19 200 14 0.070
6 200 19 0.095 20 200 25 0.125
7 200 16 0.080 21 200 19 0.095
8 200 15 0.075 22 200 12 0.060
9 200 11 0.055 23 200 6 0.030

10 200 12 0.060 24 200 12 0.060
11 200 22 0.110 25 200 18 0.090
12 200 20 0.100 26 200 15 0.075
13 200 17 0.085 27 200 20 0.100
14 200 26 0.130 28 200 22 0.110

Using Equation (17.2),

so that

and

Figure 17.2 displays a p chart for the data of Table 17.1.

LCL = 0.0827 - 0.0584 = 0.0243

UCL = 0.0827 + 0.0584 = 0.1411

0.0827 ; 3A10.0827210.91732
200

Figure 17.2 shows a process in a state of statistical control, with the individual points
distributed around without any pattern and all the points within the control limits. Thus, any
improvement in the process of making rooms ready for guests must come from the reduction
of common cause variation. Such reductions require changes in the process. These changes are
the responsibility of management. Remember that improvements in quality cannot occur until
changes to the process itself are successfully implemented.

This example illustrates a situation in which the subgroup size does not vary. As a general
rule, as long as none of the subgroup sizes, differ from the mean subgroup size, by more thann,ni,

p



Table 17.2 indicates the number of medical sponges produced daily for a period of 32 days and
the number that are nonconforming (stored in ). Construct a control chart for these
data.

Sponge

EXAMPLE 17.1
Using the p Chart
for Unequal
Subgroup Sizes

17.2 Control Chart for the Proportion: The p Chart 723

of (see reference 9), you can use Equation (17.2) on page 721 to compute the control lim-
its for the p chart. If any subgroup size differs by more than of you use alternative for-
mulas for calculating the control limits (see references 9 and 13). To illustrate the use of the p chart
when the subgroup sizes are unequal, Example 17.1 studies the production of medical sponges.

n,;25%
n;25%

T A B L E 1 7 . 2

Medical Sponges
Produced and Number
Nonconforming over a
32-Day Period

Day
(i)

Sponges
Produced

(ni)

Nonconforming
Sponges

(Xi)
Proportion

( pi)
Day
(i)

Sponges
Produced

(ni)

Nonconforming
Sponges

(Xi)
Proportion

( pi)

1 690 21 0.030 17 575 20 0.035
2 580 22 0.038 18 610 16 0.026
3 685 20 0.029 19 596 15 0.025
4 595 21 0.035 20 630 24 0.038
5 665 23 0.035 21 625 25 0.040
6 596 19 0.032 22 615 21 0.034
7 600 18 0.030 23 575 23 0.040
8 620 24 0.039 24 572 20 0.035
9 610 20 0.033 25 645 24 0.037

10 595 22 0.037 26 651 39 0.060
11 645 19 0.029 27 660 21 0.032
12 675 23 0.034 28 685 19 0.028
13 670 22 0.033 29 671 17 0.025
14 590 26 0.044 30 660 22 0.033
15 585 17 0.029 31 595 24 0.040
16 560 16 0.029 32 600 16 0.027

SOLUTION For these data,

Thus, using Equation (17.2) on page 721,

so that

Thus,

 LCL = 0.034 - 0.022 = 0.012

 UCL = 0.034 + 0.022 = 0.056

= 0.034 ; 0.022

0.034 ; 3A10.034211 - 0.0342
622.69

p =
679

19,926
= 0.034

n =
19,926

32
= 622.69

a
k

i=1
Xi = 679

k = 32, a
k

i=1
ni = 19,926
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F I G U R E 1 7 . 3
Excel and Minitab p charts for the proportion of nonconforming medical sponges

Problems for Section 17.2
LEARNING THE BASICS
17.1 The following data were collected on nonconfor-
mances for a period of 10 days:

Figure 17.3 displays the Excel and Minitab control charts for the sponge data. Because
Minitab calculates new control limits when the subgroup size changes from one time period
(day) to another, the UCL and LCL appear as jagged lines in the Minitab chart.

From Figure 17.3, you can see that day 26, on which there were 39 nonconforming sponges
produced out of 651 sampled, is above the UCL. Management needs to determine the reason (i.e.,
root cause) for this special cause variation and take corrective action. Once actions are taken, you
can remove the data from day 26 and then construct and analyze a new control chart.

Day Sample Size Nonconformances

1 100 12
2 100 14
3 100 10
4 100 18
5 100 22
6 100 14
7 100 15
8 100 13
9 100 14

10 100 16

Day Sample Size Nonconformances

1 111 12
2 93 14
3 105 10
4 92 18
5 117 22
6 88 14
7 117 15
8 87 13
9 119 14

10 107 16

a. On what day is the proportion of nonconformances
largest? Smallest?

b. What are the LCL and UCL?
c. Are there any special causes of variation?

17.2 The following data were collected on nonconfor-
mances for a period of 10 days:

a. On what day is the proportion of nonconformances
largest? Smallest?

b. What are the LCL and UCL?
c. Are there any special causes of variation?

APPLYING THE CONCEPTS
17.3 A medical transcription service enters medical data
on patient files for hospitals. The service has the business
objective of improving the turnaround time (defined as the
time between sending data and the time the client receives
completed files). After studying the process, it was deter-
mined that turnaround time was increased by transmission
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errors. A transmission error was defined as data transmitted
that did not go through as planned and needed to be retrans-
mitted. For a period of 31 days, a sample of 125 transmis-
sions were randomly selected and evaluated for errors and
stored in . The following table presents the number
and proportion of transmissions with errors:

Transmit

Day
(i)

Number
of Errors

(Xi)

Proportion
of Errors

( pi)
Day
(i)

Number
of Errors

(Xi)

Proportion
of Errors

( pi)

1 6 0.048 17 4 0.032
2 3 0.024 18 6 0.048
3 4 0.032 19 3 0.024
4 4 0.032 20 5 0.040
5 9 0.072 21 1 0.008
6 0 0.000 22 3 0.024
7 0 0.000 23 14 0.112
8 8 0.064 24 6 0.048
9 4 0.032 25 7 0.056

10 3 0.024 26 3 0.024
11 4 0.032 27 10 0.080
12 1 0.008 28 7 0.056
13 10 0.080 29 5 0.040
14 9 0.072 30 0 0.000
15 3 0.024 31 3 0.024
16 1 0.008

a. Construct a p chart.
b. Is the process in a state of statistical control? Why?

17.4 The following data (stored in )
represent the findings from a study conducted at a

factory that manufactures film canisters. For 32 days, 500
film canisters were sampled and inspected. The following
table lists the number of defective film canisters (the
nonconforming items) for each day (the subgroup):

CanisterSELF
Test

Day
Number

Nonconforming Day
Number

Nonconforming

1 26 17 23
2 25 18 19
3 23 19 18
4 24 20 27
5 26 21 28
6 20 22 24
7 21 23 26
8 27 24 23
9 23 25 27

10 25 26 28
11 22 27 24
12 26 28 22
13 25 29 20
14 29 30 25
15 20 31 27
16 19 32 19

a. Construct a p chart.
b. Is the process in a state of statistical control? Why?

17.5 A hospital administrator has the business objective of
reducing the time to process patients’ medical records after
discharge. She determined that all records should be
processed within 5 days of discharge. Thus, any record not
processed within 5 days of a patient’s discharge is noncon-
forming. The administrator recorded the number of patients
discharged and the number of records not processed within
the 5-day standard for a 30-day period and stored in

.
a. Construct a p chart for these data.
b. Does the process give an out-of-control signal?

Explain.
c. If the process is out of control, assume that special causes

were subsequently identified and corrective action was
taken to keep them from happening again. Then eliminate
the data causing the out-of-control signals and recalcu-
late the control limits.

17.6 The bottling division of Sweet Suzy’s Sugarless Cola
maintains daily records of the occurrences of unacceptable
cans flowing from the filling and sealing machine. The data
in lists the number of cans filled and the number
of nonconforming cans for one month (based on a five-day
workweek).
a. Construct a p chart for the proportion of unacceptable

cans for the month. Does the process give an out-of-
control signal?

b. If you want to develop a process for reducing the propor-
tion of unacceptable cans, how should you proceed?

17.7 The manager of the accounting office of a large hos-
pital has the business objective of reducing the number of
incorrect account numbers entered into the computer sys-
tem. A subgroup of 200 account numbers is selected from
each day’s output, and each account number is inspected to
determine whether it is a nonconforming item. The results
for a period of 39 days are stored in .
a. Construct a p chart for the proportion of nonconforming

items. Does the process give an out-of-control signal?
b. Based on your answer in (a), if you were the manager of

the accounting office, what would you do to improve the
process of account number entry?

17.8 A regional manager of a telephone company is re-
sponsible for processing requests concerning additions,
changes, and deletions of telephone service. She forms a
service improvement team to look at the corrections to the
orders in terms of central office equipment and facilities
required to process the orders that are issued to service
requests. Data collected over a period of 30 days are stored
in .
a. Construct a p chart for the proportion of corrections.

Does the process give an out-of-control signal?
b. What should the regional manager do to improve the pro-

cessing of requests for changes in telephone service?

Telespc

Errorspc

Colaspc

MedRec
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17.3 The Red Bead Experiment: Understanding 
Process Variability

This chapter began with a discussion of common cause variation and special cause variation.
Now that you have studied the p chart, this section presents a famous parable, the red bead
experiment, to enhance your understanding of common cause and special cause variation. The
red bead experiment involves the selection of beads from a bowl that contains 4,000 beads.4 Un-
known to the participants in the experiment, 3,200 (80%) of the beads are white and 800 (20%)
are red. You can use several different scenarios for conducting the experiment. The one used here
begins with a facilitator (who will play the role of company supervisor) asking members of the
audience to volunteer for the jobs of workers (at least four are needed), inspectors (two are
needed), chief inspector (one is needed), and recorder (one is needed). A worker’s job consists of
using a paddle that has five rows of 10 bead-size holes to select 50 beads from the bowl of beads.

When the participants have been selected, the supervisor explains the jobs to them. The
job of the workers is to produce white beads because red beads are unacceptable to the
customers. Strict procedures are to be followed. Work standards call for the daily produc-
tion of exactly 50 beads by each worker (a strict quota system). Management has estab-
lished a standard that no more than 2 red beads (4%) per worker are to be produced on any
given day.

Each worker dips the paddle into the box of beads so that when it is removed, each of the
50 holes contains a bead. The worker carries the paddle to the two inspectors, who independ-
ently record the count of red beads. The chief inspector compares their counts and announces
the results to the audience. The recorder writes down the number and percentage of red beads
next to the name of the worker.

When all the people know their jobs, “production” can begin. Suppose that on the first
“day,” the number of red beads “produced” by the four workers (call them Alyson, David, Pe-
ter, and Sharyn) was 9, 12, 13, and 7, respectively. How should management react to the day’s
production when the standard says that no more than 2 red beads per worker should be pro-
duced? Should all the workers be reprimanded, or should only David and Peter be warned that
they will be fired if they don’t improve?

Suppose that production continues for an additional two days. Table 17.3 summarizes the
results for all three days.

4For information on how to pur-
chase such a bowl, visit the Light-
ning Calculator website, www.
qualitytng.com.

T A B L E 1 7 . 3

Red Bead Experiment
Results for Four Workers
over Three Days

DAY

WORKER 1 2 3 All Three Days

Alyson 9 (18%) 11 (22%) 6 (12%) 26 (17.33%)
David 12 (24%) 12 (24%) 8 (16%) 32 (21.33%)
Peter 13 (26%) 6 (12%) 12 (24%) 31 (20.67%)
Sharyn 7 (14%) 9 (18%) 8 (16%) 24 (16.0%)
All four workers 41 38 34 113
Mean 10.25 9.5 8.5 9.42
Percentage 20.5% 19% 17% 18.83%

From Table 17.3, on each day, some of the workers were above the mean and some below
the mean. On Day 1, Sharyn did best, but on Day 2, Peter (who had the worst record on Day 1)
was best, and on Day 3, Alyson was best. How can you explain all this variation? Using Equa-
tion (17.2) on page 721 to develop a p chart for these data,

k = 4 workers * 3 days = 12, n = 50, a
k

i=1
Xi = 113, and a

k

i=1
ni = 600

www.qualitytng.com
www.qualitytng.com
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P = 0.1883

F I G U R E 1 7 . 4
chart for the red bead

experiment
p

Thus,

so that

Thus,

Figure 17.4 represents the chart for the data of Table 17.3. In Figure 17.4, all the points
are within the control limits, and there are no patterns in the results. The differences between
the workers merely represent common cause variation inherent in an in-control process.

p

 LCL = 0.1883 - 0.1659 = 0.0224

 UCL = 0.1883 + 0.1659 = 0.3542

= 0.1883 ; 0.1659

= 0.1883 ; 3A0.188311 - 0.18832
50

p ; 3Ap11 - p2
n

p =
113

600
= 0.1883

The parable of the red beads has four morals:

• Variation is an inherent part of any process.
• Workers work within a process over which they have little control. It is the process that

primarily determines their performance.
• Only management can change the process.
• There will always be some workers above the mean and some workers below the mean.

Problems for Section 17.3
APPLYING THE CONCEPTS
17.9 In the red bead experiment, how do you think many
managers would have reacted after Day 1? Day 2? Day 3?

17.10 (Class Project) Obtain a version of the red bead
experiment for your class.

a. Conduct the experiment in the same way as described in
this section.

b. Remove 400 red beads from the bead bowl before begin-
ning the experiment. How do your results differ from
those in (a)? What does this tell you about the effect of
the process on the results?
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17.4 Control Chart for an Area of Opportunity: The c Chart
Recall that you use a chart for monitoring and analyzing the proportion of nonconforming
items. Nonconformities are defects or flaws in a product or service. To monitor and analyze
the number of nonconformities in an area of opportunity, you use a c chart. An area of op-
portunity is an individual unit of a product or service, or a unit of time, space, or area. Exam-
ples of “the number of nonconformities in an area of opportunity” would be the number of
flaws in a square foot of carpet, the number of typographical errors on a printed page, and the
number of hotel customers filing complaints in a given week.

Counting the number of nonconformities in an area of opportunity is unlike the process
used to prepare a chart in which you classify each unit as conforming or nonconforming.
The chart process fits the assumptions of a Poisson distribution (see Section 5.4). For
the Poisson distribution, the standard deviation of the number of nonconformities is the
square root of the mean number of nonconformities Assuming that the size of
each area of opportunity remains constant,5 you can compute the control limits for the num-
ber of nonconformities per area of opportunity using the observed mean number of
nonconformities as an estimate of Equation (17.3) defines the control limits for the
chart, which you use to monitor and analyze the number of nonconformities per area of
opportunity.

cl.

1l2.
c

p

p

CONTROL LIMITS FOR THE CHART

(17.3)

where

ci = number of nonconformities in unit i

k = number of units sampled

c =
a

k

i=1
ci

k

LCL = c - 31c

UCL = c + 31c

c ; 31c

c

5If the size of the unit varies, you
should use a chart instead of a
chart (see references 9, 13, and 19).

cu

To help study the hotel service quality in the Beachcomber Hotel scenario on page 717,
you can use a chart to monitor the number of customer complaints filed with the hotel. If
guests of the hotel are dissatisfied with any part of their stay, they are asked to file a
customer complaint form. At the end of each week, the number of complaints filed is
recorded. In this example, a complaint is a nonconformity, and the area of opportunity
is one week. Table 17.4 lists the number of complaints from the past 50 weeks (stored in

).
For these data,

Thus,

c =
312

50
= 6.24

k = 50 and a
k

i=1
ci = 312

Complaints

c
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T A B L E 1 7 . 4

Number of Complaints in
the Past 50 Weeks

Week
Number of 
Complaints Week

Number of 
Complaints Week

Number of 
Complaints

1 8 18 7 35 3
2 10 19 10 36 5
3 6 20 11 37 2
4 7 21 8 38 4
5 5 22 7 39 3
6 7 23 8 40 3
7 9 24 6 41 4
8 8 25 7 42 2
9 7 26 7 43 4

10 9 27 5 44 5
11 10 28 8 45 5
12 7 29 6 46 3
13 8 30 7 47 2
14 11 31 5 48 5
15 10 32 5 49 4
16 9 33 4 50 4
17 8 34 4

so that using Equation (17.3) on page 728,

Thus,

Therefore, the LCL does not exist.
Figure 17.5 displays the control chart for the complaint data of Table 17.4.

LCL = 6.24 - 7.494 6 0

UCL = 6.24 + 7.494 = 13.734

= 6.24 ; 7.494

= 6.24 ; 316.24

c ; 31c

F I G U R E 1 7 . 5
Excel and Minitab charts for hotel complaintsc
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LEARNING THE BASICS
17.11 The following data were collected on the number of
nonconformities per unit for 10 time periods:

Time
Nonconformities

per Unit Time
Nonconformities

per Unit

1 7 6 5
2 3 7 3
3 6 8 5
4 3 9 2
5 4 10 0

a. Construct the appropriate control chart and determine the
LCL and UCL.

b. Are there any special causes of variation?

17.12 The following data were collected on the number of
nonconformities per unit for 10 time periods:

Time
Nonconformities

per Unit Time
Nonconformities

per Unit

1 25 6 15
2 11 7 12
3 10 8 10
4 11 9 9
5 6 10 6

the number of dry-cleaned items that are returned for
rework per day. Records were kept for a four-week period
(the store is open Monday through Saturday), with the
results given in the following table and in the file

.Dryclean

Day
Items Returned

for Rework Day
Items Returned

for Rework

1 4 13 5
2 6 14 8
3 3 15 3
4 7 16 4
5 6 17 10
6 8 18 9
7 6 19 6
8 4 20 5
9 8 21 8

10 6 22 6
11 5 23 7
12 12 24 9

730 CHAPTER 17 Statistical Applications in Quality Management

The chart does not indicate any points outside the control limits. However, because there
are eight or more consecutive points that lie above the center line and there are also eight or
more consecutive points that lie below the center line, the process is out of control. There is a
clear pattern to the number of customer complaints over time. During the first half of the se-
quence, the number of complaints for almost all the weeks is greater than the mean number of
complaints, and the number of complaints for almost all the weeks in the second half are less
than the mean number of complaints. This change, which is an improvement, is due to a spe-
cial cause of variation. The next step is to investigate the process and determine the special
cause that produced this pattern. When identified, you then need to ensure that this becomes a
permanent improvement, not a temporary phenomenon. In other words, the source of the spe-
cial cause of variation must become part of the permanent ongoing process in order for the
number of customer complaints not to slip back to the high levels experienced in the first
25 weeks.

c

a. Construct the appropriate control chart and determine the
LCL and UCL.

b. Are there any special causes of variation?

APPLYING THE CONCEPTS
17.13 To improve service quality, the owner of a dry-
cleaning business has the business objective of reducing

a. Construct a chart for the number of items per day that
are returned for rework. Do you think the process is in a
state of statistical control?

b. Should the owner of the dry-cleaning store take action to
investigate why 12 items were returned for rework on
Day 12? Explain. Would your answer change if 20 items
were returned for rework on Day 12?

c. On the basis of the results in (a), what should the owner
of the dry-cleaning store do to reduce the number of
items per day that are returned for rework?

17.14 The branch manager of a savings bank
has recorded the number of errors of a particular

SELF
Test

c
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type that each of 12 tellers has made during the past year.
The results (stored in ) are as follows:Teller

Teller
Number
of Errors Teller

Number
of Errors

Alice 4 Mitchell 6
Carl 7 Nora 3
Gina 12 Paul 5
Jane 6 Salvador 4
Livia 2 Tripp 7
Marla 5 Vera 5

a. Do you think the bank manager will single out Gina for
any disciplinary action regarding her performance in the
past year?

b. Construct a chart for the number of errors committed
by the 12 tellers. Is the number of errors in a state of sta-
tistical control?

c. Based on the chart developed in (b), do you now think
that Gina should be singled out for disciplinary action
regarding her performance? Does your conclusion now
agree with what you expected the manager to do?

d. On the basis of the results in (b), what should the branch
manager do to reduce the number of errors?

17.15 Falls are one source of preventable hospital injury.
Although most patients who fall are not hurt, a risk of seri-
ous injury is involved. The data in represent the
number of patient falls per month over a 28-month period in
a 19-bed AIDS unit at a major metropolitan hospital.
a. Construct a chart for the number of patient falls per

month. Is the process of patient falls per month in a state
of statistical control?

b. What effect would it have on your conclusions if you
knew that the AIDS unit was started only one month prior
to the beginning of data collection?

c. Compile a list of factors that might produce special cause
variation in this problem?

17.16 A member of the volunteer fire department for Tren-
ton, Ohio, decided to apply the control chart methodology he
learned in his business statistics class to data collected by the
fire department. He was interested in determining whether
weeks containing more than the mean number of fire runs
were due to inherent, chance causes of variation, or if there
were special causes of variation such as increased arson,

c

PtFalls

c

c

severe drought, or holiday-related activities. The file
contains the number of fire runs made per week

(Sunday through Saturday) during a single year.
Source: Data extracted from The City of Trenton 2001 Annual Report,
Trenton, Ohio, February 21, 2002.

a. What is the mean number of fire runs made per week?
b. Construct a chart for the number of fire runs per week.
c. Is the process in a state of statistical control?
d. Weeks 15 and 41 experienced seven fire runs each. Are

these large values explainable by common causes, or
does it appear that special causes of variation occurred in
these weeks?

e. Explain how the fire department can use these data to
chart and monitor future weeks in real-time (i.e., on a
week-to-week basis)?

17.17 Rochester-Electro-Medical Inc. is a manufacturing
company based in Tampa, Florida, that produces medical
products. Management had the business objective of
improving the safety of the workplace and began a safety
sampling study. The following data (stored in )
represent the number of unsafe acts observed by the com-
pany safety director over an initial time period in which he
made 20 tours of the plant.

Safety

c

FireRuns

Tour
Number of 
Unsafe Acts Tour

Number of 
Unsafe Acts

1 10 11 2
2 6 12 8
3 6 13 7
4 10 14 6
5 8 15 6
6 12 16 11
7 2 17 13
8 1 18 9
9 23 19 6

10 3 20 9

Source: Data extracted from H. Gitlow, A. R. Berkins, and M. He,
“Safety Sampling: A Case Study,” Quality Engineering, 14 (2002),
405–419.

a. Construct a chart for the number of unsafe acts.
b. Based on the results of (a), is the process in a state of sta-

tistical control?
c. What should management do next to improve the

process?

c



CONTROL LIMITS FOR THE RANGE

(17.4)

where

k = number of subgroups selected

R =
a

k

i=1
Ri

k

LCL = R - 3R
d3

d2

UCL = R + 3R
d3

d2

R ; 3R
d3

d2

You can simplify the computations in Equation (17.4) by using the factor, equal to
and the factor, equal to to express the control limits (see

Table E.9), as shown in Equations (17.5a) and (17.5b).
1 + 31d3>d22,D41 - 31d3>d22,

D3
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17.5 Control Charts for the Range and the Mean
You use variables control charts to monitor and analyze a process when you have numerically
measured data. Common numerical variables include time, money, and weight. Because numer-
ical variables provide more information than categorical data, such as the proportion of noncon-
forming items, variables control charts are more sensitive than the chart in detecting special
cause variation. Variables charts are typically used in pairs, with one chart monitoring the vari-
ability in a process and the other monitoring the process mean. You must examine the chart that
monitors variability first because if it indicates the presence of out-of-control conditions, the in-
terpretation of the chart for the mean will be misleading. Although businesses currently use
several alternative pairs of charts (see references 9, 13, and 19), this book considers only the
control charts for the range and the mean.

The R Chart
You can use several different types of control charts to monitor the variability in a numerically
measured characteristic of interest. The simplest and most common is the control chart for the
range, the chart. You use the range chart only when the sample size or subgroup is 10 or
less. If the sample size is greater than 10, a standard deviation chart is preferable (see
references 9, 13, and 19). Because sample sizes of 5 or less are typically used in many applica-
tions, the standard deviation chart is not illustrated in this book. An chart enables you to
determine whether the variability in a process is in control or whether changes in the amount
of variability are occurring over time. If the process range is in control, then the amount of
variation in the process is consistent over time, and you can use the results of the chart to
develop the control limits for the mean.

To develop control limits for the range, you need an estimate of the mean range and the stan-
dard deviation of the range. As shown in Equation (17.4), these control limits depend on two con-
stants, the factor, which represents the relationship between the standard deviation and the
range for varying sample sizes, and the factor, which represents the relationship between the
standard deviation and the standard error of the range for varying sample sizes. Table E.9 con-
tains values for these factors. Equation (17.4) defines the control limits for the chart.R

d3

d2

R

R

R

p
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COMPUTING CONTROL LIMITS FOR THE RANGE

(17.5a)

(17.5b)LCL = D3 R

UCL = D4 R

To illustrate the chart, return to the Beachcomber Hotel scenario on page 717. As part
of the Measure phase of a Six Sigma project (see Section 17.8), the amount of time to deliver
luggage was operationally defined as the time from when the guest completes check-in
procedures to the time the luggage arrives in the guest’s room. During the Analyze phase of the
Six Sigma project, data were recorded over a four-week period (see the file ).
Subgroups of five deliveries were selected from the evening shift on each day. Table 17.5
summarizes the results for all 28 days.

Hotel2

R

T A B L E 1 7 . 5

Luggage Delivery Times
and Subgroup Mean and
Range for 28 Days

Day Luggage Delivery Times (in minutes) Mean Range

1 6.7 11.7 9.7 7.5 7.8 8.68 5.0
2 7.6 11.4 9.0 8.4 9.2 9.12 3.8
3 9.5 8.9 9.9 8.7 10.7 9.54 2.0
4 9.8 13.2 6.9 9.3 9.4 9.72 6.3
5 11.0 9.9 11.3 11.6 8.5 10.46 3.1
6 8.3 8.4 9.7 9.8 7.1 8.66 2.7
7 9.4 9.3 8.2 7.1 6.1 8.02 3.3
8 11.2 9.8 10.5 9.0 9.7 10.04 2.2
9 10.0 10.7 9.0 8.2 11.0 9.78 2.8

10 8.6 5.8 8.7 9.5 11.4 8.80 5.6
11 10.7 8.6 9.1 10.9 8.6 9.58 2.3
12 10.8 8.3 10.6 10.3 10.0 10.00 2.5
13 9.5 10.5 7.0 8.6 10.1 9.14 3.5
14 12.9 8.9 8.1 9.0 7.6 9.30 5.3
15 7.8 9.0 12.2 9.1 11.7 9.96 4.4
16 11.1 9.9 8.8 5.5 9.5 8.96 5.6
17 9.2 9.7 12.3 8.1 8.5 9.56 4.2
18 9.0 8.1 10.2 9.7 8.4 9.08 2.1
19 9.9 10.1 8.9 9.6 7.1 9.12 3.0
20 10.7 9.8 10.2 8.0 10.2 9.78 2.7
21 9.0 10.0 9.6 10.6 9.0 9.64 1.6
22 10.7 9.8 9.4 7.0 8.9 9.16 3.7
23 10.2 10.5 9.5 12.2 9.1 10.30 3.1
24 10.0 11.1 9.5 8.8 9.9 9.86 2.3
25 9.6 8.8 11.4 12.2 9.3 10.26 3.4
26 8.2 7.9 8.4 9.5 9.2 8.64 1.6
27 7.1 11.1 10.8 11.0 10.2 10.04 4.0
28 11.1 6.6 12.0 11.5 9.7 10.18 5.4

Sums: 265.38 97.5

For the data in Table 17.5,

For from Table E.9, and Then, using Equation (17.5),

and the LCL does not exist.

UCL = D4 R = 12.114213.4822 = 7.36

D4 = 2.114.D3 = 0n = 5,

k = 28, a
k

i=1
Ri = 97.5, R =

a
k

i=1
Ri

k
=

97.5

28
= 3.482



Figure 17.6 displays the chart for the luggage delivery times. Figure 17.6 does not
indicate any individual ranges outside the control limits or any obvious patterns. Therefore,
you conclude that the R chart is in control.

R

CONTROL LIMITS FOR THE CHART

(17.6)

where

sample mean of n observations at time i

range of n observations at time i

number of subgroupsk =
Ri =
Xi =

X =
a

k

i=1
X i

k
, R =

a
k

i=1
Ri

k

LCL = X - 3
R

d21n

UCL = X + 3
R

d21n

X ; 3
R

d21n

X

6 is used to estimate the stan-
dard deviation of the individual
items in the population, and

is used to estimate the
standard error of the mean.
R>d21n

R>d2
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F I G U R E 1 7 . 6
Excel and Minitab R charts for the luggage delivery times (Minitab includes a companion chart, discussed in the
next subsection, with every R chart it creates.)

X

The Chart
When you have determined from the R chart that the range is in control, you examine the
control chart for the process mean, the chart.

The control chart for uses subgroups collected in consecutive periods of time. Each
subgroup contains items. You calculate for each subgroup and plot these values on the
control chart. To compute control limits for the mean, you need to compute the mean of the sub-
group means (called double bar and denoted and the estimate of the standard error of the
mean The estimate of the standard error of the mean is a function of the

factor, which represents the relationship between the standard deviation and the range for
varying sample sizes.6 Equations (17.6) and (17.7) define the control limits for the chart.X
d2

1denoted R>1d21n22. XX

XXn
kkX

X

X
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You can simplify the computations in Equation (17.6) by utilizing the factor given in
Table E.9, equal to Equations (17.7a) and (17.7b) show the simplified control limits.3>d21n.

A2

COMPUTING CONTROL LIMITS FOR THE MEAN, USING THE FACTOR

(17.7a)

(17.7b) LCL = X - A2 R

 UCL = X + A2 R

A2

From Table 17.5 on page 733,

so that

Using Equations (17.7a) and (17.7b), since from Table E.9, so that

Figure 17.7 displays the Excel chart for the luggage delivery time data. (The Minitab
chart can be seen in Figure 17.6 on page 734.)

XX

LCL = 9.478 - 10.577213.4822 = 9.478 - 2.009 = 7.469

UCL = 9.478 + 10.577213.4822 = 9.478 + 2.009 = 11.487

A2 = 0.577,n = 5,

R =
a

k

i=1
Ri

k
=

97.5

28
= 3.482

X =
a

k

i=1
X i

k
=

265.38

28
= 9.478

k = 28, a
k

i=1
Xi = 265.38, a

k

i=1
Ri = 97.5

F I G U R E 1 7 . 7
Excel chart for the
luggage delivery times

X

Figure 17.7 (or the Minitab results shown in Figure 17.6) does not reveal any points outside
the control limits, and there are no obvious patterns. Although there is a considerable amount of
variability among the 28 subgroup means, because both the chart and the chart are in con-
trol, you know that the luggage delivery process is in a state of statistical control. If you want to
reduce the variation or lower the mean delivery time, you need to change the process.

XR



Day Mean Range Day Mean Range

1 48.03 0.29 6 48.07 0.22
2 48.08 0.43 7 47.99 0.16
3 47.90 0.16 8 48.04 0.15
4 48.03 0.13 9 47.99 0.46
5 47.81 0.32 10 48.04 0.15

Day Mean Range Day Mean Range

1 13.6 3.5 6 12.9 4.8
2 14.3 4.1 7 17.3 4.5
3 15.3 5.0 8 13.9 2.9
4 12.6 2.8 9 12.6 3.8
5 11.8 3.7 10 15.2 4.6

Day Time (Minutes)

1 7.2 8.4 7.9 4.9
2 5.6 8.7 3.3 4.2
3 5.5 7.3 3.2 6.0
4 4.4 8.0 5.4 7.4
5 9.7 4.6 4.8 5.8
6 8.3 8.9 9.1 6.2
7 4.7 6.6 5.3 5.8
8 8.8 5.5 8.4 6.9
9 5.7 4.7 4.1 4.6

10 3.7 4.0 3.0 5.2
11 2.6 3.9 5.2 4.8
12 4.6 2.7 6.3 3.4
13 4.9 6.2 7.8 8.7
15 7.1 5.8 6.9 7.0
16 6.7 6.9 7.0 9.4
17 5.5 6.3 3.2 4.9
18 4.9 5.1 3.2 7.6
19 7.2 8.0 4.1 5.9
20 6.1 3.4 7.2 5.9

a. Construct control charts for the range and the mean.
b. Is the process in control?

17.23 The manager of a warehouse for a telephone
company is involved in a process that receives expensive
circuit boards and returns them to central stock so that they
can be reused at a later date. Speedy processing of these
circuit boards is critical in providing good service to
customers and reducing capital expenditures. The data in

represent the number of circuit boards processed
per day by a subgroup of five employees over a 30-day
period.
a. Construct control charts for the range and the mean.
b. Is the process in control?

17.24 An article in the Mid-American Journal of Business
presents an analysis for a spring water bottling operation.
One of the characteristics of interest is the amount of
magnesium, measured in parts per million (ppm), in the
water. The data in the table on page 737 (stored in )
represent the magnesium levels from 30 subgroups of four
bottles collected over a 30-hour period:
a. Construct a control chart for the range.
b. Construct a control chart for the mean.
c. Is the process in control?

SpWater

Warehse
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Problems for Section 17.5
LEARNING THE BASICS
17.18 For subgroups of what is the value of
a. the factor?
b. the factor?
c. the factor?
d. the factor?
e. the factor?

17.19 For subgroups of what is the value of
a. the factor?
b. the factor?
c. the factor?
d. the factor?
e. the factor?

17.20 The following summary of data is for subgroups of
for a 10-day period:n = 3

A2

D4

D3

d3

d2

n = 3,

A2

D4

D3

d3

d2

n = 4,

(one at each 15-minute interval during the hour), and the time,
in minutes, is measured from when each customer enters the
line to when he or she reaches the teller window. The results
over a four-week period, stored in , are as follows:BankTime

a. Compute control limits for the range.
b. Is there evidence of special cause variation in (a)?
c. Compute control limits for the mean.
d. Is there evidence of special cause variation in (c)?

17.21 The following summary of data is for subgroups of
for a 10-day period:n = 4

a. Compute control limits for the range.
b. Is there evidence of special cause variation in (a)?
c. Compute control limits for the mean.
d. Is there evidence of special cause variation in (c)?

APPLYING THE CONCEPTS
17.22 The manager of a branch of a local bank has
the business objective of reducing the waiting times

of customers for teller service during the 12:00 noon-to-
1:00 P.M. lunch hour. A subgroup of four customers is selected

SELF
Test



17.6 Process Capability 737

Bottles

Hour 1 2 3 4

1 19.91 19.62 19.15 19.85
2 20.46 20.44 20.34 19.61
3 20.25 19.73 19.98 20.32
4 20.39 19.43 20.36 19.85
5 20.02 20.02 20.13 20.34
6 19.89 19.77 20.92 20.09
7 19.89 20.45 19.44 19.95
8 20.08 20.13 20.11 19.32
9 20.30 20.42 20.68 19.60

10 20.19 20.00 20.23 20.59
11 19.66 21.24 20.35 20.34
12 20.30 20.11 19.64 20.29
13 19.83 19.75 20.62 20.60
14 20.27 20.88 20.62 20.40
15 19.98 19.02 20.34 20.34
16 20.46 19.97 20.32 20.83
17 19.74 21.02 19.62 19.90
18 19.85 19.26 19.88 20.20
19 20.77 20.58 19.73 19.48
20 20.21 20.82 20.01 19.93
21 20.30 20.09 20.03 20.13
22 20.48 21.06 20.13 20.42
23 20.60 19.74 20.52 19.42
24 20.20 20.08 20.32 19.51
25 19.66 19.67 20.26 20.41
26 20.72 20.58 20.71 19.99
27 19.77 19.40 20.49 19.83
28 19.99 19.65 19.41 19.58
29 19.44 20.15 20.17 20.76
30 20.03 19.96 19.86 19.91
Source: Data extracted from Susan K. Humphrey and Timothy
C. Krehbiel, “Managing Process Capability,” The Mid-American
Journal of Business, 14 (Fall 1999), 7–12.

in subgroups of three bolts of cloth over a 25-hour
period.
a. Construct a control chart for the range.
b. Construct a control chart for the mean.
c. Is the process in control?

17.26 The director of radiology at a large metropolitan
hospital has the business objective of improving the
scheduling in the radiology facilities. On a typical day, 250
patients are transported to the radiology department for
treatment or diagnostic procedures. If patients do not reach
the radiology unit at their scheduled times, backups occur,
and other patients experience delays. The time it takes to
transport patients to the radiology unit is operationally de-
fined as the time between when the transporter is assigned
to the patient and when the patient arrives at the radiology
unit. A sample of patients was selected each day for
20 days, and the time to transport each patient (in minutes)
was determined, with the results stored in .
a. Construct control charts for the range and the mean.
b. Is the process in control?

17.27 A filling machine for a tea bag manufacturer produces
approximately 170 tea bags per minute. The process manager
monitors the weight of the tea placed in individual bags.
A subgroup of tea bags is taken every 15 minutes for
25 consecutive time periods. The results are stored in .
a. What are some of the sources of common cause variation

that might be present in this process?
b. What problems might occur that would result in special

causes of variation?
c. Construct control charts for the range and the mean.
d. Is the process in control?

17.28 A manufacturing company makes brackets for
bookshelves. The brackets provide critical structural support
and must have a 90-degree bend degree. Measurements
of the bend of the brackets were taken at 18 different times.
Five brackets were sampled at each time. The data are stored
in .
a. Construct control charts for the range and the mean.
b. Is the process in control?

Angle

;1

Tea3

n = 4

Transport

n = 4

17.6 Process Capability
Often, it is necessary to analyze the amount of common cause variation present in an in-
control process. Is the common cause variation small enough to satisfy customers with the
product or service? Or is the common cause variation so large that there are too many dissatis-
fied customers, and a process change is needed?

Analyzing the capability of a process is a way to answer these questions. Process capabil-
ity is the ability of a process to consistently meet specified customer-driven requirements.
There are many methods available for analyzing and reporting process capability (see
reference 3). This section begins with a method for estimating the percentage of products or
services that will satisfy the customer. Later in the section, capability indices are introduced.

Customer Satisfaction and Specification Limits
Quality is defined by the customer. A customer who believes that a product or service has met or
exceeded his or her expectations will be satisfied. The management of a company must listen to

17.25 The data in represent the tensile
strengths of bolts of cloth. The data were collected

Tensile



the customer and translate the customer’s needs and expectations into easily measured critical-
to-quality (CTQ) variables. Management then sets specification limits for these CTQ variables.

Specification limits are technical requirements set by management in response to customers’
needs and expectations. The upper specification limit (USL) is the largest value a CTQ variable
can have and still conform to customer expectations. Likewise, the lower specification limit
(LSL) is the smallest value a CTQ variable can have and still conform to customer expectations.

For example, a soap manufacturer understands that customers expect their soap to produce
a certain amount of lather. The customer can become dissatisfied if the soap produces too
much or too little lather. Product engineers know that the level of free fatty acids in the soap
controls the amount of lather. Thus, the process manager, with input from the product
engineers, sets both a USL and a LSL for the amount of free fatty acids in the soap.

As an example of a case in which only a single specification limit is involved, consider the
Beachcomber Hotel scenario on page 717. Because customers want their bags delivered as
quickly as possible, hotel management sets a USL for the time required for delivery. In this
case, there is no LSL. In both the luggage delivery time and soap examples, specification
limits are customer-driven requirements placed on a product or a service. If a process
consistently meets these requirements, the process is capable of satisfying the customer.

One way to analyze the capability of a process is to estimate the percentage of products or
services that are within specifications. To do this, you must have an in-control process because
an out-of-control process does not allow you to predict its capability. If you are dealing with
an out-of-control process, you must first identify and eliminate the special causes of variation
before performing a capability analysis. Out-of-control processes are unpredictable, and,
therefore, you cannot conclude that such processes are capable of meeting specifications or
satisfying customer expectations in the future. In order to estimate the percentage of product
or service within specifications, first you must estimate the mean and standard deviation of
the population of all values, the CTQ variable of interest for the product or service. The esti-
mate for the mean of the population is the mean of all the sample means [see Equation
(17.6) on page 734]. The estimate of the standard deviation of the population is divided by

You can use the and from in-control and charts, respectively. You need to find
the appropriate value in Table E.9.

Assuming that the process is in control and is approximately normally distributed, you
can use Equation (17.8) to estimate the probability that a process outcome is within
specifications. (If your data are not approximately normally distributed, see reference 3 for an
alternative approach.)

X
d2

RXRXd2.
R

X ,
X

ESTIMATING THE CAPABILITY OF A PROCESS
For a CTQ variable with an LSL and a USL:

(17.8a)

For a CTQ variable with only a USL:

(17.8b)

For a CTQ variable with only an LSL:

(17.8c)

where is a standardized normal random variableZ

= PaLSL - X

R>d2
6 Zb

P1An outcome will be within specifications2 = P1LSL 6 X2

= PaZ 6
USL - X

R>d2
b

P1An outcome will be within specifications2 = P1X 6 USL2

= PaLSL - X

R>d2
6 Z 6

USL - X

R>d2
b

P1An outcome will be within specifications2 = P1LSL 6 X 6 USL2
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In Section 17.5, you determined that the luggage delivery process was in control. Suppose
that the hotel management has instituted a policy that 99% of all luggage deliveries must be
completed in 14 minutes or less. From the summary computations on page 735:

and from Table E.9,

Using Equation (17.8b),

Using Table E.2,

Thus, you estimate that 99.874% of the luggage deliveries will be made within the specified
time. The process is capable of meeting the 99% goal set by the hotel management.

Capability Indices
A common approach in business is to use capability indices to report the capability of a
process. A capability index is an aggregate measure of a process’s ability to meet specifica-
tion limits. The larger the value of a capability index, the more capable the process is of meet-
ing customer requirements. Equation (17.9) defines the most commonly used index.Cp,

P1Z 6 3.022 = 0.99874

= P1Z 6 3.022
= PaZ 6

14 - 9.478

3.482>2.326
b

P1Delivery is made within specifications2 = P1X 6 142

d2 = 2.326

n = 5 X = 9.478 R = 3.482

Cp

(17.9)

=
Specification spread

Process spread

Cp =
USL - LSL

61R>d22

The numerator in Equation (17.9) represents the distance between the upper and lower
specification limits, referred to as the specification spread. The denominator,
represents a 6 standard deviation spread in the data (the mean standard deviations),
referred to as the process spread. (Recall from Chapter 6 that approximately 99.73% of the
values from a normal distribution fall in the interval from the mean standard deviations.)
You want the process spread to be small in comparison to the specification spread so that the
vast majority of the process output falls within the specification limits. Therefore, the larger
the value of the better the capability of the process.

is a measure of process potential, not of actual performance, because it does not
consider the current process mean. A value of 1 indicates that if the process mean could be
centered (i.e., equal to the halfway point between the USL and LSL), approximately 99.73%
of the values would be inside the specification limits. A value greater than 1 indicates that a
process has the potential of having more than 99.73% of its outcomes within specifications. A

value less than 1 indicates that the process is not very capable of meeting customer require-
ments, for even if the process is perfectly centered, fewer than 99.73% of the process outcomes
will be within specifications. Historically, many companies required a greater than or equal
to 1. Now that the global economy has become more quality conscious, many companies are
requiring a as large as 1.33, 1.5, or, for companies adopting Six Sigma management, 2.0.

To illustrate the calculation and interpretation of the index, suppose a soft-drink pro-
ducer bottles its beverage into 12-ounce bottles. The LSL is 11.82 ounces, and the USL is

Cp

Cp

Cp

Cp

Cp

Cp

Cp

Cp,

;3

;3
61R>d22,



12.18 ounces. Each hour, four bottles are selected, and the range and the mean are plotted on
control charts. At the end of 24 hours, the capability of the process is studied. Suppose that the
control charts indicate that the process is in control and the following summary calculations
were recorded on the control charts:

To calculate the index, assuming that the data are normally distributed, from Table E.9,
for Using Equation (17.9),

Because the index is greater than 1, the bottling process has the potential to fill more than
99.73% of the bottles within the specification limits.

In summary, the index is an aggregate measure of process potential. The larger the
value of the more potential the process has of satisfying the customer. In other words, a
large indicates that the current amount of common cause variation is small enough to con-
sistently produce items within specifications. For a process to reach its full potential, the
process mean needs to be at or near the center of the specification limits. Capability indices
that measure actual process performance are considered next.

CPL, CPU, and 
To measure the capability of a process in terms of actual process performance, the most com-
mon indices are CPL, CPU, and Equation (17.10) defines CPL and CPU.Cpk.

Cpk

Cp

Cp,
Cp

Cp

=
12.18 - 11.82

610.10>2.0592 = 1.24

Cp =
USL - LSL

61R>d22

n = 4.d2 = 2.059
Cp

R = 0.10X = 12.02n = 4

CPL AND CPU

(17.10a)

(17.10b)CPU =
USL - X

31R>d22

CPL =
X - LSL

31R>d22

Because the process mean is used in the calculation of CPL and CPU, these indices meas-
ure process performance—unlike which measures only potential. A value of CPL (or CPU)
equal to 1.0 indicates that the process mean is 3 standard deviations away from the LSL (or
USL). For CTQ variables with only an LSL, the CPL measures the process performance. For
CTQ variables with only a USL, the CPU measures the process performance. In either case,
the larger the value of the index, the greater the capability of the process.

In the Beachcomber Hotel scenario, the hotel management has a policy that luggage
deliveries are to be made in 14 minutes or less. Thus, the CTQ variable delivery time has a USL
of 14, and there is no LSL. Because you previously determined that the luggage delivery process
was in control, you can now compute the CPU. From the summary computations on page 735,

And, from Table E.9, Then, using Equation (17.10b),

The capability index for the luggage delivery CTQ variable is 1.01. Because this value is
slightly more than 1, the USL is slightly more than 3 standard deviations above the mean. To
increase CPU even farther above 1.00 and therefore increase customer satisfaction, you need

CPU =
USL - X

31R>d22 =
14 - 9.478

313.482>2.3262 = 1.01

d2 = 2.326.

X = 9.478 R = 3.482

Cp,
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to investigate changes in the luggage delivery process. To study a process that has a CPL and a
CPU, see the bottling process discussed in Example 17.2.

In the soft-drink bottle-filling process described on pages 739–740, the following information
was provided:

Compute the CPL and CPU for these data.

SOLUTION You compute the capability indices CPL and CPU by using Equations (17.10a)
and (17.10b):

Both the CPL and CPU are greater than 1, indicating that the process mean is more than 3
standard deviations away from both the LSL and USL. Because the CPU is less than the CPL,
you know that the mean is closer to the USL than to the LSL.

=
12.18 - 12.02

310.10>2.0592 = 1.10

CPU =
USL - X

31R>d22

=
12.02 - 11.82

310.10>2.0592 = 1.37

CPL =
X - LSL

31R>d22

d2 = 2.059USL = 12.18LSL = 11.82R = 0.10X = 12.02n = 4

EXAMPLE 17.2
Computing CPL
and CPU for the
Bottling Process

The capability index, [shown in Equation (17.11)], measures actual process perform-
ance for quality characteristics with two-sided specification limits. is equal to the value of
either the CPL or CPU, whichever is smaller.

Cpk

Cpk

Cpk

(17.11)Cpk = MIN3CPL, CPU4

A value of 1 for indicates that the process mean is 3 standard deviations away from the
closest specification limit. If the characteristic is normally distributed, then a value of 1 indi-
cates that at least 99.73% of the current output is within specifications. As with all other capa-
bility indices, the larger the value of the better. Example 17.3 illustrates the use of Cpk.Cpk,

Cpk

The soft-drink producer in Example 17.2 requires the bottle filling process to have a
greater than or equal to 1. Calculate the index.

SOLUTION In Example 17.2, and Using Equation (17.11):

The index is greater than 1, indicating that the actual process performance exceeds the
company’s requirement. More than 99.73% of the bottles contain between 11.82 and
12.18 ounces.

Cpk

= MIN31.37, 1.104 = 1.10

Cpk = MIN3CPL, CPU4
CPU = 1.10.CPL = 1.37

Cpk

CpkEXAMPLE 17.3
Computing for
the Bottling
Process

Cpk



Problems for Section 17.6
LEARNING THE BASICS
17.29 For an in-control process with subgroup data

and find the estimate of
a. the population mean of all values.
b. the population standard deviation of all values.

17.30 For an in-control process with subgroup data
and compute the percentage

of outcomes within specifications if
a. and
b. and
c. and there is no USL.
d. and there is no LSL.

17.31 For an in-control process with subgroup data
and compute the CPL,

CPU, and if
a. and
b. and

APPLYING THE CONCEPTS
17.32 Referring to the data of Problem 17.24
on page 736, stored in , the researchers

stated, “Some of the benefits of a capable process are
increased customer satisfaction, increased operating
efficiencies, and reduced costs.” To illustrate this point,
the authors presented a capability analysis for a spring
water bottling operation. One of the CTQ variables is
the amount of magnesium, measured in parts per
million (ppm), in the water. The LSL and USL for the
level of magnesium in a bottle are 18 ppm and 22 ppm,
respectively.
a. Estimate the percentage of bottles that are within specifi-

cations.
b. Compute the CPL, CPU, and Cpk.Cp,

SpWater
SELF
Test

USL = 107.5.LSL = 93
USL = 102.LSL = 98

Cpk

Cp,R = 3.386,n = 3, X = 100,

USL = 110
LSL = 93.8

USL = 107.5.LSL = 93
USL = 102.LSL = 98

R = 3.386,n = 3, X = 100,

X
X

R = 2,n = 4, X = 20,

17.33 Refer to the data in Problem 17.25 on page 737
concerning the tensile strengths of bolts of cloth (stored in

). There is no USL for tensile strength, and the LSL
is 13.
a. Estimate the percentage of bolts that are within

specifications.
b. Calculate the and CPL.

17.34 Refer to Problem 17.27 on page 737 concerning a
filling machine for a tea bag manufacturer (data stored in

). In that problem, you should have concluded that the
process is in control. The label weight for this product is 5.5
grams, the LSL is 5.2 grams, and the USL is 5.8 grams.
Company policy states that at least 99% of the tea bags pro-
duced must be inside the specifications in order for the
process to be considered capable.
a. Estimate the percentage of the tea bags that are inside the

specification limits. Is the process capable of meeting the
company policy?

b. If management implemented a new policy stating that
99.7% of all tea bags are required to be within the specifica-
tions, is this process capable of reaching that goal? Explain.

17.35 Refer to Problem 17.22 on page 736 concerning
waiting time for customers at a bank (data stored in

). Suppose management has set a USL of five
minutes on waiting time and specified that at least 99% of
the waiting times must be less than five minutes in order for
the process to be considered capable.
a. Estimate the percentage of the waiting times that are in-

side the specification limits. Is the process capable of
meeting the company policy?

b. If management implemented a new policy, stating that
99.7% of all waiting times are required to be within spec-
ifications, is this process capable of reaching that goal?
Explain.

Banktime

Tea3

Cp

Tensile

17.7 Total Quality Management
An increased interest in improving the quality of products and services in the United States oc-
curred as a reaction to improvements of Japanese industry that began as early as 1950. Individ-
uals such as W. Edwards Deming, Joseph Juran, and Kaoru Ishikawa developed an approach
that focuses on continuous improvement of products and services through an increased empha-
sis on statistics, process improvement, and optimization of the total system. This approach,
widely known as total quality management (TQM), is characterized by these themes:

• The primary focus is on process improvement.
• Most of the variation in a process is due to the system and not the individual.
• Teamwork is an integral part of a quality management organization.
• Customer satisfaction is a primary organizational goal.
• Organizational transformation must occur in order to implement quality management.
• Fear must be removed from organizations.
• Higher quality costs less, not more, but requires an investment in training.
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Act

DoStudy

Plan
F I G U R E 1 7 . 8
Shewhart–Deming cycle

In the 1980s, the federal government of the United States increased its efforts to encour-
age the improvement of quality in American business. Congress passed the Malcolm Baldrige
National Improvement Act of 1987 and began awarding the Malcolm Baldrige Award to com-
panies making the greatest strides in improving quality and customer satisfaction. Deming
became a prominent consultant to many Fortune 500 companies, including Ford and Procter &
Gamble. Many companies adopted some or all the basic themes of TQM.

Today, quality improvement systems have been implemented in many organizations world-
wide. Although most organizations no longer use the name TQM, the underlying philosophy
and statistical methods used in today’s quality improvement systems are consistent with TQM,
as reflected by Deming’s 14 points for management:

1. Create constancy of purpose for improvement of product and service.
2. Adopt the new philosophy.
3. Cease dependence on inspection to achieve quality.
4. End the practice of awarding business on the basis of price tag alone. Instead, minimize

total cost by working with a single supplier.
5. Improve constantly and forever every process for planning, production, and service.
6. Institute training on the job.
7. Adopt and institute leadership.
8. Drive out fear.
9. Break down barriers between staff areas.

10. Eliminate slogans, exhortations, and targets for the workforce.
11. Eliminate numerical quotas for the workforce and numerical goals for management.
12. Remove barriers that rob people of pride of workmanship. Eliminate the annual rating or

merit system.
13. Institute a vigorous program of education and self-improvement for everyone.
14. Put everyone in the company to work to accomplish the transformation.

Points 1, 2, 5, 7, and 14 focus on the need for organizational transformation and the re-
sponsibility of top management to assert leadership in committing to the transformation. With-
out this commitment, any improvements obtained will be limited.

One aspect of the improvement process is illustrated by the Shewhart–Deming cycle,
shown in Figure 17.8. The Shewhart–Deming cycle represents a continuous cycle of “plan, do,
study, and act.” The first step, planning, represents the initial design phase for planning a change
in a manufacturing or service process. This step involves teamwork among individuals from dif-
ferent areas within an organization. The second step, doing, involves implementing the change,
preferably on a small scale. The third step, studying, involves analyzing the results, using statis-
tical methods to determine what was learned. The fourth step, acting, involves the acceptance of
the change, its abandonment, or further study of the change under different conditions.

Point 3, cease dependence on inspection to achieve quality, implies that any inspection
whose purpose is to improve quality is too late because the quality is already built into the
product. It is better to focus on making it right the first time. Among the difficulties involved
in inspection (besides high costs) are the failure of inspectors to agree on the operational defi-
nitions for nonconforming items and the problem of separating good and bad items. The fol-
lowing example illustrates the difficulties inspectors face.

Suppose your job involves proofreading the sentence in Figure 17.9, with the objective of
counting the number of occurrences of the letter F. Perform this task and record the number of
occurrences of the letter F that you discover.



People usually see either three Fs or six Fs. The correct number is six Fs. The number you
see depends on the method you use to examine the sentence. You are likely to find three Fs if
you read the sentence phonetically and six Fs if you count the number of Fs carefully. If such
a simple process as counting Fs leads to inconsistency of inspectors’ results, what will happen
when a much more complicated process fails to provide clear operational definitions?

Point 4, end the practice of awarding business on the basis of price tag alone, focuses on
the idea that there is no real long-term meaning to price without knowledge of the quality of
the product. In addition, minimizing the number of entities in the supply chain will reduce the
variation involved.

Points 6 and 13 refer to training and reflect the needs of all employees. Continuous learn-
ing is critical for quality improvement within an organization. In particular, management needs
to understand the differences between special causes and common causes of variation so that
proper action is taken in each circumstance.

Points 8 through 12 relate to the evaluation of employee performance. Deming believed
that an emphasis on targets and exhortations places an improper burden on the workforce.
Workers cannot produce beyond what the system allows (as illustrated in the red bead experi-
ment in Section 17.3). It is management’s job to improve the system, not to raise the expecta-
tions on workers beyond the system’s capability.

Although Deming’s points are thought provoking, some have criticized his approach for lack-
ing a formal, objective accountability (see reference 12). Many managers of large organizations,
used to seeing financial analyses of policy changes, need a more prescriptive approach.

FINISHED FILES ARE THE RESULT
OF YEARS OF SCIENTIFIC
STUDY COMBINED WITH THE
EXPERIENCE OF MANY YEARS
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F I G U R E 1 7 . 9
An example of a
proofreading process

Source: Adapted from W. W.
Scherkenbach, The Deming
Route to Quality and
Productivity: Road Maps and
Roadblocks (Washington, DC:
CEEP Press, 1987).

17.8 Six Sigma
Six Sigma is a quality improvement system originally developed by Motorola in the mid-
1980s. After seeing the huge financial successes at Motorola, GE, and other early adopters of
Six Sigma, many companies worldwide have now instituted Six Sigma to improve efficiency,
cut costs, eliminate defects, and reduce product variation (see references 1, 4, 11, and 18). Six
Sigma offers a more prescriptive and systematic approach to process improvement than TQM.
It is also distinguished from other quality improvement systems by its clear focus on achieving
bottom-line results in a relatively short three- to six-month period of time.

The name Six Sigma comes from the fact that it is a managerial approach designed to cre-
ate processes that result in no more than 3.4 defects per million. The Six Sigma approach as-
sumes that processes are designed so that the upper and lower specification limits are each six
standard deviations away from the mean. Then, if the processes are monitored correctly with
control charts, the worst possible scenario is for the mean to shift to within 4.5 standard devia-
tions from the nearest specification limit. The area under the normal curve less than 4.5 stan-
dard deviations below the mean is approximately 3.4 out of 1 million. (Table E.2 reports this
probability as 0.000003398.)

The DMAIC Model
To guide managers in their task of improving short-term and long-term results, Six Sigma uses
a five-step process known as the DMAIC model—named for the five steps in the process:

• Define The problem is defined, along with the costs, the benefits, and the impact on
the customer.

• Measure Important characteristics related to the quality of the service or product are
identified and discussed. Variables measuring these characteristics are defined and
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called critical-to-quality (CTQ) variables. Operational definitions for all the CTQ vari-
ables are then developed. In addition, the measurement procedure is verified so that it is
consistent over repeated measurements.

• Analyze The root causes of why defects occur are determined, and variables in the
process causing the defects are identified. Data are collected to determine benchmark
values for each process variable. This analysis often uses control charts (discussed in
Sections 17.2–17.5).

• Improve The importance of each process variable on the CTQ variable is studied
using designed experiments (see Chapter 11 and references 9, 10, and 13). The objec-
tive is to determine the best level for each variable.

• Control The objective is to maintain the benefits for the long term by avoiding poten-
tial problems that can occur when a process is changed.

The Define phase of a Six Sigma project consists of the development of a project charter,
performing a SIPOC analysis, and identifying the customers for the output of the process. The
development of a project charter involves forming a table of business objectives and indicators
for all potential Six Sigma projects. Importance ratings are assigned by top management, proj-
ects are prioritized, and the most important project is selected. A SIPOC analysis is used to
identify the Suppliers to the process, list the Inputs provided by the suppliers, flowchart the
Process, list the process Outputs, and identify the Customers of the process. This is followed
by a Voice of the Customer analysis that involves market segmentation in which different types
of users of the process are identified and the circumstances of their use of the process are
identified. Statistical methods used in the Define phase include tables and charts, descriptive
statistics, and control charts.

In the Measure phase of a Six Sigma project, members of a team identify the CTQ vari-
ables that measure important quality characteristics. Next, operational definitions (see Section
1.3) of each CTQ variable are developed so that everyone will have a firm understanding of
the CTQ. Then studies are undertaken to ensure that there is a valid measurement system for
the CTQ that is consistent across measurements. Finally, baseline data are collected to
determine the capability and stability of the current process. Statistical methods used in the
Measure phase include tables and charts, descriptive statistics, the normal distribution, the
Analysis of Variance, and control charts.

The Analyze phase of a Six Sigma project focuses on the factors that affect the central ten-
dency, variation, and shape of each CTQ variable. Factors are identified, and the relationships
between the factors and the CTQs are analyzed. Statistical methods used in the Analyze phase
include tables and charts, descriptive statistics, the Analysis of Variance, regression analysis,
and control charts.

In the Improve phase of a Six Sigma project, team members carry out designed experi-
ments to actively intervene in a process. The objective of the experiments is to determine the
settings of the factors that will optimize the central tendency, variation, and shape of each
CTQ variable. Statistical methods used in the Improve phase include tables and charts,
descriptive statistics, regression analysis, hypothesis testing, the Analysis of Variance, and
designed experiments.

The Control phase of a Six Sigma project focuses on the maintenance of improvements
that have been made in the Improve phase. A risk abatement plan is developed to identify
elements that can cause damage to a process. Statistical methods used in the Control phase
include tables and charts, descriptive statistics, and control charts.

Roles in a Six Sigma Organization
Six Sigma requires that the employees of an organization have well-defined roles. The roles
senior executive (CEO or president), executive committee, champion, process owner, master
black belt, black belt, and green belt are critical to Six Sigma. More importantly, everyone
must be properly trained in order to successfully fulfill their roles’ tasks and responsibilities.

The role of the senior executive is critical for Six Sigma’s ultimate success. The most suc-
cessful, highly publicized Six Sigma efforts have all had unwavering, clear, and committed
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leadership from top management. Although Six Sigma concepts and processes can be initiated
at lower levels, high-level success cannot be achieved without the leadership of the senior
executive.

The members of the executive committee consist of the top management of an organiza-
tion. They need to operate at the same level of commitment to Six Sigma as the senior executive.

Champions take a strong sponsorship and leadership role in conducting and implement-
ing Six Sigma projects. They work closely with the executive committee, the black belt
assigned to their project, and the master black belt overseeing their project. A champion should
be a member of the executive committee, or at least someone who reports directly to a member
of the executive committee. He or she should have enough influence to remove obstacles or
provide resources without having to go higher in the organization.

A process owner is the manager of a process. He or she has responsibility for the process
and has the authority to change the process on her or his signature. The process owner should
be identified and involved immediately in all Six Sigma projects related to his or her own area.

A master black belt takes on a leadership role in the implementation of the Six Sigma
process and as an advisor to senior executives. The master black belt must use his or her skills
while working on projects that are led by black belts and green belts. A master black belt has
successfully led many teams through complex Six Sigma projects. He or she is a proven
change agent, leader, facilitator, and technical expert in Six Sigma.

A black belt works full time on Six Sigma projects. A black belt is mentored by a master
black belt but may report to a manager for his or her tour of duty as a black belt. Ideally, a
black belt works well in a team format, can manage meetings, is familiar with statistics and
systems theory, and has a focus on the customer.

A green belt is an individual who works on Six Sigma projects part time (approximately
25%), either as a team member for complex projects or as a project leader for simpler projects.
Most managers in a mature Six Sigma organization are green belts. Green belt certification is
a critical prerequisite for advancement into upper management in a Six Sigma organization.

Recent research (see reference 4) indicates that more than 80% of the top 100 publicly
traded companies in the United States use Six Sigma. So, you do need to be aware of the dis-
tinction between master black belt, black belt, and green belt if you are to function effectively
in a Six Sigma organization.

In a Six Sigma organization, 25% to 50% of the organization will be green belts, only 6%
to 12% of the organization will be black belts, and only 1% of the organization will be master
black belts (reference 9). Individual companies, professional organizations such as the Ameri-
can Society for Quality, and universities such as the University of Miami offer certification
programs for green belt, black belt, and master black belt. For more information on certifica-
tion and other aspects of Six Sigma, see references 9, 10, and 13.

In the Using Statistics scenario, you were the manager of the Beach-
comber Hotel. After being trained in Six Sigma, you decided to fo-
cus on two critical first impressions: Is the room ready when a guest
checks in? And, do guests receive their luggage in a reasonable

amount of time?
You constructed a p chart of the proportion of rooms not ready at check-

in. The p chart indicated that the check-in process was in control and that, on average, the pro-
portion of rooms not ready was approximately 0.08 (i.e., 8%). You then constructed and R
charts for the amount of time required to deliver luggage. Although there was a considerable
amount of variability around the overall mean of approximately 9.5 minutes, you determined that
the luggage delivery process was also in control.

You have learned that an in-control process contains common causes of variation but no spe-
cial causes of variation. Improvements in the outcomes of in-control processes must come from

X
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changes in the actual processes. Thus, if you want to reduce the proportion of rooms not ready at
check-in and/or lower the mean luggage delivery time, you will need to change the check-in
process and/or the luggage delivery process. From your knowledge of Six Sigma and statistics,
you know that during the Improve phase of the DMAIC model, you will be able to perform and
analyze experiments using different process designs. Hopefully you will discover better process
designs that will lead to a higher percentage of rooms being ready on time and/or quicker
luggage delivery times. These improvements should ultimately lead to greater guest satisfaction.

S U M M A R Y
In this chapter you have learned how to use control charts to
distinguish between common causes and special causes of
variation. For categorical variables, you learned how to con-
struct and analyze p charts. For discrete variables involving
a count of nonconformances, you learned how to construct

and analyze c charts. For numerically measured variables,
you learned how to construct and analyze and R charts.
The chapter also discussed managerial approaches such as
TQM and Six Sigma that improve the quality of products
and services.

X

K E Y E Q U AT I O N S
Constructing Control Limits

(17.1)

Control Limits for the p Chart

(17.2)

Control Limits for the c Chart

(17.3)

Control Limits for the Range
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d2
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(17.5b)

Control Limits for the Chart

(17.6)

Computing Control Limits for the Mean,
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(17.7a)

(17.7b)

Estimating the Capability of a Process

For a CTQ variable with an LSL and a USL:

(17.8a)

= PaLSL - X
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6 Z 6

USL - X

R>d2
b

P(An outcome will be
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= P1LSL 6 X 6 USL2
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R

d21n

UCL = X + 3
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X ; 3
R
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X

LCL = D3 R

UCL = D4 R
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For a CTQ variable with only a USL:

(17.8b)

For a CTQ variable with only an LSL:

(17.8c)= PaLSL - X

R>d2
6 Zb

P(An outcome will be
within specification)

= P1LSL 6 X2

= PaZ 6
USL - X

R>d2
b

P(An outcome will be
within specification)

= P1X 6 USL2

The Index

(17.9)

CPL and CPU

(17.10a)

(17.10b)

(17.11)Cpk = MIN3CPL, CPU4
Cpk

CPU =
USL - X

31R>d22

CPL =
X - LSL

31R>d22

=
Specification spread

Process spread

Cp =
USL - LSL

61R>d22

Cp
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C H A P T E R R E V I E W P R O B L E M S
CHECKING YOUR UNDERSTANDING
17.36 What is the difference between common cause vari-
ation and special cause variation?

17.37 What should you do to improve a process when spe-
cial causes of variation are present?

17.38 What should you do to improve a process when only
common causes of variation are present?

17.39 Under what circumstances do you use a p chart?

17.40 What is the difference between attribute control
charts and variables control charts?

17.41 Why are and charts used together?

17.42 What principles did you learn from the red bead ex-
periment?

17.43 What is the difference between process potential
and process performance?

17.44 A company requires a value of 1 or larger. If a
process has and what changes should
you make to the process?

17.45 Why is a capability analysis not performed on out-
of-control processes?

Cpk = 0.8,Cp = 1.5
Cpk

RX
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APPLYING THE CONCEPTS
17.46 According to the American Society for Quality, cus-
tomers in the United States consistently rate service quality
lower than product quality (American Society for Quality,
The Quarterly Quality Report, www.asq.org, May 16,
2006). For example, products in the beverage, personal care,
and cleaning industries, as well as the major appliance sec-
tor all received very high customer satisfaction ratings. At
the other extreme, services provided by airlines, banks, and
insurance companies all received low customer satisfaction
ratings.
a. Why do you think service quality consistently rates lower

than product quality?
b. What are the similarities and differences between meas-

uring service quality and product quality?
c. Do Deming’s 14 points apply to both products and serv-

ices?
d. Can Six Sigma be used for both products and services?

17.47 Suppose that you have been hired as a summer in-
tern at a large amusement park. Every day, your task is to
conduct 200 exit interviews in the parking lot when cus-
tomers leave. You need to construct questions to address the
cleanliness of the park and the customers’ intent to return.
When you begin to construct a short questionnaire, you re-
member the control charts you learned in a statistics course,
and you decide to write questions that will provide you with
data to graph on control charts. After collecting data for
30 days, you plan to construct the control charts.
a. Write a question that will allow you to develop a control

chart of customers’ perceptions of cleanliness of the park.
b. Give examples of common cause variation and special

cause variation for the control chart.
c. If the control chart is in control, what does that indicate

and what do you do next?
d. If the control chart is out of control, what does this indi-

cate and what do you do next?
e. Repeat (a) through (d), this time addressing the cus-

tomers’ intent to return to the park.
f. After the initial 30 days, assuming that the charts indicate

in-control processes or that the root sources of special
cause variation have been corrected, explain how the
charts can be used on a daily basis to monitor and im-
prove the quality in the park.

17.48 Researchers at Miami University in Oxford, Ohio,
investigated the use of p charts to monitor the market share
of a product and to document the effectiveness of marketing
promotions. Market share is defined as the company’s pro-
portion of the total number of products sold in a category. If
a p chart based on a company’s market share indicates an in-
control process, then the company’s share in the market-
place is deemed to be stable and consistent over time. In the
example given in the article, the RudyBird Disk Company
collected daily sales data from a nationwide retail audit
service. The first 30 days of data in the accompanying table

Cases Sold Before the Promotion

Day Total RudyBird Day Total RudyBird

1 154 35 16 177 56
2 153 43 17 143 43
3 200 44 18 200 69
4 197 56 19 134 38
5 194 54 20 192 47
6 172 38 21 155 45
7 190 43 22 135 36
8 209 62 23 189 55
9 173 53 24 184 44

10 171 39 25 170 47
11 173 44 26 178 48
12 168 37 27 167 42
13 184 45 28 204 71
14 211 58 29 183 64
15 179 35 30 169 43

Cases Sold After the Promotion

Day Total RudyBird

31 201 92
32 177 76
33 205 85
34 199 90
35 187 77
36 168 79
37 198 97

Source: Data extracted from C. T. Crespy, T. C. Krehbiel, and J. M.
Stearns, “Integrating Analytic Methods into Marketing Research
Education: Statistical Control Charts as an Example,” Marketing
Education Review, 5 (Spring 1995), 11–23.

(stored in ) indicate the total number of cases of
computer disks sold and the number of RudyBird disks sold.
The final 7 days of data were taken after RudyBird launched
a major in-store promotion. A control chart was used to see
if the in-store promotion would result in special cause varia-
tion in the marketplace.

RudyBird

a. Construct a p chart, using data from the first 30 days
(prior to the promotion) to monitor the market share for
RudyBird disks.

b. Is the market share for RudyBird in control before the
start of the in-store promotion?

c. On your control chart, extend the control limits generated
in (b) and plot the proportions for days 31 through 37.
What effect, if any, did the in-store promotion have on
RudyBird’s market share?

17.49 The manufacturer of Boston and Vermont asphalt
shingles constructed control charts and analyzed several
quality characteristics. One characteristic of interest is the

www.asq.org
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strength of the sealant on the shingle. During each day of
production, three shingles are tested for their sealant
strength. (Thus, a subgroup is operationally defined as one
day of production, and the sample size for each subgroup is
3.) Separate pieces are cut from the upper and lower por-
tions of a shingle and then reassembled to simulate shingles
on a roof. A timed heating process is used to simulate the
sealing process. The sealed shingle pieces are pulled apart,
and the amount of force (in pounds) required to break the
sealant bond is measured and recorded. This variable is
called the sealant strength. The file contains
sealant strength measurements on 25 days of production for
Boston shingles and 19 days for Vermont shingles.

For the 25 days of production for Boston shingles,
a. construct a control chart for the range.
b. construct a control chart for the mean.
c. is the process in control?
d. Repeat (a) through (c), using the 19 production days for

Vermont shingles.

17.50 A professional basketball player has embarked on a
program to study his ability to shoot foul shots. On each day
in which a game is not scheduled, he intends to shoot 100
foul shots. He maintains records over a period of 40 days of
practice, with the results stored in :
a. Construct a p chart for the proportion of successful foul

shots. Do you think that the player’s foul-shooting
process is in statistical control? If not, why not?

b. What if you were told that the player used a different
method of shooting foul shots for the last 20 days? How
might this information change your conclusions in (a)?

c. If you knew the information in (b) prior to doing (a), how
might you do the analysis differently?

17.51 The funds-transfer department of a bank is concerned
with turnaround time for investigations of funds-transfer pay-
ments. A payment may involve the bank as a remitter of
funds, a beneficiary of funds, or an intermediary in the pay-
ment. An investigation is initiated by a payment inquiry or a
query by a party involved in the payment or any department
affected by the flow of funds. When a query is received, an in-
vestigator reconstructs the transaction trail of the payment
and verifies that the information is correct and that the proper
payment is transmitted. The investigator then reports the re-
sults of the investigation, and the transaction is considered
closed. It is important that investigations be closed rapidly,
preferably within the same day. The number of new investiga-
tions and the number and proportion closed on the same day
that the inquiry was made are stored in .
a. Construct a control chart for these data.
b. Is the process in a state of statistical control? Explain.
c. Based on the results of (a) and (b), what should manage-

ment do next to improve the process?

17.52 A branch manager of a brokerage company is con-
cerned with the number of undesirable trades made by her
sales staff. A trade is considered undesirable if there is an

FundTran

Foulspc

Sealant

error on the trade ticket. Trades with errors are canceled and
resubmitted. The cost of correcting errors is billed to the
brokerage company. The branch manager wants to know
whether the proportion of undesirable trades is in a state of
statistical control so she can plan the next step in a quality
improvement process. Data were collected for a 30-day
period and stored in .
a. Construct a control chart for these data.
b. Is the process in control? Explain.
c. Based on the results of (a) and (b), what should the

manager do next to improve the process?

17.53 As chief operating officer of a local community
hospital, you have just returned from a three-day seminar on
quality and productivity. It is your intention to implement
many of the ideas that you learned at the seminar. You have
decided to construct control charts for the upcoming month
for the proportion of rework in the laboratory (based on
1,000 daily samples), the number of daily admissions, and
time (in hours) between receipt of a specimen at the labora-
tory and completion of the work (based on a subgroup of 10
specimens per day). The data collected are summarized and
stored in . You are to make a presentation to the
chief executive officer of the hospital and the board of di-
rectors. Prepare a report that summarizes the conclusions
drawn from analyzing control charts for these variables. In
addition, recommend additional variables to measure and
monitor by using control charts.

17.54 A team working at a cat food company had the
business objective of reducing nonconformance in the cat food
canning process. As the team members began to investigate
the current process, they found that, in some instances, pro-
duction needed expensive overtime costs to meet the require-
ments requested by the market forecasting team. They also
realized that data were not available concerning the stability
and magnitude of the rate of nonconformance and the produc-
tion volume throughout the day. Their previous study of the
process indicated that output could be nonconforming for a
variety of reasons. The reasons broke down into two cate-
gories: quality characteristics due to the can and characteris-
tics concerning the fill weight of the container. Because these
nonconformities stemmed from different sets of underlying
causes, they decided to study them separately. The group as-
signed to study and reduce the nonconformities due to the can
decided that at 15-minute intervals during each shift the num-
ber of nonconforming cans would be determined along with
the total number of cans produced during the time period. The
results for a single day’s production of kidney cat food and a
single day’s production of shrimp cat food for each shift are
stored in .You want to study the process of produc-
ing cans of cat food for the two shifts and the two types of
food. Completely analyze the data.

17.55 Refer to Problem 17.54. The production team at the
cat food company investigating nonconformities due to the
fill weight of the cans determined that at 15-minute intervals

CatFood3
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during each shift, a subgroup of five cans would be selected,
and the contents of the selected cans would be weighed. The
results for a single day’s production of kidney cat food and a
single day’s production of shrimp cat food are stored in

. You want to study the process of producing cans
of cat food for the two shifts and the two types of food.
Completely analyze the data.

17.56 For a period of four weeks, record your pulse rate
(in beats per minute) just after you get out of bed in the
morning and then again before you go to sleep at night.
Construct and R charts and determine whether your pulse
rate is in a state of statistical control. Discuss.

17.57 (Class Project) Use the table of random numbers
(Table E.1) to simulate the selection of different-colored
balls from an urn, as follows:
1. Start in the row corresponding to the day of the month

in which you were born plus the last two digits of the

X

CatFood4

year in which you were born. For example, if you
were born October 3, 1990, you would start in row 93
(3 + 90). If your total exceeds 100, subtract 100 from
the total.

2. Select two-digit random numbers.
3. If you select a random number from 00 to 94, consider

the ball to be white; if the random number is from 95 to
99, consider the ball to be red.

Each student is to select 100 two-digit random numbers and
report the number of “red balls” in the sample. Construct a
control chart for the proportion of red balls. What conclu-
sions can you draw about the system of selecting red balls?
Are all the students part of the system? Is anyone outside the
system? If so, what explanation can you give for someone
who has too many red balls? If a bonus were paid to the top
10% of the students (the 10% with the fewest red balls), what
effect would that have on the rest of the students? Discuss.

T H E H A R N S W E L L S E W I N G M A C H I N E
C O M P A N Y C A S E

Phase 1
For more than 40 years, the Harnswell Sewing Machine
Company has manufactured industrial sewing machines.
The company specializes in automated machines called pat-
tern tackers that sew repetitive patterns on such mass-
produced products as shoes, garments, and seat belts. Aside
from the sales of machines, the company sells machine
parts. Because the company’s products have a reputation for
being superior, Harnswell is able to command a price
premium for its product line.

Recently, the operations manager, Natalie York, pur-
chased several books related to quality. After reading them,
she considered the feasibility of beginning a quality pro-
gram at the company. At the current time, the company has
no formal quality program. Parts are 100% inspected at the
time of shipping to a customer or installation in a machine,
yet Natalie has always wondered why inventory of certain
parts (in particular, the half-inch cam rollers) invariably falls
short before a full year lapses, even though 7,000 pieces
have been produced for a demand of 5,000 pieces per year.

After a great deal of reflection and with some apprehen-
sion, Natalie has decided that she will approach John Harn-
swell, the owner of the company, about the possibility of
beginning a program to improve quality in the company,
starting with a trial project in the machine parts area. As she
is walking to Mr. Harnswell’s office for the meeting, she has
second thoughts about whether this is such a good idea. Af-
ter all, just last month, Mr. Harnswell told her, “Why do you
need to go to graduate school for your master’s degree in
business? That is a waste of your time and will not be of any

value to the Harnswell Company. All those professors are
just up in their ivory towers and don’t know a thing about
running a business, like I do.”

As she enters his office, Mr. Harnswell invites Natalie to
sit down across from him. “Well, what do you have on your
mind this morning?” Mr. Harnswell asks her in an inquisitive
tone. She begins by starting to talk about the books that she
has just completed reading and about how she has some in-
teresting ideas for making production even better than it is
now and improving profits. Before she can finish, Mr. Harn-
swell has started to answer: “Look, everything has been fine
since I started this company in 1968. I have built this com-
pany up from nothing to one that employs more than 100
people. Why do you want to make waves? Remember, if it
ain’t broke, don’t fix it.” With that, he ushers her from his of-
fice with the admonishment of, “What am I going to do with
you if you keep coming up with these ridiculous ideas?”

EXERCISES
1. Based on what you have read, which of Deming’s

14 points of management are most lacking at the
Harnswell Sewing Machine Company? Explain.

2. What changes, if any, do you think that Natalie York
might be able to institute in the company? Explain.

Phase 2
Natalie slowly walks down the hall after leaving Mr. Harn-
swell’s office, feeling rather downcast. He just won’t listen to
anyone, she thinks. As she walks, Jim Murante, the shop
foreman, comes up beside her. “So,” he says, “did you really
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think that he would listen to you? I’ve been here more than
25 years. The only way he listens is if he is shown something
that worked after it has already been done. Let’s see what we
can plan together.”

Natalie and Jim decide to begin by investigating the
production of the cam rollers, which are precision-ground
parts. The last part of the production process involves the
grinding of the outer diameter. After grinding, the part
mates with the cam groove of the particular sewing pattern.
The half-inch rollers technically have an engineering speci-
fication for the outer diameter of the roller of 0.5075 inch
(the specifications are actually metric, but in factory floor
jargon, they are referred to as half-inch), plus a tolerable
error of 0.0003 inch on the lower side. Thus, the outer diam-
eter is allowed to be between 0.5072 and 0.5075 inch. Any-
thing larger is reclassified into a different and less costly
category, and anything smaller is unusable for anything
other than scrap.

T A B L E H S 1 7 . 1

Diameter of Cam Rollers (in Inches)

Cam Roller

Batch 1 2 3 4 5

1 .5076 .5076 .5075 .5077 .5075
2 .5075 .5077 .5076 .5076 .5075
3 .5075 .5075 .5075 .5075 .5076
4 .5075 .5076 .5074 .5076 .5073
5 .5075 .5074 .5076 .5073 .5076
6 .5076 .5075 .5076 .5075 .5075
7 .5076 .5076 .5076 .5075 .5075
8 .5075 .5076 .5076 .5075 .5074
9 .5074 .5076 .5075 .5075 .5076

10 .5076 .5077 .5075 .5075 .5075
11 .5075 .5075 .5075 .5076 .5075
12 .5075 .5076 .5075 .5077 .5075
13 .5076 .5076 .5073 .5076 .5074
14 .5075 .5076 .5074 .5076 .5075
15 .5075 .5075 .5076 .5074 .5073
16 .5075 .5074 .5076 .5075 .5075
17 .5075 .5074 .5075 .5074 .5072
18 .5075 .5075 .5076 .5075 .5076
19 .5076 .5076 .5075 .5075 .5076
20 .5075 .5074 .5077 .5076 .5074
21 .5075 .5074 .5075 .5075 .5075
22 .5076 .5076 .5075 .5076 .5074
23 .5076 .5076 .5075 .5075 .5076
24 .5075 .5076 .5075 .5076 .5075
25 .5075 .5075 .5075 .5075 .5074
26 .5077 .5076 .5076 .5074 .5075
27 .5075 .5075 .5074 .5076 .5075
28 .5077 .5076 .5075 .5075 .5076
29 .5075 .5075 .5074 .5075 .5075
30 .5076 .5075 .5075 .5076 .5075

The grinding of the cam roller is done on a single
machine with a single tool setup and no change in the
grinding wheel after initial setup. The operation is done by
Dave Martin, the head machinist, who has 30 years of ex-
perience in the trade and specific experience producing the
cam roller part. Because production occurs in batches, Na-
talie and Jim sample five parts produced from each batch.
Table HS17.1 presents data collected over 30 batches
(stored in ).

EXERCISE
3. a. Is the process in control? Why?

b. What recommendations do you have for improving
the process?

Phase 3
Natalie examines the and R charts developed from the
data presented in Table HS17.1. The R chart indicates that
the process is in control, but the chart reveals that the
mean for batch 17 is outside the LCL. This immediately
gives her cause for concern because low values for the
roller diameter could mean that parts have to be scrapped.
Natalie goes to see Jim Murante, the shop foreman, to try
to find out what had happened to batch 17. Jim looks up the
production records to determine when this batch was pro-
duced. “Aha!” he exclaims. “I think I’ve got the answer!
This batch was produced on that really cold morning we
had last month. I’ve been after Mr. Harnswell for a long
time to let us install an automatic thermostat here in the
shop so that the place doesn’t feel so cold when we get here
in the morning. All he ever tells me is that people aren’t as
tough as they used to be.”

Natalie is almost in shock. She realizes that what
happened is that, rather than standing idle until the envi-
ronment and the equipment warmed to acceptable temper-
atures, the machinist opted to manufacture parts that
might have to be scrapped. In fact, Natalie recalls that a
major problem occurred on that same day, when several
other expensive parts had to be scrapped. Natalie says to
Jim, “We just have to do something. We can’t let this go
on now that we know what problems it is potentially caus-
ing.” Natalie and Jim decide to take enough money out of
petty cash to get the thermostat without having to fill out
a requisition requiring Mr. Harnswell’s signature. They
install the thermostat and set the heating control so that
the heat turns on a half hour before the shop opens each
morning.

EXERCISES
4. What should Natalie do now concerning the cam roller

data? Explain.
5. Explain how the actions of Natalie and Jim to avoid this

particular problem in the future have resulted in quality
improvement.

X

X

Harnswell
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PHASE 4
Because corrective action was taken to eliminate the special
cause of variation, Natalie removes the data for batch 17
from the analysis. The control charts for the remaining days
indicate a stable system, with only common causes of varia-
tion operating on the system. Then, Natalie and Jim sit down
with Dave Martin and several other machinists to try to de-
termine all the possible causes for the existence of oversized
and scrapped rollers. Natalie is still troubled by the data. Af-
ter all, she wants to find out whether the process is giving
oversizes (which are downgraded) and undersizes (which
are scrapped). She thinks about which tables and charts
might be most helpful.

EXERCISE
6. a. Construct a frequency distribution and a stem-and-leaf

display of the cam roller diameters. Which do you prefer
in this situation?

b. Based on your results in (a), construct all appropriate
charts of the cam roller diameters.

c. Write a report, expressing your conclusions concern-
ing the cam roller diameters. Be sure to discuss the
diameters as they relate to the specifications.

PHASE 5
Natalie notices immediately that the overall mean diameter
with batch 17 eliminated is 0.507527, which is higher than
the specification value. Thus, the mean diameter of the

rollers produced is so high that many will be downgraded in
value. In fact, 55 of the 150 rollers sampled (36.67%) are
above the specification value. If this percentage is extrapo-
lated to the full year’s production, 36.67% of the 7,000
pieces manufactured, or 2,567, could not be sold as half-
inch rollers, leaving only 4,433 available for sale. “No won-
der we often have shortages that require costly emergency
runs,” she thinks. She also notes that not one diameter is be-
low the lower specification of 0.5072, so not one of the
rollers had to be scrapped.

Natalie realizes that there has to be a reason for all this.
Along with Jim Murante, she decides to show the results to
Dave Martin, the head machinist. Dave says that the results
don’t surprise him that much. “You know,” he says, “there is
only 0.0003 inch variation in diameter that I’m allowed. If I
aim for exactly halfway between 0.5072 and 0.5075, I’m
afraid that I’ll make a lot of short pieces that will have to be
scrapped. I know from way back when I first started here
that Mr. Harnswell and everybody else will come down on
my head if they start seeing too many of those scraps. I fig-
ure that if I aim at 0.5075, the worst thing that will happen
will be a bunch of downgrades, but I won’t make any pieces
that have to be scrapped.”

EXERCISES
7. What approach do you think the machinist should take in

terms of the diameter he should aim for? Explain.
8. What do you think that Natalie should do next? Explain.

M A N A G I N G A S H L A N D M U LT I C O M M S E R V I C E S
The AMS technical services team has embarked on a

quality improvement effort. Its first project relates to
maintaining the target upload speed for its Internet service
subscribers. Upload speeds are measured on a device that
records the results on a standard scale in which the target
value is 1.0. Each day five uploads are randomly selected,
and the speed of each upload is measured. Table AMS17.1
on page 754 presents the results for 25 days (stored in

).AMS17

EXERCISE
1. a. Construct the appropriate control charts for these

data.
b. Is the process in a state of statistical control?

Explain.
c. What should the team recommend as the next step to

improve the process?
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Upload Speeds for 25 Consecutive Days

Upload

Day 1 2 3 4 5

1 0.96 1.01 1.12 1.07 0.97
2 1.06 1.00 1.02 1.16 0.96
3 1.00 0.90 0.98 1.18 0.96
4 0.92 0.89 1.01 1.16 0.90
5 1.02 1.16 1.03 0.89 1.00
6 0.88 0.92 1.03 1.16 0.91
7 1.05 1.13 1.01 0.93 1.03
8 0.95 0.86 1.14 0.90 0.95
9 0.99 0.89 1.00 1.15 0.92

10 0.89 1.18 1.03 0.96 1.04
11 0.97 1.13 0.95 0.86 1.06
12 1.00 0.87 1.02 0.98 1.13
13 0.96 0.79 1.17 0.97 0.95
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Upload Speeds for 25 Consecutive Days

Upload

Day 1 2 3 4 5

14 1.03 0.89 1.03 1.12 1.03
15 0.96 1.12 0.95 0.88 0.99
16 1.01 0.87 0.99 1.04 1.16
17 0.98 0.85 0.99 1.04 1.16
18 1.03 0.82 1.21 0.98 1.08
19 1.02 0.84 1.15 0.94 1.08
20 0.90 1.02 1.10 1.04 1.08
21 0.96 1.05 1.01 0.93 1.01
22 0.89 1.04 0.97 0.99 0.95
23 0.96 1.00 0.97 1.04 0.95
24 1.01 0.98 1.04 1.01 0.92
25 1.01 1.00 0.92 0.90 1.11
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EG17.1 The THEORY of CONTROL CHARTS

There are no Excel Guide instructions for this section.

EG17.2 CONTROL CHART for the
PROPORTION: The p CHART

PHStat2 Use p Chart to create a chart and supporting
worksheets that compute the control limits and plot points.
For example, to create the Figure 17.2 chart for the Table
17.1 nonconforming hotel room data on page 722, open to
the DATA worksheet of the Hotel1 workbook. Select
PHStat ➔ Control Charts ➔ p Chart and in the proce-
dure’s dialog box (shown below):

1. Enter C1:C29 as the Nonconformances Cell Range.

2. Check First cell contains label.

3. Click Size does not vary and enter 200 as the
Sample/Subgroup Size.

4. Enter a Title and click OK.

p

p

Sample/Subgroup Cell Range, and click First cell contain
label.

In-Depth Excel Use the pChartDATA and COMPUTE
worksheets of the p Chart workbook as a template for
computing control limits and plot points. The pChart-
DATA worksheet uses formulas in column D that divide
the column C number of nonconformances value by the
column B subgroup/sample size value to compute the
proportion and uses formulas in columns E through
G to display the values for the LCL, and UCL that are
computed in cells B12 through B14 of the COMPUTE
worksheet. In turn, the COMPUTE worksheet (shown be-
low) uses the subgroup sizes and the proportion values
found in the pChartDATA worksheet to compute the con-
trol limits.

p,
1pi2
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The procedure creates a chart on its own chart sheet and
two supporting worksheets: one that computes the control
limits and one that computes the values to be plotted. For
more information about these two worksheets, read the fol-
lowing In-Depth Excel instructions.

For problems in which the sample/subgroup sizes vary,
replace step 3 with this step: Click Size varies, enter the cell
range that contains the sample/subgroup sizes as the

p

Computing control limits and plotting points for other
problems requires changes to the pChartDATA worksheet
of the p Chart workbook. First, paste the time period, sub-
group/sample size, and number of nonconformances data
into columns A through C of the pChartDATA worksheet. If
there are more than 28 time periods, select cell range
D29:G29 and copy the range down through all the rows. If
there are fewer than 28 time periods, delete the extra rows
from the bottom up, starting with row 29.

Use the pChartDATA worksheet as the basis for creat-
ing a p chart. For example, to create the Figure 17.2 chart
for the nonconforming hotel room data on page 722, open
to the pChartDATA worksheet which contains the Table 17.1
nonconforming hotel room data on page 722. Select the cell

p
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range A1:A29 and while holding down the Ctrl key, select
the cell range D1:G29. (This operation selects the cell range
A1:A29, D1:G29.) Then:

1. Select Insert ➔ Scatter and select the fourth choice
from the Scatter gallery (Scatter with Straight Lines
and Markers).

2. Relocate the chart to a chart sheet and adjust chart for-
matting by using the instructions in Appendix Section
F.4 on page 815.

At this point, a recognizable chart begins to take shape,
but the control limit and center lines are improperly
formatted and are not properly labeled. Use the following
three sets of instructions to correct these formatting errors:

To reformat each control limit line:

1. Right-click the control limit line and select Format
Data Series from the shortcut menu.

2. In the Format Data Series dialog box left pane, click
Marker Options and in the Marker Options right
panel, click None.

3. In the left pane, click Line Style and in the Line Style
right panel, select the sixth choice (a dashed line) from
the Dash type drop-down gallery list.

4. In the left pane, click Line Color and in the Line Color
right panel, select the black color from the Color drop-
down gallery list.

5. Click Close.

To reformat the center line:

1. Right-click the center line and select Format Data
Series from the shortcut menu.

2. In the Format Data Series dialog box left pane, click
Marker Options and in the Marker Options right
panel, click None.

3. In the left pane, click Line Color and in the Line Color
right panel, click Solid line and then select a red color
from the Color drop-down gallery.

4. Click Close.

To label a control limit line or the center line:

1. Select Layout ➔ Text Box (in Insert group) and start-
ing slightly above and to the right of the line, drag the
special cursor diagonally to form a new text box.

2. Enter the line label in the text box and then click on the
chart background.

EG17.3 The RED BEAD EXPERIMENT:
UNDERSTANDING PROCESS
VARIABILITY

There are no Excel Guide instructions for this section.

EG17.4 CONTROL CHART for an AREA of
OPPORTUNITY: The c CHART

PHStat2 Use c Chart to create a c chart and supporting
worksheets that compute the control limits and plot points.
For example, to create the Figure 17.5 c chart for the hotel
complaint data on page 729, open to the DATA worksheet
of the Complaints workbook. Select PHStat ➔ Control
Charts ➔ c Chart and in the procedure’s dialog box
(shown below):

1. Enter B1:B51 as the Nonconformances Cell Range.

2. Check First cell contains label.

3. Enter a Title and click OK.

The procedure creates a c chart on its own chart sheet and
two supporting worksheets: one that computes the control
limits and one that computes the values to be plotted. For
more information about these two worksheets, read the fol-
lowing In-Depth Excel instructions.

In-Depth Excel Use the cChartDATA and COMPUTE
worksheets of the c Chart workbook as a template
for computing control limits and plot points. The cChart-
DATA worksheet uses formulas in columns C through
E to display the values for the LCL, cBar, and UCL that
are computed in cells B10 through B12 of the COMPUTE
worksheet. In turn, the COMPUTE worksheet (shown on
page 757) computes sums and counts of the number of
nonconformities found in the cChartDATA worksheet to
help compute the control limits.



Computing control limits and plotting points for other
problems requires changes to the cChartDATA worksheet
of the c Chart workbook. First, paste the time period and
number of nonconformances data into columns A and B of
the cChartDATA worksheet. If there are more than 50 time
periods, select cell range C51:E51 and copy the range
down through all the rows. If there are fewer than 50 time
periods, delete the extra rows from the bottom up, starting
with row 51.

Use the cChartDATA worksheet as the basis for creat-
ing a c chart. For example, to create the Figure 17.5 c chart
for the hotel complaint data on page 729, open to the
cChartDATA worksheet which contains the Table 17.4 hotel
complaint data on page 729. Select the cell range B1:E51
and:

1. Select Insert ➔Scatter and select the fourth choice
from the Scatter gallery (Scatter with Straight Lines
and Markers).

2. Relocate the chart to a chart sheet and adjust the chart
formatting by using the instructions in Appendix Sec-
tion F.4 on page 815.

At this point, a recognizable chart begins to take shape, but
the control limit and center lines are improperly formatted
and are not properly labeled. To correct these formatting er-
rors, use the three sets of instructions given in the Section
EG17.2 In-Depth Excel instructions.

EG17.5 CONTROL CHARTS for the RANGE
and the MEAN

The R Chart and the Chart

PHStat2 Use R and XBar Charts to create R and
charts and supporting worksheets that compute the control

X

X
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limits and plot points. For example, to create the Figure
17.6 R chart and the Figure 17.7 chart for the Table 17.5
luggage delivery times (see pages 734 and 735), open to
the DATA worksheet of the Hotel2 workbook. Because
the PHStat2 procedure requires column cell ranges that
contain either means or ranges, first add two columns that
compute the mean and ranges on this worksheet. Enter the
column heading Mean in cell G1 and the heading Range
in cell H1. Enter the formula =AVERAGE(B2:F2) in cell
G2 and the formula =MAX(B2:F2) - MIN(B2:F2) in cell
H2. Select the cell range G2:H2 and copy the range down
through row 29.

With the two columns created, select PHStat ➔ Con-
trol Charts ➔ R and XBar Charts. In the procedure’s dia-
log box (shown below):

1. Enter 5 as the Subgroup/Sample Size.

2. Enter H1:H29 as the Subgroup Ranges Cell Range.

3. Check First cell contains label.

4. Click R and XBar Charts. Enter G1:G29 as the
Subgroup Means Cell Range and check First cell
contains label.

5. Enter a Title and click OK.

X

The procedure creates the two charts on separate chart
sheets and two supporting worksheets: one that computes
the control limits and one that computes the values to be
plotted. For more information about these two worksheets,
read the following In-Depth Excel section.



In-Depth Excel Use the DATA, RXChartDATA, and
COMPUTE worksheets of the R and XBar Chart
workbook as a template for computing control limits and
plotting points. The RXChartDATA worksheet uses
formulas in columns B and C to compute the mean and
range values for the Table 17.5 luggage delivery times
(see page 733 stored in the DATA worksheet. The work-
sheet uses formulas in columns D through I to display the
values for the control limit and center lines, using values
that are computed in the COMPUTE worksheet. Formulas
in columns D and G use IF functions that will omit the
lower control limit if the LCL value computed is less than
0. (To examine the formulas used in the worksheet, open
to the RXChartDATA_FORMULAS worksheet.)

The COMPUTE worksheet (shown below) uses the
computed means and ranges to compute and the
mean of the subgroup means. Unlike the COMPUTE
worksheets for other control charts, you must manually
enter the Sample/Subgroup Size in cell B4 (5, as shown
below) in addition to the D3, D4, and A2 factors in cells
B8, B9, and B18 (0, 2.114, and 0.577, as shown). Use
Table E.9 on page 812 to look up the values for the D3, D4,
and A2 factors.

X ,R
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ranges have been previously computed. If the means and
ranges have been previously computed, paste these values
into column B and C of the RXChartDATA worksheet. If
there are more than 28 time periods, select cell range
D29:I29 and copy the range down through all the rows. If
there are fewer than 28 time periods, delete the extra rows
from the bottom up, starting with row 29.

If the means and ranges have not been previously
computed, changes must be made to the DATA worksheet.
First, determine the subgroup size. If the subgroup size is
less than 5, delete the extra columns, right-to-left, starting
with column F. If the subgroup size is greater than 5,
select column F, right-click, and click Insert from the
short-cut menu. (Repeat as many times as necessary.)
With the DATA worksheet so adjusted, paste the time and
subgroup data into the worksheet, starting with cell A1.
Then open to the RXChartDATA worksheet, and if the
number of time periods is not equal to 28, adjust the
number of rows using the instructions of the previous
paragraph.

Use the RXChartDATA worksheet as the basis for
creating R and charts. For example, open to the
RXChartDATA worksheet of the R and XBar Chart
workbook which contains Table 17.5 luggage delivery
times data on page 733. To create the Figure 17.6 R chart
on page 734, select the cell range C1:F29. To create the
Figure 17.7 chart on page 735, select the cell range
B1:B29, G1:I29, (while holding down the Ctrl key, se-
lect the cell range B1:B29 and then the cell range
G1:I29). In either case:

1. Select Insert ➔ Scatter and select the fourth choice
from the Scatter gallery (Scatter with Straight Lines
and Markers).

2. Relocate the chart to a chart sheet and adjust the chart
formatting by using the instructions in Appendix Sec-
tion F.4 on page 815.

At this point, a recognizable chart begins to take shape, but
the control limit and center lines are improperly formatted
and are not properly labeled. To correct these formatting er-
rors, use the three sets of instructions given in the Section
EG17.2 In-Depth Excel instructions.

EG17.6 PROCESS CAPABILITY

Use the COMPUTE worksheet of the CAPABILITY
workbook as a template for computing the process
capability indices discussed in Section 17.6.

X

X

Computing control limits and plotting points for other
problems requires changes to the RXChartDATA or the
DATA worksheet, depending on whether means and
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MG17.1 The THEORY of CONTROL CHARTS

There are no Minitab Guide instructions for this section.

MG17.2 CONTROL CHART for the
PROPORTION: The p CHART

Use P to create a p chart. For example, to create the Figure 17.2
p chart for the Table 17.1 nonconforming hotel room data on
page 722, open to the Hotel1 worksheet. Select Stat ➔
Control Charts ➔ Attribute Charts ➔ P. In the P Chart
dialog box (shown below):

1. Double-click C3 Not ready in the variables list to add
‘Not ready’ to the Variables box.

2. Enter 200 in the Subgroup sizes box.
3. Click P Chart Options.

9. Back in the P Chart dialog box, click OK.

To omit points when estimating the center line and control
limits, click the Estimate tab in the P Chart - Options
dialog box and select Omit the following subgroups
when estimating parameters (eg, 3 12:15) from the
drop-down list and enter the points to omit in the box. If
you create more than one control chart during the same
session, Minitab remembers the list of points to omit and
you must delete any points in the box that you want to be
included in a subsequent control chart.

MG17.3 The RED BEAD EXPERIMENT:
UNDERSTANDING PROCESS
VARIABILITY

There are no Minitab Guide instructions for this section.

MG17.4 CONTROL CHART for an AREA of
OPPORTUNITY: The c CHART

Use C to create a c chart. For example, to create the Figure
17.5 c chart for the hotel complaint data on page 729, open

In the P Chart - Options box shown in the next column:

4. Click the Tests tab.
5. Select Perform selected tests for special causes from

the drop-down list.
6. Check 1 point > K standard deviations from the cen-

ter line and enter 3 in the K box.
7. Check K points in a row on same side of center line

and enter 8 in the K box.
8. Click OK.

EG17.7 TOTAL QUALITY MANAGEMENT

There are no Excel Guide instructions for this section.

EG17.8 SIX SIGMA

There are no Excel Guide instructions for this section.
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to the Complaints worksheet. Select Stat ➔ Control
Charts ➔ Attribute Charts ➔ C. In the C Chart dialog
box (shown below):

1. Double-click C2 Complaints in the variables list to
add Complaints to the Variables box.

2. Click C Chart Options.

In the C Chart-Options dialog box (not shown, but
similar to the P Chart-Options dialog box shown on
page 759):

3. Click the Tests tab

4. Select Perform selected tests for special causes from
the drop-down list.

5. Check 1 point > K standard deviations from the cen-
ter line and enter 3 in the K box.

6. Check K points in a row on same side of center line
and enter 8 in the K box.

7. Click OK.

8. Back in the C Chart dialog box, click OK.

To omit points when estimating the center line and control
limits, click the Estimate tab in the C Chart - Options dia-
log box and select Omit the following subgroups when es-
timating parameters (eg, 3 12:15) from the drop-down list
and enter the points to omit in the box. If you create more
than one control chart during the same session, Minitab re-
members the list of points to omit and you must delete any
points in the box that you want to be included in a subse-
quent control chart.

MG17.5 CONTROL CHARTS for the RANGE
and the MEAN

The R Chart and the Chart

Use Xbar-R to create R and charts. For example, to cre-
ate the Figure 17.6 R chart and the chart for the Table 17.5X

X

X

luggage delivery times (see pages 733–735), open to the
Hotel2 worksheet. Select Stat ➔ Control Charts ➔ Vari-
able Charts for Subgroups ➔ Xbar-R. In the Xbar-R
Chart dialog box (shown below):

1. Select Observations for a subgroup are in one row of
columns from the drop-down list and press Tab.

2. Enter Time1-Time5 in the box below the drop-down list
(as the shortcut way of entering the columns C2 through
C6, Time1 through Time5).

3. Click Xbar-R Options.

In the Xbar-R Chart-Options dialog box:

4. Click the Tests tab.

5. Select Perform selected tests for special causes from
the drop-down list.

6. Check 1 point > K standard deviations from the cen-
ter line and enter 3 in the K box.

7. Check K points in a row on same side of center line
and enter 8 in the K box.

8. Click the Estimate tab (shown below).

9. Select Rbar for the Method for estimating standard
deviation.

10. Click OK.

11. Back in the Xbar-R Chart dialog box, click OK.
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session, Minitab remembers the list of points to omit and
you must delete any points in the box that you want to be in-
cluded in a subsequent control chart.

MG17.6 PROCESS CAPABILITY

There are no Minitab Guide instructions for this section.

MG17.7 TOTAL QUALITY MANAGEMENT

There are no Minitab Guide instructions for this section.

MG17.8 SIX SIGMA

There are no Minitab Guide instructions for this section.

The Hotel2 worksheet contains data in unstacked order.
When using worksheets with stacked data for other prob-
lems, select All observations for a chart are in one
column from the drop-down list in step 1 and enter the
name of the column that contains the stacked data in the
box. You will also need to enter the subgroup size in a
Subgroup sizes box that appears with this option.

To omit points when estimating the center line and
control limits, select Omit the following subgroups when
estimating parameters (eg, 3 12:15) from the drop-down
list and enter the points to omit in the box in the Estimate
tab of the Xbar-R Chart-Options dialog box shown above. If
you create more than one control chart during the same
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Learning Objectives
In this chapter, you learn:

• The steps involved in choosing which statistical methods to use to conduct a data
analysis

A Roadmap for
Analyzing Data18



A s a student who is completing an introductory business statistics course, you find
yourself needing to analyze data in other courses and in new business situations.
Analyzing data is the last part of the Define, Collect, Organize, Visualize,
Analyze (DCOVA) approach to which you were introduced in Chapter 2. 
Determining what methods to use to analyze data may have seemed straightfor-

ward when doing homework problems from the chapters of this book, but in real-life situations it is
much more difficult; after all, when doing a problem in the multiple regression chapter, you “knew”
that methods of multiple regression would be used somewhere in your analysis. In your new situation,
you might wonder if you should use multiple regression—or whether using simple linear regression
would be better—or whether any type of regression would be appropriate. You also might wonder if
you should use methods from more than one chapter to do your analysis. The question for you
becomes: How can you apply the statistics you have learned to future situations that require you to
analyze data?

U S I N G S TAT I S T I C S

@ YourBusiness
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T A B L E 1 8 . 1

Commonly Used Data
Analysis Tasks Discussed
in This Book

DESCRIBING A GROUP OR SEVERAL GROUPS

For Numerical Variables:
Ordered array, stem-and-leaf display, frequency distribution, relative frequency

distribution, percentage distribution, cumulative percentage distribution, histogram,
polygon, cumulative percentage polygon (Sections 2.3 and 2.5)

Boxplot (Section 3.3)
Normal probability plot (Section 6.3)
Mean, median, mode, quartiles, geometric mean, range, interquartile range, standard

deviation, variance, coefficient of variation (Sections 3.1, 3.2, and 3.3)
Index numbers (Online Topic Section 16.8)

For Categorical Variables:
Summary table, bar chart, pie chart, Pareto chart (Sections 2.2 and 2.4)
Contingency tables and Multidimensional tables (Sections 2.2 and 2.7)

MAKING INFERENCES ABOUT ONE GROUP

For Numerical Variables:
Confidence interval estimate of the mean (Sections 8.1 and 8.2)

test for the mean (Section 9.2)t
Chi-square test for a variance or standard deviation (Section 12.5)

For Categorical Variables:
Confidence interval estimate of the proportion (Section 8.3)

test for the proportion (Section 9.4)Z

COMPARING TWO GROUPS

For Numerical Variables:
Tests for the difference in the means of two independent populations (Section 10.1)
Wilcoxon rank sum test (Section 12.6)
Paired test (Section 10.2)t
Wilcoxon signed ranks test (Online Topic Section 12.8)

test for the difference between two variances (Section 10.4)F
For Categorical Variables:

test for the difference between two proportions (Section 10.3)Z
Chi-square test for the difference between two proportions (Section 12.1)
McNemar test for two related samples (Section 12.4)

COMPARING MORE THAN TWO GROUPS

For Numerical Variables:
One-way analysis of variance (Section 11.1)
Kruskal-Wallis rank test (Section 12.7)
Randomized block design (Section 11.2)
Friedman rank test for the randomized block design (Online Topic Section 12.9)
Two-way analysis of variance (Section 11.3)

For Categorical Variables:
Chi-square test for differences among more than two proportions (Section 12.2)

ANALYZING THE RELATIONSHIP BETWEEN TWO VARIABLES

For Numerical Variables:
Scatter plot, time-series plot (Section 2.6)
Covariance, coefficient of correlation, test of correlation (Sections 3.5 and 13.7)t
Simple linear regression (Chapter 13)
Time-series forecasting (Chapter 16)

Reviewing Table 18.1, a review and summary of the contents of this book, arranged by
data analysis task, would be a good starting point.
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(Continued)
For Categorical Variables:

Contingency table, side-by-side bar chart (Sections 2.2 and 2.4)
Chi-square test of independence (Section 12.3)

ANALYZING THE RELATIONSHIP BETWEEN TWO OR MORE VARIABLES

For Numerical Dependent Variables:
Multiple regression (Chapters 14 and 15)

For Categorical Dependent Variables:
Logistic regression (Section 14.7)
Analytics and Data Mining (Online Topic Section 15.7)

ANALYZING PROCESS DATA

For Numerical Variables:
and control charts (Section 17.5)RX

For Categorical Variables:
chart (Section 17.2)p

For Counts of Nonconformities:
chart (Section 17.4)c

18.1 Analyzing Numerical Variables
Exhibit 18.1 presents the list of questions to ask if you plan to analyze a numerical variable.
Each question is independent of the others, and you can ask as many or as few questions as is
appropriate for your analysis. How to go about answering these questions follows Exhibit 18.1.

In the DCOVA approach, the first thing you do is to define the variables that you want to study
in order to solve a business problem or meet a business objective. To do this, you must identify the
type of business problem and then determine the type of variable—numerical or categorical—you
are analyzing. (Recall that numerical variables have values that represent quantities, while
categorical variables have values that can only be placed into categories, such as yes and no.)

In Table 18.1, the all-uppercase first-level headings identify types of business problems
(e.g., whether you are describing a group or making inferences about a group, among other
choices), and the second-level headings always include the two types of variables. The third-
level (lowest) entries in Table 18.1 identify the specific statistical methods appropriate for a
particular type of business problem and type of variable.

Choosing appropriate statistical methods for your data is the single most important task you
face and is at the heart of “doing statistics.” But this choosing process is also the single most
difficult thing you do when applying statistics! How, then, can you ensure that you have made
an appropriate choice? By asking a series of questions, you can guide yourself to the appropri-
ate choice of methods.

The rest of this chapter presents questions that will help guide you in making this choice.
Two lists of questions, one for numerical variables and the other for categorical variables, are pre-
sented in the next two sections. Having two lists makes the decision you face more manageable
while also reinforcing the importance of identifying the type of variable that you seek to analyze.

EXHIBIT 18.1 QUESTIONS TO ASK WHEN ANALYZING NUMERICAL VARIABLES
When analyzing numerical variables, ask yourself, do you want to:

• Describe the characteristics of the variable (possibly broken down into several
groups)?

• Reach conclusions about the mean and standard deviation of the variable in a
population?
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How to Describe the Characteristics of a Numerical Variable
You develop tables and charts and compute descriptive statistics to describe characteristics.
Specifically, you can create a stem-and-leaf display, percentage distribution, histogram,
polygon, boxplot, and normal probability plot (see Sections 2.3, 2.5, 3.3, and 6.3), and you can
compute statistics such as the mean, median, mode, quartiles, range, interquartile range,
standard deviation, variance, and coefficient of variation (see Sections 3.1, 3.2, and 3.3).

How to Reach Conclusions About the Population 
Mean or Standard Deviation
You have several different choices, and you can use any combination of these choices. To
estimate the mean value of the variable in a population, you construct a confidence interval
estimate of the mean (see Section 8.2). To determine whether the population mean is equal to a
specific value, you conduct a test of hypothesis for the mean (see Section 9.2). To determine
whether the population standard deviation or variance is equal to a specific value, you conduct
a test of hypothesis for the standard deviation or variance (see Section 12.5).

How to Determine Whether the Mean or Standard
Deviation Differs Depending on the Group
When examining differences between groups, you first need to establish which categorical
variable divides your data into groups. You then need to know whether this grouping variable
divides your data in two groups, as a gender variable would divide your data into male and
female groups, or whether the variable divides your data into more than two groups (such as
the four parachute suppliers discussed in Section 11.1). Finally, you must ask whether your
data set contains independent groups or whether your data set contains matched or repeated
measurements.

If the Grouping Variable Defines Two Independent Groups and You Are
Interested in Central Tendency Which hypothesis tests you use depends on the assump-
tions you make about your data.

If you assume that your numerical variable is normally distributed and that the variances
are equal, you conduct a pooled t test for the difference between the means (see Section 10.1).
To evaluate the assumption of normality that this test includes, you can construct boxplots and
normal probability plots for each group.

If you cannot assume that the variances are equal, you conduct a separate-variance test
for the difference between the means (see Section 10.1). To test whether the variances are
equal, assuming that the populations are normally distributed, you can conduct an test for
the differences between the variances.

In either case, if you believe that your numerical variables are not normally distributed,
you can perform a Wilcoxon rank sum test (see Section 12.6) and compare its results to those
of the test.

If the Grouping Variable Defines Two Groups of Matched Samples or
Repeated Measurements If you can assume that the paired differences are normally
distributed, you conduct a paired test (see Section 10.2). If you cannot assume that the pairedt

t

F

t

x2

t

• Determine whether the mean and standard deviation of the variable differs depending
on the group?

• Determine which factors affect the value of a variable?
• Predict the value of the variable based on the value of other variables?
• Determine whether the values of the variable are stable over time?
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differences are normally distributed, you conduct a Wilcoxon signed ranks test (see Online
Topic Section 12.8).

If the Grouping Variable Defines Two Independent Groups and You
Are Interested in Variability If you can assume that your numerical variable is
normally distributed, you conduct an test for the difference between two variances (see
Section 10.4).

If the Grouping Variable Defines More Than Two Independent Groups If you
can assume that the values of the numerical variable are normally distributed, you conduct a
one-way analysis of variance (see Section 11.1); otherwise, you conduct a Kruskal-Wallis rank
test (see Section 12.7).

If the Grouping Variable Defines More Than Two Groups of Matched Samples
or Repeated Measurements You have a design where the rows represent the blocks and
the columns represent the levels of a factor. If you can assume that the values of the numerical
variable are normally distributed, you conduct a randomized block design test (see Section
11.2). If you cannot assume that the values of the numerical variable are normally distributed,
you perform a Friedman rank test (see Online Topic Section 12.9).

How to Determine Which Factors Affect the Value
of a Variable
If there are two factors to be examined to determine their effect on the values of a variable, you
develop a two-factor factorial design (see Section 11.3).

How to Predict the Value of a Variable Based 
on the Value of Other Variables
You conduct least-squares regression analysis. If you have values over a period of time and you
want to forecast the variable for future time periods, you can use moving averages, exponential
smoothing, least-squares forecasting, and autoregressive modeling (see Chapter 16).

When predicting the values of a numerical dependent variable, which least-squares
regression model you develop depends on the number of independent variables in your model.
If there is only one independent variable being used to predict the numerical dependent
variable of interest, you develop a simple linear regression model (see Chapter 13); otherwise,
you develop a multiple regression model (see Chapters 14 and 15).

How to Determine Whether the Values of a Variable
Are Stable over Time
If you are studying a process and have collected data on the values of a numerical variable over
a time period, you construct and charts (see Section 17.5). If you have collected data in
which the values are counts of the number of nonconformities, you construct a chart (see
Section 17.4).

c
XR

F

F

18.2 Analyzing Categorical Variables
Exhibit 18.2 presents the list of questions to ask if you plan to analyze a categorical vari-
able. Each question is independent of the others, and you can ask as many or as few ques-
tions as is appropriate for your analysis. How to go about answering these questions follows
Exhibit 18.2.
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How to Describe the Proportion
of Items of Interest in Each Category
You create summary tables and use these charts: bar chart, pie chart, Pareto chart, or side-by-side
bar chart (see Sections 2.2 and 2.4).

How to Reach Conclusions About the Proportion
of Items of Interest
You have two different choices. You can estimate the proportion of items of interest in a
population by constructing a confidence interval estimate of the proportion (see Section 8.3).
Or, you can determine whether the population proportion is equal to a specific value by
conducting a test of hypothesis for the proportion (see Section 9.4).

How to Determine Whether the Proportion of Items 
of Interest Differs Depending on the Group
When examining this difference, you first need to establish the number of categories
associated with your categorical variable and the number of groups in your analysis. If your
data contain two groups, you must also ask if your data contain independent groups or if your
data contain matched samples or repeated measurements.

For Two Categories and Two Independent Groups You conduct either the test for
the difference between two proportions (see Section 10.3) or the test for the difference
between two proportions (see Section 12.1).

For Two Categories and Two Groups of Matched or Repeated Measure-
ments You conduct the McNemar test (see Section 12.4).

For Two Categories and More Than Two Independent Groups You conduct a
test for the difference among several proportions (see Section 12.2).

For More Than Two Categories and More Than Two Groups You develop
contingency tables and use multidimensional contingency tables to drill down to examine rela-
tionships among two or more categorical variables (Sections 2.2 and 2.7). When you have two
categorical variables, you conduct a test of independence (see Section 12.3).

How to Predict the Proportion of Items of Interest
Based on the Value of Other Variables
You develop a logistic regression model (see Section 14.7).

x2

x2

x2
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EXHIBIT 18.2 QUESTIONS TO ASK WHEN ANALYZING CATEGORICAL VARIABLES

When analyzing categorical variables, ask yourself, do you want to:

• Describe the proportion of items of interest in each category (possibly broken down
into several groups)?

• Reach conclusions about the proportion of items of interest in a population?
• Determine whether the proportion of items of interest differs depending on the group?
• Predict the proportion of items of interest based on the value of other variables?
• Determine whether the proportion of items of interest is stable over time?
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D I G I TA L C A S E
Whereas other Digital Cases asked you to apply your
knowledge about the proper use of statistics, this case helps
you remember how to properly apply that knowledge.

Guadalupe Cooper and Gilbert Chandler had worked very hard
all semester long in their business statistics course. They now
faced a final project in which they had to establish a plan to

analyze a set of data that had been assigned to them by their in-
structor. As they looked through the online materials at the
companion website for their statistics textbook, they found
DataAnalysisGuide.pdf in the Digital Case materials. “Gee,
this is like the material in Chapter 18, but in interactive form!”
one of them noted. They both then knew what questions they
needed to ask in order to get started on their final semester task.

How to Determine Whether the Proportion of Items 
of Interest Is Stable over Time
If you are studying a process and have collected data over a time period, you can create the
appropriate control chart. If you have collected the proportion of items of interest over a time
period, you develop a chart (see Section 17.2).p

C H A P T E R R E V I E W P R O B L E M S
18.1 In many manufacturing processes, the term work-in-
process (often abbreviated WIP) is used. At the BLK
Publishing book manufacturing plants, WIP represents the
time it takes for sheets from a press to be folded, gathered,
sewn, tipped on end sheets, and bound together to form a
book, and the book placed in a packing carton. The opera-
tional definition of the variable of interest, processing time,
is the number of days (measured in hundredths) from when
the sheets come off the press to when the book is placed in a
packing carton. The company has the business objective of
determining whether there are differences in the WIP be-
tween plants. Data have been collected from samples of 20
books at each of two production plants. The data, stored in

, are as follows:
Plant A

11.62 7.29 7.50 7.96 4.42 10.50 7.58 9.29 7.54 8.92

5.62 5.29  16.25 10.92 11.46 21.62 8.45 8.58 5.41 11.42

WIP

Plant B
9.54 11.46 16.62 12.62 25.75 15.41 14.29 13.13 13.71 10.04

5.75 12.46 9.17 13.21 6.00 2.33 14.25 5.37 6.25 9.71

Completely analyze the data.

18.2 Many factors determine the attendance at Major
League Baseball games. These factors can include when the
game is played, the weather, the opponent, whether the team
is having a good season, and whether a marketing
promotion is held. Popular promotions during a recent
season included the traditional hat days and poster days and
the newer craze, bobble-heads of star players. (Data extracted
from T. C. Boyd and T. C. Krehbiel, “An Analysis of the
Effects of Specific Promotion Types on Attendance at Ma-
jor League Baseball Games,” Mid-American Journal of
Business, 2006, 21, pp. 21–32.) The file includesBaseball

This chapter summarizes all the methods discussed in the first
17 chapters of this book. The data analysis methods discussed
in the book are organized in Table 18.1 according to whether
each method is used for describing a group or several groups,

for making inferences about one group or comparing two or more groups,
or for analyzing relationships between two or more variables. Then, sets of
questions are listed in Exhibits 18.1 and 18.2 to assist you in determining
what method to use to analyze your data.

U S I N G S TAT I S T I C S @ YourBusiness Revisited
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the following variables for a recent Major League Baseball
season:

TEAM—Kansas City Royals, Philadelphia Phillies,
Chicago Cubs, or Cincinnati Reds

ATTENDANCE—Paid attendance for the game
TEMP—High temperature for the day
WIN%—Team’s winning percentage at the time of the game
OPWIN%—Opponent team’s winning percentage at the

time of the game
WEEKEND—1 if game played on Friday, Saturday, or Sun-

day; 0 otherwise
PROMOTION—1 if a promotion was held; 0 if no

promotion was held

You want to predict attendance and determine the factors
that influence attendance. Completely analyze the data for
the Kansas City Royals.

18.3 Repeat Problem 18.2 for the Philadelphia Phillies.

18.4 Repeat Problem 18.2 for the Chicago Cubs.

18.5 Repeat Problem 18.2 for the Cincinnati Reds.

18.6 The file contains data for a sample of 362
single-family homes located in five different communities
in a suburban county outside a large city in the northeastern
United States. The following variables are included:

1. Appraised value ($000)
2. Lot size (000 square feet)
3. Number of bedrooms
4. Number of bathrooms
5. Number of rooms
6. Age in years
7. Annual real estate taxes ($)
8. Type of Indoor parking facility—None One-car

garage Two-car garage
9. Location—A B C D E

10. Architectural style—Cape Expanded ranch Colo-
nial Ranch Split level

11. Type of heating fuel used—Gas Oil
12. Type of heating system—Hot air Hot water Other
13. Type of swimming pool—None Above ground

In-ground
14. Eat-in kitchen—Absent Present
15. Central air-conditioning—Absent Present
16. Fireplace—Absent Present
17. Connection to local sewer system—Absent Present
18. Basement—Absent Present
19. Modern kitchen—Absent Present
20. Modern bathrooms—Absent Present

Prepare a report in which your objective is to compare the
characteristics of single-family homes in the five communi-
ties. In addition, develop models to predict the assessed
value of the house and the annual real estate taxes.

18.7 The file contains information on all the
single-family houses sold in a small city in the midwestern

Homes

RealEstate

United States for one year. The following variables are
included:

Price—Selling price of home, in dollars
Location—Rating of the location from 1 to 5, with 1 the

worst and 5 the best
Condition—Rating of the condition of the home from 1 to

5, with 1 the worst and 5 the best
Bedrooms—Number of bedrooms in the home
Bathrooms—Number of bathrooms in the home
Other Rooms—Number of rooms in the home other than

bedrooms and bathrooms
You want to be able to predict the selling price of the homes.
Completely analyze the data.

18.8 Zagat’s publishes restaurant ratings for various
locations in the United States. The file
contains the Zagat rating for food, decor, service, and price
per person for a sample of 50 restaurants located in New
York City and 50 restaurants located in suburban areas
outside New York City.

You want to study differences in the cost of a meal
between restaurants in New York City and suburban areas
and also want to be able to predict the cost of a meal.
Completely analyze the data.
Source: Data extracted from Zagat Survey 2010, New York City
Restaurants and Zagat Survey 2010–2011, Long Island Restaurants.

18.9 The data in represent different characteris-
tics of 171 late-model automobiles. The variables included
are make/model, length (in.), width (in.), height (in.),
wheelbase (in.), weight (lbs.), maximum cargo load (lb.),
cargo volume (cu. ft.), front shoulder room (in.), front leg
room (in.), front head room (in.), horsepower, miles per gal-
lon, acceleration (sec.) from 0 to 60 miles per hour, braking
distance in feet from 60 miles per hour (dry), braking dis-
tance in feet from 60 miles per hour (wet), turning circle
(ft.), country of origin (Asia, Europe, United States), vehi-
cle type (4 door SUV, sedan, 4 door hatchback, coupe, mini-
van, wagon) transmission type (auto 4, auto 5, auto 6, auto
7, CVT, manual 5, manual 6).

You want to describe each of these variables in this
sample of automobiles. In addition, you would like to pre-
dict the miles per gallon and dry braking distance and deter-
mine which variables are important in predicting these
variables. Analyze the data.
Source: Data extracted from “Vehicle Ratings,” Consumer Reports,
April 2008, pp. 31–75.

18.10 The data in represent different char-
acteristics of used automobiles advertised for sale in a re-
cent year. The variables included are car, model, year of
model , asking price (in $000), miles driven
by the car (in 000s), age in years, and type (coupe, mini-
van, pickup truck, sedan, sedan wagon, sports car, SUV,
van, wagon).

You want to describe each of these variables, and you
would like to predict the asking price of used autos. Analyze
the data.

(2000 = 0)

UsedAutos

Auto2008

Restaurants2
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Source: Data extracted from The Newark Star Ledger, January 3,
2009, pp. 35–38.

18.11 The data in consist of different
characteristics of 7,903 credit unions in the United States.
The variables included are name, city, state, zip code, region,
total assets ($), total investments ($), net income ($), total net
worth ($), total amount of delinquent loans and leases ($),
number of credit union members, number of potential
members, number of full-time credit union employees, and
number of credit union employees.

Your job is to present a report that summarizes descrip-
tive characteristics of credit unions and highlight factors
that differ among the credit unions. Analyze the data.
Source: www.ncua.gov, January 29, 2009.

18.12 The data in consist of the
different characteristics of 382 banks in the Tri-State New
York City area as of June 30, 2008. The variables included
are name, state, zip code, number of domestic and foreign
offices, ownership type, regulator, Federal Reserve district,
total deposits ($000), gross loans and leases ($000), real
estate loans ($000), construction and development loans
($000), all real estate loans ($000), commercial real estate
loans ($000), multifamily real estate loans ($000), 1–4
family real estate loans ($000), farmland loans ($000), com-
mercial and industrial loans ($000), credit card loans
($000), related plans ($000), other loans to individuals
($000), and all other loans and leases ($000).

Your job is to present a report that summarizes descrip-
tive characteristics of banks in the Tri-State New York City
area and highlight factors that differ among the banks.
Analyze the data.
Source: www.fdic.gov.

Loans and Leases

Credit Unions

18.13 A mining company operates a large heap-leach gold
mine in the western United States. The gold mined at this
location consists of ore that is very low grade, having about
0.0032 ounce of gold in 1 ton of ore. The process of heap-
leaching involves the mining, crushing, stacking, and
leaching millions of tons of gold ore per year. In the
process, ore is placed in a large heap on an impermeable
pad. A weak chemical solution is sprinkled over the heap
and is collected at the bottom after percolating through the
ore. As the solution percolates through the ore, the gold is
dissolved and is later recovered from the solution. This tech-
nology, which has been used for more than 30 years, has
made the operation profitable. Due to the large amount of
ore that is handled, the company is continually exploring
ways to improve the process. As part of an expansion sev-
eral years ago, the stacking process was automated with the
construction of a computer controlled stacker. This stacker
was designed to load 35,000 tons of ore per day at a cost that
was less than the previous process that used manually
operated trucks and bulldozers. However, since its
installation, the stacker has not been able to achieve these
results consistently. Data for a recent 35-day period that
indicate the amount stacked (tons) and the downtime (min-
utes) are stored in the file . Other data that indicate
the causes for the downtime are stored in .

Analyze the data, making sure to present conclusions
about the daily amount stacked and the causes of the down-
time. In addition, be sure to develop a model to predict the
amount stacked based on downtime.

Mining2

Mining

www.ncua.gov
www.fdic.gov
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A.1 Rules for Arithmetic Operations

A P P E N D I X A Basic Math Concepts and Symbols

RULE EXAMPLE

1. and b + a = ca + b = c and 1 + 2 = 32 + 1 = 3

2. a + (b + c) = (a + b) + c 5 + (7 + 4) = (5 + 7) + 4 = 16

3. but b - a Z ca - b = c but 7 - 9 Z 29 - 7 = 2

4. (a)(b) = (b)(a) (7)(6) = (6)(7) = 42

5. (a)(b + c) = ab + ac (2)(3 + 5) = (2)(3) + (2)(5) = 16

6. a , b Z b , a 12 , 3 Z 3 , 12

7.
a + b

c
=

a
c

+
b
c

7 + 3

2
=

7

2
+

3

2
= 5

8.
a

b + c
Z

a

b
+

a
c

3

4 + 5
Z

3

4
+

3

5

9.
1
a

+
1
b

=
b + a

ab

1

3
+

1

5
=

5 + 3

(3)(5)
=

8

15

10. aa

b
b a c

d
b = a ac

bd
b a2

3
b a6

7
b = a 122162132172 b =

12

21

11.
a

b
,

c

d
=

ad

bc
5

8
,

3

7
= a 152172182132 b =

35

24

A.2 Rules for Algebra: Exponents and Square Roots

RULE EXAMPLE

1. (X a)(X b) = X a+b (42)(43) = 45

2. (X a)b = X ab (22)3 = 26

3. (X a>X b) = X a-b 35

33
= 32

4.
X a

X a = X 0 = 1 34

34
= 30 = 1

5. 1XY = 1X1Y 1(25)(4) = 12514 = 10

6.AX

Y
=
2X2Y A 16

100
=
2162100

= 0.40
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RULE EXAMPLE

1. log(10a) = a log(100) = log(102) = 2

2. If then a = 10blog(a) = b, If then a = 102 = 100log(a) = 2,

3. log(ab) = log(a) + log(b)
= 1 + 1 = 2

log(100) = log3(10)(10)4 = log(10) + log(10)

4. log(ab) = (b) log(a) log(1,000) = log(103) = (3) log(10) = (3)(1) = 3

5. log(a>b) = log(a) - log(b) = log(1,000) - log(10)log(100) = log(1,000>10)

= 3 - 1 = 2

A.3 Rules for Logarithms
Base 10
Log is the symbol used for base-10 logarithms:

Take the base-10 logarithm of each side of the following equation:

SOLUTION: Apply rules 3 and 4:

= log(b0) + X log(b1) + log(e)

= log(b0) + log(bX
1) + log(e)

log(Y) = log(b0b
X
1e)

Y = b0b1
Xe

EXAMPLE

Base e
ln is the symbol used for base e logarithms, commonly referred to as natural logarithms. e is
Euler’s number, and :e � 2.718282

Take the base e logarithm of each side of the following equation:

SOLUTION: Apply rules 3 and 4:

= ln(b0) + X ln(b1) + ln(e)

= ln(b0) + ln(bX
1) + ln(e)

ln(Y) = ln(b0b
X
1e)

Y = b0b
X
1e

EXAMPLE

RULE EXAMPLE

1. ln(ea) = a ln(7.389056) = ln(e2) = 2

2. If then a = ebln(a) = b, If then a = e2 = 7.389056ln(a) = 2,
3. ln(ab) = ln(a) + ln(b) ln(100) = ln3(10) (10)4

=  ln(10) + ln(10) = 2.302585 + 2.302585 = 4.605170

4. ln(ab) = (b) ln(a) ln(1,000) = ln(103) = 3 ln(10) = 3(2.302585) = 6.907755
5. ln(a>b) = ln(a) - ln(b) ln(100) = ln(1,000>10) = ln(1,000) - ln(10)

= 6.907755 - 2.302585 = 4.605170
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A.4 Summation Notation
The symbol the Greek capital letter sigma, represents “taking the sum of.” Consider a set of

n values for variable X. The expression means to take the sum of the n values for variable

X. Thus:

The following problem illustrates the use of the symbol Consider five values of a variable
and Thus:

In statistics, the squared values of a variable are often summed. Thus:

and, in the example above:

the summation of the squares, is not the same as the square of the sum:

In the example given earlier, the summation of squares is equal to 79. This is not equal to the
square of the sum, which is 

Another frequently used operation involves the summation of the product. Consider two
variables, X and Y, each having n values. Then:

Continuing with the previous example, suppose there is a second variable, Y, whose five
values are and Then,

= 45

= 2 + 0 + 2 + 20 + 21

= (2)(1) + (0)(3) + (-1)(-2) + (5)(4) + (7)(3)

a
n

i=1
XiYi = X1Y1 + X2Y2 + X3Y3 + X4Y4 + X5Y5

Y5 = 3.Y1 = 1, Y2 = 3, Y3 = - 2, Y4 = 4,

a
n

i=1
XiYi = X1Y1 + X2Y2 + X3Y3 + Á + XnYn

132 = 169.

a
n

i=1
X 2

i Z aa
n

i=1
Xib

2

aa
n

i=1
Xib

2

,a
n

i=1
X 2

i ,

= 79

= 4 + 0 + 1 + 25 + 49

= 22 + 02 + (-1)2 + 52 + 72

a
5

i=1
X 2

i = X2
1 + X 2

2 + X 2
3 + X 2

4 + X 2
5

a
n

i=1
X 2

i = X 2
1 + X 2

2 + X 2
3 + Á + X 2

n

a
5

i=1
Xi = X1 + X2 + X3 + X4 + X5 = 2 + 0 + (-1) + 5 + 7 = 13

X5 = 7.X: X1 = 2, X2 = 0, X3 = -1, X4 = 5,
©.

a
n

i=1
Xi = X1 + X2 + X3 + Á + Xn

a
n

i=1
Xi

©,
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In computing you need to realize that the first value of X is multiplied by the first

value of Y, the second value of X is multiplied by the second value of Y, and so on. These prod-
ucts are then summed in order to compute the desired result. However, the summation of prod-
ucts is not equal to the product of the individual sums:

In this example,

and

so that

However,

The following table summarizes these results:

a
5

i=1
XiYi = 45

aa
5

i=1
Xib aa

5

i=1
Yib = (13)(9) = 117

a
5

i=1
Yi = 1 + 3 + (-2) + 4 + 3 = 9

a
5

i=1
Xi = 13

a
n

i=1
XiYi Z aa

n

i=1
Xib aa

n

i=1
Yib

a
n

i=1
XiYi,

VALUE Xi Yi XiYi

1 2 1 2
2 0 3 0
3 -1 -2 2
4 5 4 20
5 7 3 21

a
5

i=1
Xi = 13 a

5

i=1
Yi = 9 a

5

i=1
XiYi = 45

Rule 1 The summation of the values of two variables is equal to the sum of the values of
each summed variable:

Thus,

a
5

i=1
Xi + a

5

i=1
Yi = 13 + 9 = 22

= 22

= 3 + 3 + (-3) + 9 + 10

a
5

i=1
(Xi + Yi) = (2 + 1) + (0 + 3) + (-1 + (-2)) + (5 + 4) + (7 + 3)

a
n

i=1
(Xi + Yi) = a

n

i=1
Xi + a

n

i=1
Yi



778 APPENDICES

Rule 2 The summation of a difference between the values of two variables is equal to the
difference between the summed values of the variables:

Thus,

Rule 3 The sum of a constant times a variable is equal to that constant times the sum of the
values of the variable:

where c is a constant. Thus, if 

Rule 4 A constant summed n times will be equal to n times the value of the constant.

where c is a constant. Thus, if the constant is summed 5 times,

nc = (5)(2) = 10

a
5

i=1
c = 2 + 2 + 2 + 2 + 2 = 10

c = 2

a
n

i=1
c = nc

ca
5

i=1
Xi = 2a

5

i=1
Xi = (2)(13) = 26

= 26

= 4 + 0 + (-2) + 10 + 14

a
5

i=1
cXi = a

5

i=1
2Xi = (2)(2) + (2)(0) + (2)(-1) + (2)(5) + (2)(7)

c = 2,

a
n

i=1
cXi = ca

n

i=1
Xi

a
5

i=1
Xi - a

5

i=1
Yi = 13 - 9 = 4

= 4

= 1 + (-3) + 1 + 1 + 4

a
5

i=1
(Xi - Yi) = (2 - 1) + (0 - 3) + (-1 - (-2)) + (5 - 4) + (7 - 3)

a
n

i=1
(Xi - Yi) = a

n

i=1
Xi - a

n

i=1
Yi

Suppose there are six values for the variables X and Y, such that
and and

Compute each of the following:

(a)

(b)

(c) a
6

i=1
X2

i

a
6

i=1
Yi

a
6

i=1
Xi

Y6 = -3.Y1 = 4, Y2 = 0, Y3 = -1, Y4 = 2, Y5 = 7,X4 = -3, X5 = 1, X6 = -2
X1 = 2, X2 = 1, X3 = 5,EXAMPLE

(d)

(e)

(f) a
6

i=1
(Xi + Yi)

a
6

i=1
XiYi

a
6

i=1
Y2

i
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add+ multiply*
subtract- divide,
equal to= not equal toZ
approximately equal to� less than6
greater than7 less than or equal to…
greater than or equal toÚ

(i)

(j) a
6

i=1
(Xi - 3Yi + c), where c = +3

a
6

i=1
(cXi), where c = -1

Answers
(a) 4 (b) 9 (c) 44 (d) 79 (e) 10 (f) 13 (g) (h) 65 (i) (j) -5-4-5
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(g)

(h) a
6

i=1
(Xi - 3Yi + 2X 2

i )

a
6

i=1
(Xi - Yi)

A.6 Greek Alphabet

GREEK LETTER LETTER NAME ENGLISH EQUIVALENT GREEK LETTER LETTER NAME ENGLISH EQUIVALENT

A a Alpha a N n Nu n
B b Beta b Ξ j Xi x
≠ g Gamma g � o Omicron oI

¢ d Delta d ß p Pi p
E e Epsilon eI P r Rho r
Z z Zeta z © s Sigma s
H h Eta e T t Tau t
Θ u Theta th Y y Upsilon u
I i Iota i £ f Phi ph
K k Kappa k X x Chi ch
¶ l Lambda l ° c Psi ps
M m Mu m Æ v Omega o

A.5 Statistical Symbols



B.1 Objects in a Window
When you open Excel or Minitab, you see a window that contains the objects listed in Table B.1 and shown in Figure B.1 on page 781.
To effectively use Excel or Minitab, you must be familiar with these objects and their names.
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Number Element Function

Title bar Displays the name of the program and contains the
Minimize, Resize, and Close buttons for the program
window. You drag and drop the title bar to reposition a
program window onscreen.

Minimize, Resize, 
and Close buttons

Changes the display of the program window. Minimize
hides the window without closing the program, Resize
permits you to change the size of the window, and Close
removes the window from the screen and closes the
program. A second set of these buttons that appear below
the first set perform the three actions for the currently
active workbook.

Menu Bar and 
Toolbars

The menu bar is a horizontal list of words, where each
word represents either a command operation or leads to
another list of choices. Toolbars are sets of graphical icons
that represent commands. The toolbar icons serve as
shortcuts to menu bar choices. (Minitab and Excel 2003)

Ribbon A selectable area that combines the functions of a menu bar
and toolbars. In the Ribbon, commands are arranged in a
series of tabs, and the tabs are further divided into groups.
Some groups contain launcher buttons that display
additional choices presented in a dialog box or as a gallery,
a set of pictorial choices. (Excel 2007 and Excel 2010)

Workbook area Displays the currently open worksheets. In Excel, this 
area usually displays the currently active worksheet in the
workbook and shows the other worksheets as sheet tabs
near the bottom of the workbook area.

Scroll bar Allows you to move through a worksheet vertically or
horizontally to reveal rows and columns that cannot
otherwise be seen.

T A B L E B . 1
Common Window
Elements 1

2

3

4

5

6
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B.2 Basic Mouse Operations
To interact with the objects in a window, you frequently use a mouse (or some other pointing de-
vice). Mouse operations can be divided into four types and assume a mouse with two buttons, one
designated as the primary button (typically the left button) and the other button designated as the
secondary button (typically the right button).

Click, select, check, and clear are operations in which you move the mouse pointer over an
object and press the primary button. Click is used when pressing the primary button completes an
action, as in “click (the) OK (button).” Select is used when pressing the primary button to choose
or highlight one choice from a list of choices. Check is used when pressing the primary button
places a checkmark in the dialog box’s check box. (Clear reverses this action, removing the check-
mark.)

Double-click is an operation in which two clicks are made in rapid succession. Most double-
click operations enable an object for following use, such as double-clicking a chart in order to make
changes to the chart. Right-click is an operation in which you move the mouse pointer over an ob-
ject and press the secondary button. In the Excel Guide instructions, you will often right-click an
object in order to display a pop-up shortcut menu of context-sensitive command operations.

Drag is an operation in which you hold down the primary button over an object and then move
the mouse. (The drag operation ends when you release the mouse button.) Dragging is done to se-
lect multiple objects, such as selecting all the cells in a cell range, as well as to physically move an
object to another part of the screen. The related drag-and-drop operation permits you to move one
object over another to trigger an action. You drag the first object across the screen, and when the
first object is over the second object, you release the primary mouse button. (In most cases, releas-
ing the primary button causes the first object to reappear in its original position onscreen.)

Without a working knowledge of these mousing operations, you will find it difficult to under-
stand and follow the instructions presented in the end-of-chapter Excel and Minitab Guides.

B.3 Dialog Box Interactions
When you interact with either Excel or Minitab, you will see dialog boxes, pop-up windows that
contain messages or ask you to make entries or selections. Table B.2 identifies and defines the com-
mon objects found in dialog boxes which are shown in Figure B.2 on page 782.

F I G U R E B . 1
Minitab, Excel 2010, and
Excel 2007 windows (with
number labels keyed to
Table B.1)
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Element Function

Command button A clickable area that tells a program to take some action. For example,
a dialog box OK button causes a program to take an action using the
current entries and selections of the dialog box. A dialog box Cancel
button closes a dialog box and cancels the pending operation
associated with the entries and selections in the dialog box.

List box A box that displays a list of clickable choices. If a list exceeds the
dimensions of a list box, list boxes display scroll buttons or sliders
(not shown in Figure B.2) that can be clicked to reveal choices not
currently displayed.

Drop-down list A special button that, when clicked, displays a list of choices from
which you typically select one choice.

Edit box An area into which entries can be typed. Some edit boxes also contain
drop-down lists or spinner buttons that can be used to make entries. A
cell range edit box typically contains a clickable button that allows you to
drag the mouse over a cell range as an alternative to typing the cell range.

Set of option
buttons

A set of buttons that represent a set of mutually exclusive choices.
Clicking one option button clears all the other option buttons in the set.

Check box A clickable area that represents an optional action. A check box displays
either a checkmark or nothing, depending on whether the optional action
has been selected. Unlike with option buttons, clicking a check box does
not affect the status of other check boxes, and more than one check box
can be checked at a time. Clicking a check box that already contains a
checkmark clears the check box. (To distinguish between the two states,
instructions in this book use the verbs check and clear.)

T A B L E B . 2
Dialog Box Elements

F I G U R E B . 2
Excel 2010 Open (partially obscured) and Minitab Print dialog boxes
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B.4 Unique Features
Excel 2007 This version of Excel uniquely features the Office Button, the circular logo in the
upper left of the window that displays a menu of basic computing commands when clicked (see
Figure B.1). The Office Button functions much like the File menu in Excel 2003 and Minitab and
the File tab in Excel 2010.

Minitab Minitab (all versions) displays a session manager (shown in Figure MG1.1 on page 22),
a window in which results are added as a continuous log. (All Minitab results, other than charts,
shown throughout this book are copied from this session manager log.)

Minitab 16 Minitab 16 includes an Assistant feature that helps guide you through the choice of
the statistical method to use. The Assistant appears as an additional choice on the Minitab menu bar
and also provides direct clickable shortcuts to menu choices that might otherwise require several
different mouse clicks to select. The Assistant is not explicitly used in this book due to its unique-
ness to Minitab 16.



C.1 Visiting the Companion
Website for This Book
The companion website for this book contains study
resources, Excel workbook files, the free PHStat2 add-in,
and the optional online topics. To visit this site, open a web
browser and go to www.pearsonhighered.com/levine. On
that web page, click the Companion Website link for this
book. (Be careful; the web page lists several books, each
with its own Companion Website link.) The link takes you
to the home page of the companion website. On the home
page, there are links for downloading the files for this book
(see Section C.2), any updates or corrections to this book,
and a horizontal menu of chapter numbers that you can use
to display the companion materials for an individual chapter.

C.2 Downloading the Files for
This Book
The companion website described in Section C.1 contains
the links that will allow you to download the six sets of files
listed below that support this book. (Section C.4 provides
additional details about each set and contains a complete list
of the files that comprise the first three sets.)

• Data Files Files that contain the data used in chapter
examples or named in problems. These files are avail-
able in both .xls (Excel) and .mtw (Minitab) format.

• Online Topics A set of files in Adobe PDF format
that contain the optional online topics for this book.

• Excel Guide Workbooks Workbooks that contain
model solutions that can also be reused as templates for
solving other problems.

• Case Files A mix of data and document files that sup-
port the “Managing Ashland MultiComm Services”
running case and the end-of-chapter Digital Cases.

• Visual Explorations Files The files needed to use the
Visual Explorations add-in workbook, the interactive
Excel add-in that illustrates selected statistical concepts.
(Not compatible with Mac Excel 2008.)

• PHStat2 Readme File and PHStat2 Setup Program
Files that allow you to set up and install the free PHStat2
add-in. See Sections D.2, D.3, and G.1 for more informa-
tion. (Requires Microsoft Windows–based Excel.)

To download a set of files, right-click its download link
and click the “save as” choice from the shortcut menu (Save
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Target As in Internet Explorer, Save Link As in Mozilla
Firefox). Other than PHStat2, each set is downloaded as a
self-extracting archive of compressed files, which you
extract and store in the folder of your choice.

C.3 Accessing the Online
Topics Files
While you can download the set of online topic files for your
own use while not connected to the Internet, you can also
access these files individually while online. To do so, visit
this book’s companion website (see Section C.1). In the hor-
izontal menu of chapter numbers, click the chapter number
that corresponds to the chapter you want. Then, in that chap-
ter’s own web page, click the left menu link for the material
you want to use online.

C.4 Details of Downloadable
Files
Data Files
Data files are available as either Excel workbook files stored
in .xls format, compatible with all Excel versions, or
Minitab worksheet files, stored in the .mtw format, compat-
ible with Minitab Release 14 or later. Data files organize the
data for each variable by column, using the rules discussed
in Sections EG1.2 and MG1.2. Throughout this book, the
names of data files appear in a special typeface—for exam-
ple, .

In the following alphabetical list, the variables included
are presented in the order of their appearance in the file.
Except where noted in the text, the Excel workbook files
store data in a DATA worksheet.

ACT Method, ACT scores for condensed course, ACT scores
for regular course (Chapter 11)
ACT-ONEWAY Group 1 ACT scores, group 2 ACT scores,
group 3 ACT scores, group 4 ACT scores (Chapter 11)
AD PAGES Magazine name, magazine ad pages in 2008,
and magazine ad pages in 2009 (Chapter 10)
ADVERTISE Sales ($thousands), radio ads ($thousands), and
newspaper ads ($thousands) for 22 cities (Chapters 14 and 15)
ADVERTISING Sales ($millions) and newspaper ads
($thousands) (Chapter 15)
AMS2-1 Types of errors and frequency; types of errors and
cost; types of wrong billing errors and cost (Chapter 2)
AMS2-2 Days and number of calls (Chapter 2)

Bond Funds

www.pearsonhighered.com/levine


AMS8 Rate willing to pay in $ (Chapter 8)

AMS9 Upload speed (Chapter 9)

AMS10 Update times for email interface 1 and email inter-
face 2 (Chapter 10)

AMS11-1 Update time for system 1, system 2, and system 3
(Chapter 11)

AMS11-2 Media (cable or fiber) and interface (system 1,
system 2, or system 3) (Chapter 11)

AMS13 Number of hours spent telemarketing and number
of new subscriptions (Chapter 13)

AMS14 Week, number of new subscriptions, hours spent
telemarketing, and type of presentation (formal or informal)
(Chapter 14)

AMS16 Month and number of home delivery subscriptions
(Chapter 16)

AMS17 Day and upload speed (Chapter 17)

ANGLE Subgroup number and angle (Chapter 17)

ANSCOMBE Data sets A, B, C, and D—each with 11 pairs
of X and Y values (Chapter 13)

ATM TRANSACTIONS Cause, frequency, and percent-
age (Chapter 2)

AUDITS Year and number of audits (Chapters 2 and 16)

AUTO2008 Make/model, length (in.), width (in.), height
(in.), wheelbase (in.), weight (lb.), maximum cargo load
(lb.), cargo volume (cu. ft.), front shoulder room (in.), front
leg room (in.), front head room (in.), horsepower, miles per
gallon, acceleration from 0 to 60 mph (in sec.), braking from
60 mph dry (in sec.), braking from 60 mph wet (in sec.),
turning circle (ft.), region of origin, vehicle type, and trans-
mission type (Chapter 18)

AUTO2010 Car, miles per gallon, horsepower, and weight
(in lb.) (Chapters 14 and 15)

BANK1 Waiting time (in minutes) of 15 customers at a
bank located in a commercial district (Chapters 3, 9, 10,
and 12)

BANK2 Waiting time (in minutes) of 15 customers at a
bank located in a residential area (Chapters 3, 10, and 12)

BANKTIME Day, waiting times of four bank customers
(A, B, C, and D) (Chapter 17)

BASEBALL Team; attendance; high temperature on game
day; winning percentage of home team; opponent’s winning
percentage; game played on Friday, Saturday, or Sunday (0 =
no, 1 = yes); and promotion held (0 = no, 1 = yes) (Chapter 18)

BB2009 Team, league (0 = American, 1 = National), wins,
earned run average, runs scored, hits allowed, walks allowed,
saves, and errors (Chapters 13 and 15)

BBCOST Team and fan cost index (Chapters 2 and 6)

BBREVENUE Team, revenue ($millions), and value
($millions) (Chapter 13)

BBSALARIES Year and average major league baseball
salary ($millions) (Chapter 16)
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BED & BATH Year, coded year, and number of stores open
(Chapter 16)

BESTFUNDS Fund type (large cap value, large cap
growth), 3-year return, 5-year return, 10-year return, expense
ratio (Chapter 10)

BESTFUNDS2 Fund type (foreign large cap blend, small
cap blend, midcap blend, large cap blend, diversified emerg-
ing markets), 3-year return, 5-year return, 10-year return,
expense ratio (Chapter 11)

BESTFUNDS3 Fund type (intermediate municipal bond,
short-term bond, intermediate term bond), 3-year return, 5-
year return, 10-year return, expense ratio (Chapter 11)

BILL PAYMENT Form of payment and percentage
(Chapter 2)

BOND FUNDS Fund number, type, assets, fees, expense
ratio, 2009 return, 3-year return, 5-year return, risk, bins,
and midpoints (Chapters 2, 3, 4, 6, 8, 10, 11, 12, and 15)

BOND FUNDS2008 Fund number, type, assets, fees,
expense ratio, 2008 return, 3-year return, 5-year return, risk,
bins, and midpoints (Chapters 2 and 3)

BOOKPRICES Author, title, bookstore price, and online
price (Chapter 10)

BRAKES Part, gauge 1, and gauge 2 (Chapter 11)

BREAKFAST Menu choice, delivery time difference for
early time period, and delivery time difference for late time
period (Chapter 11)

BREAKFAST2 Menu choice, delivery time difference for
early time period, and delivery time difference for late time
period (Chapter 11)

BREAKSTW Operator and breaking strength for machines
I, II, and III (Chapter 11)

BULBS Manufacturer (1 = A, 2 = B) and length of life in
hours (Chapters 2, 10, and 12)

CABERNET California and Washington ratings and
California and Washington rankings (Chapter 12)

CANISTER Day and number of nonconformances
(Chapter 17)

CATFOOD Ounces eaten of kidney, shrimp, chicken liver,
salmon, and beef cat food (Chapters 11 and 12)

CATFOOD2 Piece size (F = fine, C = chunky), coded
weight for low fill height, and coded weight for current fill
height (Chapter 11)

CATFOOD3 Type (1 = kidney, 2 = shrimp), shift, time
interval, nonconformances, and volume (Chapter 17)

CATFOOD4 Type (1 = kidney, 2 = shrimp), shift, time
interval, and weight (Chapter 17)

CD-FIVEYEAR Five-year CD rates 3/29/2010 and
8/23/2010 (Chapter 10)

CELLRATING City and ratings for Verizon, AT&T,
T-Mobile, and Sprint (Chapter 11)
CEO-COMPENSATION Company, compensation of
CEO in $millions, and return in 2009 (Chapters 2, 3, and 13)



CEREALS Cereal, calories, carbohydrates, and sugar
(Chapters 3 and 13)

CHOCOLATECHIP Cost (cents) of chocolate chip cook-
ies (Chapter 3)

CIGARETTETAX State and cigarette tax ($) (Chapters 2
and 3)

CIRCUITS Batch and thickness of semiconductor wafers
by position (Chapter 11)

COCA-COLA Year, coded year, and operating revenues
($billions) at The Coca-Cola Company (Chapter 16)

COFFEE Expert, Rating of coffees, by brand A, B, C, and
D (Chapters 10 and 11)

COFFEE PRICES Year and price per pound of coffee in
the United States (Chapter 16)

COFFEESALES Coffee sales at $0.59, $0.69, $0.79, and
$0.89 (Chapters 11 and 12)

COFFEESALES2 Coffee sales and price in $ (Chapter 15)

COLA Sales for normal and end-aisle locations (Chapters
10 and 12)

COLASPC Day, total number of cans filled, and number of
unacceptable cans (Chapter 17)

COLLEGE BASKETBALL School, coach’s total salary
in $thousands, expenses, and revenues ($thousands)
(Chapters 2, 3, and 13)

COMPLAINTS Day and number of complaints (Chapter 17)

CONCRETE1 Sample number and compressive strength
after two days and seven days (Chapter 10)

CONCRETE2 Sample number and compressive strength
after 2 days, 7 days, and 28 days (Chapter 11)

CPI-U Year, coded year, and value of CPI-U (the consumer
price index) (Chapter 16)

CRACK Type of crack (0 = unflawed, 1 = flawed) and
crack size (Chapters 10 and 12)

CREDIT Month, coded month, and credit charges
(Chapter 16)

CREDIT UNIONS Name, city, state, zip code, region,
total assets ($), total investments ($), net income ($), total
net worth ($), total amount of delinquent loans and leases
($), number of current members, number of potential mem-
bers, number of full-time credit union employees, and num-
ber of branches (Chapter 18)

CURRENCY Year, coded year, and exchange rates
(against the U.S. dollar) for the Canadian dollar, Japanese
yen, and English pound (Chapter 16)

CUSTSALE Week number, number of customers, and
sales ($thousands) over a period of 15 consecutive weeks
(Chapter 13)

DARKCHOCOLATE Cost ($) per ounce of dark choco-
late bars (Chapters 2, 3, and 8)

DELIVERY Customer number, number of cases, and
delivery time (Chapter 13)

DENTAL Annual family dental expenses (Chapter 8)

DIFFTEST Differences in the sales invoices and actual
amounts (Chapter 8)

DIGITALCAMERAS Battery life (in shots) for subcom-
pact cameras and compact cameras (Chapters 10 and 12)

DINNER Time to prepare and cook dinner (in minutes)
(Chapter 9)

DISCOUNT Amount of discount not taken in $ (Chapter 8)

DJIA Year and Dow Jones Industrial Average at the end of
the year (Chapter 16)

DOMESTICBEER Brand, alcohol percentage, calories,
and carbohydrates in U.S. domestic beers (Chapters 2, 3,
6, and 15)

DOWMARKETCAP Company and market capitalization
($billions), (Chapters 3 and 6)

DRILL Depth, time to drill additional 5 feet, and type of
hole (Chapter 14)

DRINK Amount of soft drink filled in 2-liter bottles
(Chapters 2 and 9)

DRYCLEAN Days and number of items returned
(Chapter 17)

E-CYCLING Year and recycled amount (Chapter 16)

ENERGY State and per capita kilowatt hour use (Chapter 3)

ENERGY PRICES Year, price of electricity, natural gas,
and fuel oil (Chapter 16)

ERRORSPC Number of nonconforming items and number
of accounts processed (Chapter 17)

ERWAITING Emergency room waiting time (in minutes)
at the main facility and at satellite 1, satellite 2, and satellite
3 (Chapters 11 and 12)

ESPRESSO Tamp (the distance in inches between the
espresso grounds and the top of the portafilter) and time (the
number of seconds the heart, body, and crema are separated)
(Chapter 13)

EURODOLLAR Year and six month Eurodollar deposit
rate (Chapter 16)

FASTFOOD Amount spent on fast food in dollars
(Chapters 3, 8, and 9)

FEDRECEIPT Year, coded year, and federal receipts
($billions) (Chapter 16)

FFCHAIN Rater and ratings for restaurants A, B, C, and D
(Chapter 11)

FIFO Historical cost ($) and audited value ($) for inventory
items (Chapter 8)

FIRERUNS Week and number of fire runs (Chapter 17)

FLYASH Fly ash percentage and strength in psi (Chapter 15)

FORCE Force required to break an insulator (Chapters 2,
3, 8, and 9)

FOULSPC Number of foul shots made and number taken
(Chapter 17)

FREEPORT Address, appraised value ($thousands), property
size (acres), house size (square feet), age, number of rooms,
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number of bathrooms, and number of cars that can be parked
in the garage located in Freeport, New York (Chapter 15)
FRUIT Fruit and year, price ($), and quantity (Chapter 16)
FUNDTRAN Day, number of new investigations, and
number of investigations closed (Chapter 17)
FURNITURE Days between receipt and resolution of
complaints regarding purchased furniture (Chapters 2, 3, 8,
and 9)
GASOLINE Year, gasoline price, 1980 price index, and
1995 price index (Chapter 16)
GAS PRICES Month and price per gallon ($) (Chapters 2
and 16)
GCFREEROSLYN Address, appraised value ($thou-
sands), location, property size (acres), house size (square
feet), age, number of rooms, number of bathrooms, and
number of cars that can be parked in the garage (Chapter 15)
GCROSLYN Address, appraised value ($thousands), loca-
tion, property size (acres), house size (square feet), age,
number of rooms, number of bathrooms, and number of cars
that can be parked in the garage (Chapters 14 and 15)
GDP Year and real gross domestic product (Chapter 16)
GLENCOVE Address, appraised value ($thousands),
property size (acres), house size (square feet), age, number
of rooms, number of bathrooms, and number of cars that can
be parked in the garage in Glen Cove, New York (Chapters
14 and 15)
GOLD Quarter, coded quarter, price ($) (Chapter 16)
GOLFBALL Distance for designs 1, 2, 3, and 4 (Chapters
11 and 12)
GPIGMAT GMAT scores and GPA (Chapter 13)
GRADSURVEY ID number, gender, age (as of last birth-
day), graduate major (accounting, economics and finance,
management, marketing/retailing, other, undecided), current
graduate cumulative grade point average, undergraduate
major (biological sciences, business, computers, engineer-
ing, other), undergraduate cumulative grade point average,
current employment status (full-time, part-time, unem-
ployed), number of different full-time jobs held in the
past 10 years, expected salary upon completion of MBA
($thousands), amount spent for books and supplies this
semester, satisfaction with student advising services on
campus, type of computer owned, text messages per week,
and wealth accumulated to feel rich (Chapters 2, 3, 4, 6, 8,
10, 11, and 12)
GRANULE Granule loss in Boston and Vermont shingles
(Chapters 3, 8, 9, and 10)
HARNSWELL Day and diameter of cam rollers (in
inches) (Chapter 17)
HEATINGOIL Monthly consumption of heating oil (gal-
lons), temperature (degrees Fahrenheit), attic insulation
(inches), and style (0 = not ranch, 1 = ranch) (Chapters 14
and 15)
HEMLOCKFARMS Asking price ($thousands), hot tub (0
= no, 1 = yes), rooms, lake view (0 = no, 1 = yes), bathrooms,

bedrooms, loft/den, finished basement, and number of acres
(Chapter 15)
HOMES Price ($thousands), location, condition, bed-
rooms, bathrooms, and other rooms (Chapter 18)
HOSPADM Day, number of admissions, mean processing
time (in hours), range of processing times, and proportion of
laboratory rework (over a 30-day period) (Chapter 17)
HOTEL1 Day, number of rooms studied, number of
nonconforming rooms per day over a 28-day period, and
proportion of nonconforming items (Chapter 17)
HOTEL2 Day and delivery time for subgroups of five
luggage deliveries per day over a 28-day period (Chapter 17)
HOTELPRICES City and cost (in English pounds) of two-
star, three-star, and four-star hotels (Chapters 2 and 3)
HOTELUK City and cost of a hotel room ($) (Chapter 3)
HOUSE1 Selling price ($thousands), assessed value
($thousands), type (new = 0, old = 1), and time period of sale
for 30 houses (Chapters 13, 14, and 15)
HOUSE2 Assessed value ($thousands), size of heating area
(in thousands of square feet), and age (in years) for 15
houses (Chapters 13 and 14)
HOUSE3 Assessed value ($thousands), size (in thousands
of square feet), and presence of a fireplace for 15 houses
(Chapter 14)
ICECREAM Daily temperature (in degrees Fahrenheit)
and sales ($thousands) for 21 days (Chapter 13)
INDICES Year and yearly rate of return (in percentage) for
the Dow Jones Industrial Average (DJIA), the Standards &
Poor’s 500 (S&P 500), and the technology-heavy NASDAQ
Composite (NASDAQ) (Chapter 3)
INSURANCE Processing time in days for insurance poli-
cies (Chapters 3, 8, and 9)
INTAGLIO Surface hardness of untreated and treated steel
plates (Chapter 10)
INVOICE Number of invoices processed and amount of
time (in hours) for 30 days (Chapter 13)
INVOICES Amount recorded (in dollars) from sales
invoices (Chapter 9)
ITEMERR Amount of error (in dollars) from 200 items
(Chapter 8)
LARGEST BONDS Bond fund and one-year return of
bond funds (Chapter 3)
LAUNDRY Detergent brand and dirt (in pounds) removed
for cycle times of 18, 20, 22, and 24 (Chapter 11)
LOANS AND LEASES Name of bank, state, zip code,
number of domestic and foreign offices, ownership type,
regulator, Federal Reserve district, total deposits ($thou-
sands), gross loans and leases ($thousands), all real estate
loans ($thousands), construction and development loans
($thousands), commercial real estate ($thousands), multi-
family residential real estate ($thousands), 1–4 family resi-
dential loans, ($thousands), farmland loans ($thousands),
commercial and industrial loans ($thousands), credit card
loans ($thousands), related plans ($thousands), other loans
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to individuals ($thousands), and all other loans and leases
($thousands) (Chapter 18)

LOGPURCH Upgraded (0 = no, 1 = yes), purchases
($thousands), and extra cards (Chapter 14)

LUGGAGE Delivery time (in minutes) for luggage in
Wing A and Wing B of a hotel (Chapters 10 and 12)

MANAGERS Sales (ratio of yearly sales divided by the tar-
get sales value for that region), score from the Wonderlic
Personnel Test, score on the Strong-Campbell Interest
Inventory Test, number of years of selling experience prior
to becoming a sales manager, and whether the sales manager
has a degree in electrical engineering (Chapter 15)

MBA Success (0 = did not complete, 1 = completed), GPA,
and GMAT (Chapter 14)

MCDONALDS Year, coded year, and annual total revenues
($billions) at McDonald’s Corporation (Chapter 16)

MEASUREMENT Sample, in-line measurement, and ana-
lytical lab measurement (Chapter 10)

MEDICARE Difference in amount reimbursed and amount
that should have been reimbursed for office visits (Chapter 8)

MEDREC Day, number of discharged patients, and number
of records not processed for a 30-day period (Chapter 17)

METALS Year and the yearly rate of return (in percentage)
for platinum, gold, and silver (Chapter 3)

MINING Day, amount stacked, and downtime in minutes
(Chapter 18)

MINING2 Day, minutes of downtime due to mechanical,
electrical, tonnage restriction, operator, and no feed
(Chapter 18)

MMCDRATE Bank, money market rate, one-year CD rate,
two-year CD rate, and five-year CD rate (Chapter 11)

MOISTURE Moisture content of Boston shingles and
Vermont shingles (Chapter 9)

MOVIE Title, box office gross ($millions), and DVD
revenue ($millions) (Chapter 13)

MOVIE ATTENDANCE Year and movie attendance
(billions) (Chapter 16)

MOVIE SHARE Type of movie, number of movies, gross
($millions), and number of tickets (millions) (Chapter 2)

MOVIEGROSS Year and combined gross of movies
($millions) (Chapter 2)

MOVING Labor hours, cubic feet, number of large pieces
of furniture, and availability of an elevator (Chapters 13
and 14)

MUTUAL FUNDS Category, objective, assets ($millions),
fees, expense ratio, 2006 return, three-year return, five-year
return, and risk (Chapter 2)

MYELOMA Patient, measurement before transplant, and
measurement after transplant (Chapter 10)

NASCAR Year and number of accidents (Chapter 16)

NATURAL GAS Month, wellhead, price, and residential
price (Chapter 16)
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NBA2010 Team, number of wins, points per game (for
team, opponent, and the difference between team and oppo-
nent), field goal (shots made) percentage (for team, oppo-
nent, and the difference between team and opponent), steals
per game (for team, opponent, and the difference between
team and opponent), and rebound percentage (for team,
opponent, and the difference between team and opponent)
(Chapters 14 and 15)

NBAVALUES Team, annual revenue ($millions), and value
($millions) for NBA franchises (Chapters 2, 3, and 13)

NEIGHBOR Selling price ($thousands), number of rooms,
and neighborhood location (0 = east, 1 = west) (Chapter 14)

NEW HOME PRICES Year and mean price ($thousands)
(Chapter 2)

OIL&GAS Week, price of oil per barrel, and price of a gal-
lon of gasoline ($) (Chapter 13)

OMNIPOWER Bars sold, price (cents), and promotion
expenses ($) (Chapter 14)

ORDER Time in minutes to fill orders for a population of
200 (Chapter 8)

O-RING Flight number, temperature, and O-ring damage
index (Chapter 13)

PAINRELIEF Temperature and dissolve times (seconds)
for Equate, Kroger, and Alka-Seltzer tablets (Chapter 11)

PALLET Weight of Boston shingles and weight of Vermont
shingles (Chapters 2, 8, 9, and 10)

PARACHUTE Tensile strength of parachutes from suppli-
ers 1, 2, 3, and 4; the sample means and the sample standard
deviations for the four suppliers in rows 8 and 9 (Chapters
11 and 12)

PARACHUTE2 Loom and tensile strength of parachutes
from suppliers 1, 2, 3, and 4 (Chapter 11)

PASTA Type of pasta (A = American, I = Italian), weight
for 4-minute cooking time, and weight for 8-minute cooking
time (Chapter 11)

PEN Gender, ad, and product rating (Chapters 11 and 12)

PERFORM Performance rating before and after motiva-
tional training (Chapter 10)

PETFOOD Shelf space (in feet), weekly sales ($), and
aisle location (0 = back, 1 = front) (Chapters 13 and 14)

PHONE Time (in minutes) to clear telephone line problems
and location (1 = I and 2 = II) (Chapters 10 and 12)

PHOTO Developer strength, density at 10 minutes, and
density at 14 minutes (Chapters 11)

PIZZAHUT Gender (0 = female , 1 = male), price ($), and
purchase (0 = the student selected another pizzeria, 1 = stu-
dent selected Pizza Hut) (Chapter 14)

PIZZATIME Time period, delivery time for local restau-
rant, and delivery time for national chain (Chapter 10)

PLUMBINV Difference ($) between actual amounts
recorded on sales invoices and amounts entered into the
accounting system (Chapter 8)



POLIO Year and incidence rates per 100,000 persons of
reported poliomyelitis (Chapter 16)

POTATO Percentage of solids content in filter cake, acidity
(in pH), lower pressure, upper pressure, cake thickness,
varidrive speed, and drum speed setting (Chapter 15)

POTTERMOVIES Title, first weekend gross ($millions),
U.S. gross ($millions), and worldwide gross ($millions)
(Chapters 2, 3, and 13)

PROPERTYTAXES State and property taxes per capita ($)
(Chapters 2, 3, and 6)

PROTEIN Type of food, calories (in grams), protein,
percentage of calories from fat, percentage of calories from
saturated fat, and cholesterol (mg) (Chapters 2 and 3)

PTFALLS Month and patient falls (Chapter 17)

PUMPKIN Circumference and weight of pumpkins
(Chapter 13)

REALESTATE Value ($thousands), lot size (thousands of
sq. ft.), number of bedrooms, number of rooms, number of
bathrooms, age in years, annual taxes ($), type of parking
facility (none, one-car garage, two-car garage), location (A,
B, C, D, E), style of house (cape, expanded ranch, colonial,
ranch, split level), type of heating fuel (gas, oil), type of
heating system (hot air, hot water, other), type of swimming
pool (none, above ground, in ground), eat-in kitchen (absent,
present), central air-conditioning (absent, present), fireplace
(absent, present), connection to local sewer system (absent,
present), basement (absent, present), modern kitchen
(absent, present), and modern bathrooms (absent, present)
(Chapter 18)

REDWOOD Height (ft.), breast height diameter (in.), and
bark thickness (in.) (Chapters 13 and 14)

RENT Monthly rental cost (in dollars) and apartment size (in
square footage) (Chapter 13)

RESTAURANTS Location, food rating, decor rating, serv-
ice rating, summated rating, coded location (0 = city, 1 =
suburban), and cost of a meal (Chapters 2, 3, 10, 13, and 14)

RESTAURANTS2 Location, food rating, decor rating,
service rating, summated rating, coded location (0 = city, 1 =
suburban), and cost of a meal (Chapter 18)

RETURN 2009 UNSTACKED Intermediate government
return in 2009 and short-term corporate return in 2009
(Chapter 2)

ROSLYN Address, appraised value, property size (acres),
house size (square feet), age, number of rooms, number of
bathrooms, and number of cars that can be parked in the
garage (Chapter 15)

RUDYBIRD Day, total cases sold, and cases of Rudybird
sold (Chapter 17)

SAFETY Tour and number of unsafe acts (Chapter 17)

SATISFACTION Satisfaction (0 = unsatisfied, 1 = satis-
fied), delivery time difference in minutes (0 = no, 1 = yes),
and whether the person had been a previous customer of the
hotel (0 = no, 1 = yes) (Chapter 14)
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SAVINGSRATE-MMCD Bank, location, rate for a money
market account, and five-year CD (Chapters 2, 3, 6, and 8)
SCRUBBER Airflow, water flow, recirculating water flow,
orifice diameter, and NTU (Chapter 15)
SEALANT Sample number, sealant strength for Boston shin-
gles, and sealant strength for Vermont shingles (Chapter 17)
SEDANS Miles per gallon for 2010 family sedans
(Chapters 3 and 8)
SHOPPING1 Product, Costco price ($), and store brand
price ($) (Chapter 10)
SHOPPING2 Product, impulsive shopper price ($), savvy
shopper price ($), Costco price ($), and store brand price ($)
(Chapter 11)
SILVER Year and price of silver ($) (Chapter 16)
SILVER-Q Quarter, coded quarter, and price of silver ($)
(Chapter 16)
SITE Store number, square footage (in thousands of square
feet), and sales ($millions) (Chapter 13)
SOCCERVALUES Team, country, revenue ($millions),
and value ($millions) (Chapter 13)
SOLAR POWER Year and amount of solar power installed
(in megawatts) (Chapters 2 and 16)
SPONGE Day, number of sponges produced, number of
nonconforming sponges, and proportion of nonconforming
sponges (Chapter 17)
SPORTING Sales ($), age, annual population growth,
income ($), percentage with high school diploma, and per-
centage with college diploma (Chapters 13 and 15)
SPWATER Sample number and amount of magnesium
(Chapter 17)
STANDBY Standby hours, total staff present, remote
hours, Dubner hours, and labor hours (Chapters 14 and 15)
STEEL Error in actual length and specified length
(Chapters 2, 6, 8, and 9)
STOCK PERFORMANCE Decade and stock perform-
ance (%) (Chapters 2 and 16)
STOCKPRICES Week, and closing weekly stock price for
GE, Discovery, and Apple (Chapters 2 and 13)
STRATEGIC Year and number of barrels (billions) in U.S.
strategic oil reserve (Chapter 16)
STUDYTIME Gender and study time (Chapter 10)
SUPERMARKET Day, number of customers, and check-
out time (minutes) (Chapter 13)
SUV Miles per gallon for 2010 small SUVs (Chapters 3, 6,
and 8)
TAX Quarterly sales tax receipts ($thousands) (Chapter 3)
TAXES County taxes ($) and age of house (years) (Chapter 15)
TEA3 Sample number and weight of tea bags in ounces
(Chapter 17)
TEABAGS Weight of tea bags in ounces (Chapters 3, 8,
and 9)
TEABAGS2 Weight of tea bags in ounces (Chapter 12)



TELESPC Number of orders and number of corrections
over 30 days (Chapter 17)

TELLER Number of errors by tellers (Chapter 17)

TENSILE Sample number and strength (Chapter 17)

TESTRANK Rank scores and training method used (0 =
traditional, 1 = experimental) (Chapter 12)

THICKNESS Thickness, catalyst, pH, pressure, tempera-
ture, and voltage (Chapters 14 and 15)

TIMES Times to get ready (Chapter 3)

TOMATO Fertilizer and yield (Chapter 15)

TOMATO PRICE Year and price per pound ($) in the
United States (Chapter 16)

TOYS R US Quarter, coded quarter, revenue ($millions),
and three dummy variables for quarters (Chapter 16)

TRADE Days, number of undesirable trades, and total
number of trades made over a 30-day period (Chapter 17)

TRANSMIT Day and number of errors in transmission
(Chapter 17)

TRANSPORT Days and patient transport times (in min-
utes) (Chapter 17)

TRASHBAGS Weight required to break four brands of trash
bags (Kroger, Glad, Hefty, Tuff Stuff) (Chapters 11 and 12)

TRAVEL Week and average traffic on Google for searches
from the U. S. on travel scaled to the average traffic for the
entire time period based on a fixed point at the beginning of
the time period (Chapter 16)

TREASURY Year and interest rate (Chapter 16)

TROUGH Width of trough (Chapters 2, 3, 8, and 9)

TROUGH2 Width of trough (Chapter 12)

TRSNYC Year, unit value of the Diversified Equity Fund,
and unit value of the Stable Value Fund (Chapter 16)

TSMODEL1 Year, coded year, and three time series (I, II,
and III) (Chapter 16)

TSMODEL2 Year, coded year, and two time series (I and
II) (Chapter 16)

UNDERGRADSURVEY ID number, gender, age (as of last
birthday), class designation, major (accounting, computer
information systems, economics and finance, international
business, management, marketing, other, undecided) graduate
school intention (yes, no, undecided), cumulative grade point
average, current employment status, expected starting salary
($thousands), number of social networking sites registered
for, satisfaction with student advisement services on campus,
amount spent on books and supplies this semester, type of
computer preferred (desktop, laptop, tablet/notebook/net-
book), text messages per week, and wealth accumulated to
feel rich (Chapters 2, 3, 4, 6, 8, 10, 11, and 12)

UNDERWRITING Score on end-of-training exam, score
on proficiency exam, and training method (Chapter 14)

USEDAUTOS Car, model, year (2000 = 0), asking price in
($thousands), mileage (in thousands), age (in years), vehicle
type, and region of origin (Chapter 18)

UTILITY Utilities charges ($) for 50 one-bedroom apart-
ments (Chapters 2 and 6)
VB Time (in minutes) for nine students to write and run a
Visual Basic program (Chapter 10)
VEGGIEBURGER Calories and fat in veggie burgers
(Chapters 2 and 3)
WAIT Waiting times and seating times (in minutes) in a
restaurant (Chapter 6)
WALMART Quarter and quarterly revenues ($billions)
(Chapter 16)
WARECOST Distribution cost ($thousands), sales ($thou-
sands), and number of orders (Chapters 13, 14, and 15)
WAREHSE Day, units handled, and employee number
(Chapter 17)
WINE Expert, wine, and rating (Chapter 11)
WIP Processing times in days and plant number (Chapter 18)
WONDERLIC School, average Wonderlic score of foot-
ball players trying out for the NFL, and graduation rate
(Chapters 2, 3, and 13)
WORKFORCE Year, population, and size of the work-
force in thousands (Chapter 16)
YARN Side-by-side aspect and breaking strength scores for
30 psi, 40 psi, and 50 psi (Chapter 11)
YIELD Cleansing step, new etching step yield, and
standard etching step yield (Chapter 11)
YIELD-ONEWAY Yield for new method 1, new method 2,
and standard (Chapter 11)

Downloadable Online Topics
The downloadable online topics contain the optional topics for
this book. These files are stored in the Portable Document
Format (PDF) format that can be viewed in many web browsers
and utility programs, including Adobe Reader, the free pro-
gram available for download at get.adobe.com/reader/.

The downloadable online topics for this book are:

Binomial Section 8.7 Section 15.7

Poisson Section 9.6 Section 16.8

Section 5.6 Section 12.8 Chapter 19

Section 6.6 Section 12.9 ANOM

Section 7.6 Section 15.6 ANOP

Excel Guide Workbooks
Excel Guide workbooks contain model solutions that can be
reused as templates for solving other problems. The work-
books are featured in the In-Depth Excel instructions of the
Excel Guides and also serve to document the worksheets cre-
ated by many PHStat2 procedures and provide many of the
illustrations of Excel results throughout this book.

All of these workbooks are stored in the .xls format, com-
patible with all Excel versions. Most contain a COMPUTE
worksheet (often shown in this book) that presents results
as well as a COMPUTE_FORMULAS worksheet that
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presents the COMPUTE worksheet in formulas view, which
allows for the easy inspection of all worksheet formulas
used in the worksheet.

The Excel Guide workbooks for this book are:
Bayes
Binomial
Boxplot
c Chart
Capability
Chapter 2
Chi-Square
Chi-Square Variance
Chi-Square Worksheets
CIE Proportion
CIE sigma known
CIE sigma unknown
CIE Total Difference
CIE Total
Correlation
Covariance
Descriptive
Differences
Discrete Random Variable
Expected Monetary Value
Exponential
Exponential Smoothing
Exponential Trend
F Two Variances
Friedman Rank Test
Hypergeometric
Index Numbers
Kruskal-Wallis Worksheets
Lagged Predictors
Levene

Other Downloadable Files
Case Files These files support the Managing Ashland
MultiComm Services running case and the end-of-chapter
Digital Cases; they come packaged as a self-extracting
archive file. When this archive is expanded and extracted to
the folder you choose, you will notice that some supporting
files have been placed in one of three subfolders that the
self-extraction process creates. The Digital Cases require
Adobe Reader version 10 or later and some features of the
selected Digital Case files may require the Adobe Flash or
Adobe Air plug-ins.

Visual Explorations This Excel add-in is also packaged
as a self-extracting archive file that expands to three files.
The three files can be extracted to any folder you choose,
and all three must be present together in the same folder for
the add-in workbook to function properly.

PHStat2 readme file and PHStat2 setup file The files
for the add-in, designed to be used with Windows-based
Excel versions. The PHStat2 setup file is a self-extracting
program that will install PHStat2 on a Windows-based sys-
tem. If you plan to install PHStat2, first read Appendix
Section D.2 and then download and read the PHStat2
readme file for the latest and most detailed instructions for
installing PHStat2. You can also review the PHStat2 FAQs in
Appendix G for additional information.

McNemar
Moving Averages
Multiple Regression
Normal
NPP
One-Way ANOVA
Opportunity Loss
p Chart
Paired T
Poisson
Pooled-Variance T
Portfolio
Probabilities
Quartiles
R and XBar Chart
Random
Randomized Block
Sample Size Mean
Sample Size Proportion
SDS
Separate-Variance T
Simple Linear Regression
StackedAndUnstacked
T Mean
Two-Way ANOVA
Variability
Wilcoxon
Z Mean
Z Proportion
Z Two Proportions



D.1 Checking for and Applying Updates
Excel
To check for and apply Excel updates, your system must be connected to the Internet. You can
check and apply updates using one of two methods. If Internet Explorer is the default web
browser on your system, use the Excel “check for updates” feature. In Excel 2010, select
File ➔ Help ➔ Check for Updates and follow the instructions that appear on the web page
that is displayed. In Excel 2007, click the Office Button and then Excel Options (at the bottom
of the Office Button menu window). In the Excel options dialog box, click Resources in the
left pane and then in the right pane click Check for Updates and follow the instructions that
appear on the web page that is displayed.

If the first method fails for any reason, you can manually download Excel and Microsoft
Office updates by opening a web browser and going to office.microsoft.com/officeupdate. On
the web page that is displayed, you can find download links arranged by popularity as well as
by product version. If you use this second method, you need to know the exact version and sta-
tus of your copy of Excel. In Excel 2010, select File ➔ Help and note the information under
the heading “About Microsoft Excel.” In Excel 2007, click the Office Button and then Excel
Options. In the Excel options dialog box, click Resources in the left pane and then in the right
pane note the detail line under the heading “about Microsoft Office Excel 2007.” The numbers
and codes that follow the words “Microsoft Office Excel” indicate the version number and
updates already applied.

If you use Mac Excel, select Help ➔ Check for Updates to begin Microsoft AutoUpdate
for Mac, similar to Microsoft Update, described above, for checking and applying updates.

Special Notes About the Windows Update Service If you use a Microsoft Windows–based
system and have previously turned on the Windows Update service, your system has not necessar-
ily downloaded and applied all Excel updates. If you use Windows Update, you can upgrade for
free to the Microsoft Update service that searches for and downloads updates for all Microsoft
products, including Excel and Office. (You can learn more about the Microsoft Update service by
visiting www.microsoft.com/security/updates/mu.aspx.)

Minitab
To check for and apply Minitab updates, your system must be connected to the Internet. Select
Help ➔ Check for Updates. Follow directions, if any, that appear in the Minitab Software
Update Manager dialog box. If there are no new updates, you will see a dialog box that states
“There are no updates available.” Click OK in that dialog box and then click Cancel in the
Update Manager dialog box to continue with your Minitab session.

D.2 Concise Instructions for Installing PHStat2
If your system can run the Microsoft Windows–based Excel 2003, Excel 2007, or Excel 2010,
and has 15 MB of storage space free, you will be able to install and use PHStat2. If using
PHStat2:

• Check for and apply all Excel updates by using the instructions in Section D.1.
• Download and read the PHStat2 readme file for the latest information about PHStat2 (see

Appendix Section C.2). 
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• Download the PHStat2 setup program (see Appendix Section C.2).
• Install PHStat2 using the instructions in that section.
• Configure Excel to use PHStat2 (see Appendix Section D.3).

The PHStat2 setup program copies the PHStat2 files to your system and adds entries in the
Windows registry file on your system. Run the setup program only after first logging on to
Windows using a user account that has administrator privileges. (Running the setup program
with a Windows user account that does not include these privileges will prevent the setup pro-
gram from properly installing PHStat2.)

If your system runs Windows Vista, Windows 7, or certain third-party security programs,
you may see messages asking you to “permit” or “allow” specific system operations as the
setup program executes. If you do not give the setup program the necessary permissions,
PHStat2 will not be properly installed on your computer.

After the setup completes, check the installation by opening PHStat2. If the installation ran
properly, Excel will display a PHStat menu in the Add-Ins tab of the Office Ribbon (Excel 2007
or Excel 2010) or the Excel menu bar (Excel 2003). If you have skipped checking for and apply-
ing necessary Excel updates, or if some of the updates were unable to be applied, when you first
attempt to use PHStat2, you may see a “Compile Error” message that talks about a “hidden mod-
ule.” If this occurs, repeat the process of checking for and applying updates to Excel. (If the
bandwidth of the Internet connection is limited, you may need to use another connection.)

As you use PHStat2, check the PHStat2 website, www.pearsonhighered.com/phstat, on a
regular basis to see if any free updates are available for your version. For more information
about PHStat2 without going online, read Appendix Section G.1 on page 818.

D.3 Configuring Excel for PHStat2 Usage
To configure Excel security settings for PHStat2 usage:

1. In Excel 2010, select File ➔ Options. In Excel 2007, click the Office Button and then
click Excel Options (at the bottom of the Office Button menu window).

In the Excel Options dialog box:

2. Click Trust Center in the left pane and then click Trust Center Settings in the right pane
(see the top of Figure D.1).

In the Trust Center dialog box:

3. Click Add-ins in the next left pane, and in the Add-ins right pane clear all of the check-
boxes (see the bottom left of Figure D.1).

4. Click Macro Settings in the left pane, and in the Macro Settings right pane click Disable
all macros with notification and check Trust access to the VBA object model (see the
bottom right of Figure D.1).

5. Click OK to close the Trust Center dialog box.

Back in the Excel Options dialog box:

6. Click OK to finish.

www.pearsonhighered.com/phstat
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On some systems that have stringent security settings, you might need to modify step 5.
For such systems, in step 5, click Trusted Locations in the left pane and then, in the Trusted
Locations right pane, click Add new location to add the folder path to the PHStat2 add-in (typ-
ically C:\Program Files\PHStat2) and then click OK.

When you open PHStat2, Excel will display a Microsoft Excel Security Notice dialog box
(shown below). Click Enable Macros to enable PHStat2 to open and function.

F I G U R E D . 1
Configuring Excel security settings



APPENDIX D Software Configuration Details 795

D.4 Using the Visual Explorations Add-in Workbook
To use the Visual Explorations add-in workbook, first download the set of three files that com-
prise Visual Explorations from this book’s companion website (see Appendix C). Place the
three files together in a folder of your choosing. Next, use the Section D.3 instructions for con-
figuring Excel for PHStat2 usage. Then open the Visual Explorations.xla file in Excel and use
the VisualExplorations menu in the Add-Ins tab to select individual procedures.

D.5 Checking for the Presence of the Analysis ToolPak
To check for the presence of the Analysis ToolPak add-in (needed only if you will be using the
Analysis ToolPak Excel Guide instructions):

1. In Excel 2010, select File ➔ Options. In Excel 2007, click the Office Button and then
click Excel Options (at the bottom of the Office Button menu window).

In the Excel Options dialog box:

2. Click Add-Ins in the left pane and look for the entry Analysis ToolPak in the right pane,
under Active Application Add-ins.

3. If the entry appears, click OK.

If the entry does not appear in the Active Application Add-ins list, click Go. In the Add-Ins dia-
log box, check Analysis ToolPak in the Add-Ins available list and click OK. If Analysis ToolPak
does not appear in the list, rerun the Microsoft Office setup program to install this component.

The Analysis ToolPak add-in is not included and is not available for Mac Excel 2008 but is
included in older versions of Mac Excel.
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Column

00000 00001 11111 11112 22222 22223 33333 33334
Row 12345 67890 12345 67890 12345 67890 12345 67890

01 49280 88924 35779 00283 81163 07275 89863 02348
02 61870 41657 07468 08612 98083 97349 20775 45091
03 43898 65923 25078 86129 78496 97653 91550 08078
04 62993 93912 30454 84598 56095 20664 12872 64647
05 33850 58555 51438 85507 71865 79488 76783 31708
06 97340 03364 88472 04334 63919 36394 11095 92470
07 70543 29776 10087 10072 55980 64688 68239 20461
08 89382 93809 00796 95945 34101 81277 66090 88872
09 37818 72142 67140 50785 22380 16703 53362 44940
10 60430 22834 14130 96593 23298 56203 92671 15925
11 82975 66158 84731 19436 55790 69229 28661 13675
12 30987 71938 40355 54324 08401 26299 49420 59208
13 55700 24586 93247 32596 11865 63397 44251 43189
14 14756 23997 78643 75912 83832 32768 18928 57070
15 32166 53251 70654 92827 63491 04233 33825 69662
16 23236 73751 31888 81718 06546 83246 47651 04877
17 45794 26926 15130 82455 78305 55058 52551 47182
18 09893 20505 14225 68514 47427 56788 96297 78822
19 54382 74598 91499 14523 68479 27686 46162 83554
20 94750 89923 37089 20048 80336 94598 26940 36858
21 70297 34135 53140 33340 42050 82341 44104 82949
22 85157 47954 32979 26575 57600 40881 12250 73742
23 11100 02340 12860 74697 96644 89439 28707 25815
24 36871 50775 30592 57143 17381 68856 25853 35041
25 23913 48357 63308 16090 51690 54607 72407 55538
26 79348 36085 27973 65157 07456 22255 25626 57054
27 92074 54641 53673 54421 18130 60103 69593 49464
28 06873 21440 75593 41373 49502 17972 82578 16364
29 12478 37622 99659 31065 83613 69889 58869 29571
30 57175 55564 65411 42547 70457 03426 72937 83792
31 91616 11075 80103 07831 59309 13276 26710 73000
32 78025 73539 14621 39044 47450 03197 12787 47709
33 27587 67228 80145 10175 12822 86687 65530 49325
34 16690 20427 04251 64477 73709 73945 92396 68263
35 70183 58065 65489 31833 82093 16747 10386 59293
36 90730 35385 15679 99742 50866 78028 75573 67257
37 10934 93242 13431 24590 02770 48582 00906 58595
38 82462 30166 79613 47416 13389 80268 05085 96666
39 27463 10433 07606 16285 93699 60912 94532 95632
40 02979 52997 09079 92709 90110 47506 53693 49892
41 46888 69929 75233 52507 32097 37594 10067 67327
42 53638 83161 08289 12639 08141 12640 28437 09268
43 82433 61427 17239 89160 19666 08814 37841 12847
44 35766 31672 50082 22795 66948 65581 84393 15890
45 10853 42581 08792 13257 61973 24450 52351 16602
46 20341 27398 72906 63955 17276 10646 74692 48438
47 54458 90542 77563 51839 52901 53355 83281 19177
48 26337 66530 16687 35179 46560 00123 44546 79896
49 34314 23729 85264 05575 96855 23820 11091 79821
50 28603 10708 68933 34189 92166 15181 66628 58599
51 66194 28926 99547 16625 45515 67953 12108 57846
52 78240 43195 24837 32511 70880 22070 52622 61881
53 00833 88000 67299 68215 11274 55624 32991 17436
54 12111 86683 61270 58036 64192 90611 15145 01748
55 47189 99951 05755 03834 43782 90599 40282 51417
56 76396 72486 62423 27618 84184 78922 73561 52818
57 46409 17469 32483 09083 76175 19985 26309 91536

T A B L E E . 1
Table of Random
Numbers
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Column

00000 00001 11111 11112 22222 22223 33333 33334
Row 12345 67890 12345 67890 12345 67890 12345 67890

T A B L E E . 1
Table of Random
Numbers (continued)

58 74626 22111 87286 46772 42243 68046 44250 42439
59 34450 81974 93723 49023 58432 67083 36876 93391
60 36327 72135 33005 28701 34710 49359 50693 89311
61 74185 77536 84825 09934 99103 09325 67389 45869
62 12296 41623 62873 37943 25584 09609 63360 47270
63 90822 60280 88925 99610 42772 60561 76873 04117
64 72121 79152 96591 90305 10189 79778 68016 13747
65 95268 41377 25684 08151 61816 58555 54305 86189
66 92603 09091 75884 93424 72586 88903 30061 14457
67 18813 90291 05275 01223 79607 95426 34900 09778
68 38840 26903 28624 67157 51986 42865 14508 49315
69 05959 33836 53758 16562 41081 38012 41230 20528
70 85141 21155 99212 32685 51403 31926 69813 58781
71 75047 59643 31074 38172 03718 32119 69506 67143
72 30752 95260 68032 62871 58781 34143 68790 69766
73 22986 82575 42187 62295 84295 30634 66562 31442
74 99439 86692 90348 66036 48399 73451 26698 39437
75 20389 93029 11881 71685 65452 89047 63669 02656
76 39249 05173 68256 36359 20250 68686 05947 09335
77 96777 33605 29481 20063 09398 01843 35139 61344
78 04860 32918 10798 50492 52655 33359 94713 28393
79 41613 42375 00403 03656 77580 87772 86877 57085
80 17930 00794 53836 53692 67135 98102 61912 11246
81 24649 31845 25736 75231 83808 98917 93829 99430
82 79899 34061 54308 59358 56462 58166 97302 86828
83 76801 49594 81002 30397 52728 15101 72070 33706
84 36239 63636 38140 65731 39788 06872 38971 53363
85 07392 64449 17886 63632 53995 17574 22247 62607
86 67133 04181 33874 98835 67453 59734 76381 63455
87 77759 31504 32832 70861 15152 29733 75371 39174
88 85992 72268 42920 20810 29361 51423 90306 73574
89 79553 75952 54116 65553 47139 60579 09165 85490
90 41101 17336 48951 53674 17880 45260 08575 49321
91 36191 17095 32123 91576 84221 78902 82010 30847
92 62329 63898 23268 74283 26091 68409 69704 82267
93 14751 13151 93115 01437 56945 89661 67680 79790
94 48462 59278 44185 29616 76537 19589 83139 28454
95 29435 88105 59651 44391 74588 55114 80834 85686
96 28340 29285 12965 14821 80425 16602 44653 70467
97 02167 58940 27149 80242 10587 79786 34959 75339
98 17864 00991 39557 54981 23588 81914 37609 13128
99 79675 80605 60059 35862 00254 36546 21545 78179

100 72335 82037 92003 34100 29879 46613 89720 13274

Source: Partially extracted from the Rand Corporation, A Million Random Digits with 100,000 Normal Deviates
(Glencoe, IL, The Free Press, 1955).
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T A B L E E . 2
The Cumulative Standardized Normal Distribution
Entry represents area under the cumulative standardized 
normal distribution from to Zq-

Cumulative Probabilities

Z 0.00 0.01 0.02 0.03 0.04 0.05 0.06 0.07 0.08 0.09

-6.0 0.000000001
-5.5 0.000000019
-5.0 0.000000287
-4.5 0.000003398
-4.0 0.000031671
-3.9 0.00005 0.00005 0.00004 0.00004 0.00004 0.00004 0.00004 0.00004 0.00003 0.00003
-3.8 0.00007 0.00007 0.00007 0.00006 0.00006 0.00006 0.00006 0.00005 0.00005 0.00005
-3.7 0.00011 0.00010 0.00010 0.00010 0.00009 0.00009 0.00008 0.00008 0.00008 0.00008
-3.6 0.00016 0.00015 0.00015 0.00014 0.00014 0.00013 0.00013 0.00012 0.00012 0.00011
-3.5 0.00023 0.00022 0.00022 0.00021 0.00020 0.00019 0.00019 0.00018 0.00017 0.00017
-3.4 0.00034 0.00032 0.00031 0.00030 0.00029 0.00028 0.00027 0.00026 0.00025 0.00024
-3.3 0.00048 0.00047 0.00045 0.00043 0.00042 0.00040 0.00039 0.00038 0.00036 0.00035
-3.2 0.00069 0.00066 0.00064 0.00062 0.00060 0.00058 0.00056 0.00054 0.00052 0.00050
-3.1 0.00097 0.00094 0.00090 0.00087 0.00084 0.00082 0.00079 0.00076 0.00074 0.00071
-3.0 0.00135 0.00131 0.00126 0.00122 0.00118 0.00114 0.00111 0.00107 0.00103 0.00100
-2.9 0.0019 0.0018 0.0018 0.0017 0.0016 0.0016 0.0015 0.0015 0.0014 0.0014
-2.8 0.0026 0.0025 0.0024 0.0023 0.0023 0.0022 0.0021 0.0021 0.0020 0.0019
-2.7 0.0035 0.0034 0.0033 0.0032 0.0031 0.0030 0.0029 0.0028 0.0027 0.0026
-2.6 0.0047 0.0045 0.0044 0.0043 0.0041 0.0040 0.0039 0.0038 0.0037 0.0036
-2.5 0.0062 0.0060 0.0059 0.0057 0.0055 0.0054 0.0052 0.0051 0.0049 0.0048
-2.4 0.0082 0.0080 0.0078 0.0075 0.0073 0.0071 0.0069 0.0068 0.0066 0.0064
-2.3 0.0107 0.0104 0.0102 0.0099 0.0096 0.0094 0.0091 0.0089 0.0087 0.0084
-2.2 0.0139 0.0136 0.0132 0.0129 0.0125 0.0122 0.0119 0.0116 0.0113 0.0110
-2.1 0.0179 0.0174 0.0170 0.0166 0.0162 0.0158 0.0154 0.0150 0.0146 0.0143
-2.0 0.0228 0.0222 0.0217 0.0212 0.0207 0.0202 0.0197 0.0192 0.0188 0.0183
-1.9 0.0287 0.0281 0.0274 0.0268 0.0262 0.0256 0.0250 0.0244 0.0239 0.0233
-1.8 0.0359 0.0351 0.0344 0.0336 0.0329 0.0322 0.0314 0.0307 0.0301 0.0294
-1.7 0.0446 0.0436 0.0427 0.0418 0.0409 0.0401 0.0392 0.0384 0.0375 0.0367
-1.6 0.0548 0.0537 0.0526 0.0516 0.0505 0.0495 0.0485 0.0475 0.0465 0.0455
-1.5 0.0668 0.0655 0.0643 0.0630 0.0618 0.0606 0.0594 0.0582 0.0571 0.0559
-1.4 0.0808 0.0793 0.0778 0.0764 0.0749 0.0735 0.0721 0.0708 0.0694 0.0681
-1.3 0.0968 0.0951 0.0934 0.0918 0.0901 0.0885 0.0869 0.0853 0.0838 0.0823
-1.2 0.1151 0.1131 0.1112 0.1093 0.1075 0.1056 0.1038 0.1020 0.1003 0.0985
-1.1 0.1357 0.1335 0.1314 0.1292 0.1271 0.1251 0.1230 0.1210 0.1190 0.1170
-1.0 0.1587 0.1562 0.1539 0.1515 0.1492 0.1469 0.1446 0.1423 0.1401 0.1379
-0.9 0.1841 0.1814 0.1788 0.1762 0.1736 0.1711 0.1685 0.1660 0.1635 0.1611
-0.8 0.2119 0.2090 0.2061 0.2033 0.2005 0.1977 0.1949 0.1922 0.1894 0.1867
-0.7 0.2420 0.2388 0.2358 0.2327 0.2296 0.2266 0.2236 0.2206 0.2177 0.2148
-0.6 0.2743 0.2709 0.2676 0.2643 0.2611 0.2578 0.2546 0.2514 0.2482 0.2451
-0.5 0.3085 0.3050 0.3015 0.2981 0.2946 0.2912 0.2877 0.2843 0.2810 0.2776
-0.4 0.3446 0.3409 0.3372 0.3336 0.3300 0.3264 0.3228 0.3192 0.3156 0.3121
-0.3 0.3821 0.3783 0.3745 0.3707 0.3669 0.3632 0.3594 0.3557 0.3520 0.3483
-0.2 0.4207 0.4168 0.4129 0.4090 0.4052 0.4013 0.3974 0.3936 0.3897 0.3859
-0.1 0.4602 0.4562 0.4522 0.4483 0.4443 0.4404 0.4364 0.4325 0.4286 0.4247
-0.0 0.5000 0.4960 0.4920 0.4880 0.4840 0.4801 0.4761 0.4721 0.4681 0.4641

0Z–∞



T A B L E E . 2
The Cumulative Standardized Normal Distribution (continued)
Entry represents area under the cumulative standardized 
normal distribution from to Zq-

Cumulative Probabilities

Z 0.00 0.01 0.02 0.03 0.04 0.05 0.06 0.07 0.08 0.09
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0.0 0.5000 0.5040 0.5080 0.5120 0.5160 0.5199 0.5239 0.5279 0.5319 0.5359
0.1 0.5398 0.5438 0.5478 0.5517 0.5557 0.5596 0.5636 0.5675 0.5714 0.5753
0.2 0.5793 0.5832 0.5871 0.5910 0.5948 0.5987 0.6026 0.6064 0.6103 0.6141
0.3 0.6179 0.6217 0.6255 0.6293 0.6331 0.6368 0.6406 0.6443 0.6480 0.6517
0.4 0.6554 0.6591 0.6628 0.6664 0.6700 0.6736 0.6772 0.6808 0.6844 0.6879
0.5 0.6915 0.6950 0.6985 0.7019 0.7054 0.7088 0.7123 0.7157 0.7190 0.7224
0.6 0.7257 0.7291 0.7324 0.7357 0.7389 0.7422 0.7454 0.7486 0.7518 0.7549
0.7 0.7580 0.7612 0.7642 0.7673 0.7704 0.7734 0.7764 0.7794 0.7823 0.7852
0.8 0.7881 0.7910 0.7939 0.7967 0.7995 0.8023 0.8051 0.8078 0.8106 0.8133
0.9 0.8159 0.8186 0.8212 0.8238 0.8264 0.8289 0.8315 0.8340 0.8365 0.8389
1.0 0.8413 0.8438 0.8461 0.8485 0.8508 0.8531 0.8554 0.8577 0.8599 0.8621
1.1 0.8643 0.8665 0.8686 0.8708 0.8729 0.8749 0.8770 0.8790 0.8810 0.8830
1.2 0.8849 0.8869 0.8888 0.8907 0.8925 0.8944 0.8962 0.8980 0.8997 0.9015
1.3 0.9032 0.9049 0.9066 0.9082 0.9099 0.9115 0.9131 0.9147 0.9162 0.9177
1.4 0.9192 0.9207 0.9222 0.9236 0.9251 0.9265 0.9279 0.9292 0.9306 0.9319
1.5 0.9332 0.9345 0.9357 0.9370 0.9382 0.9394 0.9406 0.9418 0.9429 0.9441
1.6 0.9452 0.9463 0.9474 0.9484 0.9495 0.9505 0.9515 0.9525 0.9535 0.9545
1.7 0.9554 0.9564 0.9573 0.9582 0.9591 0.9599 0.9608 0.9616 0.9625 0.9633
1.8 0.9641 0.9649 0.9656 0.9664 0.9671 0.9678 0.9686 0.9693 0.9699 0.9706
1.9 0.9713 0.9719 0.9726 0.9732 0.9738 0.9744 0.9750 0.9756 0.9761 0.9767
2.0 0.9772 0.9778 0.9783 0.9788 0.9793 0.9798 0.9803 0.9808 0.9812 0.9817
2.1 0.9821 0.9826 0.9830 0.9834 0.9838 0.9842 0.9846 0.9850 0.9854 0.9857
2.2 0.9861 0.9864 0.9868 0.9871 0.9875 0.9878 0.9881 0.9884 0.9887 0.9890
2.3 0.9893 0.9896 0.9898 0.9901 0.9904 0.9906 0.9909 0.9911 0.9913 0.9916
2.4 0.9918 0.9920 0.9922 0.9925 0.9927 0.9929 0.9931 0.9932 0.9934 0.9936
2.5 0.9938 0.9940 0.9941 0.9943 0.9945 0.9946 0.9948 0.9949 0.9951 0.9952
2.6 0.9953 0.9955 0.9956 0.9957 0.9959 0.9960 0.9961 0.9962 0.9963 0.9964
2.7 0.9965 0.9966 0.9967 0.9968 0.9969 0.9970 0.9971 0.9972 0.9973 0.9974
2.8 0.9974 0.9975 0.9976 0.9977 0.9977 0.9978 0.9979 0.9979 0.9980 0.9981
2.9 0.9981 0.9982 0.9982 0.9983 0.9984 0.9984 0.9985 0.9985 0.9986 0.9986
3.0 0.99865 0.99869 0.99874 0.99878 0.99882 0.99886 0.99889 0.99893 0.99897 0.99900
3.1 0.99903 0.99906 0.99910 0.99913 0.99916 0.99918 0.99921 0.99924 0.99926 0.99929
3.2 0.99931 0.99934 0.99936 0.99938 0.99940 0.99942 0.99944 0.99946 0.99948 0.99950
3.3 0.99952 0.99953 0.99955 0.99957 0.99958 0.99960 0.99961 0.99962 0.99964 0.99965
3.4 0.99966 0.99968 0.99969 0.99970 0.99971 0.99972 0.99973 0.99974 0.99975 0.99976
3.5 0.99977 0.99978 0.99978 0.99979 0.99980 0.99981 0.99981 0.99982 0.99983 0.99983
3.6 0.99984 0.99985 0.99985 0.99986 0.99986 0.99987 0.99987 0.99988 0.99988 0.99989
3.7 0.99989 0.99990 0.99990 0.99990 0.99991 0.99991 0.99992 0.99992 0.99992 0.99992
3.8 0.99993 0.99993 0.99993 0.99994 0.99994 0.99994 0.99994 0.99995 0.99995 0.99995
3.9 0.99995 0.99995 0.99996 0.99996 0.99996 0.99996 0.99996 0.99996 0.99997 0.99997
4.0 0.999968329
4.5 0.999996602
5.0 0.999999713
5.5 0.999999981
6.0 0.999999999

0 Z–∞



T A B L E E . 3
Critical Values of t

For a particular number of degrees of freedom, entry represents
the critical value of t corresponding to the cumulative probability

and a specified upper-tail area .1a211 - a2
Cumulative Probabilities

0.75 0.90 0.95 0.975 0.99 0.995

Degrees of 
Freedom

Upper-Tail Areas

0.25 0.10 0.05 0.025 0.01 0.005

1 1.0000 3.0777 6.3138 12.7062 31.8207 63.6574
2 0.8165 1.8856 2.9200 4.3027 6.9646 9.9248
3 0.7649 1.6377 2.3534 3.1824 4.5407 5.8409
4 0.7407 1.5332 2.1318 2.7764 3.7469 4.6041
5 0.7267 1.4759 2.0150 2.5706 3.3649 4.0322

6 0.7176 1.4398 1.9432 2.4469 3.1427 3.7074
7 0.7111 1.4149 1.8946 2.3646 2.9980 3.4995
8 0.7064 1.3968 1.8595 2.3060 2.8965 3.3554
9 0.7027 1.3830 1.8331 2.2622 2.8214 3.2498

10 0.6998 1.3722 1.8125 2.2281 2.7638 3.1693

11 0.6974 1.3634 1.7959 2.2010 2.7181 3.1058
12 0.6955 1.3562 1.7823 2.1788 2.6810 3.0545
13 0.6938 1.3502 1.7709 2.1604 2.6503 3.0123
14 0.6924 1.3450 1.7613 2.1448 2.6245 2.9768
15 0.6912 1.3406 1.7531 2.1315 2.6025 2.9467

16 0.6901 1.3368 1.7459 2.1199 2.5835 2.9208
17 0.6892 1.3334 1.7396 2.1098 2.5669 2.8982
18 0.6884 1.3304 1.7341 2.1009 2.5524 2.8784
19 0.6876 1.3277 1.7291 2.0930 2.5395 2.8609
20 0.6870 1.3253 1.7247 2.0860 2.5280 2.8453

21 0.6864 1.3232 1.7207 2.0796 2.5177 2.8314
22 0.6858 1.3212 1.7171 2.0739 2.5083 2.8188
23 0.6853 1.3195 1.7139 2.0687 2.4999 2.8073
24 0.6848 1.3178 1.7109 2.0639 2.4922 2.7969
25 0.6844 1.3163 1.7081 2.0595 2.4851 2.7874

26 0.6840 1.3150 1.7056 2.0555 2.4786 2.7787
27 0.6837 1.3137 1.7033 2.0518 2.4727 2.7707
28 0.6834 1.3125 1.7011 2.0484 2.4671 2.7633
29 0.6830 1.3114 1.6991 2.0452 2.4620 2.7564
30 0.6828 1.3104 1.6973 2.0423 2.4573 2.7500

31 0.6825 1.3095 1.6955 2.0395 2.4528 2.7440
32 0.6822 1.3086 1.6939 2.0369 2.4487 2.7385
33 0.6820 1.3077 1.6924 2.0345 2.4448 2.7333
34 0.6818 1.3070 1.6909 2.0322 2.4411 2.7284
35 0.6816 1.3062 1.6896 2.0301 2.4377 2.7238

36 0.6814 1.3055 1.6883 2.0281 2.4345 2.7195
37 0.6812 1.3049 1.6871 2.0262 2.4314 2.7154
38 0.6810 1.3042 1.6860 2.0244 2.4286 2.7116
39 0.6808 1.3036 1.6849 2.0227 2.4258 2.7079
40 0.6807 1.3031 1.6839 2.0211 2.4233 2.7045

41 0.6805 1.3025 1.6829 2.0195 2.4208 2.7012
42 0.6804 1.3020 1.6820 2.0181 2.4185 2.6981
43 0.6802 1.3016 1.6811 2.0167 2.4163 2.6951
44 0.6801 1.3011 1.6802 2.0154 2.4141 2.6923
45 0.6800 1.3006 1.6794 2.0141 2.4121 2.6896

46 0.6799 1.3002 1.6787 2.0129 2.4102 2.6870
47 0.6797 1.2998 1.6779 2.0117 2.4083 2.6846
48 0.6796 1.2994 1.6772 2.0106 2.4066 2.6822

0 t

α
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T A B L E E . 3
Critical Values of t
(continued)

Cumulative Probabilities

0.75 0.90 0.95 0.975 0.99 0.995

Degrees of 
Freedom

Upper-Tail Areas

0.25 0.10 0.05 0.025 0.01 0.005

801

49 0.6795 1.2991 1.6766 2.0096 2.4049 2.6800
50 0.6794 1.2987 1.6759 2.0086 2.4033 2.6778

51 0.6793 1.2984 1.6753 2.0076 2.4017 2.6757
52 0.6792 1.2980 1.6747 2.0066 2.4002 2.6737
53 0.6791 1.2977 1.6741 2.0057 2.3988 2.6718
54 0.6791 1.2974 1.6736 2.0049 2.3974 2.6700
55 0.6790 1.2971 1.6730 2.0040 2.3961 2.6682

56 0.6789 1.2969 1.6725 2.0032 2.3948 2.6665
57 0.6788 1.2966 1.6720 2.0025 2.3936 2.6649
58 0.6787 1.2963 1.6716 2.0017 2.3924 2.6633
59 0.6787 1.2961 1.6711 2.0010 2.3912 2.6618
60 0.6786 1.2958 1.6706 2.0003 2.3901 2.6603

61 0.6785 1.2956 1.6702 1.9996 2.3890 2.6589
62 0.6785 1.2954 1.6698 1.9990 2.3880 2.6575
63 0.6784 1.2951 1.6694 1.9983 2.3870 2.6561
64 0.6783 1.2949 1.6690 1.9977 2.3860 2.6549
65 0.6783 1.2947 1.6686 1.9971 2.3851 2.6536

66 0.6782 1.2945 1.6683 1.9966 2.3842 2.6524
67 0.6782 1.2943 1.6679 1.9960 2.3833 2.6512
68 0.6781 1.2941 1.6676 1.9955 2.3824 2.6501
69 0.6781 1.2939 1.6672 1.9949 2.3816 2.6490
70 0.6780 1.2938 1.6669 1.9944 2.3808 2.6479

71 0.6780 1.2936 1.6666 1.9939 2.3800 2.6469
72 0.6779 1.2934 1.6663 1.9935 2.3793 2.6459
73 0.6779 1.2933 1.6660 1.9930 2.3785 2.6449
74 0.6778 1.2931 1.6657 1.9925 2.3778 2.6439
75 0.6778 1.2929 1.6654 1.9921 2.3771 2.6430

76 0.6777 1.2928 1.6652 1.9917 2.3764 2.6421
77 0.6777 1.2926 1.6649 1.9913 2.3758 2.6412
78 0.6776 1.2925 1.6646 1.9908 2.3751 2.6403
79 0.6776 1.2924 1.6644 1.9905 2.3745 2.6395
80 0.6776 1.2922 1.6641 1.9901 2.3739 2.6387

81 0.6775 1.2921 1.6639 1.9897 2.3733 2.6379
82 0.6775 1.2920 1.6636 1.9893 2.3727 2.6371
83 0.6775 1.2918 1.6634 1.9890 2.3721 2.6364
84 0.6774 1.2917 1.6632 1.9886 2.3716 2.6356
85 0.6774 1.2916 1.6630 1.9883 2.3710 2.6349

86 0.6774 1.2915 1.6628 1.9879 2.3705 2.6342
87 0.6773 1.2914 1.6626 1.9876 2.3700 2.6335
88 0.6773 1.2912 1.6624 1.9873 2.3695 2.6329
89 0.6773 1.2911 1.6622 1.9870 2.3690 2.6322
90 0.6772 1.2910 1.6620 1.9867 2.3685 2.6316

91 0.6772 1.2909 1.6618 1.9864 2.3680 2.6309
92 0.6772 1.2908 1.6616 1.9861 2.3676 2.6303
93 0.6771 1.2907 1.6614 1.9858 2.3671 2.6297
94 0.6771 1.2906 1.6612 1.9855 2.3667 2.6291
95 0.6771 1.2905 1.6611 1.9853 2.3662 2.6286

96 0.6771 1.2904 1.6609 1.9850 2.3658 2.6280
97 0.6770 1.2903 1.6607 1.9847 2.3654 2.6275
98 0.6770 1.2902 1.6606 1.9845 2.3650 2.6269
99 0.6770 1.2902 1.6604 1.9842 2.3646 2.6264

100 0.6770 1.2901 1.6602 1.9840 2.3642 2.6259

110 0.6767 1.2893 1.6588 1.9818 2.3607 2.6213

120 0.6765 1.2886 1.6577 1.9799 2.3578 2.6174

q 0.6745 1.2816 1.6449 1.9600 2.3263 2.5758



T A B L E E . 4

Critical Values of x2

For a particular number of degrees of freedom, entry represents the critical value of 
corresponding to the cumulative probability and a specified upper-tail area .1a211 - a2 x2

Cumulative Probabilities

0.005 0.01 0.025 0.05 0.10 0.25 0.75 0.90 0.95 0.975 0.99 0.995

Degrees of
Freedom

Upper-Tail Areas ( )A

0.995 0.99 0.975 0.95 0.90 0.75 0.25 0.10 0.05 0.025 0.01 0.005

1 0.001 0.004 0.016 0.102 1.323 2.706 3.841 5.024 6.635 7.879
2 0.010 0.020 0.051 0.103 0.211 0.575 2.773 4.605 5.991 7.378 9.210 10.597
3 0.072 0.115 0.216 0.352 0.584 1.213 4.108 6.251 7.815 9.348 11.345 12.838
4 0.207 0.297 0.484 0.711 1.064 1.923 5.385 7.779 9.488 11.143 13.277 14.860
5 0.412 0.554 0.831 1.145 1.610 2.675 6.626 9.236 11.071 12.833 15.086 16.750

6 0.676 0.872 1.237 1.635 2.204 3.455 7.841 10.645 12.592 14.449 16.812 18.548
7 0.989 1.239 1.690 2.167 2.833 4.255 9.037 12.017 14.067 16.013 18.475 20.278
8 1.344 1.646 2.180 2.733 3.490 5.071 10.219 13.362 15.507 17.535 20.090 21.955
9 1.735 2.088 2.700 3.325 4.168 5.899 11.389 14.684 16.919 19.023 21.666 23.589

10 2.156 2.558 3.247 3.940 4.865 6.737 12.549 15.987 18.307 20.483 23.209 25.188

11 2.603 3.053 3.816 4.575 5.578 7.584 13.701 17.275 19.675 21.920 24.725 26.757
12 3.074 3.571 4.404 5.226 6.304 8.438 14.845 18.549 21.026 23.337 26.217 28.299
13 3.565 4.107 5.009 5.892 7.042 9.299 15.984 19.812 22.362 24.736 27.688 29.819
14 4.075 4.660 5.629 6.571 7.790 10.165 17.117 21.064 23.685 26.119 29.141 31.319
15 4.601 5.229 6.262 7.261 8.547 11.037 18.245 22.307 24.996 27.488 30.578 32.801

16 5.142 5.812 6.908 7.962 9.312 11.912 19.369 23.542 26.296 28.845 32.000 34.267
17 5.697 6.408 7.564 8.672 10.085 12.792 20.489 24.769 27.587 30.191 33.409 35.718
18 6.265 7.015 8.231 9.390 10.865 13.675 21.605 25.989 28.869 31.526 34.805 37.156
19 6.844 7.633 8.907 10.117 11.651 14.562 22.718 27.204 30.144 32.852 36.191 38.582
20 7.434 8.260 9.591 10.851 12.443 15.452 23.828 28.412 31.410 34.170 37.566 39.997

21 8.034 8.897 10.283 11.591 13.240 16.344 24.935 29.615 32.671 35.479 38.932 41.401
22 8.643 9.542 10.982 12.338 14.042 17.240 26.039 30.813 33.924 36.781 40.289 42.796
23 9.260 10.196 11.689 13.091 14.848 18.137 27.141 32.007 35.172 38.076 41.638 44.181
24 9.886 10.856 12.401 13.848 15.659 19.037 28.241 33.196 36.415 39.364 42.980 45.559
25 10.520 11.524 13.120 14.611 16.473 19.939 29.339 34.382 37.652 40.646 44.314 46.928

26 11.160 12.198 13.844 15.379 17.292 20.843 30.435 35.563 38.885 41.923 45.642 48.290
27 11.808 12.879 14.573 16.151 18.114 21.749 31.528 36.741 40.113 43.194 46.963 49.645
28 12.461 13.565 15.308 16.928 18.939 22.657 32.620 37.916 41.337 44.461 48.278 50.993
29 13.121 14.257 16.047 17.708 19.768 23.567 33.711 39.087 42.557 45.722 49.588 52.336
30 13.787 14.954 16.791 18.493 20.599 24.478 34.800 40.256 43.773 46.979 50.892 53.672

For larger values of degrees of freedom (df ) the expression may be used and the resulting upper-tail area can be found
from the cumulative standardized normal distribution (Table E.2).

Z = 22x2 - 221df 2 - 1

0

α

χ2

1 – �
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T A B L E E . 5
Critical Values of F

For a particular combination of numerator and denominator degrees of freedom, entry represents the critical values
of F corresponding to the cumulative probability and a specified upper-tail area ( ).a(1 - a)

Cumulative Probabilities = 0.95

Upper-Tail Areas = 0.05

Numerator, df1

Denominator,
df2 1 2 3 4 5 6 7 8 9 10 12 15 20 24 30 40 60 120 ˆ
1 161.40 199.50 215.70 224.60 230.20 234.00 236.80 238.90 240.50 241.90 243.90 245.90 248.00 249.10 250.10 251.10 252.20 253.30 254.30
2 18.51 19.00 19.16 19.25 19.30 19.33 19.35 19.37 19.38 19.40 19.41 19.43 19.45 19.45 19.46 19.47 19.48 19.49 19.50
3 10.13 9.55 9.28 9.12 9.01 8.94 8.89 8.85 8.81 8.79 8.74 8.70 8.66 8.64 8.62 8.59 8.57 8.55 8.53
4 7.71 6.94 6.59 6.39 6.26 6.16 6.09 6.04 6.00 5.96 5.91 5.86 5.80 5.77 5.75 5.72 5.69 5.66 5.63

5 6.61 5.79 5.41 5.19 5.05 4.95 4.88 4.82 4.77 4.74 4.68 4.62 4.56 4.53 4.50 4.46 4.43 4.40 4.36
6 5.99 5.14 4.76 4.53 4.39 4.28 4.21 4.15 4.10 4.06 4.00 3.94 3.87 3.84 3.81 3.77 3.74 3.70 3.67
7 5.59 4.74 4.35 4.12 3.97 3.87 3.79 3.73 3.68 3.64 3.57 3.51 3.44 3.41 3.38 3.34 3.30 3.27 3.23
8 5.32 4.46 4.07 3.84 3.69 3.58 3.50 3.44 3.39 3.35 3.28 3.22 3.15 3.12 3.08 3.04 3.01 2.97 2.93
9 5.12 4.26 3.86 3.63 3.48 3.37 3.29 3.23 3.18 3.14 3.07 3.01 2.94 2.90 2.86 2.83 2.79 2.75 2.71

10 4.96 4.10 3.71 3.48 3.33 3.22 3.14 3.07 3.02 2.98 2.91 2.85 2.77 2.74 2.70 2.66 2.62 2.58 2.54
11 4.84 3.98 3.59 3.36 3.20 3.09 3.01 2.95 2.90 2.85 2.79 2.72 2.65 2.61 2.57 2.53 2.49 2.45 2.40
12 4.75 3.89 3.49 3.26 3.11 3.00 2.91 2.85 2.80 2.75 2.69 2.62 2.54 2.51 2.47 2.43 2.38 2.34 2.30
13 4.67 3.81 3.41 3.18 3.03 2.92 2.83 2.77 2.71 2.67 2.60 2.53 2.46 2.42 2.38 2.34 2.30 2.25 2.21
14 4.60 3.74 3.34 3.11 2.96 2.85 2.76 2.70 2.65 2.60 2.53 2.46 2.39 2.35 2.31 2.27 2.22 2.18 2.13

15 4.54 3.68 3.29 3.06 2.90 2.79 2.71 2.64 2.59 2.54 2.48 2.40 2.33 2.29 2.25 2.20 2.16 2.11 2.07
16 4.49 3.63 3.24 3.01 2.85 2.74 2.66 2.59 2.54 2.49 2.42 2.35 2.28 2.24 2.19 2.15 2.11 2.06 2.01
17 4.45 3.59 3.20 2.96 2.81 2.70 2.61 2.55 2.49 2.45 2.38 2.31 2.23 2.19 2.15 2.10 2.06 2.01 1.96
18 4.41 3.55 3.16 2.93 2.77 2.66 2.58 2.51 2.46 2.41 2.34 2.27 2.19 2.15 2.11 2.06 2.02 1.97 1.92
19 4.38 3.52 3.13 2.90 2.74 2.63 2.54 2.48 2.42 2.38 2.31 2.23 2.16 2.11 2.07 2.03 1.98 1.93 1.88

20 4.35 3.49 3.10 2.87 2.71 2.60 2.51 2.45 2.39 2.35 2.28 2.20 2.12 2.08 2.04 1.99 1.95 1.90 1.84
21 4.32 3.47 3.07 2.84 2.68 2.57 2.49 2.42 2.37 2.32 2.25 2.18 2.10 2.05 2.01 1.96 1.92 1.87 1.81
22 4.30 3.44 3.05 2.82 2.66 2.55 2.46 2.40 2.34 2.30 2.23 2.15 2.07 2.03 1.98 1.91 1.89 1.84 1.78
23 4.28 3.42 3.03 2.80 2.64 2.53 2.44 2.37 2.32 2.27 2.20 2.13 2.05 2.01 1.96 1.91 1.86 1.81 1.76
24 4.26 3.40 3.01 2.78 2.62 2.51 2.42 2.36 2.30 2.25 2.18 2.11 2.03 1.98 1.94 1.89 1.84 1.79 1.73

25 4.24 3.39 2.99 2.76 2.60 2.49 2.40 2.34 2.28 2.24 2.16 2.09 2.01 1.96 1.92 1.87 1.82 1.77 1.71
26 4.23 3.37 2.98 2.74 2.59 2.47 2.39 2.32 2.27 2.22 2.15 2.07 1.99 1.95 1.90 1.85 1.80 1.75 1.69
27 4.21 3.35 2.96 2.73 2.57 2.46 2.37 2.31 2.25 2.20 2.13 2.06 1.97 1.93 1.88 1.84 1.79 1.73 1.67
28 4.20 3.34 2.95 2.71 2.56 2.45 2.36 2.29 2.24 2.19 2.12 2.04 1.96 1.91 1.87 1.82 1.77 1.71 1.65
29 4.18 3.33 2.93 2.70 2.55 2.43 2.35 2.28 2.22 2.18 2.10 2.03 1.94 1.90 1.85 1.81 1.75 1.70 1.64

30 4.17 3.32 2.92 2.69 2.53 2.42 2.33 2.27 2.21 2.16 2.09 2.01 1.93 1.89 1.84 1.79 1.74 1.68 1.62
40 4.08 3.23 2.84 2.61 2.45 2.34 2.25 2.18 2.12 2.08 2.00 1.92 1.84 1.79 1.74 1.69 1.64 1.58 1.51
60 4.00 3.15 2.76 2.53 2.37 2.25 2.17 2.10 2.04 1.99 1.92 1.84 1.75 1.70 1.65 1.59 1.53 1.47 1.39

120 3.92 3.07 2.68 2.45 2.29 2.17 2.09 2.02 1.96 1.91 1.83 1.75 1.66 1.61 1.55 1.50 1.43 1.35 1.25
q 3.84 3.00 2.60 2.37 2.21 2.10 2.01 1.94 1.88 1.83 1.75 1.67 1.57 1.52 1.46 1.39 1.32 1.22 1.00

0 F

α = 0.05
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0 F

α = 0.025

Cumulative Probabilities = 0.975

Upper-Tail Areas = 0.025

Numerator, df1

Denominator,
df2 1 2 3 4 5 6 7 8 9 10 12 15 20 24 30 40 60 120 ˆ

1 647.80 799.50 864.20 899.60 921.80 937.10 948.20 956.70 963.30 968.60 976.70 984.90 993.10 997.20 1,001.00 1,006.00 1,010.00 1,014.00 1,018.00
2 38.51 39.00 39.17 39.25 39.30 39.33 39.36 39.39 39.39 39.40 39.41 39.43 39.45 39.46 39.46 39.47 39.48 39.49 39.50
3 17.44 16.04 15.44 15.10 14.88 14.73 14.62 14.54 14.47 14.42 14.34 14.25 14.17 14.12 14.08 14.04 13.99 13.95 13.90
4 12.22 10.65 9.98 9.60 9.36 9.20 9.07 8.98 8.90 8.84 8.75 8.66 8.56 8.51 8.46 8.41 8.36 8.31 8.26

5 10.01 8.43 7.76 7.39 7.15 6.98 6.85 6.76 6.68 6.62 6.52 6.43 6.33 6.28 6.23 6.18 6.12 6.07 6.02
6 8.81 7.26 6.60 6.23 5.99 5.82 5.70 5.60 5.52 5.46 5.37 5.27 5.17 5.12 5.07 5.01 4.96 4.90 4.85
7 8.07 6.54 5.89 5.52 5.29 5.12 4.99 4.90 4.82 4.76 4.67 4.57 4.47 4.42 4.36 4.31 4.25 4.20 4.14
8 7.57 6.06 5.42 5.05 4.82 4.65 4.53 4.43 4.36 4.30 4.20 4.10 4.00 3.95 3.89 3.84 3.78 3.73 3.67
9 7.21 5.71 5.08 4.72 4.48 4.32 4.20 4.10 4.03 3.96 3.87 3.77 3.67 3.61 3.56 3.51 3.45 3.39 3.33

10 6.94 5.46 4.83 4.47 4.24 4.07 3.95 3.85 3.78 3.72 3.62 3.52 3.42 3.37 3.31 3.26 3.20 3.14 3.08
11 6.72 5.26 4.63 4.28 4.04 3.88 3.76 3.66 3.59 3.53 3.43 3.33 3.23 3.17 3.12 3.06 3.00 2.94 2.88
12 6.55 5.10 4.47 4.12 3.89 3.73 3.61 3.51 3.44 3.37 3.28 3.18 3.07 3.02 2.96 2.91 2.85 2.79 2.72
13 6.41 4.97 4.35 4.00 3.77 3.60 3.48 3.39 3.31 3.25 3.15 3.05 2.95 2.89 2.84 2.78 2.72 2.66 2.60
14 6.30 4.86 4.24 3.89 3.66 3.50 3.38 3.29 3.21 3.15 3.05 2.95 2.84 2.79 2.73 2.67 2.61 2.55 2.49

15 6.20 4.77 4.15 3.80 3.58 3.41 3.29 3.20 3.12 3.06 2.96 2.86 2.76 2.70 2.64 2.59 2.52 2.46 2.40
16 6.12 4.69 4.08 3.73 3.50 3.34 3.22 3.12 3.05 2.99 2.89 2.79 2.68 2.63 2.57 2.51 2.45 2.38 2.32
17 6.04 4.62 4.01 3.66 3.44 3.28 3.16 3.06 2.98 2.92 2.82 2.72 2.62 2.56 2.50 2.44 2.38 2.32 2.25
18 5.98 4.56 3.95 3.61 3.38 3.22 3.10 3.01 2.93 2.87 2.77 2.67 2.56 2.50 2.44 2.38 2.32 2.26 2.19
19 5.92 4.51 3.90 3.56 3.33 3.17 3.05 2.96 2.88 2.82 2.72 2.62 2.51 2.45 2.39 2.33 2.27 2.20 2.13

20 5.87 4.46 3.86 3.51 3.29 3.13 3.01 2.91 2.84 2.77 2.68 2.57 2.46 2.41 2.35 2.29 2.22 2.16 2.09
21 5.83 4.42 3.82 3.48 3.25 3.09 2.97 2.87 2.80 2.73 2.64 2.53 2.42 2.37 2.31 2.25 2.18 2.11 2.04
22 5.79 4.38 3.78 3.44 3.22 3.05 2.93 2.84 2.76 2.70 2.60 2.50 2.39 2.33 2.27 2.21 2.14 2.08 2.00
23 5.75 4.35 3.75 3.41 3.18 3.02 2.90 2.81 2.73 2.67 2.57 2.47 2.36 2.30 2.24 2.18 2.11 2.04 1.97
24 5.72 4.32 3.72 3.38 3.15 2.99 2.87 2.78 2.70 2.64 2.54 2.44 2.33 2.27 2.21 2.15 2.08 2.01 1.94

25 5.69 4.29 3.69 3.35 3.13 2.97 2.85 2.75 2.68 2.61 2.51 2.41 2.30 2.24 2.18 2.12 2.05 1.98 1.91
26 5.66 4.27 3.67 3.33 3.10 2.94 2.82 2.73 2.65 2.59 2.49 2.39 2.28 2.22 2.16 2.09 2.03 1.95 1.88
27 5.63 4.24 3.65 3.31 3.08 2.92 2.80 2.71 2.63 2.57 2.47 2.36 2.25 2.19 2.13 2.07 2.00 1.93 1.85
28 5.61 4.22 3.63 3.29 3.06 2.90 2.78 2.69 2.61 2.55 2.45 2.34 2.23 2.17 2.11 2.05 1.98 1.91 1.83
29 5.59 4.20 3.61 3.27 3.04 2.88 2.76 2.67 2.59 2.53 2.43 2.32 2.21 2.15 2.09 2.03 1.96 1.89 1.81

30 5.57 4.18 3.59 3.25 3.03 2.87 2.75 2.65 2.57 2.51 2.41 2.31 2.20 2.14 2.07 2.01 1.94 1.87 1.79
40 5.42 4.05 3.46 3.13 2.90 2.74 2.62 2.53 2.45 2.39 2.29 2.18 2.07 2.01 1.94 1.88 1.80 1.72 1.64
60 5.29 3.93 3.34 3.01 2.79 2.63 2.51 2.41 2.33 2.27 2.17 2.06 1.94 1.88 1.82 1.74 1.67 1.58 1.48

120 5.15 3.80 3.23 2.89 2.67 2.52 2.39 2.30 2.22 2.16 2.05 1.94 1.82 1.76 1.69 1.61 1.53 1.43 1.31
q 5.02 3.69 3.12 2.79 2.57 2.41 2.29 2.19 2.11 2.05 1.94 1.83 1.71 1.64 1.57 1.48 1.39 1.27 1.00
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T A B L E E . 5
Critical Values of F (continued)

Cumulative Probabilities = 0.99

Upper-Tail Areas = 0.01

Numerator, df1

Denominator,
df2 1 2 3 4 5 6 7 8 9 10 12 15 20 24 30 40 60 120 ˆ

0 F

α = 0.01

1 4,052.00 4,999.50 5,403.00 5,625.00 5,764.00 5,859.00 5,928.00 5,982.00 6,022.00 6,056.00 6,106.00 6,157.00 6,209.00 6,235.00 6,261.00 6,287.00 6,313.00 6,339.00 6,366.00
2 98.50 99.00 99.17 99.25 99.30 99.33 99.36 99.37 99.39 99.40 99.42 99.43 44.45 99.46 99.47 99.47 99.48 99.49 99.50
3 34.12 30.82 29.46 28.71 28.24 27.91 27.67 27.49 27.35 27.23 27.05 26.87 26.69 26.60 26.50 26.41 26.32 26.22 26.13
4 21.20 18.00 16.69 15.98 15.52 15.21 14.98 14.80 14.66 14.55 14.37 14.20 14.02 13.93 13.84 13.75 13.65 13.56 13.46

5 16.26 13.27 12.06 11.39 10.97 10.67 10.46 10.29 10.16 10.05 9.89 9.72 9.55 9.47 9.38 9.29 9.20 9.11 9.02
6 13.75 10.92 9.78 9.15 8.75 8.47 8.26 8.10 7.98 7.87 7.72 7.56 7.40 7.31 7.23 7.14 7.06 6.97 6.88
7 12.25 9.55 8.45 7.85 7.46 7.19 6.99 6.84 6.72 6.62 6.47 6.31 6.16 6.07 5.99 5.91 5.82 5.74 5.65
8 11.26 8.65 7.59 7.01 6.63 6.37 6.18 6.03 5.91 5.81 5.67 5.52 5.36 5.28 5.20 5.12 5.03 4.95 4.86
9 10.56 8.02 6.99 6.42 6.06 5.80 5.61 5.47 5.35 5.26 5.11 4.96 4.81 4.73 4.65 4.57 4.48 4.40 4.31

10 10.04 7.56 6.55 5.99 5.64 5.39 5.20 5.06 4.94 4.85 4.71 4.56 4.41 4.33 4.25 4.17 4.08 4.00 3.91
11 9.65 7.21 6.22 5.67 5.32 5.07 4.89 4.74 4.63 4.54 4.40 4.25 4.10 4.02 3.94 3.86 3.78 3.69 3.60
12 9.33 6.93 5.95 5.41 5.06 4.82 4.64 4.50 4.39 4.30 4.16 4.01 3.86 3.78 3.70 3.62 3.54 3.45 3.36
13 9.07 6.70 5.74 5.21 4.86 4.62 4.44 4.30 4.19 4.10 3.96 3.82 3.66 3.59 3.51 3.43 3.34 3.25 3.17
14 8.86 6.51 5.56 5.04 4.69 4.46 4.28 4.14 4.03 3.94 3.80 3.66 3.51 3.43 3.35 3.27 3.18 3.09 3.00

15 8.68 6.36 5.42 4.89 4.56 4.32 4.14 4.00 3.89 3.80 3.67 3.52 3.37 3.29 3.21 3.13 3.05 2.96 2.87
16 8.53 6.23 5.29 4.77 4.44 4.20 4.03 3.89 3.78 3.69 3.55 3.41 3.26 3.18 3.10 3.02 2.93 2.81 2.75
17 8.40 6.11 5.18 4.67 4.34 4.10 3.93 3.79 3.68 3.59 3.46 3.31 3.16 3.08 3.00 2.92 2.83 2.75 2.65
18 8.29 6.01 5.09 4.58 4.25 4.01 3.84 3.71 3.60 3.51 3.37 3.23 3.08 3.00 2.92 2.84 2.75 2.66 2.57
19 8.18 5.93 5.01 4.50 4.17 3.94 3.77 3.63 3.52 3.43 3.30 3.15 3.00 2.92 2.84 2.76 2.67 2.58 2.49

20 8.10 5.85 4.94 4.43 4.10 3.87 3.70 3.56 3.46 3.37 3.23 3.09 2.94 2.86 2.78 2.69 2.61 2.52 2.42
21 8.02 5.78 4.87 4.37 4.04 3.81 3.64 3.51 3.40 3.31 3.17 3.03 2.88 2.80 2.72 2.64 2.55 2.46 2.36
22 7.95 5.72 4.82 4.31 3.99 3.76 3.59 3.45 3.35 3.26 3.12 2.98 2.83 2.75 2.67 2.58 2.50 2.40 2.31
23 7.88 5.66 4.76 4.26 3.94 3.71 3.54 3.41 3.30 3.21 3.07 2.93 2.78 2.70 2.62 2.54 2.45 2.35 2.26
24 7.82 5.61 4.72 4.22 3.90 3.67 3.50 3.36 3.26 3.17 3.03 2.89 2.74 2.66 2.58 2.49 2.40 2.31 2.21

25 7.77 5.57 4.68 4.18 3.85 3.63 3.46 3.32 3.22 3.13 2.99 2.85 2.70 2.62 2.54 2.45 2.36 2.27 2.17
26 7.72 5.53 4.64 4.14 3.82 3.59 3.42 3.29 3.18 3.09 2.96 2.81 2.66 2.58 2.50 2.42 2.33 2.23 2.13
27 7.68 5.49 4.60 4.11 3.78 3.56 3.39 3.26 3.15 3.06 2.93 2.78 2.63 2.55 2.47 2.38 2.29 2.20 2.10
28 7.64 5.45 4.57 4.07 3.75 3.53 3.36 3.23 3.12 3.03 2.90 2.75 2.60 2.52 2.44 2.35 2.26 2.17 2.06
29 7.60 5.42 4.54 4.04 3.73 3.50 3.33 3.20 3.09 3.00 2.87 2.73 2.57 2.49 2.41 2.33 2.23 2.14 2.03

30 7.56 5.39 4.51 4.02 3.70 3.47 3.30 3.17 3.07 2.98 2.84 2.70 2.55 2.47 2.39 2.30 2.21 2.11 2.01
40 7.31 5.18 4.31 3.83 3.51 3.29 3.12 2.99 2.89 2.80 2.66 2.52 2.37 2.29 2.20 2.11 2.02 1.92 1.80
60 7.08 4.98 4.13 3.65 3.34 3.12 2.95 2.82 2.72 2.63 2.50 2.35 2.20 2.12 2.03 1.94 1.84 1.73 1.60

120 6.85 4.79 3.95 3.48 3.17 2.96 2.79 2.66 2.56 2.47 2.34 2.19 2.03 1.95 1.86 1.76 1.66 1.53 1.38
q 6.63 4.61 3.78 3.32 3.02 2.80 2.64 2.51 2.41 2.32 2.18 2.04 1.88 1.79 1.70 1.59 1.47 1.32 1.00



Cumulative Probabilities = 0.995

Upper-Tail Areas = 0.005

Numerator, df1

Denominator,
df2 1 2 3 4 5 6 7 8 9 10 12 15 20 24 30 40 60 120 ˆ

0 F

α = 0.005

1 16,211.00 20,000.00 21,615.00 22,500.00 23,056.00 23,437.00 23,715.00 23,925.00 24,091.00 24,224.00 24,426.00 24,630.00 24,836.00 24,910.00 25,044.00 25,148.00 25,253.00 25,359.00 25,465.00
2 198.50 199.00 199.20 199.20 199.30 199.30 199.40 199.40 199.40 199.40 199.40 199.40 199.40 199.50 199.50 199.50 199.50 199.50 199.50
3 55.55 49.80 47.47 46.19 45.39 44.84 44.43 44.13 43.88 43.69 43.39 43.08 42.78 42.62 42.47 42.31 42.15 41.99 41.83
4 31.33 26.28 24.26 23.15 22.46 21.97 21.62 21.35 21.14 20.97 20.70 20.44 20.17 20.03 19.89 19.75 19.61 19.47 19.32

5 22.78 18.31 16.53 15.56 14.94 14.51 14.20 13.96 13.77 13.62 13.38 13.15 12.90 12.78 12.66 12.53 12.40 12.27 12.11
6 18.63 14.54 12.92 12.03 11.46 11.07 10.79 10.57 10.39 10.25 10.03 9.81 9.59 9.47 9.36 9.24 9.12 9.00 8.88
7 16.24 12.40 10.88 10.05 9.52 9.16 8.89 8.68 8.51 8.38 8.18 7.97 7.75 7.65 7.53 7.42 7.31 7.19 7.08
8 14.69 11.04 9.60 8.81 8.30 7.95 7.69 7.50 7.34 7.21 7.01 6.81 6.61 6.50 6.40 6.29 6.18 6.06 5.95
9 13.61 10.11 8.72 7.96 7.47 7.13 6.88 6.69 6.54 6.42 6.23 6.03 5.83 5.73 5.62 5.52 5.41 5.30 5.19

10 12.83 9.43 8.08 7.34 6.87 6.54 6.30 6.12 5.97 5.85 5.66 5.47 5.27 5.17 5.07 4.97 4.86 4.75 4.61
11 12.23 8.91 7.60 6.88 6.42 6.10 5.86 5.68 5.54 5.42 5.24 5.05 4.86 4.75 4.65 4.55 4.44 4.34 4.23
12 11.75 8.51 7.23 6.52 6.07 5.76 5.52 5.35 5.20 5.09 4.91 4.72 4.53 4.43 4.33 4.23 4.12 4.01 3.90
13 11.37 8.19 6.93 6.23 5.79 5.48 5.25 5.08 4.94 4.82 4.64 4.46 4.27 4.17 4.07 3.97 3.87 3.76 3.65
14 11.06 7.92 6.68 6.00 5.56 5.26 5.03 4.86 4.72 4.60 4.43 4.25 4.06 3.96 3.86 3.76 3.66 3.55 3.41

15 10.80 7.70 6.48 5.80 5.37 5.07 4.85 4.67 4.54 4.42 4.25 4.07 3.88 3.79 3.69 3.58 3.48 3.37 3.26
16 10.58 7.51 6.30 5.64 5.21 4.91 4.69 4.52 4.38 4.27 4.10 3.92 3.73 3.64 3.54 3.44 3.33 3.22 3.11
17 10.38 7.35 6.16 5.50 5.07 4.78 4.56 4.39 4.25 4.14 3.97 3.79 3.61 3.51 3.41 3.31 3.21 3.10 2.98
18 10.22 7.21 6.03 5.37 4.96 4.66 4.44 4.28 4.14 4.03 3.86 3.68 3.50 3.40 3.30 3.20 3.10 2.99 2.87
19 10.07 7.09 5.92 5.27 4.85 4.56 4.34 4.18 4.04 3.93 3.76 3.59 3.40 3.31 3.21 3.11 3.00 2.89 2.78

20 9.94 6.99 5.82 5.17 4.76 4.47 4.26 4.09 3.96 3.85 3.68 3.50 3.32 3.22 3.12 3.02 2.92 2.81 2.69
21 9.83 6.89 5.73 5.09 4.68 4.39 4.18 4.02 3.88 3.77 3.60 3.43 3.24 3.15 3.05 2.95 2.84 2.73 2.61
22 9.73 6.81 5.65 5.02 4.61 4.32 4.11 3.94 3.81 3.70 3.54 3.36 3.18 3.08 2.98 2.88 2.77 2.66 2.55
23 9.63 6.73 5.58 4.95 4.54 4.26 4.05 3.88 3.75 3.64 3.47 3.30 3.12 3.02 2.92 2.82 2.71 2.60 2.48
24 9.55 6.66 5.52 4.89 4.49 4.20 3.99 3.83 3.69 3.59 3.42 3.25 3.06 2.97 2.87 2.77 2.66 2.55 2.43

25 9.48 6.60 5.46 4.84 4.43 4.15 3.94 3.78 3.64 3.54 3.37 3.20 3.01 2.92 2.82 2.72 2.61 2.50 2.38
26 9.41 6.54 5.41 4.79 4.38 4.10 3.89 3.73 3.60 3.49 3.33 3.15 2.97 2.87 2.77 2.67 2.56 2.45 2.33
27 9.34 6.49 5.36 4.74 4.34 4.06 3.85 3.69 3.56 3.45 3.28 3.11 2.93 2.83 2.73 2.63 2.52 2.41 2.29
28 9.28 6.44 5.32 4.70 4.30 4.02 3.81 3.65 3.52 3.41 3.25 3.07 2.89 2.79 2.69 2.59 2.48 2.37 2.25
29 9.23 6.40 5.28 4.66 4.26 3.98 3.77 3.61 3.48 3.38 3.21 3.04 2.86 2.76 2.66 2.56 2.45 2.33 2.21

30 9.18 6.35 5.24 4.62 4.23 3.95 3.74 3.58 3.45 3.34 3.18 3.01 2.82 2.73 2.63 2.52 2.42 2.30 2.18
40 8.83 6.07 4.98 4.37 3.99 3.71 3.51 3.35 3.22 3.12 2.95 2.78 2.60 2.50 2.40 2.30 2.18 2.06 1.93
60 8.49 5.79 4.73 4.14 3.76 3.49 3.29 3.13 3.01 2.90 2.74 2.57 2.39 2.29 2.19 2.08 1.96 1.83 1.69

120 8.18 5.54 4.50 3.92 3.55 3.28 3.09 2.93 2.81 2.71 2.54 2.37 2.19 2.09 1.98 1.87 1.75 1.61 1.43

q 7.88 5.30 4.28 3.72 3.35 3.09 2.90 2.74 2.62 2.52 2.36 2.19 2.00 1.90 1.79 1.67 1.53 1.36 1.00

Source: Reprinted from E. S. Pearson and H. O. Hartley, eds., Biometrika Tables for Statisticians, 3rd ed., 1966, by permission of the Biometrika Trustees.
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A n1

n2 One-tail Two-tail 4 5 6 7 8 9 10

4 0.05 0.10 11,25
0.025 0.05 10,26
0.01 0.02 —,—
0.005 0.01 —,—

5 0.05 0.10 12,28 19,36
0.025 0.05 11,29 17,38
0.01 0.02 10,30 16,39
0.005 0.01 —,— 15,40

6 0.05 0.10 13,31 20,40 28,50
0.025 0.05 12,32 18,42 26,52
0.01 0.02 11,33 17,43 24,54
0.005 0.01 10,34 16,44 23,55

7 0.05 0.10 14,34 21,44 29,55 39,66
0.025 0.05 13,35 20,45 27,57 36,69
0.01 0.02 11,37 18,47 25,59 34,71
0.005 0.01 10,38 16,49 24,60 32,73

8 0.05 0.10 15,37 23,47 31,59 41,71 51,85
0.025 0.05 14,38 21,49 29,61 38,74 49,87
0.01 0.02 12,40 19,51 27,63 35,77 45,91
0.005 0.01 11,41 17,53 25,65 34,78 43,93

9 0.05 0.10 16,40 24,51 33,63 43,76 54,90 66,105
0.025 0.05 14,42 22,53 31,65 40,79 51,93 62,109
0.01 0.02 13,43 20,55 28,68 37,82 47,97 59,112
0.005 0.01 11,45 18,57 26,70 35,84 45,99 56,115

10 0.05 0.10 17,43 26,54 35,67 45,81 56,96 69,111 82,128
0.025 0.05 15,45 23,57 32,70 42,84 53,99 65,115 78,132
0.01 0.02 13,47 21,59 29,73 39,87 49,103 61,119 74,136
0.005 0.01 12,48 19,61 27,75 37,89 47,105 58,122 71,139

Source: Adapted from Table 1 of F. Wilcoxon and R. A. Wilcox, Some Rapid Approximate Statistical Procedures
(Pearl River, NY: Lederle Laboratories, 1964), with permission of the American Cyanamid Company.

T A B L E E . 6
Lower and Upper Critical
Values, T1, of the
Wilcoxon Rank Sum Test
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T A B L E E . 7
Critical Values of the Studentized Range, Q

Upper 5% Points (A � 0.05)

Denominator, Numerator, df
df 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20

1 18.00 27.00 32.80 37.10 40.40 43.10 45.40 47.40 49.10 50.60 52.00 53.20 54.30 55.40 56.30 57.20 58.00 58.80 59.60
2 6.09 8.30 9.80 10.90 11.70 12.40 13.00 13.50 14.00 14.40 14.70 15.10 15.40 15.70 15.90 16.10 16.40 16.60 16.80
3 4.50 5.91 6.82 7.50 8.04 8.48 8.85 9.18 9.46 9.72 9.95 10.15 10.35 10.52 10.69 10.84 10.98 11.11 11.24
4 3.93 5.04 5.76 6.29 6.71 7.05 7.35 7.60 7.83 8.03 8.21 8.37 8.52 8.66 8.79 8.91 9.03 9.13 9.23
5 3.64 4.60 5.22 5.67 6.03 6.33 6.58 6.80 6.99 7.17 7.32 7.47 7.60 7.72 7.83 7.93 8.03 8.12 8.21

6 3.46 4.34 4.90 5.31 5.63 5.89 6.12 6.32 6.49 6.65 6.79 6.92 7.03 7.14 7.24 7.34 7.43 7.51 7.59
7 3.34 4.16 4.68 5.06 5.36 5.61 5.82 6.00 6.16 6.30 6.43 6.55 6.66 6.76 6.85 6.94 7.02 7.09 7.17
8 3.26 4.04 4.53 4.89 5.17 5.40 5.60 5.77 5.92 6.05 6.18 6.29 6.39 6.48 6.57 6.65 6.73 6.80 6.87
9 3.20 3.95 4.42 4.76 5.02 5.24 5.43 5.60 5.74 5.87 5.98 6.09 6.19 6.28 6.36 6.44 6.51 6.58 6.64

10 3.15 3.88 4.33 4.65 4.91 5.12 5.30 5.46 5.60 5.72 5.83 5.93 6.03 6.11 6.20 6.27 6.34 6.40 6.47
11 3.11 3.82 4.26 4.57 4.82 5.03 5.20 5.35 5.49 5.61 5.71 5.81 5.90 5.99 6.06 6.14 6.20 6.26 6.33
12 3.08 3.77 4.20 4.51 4.75 4.95 5.12 5.27 5.40 5.51 5.62 5.71 5.80 5.88 5.95 6.03 6.09 6.15 6.21
13 3.06 3.73 4.15 4.45 4.69 4.88 5.05 5.19 5.32 5.43 5.53 5.63 5.71 5.79 5.86 5.93 6.00 6.05 6.11
14 3.03 3.70 4.11 4.41 4.64 4.83 4.99 5.13 5.25 5.36 5.46 5.55 5.64 5.72 5.79 5.85 5.92 5.97 6.03

15 3.01 3.67 4.08 4.37 4.60 4.78 4.94 5.08 5.20 5.31 5.40 5.49 5.58 5.65 5.72 5.79 5.85 5.90 5.96
16 3.00 3.65 4.05 4.33 4.56 4.74 4.90 5.03 5.15 5.26 5.35 5.44 5.52 5.59 5.66 5.72 5.79 5.84 5.90
17 2.98 3.63 4.02 4.30 4.52 4.71 4.86 4.99 5.11 5.21 5.31 5.39 5.47 5.55 5.61 5.68 5.74 5.79 5.84
18 2.97 3.61 4.00 4.28 4.49 4.67 4.82 4.96 5.07 5.17 5.27 5.35 5.43 5.50 5.57 5.63 5.69 5.74 5.79
19 2.96 3.59 3.98 4.25 4.47 4.65 4.79 4.92 5.04 5.14 5.23 5.32 5.39 5.46 5.53 5.59 5.65 5.70 5.75

20 2.95 3.58 3.96 4.23 4.45 4.62 4.77 4.90 5.01 5.11 5.20 5.28 5.36 5.43 5.49 5.55 5.61 5.66 5.71
24 2.92 3.53 3.90 4.17 4.37 4.54 4.68 4.81 4.92 5.01 5.10 5.18 5.25 5.32 5.38 5.44 5.50 5.54 5.59
30 2.89 3.49 3.84 4.10 4.30 4.46 4.60 4.72 4.83 4.92 5.00 5.08 5.15 5.21 5.27 5.33 5.38 5.43 5.48
40 2.86 3.44 3.79 4.04 4.23 4.39 4.52 4.63 4.74 4.82 4.91 4.98 5.05 5.11 5.16 5.22 5.27 5.31 5.36
60 2.83 3.40 3.74 3.98 4.16 4.31 4.44 4.55 4.65 4.73 4.81 4.88 4.94 5.00 5.06 5.11 5.16 5.20 5.24

120 2.80 3.36 3.69 3.92 4.10 4.24 4.36 4.48 4.56 4.64 4.72 4.78 4.84 4.90 4.95 5.00 5.05 5.09 5.13
q 2.77 3.31 3.63 3.86 4.03 4.17 4.29 4.39 4.47 4.55 4.62 4.68 4.74 4.80 4.85 4.89 4.93 4.97 5.01

continued
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T A B L E E . 7
Critical Values of the Studentized Range, Q

Upper 1% Points (A � 0.01)

Denominator, Numerator, df
df 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20

1 90.00 135.00 164.00 186.00 202.00 216.00 227.00 237.00 246.00 253.00 260.00 266.00 272.00 277.00 282.00 286.00 290.00 294.00 298.00
2 14.00 19.00 22.30 24.70 26.60 28.20 29.50 30.70 31.70 32.60 33.40 34.10 34.80 35.40 36.00 36.50 37.00 37.50 37.90
3 8.26 10.60 12.20 13.30 14.20 15.00 15.60 16.20 16.70 17.10 17.50 17.90 18.20 18.50 18.80 19.10 19.30 19.50 19.80
4 6.51 8.12 9.17 9.96 10.60 11.10 11.50 11.90 12.30 12.60 12.80 13.10 13.30 13.50 13.70 13.90 14.10 14.20 14.40

5 5.70 6.97 7.80 8.42 8.91 9.32 9.67 9.97 10.24 10.48 10.70 10.89 11.08 11.24 11.40 11.55 11.68 11.81 11.93
6 5.24 6.33 7.03 7.56 7.97 8.32 8.61 8.87 9.10 9.30 9.49 9.65 9.81 9.95 10.08 10.21 10.32 10.43 10.54
7 4.95 5.92 6.54 7.01 7.37 7.68 7.94 8.17 8.37 8.55 8.71 8.86 9.00 9.12 9.24 9.35 9.46 9.55 9.65
8 4.74 5.63 6.20 6.63 6.96 7.24 7.47 7.68 7.87 8.03 8.18 8.31 8.44 8.55 8.66 8.76 8.85 8.94 9.03
9 4.60 5.43 5.96 6.35 6.66 6.91 7.13 7.32 7.49 7.65 7.78 7.91 8.03 8.13 8.23 8.32 8.41 8.49 8.57

10 4.48 5.27 5.77 6.14 6.43 6.67 6.87 7.05 7.21 7.36 7.48 7.60 7.71 7.81 7.91 7.99 8.07 8.15 8.22
11 4.39 5.14 5.62 5.97 6.26 6.48 6.67 6.84 6.99 7.13 7.25 7.36 7.46 7.56 7.65 7.73 7.81 7.88 7.95
12 4.32 5.04 5.50 5.84 6.10 6.32 6.51 6.67 6.81 6.94 7.06 7.17 7.26 7.36 7.44 7.52 7.59 7.66 7.73
13 4.26 4.96 5.40 5.73 5.98 6.19 6.37 6.53 6.67 6.79 6.90 7.01 7.10 7.19 7.27 7.34 7.42 7.48 7.55
14 4.21 4.89 5.32 5.63 5.88 6.08 6.26 6.41 6.54 6.66 6.77 6.87 6.96 7.05 7.12 7.20 7.27 7.33 7.39

15 4.17 4.83 5.25 5.56 5.80 5.99 6.16 6.31 6.44 6.55 6.66 6.76 6.84 6.93 7.00 7.07 7.14 7.20 7.26
16 4.13 4.78 5.19 5.49 5.72 5.92 6.08 6.22 6.35 6.46 6.56 6.66 6.74 6.82 6.90 6.97 7.03 7.09 7.15
17 4.10 4.74 5.14 5.43 5.66 5.85 6.01 6.15 6.27 6.38 6.48 6.57 6.66 6.73 6.80 6.87 6.94 7.00 7.05
18 4.07 4.70 5.09 5.38 5.60 5.79 5.94 6.08 6.20 6.31 6.41 6.50 6.58 6.65 6.72 6.79 6.85 6.91 6.96
19 4.05 4.67 5.05 5.33 5.55 5.73 5.89 6.02 6.14 6.25 6.34 6.43 6.51 6.58 6.65 6.72 6.78 6.84 6.89

20 4.02 4.64 5.02 5.29 5.51 5.69 5.84 5.97 6.09 6.19 6.29 6.37 6.45 6.52 6.59 6.65 6.71 6.76 6.82
24 3.96 4.54 4.91 5.17 5.37 5.54 5.69 5.81 5.92 6.02 6.11 6.19 6.26 6.33 6.39 6.45 6.51 5.56 6.61
30 3.89 4.45 4.80 5.05 5.24 5.40 5.54 5.65 5.76 5.85 5.93 6.01 6.08 6.14 6.20 6.26 6.31 6.36 6.41
40 3.82 4.37 4.70 4.93 5.11 5.27 5.39 5.50 5.60 5.69 5.77 5.84 5.90 5.96 6.02 6.07 6.12 6.17 6.21

60 3.76 4.28 4.60 4.82 4.99 5.13 5.25 5.36 5.45 5.53 5.60 5.67 5.73 5.79 5.84 5.89 5.93 5.98 6.02
120 3.70 4.20 4.50 4.71 4.87 5.01 5.12 5.21 5.30 5.38 5.44 5.51 5.56 5.61 5.66 5.71 5.75 5.79 5.83
q 3.64 4.12 4.40 4.60 4.76 4.88 4.99 5.08 5.16 5.23 5.29 5.35 5.40 5.45 5.49 5.54 5.57 5.61 5.65

Source: Reprinted from E. S. Pearson and H. O. Hartley, eds., Table 29 of Biometrika Tables for Statisticians, Vol. 1, 3rd ed., 1966, by permission of the Biometrika Trustees, London.
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T A B L E E . 8
Critical Values, and of the Durbin-Watson Statistic, D (Critical Values Are One-Sided)adU,dL

A � 0.05 A � 0.01

k � 1 k � 2 k � 3 k � 4 k � 5 k � 1 k � 2 k � 3 k � 4 k � 5

n dL dU dL dU dL dU dL dU dL dU dL dU dL dU dL dU dL dU dL dU

15 1.08 1.36 .95 1.54 .82 1.75 .69 1.97 .56 2.21 .81 1.07 .70 1.25 .59 1.46 .49 1.70 .39 1.96
16 1.10 1.37 .98 1.54 .86 1.73 .74 1.93 .62 2.15 .84 1.09 .74 1.25 .63 1.44 .53 1.66 .44 1.90
17 1.13 1.38 1.02 1.54 .90 1.71 .78 1.90 .67 2.10 .87 1.10 .77 1.25 .67 1.43 .57 1.63 .48 1.85
18 1.16 1.39 1.05 1.53 .93 1.69 .82 1.87 .71 2.06 .90 1.12 .80 1.26 .71 1.42 .61 1.60 .52 1.80
19 1.18 1.40 1.08 1.53 .97 1.68 .86 1.85 .75 2.02 .93 1.13 .83 1.26 .74 1.41 .65 1.58 .56 1.77
20 1.20 1.41 1.10 1.54 1.00 1.68 .90 1.83 .79 1.99 .95 1.15 .86 1.27 .77 1.41 .68 1.57 .60 1.74
21 1.22 1.42 1.13 1.54 1.03 1.67 .93 1.81 .83 1.96 .97 1.16 .89 1.27 .80 1.41 .72 1.55 .63 1.71
22 1.24 1.43 1.15 1.54 1.05 1.66 .96 1.80 .86 1.94 1.00 1.17 .91 1.28 .83 1.40 .75 1.54 .66 1.69
23 1.26 1.44 1.17 1.54 1.08 1.66 .99 1.79 .90 1.92 1.02 1.19 .94 1.29 .86 1.40 .77 1.53 .70 1.67
24 1.27 1.45 1.19 1.55 1.10 1.66 1.01 1.78 .93 1.90 1.04 1.20 .96 1.30 .88 1.41 .80 1.53 .72 1.66
25 1.29 1.45 1.21 1.55 1.12 1.66 1.04 1.77 .95 1.89 1.05 1.21 .98 1.30 .90 1.41 .83 1.52 .75 1.65
26 1.30 1.46 1.22 1.55 1.14 1.65 1.06 1.76 .98 1.88 1.07 1.22 1.00 1.31 .93 1.41 .85 1.52 .78 1.64
27 1.32 1.47 1.24 1.56 1.16 1.65 1.08 1.76 1.01 1.86 1.09 1.23 1.02 1.32 .95 1.41 .88 1.51 .81 1.63
28 .33 1.48 1.26 1.56 1.18 1.65 1.10 1.75 1.03 1.85 1.10 1.24 1.04 1.32 .97 1.41 .90 1.51 .83 1.62
29 1.34 1.48 1.27 1.56 1.20 1.65 1.12 1.74 1.05 1.84 1.12 1.25 1.05 1.33 .99 1.42 .92 1.51 .85 1.61
30 1.35 1.49 1.28 1.57 1.21 1.65 1.14 1.74 1.07 1.83 1.13 1.26 1.07 1.34 1.01 1.42 .94 1.51 .88 1.61
31 1.36 1.50 1.30 1.57 1.23 1.65 1.16 1.74 1.09 1.83 1.15 1.27 1.08 1.34 1.02 1.42 .96 1.51 .90 1.60
32 1.37 1.50 1.31 1.57 1.24 1.65 1.18 1.73 1.11 1.82 1.16 1.28 1.10 1.35 1.04 1.43 .98 1.51 .92 1.60
33 1.38 1.51 1.32 1.58 1.26 1.65 1.19 1.73 1.13 1.81 1.17 1.29 1.11 1.36 1.05 1.43 1.00 1.51 .94 1.59
34 1.39 1.51 1.33 1.58 1.27 1.65 1.21 1.73 1.15 1.81 1.18 1.30 1.13 1.36 1.07 1.43 1.01 1.51 .95 1.59
35 1.40 1.52 1.34 1.58 1.28 1.65 1.22 1.73 1.16 1.80 1.19 1.31 1.14 1.37 1.08 1.44 1.03 1.51 .97 1.59
36 1.41 1.52 1.35 1.59 1.29 1.65 1.24 1.73 1.18 1.80 1.21 1.32 1.15 1.38 1.10 1.44 1.04 1.51 .99 1.59
37 1.42 1.53 1.36 1.59 1.31 1.66 1.25 1.72 1.19 1.80 1.22 1.32 1.16 1.38 1.11 1.45 1.06 1.51 1.00 1.59
38 1.43 1.54 1.37 1.59 1.32 1.66 1.26 1.72 1.21 1.79 1.23 1.33 1.18 1.39 1.12 1.45 1.07 1.52 1.02 1.58
39 1.43 1.54 1.38 1.60 1.33 1.66 1.27 1.72 1.22 1.79 1.24 1.34 1.19 1.39 1.14 1.45 1.09 1.52 1.03 1.58
40 1.44 1.54 1.39 1.60 1.34 1.66 1.29 1.72 1.23 1.79 1.25 1.34 1.20 1.40 1.15 1.46 1.10 1.52 1.05 1.58
45 1.48 1.57 1.43 1.62 1.38 1.67 1.34 1.72 1.29 1.78 1.29 1.38 1.24 1.42 1.20 1.48 1.16 1.53 1.11 1.58
50 1.50 1.59 1.46 1.63 1.42 1.67 1.38 1.72 1.34 1.77 1.32 1.40 1.28 1.45 1.24 1.49 1.20 1.54 1.16 1.59
55 1.53 1.60 1.49 1.64 1.45 1.68 1.41 1.72 1.38 1.77 1.36 1.43 1.32 1.47 1.28 1.51 1.25 1.55 1.21 1.59
60 1.55 1.62 1.51 1.65 1.48 1.69 1.44 1.73 1.41 1.77 1.38 1.45 1.35 1.48 1.32 1.52 1.28 1.56 1.25 1.60
65 1.57 1.63 1.54 1.66 1.50 1.70 1.47 1.73 1.44 1.77 1.41 1.47 1.38 1.50 1.35 1.53 1.31 1.57 1.28 1.61
70 1.58 1.64 1.55 1.67 1.52 1.70 1.49 1.74 1.46 1.77 1.43 1.49 1.40 1.52 1.37 1.55 1.34 1.58 1.31 1.61
75 1.60 1.65 1.57 1.68 1.54 1.71 1.51 1.74 1.49 1.77 1.45 1.50 1.42 1.53 1.39 1.56 1.37 1.59 1.34 1.62
80 1.61 1.66 1.59 1.69 1.56 1.72 1.53 1.74 1.51 1.77 1.47 1.52 1.44 1.54 1.42 1.57 1.39 1.60 1.36 1.62
85 1.62 1.67 1.60 1.70 1.57 1.72 1.55 1.75 1.52 1.77 1.48 1.53 1.46 1.55 1.43 1.58 1.41 1.60 1.39 1.63
90 1.63 1.68 1.61 1.70 1.59 1.73 1.57 1.75 1.54 1.78 1.50 1.54 1.47 1.56 1.45 1.59 1.43 1.61 1.41 1.64
95 1.64 1.69 1.62 1.71 1.60 1.73 1.58 1.75 1.56 1.78 1.51 1.55 1.49 1.57 1.47 1.60 1.45 1.62 1.42 1.64

100 1.65 1.69 1.63 1.72 1.61 1.74 1.59 1.76 1.57 1.78 1.52 1.56 1.50 1.58 1.48 1.60 1.46 1.63 1.44 1.65

a number of observations; number of independent variables.k =n =
Source: This table is reproduced from Biometrika, 41 (1951): pp. 173 and 175, with the permission of the Biometrika Trustees.
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Number of Observations
in Sample/Subgroup (n) d2 d3 D3 D4 A2

2 1.128 0.853 0 3.267 1.880
3 1.693 0.888 0 2.575 1.023
4 2.059 0.880 0 2.282 0.729
5 2.326 0.864 0 2.114 0.577
6 2.534 0.848 0 2.004 0.483
7 2.704 0.833 0.076 1.924 0.419
8 2.847 0.820 0.136 1.864 0.373
9 2.970 0.808 0.184 1.816 0.337

10 3.078 0.797 0.223 1.777 0.308
11 3.173 0.787 0.256 1.744 0.285
12 3.258 0.778 0.283 1.717 0.266
13 3.336 0.770 0.307 1.693 0.249
14 3.407 0.763 0.328 1.672 0.235
15 3.472 0.756 0.347 1.653 0.223
16 3.532 0.750 0.363 1.637 0.212
17 3.588 0.744 0.378 1.622 0.203
18 3.640 0.739 0.391 1.609 0.194
19 3.689 0.733 0.404 1.596 0.187
20 3.735 0.729 0.415 1.585 0.180
21 3.778 0.724 0.425 1.575 0.173
22 3.819 0.720 0.435 1.565 0.167
23 3.858 0.716 0.443 1.557 0.162
24 3.895 0.712 0.452 1.548 0.157
25 3.931 0.708 0.459 1.541 0.153

Source: Reprinted from ASTM-STP 15D by kind permission of the American Society for Testing and Materials.

T A B L E E . 9
Control Chart Factors
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T A B L E E . 1 0
The Standardized Normal Distribution

Entry represents area under the standardized normal
distribution from the mean to Z

Z .00 .01 .02 .03 .04 .05 .06 .07 .08 .09

0.0 .0000 .0040 .0080 .0120 .0160 .0199 .0239 .0279 .0319 .0359
0.1 .0398 .0438 .0478 .0517 .0557 .0596 .0636 .0675 .0714 .0753
0.2 .0793 .0832 .0871 .0910 .0948 .0987 .1026 .1064 .1103 .1141
0.3 .1179 .1217 .1255 .1293 .1331 .1368 .1406 .1443 .1480 .1517
0.4 .1554 .1591 .1628 .1664 .1700 .1736 .1772 .1808 .1844 .1879
0.5 .1915 .1950 .1985 .2019 .2054 .2088 .2123 .2157 .2190 .2224
0.6 .2257 .2291 .2324 .2357 .2389 .2422 .2454 .2486 .2518 .2549
0.7 .2580 .2612 .2642 .2673 .2704 .2734 .2764 .2794 .2823 .2852
0.8 .2881 .2910 .2939 .2967 .2995 .3023 .3051 .3078 .3106 .3133
0.9 .3159 .3186 .3212 .3238 .3264 .3289 .3315 .3340 .3365 .3389

1.0 .3413 .3438 .3461 .3485 .3508 .3531 .3554 .3577 .3599 .3621
1.1 .3643 .3665 .3686 .3708 .3729 .3749 .3770 .3790 .3810 .3830
1.2 .3849 .3869 .3888 .3907 .3925 .3944 .3962 .3980 .3997 .4015
1.3 .4032 .4049 .4066 .4082 .4099 .4115 .4131 .4147 .4162 .4177
1.4 .4192 .4207 .4222 .4236 .4251 .4265 .4279 .4292 .4306 .4319
1.5 .4332 .4345 .4357 .4370 .4382 .4394 .4406 .4418 .4429 .4441
1.6 .4452 .4463 .4474 .4484 .4495 .4505 .4515 .4525 .4535 .4545
1.7 .4554 .4564 .4573 .4582 .4591 .4599 .4608 .4616 .4625 .4633
1.8 .4641 .4649 .4656 .4664 .4671 .4678 .4686 .4693 .4699 .4706
1.9 .4713 .4719 .4726 .4732 .4738 .4744 .4750 .4756 .4761 .4767

2.0 .4772 .4778 .4783 .4788 .4793 .4798 .4803 .4808 .4812 .4817
2.1 .4821 .4826 .4830 .4834 .4838 .4842 .4846 .4850 .4854 .4857
2.2 .4861 .4864 .4868 .4871 .4875 .4878 .4881 .4884 .4887 .4890
2.3 .4893 .4896 .4898 .4901 .4904 .4906 .4909 .4911 .4913 .4916
2.4 .4918 .4920 .4922 .4925 .4927 .4929 .4931 .4932 .4934 .4936
2.5 .4938 .4940 .4941 .4943 .4945 .4946 .4948 .4949 .4951 .4952
2.6 .4953 .4955 .4956 .4957 .4959 .4960 .4961 .4962 .4963 .4964
2.7 .4965 .4966 .4967 .4968 .4969 .4970 .4971 .4972 .4973 .4974
2.8 .4974 .4975 .4976 .4977 .4977 .4978 .4979 .4979 .4980 .4981
2.9 .4981 .4982 .4982 .4983 .4984 .4984 .4985 .4985 .4986 .4986

3.0 .49865 .49869 .49874 .49878 .49882 .49886 .49889 .49893 .49897 .49900
3.1 .49903 .49906 .49910 .49913 .49916 .49918 .49921 .49924 .49926 .49929
3.2 .49931 .49934 .49936 .49938 .49940 .49942 .49944 .49946 .49948 .49950
3.3 .49952 .49953 .49955 .49957 .49958 .49960 .49961 .49962 .49964 .49965
3.4 .49966 .49968 .49969 .49970 .49971 .49972 .49973 .49974 .49975 .49976
3.5 .49977 .49978 .49978 .49979 .49980 .49981 .49981 .49982 .49983 .49983
3.6 .49984 .49985 .49985 .49986 .49986 .49987 .49987 .49988 .49988 .49989
3.7 .49989 .49990 .49990 .49990 .49991 .49991 .49992 .49992 .49992 .49992
3.8 .49993 .49993 .49993 .49994 .49994 .49994 .49994 .49995 .49995 .49995
3.9 .49995 .49995 .49996 .49996 .49996 .49996 .49996 .49996 .49997 .49997

0 Z



F.1 Enhancing Workbook Presentation
You can enhance workbook presentation by using common formatting commands and rear-
ranging the order of the worksheets and chart sheets in a workbook.

Table F.1 presents the shortcuts for worksheet formatting operations used to create the
Excel Guide workbooks and the results shown throughout this book. These shortcuts can be
found in the Home tab of the Excel Office Ribbon (see Figure F.1 on page 816).
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Number Operation Name Use

1 Font Face and Font Size Changes the text font face and size for cell entries
and chart labels. Worksheets shown in this book
have been formatted as Calibri 11. Many DATA
worksheets have been formatted as Arial 10.

Boldface Toggles on (or off) boldface text style for the
currently selected object.

Italic Toggles on (or off) italic text style for the
currently selected object.

Borders Displays a gallery of choices that permit drawing
lines (borders) around a cell or cell range.

Fill Color Displays a gallery of choices for the background
color of a cell. Immediately to the right of Fill
Color is the related Font Color (not used in any
example in this book).

Align Text Aligns the display of the contents of a worksheet
cell. Three buttons are available: Align Text Left,
Center, and Align Text Right.

Merge & Center Merges (combines) adjacent cells into one cell
and centers the display of the contents of that cell.
In Excel 2007, this button is also a drop-down list
that offers additional Merge and Unmerge
choices.

Percent Formats the display of a number value in a cell as
a percentage. The value 1 displays as 100%, the
value 0.01 displays as 1%. To the immediate left
of Percent is Currency, which formats values as
dollars and cents. Do not confuse Currency
formatting with the symbol used to identify
absolute cell references (discussed in Section
EG1.7 on page 21).

Increase Decimal and
Decrease Decimal

Adjusts the number of decimal places to display
a number value in a cell.

Format Displays a gallery of choices that affect the row
height and column width of a cell. The most
common usage is to select a column and then
select Format ➔ AutoFit Column Width.

T A B L E F . 1
Shortcuts to Common
Formatting
Operations

2

3

4

5

6

7

8

9

10
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Use the Move or Copy command to rearrange the order of the worksheets and chart sheets
in a workbook. To move or copy a worksheet, right-click the worksheet sheet tab and click
Move or Copy in the shortcut menu that appears. In the Move or Copy dialog box, select the
destination workbook from the To book drop-down list—select (new book) to place the work-
sheet in a new workbook—and select a position for the worksheet in the Before sheet list. If
making a copy, also check Create a copy. Click OK to complete the move or copy operation.

Worksheet cell formatting can also be done through the Format Cells command. When
editing a worksheet, right-click a cell and then click Format Cells from the shortcut menu. In
the Format Cells dialog box that appears, you can perform all the formatting operations
discussed in Table F.1 and more.

F.2 Useful Keyboard Shortcuts
In Excel, certain keys or keystroke combinations (one or more keys held down as you press
another key) are keyboard shortcuts that act as alternate means of executing common opera-
tions. Table F.2 presents some common shortcuts that represent some of the common Excel
operations described in this book. (Keystroke combinations are shown using a plus sign, as in
Ctrl+C, which means “while holding down the Ctrl key, press the C key.”)

F I G U R E F . 1
Home tab of the Excel
Office Ribbon (with number
labels keyed to Table F.1)

Key Operation

Backspace Erases typed characters to the left of the current position, one
character at a time.

Delete Erases characters to the right of the cursor, one character at a time.

Enter or Tab Finalizes an entry typed into a worksheet cell. Implied by the use of
the verb enter in the Excel Guides.

Esc Cancels an action or a dialog box. Equivalent to the dialog box
Cancel button.

F1 Displays the Excel help system.

Ctrl+C Copies the currently selected worksheet entry or chart label.

Ctrl+V Pastes the currently copied object into the currently selected
worksheet cell or chart label.

Ctrl+X Cuts the currently selected worksheet entry or chart label. You cut,
and not delete, something in order to paste it somewhere else.

Ctrl+B Toggles on (or off) boldface text style for the currently selected object.

Ctrl+I Toggles on (or off) italic text style for the currently selected object.

Ctrl+F Finds a Find what value.

Ctrl+H Replaces a Find what value with the Replace with value.

Ctrl+Z Undoes the last operation.

Ctrl+Y Redoes the last operation.

Ctrl+` Toggles on (or off) formulas view of worksheet.

Ctrl+Shift+Enter Enters an array formula.

Note: Using the copy-and-paste keyboard shortcut, Ctrl+C and Ctrl+V, to copy formulas from one worksheet
cell to another is subject to the same type of adjustment as discussed in Section EG1.7.

T A B L E F . 2
Useful Keyboard
Shortcuts
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F.3 Verifying Formulas and Worksheets
If you use formulas in your worksheets, you should review and verify formulas before you use
their results. To view the formulas in a worksheet, press Ctrl+` (grave accent key). To restore
the original view, the results of the formulas, press Ctrl+` a second time.

As you create and use more complicated worksheets, you might want to visually examine
the relationships among a formula and the cells it uses (called the precedents) and the cells that
use the results of the formula (the dependents). Select Formulas ➔ Trace Precedents (or
Trace Dependents). When you are finished, clear all trace arrows by selecting Formulas ➔
Remove Arrows.

F.4 Chart Formatting
Excel incorrectly formats the charts created by the In-Depth Excel instructions. Use the for-
matting adjustments in Table F.3 to properly format charts you create. Before applying these
adjustments, relocate a chart to its own chart sheet. To do so, right-click the chart background
and click Move Chart from the shortcut menu. In the Move Chart dialog box, click New Sheet,
enter a name for the new chart sheet, and click OK.

Layout Tab Selection Notes

Chart Title ➔ Above Chart In the box that is added to the chart,
double-click Chart Title and enter an
appropriate title.

Axes Titles ➔ Primary Horizontal 
Axis Title ➔ Title Below Axis

In the box that is added to the chart, double-
click Axis Title and enter an appropriate title.

Axes Titles ➔ Primary Vertical Axis
Title ➔ Rotated Title

In the box that is added to the chart, double-
click Axis Title and enter an appropriate
title.

Axes Titles ➔ Secondary Horizontal ➔
Axis Title ➔ None and
Axes Titles ➔ Secondary Vertical Axis
Title ➔ Rotated Title

Only for charts that contain secondary axes.

Legend ➔ None Turns off the chart legend.

Data Labels ➔ None Turns off the display of values at plotted
points or bars in the charts.

Data Table ➔ None Turns off the display of a summary table on
the chart sheet.

Axes ➔ Primary Horizontal Axis ➔
Show Left to Right Axis (or Show
Default Axis, if listed)

Turns on the display of the X axis.

Axes ➔ Primary Vertical Axis ➔
Show Default Axis

Turns on the display of the Y axis.

Gridlines ➔ Primary Horizontal
Gridlines ➔ None

Turns off the improper horizontal gridlines.

Gridlines ➔ Primary Vertical
Gridlines ➔ None

Turns off the improper vertical gridlines.

T A B L E F . 3
Excel Chart Formatting
Adjustments
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Use all of the adjustments in Table F.3, unless a particular set of charting instructions tells
you otherwise. To apply the adjustments, you must be open to the chart sheet that contains the
chart to be adjusted. All adjustments are made by first selecting the Layout tab (under the
Chart Tools heading). If a Layout tab selection cannot be made, the adjustment does not apply
to the type of chart being adjusted. (Excel hides or disables chart formatting choices that do not
apply to a particular chart type.)

Occasionally, when you open to a chart sheet, the chart is either too large to be fully seen
or too small, surrounded by a chart frame mat that is too large. Click the Zoom Out or Zoom
In buttons, located in the lower-right portion of the Excel window frame, to adjust the display.

F.5 Creating Histograms for Discrete Probability Distributions
You can create a histogram for a discrete probability distribution based on a discrete probabili-
ties table. For example, to create a histogram based on the Figure 5.2 binomial probabilities
worksheet on page 194, open to the COMPUTE worksheet of the Binomial workbook.
Select the cell range B14:B18, the probabilities in the Binomial Probabilities Table, and:

1. Select Insert ➔ Column and select the first 2-D Column gallery choice (Clustered
Column).

2. Right-click the chart background and click Select Data.

In the Select Data Source dialog box:

3. Click Edit under the Horizontal (Categories) Axis Labels heading.

4. In the Axis Labels dialog box, enter =COMPUTE!A14:A18 the cell range of the X axis
values. (This cell range must be entered as a formula in the form =SheetName!CellRange.)
Then, click OK to return to the Select Data Source dialog box.

5. Click OK.

In the chart:

6. Right-click inside a bar and click Format Data Series in the shortcut menu.

In the Format Data Series dialog box:

7. Click Series Options in the left pane. In the Series Options right pane, change the Gap
Width slider to Large Gap. Click Close.

Relocate the chart to a chart sheet and adjust the chart formatting by using the instructions in
Section F.4.

F.6 Pasting with Paste Special
Pasting data from one worksheet to another can sometimes cause unexpected side effects.
When the two worksheets are in different workbooks, a simple paste creates an external link to
the original workbook. This can lead to errors later if the first workbook is unavailable when
the second one is being used. Even pasting between worksheets in the same workbook can lead
to problems if what is being pasted is a cell range of formulas.

To avoid such side effects, use Paste Special in these special situations. To use this opera-
tion, copy the original cell range as you would do normally and select the cell or cell range to be
the target of the paste. Right-click the target and click Paste Special from the shortcut menu. In
the Paste Special dialog box (shown on page 819), click Values and then click OK. For the first
case, Paste Special Values pastes the current values of the cells in the first workbook and not for-
mulas that use cell references to the first workbook. For the second case, Paste Special Values
pastes the current evaluation of the formulas copied and not the formulas themselves.
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If you use PHStat2 and have data for a procedure in the form of formulas, use Paste Special
Values to create columns of equivalent values before using the procedure. (PHStat2 will not
work properly if data for a procedure are in the form of formulas.) Paste Special can paste other
types of information, including cell formatting information. For a full discussion of Paste
Special, see the Excel help system.



G.1 PHStat2 FAQs
What is PHStat2?
PHStat2 is software that makes operating Windows-based
Microsoft Excel as distraction free as possible. As a student
studying statistics, you can focus mainly on learning statis-
tics and not worry about having to fully master Excel first.
PHStat2 contains just about all the statistical methods taught
in an introductory statistics course that can be illustrated
using Excel.

How much storage space does PHStat2 require?
PHStat2 requires about 3MB of storage space, although the
PHStat2 setup program that you run to install PHStat2 (see
Appendix Section D.2) requires about 15MB of storage space.

Are updates to PHStat2 available?
Yes, free minor updates to resolve issues or enhance func-
tionality may be available for download from the PHStat2
website (www.pearsonhighered.com/phstat).

Where can I find the latest and most complete technical
information for setting up PHStat2?
Download and read the PHStat2 readme file (see Appendix
Section C.2) for the latest and most complete technical
information for setting up PHStat2. The readme file expands
on the concise installation and configuration instructions
presented in Appendix Section D.2. Also check the PHStat2
website (www.pearsonhighered.com/phstat) for any tech-
nical issues created by Microsoft-supplied Excel updates
distributed after the publication of this book.

Where can I get help setting up PHStat2?
If you need help setting up PHStat2, first review the
“Troubleshooting PHStat2” section of the downloadable
PHStat2 readme file. If your problem is still unresolved,
visit the PHStat2 frequently asked questions web page and
the web page for your version at the PHStat2 website (www.
pearsonhighered.com/phstat) to see if your problem is
addressed. If you need further assistance, click the Contact
Pearson Technical Support on either web page for free
technical support. (Pearson Technical Support cannot
answer questions about the statistical applications of
PHStat2 or questions about specific PHStat2 procedures.)

How can I identify which PHStat2 version I have?
Open Microsoft Excel with PHStat2 and select PHStat ➔
Help for PHStat. In the dialog box that appears, note the
XLA and DLL version numbers. If you downloaded and
installed the PHStat2 version designed for this book, both of
these numbers will not be lower than 3.0.

Where can I find tips for using PHStat2?
While your classmates and instructor can be the best sources of
tips, you can check for any tips that may be posted on the new
third-party PHStat2 community website phstatcommunity.
org that, at the time of publication of this book, was scheduled
to be activated by Fall 2011.

G.2 Excel FAQs
What does “Compatibility Mode” in the title bar mean?
Excel displays “Compatibility Mode” when the workbook
you are currently using has been previously stored using the
.xls file format that is compatible with all Excel versions.
Compatibility Mode does not affect Excel functionality but
will cause Excel to review your workbook for exclusive-to-
Excel-2007-or-2010 formatting properties and objects the
next time you save the workbook. (To preserve exclusive
features in Excel 2010, select File ➔ Save As and select
Excel Workbook (*.xlsx) from the Save as type drop-down
list. To preserve exclusive features in Excel 2007, click the
Office Button, move the mouse pointer over Save As, and in
the Save As gallery, click Excel Workbook to save the
workbook in the .xlsx file format.)

If you open any of the Excel data or Excel Guide work-
books for this book, you will see “Compatibility Mode,” as all
workbooks for this book have been stored using the .xls for-
mat. Generally, it makes little difference whether you use com-
patibility mode or not. The one exception is when working
with PivotTables, as explained in Section EG2.7 on page 86.

In Excel 2010, how can I specify the custom settings that
you recommend?
Select File ➔ Options. In the Excel Options dialog box,
click Formulas in the left pane, and in the Formulas right
pane, click Automatic under Workbook Calculation and
verify that all check boxes are checked except Enable itera-
tive calculation, R1C1 reference style, and Formulas
referring to empty cells.

In Excel 2007, how can I specify the custom settings that
you recommend?
Click the Office Button and then click Excel Options. In
the Excel Options dialog box, click Formulas in the left
pane, and in the Formulas right pane, click Automatic
under Workbook Calculation and verify that all check
boxes are checked except Enable iterative calculation,
R1C1 reference style, and Formulas referring to empty
cells.
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What Excel security settings will allow the PHStat2 or
Visual Explorations add-in to function properly?
Use the instructions in Appendix Section D.3 on page 793
for configuring Excel for PHStat2 for both add-ins.

I do not see the menu for the Visual Explorations (or
PHStat2) add-in that I opened. Where is it?
Unlike earlier versions of Excel that allowed add-ins to add
menus to the menu bar, Excel 2007 and 2010 places all add-
in menus under the Add-ins tab. In order to see the menu,
click Add-ins and then click the name of the add-in menu.

How can I install the Analysis ToolPak?
Close Excel and rerun the Microsoft Office or Microsoft
Excel setup program. When the setup program runs, choose
the option that allows you to add components which will be
labeled either as Change or Add or Remove Features. (If
you use Windows 7, open the Programs and Features
Control Panel applet, select the entry for your version or
Office or Excel, and then click Change at the top of the list
of programs.)

In the Installation Options screen, double-click Microsoft
Office Excel and then double-click Add-ins. Click the
Analysis ToolPak drop-down list button and select Run

from My Computer. (You may need access to the original
Microsoft Office/Excel setup CD-ROMs or DVD to complete
this task.) Upon successful installation, you will see Data
Analysis as a choice in the Analysis group of the Data tab
when you next open Excel.

G.3 FAQs for Minitab
Can I use Minitab Release 14 or 15 with this book?
Yes, you can use the Minitab Guide instructions, written for
Minitab 16, with Release 14 or 15. For certain methods, there
may be minor differences in labeling of dialog box elements.
Any difference that is not minor is noted in the instructions.

Can I save my Minitab worksheets or projects for use
with Release 14 or 15?
Yes. Select either Minitab14 or Minitab 15 (for a work-
sheet) or Minitab 14 Project (*.MPJ) or Minitab 15
Project (*.MPJ) (for a project) from the Save as type drop-
down list in the save as dialog box. See Section MG1.3 on
page 23 for more information about using the Save
Worksheet As and Save Project As dialog boxes.
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Self-Test Solutions and Answers to
Selected Even-Numbered Problems
The following represent worked-out solutions to Self-Test Problems and brief answers to most of the even-numbered problems in the text. For
more detailed solutions, including explanations, interpretations, and Excel and Minitab results, see the Student Solutions Manual.

CHAPTER 1

1.2 Small, medium, and large sizes imply order but do not specify how
much more soft drink is added at increasing levels.

1.4 (a) The number of telephones is a numerical variable that is discrete
because the outcome is a count. It is ratio scaled because it has a true zero
point. (b) The length of the longest telephone call is a numerical variable
that is continuous because any value within a range of values can occur.
It is ratio scaled because it has a true zero point. (c) Whether someone in
the household owns a Wi-Fi–capable cell phone is a categorical variable
because the answer can be only yes or no. This also makes it a nominal-
scaled variable. (d) Same answer as in (c).

1.6 (a) Categorical, nominal scale. (b) Numerical, continuous, ratio scale.
(c) Numerical, discrete, ratio scale. (d) Numerical, discrete, ratio scale.

1.8 (a) Numerical, continuous, ratio scale. (b) Numerical, discrete, 
ratio scale. (c) Numerical, continuous, ratio scale. (d) Categorical,
nominal scale.

1.10 The underlying variable, ability of the students, may be continuous,
but the measuring device, the test, does not have enough precision to
distinguish between the two students.

1.20 (a) All 3,727 full-time first-year students at the university.
(b) The 2,821 students who responded to the survey. (c) The proportion
of all 3,727 students who studied with other students. (d) The proportion
of the sample of 2,821 responding students who studied with other
students.

1.22 (a) Adults living in the United States, aged 18 and older.
(b) The 1,006 adults living in the United States, aged 18 and older, who
were selected in the sample. (c) Because the 20% is based on the sample, it
is a statistic. (d) Because the 58% is based on the sample, it is a statistic.

1.26 (a) Categorical, categorical, numerical discrete, categorical.

1.28 Gender, graduate major, undergraduate major, employment status,
satisfaction with MBA advisory services, and preferred type of computer
are categorical variables. Age, graduate grade point average, undergraduate
grade point average, number of full-time jobs, expected starting salary,
spending for textbooks and supplies, advisory rating number of text
messages sent in a typical week, and the amount of wealth needed to feel
rich are numerical variables.

CHAPTER 2
2.6 (a) Table of frequencies for all student responses:

(b) Table based on total percentages:

STUDENT MAJOR CATEGORIES

GENDER A C M Totals

Male 35.0% 22.5% 5.0% 62.5%
Female 15.0 15.0 7.5 37.5
Totals 50.0 37.5 12.5 100.0

Table based on row percentages:

STUDENT MAJOR CATEGORIES

GENDER A C M Totals

Male 56.0% 36.0% 8.0% 100.0%
Female 40.0 40.0 20.0 100.0
Totals 50.0 37.5 12.5 100.0

Table based on column percentages;

STUDENT MAJOR CATEGORIES

GENDER A C M Totals

Male 70.0% 60.0% 40.0% 62.5%
Female 30.0 40.0 60.0 37.5
Totals 100.0 100.0 100.0 100.0

2.8 (a) The percentages are 48.52, 6.04, 21.33, 19.61, and 4.49.
(b) Almost half the electricity is generated from coal. About 20%
of the electricity is generated from natural gas, and about 20% is
generated from nuclear power.

2.10 (a) Table of row percentages:

ENJOY SHOPPING
FOR CLOTHING

GENDER

Male Female Total

Yes 38% 62% 100%
No 74 26 100
Total 48 52 100

Table of column percentages:

ENJOY SHOPPING
FOR CLOTHING

GENDER

Male Female Total

Yes 57% 86% 72%
No 43 14 28
Total 100 100 100

STUDENT MAJOR CATEGORIES

GENDER A C M Totals

Male 14 9 2 25
Female 6 6 3 15
Totals 20 15 5 40

820
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Table of total percentages: (c) All the troughs will meet the company’s requirements of between 8.31
and 8.61 inches wide.

2.22 (a) Bulb Life Percentage, Percentage,
(hrs) Mfgr A Mfgr B

650–749 7.5% 0.0%
750–849 12.5 5.0
850–949 50.0 20.0
950–1,049 22.5 40.0

1,050–1,149 7.5 22.5
1,150–1,249 0.0 12.5

(b) Percentage Less Percentage Less 
% Less Than Than, Mfgr A Than, Mfgr B 

750 7.5% 0.0%
850 20.0 5.0
950 70.0 25.0

1,050 92.5 65.0
1,150 100.0 87.5
1,250 100.0 100.0

(c) Manufacturer B produces bulbs with longer lives than Manufacturer A.
The cumulative percentage for Manufacturer B shows that 65% of its
bulbs lasted less than 1,050 hours, contrasted with 92.5% of Manufacturer
A’s bulbs, which lasted less than 950 hours. None of Manufacturer A’s
bulbs lasted more than 1,149 hours, but 12.5% of Manufacturer B’s bulbs
lasted between 1,150 and 1,249 hours. At the same time, 7.5% of
Manufacturer A’s bulbs lasted less than 750 hours, whereas all of
Manufacturer B’s bulbs lasted at least 750 hours.

2.24 (b) The Pareto chart is best for portraying these data because it not
only sorts the frequencies in descending order but also provides the
cumulative line on the same chart. (c) You can conclude that friends/family
account for the largest percentage, 45%. When other, news media, and
online user reviews are added to friends/family, this accounts for 83%.

2.26 (b) 88%. (d) The Pareto chart allows you to see which sources
account for most of the electricity.

2.28 (b) Since electricity consumption is spread over many types of
appliances, a bar chart may be best in showing which types of appliances
used the most electricity. (c) Air conditioning, lighting, and clothes
washers/other accounted for 58% of the residential electricity use in the
United States.

2.30 (b) A higher percentage of females enjoy shopping for clothing.

2.32 The percentage of online retailers who require three or more clicks to
be removed from an e-mail list has increased drastically from 2008 to 2009.

(b) A higher percentage of females enjoy shopping for clothing.

2.12 The percentage of online retailers who require three or more clicks to
be removed from an e-mail list has increased drastically from 2008 to 2009.

2.14 73 78 78 78 85 88 91.

2.16 (a) 10 but less than 20, 20 but less than 30, 30 but less than 40, 40
but less than 50, 50 but less than 60, 60 but less than 70, 70 but less than
80, 80 but less than 90, 90 but less than 100. (b) 10. (c) 15, 25, 35, 45, 55,
65, 75, 85, 95.

2.18 (a) Electricity Costs Frequency Percentage

$80 up to $99 4 8%
$100 up to $119 7 14
$120 up to $139 9 18
$140 up to $159 13 26
$160 up to $179 9 18
$180 up to $199 5 10
$200 up to $219 3 6

(b) Electricity Cumulative
Costs Frequency Percentage %

$ 99 4 8.00% 8.00%
$119 7 14.00 22.00
$139 9 18.00 40.00
$159 13 26.00 66.00
$179 9 18.00 84.00
$199 5 10.00 94.00
$219 3 6.00 100.00

(c) The majority of utility charges are clustered between $120 and $180.

2.20 (a) Width Frequency Percentage

8.310–8.329 3 6.12%
8.330–8.349 2 4.08
8.350–8.369 1 2.04
8.370–8.389 4 8.16
8.390–8.409 5 10.20
8.410–8.429 16 32.65
8.430–8.449 5 10.20
8.450–8.469 5 10.20
8.470–8.489 6 12.24
8.490–8.509 2 4.08

(b) Width Percentage Less Than

8.310 0
8.330 6.12
8.350 10.20
8.370 12.24
8.390 20.40
8.410 30.60
8.430 63.25
8.450 73.45
8.470 83.65
8.490 95.89
8.51 100.00

GENDER
ENJOY SHOPPING 
FOR CLOTHING Male Female Total

Yes 27% 45% 72%
No 21 7 28
Total 48 52 100

Stem
unit: 10

11 4
12
13 5
14 1 5 6
15 1 8
16 1 2 4 5 6
17 0 0 2
18 0 5 7
19
20 5
21 0 5 6

Stem
unit: 10

22 0 2 3 4
23
24
25 9
26
27
28
29
30 5
31
32 6

Stem
unit: 10

33
34
35
36
37
38
39
40
41 1

(b) The results are concentrated between $160 and $225.

2.36 (a)

2.34 50 74 74 76 81 89 92.
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2.38 (c) The majority of utility charges are clustered between $120 and $180.

2.40 The property taxes per capita appear to be right-skewed, with
approximately 90% falling between $399 and $1,700 and the remaining
10% falling between $1,700 and $2,100. The center is at about $1,000.

2.42 (d) All the troughs will meet the company’s requirements of between
8.31 and 8.61 inches wide.

2.44 (c) Manufacturer B produces bulbs with longer lives than
Manufacturer A.

2.46 (b) Yes, there is a strong positive relationship between X and Y. As X
increases, so does Y.

2.48 (c) There appears to be very little relationship between the first weekend
gross and either the U.S. gross or the worldwide gross of Harry Potter movies.

2.50 (c) There appears to be a positive relationship between the coaches’
salary and revenue. Yes, this is borne out by the data.

2.52 (b) There is a great deal of variation in the returns from decade to
decade. Most of the returns are between 5% and 15%. The 1950s, 1980s,
and 1990s had exceptionally high returns, and only the 1930s and 2000s
had negative returns.

2.54 (b) There has been a steady increase in the amount of solar power
installed in the United States between 2000 and 2008. During that time, the
yearly amount of solar power installed has increased from 44 megawatts to
250 megawatts. The yearly rate of increase appears to have accelerated
since 2006.

2.56 (a)

2.78 (c) The publisher gets the largest portion (64.8%) of the revenue.
About half (32.3%) of the revenue received by the publisher covers
manufacturing costs. The publisher’s marketing and promotion account
for the next largest share of the revenue, at 15.4%. Author, bookstore
employee salaries and benefits, and publisher administrative costs and
taxes each account for around 10% of the revenue, whereas the publisher
after-tax profit, bookstore operations, bookstore pretax profit, and freight
constitute the “trivial few” allocations of the revenue. Yes, the bookstore
gets twice the revenue of the authors.

2.80 (b) The pie chart may be best since with only three categories it
enables you to see the portion of the whole in each category. (d) The pie
chart may be best since with only four categories since it enables you to
see the portion of the whole in each category. (e) The online content is not
copy-edited or fact-checked as carefully as print content. Only 41% of the
online content is copy-edited as carefully as print content and only 57%
of the online content is fact-checked as carefully as the print content.

2.82 (a)

(b) Although the ratio of fee-yes to fee-no bond funds for intermediate
government category seems to be about 2-to-3 (19% to 31%), the ratio for
above-average-risk intermediate government bond funds is closer to 1-to-1
(8.9% to 9.4%). While the group “intermediate government funds that do
not charge a fee” has nearly equal numbers of above average risk, average
risk, and below risk funds, the group “short term corporate bond funds that
do not charge a fee” contains about 50% more below-average-risk funds
than above-average-risk ones. The pattern of risk percentages differs
between the fee-yes and fee-no funds in each of bond fund categories.
(c) The results for type, fee, and risk, in the two years are similar.

2.58 (a)
Count

of Risk

Fees

No No

Total

Yes Yes

Total

Grand

TotalCategory Average High Low Average High Low

Large cap 95 76 80 251 79 51 69 199 450
Mid-cap 33 41 23 97 22 45 10 77 174
Small cap 52 84 16 152 30 58 4 92 244
Grand

Total
180 201 119 500 131 154 83 368 868

GENDER
DESSERT
ORDERED Male Female Total

Yes 71% 29% 100%
No 48 52 100
Total 53 47 100

GENDER
DESSERT
ORDERED Male Female Total

Yes 30% 14% 23%
No 70 86 77
Total 100 100 100

BEEF ENTRÉE
DESSERT
ORDERED Yes No Total

Yes 52% 48% 100%
No 25 75 100
Total 31 69 100

GENDER
DESSERT
ORDERED Male Female Total

Yes 16% 7% 23%
No 37 40 77
Total 53 47 100

BEEF ENTRÉE
DESSERT
ORDERED Yes No Total

Yes 38% 16% 23%
No 62 84 77
Total 100 100 100

(b) Large-cap funds without fees are fairly evenly spread in risk, while
large-cap funds with fees are more likely to have average or low risk.
Mid-cap and small-cap funds, regardless of fees, are more likely to have
average or high risk.

BEEF ENTRÉE
DESSERT
ORDERED Yes No Total

Yes 12% 11% 23%
No 19 58 77
Total 31 69 100
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(b) If the owner is interested in finding out the percentage of males and
females who order dessert or the percentage of those who order a beef
entrée and a dessert among all patrons, the table of total percentages is
most informative. If the owner is interested in the effect of gender on
ordering of dessert or the effect of ordering a beef entrée on the ordering
of dessert, the table of column percentages will be most informative.
Because dessert is usually ordered after the main entrée, and the owner
has no direct control over the gender of patrons, the table of row
percentages is not very useful here. (c) 30% of the men ordered desserts,
compared to 14% of the women; men are more than twice as likely to
order dessert as women. Almost 38% of the patrons ordering a beef entrée
ordered dessert, compared to 16% of patrons ordering all other entrées.
Patrons ordering beef are more than 2.3 times as likely to order dessert as
patrons ordering any other entrée.

2.84 (a) 23575R15 accounts for over 80% of the warranty claims. 
(b) 91.82% of the warranty claims are from the ATX model. (c) Tread
separation accounts for 73.23% of the warranty claims among the ATX
model. (d) The number of claims is evenly distributed among the three
incidents; other/unknown incidents account for almost 40% of the claims,
tread separation accounts for about 35% of the claims, and blowout
accounts for about 25% of the claims.

2.86 (c) The alcohol percentage is concentrated between 4% and 6%, 
with the largest concentration between 4% and 5%. The calories are
concentrated between 140 and 160. The carbohydrates are concentrated
between 12 and 15. There are outliers in the percentage of alcohol in 
both tails. The outlier in the lower tail is due to the non-alcoholic beer
O’Doul’s with only a 0.4% alcohol content. There are a few beers with
alcohol content as high as around 10.5%. There are a few beers with
calorie content as high as around 302.5 and carbohydrates as high as 31.5.
There is a strong positive relationship between percentage alcohol and
calories, and calories and carbohydrates and a moderately positive
relationship between percentage alcohol and carbohydrates.

2.88 (c) The money market yield is concentrated between 0.95 and 1.35.
The five-year CD is concentrated between 2.8 and 3.1. In general, the
five-year CD has the higher yield. There appears to be a positive
relationship between the yield of the money market and the five-year CD.

2.90 (a) Frequency (Boston)

Weight (Boston) Frequency Percentage

3,015 but less than 3,050 2 0.54%
3,050 but less than 3,085 44 11.96
3,085 but less than 3,120 122 33.15
3,120 but less than 3,155 131 35.60
3,155 but less than 3,190 58 15.76
3,190 but less than 3,225 7 1.90
3,225 but less than 3,260 3 0.82
3,260 but less than 3,295 1 0.27

(b) Frequency (Vermont)

Weight (Vermont) Frequency Percentage

3,550 but less than 3,600 4 1.21%
3,600 but less than 3,650 31 9.39
3,650 but less than 3,700 115 34.85
3,700 but less than 3,750 131 39.70
3,750 but less than 3,800 36 10.91
3,800 but less than 3,850 12 3.64
3,850 but less than 3,900 1 0.30

Calories Frequency Percentage Limit
Percentage
Less Than

50 but less than 100 3 12% 100 12%
100 but less than 150 3 12 150 24
150 but less than 200 9 36 200 60
200 but less than 250 6 24 250 84
250 but less than 300 3 12 300 96
300 but less than 350 0 0 350 96
350 but less than 400 1 4 400 100

Cholesterol Frequency Percentage Limit
Percentage
Less Than

0 but less than 50 2 8% 50 8%
50 but less than 100 17 68 100 76
100 but less than 150 4 16 150 92
150 but less than 200 1 4 200 96
200 but less than 250 0 0 250 96
250 but less than 300 0 0 300 96
300 but less than 350 0 0 350 96
350 but less than 400 0 0 400 96
400 but less than 450 0 0 450 96
450 but less than 500 1 4 500 100

The sampled fresh red meats, poultry, and fish vary from 98 to 397
calories per serving, with the highest concentration between 150 to 200
calories. One protein source, spareribs, with 397 calories, is more than
100 calories above the next-highest-caloric food. The protein content of
the sampled foods varies from 16 to 33 grams, with 68% of the values
falling between 24 and 32 grams. Spareribs and fried liver are both very
different from other foods sampled—the former on calories and the latter
on cholesterol content.

2.94 (b) There is a downward trend in the amount filled. (c) The amount
filled in the next bottle will most likely be below 1.894 liter. (d) The
scatter plot of the amount of soft drink filled against time reveals the
trend of the data, whereas a histogram only provides information on the
distribution of the data.

CHAPTER 3
3.2 (a) (b)

(c) Z scores:
None of the Z scores are larger than 3.0 or smaller than .

There is no outlier. (d) Symmetric because 

3.4 (a) (b)
(c) .

(d) Left-skewed because 

3.6

3.8 (a)

-0.085.

mean 6 median.
0.635, -0.889, -1.270, 0.635, 0.889S = 7.874, CV = 393.7%.

Range = 17, S2 = 62Mean = 2, median = 7, mode = 7.

mean = median.
-3.01.522.

0, -0.913, 0.609, 0, -1.217,S = 3.286, CV = 46.948%.
Range = 9, S2 = 10.8,Mean = 7, median = 7, mode = 7.

Grade X Grade Y

Mean 575 575.4
Median 575 575
Standard deviation 6.40 2.07

(b) If quality is measured by central tendency, Grade X tires provide
slightly better quality because X’s mean and median are both equal to the
expected value, 575 mm. If, however, quality is measured by consistency,
Grade Y provides better quality because, even though Y’s mean is only
slightly larger than the mean for Grade X, Y’s standard deviation is much
smaller. The range in values for Grade Y is 5 mm compared to the range
in values for Grade X, which is 16 mm.

2.92 (c)

(d) 0.54% of the Boston shingles pallets are underweight, and 0.27% are
overweight. 1.21% of the Vermont shingles pallets are underweight, and
3.94% are overweight.
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3.20 (a)
per year. (b)

(c) The result for Taser was worse than the result for GE, which
was worth $461.18.

3.22 (a) per year.
(b) Gold had a higher return than silver and a much higher return than
platinum. (c) All the metals had positive returns, whereas the three stock
indices all had returns that were close to 0.

3.24 (a) 4, 9, 5. (b) 3, 4, 7, 9, 12. (c) The distances between the median
and the extremes are close, 4 and 5, but the differences in the tails are
different (1 on the left and 3 on the right), so this distribution is slightly
right-skewed. (d) In Problem 3.2 (d), because , the
distribution is symmetric. The box part of the graph is symmetric, but the
tails show right-skewness.

3.26 (a) (b) (c) The shape is left-skewed.
(d) This is consistent with the answer in Problem 3.4 (d).

3.28 (a) ranked value = 4th ranked value = $0.68, 

ranked value = 11th ranked value = $1.14,

Interquartile (b) Five-number summary:
0.55 0.68 0.88 1.14 1.51. (c) The distribution is right-skewed.

3.30 (a) (b) Five-number
summary: 16 19 21 22 26. (c) The MPG of SUVs is approximately
symmetric since the distance from the smallest value to the median is the
same as the distance from the median to the largest value although the
other comparisons are inconsistent.

3.32 (a) Commercial district five-number summary: 0.38 3.2 4.5 5.55
6.46. Residential area five-number summary: 3.82 5.64 6.68 8.73 10.49.
(b) Commercial district: The distribution is left-skewed. Residential area:
The distribution is slightly right-skewed. (c) The central tendency of the
waiting times for the bank branch located in the commercial district of a
city is lower than that of the branch located in the residential area. There
are a few long waiting times for the branch located in the residential area,
whereas there are a few exceptionally short waiting times for the branch
located in the commercial area.

3.34 (a)

interquartile range = 3.Q1 = 19, Q3 = 22,

range = 1.14 - 0.68 = $0.46.

Q3 =
3114 + 12

4
=

45
4

= 11.25

Q1 =
14 + 1

4
= 3.75

-8, -6.5, 7, 8, 9.-6.5, 8, 14.5.

mean = median

Platinum = 10.95%, gold = 20.65%, silver = 17.65%

$304.37.
= 1$1,0002 * 11 - 0.44832 * 11 - 0.44832 =-44.83%

311 - 0.63312 * 11 - 0.1705241>2 - 1 = 0.5517 - 1 =Grade X Grade Y, Altered

Mean 575 577.4
Median 575 575
Standard deviation 6.40 6.11

When the fifth Y tire measures 588 mm rather than 578 mm, Y’s mean
inner diameter becomes 577.4 mm, which is larger than X’s mean inner
diameter, and Y’s standard deviation increases from 2.07 mm to 6.11 mm.
In this case, X’s tires are providing better quality in terms of the mean
inner diameter, with only slightly more variation among the tires than Y’s.

3.10 (a) ,

(c) The mean is only slightly smaller than the median, so the data are only
slightly right-skewed. (d) The mean cost is $7.03, and the median cost is
$7.38. The average scatter of cost around the mean is $1.81. The
difference between the highest cost and the lowest cost is $5.67.

3.12 (a) (b)
and

Z scores are 1.13, 0.76, 0.39, 0.03, 0.39, 0.39, -1.07, -1.07, 1.86, 1.86,
1.86, -0.71, -0.71, -0.71, 0.03, 0.03, 0.03, 0.03, 0.03, -1.07, -0.71,
0.03, 0.39, 0.39, -1.81, -1.81. (c) Because the mean is very close to the
median, the data are approximately symmetric. (d) The distributions of
MPG of the sedans is right-skewed, while the MPG of the SUVs is
symmetric. The mean MPG of sedans is 3.93 higher than that of SUVs.
The average scatter and the range of the MPG of sedans is much higher
than that for SUVs.

3.14 (a) (b)
There is no

outlier because none of the Z scores has an absolute value that is greater
than 3.0. (c) The data appear to be right-skewed because the mean is
greater than the median.

3.16 (a) . (b)
(c) The price paid by

U.S. travelers is right-skewed because the mean is greater than the
median. (d) (a) (b)

. (c) The price paid by
U.S. travelers is now almost symmetric because the mean is only slightly
greater than the median due to the much lower price in the first city ($85).

3.18 (a) (b)

(c) Because the mean is greater than the median, the distribution is right-
skewed. (d) The mean and median are both greater than 5 minutes. The
distribution is right-skewed, meaning that there are some unusually high
values. Further, 13 of the 15 bank customers sampled (or 86.7%) had
waiting times greater than 5 minutes. So the customer is likely to
experience a waiting time in excess of 5 minutes. The manager overstated
the bank’s service record in responding that the customer would “almost
certainly” not wait longer than 5 minutes for service.

CV = 29.27%.range = 6.67,standard deviation = 2.082,
Variance = 4.336,Mean = 7.11, median = 6.68.

variance = 624.67, standard deviation = $24.99
Range = $75,Mean = $117.33, median = $114.00.

variance = 998.00, standard deviation = $31.59.
Range = $80,Mean = $134.0, median = $121.0

CV = 35.36%.range = 0.96,standard deviation = 0.3273,
Variance = 0.1071,Mean = 0.9257, median = 0.88

S = 2.7265, range = 10, coefficient of variation = 13.03%,
S2 = 7.4338,Mean = 20.9231, median = 21, mode = 21

Coefficient of variation =
1.8125
7.0289

* 100% = 25.79%

= 5.67,
range = 9.87 - 4.20Standard deviation = 23.2851 = 1.8125,

=
26.2809
9 - 1

= 3.2851,

+18.46 - 7.028922 + 18.47 - 7.028922 + 19.87 - 7.028922
+16.45 - 7.028922 + 17.38 - 7.028922 + 17.54 - 7.028922

Variance = 14.20 - 7.028922 + 15.03 - 7.028922 + 15.86 - 7.028922
Median = 5th ranked value = 7.38

Mean =
63.26

9
= 7.0289

Average of 

3-Year Return Risk

Type
Above

Average Average
Below

Average
Grand
Total

Intermediate
government

5.6515 5.7862 4.8214 5.4367

Short-term
corporate

-0.0440 2.6355 3.2294 2.1156

Grand total 3.1966 4.1583 3.9484 3.7761

(c)

(b)

StdDev of 
3-Year Return Risk

Type
Above

Average Average Below Average Grand Total

Intermediate
government

2.4617 1.1457 1.2784 1.8066

Short-term
corporate

3.6058 1.7034 1.4886 2.6803

Grand total 4.1197 2.1493 1.6001 2.8227
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respectively. (c) This is consistent with 68%, 95%, and 99.7%, according 

to the empirical rule. (d) (a)

(b) 66%, 98%, and 100% of these states have a mean 
per capita energy consumption within 1, 2, and 3 standard deviations of
the mean, respectively. (c) This is consistent with 68%, 95%, and 99.7%,
according to the empirical rule.

3.44

3.46 (a)

(b)

(c) The correlation coefficient is more valuable for expressing the
relationship between calories and sugar because it does not depend on the
units used to measure calories and sugar. (d) There is a strong positive
linear relationship between calories and sugar.

3.48 (a) (b) (c) There is a positive
linear relationship between the coaches’ salary and revenue.

3.62 (a) 3rd quartile =
63. (b)

(c) The distribution is right-
skewed because there are a few policies that require an exceptionally long
period to be approved. (d) The mean approval process takes 43.89 days,
with 50% of the policies being approved in less than 45 days. 50% of the
applications are approved between 18 and 63 days. About 67% of the
applications are approved between 18.6 and 69.2 days.

3.64 (a)
The mean and median width are both 8.42 inches. The range of the widths
is 0.186 inch, and the average scatter around the mean is 0.0461 inch.
(b) 8.312, 8.404, 8.42, 8.459, 8.498. (c) Even though mean = median the
left tail is slightly longer, so the distribution is slightly left-skewed.
(d) All the troughs in this sample meet the specifications.

3.66 (a), (b)

S = 0.0461.Mean = 8.421, median = 8.42, range = 0.186,

standard deviation = 25.28, CV = 57.61%.
Range = 76, interquartile range = 45, variance = 639.2564,
Mean = 43.89, median = 45, 1st quartile = 18,

r = 0.7903cov1X, Y2 = 4,473,270.3

r =
cov 1X, Y2

SX SY
=

133.3333

146.9042213.38772 = 0.8391.

cov1X, Y2 =
a

n

i=1
1Xi - X 21Yi - Y 2

n - 1
=

800
6

= 133.3333.

Covariance = 65.2909, r = + 1.0.

3,773.34.

711,905,533.6

50
= 14,238,110.67, standard deviation = 114,238,110.67 =

Mean =
642,887

50
= 12,857.74, variance =

Average of Return
2008 Risk

Type Fees
Above
Average Average

Below
Average Grand Total

Intermediate
government

No 9.0294 6.9053 4.0368 6.5709

Yes 3.8863 7.1700 4.5444 4.9937

Intermediate
government total

6.5358 6.99656 4.200 5.9576

Short-term
corporate

No 10.7315 -1.6174 0.4600 -3.2607

Yes -10.2000 -1.6250 0.7250 -3.5941

Short-term
corporate total

-10.6252 -1.6140 0.492 -3.3237

Grand total -0.8612 2.5450 2.1661 1.316

StdDev of Return
2008 Risk

Type Fees
Above
Average Average

Below
Average Grand Total

Intermediate
government

No 5.6635 3.6998 3.5178 4.7322

Yes 6.5778 2.8744 3.2055 5.0712

Intermediate
government total

6.5675 3.3870 3.3694 4.8999

Short-term
corporate

No 8.6070 4.0613 3.3503 7.1587

Yes 7.2928 5.4013 3.5790 6.9786

Short-term
corporate total

8.2199 4.3480 3.3220 7.0874

Grand total 11.2319 5.8231 3.8020 7.6530

Calories Fat

Mean 108.3333 3.375
Median 110 3.25
Standard deviation 19.4625 1.7597
Sample variance 378.7879 3.0966
Range 70 5.5
First quartile 90 1.5
Third quartile 120 5
Interquartile range 30 3.5
Coefficient of variation 17.97% 52.14%

(c) Across the three different risk levels, intermediate government funds
have the highest average three-year returns but the lowest standard
deviation. (d) Similarly to the 2006–2008 three-year returns, intermediate
government funds have the highest average three-year returns but the
lowest standard deviation across the three different risk levels.

3.36 (a)

(b)

(c) The intermediate government funds have the highest average 2008
returns but the lowest standard deviation among all different
combinations of risk level and whether there is a fee charged with the
exception that they have the highest average 2008 returns and the highest
standard deviation among the below average risk funds that do not charge
a fee. (d) In contrast to the 2008 returns, the intermediate government
funds have the lowest average 2009 returns for all combinations of risk
level and whether the funds charged a fee with the except of the below
average risk funds that do not charge a fee where the intermediate
government funds have the highest average 2008 returns. Unlike the 2008
returns, the intermediate government funds have the lowest standard
deviations only among the above average risk funds that do not charge a
fee, the average risk funds that either charge a fee or do not charge a fee,
and the below average risk funds that charge a fee.

3.38 (a) Population mean, (b) Population standard deviation,
population variance,

3.40 (a) 68%. (b) 95%. (c) Not calculable, 75%, 88.89%. (d) to
or to 19.2.

3.42 (a)

(b) 64.71%, 98.04%, and 100% of these states have mean per capita
energy consumption within 1, 2, and 3 standard deviations of the mean,

standard deviation = 114,959,700.52 = 3,867.78.14,959,700.52,

Mean =
662,960

51
= 12,999.22, variance =

762,944,726.6

51
=

-2.8m + 4s
m - 4s

s2 = 2.8.s = 1.673,
m = 6.

(c) The distribution of calories and total fat are symmetrical.

(d)

(e) The number of calories of the veggie burgers centers around 110, and
its distribution is symmetrical. The amount of fat centers around 3.3 grams
per serving, and its distribution is symmetrical. There is a positive linear
relationship between calories and fat.

3.68 (a) Boston: 0.04, 0.17, 0.23, 0.32, 0.98; Vermont: 0.02, 0.13, 0.20,
0.28, 0.83. (b) Both distributions are right-skewed. (c) Both sets of
shingles did quite well in achieving a granule loss of 0.8 gram or less.

r =
cov 1X, Y2

SX SY
= 0.6969.



826 Self-Test Solutions and Answers to Selected Even-Numbered Problems

Only two Boston shingles had a granule loss greater than 0.8 gram. The
next highest to these was 0.6 gram. These two values can be considered
outliers. Only 1.176% of the shingles failed the specification. Only one of
the Vermont shingles, had a granule loss greater than 0.8 gram. The next
highest was 0.58 gram. Thus, only 0.714% of the shingles failed to meet
the specification.

3.70 (a) The correlation between calories and protein is 0.4644. (b) The
correlation between calories and cholesterol is 0.1777. (c) The correlation
between protein and cholesterol is 0.1417. (d) There is a weak positive
linear relationship between calories and protein, with a correlation
coefficient of 0.46. The positive linear relationships between calories and
cholesterol and between protein and cholesterol are very weak.

3.72 (a), (b)

4.16 (a) (b)
(c) (d) Because events
A and B are independent.

4.18

4.20 Because and events A and B
are not independent.

4.22 (a) (b) (c)
which is not equal to 

Therefore, answers quickly and
age are not independent.

4.24 (a) (b) (c)
(d)

4.26 (a) (b) (c) Because
and

the two events are not independent.

4.28 (a) 0.0045. (b) 0.012. (c) 0.0059. (d) 0.0483.

4.30 0.095.

4.32 (a) 0.736. (b) 0.997.

4.34 (a)

(b)

4.36 (a)

(b)

4.38

4.40 (a) (b) (c) There are two mutually
exclusive and collectively exhaustive outcomes in (a) and six in (b).

4.42

4.44 Not all the orders are equally likely
because the teams have a different probability of finishing first through fifth.

4.46

4.48

4.50 4,950.

4.60 (a)

10!
4!6!

= 210.

n! = 6! = 720.

5! = (5)(4)(3)(2)(1) = 120.

(8)(4)(3)(3) = 288.

67 = 279,936.27 = 128.

310 = 59,049.

P1Favorable review2 = 0.459.
P1Loser|Favorable review2 = 0.06>0.459 = 0.1307.
P(Break even|Favorable review2 = 0.16>0.459 = 0.3486;
P1Moderate success|Favorable review2 = 0.14>0.459 = 0.3050;

P1Huge success|Favorable review2 = 0.099>0.459 = 0.2157;

P1O2 = 0.175 + 0.15 = 0.325.

P1B¿|O2 =
10.5210.32

10.5210.32 + 10.25210.72 = 0.4615.

P1Needs warranty repair2 = 0.04,
P1Needs warranty repair|Manufacturer based in U.S.2 = 0.0417

0.015>0.4 = 0.0375.0.025>0.6 = 0.0417.

1,649>1,895 = 0.8702.0.1298.
246>1,895 =1,345>1,895 = 0.7098.550>1,895 = 0.2902.

quickly|between 12 and 502 = 0.536.
P(Answersquickly) = 1,243>2,000 = 0.6215
P1Answers707>1,000 = 0.707.536>1,000 = 0.536.

P1A2P1B2 = 0.12,P1A and B2 = 0.20

1
2 = 0.5.

P(A>B) = P1A2 = 1>3,40>60 = 2>3 = 0.67.
20>60 = 1>3 = 0.33.10>30 = 1>3 = 0.33.

Property Taxes per Capita ($)

Mean 1,040.863
Median 981
Standard deviation 428.5385
Sample variance 183,645.2
Range 1,732
First quartile 713
Third quartile 1,306
Interquartile range 593
Coefficient of variation 41.17%

Age

Goals 18–25 26–40 Total

Getting Rich 405 310 715
Other 95 190 285
Total 500 500 1,000

(c), (d) The distribution of the property taxes per capita is right-skewed,
with a mean value of $1,040.83, a median of $981, and an average spread
around the mean of $428.54. There is an outlier in the right tail at $2,099,
while the standard deviation is about 41.17% of the mean. 25% of the
states have property tax that falls below $713 per capita, and 25% have
property taxes that are higher than $1,306 per capita.

CHAPTER 4
4.2 (a) Simple events include selecting a red ball. (b) Selecting a white ball.

4.4 (a) (b)
(c) (d)

4.6 (a) Mutually exclusive, not collectively exhaustive. (b) Not mutually
exclusive, not collectively exhaustive. (c) Mutually exclusive, not
collectively exhaustive. (d) Mutually exclusive, collectively exhaustive.

4.8 (a) Needs three or more clicks to be removed from an email list.
(b) Needs three or more clicks to be removed from an email list in 2009.
(c) Does not need three or more clicks to be removed from an email list.
(d) “Needs three or more clicks to be removed from an email list in 2009”
is a joint event because it consists of two characteristics.

4.10 (a) A respondent who answers quickly. (b) A respondent who
answers quickly who is over 70 years old. (c) A respondent who does
not answer quickly. (d) A respondent who answers quickly and is over
70 years old is a joint event because it consists of two characteristics,
answering quickly and being over 70 years old.

4.12 (a) (b) (c)
(d) The probability

of “is engaged with their workplace or is a U.S. worker” includes the
probability of “is engaged with their workplace” plus the probability of
“is a U.S. worker” minus the joint probability of “is engaged with their
workplace and is a U.S. worker.”

4.14 (a) (b)
(c) (d) 500>500 = 1.00.396>500 = 99>125 = 0.792.

224>500 = 56>125 = 0.448.360>500 = 18>25 = 0.72.

1,895>3,790 - 550>3,790 = 2,141>3790 = 0.5649.
796>3,790 +1,895>3,790 = 0.50.796/3,790 = 0.21.

9>10 = 0.9.35>100 = 7>20 = 0.35.
10>100 = 1>10 = 0.1.60>100 = 3>5 = 0.6.

(b) Simple event: “Has a goal of getting rich.” Joint event: “Has a goal
of getting rich and is between 18–25 years old.” (c) P(Has a goal of
getting rich). (d) P(Has a goal of getting rich and is in the 26–40-year-old
group) (e) Not independent.

4.62 (a) 99/200. (b) 127/200. (c) 129/200. (d) 29/200. (f) 10/100.

4.64 (a) 0.4712. (b) Because the probability that a fatality involved a
rollover, given that the fatality involved an SUV, a van, or a pickup is
0.4712, which is almost twice the probability that a fatality involved a
rollover with any vehicle type, at 0.24, SUVs, vans, and pickups are
generally more prone to rollover accidents.

= 310>1000 = 0.31.
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CHAPTER 5
5.2 (a)

(b)

.

5.4 (a)

= 1.183

s = A (0 - 2)2(0.10) + (1 - 2)2(0.20) + (2 - 2)2(0.45) +
(3 - 2)2(0.15) + (4 - 2)2(0.05) + (5 - 2)210.052

510.052 = 2.0.
m = 010.102 + 110.202 + 210.452 + 310.152 + 410.052 +

5.26 Given and

(a)

(b)

(c)

.

(d)

5.28 (a) 0.2565. (b) 0.1396. (c) 0.3033. (d) 0.0247.

5.30 (a) 0.0337. (b) 0.0067. (c) 0.9596. (d) 0.0404.

5.32 (a)

(b)

(c)

(d)

5.34 (a) (b)
(c)

5.36 (a) 0.0176. (b) 0.9093. (c) 0.9220.

5.38 (a) 0.2618. (b) 0.8478. (c) Because Ford had a lower mean rate of
problems per car in 2009 compared to Dodge, the probability of a
randomly selected Ford having zero problems and the probability of no
more than two problems are both higher than their values for Dodge.

5.40 (a) 0.2441. (b) 0.8311. (c) Because Dodge had a lower mean rate of
problems per car in 2009 compared to 2008, the probability of a randomly
selected Dodge having zero problems and the probability of no more than
two problems are both lower in 2009 than their values in 2008.

5.42 (a) 0.238. (b) 0.2. (c) 0.1591. (d) 0.0083.

5.44 (a) If and

(b) If and

= 1 - [0.1100 + 0.3046] = 0.5854.

= 1 - D a30
0
b a100 - 30

6 - 0
b

a100
6
b

+
a30

1
b a100 - 30

6 - 1
b

a100
6
b

T .

P1X Ú 22 = 1 - [P1X = 02 + P1X = 12]
N = 100,n = 6, A = 30,

= 1 - [0.1689 + 0.3620] = 0.4691.

= 1 - D a25
0
b a100 - 25

6 - 0
b

a100
6
b

+
a25

1
b a100 - 25

6 - 1
b

a100
6
b

T .

P1X Ú 22 = 1 - [P1X = 02 + P1X = 12]
N = 100,n = 6, A = 25,

P1X Ú 22 = 0.9000.
P1X Ú 12 = 0.9796.P1X = 02 = 0.0204.

= 0.2945.

P(X = 4 or X = 5) = P(X = 4) + P(X = 5) =
e-6(6)4

4!
+

e-61625
5!

P1X Ú 52 = 1 - P1X 6 52 = 1 - 0.2851 = 0.7149.

P(X = 5) =
e-61625

5!
= 0.1606.

= 0.2851.

+ 0.133853
= 0.002479 + 0.014873 + 0.044618 + 0.089235

=
e-6(6)0

0!
+

e-6(6)1

1!
+

e-6(6)2

2!
+

e-6(6)3

3!
+

e-61624
4!

+P(X = 4)
P(X 6 5) = P(X = 0) + P(X = 1) + P(x = 2) + P(X = 3)

= 1310.848210.1522 = 0.6218.

E1X2 = np = 310.8482 = 2.544 sX = 1np11 - p2
=

3!
2!1!

(0.848)2(0.152)1 +
3!

3!0!
(0.848)310.15220 = 0.9377

P1X Ú 22 = P1X = 22 + P1X = 32
P(X = 0) =

n!
x!(n - x)!

px(1 - p)n-x =
3!

0!3!
 (0.848)010.15223 = 0.0035.

P(X = 3) =
n!

x!(n - x)!
px(1 - p)n-x =

3!
3!0!

 (0.848)310.15220 = 0.6098.

n = 3,p = 0.848

X P(X)

$ - 1 21>36
$ + 1 15>36

X P(X)

$ - 1 21>36
$ + 1 15>36

X P(X)

$ - 1 30>36
$ + 4 6>36

(b)

(c)

(d) for each method of play.

5.6 (a) 2.1058. (b) 1.4671.

5.8 (a) 90; 30. (b) 126.10, 10.95. (c) (d) 120.

5.10 (a) 9.5 minutes. (b) 1.9209 minutes.

5.12

-1,300.

$-0.167

(a)

(b)

(c)

(d) Stock X gives the investor a lower standard deviation while yielding a
higher expected return, so the investor should select stock X.

5.14 (a) $71; $97. (b) 61.88; 84.27. (c) 5,113. (d) Risk-averse investors
would invest in stock X, whereas risk takers would invest in stock Y.

5.16 (a) (b)
. (c) (d) Based on the expected value criteria,

you would choose the common stock fund. However, the common stock
fund also has a standard deviation more than three times higher than that
for the corporate bond fund. An investor should carefully weigh the
increased risk. (e) If you chose the common stock fund, you would need
to assess your reaction to the small possibility that you could lose
virtually all of your entire investment.

5.18 (a) 0.0768. (b) 0.9130. (c) 0.3370. (d) 0.6630.

5.20 (a) 0.40, 0.60. (b) 1.60, 0.98. (c) 4.0, 0.894. (d) 1.50, 0.866.

5.22 (a) 0.2128. (b) 0.3153. (c) 0.9294. (d) = 4.95 = 0.9307.

5.24 (a) 0.0834. (b) 0.2351. (c) 0.6169. (d) 0.3831.

sm

sXY = $10,766.44.$195.22
sY =sX = $57.22;E1Y2 = $63.01.E1X2 = $66.20;

sXY = a
N

i=1
[Xi - E1X2][Yi - E1Y2]P1XiYi2 = -6,306.

sY = AaN
i=1

[Yi - E1Y2]2P1Yi2 = 99.62.

sX = AaN
i-1

[Xi - E1X2]2P1Xi2 = 78.6702.

E1X2 = mX = a
N

i-1
XiP1Xi2 = 59, E1Y2 = mY = a

N

i-1
YiP1Yi2 = 14.

X*P1X2 Y*P1Y2 P1X2
1X - mX22*

P1Y2
1Y - mY22*

P1XY2
1X - mX21Y - mY2*

-10 5 2,528.1 129.6 -572.4
0 45 1,044.3 5,548.8 -2,407.2

24 -6 132.3 346.8 -214.2
45 -30 2,484.3 3,898.8 -3,112.2
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(c) If and

(d) If and

.

(e) The probability that the entire group will be audited is very sensitive
to the true number of improper returns in the population. If the true
number is very low , the probability is very low (0.0279).
When the true number is increased by a factor of , the
probability the group will be audited increases by a factor of more than
20 (0.5854).

5.46 (a) (b)
(c) (d) (a)
(b) (c)

5.48 (a) (b)
(c) (d) Because there were now 12 funds to
consider, the probability that 3 would be short-term corporate funds
decreased from 0.3810 to 0.2424.

5.54 (a) 0.64. (b) 0.64. (c) 0.3020. (d) 0.0060. (e) The assumption of
independence may not be true.

5.56 (a) If and
(b) If and

5.58 (a) 0.1074. (b) 0.2684. (c) 0.6242. (d)
standard

5.60 (a) (b)
(c) (d)
(e)

5.62 (a) If and
(b) If and (c) If and

(d) Based on the results in (a)–(c), the
probability that the Standard & Poor’s 500 Index will increase if there is
an early gain in the first five trading days of the year is very likely to be
close to 0.90 because that yields a probability of 82.52% that at least
33 of the 38 years the Standard & Poor’s 500 Index will increase the
entire year.

5.64 (a) The assumptions needed are (i) the probability that a golfer loses
a golf ball in a given interval is constant, (ii) the probability that a golfer
loses more than one golf ball approaches 0 as the interval gets smaller,
and (iii) the probability that a golfer loses a golf ball is independent from
interval to interval. (b) 0.0067. (c) 0.6160. (d) 0.3840.

5.66 (a) Virtually 0. (b) 0.00000037737. (c) 0.00000173886.
(d) 0.000168669. (e) 0.0011998. (f) 0.00407937. (g) 0.006598978.
(h) 0.0113502. (i) 0.976601.

n = 38, P(X Ú 33) = 0.8252.
p = 0.90n = 38, P(X Ú 33) = 0.0137.p = 0.70

n = 38, P(X Ú 33) = 0.00000213.p = 0.50

P(X Ú 10) = 0.9721.
P(X … 10) = 0.0719.P(X = 15) = 0.1599.
s = 2np(1 - r) = 2.0861.m = np = 13.6

deviation = 1.2649.
Mean = 2.0,

n = 12, P(X Ú 9) = 0.6488.p = 0.75
P(X Ú 9) = 0.0730.n = 12,p = 0.50

P(X = 3) = 0.2424.
P(X Ú 1) = 0.9697.P(X = 1) = 0.2424.

P(X Ú 1) = 0.6123.P(X = 0) = 0.3877.
P(X = 4) = 0.0005.X = 6.P(X Ú 1) = 0.4545.

P(X = 0) = 0.5455.P(X = 4) = 0.00003649.

6 (A = 30)
(A = 5)

= 1 - [0.5223 + 0.3687] = 0.1090

= 1 - D a10
0
b a100 - 10

6 - 0
b

a100
6
b

+
a10

1
b a100 - 10

6 - 1
b

a100
6
b

T
P1X Ú 22 = 1 - [P1X = 02 + P1X = 12]

N = 100,n = 6, A = 10,

= 1 - [0.7291 + 0.2430] = 0.0279

= 1 - D a5
0
b a100 - 5

6 - 0
b

a100
6
b

+
a5

1
b a100 - 5

6 - 1
b

a100
6
b

T .

P1X Ú 22 = 1 - [P1X = 02 + P1X = 12]
N = 100,n = 6, A = 5, CHAPTER 6

6.2 (a) 0.9089. (b) 0.0911. (c) (d) and .

6.4 (a) 0.1401. (b) 0.4168. (c) 0.3918. (d) .

6.6 (a) 0.9599. (b) 0.0228. (c) 43.42. (d) 46.64 and 53.36.

6.8 (a)

(b)

(c)

thousand miles, or

39,920 miles. (d) The smaller standard deviation makes the Z values
larger. (a)

(b)

(c)
thousand miles, or 41,600 miles.

6.10 (a) 0.9878. (b) 0.8185. (c) 86.16%. (d) Option 1: Because your score
of 81% on this exam represents a Z score of 1.00, which is below the
minimum Z score of 1.28, you will not earn an A grade on the exam
under this grading option. Option 2: Because your score of 68% on this
exam represents a Z score of 2.00, which is well above the minimum 
Z score of 1.28, you will earn an A grade on the exam under this grading
option. You should prefer Option 2.

6.12 (a) 0.9461. (b) 0.0032. (c) 0.0045. (d) 29.6714.

6.14 With 39 values, the smallest of the standard normal quantile values
covers an area under the normal curve of 0.025. The corresponding
Z value is . The middle (20th) value has a cumulative area of 0.50 
and a corresponding Z value of 0.0. The largest of the standard normal
quantile values covers an area under the normal curve of 0.975, and its
corresponding Z value is

6.16 (a)
interquartile range 

The mean is slightly less than the median. The range is much less
than 6S, and the interquartile range is less than 1.33S. (b) The normal
probability plot does not appear to be highly skewed. The data may be
symmetrical but not normally distributed.

6.18 (a)

There are 62.75%, 78.43%, and 94.12% of the observations that fall
within 1, 1.28, and 2 standard deviations of the mean, respectively, as
compared to the approximate theoretical 66.67%, 80%, and 95%.
Because the mean is slightly larger than the median, the interquartile
range is slightly larger than 1.33 times the standard deviation, and the
range is much smaller than 6 times the standard deviation, the data appear
to deviate slightly from the normal distribution. (b) The normal
probability plot suggests that the data appear to be slightly right-skewed.

6.20 (a)
Because the interquartile range is close to 1.33S

and the range is also close to 6S, the data appear to be approximately
normally distributed. (b) The normal probability plot suggests that the
data appear to be approximately normally distributed.

6.22 (a) Five-number summary: 82 127 148.5 168 213; 

The mean is very close to the median. The five-number
summary suggests that the distribution is approximately symmetrical
around the median. The interquartile range is very close to 1.33S. The range
is about $50 below 6S. In general, the distribution of the data appears to
closely resemble a normal distribution. (b) The normal probability plot
confirms that the data appear to be approximately normally distributed.

6.24 (a) (b)
(c) (d) Mean standard deviation = 34.641.= 60,1120 - 352>120 = 0.7083.

130 - 102>120 = 0.1667.120 - 02>120 = 0.1667.

deviation = 31.69.
mode = 130, range = 131, interquartile range = 41, standard147.06,

mean =

0.0023, 61S2 = 0.0102.
Interquartile range = 0.0025, S = 0.0017, range = 0.008, 1.331S2=

interquartile range = 593,1.33(S) = 569.9562.6(S) = 2,571.2310,
Mean = 1,040.863, median = 981, range = 1,732,

3.6262.
= 3,1.33(2.7265) =6S = 6(2.7265) = 16.359,

Mean = 20.9231, median = 21, S = 2.7265, range = 10,

+1.96.

-1.96

X = 50 - 0.841102 = 41.60.0228 + 11.0 - 0.84132 = 0.1815.

+ P1Z 7 1.002 =P1X 6 302 + P1X 7 602 = P1Z 6 -2.002
6 Z 6 02 = 0.4452.P134 6 X 6 502 = P1-1.60

=
X - 50

12
, X = 50 - 0.841122 = 39.92Z = -0.84

0.20,P1Z 6 -0.842 �0.0475 + 11.0 - 0.79672 = 0.2508.

P1X 6 302 + P1X 7 602 = P1Z 6 -1.672 + P1Z 7 0.832 =
P134 6 X 6 502 = P1-1.33 6 Z 6 02 = 0.4082.

+1.00

+1.00-1.00+1.96.
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6.26 (a) 0.1. (b) 0.3333. (c) 0.3333. (d) Mean standard deviation

6.28 (a) 0.6321. (b) 0.3679. (c) 0.2326. (d) 0.7674.

6.30 (a) 0.7769. (b) 0.2231. (c) 0.1410. (d) 0.8590.

6.32 (a) For (b) For
(c) For for

6.34 (a) 0.6321. (b) 0.3935. (c) 0.0952.

6.36 (a) 0.8647. (b) 0.3297. (c)(a) 0.9765. (b) 0.5276.

6.46 (a) 0.4772. (b) 0.9544. (c) 0.0456. (d) 1.8835. (e) 1.8710 and 2.1290.

6.48 (a) 0.2734. (b) 0.2038. (c) 4.404 ounces. (d) 4.188 ounces and 5.212
ounces.

6.50 (a) Waiting time will more closely resemble an exponential
distribution. (b) Seating time will more closely resemble a normal
distribution. (c) Both the histogram and normal probability plot suggest
that waiting time more closely resembles an exponential distribution.
(d) Both the histogram and normal probability plot suggest that seating
time more closely resembles a normal distribution.

6.52 (a) 0.999968 (b) 0.0668 (c) 0.0013 (d) 1.6653 (e) 0.8080 to 1.592
(f) 1.0, 0.30, 0.10, 1.935, 0.4875 to 1.91255.

CHAPTER 7
7.2 Sample without replacement: Read from left to right in three-digit
sequences and continue unfinished sequences from the end of the row to
the beginning of the next row:
Row 05: 338 505 855 551 438 855 077 186 579 488 767 833 170
Rows 05–06: 897
Row 06: 340 033 648 847 204 334 639 193 639 411 095 924
Rows 06–07: 707
Row 07: 054 329 776 100 871 007 255 980 646 886 823 920 461
Row 08: 893 829 380 900 796 959 453 410 181 277 660 908 887
Rows 08–09: 237
Row 09: 818 721 426 714 050 785 223 801 670 353 362 449
Rows 09–10: 406
Note: All sequences above 902 and duplicates are discarded.

7.4 A simple random sample would be less practical for personal
interviews because of travel costs (unless interviewees are paid to go to a
central interviewing location).

7.6 Here all members of the population are equally likely to be selected,
and the sample selection mechanism is based on chance. But selection of
two elements is not independent; for example, if A is in the sample, we
know that B is also and that C and D are not.

7.8 (a)

Row 16: 2323 6737 5131 8888 1718 0654 6832 4647 6510 4877
Row 17: 4579 4269 2615 1308 2455 7830 5550 5852 5514 7182
Row 18: 0989 3205 0514 2256 8514 4642 7567 8896 2977 8822
Row 19: 5438 2745 9891 4991 4523 6847 9276 8646 1628 3554
Row 20: 9475 0899 2337 0892 0048 8033 6945 9826 9403 6858
Row 21: 7029 7341 3553 1403 3340 4205 0823 4144 1048 2949
Row 22: 8515 7479 5432 9792 6575 5760 0408 8112 2507 3742
Row 23: 1110 0023 4012 8607 4697 9664 4894 3928 7072 5815
Row 24: 3687 1507 7530 5925 7143 1738 1688 5625 8533 5041
Row 25: 2391 3483 5763 3081 6090 5169 0546
Note: All sequences above 5,000 are discarded. There were no repeating
sequences.

0.9933.
l = 1, P1X … 52 =l = 1, P1X … 12 = 0.6321,0.99996.
l = 2, P1X … 52 =l = 2, P1X … 12 = 0.8647.

0.8660.
==  4.5, (b) 089

(c) With the single exception of invoice 0989, the invoices selected in the
simple random sample are not the same as those selected in the
systematic sample. It would be highly unlikely that a simple random
sample would select the same units as a systematic sample.

7.10 Before accepting the results of a survey of college students, you
might want to know, for example: Who funded the survey? Why was it
conducted? What was the population from which the sample was
selected? What sampling design was used? What mode of response was
used: a personal interview, a telephone interview, or a mail survey? Were
interviewers trained? Were survey questions field-tested? What questions
were asked? Were the questions clear, accurate, unbiased, and valid? What
operational definition of “vast majority” was used? What was the
response rate? What was the sample size?

7.12 (a) The four types of survey errors are coverage error, nonresponse
error, sampling error, and measurement error. (b) When people who
answer the survey tell you what they think you want to hear, rather than
what they really believe, this is the halo effect, which is a source of
measurement error. Also, every survey will have sampling error that
reflects the chance differences from sample to sample, based on the
probability of particular individuals being selected in the particular
sample.

7.14 Before accepting the results of the survey, you might want to know,
for example: Who funded the study? Why was it conducted? What was
the population from which the sample was selected? What sampling
design was used? What mode of response was used: a personal interview,
a telephone interview, or a mail survey? Were interviewers trained? Were
survey questions field-tested? What other questions were asked? Were the
questions clear, accurate, unbiased, and valid? What was the response
rate? What was the margin of error? What was the sample size? What
frame was used?

7.16 (a) Virtually 0. (b) 0.1587. (c) 0.0139. (d) 50.195.

7.18 (a) Both means are equal to 6. This property is called unbiasedness.
(c) The distribution for has less variability. The larger sample size
has resulted in sample means being closer to 

7.20 (a) When because the mean is larger than the median, the
distribution of the sales price of new houses is skewed to the right, and so
is the sampling distribution of although it will be less skewed than the
population. (b) If you select samples of the shape of the
sampling distribution of the sample mean will be very close to a normal
distribution, with a mean of $274,300 and a standard deviation of $9,000.
(c) 0.9996. (d) 0.2796

7.22 (a)
(b) (c) To be able
to use the standardized normal distribution as an approximation for the
area under the curve, you must assume that the population is approximately
symmetrical. (d) .

7.24 (a) 0.40. (b) 0.0704.

7.26 (a)

(b) p = 0.60,sP = Ap11 - p2
n

= A0.611 - 0.62
100

= 0.04899.

P1p 7 0.552 = P1Z 7 0.982 = 1.0 - 0.8365 = 0.1635.

p = 0.501,sP = Ap11 - p2
n

= A0.50111 - 0.5012
100

= 0.05

3.152X = 3.10 + 1.0410.052 =P1Z 6 1.042 = 0.85;

P1Z 6 1.042 = 0.85; X = 3.10 + 1.0410.12 = 3.204.
P1X 7 32 = P1Z 7 -1.002 = 1.0 - 0.1587 = 0.8413.

n = 100,
X

n = 2,

m.
n = 3

4089 4189 4289 4389 4489 4589 4689 4789 4889 4989
3089 3189 3289 3389 3489 3589 3689 3789 3889 3989
2089 2189 2289 2389 2489 2589 2689 2789 2889 2989
1089 1189 1289 1389 1489 1589 1689 1789 1889 1989

189   289   389   489   589   689   789   889   989
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(c)

(d) Increasing the sample size by a factor of 4 decreases the standard
error by a factor of 2.

(a)
(b)
(c)

7.28 (a) 0.7889. (b) 0.6746. (c) 0.8857. (d) (a) 0.9458. (b) 0.9377.
(c) 0.9920.

7.30 (a) 0.8422 (b) The probability is 90% that the sample percentage
will be contained within 5.58% (0.3042 to 0.4158) symmetrically around
the population percentage. (c) The probability is 95% that the sample
percentage will be contained within 6.65% (0.2935 to 0.4265)
symmetrically around the population percentage.

7.32 (a) 0.0336. (b) 0.0000. (c) Increasing the sample size by a factor of 
5 decreases the standard error by a factor of The sampling distribution
of the proportion becomes more concentrated around the true proportion
of 0.59 and, hence, the probability in (b) becomes smaller than that in (a).

7.44 (a) 0.4999. (b) 0.00009. (c) 0. (d) 0. (e) 0.7518.

7.46 (a) 0.8944. (b) 4.617; 4.783. (c) 4.641.

7.48 (a) 0.0668. (b) 0.6912. (c) 0.9998.

CHAPTER 8
8.2

8.4 Yes, it is true because 5% of intervals will not include the population
mean.

8.6 (a) You would compute the mean first because you need the mean to
compute the standard deviation. If you had a sample, you would compute
the sample mean. If you had the population mean, you would compute 
the population standard deviation. (b) If you have a sample, you are
computing the sample standard deviation, not the population standard
deviation needed in Equation (8.1). If you have a population and have
computed the population mean and population standard deviation, you
don’t need a confidence interval estimate of the population mean because
you already know the mean.

8.8 Equation (8.1) assumes that you know the population standard
deviation. Because you are selecting a sample of 100 from the population,
you are computing a sample standard deviation, not the population
standard deviation.

8.10 (a)

(b) No, the manufacturer cannot support a claim that the bulbs have a
mean of 400 hours. Based on the data from the sample, a mean of 
400 hours would represent a distance of 4 standard deviations above the
sample mean of 350 hours. (c) No. Because is known and , from
the Central Limit Theorem, you know that the sampling distribution of 
is approximately normal. (d) The confidence interval is narrower, based on
a population standard deviation of 80 hours rather than the original standard

deviation of 100 hours. 

Based on the smaller standard deviation, a mean of 400 hours
would represent a distance of 5 standard deviations above the sample
mean of 350 hours. No, the manufacturer cannot support a claim that the
bulbs have a mean life of 400 hours.

m … 369.6.

330.4 …X ; Z # s1n
= 350 ; 1.96 # 80164

,

X
n = 64s

X ; Z # s1n
= 350 ; 1.96 # 100164

; 325.50 … m … 374.50.

114.68 … m … 135.32.

15.

P1p 7 0.552 = P1Z 7 2.402 = 1.0 - 0.9918 = 0.0082.
P1p 7 0.552 = P1Z 7 -2.042 = 1.0 - 0.0207 = 0.9793.
P1p 7 0.552 = P1Z 7 1.962 = 1.0 - 0.9750 = 0.0250.

P1p 7 0.552 = P1Z 7 1.202 = 1.0 - 0.8849 = 0.1151.

p = 0.49,sP = Ap11 - p2
n

= A0.4911 - 0.492
100

= 0.05

P1p 7 0.552 = P1Z 7 -1.0212 = 1.0 - 0.1539 = 0.8461. 8.12 (a) 2.2622. (b) 3.2498. (c) 2.0395. (d) 1.9977. (e) 1.7531.

8.14 The presence of the outlier
increases the sample mean and greatly inflates the sample standard
deviation.

8.16 (a) (b) The quality
improvement team can be 95% confident that the population mean
turnaround time is between 29.44 hours and 34.56 hours. (c) The project
was a success because the initial turnaround time of 68 hours does not fall
within the interval.

8.18 (a) (b) You can be 95% confident that the
population mean amount spent for lunch at a fast-food restaurant is
between $5.64 and $8.42.

8.20 (a) (b) You can be 95% confident that the
population mean miles per gallon of 2010 small SUVs is between 19.82
and 22.02. (c) Because the 95% confidence interval for population mean
miles per gallon of 2010 small SUVs overlaps with that for the population
mean miles per gallon of 2010 family sedans, you are unable to conclude
that the population mean miles per gallon of 2010 small SUVs is lower
than that of 2010 family sedans.

8.22 (a) (b) The number of days is approximately
normally distributed. (c) No, the outliers skew the data. (d) Because the
sample size is fairly large, at the use of the t distribution is
appropriate.

8.24 (a) (b) The population distribution needs to 
be normally distributed. (c) Both the normal probability plot and the
boxplot show that the distribution of the cost of dark chocolate bars is
right-skewed.

8.26

8.28 (a)

; (b) The manager in charge of

promotional programs concerning residential customers can infer that the
proportion of households that would purchase an additional telephone
line if it were made available at a substantially reduced installation cost is
somewhere between 0.22 and 0.32, with 99% confidence.

8.30 (a) (b) No, you cannot, because the interval
estimate includes 0.50 (50%). (c) Yes, you can,
because the interval is above 0.50 (50%). (d) The larger the sample size,
the narrower the confidence interval, holding everything else constant.

8.32 (a) (b) (c) Many more
people think that e-mail messages are easier to misinterpret.

8.34

8.36

8.38 (a) Use

(b) Use

8.40

8.42 (a) (b)

8.44 (a) (b) (c) (d) When there is more
variability in the population, a larger sample is needed to accurately
estimate the mean.

n = 554.n = 385.n = 246.

n = 97.n = 167.

n = 97.

n = 984.n =
Z2s2

e2
=

(1.96)2(400)2

252
= 983.41.

n = 246.n =
Z2s2

e2
=

(1.96)2(400)2

502
= 245.86.

n = 1,041.

n = 35.

0.5099 … p … 0.5498.0.784 … p … 0.816.

0.5062 … p … 0.5338.
0.4762 … p … 0.5638.

0.2189 … p … 0.3211.2.58A0.2710.732
500

p =
X

n
=

135
500

= 0.27, p ; ZAp11 - p2
n

= 0.27 ;

0.19 … p … 0.31.

$0.7367 … $1.1147.

n = 50,

31.12 … m … 54.96.

19.82 … m … 22.02.

5.64 … m … 8.42.

32 ; (2.0096)(9)>150; 29.44 … m … 34.56

-0.12 … m … 11.84, 2.00 … m … 6.00.
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8.46 (a) (b)
(c) (d) (a)

(b) (c)

8.48 (a) If you conducted a follow-up study to estimate the population
proportion of individuals who view oil companies favorably, you would
use in the sample size formula because it is based on past
information on the proportion. (b)

8.50

8.52 (a) 0.054. (b) 0.0586. (c) 0.066.

8.54

8.56

8.58 (a) 0.0542. (b) Because the upper bound is higher than the tolerable
exception rate of 0.04, the auditor should request a larger sample.

8.66 Based on the evidence gathered from the
sample of 34 stores, the 95% confidence interval for the mean per-store
count in all of the franchise’s stores is from 940.50 to 1,007.50. With a
95% level of confidence, the franchise can conclude that the mean per-
store count in all its stores is somewhere between 940.50 and 1,007.50,
which is larger than the original average of 900 mean per-store count
before the price reduction. Hence, reducing coffee prices is a good
strategy to increase the mean customer count.

8.68 (a) (b) (c)
(d) (e) If a single sample were to be selected for both purposes,
the larger of the two sample sizes should be used.

8.70 (a) (b) (c)
(d) (e) If a single sample were to be selected for both purposes,
the larger of the two sample sizes should be used.

8.72 (a) (b) (c)
(d) (e) If a single sample were to be selected for both purposes,
the larger of the two sample sizes should be used.

8.74 (a) (b) (c)
(d) (e) If a single sample were to be selected for both purposes,
the larger of the two sample sizes should be used.

8.76 (a) (b) Because the upper bound is higher than the
tolerable exception rate of 0.15, the auditor should request a larger
sample.

8.78 (a) (b) Population total

8.80 (a) (b) With 95% confidence, the population
mean width of troughs is somewhere between 8.41 and 8.43 inches. 
(c) The assumption is valid as the width of the troughs is approximately
normally distributed.

8.82 (a) (b) (c) The
amounts of granule loss for both brands are skewed to the right, but the
sample sizes are large enough. (d) Because the two confidence intervals
do not overlap, you can conclude that the mean granule loss of Boston
shingles is higher than that of Vermont shingles.

CHAPTER 9
9.2 Because reject

9.4 Reject if or if

9.6 p-value = 0.0456.

ZSTAT 7 2.58.ZSTAT 6 -2.58H0

H0.ZSTAT = +2.21 7 1.96,

0.1975 … m … 0.2385.0.2425 … m … 0.2856.

8.41 … m … 8.43.

… $450,950.79.$402,652.53 …n = 27.

p … 0.2013.

(n = 423)
n = 423.

n = 110.0.2027 … p … 0.3973.$36.66 … m … $40.42.

(n = 423)
n = 423.

n = 97.0.3037 … p … 0.4963.$25.80 … m … $31.24.

(n = 121)
n = 121.

n = 35.0.284 … p … 0.676.8.049 … m … 11.351.

(n = 784)
n = 784.

n = 25.0.530 … p … 0.820.14.085 … m … 16.515.

940.50 … m … 1007.50.

$5,443 … Total difference … $54,229.

$543,176.96 … Total … $1,025,224.04.

13,00021$261.402 ; 13,000211.83312 1138.80462110 A3,000 - 10

3,000 - 1
.

$10,721.53 … Total … $14,978.47.

n = 574.
p = 0.84

n = 626.n = 1,479.
n = 1,937.p = 0.07; 0.0542 … p … 0.0858.p … 0.2143.

p = 0.19; 0.1657 …p = 0.28; 0.2522 … p … 0.3078. 9.8

9.10 Defendant is guilty; Defendant is innocent. A Type I error
would be not convicting a guilty person. A Type II error would be
convicting an innocent person.

9.12 20 minutes is adequate travel time between
classes. 20 minutes is not adequate travel time
between classes.

9.14 (a) Because

reject (b) (c) (d) The
conclusions are the same.

9.16 (a) Because do not reject 
(b) (c) (d) The conclusions
are the same.

9.18

9.20

9.22 No, you should not use a t test because the original population is left-
skewed, and the sample size is not large enough for the t test to be valid.

9.24 (a) Because
and there is no

evidence that the population mean waiting time is different from
3.7 minutes. (b) Because the central limit theorem should ensure
that the sampling distribution of the mean is approximately normal. In
general, the t test is appropriate for this sample size except for the case
where the population is extremely skewed or bimodal.

9.26 (a) There is no evidence that
the population mean retail value of the greeting cards is different from
$2.50. (b) The probability of getting a 
statistic greater than or less than given that the null
hypothesis is true, is 0.2585.

9.28 (a) Because do not reject 
There is not enough evidence to conclude that the mean amount spent
for lunch at a fast food restaurant, is different from $6.50. (b) The p-value
is 0.4069. If the population mean is $6.50, the probability of observing
a sample of nine customers that will result in a sample mean farther
away from the hypothesized value than this sample is 0.4069. (c) The
distribution of the amount spent is normally distributed. (d) With a small
sample size, it is difficult to evaluate the assumption of normality.
However, the distribution may be symmetric because the mean and
the median are close in value.

9.30 (a) Because do not reject 
There is no evidence that the mean amount is different from 2 liters. 
(b) (d) Yes, the data appear to have met the normality
assumption. (e) The amount of fill is decreasing over time. Therefore, the
t test is invalid.

9.32 (a) Because reject There is
enough evidence to conclude that mean widths of the troughs is different
from 8.46 inches. (b) The population distribution is normal. (c) Although
the distribution of the widths is left-skewed, the large sample size means
that the validity of the t test is not seriously affected.

9.34 (a) Because do not reject 
There is no evidence that the mean amount is different from 5.5 grams.
(b) (c) The conclusions are the same.

9.36 p-value = 0.0228.

5.462 … m … 5.542.

H0.-2.68 6 tSTAT = 0.094 6 2.68,

H0.tSTAT = -5.9355 6 -2.0106,

p-value = 0.9095.

H0.-2.0096 6 tSTAT = 0.114 6 2.0096,

H0.-2.306 6 tSTAT = 0.8754 6 2.306,

-1.1364,+1.1364
tSTATp-value = 0.2585 7 0.05.

-1.9842 6 tSTAT = 1.1364 6 1.9842.

n = 64,

p-value = 0.1984 7 0.05,tSTAT = -1.30 6 1.9983
-1.9983 6tSTAT = (3.57 - 3.70)>0.8>164 = -1.30.

;2.1315.

tSTAT = 2.00.

0.9877 … m … 1.0023.p-value = 0.0771.
H0.-2.58 6 ZStat = -1.7678 6 2.58,

325.5 … m … 374.5.p-value = 0.0456.H0.

ZStat = -2.00 6 -1.96,ZStat =
350 - 375

100164

= -2.0.

H1: m Z 20 minutes.
H0: m = 20 minutes.

H1:H0:

p-value = 0.1676.
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9.38

9.40

9.42

9.44

9.46 (a) There is evidence that the population
mean waiting time is less than 36.5 hours. (b)
The probability of getting a statistic less than given that
the null hypothesis is true, is 0.0453. (c) The results are different because
in this problem you have conducted a one-tail test with the entire rejection
region in the lower tail.

9.48 (a) Because
reject reject

(b) The probability of getting a sample mean of 32 minutes or less if the
population mean is 68 minutes is 0.0000. 

9.50 (a) (b) A Type I error occurs when
you conclude that the mean number of customers increased above 900 when
in fact the mean number of customers is not greater than 900. A Type II error
occurs when you conclude that the mean number of customers is not greater
than 900 when in fact the mean number of customers has increased above
900. (c) Because or
reject There is enough evidence to conclude the population mean
number of customers is greater than 900. (d) The probability that the sample
mean is 900 customers or more when the null hypothesis is true is 0.0000.

9.52

9.54 Do not reject 

9.56 (a) Because
or reject There is evidence to show that more than
half the readers of online magazines have linked to an advertiser’s website.
(b) Because do
not reject There is insufficient evidence to show that more than half of
the readers of online magazines have linked to an advertiser’s website. (c) The
sample size had a major effect on being able to reject the null hypothesis.
(d)You would be very unlikely to reject the null hypothesis with a sample of 20.

9.58 Decision rule: If or
reject

Test statistic:

Because or reject
and conclude that there is evidence that the percentage of young job

seekers who prefer to look for a job in a place they want to reside is
different from 60%.

9.60 (a) No more than 8% of students at your school are
omnivores. More than 8% of students at your school are
omnivores. (b) Because

or reject
There is enough evidence to show that the percentage of omnivores at
your school is greater than 8%.

9.70 (a) Buying a site that is not profitable. (b) Not buying a profitable site.
(c) Type I. (d) If the executives adopt a less stringent rejection criterion by
buying sites for which the computer model predicts moderate or large
profit, the probability of committing a Type I error will increase. Many

H0.p-value = 0.0001316 6 0.05,ZSTAT = 3.6490 7 1.645
ZSTAT = 3.6490 7 1.645; p-value = 0.0001316.

H1: p 7 0.08.
H0: p … 0.08.

H0

p-value = 0.0012 6 0.05,ZSTAT = 3.2275 7 1.96

ZSTAT =
p - p

Ap(1 - p)

n

=
0.65 - 0.60

A0.611 - 0.62
1,000

= 3.2275

p =
650

1,000
= 0.65

H0.ZSTAT 6 -1.96,
ZSTAT 7 1.96H1: p = 0.6; H1: p Z 0.6.

H0.
ZSTAT = 1.20 6 1.645,ZSTAT = 1.20, p-value = 0.115.

H0.0.0000 6 0.05,
ZSTAT = 9.61 7 1.645ZSTAT = 9.61, p-value = 0.0000.

H0.

p = 0.22.

H0.
p-value = 0.0000 6 0.01,tSTAT = 4.4947 7 2.4448

H0: m … 900; H1: m 7 900.

H0.p-value = 0.0000 6 0.01,H0.-28.2843 6 -2.4049,
tSTAT =tSTAT = (32 - 68)>9>150 = -28.2843.

-1.7094,tSTAT

p-value = 0.0453 6 0.05.
tSTAT = -1.7094 6 -1.6604.

tSTAT = -2.5280.

tSTAT = 2.7638.

p-value = 0.9162.

p-value = 0.0838. more of the sites the computer model predicts that will generate moderate
profit may end up not being profitable at all. On the other hand, the less
stringent rejection criterion will lower the probability of committing a Type
II error because more potentially profitable sites will be purchased.

9.72 (a) Because reject (b)
(c) Because do not reject (d) Because

do not reject (e) Because
do not reject 

9.74 (a) Because do not reject 
(b) The data are from a population that is normally distributed. (d) With
the exception of one extreme value, the data are approximately normally
distributed. (e) There is insufficient evidence to state that the waiting time
is less than five minutes.

9.76 (a) Because do not reject 
(b) If the null hypothesis is true, the probability 
of obtaining a of or more extreme is 0.0748. (c) Because

reject (d) If the null
hypothesis is true, the probability of obtaining a of or more
extreme is 0.0021. (e) The data in the population are assumed to be
normally distributed. (f) Both boxplots suggest that the data are skewed
slightly to the right, more so for the Boston shingles. However, the very
large sample sizes mean that the results of the t test are relatively
insensitive to the departure from normality.

9.78 (a) reject (b) (c)
reject (d) (e) Because of the large sample

sizes, you do not need to be concerned with the normality assumption.

CHAPTER 10
10.2 (a) (b) (c) 2.5177. (d) Because

reject

10.4

10.6 Because or do
not reject . There is no evidence of a difference in the means of the two
populations.

10.8 (a) Because or
reject There is evidence that the mean amount of Goldfish crackers
eaten by children is higher for those who watched food ads than for those
who did not watch food ads. (b) (c) The results
cannot be compared because (a) is a one-tail test and (b) is a confidence
interval that is comparable only to the results of a two-tail test.

10.10 (a) where Populations:
Decision rule: If or

reject

Test statistic:

=
140.26 - 36.852 - 0

A140.8489a 1
100

+
1

72
b

= 1.859.

tSTAT =
1X1 - X22 - 1m1 - m22

AS 2
p a 1

n1
+

1
n2
b

=
1992113.3522 + 171219.4222

99 + 71
= 140.8489

S 2
p =

1n1 - 121S 2
12 + 1n2 - 121S 2

22
1n1 - 12 + 1n2 - 12

H0.tSTAT 7 1.974,
tSTAT 6 -1.974df = 170.H1: m1 Z m2.

1 = Males, 2 = Females.H0: m1 = m2,

5.79 … m1 - m2 … 11.81.

H0.
p-value = 0.0000 6 0.05,tSTAT = 5.7883 7 1.6581

H0

p-value = 0.0158 7 0.01,tSTAT = 2.6762 6 2.9979

3.73 … m1 - m2 … 12.27.

H0.3.8959 7 2.5177,
tSTAT =df = 21.t = 3.8959.

p-value = 0.0000.H0.-27.19,
tSTAT =p-value = 0.0000.H0.tSTAT = -21.61,

-3.10tSTAT

p-value = 0.0021.H0.tSTAT = -3.10 6 -1.6973,
-1.47tSTAT

p-value = 0.0748.
H0.tSTAT = -1.47 7 -1.6896,

H0.tSTAT = -1.69 7 -1.7613,

H0.ZSTAT = -1.61 7 -1.645,
H0.-2.0010 6 tSTAT = 0.75 6 2.0010,

H0.ZSTAT = -0.32 7 -1.645,
p-value = 0.0019.H0.tSTAT = 3.248 7 2.0010,
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Decision: Because do not reject 
There is not enough evidence to conclude that the mean computer anxiety
experienced by males and females is different. (b)
(c) In order to use the pooled-variance t test, you need to assume that the
populations are normally distributed with equal variances.

10.12 (a) Because reject (b)
(c) The original populations of waiting times are approximately

normally distributed. (d)

10.14 (a) Because reject There is evidence of
a difference in the mean surface hardness between untreated and treated
steel plates. (b) The probability that two samples have
a mean difference of 9.3634 or more is 0.0002 if there is no difference
in the mean surface hardness between untreated and treated steel plates.
(c) You need to assume that the population distribution of hardness
of both untreated and treated steel plates is normally distributed.
(d)

10.16 (a) Because or
reject There is evidence of a difference in the mean

number of calls for cell phone users under age 12 and cell phone users
who are between 13 and 17 years of age. (b) You must assume that each of
the two independent populations is normally distributed.

10.18

10.20 (a) Because
or reject There is

enough evidence of a difference in the mean summated ratings between
the two brands. (b) You must assume that the distribution of the differences
between the two ratings is approximately normal. (c)
The probability of obtaining a mean difference in ratings that results in a
test statistic that deviates from 0 by 3.2772 or more in either direction is
0.0112 if there is no difference in the mean summated ratings between the
two brands. (d) You are 95% confident that
the mean difference in summated ratings between brand A and brand B is
somewhere between and

10.22 (a) Because or
do not reject There is not enough evidence to

conclude that there is a difference between the mean prices between
Costco and store brands. (b) You must assume that the distribution of the
differences between the prices is approximately normal. (c)

You are 95% confident that the mean difference between the
prices is between -$1.612 and $1.66. (d) The results in (a) and (c) are the
same. The hypothesized value of 0 for the difference in the price of
shopping items between Costco and store brands is within the 95%
confidence interval.

10.24 (a) Because do not reject There is not
enough evidence to conclude that the mean bone marrow microvessel
density is higher before the stem cell transplant than after the stem cell
transplant. (b) The probability that the t statistic for the
mean difference in microvessel density is 1.8425 or more is 5.75% if the
mean density is not higher before the stem cell transplant than after the
stem cell transplant. (c) You are 95% confident
that the mean difference in bone marrow microvessel density before and
after the stem cell transplant is somewhere between and 200.55.

10.26 (a) Because reject There is
evidence that the mean strength is lower at two days than at seven days.
(b) The population of differences in strength is approximately normally
distributed. (c)

10.28 (a) Because do not reject 
(b) -0.273 … p1 - p2 … 0.173.

H0.-2.58 … ZSTAT = -0.58 … 2.58,

p = 0.000.

H0.tSTAT = -9.3721 6 -2.4258,

-28.26

-28.26 … mD … 200.55.

p-value = 0.0575.

H0.tSTAT = 1.8425 6 1.943,

mD … $1.66.
-$1.612 …

H0.0.9743 7 0.05,
p-value =-2.2622 6 tSTAT = 0.0332 6 2.2622

-0.4610.-2.6501

-2.6501 … mD … -0.4610.

p-value = 0.0112.

H0.p-value = 0.0112 6 0.05,-3.2772 6 -2.306
tSTAT =tSTAT = (-1.5566)>(1.424)>19 = -3.2772.

df = 19.

H0.0.0000 6 0.05,
p-value =tSTAT = -7.8124 6 -1.9845

4.7447 … m1 - m2 … 13.9821.

p-value = 0.0002.

H0.tSTAT = 4.10 7 2.024,

-4.2292 … m1 - m2 … -1.4268.
0.0003.

p-value =H0.tSTAT = -4.1343 6 -2.0484,

p-value = 0.0648.

H0.-1.974 6 tSTAT = 1.859 6 1.974, 10.30 (a) Populations:
(b) Because or
reject There is sufficient evidence to conclude that the population
proportion of large online retailers who require three or more clicks to be
removed from an e-mail list is greater in 2009 than in 2008. (c) Yes, the
result in (b) makes it appropriate to claim that the population proportion
of large online retailers who require three or more clicks to be removed
from an e-mail list is greater in 2009 than in 2008.

10.32 (a) Decision rule: If 
reject

Test statistic: 

reject There is evidence of a difference in
the proportion who believe that e-mail messages should be answered
quickly between the two age groups. (b) The
probability of obtaining a difference in proportions that gives rise to a test
statistic below or above is 0.0000 if there is no
difference in the proportion of people in the two age groups who believe
that e-mail messages should be answered quickly.

10.34 (a) Because reject There is evidence
of a difference in the proportion of adults and users ages 12–17 who
oppose ads. (b) The probability of obtaining a
difference in proportions that is 0.16 or more in either direction is 0.0000
if there is no difference between the proportion of adults and users ages
12–17 who oppose ads.

10.36 (a) 2.20. (b) 2.57. (c) 3.50.

10.38 (a) Population B: (b) 1.5625.

10.40

10.42 Because do not reject 

10.44 (a) Because do not reject (b) Because
do not reject 

10.46 (a)

Decision rule: If reject

Test statistic: 

Decision: Because reject There is evidence
to conclude that the two population variances are different. (b)

(c) The test assumes that each of the two populations is normally
distributed. (d) Based on (a) and (b), a separate-variance t test should be used.

10.48 (a) Because or
reject There is evidence of a difference in the variability of the battery
life between the two types of digital cameras. (b) The
probability of obtaining a sample that yields a test statistic more extreme
than 5.1802 is 0.0002 if there is no difference in the two population variances.
(c) The test assumes that the two populations are both normally distributed.
(d) Based on (a) and (b), a separate-variance t test should be used.

10.50 Because or
reject There is evidence of a difference in the variance of the yield at
the two time periods.

10.58 (a) $0.59 coffee: (or
), so reject There is evidence that reducing the price toH0.0.0069 6 0.05

p-value =tSTAT = 2.8167 7 1.7613

H0.
p-value = 0.0156 6 0.05,FSTAT = 2.7684 7 2.2693,

p-value = 0.0002.
H0.

p-value = 0.0002 6 0.05,FSTAT = 5.1802 7 2.34

0.0022.
p-value =

H0.FSTAT = 2.008 7 1.556,

FSTAT =
S 2

1

S 2
2

=
(13.35)2

(9.42)2
= 2.008.

H0.FSTAT 7 1.556,

H0: s
2
1 = s2

2. H1: s
2
1 Z s2

2.

H0.FSTAT = 1.2995 6 2.62,
H0.FSTAT = 1.2995 6 3.18,

H0.FSTAT = 1.2109 6 2.27,

dfnumerator = 24, dfdenominator = 24.

S2 = 25.

p-value = 0.0000.

H0.ZSTAT = 7.2742 7 1.96,

+7.8837-7.8837

p-value = 0.0000.

H0.ZSTAT = 7.8837 7 2.58,

ZSTAT =
1p1 - p22 - 1p2 - p22

Ap11 - p2a 1
n1

+
1
n2
b

=
10.707 - 0.5362 - 0

A0.621511 - 0.62152a 1

1,000
+

1

1,000
b

.

p =
X1 + X2

n1 + n2
=

707 + 536
1,000 + 1,000

= 0.6215

H0.
ƒZSTAT ƒ 7 2.58,H0: p1 = p2. H1: p1 Z p2.

H0.
p-value = 0.0000 6 0.05,ZSTAT = 5.3768 7 1.6449

1 = 2009, 2 = 2008.H0: p1 … p2. H1: p1 7 p2.
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$0.59 has increased mean daily customer count. $0.79 coffee:
(or ), so reject 

There is evidence that reducing the price to $0.79 has increased mean daily
customer count. (b) Because or

do not reject There is not enough evidence of a
difference in the variance of the daily customer count for $0.59 and $0.79
coffee. Because or

do not reject There is insufficient evidence of a
difference in the mean daily customer count for $0.59 and $0.79 coffee.
(c) Since both $0.59 and $0.79 coffee increased daily customer count, you
should recommend that the price of coffee should be reduced. However, since
there is no significant difference in the mean daily customer count between
the two prices, you should price the coffee at $0.79 per 12-ounce cup.

10.60 (a) Because or
do not reject There is not enough evidence of a difference in

the variance of the salary of Black Belts and Green Belts. (b) The
pooled-variance t test. (c) Because or

reject There is evidence of a difference in the mean
salary of Black Belts and Green Belts.

10.62 (a) Because reject There is
enough evidence to conclude that there is a difference between the
variances in age of students at the Western school and at the Eastern
school. (b) Because there is a difference between the variances in the age
of students at the Western school and at the Eastern school, schools
should take that into account when designing their curriculum to
accommodate the larger variance in age of students in the state university
in the Western United States. (c) It is more appropriate to use a separate-
variance t test. (d) Because do not reject 

There is not enough evidence to conclude that there is a difference
between the variances in years of spreadsheet usage of students at the
Western school and at the Eastern school. (e) Using the pooled-variance t
test, because reject There is enough
evidence of a difference in the mean years of spreadsheet usage of students
at the Western school and at the Eastern school.

10.64 (a) Because reject There is enough
evidence to conclude that the introductory computer students required
more than a mean of 10 minutes to write and run a program in Visual
Basic. (b) Because do not reject There is
not enough evidence to conclude that the introductory computer students
required more than a mean of 10 minutes to write and run a program
in Visual Basic. (c) Although the mean time necessary to complete the
assignment increased from 12 to 16 minutes as a result of the increase
in one data value, the standard deviation went from 1.8 to 13.2, which
reduced the value of t statistic. (d) Because do
not reject There is not enough evidence to conclude that the population
variances are different for the Introduction to Computers students and
computer majors. Hence, the pooled-variance t test is a valid test to
determine whether computer majors can write a Visual Basic program in
less time than introductory students, assuming that the distributions of the
time needed to write a Visual Basic program for both the Introduction to
Computers students and the computer majors are approximately normally
distributed. Because reject There is enough
evidence that the mean time is higher for Introduction to Computers
students than for computer majors. (e) If the true
population mean amount of time needed for Introduction to Computer
students to write a Visual Basic program is no more than 10 minutes, the
probability of observing a sample mean greater than the 12 minutes in the
current sample is 0.0362%. Hence, at a 5% level of significance, you can
conclude that the population mean amount of time needed for Introduction
to Computer students to write a Visual Basic program is more than 10
minutes. As illustrated in part (d), in which there is not enough evidence to
conclude that the population variances are different for the Introduction to

p-value = 0.000362.

H0.tSTAT = 4.0666 7 1.7341,

H0.
FSTAT = 1.2308 6 3.8549,

H0.tSTAT = 1.3636 6 1.8595,

H0.tSTAT = 3.3282 7 1.8595,

H0.tSTAT = -4.6650 6 -2.5978,

H0.
FSTAT = 1.3061 6 1.6275,

H0.FSTAT = 22.7067 7 Fa = 1.6275,

H0.0.0000 6 0.05,
p-value =tSTAT = 5.7032 7 1.96

H0.0.05,
p-value = 0.3236 7FSTAT = 1.3349 6 1.7787,

H0.0.4500 7 0.05,
p-value =-2.0484 6 tSTAT = 0.7661 6 2.0484

H0.0.5906 7 0.05,
p-value =FSTAT = 1.3407 6 2.9786,

H0.p-value = 0.0277 6 0.05tSTAT = 2.0894 7 1.7613
Computers students and computer majors, the pooled-variance t test
performed is a valid test to determine whether computer majors can write
a Visual Basic program in less time than introductory students, assuming
that the distribution of the time needed to write a Visual Basic program for
both the Introduction to Computers students and the computer majors are
approximately normally distributed.

10.66 From the boxplot and the summary statistics, both distributions are
approximately normally distributed. There is
insufficient evidence to conclude that the two population variances are
significantly different at the 5% level of significance.

At the 5% level of significance, there is sufficient evidence to
reject the null hypothesis of no difference in the mean life of the bulbs
between the two manufacturers. You can conclude that there is a significant
difference in the mean life of the bulbs between the two manufacturers.

10.68 Playing a game on a video game system: Because
and reject There is evidence that

there is a difference between boys and girls in the proportion who played
a game on a video game system. Reading a book for fun: Because

and reject
There is evidence that there is a difference between boys and girls in the
proportion who have read a book for fun. Gave product advice to parents:
Because and
do not reject There is insufficient evidence that there is a difference
between boys and girls in the proportion who gave product advice to
parents. Shopped at a mall: Because and

reject There is evidence that there is a
difference between boys and girls in the proportion who shopped at a mall.

10.70 The normal probability plots suggest that the two populations are
not normally distributed. An F test is inappropriate for testing the
difference in two variances. The sample variances for Boston and
Vermont shingles are 0.0203 and 0.015, respectively. Because

or reject
There is sufficient evidence to conclude that there is a difference in the
mean granule loss of Boston and Vermont shingles.

CHAPTER 11
11.2 (a) (b) (c) (d)

11.4 (a) 2. (b) 18. (c) 20.

11.6 (a) Reject if otherwise, do not reject 
(b) Because reject (c) The table does not have
28 degrees of freedom in the denominator, so use the next larger critical
value, (d) Critical

11.8 (a) and

Because the p-value is approximately 0 and 
reject There is sufficient evidence of a difference in the mean strength
of the four brands of trash bags. 

(b)

= 4.446.

Critical range = QaAMSW

2
a 1

nj
+

1
nj¿
b = 3.79A13.7639

2
a 1

10
+

1
10
b

H0.
FSTAT = 48.1084 7 2.8663,

F0.05,3,36 = 2.8663.

FSTAT =
MSA

MSW
=

662.1583
13.76389

= 48.1084.

MSW =
SSW

n - c
=

495.5
36

= 13.76389.

MSA =
SSA

c - 1
=

1,986.475

3
= 662.1583.

H1: At least one mean is different.H0: mA = mB = mC = mD

range = 6.166.Qa = 3.90.

H0.FSTAT = 4 7 2.95,
H0.FSTAT 7 2.95;H0

FSTAT = 3.MSW = 5.MSA = 15.SSW = 150.

H0.p-value = 0.0028 6 a = 0.05,tSTAT = 3.015 7 1.967

H0.p-value = 0.0000 6 0.05,
ZSTAT = -6.7026 6 -1.96

H0.
p-value = 0.4576 7 0.05,-1.96 6 ZSTAT = 0.7427 6 1.96

H0.p-value = 0.0357 6 0.05,ZSTAT = -2.1005 6 -1.96

H0.p-value = 0.0000 6 0.05,1.96
ZSTAT = 15.74 7

-1.99.
tSTAT = -5.084 6

FSTAT = 1.056 6 1.89.



Self-Test Solutions and Answers to Selected Even-Numbered Problems 835

From the Tukey-Kramer procedure, there is a difference in mean strength
between Kroger and Tuffstuff, Glad and Tuffstuff, and Hefty and Tuffstuff.
(c) ANOVA output for Levene’s test for homogeneity of variance:

Because and do not
reject There is insufficient evidence to conclude that the variances in
strength among the four brands of trash bags are different. (d) From the
results in (a) and (b), Tuffstuff has the lowest mean strength and should be
avoided.

11.10 (a) Because reject (b)
Advertisements A and B are different from Advertisements C and D.

Advertisement E is only different from Advertisement D. (c) Because
do not reject There is no evidence of a

significant difference in the variation in the ratings among the five
advertisements. (d) The advertisements underselling the pen’s
characteristics had the highest mean ratings, and the advertisements
overselling the pen’s characteristics had the lowest mean ratings. Therefore,
use an advertisement that undersells the pen’s characteristics and avoid
advertisements that oversell the pen’s characteristics.

11.12 (a) Because the p-value for this test, 0.922, is greater than the level
of significance, (or the computed F test statistic, 0.0817, is less
than the critical value ), you cannot reject the null hypothesis.
You conclude that there is insufficient evidence of a difference in the
mean yield between the three methods used in the cleansing step.
(b) Because there is no evidence of a difference between the methods,
you should not develop any multiple comparisons. (c) Because the p-value
for this test, 0.8429, is greater than the level of significance,
(or the computed F test statistic, 0.1728, is less than the critical value,

), you cannot reject the null hypothesis. You conclude that
there is insufficient evidence of a difference in the variation in the yield
between the three methods used in the cleansing step. (d) Because there
is no evidence of a difference in the variation between the methods, the
validity of the conclusion reached in (a) is not affected.

11.14 (a) Because reject
(b) (using 30 degrees of freedom). Designs 3 and 4
are different from Designs 1 and 2. Designs 1 and 2 are different from
each other. (c) The assumptions are that the samples are randomly and
independently selected (or randomly assigned), the original populations
of distances are approximately normally distributed, and the variances are
equal. (d) Because do not reject There is 
no evidence of a significant difference in the variation in the distance
among the four designs. (e) The manager should choose Design 3 or 4.

11.16 (a) (b)
(c) (d)

11.18 (a) (b)
(c)

11.20 (a) (b) (c)
(d) Because do not reject There is insufficient
evidence of a treatment effect. Because do not reject

There is insufficient evidence of a block effect.

11.22 (a) Because reject (b) Because
reject H0.FSTAT = 5 7 2.49,

H0.FSTAT = 5.185 7 3.07,

H0.
FSTAT = 4 6 4.82,

H0.FSTAT = 6 6 6.9266,
SST = 144.SSBL = 72.MSE = 3, SSE = 36.

Critical range = 2.786.
Q = 4.17.df numerator = 5, df denominator = 24.

FSTAT = 4.FSTAT = 4.8.
MSA = 15, MSBL = 12.5, MSE = 3.125.SSE = 75.

H0.FSTAT = 2.093 6 2.92,

Critical range = 5.27
H0.FSTAT = 53.03 7 2.92,

F = 3.6823

a = 0.05

F = 3.6823
a = 0.05

H0.FSTAT = 1.927 6 2.76,

4.67.
Critical range =H0.FSTAT = 12.56 7 2.76,

H0.
FSTAT = 1.458 6 2.866,p-value = 0.2423 7 0.05

F0.05,3,36 = 2.8663.

FSTAT =
MSA

MSW
=

8.025
5.5056

= 1.4576.

MSW =
SSW

n - c
=

198.2
36

= 5.5056.

MSA =
SSA

c - 1
=

24.075
3

= 8.025.

11.24 (a) where 1 = Verizon, 2 = AT&T,
3 = T-Mobile, 4 = Sprint Not all .j are equal where
Excel output:

j = 1, 2, 3, 4mH1:
H0: m.1 = m.2 = m.3 = m.4

ANOVA
Source of
Variation SS df MS F P-value F crit

Rows 109.6579 18 6.0921 1.2356 0.2679 1.79823
Columns 1,431.2630 3 477.0877 96.7662 1.04E-21 2.7758
Error 266.2368 54 4.93031
Total 1807.158 75

Since the p-value is virtually , reject
There is evidence of a difference in the mean cell rating for the four cell
phone services.
(b)

H0.0 6 0.05FSTAT = 96.7662.

Tukey Multiple Comparisons

Sample Sample Absolute Std. Error Critical

Group Mean Size Comparison Difference of Difference Range Results

Verizon-1 78.3158 19 Group 1 to
Group 2

7.5263 0.5094 1.9052 Means are
different

AT&T - 2 70.7895 19 Group 1 to
Group 3

5.26316 0.509 1.9052 Means are
different

T-Mobile - 3 73.0526 19 Group 1 to
Group 4

12.052 0.509 1.9052 Means are
different

Sprint - 4 66.2631 19 Group 2 to
Group 3

2.2632 0.50940 1.9052 Means are
different

Group 2 to
Group 4

4.5263 0.5094 1.9052 Means are
different

Other Data Group 3 to
Group 4

6.7895 0.5094 1.9052 Means are
different

The mean cell rating for the four cell phone services are significantly
different from each other with Verizon highest followed by T-Mobile, AT&T,
and then Sprint.

11.26 (a) Since the p-value is virtually reject
There is evidence of a difference between the mean price of an

impulsive shopper, a savvy shopper, if you shop at a warehouse club such
as Costco, or if you purchase store-brands. (b) The assumptions needed are:
(i) Samples are randomly and independently drawn, (ii) populations are
normally distributed, (iii) populations have equal variances, and 
(iv) no interaction effect between treatments and blocks. (c) Critical

The absolute differences are group 1 to group
group 1 to group group 1 to group

group 2 to group group 2 to group group 3 to
group The mean of impulsive shoppers differs from the other
three while being a savvy shopper, shopping at Costco or purchasing at
store-brands do not differ from each other at 5% level of significance.
(d) and Reject There is
evidence of a significant block effect in this experiment. The blocking has
been advantageous in reducing the experimental error.

11.28 (a) Because reject There is enough
evidence to conclude that there is a difference in the mean compressive
strength after 2, 7, and 28 days. (b) At the
0.05 level of significance, all of the comparisons are significant.
(c) (e) The compressive strength of the concrete increases
over the three time periods.

RE = 2.558.

Critical range = 0.1651.

H0.FSTAT = 268.26 7 3.114,

H0.p-value = 0.0000 6 0.05,FSTAT = 23.8081

4 = 0.024.
4 = 1.33,3 = 1.306,

4 = 7.622,3 = 7.598,2 = 6.292,
range = 3.2674

H0.
0 6 0.05,FSTAT = 18.2879.

Level of significance 0.05
Numerator d.f. 4
Denominator d.f. 54
MSW 4.930
Q Statistic 3.74
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11.30 (a) 40. (b) 60 and 55. (c) 10. (d) 10.

11.32 (a) Because reject (b) Because
reject (c) Because

do not reject

11.34 SSE 150,
For For

For

11.36 (a) Because do not reject (b) Because
reject (c) Because do

not reject (e) Developer strength has a significant effect on density,
but development time does not.

11.38 (a) There is no interaction between brand and water tempe-
rature. There is an interaction between brand and water temperature. 

Because or the p-value =

reject There is evidence of interaction between
brand of pain reliever and temperature of the water. (b) Because there is
an interaction between brand and the temperature of the water, it is
inappropriate to analyze the main effect due to brand. (c) Because there is
an interaction between brand and the temperature of the water, it is
inappropriate to analyze the main effect due to water temperature. (e) The
difference in the mean time a tablet took to dissolve in cold and hot water
depends on the brand, with Alka-Seltzer having the largest difference and
Equate with the smallest difference.

11.40 (a) do not reject 
There is not enough evidence to conclude that there is an interaction
between the brake discs and the gauges. (b) p-value is
virtually reject There is sufficient evidence to conclude
that there is an effect due to brake discs. (c)

do not reject There is inadequate evidence to
conclude that there is an effect due to the gauges. (d) From the plot, there
is no obvious interaction between brake discs and gauges. (e) There is no
obvious difference in mean temperature across the gauges. It appears that
Part 1 has the lowest, Part 3 the second lowest, and Part 2 has the highest
average temperature.

11.52 (a) Because do not reject (b) Because
do not reject (c) Because

reject (e) Critical Washing cycles for 22 and
24 minutes are not different with respect to dirt removal, but they are both
different from 18- and 20-minute cycles. (f) 22 minutes. (24 minutes was
not different, but 22 does just as well and would use less energy.) (g) The
results are the same.

11.54 (a) Because do not reject (b) Because
reject (c) Critical Breaking

strength is significantly different between 30 and 50 psi.

11.56 (a) Because do not reject (b) Because
reject (c) Because

reject (e) Critical Mean breaking strength under 30 psi
is significantly different from 40 psi and 50 psi. (f) The mean breaking
strength is highest under 30 psi. (g) The two-factor experiment gave a
more complete set of results than the one-factor experiment. Not only was
the side-to-side aspect factor significant, the application of the Tukey
procedure on the air-jet pressure factor determined that breaking strength
scores are highest under 30 psi.

11.58 (a) Because do not reject There is
insufficient evidence to conclude that there is any interaction between type
of breakfast and desired time. (b) Because
reject There is sufficient evidence to conclude that there is an effect
that is due to type of breakfast. (c) Because FSTAT = 12.4441 7 4.1132,

H0.
FSTAT = 30.4434 7 4.1132,

H0.FSTAT = 0.1899 6 4.1132,

range = 1.30.H0.
FSTAT = 5.67 7 3.89,H0.FSTAT = 4.87 7 4.75,

H0.FSTAT = 1.97 6 3.89,

range = 1.489.H0.FSTAT = 4.09 7 3.68,
H0.FSTAT = 0.075 6 3.68,

range = 0.0189.H0.3.24,
FSTAT = 52.07 7H0.FSTAT = 0.79 6 3.24,

H0.FSTAT = 1.485 6 2.54,

H0.0.7031 7 0.05,
FSTAT = 0.1465, p-value =

H0.0 6 0.05,
FSTAT = 7.7701,

H0.FSTAT = 0.1523, p-value = 0.9614 7 0.05,

H0.0.0000214 6 0.05,

FSTAT =
253.1552
12.2199

= 20.7167 7 3.555

H1:
H0:

H0.
FSTAT = 0.70 6 4.75,H0.FSTAT = 23.58 7 4.75,

H0.FSTAT = 1.37 6 4.75,

AB: FSTAT = 2.
B: FSTAT = 11A: FSTAT = 16.SST = 610, MSB = 55, MSE = 5.

=dfB = 4, df TOTAL = 44, SSA = 160, SSAB = 80,

H0.
F = 2.73,FSTAT = 1.00 6H0.FSTAT = 5.50 7 3.35,

H0.FSTAT = 6.00 7 3.35,

reject There is sufficient evidence to conclude that there is an effect
that is due to desired time. (e) At the 5% level of significance, both the type
of breakfast ordered and the desired time have an effect on delivery time
difference. There is no interaction between the type of breakfast ordered
and the desired time.

11.60 Population large-cap blend, 2 = small-cap blend,
3 = mid-cap blend, 4 = Large-cap blend, 5 = diversified emerging markets;
Three-year return: Levene test: Since the 

do not reject There is insufficient evidence to show a
difference in the variance of return among the 5 different types of mutual
funds at a 5% level of significance. Since the p-value is
virtually zero, reject There is sufficient evidence to show a difference
in the mean three-year returns among the five different types of mutual
funds at a 5% level of significance. Critical range = 2.83. Groups 3 and 4.
(Mid-cap blend and large-cap blend) are lower than diversified emerging
markets. All other comparisons are not significant. Five-year return:
Levene test: Since the do not
reject There is insufficient evidence to show a difference in the
variance of return among the 5 different types of mutual funds at a 5%
level of significance. Since the p-value is virtually zero,
reject There is sufficient evidence to show a difference in the mean
five-year returns among the five different types of mutual funds at a 5%
level of significance. Critical At the 5% level of
significance, there is sufficient evidence that the mean five-year returns
of the diversified emerging market funds is significantly higher than the
others. Also, the mean five-year returns of the large-cap blend funds are
significantly lower than that of the foreign large-cap funds. Ten-year
return: Levene test: Since the 
do not reject There is insufficient evidence to show a difference in the
variance of return among the five different types of mutual funds at a 5%
level of significance. Since the p-value is virtually
zero, reject There is sufficient evidence to show a difference in the
mean 10-year returns among the five different types of mutual funds at a
5% level of significance. Critical At the 5% level of
significance, there is sufficient evidence that the mean 10-year returns of
the diversified emerging market funds is significantly higher than the
others. Expense ratio: Levene test: Since the

do not reject There is insufficient evidence to show a difference
in the variance in expense ratios among the 5 different types of mutual funds
at a 5% level of significance. Since the

reject There is sufficient evidence to show a difference
in the mean among the five different types of mutual funds at a 5% level
of significance. Critical At the 5% level of significance,
there is sufficient evidence that the mean expense ratio of the
diversified emerging market funds is signif icantly higher than the
foreign large-cap funds.

11.62 (a) Since the p-value is virtually reject
There is evidence of a difference in the mean rating scores among the

wines. (b) The assumptions needed are: (i) samples are randomly and
independently drawn, (ii) populations are normally distributed, (iii) popula-
tions have equal variances and (iv) no interaction effect between
treatments and blocks. (c) Critical The mean ratings 
of the eight different type of wines in ascending order are California
Beaujolais (red) $10.50, French burgundy (red) $10.69, California white
$13.59, French white $10.59, Italian red $8.50, French white $9.75,
French burgundy (red) $11.75, and Italian white $8.50. At the 5% level
of significance, the mean rating of French burgundy (red) $11.75 is
significantly higher than French white $10.59 and the other types that
have lower mean rating, and the mean rating of Italian white $8.50 is also
significantly higher than French white $10.59 and the other types that
have lower mean rating. There is no significant differences in mean rating

range = 3.5593.

H0.
0 6 0.05,FSTAT = 7.6863.

range = 0.479.

H0.0.0064 6 0.05,
p-value =FSTAT = 4.1069.

H0.0.05,
p-value = 0.6716 7FSTAT = 0.59.

range = 3.3372.

H0.
FSTAT = 11.9951.

H0.
p-value = 0.5407 7 0.05,FSTAT = 0.7854.

range = 2.3171.

H0.
FSTAT = 62.4531

H0.
p-value = 0.4349 7 0.05,FSTAT = 0.9671.

H0.
FSTAT = 14.3127.

H0.0.7971 7 0.05,
p-value =FSTAT = 0.4148.

1 = foreign

H0.
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among the other pairs. (d) Based upon the results in (c), none of the
country of origin, the type of wine, or the price has had an effect on the
ratings. (e)

CHAPTER 12
12.2 (a) For and (b) For and

(c) For and

12.4 (a) All (b) Because reject

12.6 (a) Because reject There is enough
evidence to conclude that there is a significant difference between the
proportion of retail websites that require three or more clicks to be
removed from an email list in 2009 as compared to 2008. (b) p-value

The probability of obtaining a test statistic of 28.9102 or larger
when the null hypothesis is true is 0.0000. (c) You should not compare the
results in (a) to those of Problem 10.30 (b) because that was a one-tail
test.

12.8 (a) Because

reject There is evidence
of a difference in the proportion who believe that e-mail messages should
be answered quickly between the two age groups. (b) p-value
The probability of obtaining a difference in proportions that gives rise to a
test statistic greater than 62.152 is 0.0000 if there is no difference in the
proportion of people in the two age groups who believe that e-mail messages
should be answered quickly. (c) The results of (a) and (b) are exactly the
same as those of Problem 10.32. The in (a) and the Z in Problem 10.32
(a) satisfy the relationship that and the
p-value in (b) is exactly the same as the p-value computed in Problem 10.32 (b).

12.10 (a) Since reject There is evidence
that there is a significant difference between the proportion of adults and
users ages 12–17 who oppose ads on websites. (b) p-value The
probability of obtaining a test statistic of 52.9144 or larger when the null
hypothesis is true is 0.0000.

12.12 (a) The expected frequencies for the first row are 20, 30, and 40.
The expected frequencies for the second row are 30, 45, and 60. 
(b) Because reject

12.14 (a) Because the calculated test statistic
reject and conclude that there is a difference in the proportion who
oppose ads on websites between the age groups. (b) The p-value is
virtually 0. The probability of a test statistic greater than 48.6268 or more
is approximately 0 if there is no difference between the age groups in the
proportion who oppose ads on websites. (c) The 18–24 and 25–34 age
groups are each different from the 50–64 and 65–89 age groups. The
35–49 age groups is different from the 65–89 group.

12.16 (a) At least one proportion differs.H0: p1 = p2 = p3. H1:

H0

x2
STAT = 48.6268 7 9.4877,

H0.x2
STAT = 12.5 7 5.991,

0.0000.

H0.x2
STAT = 52.9144 7 3.841,

x2 = 62.152 = Z2 = (7.8837)2,
x2

= 0.0000.

H0.(293 - 378.522>378.5 = 62.152 7 6.635,

1707 - 621.522>621.5 +621.5+ 1464 - 378.522>378.5 +1536 - 621.522>
x2

STAT =H0:p1 = p2. H1:p1 Z p2.

0.0000.
=

H0.x2
STAT = 28.9102 7 3.841,

H0.x2
STAT = 4.00 7 3.841,fe = 25.

a = 0.01, xa
2 = 6.635.df = 1a = 0.025, x2 = 5.024.
df = 1a = 0.05, xa

2 = 3.841.df = 1

RE = 1.555.

Decision: Because reject There is a
significant difference in the age groups with respect to major grocery
shopping day. (b) p-value The probability that the test statistic
is greater than or equal to 16.526 is 0.0003, if the null hypothesis is true.

(c)

= 0.0003.

H0.x2
STAT = 16.526 7 5.9915,

f0 fe ( f0 - fe) ( f0 - fe )2>fe

48 42.667 5.333 0.667
152 157.333 -5.333 0.181

56 42.667 13.333 4.166
144 157.333 -13.333 1.130

24 42.667 -18.667 8.167
176 157.333 18.667 2.215

16.526

Decision rule: If reject

Test statistic: x2
STAT = a

all cells

(f0 - fe)

fe
= 16.526.

H0.x2
STAT 7 5.9915,df = (c - 1) = (3 - 1) = 2.

Pairwise Comparisons Critical Range ƒpj - pj¿ ƒ

1 to 2 0.1073 0.04
2 to 3 0.0959 0.16*
1 to 3 0.0929 0.12*

There is a significant difference between the 35–54 and over-54 groups
and between the under-35 and over-54 groups. (d) The stores can use this
information to target their marketing to the specific groups of shoppers
on Saturday and the days other than Saturday.

12.18 (a) Because reject There is evidence
of a difference in the percentage who often listen to rock music among
the age groups. (b) (c) The 16–29 group is different
from the 50–64 age group.

12.20

12.22 reject and conclude that there is
evidence of a relationship between the type of dessert ordered and the
type of entrée ordered.

12.24 (a) There is no relationship between the commuting time of
company employees and the level of stress-related problems observed on the
job. There is a relationship between the commuting time of company
employees and the level of stress-related problems observed on the job.

H1:

H0:

H0x2
STAT = 92.1028 7 16.919,

df = (r - 1)(c - 1) = (3 - 1)(4 - 1) = 6.

p-value = 0.0388.

H0.x2
STAT = 6.50 7 5.9915,

f0 fe 1f0 - fe2 1f0 - fe22>fe

9 12.1379 -3.1379 0.8112
17 20.1034 -3.1034 0.4791
18 11.7586 6.2414 3.3129
5 5.2414 -0.2414 0.0111
8 8.6810 -0.6810 0.0534
6 5.0776 0.9224 0.1676

18 14.6207 3.3793 0.7811
28 24.2155 3.7845 0.5915
7 14.1638 -7.1638 3.6233

9.8311

Decision rule: If reject

Test statistic: 

Decision: Because do not reject There is
insufficient evidence to conclude that there is a relationship between the
commuting time of company employees and the level of stress-related
problems observed on the job. (b) Because
reject There is enough evidence at the 0.05 level to conclude that
there is a relationship.

12.26 Because reject There is a relation-
ship between when the decision is made of what to have for dinner and
the type of household.

12.28 (a) and where 1 = beginning, 2 = end.
Decision rule: If reject

Test statistic: 

Decision: Because reject There is evi-
dence that the proportion of coffee drinkers who prefer Brand A is lower at the

H0.ZSTAT = -2.3349 6 -1.645,

ZSTAT =
B - C1B + C

=
9 - 2219 + 22

= -2.3349.

H0.Z 6 -1.645,
H1: p1 6 p2,H0: p1 Ú p2

H0.x2
STAT = 129.520 7 21.026,

H0.
x2

STAT = 9.831 7 9.488,

H0.x2
STAT = 9.8311 6 13.277,

x2
STAT = ©

all cells

1f0 - fe22
fe

= 9.8311.

H0.x2
STAT 7 13.277,
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beginning of the advertising campaign than at the end of the advertising
campaign. (b) p-value The probability of a test statistic less
than is 0.0098 if the proportion of coffee drinkers who prefer
Brand A is not lower at the beginning of the advertising campaign than at
the end of the advertising campaign.

12.30 (a) Because reject There is
evidence that the proportion who prefer Brand A is lower before the
advertising than after the advertising. (b) p-value The
probability of a test statistic less than is 0.00127 if the proportion
who prefer Brand A is not lower before the advertising than after the
advertising.

12.32 (a) Because reject There is
evidence that the proportion of employees absent fewer than five days was
lower in Year 1 than in Year 2. (b) The p-value is virtually 0. The probability
of a test statistic smaller than is virtually 0 if the proportion of
employees absent fewer than five days was not lower in Year 1 than in Year 2.

12.34 (a) 9.2604 and 44.1814. (b) 8.9065 and 32.8523. (c) 7.2609 and
24.9958.

12.36 10.417.

12.38 (a) 6.262 and 27.488. (b) 7.261.

12.40 You must assume that the data in the population are normally
distributed to be able to use the chi-square test of a population variance
or standard deviation. If the data selected do not come from an approxi-
mately normally distributed population, the accuracy of the test can be
seriously affected.

12.42 (a)
Decision rule: If or reject

Test statistic: 

Decision: Because do not reject
There is insufficient evidence to conclude that the standard deviation

of the amount of auto repairs is not equal to $200. (b) You must assume
that the data in the population are normally distributed to be able to use the
chi-square test of a population variance or standard deviation. (c) p-value

The p-value of 0.1748 is the probability of obtaining a result
greater from the sample value of $237.52 when the null hypothesis is true.

12.44 (a) Because reject There is
sufficient evidence to conclude that the standard deviation of the diameter
of doorknobs is less than 0.035 inch in the redesigned production process.
(b) You must assume that the data in the population are normally distrib-
uted to be able to use the chi-square test of a population variance
or standard deviation. (c) p-value The probability of a test
statistic equal to or more extreme than the result from this sample data is
0.0230 if the population standard deviation is no less than 0.035 inch.

12.46 (a) Because do not reject There is
insufficient evidence to conclude that the standard deviation of the weight
of the teabags is greater than 0.5 gram. (b) You must assume that the data
in the population are normally distributed to be able to use the chi-square
test of a population variance or standard deviation.

12.48 (a) 31. (b) 29. (c) 27. (d) 25.

12.50 40 and 79.

12.52 (a) The ranks for Sample 1 are 1, 2, 4, 5, and 10. The ranks for
Sample 2 are 3, 6.5, 6.5, 8, 9, and 11. (b) 22. (c) 44.

12.54 Because do not reject H0.T1 = 22 7 20,

H0.x2
STAT = 1.5315 6 30.135,

= 0.0230.

H0.x2
STAT = 1.2245 6 13.848,

0.1748.
=

H0.
12.401 6 x2

STAT = 33.849 6 39.364,

(n - 1)S2

s2
=

(24)237.522

2002
= 33.849

H0.x2
STAT 7 39.364,x2

STAT 6 12.401df = 24.
H0:s = $200. H1:s Z $200.

-3.8996

H0.ZSTAT = -3.8996 6 -1.645,

-2.2361
= 0.0127.

H0.ZSTAT = -2.2361 6 -1.645,

-2.3349
= 0.0098.

12.56 (a) The data are ordinal. (b) The two-sample t test is inappropriate
because the data can only be placed in ranked order. (c) Because

reject There is evidence of a
significance difference in the median rating of California Cabernets and
Washington Cabernets.

12.58 (a) where Populations: 1 = Wing A, 2 = Wing B.

Population 1 sample: Sample size 20 Sum of ranks 561

Population 2 sample: Sample size 20 Sum of ranks 259 

Decision: Because (or p-value ,
reject There is sufficient evidence of a difference in the median
delivery time in the two wings of the hotel. (b) The results of (a) are
consistent with the results of Problem 10.67.

12.60 (a) Because reject There is
enough evidence to conclude that the median crack size is less for the
unflawed sample than for the flawed sample. (b) You must assume
approximately equal variability in the two populations. (c) Using both the
pooled-variance t test and the separate-variance t test allowed you to
reject the null hypothesis and conclude in Problem 10.17 that the mean
crack size is less for the unflawed sample than for the flawed sample. 
In this test, using the Wilcoxon rank sum test with large-sample Z
approximation also allowed you to reject the null hypothesis and conclude
that the median crack size is less for the unflawed sample than for the
flawed sample.

12.62 (a) Because (or the
), do not reject There is not enough

evidence to conclude that there is a difference in the median battery life
between subcompact cameras and compact cameras. (b)You must assume
approximately equal variability in the two populations. (c) Using the
pooled-variance t-test, you reject the null hypothesis

and conclude that there is evidence of
a difference in the mean battery life between the two types of digital
cameras in Problem 10.11 (a). However, in Problem 10.48, the F test for
the ratio of two variances shows a significant difference between the
variances in the battery life. Therefore, the pooled-variance t test is not
valid for these data. The separate-variance t test, however, also shows
evidence of a difference in the mean battery life between the two types of
digital cameras The
difference in results can be explained by the fact that the Wilcoxon rank
sum test assumes equal variances not normality and the separate-variance
test assumes normality but not equal variances.

12.64 (a) Decision rule: If reject (b) Because
do not reject 

12.66 (a) reject
There is sufficient evidence of a difference in the median waiting time in
the four locations. (b) The results are consistent with those of Problem 11.9.

12.68 (a) reject There is evidence of a
difference in the median ratings of the ads. (b) The results are consistent
with those of Problem 11.10. (c) Because the combined scores are not
true continuous variables, the nonparametric Kruskal-Wallis rank test is

H0.H = 19.3269 7 9.488,

H0.H = 13.517 7 7.815, p-value = 0.0036 6 0.05,

H0.H = 13.77 6 15.086,
H0.H 7 xU

2 = 15.086,

(t = 2.3248 7 2.1009; p-value = 0.0320 6 0.05).

2.0167; p-value = 0.0067 6 0.05)
(t = 2.8498 7

H0.p-value = 0.0504 7 0.05
-1.96 6 ZSTAT = 1.956 6 1.96

H0.ZSTAT = -4.118 6 -1.645,

H0.
= 0.0000 6 0.05)ZSTAT = 4.0846 7 1.96

ZSTAT =
T1 - mT1

ST1

=
561 - 410

36.9685
= 4.0846

sT1
= An1n2(n + 1)

12
= A20(20)(40 + 1)

12
= 36.9685

mT1
=

n1(n + 1)

2
=

20(40 + 1)

2
= 410

H1: M1 Z M2.
H0: M1 = M2,

H0.ZSTAT = -2.2054 6 -1.96,
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more appropriate because it does not require that the scores be normally
distributed.

12.70 (a) Because or the p-value is approximately 0,
reject There is sufficient evidence of a difference in the median
strength of the four brands of trash bags. (b) The results are the same.

12.78 (a) Because do not reject There is
insufficient evidence to conclude that there is a relationship between a
student’s gender and pizzeria selection. (b) Because

do not reject There is insufficient evidence to conclude that
there is a relationship between a student’s gender and pizzeria selection.
(c) Because do not reject There is insufficient
evidence to conclude that there is a relationship between price and pizzeria
selection. (d) The probability of a sample that gives a
test statistic equal to or greater than 4.956 is 8.39% if the null hypothesis of
no relationship between price and pizzeria selection is true.

12.80 (a) Because do not reject There is
not enough evidence to conclude that there is a relationship between the
attitudes of employees toward the use of self-managed work teams and
employee job classification. (b) Because do
not reject There is insufficient evidence to conclude that there is a
relationship between the attitudes of employees toward vacation time
without pay and employee job classification.

12.82 (a) Because reject There is
enough evidence of a difference in the proportion of respondents who
prefer Coca-Cola before and after viewing the ads. (b)
The probability of a test statistic that differs from 0 by 1.7889 or more in
either direction is 0.0736 if there is no difference in the proportion of
respondents who prefer Coca-Cola before and after viewing the ads.
(c) The frequencies in the second table are computed from the row and
column totals of the first table. (d) Because the calculated test statistic

do not reject and conclude that there is no
evidence of a significant difference in preference for Coca-Cola before
and after viewing the ads. (e) The probability of a test
statistic larger than 0.6528 is 41.91% if there is not a significant
difference in preference for Coca-Cola before and after viewing the ads.
(f) The McNemar test performed using the information in the first table
takes into consideration the fact that the same set of respondents is
surveyed before and after viewing the ads while the chi-square test
performed using the information in the second table ignores this fact. The
McNemar test should be used because of the related samples (before–after
comparison).

CHAPTER 13
13.2 (a) Yes. (b) No. (c) No. (d) Yes.

13.4 (a) The scatter plot shows a positive linear relationship. (b) For each
increase in shelf space of an additional foot, predicted weekly sales are
estimated to increase by $7.40. (c)

or $204.20.

13.6 (b) (c) For every cubic foot increase in the
amount moved, predicted labor hours are estimated to increase by 0.0501.
(d) 22.67 labor hours.

13.8 (b) (c) For each additional million-
dollar increase in revenue, the value is predicted to increase by an estimated
$4.4564 million. Literal interpretation of is not meaningful because an
operating franchise cannot have zero revenue. (d) 283.6654 million.

13.10 (b) 10.473
0.3839. (c) For each increase of one additional increase of million dollars
of box office gross, the predicted DVD revenue is estimated to increase by

+YN =YN = b0 + b1X.b0 = 10.473, b1 = 0.3839.

b0

b0 = -384.7934, b1 = 4.4564.

b0 = -2.37, b1 = 0.0501

204.2,
YN = 145 + 7.4X = 145 + 7.4(8) =

p-value = 0.4191.

H0x2
STAT = 0.6528 6 3.8415,

p-value = 0.0736.

H0.ZSTAT = -1.7889 6 -1.645,

H0.
x2

STAT = 3.294 6 12.592,

H0.x2
STAT = 11.895 6 12.592,

p-value = 0.0839.

H0.x2
STAT = 4.956 6 5.991,

H0.3.841,
x2

STAT = 2.624 6

H0.x2
STAT = 0.412 6 3.841,

H0.
H = 22.26 7 7.815

$0.3839 million. (d)
million.

13.12 90% of the variation in the dependent variable can be
explained by the variation in the independent variable.

13.14 75% of the variation in the dependent variable can be
explained by the variation in the independent variable.

13.16 (a) 68.4% of the variation in sales 

can be explained by the variation in shelf space. 

(b)

(c) Based on (a) and (b), the model should be useful for predicting sales.

13.18 (a) 88.92% of the variation in labor hours can be
explained by the variation in cubic feet moved. (b)
(c) Based on (a) and (b), the model should be very useful for predicting
the labor hours.

13.20 (a) 96.95% of the variation in the value of a baseball
franchise can be explained by the variation in its annual revenue.
(b) (c) Based on (a) and (b), the model should be very
useful for predicting the value of a baseball franchise.

13.22 (a) 54.52% of the variation in DVD revenue can be
explained by the variation in box office gross. (b) The
variation of DVD revenue around the prediction line is $15.3782 million.
The typical difference between actual DVD revenue and the predicted
DVD revenue using the regression equation is approximately $15.3782
million. (c) Based on (a) and (b), the model is useful for predicting DVD
revenue. (d) Other variables that might explain the variation in DVD
revenue could be the amount spent on advertising, the timing of the
release of the DVDs, and the type of movie.

13.24 A residual analysis of the data indicates a pattern, with sizable
clusters of consecutive residuals that are either all positive or all negative.
This pattern indicates a violation of the assumption of linearity. A
curvilinear model should be investigated.

13.26 There does not appear to be a pattern in the residual plot. The
assumptions of regression do not appear to be seriously violated.

13.28 Based on the residual plot, there does not appear to be a curvilinear
pattern in the residuals. The assumptions of normality and equal variance
do not appear to be seriously violated.

13.30 Based on the residual plot, there appears to be a nonlinear pattern
in the residuals. A curvilinear model should be investigated. There is
some right-skewness in the residuals, and there is some violation of the
equal-variance assumption.

13.32 (a) An increasing linear relationship exists. (b) There is evidence of
a strong positive autocorrelation among the residuals.

13.34 (a) No, because the data were not collected over time. (b) If a
single store had been selected and studied over a period of time, you
would compute the Durbin-Watson statistic.

13.36 (a)

(b) or
$72,908. (c) There is no evidence of a pattern in the residuals over time.

YN = 0.458 + 0.0161X = 0.458 + 0.016114,5002 = 72.908,

b0 = Y - b1X = 71.2621 - 0.0161 14,3932 = 0.458

b1 =
SSXY

SSX
=

201399.05
12495626

= 0.0161

SYX = 15.3782.
r2 = 0.5452.

SYX = 46.1275.

r2 = 0.9695.

SYX = 5.0314
r2 = 08892.

SYX = A SSE

n - 2
= Sa

n

i=1
(Yi - YNi)

2

n - 2
= A9,490

10
= 30.8058.

r2 =
SSR

SST
=

20,535

30,025
= 0.684.

r2 = 0.75.

r2 = 0.90.

$39.2658
YN = b0 + b1 X. YN = 10.473 + 0.3839(75) =
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(d) There is no 

evidence of positive autocorrelation among the residuals. (e) Based on a
residual analysis, the model appears to be adequate.

13.38 (a) (b) $2,505.40. (d)
so there is no evidence of positive autocorrelation among the

residuals. (e) The plot shows some nonlinear pattern, suggesting that a non-
linear model might be better. Otherwise, the model appears to be adequate.

13.40 (a) 3.00. (b) (c) Reject There is evidence that the
fitted linear regression model is useful. (d)

13.42 (a) Reject There

is evidence of a linear relationship between shelf space and sales. 

(b)

13.44 (a) reject There is evidence of a
linear relationship between the number of cubic feet moved and labor
hours. (b)

13.46 (a) or because the p-value is
approximately 0, reject at the 5% level of significance. There is
evidence of a linear relationship between annual revenue and franchise
value. (b)

13.48 (a) or because the p-value is virtually
reject There is evidence of a linear relationship between

box office gross and sales of DVDs. (b)

13.50 (a) (% daily change in BGU) (% daily change in
Russell 1000 index). (b) If the Russell 1000 gains 10% in a year, BGU is
expected to gain an estimated 30%. (c) If the Russell 1000 loses 20% in a
year, BGU is expected to lose an estimated 60%. (d) Risk takers will be
attracted to leveraged funds, and risk-averse investors will stay away.

13.52 (a), (b) First weekend and U.S. gross:
Do not reject At the 0.05 level of

significance, there is a insufficient evidence of a linear relationship
between First weekend sales and U.S. gross. First weekend and worldwide
gross:
Do not reject At the 0.05 level of significance, there is a insufficient
evidence of a linear relationship between first weekend sales and
worldwide gross. U.S. gross and worldwide gross:

Reject At the 0.05 level
of significance, there is evidence of a linear relationship between U.S.
gross and worldwide gross.

13.54 (a) There appears to be a moderate positive linear
relationship between the average Wonderlic score of football players
trying out for the NFL and the graduation rate for football players at
selected schools. (b) Reject

At the 0.05 level of significance, there is a significant linear
relationship between the average Wonderlic score of football players
trying out for the NFL and the graduation rate for football players at
selected schools. (c) There is a significant linear relationship between the
average Wonderlic score of football players trying out for the NFL and
the graduation rate for football players at selected schools, but the
positive linear relationship is only moderate.

13.56 (a) (b)

13.58 (a)

178.76 … mY|X=8 … 229.64.

= 204.2 ; 2.2281130.81210.1373

YN = 145 + 7.4182 = 204.2 YN ; ta>2SYX1hi

14.651 … YX=4 … 19.349.15.95 … mY|X=4 … 18.05.

H0.
tSTAT = 3.9485, p-value = 0.0004 6 0.05.

r = 0.5497.

H0.5.5807 7 2.7764, p-value = 0.0051 6 0.05.
r = 0.9414, tSTAT =

H0.
r = 0.4149, tSTAT = -0.912 6 2.7764, p-value = 0.4134 7 0.05.

H0.2.7764, p-value = 0.6292 7 0.05.
r = 0.2526, tSTAT = -0.5221 6

= b0 + 3.0

3.3072 … b1 … 5.3590.
H0.0 6 0.05;

tSTAT = 4.8964 7 2.086

4.1502 … b1 … 4.7626.

H0

tSTAT = 29.8157 7 2.0484

0.0439 … b1 … 0.0562.

H0.tSTAT = 16.52 7 2.0322;

b1 ; ta>2Sb1
= 7.4 ; 2.2281(1.59) 3.86 … b1 … 10.94.

H0.tSTAT =
b1 - b1

Sb1

=
7.4

1.59
= 4.65 7 2.2281.

1.32 … b1 … 7.68.
H0.;2.1199.

dU = 1.42,
D = 1.64 7b0 = -2.535, b1 = .06073.

D =
a

n

i=2
1ei - ei-122

a
n

i=1
e2

i

=
1,243.2244

599.0683
= 2.08 7 1.45.

(b)

(c) Part (b) provides a prediction interval for the individual response
given a specific value of the independent variable, and part (a) provides
an interval estimate for the mean value, given a specific value of the
independent variable. Because there is much more variation in predicting
an individual value than in estimating a mean value, a prediction interval
is wider than a confidence interval estimate.

13.60 (a) (b)
(c) You can estimate a mean more precisely than you can predict a single
observation.

13.62 (a) (b)
(c) Part (b) provides a prediction interval for an individual

response given a specific value of X, and part (a) provides a confidence
interval estimate for the mean value, given a specific value of X. Because
there is much more variation in predicting an individual value than in
estimating a mean, the prediction interval is wider than the confidence
interval.

13.74 (a) (b) For each additional case, the
predicted delivery time is estimated to increase by 0.14 minutes.
(c) 45.84. (d) No, 500 is outside the relevant range of the data used to fit
the regression equation. (e) (f) There is no obvious pattern
in the residuals, so the assumptions of regression are met. The model
appears to be adequate. (g) reject
(h)

13.76 (a) (b) For each additional
thousand dollars in assessed value, the estimated selling price of a 
house increases by $1.7817 thousand. The estimated selling price of a
house with a 0 assessed value is thousand. However,
this interpretation is not meaningful because the assessed value cannot 
be below 0. (c)

thousand dollars. (d) So
92.56% of the variation in selling price can be explained by the 
variation in assessed value. (e) Neither the residual plot nor the normal
probability plot reveals any potential violation of the linearity, equal
variance, and normality assumptions. (f)
p-value is virtually 0. Because reject There is
evidence of a linear relationship between selling price and assessed 
value. (g)

13.78 (a) (b) For each additional point on the
GMAT score, the predicted GPA is estimated to increase by 0.00487.
Because a GMAT score of 0 is not possible, the Y intercept does not have
a practical interpretation. (c) 3.222. (d) (e) There is no
obvious pattern in the residuals, so the assumptions of regression are met.
The model appears to be adequate. (f) reject
(g)
(h)

13.80 (a) There is no clear relationship shown on the scatter plot.
(c) Looking at all 23 flights, when the temperature is lower, there is likely
to be some O-ring damage, particularly if the temperature is below
60 degrees. (d) 31 degrees is outside the relevant range, so a prediction
should not be made. (e) Predicted where

and -ring damage (g) A nonlinear model would
be more appropriate. (h) The appearance on the residual plot of a
nonlinear pattern indicates that a nonlinear model would be better. It also
appears that the normality assumption is invalid.

13.82 (a) (b) For each additional million-
dollar increase in revenue, the franchise value will increase by an

b0 = -6.2448, b1 = 2.9576.

Y = OX = temperature
Y = 18.036 - 0.240X,

.00366 … b1 … .00608.
3.144 … mY|X=600 … 3.301,2.866 … YX=600 … 3.559.

H0.tSTAT = 8.43 7 2.1009;

r2 = 0.798.

b0 = 0.30, b1 = 0.00487.

1.5862 … b1 … 1.9773.

H0.p-value 6 0.05,
18.6648 7 2.0484,tSTAT =

r2 = 0.9256.1.78171(170) = 180.5475
-122.3439 +YN = -122.3439 + 1.78171X =

$ - 122.3439

b0 = -122.3439, b1 = 1.7817.

41.56 … YX=150 … 50.12.44.88 … mY|X=150 … 46.80.
H0.tSTAT = 24.88 7 2.1009;

r2 = 0.972.

b0 = 24.84, b1 = 0.14.

350.769.
186.5618 … YX=150 …261.279 … mY|X=150 … 306.0519.

12.276 … YX=500 … 33.065.20.799 … mY|X=500 … 24.542.

131.00 … YX=8 … 277.40.

= 204.2 ; 2.2281130.81211 + 0.1373

YN ; ta>2SYX11 + hi
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estimated $2.9576 million. Literal interpretation of is not meaningful
because an operating franchise cannot have zero revenue. (c) $437.3901
million. (d) 98.1% of the variation in the value of an NBA
franchise can be explained by the variation in its annual revenue.
(e) There does not appear to be a pattern in the residual plot. The
assumptions of regression do not appear to be seriously violated.
(f) or because the p-value is approximately 0,
reject at the 5% level of significance. There is evidence of a linear
relationship between annual revenue and franchise value. (g)

(h) (i) The
strength of the relationship between revenue and value is stronger for
baseball and NBA franchises than for European soccer teams.

13.84 (a) (b) For each additional
centimeter in circumference, the weight is estimated to increase by
82.472 grams. (c) 2,319.08 grams. (d) Yes, since circumference is a very
strong predictor of weight. (e) (f) There appears to be a
nonlinear relationship between circumference and weight. (g) p-value is
virtually reject (h)

13.86 (b) (c) For each
increase of the median age of the customer base by one year, the latest one-
month sales total is estimated to increase by $21,782.76.
Since age cannot be 0, there is no direct interpretation for
(d) Only 0.17% of the total variation in the franchise’s latest
one-month sales total can be explained by using the median age of the
customer base. (e) The residuals are very evenly spread out across different
ranges of median age. (f) Because
do not reject There is insufficient evidence to conclude that there is a
linear relationship between the one-month sales total and the median age of
the customer base. (g)

13.88 (a) There is a positive linear relationship between total sales and
the percentage of the customer base with a college diploma. 
(b) (c) For each increase
of 1% of the customer base having received a college diploma, the latest
one-month mean sales total is estimated to increase by $35,854.15.

Although this is outside the range of the data, it would
mean that the estimated sales when the percentage of the customer base
with a college diploma was 0 would be $789,847.38 
(d) 10.36% of the total variation in the franchise’s latest
one-month sales total can be explained by the percentage of the customer
base with a college diploma. (e) The residuals are evenly spread out
around zero. (f) Because reject There is
enough evidence to conclude that there is a linear relationship between
one-month sales total and percentage of customer base with a college
diploma. (g)

13.90 (a) The correlation between compensation and stock performance
is 0.0281. (b) The correlation between
compensation and stock performance is not significant. (c) The lack of
correlation between compensation and stock performance was surprising
(or maybe it shouldn’t have been!).

CHAPTER 14
14.2 (a) For each one-unit increase in you estimate that Y will
decrease 2 units, holding constant. For each one-unit increase in 
you estimate that Y will increase 7 units, holding constant. (b) The Y
intercept, equal to 50, estimates the value of Y when both and are 0.

14.4 (a) (b) For a given
number of orders, for each increase of $1,000 in sales, the distribution
cost is estimated to increase by $47.114. For a given amount of sales, for
each increase of one order, the distribution cost is estimated to increase

YN = -2.72825 + 0.047114X1 + 0.011947X2.

X2X1

X1

X2,X2

X1,

tSTAT = -0.3924 7 -1.96.-

195.75 … b1 … 71,512.60.
b1 ; ta>2 Sb1

= 35,854.15 ; 2.0281(17,582.269),

H0.tSTAT = 2.0392 7 2.0281,

r2 = 0.1036.

b0 = 789,847.38

b1 = 35,854.15YN = 789,847.38 + 35,854.15X.

-156,181.50 … b1 … 199,747.02.

H0.
-2.0281 6 tSTAT = 0.2482 6 2.0281,

r2 = 0.0017.
b0.

b0 = 931,626.16

b1 = 21,782.76YN = 931,626.16 + 21,782.76X.

72.7875 … b1 … 92.156.H0.0 6 0.05;

r2 = 0.937.

b0 = -2,629.222, b1 = 82.472.

408.8257 … YX=150 … 465.9544.mY|X=150 … 443.7334.
431.0467 …

H0

tSTAT = 38.0207 7 2.0484

r2 = 0.981.

b0 by $11.95. (c) The interpretation of has no practical meaning here
because it would represent the estimated distribution cost when there
were no sales and no orders. (d)

, or $69,878. (e)
(f) (g) The interval in (e)

is narrower because it is estimating the mean value, not an individual value.

14.6 (a) . (b) For a given amount of
newspaper advertising, each increase by $1,000 in radio advertising is
estimated to result in an increase in sales of $13,081. For a given amount
of radio advertising, each increase by $1,000 in newspaper advertising is
estimated to result in an increase in sales of $16,795. (c) When there is no
money spent on radio advertising and newspaper advertising, the
estimated mean sales is $156,430.44. (d) Holding the other independent
variable constant, newspaper advertising seems to be more effective
because its slope is greater.

14.8 (a) where
(b) For a given age, each increase by one acre in land area 

is estimated to result in an increase in appraised value by $456.45
thousands. For a given land area, each increase of one year in age is
estimated to result in a decrease in appraised value by $2.47 thousands.
(c) The interpretation of has no practical meaning here because it
would represent the estimated appraised value of a new house that has
no land area. (d)

thousands. (e) (f)

14.10 (a) (b) 1.25. (c) do
not reject (d) 0.20. (e) 0.04.

14.12 (a) . Reject There is evidence of a
significant linear relationship with at least one of the independent
variables. (b) (c) 94.21% of the variation
in the long-term ability to absorb shock can be explained by variation
in forefoot absorbing capability and variation in midsole impact. 
(d)

14.14 (a) reject (b)
(c) 87.59% of the variation in distribution cost can be
explained by variation in sales and variation in number of orders. 
(d)

14.16 (a) . Reject There is evidence
of a significant linear relationship. (b)
(c) 80.87% of the variation in sales can be explained by
variation in radio advertising and variation in newspaper advertising.
(d)

14.18 (a)–(e) Based on a residual analysis, there is no evidence of a
violation of the assumptions of regression.

14.20 (a) There appears to be a quadratic relationship in the plot of the
residuals against both radio and newspaper advertising. (b) Since the
data are not collected over time, the Durbin-Watson test is not
appropriate. (c) Curvilinear terms for both of these explanatory variables
should be considered for inclusion in the model.

14.22 (a) The residual analysis reveals no patterns. (b) Since the data are
not collected over time, the Durbin-Watson test is not appropriate. (c)
There are no apparent violations in the assumptions.

14.24 (a) Variable has a larger slope in terms of the t statistic of 3.75
than variable which has a smaller slope in terms of the t statistic of
3.33. (b) (c) For

with 17 degrees of freedom for Reject There
is evidence that contributes to a model already containing 
For with 17 degrees of freedom forX2: tSTAT = 3>0.8 = 3.75 7 2.1098,

X2.X1

H0.a = 0.05.2.1098,
X1: tSTAT = 4>1.2 = 3.33 71.46824 … b1 … 6.53176.

X1,
X2

r2
adj = 0.7886.

r2 = 0.8087.
p-value 6 0.001.

H0.FSTAT = 40.16 7 3.522

r2
adj = 0.8641.

r2 = 0.8759.
p-value = 0.H0.FSTAT = 74.13 7 3.467;

r2
adj = 0.935.

r2 = 0.9421.p-value = 0.0001.

H0.FSTAT = 97.69 7 3.89

H0.
FSTAT = 1.25 6 4.10;MSR = 15, MSE = 12.

YX … 572.2649.
235.1964 …372.7370 … mY|X … 434.7243.$403.73

YN = 400.8057 + 456.448510.252 - 2.47081452 =

b0

X2 = age.
X1 = land area,YN = 400.8057 + 456.4485X1 - 2.4708X2

YN = 156.4 + 13.081X1 + 16.795X2

$59,380.61 … YX … $80,376.33.$73,337.01.
$66,419.93 … mY|X …0.011947145002 = 69.878

YN = -2.72825 + 0.04711414002 +

b0
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Reject There is evidence that contributes to a 
model already containing Both and should be included 
in the model.

14.26 (a) 95% confidence interval on 
(b) For
Reject There is evidence that 

contributes to a model already containing For
Reject There is evidence that 

contributes to a model already containing Both (sales) and 
(orders) should be included in the model.

14.28 (a) (b) For
Reject There is evidence that contributes to a model already
containing For Reject There is
evidence that contributes to a model already containing Both
(radio advertising) and (newspaper advertising) should be included in
the model.

14.30 (a) (b) For
and Because reject There is
evidence that contributes to a model already containing For

and . Because
reject There is evidence that contributes to a model already
containing Both (land area) and (age) should be included
in the model.

14.32 (a) For do not reject For
do not reject (b) 0.1111, 0.0769.

14.34 (a) For and

Reject There is evidence that 

contributes to a model already containing For
and

Reject

There is evidence that contributes to a model already containing 
Because both and make a significant contribution to the model in
the presence of the other variable, both variables should be included in
the model.

(b)

Holding constant the effect of the number of orders, 20.37% of the
variation in distribution cost can be explained by the variation in sales.

Holding constant the effect of sales, 57.34% of the variation in
distribution cost can be explained by the variation in the number of
orders.

14.36 (a) For Reject There is
evidence that contributes to a model containing For

Reject There is evidence that 
contributes to a model already containing Because both and X2X1X1.

X2H0.X2: FSTAT = 32.12 7 4.381.
X2.X1

H0.X1: FSTAT = 55.28 7 4.381.

=
641.265

3,845.13 - 3,368.087 + 641.265
= 0.5734

r2
Y2.1 =

SSR(X2|X1)

SST - SSR(X1 and X2) + SSR(X2|X1)

=
122.025

3,845.13 - 3,368.087 + 122.025
= 0.2037.

r2
Y1.2 =

SSR(X1|X2)

SST - SSR(X1 and X2) + SSR(X1|X2)

X2X1

X1.X2

H0.FSTAT =
SSR1X2|X12

MSE
=

641.265

477.043>21
= 28.23 7 4.325.

X22 - SSR1X12 = 3,368.087 - 2,726.822 = 641.265,SSR1X1

X2: SSR1X2|X12 =X2.

X1H0.
122.025

477.043>21
= 5.37 7 4.325.

FSTAT =
SSR1X1|X22

MSE
=3,368.087 - 3,246.062 = 122.025,

X22 - SSR1X22 =X1: SSR1X1|X22 = SSR1X1

H0.0.833 6 4.96;
X2: FSTAT =H0.X1: FSTAT = 1.25 6 4.96;

X2X1X1.
X2H0.

p-value 6 0.05p-value = 0.0012X2: tSTAT = -3.6295
X2.X1

H0.p-value 6 0.05,p-value = 0.0003.
X1: tSTAT = 4.0922227.5865 … b1 … 685.3104.

X2

X1X1.X2

H0.X2: tSTAT = 5.67 7 2.093.X2.
X1H0.

X1: tSTAT = 7.43 7 2.093.9.398 … b1 … 16.763.

X2X1X1.X2

H0.0.0112>0.0023 = 5.31 7 2.0796.
X2: tSTAT = b1>Sb1

=X2.
X1H0.0.0471>0.0203 = 2.32 7 2.0796.

X1: tSTAT = b1>Sb1
=(0.0203), 0.0049 … b1 … 0.0893.

b1: b1 ; tSb1
, 0.0471 ; 2.0796

X2X1X1.
X2H0.a = 0.05. make a significant contribution to the model in the presence of the other

variable, both variables should be included in the model. (b)
Holding constant the effect of newspaper advertising,

74.42% of the variation in sales can be explained by the variation in radio
advertising. Holding constant the effect of radio
advertising, 62.83% of the variation in sales can be explained by the
variation in newspaper advertising.

14.38 (a) Holding constant the effect of for each increase of one unit
of increases by 4 units. (b) Holding constant the effect of for
each increase of one unit of increases by 2 units. (c) Because

reject Variable makes a significant
contribution to the model.

14.40 (a) where
of rooms and (b) Holding constant the effect
of neighborhood, for each additional room, the selling price is estimated to
increase by 9.2189 thousands of dollars, or $9,218.9. For a given number
of rooms, a west neighborhood is estimated to increase the selling price
over an east neighborhood by 12.6967 thousands of dollars, or $12,696.7.
(c) or

(d) Based on a residual analysis, the model appears to be adequate. 
(e) the p-value is virtually 0. Because 
reject There is evidence of a significant relationship between selling
price and the two independent variables (rooms and neighborhood). 
(f) For the p-value is virtually 0. Reject Number
of rooms makes a significant contribution and should be included in the
model. For Reject
Neighborhood makes a significant contribution and should be included in
the model. Based on these results, the regression model with the two
independent variables should be used. (g)
(h) (i) (j) . Holding
constant the effect of neighborhood, 82.5% of the variation in selling
price can be explained by variation in number of rooms. 
Holding constant the effect of number of rooms, 43.1% of the variation
in selling price can be explained by variation in neighborhood. (k) The
slope of selling price with number of rooms is the same, regardless
of whether the house is located in an east or west neighborhood. 
(l) For

Do not reject There is no evidence that the interaction term
makes a contribution to the model. (m) The model in (b) should be used.

14.42 (a) Predicted Dry.
(b) Holding constant the effect of type of drilling, for each foot
increase in depth of the hole, the drilling time is estimated to increase
by 0.00523 minutes. For a given depth, a dry drilling hole is estimated
to reduce the drilling time over wet drilling by 2.1052 minutes. (c) 6.428
minutes, (d) The model
appears to be adequate. (e) reject
(f) reject
reject Include both variables. (g)
(h) (i) 69.0%. (j) 0.207, 0.670. (k) The
slope of the additional drilling time with the depth of the hole is the same,
regardless of the type of drilling method used. (l) The p-value of the
interaction so the term is not significant and
should not be included in the model. (m) The model in part (b) should 
be used.

14.44 (a)
where Do not reject

There is not enough evidence that the interaction term makes a
contribution to the model. (b) Because there is insufficient evidence of
any interaction effect between sales and orders, the model in Problem
14.4 should be used.

H0.
X1 = sales, X2 = orders, p-value = 0.3249 7 0.05.

YN = 31.5594 + 0.0296X1 + 0.0041X2 + 0.000017159X1X2,

term = 0.462 7 0.05,

-2.403 … b2 … -1.808.
0.0032 … b1 … 0.0073.H0.

tSTAT = -14.03 6 -1.9847;H0.1.9847;tSTAT = 5.03 7
H0.FSTAT = 111.11 7 3.09;

6.210 … mY|X … 6.646, 4.923 … YX … 7.932.

time = 8.01 + 0.00523 Depth - 2.105

H0.0.330.
X1 X2, p-value =8.032X1 - 5.90X2 + 2.089X1X2.YN = 253.95 +

r2
Y2.1 = 0.431.

r2
Y1.2 = 0.825r2

adj = 0.851.5.2378 … b2 … 20.1557.
7.0466 … b1 … 11.3913.

H0.X2:tSTAT = 3.5913, p-value = 0.0023 6 0.05,

H0.X1:tSTAT = 8.9537,

H0.
p-value 6 0.05,FSTAT = 55.39,

mY|X … $331, 943.71.$309,560.04 … YX … $343,855.1. $321,471.44 …
$326, 707.6.YN = 243.7371 + 9.2189192 + 12.6967102 = 326.7076,

X2 = neighborhood (east = 0)
X1 = numberYN = 243.7371 + 9.2189X1 + 12.6967X2,

X2H0.tSTAT = 3.27 7 2.1098,
X2, Y

X1,X1, Y
X2,

r2
Y2.1 = 0.6283.

r2
Y1.2 = 0.7442.
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14.46 (a) The p-value of the interaction so the
term is significant and should be included in the model. (b) Use the
model developed in this problem.

14.48 (a) For Do not reject There
is insufficient evidence that the interaction term makes a contribution
to the model. (b) Because there is not enough evidence of an interaction
effect between total staff present and remote hours, the model in
Problem 14.7 should be used.

14.50 Holding constant the effect of other variables, the natural logarithm
of the estimated odds ratio for the dependent categorical response will
increase by 2.2 for each unit increase in the particular independent
variable.

14.52 0.4286.

14.54 (a)

Estimated Probability of Success
(b) From the text discussion of the

example, 70.16% of the individuals who charge $36,000 per annum and
possess additional cards can be expected to purchase the premium card.
Only 12.80% of the individuals who charge $36,000 per annum and do
not possess additional cards can be expected to purchase the premium
card. For a given amount of money charged per annum, the likelihood of
purchasing a premium card is substantially higher among individuals
who already possess additional cards than for those who do not possess
additional cards. (c) ln(estimated odds ratio) 

Estimated Probability of 
(d) Among individuals who do not

purchase additional cards, the likelihood of purchasing a premium card
diminishes dramatically with a substantial decrease in the amount charged
per annum.

14.56 (a) ln(estimated odds)
(b) Holding constant the effect of GMAT score, for each increase of one
point in GPA, ln(estimated odds) increases by an estimate of 8.053.
Holding constant the effect of GPA, for each increase of one point in
GMAT score, ln(estimated odds) increases by an estimate of 0.1573. 
(c) 0.197. (d) Deviance do not reject so
model is adequate. (e) For GPA: do not reject .
For GMAT: reject (f) ln(estimated odds)

GPA. (g) ln(estimated odds) 
GMAT. (h) Use model in (g).

14.68 (a) , where number
cubic feet moved and number of pieces of large furniture.
(b) Holding constant the number of pieces of large furniture, for each
additional cubic foot moved, the labor hours are estimated to increase
by 0.0319. Holding constant the amount of cubic feet moved, for each
additional piece of large furniture, the labor hours are estimated to
increase by 4.2228. (c)

(d) Based on a residual analysis, the errors appear to be
normally distributed. The equal-variance assumption might be violated
because the variances appear to be larger around the center region of 
both independent variables. There might also be violation of the linearity
assumption. A model with quadratic terms for both independent variables
might be fitted. (e) p-value is virtually 0. Because

reject There is evidence of a significant relationship
between labor hours and the two independent variables (the amount of

H0.p-value 6 0.05,
FSTAT = 228.80,

20.4926.
YN = -3.9152 + 0.031915002 + 4.2228 122 =

X2 =
X1 =YN = -3.9152 + 0.0319X1 + 4.2228X2

= -60.15 + 0.099= 2.765 + 1.02
H0.ZSTAT = 2.07 7 1.96,

H0ZSTAT = 1.60 6 1.96,
H0,statistic = 8.122 6 40.133,

= -121.95 + 8.053 GPA + 0.1573 GMAT.

0.0119>(1 + 0.0119) = 0.01178.
Success = Odds Ratio>(1 + Odds Ratio) =

Estimated odds ratio = e-4.42954 = 0.0119.

2.774X2 = -6.94 + 0.13947(18) + 2.774(0) = -4.42954.
= -6.94 + 0.13947X1 +

0.1467>(1 + 0.1467) = 0.1280.
= Odds Ratio>(1 + Odds Ratio) =

Estimated odds ratio = e-1.91908 = 0.1467.

-6.94 + 0.13947(36) + 2.774(0) = -1.91908.
-6.94 + 0.13947X1 + 2.774X2 =ln(estimated odds ratio) =

H0.X1 X2, p-value = 0.2353 7 0.05.

term = 0.002 6 0.05, cubic feet moved and the number of pieces of large furniture). (f) The
p-value is virtually 0. The probability of obtaining a test statistic of
228.80 or greater is virtually 0 if there is no significant relationship
between labor hours and the two independent variables (the amount 
of cubic feet moved and the number of pieces of large furniture).
(g) of the variation in labor hours can be explained
by variation in the number of cubic feet moved and the number of pieces
of large furniture. (h) (i) For the
p-value is virtually 0. Reject The number of cubic feet moved
makes a significant contribution and should be included in the model. For

the p-value is virtually 0. Reject The number of
pieces of large furniture makes a significant contribution and should be
included in the model. Based on these results, the regression model with
the two independent variables should be used. (j) For
the p-value is virtually 0. The probability of obtaining a sample that
will yield a test statistic farther away than 6.9339 is virtually 0 if the
number of cubic feet moved does not make a significant contribution,
holding the effect of the number of pieces of large furniture constant. 
For the p-value is virtually 0. The probability of
obtaining a sample that will yield a test statistic farther away than 4.6192
is virtually 0 if the number of pieces of large furniture does not make a
significant contribution, holding the effect of the amount of cubic feet
moved constant. (k) You are 95% confident that
the mean labor hours will increase by between 0.0226 and 0.0413 for
each additional cubic foot moved, holding constant the number of pieces
of large furniture. In Problem 13.44, you are 95% confident that the labor
hours will increase by between 0.0439 and 0.0562 for each additional
cubic foot moved, regardless of the number of pieces of large furniture.
(l) Holding constant the effect of the number of pieces 
of large furniture, 59.3% of the variation in labor hours can be explained
by variation in the amount of cubic feet moved. Holding
constant the effect of the number of cubic feet moved, 39.27% of the
variation in labor hours can be explained by variation in the number of
pieces of large furniture.

14.70 (a) , where
value and since assessment. (b) Holding constant the

time period, for each additional thousand dollars of assessed value, the
selling price is estimated to increase by 1.7506 thousand dollars. Holding
constant the assessed value, for each additional month since assessment,
the selling price is estimated to increase by 0.3680 thousand dollars.
(c)
thousand dollars. (d) Based on a residual analysis, the model appears to be
adequate. (e) the p-value is virtually 0. Because

reject There is evidence of a significant relationship
between selling price and the two independent variables (assessed value and
time since assessment). (f) The p-value is virtually 0. The probability of
obtaining a test statistic of 223.46 or greater is virtually 0 if there is no
significant relationship between selling price and the two independent
variables (assessed value and time since assessment). (g)
94.30% of the variation in selling price can be explained by variation in
assessed value and time since assessment. (h) (i) For

the p-value is virtually 0. Reject The assessed
value makes a significant contribution and should be included in the model.
For Reject The time
since assessment makes a significant contribution and should be included
in the model. Based on these results, the regression model with the two
independent variables should be used. (j) For the
p-value is virtually 0. The probability of obtaining a sample that will
yield a test statistic farther away than 20.4137 is virtually 0 if the
assessed value does not make a significant contribution, holding time since
assessment constant. For the p-value is virtually 0. The
probability of obtaining a sample that will yield a test statistic farther away
than 2.8734 is virtually 0 if the time since assessment does not make a

X2: tSTAT = 2.8734,

X1: tSTAT = 20.4137,

H0.X2: tSTAT = 2.8734, p-value = 0.0078 6 0.05.

H0.X1: tSTAT = 20.4137,
r2

adj = 0.9388.

r2 = 0.9430.

H0.p-value 6 0.05,
FSTAT = 223.46,

1.750611702 + 0.36801122 = 181.9692YN = -120.0483 +

X2 = timeassessed
X1 =YN = -120.0483 + 1.7506X1 + 0.3680X2

r2
Y2.1 = 0.3927.

r2
Y1.2 = 0.5930.

0.0226 … b1 … 0.0413.

X2: tSTAT = 4.6192,

X1: tSTAT = 6.9339,

H0.X2: tSTAT = 4.6192,

H0.
X1: tSTAT = 6.9339,r2

adj = 0.9287.

r2 = 0.9327.93.27%
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significant contribution holding the effect of the assessed value constant.
(k) You are 95% confident that the selling price
will increase by an amount somewhere between $1.5746 thousand and
$1.9266 thousand for each additional thousand-dollar increase in assessed
value, holding constant the time since assessment. In Problem 13.76, you
are 95% confident that the selling price will increase by an amount
somewhere between $1.5862 thousand and $1.9773 thousand for each
additional thousand-dollar increase in assessed value, regardless of the time
since assessment. (l) Holding constant the effect of the
time since assessment, 93.92% of the variation in selling price can be
explained by variation in the assessed value. Holding
constant the effect of the assessed value, 23.42% of the variation in selling
price can be explained by variation in the time since assessment.

14.72 (a) , where and
(b) Holding age constant, for each additional thousand square

feet, the assessed value is estimated to increase by $10.7252 thousand.
Holding size constant, for each additional year, the assessed value is
estimated to decrease by $0.2843 thousand. (c)

thousand dollars. (d) Based
on a residual analysis, the errors appear to be normally distributed.
The equal-variance assumption appears to be valid. There might be a
violation of the linearity assumption for age. You might want to include a
quadratic term in the model for age. (e)

Because reject There is
evidence of a significant relationship between assessed value and the two
independent variables (size and age). (f) The
probability of obtaining an test statistic of 28.58 or greater is
virtually 0 if there is no significant relationship between assessed value
and the two independent variables (size and age). (g)
82.65% of the variation in assessed value can be explained by variation
in size and age. (h) (i) For

Reject The size of a house makes a significant
contribution and should be included in the model. For

Reject The age of a house makes a
significant contribution and should be included in the model. Based on
these results, the regression model with the two independent variables
should be used. (j) For The probability of
obtaining a sample that will yield a test statistic farther away than 3.5581
is 0.0039 if the size of a house does not make a significant contribution,
holding age constant. For The probability of
obtaining a sample that will yield a test statistic farther away than
is 0.0053 if the age of a house does not make a significant contribution,
holding the effect of the size constant. (k)
You are 95% confident that the mean assessed value will increase by an
amount somewhere between $4.1575 thousand and $17.2928 thousand
for each additional thousand-square-foot increase in the size of a house,
holding constant the age. In Problem 13.77, you are 95% confident that
the mean assessed value will increase by an amount somewhere between
$9.4695 thousand and $23.7972 thousand for each additional thousand-
square-foot increase in heating area, regardless of the age. (l)
Holding constant the effect of age, 51.34% of the variation in assessed
value can be explained by variation in the size. Holding
constant the effect of the size, 49.07% of the variation in assessed value
can be explained by variation in the age. (m) Based on your answers to
(b) through (l), the age of a house does have an effect on its assessed
value.

14.74 (a) , where
and (b) Holding constant the
effect of the league, for each additional ERA, the number of wins is
estimated to decrease by 19.2757. For a given ERA, a team in the National
League is estimated to have 6.6882 fewer wins than a team in the
American League. (c) 80.9484 wins. (d) Based on a residual analysis, the

X2 = league (American = 0 National = 1)
X1 = ERAYN = 167.6892 - 19.2757X1 - 6.6882X2

r2
Y2.1 = 0.4907.

r2
Y1.2 = 0.5134.

4.1572 … b1 … 17.2928.

-3.4002
X2: p-value = 0.0053.

X1: p-value = 0.0039.

H0.p-value = 0.0053 6 0.05.
X2: tSTAT = -3.4002,

H0.0.0039 6 0.05.
X1: tSTAT = 3.5581, p-value =r2

adj = 0.7976.

r2 = 0.8265.

FSTAT

p-value = 0.0000272776.

H0.p-value = 0.0000 6 0.05,0.0000272776.
FSTAT = 28.58, p-value =

10.725211.752 - 0.28431102 = 179.7017
YN = 163.7751 +

X2 = age.
X1 = sizeYN = 163.7751 + 10.7252X1 - 0.2843X2

r2
Y2.1 = 0.2342.

r2
Y1.2 = 0.9392.

1.5746 … b1 … 1.9266.
errors appear to be somewhat right skewed. There is no apparent violation
of other assumptions. (e)
Because reject There is evidence of a significant
relationship between wins and the two independent variables (ERA and
league). (f) For the p-value is virtually
0. Reject ERA makes a significant contribution and should be
included in the model. For

Do not reject The league does not make
a significant contribution and should not be included in the model.
Based on these results, the regression model with only the ERA as the
independent variable should be used. (g)
(h) (i) 44.77% of the variation
in wins can be explained by the variation in ERA and league after
adjusting for number of independent variables and sample size.
(j) Holding constant the effect of league, 48.30% of the
variation in number of wins can be explained by the variation in ERA.

Holding constant the effect of ERA, 13.47% of the
variation in number of wins can be explained by the variation in league.
(k) The slope of the number of wins with ERA is the same, regardless
of whether the team belongs to the American League or the National League.
(l) For the p-value is
Do not reject There is no evidence that the interaction term makes a
contribution to the model. (m) The model with one independent variable
(ERA) should be used.

14.76 The of the multiple regression is very low, at 0.0645. Only 6.45%
of the variation in thickness can be explained by the variation of pressure
and temperature. The F test statistic for the combined significant of
pressure and temperature is 1.621, with Hence, at a
5% level of significance, there is not enough evidence to conclude that
both pressure and temperature affect thickness. The p-value of the t test
for the significance of pressure is Hence, there is
insufficient evidence to conclude that pressure affects thickness, holding
constant the effect of temperature. The p-value of the t test for the
significance of temperature is 0.0820, which is also There is 
insufficient evidence to conclude that temperature affects thickness at the
5% level of significance, holding constant the effect of pressure. Hence,
neither pressure nor temperature affects thickness individually.

The normal probability plot does not suggest any potential violation
of the normality assumption. The residual plots do not indicate potential
violation of the equal variance assumption. The temperature residual plot,
however, suggests that there might be a nonlinear relationship between
temperature and thickness.

The of the multiple regression model is very low, at 0.0734. Only
7.34% of the variation in thickness can be explained by the variation of
pressure, temperature, and the interaction of the two. The F test statistic
for the model that includes pressure and temperature is 1.214, with a 
p-value of 0.3153. Hence, at a 5% level of significance, there is
insufficient evidence to conclude that pressure, temperature, and the
interaction of the two affect thickness. The p-value of the t test for the
significance of pressure, temperature, and the interaction term are 0.5074,
0.4053, and 0.5111, respectively, which are all greater than 5%. Hence,
there is insufficient evidence to conclude that pressure, temperature, or
the interaction individually affects thickness, holding constant the effect
of the other variables.

The pattern in the normal probability plot and residual plots is
similar to that in the regression without the interaction term. Hence the
article’s suggestion that there is a significant interaction between the
pressure and the temperature in the tank cannot be validated.

CHAPTER 15
15.2 (a) Predicted HOCS is 2.8600, 3.0342, 3.1948, 3.3418, 3.4752,
3.5950, 3.7012, 3.7938, 3.8728, 3.9382, 3.99, 4.0282, 4.0528, 4.0638,

r2

7 0.05.

0.8307 7 0.05.

p-value = 0.2085.

r2

H0.
0.5685 7 0.05.X1X2: tSTAT = 0.5777 6 2.0555

r2
Y2.1 = 0.1347.

r2
Y1.2 = 0.4830.

r2
adj = 0.4477.-13.3818 … b2 … 0.0054.

-27.1512 … b1 … -11.4002.

H0.p-value = 0.0502 7 0.05.
X2: tSTAT = -2.0502 7 -2.0518,

H0.
X1: tSTAT = -5.0220 6 -2.0518,

H0.p-value 6 0.05,
FSTAT = 12.7547 7 3.35, p-value = 0.0001.
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4.0612, 4.045, 4.0152, 3.9718, 3.9148, 3.8442, and 3.76. (c) The
curvilinear relationship suggests that HOCS increases at a decreasing
rate. It reaches its maximum value of 4.0638 at and declines
after that as GPA continues to increase. (d) An of 0.07 and an adjusted

of 0.06 tell you that GPA has very low explanatory power in identifying
the variation in HOCS. You can tell that the individual HOCS scores are
scattered widely around the curvilinear relationship.

15.4 (a) where

and (b)
, where and

(c) so reject At the 5% level
of significance, the quadratic terms are significant together. Hence, the
model in (b) is better. and the p-value is virtually 0.
Reject . There is enough evidence that the quadratic term for alcohol
% is significant at the 5% level of significance.

Do not reject There is insufficient evidence
that the quadratic term for carbohydrates is significant at the 5%
level of significance. The normal probability plot suggests some left-
skewness in the errors. However, because of the large sample size, the
validity of the results is not seriously impacted. The residual plots of the
alcohol percentage and carbohydrates in the quadratic model do not
reveal any remaining nonlinearity. (d) The number of calories in a
beer depends quadratically on the alcohol percentage but linearly on
the number of carbohydrates. The alcohol percentage and number
of carbohydrates explain about 97.68% of the variation in the 
number of calories in a beer.

15.6 (b) Predicted
(c) Predicted
pounds. (d) The model appears to be adequate. (e)

reject (f) so the model is signifi-
cant. (g) reject . There is a significant
quadratic effect. (h) so the quadratic term
is significant. (i) 97.2% of the variation in yield can be explained by the
quadratic model. (j) 96.6%.

15.8 (a) 215.37. (b) For each additional unit of the logarithm of the
logarithm of Y is estimated to increase by 0.9 units, holding all other
variables constant. For each additional unit of the logarithm of the
logarithm of Y is estimated to increase by 1.41 units, holding all other
variables constant.

15.10 (a) , where
and (b) The normal probability plot

suggests that the errors are normally distributed. The residual plots of the
square-root transformation of alcohol percentage and carbohydrates do
not reveal any remaining nonlinearity. (c) Because
the p-value is virtually 0, reject at the 5% level of significance. There
is evidence of a significant linear relationship between calories and the
square root of the percentage of alcohol and the square root of the number
of carbohydrates. (d) So 93.47% of the variation in calories
can be explained by the variation in the square root of the percentage of
alcohol and the square root of the number of carbohydrates. (e) Adjusted

(f) The model in Problem 15.4 is slightly better because it
has a higher .

15.12 (a) Predicted (b) 32.95
pounds. (c) A quadratic pattern exists, so the model is not adequate. 
(d) reject (e) 78.9%. (f) 76.8%. (g) Choose
the model from Problem 15.6. That model has a much higher adjusted 
of 96.6%.

15.14 1.25.

15.16 R2
1 = 0.64, VIF1 =

1
1 - 0.64

= 2.778, R2
2 = 0.64,

r2
H0.tSTAT = 6.11 7 2.2281;

ln(Yield) = 2.475 + 0.0185 AmtFert.

r2
r2 = 0.9347.

r2 = 0.9357.

H0

FSTAT = 988.7901.

X2 = carbohydrates.X1 = alcohol %
YN = -146.4770 + 90.15921X1 + 28.3833 1X2

X2,

X1,

p-value = 0.002 6 0.05,
H0tSTAT = -4.27 6 -2.2622;

p-value = 0.0000 6 0.05,H0.4.26;
FSTAT = 157.32 7

yield = 6.643 + 0.895(70) - 0.00411(70)2 = 49.168
yield = 6.643 + 0.895 AmtFert - 0.00411 AmtFert2.

H0.p-value = 0.1197.
tSTAT = -1.5659,

H0

tSTAT = 3.8904,

H0.6 0.05,p-value = 0.0007FSTAT = 7.7018
X2 = carbohydrates.X1 = alcohol %0.6237 X 2

1 - 0.0229 X 2
2

YN = 13.0505 + 13.4035X1 + 4.7205X2 +X2 = carbohydrates.

X1 = alcohol %YN = -4.5056 + 20.9262X1 + 4.1052X2

r2
r2
GPA = 3.3

There is no evidence of collinearity.

15.18 There is no evidence of collinearity.

15.20 There is no evidence of collinearity.

15.22 (a) 35.04. (b) This does not meet the criterion for
consideration of a good model.

15.24 Let since
assessment, and house was Based
on a full regression model involving all of the variables, all the VIF values
(1.32, 1.04, and 1.31, respectively) are less than 5. There is no reason to
suspect the existence of collinearity. Based on a best-subsets regression
and examination of the resulting values, the best models appear to be a
model with variables and which has and the full
regression model, which has Based on a regression analysis
with all the original variables, variable fails to make a significant
contribution to the model at the 0.05 level. Thus, the best model is the
model using the assessed value and time since assessment 
as the independent variables. A residual analysis shows no strong
patterns. The final model is 

Overall significance of the 
model: Each independent variable is
significant at the 0.05 level.

15.30 (a) An analysis of the linear regression model with all of the 
six possible independent variables does not reveals any variables with

A best-subsets regression produces numerous models that
have values less than or equal to The model that includes 
points scored and points allowed can be selected since it is simpler and
has adjusted r2 similar to the other models. The best linear model is
determined to be

The overall model has (2 and 27 degrees of freedom)
with a p-value that is virtually 0. A residual
analysis does not reveal any strong patterns. The errors appears to be
normally distributed. (b) An analysis of the linear regression model with
all of the possible independent variables reveals that point difference has
a VIF value in excess of 5.0. A best-subsets regression reveals that only
the regression model with field goal % difference, steal % difference, and
rebound % difference has a value less than or equal to . Analysis
of the p-value of the slope coefficients for the rebound difference reveals
that it is not significant Dropping rebound % difference,
the best linear model is determined to be

The normal probability plot reveals some
left-skewness in the residuals. The residual plot does not reveal any strong
patterns. (c) The model in (a) with a higher adjusted of 0.9485 is better
than that in (b) in predicting the number of wins.

15.32 (a) Best model: predicted appraised 
(b) The adjusted for the

best model in 15.32(a), 15.33(a), and 15.34(a) are, respectively, 0.81,
0.8117 and 0.8383. The model in 15.34(a) has the highest explanatory
power after adjusting for the number of independent variables and
sample size.

15.34 (a) Predicted appraised house size 
(sq ft). (b) The adjusted for the best model in 15.32(a), 15.33(a), and
15.34(a) are, respectively, 0.81, 0.8117 and 0.8383. The model in 15.34(a)
has the highest explanatory power after adjusting for the number of
independent variables and sample size.

r2
value = 110.27 + 0.0821

r2land + 0.1288 house size (sq ft) - 1.3989 age.
value = 136.794 + 276.0876

r2

r2 = 0.7442, r2
adj = 0.7253.

YN = 40.9108 + 4.408X1 + 3.0381X2.

(0.0609 7 .05).

k + 1Cp

r2
adj = 0.9485.r2 = 0.9521,

F = 268.0845

YN = 46.6301 + 2.7402X1 + -2.7969 X2

k + 1.Cp

VIF 7 5.0.

FSTAT = 223.4575, p 6 0.001.
0.3680X2, r2 = 0.9430, r2

adj = 0.9388.
YN = -120.0483 + 1.7506X1 +

(X2)(X1)

X3

Cp = 4.0.
Cp = 2.84,X2,X1

Cp

new (0 = no, 1 = yes).X3 = whether
Y = selling price, X1 = assessed value, X2 = time

Cp 7 3.

VIF = 1.0428.

VIF = 1.0 6 5.

VIF2 =
1

1 - 0.64
= 2.778.
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15.36 Let appraised value, land area, interior,
age, number of rooms, number of bathrooms, 
garage size, if Glen Cove and 0 otherwise, and if
Roslyn and 0 otherwise. (a) All VIFs are less than 5 in a full regression
model involving all the variables: There is no reason to suspect
collinearity between any pair of variables. The following is the
multiple regression model that has the smallest and the highest
adjusted

The individual t test for the significance of each independent variable at
the 5% level of significance concludes that only and are
significant individually. This subset, however, is not chosen when the 
criterion is used. The following is the multiple regression result for the
model chosen by stepwise regression:

This model has a value of 7.7 and an adjusted of 89.0. All the
variables are significant individually at the 5% level of significance.
Combining the stepwise regression and the best-subsets regression results
along with the individual t-test results, the most appropriate multiple
regression model for predicting the appraised value is

(b) The estimated appraised value in Glen Cove is 57.74 thousand dollars
above Freeport for two otherwise identical properties. The estimated
appraised value in Roslyn is 213.46 thousand dollars above Freeport for
two otherwise identical properties.

15.38 In the multiple regression model with catalyst, pH, pressure,
temperature, and voltage as independent variables, none of the variables
has a VIF value of 5 or larger. The best-subsets approach showed that only
the model containing and should be considered, where

and
Looking at the p-values of the t statistics for each slope coefficient of the
model that includes through reveals that pH level is not significant
at the 5% level of significance The multiple
regression model with pH level deleted shows that all coefficients are
significant individually at the 5% level of significance. The best linear model
is determined to be

The overall model has (4 and 45 degrees of
freedom), with a p-value that is virtually 0. 
The normal probability plot does not suggest possible violation of the
normality assumption. A residual analysis reveals a potential nonlinear
relationship in temperature. The p-value of the squared term for
temperature (0.1273) in the following quadratic transformation of
temperature does not support the need for a quadratic transformation at
the 5% level of significance. The p-value of the interaction term between
pressure and temperature (0.0780) indicates that there is not enough
evidence of an interaction at the 5% level of significance. The best model
is the one that includes catalyst, pressure, temperature, and voltage which
explains 87.26% of the variation in thickness.

CHAPTER 16
16.2 (a) 1959. (b) The first four years and the last four years.

16.4 (b)–(d)

r2 = 0.8726, r2
adj = 0.8613.

F = 77.07930.4288X5.
YN = 3.6833 + 0.1548X1 - 0.04197X3 - 0.4036X4 +

(p-value = 0.2862).
X5X1

X5 = voltage.X1 = catalyst, X2 = pH, X3 = pressure, X4 = temp,
X5X1, X2, X3, X4,

+ 26.38X5 + 57.74X7 + 213.46X8

YN = 23.40 + 347.02X1 + 0.10614X2 - 0.7921X3

r2Cp

+ 213 Roslyn

- 0.792 Age + 26.4 Baths + 57.7 Glen Cove

Appraised Value = 23.4 + 347 Land + 0.106 House Size

Cp

X8X1, X2, X5, X7,

+ 5.0 Garage + 56.4 Glen Cove + 210 Roslyn

- 0.585 Age - 8.24 Rooms + 26.9 Baths

Appraised Value = 49.4 + 343 Land + 0.115 House Size

r2 (0.891):
Cp (9.0)

X8 = 1X7 = 1
X6 =X5 =X4 =

X3 =X2 =X1 =Y =

(e) A smoothing coefficient of smoothes out the attendance
more than The exponential smoothing with assigns
more weight to the more recent values and is better for forecasting, while
the exponential smoothing with which assigns more weight to
more distant values, is better suited for eliminating unwanted cyclical and
irregular variations.

16.6 (b), (c), (e)

W = 0.25,

W = 0.50W = 0.50.
W = 0.25

Year Attendance MA(3) ES(W � 0.5) ES(W � 0.25)

2001 1.44 1.4400 1.4400
2002 1.60 1.5200 1.5200 1.4800
2003 1.52 1.5333 1.5200 1.4900
2004 1.48 1.4600 1.5000 1.4875
2005 1.38 1.4200 1.4400 1.4606
2006 1.40 1.3933 1.4200 1.4455
2007 1.40 1.3867 1.4100 1.4341
2008 1.36 1.3933 1.3850 1.4156
2009 1.42 1.4025 1.4167

Decade Performance(%) MA(3) ES(W � 0.5) ES(W � 0.25)

1830s 2.8 2.8000 2.8000
1840s 12.8 7.4000 7.8000 5.3000
1850s 6.6 10.6333 7.2000 5.6250
1860s 12.5 8.8667 9.8500 7.3438
1870s 7.5 8.6667 8.6750 7.3828
1880s 6.0 6.3333 7.3375 7.0371
1890s 5.5 7.4667 6.4188 6.6528
1900s 10.9 6.2000 8.6594 7.7146
1910s 2.2 8.8000 5.4297 6.3360
1920s 13.3 4.4333 9.3648 8.0770
1930s 2.2- 6.9000 3.5824 5.5077
1940s 9.6 8.5333 6.5912 6.5308
1950s 18.2 12.0333 12.3956 9.4481
1960s 8.3 11.0333 10.3478 9.1611
1970s 6.6 10.5000 8.4739 8.5208
1980s 16.6 13.6000 12.5370 10.5406
1990s 17.6 11.2333 15.0685 12.3055
2000s 0.5- 7.2842 9.1041

(d) (e) (f) The exponen-
tially smoothed forecast for 2010 with is lower than that with

The exponential smoothing with assigns more
weight to the more recent values and is better for forecasting, while the
exponential smoothing with which assigns more weight to
more distanct values is better suited for eliminating unwanted cyclical and
irregular variations. (g) According to the exponential smoothing with

there appears to be a general upward trend in the performance
of the stocks in the past.

16.8 (b),(c),(e)

W = 0.25,

W = 0.25

W = 0.5W = 0.25.
W = 0.5

YN2010 = E2000 = 9.1041.YN2010 = E2000 = 7.2842

Year Audits MA(3) ES(W � 0.5) ES(W � 0.25)

2001 3,305 3,305.0000 3,305.0000
2002 3,749 3,461.3333 3,527.0000 3,416.0000
2003 3,330 3,821.6667 3,428.5000 3,394.5000
2004 4,386 4,191.6667 3,907.2500 3,642.3750
2005 4,859 4,507.0000 4,383.1250 3,946.5313
2006 4,276 4,186.3333 4,329.5625 4,028.8984
2007 3,424 3,784.6667 3,876.7813 3,877.6738
2008 3,654 3,616.3333 3,765.3906 3,821.7554
2009 3,771 3,768.1953 3,809.0665
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(d) (e) (f) The
exponentially smoothed forecast for 2010 with is lower than that
with The exponential smoothing with assigns more
weight to the more recent values and is better for forecasting, while the
exponential smoothing with which assigns more weight to
more distance values is better suited for eliminating unwanted cyclical
and irregular variations.

16.10 (a) The Y intercept is the fitted trend value reflecting the
real total revenues (in millions of dollars) during the origin, or base year,
1989. (b) The slope indicates that the real total revenues are
increasing at an estimated rate of $1.5 million per year. (c) Year is 1993,

million dollars. 

(d) Year is 2010, 
million dollars. (e) Year is 2013, 

million dollars.

16.12 (b) Linear trend: where X is relative
to 1993. (c) Quadratic trend: , where
X is relative to 1993. (d) Exponential trend: where
X is relative to 1993. (e) Linear trend:

Quadratic trend: 

Exponential trend:

(f) The quadratic trend model fits the data better
and, hence, of the models fit, its forecast should be used.

16.14 (b) , where relative to 
1978. (c)

billion,
(d) There is an upward trend in federal

receipts between 1978 and 2009. The trend appears to be nonlinear.
A quadratic trend or an exponential trend model could be explored.

16.16 (b) Linear trend: , where X is relative to
2000. (c) Quadratic trend: , where
X is relative to 2000. (d) Exponential trend: ,
where X is relative to 2000. (e) Linear trend:

megawatts,
megawatts. Quadratic trend: 

megawatts,
megawatts. Exponential trend:

megawatts, megawatts.

16.18 (b) Linear trend: , where X is relative to
2000. (c) Quadratic trend: , where
X is relative to 2000. (d) Exponential trend: ,
where X is relative to 2000. (e) Investigating the first, second, and
percentage differences suggests that the linear and quadratic trend models
have the best fit. (f) Using the linear trend model,

Using the quadratic trend model, 

Using the

exponential trend model, millionsYN2011 = 100.3270+0.0201(11) = $3.5339

0.00057(11)2 = $3,4306 millions.2.0819 + 0.1289(11) -
YN2011 =(11) = $3.4455 millions.

YN2011 = 2.0905 + 0.1232

log10YN = 0.3270 + 0.0201X
YN = 2.0819 + 0.1289X - 0.00057X 2

YN = -2.0905 + 0.1232X

YN2010 = 101.3220+0.1403(10) = 530.5360384.1023
YN2009 = 101.3220+0.1403(9) =(10)2 = 375.3381

YN2010 = 23.1152 + 0.8608(10) + 3.4361(9)2 = 309.1905
YN2009 = 23.1152 + 0.8608(9) + 3.4361

YN2010 = -8.9556 + 28.35(10) = 274.5444246.1944
YN2009 = -8.9556 + 28.35(9) =

log10YN = 1.3220 + 0.1403X
YN = 23.1152 + 0.8608X + 3.4361X 2

YN = -8.9556 + 28.35X

(33) = $2,597.2487 billion.
X = 2011 - 1978 = 33, YN = 257.1858 + 70.9110$2,526.3377

YN = 257.1858 + 70.9110 (32) =X = 2010 - 1978 = 32,
X = yearsYN = 257.1858 + 70.9110X

= 2,602.1172 = 2,602
YN2012 = 101.6704+0.091811922,106,YN2011 = 101.6704+0.09181182 = 2,106.1491 =

1,423.(19) + 2.8231(19)2 = 1,422.9978 =
21.3111YN2012 = -1.0439 ++ 2.8231(18)2 = 1,297.2328 = 1,297,

YN2011 = -1.0439 + 21.3111 11821,187.7413 = 1,188.
YN2012 = -129.0234 + 69.3034(19) == 1,118.4379 = 1,118,

YN2011 = -129.0234 + 69.3034(18)
YN = 1.6704 + 0.0918X,log10

YN = -1.0439 + 21.3111X + 2.8231X 2
YN = -129.0234 + 69.3034 X,

YN23 = 4.0 + 1.5(24) = 40

X = 2012 - 1988 = 24,
YN20 = 4.0 + 1.5(21) = 35.5X = 2009 - 1988 = 21,

YN5 = 4.0 + 1.5(4) = 10.0X = 1992 - 1988 = 4,

b1 = 1.5

b0 = 4.0

W = 0.25

W = 0.5W = 0.25.
W = 0.5

YN2010 = E2009 = 3,809.0665YN2010 = E2009 = 3,768.1953 16.22 (a) For Time Series I, the graph of Y vs. X appears to be more
linear than the graph of log Y vs. X, so a linear model appears to be more
appropriate. For Time Series II, the graph of log Y vs. X appears to be
more linear than the graph of Y vs. X, so an exponential model appears to
be more appropriate. (b) Time Series I: where

relative to 1999. Time Series II: where
relative to 1999. (c) Forecasts for 2009: Time Series I:

249.834; Time Series II: 403.709.

16.24 reject

16.26 (a) do not reject 

16.28 (a) Because level of significance, the
third-order term can be dropped (b) Because the p-value is virtually 0 and
is less than the 0.05 level of significance, the second-order term cannot be
dropped. (c) It is not necessary to fit a first-order regression. (d) The most
appropriate model for forecasting is the second-order autoregressive model:

stores.
stores.

16.30 (a) Because level of significance, the
third-order term can be dropped. (b) Because
level of significance, the second-order term can be dropped. (c) Because
the p-value is virtually 0, the first-order term cannot be dropped. (d) The
most appropriate model for forecasting is the first-order autoregressive
model:

16.32 (a) 2.121. (b) 1.50.

16.34 (c) (d) The residuals in the linear trend model
show strings of consecutive positive and negative values. The linear trend
model is inadequate in capturing the nonlinear trend.

16.36 (b), (c)

MAD = 439.8557.

YN2011 = 0.4419 + 0.8815Y2010 = $3.3246 millions.

p-value = 0.3971 7 0.05
p-value = 0.8237 7 0.05

1,197
1,196.8472 =YN2012 = 14.2403 + 1.9498Y2011 - 0.9696YN2010 =

YN2011 = 14.2403 + 1.9498Y2010 - 0.9696Y2009 = 1,153.5399 = 1,154

p-value = 0.8566 7 0.05

H0.tSTAT = 1.60 6 2.2281;

H0.tSTAT = 2.40 7 2.2281;

X = years
YN = 99.704(1.1501)X,X = years

YN = 100.082 + 14.9752X,

Linear Quadratic Exponential AR2

SSE 110,671.8438 28,296.3123 578,885.304 2,142.5328

SYX 83.1684 43.4329 190.2113 12.8378

MAD 66.1130 35.3306 102.0806 8.4826

Linear Quadratic Exponential AR1

SSE 0.0571 6.4530 0.0670 0.0918

SYX 0.0797 0.8981 0.0863 0.1071

MAD 0.0645 0.6611 0.0675 0.07526

(d) The residuals in the three trend models show strings of consecutive
positive and negative values. The autoregressive model performs well
for the historical data and has a fairly random pattern of residuals. The
autoregressive model also has the smallest values in MAD and . Based
on the principle of parsimony, the autoregressive model would be the best
model for forecasting.

16.38 (b), (c)

SYX

(d) The residuals in the linear, quadratic and exponential trend models
show strings of consecutive positive and negative values. The
autoregressive model perform well for the historical data and have a fairly
random pattern of residuals. The linear trend model, however, has the
smallest values in MAD and . The autoregressive model would be the
best model for forecasting due to its fairly random pattern of residuals
even though it has slightly larger MAD and than the linear model.

16.40 (a) This is the fitted value for 
January 2005 prior to adjustment with the January multiplier.
(b) The estimated monthlylog bN1 = 0.01, bN1 = 100.01 = 1.0233.

log bN0 = 2, bN0 = 102 = 100.

SYX

SYX

16.20 (b) There has been an upward trend in the CPI in the United States
over the 45-year period. The rate of increase became faster in the late
1970s but tapered off in the early 1980s. (c) Linear trend:

. (d) Quadratic trend: .
(e) Exponential trend: . (f) The quadratic
trend appears to be a better model, according to the narrow spread of the
second differences. (g) Quadratic trend: For 2010: 

For 2011: 
3.9668(46) + 0.0116(46)2 = 227.2308.

YN2011 = 20.1201 +3.9668(458) + 0.0116(45)2 = 222.2044.
YN2010 = 20.1201 +

log10YN = 1.5480 + 0.0200X
YN = 20.1201 + 3.9668X + 0.0116X 24.4791X

YN = 16.4483 +
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is relative to 1975. (d) Exponential trend: ,

where X is relative to 1975. (e) AR(3):
. Test of Do

not reject that Third-order term can be deleted. AR(2):

. Test of
Do not reject that Second-order term can

be deleted. AR(1): . Test of p-value is
virtually 0. Reject that A first-order autoregressive model is
appropriate. (f) The residuals in the first three models show strings of
consecutive positive and negative values. The autoregressive model has a
fairly random pattern of residuals.
(g)

A1 = 0.H0

A1:YNi = 0.3455 + 1.0325Yi-1

A2 = 0.H00.05001 7 0.05.
A2: p-value =YNi = 0.2610 + 1.5418Yi-1 - 0.5393Yi-2

A3 = 0.H0

A3: p-value = 0.0641 7 0.05.1.0741Yi-2 + 0.5517Yi-3

YNi = 0.3441 + 1.5575Yi-1 -
log10YN = 0.1549 + 0.0391Xcompound growth rate is 2.33%. (c)

The January values in the time series are estimated to have a mean 25.89%
higher than the December values.

16.42 (a) This is the fitted value for
the first quarter of 2005 prior to adjustment by the quarterly multiplier.
(b) The estimated quarterly com-

pound growth rate is . (c)

16.44 (a) The retail industry is heavily subject to seasonal variation due to the
holiday season, and so are the revenues for Toys R Us. (b) There is an obvious
seasonal effect in the time series. (c)

(d)
The estimated quarterly compound growth rate is

(e)
The first-quarter values in the

time series are estimated to be 57.04% below the fourth-quarter values.

The second-quarter values in the time series are estimated to be
57.49% below the fourth-quarter values.

The third-quarter
values in the time series are estimated to be 54.77% below the fourth-
quarter values. (f) Forecasts for 2009: 

16.46 (b)

(c) . (d) Forecasts for the last four months of 2009 are
September: 0.4306, October: 0.4173, November: 0.4084, December: 0.4001.
(e) The estimated

monthly compound growth rate is 

(f)
The July values in the time series are estimated to be

28.8457% above the December values.

16.48 (b)

(c)

The estimated quarterly compound growth
rate in the price of silver is 4.4359%, after adjusting for the seasonal
component. (d)

13.7344%. The first-quarter values in the time series
are estimated to have a mean 13.7344% above the fourth-quarter values.
(e) Last quarter, 2009: (f) 2010: First quarter: 20.7473
second quarter: 19.3860, third quarter: 20.1937, fourth quarter: 20.7787.
(g) The forecasts in (f) were not accurate because the price of silver
experienced a drastic decline in 2010, and the exponential trend model
was not very good at picking up this drastic decline.

16.60 (b) Linear trend: , where X is

relative to 1984. (c)

(d) Linear trend: , where X is relative

to 1984.(c)

16.62 (b) Linear trend: , where X is relative to
1975. (c) Quadratic trend: , where XYN = 1.3011 + 0.0661X + 0.0178X 2

YN = -2.0352 + 0.6727X

thousands
2010: YN2010 = 114,542.0985 + 1,673.71851262 = 158,058.7785thousands,

2009: YN2009 = 114,542.0985 + 1,673.71851252 = 156,385.06

YN = 114,542.0985 + 1673.7185X

236,864.2108 thousands

2010: YN2010 = 174,246.8308 + 2,408.36081262 =234,455.85 thousands,

2009: YN2009 = 174,246.8308 + 2,408.36081252 =
YN = 174,246.8308 + 2,408.3608X

YN23 = 17.4670.

 (bN 2 - 1) 100% =
1.1373;100.0559 =log10 bN 2 = 0.0559; bN 2 =

(bN 1 - 1)100% = 4.4359%.

0.8087 bN 1 = 100.8087 = 1.0444;log10 bN1 =0.0076 Q2 - 0.0064 Q3.

 Q1 +0.0188 coded quarter - 0.0559log YN = 0.8087 +

28.8457%.
= 0.1101; bN 8 = 100.1101 = 1.2885. (bN 8 - 1) 100% =log10 bN 8

(bN1 - 1) 100% = -0.8775%.

-0.0038; bN 1 = 10-0.0038 = 0.9912.log10 bN 1 =

YN79 = 0.5069
 M10 + 0.0051 M11. M8 + 0.0204 M9 + 0.01060.1101 M7 + 0.0874

 M3 + 0.0761 M4 + 0.0795 M5 + 0.1084 M6 -0.0794 M2 + 0.1008
 coded month - 0.1067 M1 +log YN = 0.0801 - 0.0038

$6,084.0383 millions.
YN54 = $2,551.4693 millions; YN55 = $2,733.2744 millions; YN56 =

YN53 = $2,560.7240 millions;

bN = 10-0.3445 = 0.4523. 1bN4 - 12 100% = 54.77%.

log10 b
N

4 = -0.3445.
57.49%.
log10 b

N

3 = -0.3715. bN3 = 10-0.3715 = 0.4251. 1bN3 - 12 100% =

0.4296. 1bN2 - 12 100% = -57.0391%.
log10 b

N

2 = -0.3669. bN2 = 10-0.3669 =1bN1 - 12100% = 0.69%.
100.0030 = 1.0069.

log10 b
N

1 = 0.0030. bN1 =-  0.3669Q1 - 0.3715Q2 - 0.3445Q3.

log10YN = 3.6210 + 0.0030X

100.2 = 1.5849.bN3 =
logbN3 = 0.2,1bN1 - 12100% = 25.89%

log bN1 = 0.1, bN1 = 100.1 = 1.2589.

log bN0 = 3.0, bN0 = 103.0 = 1,000.

log bN2 = 0.1, bN2 = 100.1 = 1.2589.

Linear Quadratic Exponential
First-Order

Aotoregressive

SSE 100.2117 7.7125 107.3081 8.1811
SYX 1.7426 0.4909 1.8033 0.5056
MAD 1.4587 0.3309 1.0215 0.3221

(h) The residuals in the first three models show strings of consecutive
positive and negative values. The autoregressive model performs well for
the historical data and has a fairly random pattern of residuals. It also has
the smallest values in the standard error of the estimate, MAD, and SSE.
Based on the principle of parsimony, the autoregressive model would
probably be the best model for forecasting. (i)

billions.

CHAPTER 17
17.2 (a) Day 4, Day 3. (b) . (c) No,
proportions are within control limits.

17.4 (a) .

(b) Because the individual points are distributed around without any
pattern and all the points are within the control limits, the process is in a
state of statistical control.

17.6 (a) . The proportion of unacceptable
cans is below the LCL on Day 4. There is evidence of a pattern over time
because the last eight points are all above the mean, and most of the earlier
points are below the mean. Therefore, this process is out of control.

17.8 (a) . Days 9, 26, and 30 are above
the UCL. Therefore, this process is out of control.

17.12 (a) (b) Yes, time 1 is above the
UCL.

17.14 (a) The 12 errors committed by Gina appear to be much higher
than all others, and Gina would need to explain her performance.

UCL = 21.6735, LCL = 1.3265.

UCL = 0.1431, LCL = 0.0752

UCL = 0.0176, LCL = 0.0082

p

= 0.0476 - 3A0.047611 - 0.04762
500

= 0.0190

LCL = p - 3Ap11 - p2
n

= 0.0476 + 3A0.047611 - 0.04762
500

= 0.0761

UCL = p + 3Ap11 - p2
n

n = 500, p = 761>16,000 = 0.0476

LCL = 0.0397, UCL = 0.2460

1.0325Y2009 = $23.7831
YN2010 = 0.3455 +
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(b) LCL does not exist. The number
of errors is in a state of statistical control because none of the tellers is
outside the UCL. (c) Because Gina is within the control limits, she is
operating within the system and should not be singled out for further
scrutiny. (d) The process needs to be studied and potentially changed,
using principles of Six Sigma and/or total quality management.

17.16 (a) (b) LCL does not exist, (c) There
are no weeks outside the control limits. Therefore, this process is in
control. Note, however that the first eight weeks are below the mean.
(d) Because these weeks are within the control limits, the results are
explainable by common cause variation.

17.18 (a) . (b) . (c) . (d) .
(e) .

17.20 (a) R chart: LCL does not exist.
(b) According to the R chart, the process appears to be in control, with all
points lying inside the control limits, without any pattern and no evidence
of special cause variation. (c) chart:

(d) According to the chart, the process appears to be
in control, with all points lying inside the control limits, without any
pattern and no evidence of special cause variation.

17.22 (a) R chart:

LCL does not exist. chart:

(b) The process appears to be
in control because there are no points outside the control limits, there is
no evidence of a pattern in the range chart, there are no points outside the

control limits, and there is no evidence of a pattern in the chart.

17.24 (a) , LCL does not exist,
(b) . (c) The process is
in control.

17.26 (a) , LCL does not exist,
(b) There are no sample ranges 

outside the control limits, and there does not appear to be a pattern in the
range chart. The mean is above the UCL on Day 15 and below the LCL
on Day 16. Therefore, the process is not in control.

17.28 (a) , LCL does not exist,
(b) On Days 5 and 6, the sample

ranges were above the UCL. The mean chart may be erroneous because
the range is out of control. The process is out of control.

17.30 (a) (b)
(c)

(d)

17.32 (a)

(b)

= 1.644

CPL =
1X - LSL2

31R>d22 =
120.1065 - 182
310.8794>2.0592

= 1.56

Cp =
1USL - LSL2

61R>d22 =
122 - 182

610.8794>2.0592

= P1-4.932 6 Z 6 4.43352 = 0.9999

= Pa18 - 20.1065

0.8794>2.059
6 Z 6

22 - 20.1065

0.8794>2.059
b

P118 6 X 6 222
0.999999713.

P1X 6 1102 = P 1Z 6 52 =P1Z 7 -3.12 = 0.99903.
P1X 7 93.82 =X 6 107.52 = P1-3.5 6 Z 6 3.752 = 0.99968.

P193 6P198 6 X 6 1022 = P1-1 6 Z 6 12 = 0.6826.

UCL = 90.3060, LCL = 89.9573.
UCL = 0.6389; X = 90.1312,R = 0.3022

UCL = 24.0577, LCL = 12.1823.
UCL = 18.5869; X = 18.12,R = 8.145

X = 20.1065, LCL = 19.4654, UCL = 20.7475
UCL = 2.0068.R = 0.8794

X

A2R = 5.9413 - 0.72913.2752 = 3.5538.

LCL = X -UCL = X + A2R = 5.9413 + 0.72913.2752 = 8.3287.

XUCL = D4 R = 2.28213.2752 = 7.4736.

R =
a

k

i=1
Ri

k
= 3.275, X =

a
k

i=1
Xi

k
= 5.941.

XLCL = 47.7453.
UCL = 48.2507;X= 47.998,X

UCL = 0.636;R = 0.247,

A2 = 0.729
D4 = 2.282D3 = 0d3 = 0.880d2 = 2.059

UCL = 8.3015.c = 3.0566.

c = 66>12 = 5.5, UCL = 12.5356,

17.34 (a)

(b) Because only 99.39% of the tea bags are within the specification
limits, this process is not capable of meeting the goal of 99.7%.

17.46 (a) The main reason that service quality is lower than product
quality is because the former involves human interaction, which is prone
to variation. Also, the most critical aspects of a service are often
timeliness and professionalism, and customers can always perceive that
the service could be done more quickly and with greater professionalism.
For products, customers often cannot perceive a better or more ideal
product than the one they are getting. For example, a new laptop is better
and contains more interesting features than any laptop the owner has ever
imagined. (b) Both services and products are the results of processes.
However, measuring services is often harder because of the dynamic
variation due to the human interaction between the service provider and
the customer. Product quality is often a straightforward measurement of a
static physical characteristic such as the amount of sugar in a can of soda.
Categorical data are also more common in service quality. (c) Yes. (d) Yes.

17.48 (a) (b) Yes,
RudyBird’s market share is in control before the in-store promotion.
(c) All seven days of the in-store promotion are above the UCL. The
promotion increased market share.

17.50 (a) . Although
none of the points are outside the control limits, there is a clear pattern
over time, with the last 13 points above the center line. Therefore, this
process is not in control. (b) Because the increasing trend begins around
Day 20, this change in method would be the assignable cause. (c) The
control chart would have been developed using the first 20 days, and then
a different control chart would be used for the final 20 points because
they represent a different process.

17.52 (a) (b) Day 24 is
below the LCL; therefore, the process is out of control. (c) Special causes
of variation should be investigated to improve the process. Next, the process
should be improved to decrease the proportion of undesirable trades.

17.54 Separate p charts should be developed for each food for each shift:

Kidney—Shift 1:
Although there are no points outside the control limits, there is a strong
increasing trend in nonconformances over time.

Kidney—Shift 2:
Although there are no points outside the control limits, there is a strong
increasing trend in nonconformances over time.

Shrimp—Shift 1: There are
no points outside the control limits, and there is no pattern over time.

Shrimp—Shift 2: There are no
points outside the control limits, and there is no pattern over time.

The team needs to determine the reasons for the increase in
nonconformances for the kidney product. The production volume for
kidney is clearly decreasing for both shifts. This can be observed from a
plot of the production volume over time. The team needs to investigate
the reasons for this.

p = 0.01023, UCL = 0.021, LCL = 0.

p = 0.006995, UCL = 0.01569, LCL = 0.

p = 0.01829, UCL = 0.03329, LCL = 0.00329.

p = 0.01395, UCL = 0.02678, LCL = 0.00112.

p = 0.1198, LCL = 0.0205, UCL = 0.2191.

p = 0.75175, LCL = 0.62215, UCL = 0.88135

p = 0.2702, LCL = 0.1700, UCL = 0.3703.

X 6 5.82 = P1-2.83 6 Z 6 2.672 = 0.9962 - 0.0023 = 0.9939.
P15.2 6R = 0.2248, X = 5.509, n = 4, d2 = 2.059.

Cpk = min1CPL, CPU2 = 1.477

= 1.477

CPU =
1USL - X 2

31R>d22 =
22 - 20.1065)

310.8794>2.0592
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A
(level of significance), 329

A2 factor, 735
A priori probability, 146
Addition rule, 151–152
Adjusted r2, 585
Algebra, rules for, 774
Alternative hypothesis, 326
Among-group variation, 416–417
Analysis of means (ANOM), 424
Analysis of proportions (ANOP), 480
Analysis of variance (ANOVA)

Kruskal-Wallis rank test for differences in c medians, 500–504
assumptions of, 503

One-way, 416–422
assumptions, 424–425
F test for differences in more than two means, 418–419
F test statistic, 418
Levene’s test for homogeneity of variance, 425–427
summary table, 419
Tukey-Kramer procedure, 422–424

Randomized block design,
Testing for factor and block effects, 430–436
summary table, 433
Tukey procedure, 436

two-way, 439
cell means plot, 445–446
factorial design, 438–439
interpreting interaction effects, 446–447
multiple comparisons, 444–445
summary table, 442
testing for factor and interaction effects, 439–444

Analysis ToolPak,
checking for presence, 795
frequency distribution, 79–80
histogram, 82
descriptive statistics, 139
exponential smoothing, 709–710
F test for ratio of two variances, 410
multiple regression, 622–623
one-way ANOVA, 460
paired t test, 409
pooled-variance t test, 406–407
randomized block design, 461–462
separate-variance t test, 407–408
simple linear regression, 572
two-way ANOVA, 463
random sampling, 275,
sampling distributions, 276

Analyze, 28
ANOVA. See Analysis of variance (ANOVA)
Area of opportunity, 197, 728
Arithmetic mean. See Mean
Arithmetic operations, rules for, 774
Assignable causes of variation, 718

a

Assumptions
analysis of variance (ANOVA), 424–425
of the chi-square (χ2) test for the variance or standard deviation, 492
of the confidence interval estimate for the mean ( unknown),

286–287
of the confidence interval estimate for the proportion, 295
of the F test for the ratio of two variances, 392
of the paired t test, 378, 381
of Kruskal-Wallis test, 503
of regression, 538
for table, 473
for table, 478
for table, 485
for the t distribution, 287
t test for the mean ( unknown), 340–341
in testing for the difference between two means, 369
of the Wilcoxon rank sum test, 494
of the Z test for a proportion, 349

Attribute chart, 720
Auditing, 303
Autocorrelation, 543
Autoregressive modeling

steps involved in, on annual time-series data, 688
for trend fitting and forecasting, 684–691

B
Bar chart, 42–43
Bayes’ theorem, 163
Best-subsets approach in model building, 647–648

Risk, 329
Bias

nonresponse, 255
selection, 255

Binomial distribution, 190
mean of, 195
properties of, 190
shape of, 194
standard deviation of, 195

Binomial probabilities
calculating, 192

Black belt, 746
Blocks, 430
Boxplots, 117
Business analytics, 654

C
Capability indices, 739–740
Categorical data

chi-square test for the difference between two proportions,
461–472

chi-square test of independence, 475–478
chi-square test for c proportions, 481–485
organizing, 30–32
visualizing, 41–46
Z test for the difference between two proportions, 386–388

b

s

r * c
2 * c
2 * 2

s

850
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Categorical variables, 6
Causal forecasting methods, 666
c chart, 728–730
Cell means plot, 445–446
Cell, 10
Central limit theorem, 264–265
Central tendency, 96
Certain event, 146
Champions, 746
Chance causes of variation, 718
Chartjunk, 64
Charts. See also Control charts

bar, 42
Pareto, 44
pie, 43
side-by-side bar, 46–47

Chebyshev Rule, 123
Chi-square (χ2) distribution, 470
Chi-square (χ2) test for differences

between c proportions, 475–478
between two proportions, 469–472

Chi-square (χ2) test for the variance or standard deviation,
490–492

Chi-square (χ2) test of independence, 481–485
Chi-square (χ2) table
Class boundaries, 35
Class intervals, 35
Class midpoint, 36
Class interval width, 35
Classes, 35
Cluster sample, 254
Coefficient of correlation, 127–128

inferences about, 551
Coefficient of determination, 534–535
Coefficient of multiple determination, 584–585
Coefficient of partial determination, 597–598
Coefficient of variation, 106
Collectively exhaustive events, 151
Collect, 28
Collinearity of explanatory variables, 642–643
Combinations, 169–170, 191
Common causes of variation, 718
Companion website, 784
Complement, 147
Completely randomized design, . See also One-way analysis

of variance
Conditional probability, 155
Confidence coefficient, 329
Confidence interval estimation, 280

connection between hypothesis testing and, 336
for the difference between the means of two independent 

groups, 371
for the difference between the proportions of two independent

groups, 390–391
ethical issues and, 310–311
for the mean ( known), 280–285
for the mean ( unknown), 286–292
for the mean difference, 383–384
for the mean response, 554–556
for the population total, 304–305
for the proportion, 294–296
of the slope, 550, 591–592

for the total difference, 306–308
one-sided of the rate of noncomplaince with internal controls,

308–309
Contingency tables, 30–32 , 148, 468
Continuous probability distributions, 218
Continuous variables, 7
Control chart factors, 733–735

tables, 811
Control charts, 718

c chart, 728–730
p chart, 720–724
R chart, 732–733
theory of, 718–720
for chart, 734–735

Control limits, 719
Convenience sampling, 250
Correlation coefficient. See Coefficient of correlation
Counting rules, 167–170
Covariance, 125, 185–186
Coverage error, 255
Cp, 739
Cp statistic, 648
Cpk, 741
CPL, 740
CPU, 740
Critical to quality (CTQ), 738
Critical range, 423
Critical value approach, 331–333
Critical values, 284

of test statistic, 327–328
Cross-product term, 602
Cross validation, 652
Cumulative percentage distribution, 38–39
Cumulative polygons, 53–54
Cumulative standardized normal distribution, 221

tables, 798–799
Cyclical effect, 666

D
Data, 5

sources of, 28
Data collection, 28
Data mining, 647, 654
DCOVA, 28
Decision trees, 156–157
Define, 28
Degrees of freedom, 286, 288
Deming, W. Edwards, 743
Deming’s fourteen points for management, 743
Dependent variable, 522
Descriptive statistics, 4
Difference estimation, 305
Digital Case, 15, 75, 138, 177, 210, 244, 273, 318, 358, 405, 458,

512, 569, 620, 659, 708
Directional test, 345
Discrete probability distributions

binomial distribution, 190–194
covariance, 185–187
hypergeometric distribution, 203–205
Poisson distribution, 197–199

Discrete variables, 6
expected value of, 183

X
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probability distribution for, 182
variance and standard deviation of, 183–184

Dispersion, 101
DMAIC model, 744–745
Downloading files for this book, 784
Dummy variables, 599–601
Durbin-Watson statistic, 544–545

tables, 810–811

E
Empirical probability, 147
Empirical rule, 122
Estimated relative efficiency, 435
Ethical issues

confidence interval estimation and, 310–311
in hypothesis testing, 353–354
in multiple regression, 654
in numerical descriptive measures, 131
for probability, 171
for surveys, 256

Events, 147
Executive committee, 746
Expected frequency, 469
Expected value, 182

of discrete random variable, 182–183
of sum of two random variables, 187

Explained variation or regression sum of squares 
(SSR), 534

Explanatory variables, 522
Exponential distribution, 237

mean of, 238
standard deviation of, 238

Exponential growth
with monthly data forecasting equation, 699
with quarterly data forecasting equation, 698

Exponential smoothing, 670–671
Exponential trend model, 676–678
Exponents, rules for, 774
Extrapolation, predictions in regression analysis and, 527
Extreme value, 107

F
Factor, 416
Factorial design. See Two-way analysis of variance
F distribution, 392 , 418

tables, 803–806
First-order autoregressive model, 684
Five-number summary, 115
Forecasting, 666

autoregressive modeling for, 684–691
choosing appropriate model for, 692–695
least-squares trend fitting, 673–678
seasonal data, 696–701

Frame, 250
Frequency distribution, 35–36
Friedman test, 506
F test for the ratio of two variances, 392–395
F test for the block effect, 433
F test for the factor effect, 433
F test for factor A effect, , 441
F test for factor B effect, 441
F test for interaction effect, 442

F test for the slope, 549
F test in one-way ANOVA, 418

G
Gaussian distribution, 218
General addition rule, 151–152
General multiplication rule, 159–160
Geometric mean, 100
Geometric mean rate of return, 100–101
Grand mean, 417
Greek alphabet, 779
Green belt, 746
Groups, 416

H
Harnswell Sewing Machine Company case, 751–753
Histograms, 50–51
Homogeneity of variance, 425

Levene’s test for, 425–427
Homoscedasticity, 538
Hypergeometric distribution, 201

mean of, 202
standard deviation of, 202

Hypergeometric probabilities
calculating, 201

Hypothesis. See also One-sample tests of hypothesis
alternative, 326
null, 326
tests of, 326

I
Impossible event, 146
In-control process, 720
Independence, 158

of errors, 538
χ2 test of, 481–485

Independent events, multiplication rule for, 160
Independent variable, 522
Inferential statistics, 4
Influence analysis, 654
Interaction, 439,
Interaction terms, 602
Interpolation, predictions in regression analysis and, 527
Interquartile range, 115
Interval scale, 8
Irregular efect, 667

J
Joint probability, 150
Joint event, 147
Judgment sample, 250

K
Kruskal-Wallis rank test for differences in c medians, 500–504

assumptions of, 503
Kurtosis, 108

L
Least-squares method in determining simple linear regression, 525
Least-squares trend fitting

and forecasting, 673–678
Left-skewed, 108
Level of confidence, 283
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Level of significance ( ), 329
Levels, 416
Levene’s test

for homogeneity of variance, 425–427
Linear regression. See Simple linear regression
Linear relationship, 522
Linear trend model, 673–675
Logarithms, rules for, 775
Logarithmic transformation, 639–641
Logistic regression, 609–612
Lower control limit (LCL), 719
Lower specification limit (LSL), 738

M
Main effects, 443
Main effects plot, 420
Managing the Managing Ashland MultiComm Services, 74, 138, 209,

244, 273, 317–318, 358, 404, 457–458, 511–512, 569 , 620,
707, 753

Marascuilo procedure, 478–479
Marginal probability, 150–151, 160
Margin of error, 256,
Master black belt, 746
Matched samples, 377
Mathematical model, 190
McNemar test, 487–489
Mean, 96

of the binomial distribution, 195
confidence interval estimation for, 280–292
geometric, 100
of hypergeometric distribution, 202
population, 121
sample size determination for, 297–299
sampling distribution of, 258–260
standard error of, 260
unbiased property of, 258

Mean absolute deviation, 693–694
Mean square, 418
Mean Square Among (MSA), 418
Mean Square A (MSA), 432, 441
Mean Square B (MSB), 441
Mean Square Blocks (MSBL), 432
Mean Square Error (MSE), 432, 441
Mean Square Interaction (MSAB), 441
Mean Square Total (MST), 418
Mean Square Within (MSW), 418
Measurement

levels of, 7
types of scales, 7–9

Measurement error, 256
Median, 98
Microsoft Excel,

absolute and relative cell references, 21
autogressive modeling, 711
bar charts, 80–81
Bayes’ theorem, 177
basic probabilities, 177
binomial probabilities, 212
bins for frequency distributions, 78
boxplots, 140
c-chart, 756–757
cell means plot, 463

a cell references, 21
chart formatting, 815
chi-square tests for contingency tables, 514–515
chi-square tests for the variance or standard deviation, 516
choosing an appropriate forecasting model, 711–712
collinearity, 660
confidence interval esimate for the difference between the means

of two independent groups, 407
confidence interval for the mean, 319
confidence interval for the proportion, 320
confidence interval for the total, 321
confidence interval for the total difference, 322
contingency tables, 77–78
copying worksheets, 19
correlation coefficient, 141
counting rules, 178
covariance, 141, 211
creating histograms for discrete probability distributions, 816
creating new workbooks and worksheets, 19
cross-classification table, 514–515
cumulative percentage distribution, 80
cumulative percentage polygon, 84
descriptive statistics, 139
dialog boxes, 781–783
enhancing workbook presentation, 813–814
entering data, 18
entering formulas into worksheets, 21
expected value, 211
exponential probabilities, 246
exponential smoothing, 709–710
FAQs, 818
frequency distribution, 78–80
F test for the ratio of two variances, 410
Histogram, 82–83
Hypergeometric probabilities, 213
Keyboard shortcuts, 814
Kruskal-Wallis test, 517
least-squares trend fitting, 710–711
Levene test, 461
Marascuilo procedure, 515
McNemar test, 516
moving averages, 709
multidimensional tables, 85–86
multiple regression, 622–624
mean absolute deviation, 711–712
model building, 660–661
normal probabilities, 245
normal probability plot, 245–246
objects in a window, 780
one-tail tests, 360–361
one-way analysis of variance, 459
opening workbooks, 18–19
ordered array, 78
p-chart, 755–756
Paired t test, 408
Pareto chart, 81
Pasting with Paste Special, 816
Percentage polygon, 84
pie chart, 80–81
PivotTables, 76–77 85–86
Poisson probabilities, 213
Pooled-variance t test, 406
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Population parameters, 140
portfolio expected return, 211–212
prediction interval, 556–557
printing worksheets, 19–20
probability, 179
probability distribution for a discrete random variable, 211
process capability, 758
program window elements
quadratic regression, 660
randomized block design, 461
R-chart, 758
sample size determination, 320–321
sampling distributions, 276
saving workbooks, 18–19
scatter plot, 85
simple random samples, 275
seasonal data, 712
separate-variance t test, 407
side-by-side bar chart, 81–82
simple linear regression, 571–573
summary tables, 76–77
t test for the mean ( unknown), 360
time-series plot, 85
transformations, 660
two-way analysis of variance, 462–463
Tukey-Kramer multiple comparisons, 460
variance inflationary factor (VIF), 660
Wilcoxon rank sum test, 517
workbooks, 10
worksheet entries and references, 20–21
worksheets, 10

chart, 758
Z test for the difference between two proportions, 409
Z test for the mean (known), 359
Z test for the proportion, 361

Midspread, 115
Minitab

autoregressive modeling, 714
bar chart, 88
best-subsets regression, 662–663
binomial probabilities, 214
boxplot, 142
c chart, 759–760
chi-square tests for contingency tables, 518
collinearity, 662
confidence interval for the mean, 322–323
confidence interval for the proportion, 323
contingency table, 87
correlation coefficient, 143
counting rules, 178
covariance, 143
creating and copying worksheets, 24
cross-tabulation table, 519
cumulative percentage polygon, 91–92
descriptive statistics, 141–142
dummy variables, 626
entering data, 22–23
exponential probabilities, 247
exponential smoothing, 713
F test for the difference between variances, 412–413
FAQs, 819
histogram, 90–91

X

geometric mean, 141–142
hypergeometric probabilities, 215
Kruskal-Wallis test, 519
least-squares trend fitting, 713–714
Levene test, 464
logistic regression, 627
main effects plot, 464
model building, 662–663
moving averages, 713
multidimensional contingency tables, 93
multiple regression, 625–627
normal probabilities, 246
normal probability plot, 247
one-tail tests, 362
one-way analysis of variance, 464
opening worksheets and projects, 23
ordered array, 87
percentage polygon, 91
p chart, 759
paired t test, 411–412
Pareto plot, 89
pie chart, 88
Poisson probabilities, 214–215
printing parts of projects, 24
probability distribution for a discrete random variable, 216
printing worksheets, 24
project, 10
quadratic regression, 661
randomized block design, 465
R chart, 760–761
saving worksheets, 23
sampling distributions, 277, 280–285
saving worksheets and projects, 23
scatter plot, 92
seasonal data, 714–715
session

window, 11
side-by-side bar chart, 89
simple linear regression, 573–575
simple random samples, 276–277
stacked data, 87
stem-and-leaf display, 89
stepwise regression, 662
summary table, 86
t test for the difference between two means, 411
t test for the mean ( unknown), 362
three-dimensional plot, 625
time-series plot, 92
transforming variables, 662
Tukey-Kramer procedure, 464
two-way ANOVA, 465
unstacked data, 87
variance inflationary factors, 662
Wilcoxon rank sum test, 519
worksheet entries, 24–25
worksheet references, 24–25

chart, 760–761
Z test for the mean ( known), 361–362
Z test for the difference between two

proportions, 412
Z test for the proportion, 362–363

Mode, 99–100

s
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Model selection using
first differences, 678–680
second differences, 678–680
percentage differences, 678–680

Models. See Multiple regression models
Mountain States Potato Company case, 658–659
Mouse operations, 781
Moving averages, 668–669
Multidimensional contingency tables, 60–62
Multiple comparisons, 422
Multiple regression models, 578

adjusted r2, 585
best-subsets approach to, 647–648
coefficient of multiple determination in, 584–585, 635–636
coefficients of partial determination in, 597–598
collinearity in, 642–643
confidence interval estimates for the slope in, 591–592
dummy-variable models in, 599–601
ethical considerations in, 654
interpreting slopes in, 578–581
interaction terms, 602
with k independent variables, 579
model building, 644–652
model validation, 652
net regression coefficients, 581
partial F-test statistic in, 593–597
pitfalls in, 653–654
predicting the dependent variable Y, 581–582
quadratic, 630–635
residual analysis for, 588–589
stepwise regression approach to, 646–647
testing for significance of, 585
testing portions of, 593–597
testing slopes in, 590
transformation in, 638–641
variance inflationary factors in, 642–643

Multidimensional data,
Multiplication rule, 160
Mutually exclusive events, 151

N
Net regression coefficients, 581
Nominal scale, 8
Nonprobability sample, 250
Nonresponse bias, 255
Nonresponse error, 255
Normal approximation to the binomial distribution, 240
Normal distribution, 218

cumulative standardized, 221
properties of, 218

Normal probabilities
calculating, 222–228

Normal probability density function, 220
Normal probability plot

constructing, 232–234
Normality assumption, 424–425
Null hypothesis, 326
Numerical data,

organizing, 28
visualizing, 28

Numerical descriptive measures
coefficient of correlation, 127–128

measures of central tendency, variation, and shape, 96
from a population, 120–124

Numerical variables, 6

O
Observed frequency, 469
Odds ratio, 609–610
Ogive, 53–54
One-sided confidence interval, 308
One-tail tests, 344

null and alternative hypotheses in, 344–347
Online topics and case files, 791
Operational definitions, 6
Ordered array, 34
Ordinal scale, 8
Organize, 28
Outliers, 107
Out-of-control process, 720
Overall F test, 585

P
Paired t test, 377–381
Parameter, 6
Pareto chart, 44–46
Pareto principle, 44
Parsimony, 645, 694
Partial F-test statistic, 595
p chart, 720–724
Percentage distribution, 37
Percentage polygon, 51–53
Permutations, 169
PHStat

autocorrelation, 573
bar chart, 80
basic probabilities, 177
best subsets regression, 661
binomial probabilities, 212
boxplot, 140
c-chart, 756
cell means plot, 463
chi-square (χ2) test for contingency tables, 514–515
chi-square (χ2) test for the variance or standard 

deviation, 516
collinearity, 660
confidence interval

for the mean ( known), 319
for the mean ( unknown), 319
for the difference between two means, 407
for the population total, 321
for the proportion, 320
for the total difference, 321–322

configuring Excel for PHStat usage, 793
contingency tables, 77
cumulative percentage distributions, 80
cumulative polygons, 84
exponential probabilities, 246
FAQs, 818
F test for ratio of two variances, 410
frequency distributions, 78–79
histograms, 82
hypergeometric probabilities, 213
installing, 792–793

s

s
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Kruskal-Wallis test, 517
Levene’s test, 460–461
Marascuilo procedure, 514–515
McNemar, test 515–516
model building, 660–661
multiple regression, 622–624
normal probabilities, 245
normal probability plot, 245
one-way ANOVA, 459
one-tail tests, 360
p chart, 755
paired t test, 408
Pareto chart, 81
percentage polygon, 83
pie chart, 80
Poisson probabilities, 212
polygons, 83–84
pooled-variance t test, 406
portfolio expected return, 211
portfolio risk, 211
R chart, 757
residual analysis, 572
sample size determination

for the mean, 320
for the proportion, 320

sampling distributions, 275
scatter plot, 84–85
separate-variance t test, 407
side-by-side bar chart, 81
simple linear regression, 571–573
simple probability, 179
simple random samples, 275
stacked data, 78
stem-and-leaf display, 82
stepwise regression, 660–661
summary tables, 76
t test for the mean ( unknown), 360
time-series plot,
two-way ANOVA, 462
Tukey-Kramer procedure, 460
unstacked data, 78
Wilcoxon rank sum test, 516

chart, 757
Z test for the mean ( known), 359
Z test for the difference in two proportions, 409
Z test for the proportion, 361

Pie chart, 43–44
PivotTables, 60
Point estimate, 280
Poisson distribution, 197

calculating probabilities, 198
properties of, 197

Polygons, 51–52
cumulative percentage, 53

Pooled-variance t test, 366–368
Population(s), 6
Population mean, 121
Population standard deviation, 122
Population total

confidence interval estimate for, 304
Population variance, 121
Portfolio, 187
Portfolio expected return, 187–188

s

X

s

Portfolio risk, 187–188
Power of a test, 329
Practical significance, 353
Prediction interval estimate, 556–557
Prediction line, 525
Primary data source, 28
Probability, 146

a priori, 146
Bayes’ theorem for, 163
conditional, 155
empirical, 147
ethical issues and, 171
joint, 150
marginal, 150–151
simple, 149
subjective, 147

Probability density function, 218
Probability distribution for discrete random variable, 182
Probability sample, 250
Process, 718
Process owner, 746
Process capability, 737
Productivity management. See Quality and productivity

management
Proportions, 37

chi-square (χ2) test for differences between two, 469–472
chi-square (χ2) test for differences between c, 475–478
confidence interval estimation for, 294–296
control chart for, 720–724
sample size determination for, 299–301
sampling distribution of, 266–268
Z test for the difference between two, 386–388
Z test of hypothesis for, 349–351

pth-order autoregressive model, 684
p-value approach, 333–334

steps in determining, 335

Q
Quadratic regression, 630–635
Quadratic trend model, 675–676
Qualitative forecasting methods, 666
Qualitative variable, 6
Quantitative forecasting methods, 666
Quantitative variable, 6
Quartiles, 113
Quantile-quantile plot, 232–233

R
Random effect, 667
Random numbers, table of, 796–797
Randomized block design 430–436
Randomness and independence, 424–425
Range, 102

interquartile, 115
Ratio scale, 9
R chart, 732–733
Rectangular distribution, 235
Red bead experiment, 726–727
Region of nonrejection, 328
Region of rejection, 328
Regression analysis. See Multiple regression models; Simple linear

regression
Regression coefficients, 525
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Relative frequency distribution, 37
Relevant range, 527
Repeated measurements, 377
Replicates, 439
Residual analysis, 539, 589–590
Residual plots

in detecting autocorrelation, 543–544
in evaluating equal variance, 541
in evaluating linearity, 539
in evaluating normality, 541
in multiple regression, 588–589
in time series, 693

Residuals, 539
Resistant measures, 115
Response variable, 522
Right-skewed, 108
Robust, 369
Roles in a Six Sigma organization

Black belt, 746
Champions, 746
Executive committee, 746
Green belt, 746
Master black belt, 746
Process owner, 747
Senior executive, 745

S
Sample, 6
Sample mean, 97
Sample proportion, 349
Sample standard deviation, 103
Sample variance, 103
Sample size determination

for mean, 297–299
for proportion, 299–301

Sample space, 148
Samples

cluster, 254
convenience, 250
judgment, 250
nonprobability, 250
probability, 250
simple random, 251–252
stratified, 253
systematic, 253

Sampling
from nonnormally distributed populations, 264–265
from normally distributed populations, 261–263
with replacement, 251
without replacement, 251

Sampling distributions, 258
of the mean, 258–260
of the proportion, 266–268

Sampling error, 255
Scale

interval, 8
nominal, 8
ordinal, 8
ratio, 9

Scatter diagram, 522
Scatter plot, 56–57, 522
Seasonal effect, 667
Secondary data source, 28

Selection bias, 255
Senior executive, 745
Separate-variance t test for differences in two means, 372–374
Shape, 96, 108
Shewhart-Deming cycle, 743
Side-by-side bar chart, 46–47
Simple event, 147
Simple linear regression

assumptions in, 538
avoiding pitfalls in, 560
coefficient of determination in, 534–535
coefficients in, 525
computations in, 528
Durbin-Watson statistic, 544, 545
equations in, 525
estimation of mean values and prediction of individual values,

554–557
inferences about the slope and correlation coefficient, 547–552
least-squares method in, 525
pitfalls in, 558
residual analysis, 539–542
standard error of the estimate in, 536–537
sum of squares in, 533–534

Simple probability, 149
Simple random sample, 251–252
SIPOC analysis, 745
Six Sigma, 744–746
Skewness, 108
Slope, 523

inferences about 548–549, 590
interpreting, in multiple regression, 578–581

Special or assignable causes of variation, 718
Specification limits, 738
Spread, 101
Square roots, rules for, 774
Square-root transformation, 638–639
Stacked data, 33–34
Standard deviation, 102–103

of binomial distribution, 195
of discrete random variable, 184
of hypergeometric distribution, 202
of population, 122
of sum of two random variables, 187

Standard error of the estimate, 536–537
Standard error of the mean, 260
Standard error of the proportion, 267
Standardized normal random variable, 220
Statistic, 6
Statistical control, 720
Statistical inference, 4
Statistical package, 10
Statistical sampling, advantages of, in auditing, 303
Statistical symbols, 779
Statistics, 4

descriptive, 4
inferential, 4

Stem-and-leaf display, 49–50
Stepwise regression

approach to model building, 646–647
Strata, 253
Stratified sample, 253
Studentized range distribution, 423

tables, 808–809
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Student’s t distribution, 286
Subgroups, 719
Subjective probability, 147
Summary table, 30
Summation notation, 776–778
Sum of squares, 102
Sum of squares among groups (SSA), 417, 431
Sum of squares due to blocks (SSBL), 432
Sum of squares due to factor A (SSA), 440
Sum of squares due to factor B (SSB), 440
Sum of squares due to regression (SSR), 534
Sum of squares of error (SSE), 432, 440, 534
Sum of squares to interaction (SSAB), 440
Sum of squares total (SST), 417, 431, 440, 533
Sum of squares within groups (SSW), 417
Survey errors, 255
Symmetrical, 108
Systematic sample, 253

T
Tables

chi-square, 802
contingency, 30–32, 148, 468
Control chart factors, 811
Durbin-Watson, 810–811
F distribution, 803–806
for categorical data, 30–32
cumulative standardized normal distribution, 798–799
for numerical data, 28
of random numbers, 251–252, 796–797
standardized normal distribution, 812
Studentized range, 808–809
summary, 30
t distribution, 800–801
Wilcoxon rank sum, 807

t distribution, properties of, 287
Tampering, 719
Test statistic, 328
Tests of hypothesis

Chi-square (χ2) test for differences
between c proportions, 475–478
between two proportions, 469–472

Chi-square (χ2) test for the variance or standard deviation, 490–492
Chi-square (χ2) test of independence, 481–485
Friedman test, 506
F test for the ratio of two variances, 392–394
F test for the regression model, 585–586
F test for the slope, 549
Highest-order autoregressive parameter, 686
Kruskal-Wallis rank test for differences in c medians, 500–504
Levene test, 425–427
McNemar test, 487–489
Paired t test, 377–381
pooled-variance t test, 366–368
separate-variance t test for differences in two means, 372–374
t test for the correlation coefficient, 551
t test for the mean (unknown), 338, 340
t test for the slope, 548, 590
testing portions of the multiple regression model, 593–597
testing the quadratic model, 633
Wilcoxon signed ranks test, 505
Wilcoxon rank sum test for differences in two medians, 494–498

Z test for the mean ( known), 330–332
Z test for the difference between two proportions, 386–388
Z test for the proportion, 349–351

Think About This, 166, 228–229, 256–257, 374, 561, 703
Times series, 666
Time-series forecasting

autoregressive model, 684–691
choosing an appropriate forecasting model, 692–695
component factors of classical multiplicative, 666–667
exponential smoothing in, 670–671
least-squares trend fitting and forecasting, 673–678
moving averages in, 668–669
seasonal data, 696–701

Times series plot, 58
Total amount, 304
Total difference, confidence interval estimate for, 306
Total quality management (TQM), 742–744
Total variation, 417
Transformation formula, 220
Transformations in regression models

logarithmic, 639–640
square-root, 638–639

Trend, 666
t test for a correlation coefficient, 551–552
t test for the mean ( unknown), 338–340
t test for the slope, 548, 590
Tukey procedure, 436, 444–445
Tukey-Kramer multiple comparison procedure, 422–424
Two-factor factorial design, 439–444
Two-sample tests of hypothesis for numerical data

F tests for differences in two variances, 392–394
Paired t test, 377–381
t tests for the difference in two means, 366–368, 372–374
Wilcoxon rank sum test for differences in two medians, 494–498

Two-tail test, 331
two-way, 439

cell means plot, 445–446
factorial design, 438–439
interpreting interaction effects, 446–447
multiple comparisons, 444–445
summary table, 442
testing for factor and interaction effects, 439–444

Type I error, 328
Type II error, 328

U
Unbiased, 258
Unexplained variation or error sum of squares (SSE), 432, 440, 534
Uniform probability distribution, 235

mean, 235
standard deviation, 235

Unstacked data, 33–34
Upper control limit (UCL), 719
Upper specification limit (USL), 738

V
Variables, 5

categorical, 5
continuous, 5
discrete, 5
dummy, 599–601
numerical, 5

s
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Variables control charts, 732–735
Variance inflationary factor (VIF), 642–643
Variance, 102

of discrete random variable, 183–184
F-test for the ratio of two, 392–394
Levene’s test for homogeneity of, 425–427
of the sum of two random variables, 187
population, 121
sample, 103

Variation, 96
Venn diagrams, 148–149
Visual Explorations

descriptive statistics, 110
normal distribution, 228
sampling distributions, 265
simple linear regression, 530
Visualize, 28

W
Wald statistic, 612
Width of class interval, 35

Wilcoxon rank sum test
for differences in two medians, 494–498
tables, 807
Wilcoxon signed ranks test, 505

Within-group variation, 416–417

X
chart, 734–735

Y
Y intercept , 523

Z
Z scores, 107
Z test

for the difference between two proportions, 386–388
for the mean ( known), 330–331
for the proportion, 349–351
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